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1.  Copyright Notice
© Copyright 2020 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are
the property of Esko Software BV. The material, information and instructions are provided
on an AS IS basis without warranty of any kind. There are no warranties granted or extended
by this document. Furthermore Esko Software BV does not warrant, guarantee or make any
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contained herein.

The information contained herein is subject to change without notice. Revisions may be issued
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No part of this document may be reproduced, stored in a data base or retrieval system,
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PANTONE
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Media Entertainment.
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Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP
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Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric
Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign,
PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.
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Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the
United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
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reserved.
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Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
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Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.
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Reserved.

All other product names are trademarks or registered trademarks of their respective owners.
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info.eur@esko.com
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2.  What's New?

2.1.  What's New in this Version?

You can find all information about changes in this version in these documents:

• Download the "What's New?" PDF from https://www.esko.com/en/Support/Product?
id=Automation%20Engine.

• http://www.esko.com/systemrequirements includes updated information on the system
requirements.

• On the installation DVD, find a link to the Release Notes, which contain a list of the
customer support logs that were solved in this version.

• All information about "(soon) outdated tasks" is part of this manual. Find it at the end of
the chapter Task and Workflow Controls, at the bottom of the list with all the types of tasks.
Here's a direct link: Outdated and Soon Outdated Tasks in this Version on page 488.
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3.  Introducing Automation Engine

3.1.  What is Automation Engine?

Automation Engine serves to increase productivity of prepress workflows. It does this through
automated workflows, data management and quality control tools.

Automation Engine is one of many Esko Software applications that serve various segments of
the packaging and printing industry.

3.1.1.  Client-Server Architecture

The Automation Engine server is where all background actions are executed. This is also where
the main configuration and databases are stored. This server is a powerful computer running
on Windows server OS.

The most known client application is the Automation Engine Pilot. You can install a Pilot on
Mac or Windows computers in the LAN network of the server. The Pilot is the main interface
for most users. This is where they inspect files and launch and manage tasks on the server.
Depending on the user's Access Rights, more setup and configuration tools become available.

Note:  Since v18.1, Some of the Automation Engine tools can also be used from a browser
client.

Some customers prefer to use the client application Shuttle. This tool offers a more limited
interface where you can simply drag and drop files to launch the same kind of workflows on
the Server.

Users that work with interactive applications from Esko (ArtPro, ArtPro+, PackEdge, Plato,
DeskPack) can also launch tasks from within those applications on the file that they currently
work on.

Most server activity can also be started directly by external systems. Automation Engine offers
many tools for a two way integration with non-Esko tools like business systems.
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Tip:  Learn more about its architecture in the online interactive Learning Module.
 

 

Attention:  Detailed technical requirements for server and client computers are
described on http://www.esko.com/systemrequirements.

3.1.2.  Data Management and Central Resources

Data Management and Central Resources

The (prepress) data that Automation Engine can work with does not have to be stored on the
Automation Engine server, it can also be stored on a dedicated file server. Automation Engine
can work with any data that is stored on network shares that you configured on Automation
Engine. These places are called Containers.

Automation Engine offers databases to structure, manage and quickly access to files. Learn
more in the Jobs and Products concepts. The database server software is automatically installed.
You have the option to use a different database server. Learn more in the chapter Pre-Install IT
Requirements on page 1739.

The Automation Engine server also stores its Central Resources. These are for example files
related to fonts, color management or RIP'ing (curves, screening files).

3.1.3.  Multi-Site Environments

Automation Engine itself is restricted to work with data within the same LAN.

• Access Points enable up and downloading data from (S)FTP or cloud storage sites to your
Automation Engine.

• Esko WebCenter, a web platform for packaging project management, can also be used to
share data between multiple sites.

Automation Engine's in different Locations that Collaborate by Sharing Jobs
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Learn about this setup in the chapter Collaborating via Esko Cloud  on page 1471.

3.1.4.  Scalability and Security

More Functionality

Automation Engine is a very modular product. The sales modules that you purchased or
subscribed to decide the licenses on your server. For example, the "Layout" module enables
the licences for the "Step & Repeat" tasks.

For more info, check the available sales modules with your Esko sales contact.

More Power and Usage

The more powerful your Automation Engine server computer is, the faster it will process the
background tasks and the faster it will react to requests from Pilot users.

Attention:  It is important to check the minimal requirements for server and client
computers on http://www.esko.com/systemrequirements.

• Processing Channels: How many tasks your server will process at the same time is also
decided by licenses. A sales module so decides whether your server is allowed to process 1,
2, 4, 8 or 16 tasks at the same time ("concurrent"). 16 is the maximum. It is also possible to
reserve some processing channels for specific tasks.

• Maximum Client Users: This same sales module also defines how many client applications
can be used at the same time. For example: a maximum of 20 Pilot users logged in at the
same time.

Note:  Learn more in the chapter Automation Engine Server Management on page 1778.

Fail Safety

Automation Engine offers tools to automatically backup your software configuration and
databases.

Learn more in the chapter Automation Engine Server Management on page 1778.

More Power combined with More Fail Safety

You can add Automation Engine Assistants to your Automation Engine Master Server.

• An Automation Engine Assistant is another computer that helps out by also executing tasks
(maybe a specific type of tasks).

• An Assistant can also be stand-by to become the Master Server when your Master server is
down because of a serious problem. There are many scenarios for disaster recovery. These
depend on where the data server is and where the database server is.
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Note:  Learn more in the chapter Pre-Install IT Requirements on page 1739.

3.1.5.  The Automation Engine Viewer

The Automation Engine Viewer is a tool that your start from the Pilot to view and inspect files.
It offers powerful features to view, measure and compare files, even when they are different
file formats or have different sizes. Even staff in your customer service department can for
example install a Pilot for this reason only.

Each file that you open in this Viewer is a stream of pixels sent by the Automation Engine
server to your local Pilot. These pixels can be created by the server on-the-fly , or they could
have been prepared before, also by the server. This is why the use of the Viewer can have a
significant impact on the load of your server.

Learn more in the chapter Quality Control Tools.

3.1.6.  Integration with Other Applications

External Applications bundled with Automation Engine

Automation Engine also offers licenses for tasks that use these built-in applications:

• The Preflight technology from Enfocus PitStop Server.

• Several file Inspection tasks from Global Vision.

Learn more in Quality Control tools on page 992.

Integrating with other Esko Applications

Automation Engine offers a bi-directional communication with most other Esko applications:

• Esko Editors can link with the Automation Engine server. This way, they use the same
central resources (color data, fonts etc.) and can also launch tasks on the file that the
operator has open in the Editor. Learn more in Launching Tasks from Editors on page 101.

• Esko RIP and Proof software (Imaging Engine, FlexRip).

• the Front End application of an Esko CDI (DFS or Grapholas) or an Esko Kongsberg table (iPC).

• Integration with Esko WebCenter. Learn more in the dedicated chapter Integrating with
WebCenter on page 1526.

• Integration with Esko Share & Approve. Learn more in the dedicated chapter Integrating with
Share & Approve on page 1547.

Integrating with External Systems

Apart from classic tools like integration via Folder Access Points exchanging data via FTP,
Automation Engine offers a wide range of integration capabilities with external systems. These
tools can use XML, JDF or even direct database interaction.
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Learn more in the dedicated chapter Integrating with External Systems on page 1553.

3.1.7.  Scripting

Although Automation Engine already offers a broad set of tools to create custom workflows,
it is still possible that you miss some functionality or that the available functionality does not
support the native graphics format that you want to run them on.

This is why Automation Engine also offers custom scripting: you can write scripts (small
programs) that typically represent actions that operators do interactively in their graphic
desktop applications..

Learn more in Using Scripts on page 1697.

3.1.8.  More Help?

Next to this elaborate documentation set, these tools can also help:

• Tool Tips: In many places in the Pilot, hover your mouse over a button or text to get a short
explanation.

• In each dialog of a task ticket (and some other places), click on  to open the online
documentation page for that topic.

• Keyboard Shortcuts: They are listed in the Pilot's Help menu.

• You can still see some old interactive Learn Modules about several basic concepts.

• Esko's Knowledge Base contains information that is not part of this documentation. It
contains articles about temporary topics, very technical topics, tips and tricks or specific
error messages.

3.2.  File Types and How they are Recognized

Supported File Types

Automation Engine recognizes most of the standard file formats in the printing and packaging
industry (graphics, CAD and communication standards). It also supports Esko native formats
like ArtPro (AP) and ArtiosCAD (ARD, MFG).

Most graphics functionality runs on PDF.

• Learn more about benefits of 'normalization' in Normalized PDF and XMP in Automation
Engine on page 43.

• Learn more about native PDF workflows in PDF+ in Automation Engine on page 51.

• Learn more about the use of PDF/X-4 in the separate document available on the Automation
Engine documentation page, in the section "Related documentation".

When your production file format is ArtPro, you can also choose to execute background tasks
on the native AP format by using ArtPro Action Lists.
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Table: File types offered by the Pilot's 'Filter' tool

File Type File
Extension

Description

A3D A3D 3D format of Esko ArtiosCAD

Adobe
Illustrator 8.0

AI These old AI files can still be read with the task that
normalizes PostScript data.

Adobe
Illustrator

AI Since v9, AI files can be the native AI format, which
Automation Engine cannot read/normalize, or they can be
saved as PDF compatible. The Pilot checks and shows the real
format.

ARD ARD Native CAD format of Esko ArtiosCAD (one-up)

ArtPro AP Native format of Esko ArtPro

CT CT Contone file (Esko legacy picture format)

JS JS 'Job Sheet' (used in TIFF/IT workflow)

LC LC Esko legacy contour (vector)

LP LP Esko legacy bitmap

Plato Plate PLA Esko Plato layout file, referring to legacy GRS files

BMP BMP Bitmap image

CDI LEN, VIEW RIP'ed (view) file for Esko CDI (flexo CTP)

CorelDRAW CDR CorelDraw native graphics

CFF2 CF2 Packaging CAD format

CSV CSV Comma Separated Value, typically exported from a
spreadsheet or database

CTD CTD Preview data of CT file

Collada DAE Format for interactive 3D applications, XML version

DAT DAT Archive file of all impositions and page lists of a Job (Esko page
workflow)

DCS EPS, DCS Desktop Color Separation, a collection of EPS files

Microsoft
Word 97- 2003

DOC Old native MS Word document

Microsoft
Word

DOCX Native MS Word document

DXF DXF CAD format

EPS EPS Encapsulated PostScript file

Flat - Item in Esko page workflow (set of plates)

Adobe
FrameMaker

FM Native file

GRA GRA Legacy Esko format (page graphics)
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File Type File
Extension

Description

GRC GRC Legacy Esko format (label or packaging graphics)

GRI GRI Legacy Esko format (imposition output)

GRO GRO Legacy Esko format (generic output)

GRQ GRQ Legacy Esko format (QuickStep layout)

GRR GRR Legacy Esko format (layout)

GRS GRS Legacy Esko format (graphics)

GRT GRT Legacy Esko format (tiles)

GRV GRV Legacy Esko format (view data)

GRZ GRZ Legacy Esko format (ZIP'ed)

HTML HTM, HTML Web page

Imposition File IMP Imposition created by Esko FastImpose

Imposition File
(GRS)

IMP Imposition created by Esko FastImpose, referring to legacy
GRS files,

Imposition - Item in Esko page workflow

Adobe
InDesign

INDD Native graphics format

JDF JDF Job Definition Format (www.cip4.org)

JMF JMF Job Messaging Format, HTTP version of JDF

JPEG JPG Picture

Layer - Item in Esko page workflow (layer of an Imposition)

MFG MFG Esko ArtiosCAD manufacturing file (CAD layout)

MJM MJM JMF Mime Package

PAF PAF Legacy version of Packed Archive Format.

PAF PAFSC Packed Archive Format. Esko native format to exchange
graphics files.

PAG PAG Legacy Esko FastImpose "page" file

Page - Item in Pages View (Esko page workflow)

PageSlot - Empty item in Pages View (Esko page workflow)

PDF PDF Portable Document Format. Including PDF+.

PDF Plato PDFPLA Esko Plato layout (PDF with references)

Normalized
PDF

PDF PDF checked by Esko for print-ability, enriched with XMP
metadata, allowing external references

PDF Station PDFSTA Esko Plato "station" file

PICT PICT, PCT Old file format often used for screenshots

PLA PLA Legacy Esko FastImpose "plate" file
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File Type File
Extension

Description

Adobe
PageMaker

PMD Native file

PNG PNG Portable Network Graphic (picture)

PPF PPF Print Production Format (CIP3 ink key settings)

PPML PPML Personalized Print Markup Language, XML-based standard for
Variable Data Printing

PostScript PS PostScript file

PSD PSD Adobe Photoshop file

Microsoft
Publisher

PUB Native file

QuarkXpress QXD, QXP Native file

Rich Text
Format

RTF Text format

RTL RTL Old pixel format for HP proofers

RunList Runlist List of required page or station files (imposition and layout
workflow)

Section - Item in Esko page workflow

Sheet - Item in Esko page workflow

Sheet Side - Item in Esko page workflow

SIG SIG Legacy Esko signature file (page workflow)

STA STA Legacy Esko Plato "station" file, GRS format

TCP TCP Esko legacy Trapping Color Pair

Tiff TIF, TIFF Tagged Image File Format

TIFF/IT TIF, TIFF, LW,
CT...

Version of TIFF, bitmap separations

TXT TXT Simple text format

U3D U3D 3D graphics format, supported by Acrobat

VRML WRL 3D graphics format

Microsoft
Excel 97 - 2003

XLS Older version of spreadsheet file

Microsoft
Excel

XLSX Spreadsheet file

XML XML Extensible Markup Language

ZAE ZAE Format for interactive 3D applications, full version

ZIP ZIP Archive file
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Automatic File Type Determination

Several Views in the Pilot show a column File Type. The shown file type determines the
functionality that the Pilot offers on that file.

Several steps are used to determine the correct file type:

1. The Pilot immediately shows the file type based on the file's extension.
2. In the next second, for some files, a second check is done. This can change the shown

file type. For example: The file type of a file with an extension .AI that was saved as PDF
compatible, will so change from "Adobe Illustrator file" to "PDF file".

Note:  This extra check is not done for all file formats. To manually change the file type ,
right-click the file and choose "Change File Type". This can for example be necessary to
enable launching a specific task on that file.

3. When a task is started, the task does an extra check as well, to make sure it is worth
launching that task on this file. This for example also happens when Access Points receive
files with an extension that you cannot control.

3.3.  Important Concepts and Work Modes

We here introduce some important terms that we use in the next chapter Getting Started on
page 73.

Note:  Although parts of it are outdated, it might still be interesting to check the interactive
Learn Module that introduces the Pilot. Find it next to the documentation on Automation
Engine's documentation web page.

3.3.1.  Containers (introduction)

A Container is a network share that contains data that Automation Engine can work with.
Containers can be located on your Automation Engine server or on another computer in the
same LAN (Local Area Network).

You can create a Container by using (part of) an existing network share or you can have
Automation Engine create the network share while creating a Container. To manage
Containers, go to Tools >  Containers.

The installation of Automation Engine by default creates an "ExampleJobContainer" on the
disk drive where you installed the server software.

You can add many more Containers. You can see and browse through them in the Pilots’
Containers mode. An example:
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Looking at Files or Looking at Database Items

As a Pilot user, you can choose to

• Use the Files view, where you see and manage data by browsing through Containers.
This is a classic way of accessing data, but if you combine it with using SmartNames and
Workflows, you can also get a high level of automation.

• Use one or multiple Pilot Views that offer faster and smarter ways to access and manage
data.

• Jobs: a database representation of "jobs to do". Each Job has it's specific parameters.
One of those is the folder containing the data for that specific Job. In the Pilot, these Job
Folders show up as a blue folder.

• Products: a database representation of one-up assets, easily linked to Job where they play
a part in. This is typically used at packaging and labels sites that do print re-runs. Using
this Products tool significantly improves their data management.

Many more Pilot Views focus on a specific type of workflow or output. All these Views are
introduced in Pilot Views and Tools  on page 107. Some are described in detail in dedicated
chapters.

3.3.2.  Jobs (introduction)

What is a Job?
In Automation Engine, a Job represents work that has to be done. A Job contains all the files
and information related to a specific job-order. A Job has a unique name. Depending on
your type of business, your Job could be to create a specific asset or to physically produce
something, or a combination of both.

A Job represents a job-order and is therefor also "WIP": Work In Progress. This also means that,
in Automation Engine, you should remove Jobs that are finished. The Jobs database can hold a
few thousands Jobs, but having that many Jobs means that there is something wrong with how
you use this tool.

A Job is an item in the Automation Engine Jobs database, its Job folder is displayed as a blue
folder .

In the Containers mode and Files view, you can see the location of Jobs in their Container:
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Once a Job is open ("Last used Job mode"), you can see its subfolders and files.
 

 

Job Metadata (Job Setup Parameters)
A Job can have an extended set of metadata: inks, barcodes or layouts to use, customer
information, categorizations or any other custom parameter. This metadata is also stored in
the Jobs database, and can be used when launching tasks on files that are present in the Job
folder of Job.

Ideally, these Job Setup parameters are not set manually but came in automatically when the
Job was created by your business system.

Job based Automation

Automation Engine is very Job-centric. Workflow tasks can take their settings from the Job
Setup. They can even be launched automatically when the Job reaches a certain status (for
example: all the expected files have been delivered, the Milestone changed to 'Approved'
etc...).

Note:  When you choose not to work with the Jobs tool, you can still get a similar level of
automation by using alternative tools like Workflow Parameters.

Job Folders

Each Job has a Job Folder. Job Folders are located somewhere in a Container and typically have
a similar substructure, for example specific subfolders for artwork, production file(s), proof or
other output file(s).

Learn more in the dedicated chapter Jobs on page 495.

3.3.3.  Products (introduction)

A Product represents a production asset. The Products database stores their location within
the Container and a lot of metadata, for example their status, their graphic parts, etc.

The Products view is a user-friendly, searchable view on the Products database. You can use it
to create new Products, search them and link them to Jobs.

Customers doing a lot of print re-runs use the Products tool to easily re-link production files
that they printed earlier to the new Job (the one representing the order where the product was
re-ordered).
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Learn more in the dedicated chapter Products on page 548.

3.3.4.  Page Workflow Views and Tools (introduction)

Customers with page (imposition) workflows typically combine the Jobs tool with the 3 Views in
the category "Commercial Print":

• The Pages view allows to build page lists, monitor incoming pages and their individual state
of approval.

• The Proofs view shows the proof data that was made of the imposition and its status.

• The Plates view shows the status of the expected plates for that Job.

Impositions can be created with Esko FastImpose or with non-Esko applications.

Automation Engine is fully equipped to serve high automated JDF workflows.

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.
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4.  PDF Formats and Metadata

4.1.  Normalized PDF and XMP in Automation Engine

4.1.1.  Introduction

Naming Convention

In this section, PDF files that have not gone through normalization will be referred to as “PDF”.

PDF files that have been normalized will be referred to as “Normalized PDF”.

Normalization in Automation Engine, but not always...

• In Automation Engine v16 till 18.1 - Before PDF+

There are 2 types of technologies handling graphic files:

• PDF tasks: These tasks can process PDFs directly without prior normalization.
• Normalized PDF tasks: These tasks require a PDF to be normalized before further

processing.

These 2 types of tasks can be mixed in a workflow:

• PDF tasks can process Normalized PDFs.
• Normalized PDF tasks will automatically normalize regular PDFs.

• Since Automation Engine 18.1.1 - Since PDF+

Automation Engine 18.1.1 (Nov 2019) introduced the first tasks handling PDF+ files from
ArtPro+.

This added a 3rd type of task technology, but it is the one that eventually will replace Esko's
PDF Normalization.

Learn all about PDF+ and this native PDF workflow in PDF+ in Automation Engine on page
51.

4.1.2.  What Makes a Normalized PDF Special?

Overview
Normalized PDF files are to a large extent regular PDF 1.6 files, except in these specific areas:

• External references
• Color space
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• Document level metadata
• Object level metadata

External references
A Normalized PDF is not always self-contained. It can refer to images or other PDFs that are
not embedded in the PDF itself. Making use of references instead of embedding images and/or
graphics can have several advantages in the workflow.

• The main advantage is that it allows for “late binding”.

For example: An image can be color corrected. After the color correction all PDFs that refer
to this image will automatically contain the corrected version of the image without the need
to open and rewrite these PDFs.

• Working with Normalized PDFs that have external references can also lead to faster
processing, especially when the Normalized PDF refers to large amounts of external image
data.

Attention:  Although referring to external files is a standard PDF feature (for example
used in the PDF/X-5), most PDF applications do not support this. To guarantee that
a PDF can be processed correctly by a PDF application (like Adobe Acrobat), it has to
be made self-contained (embedding all the referred components like images). A self-
contained Normalized PDF is 100% PDF compatible.

Color space
A Normalized PDF can only contain objects in the final printing color space. This final printing
color space can have any number of separations but in most cases this will be CMYK and some
spot colors. The PDF object model allows objects to be defined in RGB and CIE based color
spaces. This is not possible in Normalized PDF. During normalization such objects are color
converted to CMYK.

The fact that Normalized PDF cannot contain objects in RGB or CIE based color spaces is its
biggest limitation. On the positive side, it makes the workflow more predictable. It avoids
late and often somewhat hidden color conversions (for example in the RIP) that can lead to
problems in printing.

Document level metadata
A Normalized PDF contains XMP metadata. The schema of the XMP data is Esko specific, but
the specification is public. The XMP metadata serves 2 purposes. It contains info about the
file that can be extracted by 3th party applications and used for example for quality control
or asset management. The XMP metadata are also used by Esko applications like Automation
Engine to retrieve information from a PDF in an efficient way (for example the number of
separations).
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Object level metadata
A Normalized PDF contains metadata for specific objects like barcodes. Object level metadata
are added to allow modification of those objects using an Esko application. Object level
metadata are stored using a proprietary mechanism and format.

4.1.3.  Which Tasks Require PDF Normalization?

The table below lists the Automation Engine tasks,

• that require normalization and will normalize regular PDFs automatically (Normalized PDF
Tasks),

• that do not require normalization (PDF tasks).

Note:  The exact list of tasks available on your Automation Engine server depends on the
licenses you have, so some tasks in the list below may not be visible in your Pilot.

Normalized PDF Tasks PDF Tasks

Add Ink Eaters Adjust PDF Screening

Check Job Parameters Compare PDF

Check Print Rules (PRC) Create PDF File from RunList

Convert CMYK Colors Extract Inks

Convert Colors with Equinox Optimize PDF Document

Create Design (DesignWizard) Optimize PDF Separations

Create PAF/JPG/XML (LinkEdge) Preflight with PitStop

Create Report (ReportMaker) Process PDF Spreads

Enrich Black Resize PDF for Output

Export to 3D Resolve OPI

Export to ArtPro File Split Pages

Export to EPS/DCS File Version PDF

Export to PDF File Image to Screened Separations

Export to PostScript File Image to Unscreened Proof

Export to VRML File Image to Unscreened Separations

FastVariants (all tasks) Inspect Artwork

Manage Colors Inspect Barcodes

Optimize and Clean (PSFix) Inspect Braille

Outline Fonts Inspect Spelling

PowerTrapper Inspect Text

Prepare Station Merge PDF Files

RIP (all tasks) Proof for Content Approval

Trap (all tasks) Proof for Contract Approval
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Normalized PDF Tasks PDF Tasks

Check Product Parameters Step and Repeat Tabular (Dynamic)

Create Cad Sheet Step and Repeat Template (Dynamic)

Create Tiles Verify Certification

Load Structural File

Prepare for Viewer

Prepare Graphics for Nesting

Step and Repeat CAD based

Step and Repeat Tabular

Step and Repeat Template based

4.1.4.  How do PDF Tasks Work with Normalized PDF Files?

Important:  The PDF tasks require self-contained input files and will therefore automatically
embed all external references where needed.

The example workflow described here takes a file, removes the separation named “Cut” and
traps the file. It can be used with both Normalized and regular PDF documents.  
 

 
We here describe how Automation Engine processes a Normalized PDF input file in this
workflow:

Task Task Type Description

Optimize PDF
Separations

PDF task The task checks whether the Normalized PDF input file
contains any external references to images or other
Normalized PDFs:

• if there are external references, the "Optimize
PDF Separations" task will first make the Normalized
PDF input file self-contained (by embedding all the
external references).

• if there are no external references, the task will
process the Normalized PDF directly.

The task also updates the XMP document metadata.
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Task Task Type Description

Trap with
PowerTrapper

Normalized PDF
task

The task traps the Normalized PDF file.

4.1.5.  How do Normalized PDF Tasks handle Regular PDF Files?

We will use this example workflow: 

 

 

Task Task Type Description

Optimize PDF
Separations

PDF task The PDF is processed directly, there is no normalization
process.

Trap with
PowerTrapper

Normalized PDF
task

The task detects that the input file is a regular PDF
file, and first automatically normalizes it. Then, this
normalized PDF is trapped and the output is a self-
contained Normalized PDF.

The ticket that is used for this Automatic Normalization can be configured in the Configure
tool (Pilot: Tools > Configure >  Processing Preferences > Automatic Normalization).

 

 

By default, Automation Engine uses the ticket named “OnDemand”, a ticket of the task
Normalize PostScript/PDF/Illustrator 8.0 File.
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Attention:  From this ticket, only the settings in its tab “Color Management” are taken
into account. All other settings of the auto-normalization are forced to fixed default
settings. For example, automatic normalization will always embed all images.
 

 

4.1.6.  PDF Normalization and Step and Repeat

Step and repeat tasks support both regular PDF and Normalized PDF as input files, or even a
mix of both.

The format of the task output file depends on your choice in the ticket.

Output Formats
Depending on your choice in the step & repeat ticket's setting Output Format, the format of
the output file can be:

• a PDFPLA
• a self-contained Normalized PDF
• a regular PDF

 

48



4Automation Engine

 

PDFPLA
A PDFPLA is a Normalized PDF with external references to the one-ups, which also have to be
Normalized PDFs.

A PDFPLA file can be edited and modified in Esko Plato. It can be RIP'ed directly by Esko
Imaging Engine and FlexRip. To send it to a non-Esko system, first export the PDFPLA to a (self-
contained) PDF using the Export PDF task.

Note:  PDFPLA output can only be generated when all input files are Normalized PDFs, else the
task will fail.

PDFPLA is the recommended output format when the primary purpose of the step and
repeat file is to send it to Imaging Engine or FlexRip.

Normalized PDF (embed all)
In this case, the task output file is a self-contained Normalized PDF. The one-ups are
embedded in the PDF. The PDF technique 'PDF forms' is used so that the file size remains
compact.

This file can not be modified in Esko Plato. It can be RIP'ed directly by an Imaging Engine or
FlexRip. It can also be sent to a non-Esko system.
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Normalized PDF inputs will be embedded in the output. PDF inputs will first be automatically
normalized and then embedded in the output.

This format is recommended when further processing is needed on the output, for
example by the "Optimize PDF Separations" task before sending it to Imaging Engine or
FlexRip.

PDF
When you choose this option, the output of the step and repeat task is a PDF. The one-ups
are embedded in the PDF. The PDF technique 'PDF forms' is used so that the file size remains
compact.

This file can not be modified in Esko Plato. Imaging Engine or FlexRip can not RIP this file
directly ; they will first automatically normalize this step and repeat PDF file. This file can be
sent to a non-Esko system.

Normalized PDF input files will be embedded in the output. PDF input files will be embedded in
the PDF 'as is'.

This format is recommended when the primary purpose of the step and repeat file is to
send it to a third-party, a non-Esko RIP.

4.1.7.  Normalized PDF XMP Metadata (the File's Info Dialog)

XMP stands for ‘eXtensible Metadata Platform’, a standard defined by Adobe. XMP is a
technology that allows embedding data about a file, known as metadata, into the file itself, in
the format of XML.

Adobe uses XMP in its own applications like the Creative Cloud applications (Acrobat,
Illustrator, InDesign, Photoshop,…) and has defined a number of XML schema. The XMP
framework was designed to be extensible so that other vendors like Esko can define additional
schema and add their XMP metadata to the file as well.

When Esko applications "normalize" data, they also add XMP to the resulting PDF file. Files
created by an Esko RIP also contain XMP.

An example: In the Pilot, the Info dialog shows you the XMP of the selected file (here a
normalized PDF):
 

 
The XMP of a Step & Repeat file also shows basic info on its grids:
 

50

https://en.wikipedia.org/wiki/Extensible_Metadata_Platform


4Automation Engine

 

Note:  There are also Esko tools that generate regular native PDF files but still include the Esko
XMP section:

• PDF files generated by the DeskPack Data Exchange plugin
• PDF files generated by the Dynamic VDP tasks

Some advantages of XMP:

• By only reading the XMP, you can learn a lot about the file without really opening the file.
• Quality control tools can read the metadata and compare specifications against actual

values.
• Asset management applications can read the metadata and use this information to

catalogue digital files for fast search and retrieval.

Attention:  There is no mechanism to detect modifications done in the PDF by non-
Esko applications! When an external application edits the PDF (for example remove
an ink), the file's Info dialog will still use the metadata from the XMP: i.e. the Esko XMP
metadata is not invalidated.

Attention:  "PDF proxy" files are PDF files generated from an Esko Normalized PDF, for
example for proofing or for remote exposure. The XMP data embedded in a PDF proxy
is still the metadata of the Esko Normalized file from which that PDF proxy was derived.

Find the XMP specification in the separate document "XMP Metadata in Graphics Documents".
Find this PDF next to the Automation Engine documentation, as part of the "Related
Documentation". You will there also find the documents on XMP in RIP output ("XMP
metadata in Digital Film Sets").

4.2.  PDF+ in Automation Engine

4.2.1.  PDF+, Successor of Normalized PDF

What is PDF+ ?
• PDF+ is the next generation internal graphics format in Esko applications.
• PDF+ is native PDF.
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• The '+' in the name PDF+ means 'additional information'. It does not refer to a conversion.
• An important item in this additional information are the 'Processing Steps and

content' (ISO 19593).

Note:  ISO 19593 defines a new mechanism to store objects and metadata corresponding
to finishing production steps in a PDF file in a standardized way. Based on this ISO standard,
the use of Processing Steps was introduced in ArtPro+ as Processing Step Layers.

Giving layers the attribute of a type of processing step (for example the type 'embossing')
enables to no longer use the attributes 'technical' and 'varnish' that you could set for
‘Inks’. Those extra ink-type attributes are Esko proprietary attributes restricted to use in
normalized PDF. PDF+ enables to skip using those and instead use this ISO conform way to
use layers for this purpose.

• PDF+ is based on ISO 32000-1:2008, corresponding to the Adobe PDF 1.7 specification. Find
an ISO approved version of the specification on here.

• Currently, PDF+ is the format used in and written by Esko ArtPro+ and several AE tasks.

Note:  This KB article also explains PDF+ from a more generic standpoint.

Why is PDF+ replacing Normalized PDF?

These are the 2 main reasons why PDF+ replaces Normalized PDF:

• The PDF format itself became more print-aware.
• Interoperability requirements became broader.

Some more specific advantages to have Esko workflow use PDF+ :

• Any flavor of PDF is supported throughout the system (editor, workflow system, RIP).
• Editors and workflow server make no unnecessary changes to the PDF files.

• They preserve 3rd party metadata.
• They don't change the structure of the PDF file.
• They only make the changes that the user requests.

Limitations of Normalized PDF

Normalized PDF has advantages, but also these limitations:

• Technical:

• A Normalized PDF is 'fixed' to the capabilities of its 'BRIX' kernel. For example: in a
multipage PDF, mixed page sizes were never supported.

• A Normalized PDF always has its focus on print output (converting all RGB, ...). Today's
needs are broader.

• In the meantime several industry standards have emerged that serve the concept of
normalization (PDF/X, ...). And some of the semantics in Esko's normalized PDF became
outdated by ISO specifications (ink order, processing steps, ...).

• Interoperability

• The normalization process removes all 3rd party metadata.
• Normalized PDF files were not designed to be modified by 3rd party tools. This means

that the metadata can easily get out of sync.
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Table: Small Overview of Esko's Graphical Formats and their Technology

Technology BRIX ArtPro Enfocus PDF
library

NDL (*)

File Format Normalized PDF
PDFPLA PDFSTA

ArtPro PDF PDF+

Native
Application

PackEdge, Plato,
i-Cut Layout,
various AE tasks.
FlexRip kernel
(read only)

ArtPro PitStop tasks ArtPro+

Note:  (*) 'NDL' stands for 'New Document Layer', an Esko R&D project name.

Find a much more detailed list of technologies in Which AE task Uses which Technology? on page
64.

FAQs
• Q: In a native PDF workflow with PDF+ files, is there still a concept to "normalize"

these PDFs?

• The concept to 'check and control' PDFs that enter your production flow is indeed still
possible. In a native PDF workflow, we recommend Enfocus Pitstop to do this. A typical
example would be to use preflight tools to avoid RGB data in the production PDF.

• The main difference with actual normalization to a different 'normalized PDF', is that
the Enfocus tools give you full control over when and how this 'check' is done. Plus, your
workflow is executed on the PDF that came in, not on a normalized variant PDF file.
Automation Engine offers this technology through the Preflight with PitStop Task.

• Another way to control PDFs that enter the workflow is to use the task Apply PDF Action
List. This task allows to automate a linear series of functions that you would otherwise
execute within ArtPro+.

• Q: Can ArtPro+ work with Normalized PDFs?

• Sure. When you open and edit a normalized PDF ArtPro+, it will by default save it again
as a normalized PDF.

• But you can as well choose to 'Convert To PDF+' and then save it as a PDF+ file.
• Learn more in the user guide of ArtPro+ (Working with Files > PDF, PDF+ and Normalized

PDF).

• Q: When you Step & Repeat PDF+ files, what is the output format?

• When you step & repeat PDF+ files in ArtPro+, the result is also saved as a PDF+ file.
• When you step & repeat PDF+ files via tasks in Automation Engine, it depends if the task

supports PDF+ files.

• When the task supports PDF+, the output will be a PDF+ file. This is for example the
case for 'Dynamic' variants of the S&R tasks.

• When the task does not support PDF+ (i.e. it uses the BRIX technology), then the PDF
+ will first be normalized and the output will be a Normalized PDF or a PDFPLA file
(depending on the output choice in the ticket).

Note:  PDFPLA files can only be made when it's one-ups are normalized PDFs.
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Note:  Learn more about which AE tasks support the PDF+ technology in Which AE task
Uses which Technology? on page 64.

• Q: In a PDF+ file, Images and Placed Art can be 'Linked & Embedded'. Which data is
used when?

• PDF+ is always self-contained ; images and placed art are always embedded. The actual
image or art information is saved in the file, at its full resolution. The PDF+ file also keeps
a time-stamp of when this data was embedded.

• Optionally, they can also be linked. This means that a reference to the external file is
saved in the PDF+ file. These links are not just to images or placed art but can also be
to structural design files.

Note:  In a normalized PDF file, you have to choose between embedding the data or
only adding a link. You can not do both.

Learn more on how to create and manage such links in the user guide of ArtPro+.

• AE tasks always use the embedded data. Also a Step & Repeat task by default uses the
embedded data.

• An operator of AP+ or an AE task can choose to update that link. The task 'Apply PDF
Action List' can 'Update linked images', 'Update linked placed art' and 'Update structural
design file'.

Note:  Normalized PDF could contain an external reference in which case only a low
res proxy was embedded in the PDF. As a result, the external referenced files had to be
found and used to make final output.

4.2.2.  Metadata in PDF+ (vs. XMP in Normalized PDF)

Why and How To Extract or read a PDF file's Metadata?

There are 2 main reasons why Esko workflows extract metadata out of their production PDFs:

• To send this information to external systems. Those systems interpret the XML and
show these PDF attributes to their users.

• Normalized PDF file: Use the task Create PAF / JPG / XML (LinkEdge). It was designed to
export the XMP metadata that is on board a normalized PDF to an XML file.

• PDF(+) file: Since v20, use the task Export PDF Info to export the metadata of a PDF+ to an
XML file (and it can also create a preview image).

Note:  This type of XML is aware of 'processing steps' , a typical attribute of PDF+ files.

Note:  The task Create Report (ReportMaker) is an exception: Although it is based on BRIX
technology used for normalized PDF, it can still read the metadata of a PDF+ file. That
is why it can extract info from PDF+ files (inks, barcodes, external references, etc.) and
it can also generate 3D previews (when the PDF+ file contains a CAD reference with 3D
info).
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• To use this information to increase workflow automation. Many users create
SmartNames that extract metadata and then use it to increase the automation in a
workflow.

• SmartNames that extract XMP from normalized PDF files: SmartNames that extracted a
part of that XMP.

• There are no SmartNames that can extract metadata from PDF+ files. You can use Xpath
SmartNames on the exported XML file.

In Normalized PDF, Metadata is proprietary, and in XMP format

The XMP metadata in Normalized PDF is Esko specific. Additional and Esko specific information is
stored in the open source XMP (extension schema). It's purpose is to make the PDF smarter for
its packaging workflow.

The XMP data is added during Esko normalization and updated during Esko editing. It is visible
in the Pilot, in the file's Info panel.

With PDF+, do we still Need to Add Metadata?

PDF+ uses standard PDF as much as possible. All the information that can be stored in the
PDF structure (within the boundaries of the PDF imaging model), will be stored in that way. For
example 'Ink Order', 'Processing steps', etc.

Note:  An illustration of this is that when, in ArtPro+, you convert a Normalized PDF to a PDF+,
all its Esko proprietary XMP metadata is removed.

Not even PDF 2.0 will support all the concepts and terminology in packaging production. So
until that will be the case, Esko will still add what is missing. As before, the reason is to enrich
the file's information and enhance the workflow automation.

Only the information for which there is no support (yet) in standard PDF is defined in an Esko
proprietary metadata scheme on board that PDF. This complimentary information is why this
PDF is named PDF+ .

Important:  The metadata that Esko adds to a PDF+ is not XMP or XML, it is part of the PDF
data stream itself.

Note:  The PDF+ specification adds metadata to any ISO 32000-1 compatible PDF file. Some of
this metadata is purely additional ; there is no corresponding graphical representation in the
PDF file, for example the position of the cross-hair. Other metadata describes how the actual
graphical representation was generated, for example barcodes.

Overview of Metadata in PDF+ files

• Ink order
• Non-printing data (Cut, Die, …) and special processing steps (varnish, …)
• Ink Types
• Document Profile, as output intent
• Screening
• Crosshair position
• Group and Barcode metadata
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• Marks
• Images
• Placed Art (PDF)
• Structural Design
• Preflight

The technical specification of this metadata, is described in the pages about the task that
creates it: Export PDF Info on page 278.

Note:  Learn more in the ArtPro+ user guide (> Working with Files > PDF, PDF+ and Normalized
PDF).

In PDF+, what happens to XMP metadata from 3rd parties?

With PDF+ (and also Normalized PDF), any 3rd party metadata is removed. However, any 3rd
party (non-Esko) XMP (metadata) is kept during the workflow, untouched.

4.2.3.  PDF+ File's Info Dialog

The File Info dialog shows the PDF's metadata

When a PDF+ file is selected, the file Info dialog reads the metadata that Esko added to the
PDF. Notice that, as this metadata is not XMP, that there is also no logo of the 'XMP technology'
in the below left corner of this dialog.

Note:  Notice these main differences with the info dialog of a normalized PDF (which is based
on XMP):

• The data type 'Inks' is here split over Separations and Screen sets.

• The data type 'External References' is here listed as Placed Art / Images.

PDF+ Info Dialog Examples

• Artwork
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Note:  The value of the field 'Trapped' is based on a check if this flag is present in the PDF
description ; it does not check the presence of a trapping layer or trapping objects.

• Barcodes

 

 
When the PDF contains barcodes that were created with Esko tools, their parameters will
appear here.

• Fonts

Fonts are either embedded, embedded subset or not embedded.

• General
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SmartID: Click Calculate to have the system calculate the unique identification number for
that version of this file. This number is calculated from the combination of an identifier of
the document itself and of the identifiers of all its external references..

Note:  You can for example use its SmartName to place this 'SmartID' on the proof (file).
When the customer approves what he sees on the proof, he then actually approves that ID.
That ID is then also a number that you can make appear on the plate or print, so proving
that the file that considered 'good for print' has not changed in the meantime.

• Layers

 

 

In PDF+, a layer can be of the type Processing Step.

Learn about all types in Processing Steps - Groups and Types on page 61.

• Pages

Their number and their inks (separations).

• Placed Art / Images

Placed Art or Images are always embedded in the PDF. If there is also a link to their original
data present in this PDF, they appear in this list:
 

58



4Automation Engine

 

Click Check to check this link, i.e the availability of the selected file(s). The result can show
that the embedded data of that link are Up-to-date, Not Up-to-date or No (not available).
 

 

Click Info... to open the info dialog of the selected placed art or image(s).

• Screen Sets
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This example has 3 different sets of screens: one at ruling 120 LPI, one at ruling 250 LPI
using the dot CS9 and one at 120 LPI using the dot CS4.

• Separations

 

 

• About 'Colorants': Separations that are only used in Processing Step Layers are
considered 'Colorants': they can be used to color objects in the Processing Step Layers,
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but are not considered printing inks, as they should not appear on plates or on the final
printed result.

Colorants for Processing Step Layers are represented using a round color patch.

Note:  In normalized PDF files, these were often indicated as 'technical Inks'

• Structural Designs:

This data type only appears when any such files were placed in the PDF. These can be ARD,,
one-up CF2, ZAE and DAE.

Note:  Placing ZAE or DAE files requires v20 of ArtPro+ .

When a cad file was placed, there is always a link.

Selecting them also allows to check their availability.

The Info Summary dialog

When you select more than one file, and then right-click (or use the File menu), you can choose
between Info and Summary.

• When you selected 10 or less files, 'Info’ will open the various 'Info' dialogs.
• When you selected between 11 and 20 files, you will see a list of files, and an 'Info' panel of

the file selected in that list.
• When you selected more than 20 files, you always get a 'Summary' dialog:

 

 

Processing Steps - Groups and Types

Groups

In the ISO norm, types of processing steps are grouped as follows:
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• Structural Data: A collection of contours that describe how the printed product will be
finished to produce a 3D end product from a flat substrate. These are as lines defining
cutting, creasing, folding etc. The types of this group are listed below.

• Positions: Objects that indicate intended, allowed or forbidden positions for certain types
of elements. For example the positions on a flap of a carton where content is allowed. The
types of this group are listed below.

• Braille: Braille characters that are applied after printing, typically by a die cutter or inkjet
device.

• Legend: Job related data added outside the boundaries of the actual printed products.

• Dimensions: Indications of the physical sizes.

• White: White ink to be printed on a transparent or metallic substrate.

• Varnish: Indicating the application of varnish after printing.

Types of the group 'Structural Data'

Group Type Description

Structural
Data

Cutting Processing step objects indicating where the printed
artwork will be cut from the printed sheet e.g. with a
guillotine cutter or die cutting device.

Structural
Data

PartialCutting Processing step objects indicating where the substrate
will be cut partially i.e. not entirely through the material.

Structural
Data

ReversePartialCutting Processing step objects indicating where the substrate
will be cut partially i.e. not entirely through the material
on the back side of the substrate.

Structural
Data

Creasing Processing step objects indicating where the substrate
will be creased to guide subsequent folding.

Structural
Data

ReverseCreasing Processing step objects indicating where the substrate
will be creased on the back side of the substrate.

Structural
Data

CuttingCreasing Processing step objects indicating where the substrate
will undergo alternating cutting and creasing.

Structural
Data

ReverseCuttingCreasing Processing step objects indicating where the substrate
will undergo alternating cutting and creasing on the
back side of the substrate.

Structural
Data

PartialCuttingCreasing Processing step objects indicating where the substrate
will undergo alternating partial cutting and creasing.

Structural
Data

ReversePartial-
CuttingCreasing

Processing step objects indicating where the substrate
will undergo alternating partial cutting and creasing on
the back side of the substrate.

Structural
Data

Drilling Processing step objects indicating locations where the
substrate will be drilled and the intended size of the
resulting hole.

Structural
Data

Gluing Processing step objects enclosing an area where glue
will be applied.

Structural
Data

FoilStamping Processing step objects enclosing an area where foil will
be applied through hot foil stamping.
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Group Type Description

Structural
Data

ColdFoilStamping Processing step objects enclosing an area where foil will
be applied through cold foil stamping (i.e. using glue).

Structural
Data

Embossing Processing step objects enclosing an area where
embossing will be applied.

Structural
Data

Debossing Processing step objects enclosing an area where
debossing will be applied.

Structural
Data

Perforating Processing step objects indicating where the substrate
will be perforated.

Structural
Data

Bleed Processing step objects indicating the intended bleed for
print.

Structural
Data

VarnishFree Processing step objects enclosing an area where it is not
allowed to have varnish.

Structural
Data

InkFree Processing step objects enclosing an area where it is not
allowed to have printing ink.

Structural
Data

InkVarnishFree Processing step objects enclosing an area where it is not
allowed to have printing ink and where it is not allowed
to have varnish.

Structural
Data

Folding Processing step objects indicating where the substrate
will be folded without prior creasing.

Structural
Data

Punching Processing steps objects indicating the locations at
which the substrate will be punched and the size and
shape of the resulting holes.

Structural
Data

Stapling Processing steps objects indicating the locations at
which the substrate will be stapled or stitched, and the
size of the staples or stitches to be used.

Types of the group 'Positions'

Group Type Description

Positions Hologram Processing step objects that indicate the intended position of
holograms.

Positions Barcode Processing step objects that indicate the intended position of
barcodes.

Positions ContentArea Processing step objects that indicate areas where it is allowed to
place text and other graphical elements.

Positions CodingMarking Processing step objects specific to packaging that indicate areas
where additional information not contained in the PDF will be
printed on the packaging at a post-press stage, such as on filling
lines where final products are being packed. Some examples of
information that might be marked as CodingMarking include but
are not limited to best before dates, lot numbers, production dates,
and tracking codes.
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Group Type Description

Positions Imprinting Processing step objects that indicate areas where additional
information (e.g. variable data) will be printed on pre-printed shells
which contain the bulk of the graphical content, as a secondary
print stage prior to finishing.

4.2.4.  Which AE task Uses which Technology?

In the above page PDF+, Successor or Normalized PDF, we already introduced the graphic
software kernels that are used in Automation Engine.

We here add more detail.

Graphic Software Kernels used in Automation Engine

• BRIX

For example used by the tasks 'Trap with PowerTrapper', 'Add SmartMarks', 'Export Nested
Layouts', 'Manage Color'.

• BRIX *

Some BRIX tasks have a special behavior. We marked them in the table below with an '*'.

These BRIX tasks can handle native PDF in and out without normalizing it. These are:

• The i-cut tasks. This for example allows i-cut workflow users to keep RGB data till
output.

• The Step & Repeat tasks that are not of the type 'Dynamic' and that offer the output
format 'PDF' in their ticket.

• ArtPro

The proprietary ArtPro format. For example used by the task 'Apply ArtPro Action List' (AP
file in, AP file out).

• Enfocus

The task 'Preflight with PitStop' uses the PitStop Server software on board Automation
Engine.

Normalized PDF files can only be preflighted when, in the preflight profile, the option "Allow
fixes" is switched off. PDF Action Lists can never be executed on Normalized PDF files.

• Enfocus **

Another Enfocus software library is used to execute prepress tasks on PDF. These tasks
do not use the PitStop technology. We marked them in the table below with an '**'.

For example the tasks 'Optimize PDF Document', 'Optimize PDF Pages', 'Extract Inks'.

These tasks can be launched on Normalized PDF as well.

• NDL

This is the native PDF kernel that is used in ArtPro+.

It is used by the 'Dynamic' tasks.

• NDL ***
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An ArtPro+ operator can, apart from using the editing tools, also execute Action Lists.
To enable executing such action lists also on AE, the NDL kernel is made available on
Automation Engine, wrapped in what is called the "PDF Action List Processor" (a.k.a. 'PAL
Processor').

Task types that use this PAL Processor mention this in their ticket ; they are 'Powered by
PDF Action List Processor'.

We marked them in the table below with an '***'.

For example: The tasks 'Trap', 'Optimize PDF', 'Apply PDF Action List'.

In next versions of AE, many more tasks will use this technology.

Note:  These tasks use the PDF Action List processor that is installed on your Automation
Engine. When you use a very recent version of ArtPro+, maybe a test version or one
that was released after the latest release of AE, you then might need to update the PDF
Action List processor that came by default with your AE. You will find this processor
as a separate install on https://mysoftware.esko.com/. Download and update this PAL
processor when required.

• Other / none. These tasks do not use any of these graphic kernels. Some even use 3rd
party technology. For example the tasks 'Copy or Move File', 'Create XML', 'ZIP', the various
Inspection tasks powered by Global Vision, etc.

Which Graphics Kernel does this Task use?

* = BRIX tasks that can handle native PDF (without normalizing on the fly).

** = Enfocus PDF library for prepress tasks (not using PitStop).

*** = Powered by PDF Action List Processor. These use the PAL Processor installed on the AE
server.

Task name BRIX ArtPro Enfocus NDL Other

Add Ink Eaters V

Add SmartMarks V

Apply ArtPro Action List V

Apply PDF Action List V ***

Check Print Rules (PRC) V

Check Technical Inks V

Contourize & Clean V

Convert CMYK Colors V

Convert Imposition to Normalized PDF V

Copy or Move File V

Create Imposition Sheet Report V

Create Master DCS File V

Create PAF / JPG / XML (LinkEdge) V

Create Preview V
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Task name BRIX ArtPro Enfocus NDL Other

Create or Modify WebCenter Project V

Create XML V

Create Wrapper File V

Delete File V

Enrich Black V

Export ArtPro to Normalized PDF File V

Export Imposition to JDF Layout V

Export Imposition to PDF File V

Export Imposition to PostScript File V

Export Step&Repeat to JDF Layout V

Export to ArtPro File V

Export to EPS/DCS File V

Export to GRS File V

Export to Normalized File (DeskPack Only) V

Export to Normalized PDF File V

Export to PDF File V

Export to PostScript File V

Extract Inks V **

Import Image V

Import JDF Layout V

Integrate via External Hot Folder V

Normalize PDF File (a.k.a. FastNormalize) V **

Normalize PostScript / PDF / Illustrator 8.0 File V

Optimize and Clean (PSFix) V

Outline Fonts V

Preflight via External Application (when
PitStop)

V

Prepare Station V

Publish on WebCenter V

Run Script V

Select File V

Send E-mail V

Send to Nexus V

Send to Odystar V
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Task name BRIX ArtPro Enfocus NDL Other

Split Pages V **

Trap with Powertrapper V

Trap V ***

Unzip V

Upload via FTP V

Wait V

Wait for Action (Checkpoint) V

Wait for Files V

Wait for Files (via JDF) V

Zip V

Create Job V

Interact with Database V

Add Parameters for Nesting V *

Export Nested Layouts V *

Create Tiles V *

Prepare Graphics for Nesting V *

Submit to Gang Run V

Import Sheet Sizes from XML V

Add to Products V

Archive Job V

Check Job Parameters

Check Product Parameters V

Relocate Job V

Restore Job V

Wait for Product Status V

Add to Pages View V

Create Imposition V

Create Imposition from JDF Layout V

Create Imposition from Runlist V

Create Runlist V

Export Imposition to JDF Layout V

Export Imposition to JDF Post-Press V

Export Imposition to PDF V

Export to JDF Layout V
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Task name BRIX ArtPro Enfocus NDL Other

Import JDF Step & Repeat V

Proof Imposition (FlexProof)

Publish Imposition on WebCenter Chain V

Step & Repeat CAD based V *

Step & Repeat Tabular based V *

Step & Repeat Template based V *

Create Sheet Layout V *

Step & Repeat Tabular (Dynamic) V

Step & Repeat Template Based (Dynamic) V

Step & Repeat CAD based (Dynamic) V

Add Marks to Imposition V

Create Imposition from Runlist V

Apply Creep V

Create PDF from Runlist V

Adjust PDF Screening V **

Compare PDF V **

Optimize PDF Document V **

Optimize PDF Separations V **

Optimize PDF V ***

Preflight with PitStop V

Process PDF Spreads V **

Resize PDF for Output V **

Resolve OPI V **

Version PDF V **

Create Report (ReportMaker) V

Export to 3D V

Export to VRML File V

FastVariants V

Prepare for Viewer V

Expand Variable Data to PPML File V

Expand Dynamic VDP Data V

Add Dynamic Marks V

Image to screened/unscreened separations V

PackProof V
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Task name BRIX ArtPro Enfocus NDL Other

Add Margins to LEN File V

Apply PantoneLIVE Condition V **

Assign PDF Pages to RunList V

Calculate Ink Key Settings (CIP3) V

Change Imposition Layout V

Check Dynamic VDP Database V

Convert Colors for Digital Printing V

Convert Colors with Equinox V

Convert JSON to XML V

Convert Selection V

Convert XML to JSON V

Create ArtiosCAD Layouts V

Create ArtiosCAD Report from XML V

Create Design (DesignWizard) V

Create IMP File V

Job Creation From Remote Location V

Create Job Report V

Create Merged Plate V

Create PDF File from JDF RunList V **

Create RunList from PDF V

Create Packshot from XML V

Create Sheet Layout V

Create or Modify WebCenter Project V

Crop LEN File V

Delete File V

Download Files from Esko Cloud Job Folder V

Download Products from Esko Cloud V

Download WebCenter Document V

Export ArtiosCAD Design Info V

Export IMP File to GRI File V

Export IMP File to JDF Layout V

Export IMP File to JDF Post-Press V

Export IMP File to PDF File V

Export IMP File to PostScript File V
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Task name BRIX ArtPro Enfocus NDL Other

Export Kongsberg Cutting History V

Fill Printing Lanes V

Generic Brix V

Image to Content Proof (RGB) V

Image to Unscreened Proof V

Import Die V

Import JDF Stripping V

Import Substrate Sizes from XML V

Inspect Artwork V

Inspect Barcodes V

Inspect Braille V

Inspect Spelling V

Inspect Text V

Integrate with WebCenter V

Interact using JDF V

Interact using JMF V

Interact with SAP V

Interact with Web Service V

Join XML Files V

Link Product to Job V

Load Structural File V

Manage Color V

Manage Milestone V

Manage Product Status V

Map Data V

Mark as Proof V

Merge PDF Files V **

Normalize TIFF/IT File V

Preflight Color for Digital Printing V

Prepare for Inspection V **

Proof for Content Approval V

Remove Job V

Remove Product V

Resize Shape V
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Task name BRIX ArtPro Enfocus NDL Other

Run ArtiosCAD Standard V

Send to AE V

Share Job V

Smart Task V

Split XML File V

Submit XML to Gang Run V

Submit to CDI V

Submit to Esko DFE V

Submit to HP SmartStream Production Pro
Print Server

V

Submit to Kongsberg Table V

Submit to Plate Merger V

Synchronize ArtiosCAD Boards V

Synchronize ArtiosCAD Companies V

Unshare Job V

Upload Files to Esko Cloud Job Folder V

Upload Product to Esko Cloud V

Upload to Cloud Storage V

Upload to SFTP V

Verify Certification V

* = BRIX tasks that can handle regular PDF (without normalizing on the fly)

** = Enfocus PDF library for prepress tasks (not using PitStop)

*** = Powered by PDF Action List Processor. These use the PAL Processor installed on the AE
server.

4.2.5.  Workflow and Current Limitations

PDF+ Workflow

A native PDF workflow in Automation Engine (or Imaging Engine) is one where the one-up PDF
stays a PDF+ during all typical prepress steps.

Such a workflow requires that all its prepress tasks need to use the PDF+ technology (the 'NDL
kernel') so that the production PDF file stays a PDF+ file.

Note:  Of course many Automation Engine tasks do not use any graphics kernel (see the list
above).
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However, Esko can not offer all migrated technology in one go, in one software update. Until
then, you will have to rely on mixed workflows where NDL tasks are used in combination
with BRIX tasks and/or Enfocus PDF tasks.

This means that, in the current version of Automation Engine, your workflow might still need
tasks that normalize the PDF. Some of those will do that all the time and explicitly (creating also
a normalized PDF), some will do that hidden, on-demand (a first stage of the task that starts by
creating a hidden and temporary normalized PDF).

In next versions of Automation Engine, the need to create normalized PDF files in a
workflow will eventually become an exception. This will be done by both adapting BRIX
based tasks and by introducing new NDL based tasks.

Current Limitations

When opening or using a PDF+ file as input, this version of Automation Engine and these tools
will normalize the PDF file:

• Esko tools / applications that will normalize in this (coinciding) version:

• PackEdge, ArtPro (classic)
• Plato, i-cut Layout

Note:  i-cut Layout ignores the metadata in PDF+ files, i.e.: the extra metadata is not
used.

• Esko Viewer (in AE Pilot or Browser client, in WebCenter)

• FlexRip, FlexProof
• Imaging Engine
• WebCenter (tasks, workflow)
• Share & Approve

• AE Tasks that will still normalize:

See them listed above in Which AE task Uses which Technology? on page 64.
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5.  Getting Started

5.1.  Installing Server and Clients

Before you can start a Pilot or Shuttle, this needs to be done first:

1. Install the Automation Engine server software, on a central powerful computer.
2. Install the Automation Engine client application Pilot and/or Shuttle. You typically install

these on each computer from where users will want access to Automation Engine. You can
install as many as you want, but your licenses decide how many users can be logged in to
the server at the same time.

Note:  Some setups, like the QuickStart deployment for roll label production, mainly use a
browser as a client.

Both steps are documented in detail in the chapter Installation Guide on page 1761.

Important:  Before installing the server software, make sure your IT specialists have read the
chapter Pre-Install IT Requirements on page 1739.

5.2.  Changing the Language used in the Pilot or Shuttle

The client applications Pilot and Shuttle are available in several languages (aka "Localization").

This online KB article describes how you can specify that language.

5.3.  Signing In to the Pilot or Shuttle

Note:  Learn about managing users on the page about the Users view. Learn more technical
details in the chapter Pre-Install IT Requirements on page 1739, on the pages about Users and
Groups.

Note:  The Pilot and Shuttle are available in several languages. Learn more in Changing the
Language used in the Pilot or Shuttle on page 73.

On the computer where you installed a Pilot or Shuttle:

1. Double-click the application shortcut.

• On MacOS: in the folder Applications or in your Dock.

• On Windows: on the desktop or in the task bar. Alternatively, find it under Start > All
Programs > Esko.
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2. The Sign In dialog looks different, depending on whether you already used it on this
computer or whether it was already used to sign in to a different Automation Engine server.

• When this is the first time, you will be asked to first enter the name or the IP address of
your Automation Engine server. Do so and press Continue.
 

 
From then on, the drop-down list will list other servers that were signed in to from this
client.

• When someone already signed in from this computer, the dialog already assumes the
same Automation Engine server and also fills in the name of that previous user.

You then only need to type the password and click Sign In (or you use another user
name and password).
 

 

• Click Forgot Password? to get an e-mail with a link to reset your password. The e-mail
is sent to the e-mail address defined for that user. Learn more in Users View on page
140.

Important:  Make sure the e-mail configuration is set up in your Configure tool. This
dialog does not show any error messages when the sending of this e-mail fails.

• Click Change Server if you want to sign in to another Automation Engine server. You
then get the dialog as shown here above.

Note:  Every time you select another server, the dialog also checks whether this client
version matches the version of that server.

3. Possible messages or problems when signing in:

• When the attempt to sign in does not succeed immediately, you will see an extra dialog
with a Cancel button. This button is useful when you noticed that you for example
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mistyped the server name, or when you just now remember that this client computer or
the server is offline.
 

 
So when you know there is no point in waiting, click Cancel to stop the authentication
attempt immediately.

• When a sign-in fails, you will be told if the problem is a wrong combo of the user name
and password you entered. In other cases, the message will, for security reasons, not
add too many details on the cause. It could be that you just mistyped the server name or
any other type of problem (network, server software not running, etc.)
 

 
When you are sure that your user name and password were correct, click Connection
Doctor... to start a first analysis of the problem. Learn more in the chapter
Troubleshooting on page 1803.

• When the version of the client software (the build nr.) is different from the one on
the Automation Engine server (typically the case right after the server software was
updated), this dialog will pop up:
 

 
Click Install Update to download the update. At the end of the download, the message
"Ready to install" appears. Then click Install and Relaunch to install the update on
this client. When finished, the Sign In dialog will be shown again.

On Mac, you need to enter the credentials of an administrator user to update the Pilot
application.

• When the system can't even find the sign-in options to offer to the client, then the
version of the server software is probably an older major version number. For example:
The client software is v20 but the server is still on v18.1.
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5.4.  The Pilot's Main Window

Note:  The Pilot's user interface and its View modes are introduced in some of the "Learning
Modules" that you can follow on Automation Engine's documentation web page.

 

 

1. The Pilot offers three View modes:

•
 Containers: This mode allows to access all Containers, which contain the network

data that Automation Engine is allowed to work with. Learn more in  Containers on page
133.
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•
 Job Overview: This mode lists all Jobs existing in the Automation Engine Jobs

database. Learn more in the dedicated chapter on Jobs on page 495.

•  Last used Job: This mode shows the last Job you opened, and the data in its Job
Folder.
 

 
2. The top tool bar:

•
 Create Job allows you to create a Job in the Jobs database. Learn more in the

chapter Jobs on page 495.

•
 New Task allows to launch a new task on the current selection.

•
 New Workflow opens the workflow editor to create a new Workflow ticket. Learn

more in the chapter on Workflows on page 687.

•
 shows information about the selected Job or file.

• A search field that also allows to create filters.

3. The Views pane allows to focus on specific functionality of Automation Engine. Certain
Views are only shown in specific view modes. Learn more in Pilot Views and Tools  on page
107.

4. The bottom bar offers this information:

• Left side: info on your current selection (could be files, tasks, jobs, etc.)
• Right side:

• Name of the Location of this server setup. A Location name is used (and here visible)
when several Automation Engines collaborate via Esko Cloud.

• Name of the Server computer.

• Name of the current User that logged on to this Pilot.

• Amount of To Do items for this user. Click  to open the 'To Do List' tool and see all To
Dos.
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• Amount of Alerts. Click  to open the list of alerts. Learn more in Alerts on page
1803.

The contents of the central panes depends on the selected view Mode and View.

Using Tabs to enable Multiple Views

Tabs allow you to have multiple Views open in your Pilot.
 

 

In any view, use any of these methods to create a new tab:

• Choose File > New Tab or use the shortcut Ctrl-T (Windows) or CMD-T (Mac).
• Once a tab bar is visible, you can also create a new tab

• by clicking .
• by right-clicking on the tab bar and choosing New Tab.

You can close tabs by using similar tools.

Note:  To close all other tabs but the current one, choose File > Close Other Tabs.

Smart Views

You can use the filter tool to create filters for specific views. When you save such a filter, they
are listed in the Views pane, in the category "Smart Views". so you can easily re-select them
from there. Learn more in Smart Views on page 127.

5.5.  Concepts of Tasks, Tickets and Workflows

5.5.1.  Tasks

What is a Task?
A task is a background action executed on one or multiple files, folders or items in an
Automation Engine database. A task can be started by a user, by an external system or be
triggered automatically by Automation Engine itself.

There are many types of tasks:

• Conversion tasks such as Export to PDF, Export to PostScript...
• File Creation tasks such as Step & Repeat, Create 3D file...
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• File Editing tasks such as Optimize PDF, Split Pages, Trap...

• Verification tasks such as Preflight, Inspect Braille...

• Administration tasks such as Copy or Move, Upload via FTP, ZIP...

• RIP tasks.

• Device Output tasks, communicating with CDI imagers, Digital presses or Kongsberg tables.

Task Settings
A task are defined by many settings: these are

• the attributes of the task itself (for example its priority and the user who launched it),
• its parameters, usually saved as a task Ticket. These decide the specifics of what is executed

in background (for example a chosen resolution).

Task Progress
When a task is launched, you can monitor its progress and end status. Learn more in Checking
the Status of a Task on page 83.

5.5.2.  Workflows

A workflow ticket contains multiple steps. Launching a workflow results in multiple tasks. A
workflow step can be

• a single task ticket
• a workflow control

• a sub-workflow (included or referenced).

An example:
 

 

Just like single task tickets,

• you can launch workflow tickets from the Pilot, from the Shuttle or from within most Esko
editors

• workflow can also be launched automatically, often triggered by external signals (files
arriving, commands from external systems, etc.).

You can build and launch workflows in the Workflow Editor. Learn more in the dedicated
chapter on Workflows on page 687.
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Task Chains (old workflows)
Task Chains are old BackStage workflows. They are still supported in Automation Engine but
will need to be migrated.

A Task Chain is a linear succession of tasks, linked together in a Task Chain ticket.

 

 

You can build new Workflows from these old Task Chains, while keeping all your tickets
settings. Learn more in Migrating Old Task Chains on page 816, a page in the chapter
Workflows on page 687.

5.5.3.  Tickets

What is a Ticket?
A Ticket is a collection of parameters of a specific Task type. When a user (or system) selects
files and launches a Ticket, a Task is executed on the server.

Default and Custom Tickets
There is a default ticket for each task type. You can also create custom tickets. You cannot
overwrite or delete default tickets.

The Tickets View shows all available tickets (default and custom).

Workflow Tickets

A Workflow Ticket contains the steps and parameters of several tasks. Its is also referred to as
"a Workflow".

Global and Job Tickets
• Global Tickets (  ) can be used on any file inside a Container (network areas that you

allow Automation Engine to work with).

• Job Tickets (  ) can only be used on data inside the Job Folder of the Job you saved them
for. Learn about Jobs in the chapter Jobs on page 495.

80



5Automation Engine

Public Tickets
Public Tickets are tickets that all Pilot users can see and use. These are also the ones you can
launch from the Shuttle and directly from within Esko editors.

Note:  Depending on your User Access Rights, you may only see public tickets, and Public
Parameters inside these tickets.

Learn about making tickets public here.

General Ticket Functions
 

 

1. The top bar of the dialog shows an icon indicating the type of ticket (  = Global,  = Job
ticket), followed by the name of the ticket and the type of task.

2. Menu items

• File menu (standard functions).

• The View menu is only used when creating a Workflow ticket (to filter which type of
tickets you want to see). Learn more in The Workflow Editor Menus on page 689.

• The Advanced menu is where you can Manage Public Parameters. Learn more in Using
Public Parameters  on page 92.

3. An icon of the task type.
4. Click  to add Notifications that will be executed when the task is launched (or finished).

When a ticket includes notifications, the icon changes to . Learn more in Task
Notifications on page 92.

5. Fields to specify the name and place of the files that this ticket creates. Typically,
SmartNames are used. Learn more in SmartNames on page 591.

6. The Parameters for this ticket.
7. Click  to see the online help page for this task type.
8. "Show Steps" is only relevant when you still have old "Task Chains" (a technology used

before "Workflow Tickets". Learn more in Old Task Chains.
9. Click Save to save the ticket and all its parameters. When you opened a default ticket, you

will be asked to Save As another name. Click Cancel to close the ticket without saving.
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5.6.  First Steps in Launching Tasks

5.6.1.  Launching a Task on a File

There are several ways to launch a tasks: from the Pilot, from Shuttle (plug-in), via Access
Points or via JDF/JMF.

We here describe how to launch a task from the Pilot's Files view.

Note:  Before you can launch RIP or Proofing tasks, you need to configure the matching RIP.
Learn more here.

1. In the Pilot, choose the Containers mode and select the Files view in the Views pane.

Note:  If you don't have any custom Containers yet, simply drag a file from outside the Pilot
onto a folder in your ExampleJobContainer. Learn more in Uploading files using the Pilot 
and in Creating a Container on page 134.

2. Browse to your chosen file. Right-click it, and select either

• New Task if you want to open the ticket that you will select and check or change some of
its settings before launching the task.

• Launch with to immediately launch the task without opening the selected ticket.

Note:  If you don't have the access right 'Tickets: Show All Tickets and their Parameters
(Public and other)', you will only see 'Launch with'. In this case, you can only select Public
tickets, and only fill in Public Parameters in the ticket.

3. Select the ticket to use.

• If you have launched tasks previously, the most recent task tickets you used are listed.
One ticket is shown per task type. A small arrow indicates there were several tickets
launched of this task type.
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• If you didn't launch tickets yet, or if you need a different ticket, select 'Other'. Then select
the ticket you want to use and click OK.

Note:  This list only shows the tickets of task types that can be launched on the file type
that you selected. You can either choose a Default ticket or a custom ticket that was
created earlier.

4. • If you chose New Task, the selected ticket opens. Fill in the settings you want to use and

click  Launch
• If you chose Launch with and you have the access right 'Tickets: Show All Tickets and

their Parameters (Public and other)', the task is launched on the file as soon as you
select the ticket. You don't need to fill in any settings.

• If you chose Launch with and you don't have the access right 'Tickets: Show All Tickets
and their Parameters (Public and other)', the task is launched on the file

• as soon as you select the ticket if the ticket has no Public Parameters.

• If the ticket contains Public Parameters, it will first open for you to fill them in (you
will only see the public parameters). Click Launch when you are done.

Note:  For a description of all of the ticket's parameters for each task type, see the chapter
Tasks and Workflow Controls on page 218.

5.6.2.  Checking the Status of a Task

After launching a task on one or several file(s), you can check its processing status in the Pilot’s
Tasks pane (present in many Views).

 

 

You can see the Progress (in percentage) and the processing State. The state can be:

•  on hold

•  on hold until

•  running (for a Checkpoint task: waiting to be handled)

•  waiting (in the queue)

•  successfully done

•  part of workflow successfully done

•  done with warning

•  failed

•  cancelled

You can also double-click the task's entry in the Tasks pane to open your task ticket and check
its parameters.
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5.6.3.  Relaunching a Task

You can easily relaunch tasks, even when they are not finished yet.

• To relaunch one or multiple tasks without changing its settings:
a) Select the task(s) in Tasks view or the Tasks pane in another view.
b) Click CTRL-L (CMD-L) or go to Task > Relaunch.

• To first change its settings and then relaunch a task:
a) Select the task to relaunch.
b) Double click the task or go to Task > Open Task.
c) Change the task settings as necessary.
d) Click  Launch.

5.6.4.  Launching Workflows

How to create and launch workflows is described in the separate chapter Workflows on page
687.

5.6.5.  Creating Task Tickets

Creating a Custom Ticket from the Tickets View
To create a custom ticket:

1. Open the Default ticket of that task type.

Note:  To create a custom Workflow ticket, see the chapter Workflows on page 687.

2. Select the wanted ticket parameters.
3. Go to File > Save As... or use the keyboard shortcut.
4. In the Save As dialog:

 

 

84



5Automation Engine

a) Enter the name of your new ticket. You can not overwrite a default ticket.

Attention:  Ticket names are case-sensitive.

b) Add one or more Tags. This allows to sort and filter based on those tags.
c) Decide the Scope of the ticket: only to be seen and used in the (currently selected) Job or

Global (possible use in all Jobs).
d) Select if you want to add the ticket to your Favorites.
e) Select Public if you want to show this ticket to all Pilot users and/or if you want to use it

from Shuttle or from Esko editors.

Note:

• Default tickets and Job tickets can not be made Public.

• In the Tickets view, Public tickets have a mark in the column 'Public'.

Note:  Alternatively, when you do not want to change any ticket parameters (yet), select the

ticket and click on  to duplicate it (and fill in a new name).

Creating a Custom Ticket after Selecting a File
You can also create a custom ticket while you prepare to launch a task on a file:

1. Right-click your file(s), select New Task then Other...
2. In the Select Ticket dialog, select the Default ticket for the task you want to use.

Note:  If you do not see any Default tickets, check your Pilot Preferences.

3. Fill in the settings you want to use in the ticket.
4. Go to File > Save As... or use Ctrl + Shift + S (Windows) / Shift + Command + S (Mac).
5. In the Save As dialog:

a) Enter a name for this custom ticket.
b) Select if you want to add the ticket to your Favorites.
c) Select Public if you want to show this ticket to all Pilot users and/or if you want to use it

from Shuttle or from Esko editors.

Note:

• Default tickets and Job tickets can not be made Public.

• In the Tickets view, Public tickets have a mark in the column 'Public'.
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5.7.  Performing Basic Configuration

5.7.1.  Creating Favorite Tickets

Tickets that you use a lot can be added to a list of Favorites. It then becomes easier to launch
them, even with only one click.

Favorite tickets are linked to:

• the User logged into the Pilot. Favorites are personal.

• the file type. The favorite tickets you see or add are only those that match the file type you
selected.

Creating a Favorite Ticket in the Files View
In the Files view, follow these steps to create a favorite ticket:

1. In the Containers or Last used Job mode, select a file (remember that you make favorites
per file type).

2. Right-click in the Launch Favorites pane and choose Add Favorite... .
When you have no favorites yet, click this dedicated link:
 

 
3. In the Add Favorite dialog, select the ticket you want to add as a favorite and click OK.
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The drop-down list top-left offers to filter the list of tickets based on filters that you saved in
the Tickets View. Learn about creating filters in Smart Views on page 127.

Note:  This dialog only shows the (single and workflow) tickets suitable for the file type that
you selected.

Creating a Favorite Ticket in the Tickets View
In the Tickets view, you can either:

• Right-click your chosen ticket, select Add to Favorites and choose the group.
• When creating a ticket, select Add to Favorites in the Save As dialog.

 

 

Using a Favorite Ticket
In any Pilot view where you can make a selection, follow these steps to launch a task by using a
favorite ticket:

1. Select the file(s) you want to launch a task on.

The Launch Favorites pane shows all the favorite tickets for this file type.
2. Click the favorite ticket you want to use.

Note:  If you want to use another ticket of the same task type (for example another prepare
for Viewer ticket that is not a favorite), click the small arrow on the right side of the favorite
ticket and select one from the list. This helps to avoid making too many favorites.
 

 
Mind that a ticket only appears in this list when it has already been launched at least once.
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3. The ticket opens. If necessary, review or edit its parameters.
4. Click Launch.

Attention:  If you do not want to open the ticket, but launch the task immediately, just
press Alt when clicking the ticket.

Learn more in the chapter on Workflows, where we describe extra features in the page
Organizing and Using Favorite Workflow Tickets.

Organizing Favorites (Sorting and Grouping)

Sorting

In your Files view, right-click the Favorites pane and select Organize Favorites.... The resulting
dialog shows the default group named 'Favorites' and the tickets you already added.
 

 

In this dialog, you can

• Sort them. Just make a selection and use drag-and-drop to define the order in which they
appear.

• Add or Remove any favorites from this group.

You can even use SmartNames to define their name. Learn more in Adding a Favorite based
on a SmartName on page 735.

Grouping

Next the default group named 'Favorites', you can create your own groups.

Follow these steps:

1. In the Organize Favorites dialog: click Add Group, type in its name and click OK.
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2. The new group appears in the Organize Favorites dialog.

 

 
3. Select the group name and click Add to start adding favorite tickets.

Attention:  If you do not do this right now, you will create an empty group when
clicking OK. This will make the group disappear again.
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Note:  You can also add a group by first making a selecting tickets:

• In the Organize Favorites dialog, select one or multiple tickets.

• Right-click and choose 'New group from selection'.

• An 'Untitled Group' appears. Rename it at wish.

4. Click OK to close.

You can drag-and-drop groups.

You can fold or un-fold groups.

You can drag-and-drop tickets from one group to another.

You can not create sub-groups.

Right-click the name of a group to Rename it or to Remove it (no confirmation is asked).

Note:  All changes are immediately visualized in your Pilot. This includes whether the
group's content is folded out or not.

Check the result in the Pilot's 'Favorites' pane. Don't forget that what you see there depends
on your selection.

5.7.2.  Creating Users (Introduction) - OLD - DROP

Managing Automation Engine Users is described in detail on the page about the Users view
(part of the chapter Pilot Views and Tools  on page 107).

A small introduction:

1. In the Pilot, go to Tools > Users (or open the View Users (category 'Setup')).
2. In the Users window, choose one of these:

• go to File > New User,
• use CTRL + N ,
• click .

3. Enter the user's Name and Password. Optionally, add a Full Name, Description and valid
E-mail address.

4. If you want the user to be able to administer Automation Engine, check that toggle.

This will give all Access Rights to that user. Learn more in Managing User Access Rights - OLD
- CONTENT USED.

5. Click OK.

5.7.3.  Configuring RIPs or Proofers

To start making output for devices, you need to configure the related RIPs or proofers.

Automation Engine is optimized to work with Esko Imaging Engine and Esko FlexRip/Proof.
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To configure an Imaging Engine RIP, learn more in this page of the chapter "RIP'ing with Imaging
Engine". For FlexRip or FlexProof, see their item in the tool "Configure".

5.7.4.  Pilot Preferences

Go to Edit > Preferences to define some Pilot preferences.

Tickets
• Show default tickets: Deselect this option to hide the default tickets in all lists that show

tickets.

• Use bold ticket names in task launching menu: Select this if you want to see the ticket
names in bold when choosing New Task or Launch with.

• Show only Public Parameters in Tickets: This preference is only available if you have the
Access Right "Tickets: Show All Tickets and their Parameters (Public and other)".

Select this option to only see public tickets and public parameters in the Pilot. This will show
the same effect as if you didn't have the access right 'Tickets: Show All Tickets and their
Parameters (Public and other)'.

This option is useful for administrators who want to check how users without that access
right will see the tickets and their parameters.

Units
• Units: Select the units you want to work with for Dimension (mm, cm, mil, inch, point),

Resolution (ppi, ppmm, ppcm) and Ruling (lpi, lpmm, lpcm).

• Enter the number of Decimals you want the system to display.

Note:  Changes that you make here are automatically adopted in the Shuttle and vice versa.

Files
• Preview Size (Info): This defines the size of the preview in the Info (XMP) dialog (in pixels).

• Open Normalized PDF files with: This defines which application should become the
default application when opening Normalized PDF files from within the Pilot. Learn about
'Normalization' in Normalized PDF and XMP in Automation Engine on page 43.

Normalized PDF files have a .PDF extension. The OS of your client computer will not make a
distinction between Normalized PDF files and regular PDF files.

By default, PDF files will be opened by the OS with Adobe Acrobat Reader (when installed).
However, when working with the Pilot, you may want to open Normalized PDF files in an
Esko editor. Because making this distinction is not possible on OS level, you here have to
specify which application you prefer to use. To do this, choose Other and Browse to the
application's program file.

An example effect is that, if you double-click a PDF file in the Pilot, and it happens to be a
Normalized PDF file, the application that you defined here will open that PDF.
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This preference will be taken into account:

• in the Files view, when double-clicking the file or selecting Open from the pop-up menu

• in the Tasks view, when selecting Open Output File from the pop-up menu

• in the To Do List, when clicking a URL link to a PDF.

Tip:  The Pilot also offers 'Open with', which allows you to select a non-default choice.

Pilot
• Number of recently used jobs in the job selector: Indicate how many you jobs you want

to see in these drop-down lists (10 by default). Changes are applied when you log back into
your Pilot.

• When switching views, keep search criteria: Select this option if wanted.

Jobs
Multi-Job Removal

Select your preferences when you remove multiple Jobs at once:

• Remove Jobs even when they are in use by other users.

• Remove Jobs even when they contain unfinished tasks.

5.7.5.  Task Notifications

Each task ticket can trigger a Notification. The system will so notify someone by sending an
E-mail when that task finishes in a specified state. A notification can also notify an external
system by feeding it an XML or a TXT file with the same type of content.
 

 

Note:  In workflows, when your goal is to send an E-mail, consider using the separate task
"Send E-mail" instead.

Learn more in the pages on setting up Notifications in the Configure tool.

5.8.  Using Public Parameters

Concept

Users often do not want or have to see all the parameters of a chosen task ticket. You can
make them see and define only the parameters that you decided to make Public. Seeing less
options makes it simpler and helps reduce mistakes.
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Ticket parameters that are made Public will be the only parameters visible to users when they
want to launch tasks from:

• Automation Engine client applications: Pilot and Shuttle
• Esko Editors connected to the Automation Engine server: ArtPro, PackEdge, Plato,

FastImpose, DeskPack (Adobe Illustrator).

Note:  Only Public Tickets can be launched from these client applications or editors.

For each Public Parameter, you can decide if the user can either:

• select a value from a list,
• enter a value himself.

5.8.1.  Making a Parameter Public

Note:

• Not all ticket parameters can be made public.
• Parameters need to be made public before you start the workflow that their ticket is part of.

Open the ticket and follow these steps:

1. Right-click the parameter and select Make Parameter Public.
2. Right-click it again and select Modify Public Parameter...
3. In the Modify Public Parameter dialog that opens:

a) Prompt as: If you want, change the way the parameter will be called in the client
application.

b) Choose either:

• Allow the user to set the value: Select this if you want users to be able to freely
enter a value.
 

 

• Let the user select a predefined value: Select this if you want users to choose from
a list of values that you define.
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Note:  Users will only see (and choose from) the Predefined Settings. They will not
see the associated Values.

In the above example, this is how the public parameter will look like to the users of
the client application:

If you chose 'Allow the user to
set the value'

If you chose 'Let the user select
a predefined value'

 

 

 

 

If, in the ticket, that parameter already offers a list of values to choose from, they will
be displayed here.

Default Predefined Setting: You can here define the setting that will be used when
the user didn’t select another one.

4. Click OK.

Attention:  Settings related to public parameters are saved when you save the
ticket.

5.8.2.  Managing Public Parameters in Your Ticket

The Manage Public Parameters... dialog of a ticket is where you overview and manage its
public parameters.

1. In your ticket, go to Advanced > Manage Public Parameters...
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The left pane shows all parameters that can be made public for this ticket. The ones you
already made public are greyed out.

The right pane shows the public parameters and their settings.
2. You can:

• drag parameters from left to right to make them public
• click  if you don’t want it to be public anymore
• drag them up or down to rearrange the order that they will be shown to the user.
• change public parameters’ settings (Prompt as, Predefined Settings, etc.)
• group public parameters under a custom header (click Add Group, click  to edit the

header and drag parameters from the left). An example:

 

 
• use Presets to further simplify the users' choices (see Making Presets to Simplify the Users’

Choices on page 96).
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Making Presets to Simplify the Users’ Choices
Presets are customized combinations of parameters. They limit the amount of decisions that
users have to make.

Example

Let's assume you want users to use different trapping settings when printing offset versus
dry offset. You can collect those trapping settings in a Preset, so that users will only have to
choose between 'offset' and 'dry offset'.

We start from a dialog of a workflow ticket where the trapping step has 3 public parameters:
 

 

1. Click  to remove the (default) Group named "Trap with PowerTrapper"
2. Click Add Group.

A new "Untitled Group" is created. Click  to change its name.
3. Click Add Preset.

A new "Preset" is created. Click  to change its name.
By default, two example values will appear. The preset was renamed to 'Choosing
Process to Decide Traps':
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4. Define what the users will see:

a) in Prompt as, enter the text that users will see (replacing 'Type the name of the
preset here (e.g. “Paper Size”)')

b) enter the values that the users will choose from (replacing 'Type a value here (e.g.
A4)'). In our example, we add 'Offset' and 'Dry Offset'.

Click Add if you want to add extra values (not the case in our example).

5. Drag the parameters from the dialog’s middle pane onto one preset item. This will make
them automatically appear under each preset item (here both under Offset and Dry
Offset).
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6. Define the parameters values for each preset item.

See the above screen shot for a good example.
7. Use the buttons Move Up / Down to define the order of the Presets in the panel that the

end-user will see.
8. Click OK to confirm and close the dialog.
9. Save your ticket to also save these public parameters.

This is how the resulting dialog will look like to the users of the client applications:
 

 

5.9.  Uploading Files to Automation Engine
You can work with files that are already stored in your Containers, or with files that you (first)
upload to Automation Engine.
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Read below about several techniques to upload files. Some of those also immediately launch a
workflow on the uploaded files.

5.9.1.  Uploading Files using the Pilot

In the Pilot, in the Container mode or in the Last used Job mode, there are two ways to
manually upload files:

• Drag and drop files or folders from outside the Pilot onto a folder in the Pilot. Or use copy/
paste shortcuts.

• Right-click your destination folder or go to File > Upload Files.... In the dialog that opens,
browse to your files or folders and click Upload.

About multiple uploads and cancelling uploads

When the upload is not immediately finished, an Upload window appears and you can
continue working with the Pilot. You can upload multiple sets of files. When other files are still
uploading, they will be added to this Upload window.
 

 

All uploads can be canceled individually. Click  to stop the upload immediately. Any partially
uploaded files will be deleted.

When all uploads are done, the Upload window automatically closes.

5.9.2.  Uploading Files from an FTP Server

1. In Containers mode or in Last used Job mode, right-click the folder in which you want to
upload your file, and select Upload from FTP Site....
This opens the Upload from FTP Site dialog, where you enter the settings for the FTP
connection:

2. In Host, enter the name of the FTP server that hosts your files.

Tip:  To use a port other than the default port, add ' :' and the port number after the host
name. For example: myftpserver:1085

3. Enter a User Name and Password that corresponds to an account on the FTP server.
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4. In File Transfer, choose between Binary and ASCII.
Binary will always work, but if you have an ASCII file, the transfer will go a bit faster when
selecting ASCII.

5. By default, the transfer uses Active Connection Mode (where the FTP server opens the data
connection).

If your system is behind a firewall that blocks incoming FTP server connections, select
Passive to use Passive Connection Mode (where the client initiates the connection).

6. Select Secure FTP if you are connecting to a secure FTP server (over FTPS, not SSL or SSH).

Tip:  If you are experiencing problems using secure FTP, try connecting over regular FTP, and
ask your IT administrator to check the security settings of your FTP server.

7. Select 'Remove remote data after transfer' if you want to delete the files from the FTP site
once they are uploaded to Automation Engine.

This enables the option to 'Backup remote data before removal'. When selected, indicate
the Backup Folder where the files should be copied.

8. When you are done, click Connect to establish the connection.
9. Click Upload to start the file transfer.

 

 

5.9.3.  Using Access Points to Upload Files
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Access Points are documented here in the dedicated chapter Integrating with External Systems
on page 1553.

5.9.4.  Using Shuttle to Upload and Process Files

You can upload and immediately process files from any Mac or Windows client computer using
the Shuttle tool.

Learn more in the chapter Working with Shuttle on page 819.

5.10.  Launching Tasks from Editors

5.10.1.  Setup Requirements

For Esko editors and DeskPack (Adobe Illustrator) to be able to connect to an Automation
Engine server, the "Shuttle Server" component needs to be running. Learn more on this page
of the Configuration tool.

In the Preferences menu of the editor, you also need to define which Automation Engine
server you want to connect to.

5.10.2.  Launching Tasks from ArtPro

In Preferences > Servers >  Shuttle, add the name of your Automation Engine server.

Note:  In that same dialog, the tab Automation Engine serves to define other preferences
related to that server. You do not need to fill that one in when you only need this connection to
the "Shuttle Server".

1. To launch a workflow on the currently open file, go to File > Launch Workflow...

This opens the Launch Workflow dialog.
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2. Launch as: Your open file is an ArtPro file, but you can choose as which file type you will

send it to the selected workflow.

If your workflow is... you can launch the file
as...

with...

an Automation Engine
workflow accepting
Normalized PDF files as
input,

Normalized PDF either Normalized PDF
or Normalized PDF
(embedded).

an Automation Engine
workflow accepting PDF
files as input,

PDF any of the available PDF
flavors.

an Automation Engine
workflow accepting ArtPro
files as input,

ArtPro with the included images
(TIFF, EPS...) or without
(then only the ArtPro file
and any ArtPro CT file).

3. If you want to add your file to the Job Folder of an Automation Engine Job, select it from the
Job list or fill in its Job ID and/or Job Part ID.
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Note:  Use the Search... button to see a list of active Jobs, including some of their metadata.
 

 

4. If you want to add your file to an Automation Engine Product, select it from the Products
list or fill in the Product ID and/or Product Part ID.

Note:  Use the Search... button to see a list of your server's Products.

5. Select the workflow you want to launch.
6. Fill in any of its Public Parameters.

If you want to go back to the default parameters values after changing them, click 'Reset To
Defaults'.

7. Click Launch.

5.10.3.  Launching Tasks from PackEdge or Plato

Attention:  You must save your file on an Automation Engine Container before you
can launch a task on it from within PackEdge or Plato.

1. Go to File > Launch Workflow...

The dialog lists all public tickets. When selected, a ticket shows it Public Parameters.
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2. Select the task or workflow you want. If it has public parameters, fill them in.
3. Click Launch to launch the workflow on your open file.

Tip:  To access this "Shuttle Server" easily in the future (without using the menus):

1.

Go to Window > Toolbars > Shuttle to open the Shuttle palette. 
2. Drag it into your application's toolbar.
3.

Click  to open the Launch Workflow window. Click  to open the Shuttle window
where you can monitor and manage the launched tasks.

5.10.4.  Launching Tasks from FastImpose

When working with FastImpose Server, you must save your file on an Automation Engine
Container before you can launch a task or workflow.

1. Go to File > Launch Workflow...

The dialog lists all public tickets. When selected, a ticket shows it Public Parameters.
2. Choose what file type you want to launch your file as.

• When working with FastImpose Server, you can only launch your file as an IMP file.
• When working with FastImpose Standalone, you can launch your file either as a JDF or a

PDF file.

Click the Settings... button to set JDF or PDF Export Preferences. Learn more in the
FastImpose documentation.

3. Select the workflow you want. If it has public parameters, fill them in.
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4. Click Launch to launch the workflow on your file.

5.10.5.  Launching Tasks from Adobe Illustrator (the Shuttle Plug-in)

Note:  To launch tasks from Adobe Illustrator, you need to install the Shuttle Plug-in.
Download it from https://mysoftware.esko.com/.

Follow these steps to launch a task or workflow on the file that you have open (and in front of
any other open files):

1. Go to File > Launch Workflow... or use Option + CMD + Z.
 

 
2. In Launch As, choose Esko PDF to copy a Normalized PDF or PDF+ version of your file onto

the DeskPack Container. Choose Adobe PDF to copy the Adobe Illustrator PDF version.

• 'Esko PDF' uses the 'PDF Export' plug-in to convert your Illustrator file to either
Normalized PDF or PDF+, depending on the setting in Ink Manager. To refine the
conversion, you can select one of the PDF Export Presets, or click Settings... and edit the
PDF Export Settings. These changes are not saved.

• 'Adobe PDF' uses the Adobe PDF preset 'Illustrator Default'.

Note:  'Color Conversion' and 'Profile Inclusion Policy' are not part of the preset
'Illustrator Default', but Launch Workflow will apply color conversion with the last
settings used.

3. If you want to link your file to an existing Automation Engine Job, fill in an existing Job ID
and/or Job Sub ID. The task on the Normalized PDF will then run in that Job context, which
means it can use the Job Setup parameters via SmartNames.

Note:  If your open file is already saved in an Automation Engine Job Folder, the Job ID and/
or Job Sub ID will be filled automatically.
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4. Select the task or workflow you want. If it has public parameters, fill them in.
5. Click Launch. If your file was changed since the last save, you can click Save and Launch to

first save your document and then launch the task.
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6.  Pilot Views and Tools

6.1.  Concepts and Overview

Concept

The Pilot's Views offer different functionality or a specific mode to work in. Find an overview
below with a short description.

At the end of this chapter, we also describe the Tools. Tools are views or dialogs that you can
open in a separate window, next to your Pilot. Most of these are also available as a View.

Automatic Hiding of Views

Depending on the View Mode you are using (Containers, Job Overview or Last used Job),
you will have access to different views.

Depending on your access rights, you may not be able to see some of the views.

Manually Selecting Views

Right-click a view and choose Remove from Views bar. To enable that view again later, right-
click anywhere in the Views panel, choose Select Views... and select the one(s) you want. This
selection is saved per user and remembered the next time you log in to the Pilot.

Overview per Category

• General

• The Files view offers a view on the files in your Containers or Jobs. You typically use it
to open or view them and to launch workflows on them. Learn more in The Files View on
page 109.

• The Jobs view is only visible in Job Overview mode. It lists all or a filtered list of your
Automation Engine Jobs database. Learn more in The Job Views on page 497.

• The To Do List view lists all actions that need user intervention. Learn more in The To Do
List View.

• The Products view shows the items in your Products database. This concept is useful
when you manage re-prints. Products represent production data that you temporarily
link to a Job order. It is the Job order that has the specifications how to output the
product this time, possibly together with many other Product items.

Products are what you keep long term, until you are sure you will not have to produce
them again. Jobs however are 'WIP' (Work In Progress), temporary by definition. A Job
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should be removed when it is finished. Learn more in the dedicated chapter Products on
page 548.

• The WebCenter view enables Pilot users to see what documents are inside a WebCenter
project without having to open a browser. Learn more in the chapter on Integrating with
WebCenter on page 1526, in its section The WebCenter View in Automation Engine Pilot on
page 1529.

• The Tasks view shows all or a filtered list of tasks. It shows their status and offers easy
access to log files or input or output files. You can here also relaunch them, with or
without opening and changing settings first. You have to clean up this list. Learn more in
The Tasks View on page 117.

• The Milestones view shows the milestones of the selected Job (in Last used job mode),
or those of all Jobs (in Job Overview mode). Learn more in Milestones: Tracking Job Status
on page 524.

• The SmartNames view allows to manage SmartNames. Learn more in The SmartNames
View on page 595.

• The Tickets view allows to manage tickets. Learn more in The Tickets View on page 121.

• Commercial Print

These views only serve page imposition workflows:

• The Pages view shows a page list and details about the page status in its impositions.

• The Proofs view shows the sets of imposition proofs and their status.

• The Plates view shows details about all (offset) plates required for that Job.

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

• Sign and Display

These views are described in the dedicated chapter on Gang Run Printing for Sign & Display
on page 871.

• The Orders view shows an overview of what was ordered to be printed on (flat bed or
roll fed) digital printers. Learn more in The Orders View on page 960.

• The Gang Run Printing view shows the substrate queues where submitted graphics
wait to be nested on your available sheet or roll substrates. Learn more in The Gang Run
Printing View on page 882.

• Flexo CTP

These views are described in the dedicated chapter on Flexo CTP Workflow. Find their short
description in Introducing Flexo CTP related Views and Tasks on page 1345.

• Press Plate Sets.

• Press Plates.

• Plate Merger.
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• Merged Plates.

• CTP Queues.

• Cutting Tables

These views are described in Kongsberg related Views, a section of the dedicated chapter on
using Automation Engine to cut jobs on a Kongsberg table.

• Sheets.

• Table Queues.

• Smart Views

Smart Views are custom filters that you saved as a View. Learn more in Smart Views on page
127.

• Setup

These views serve to set up your configuration.

• The Devices view lists all output devices connected to your Automation Engine server.
You can see their status and workload. These devices can be CDI Imagers or Kongsberg
Tables.

• The FlexRips view gives an overview of the "Esko Link" queues to your FlexRip
Dispatchers. Learn more here.

• The Queue Monitor view.

• The Containers view.

• The Access Points view.

• The Customers view.

• The Order Materials view.

• Accounts

• The Users view.

• The Groups view.
• The Roles view.

6.2.  General Views

The views in this category can be used in most types of work.

6.2.1.  The Files View

This view is available in Containers and in Last used Job mode.
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1. The Folders pane shows your Containers, folders and job folders (in Containers mode) or a
job folder and its subfolders (in Job mode).

Note:  When working with Automation Engine Jobs, you typically don't use this view but use
the Last used Job mode to see only the data of the Job you are working on.

Tip:  Instead of browsing to a folder, you can also choose the function Go To Path (find it in
the Go menu). This is useful to paste a URL or UNC path that you copied from somewhere.
You can type the path manually as well. You can even use the function ('Shift'-)'Tab' to be
presented a next folder.
 

 
Examples of supported paths:

• file://BigServer/Data1/Products/BeerVille/Devil_33.ap

• \\BigServer\Data1\Products\BeerVille/120381 Proof.pdf

• smb://BigServer/Data1/Products/BeerVille/4545_report.pdf

2. The Contents pane shows the contents of the folder you selected in the Folders pane.
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Note:  Every time the Pilot shows you the contents of a folder, it automatically checks the
real file types and shows those in the column "Type". This means that the file's extension
is less important here. For example a file with an extension .AI initially shows as an "Adobe
Illustrator" file but when the file type detection found that it is PDF compatible, it will show
as type "PDF File".

3. The Launch Favorites pane allows you to add your favorite tickets and allows to launch
them with one click. Learn more in Creating Favorite Tickets on page 86.

4. The Tasks pane shows all launched tasks (in Job mode, only those for that job). Right-
clicking a task offers functionality to delete, open, relaunch etc... Learn more on the page on
the separate Tasks View.

6.2.2.  The Shared Files View

This view shows the files of the selected job that were uploaded to its shared job folder to Esko
Cloud.

Learn more in the chapter Collaborating via Esko Cloud  on page 1471. Find a direct link here.

6.2.3.  The To Do List View

The To Do List is where you manage all actions that need user intervention. A user
intervention is typically a step in an automated workflow where you require a human decision
of action.

This view shows several types of actions:

•
Message: When created in this view, via . Learn more here.

• Checkpoint: When created by a Wait for Action (CheckPoint) task.

• Milestone Action: When created by the Manage Milestone task.

Use the To Do List to view, modify, forward or delete these actions.

This view can also be opened as a separate window:

• Go to Tools >  To Do List.

• In the Pilot's bottom Status bar, click on the To Do List icon:
 

 

Seeing To Dos in your Mac 'Notification Center'

To Dos can also appear in the Mac OS X notification center. You can there click on 'show' to
open that item in the Pilot.
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To enable or disable this, go to 'Apple' menu > System Preferences, then click
Notifications. You may there see 2 Pilots: an Oracle version and a 1.6 java version. Of the
Pilot app that shows the number of To Do items, switch that ‘numbers' icon on or off.

Note:  Mind these requirements:

• You will only see those on your Mac when the Pilot is not the front-most application on that
computer.

• You need to be logged in to that Pilot.

Checking To Dos
 

 
As in all views, click the header of a column to select or hide columns.

Filtering
The Actions panel shows all actions when in Container mode or only those of the selected Job.

You can filter the list by using the search field. Learn more in Using Filters and Creating Smart
Views on page 129. When you opened the To Do List as a separate window, the filters you
saved also appear in the drop-down menu.

When using the To Do List as a View, a number is shown to illustrate how many of the actions
are assigned to the user logged in and also those assigned to 'any user...'. In Job view, this
is limited to the actions in that Job.
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Details
Select an action to see all its Details shown in the panel below.

Double click the action to open it and also see when and which user created it.

Handling a To Do
To handle a To Do, select it and the following options become available after a right-click (or via
the menu) or in the Details pane:

• Select I am currently handling this to do item to assign it to yourself and change its state
to In Progress.
 

 
• In Files, double-click the path to open the related file in the associated application..
• To open that file in the Viewer, click View next to the file path.
• To 'Explore' the folder of the file path, click on .
• In the Actions pane, right-click and choose Go to Job to open the Job this action relates to.

Alternatively, use Ctrl/Cmd + Alt + O .
• To release the action to one of the output states offered by the Wait for Action

(Checkpoint) task that created it, right-click or click  and choose the wanted
option (by default Completed or Aborted).
Learn more in The Wait for Action (Checkpoint) Task on page 705.
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• To forward one or more actions to another user, select them, click , select the user and
possibly change the Subject, Due Date, State or Message first.

•
To delete actions, select them and click , or press Delete. You will be asked to confirm.

Creating a To Do Message
To create a To Do Action of the type Message:

1.
Click  in the tool bar.

2. In the New Action dialog that opens:
a) Enter a Subject.
b) Choose who to assign the action To. (mandatory field)
c) Relate this action to a Job if needed.
d) Choose a Due Date.
e) Choose the To Do State.
f) Enter a Message if you want.
 

 
3. Click OK to confirm.

6.2.4.  The Products View

This view is available in Containers and in Job mode.

The Products view is a user-friendly, searchable view on the Products database. You can use it
to create new Products, search them and link them to Jobs.

You can see the Products in a thumbnail view  or a list view .
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Working with Products is documented in the dedicated chapter Products on page 548.

6.2.5.  The WebCenter View

This view is only available in Last used Job mode.

Files that have been published on WebCenter (with the Publish on Web task or the Publish
imposition on WebCenter Chain task) will appear in the WebCenter View. Pilot users can so,
without having to open a browser, see which documents are inside a WebCenter project and
what their status is.
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Attention:

• First you need to configure connections to WebCenter sites that you want to use
in tasks, for example in the Publish on WebCenter task. Learn more in Configuring
WebCenter sites.

• Then, when accessing this WebCenter View for the first time, the View will request
you to fill in a default configuration for this View (similar as one of those you added
in the Configure tool). Click Save to Configuration and click Show Documents to
check if the connection works.

• When you want to change this configuration later, right-click in an empty area of this
view and choose Configure.

The View also shows the status of the WebCenter documents.

• When a file arrives on the WebCenter site and approval is required, its status will be
pending.

• Files that do not require approval are marked with approval is not required.

• After a file is approved or rejected in WebCenter, its status automatically updates in this
WebCenter View.

 

 

Tip:

• Press F5 to update the WebCenter view to the latest information.
• Click the link in the top-left corner to open WebCenter in a browser window.

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.
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6.2.6.  The Tasks View

Concept

The Tasks View allows you to monitor, inspect and relaunch all Automation Engine tasks. Each
list entry is a separate task or one step of workflow.

• In Containers mode, this view shows all launched tasks and workflows.

• In Last used Job mode, this view only shows the tasks and workflows for that job.

 

 

Note:  Several other views also show a list of tasks in a Tasks pane at the bottom.

Don't forget to clean up!

These launched tasks and their options are kept in a database. Although you can keep many
thousands of tasks in this view, when you do not clean up this list, the size of this database will
eventually cause slow response and even cause the server software to slow down.

There are manual and automatic tools to clean up this list:

• (Filter), select and press Delete.

• Set up a set of automatic Task Cleanup Rules in the Configure tool.

• Set up a set of automatic rules to Move Tasks to History. The Task History tool is basically
another dedicated database, where you can also search and even relaunch old tasks. Learn
more here.

• (Filter), select and press Move to History.
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Learn more details in Functionality on items in Tasks View on page 118.

Sorting, Filtering and Managing Columns

As many other views, this view allows to

• Sort, by clicking on the header of the column you want to sort by.
• Show, hide or change the order of columns by going to View > Select Columns in 'Tasks'....

Note:  To easily hide a column, right-click its header and choose Hide.

• Filter, by typing in the search field in the tool bar or by specifying a filter. Learn more in
Using Filters and Creating Smart Views on page 129.

Details

Select an entry in the Tasks list to show its Details below. This offers you a summary of the log
file with information meant for the user. It is also translated.

It can also contain links to related files. See this example of the details of the 'preflight' task
that offers a direct link to the preflight report file:
 

 

Note:  In the Tasks View, you see the Details in a separate pane. In other views that also show
a list of tasks, you can request to see the Details in a separate dialog (right-click on a task item
and select Details).

Functionality on items in Tasks View

Tip:  Most of these functions offer a keyboard shortcut. They are mentioned in their Task
menu item.

• Go to Job: When this task was launched in the context of an Automation Engine Job, this
will open that Job in the Last used Job mode. Learn more about working with Jobs in the
chapter Jobs on page 495.
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• Open Task: This opens the task's dialog so you can check the used parameters. You can
also relaunch the task, with or without first changing parameters.

• Open Output File: This opens the output file in the default application for that file type on
your computer. For example: Adobe Acrobat Reader can be assigned to open PDF files.

If the task created multiple files, you will be shown a list of files to choose from.
• Open Output File With: This allows to chose from applications that you registered by

browsing to the locally installed application (on Windows to its .exe file). For example, this
is how you register a PackEdge 14.0 from a Pilot on that same client computer:
 

 
Select Other... when you want to register a new or a first application.

• Go to: This opens the Files or Last used Job view and there selects the (chosen) Output or
Input File.

• Hold: To put a pending task on hold.
• Hold until...: To put a pending task on hold till a specified time.
• Release: To release a task that was on hold.
• Cancel: To cancel a running task. Depending on the task type and its Phase, this happens

instantly or can take several seconds.

Note:  When it takes longer (for example a minute), right-click the task again and check if
the system now offers you the option to Force Quit.

Once the task is successfully cancelled, it will show its new state: .
• Priority: To change the priority of a pending task.
• Relaunch: To relaunch the task with the same options. When you want to change any task

option, first choose Open, make the changes and then click Launch in that dialog.
• Delete: To delete the selected task(s) from this view. You will be asked to confirm.
• Move to History: To move the selected tasks to the Task History database. This also deletes

it from this Tasks view.
• Annotation: To see the annotation that was added when launching this task. Or to change

or add an annotation even after the task is finished. You can for example use this to explain
your colleagues why you used specific parameters or that you already contacted Esko
regarding an error in the task.

Tip:  To easily see if tasks have annotations, switch on the column 'Annotations'.

• Log Info: The Log file not only contains the task's Details (see also below) but also a lot of
detailed technical information. This level of detail can be interesting when searching for the
cause of errors. It is mainly meant for Esko support people.

• Open... This shows the log information of the selected task in the Log dialog. When the
task is still running, click Refresh to see the latest content.

You can send an E-mail containing this log file and attachments.
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• Open with: To open the log file in a text editor installed on your client computer.
Register that application in the same way as you can do for the option 'Open Output
File With'.

Note:  This requires the Automation Engine client to have access to the network share
'AutomationEngineLogging' on the Automation Engine server.

• E-mail.... The Compose E-mail message dialog allows to send this log info in an E-
mail, using the E-mail configuration as set up in Tools -> Configure. Fill in the E-mail
address(es) and change the Body message as you wish. By default all relevant files are
already attached (remove any if you want to).

Note:

• Multiple addresses in one field need to be separated by a semicolon " ; ".

• When you here use SmartNames, make sure they resolve to a valid E-mail address.
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Note:  Files with extension .ticket, .tic and .sn are file types that Esko support can
read.

• Group by Workflow: In a view ordered by the time that the tasks were launched, this
function groups all steps of a workflow together, even when other tasks happened in the
meantime. The first step of the workflow is then shown in bold. Open the bold item to open
the whole workflow in stead of only the selected step.

Note:  This view is overruled when you click on the header of the column 'Launched'.

• Display Related Tasks: Select this to only see the tasks that are part of the same workflow.
To go back to your previous tasks view, click the button 'All Tasks' 'or Tasks' that appeared
on top of the list.

Note:  This is useful when you are already using a Filter that only shows the tasks where
"Task Level = Main Task" (only showing the single tasks and the bold initial steps of
workflows). You can then for example select the workflow with an 'error' status and ask to
see its related tasks.

• Display All Tasks. When viewing only the related tasks, use this to see all tasks.

6.2.7.  The Milestones View

The Milestones View is documented in the dedicated chapter on Jobs on page 495.

6.2.8.  The SmartNames View

The SmartNames View and Tool is documented in the dedicated chapter SmartNames. Find a
direct link here.

6.2.9.  The Tickets View

Concept

A Ticket is a set of Task parameters. In this view, you can create, delete, export or import
tickets (single tickets or workflow tickets). You can make them Public or add Tags. Learn more
below in Functionality in Tickets View.

• In Containers mode, this view shows all Global Tickets (yellow icon).

• In Last used Job mode, this view shows all Global and Job Tickets (blue icon) of the
selected Job.

Note:  Viewing tickets is also one of the Access Rights a user needs to have.

An example (filtered to all tickets that support PDF files as input file type):
 

121



6 Automation Engine

 

Note:  Creating tickets and using them to launch tasks is described in Creating Task Tickets on
page 84.

Sorting, Filtering and Managing Columns in this View

As many other views, this view allows to

• Sort, by clicking on the header of the column you want to sort by.
• Show, hide or change the order of columns by going to View > Select Columns in

'Tickets'....

• Filter, by typing in the search field in the tool bar or by clicking on the arrow in  and
specifying a filter. An example:
 

 
Learn more in Using Filters and Creating Smart Views on page 129.
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Locked Tickets

These tickets will show the icon that they are 'locked': 

These tickets are delivered by Esko. They are either

• default tickets: The initial default tickets of every type of task.
• proposed workflow tickets, typically default workflows for a specific kind of production.

• These also have tags and a description to illustrate what they are for.
• When you open them, a yellow sticky note in the background reminds you that this is a

workflow ticket delivered by Esko.

What does the lock do?

• Locked tickets can not be changed, renamed, overwritten. exported nor deleted.
• Locked tickets can be opened and added to favorites.
• Locked tickets can be duplicated by users that have the access right "Tickets: create/

modify/delete (Job tickets only)"

Note:  The filter and search fields also allow to search for tickets where the attribute 'Locked' is
'true' or 'false'.

Tags

You can add multiple Tags to a ticket. This allows to sort and filter based on those tags.

Preferences on Viewing Tickets

Go to the Pilot's Edit >  Preferences for specific options on viewing Tickets.

About the attributes 'Modification Date' and 'Modified By'

When a ticket is opened and saved, the attributes 'Modification Date' and 'Modified By' are
updated.

The 'Modification Date' and 'Modified By' attributes stay the same when

• updating the Tags,
• updating the Description,
• making the ticket Public/Private,
• renaming a ticket.

When importing a ticket, the attribute 'Modification Date' is taken from the imported ticket. The
attribute 'Modified By' is updated to set the user who imported the ticket.

Functionality on items in Tickets View

Note:  Creating tickets and using them to launch tasks is described in Creating Task Tickets on
page 84.

Tool bar functions
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Note:  Depending on your access rights, you may not be able to create, edit or delete tickets.

•
: To create a new workflow ticket. Learn more in the chapter Workflows on page 687.

•
: To duplicate the selected ticket. Learn more here.

•
: To delete the selected ticket(s). You will be asked to confirm.

•
: To add a Tag or a Description, or to make the ticket Public.

Functionality via "Ticket" Menu or via Right-Click

• Copy from other Job... (only via the "Ticket" menu):

This enables copying a (blue) Job Ticket from another Job to the current Job.

• Export Ticket(s)....

Use this to export tickets so that they can be imported on another Automation Engine
server.

Select the ticket(s), click Export Ticket(s)... and choose the location and file name of the
exported data (a ZIP file). Then transfer that ZIP to the other server and there choose the
'Import Tickets...' function.
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Note:  The resulting ZIP file not only contains the selected ticket(s) but also the following
resource files that these tickets refer to and require:

• SmartNames

• Referred global tickets. Learn more in The Difference between a Subworkflow and a
Referenced Workflow on page 701.

• ArtPro Action Lists

• PitStop Profiles and Action Lists

• SmartMark sets (as .paf files)

• ReportMaker templates (as .paf files)

• Tiling templates used in a Create Tiles ticket

• Templates used in a Step & Repeat Template based ticket

• CAD files used in a Prepare Station ticket

• "Compare with" files used in a Compare PDF ticket

• Scripts used in a Run Script ticket

• Templates used in a Create Imposition from RunList ticket

• XML files used in a Create Design (DesignWizard) ticket

• Rule sets used in a Check Print Rule ticket

• ppd files.

Attention:  Exporting tickets with these tools has these limitations:

• Some "resource" information is not included, such as DGC files and CMS related
files like Color Strategies.

• Workflows that include (blue) Job Tickets by reference can not be exported. An
error message will appear.

• Plate templates used in a Import JDF Stripping ticket are not included.

• The template used in a Create IMP File ticket is not included.

• In a Expand Variable Data to PPML File ticket, XML or CSV database files that
define a grid are not included.

Attention:  The Automation Engine software version on the server that imports the
ZIP may not be on an older version than the Automation Engine server that created
the ZIP.
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• Import Tickets... (only via the "Ticket" menu):

Use this to import tickets that were exported from another Automation Engine (by using
the Export Ticket(s)... function on that other server).

Click Import Tickets... and select the ZIP file that contains the ticket(s) and their dependant
files and click Import. The newly imported tickets will show up selected in the Tickets view
(when not hidden by filters).

Note:  Tickets are imported as Global Tickets and by default keep their original name.

Caution:  When dependant files came from a central resources folder (for example
SmartMarks sets), they will be written on the central resources folder of the current
server.

Other files (for example ReportMaker templates or ArtPro mark files referred from
an ArtPro Action List) will be written in the root of the "ExampleJobContainer", in a
folder named after the folder they originally came from. This is why, when importing
tickets, the "ExampleJobContainer" must exist and allow writing.

Note:  If the import would overwrite any files, you will be asked to confirm. Click OK to
accept that the imported files overwrite the old ones.

• Open: To open the ticket. Alternatively, double click the ticket.
• Make Public: A public ticket is visible to all users. Alternatively, set this attribute the

moment you save a ticket. Learn more in Public Tickets.
•

Duplicate... (or ): To copy a ticket and save it with a different name, without opening the
ticket.

•
Delete (or ): To delete selected tickets. You will be asked to confirm.

Caution:  Make sure that the ticket is not used in an Access Point or somewhere in
the Configure tool or as a referred ticket in a workflow ticket.

Note:  Default tickets (any locked ticket) can not be deleted.

• Rename: To change the name of the selected ticket.
• Tags...: To assign one or multiple tags to the selected tickets. In the dialog, click in the input

field to see a drop-down list with existing tags to choose from. Type in the input field to add
new ones.

• Add to Favorites: To add the selected tickets to the list of Favorite Tickets of this user.
Learn more in Creating Favorite Tickets on page 86.

6.2.10.  The Jobs View

The Jobs View shows a list of Jobs. It is documented in the dedicated chapter on Jobs on page
495.

6.3.  Commercial Print Views

These views serve a workflow dedicated to page workflows (approval, imposition, output).
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Note:  These views are only visible in Last used Job mode.

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

6.4.  Sign & Display Views

These views serve an output workflow that is typically used at sign and display printers.

6.4.1.  The Gang Run Printing View

The The Gang Run Printing View on page 882 is documented in the chapter dedicated to Gang
Run Printing for Sign & Display on page 871.

6.4.2.  The Orders View

The Orders View is documented in the chapter dedicated to Gang Run Printing for Sign & Display
on page 871.

It is used to track production orders that come out of a Gang Run Substrate Queue and are
then cut on a Kongsberg table.

6.5.  Flexo CTP Views

These views are described in the dedicated chapter Flexo CTP Workflow on page 1340. Find a
direct link here.

6.6.  Cutting Tables Views

These views are all described in the dedicated chapter Kongsberg Production Workflow on page
1407. Find a direct link here.

6.7.  Smart Views

Smart Views allow to save a filter as a custom view.

You can create Smart Views for all View types: lists of Tickets, Tasks, Jobs, Products, To Do's,
Milestones etc. Smart Views also make it easier to navigate between views.

Here's an example in Job Overview mode:
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Below example shows a Smart View that only shows the To Do's that are 'pending'. The number
indicates how many items are for this user. Below right we see which user is logged in and we
see the total of To Do's for this user (not just the ones that are pending):
 

 

Tip:  Double click the name of a Smart View to see or (temporarily) change it's filter settings.

How to create a Smart View is explained below.

128



6Automation Engine

To remove a Smart View, right-click it and choose Remove from Views Bar.

6.7.1.  Using Filters and Creating Smart Views

A Smart View is filter that you save as a custom view.

We will use an example to illustrate this. Follow these steps to create a Smart View that will
filter all tasks based on these criteria:

• Launched by a specific operator,
• During the past two days,
• and ended with a status 'Failed'.

1. In the Pilot, choose the Containers mode and go to the Tasks View.
2. Click on the arrow in  or press Ctrl/Cmd + F to open the Search bar and see the extra

filter options that can help you to refine your search:
 

 
3. Add these filters:

• Set the first filter to Operator + is + <the operator whose tasks you want to
see>. You can click  to browse a list of operators (see (1) in the image below).

• Open a second filter line by clicking the + button in the first filter line (see (2) in below
image).

• Set these parameters for this second filter: "Launched date is "within last" 2 "days".
 

 
4. Click the + sign in the second filter line while holding down the Alt key.

It changes into a ... sign and allows you to add more criteria to that same filter line.
5. Add these extra filters:

• "All" of the following are true
• "State" is "Failed".

6. Click Save to save this filter with an appropriate name.
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• Scope: Choose if this filter will be visible to All users or to This user only.
• Select "Add to my views bar" to add this filtered view to the Views pane, in the category

Smart Views.

 

 

Note:  If you don't select this, you only save it as a filter that will be available to Load again
later.

Note:  Right click a View and choose Manage Filters... to add or change saved filters.
 

 

6.8.  Setup Views

These views offer tools to set up your Automation Engine server.

6.8.1.  Devices

The Devices view shows configured output devices, their status and their workload. You can
add these device types:

• CDI Imagers.

Learn more in the chapter Flexo CTP Workflow. Find a direct link to the page on CDI devices
here.

• Kongsberg Cutting tables.

Learn more in the chapter Kongsberg Production Workflow. Find a direct link to the page on
Kongsberg devices here.
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• Esko DFE and HP Production Pro. Learn more in Devices (Digital Presses) on page 1429.

6.8.2.  FlexRips

The FlexRips view and tool gives an overview of the activity on your Esko FlexRips.

It shows the FlexRip's Name, Type, Rip Node (PC) name, its Port and the state of the
Dispatcher. The Queue Name is the channel within Automation Engine that communicates
with the Dispatcher (this name is part of how you configured this FlexRip it in the Configure
tool).
 

 

The Rip Queue pane shows the queued RIP'ing jobs of the above selected RIP. Go to View >
Select Columns in 'Rip queue'... to select the information that you want to see here.

When you stop a Rip Queue ( ), you can still send files to that FlexRip but the communication
will be queued up within Automation Engine. This can for example be useful when the
Dispatcher is located on another computer that you need to shutdown or reboot. To avoid any
communication problems between Automation Engine and that Dispatcher, you can stop this
queue, do the intervention on the Dispatcher's computer, and then start the queue again ( )
when you are sure that the Dispatcher is back up and running.

Click  for quick access to the Configure tool to manage your FlexRip configurations.

6.8.3.  Queue Monitor

Concept

The Queue Monitor shows Automation Engine's processing queues and their content. All tasks
are executed within one of these queues.

Automation Engine uses many different queues to process its tasks and can grant priority
to some types of activity. For example lighter tasks, that only take a few seconds, always get
priority over heavy calculations that typically take many minutes. This is for example why a
'Manage Milestone' task will not have to wait for a 'Trapping' task to finish.
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Which types of tasks are executed on which processing queue is set internally within the
Automation Engine software. Most tasks are executed on the 'CPU' queue. As a user you can
not choose in which queue your task will be executed, but you can choose its priority within
that queue (a standard option when launching the task).
 

 

Queue Types
• ADMIN queue. Used for tasks triggered by events, for example the automatic actions

configured in the Plate Merger's configuration.
• Archive & Restore queue. Used for such tasks.
• CPU queue. The main queue, used for most tasks. It offers the amount of processing

channels as referred to in the Server Admin web page . The more processing channels your
Automation Engine server is licensed for, the more tasks it can simultaneously process on
this queue ("concurrent running tasks").

• CPU_GV queue. Used to run the Global Vision Inspection tasks.
• CPU_HEAVY queue. Rarely used. If so, for heavy calculations and pre-RIP'ing processes.

Note:  Since v16.1, this queue is no longer shown in the 'Server Admin' web page.

• CPU_LIGHT queue. Used for tasks that are light to process.

• For example these tasks: Manage Milestone, Link Product to Job, Run Script, Wait for
Action (Checkpoint), Track Edit Session, Apply Creep, Change Imposition Layout,
Create RunList, Create PDF File from RunList, Add Marks to Imposition, Submit to
CDI, etc.

• Also the FlexRip pre-RIP tasks where the option ‘Resolve Transparencies’ was not
selected.

• FTP queue. Used for upload tasks to (S)FTP or cloud storage sites.
• FlexRip queues. These are named after the FlexRip and can also be controlled using the

FlexRips View or Tool.
• VDP queue. Used for expansion tasks in VDP workflows.
• VIEW_ACC queue. In older versions, this one was used to prepare view data

Caution:  When you open several Queue Monitors as a Tool (to monitor multiple
queues), you might reach your maximum of licenses for client connections to the server
and so get related "Exception" errors. As an alternative, consider opening several tab's
in the same Pilot.

Main Functionality

Use  to start or stop a queue. Use  to schedule when a queue can be active (see an
example below).
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A queue's task entries can be opened, relaunched, etc. Right-click to discover options identical
to those in a regular Tasks view.

When is this Tool Useful?

This tool is mostly used by Esko support staff to diagnose CPU load issues. But there are cases
where it can also be useful for you:

• The main practical reason to stop one or multiple queues is to help with a controlled
shutdown of the server. When queues are stopped, the tasks that would still be launched
right before your server intervention then do not risk to fail but stay in this queue "waiting".
When you then start the queue again after the intervention, the tasks in that queue will
start.

• Some customers only want to start the FTP tasks at night for example. In stead of having to
set these "hold-until" times when launching the task, you could for example schedule the
FTP queue to be active between 8 PM and 6 AM:
 

 

6.8.4.  Containers

A Container is a network share that contains data that Automation Engine can work with.
These containers can be located on your Automation Engine server or on another computer in
the same LAN.

You can create a container by using (part of) an existing network share or you can have
Automation Engine create the network share while creating a container.

The installation of Automation Engine by default creates an ExampleJobContainer on the disk
drive where you installed the server software.

You can add many more containers. You can see and browse through them in the Pilot's
Containers mode. An example:
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Creating a Container
Follow these steps to create a container:

1. Open the Containers view or go to Tools > Containers to open it as a separate window.
 

 
2. Click  or go to File > New.
3. In the Create Container Wizard, click Next and select either:

• Local Folder on the Server to create a container on your Automation Engine server.
• Existing Shared Folder to use an existing network share.

4. Click Next.
5. If you selected Local Folder on the Server:

a) Select the wanted disk drive and click Next.

Tip:  Select a drive to see which containers are already in there.

b) Enter a name for your new container and click Next.
c) Click Next to create another container, or Finish to leave the wizard.

6. If you selected Existing Shared Folder:
a) Enter the Computer Name of the computer where the shared folder is located, or use

the Browse... button to select that computer in your network. Then click Next.
b) The wizard now shows a list of all available shares on that computer. Select the share

you want to use as a container and click Next.

Attention:  Shared folders are not shown when their computer does not
recognize the user that was chosen to be the System Account for Automation
Engine. By default this is the local user BGSYSTEM, but you might have changed
this (using the System Account page in the Server Web tool).

Your container is now created.
c) Click Next to create another container, or Finish to leave the wizard.
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Removing a Container
Removing a container makes its contents invisible to your Automation Engine server. This does
not delete any data inside that share.

To remove a container, select it and click  or press 'Delete' or use File > Remove. You will be
asked to confirm.

• If there are active Jobs on page 495 in that container, they will be listed in the confirmation
dialog. If you remove the container anyway, the Jobs are removed from the database and
their blue Job Folders will become normal yellow folders.
 

 
Learn more about removing Jobs here.

• If there are active Products on page 548 in the container, you can not remove that
container.

Relocating a Container
When a container goes offline, this will be shown in the Pilot's Container mode and in the
Containers View and Tool:
 

 

Here are some possible reasons:

• (Temporary) network problems.
• The Location is no longer valid because the name of the computer or the share changed.

For example the disk was filling up and you decided to move the data to another computer
with another name and then remove the old share.

• The disk that hosts this container crashed. When you have a backup of that disk, you can
put that data back on another disk or computer.
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For whatever reason you need to move data to another network place, you can use the
Relocate feature to inform Automation Engine that the container data is now on another
Location.

Attention:  Relocating does not move any data. It only adapts the Automation Engine
database by informing it on the new location.

Follow these steps to relocate a container:

1. Select the offline container and right-click or go to Edit > Relocate.
2. Enter the name of the computer that you want to relocate your container on, or browse to

it.
3. In the Select the share dialog, select the share you want to relocate your container on.

Click OK.
Your container is now relocated on the share you selected (and has the name of the share).

Refreshing the Containers’ List
By default, each container's availability is automatically checked every 5 minutes. Sometimes,
you want to check it manually, for example after you solved a network problem. Then choose
one of these methods to refresh the connection:

• Go to Edit > Rescan.
• Press Cmd + R  (Mac) or Ctrl + R  (Windows).
• In the Pilot’s Files view, when using the Container mode, press F5 (Windows).

Troubleshooting Containers
These messages explain what is wrong with (the creation of) the container:

Note:  In below examples, the System Account for Automation Engine is still the default user
BGSYSTEM. This can be a different one if you changed it here).

• Creating a new container fails because the passwords for the user BGSYSTEM don't match:
 

 

• An Alert pops up: A container is no longer accessible. It could be off-line or, as in below
example, because the user BGSYSTEM doesn't have full access anymore:
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Note:  When you close this message, the alert is still present in the list of Alerts. This list
opens when you click the  icon in the bottom bar of the Pilot. Learn more in Alerts on
page 1803.

• A container is offline. Select it, right-click and choose Info  to learn why it is offline:
 

 

• In the Pilot Files view, when the host of the container is down, the warning "Could not
retrieve the list of files" appears:
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6.8.5.  Access Points

The Access Points View and Tool is described in the chapter Integrating with External Systems.
Find a direct link here.

6.8.6.  Customers

Concept
This tool allows you to manage the list of customers on Automation Engine.

A customer minimally has an ID and a Name. You can define many more fields. Go to View > 
Columns to also show those fields as columns.
 

 

Ideally, you do not type in this customer data but get it automatically via an integration with
your business system. Learn more about such integrations in Integrating with External Systems
on page 1553.

Fields

Many of these fields are used when you create a Job, in its tab 'Customers'.

Most fields can be used as a SmartName. Learn more in the chapter on SmartNames on page
591.

• Contacts, E-mail and Address fields.

• Job Folder. This field can help to automatically create job folders for that customer under
the folder that you specify here. Learn more in Smart Job Location.

Note:  Make sure the path you specify here ends with a SmartName already.

• Product Folder. When new Products are created automatically for this customer, their Data
Zone will be created under this folder and a dummy Product file can also be created there.
Learn more in  Smart Product Location.

• Upload Folder is useful to help instruct Access Points where to upload the data to. Learn
more, for example, in upload options of an FTP Access Point.
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6.8.7.  Order Materials

An Order Material is the material that your customer wants a Product to be printed on. It's
the name of the material as your customer understands it and probably also the name he
used when he was ordering the production job. This name is the name of that material as it is
mentioned on the job order.

Note:  It is possible that you internally use another name for this material, but in Automation
Engine (the browser client used in the QuickStart deployment), we refer to that one as the (real)
'Print Material'.

This view shows the database of order materials on this Automation Engine. It shows you their
Name, Thickness, Weight and Description.

This list shows the order materials that you can add as an attribute to a 'Product'.

In some MIS integrations, where Products are created automatically, also these order materials
can be created automatically and so also show up in this view. Learn more in The Add to
Products task on page 580.

Note:  Users of the Automation Engine browser client (QuickStart deployment) also manage
this same database of order materials. They do this through their browser interface.

Note:  In this view, the filter can not be saved as a Smart View.

Note:  This view only shows up when you have the license to use the 'Products' tool.

6.9.  Accounts Views

These views serve to manage the user accounts that can sign in to Automation Engine.

First some important background info on Authentication and Authorization within AE.

6.9.1.  Authentication and Authorization within AE

Authentication

• Concept

• Authentication is about validating users to be who they claim they are, at the time when
they attempt to sign in to a system.

• The typical primary authentication factor is checking the combination of a user (account)
name and a password.

• Some systems require two- or even multi-factor authentication (MFA), involving more
technologies to further verify the identity of the user (for example one-time PINs, phone
ring-back, authentication apps, biometric checks) .
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• Systems can validate their own internal users or can delegate this authentication to an
external application. These dedicated applications are called Identity Providers (IdP).

• Within Automation Engine

• When Automation Engine is first installed, authentication comes with checking user
name and password, a basic internal authentication.

• Automation Engine can be configured to delegate this authentication to third
party services, which in their turn could be configured to use one or more (other)
authentication factors.

Learn more in Users View on page 140.

Note:  Learn more technical details in the chapter Pre Install IT Requirements, in the
section on Users and Groups on page 1747.

Authorization

• Concept

• Authorization is about granting permissions to access specific functions or resources.
Once signed in, what is this user allowed to do?

• Within Automation Engine

• To a user of Automation Engine, authorization means receiving the permission to

• qualify as an administrative user or not
• have specific User Access Rights (typically relating to functionality within the Pilot).

6.9.2.  Users View

Concept
Everything that happens in Automation Engine is done by a specific user. This user can be a
person or a service.

Automation Engine does not come with default users.

At the initial installation of Automation Engine, you are asked to create an administrative user
to sign in for the first time, after which you can use that one to create others.

View

Only Automation Engine Administrator users can see this view.

Automation Engine supports both Internal users and users from external Providers. Learn
more details in the chapter IT Requirements, on the page Old and New User Model - Before and
Since v20 on page 1747.

Creating a New Internal User
After an initial install of Automation Engine server software, the system asks to create an initial
administrative user. Using that one, you can then start creating others.

Right-click anywhere in the view and select New User (or click  in the top bar).
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This tool creates an Automation Engine internal user.

 

 

• User Name: (required). The name is not case sensitive.

• Full Name: This full name can be changed later, which is not possible for the actual user
name.

• E-mail Address: Specify this user's e-mail address.

Note:  When editing an LDAP user, you cannot change his e-mail address.

• Description: You can add some details, like the user's function, working hours, phone
number, etc.

• Send invitation e-mail to user:

• When selected, the new user will receive an e-mail with a link to set his own password.

• When not selected, you, as admin user, need to set this user's password here.

• Password: Type the password this new user must use to sign in.

Important:  In the Local version of Server Admin, your IT staff can choose to enforce
a standard set of password complexity rules. When your password does not comply
with these rules, you will get a specific error message. Learn more in Server Admin
Local.

This option is still in pre-release in v20.

• Verify: If you specified a password above, type it again here.

Columns in the View
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Note:  The search field filters on name, full name, e-mail and description.

• User Name: Name used to sign in.
• Full Name: Descriptive name.
• Type: Admin or not (empty).
• Provider:

• Internal: User is provided by Automation Engine (created via this Users view in
Automation Engine v20.0 or later).

• LDAP: User is provided by LDAP.

Important:  In v20.0, the support for LDAP accounts is still in pre-release.

• Windows: A user from before v20.0 that was converted when upgrading to v20.0.

You can migrate users to other providers. Learn more in Users and Groups on page 1747.
• Last Signed In: When this user last signed in.
• Description: Description of this user.
• E-mail: The e-mail address for this user.
• Created: When this user was created.

Other Functionality
Right-click anywhere in the Users view, or first select one or multiple users and choose from
below functionality. A few functions are also available via buttons in the top bar.

• Edit Views...: Define which Views the selected user will see when he signs in to the Pilot.

When editing the views of an other administrator user, be aware that any administrator
user is always allowed to see all views. So he can overrule your settings and switch any of
them on again.

• Edit Access Rights...:

You can assign specific access rights to a user or to a group.
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A typical example is to reserve configuration features only for selected users. You can for
example fine-tune roles by allowing some users to only use tickets but not being able to
change them. Learn more on the page about the Roles View.

Administrator users always have all user access rights. You can not take any rights away.

Only Administrator users can change access rights of normal users.

Learn more in Access Rights on page 144.

• Edit Red Alerts...:

When an important event is detected by the Automation Engine server, a Red Alert is
broadcast to the users. This can pop up as message box and these alerts are indicated in
the bottom right corner of the Pilot with the  icon.

When you are logged in as an administrator user, you can choose which type of alerts you
yourself or another user should be informed about.

Learn more in Alerts on page 1803.

• Show Connections...: This shows from where and with what application the selected user is
currently connected with (signed in to) the server. A user can have several connections.

Possible connections are not only from connected client software (Pilot, Shuttle, browser
client), but also from Esko editors (ArtPro, ArtPro+, PackEdge, Plato, DeskPack, etc.)

This dialog is not live. Use the Refresh button to manually refresh this list of connections.

The list is empty when the user is not signed in.

• Show All Connections...: This shows the connections from all users. A search field helps to
filter the list.

• Copy / Paste: This tool enables to copy / paste attributes from one user to another: their
Favorites, Views, Smart Views, or Red Alerts.

First select the source user and choose Copy, then select the target users(s) and, at the
moment of Paste, select which type of attributes you want to paste to the currently
selected user(s). Select Other to indicate multiple types.

• Delete . You need the proper access right and you will be asked to confirm.
• Migrate Users...: You can migrate users of the Provider 'Windows' to either the provider

Internal or LDAP. Learn more in Migrating Users on page 1749.

Important:  In v20.0, the support for LDAP accounts is still in pre-release.

• Change Password...:

An internal user can change his own password. Internal administrator users can change the
password of any other internal user.
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• Edit User...: In the view, double click a user to see or change his attributes.

Access Rights

Concept
You can assign specific Access Rights to a user or to a group of users.

 

 

In this dialog, when access rights were granted to the user by being part of a role or a group,
they will be selected but disabled.

In above screenshot, an administrator added some extra rights.

Remove All will remove all access rights that were given specifically to this user but not those
that were granted by being part of a role or a group.

Note:  Managing these roles will be easier when you do this per user group. A user
automatically gets all rights from the group he belongs to.

Some general rules:

• Administrator users always have all user access rights.
• Only Administrator users can change access rights of normal users.

This access right: is about ...

Access Points: create / modify /
delete

managing Access Points.

Containers: create / delete creation and deletion of containers.

144



6Automation Engine

This access right: is about ...

Files: copy / move / delete files on
disk

what you can do with files using the Pilot. Note that
these users can still use the Copy or Move File on page
237 and Delete File on page 270 tasks.

Job Parameters: create / modify /
delete

managing the tab 'Parameters' in a Job setup. Learn
more in Creating and Modifying a Custom Job Parameter
on page 510 .

Jobs: create / modify / delete managing Jobs. Learn more in Creating a Job on page
503 and deleting Jobs.

Monitor: move tasks to trash or
history

removing tasks from the Tasks list. See Tasks list and
Task History on page 151.

Pilot : Start the Pilot (in addition
to Shuttle)

being able to sign in to a Pilot.

Queues: stop / start device queues managing queues in the Queue Monitor and the FlexRip
Queues.

SmartNames managing SmartNames.

Task launching: set priority
(immediate / high)

setting a higher priority to the tasks this user launches.

Tasks: Inkremapping in inks panel changing ink attributes in FlexRip or Imaging Engine
tickets (LPI, angle, dot, remap, merge).

Tickets: create / modify / delete
(Global and Job tickets)

managing Global and Job tickets. See  Tickets on page 80
and Tickets View.

Note:  This Access Right automatically grants the two
below mentioned rights.

Tickets: create / modify / delete
(Job tickets only)

managing Job tickets. See Tickets View.

Tickets: Show All Tickets and their
Parameters (Public and other)

which tickets and parameters you can see in the Pilot
(in the Tickets View, when launching a task or workflow
in the Files View, or when opening a task ticket from the
Tasks list).

When this is deselected, the user can only use:

• public tickets (see  Tickets on page 80)

• public parameters in those public tickets (see Using
Public Parameters  on page 92)

• the Launch with option on files (not the New Task
option) (see Launching a Task on a File on page 82
and Launching a Workflow on a File on page 731).

145



6 Automation Engine

This access right: is about ...

Note:

• Without this access right, a user can not create any
ticket.

• In the Pilot's Tickets Preferences, you can use the
'Show only ...' options to simulate how the Pilot looks
without this access right.

This is useful for an administrator to check which
tickets and parameters a user still can see when he
takes away this access right from that user.

To Dos: create / modify / delete forwarding To Do List actions to other users. Learn
more in To Do List.

Viewer: Deep Zoom using a deep zoom, both when viewing unprepared files
and prepared files (when zoom is deeper than prepared
for).

6.9.3.  Groups View

Concept
A Group is a set of users (the group members).

In Automation Engine, Groups make it easy to organize and manage users.

When a group receives certain properties (for example the right to administer the server
and/or a combination of roles), then those properties implicitly get propagated to all of its
members.

When Automation Engine is initially installed on a new system (so not when upgrading),

• a default group Administrators is created. Its members are by default granted the right to
administer Automation Engine.

• a 'getting started' administrative user is created and automatically added to this group.

Note:  User groups in Automation Engine have, since v20, no correlation with Windows groups.

About Groups in the Old User model (BGADMIN, BGUSERS, …)

When an Automation Engine upgraded to v20, this view will also show 2 new AE groups
BGADMIN and BGUSERS. Their name corresponds to the local Windows groups that were
always used before v20.

Note:  If, before v20, you also created other custom groups (via the UI of Windows), then the
upgrade will also have created them here as roles, not as groups, because they were just a
collection of user access rights.

You can continue to use these groups. You can also choose to remove them and start creating
other ones yourself.
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Note:  Automation Engine will not remove these pre-v20 BG* groups from Windows, even
when they no longer have group members. You decide when to do this yourself.

Functionality
This functionality is available either through the top bar buttons or via a right-click after
selecting one or multiple groups:
 

 

• Create a New Group.

• Use the button or right-click anywhere in the view to get this option. Enter a Group
Name.

• Allow users of this group to administer the server: Select this to enable members of
this group to

• create other Users

• manage their access rights

Note:  When a user is a member of several groups, its access rights are a sum of the
access rights assigned to those groups.

• create Groups

• create Roles

• enable them to see the 3 Views in the Pilot of the category Accounts.

In the Groups view, the column Type will show this group as the type Admin.

• Edit Group

Double click the group to see or change its attributes:

• Allowing its members to administer the server or not
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• Add/Remove Members

• Add/remove Roles to all members of this group.

• Delete a group.

You will be asked to confirm.

This does not remove any user accounts. It only removes the 'group' tag from users who
were member of this group.

As an admin, you're responsible to keep the users, groups and roles in a healthy,
meaningful state: This includes that at least one group with admin rights should remain.

6.9.4.  Roles View

Concept
In Automation Engine, Roles serve to organize and manage permissions regarding using the
tools in Automation Engine.

In this version, these permissions are still limited to a set of Access Rights.

A role can be attributed to an individual user but also to a group. You do that in their respective
views.

Automation Engine does not come with default roles. After initial installation, this view is
empty.

An example of different roles of AE users could the roles Prepress and Front-office
because users with these roles will most likely have different access rights to AE tools.

Note:  Only Automation Engine Administrator users can see this or any view of the category
Accounts.

Creating a New Role

1. Click the icon in the top bar, fill in the role's name and click Create.
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2. Don't forget to define the access rights for this role. By default none are selected. See

below.

Functionality
This functionality is available via a right-click after selecting one or multiple roles:

• Edit Access Rights...: This is where you select access rights for users with this role.

Learn about the various access rights in Access Rights on page 144.

• Rename: To rename a role.

• Delete: To delete the selected role(s). You will be asked to confirm.

This does not remove any user accounts. It only removes this tag from users who had this
role attributed.

6.10.  Tools Menu

Tools are views and dialogs that you can open in a separate window, next to your Pilot. Many
of these are also available as a View, in the left pane of the Pilot.
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Closing the Pilot also closes all other open Tools.

Note:  Mind that every open tool counts as a client-server connection. Depending on your
licenses, you might reach the maximum.

6.10.1.  To Do List

The To Do List Tool is also a View, in the category General. It is described here.

6.10.2.  CTP Queues

The Tool CTP Queues is also a View in the category Flexo CTP Views on page 127. It is
described in the chapter Flexo CTP Workflow on page 1340. Find a direct link here.

6.10.3.  Table Queues

The Tool Table Queues is also a View in the category Cutting Tables.
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Learn more in the chapter Kongsberg Production Workflow on page 1407. Find a direct link here.

6.10.4.  SmartNames

The SmartNames View and Tool is documented in the dedicated chapter SmartNames. Find a
direct link here.

6.10.5.  Task History

To keep your Tasks view manageable, you might have to clean the list of tasks. If you do not
want to keep some tasks, you can delete them. If you want to keep certain tasks or tickets for
later use, you can add them to the Task History.

There are 2 ways to have finished tasks move to the Task History:

• In the Pilot, select one or multiple tasks (maybe after first setting a filter) and can click on

 to move it to Task History.

• Tasks can also automatically move to this tool by using the Task Cleanup Rules (in the
Configure panel >  AE Database > Tasks). You can there define which ones should
automatically move to Task History. Learn more in Task Cleanup Rules on page 165.

To view the history, choose Tools > Task History. Initially none are shown. You only see tasks
after clicking Apply on a chosen Search filter (or press Enter)
 

 

The Task History has a lot in common with the Tasks View. It lists all 'moved' tasks which you
can relaunch, view and save.

You can archive entries in the Task History which you can restore later (learn more in Why and
How To Archive parts of this History on page 155). You can make XML reports of the tasks and
use them to bill your customers.

The Task History panel has three parts:
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1. Task History XML Report
2. Task History Search options
3. Task History List

Task History Menus

File Menu

• Open Task: opens the ticket used for the selected task.
• Export XML Report...  Writes a report of the current selection. This XML report contains

task name, ticket name (whether or not the ticket was modified), the Operator, when it
started, when the tasked ended, Status, Priority, job folder...

• Archive... It is possible to archive the data in the database to an XML file. This allows you to
put the file on CD or store it somewhere else.

• Import Archive... Restores the data in the selected XML file in the database. A browse
window pops up, browse to the archive.XML and click OK. The archive will be restored.

• Restart History Server This will shut down the History Server and reboot it.
• Close Window [Ctrl + W] Closes the window. If only one window is left, this is disabled (use

Exit, to close the last window).

Edit Menu

• Select All [Ctrl+ A] Selects all entries in the table.

View Menu

• Columns: define which columns you want to see, for more information, please refer to the
section on Columns.

• Customize Current Filter: Please see filtering.
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•  Manage Views [Ctrl + Shift + F] Here you can save the View Settings or select a
previously created view.

• Related Workflow Tasks: Some tasks are part of a workflow, use this function to get a list
of related tasks.
 

 

• Stop [Escape] This cancels the current database query and lets you set up a different
specification.

• Refresh [F5] Perform another database query with the current settings.

Task History Toolbar
•  Open Task: opens the selected task.

•  XML Report... Writes a report of the current selection. This XML report contains task
name, ticket name (whether or not the ticket was modified), the Operator, when it started,
when the tasked ended, Status, Priority, Job folder...

•  Opens the Filter Settings dialog. Please see filtering.

•  Views: use the drop-down list to select 'Manage Views...' or an already defined view.

Filter

Filter Settings allow specific modification of the way the Tasks View is filtered. There are five
tabs.
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• Operator Define the filter according to the Operator. Tick the ones you want to monitor.

• State Define the filter according to the Status of the task. Just tick the ones you'd like to
view.

• Task Type By default, the Tasks View will show all tasks launched, but you can modify
the filter in such a way that the Tasks View shows nothing but the type of tasks you are
interested in.

• Date Define the Filter according to date and time.

• in a given time window (between [date and time] and [date and time])
• during the previous X hour(s)
• during the previous X day(s)
• during the previous X month(s)

• Advanced

The Advanced Filter settings allow for precise queries.

Hit 'New' to define a rule. The set up is easy. You define a rule that shows X containing a
certain string.

Task History List
The Task History list looks a lot like the Tasks View task list.

The list lists all tasks that have been moved from the Tasks View to Task History. You define
what you want to see. You can define the number of columns (see View Menu > Columns), you
can click the head of a column to get the list to sort the way you like it, and you can filter the
entries (see View Menu > Filter).
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Why and How To Archive parts of this History
Archiving serves two purposes:

• The Task History is used to make the Tasks View quicker, more user-friendly. All tasks
stored in the Task History can be relaunched, it is a so called 'living archive'. As time goes
by, you will end up with a Task History containing a lot of tasks that you may never want to
relaunch. You can delete these tasks, but if you think that's not a good idea, you can use the
Archive function. so archiving can be a part of the Task History database maintenance.

• Archiving can be used to make a backup of the Task History data for safety reasons. You
archive your data frequently, not because you need the space, but because you want to
store your XML archive safely elsewhere, so you can easily restore it when problems should
arise.

Archiving will store all information of certain tasks in an XML file. This adds the possibility of
restoring those XML archives into the Task History. So your information will never be lost.

Note:

Archiving only works on selected tasks.

Archiving doesn't delete the archived tasks from the Task History.

1. Select the tasks you want to archive.

If you want to archive all tasks, press CTRL + A. If you want to make a sub selection, the Task
History reacts to the known shortcuts such as CTRL + click and SHIFT + click.

If you want to make an intelligent selection, and you don't want to lose time, you'd better

use the Filter . You define what you want to see in the Task History (for example all tasks
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originating from one particular job, or handled by one particular operator, ...), click CTRL + A
and you're ready to archive.

2. Click Archive (File Menu > Archive).
3. A dialog pops up, allowing you to browse to the place where you want the archive XML to be

stored. Make sure to give the archive XML a meaningful name in order to avoid confusion
later on. Confusion might arise if you bear in mind that the Task History also uses the XML
language to write an XML report.
 

 

Click OK.
4. A 'Confirm' dialog pops up and asks you whether or not you want to delete the archived

items:
 

 

6.10.6.  Devices

The View Devices is also available as a Tool in a separate window. Both are documented in the
dedicated chapter Flexo CTP Workflow on page 1340. Find a direct link here.
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6.10.7.  FlexRips

The FlexRips Tool is also a View, in the category Setup. It is described here.

6.10.8.  Queue Monitor

The Queue Monitor Tool is also a View, in the category Setup. It is described here.

6.10.9.  Containers

The Containers Tool is also a View, in the category Setup. It is described here.

6.10.10.  Access Points

The Access Points View and Tool is described in the chapter Integrating with External Systems.
Find a direct link here.

6.10.11.  Customers

The Customers Tool is also a View, in the category Setup. It is described here.

6.10.12.  Order Materials

The Tool Order Materials is also a View in the category Setup.

Learn more here.

6.10.13.  Merger Monitor

If you use a "RIP to ..." FlexRip-ticket to output on a device that has been configured to work
with merge queues, you can monitor the merging activities.

Note:  This merge tool was mainly used for Computer To Film devices.

Start the Merger Monitor by selecting 'Merger Monitor' from the Tools menu.
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The Merger Monitor consists of two panes.

The left pane lists all devices  on which files have been merged or are currently waiting to
be merged. In the example above there's one device listed example_merge. Every device on
which something has been merged stays listed until the server is rebooted.

Select a device to see what is in its merge queue. Files that are to be merged are assembled in
pools.

A pool is a group of files with the same characteristics (same plate size, negative or positive, ...).
These characteristics are defined by "extract restrictions" (in more recent features this is
named 'Grouping Keys"). For example: jobs with a different Dot Gain Compensation setting will
not be merged together. They will not belong to the same pool.

Some of these restrictions depend on the setting in the General tab of the ticket you use.

1. VDistortion and HDistortion: Files must have the same vertical and horizontal distortion
before they can be in the same pool.

2.
Reverse : Files have to be reversed in the same way before they can be in the same
pool.

3.
Mirror : Files have to be mirrored in the same way before they can be in the same
pool.

4. Dot Gain Compensation: Only files with the same Dot Gain Compensation belong in the
same pool.

The other restrictions are defined in the Output tab of the ticket you use.

1. Conf: Files need to have the same plate size before they can be in the same pool.
2. Output path and Output File Name: Files with different Output paths or Output File

names will end up in different merge pools.
3. Resolution: Files need to have the same resolution before they can be in the same pool.
4. Compression: Files need to have the same compression before they can be in the same

pool.
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Notice that example_merge has two pools : 20051128–1 and 20060215–1. When you
select the device, but not a pool, you get an overview of all files waiting to be merged. In order
to visually indicate that files belong to different pools they have a different background color.
White and gray are used consecutively.

The right hand panel provides detailed information on files in the merge queue.

• The Task ID
• Priority: this is the priority you defined in the Expose On ticket, not the priority of the task.
• The Name of the Job/File
• The Inks you are exposing, you defined them in the Expose On ... ticket.

Note:  There are two ways in which the inks are listed. C&M&Y&K or C+M+Y+K. They can be
merged on separate films or on the same film.

• The Page number
• The Size VH (mm)

Note:  The symbols used to indicate the size tell you whether or not the file can be rotated
in the merger. <> (154<>191) indicate that the file can be rotated, an x (154x191) indicates
that it cannot.

Rotation is an option you can set in the Transformations part of General tab of the used
task ticket.

• Fill %: This is ( Job size / Plate size)

These percentages are relative, the overall fill depends on the margins and gap as they are
currently defined in your ticket. You cannot simply add the percentages to get a correct idea
of the overall fill. There are all kinds of reasons why files cannot be merged together and
why the fill percentage is -as a result- not yet reached.

• The State of the file in this Merger queue

A file can be on hold  (it's an option you can choose in the 'Expose On ticket'). A file can
be released , but that does not mean that it will be merged, it still has to wait till the fill

percentage is reached. You can Force a file out  of the Merger queue. The forced out file
will take as many files possible with it, if they have a 'release' status.

6.10.14.  Configure

Overview and main functionality
Use the Configure tool to connect to a variety of devices and applications, and define general
Automation Engine settings.

To start Configure, go to Tools > Configure in the Pilot.

To Define Settings in Configure
1. Select the category in the left pane.
2. Go to File > New.
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3. Click on the default name that appears for that new item and wait a moment till the cursor
allows you to change the name.

4. Define your settings on the right.
5. Go to File > Save.

Note:  (Windows) shortcuts:

• 'Insert': to add an item.
• 'Delete': to delete the selected item.
• 'F2': to rename the selected item.

ArtiosCAD Servers
To configure a new ArtiosCAD Server in Automation Engine, go to Tools > Configure >
ArtiosCAD Servers.

 

 

Note:  When the database is of the DBMS Type "Microsoft SQL Server", you can press  to
select the Host and Instance from a list.

How to configure a Standard Edition ArtiosCAD Server

1. Set up the ArtiosCAD Database Settings
a) When using a Microsoft SQL Server:

1. Enter the Name of the ArtiosCAD database. Default is ArtiosCADdb.
2. Enter the database Host name and the name of the SQL Server Instance when

ArtiosCAD is not deployed in the default unnamed instance (typically <ArtiosCAD
Server>\Esko).
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3. Enter the Port when not using the default.
b) When using Oracle:

Important:  The Oracle Client Software (ODBC: Additional libraries for enabling ODBC
applications) needs to be installed on the Automation Engine Master and its Assistants.
When not installed, the Create CAD Report from XML task will not be able to connect to the
Oracle ArtiosCAD database.

1. Enter the name of the Oracle TNS Service name, for example Oracle X.E
2. Enter the name of the Oracle Database Driver.

Note:  The name of the Oracle database Driver can be found in the Drivers tab of
the ODBC Control Panel (%systemdrive%\Windows\\SysWoW64\Odbcad32.exe)
after installation of the Oracle Client Software.

3. Enter the database Host name.
4. Enter the Port when not using the default.

2. Enter the location of the ArtiosCAD Defaults.

This should be a file: URL, pointing to the ArtiosCAD Defaults., for example file://
MyMachine/ArtiosCAD.

The Automation Engine server should be able to reach this folder, and the service account
of the BGMD Service should have read access to the folder. This account by default is the
System Account "BGSYSTEM" (but can be changed in the System Account page).

Note:  ArtiosCAD Defaults are version specific. The version of ArtiosCAD hosting the
Defaults must match with the version of CADX installed on the Automation Engine
computer (Master and its Assistants).

When no ArtiosCAD Defaults location is specified, the Create CAD Report from XML task will
use the ArtiosCAD Defaults installed on the Automation Engine computer (Master and its
Assistants).

3. Test the connection by clicking the Test Connection button.
You will get a message stating "Connection to the database OK", or get an error
message

• when the Automation Engine server can't connect to the database,
• when the Automation Engine server can't get info about the Defaults location. If so,

check if the location exists, and if it can be reached from the server.
• when the Defaults location is not a folder.

How to configure an Enterprise Edition ArtiosCAD Server

1. Select Enterprise Edition.
2. Enter the WebCenter location, typically http://<WebCenterServer>/WebCenter_Inst .
3. Click Open to open the specified location in your default browser.
4. Enter the User Name and Password.
5. Test the connection by clicking the Test Connection button.

You will get a message stating "Connection to the database OK", or get an error
message when the Automation Engine can't connect to WebCenter.
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Automation Engine Database
These databases are set up automatically when the Automation Engine server software is
installed (and their license is present). In this item of the configure panel, you can see their
settings, make changes and test their connection.

Attention:  In the Automation Engine Server Web page, in the section databases, you can
also manage databases, but there to make changes after an installation and without
the use of a Pilot.

Standard and Alternative Database Server Choices for Automation Engine

Before going in more detail, we here summarize the choices you have:

• Standard installation with the standard database server (type).

• A standard installation of Automation Engine will install and use an SQL Server Express
version.

• In case you need a (much) more powerful database server.

• In case you have reached the limits of the SQL Server Express version, you can make
Automation Engine work with a full SQL Server version. Learn more in Databases on
page 1794.

• Commercial printers with heavy loaded page workflows, can also choose to use an
Oracle database, but only for their Application Server database.

• Or use a small test database server for other special cases. You can use an
"Embedded" database:

• In exceptional cases on advise of Esko Support, for example to help solve a database
problem.

• When first installing Automation Engine, to avoid that the installation installs the default
SQL Server Express, of which you know you will not use it anyway (because you already
decided you will use a full SQL Server). This avoids having to uninstall that SQL Server
Express version and other peripheral software.

Important:  For more information on your options when installing Automation Engine, check
the dedicated Installation Guide on page 1761.

Generic setting (Setup tab): DBMS Type
We here describe the general settings of the Setup tab in the configuration of the various
databases. See their own pages for any specific settings.

Note:  DBMS stands for "DataBase Management System".

DBMS Type "Microsoft SQL Server"

These settings will be filled out correctly after installation of the server software. You can
however change these settings.

Here is an example of the Jobs database:
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• Database: Keep the default name or, before initial use of this database, enter a different
name.

• DBMS Type: Select the driver type Microsoft SQL Server.

Important:  This type is valid both for an MS SQL Server Express as for a full MS SQL Server.

• You can press  to select the Host and Instance from a list. Here is an example of such a
list:
 

 

• Enter a correct User name and Password to access that database.

DBMS Type "Embedded" (only for test purposes)

This Embedded database engine is built into Automation Engine's installation kit.

Caution:  This Embedded database type is not suitable for production use! Embedded
databases can only be used in very low volume and low load (test) circumstances.
Production level performance and stability may not be expected with this configuration.
For production use, choose a Microsoft SQL Server (or, in case of the Application Server
database, Oracle). Failure to do so may, in a worst case, result in data loss or data
corruption.

• When the DBMS type is Embedded, set the Folder to point to the location where the
embedded database will be kept on disk (for example "C:\Esko\bg_data_database
\APPSRV" for the Application Server database).
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• Enter a correct User name and Password for the database user to create or access this
database. Enter a blank user name and password when the database or the database user
has not yet been created, except for the Application Server database, in which case you
need to use the user name "sa".

DBMS Type "Oracle"

Learn more about using Oracle as engine for the Application Server database in the chapter
Pre-Install IT Requirements, in the page Oracle as Database Server for the Application Server
component  on page 1746.

Generic setting (Setup tab): Testing the Connection and Applying the Config
Each database configuration has in its Setup tab two buttons: Test Connection and Apply.

Testing the Connection

Click the Test Connection button to perform these checks:

• Is the database management system running? These are possible error messages:

• When the instance is not running or accessible, you get Could not connect to the
SQL Server instance.

• When the user name / password is wrong or when there is no permission to connect,
you get Trying to log in failed.

• When the host is not running or not reachable (wrong name), you get Unknown
database host.

• When wrong information was typed in, you get No such instance.

• What is the database system version?

• An error is shown when The database system version is not supported
(anymore). For example: you selected an SQL Server 2000.

• A warning is shown when The database system version will soon be
outdated. For example, in version 14.1, an SQL Server 2005.

• Is the database online?

• In case of a wrong user name / password or wrong database privileges, you get Trying
to open database failed.

• When the database doesn't exist, you get Could not find database.

• What are the database user roles?

• When the user is not a member of required database roles, you get Insufficient
roles.

• What about the database system memory?

• The maximum server memory does not meet the recommendations. This is
about the memory of the (SQL) database server. For example, in version 14.1, a server
minimally needs +- 4 GB.
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• The total physical memory does not meet the recommendations. This is
about the memory of the computer. For example, in version 14.1, a server minimally
needs +- 4 GB.

• Is the database system speed sufficient?

• You get a warning when The connection is rather slow. For example, in version
14.1, on average, connecting to the database system and getting version info takes more
than 100 ms.

Note:  You can find updated and detailed minimal requirements on http://www.esko.com/
systemrequirements.

When all checks return an OK result, an info dialog will tell you that the Database is online
and accessible.

Applying the Changed Configuration

After you tested the connection, and solved any errors, click Apply to save and apply this
setup.

When you click Apply, Automation Engine restarts parts of its software and then starts
accessing the database using the new settings.

Important:  When you do not click Apply, but only Save these (and other) changes in
the Configure tool, then the changed settings will only be applied the next time the (full)
Automation Engine server software is restarted.

Tasks database

Launched tasks are stored in a database with a default name FastLane_TM.

The settings in the Setup tab are generic and described in the DBMS Type and Testing and
Applying the Configuration.

Task Cleanup Rules

In the Pilot, you can not keep all your finished tasks in the Tasks view forever ; this would slow
down Automation Engine and eventually fill up the tasks database.

You have the choice to

• remove them. In the Pilot tasks view, make a selection, press the Delete button and
confirm.

• or move them to the Task History on page 151 tool. You can define Cleanup Rules to
automate this cleanup.

Attention:  Only finished tasks (those in the state Successfully done, Done with
warning, Workflow failed, Failed, or Cancelled) can be either moved to Task
History or be deleted. The cleanup rules mechanism will ignore tasks that are still
running or waiting.

Finished tasks that are part of a workflow that is still running or waiting will be ignored
too.
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An example of Task Cleanup Rules:
 

 

The way to create these rules is very similar to making filters in many Pilot Views. You can learn
how to do this from a similar example used in Job View Filters on page 499.

Attention:  The rules are executed from top to bottom, so their order is very important.
You can use the Move Up / Move Down buttons to make sure they are executed in the
most productive order. For example: you typically first want to delete tasks and then
start moving the rest to history.

Devices database
This database stores all the information that is shown in the Devices view, both for CTP Flexo
and for Cutting Tables.

By default, this database uses the same database as for Jobs.

• Tab Setup:

Learn about these generic settings in the above pages on DBMS Type and Testing and
Applying the Configuration.

• Tab Maintenance:

Define after how many days you want to Automatically delete records in all the device-
related databases. This deletes

• records in databases that are used in these Pilot Views:

• (CDI workflow): Press Plates, Press Plate Sets, Merged Plates.

• (Kongsberg workflow): Sheets view and (Sign & Display) Orders view.

The time you specified is calculated after the item's Finished date.

• It also deletes the files in the Media Root Folder (see below) older than that specified
time.

• Tab Advanced: Browse to specify the Media Root Folder.
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When a job is finished on a Kongsberg table, a new item is added to the Kongsberg Sheets
view. The JDF and cut file that this (database) item refers to are stored in a unique subfolder
of this Media Root Folder.

Note:  Files related to the CDI Plate Merger are stored in the folder specified in the Configure
item "Plate Merger".

JDF database
This database is used when Automation Engine sends or receives JDF commands. For example
when jobs are created via JDF or when WebCenter sends workflows to Automation Engine (via
JDF).

By default, this database uses the same database as for Jobs.

The settings in the Setup tab are as described in Generic setting (Setup tab): DBMS Type  on page
162 and Generic setting (Setup tab): Testing the Connection and Applying the Config on page
164.

Gang Run Printing database
This database is used by the Gang Run Printing mode.

By default, this database uses the same database as for Jobs.

The settings in the Setup tab are as described in Generic setting (Setup tab): DBMS Type  on page
162 and Generic setting (Setup tab): Testing the Connection and Applying the Config on page
164.

Task History database

The Task History is a tool that stores old tasks. You keep them there because you may want to
look up the settings they used or to relaunch them on same or other files. Learn more in Task
History on page 151.

The settings in the Setup tab are as described in Generic setting (Setup tab): DBMS Type  on page
162 and in Generic setting (Setup tab): Testing the Connection and Applying the Config on page
164.

Maintenance

In case this database is filling up or when you experienced that you do not need tasks of a
certain age, it is advised to clean up.

• Automatically delete tasks older than X days. Choose this for an automatic partial
cleanup.

• Clear All Tasks in History. This deletes everything in this database. You will be asked to
confirm.

Printing Conditions database

This database is related to the Print Control Wizard.
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What is the Print Control Wizard?

The Print Control Wizard is a tool that will help you optimize your print quality.

Based on your exact printing setup, your current print quality and the standard you want to
print towards, the Print Control Wizard will calculate the best possible screens and curves
that you can use to achieve great results on press.

This will help you avoid common problems, for example a lack of smoothness in the transition
from shadows to solids, or from highlights to paper, and will make getting good printing quality
time after time easier.

What is a Printing Condition?

The Print Control Wizard will guide you in creating a printing condition. This printing condition
will:

• describe your exact printing setup (press, substrate, inks, plate, etc.) and the way it prints,
• include the standard you want to print towards (an ISO standard, linear printing...),
• result in the best possible screens and curves to achieve the quality of that standard with

your printing setup.

Learn more about this tool and its installation in the documentation of Print Control Wizard.

Note:  This tool is present on the installation DVD of Imaging Engine.

Jobs database

Setup

By default the database used for jobs is named BSJobs.

Note:  The BS in the name BSJobs refers to an old Esko server software application.

The settings in the Setup tab are as described in Generic setting (Setup tab): DBMS Type  on page
162 and in Generic setting (Setup tab): Testing the Connection and Applying the Config on page
164.

Maintenance

Dangling Jobs are active Automation Engine Jobs that have a link to a job folder that is not
there, probably because the folder was (re)moved or renamed.

Normally, each active Job relates to one job folder on disk. But it does happen that a user
moves or deletes a job folder, for example via Windows Explorer or Macintosh Finder. This
causes discrepancies between the information of that Job in the Jobs database and the actual
situation on disk. Removing such dangling Jobs brings the database back in sync with the
reality on disk.

Click Remove to make the database check, for each Job, whether or not their job folder still
exists. You will be asked to confirm. When that folder does not exist, the Job will be removed
from the Automation Engine database.
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Note:  This implies that instead of deleting jobs via the Pilot, you are able to delete Jobs by
deleting the corresponding folder and then manually cleaning up the dangling Jobs here.

Application Server database
This database is used when you use the Pilot Views that are valid for page workflows: Pages,
Proofs and Plates (category Commercial Print).

By default, this database uses a database named fasttrack.

The settings in the Setup tab are as described in Generic setting (Setup tab): DBMS Type  on page
162 and Generic setting (Setup tab): Testing the Connection and Applying the Config on page
164.

This database can also use the DBMS Type Oracle. Learn more about using Oracle as engine
for the Application Server database in the chapter Pre-Install IT Requirements, in the page
Oracle as Database Server for the Application Server component  on page 1746.

Automation Engine Web Service
This setup is documented in the chapter Integrating with External Systems., as part of the setup
of a Web Service Access Point.

Cloud Storage Services
This is where you configure cloud storage destinations that the Upload to Cloud Storage task
can upload files to and where a Cloud Storage Access Point can download files from.

Note:  Any form of SSO (as supported by some Cloud Storage services), is here not supported.
Access Points run as user 'BGSystem' on the master Automation Engine server.

Configuring Box, Google Drive or OneDrive
Follow these steps to create an account:

1. In Tools >  Configure > Cloud Storage Services, click Add and select the provider (Box,
Google Drive or OneDrive).

2. The Add ... Account dialog of the selected provider dialog informs you on the process and
asks to sign in to that provider.

Attention:  When your internet browser is already open, an account could already
be logged in to that service. To make sure you log in with the right account, close
your browser first.
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3. Click Sign In. Your browser opens a page asking permission for Automation Engine to

view and manage files on that storage. When your browser does not auto-remember your
credentials, it will first ask you to log in to that provider.

Here's an example using Google Drive (the used account name is shown top right):
 

 
4. Click Allow to continue. The provider now grants access to the account and calculates a

unique code.

• Google Drive shows this code in a dedicated web page. An example:
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• Box and OneDrive display the code as part of the URL that the browser is redirected to.
An example:
 

 
5. • For Google Drive: Select the code and copy it (Ctrl-c / Cmd-c).

• For Box and OneDrive: Select the full URL (or only the characters in the URL after the
'code=') and copy it (Ctrl-c / Cmd-c).

6. Go back to the Add <provider> Account dialog and paste the code or full URL in the Code
field (Ctrl-v / Cmd-V):
 

 
7. Click Continue and add an Account Name and Description.
8. Click Create.

This account is now ready to be used in the tools that use cloud storage services.

Note:  You can reset the authorization for an account. This is needed when the authorisation
token became invalid (it is broken, the administrator of the cloud storage deleted the site, ...).
Follow these steps:

• Select the account for which you want to reset the authorization.
• Click Authenticate.

• In the dialog that pops up, fill in the required key(s) and press Authenticate.

Configuring Amazon S3
Follow these steps to create an account for Amazon S3:

1. In Tools >  Configure > Cloud Storage Services, click Add, select Amazon S3 and click OK.
2. In the Add Amazon S3 Account dialog, fill in the Access Key ID and Secret Access Key as

generated in the IAM module for the user linked to this account. Contact your administrator
for more details.
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These keys allow Automation Engine the following actions on the buckets (root folders) that
are linked to this account:

• download, upload and remove files
• create new folders.

Note:  The IAM-defined user must have sufficient permissions to access the required S3
buckets. Also consider limiting this user's access to one or more specific S3 buckets. Learn
more about IAM policies and access to S3 buckets in this online article.

Attention:  When your internet browser is already open, an account could already
be logged in to that service. To make sure you log in with the right account, close
your browser first.

3. Click Continue and add an Account Name and Description.
4. Click Create to confirm and close the dialog.

Note:  You can reset the authorization for an account. This is needed when the authorisation
token became invalid (it is broken, the administrator of the cloud storage deleted the site, ...).
Follow these steps:

• Select the account for which you want to reset the authorization.
• Click Authenticate.

• In the dialog that pops up, fill in the required key(s) and press Authenticate.

Create DCS Master
 

 

When you use the Create Master DCS task, you might want to map short names used in plates
(that might not mean anything) to full ink names. This is handy for example for plates with
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international ink definitions. By default, C,M,Y and K are mapped to Cyan, Magenta, Yellow
and Black.

To add an ink definition, double-click an input field and start typing. Press 'TAB' to switch fields.

Digital Press
Use this to connect Automation Engine to the DFE (Digital Front End) of a digital press.

1. Select Digital Press and use File > New to create a new digital press connection.
2. Enter the name of your DFE Server and click Connect.

Note:  Make sure the DFE server is running and reachable over the network.

If your connection is successful, you will see Connection OK! and details about the DFE
server.

 

 
3. If your DFE server drives several presses, select the Press you want to connect to.

You will see details about the digital press.
4. Use File > Save to save your connection.

E-Mail Configuration
Automation Engine can use your E-mail server to send E-mails. These E-mails can be sent by a
task Notification, by a dedicated Send E-mail task or as an extra tool when you opened a log
file.
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• Postmaster is the E-mail address that will receive a warning mail when an E-mail could not
be delivered.

• Use as sender: Select this to include a "Sender" SMTP header.

The purpose of such a header is to indicate that the actual sender of the E-mail is
different from the person in the 'From' field of the E-mail. Some E-mail servers refuse
to send this E-mail unless this field is specified. Certain E-mail clients will visualise the
sender info as "sent by <postmaster> on behalf of <from>".

Note:  All Tab 'Red Alerts' - CONTENT COPIED are also sent as e-mail to this Postmaster.

• SMTP Server: Check with your IT department for the correct settings of the SMTP Server
and its Port.

• Use a secure connection: Select this option if you want to use a secure instead of an
unrestricted connection.

• SMTP server requires password authentication: When this is the case, select this and fill
out the User Name and Password fields.

Note:  The following authentication schemes are supported by the Automation Engine mail
component: PLAIN, LOGIN and DIGEST-MD5.

• Advanced: Use this to add generic properties for outgoing SMTP E-mail. Some examples:

• To use office365 as SMTP server for outgoing E-mail, add the Key
"mail.smtp.starttls.enable" with Value "true".

• To get some debug information when there are problems with outgoing E-mails, add the
Key "mail.debug" with Value "true".

• Send Test E-mail...: Click the button to send a test E-mail. An example:
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• From: Indicates the address you're using to send the test E-mail. If no address is filled
in, the postmaster address is used. You can choose a different sender to test if the mail
server allows you to send e-mails on behalf of others. The Send E-Mail task relies on this
behavior as it tries to send E-mails on behalf of the user that launches the task.

• To: Fill in a valid E-mail address that will receive the test mail.

• Subject: Fill in a subject line.

• Message: You can enter a personal message or leave the default text.

• When finished, click Send to see whether the configuration is working properly. When
the E-mail could be sent, an Info message will appear. When it failed, you will get a
detailed warning message.

External Databases
External Databases are databases from external systems (not part of Automation Engine).

Automation Engine uses links to such databases in

• a Database Query SmartName. Learn more here.

• a Database Access Point. Learn more here.

• the Interact with Database task. Learn more here.

Attention:  When integrating Automation Engine with an external database, make sure
you are compliant with the license agreements of that database manufacturer.

Note:  Configuring these links requires knowledge about database setups. If necessary, contact
your IT database administrator to figure out the correct settings.

Configuring External Databases

1. Go to Tools > Configure > External Databases.
2. Click File > New to configure a new link to a database.

A new database name is created with the name db_number (the number is the
chronological number of the database).

3. In the left pane, click to select the new database and then click again to enable renaming
that new database link. Type the name you want and press Enter to confirm.

4. Choose the appropriate DBMS Type.
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These Database Management Systems (DBMS) are supported:

• Microsoft SQL Server

• Oracle

• Other (using a JDBC driver).

Attention:  Esko provides the drivers for both SQL and Oracle DBMS types. Not all
database drivers can be freely distributed by Esko, and not all drivers have been
tested. If you need to connect to Other types, you need to connect using a JDBC
driver.

5. Enter the connection details. These are different per type of DBMS. See examples in
Specifics per DBMS on page 176.

6. If required for the DBMS, enter the name of the Host. This is the database server
(computer) name.

7. If required for the DBMS, enter the Port number.
8. If required for the DBMS, enter the User name and Password that will be used to access

the database.
9. Click 'Test Connection' to test if your setup is valid. If it is not valid, the error message

might contain details about the problem.
10.Disclaimer: Be aware of the risks of direct database queries and of the fact that Esko takes

no liability for them. You need to agree before this configuration can be saved.
11.Click File > Save to save the configuration.

See the next section for some specifics per DBMS.

Specifics per DBMS

Connecting to a Microsoft SQL Server

 

 

When choosing this DBMS type, the supported databases will be restricted to the supported
versions of SQL Server that is used for the Automation Engine databases. Please check the
system requirements page to see which SQL Server versions are supported.

When the External Microsoft SQL Server version is running a different version, please check
Esko Knowledge Base article KB205229874 for possible workarounds.
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Connecting to an Oracle Server
 

 

Connecting an "Other" DBMS

Other DBMS can be accessed if you can get the necessary drivers and information on how to
access the DBMS via standard JDBC technology.

• Download the JDBC driver (a jar file) from the manufacturer’s website into a Container that
is accessible to the Automation Engine (Master) server.

• Enter the required configuration fields. See an example:
 

 
• Check your JDBC driver manual for more details.

External Web Services
Using the Interact with Web Service task on page 1627, Automation Engine can communicate
with web services from external systems.
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To configure such a web service,

1. Go to Tools > Configure.
2. In the Configure window, select External Web Services.
3. Press the Insert key or go to File > New. Specify a name for the new External Web

Service.
4. Specify URL.

You can use a secure connection via SSL (a URL starting with https:// ) with or without a
valid SSL certificate signed by a "Certificate Authority" (CA).

When using a secure connection without a valid certificate, import the certificate into the
server java KeyStore. Use the following command on the Automation Engine server:

keytool -import -alias mydomain -file myfile.crt -keystore C:\Esko
\bg_prog_fastserver_v40\jre\lib\security\cacerts

Check the Allow unverified SSL Certificate option to do this.

Warning:  This setting is not secure.

If you need to pass via a proxy, configure the proxy settings via Tools > Configure > Web
Proxy.

5. Select the Authentication mode from the drop-down options: None, Basic or WebCenter.

Attention:  Please make sure the external web service is supporting the selected
authentication method. Not all web services allow this.

Attention:  About the "WebCenter" type authentication: if you try to connect to a
WebCenter 14 or more recent, you do not need to configure the WebCenter server,
you can indicate it in the task. If you try to connect to an older WebCenter server,
you have to configure the WebCenter server here and use the Interact with Web
Service task instead of the Interact with WebCenter task.

6. Provide User Name and Password.
7. Click File > Save.

FastImpose Site Preferences
The FastImpose site preferences serve to map ink names to custom names. For example if you
want to map 'C' to the French 'bleu' on your plates.

Ink Names

Click Add to add two initial values to the list: key and value. Double click the words to edit
them.

Tip:  A black rectangle around the field indicates that you can edit it.

178



6Automation Engine

If you want to change 'C' to 'Bleu', then enter C in the Name column, and 'Bleu' in the
Customized Name column:
 

 

This does not change your file, but if you used marks that would output 'C' on plate, they will
now mention that ink as 'Bleu'.

Surfaces

When the values that describe front - back printing modes, like F/B, Front/Back, Back,
F, Front, B are not conform your language or your way of working, you can here change
them.

An example: changing Front/Back to read Recto/Verso:
 

 

FlexProof - Image Downloader
Select the item FlexProof - Image Downloader and go to File >  New.
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Note:  Don't forget to save your settings. Use File >  Save.

Tab "General"

• Type: The type will appear after having synchronized. First fill in the other settings.

• Proofer Node: Enter the FlexProof computer name.

Attention:  The name of the Image Downloader Proof Node is case sensitive. This
is not the case for the other devices.

• Synchronize with Proof Node.This may take a few seconds, the system will fill out the
‘Type’ field.

Tab "Queue"

• Queue: A default name is proposed. This field automatically updates when you rename the
device.

• Queue Job Limit: A FlexRip's Dispatcher EskoLink queue can handle the expose command
of 2 jobs at the same time. If you want the Automation Engine queue to allow sending
2 expose commands at the same time, then set the job limit of the Automation Engine
queue on 2.

Putting this job limit on 1 will result in each expose command to that EskoLink queue being
handled one by one: the second job will be ripped after the first one is completely finished
("First In First Out" principle).

Note:  Having jobs RIP'ed earlier on the FlexRip does not mean that your output device can
output them any earlier.

Tab "Merge"

• Merge: Define if you want merge jobs on output.

• Unit. Select a unit for the below fields.

• Margin: Define an extra margin around the output.

• Gap: When merging, a gap adds an extra zone of empty pixels around each job.

• Minimum Fill: When merging, enter what percentage of minimum fill you want in the
output. No output is generated before this fill percentage is reached.

FlexRip - Approval
Select the item FlexProof - Approval and go to File >  New.

Note:  Don't forget to save your settings. Use File >  Save.
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Tab "General"

• Type: The type will appear after having synchronized. First fill in the other settings.

• Rip Node: Enter the FlexRip/FlexProof computer name.

• EskoLink Portnr.: Enter the port number of the Dispatcher's EskoLink queue.

• Fill out these fields before you click Synchronize with Rip. This may take a few seconds.

Tab "Queue"

• Queue: A default name is proposed. This field automatically updates when you rename the
device.

• Queue Job Limit: A FlexRip's Dispatcher EskoLink queue can handle the expose command
of 2 jobs at the same time. If you want the Automation Engine queue to allow sending
2 expose commands at the same time, then set the job limit of the Automation Engine
queue on 2.

Putting this job limit on 1 will result in each expose command to that EskoLink queue being
handled one by one: the second job will be ripped after the first one is completely finished
("First In First Out" principle).

Note:  Having jobs RIP'ed earlier on the FlexRip does not mean that your output device can
output them any earlier.

Tab "Merge"

• Merge: Define if you want merge jobs on output.

• Unit. Select a unit for the below fields.

• Margin: Define an extra margin around the output.

• Gap: When merging, a gap adds an extra zone of empty pixels around each job.

• Minimum Fill: When merging, enter what percentage of minimum fill you want in the
output. No output is generated before this fill percentage is reached.

FlexRip - B
Select the item FlexRip - B and go to File >  New.

Note:  Don't forget to save your settings. Use File >  Save.

Tab "General"

• Type: The type will appear after having synchronized. First fill in the other settings.

• Rip Node: Enter the FlexRip computer name.
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• EskoLink Portnr.: Enter the port number of the Dispatcher's EskoLink queue.

• Fill out these fields before you click Synchronize with Rip. This may take a few seconds.

Tab "Queue"

• Queue: A default name is proposed. This field automatically updates when you rename the
device.

• Queue Job Limit: A FlexRip's Dispatcher EskoLink queue can handle the expose command
of 2 jobs at the same time. If you want the Automation Engine Queue to allow sending
2 expose commands at the same time, then set the job limit of the Automation Engine
queue on 2.

Putting this job limit on 1 will result in each expose command to that EskoLink queue being
handled one by one: the second job will be ripped after the first one is completely finished
("First In First Out" principle).

Note:  Having jobs RIP'ed faster on the FlexRip does not mean that your output device can
output them any earlier.

• Optimize Expose Sequence: Select this to have all separations RIP'ed in one pass, which
normally leads to faster output. For some jobs however, this way of working results in
memory problems, when this happens, deselect this option so that all separations will be
RIP'ed separately (the RIP will be restarted after every separation).

Tab "Merge"

• Merge: We advise to set this to No as merging will then happen after this pass on the way
to the Imagesetter and this gives a higher flexibility in merging (positive and negative can
be merged on one film).

• Unit. Select a unit for the below fields.

• Margin: Define an extra margin around the separations.

• Gap: When merging, a gap adds an extra zone of empty pixels around each separation.

• Minimum Fill: When merging, enter what percentage of minimum fill you want in the
output. No output is generated before this fill percentage is reached.

FlexRip - BI (Barco Imagesetter)
Select the item FlexRip - BI (Barco Imagesetter) and go to File >  New.

Note:  Don't forget to save your settings. Use File >  Save.

Tab "General"

• Type: The type will appear after having synchronized. First fill in the other settings.
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• Rip Node: Enter the FlexRip computer name.

• EskoLink Portnr.: Enter the port number of the Dispatcher's EskoLink queue.

• Fill out these fields before you click Synchronize with Rip. This may take a few seconds.

Tab "Queue"

• Queue: A default name is proposed. This field automatically updates when you rename the
device.

• Queue Job Limit: A FlexRip's Dispatcher EskoLink queue can handle the expose command
of 2 jobs at the same time. If you want the Automation Engine Queue to allow sending
2 expose commands at the same time, then set the job limit of the Automation Engine
queue on 2.

Putting this job limit on 1 will result in each expose command to that EskoLink queue being
handled one by one: the second job will be ripped after the first one is completely finished
("First In First Out" principle).

Note:  Having jobs RIP'ed faster on the FlexRip does not mean that your output device can
output them any earlier.

• Optimize Expose Sequence: Select this to have all separations RIP'ed in one pass, which
normally leads to faster output. For some jobs however, this way of working results in
memory problems, when this happens, deselect this option so that all separations will be
RIP'ed separately (the RIP will be restarted after every separation).

Tab "Merge"

• Merge: because this device type cannot merge, this settings is always on 'No'

• Select a Unit for the below field.

• Margin: Define an extra margin around the separations.

FlexRip CDI, CDI Spark and CDI Compact
These three types of devices can be configured in the same way. Select the matching item and
go to File >  New.

Note:  Don't forget to save your settings. Use File >  Save.

Tab "General"

• Type: The type will appear after having synchronized. First fill in the other settings.

• Rip Node: Enter the FlexRip computer name.

• EskoLink Portnr.: Enter the port number of the Dispatcher's EskoLink queue.
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• Fill out these fields before you click Synchronize with Rip. This may take a few seconds.

Tab "Queue"

• Queue: A default name is proposed. This field automatically updates when you rename the
device.

• Queue Job Limit: A FlexRip's Dispatcher EskoLink queue can handle the expose command
of 2 jobs at the same time. If you want the Automation Engine Queue to allow sending
2 expose commands at the same time, then set the job limit of the Automation Engine
queue on 2.

Putting this job limit on 1 will result in each expose command to that EskoLink queue being
handled one by one: the second job will be ripped after the first one is completely finished
("First In First Out" principle).

Note:  Having jobs RIP'ed faster on the FlexRip does not mean that your output device can
output them any earlier.

• Optimize Expose Sequence: Select this to have all separations RIP'ed in one pass, which
normally leads to faster output. For some jobs however, this way of working results in
memory problems, when this happens, deselect this option so that all separations will be
RIP'ed separately (the RIP will be restarted after every separation).

Tab "Merge"

• Merge: Define if you want merge jobs on output.

• Unit. Select a unit for the below fields.

• Margin: Define an extra margin around the output.

• Gap: When merging, a gap adds an extra zone of empty pixels around each job.

• Minimum Fill: When merging, enter what percentage of minimum fill you want in the
output. No output is generated before this fill percentage is reached.

Tab "CDI"

When the CDI has a recent version of Grapholas software, the Pixelclock will here be shown
as 'Automatic'.

Older versions ask you to define the values here:

• Pixelclock is set to 360.000.

• Perimeter: Define the perimeter of the drum, in the selected unit.

FlexRip - HP Indigo 4000 Series
Select the item FlexRip - HP Indigo 4000 Series and go to File >  New.
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Note:  Don't forget to save your settings. Use File >  Save.

Tab "General"

• Type: The type will appear after having synchronized. First fill in the other settings.

• Rip Node: Enter the FlexRip computer name.

• EskoLink Portnr.: Enter the port number of the Dispatcher's EskoLink queue.

• Fill out these fields before you click Synchronize with Rip. This may take a few seconds.

Tab "Queue"

• Queue: A default name is proposed. This field automatically updates when you rename the
device.

• Queue Job Limit: A FlexRip's Dispatcher EskoLink queue can handle the expose command
of 2 jobs at the same time. If you want the Automation Engine Queue to allow sending
2 expose commands at the same time, then set the job limit of the Automation Engine
queue on 2.

Putting this job limit on 1 will result in each expose command to that EskoLink queue being
handled one by one: the second job will be ripped after the first one is completely finished
("First In First Out" principle).

Note:  Having jobs RIP'ed faster on the FlexRip does not mean that your output device can
output them any earlier.

• Optimize Expose Sequence: Select this to have all separations RIP'ed in one pass, which
normally leads to faster output. For some jobs however, this way of working results in
memory problems, when this happens, deselect this option so that all separations will be
RIP'ed separately (the RIP will be restarted after every separation).

FlexRip - Proofer Output
Select the item FlexRip - Proofer Output and go to File >  New.

Note:  Don't forget to save your settings. Use File >  Save.

Tab "General"

• Type: The type will appear after having synchronized. First fill in the other settings.

• Rip Node: Enter the FlexRip computer name.

• EskoLink Portnr.: Enter the port number of the Dispatcher's EskoLink queue.

• Fill out these fields before you click Synchronize with Rip. This may take a few seconds.
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Tab "Queue"

• Queue: A default name is proposed. This field automatically updates when you rename the
device.

• Queue Job Limit: A FlexRip's Dispatcher EskoLink queue can handle the expose command
of 2 jobs at the same time. If you want the Automation Engine Queue to allow sending
2 expose commands at the same time, then set the job limit of the Automation Engine
queue on 2.

Putting this job limit on 1 will result in each expose command to that EskoLink queue being
handled one by one: the second job will be ripped after the first one is completely finished
("First In First Out" principle).

Note:  Having jobs RIP'ed faster on the FlexRip does not mean that your output device can
output them any earlier.

Tab "Proof"

Recombine Separations:

You can define this workflow choice: or you choose to let the FlexRip recombine the
separations or you choose to add a 'Proof (FlexProof)' task.

• On the FlexRip, you can add a margin, no merging is possible.

• By Sequencing A 'Proof (Image Downloader)' Task: You then need to select the 'FlexProof
- Image Downloader' device from the list.

Note:  The list only shows those devices that are configured for the same node ; the RIP
and Proof node must be identical.

FlexRip - Screened Output

Shared Settings for all FlexRip flavors of Screened and Unscreened Output

• Tab "General"

• Type: The type will appear after having synchronized. First fill in the other settings.

• Rip Node: Enter the FlexRip computer name.

• EskoLink Portnr.: Enter the port number of the Dispatcher's EskoLink queue.

• Fill out these fields before you click Synchronize with Rip. This may take a few seconds.

• Tab "Queue"

• Queue: A default name is proposed. This field automatically updates when you rename
the device.

• Queue Job Limit: A FlexRip's Dispatcher EskoLink queue can handle the expose
command of 2 jobs at the same time. If you want the Automation Engine Queue to allow
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sending 2 expose commands at the same time, then set the job limit of the Automation
Engine queue on 2.

Putting this job limit on 1 will result in each expose command to that EskoLink queue
being handled one by one: the second job will be ripped after the first one is completely
finished ("First In First Out" principle).

Note:  Having jobs RIP'ed faster on the FlexRip does not mean that your output device
can output them any earlier.

•

• Tab "Merge"

• Merge: Define if you want merge jobs on output.

• Unit. Select a unit for the below fields.

• Margin: Define an extra margin around the output.

• Gap: When merging, a gap adds an extra zone of empty pixels around each job.

• Minimum Fill: When merging, enter what percentage of minimum fill you want in the
output. No output is generated before this fill percentage is reached.

DCS

Select the item DCS below the item FlexRip - Screened Output and go to File >  New.

Note:  Don't forget to save your settings. Use File >  Save.

All options in the menu tabs are equal to those for other flavors. They are described in the
page FlexRip - Screened Output on page 186.

TIFF

Select the item TIFF below the item FlexRip - Screened Output and go to File >  New.

Note:  Don't forget to save your settings. Use File >  Save.

All options in the menu tabs are equal to those for other flavors. They are described in the
page FlexRip - Screened Output on page 186.

There is one exception for the TIFF flavor: The tab "Queue" offers this extra option:

• Optimize Expose Sequence: Select this to have all separations RIP'ed in one pass, which
normally leads to faster output. For some jobs however, this way of working results in
memory problems, when this happens, deselect this option so that all separations will be
RIP'ed separately (the RIP will be restarted after every separation).

PDF

Select the item PDF below the item FlexRip - Screened Output and go to File >  New.

Note:  Don't forget to save your settings. Use File >  Save.
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All options in the menu tabs are equal to those for other flavors. They are described in the
page FlexRip - Screened Output on page 186.

PS

Select the item PS below the item FlexRip - Screened Output and go to File >  New.

Note:  Don't forget to save your settings. Use File >  Save.

All options in the menu tabs are equal to those for other flavors. They are described in the
page FlexRip - Screened Output on page 186.

FlexRip - Unscreened Output

DCS

Select the item DCS below the item FlexRip - Unscreened Output and go to File >  New.

Note:  Don't forget to save your settings. Use File >  Save.

All options in the menu tabs are equal to those for other flavors. They are described in the
page FlexRip - Screened Output on page 186.

TIFF

Select the item TIFF below the item FlexRip - Unscreened Output and go to File >  New.

Note:  Don't forget to save your settings. Use File >  Save.

All options in the menu tabs are equal to those for other flavors. They are described in the
page FlexRip - Screened Output on page 186.

There is one exception for the TIFF flavor: The tab "Queue" offers this extra option:

• Optimize Expose Sequence: Select this to have all separations RIP'ed in one pass, which
normally leads to faster output. For some jobs however, this way of working results in
memory problems, when this happens, deselect this option so that all separations will be
RIP'ed separately (the RIP will be restarted after every separation).

PDF

Select the item PDF below the item FlexRip - Unscreened Output and go to File >  New.

Note:  Don't forget to save your settings. Use File >  Save.

All options in the menu tabs are equal to those for other flavors. They are described in the
page FlexRip - Screened Output on page 186.

PS

Select the item PS below the item FlexRip - Unscreened Output and go to File >  New.
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Note:  Don't forget to save your settings. Use File >  Save.

All options in the menu tabs are equal to those for other flavors. They are described in the
page FlexRip - Screened Output on page 186.

Gang Run Printing
These fields are relevant when you work with the Pilot's Gang Run Printing view.

• Output Folder: Define the folder where the substrate queues write their nested layout files.
These files are picked up from here as input files for the output workflow (specifically the
Export nested Layouts task). Normal use of the Gang Run Printing mode does not require you
to access these files.

Note:  We advise to clean up these temp data. This can easily done in your output workflow
ticket: See this example:
 

 

• The Custom Fields can be given specific names so that they can be used in the 'Extra' tab of
the Submit to Gang Run task. They then show up as extra columns in the Gang Run printing
view of a specific Substrate Queue.

• If you also confirm that a Custom Field can be Used as grouping key, the value of this field
will so help control which files are nested together. Typical attributes to base nesting groups
on are Customer, Printing Method, Finishing Method. Learn more about grouping keys in
Grouping Certain Graphics Together on page 879.

• Select Use the Customer field as grouping key if you want a system-wide setting for this
feature, in stead of having to control it per ticket of the Submit to Gang Run task.
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Global Vision

Concept

Following Automation Engine tasks use technology from the company Global Vision: Inspect
Artwork, Inspect Barcodes, Inspect Braille, Inspect Spelling and Inspect Text.

These tasks require a software license created by Global Vision. You can purchase various
subscription packages directly from Global Vision or choose to purchase one via Esko.
This configuration item guides you to get that license from Global Vision and activate it on
Automation Engine.

How to Request a License

To purchase, activate or check your Global Vision license, click Request License... and follow
the indicated steps.

Note:  The registration ID identifies your computer where the Global Vision License Server
was installed. This component of the Automation Engine is by default installed on the same
computer as the Automation Engine server software.

Global Vision uses this registration ID to generate your license key to run these tasks on
Automation Engine. This license key can only be activated on the same Automation Engine
server as the one you used to get your registration ID.

The website https://esko.globalvisioninc.com/ will ask you if you already purchased such a
license from Esko or if you want to purchase a subscription plan from Global Vision.

Note:  This online video describes this procedure (the case where someone purchased the
subscription plan from Esko).

About Remaining Days and Usage Count

When you have a license from Global Vision, the panel mentions a detailed status of this
license:

• It shows the number of used inspections and the maximum number of inspections that
can be run (without being charged extra).

Note:  An inspection is "used" each time a Global Vision inspection task has run. Only if the
task failed to run completely (for example the task ran out of available memory), this is not
counted as "used".

• When the number of used inspections is equal or higher than the maximum (licensed)
number of inspections:

• An active internet connection is required to be able to continue using the Global Vision
Inspection tasks without activating a new license, given that the current license is not
expired in time.

• The Automation Engine master server needs to be able to connect to http://
www.globalvisioninc.com/eskolicense/. Connecting through a proxy server is not
supported.
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• Global Vision then bills you the extra used inspections separately.
• When no active internet connection is available, any subsequently run Global Vision

Inspection tasks will fail.

• When you have annual licenses, the number of used inspections is reset each month.
• When you have a permanent license, this will be mentioned instead.

Note:  You can also request a new license when the license is not expired.

What to do when your Automation Engine Master Server (name) changes

We mentioned above that this license is based on the computer name of your Automation
Engine server.

In case of disaster recovery of your server, you might for example promote an Automation
Engine Assistant to become the new Automation Engine Master. If you need to do this, you
also need to activate the Global Vision license on the new Master.

Note:  Learn more about server Assistants in the Pre-Install IT Requirements Guide, specifically
the page on Components Glossary on page 1739.

Follow these steps to move your Global Vision license to the new Master server:

1. Activate the new Automation Engine server to start up its Global Vision License Server. Do
this in the Server Web page: Server Admin >  Status Overview >  Activate Server.

2. On that new server, request a new license as described above.
3. To deactivate the previous license, contact Global Vision support. They will also credit you for

the previous license.

Imaging Engines
This is where you configure any Imaging Engine RIPs.

Learn more in the chapter RIP'ing with Imaging Engine, in the page Imaging Engine Configuration
on page 1156.

Jobs

Tip:  Working with Automation Engine Jobs is documented in the dedicated chapter Jobs on
page 495.

Job Setup

You can here define the name of several Custom Fields.

When you enter names in custom fields 3 to 6, an extra tab Categorization will appear in the
Job Setup dialog box.

Note:  Think carefully about these names because changing their names later creates
confusing lists of values for these fields in existing Jobs.
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JDF Setup

This item allows to define default settings that are used when (new) Jobs are created via JDF/
JMF.

• Tab "Settings for JDF job creation"

• Job Name and Job Folder: Use SmartNames to define the name and folder of the
resulting Job.

• Apply Job Setup: This option allows to create a same job folder structure for each new
Job created via JDF. Select the option and click Select the Job of which you want to take
over its job folder structure.

You can also indicate what other items should be copied from that Job, apart from
the Folders. Select Tickets to also copy any (blue) Job tickets into the new Job. Select
Parameters to also copy those defined in the Job's setup tab 'Parameters'.
 

 

• Tab "Custom Fields"

This is where you can define how the data in the "Comment" JDF elements is used to
populate the custom fields (Categories) that appear in the Job Setup dialog.

To do this, type an XPath expression into the field corresponding to the category you want
to fill in automatically. To get some help, click Edit to open the XPath builder.
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Note:

• The JDF that was loaded in the XPath builder is remembered while the Configure dialog
is open.

• When editing the next XPath, the same JDF will be automatically used as the example
XML in the XPath builder.

 

 

XPath Builder

Concept

When you click Edit in any field that allows XPath Expressions, the XPath Builder opens.

The XPath Builder offers alternative starting points:

• The XPath is not resolved relative to the root node of the XML document, but from another
XML element.

• When a proper JDF is used as the example XML, a list of possible starting points is
generated.

• While the XPath builder automatically selects the appropriate starting point, it is still
possible to manually change the starting point by clicking on another node while holding
down Command (Mac) or CTRL (Windows).

Example

See an example where the XPath builder is used to create an XPath for a product part attribute:
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• The XPath builder automatically uses the first PageData node as starting point. This is
visualised by showing the content outside the PageData node in grey.

• It is still possible to select nodes outside the PageData node as result node or as predicate
node.

• When selecting nodes outside the PageData node, the XPath builder will create absolute
XPaths.

• When you want, you can modify these absolute paths by making them relative to the
PageData node using ../

Job Web Page

Concept
In the Pilot, you can right-click a job folder and select Go to Job Web Page. This opens an
internet browser and loads a predefined path (URL).

This is typically used to navigate from within an Automation Engine Job to its related
WebCenter project.
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Configuration

This is where you define the web Address for the Job Web Page. Obviously, it needs to be a
valid URL, so if you use SmartNames, make sure they resolve correctly.

This is the typical structure of such a URL to a WebCenter project:

• The first part of the URL is typically the name of your WebCenter web site. For example
http://MyWebCenterServer/WebCenter_Inst

• This is followed by /projdetails.jsp?projectName=

• You end with a SmartName that resolves as the name of the WebCenter project for that job.
For example: when the WebCenter project has the same name as the Job on Automation
Engine, then use [Job Name] .
 

 

Smart Job Location

Concept

A Smart Job Location uses rules and SmartNames to define the location of a Job’s job folder.
This avoids having to enter this path manually when creating Jobs.

There are three types of specifications that you can use to set up the Smart Job Location. You
can base the location on the Customer of that job, or on a custom Rule or you can specify
(only) the Container.

These three methods are checked in a specific order: If no path is found based on the
Customer, the set of custom rules will be checked. If there is still no valid path found for the
job folder, then the Container setting will be checked.

The dialogs 'New Job' and 'Job Setup' offer the option to Use the Smart Job Location Rules.
To see a preview of what the folder path will be, click on the button "Show Job Location" to
see how the current rules create the path for this job. An example:
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Configuration

We now have a closer look at the types of specifications:

• Customers:

• Rules:

• Container:

Tip:  Also when using JDF to create Jobs, it is possible to use the concept of Smart Job Location
as a SmartName for the indication of the folder for the Job in JDF: use <SJL\>.

Customers

You can here define a root location for all jobs of a specific customer. An example:

 

 

These settings also become part of the customer definition in Tools >  Customers. An
example:
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Rules

When no customer based setting was specified (or no valid location could be found), the
systems checks if you did set any custom Rules.

These rules are based on conditions that use Regular Expressions. Click the Help button for a
brief tutorial.

Here is an example where job folders are created in a specific root folder based on the number
in their job's Order ID:

 

 
 

 

Container

When the checks on Customers and Rules did not return a valid path for a job folder, then the
folder will be created in the here defined Container.
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Here are two main use cases for this setting:

• Use it as a "Default Job Location". When you request a Smart Job Location, we always advise
to at least here fill in a Container based location. This way, when none of the categories
Customers or Rules result in a location, the system will use this setting, and not use a
location that you can not control.

• This setting is useful when you have a system where you have all jobs created within one
Container (a share on a hard disk) until that share has no more free space. You then create
a next Container, change this setting to the new Container and you so use that one until it
also fills up, etc.

Nexus
This configuration is explained in the dedicated section on Integrating with Nexus (soon
outdated). Find a direct link here.

Notification
Notifications are messages sent by Automation Engine (E-mail, .XML or .TXT files).

Note:  For E-mail notifications, please check if the Send E-mail task is a better alternative.

The two tabs in this Configure item offer more advanced ways:

• Rules.

• Via File.

You can also use notification Templates to customize their content. Learn more in Notification
Templates.

Notification Rules

Instead of defining notifications per ticket, you can define general notification Rules. You can
set a notification rule for all or specific tasks or devices (queues).

You can define such rules for Tasks and for Devices.

For example:

• Writing an XML file every time a Milestone task ends.

• Writing an XML file of all actions on your CDI Compact device. Or have each notification
added to the main XML for that CDI.

Note:  Note that, for CDI and Kongsberg devices, the specific tools as described in their
dedicated chapters may be a better alternative.
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Attention:  When you set a notification for both a device and for a task using that
device, then only the one on task level will be executed.

Creating a Notification Rule

1. Click Add.

The Notification Rule Editor opens.

 

 
2. Define the rule:

• Condition

• Select one or multiple of the task statuses and select if this is the status of this single
task type or of the whole workflow that this task belongs to as a step.

• Action

• Then: Choose the type of notification.

Tip:  If you want multiple types, create multiple notification rules.

• E-mail: Choose if you send it to the one who launched the task or type in E-mail
address (when multiple, use a semicolon as separator). Select any attachments to
the E-mail.

Tip:  This is a good place to use SmartNames that pick up the E-mail address of the
job’s Customer Service Representative (Job setup) or any Customer contacts.

• XML file: Choose if you want a file per notification or if you want to add the
information to an already existing XML file. For example: Adding all notification
info related to a TIFF output device to one XML for each day (use SmartName
[date] in the name of the XML file).

In the output field, minimally enter a name (use SmartNames). You can also define
or browse to a specific folder to write the XML files into or you can leave this field
empty and make the system use the default place for these files as defined in the
next configuration item "Via File".
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• TXT file: Same options as for XML files, but now you can also use templates to add
custom text.

• Template: Templates add custom made texts. Learn more in Notification Templates on
page 200.

Note:  The "Templates" list and the "Edit Templates" button are only shown when at
least one template was created before.

3. Click OK to confirm and close.

Add more if you want to.

Via File

When setting up a notification rule that creates XML or TXT file, you can choose to not enter
any output folder for these files, but only specify their name (learn more here). In that case,
these files are written in the default place that you define in these tabs.

• Tab "Text"

• Append the message in a Log File: When you choose to add the notification
information to a same file. Browse to change its location and there create/select an
empty file.

• Create a new file per message in a folder: Define the folder where these notification
text files will be created.

• Tab "XML"

Same as for TEXT files, but you can also choose to include the tasks messages (that appear
in the task's "details") and the ticket parameters it used.

Notification Templates

A notification template can add custom text to the notification.

To create, modify or delete templates, click 'Edit Templates...' in the Notification Rule Editor.
Alternatively, go to Pilot >  Advanced >  Edit Notification Templates...

Learn more below in Edit Notification Templates.

Edit Notification Templates

Creating a template
1. Click Add.
2. The Add dialog pops up. Enter a name for the template. Click OK.
3. The Edit Template dialog pops up.

It has dedicated fields for Subject and Message, SmartName enabled.

The field for Task Information is best only changed on advise of Esko support. It includes
code-based conditional information that can include the attachments you requested while
creating the notification rule.
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Here is an example:
 

 

Tip:  You can also Edit Notification Templates in the Configure tool, provided that you
already have templates available: go to Configure >  Notification >  Rules > Task/Device  >
Add....

Odystar
This configuration is explained in the dedicated section on Integrating with Odystar (soon
outdated). Find a direct link here.

Proof Servers
This configuration is used to connect the Esko Proof Server which his required for

• the Proof for Contract Approval task (part of the Pack Proof product) . Learn more in the
user guide of Pack Proof, in the page on Pack Proof Configuration.

• the Proof for Content Approval task task (part of the Imaging Engine product). Learn more in
Imaging Engine Configuration on page 1156.

Plate Merger
This item is documented in the chapter Flexo CTP Workflow. Find a direct link here.

Preflight Tools
This item serves to link Automation Engine to external preflight server software that you can
then use in the Preflight via External Application task.
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Caution:  In AE v16, the task 'Preflight via External Application' was declared to become
'Soon Outdated'. Learn more about this concept and your alternative in Concept of
(Soon) Outdated Tasks on page 488.

Note:  When you want to use Enfocus PitStop, consider using the version that is built into
Automation Engine. This is done when you use the task Preflight with PitStop.

Important:

• This external preflight server software (for example a separate install of PitStop Server) has
to run on your Automation Engine server.

• You must share the folder containing the profiles (for example PitStop's C:\Program
Files\Enfocus\Enfocus PitStop Server 13) to be able to access it from the Preflight
ticket.

 

 

Tool Name: Select one of the supported preflight applications.

Report Language: Select the language you want the report to be in. For Enfocus PitStop
Server, you can set this in the PitStop Server preferences.

Report Units: Select the units to be used in the preflight report.

Report Type: Select the type of report: PDF, XML or both.

Executable File: Enter (browse to) the path to the preflight application's executable file.

Profile Folder: Enter (browse to) the path to the folder where the default profiles for the
selected preflight tool are stored.

Action Folder: Enter (browse to) the path to the folder where the action lists for the selected
preflight tool are stored. The Preflight task will allow you to select multiple actions from this
folder.

Printing Methods
Printing Methods are defined in the Configure tool. You get a list of standard names. You can
add custom ones.

You can set an ink to a specific printing method by using the Job setup's Inks tab or by using a
one of these tasks: Adjust PDF Screening, Extract Inks, Normalize PDF File, Normalize PS / PDF / AI
8.0 File, Optimize PDF Separations, Trap with PowerTrapper, RIP'ing with Imaging Engine.

202



6Automation Engine

For example:
 

 

These are typical examples of how to make use of a Printing Method:

• In your Imaging Engine (RIP) task for a flexo device, you select only the inks of printing
method 'flexo'.

• You make a special ReportMaker PDF that focusses on the 'ink' used for embossing. In your
workflow, you use the Extract Inks task to select the wanted ink type before you start the
ReportMaker task.

Processing Preferences
• PDF+ Processing

All PDF+ files require to have a document profile.

Note:  Learn about PDF+ files in PDF+ in Automation Engine on page 51.

• Default Document Profile:

When Automation Engine runs a task on a PDF+ file (one that uses the PDF Action List
Processor, see below), it will set the PDF+ file's document profile to the one selected
here.
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When the PDF+ file did not have a profile yet, it will be set to the one defined here.

When the PDF+ file already had another a profile, it will be changed to the one defined
here.

Note:  In Automation Engine, this is the only place where you can define this default
document profile for PDF+ files.

Note:  Tasks that set this document profile are those using the PDF Action List Processor
(PAL):

• The tasks Optimize PDF, Apply PDF Action List and Trap.

• The Step&Repeat Dynamic tasks set this profile if there is no profile in the one-ups. If
any input file has a profile, the first one is used.

• Any VDP expansion also adds this profile to the expanded data.

Learn more in Which AE task Uses which Technology? on page 64.

• Automatic Normalization

Tasks that require Normalized PDF files as input will automatically normalize any native PDF
you launch them on. This hidden and automatic normalization is using the here defined
task ticket.

By default, Automation Engine uses the Normalize PostScript/PDF/Illustrator 8.0 File task ticket
named "OnDemand".

From this ticket only the settings in the Color Management tab are taken into account.

All other settings of the automatic normalization are forced to fixed default settings. For
example, automatic normalization will always embed all images.

• Embedded Images

Normalized PDF files have the ability to save all their images internally, but this may result in
oversized files. You can define the maximum size for internal images here.

Images exceeding the defined size will be saved externally.

Products

Tip:  Automation Engine Products are documented in the dedicated chapter Products on page
548.

Product Setup
In the item Product Setup, you can name the custom fields that appear in the Product Setup
and in the Product Part Setup.
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Above example configuration results in this:
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JDF Setup

Note:  JDF workflows are not documented in this user manual. Learn more about the basics
of JDF in the chapter Integrating with External Systems on page 1553. For more information,
contact Esko Solution Services.

General

When you work with JDF, decide here if you want to Enable automatic product creation via
JDF.

Data Zone

Note:  The Data Zone concept is documented in Products Data Structure on page 553.

 

 

• Create Data Zone and File when a new Product Part is created from JDF:

• Data Zone: When the JDF references a non-existing product part, define here where to
create the data zone for that product part (the physical folder containing the part's file).

• File: When the JDF references a non-existing product part, define here where to create
the subfolder and/or file in the data zone.

• Apply Data Zone Structure: Use this option when you want to add a specific substructure
to the data zone. Browse to an example data zone (folder with subfolders).

Product (Part) Setup
In the Product Setup and Part Setup tabs, you can add rules to map values from the JDF onto
the attributes of the products that the JDF creates.

To do this, type an XPath expression into the field for each attribute that should be overruled
by the system value, or click Edit to open the XPath builder.
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Note:

• The JDF that was loaded in the XPath builder is remembered while the Configure dialog is
open.

• When editing the next XPath, the same JDF will automatically be used as the example XML in
the XPath builder.

Learn more about using XPath in XPath Builder on page 193.

 

 

Updating
In the Updating tab, indicate what should happen when an existing product is updated over
JDF.

 

 

Learn more about updating products in The Add to Products task on page 580.

XPath Builder

Concept

When you click Edit in any field that allows XPath Expressions, the XPath Builder opens.

The XPath Builder offers alternative starting points:

• The XPath is not resolved relative to the root node of the XML document, but from another
XML element.
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• When a proper JDF is used as the example XML, a list of possible starting points is
generated.

• While the XPath builder automatically selects the appropriate starting point, it is still
possible to manually change the starting point by clicking on another node while holding
down Command (Mac) or CTRL (Windows).

Example

See an example where the XPath builder is used to create an XPath for a product part attribute:
 

 

• The XPath builder automatically uses the first PageData node as starting point. This is
visualised by showing the content outside the PageData node in grey.

• It is still possible to select nodes outside the PageData node as result node or as predicate
node.

• When selecting nodes outside the PageData node, the XPath builder will create absolute
XPaths.

• When you want, you can modify these absolute paths by making them relative to the
PageData node using ../

Smart Product Location
Smart Product Location allows to automatically decide the location for a new product based on
a set of rules defined in Configure >  Products >  Smart Product Location.
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Learn more about creating products in Creating Products and about their file location settings in
Product (Part) Properties on page 566.

Important:  You do not need this tool when your file is already in the right place when you
make it a product part.

Three Ways to Decide the Location
You can use three kinds of specifications to set up the Smart Product Location: based on
Customers, on custom Rules and on a chosen Container.

These three ways are checked in a specific order: if the Customers check does not return
an valid path, then Rules will be checked. If this still does not return a valid path, then the
Container rule will be used.

• Customers: This rule allows to specify per customer a SmartName based path where all its
products will be created.

• Rules: This tab allows to set extensive conditional rules. For example you could create all
the products in a structure based on their [custom field 1]. You can create several rules
and they will be checked from top to bottom.

• Container: This tab allows to set a smart path in a fixed Container where all products will
be created (from now on). For example: All products are created in Container Data1 and
when the disk of that Container is full, you change the configuration so that from now all
new products will be created in Container Data2.

Using the Smart Product Location

Smart Product Location is used in these cases:

• When choosing Uploading As a New Product on page 571. This feature is used for example
when your product data is still on a CD or on your desktop.

• When creating products via JDF or when placing products via JDF (a product part URL is
already decided but 'empty' and the JDF then delivers the file to the URL that expects the
file).

When Uploading a File as a Product, the panel shows the extra Smart Product Location tool at
the bottom:
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Click Show Product Location to see a preview of where the uploaded file will be placed. An
example:
 

 

Product Part Data Zone

Note:  Learn about the concept of Data Zone and see some examples in Products Data
Structure on page 553.

Every product part has a data zone. It contains the product part file itself and any additional
related files.

When you look at a product's data zone in the Pilot, the depth of the data zone indicates
the number of folders that you will see between the root of the data zone and the folder
containing the actual product part file.
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The Default Depth value that you enter here is used when you create or change the product
part properties.

SAP Servers
Configuring an SAP server is required when integrating with such a system. Learn more in
Interact with SAP task on page 1630.

SFTP sites
SFTP sites are used in the Upload via SFTP task and also by an SFTP Access Point. Learn more
about SFTP in the documentation pages of those tools or in this online article describing the
difference between FTPS and SFTP .

To configure an SFTP site (an SSH server), open the Configure tool, select the topic SFTP Sites
and choose File >  New. A default name appears, click and wait to change it. It is good practise
to add both the host server and the user in the name.

Settings
• Server: The name of the SFTP server.

• User Name: The name of the user logging in to that SFTP server.

• Authenticating with an SFTP server requires a valid SSH account (username@host) and one
or both of these authentication methods:

• a valid password
• a pair of public-private key files, as generated by an SHH-keygen tool.

An SHH private key authentication enables a higher level of security (it for example
avoids bots trying out all user/passwords). These keys come in pairs, a public and a
private key.

Note:  In the rare case where the SFTP server was set to accept both types of
authentication, you can enter both a password and a private key. The system then first
checks the password method, and when that fails, it tries the keys.

• When using a password, enter the password.

• When (also) using a Private Key, use Select... to upload the private SSH key file into the
Automation Engine database. Optionally, fill in the Passphrase (to be able to unlock the
key).
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Note:  When the public-private key pair authentication is used, the public key must be
added to the authorized keys of the SFTP server and the private key must be selected in
this configure tool.

Clear serves to remove a prior selected key from the Automation Engine database.

• Test Connection. Always test before saving this configuration.

Secure Web Proxy
Learn about using web proxy settings in the page on the item Web Proxy.

This item is where you add proxy settings when the communication is https (not http).

Scripts
This dedicated chapter about Scripting explains how Automation Engine can run custom scripts
and so help automate desktop applications.

Learn more about its configuration in this page on configuring the Script Runner tool.

Shuttle
 

 

Enter the Port to use for communication between your Automation Engine server and the
Shuttle clients.

Note:  By default this is port 5182, but if this port is already used by other processes, you
should enter the next available port.

Click  to define the Upload Folder. This is where Shuttle clients will upload files that are not
located in a Container.
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Attention:  However you use Shuttle, it is mandatory to specify an upload folder! If not
you might get this error:

The spool folder does not exist on the server.

Note:  The upload folder must be located in a Container.

• Select Start Shuttle server automatically when Automation Engine is started if you
plan to make frequent use of the Shuttle technology.

• Select Use the task history to re-launch tasks using the same public parameters if you
want Shuttle to remember the public parameter values that were used when submitting a
file. If you then re-submit that file, these values will be automatically filled out.

Click the Start button to start Shuttle server. This is not required to use the Shuttle application.
However, starting the server is required to use Shuttle via applications like ArtPro, PackEdge
and Illustrator. Shuttle server makes Automation Engine’s workflows, tasks and files accessible
to the Shuttle clients.

Save the settings by clicking File > Save.

Shuttle Server Status
This shows whether the Shuttle server is running and how many tasks it manages.

Track Edit Session
When you open a file that resides in an active Job (folder) in an Esko editor, the Track Edit
Session task can automatically start logging times and several editing actions. This tracking
stops when the file is closed.

You can here select for which editors you want to (automatically) run this task.

Learn more in the page about the Track Edit Session task.

Note:  When changing this configuration, restart the editor to activate this behavior.

Viewer

Note:  Learn about the Viewer in The Automation Engine Viewer.

The Viewer can view many different file formats. It can also use different graphic engines
to interpret these files. The use of a different graphic engine may lead to small differences
in color. You here define which graphic engine the viewer should use and some other
preferences.

Learn more about graphic engines in the chapter PDF Formats and Metadata on page 43.
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• View PDF Files

• As in ArtPro+: By default, PDF files are shown as they are shown in ArtPro+. This means
that the graphic engine of ArtPro+ interprets the PDF and defines the view data.

This view mode can be used for native PDF (which includes PDF+), normalized PDF, Plato
Step & Repeat PDF and Plato Station files.

• As in PackEdge: Select this mode when you want the Viewer to show the data as you are
used to seeing them in PackEdge, where the default file format is normalized PDF.

Then also define which normalization ticket will be used when you open non-normalized
files like native PDF(+), AI or (E)PS files.

Note:  When this was your choice before upgrading to a new version, it will of course be
kept.

• View ArtPro Files

• As in ArtPro: The graphic engine of ArtPro is used. This mode is advised for ArtPro users
who do not work with normalized PDF files in their workflow.

• As in PackEdge: The graphic engine BRIX is used. This mode adds a normalization step
before the view data is created. It is advised when you want to compare ArtPro files with
normalized PDF files. Some users will prefer this mode because it was used in earlier
versions. Before version 14.1 of Automation Engine, this was the default mode.

Note:  The WebCenter Viewer and the Publish to WebCenter task always use this mode
for ArtPro files.

External Images: Select the ticket of the task Export ArtPro to Normalized PDF that has
the correct settings so that the Viewer finds the external images in that ArtPro file.
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• Viewing Preferences

• Anti-aliasing: Select this to smooth the staircase effect that you can get when pixels
represent line art objects.

• Merge similar inks: Select this to merge inks with the same name that have a different
ruling or angle. They then appear as one same channel in the Viewer.

Attention:  We strongly advise to enable this option when viewing ArtPro files or
Normalized PDF files generated by ArtPro.

• Speed up for Viewing:

Choose the ticket that the "Speed up for Viewing" folders should use. Learn more in Speed
Up For Viewing on page 1006.

Web Proxy
For tools where Automation Engine uses http communication, you can here configure details
of the Web Proxy to use.

• Web Proxy Server: Specify the computer name or IP address and port of the proxy server.

• Proxy server requires a password: When the proxy server requires authentication, specify
the User Name and Password to use to authenticate.

• Bypass proxy settings: Specify a list of patterns separated by '|', The patterns may start or
end with a '*' for wildcards.

Attention:  You need to restart Automation Engine before its tools start to use the web
proxy for http communication.

These Automation Engine tools use web proxy settings for http communication:

• Tasks: Create or Modify WebCenter Project, Download WebCenter Document, Integrate with
WebCenter, Publish on WebCenter, Interact with Web Service.

• Cloud applications and storage tools, configured in External Web Services on page 177.

• Connection Doctor, to troubleshoot the server.

• In the Server Web page - Server Admin - Server Checks - Network , the Online help check and
the WebCenter Sites check.

• Automation Engine's JDF Server (JMF), used to communicate with devices and external
systems.

WebCenter Sites
Go to Tools >  Configure >  WebCenter Sites to configure links from Automation Engine to
WebCenter sites.
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Website:

Specify the web address of the WebCenter site. After you entered the WebCenter address,
click Open... to check if the WebCenter site is up and running. If you are redirected to the login
page, it means that the address is correct and that the site is up and running.

Tip:  Be aware that this address is also the address that will be included in the notification
e-mails when adding links to documents (approval cycle start E-mail). You should therefore
make sure that the address can be accessed from the outside. Make sure to not use an internal
address, but one that you want your (external) users to use when they use WebCenter.

WebCenter and Automation Engine are in the same LAN

Select this toggle if this is true. This will most likely be the case. Deselect this toggle if
WebCenter and Automation Engine are not in the same LAN.

Note:  How can you verify if these two systems are in the same LAN? They are in the same LAN
when you can connect from WebCenter’s application server, this is the system where JBOSS is
installed, to an Automation Engine Job Folder with the credentials of the System Account (by
default the user BGSYSTEM or the one you changed it to, using the System Account page in the
Server Web page).

WebCenter's Approval Client:

If WebCenter and Automation Engine are not in the same LAN, you first need to create an
Automation Engine Approval Client in WebCenter. This is necessary to give Automation
Engine permissions to listen to the approval messages that are stored in WebCenter.

216



6Automation Engine

Tip:  If the Approval Client does not exist yet, follow these steps:

1. In WebCenter, log in as Administrator.
2. Go to the Admin section. In Configurations, select Workflow and Tunnel Approval

Clients.
3. Click the link “New Workflow and Tunnel Approval Client".
4. Enter a User name and a Password for the Automation Engine client. Mind that this is also

the user name and password that have to be entered when configuring the WebCenter site
in Automation Engine.

Fill out the client Name and Password and click the Check Connection button. This will check
if the user can log on successfully.

The Info button displays the following information: ”In case Automation Engine and WebCenter
are not in the same local area network (LAN), the retrieval of the approval results is secured by a
name and password. The name and password specified in Automation Engine must match the name
and password specified in WebCenter by the WebCenter administrator. When clicking the 'Check'
button, the WebCenter version will be checked and the name and password will be validated by
WebCenter.”

Check Connection

When you click this button, you should, after a few seconds, get a window saying “Check OK".
The software version of that WebCenter will also be mentioned.

Note:  The button will check the validity of the user name or password to connect to that
WebCenter but not of your WebCenter’s Approval Client.

Note:  Passwords are encrypted.

Note:  When you connect to a secured WebCenter site (for example one that uses HTTPS://),
then you have to export its security certificate and import it on the Automation Engine server.
If this is not done, publishing from Automation Engine to WebCenter will result in an error.
Learn more on how to do this in the chapter Install SSL Certificates on the Workflow
Production Server of the WebCenter documentation.

Tip:  After configuring a new WebCenter site, it is recommended to close your Pilot and start it
again in order to see the updated list of WebCenter sites in your tickets.

6.10.15.  Connection Doctor

The Connection Doctor allows you to troubleshoot the Pilot. This is documented in the
dedicated chapter Troubleshooting on page 1803.
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7.  Tasks and Workflow Controls
This overview is a full (alphabetical) list and description of all available Tasks and Workflow
Controls. Some of these tasks and tools are optional.

Some of the items refer to another page where they are documented as part of a dedicated
chapter related to that technology.

At the end of this complete list, you can learn more about the Outdated and Soon Outdated
Tasks in v18.1.

7.1.  Add Dynamic Marks

Concept
Use this task to apply marks from a pre-defined Set of Dynamic Marks to the input PDF file.
These type of marks are created using the Dynamic Marks plug-in for Adobe Illustrator or in
ArtPro+.

This task produces a native PDF. This PDF does contain all the information from the input file
(for example object based screening).

Note:  In workflows where you need a normalized PDF in the steps after this Add Dynamic
Marks task, you can add the Normalize PostScript / PDF / Illustrator file task to the
workflow. If you use this extra task, then make sure that the option 'Use rulings, angles and
dot gain compensation from file' is selected (in the Inks tab) to preserve the screening
parameters.

Task Settings
 

 

• Replace existing marks: Select this to remove existing marks from the input file while
adding the new mark set.
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Note:  When selected, this will also remove marks that are unknown or from a too old or
too new version.

When you want to set the value via a SmartName, this option will be enabled when the
resolved value starts with a 'Y' or 'y' or '1'. Any other starting character will resolve to
disabling this option.

• Optimize output: This option can be used when PDF+ marks or grids are used. It has less
effect when DMK marks from DeskPack are used. The optimization is both in speed and
size, so most valid for VDP jobs.

• When enabled, the task evaluates the marks only once and copy them to all pages. Both
grids and marks (all types) are stored as dead objects. This is the default value.

This option was formerly named "Calculate once and copy (faster)”.

• When disabled, the task reevaluates the marks on each page independently and tries
to keep marks and grids as live objects. This means that when you open the output
in ArtPro+, the marks and grids are live objects, you see their properties and you can
modify them.

However, this only works for mark types that are ArtPro+ compatible, so not with DMK
mark sets made in DeskPack. Therefore, if your SRT template contains DeskPack marks
or if you have added DeskPack marks then the marks are re-evaluated on each page but
they will be dead objects in the output.

This option was formerly named "Calculate for each page (more accurate)”.

• Mark Set: In this table, you define which mark set you Add To which pages. Learn more
about adding mark sets below.

Adding Mark Sets

• Click Add and specify the Mark Set. Select it from the list, or type its name or use
SmartNames.

The list will show

• DMK files, normalized marks from DeskPack
• PDF files with PDF+ marks, created in ArtPro+.

Note:  A combination of these mark types is also supported (but not recommended).

In 'Add To': Specify on what page(s) the mark set should be applied: All, Even , Odd, First or
Last page.
 

 

• Use the buttons Remove and Edit to further manage this table.
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7.2.  Add Ink Eaters
Ink Eaters help to achieve a constant ink consumption over the width of the plate. This makes
it easier for press operators to set the ink keys, and results in a faster setup time for the press.

Ink Eaters are typically added to non-printed areas outside the printing job. These areas can be
left-overs that will be cut off or the white spaces next to or even in between the one-ups.

Ink Eaters help to avoid excess ink build-up by stabilizing "peaks" and "lows" in the ink key
histogram. This prevents spilling of excess ink onto the printed zones of the actual printing
job. You can flatten the ink key histogram by filling non-printed zones with a gradient. A
gradient helps to avoid hard edges in the compensation object. You can specify a minimum
ink density and a minimum ink key value. You can request warnings when the maximum Total
Area Coverage (TAC) is too high. These areas are then compensated (filled with ink) depending
on the strategy settings.

 

 
The task settings allow you to determine where the ink eater areas should be and with what
they should be filled:

Ink Eaters tab
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• Ink Eaters Areas

• Fill Named Objects: Type in the name of the Named Object as you defined it in Esko
Plato for example.

• Create Ink Eater Areas: Specify the start and end of the areas:

• Start from Station's

• Die Shape: Select this to start from a die shape (for example pre-defined in Plato).

• Trim Box or Media Box: Select this to start from the Trim or Media Box of the one-
up on the plate. Media Box is larger and it contains the Trim Box.

• Die Annotation: Select this to start from the object that was marked as a die (for
example in Plato).

• End at: Specify what should be used as the end of the area.

• Keep Away field: Fill in a distance to set an offset for the Ink Eater object in relation
to the die shape or Trim Box.

• Select Exclude SmartMarks if you want to exclude SmartMarks from the Ink Eater
object.

• Scan Ink Coverage:

When you selected a contour object or a group of objects for ink coverage, select one of
these options:

• Scan: Specify what area needs to be scanned:
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• All Inside Sheet (Sheet View): To scan within the sheet and exclude objects outside
the sheet.

• All Inside Plate (Sheet View): To scan all objects on the sheet and plate. Objects that
extend the plate area or are outside the plate are not included.

• Direction: This is the scanning direction. Horizontal means that the ink zones are
vertical on the plate and the ink histogram is on the horizontal base of the document.
The direction of the compensation gradient in the ink eater area is horizontal.

• Resolution: This defines the number of intermediate steps of the gradient to be used as
compensation. Use Very Low for 5 steps, Low for 15 steps, Medium for 30 steps, High
for 45 steps and Very High for 60 steps.

Note:

You can achieve global compensation by defining a low resolution value (for example 5
gradient steps). This gives a very smooth compensation gradient along the length of the
press. The ink histogram zones are then very wide.

You can achieve very local compensation by defining a high resolution value (for
example 60 gradient steps). This results in a gradient with more banding.

• Ink Density

• Compensation

• Strategy and Range: This defines how the Ink Eater areas should be filled.

• Economic: This minimizes the use of ink.

• Intermediate: This optimizes ink use to result in a medium performance in print..

• Best performance: This maximizes the use of ink to give the best print performance.

• Minimum Ink Density: Select this option to define a minimum density.

• Minimum Ink key Value: Select this option to define a minimum ink key value for the
ink eater area. The ink density of the gradient will be adjusted to make sure the ink key
value is higher than this setting.

• Maximum Total Area Coverage: Select this option to define a maximum total area
coverage (for example 270%). You will then get warnings when in those areas of the
histogram where the total ink coverage exceeds this limit.

Inks tab

• Select Non-process, Opaque and/or Varnish inks if you want to Exclude them from being
used in the ink eaters. .

• Select Keep similar inks in their original separations to keep the original separations in
the output file.
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7.3.  Add Marks to Imposition

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.4.  Add Margins to LEN File

This task is documented in the chapter Flexo CTP Workflow on page 1340. Find a direct link
here.

7.5.  Add SmartMarks

Add SmartMarks
This task applies a set of SmartMarks to a PDF file. A SmartMark set is a group of marks that
can be created in PackEdge, Plato or i-cut Layout. Learn more about creating them in the user
manuals of these editors.

 

 

Your input file may already have SmartMarks. You first need to decide what to do with those:

• Add to current set: This merges the new SmartMark set with any already present
SmartMark sets.

• Replace current set: This replaces any already present SmartMark sets.
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Note:

• Since only a normalized PDF file can contain SmartMarks, Replace current set is not
relevant for native PDF files.

• When applying a SmartMark set on a native PDF file, the task output file will also be a native
PDF. Any applied SmartMark set will be converted into normal PDF objects. Learn more
about native and Normalized PDFs in File Types and How they are Recognized on page 35.

Load on all Pages: This loads the selected SmartMark set on all pages of a multi page input
file.

Load different set on even pages: This loads a different SmartMark set on the even pages
of a multi-page input file. For example on the backside of a layout. When selected, define the
name of the extra set.

Load Mark Set in bottom Layer: This allows you to choose if the marks should be applied on
top of the graphics or if the graphics should be on top of the marks.

Fit Margins: Depending on the setup of your SmartMark set, marks can be (partially)
positioned outside the PDF’s Media Box. Select this option to extend the Media Box to all visible
content outside the Trim Box.

7.6.  Add to Pages View

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.7.  Add To Products

This task is documented in the chapter Products on page 548. Find a direct link here.

7.8.  Adjust PDF Screening
This task serves to apply rule-based modifications of screening parameters. One rule could
be enough to accommodate various specific requirements, but if needed you can add an
elaborate set of rules (see an example below).

You can preview the Separation Details when a file is selected. This will display the results for
the specified set of rules in the current file.

Some example applications:

• You can also criteria like Ink Book, Printing Method or Ink Type. For example: when the
printing method is flexo, set the Dot shape to "F".

• Or use SmartNames. For example: if the ink name is "Cyan", "Magenta", "Yellow" or
"Black", set Dot shape to [mydotshape] .

• A more elaborate example when using Object Based Screening: when the name is "Cyan"
and angle is between "0" and "45", then set the angle to "30" and Dot shape to "R".
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Note:  In native PDF, the screening parameter 'DotShape' does not exist. Instead there
is a 'SpotFunction Name', which can have a limited number of values like SimpleDot,
Ellipse, or Square which are mapped to the Esko dot shapes "C", "E", "S" respectively. Other
SpotFunctionName values are mapped to "C".

When reading Native PDF fIles, the task Normalize PostScript / PDF / Illustrator File does
not take account of the DotShapes (SpotFunction Name) values. You need to adjust the PDF
Screening parameters during or after normalization.

1. Click Add to define a rule.
 

 
2. Enter a Name  for the rule. For example the name of the ink that you here adjust.
3. Select 'Apply rule to all separations' when this is what you want.
4. Define a condition under 'If separation matches'. You can choose from Ink name, Ink

book, Ink type, Printing method, Ruling, Angle and Dot shape. Set the condition and
enter a related text in the field. Click  to pick a separation name from those found in the
input file. If needed, add more criteria by clicking on '+'.

Note:  Setting up these rules is very similar to creating filters in Views. Learn more in Using
Filters and Creating Smart Views on page 129.

5. Define what you want to adjust in 'Apply separation settings'. You can specify Ruling,
Angle and/or Dot shape.

6. Click OK.
7. Repeat steps 1-6 to add more rules.
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Rules are applied from top to bottom. When a separation was already handled by a rule, it
will not be handled again by a lower set rule. In above example screenshot, the rule "<all
separations>" will only be applied to all other separations that were not handled by any rule
set above.

When an input file was selected, you can click Preview to see what the above rules will
result in.

8. Click OK  to save the ticket.

7.9.  Apply ArtPro Action List

This task is documented in the dedicated chapter ArtPro automation using ArtPro Action Lists on
page 831. Find a direct link here.

7.10.  Apply PDF Action List

Concept

This task executes a PDF Action List on PDF files. The PDF Action Lists (*.pal files) are created
in Esko ArtPro+. This allows to automate a linear series of functions that you would otherwise
execute within ArtPro+.

The actions are done on a selection of the objects in the PDF. This could be all objects (default)
or a specific subset. When the action is done, the selection contains the objects that were
modified by the action.
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Learn all about creating PDF Action List files in the documentation of ArtPro+.

Important:  Always test the action list in ArtPro+ first before running it as a task on the server.

Task Settings

• Action List: Click  and select an Action List. Or define one via a SmartName. In the UI of
ArtPro+, these are called Server Action Lists.

Note:  The server action list files (*.pal) need to be in the folder \\<Name-of-AE-Server>
\bg_data_custom_v010\dat\PDF Action Lists .

• Options: When the Action List contains 'Action List Parameters', they will show up here
as options and you can change their value. Such parameters are added in Esko ArtPro+ .

• Description: This shows the user and the software version that created this .pal file. A
later version of ArtPro+ will allow you to add other info.

• Apply on Pages: Leave this empty to have the action list applied on all pages.

Extra Output Pin

When used in a workflow, this task provides an extra output pin named 'Extra'. This is where
extra output files will appear.

Currently, only the action Extract embedded images places the extracted images on that
separate output pin. This allows to collect these image files for any further processing.

About Types and Units

In the Options panel, when you type in values for the Action List Parameters, it is important to
know which type that parameter is and which unit will be used.

Each Action List Parameter has a type. This type is defined by ArtPro+, based on where the
parameter is used. There are several parameter types:

• Text: Can for example be used to define the name of a layer or separation. Any UTF-8 string
can be used in this type.

• Number Without Unit: Can for example be used to define the miter limit of a stroke.

• Number With Unit: Can be used to define distance, size, resolution, angle or percentage.

Different parameter types use different units:

Table: Defaults Units in Action List Parameters

Length Millimeters

Stroke Millimeters (represents stroke width)

Font Points (represents font size)

Area Square Millimeters

Resolution Pixels per Inch
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Percent Float number where 100.0 means 100 %

Count Whole number without a unit

Number Float number without a unit

Angle Degrees CW

String A string (no units)

When you want to use a different unit, type it in as well. Press 'Tab' to see its conversion to the
default unit immediately.

When using a SmartName, it has to resolve in:

• either in a value without units, then the default will be taken.
• or in a value that also specifies the units, for example: "4.5 in".

7.11.  Apply Creep

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.12.  Apply PantoneLIVE Condition

Concept

Important:  This task requires you to be familiar with PantoneLIVE. PantoneLIVE ink books
are ink books that take into account on what substrate an ink will be printed on. These books
are stored in the cloud. Learn more in the user guide of the Color Engine Pilot (chapter 'Inks').

This task replaces all Pantone inks in the file with inks from the selected PantoneLIVE
Dependent Standard Condition (that you already downloaded). Only the ink name and ink
book changes. Other ink settings (ruling, angle, dot shape, ink type and printing method) are
not changed.

Note:  This kind of ink mapping is what users of PantoneLIVE do interactively in Esko PackEdge.
This task may be a more productive way.

See this figure showing several inks of the identity 120 :
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Possible Mappings

This task can change

• any Pantone (or PantoneLIVE Master) ink to the corresponding ink in the selected target
'Dependent Standard'.

• any PantoneLIVE Dependent Standard ink to the corresponding ink in the (other) target
dependent standard.

Note:  If the input file contains a PantoneLIVE dependent ink and a Pantone (or
PantoneLIVE master) ink with the same identity (for example P307C FSGB and PANTONE
307 C), and if the dependent standard of the ink in the file corresponds with the target
dependent standard, then both inks will be merged (in our example they are merged to
P307C FSGB).

Attention:  This task does not change:

• any non Pantone inks found in the input file
• any CMYK process inks found in the input file.

7.13.  Archive Job

This task is documented in the separate chapter about Jobs. Find a direct link here.
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7.14.  Assign PDF Pages to RunList

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.15.  Calculate Ink Key Settings (InkPlanner)
This task creates CIP3 files (mainly PPF) which contain all necessary data for the printing and
further processing of a job.

Attention:  This task is valid when you RIP'ed files using an Esko FlexRip. If you are
using Esko Imaging Engine, use the task Calculate Ink Key Settings (CIP3) on page 1317.

Note:  This InkPlanner ticket cannot be launched separately. It always needs to be part of
a 'task chain' preceded by an Expose to FlexRip ticket. It cannot be connected to Proof or
Approval tickets.

Select the Plate Setting File (*.ini), which contains specific information for the CIP3 generation,
like image position, rotation, compensation, etc.

Select the Press Configuration File (*.dat), which contains data about the press and the
InkPlanner output.

Note:  Both above mentioned file types are created using the CIPress Setup tool (installed
with FlexRip).

The name entered in the Output File Name will be used for making files created by
InkPlanner. This InkPlanner output will be stored in the 'output directory' that was specified in
the 'Press Configuration File' (*.dat).

Page Side: select Automatic, Front or Back.

Note:  The option selected here has priority over the page side option selected in the 'Plate
Settings' file.

Tip:  In case of an imposition file, select Automatic. This will process the page side settings
typical of the imposition file.

CIP3

These fields enter administrative data in the output file. This information is used further
processing CIP3 files.

• JobName: (required) If nothing is specified, the default job name will be used.

• SheetName: (optional)

• JobCode: (optional) is the code used for the job identification.

• Make: (optional) refers to the make of expose device.
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• Artist: (optional) refers to the person who created the sheet.
• Customer: (optional) refers to the target customer.
• Software: (optional) refers to the software used to create the sheet.
• Paper Weight: (optional) the weight of the paper to be used.
• Paper Thickness: (optional) the thickness of the paper to be used.
• Paper Grade: (optional) the grade of the paper to be used.

Note:  If you do not enter anything in these CIP3 fields, the corresponding input fields in the
'CIP3' tab of the 'Plate Settings' tab in the 'CIPress Setup' tool will be checked.

7.16.  Change Imposition Layout

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.17.  Check Dynamic VDP Database

Concept
This task validates a VDP database before running the Expand Dynamic VDP Data task.
Although the same checks are done as in the Expand Dynamic VDP task, this Check Dynamic
VDP Database task faster because it does not generate any output.

This task analyzes all entries from the database using rules stored in Variable Data Template
(VDT file).

Note:  When used in a workflow and the check succeeds, the task will produce a database
CSV file which can be used as input for the next workflow step. When the check fails, the task
delivers a report file listing the detected issues.

This task requires

• a CSV file as input
• a VDT file as mandatory parameter.

Task Settings
• CSV File Encoding: Specify the wanted character encoding. The default encoding is UTF-8.

This is also the recommended encoding.
• Field Separator: Let the task Detect automatically or choose , (Comma), ; (Semicolon),

Space or Tab.
• Empty lines: Choose what needs to happen with empty lines in the input CSV file. Only lines

ending with CR, LF or CR LF can be detected as an empty line (it is possible to mix different
line endings in a single file). All empty lines at the end of the file are skipped.

• Field Names: Field names map data chunks from the database entry to its corresponding
VDP template items. Choose from:

• From CSV File: When selected, the task will extract Field Names from the first record of
the CSV file by default.
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Attention:  Field Names can only contain the following characters: lower- or
upper-case ASCII letters ("a-z, A-Z"), digits ("0-9") or underscore ("_").

• From Header File: When selected, define a Header File that contains the Field Names.
Such a file

• should contain a single line specifying the Field Names

• should have a Field Name corresponding to each column in the CSV file.

• and the CSV file must use the same delimiter and encoding.

• Template: browse to the Variable Data Template file that contains the rules to check
the database validity. Such a template is created and exported using the Dynamic VDP
DeskPack Plug-in for Adobe Illustrator.

7.18.  Check Job Parameters

This task is documented in the chapter dedicated to Jobs on page 495. Find a direct link here.

7.19.  Check Print Rules (PRC)

This task is documented in the chapter Quality Control tools. See Check Print Rules (PRC) on page
1090.

7.20.  Check Product Parameters

This task is documented in the chapter Products on page 548. Find a direct link here.

7.21.  Check Technical Inks
This task checks if the input file (Normalized PDF, PDF or Plato File) or any of its external
references contains objects that have a technical ink set in knockout.

When it finds such objects, the task allows you to decide if it then should fail or only end with a
warning.

Learn more in the chapter How to?, on the page How to Work with Technical Inks  on page 1732.

7.22.  Compare PDF

This task is documented in the chapter Quality Control tools. See Compare PDF on page 1090.
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7.23.  Convert CMYK Colors

This old technology is still supported but no longer commercially available.

Please find its documentation in the manual of Automation Engine 14.1 or older  (as part of the
Reference Guide).

7.24.  Convert Colors for Digital Printing

This task is documented in the chapter Digital Printing Workflow  on page 1429. Find a direct
link here.

7.25.  Convert Colors with Equinox
You can use this task to convert PDF files’ colors using Equinox.

Equinox is Esko's award winning expanded gamut printing solution. Expanded gamut printing
is using a standardized set of 5, 6 or 7 inks for printing, instead of CMYK plus different spot
colors for each print job.

Equinox functionality is available in Automation Engine, ArtPro, PackEdge, the Color Engine Pilot
and as a plug-in for Adobe Photoshop.

Learn more in the Equinox user manual.

Use Cases
Use this task to convert your file's colors to prepare for expanded gamut printing, especially in
these cases:

• You don't have ArtPro or PackEdge and you work with regular (native) PDF files.

With this task, you don't need to convert your file to an ArtPro file or a Normalized PDF file
before conversion, but you can get the same results as if you did.

• You do have ArtPro or PackEdge, but you want to automate the conversion.

You can, for example:

1. Set up an Equinox color strategy in the Color Engine Pilot (see the Color Engine Pilot
documentation for details).

2. Use that color strategy to experiment with Equinox conversion in ArtPro or PackEdge,
and make small adjustments to the conversion until it is exactly the way you want it.

3. Then use the adjusted color strategy in this Convert Colors with Equinox task to
automate the conversion of all your file's variants or "SKUs" (Stock Keeping Units), for
example for different languages, sizes, flavors...

This task takes both PDF and Normalized PDF files as input. When working with regular PDFs, it
will automatically normalize them using the Normalize ticket that is selected in the Configure
tool's Processing Preferences.

233

https://www.esko.com/en/Support/Product?id=Automation%20Engine&ver=14.1
https://www.esko.com/products/equinox
http://www.esko.com/en/products/overview/artpro/overview/
http://www.esko.com/en/products/overview/packedge/overview/
http://www.esko.com/en/products/overview/color-engine/overview/
https://www.esko.com/en/Support/Product?id=Equinox
https://www.esko.com/en/Support/Product?id=Color%20Engine%20Pilot
https://www.esko.com/en/Support/Product?id=Color%20Engine%20Pilot


7 Automation Engine

This task keeps your file's metadata intact (for example CAD information).

Tip:  We recommend you place this task towards the end of your workflow, as close to the
output device as possible.

Parameters
1. Select the Color Strategy you want to use for the conversion. This must be an Equinox

Color Strategy that you have created in the Color Engine Pilot.

Typically, your color strategy doesn't only contain general color conversion settings, but also
specific color builds, for either the spot colors you use the most, or for a whole Pantone
book.

These color builds determine the exact percentages of the available output inks that will be
used to print the corresponding spot colors. These have often been adjusted by your color
expert to give you the spot color simulation you want.

2. In Undefined Spot Colors, choose what to do when the file contains a spot color for which
your color strategy has no color build.

• Select Do not convert (keep in output) if you want to leave the spot color untouched
in the output file. Do this for example if you are using certain spot colors as extra output
inks (typically white or metallic inks).

In this case, the task will end in a warning.

Tip:  Consider setting up your workflow so that:

• the output file gets sent to the next task automatically (if you are sure that those spot
colors are extra output inks),

• further processing of the output file is paused, so that you can check whether those
spot colors are actually extra output inks.

• Select Convert to convert that spot color to the color strategy's output profile using the
strategy's general color conversion settings (see the Color Engine Pilot documentation for
more information about color strategy settings).

• Select Generate error if you don't want to convert the file at all, and instead have the
task end in error.

Do this if you always make a color build for each spot color, so in this situation you want
to stop the workflow and investigate why this is not the case. You may want to either
replace the spot color in your file, or add a color build for that spot color in the color
strategy.

3. Select Hide Technical Inks if you want to keep technical inks out of the conversion.
4. Select Flatten document if you are experiencing unexpected color results when converting

files containing overprints, transparencies or vignettes.

Flattening your file resolves its overprints and transparencies, and converts its vignettes to
images.

In the example below, the original file contains three objects:

• the background (sky),
• the lighthouse, which is knocking out on the background object,
• the wave, which is overprinting on both the lighthouse object and the background object.
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Flattening your file replaces the parts of objects that were overprinting or transparent by
other objects. Those new objects have the color that was resulting from the overprint/
transparency, but are not overprinting or transparent.
 

 

Attention:  We recommend that you:

• flatten files with overprints, transparencies or vignettes,
• don't flatten files that you still need to trap or edit afterwards.

If you need to both flatten and trap your file, make sure to do your trapping first,
and place the Convert Colors with Equinox task towards the end of your workflow,
as close to the output device as possible.

5. For CMYK objects, you can choose to Convert either:

• Images and Linework,

• Linework only.

• Images only.
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Attention:

• If your file contains a Device N image (an image that contains one or more spot
colors), its spot color(s) will be converted even if you select Convert Linework
only.

• Flattening your file converts vignettes into images. This means that:

• If you selected Flatten document, vignettes will be color converted when you
chose to Convert Images and Linework or Images only.

• If you didn't, they will be converted when you chose to Convert Images and
Linework or Linework only.

7.26.  Convert IMP file to Normalized PDF

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.27.  Convert JSON to XML

This task is documented in the chapter Integrating with External Systems. Find a direct link here.

7.28.  Convert Selection

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.29.  Convert XML to JSON

This task is documented in the chapter Integrating with External Systems. Find a direct link here.

7.30.  Contourize & Clean

This old technology is still supported but no longer commercially available.

Please find its documentation in the manual of Automation Engine 14.1 or older  (as part of the
Reference Guide).
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7.31.  Copy or Move File
This task copies or moves the input file or Marked files to a new location.

Note:  To Mark a file, insert the Mark File workflow control in your workflow. Learn more in
Mark File and Select Marked File on page 772.

You can also launch this task on folders.

• Select the option if you want the task to fail when the file to be copied or moved already
exists in the output folder.

• You can also choose to not take over the Extension of the Input file in the Output file.

Note:  When the files that you move or copy with this task have prepared view files for the
Automation Engine Viewer, these view files will also be moved or copied. This is also done with
the XFDF annotation files that were created by any Inspection task that you launched on the
files that you here copy or move.

7.32.  Create ArtiosCAD Layouts

What?

This task provides optimized nesting solutions including output metadata that allows a
business system to estimate the cost for these nesting solutions.

The task requires a design name, format class, MFG template, sheet size, nesting type, number
of one-ups, sheet trim, gutter, margins etc. Output parameters includes metadata such as
number of ups, blank size, waste percentage, rule length, etc.

It also accommodates the functionality of running a command script after layout is created.
The task supports both Enterprise and Standard ArtiosCAD.

More Info

This task is set up by an Esko Solution Architect. Learn about Esko Solution Services on https://
www.esko.com/support/solution-services.

For more information, search for online articles on this topic in the Esko Knowledge Base.

7.33.  Create ArtiosCAD Report from XML

What?
This task exports a 'report' of a design or layout to PDF, CF2, DCM and more file formats
(configured in ArtiosCAD Server). The output 'report' file is written onto an external folder
where it can be picked up to be interpreted by a business system or by a Kongsberg table.

This task takes an XML input file that describes a layout.
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Note:  This task can also print out this report.

Note:  This technology was formerly known as 'Speclink' or exporting a 'shop card'.

More info

This task is set up by an Esko Solution Architect. Learn about Esko Solution Services on https://
www.esko.com/support/solution-services.

For more information, search for online articles on this topic in the Esko Knowledge Base.

7.34.  Create Design (DesignWizard)
This task creates variants of a template design. The differences in the variants are described in
an external file.

Attention:  The template design needs to be made in Esko PackEdge.

This template design contains objects generated by SmartMarks (text, colors, objects, external
files)

The DesignWizard task regenerates the SmartMarks using different data sets. These data sets
can come as a field in a database (accessible from the Automation Engine server through
ODBC), or they can come from fields in an XML file.

 

 

An example: These resulting juice designs vary in color, text and bar code. External references
can also vary (images, logos).
 

 

The task used this XML file that describes their differences.
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Learn more about how SmartNames can retrieve values from an XML file or directly from an
external database in Using SmartNames in a DesignWizard template on page 239.

7.34.1.  Using SmartNames in a DesignWizard template

The DesignWizard template picks up it the variant values via SmartMarks that use
SmartNames.

In the case of a live connection to a database, you create and use Database Query SmartNames 
on page 645.

In the case of XML files, the XML file is expected to have a similar format as when saving a
database query into an XML file. This means the data can either be split over 1 file per instance
(i.e. each XML file contains all the data for 1 variant) or there can be multiple sets in 1 XML file
(see this example).

To get SmartNames out of such an XML file, you need to Load it into Parameters tab of the Job
Setup. Each new Job Parameter so automatically becomes available as a SmartName (inside
this Job)
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7.35.  Create IMP File

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.36.  Create Imposition from JDF Layout

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.37.  Create Imposition from RunList

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.
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7.38.  Create Job task

This task is documented in the chapter Integrating with External Systems on page 1553. Find a
direct link here.

7.39.  Create Merged Plate

This task is documented in the chapter Flexo CTP Workflow on page 1340. Find a direct link
here.

7.40.  Create Master DCS File

This old technology is still supported but no longer commercially available.

Please find its documentation in the manual of Automation Engine 14.1 or older  (as part of the
Reference Guide).

7.41.  Create or Modify WebCenter Project

This task is documented in the chapter Integrating with WebCenter on page 1526. Find a direct
link here.

7.42.  Create Packshot from XML

Concept

Using an XML as input file, this task links one or more artwork files (PDF) with printable parts of
a structural design file. A structural design file describes a 3D object.

Such XML is created by Esko WebCenter.

In this XML (in WebCenter), the user can specify:

• a scene and view preset. This determines at which angle one looks at the 3D object, if the
3D object should cast a shadow, which lighting environment is chosen etc.

• A finishing profile. This determines which special finishing operations should be visualized.
For example a varnish, a holographic foil etc.

• The output file type: a TIFF, PNG, JPEG or Collada file.
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7.43.  Create PAF / JPG / XML (LinkEdge)

Note:  The name of this tool refers to "LinkEdge", an old interactive tool that was used to
transfer files from the editor PackEdge between different sites.

This task packs the graphics data all its references in one file. It is also used to unpack that
set of data, possibly at another site. This task is not just a form of Esko-'Zip': The (un)packing
process also communicates with central resource folders (colors, fonts).

The task also offers to create a preview (JPEG) and/or a description of the file (XMP-XML).

You can also use the task to for example only create one of those 3 types of data.

7.43.1.  Pack/UnPack

 

 

• Select Create Packed File to create a Pack file from a Normalized PDF or Plato PLA file (and
legacy file formats GRS and GRQ).

When your ticket does not yet have an input file selection, you still need to choose the
Action:

• Pack File: This creates a .PAFSC file (.PAF when input file was a legacy .GR* file)

Note:  'PAF refers to Packed Archive File'. The 'SC' refers to 'Scope', a term used in old
Esko workflow setups.

• UnPack File: The output file is written in the ticket's Output folder. Where the
referenced files are written depends on the option 'Unpack in...' below.

• You can choose to Include Fonts. When unpacking, the task first checks if the font is
installed centrally. If so, the graphics file will refer to that central font. Otherwise, the font is
installed locally.

• Unpack in Local Directory:

The Local Directory is the output path in the ticket. When none was specified there, it is the
folder of the input file. This option is important when there are referenced files:
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• When this option is not selected, the task will try to restore the original file structure.
When a path to a reference is no longer relative but refers to other disk drives, these
data will be put in a subfolder 'External'.

• When this option is selected, all elements of the packed file will be unpacked in the same
output folder.

An example:

Suppose you packed a Normalized PDF (D:/Jobs/2345banana/2345_50ml.pdf)
which has one referenced image that resided in a subfolder (D:/Jobs/2345banana/
images/banana.eps ). When you unpack the PAFSC file and there select Unpack in
Local Directory, the task will write all files in the same folder. If you unpack without that
option, the task will try to re-create the same subfolder and put the image there. In this
case, again in a subfolder /images .

• Add a Password to protect the Packed file. The user that unpacks that file will be prompted
to enter the password (using a task ticket or using an interactive tool).

7.43.2.  XML

Select Extract XML Report if you (also) want to create an XML description of the file's XMP
metadata (job and customer data, references, inks, barcode, etc.).

Note:  Native PDF data will first automatically be normalized according the ticket configured
here.

XML Structure: choose between standard XMP and the old BackStage Version 1.2 (also
based on XMP, but contains less information).
 

 

Note:  Learn more about Esko XMP in the white paper "XMP Metadata". Find it under "Related
Documentation" next to the Automation Engine documentation.

Choose the Units that should be used in the XML file.
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Select Ignore opacity mask inks if you do not want information about such inks in the XML.
Learn more about opacity mask in the user manuals of Esko or Adobe editors.

7.43.3.  JPEG

Select Extract JPEG Preview if you want the task to (also) create a preview file of the
(unpacked) input file.

Note:  Native PDF data will first automatically be normalized according the ticket configured
here.

 

 

• Define an Image Resolution.

• Alternatively, you can define the JPEG's Width and Height in pixels. If your ticket
already has an input file, these fields will already be filled in. Changing these fields may
automatically reduce the chosen resolution.

• Alternatively, you can set limits to the JPEG's Width and Height. Changing these fields may
automatically reduce the chosen resolution.

• Choose a Compression from the drop-down list.

• Anti-aliasing smoothens the staircase effect you get in the generated images of line-art
objects. If you select it, also select it's quality.

• Select Account for Margins if you want the JPEG to also contain data from outside the file's
Trim Box ('borders'), so up to the file's Media Box ('margins').

• Select Use varnish inks in output if you want the inks with the attribute 'varnish' to be
included in the JPEG file.

• Page Range: Choose if you want a JPEG of All pages or of a specified range of pages (for
example '2-3,5-6').
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7.44.  Create PDF File from JDF RunList

7.45.  Create PDF File from RunList

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.46.  Create PDF Report

Concept

This task is used to automate the creation of 'print cards' (in French: "fiche technique", in
German: "Druckkarten").

These file reports typically contain a preview of the design and then lists extensive details
of graphics and CAD and further information related to the job-order, customer, etc. It can
even be extended to show separations or include 3D objects. Such file reports is what many
prepress operators created manually and then printed to use as proofs or to store in some
paper archive.

The task makes a report based on a Report Template that was made earlier in ArtPro+ and
saved as a PDF+ file.

Example
See this example of an output report PDF. Its format and content is decided by the Report
Template, also the amount of pages. In this example the template had a second page where
marks placed a closer view at some important details:
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Note:  In this version, this task still has these limitations :

• no support to place a 3D file
• no support for span mark
• Workflow parameters and Job parameters cannot be used in text marks.

Graphics Kernel

This task uses the graphics kernel from ArtPro+ (NDL). The report templates also need to be
created in ArtPro+. Learn more about PDF+ in PDF+ in Automation Engine on page 51.

This task succeeds the task Create Report (ReportMaker), which uses the normalized PDF
technology (BRIX), and which report templates have to be created in PackEdge.

Functionality
• Select a PDF file.

Note:  Normalized PDF is not supported as input file. In such case, use the task Create
Report (ReportMaker) instead.

• When selecting multiple input files, a task will be launched per input file.
• When an input file is a multipage file, only its first page will be processed.

• Make sure to define a (smart) output name for the report PDF.
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• Select a Report Template file that was created in ArtPro+.

• The result is a PDF.

• Its content and number of pages are decided by the report template.
• The report PDF contains a single layer ; all layers were flattened.
• All its data is embedded and all its marks were flattened to static objects.

Note:  This means that you can not ask the report PDF to update any links, like the link to
the input-file.

Creating a Report Template

How to create a report template for this task is described in the user manual of ArtPro+, in its
section Working with Files >  Report Template.

To build such a report template in ArtPro+, you need experience in working with Dynamic
Marks.

7.47.  Create Report (ReportMaker)

Attention:  This task requires report templates made in Esko PackEdge.

This task is used to automate the creation of design 'print cards' (in French: "fiche technique",
in German: "Druckkarten").

These file reports typically contain a preview of the design and then list all kinds of information
related to the job-order, customer, extensive details of graphics and CAD. It can even be
extended to show separations or include 3D objects. Such file reports is what many customers
used to create manually and then print out or use as proofs.

The task makes a report based on a Report Template. Learn more below in Creating a
ReportMaker Template on page 249.

Input File types

• Input file types:

• Native PDF
• Normalized PDF
• PDF+ files (since AE v18.1.1).

Important:  PDF+ files will be normalized before the report is made.

The following features from PDF+ files are supported:

• ink properties and ink sequence

• Processing steps will be shown as technical inks.
• Text fields showing general properties
• dimension lines showing the document sizes
• text fields showing XMP properties
• 3D previews of PDF+ files containing links to ARD or Collada files (ZAE or DAE files)
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• only when the CAD objects are rotated over a multiple of 90° are supported .

Task Settings
 

 

• To avoid that the output PDF has the same name as your input file, it is by default named
[File]_Report.pdf. Use SmartNames to define any other File Name.

• Select a Report Template.

• If you want your report to be a self-contained PDF instead of a Normalized PDF, select
Export to PDF and choose a Ticket for the PDF Export task.

Tip:  You can also use this option to help create a report containing a 3D object (see Adding
a 3D Object to a Report PDF on page 253).

Example
Here is an example of a report (viewed in Adobe Acrobat). The format and content is decided
by the Report Template, also the amount of pages. This report template had a second page
where SmartMarks place the design in separation mode:
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7.47.1.  Creating a ReportMaker Template

Remember:  You need the editor Esko PackEdge to make a template for the ReportMaker task.

A ReportMaker template is a Normalized PDF which you can design yourself. In this file, various
specific SmartMarks are needed. Some of them use specific SmartNames.

Let's make a simple template that can give us this result:

 

 

In the above example, 1, 2 and 3 are all Text Marks on board the template that are resolved
when the ReportMaker task is executed. Number 4 shows a preview of the input file. This was
placed via an Image Mark and can be scaled at wish.
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Note:  SmartMarks used in a ReportMaker template are extra smart because:

• Ink related SmartMarks show the inks of the input file, not of the generated report.
• Ink coverage related SmartMarks show the ink coverage of the unscaled version of the input

file.

Follow these steps to create a template for this task:

1. In PackEdge, create a new file that you will use as a report template.
2. Place the Text Marks. When needing help, contact Esko or check the PackEdge user manual.
3. Draw a rectangle where you want the preview to appear (no need to attribute any color).
4. Make that rectangle a Named Object:

 

 
5. In the SmartMarks dialog, select that object, click  and add an Image Mark.
6. In the tab Image, the Name of the image is a special Smart Text for this case. Click  and

choose '[taskinputfile]' from the category 'ReportMaker'. This is a special SmartName
that will place the input file in the Report when so asked by a ReportMaker task.
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7. In the tab Position, Attach the Image Mark to the Object that you created in step 4:

 

 

Notice how the Image Mark 'taskinputfile' has the same functionality as any other
SmartMark. It can also be scaled, you can make ink-selections etc.

8. This is the result so far, the Image Mark places the 'taskinputfile' in the Named Object:
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9. Save your PackEdge file.
10.Test it by using it as a ReportMaker template.

7.47.2.  Adding Previews of Details in a Report PDF

The previews in a ReportMaker report can also zoom in on ‘details’ of the input file. This makes
it possible to add extra previews where you zoom in objects that are difficult to inspect in a
full preview (ingredient copy, small logos, bar codes...). This is also useful when the design only
contains few graphic objects, for example on corrugated boxes.

Here's an example where page 3 and 4 of the report zoom in on important content of the
design:
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The way to do this is very similar to how you create the placeholder for the preview of the
complete task input file, as described here. In this case however, we will place a detail of the
input file. These details are then attached to their own Named Objects. You can for example
put these on extra pages of the template.

See below how page 4 of the template, that was used in above example, was set up:

Attention:  Important is that in this case, the named objects that indicate the details
first need to be set up in the input file. So before you launch the ReportMaker task, your
input file needs to contain these Named Objects too.

 

 

Note:  A Named Object is typically a rectangle. This contour object is used as a clip mask on the
input file. If the named object is a different object (an image, a group of objects…), then a clip
mask will be applied with the size of the bounding box of the named object.

7.47.3.  Adding a 3D Object to a Report PDF

A report PDF can even contain a 3D object of the input file. To do this, you need:

• a report template with image marks allowing 3D objects,
• a Normalized PDF file with a link to a CAD file (.ard, .dae or .zae).

Follow these steps:

1. In PackEdge:
a) Open your report template in PackEdge.
b) Add a Named Object in which you want the 3D object to be placed.
c) Add an Image Mark to that Named Object.
d) Add Smart Text to define the name of the Image. From the category 'ReportMaker',

choose '[taskinputfile in 3D]'.
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e) Save your template.

2. In Automation Engine:
a) In the Create Report ticket, make sure you select the option 'Export to PDF'. This forces

the 3D object to be embedded in the PDF.
b) This report PDF and its embedded 3D object can be viewed in Adobe Reader 8.0.1 or

later.

7.48.  Create RunList

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.49.  Create RunList from PDF

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.50.  Create Sheet Layout

Note:  Before v18.0.1, this task was named "Create CAD Sheet".

Concept
This task serves to fully automate the step and repeat process.
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The task places graphic files on the stations that are defined in a template, which can be a
CAD file, a PDFPLA file or layout description in a die database.

Which graphic files are placed is decided by the task's input file(s):

• If the input file is an XML file, this XML needs to contain information on what graphic file(s)
to use, the quantity, bleed etc. Learn more in Using XML as input file on page 263.

• If the input file is a PDF file, the PDF is placed on all stations. If the input is multiple PDF files,
the files will be distributed equally.

Note:  These PDF can be:

• native PDF
• Esko Normalized PDF

• Normalized PDF without CAD object info
• Normalized PDF including CAD object info

• CAD object info added from Adobe Illustrator, ArtPro, PackEdge or by the task Load
Structural File on page 322.

• a PDFSTA file.

Learn more in Distributing the One Up graphics onto the Stations on page 260 and Positioning a
One Up graphic onto a Station on page 259.

7.50.1.  Ticket settings

Tab 'General'
 

 

• The Output Format can be a PDFPLA, a Normalized PDF (with all references embedded) or
a native PDF.

Note:  When the input file is a native PDF and you here select PDFPLA, the task will fail.
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Note:  When the input file is a (native) PDF file and you choose to output to 'Normalized
PDF (embed all)' is selected, the input PDF will automatically normalized when while
generating the output file. It therefor uses the 'Automatic normalization' ticket from the
Processing Preferences in the Configure tool.

• The output file contains 2 layers: the CAD layer and a layer containing the placed
stations. When SmartMarks are used, an extra layer will be generated containing the
SmartMark objects.

• The output file will have a Trim box and a Media box. These page boxes represent
respectively the sheet and the plate of the layout.

• The output file contains the following inks:

• all the inks of the input files (in case the input files are native PDF files, a
normalisation on-the-fly will be executed).

• all the inks created during import of the CAD object
• all the inks that might be added by SmartMarks.

• Use the Backing Up option when working with a front and back. You can choose to Work-
and-Turn (rotate over a vertical axis) or Work-and-Tumble (rotate over a horizontal axis).

Note:  In order to make a CAD sheet with a front and a back, you need a multi-page PDF file.
The first page is placed on the front, the second on the back. In case of XML input, the XML
file can contain more detailed settings for the back side graphics.

• Limit Bleed: The bleed can be limited to a specific distance. The bleed mask is created by
spreading the die shape. When this field is left empty, the bleed setting in the stations will
be left unchanged.

Note:  When using a SmartName, the resolved value should contain a number with an
optional unit indicator. Supported unit indicators are (case insensitive): mm, cm, in, inch, mil,
point, pt. When none was specified, the value is interpreted in mm.

• Adjust masks for continuous printing:

When not selected, the top and bottom rows can have more bleed (top- and bottom bleed)
compared to graphics that occur in the middle of the layout.

When selected, the bleed of the top and bottom row of graphics will be truncated in the
same way as on the rows in the middle of the layout (i.e. truncate the bleed of the top and
bottom row of graphics as if there is a continuous set of rows of graphics). This is required
to enable continuous printing (around the drum).

• Select Add SmartMarks if you want to add any.

Note:  When a back side is created, SmartMarks will only appear on the back side if a
SmartMark set was specified for that back side. In that case, the SmartMarks added on the
front side will not be mirrored to the back side.

Click Options... and select them from the drop-down list or use SmartNames (Front and/or
Back).

• By default, marks are loaded in a layer on top of the graphics. Select Load Mark Set
in bottom layer if you want to make them appear behind the graphics, in a new layer
at the bottom. This is used for example when adding gradation strips that need to run
behind the graphics.

• Use Pull back Marks to keep marks away from the graphics. For example to keep
gradation strips away from the die line, with a set distance. This option is only available
when Load Mark Set in bottom layer was selected.
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• Screen Registration: Select this option if the Esko RIP should reset the screening origin
for every one-up. De-select it to keep the same screening origin for the complete step and
repeat. This option is only available when outputting to PDFPLA or Normalized PDF (it is
added to the XMP of those files).

• The Graphics Folder is the folder where the task searches the graphic files. This option is
only applicable when the input mode of the task is XML and when the XML does not offer a
full absolute path (only a partial path or only the name of the input file). Learn more in Using
XML as input file on page 263.

Tab 'Layout'
 

 

• Template Type: Choose between:

• CAD File: Define the MFG, DXF or CFF2 file that will be used as base for this sheet.

• Mapping: When the CAD file is a CFF2 or DXF file, you here select the set of mapping
rules. These rules map line styles (cut, crease, bleed), layer names and color numbers
onto ArtiosCAD line types. These sets of mapping rules can be created in Esko
PackEdge or Plato. Learn more in their user documentation, more specifically in their
section on placing files (PackEdge) or on importing CAD data (Plato).

• The CAD Style changes the appearance of the (imported) ArtiosCAD type lines.

Note:  This CAD Style is only applied on lines from the design (ARD) that was stepped
in the layout file (MFG). Lines manually drawn next to the placed designs (the so
called "objects at layout level") will always be ignored by the task.

The styles you can select here were also created in PackEdge or Plato. Learn more in
their user documentation, more specifically in the section on placing ArtiosCAD files,
and the option for "CAD Style".

• PDFPLA file
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• Die Database

 

 
This is the die database used in the browser client of Automation Engine (the QuickStart
deployment). Specify the name of the die that is described in there.

• Filling Order (valid for each type of Template):

• The filling order determines in which sequence stations will be filled with one ups. It also
determines the value given by the SmartMark 'Station Number'.

• The default filling order starts top left, vertical zig-zag per column.
• Select Set custom filling order to specify a filling order that is different than the one

defined in the selected template file.

• The filling order is defined by selecting a Start Position, Direction and type of Filling
Order. Learn more about using SmartNames to define these buttons in SmartNames of
Parameter Values on page 683.

Note:  The sequence of the designs is determined by taking the center points of the
designs and sorting these in rows and columns. Keep in mind that designs with different
sizes or layouts with staggered designs can result in more rows or columns than
expected.

Tab 'Plate'
 

 

The sheet size can be automatically extracted from the CAD template but neither Artios MFG
nor CFF2 file have a notion of 'plate'. As a result the plate size and position of the sheet on the
plate have to be specified in this Plate tab.

• Plate Size: You here specify the plate's horizontal and vertical size.
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• Shrink: To compensate for distortion on the output device or press, you can add vertical
and horizontal shrink values.

• When the output format is PDFPLA or Normalized PDF, this task writes the shrink factors
in the file's XMP section. This means that the objects and page boxes keep their original
sizes. These shrink factors will then be picked up by the RIP or export ticket, where they
are used as scale factors and are applied on the complete document.

• When the output format is native PDF, this task applies the shrink factors as scale factors
on the complete document.

• Sheet Position on Plate: Position the sheet on the plate by dragging and dropping the blue
square (the sheet) to the right position on the grey square (the plate).

• Define any extra horizontal and vertical Sheet Offset.

Tip:  When using SmartNames, make sure they return a value that the field expects. For
example a SmartName in the field 'Plate Size' should return a number.

Tab 'Sheet'
 

 

• If you want to use a custom sheet size instead of the Sheet Size defined in the CAD file,
then select Set custom sheet size and enter its dimensions.

• CAD Layout Position: You here position the bounding box of all cut lines versus the sheet.
If you want to use a different position for the CAD Layout than the one defined in the
template file, then select Set custom position.

• Position on Sheet: Click or drag the blue square (the CAD Layout) in a position versus
the grey square (the sheet).

• Offset: Define by how much the CAD Layout should be offset from the sheet corner,
horizontally and vertically.

7.50.2.  Positioning a One Up graphic onto a Station

To decide how to position a PDF onto the CAD file, the task tries these options, in this order:
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1. Checks if the input PDF contains a die cut object, a linked ARD file. If the name of this ARD
file matches the name of the design specified in the MFG file, the graphics will be placed.

Note:  This option is only available for Normalized PDF files.

2. Positions the Trim Box of the PDF on the bounding box of the cut and crease lines. If the
Trim Box and bounding box match, the graphic will be placed.

3. Positions the die line of the PDF defined in the XML file, on the bounding box of the cut and
crease lines. If it matches, the graphic will be placed.

Note:  This option is only available when the task input file is an XML file.

If the PDF Trim Box or die line bounding box does not match any of the bounding boxes of the
design in the CAD file, then the file will not be processed and an error will be given.

7.50.3.  Distributing the One Up graphics onto the Stations

Which PDF goes onto which position in the CAD layout?

• When the input file of the task is an XML file, the task looks for an XML element Quantity,
defining the amount of stations to be filled with that specified graphic. For example
<Quantity>10</Quantity>.

Note:  If the total number of quantities doesn't match the number of stations, the task will
stop with an error.

When the element shows the value <Quantity>Maximum</Quantity>, the task will place the
referred PDF file as many times as possible.

When more than one PDF file has the quantity element set to Maximum, the task will
distribute the referred PDF files equally. You can also combine files with a fixed quantity
with one or more files with a quantity set to Maximum.

• When the input file of the task is a set of PDF files, the task will consider all PDFs to be set to
maximum quantity, so the provided input files will be distributed evenly onto the provided
CAD layout.

When the number of available stations cannot be divided by the number of input files (for
example 9 stations and 2 PDF files), the task will automatically distribute the remaining
stations.
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Note:  When the CAD file contains different designs (different types or sizes of boxes), the
graphics will only be distributed on the corresponding (fitting) designs (see Positioning a One Up
graphic onto a Station on page 259).

7.50.4.  Bleed and overlap

When the one up graphics contains bleed, this bleed will be used around the die line, limited by
the value in Limit Bleed (in the General tab).

Note:  Everything outside the die line is considered to be bleed. Bleed zones without content
will knock out when overlapping. Overlaps can only work well if a correct bleed limit is applied.

When the bleed of two stations overlap, you can have these situations:

• There is a gap between the panels of the two stations.

In this case, centerline overlapping is applied: the bleeds from both neighboring stations
touch on the center-line of the gap.

• The station panels are touching.

• If the layout is not CAD based, centerline truncation is applied.
• If the layout is based on a CAD template, then:

• the biggest panel will overlap the smaller panel (situation A in the example below).
• if the panels are the same size, centerline overlapping is applied (situation B in the

example below).
• in case the ArtiosCAD artwork panels were given a specific 'Allow Bleed' property,

other rules apply. Learn more in Bleed Overlap Priority Decided by ArtiosCAD Artwork
Panels on page 262.
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Note:  When deciding if a station is touching another station, minor tolerances are taken into
account to cope with small inaccuracies in the die cut file.

7.50.5.  Bleed Overlap Priority Decided by ArtiosCAD Artwork Panels

The priority in bleed overlap can be automatically decided in case the layout is an MFG and
in case there are common knives (i.e. no gutters, so areas where 2 panels/flaps touch). The
decision is then based on how the ArtiosCAD user defined the bleed direction for those specific
panels.

In ArtiosCAD (v 14.0.2 or higher), a panel can be defined as an 'artwork panel' and an artwork
panel can have an 'Allow bleed' property. A panel that is set to allow bleed is considered as
having a minor priority and it can receive bleed when it touches another panel marked as
major priority (where 'Allow bleed' was not defined or turned off). In the case 2 minor panels
are touching, the bleed will be truncated to the centerline, which is the default behavior, like in
areas where there are gutters (i.e. no common knives).

Note:  This behavior applies to all Step and Repeat tasks using an MFG layout (including in
Plato).

Overview of all Possible Situations:
• In case there is a gutter: always centerline truncation.
• In case there is no gutter between 2 panels (gutter = 0), the following overview applies:

262



7Automation Engine

Table: Smart Flapping

Panel 1 Panel 2 Bleed Action

Not an artwork panel Not an artwork panel Compare size of Panel 1 and Panel 2. If size
difference > 10%, then large one bleeds into
smaller one, otherwise centerline is used

Not an artwork panel Artwork panel with
allow bleed = 0

Centerline (i.e. no bleed as the gutter = 0)

Not an artwork panel Artwork panel with
allow bleed = 1

Panel 1 bleeds into Panel 2

Artwork panel with
allow bleed = 1

Artwork panel with
allow bleed = 1

Centerline (i.e. no bleed as the gutter = 0)

Artwork panel with
allow bleed = 1

Artwork panel with
allow bleed = 0

Panel 2 bleeds into Panel 1

Artwork panel with
allow bleed = 0

Artwork panel with
allow bleed = 0

Centerline (i.e. no bleed as the gutter = 0)

Artwork panel with
allow bleed = 0

Artwork panel with
allow bleed = 1

Panel 1 bleeds into Panel 2

7.50.6.  Using XML as input file

Concept

When the business system (MIS, ERP) provides an XML description, this task can fully automate
the folding carton step and repeat process.

When using XML input file(s), the task supports 2 modes:

• An v18.0 compatible mode supporting the XML format. Advantage of this mode is that you
can use the Product ID. This is used for example in flexo printing. Learn about this XML
specification below.

• A mode which is compatible with the XML used in the 'Dynamic' Step&Repeat tasks.
Advantage of this mode is that you can specify a page range (in case your input file is a
multipage file). This is used for example in VDP. Learn about this XML specification below.

Specification

In the 18.0 compatible mode, the task scans the XML file for elements called <JOB>. Multiple
<JOB> nodes are allowed when these are placed under a <JOBS> node.

Attention:  All XML elements are case sensitive. For example, the element <JOB> must
be in capital letters.

An example:
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It's also possible to combine multiple graphics in the XML file. In that case, multiple <JOB>
elements are gathered in one <JOBS> element. An example:

Each <JOB> element will create in a station according to it's sub elements:

XML Element Description

Filename
(mandatory)

URL of the graphics. Both URLs and UNC paths are supported. Both absolute
URLs and relative URLs are supported. In case the URL is relative, the
Graphics Folder specified in the ticket is used to resolve the URL of the
graphics. Only one of FileName or ProductID may be specified. Some
examples:

<FileName>file://myserver/myfolder/mygraphics.pdf</FileName>

<FileName>\\myserver\myfolder\mygraphics.pdf</FileName>

<FileName>mygraphics.pdf</FileName>

<FileName>myfolder\mygraphics.pdf</FileName>

Product ID
(mandatory
if Filename
is not
used)

ID of the Product to use for the graphics. Only one of FileName or ProductID
may be specified. If a product contains multiple parts, the first part is used.
The second part will be used (if present) as back side graphic.

Note:  Describing products with multiple Parts in this way is not yet possible
in this version.

Quantity Number of times the graphics needs to be placed. Allowed values are either
a number or the keyword "Maximum" (the default, case insensitive, can
be abbreviated to "Max"). In case multiple graphics are using 'quantity =
maximum', they will be evenly placed on the number of matching placeholders.

DieShape Ink name of the die line of the graphics. Allowed values:

• the name of a spot color,
• 'TRIMBOX' (or 'BORDERS') will use the trim box of the PDF graphic.
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XML Element Description
• 'DEFAULT' will search for a CAD object inside the normalized PDF(STA)

file. When no CAD object is found, the trim box will be used. This also the
default value of this element.

Bleed The amount of bleed allowed outside the die shape. Sets a bleed mask, in
mm, starting from the die line. When no bleed is specified, no bleed mask
will be applied, unless the input is a PDFSTA file, in this case, the bleed setting
from the PDFSTA file will be used.

Page number Select a specific page from the specified PDF graphic. If no page is specified, all
pages of the graphics file will be loaded. Y

Specification for the <Runlist> Mode - compatible with Dynamic Step&Repeat

In the Dynamic Step&Repeat compatible mode, the task will scan the XML file for elements
called <RunList>, which contain one or multiple <RunListItem> nodes.

A <RunListItem> node consists of the following sub-nodes:

Node Description

FileName URL or UNC of the PDF graphic to be placed. Relative URL's are allowed, the
'Graphics Folder' will then contain the base path.

Repeats Number of copies required for this graphic. Allowed values are either a number
or the keyword "Maximum" (case insensitive, can be abbreviated to "Max").

FirstPage Number indicating the first page of the graphics to be used. Learn more in
Specification of RunList XML in Dynamic Step & Repeat tasks on page 455.

LastPage Number indicating the last page of the graphics to be used. Learn more in
Specification of RunList XML in Dynamic Step & Repeat tasks on page 455.

Extra XML Parameters when working Front and Back Graphics

Table: Back side handling in XML (all optional)

XML
Element

Description

BackGraphic UNC (or URL) of the PDF file to be used as back side. Example:

<BackGraphic>file://myserver/myfolder/mybackgrphic.pdf</BackGraphic>

Note:  No page selection is possible for the back graphic. Only the first page of
the back graphic PDF is used)

RectoVerso Allowed values: 0: use all pages as front, 1: use the even pages of a multipage
file on the back.
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XML
Element

Description

Attention:  The default value is <RectoVerso number="1"/> . In
other words, even when the XML file does not contain a setting for
backside and the supplied graphic is multipage, the even page(s) will be
used as back side graphics.

SameGraphic The default value is '0'. This indicates that the front graphic should also be used
as the back graphic. Allowed values: 0 or 1: use the same graphic on front and
back. Example:

 <SameGraphic number="1"/>

SameGraphic is overruled by RectoVerso in case of a multipage file.

FlipGraphic Only to be used in combination with <SameGraphic>. When value = 1, in
combination with 'SameGraphic' = 1, then the front graphic will also appear on
the back but flipped around a vertical axis. Example:

<FlipGraphic number="1"/>

Other nodes as listed above (DieShape, RectoVerso, SameGraphic, FlipGraphics, BackGraphic)
are optional.

7.51.  Create Sheet Report from IMP File

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.52.  Create Tiles
This task is described in the chapter on Gang Run Printing. Find a direct link here.

7.53.  Create Wrapper File

Concept
The task wraps the input file(s) in a Normalized PDF. This is typically used to encapsulate
screened TIFF ('Copydot') files into a PDF format before further tasks are launched on that PDF.

This task accepts these types of images as input files: TIFF, TIFF_IT, PSD, JPG, BG_CT, BG_LP,
BG_JS, EPS, DCS, Copydot, LEN. LENX files are not supported.
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Combine multiple input files (separations) to a single composite wrapper file: This is the
default behavior with multiple input files. Learn more in Separations tab on page 269.

7.53.1.  Page Size tab

 

 

• Page Size: You here define the size of the output file.

• Job size: This is the size of the input file.

• Choose Custom to define a size manually.

• Or select a standard size from the list.

Note:  About 'Scanner Trim Size': All 'Eskoscan' scanners have a feature to indicate the
trim size of the page (they add it into the master DCS file). When choosing 'Scanner Trim
Size', the borders of the output file will be automatically positioned.

• Offset: When no offset is defined, the center of the 'image' will be positioned on the center
of the page. If the page is smaller than the image (width, height, or both), then margins will
be set that enclose the image completely. The size of the margins will not be fixed. Margins
indicate the differences between the image size and the user-defined page size.

• Select Margins and define its values to set fixed size margins to the PDF (for example 3 mm
for bleed).

• Reader's Spread: None of the supported input file types have the notion of 'reader's
spread'. Select this when you want to use the output PDF in Esko FastImpose.

• Single Page forces a single page output file.

• Reader's Spread forces a reader's spread output file, set as double pages.

• Auto checks the size of the input file: When its width equals or exceeds two times the
selected page width, the reader's spread option is set. Otherwise it is treated as a single
page.

• Page number: Select the correct page number from the output PDF that you want to
output.
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• Display images: Select the preview settings of the output PDF.

7.53.2.  Inks tab

This tab serves to add ink attributes to inks that can be detected from the input file.
 

 

Note:  This tab is greyed out when you selected the option 'Combine multiple input files
(separations) to a single composite wrapper file'.

If an input file contains definitions for its ink (for example a CMYK Tiff or a Photoshop DCS2),
and this definition matches an Ink Name defined in this tab, then the Angle, Ruling, etc. in the
output PDF will be the ones as set here for this ink name. All other inks will get the attributes
as set in the Default options set below.

This tab by default contains CMYK. You can change at will manually.

Inks in this list can be selected or not. Not selected inks will be ignored by the task.

When an input file has no ink definition:

• If only one ink is selected in this tab, the output PDF will contain that ink, including all its
attributes as here specified.

• If multiple inks are selected, and K is part of that selection, the output PDF will contain K
and its attributes as here specified.

• If multiple inks are selected and K is not part of that selection, the output PDF will contain
the first ink from this list and its attributes as here specified.

• If no ink or the wrong ink is selected (one that cannot be found in the Pantone or Designer
book), then the output PDF will contain K with the Default attributes.

• If the wrong ink is selected, together with the default ink, then the output PDF will contain
the attributes from the default ink.

Tip:  In Preferred Ink Book, choose the ink book that you use most frequently. When you then
type an ink name in the table, the task searches for this ink in your preferred ink book first. For
example, if you type the ink name '154' and your preferred ink book is set to Pantone Colors
Uncoated, the task will automatically suggest the ink 'PANTONE 154 Uncoated'.

268



7Automation Engine

Overprint: Select one from list. Learn more in Overprint on page 341.

7.53.3.  Separations tab

This tab serves to define which ink each of the input files should be attributed:

Wherever possible, the task will try to define the ink automatically.

If you want to overrule these, select the Ink Type and name yourself.
 

 

7.54.  Create XML File

This task is documented in the chapter Integrating with External Systems. Find a direct link here.

7.55.  Crop LEN File

This task is documented in the chapter Flexo CTP Workflow on page 1340. Find a direct link
here.
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7.56.  Data Collector

This Workflow Control is documented in the chapter "Workflows". See Data Collector on page
773.

7.57.  Data Splitter

This Workflow Control is documented in the chapter "Workflows". See Data Splitter on page
780.

7.58.  Delete File
This task is mostly used at the end of a workflow ticket, where the original input may be
deleted since the workflow has created other data that are more worth keeping..

Tip:  This task can also be combined with the Wait task. For example: first wait 2 hours, then
delete the marked file.

Tip:  To delete marked files, you can perform the following actions: Mark File + any other
action + Select Marked File  + Delete File.

7.59.  Download Files from Esko Cloud

This task is documented in the chapter Integrating with Esko Cloud. Find a direct link here.

7.60.  Download WebCenter Document

This task is documented in the chapter Integrating with WebCenter. Find a direct link here.

7.61.  Enrich Black
This task creates "rich black" areas. Typically cyan is added to make black areas more black.
You can also use this task to enrich areas in other inks than 'process black'.

This task uses the trapping technology as used in the Powertrapper task. It also scans and then
creates (overprinting) objects, which is stores in an extra layer named "Trapping".

In the example below, 80% Cyan is added to all areas containing pure black, resulting in an
enriched black:
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• General tab

• Scan tab

7.61.1.  General Tab

 

 

• Add Inks: You here define what color will be added. This color can contain up to four inks.
Typically 80% C is added to generate rich black, or a more neutral combination of CMY such
as 60% C 40% M 40% Y. Alternatively, you can type in the name of any other ink. When the
percentage next to an ink name is set to 0%, the ink will not be used.

• Choke Distance: To prevent registration errors on the press, you here define a value so that
the generated objects in the added color will be smaller than the original (black) area. This
value is the distance between the edge of the area in the defined color and the edge of the
original (black) object.

Note:  In the PowerTrapper task, this option is named Pull Back.

• Corners: You here specify how sharp corners should be handled.

•  Mitered: If the distance from the base of the trap to the corner point is larger than

the  Miter Ratio multiplied by the trap distance, then the corner will be beveled.
Otherwise, it will remain sharp.

•  Round: All corners end in a round cap.

•  Beveled: See this cut-off shape in the graphic:
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• To:

Define the color of the objects that you want to enrich with the above set ink(s). This ink is
typically Process Black. Alternatively, you can type in the name of any other ink.

• Minimal Density: Define the minimum percentage that the To ink needs to have in an
area before the specified color will be added to that area.

7.61.2.  Scan Tab

 

 

• Objects:

• All: All objects in the file will be considered.
• Green Selection: Only objects that were saved as a green selection in PackEdge will be

considered.
• Close Gaps smaller than: Learn more in the page on the PowerTrapper task.

• Restrictions: Define which objects can be ignored (this also speeds up the task):

• Patterns: Ignores native "fill and stroke" patterns. Prior to creating the new objects, fill
patterns are converted to contours. Fine patterns can so result in a huge number of
contours, making this a long and memory heavy task.

• Bitmaps: Ignores bitmap pixel data. This type of data is also contourized before the new
objects are created, which can slow down the task.
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• Overprinting Native Blends: This option is only used in a DeskPack workflow. Certain
native Adobe Illustrator blends cause performance issues. You may ignore these because
they have little or no effect on the result of this task.

• External Objects: Ignores references to external Normalized PDF files (or legacy GRS, LC,
and LP files). When this option is not selected, the external references are degraded to
internal objects prior to creating the objects.

• Existing Trap Layers: Ignores any already existing layers created by this task. This option
is useful when re-launching this task on a file that already has such a layer.

• Don't Trap Text smaller than: Small text must be kept as sharp as possible. The task
risks to blur the sharp edges of small characters, making them harder to read.

The default value is 0 points ; it then creates objects for all text. 1 point equals 1/72 of an
inch.

This option only affects live text objects, not contourized text.

• Allow Different Settings for One Color Pair:

The task can generate a different "trapping" action for different occurrences of a same color
pair.

• Yes is the default value.

• Select No to force the task to apply one identical action to all the occurrences of a same
color pair.

• Select Only for objects bigger than to force the trap expert to apply one identical
action to occurrences of one color pair belonging to small objects, and to allow different
settings for the occurrences belonging to the bigger objects.

7.62.  Expand Dynamic VDP Data
This task creates PDF/VT files from a database containing variable data, using a VDP template
(VDT file).

This task requires:

• a CSV database as input
• a VDT template.
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Database File:

• Encoding: Choose the correct character encoding to ensure accurate interpretation of the
database entries.

Note:  The default encoding is UTF-8. This is also the recommended encoding.

• Field Separator: Let the task Detect automatically or choose , (Comma), ; (Semicolon),
Space or Tab.

• Empty lines: Choose what needs to happen with empty lines in the input CSV file. Only lines
ending with CR, LF or CR LF can be detected as an empty line (it is possible to mix different
line endings in a single file). All empty lines at the end of the file are skipped.

• Field Names: Field names map data chunks from the database entry to its corresponding
VDP template items. Choose from:

• From CSV File: When selected, the task will extract Field Names from the first record of
the CSV file by default.

Attention:  Field Names can only contain the following characters: lower- or
upper-case ASCII letters ("a-z, A-Z"), digits ("0-9") or underscore ("_").

• From Header File: When selected, define a Header File that contains the Field Names.
Such a file

• should contain a single line specifying the Field Names

• should have a Field Name corresponding to each column in the CSV file.

• and the CSV file must use the same delimiter and encoding.

• Header File: (described above). Browse or use SmartNames to define this file.

Dynamic VDP:

• Template: Define the VDP template file that contains artwork and the placeholders
necessary to generate the task output.

Note:  The VDP template can be created and exported using Dynamic VDP DeskPack Plug-in
for Adobe Illustrator.

• Image Path: If the database file has image references, provide the Image path.
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7.63.  Export ArtiosCAD Design Info

What?

This task exports an ArtiosCAD design to an XML file. This XML file is then interpreted by an
external system.

This task is also typically launched by that external system.

More Info

This task is set up by an Esko Solution Architect. Learn about Esko Solution Services on https://
www.esko.com/support/solution-services.

For more information, search for online articles on this topic in the Esko Knowledge Base.

7.64.  Export ArtiosCAD Print Item as ARD File

What?

This task exports a Print Item as a new ARD design from an ARD design that has multiple print
items.

More Info

This task is set up by an Esko Solution Architect. Learn about Esko Solution Services on https://
www.esko.com/support/solution-services.

For more information, search for online articles on this topic in the Esko Knowledge Base.

7.65.  Export ArtPro to Normalized PDF File
This task converts an ArtPro file to a Normalized PDF file.
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• Preferred Ink Book: Select the ink book that the task should check when processing inks
that are not in the predefined ink books (such as the 'process' and PANTONE ink books).

For each ink in the ArtPro file, the task will:

• First look in the predefined ink books (such as the 'process' and PANTONE ink books),
• then in the Preferred Ink Book that was selected here.

• If it doesn't find the ink in the Preferred Ink Book, it will be saved as an unregistered
ink.

• If the ink is not present in the color database, it will also be saved as an unregistered ink.

• Search for missing images in: When the ArtPro file contains links to images that the task
can't access, you can copy those images to a folder within an Automation Engine Container,
and browse to that folder here.

• Embed all images: Embeds all images referenced in the ArtPro document into the PDF file.

• Add non-printable layers: When selected, layers set to "non printing" are also exported
into the PDF file.

• Add fully transparent objects: When selected, objects that are completely transparent will
be included in the PDF file.

• Folder Mapping: When the ArtPro file contains links to images that reside on a Mac OS-
based file server, you can mount the drive of the Mac OS server on the Automation Engine
server and use this 'Folder Mapping' table to keep the links to the images working in the
output file.

To map folders from the ArtPro file to the Normalized PDF file:

1. Click Add.
2. In the Client column, type the drive name on the Mac OS system.
3. In the Server column, type the drive letter that is used to mount the Mac OS drive on the

Automation Engine server.

For example, in our ArtPro file, the path to an externally linked image is:
Intel_Mac:images:image1.

We mount the Intel_Mac drive of the Mac OS file server on our Windows-based
Automation Engine system, using the drive letter G:\.

The task will find the images when you map the folders Intel_Mac to G:\ .
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7.66.  Export IMP File to GRI File

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.67.  Export IMP File to JDF Layout

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.68.  Export IMP File to JDF Post-Press

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.69.  Export IMP File to PDF File

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.70.  Export IMP File to PDF File Chain

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.71.  Export IMP File to PostScript File

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.
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7.72.  Export Imposition to JDF Layout

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.73.  Export Imposition to PDF File

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.74.  Export Nested Layouts
This task is described in the chapter Gang Run Printing. Find a direct link here.

7.75.  Export PDF Info

Concept
This task creates a preview image (JPEG or PNG) and/or an XML file describing the metadata of
the task's input file(s).

By default, this task uses the graphic kernel of ArtPro+ or the one from Enfocus. This means it
supports native PDF (+) files as input. However it also supports input of normalized PDF files.

Note:  The task Create PAF / JPG / XML (LinkEdge) also exports preview data and metadata but
uses the BRIX graphic kernel. This means it supports normalized PDF files by default. But also
here, PDF native (+) input files are supported but those will first be normalized internally. Note
that this task extracts the XMP metadata that is already present on board the normalized PDF
file.

Note:  The ink coverage information is calculated in the same way as it is done in ArtPro+ (i.e.
how the Marks calculate it there).

Preview tab
• Create preview image: An image is made of the trim box of the PDF (RGB, 8 bits per

channel).

It is color managed, this means that BGCMS ink books are used to render the separations.
The document color profile is taken into account when calculating the RGB values.

• Set: Choose what is more important: the resolution of the image, or its dimensions?
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• Resolution:

• Resolution: Specify a resolution in ppi (default) or ppcm or ppmm. The field also
accepts some calculations, for example 72 px / 25.4 mm .

• Limit: Alternatively, limit the resolution by specifying the maximum number of rows
(Width) or columns in the image (Height).

Note:  This mode is useful to control the size of the image when seen on a screen (based
on the resolution setting of that screen).

• Dimensions: Alternatively, you can set the number of rows (Image Width) or columns
(Image Height) that the image must have. Be aware that this can result in white areas
(pixels) left/right or top/bottom of the image.

Note:  This mode is useful to control the size of the image on any output (paper).

• Image Format: JPEG or PNG files, both RGB.
• Compression: When creating JPEG files, select the level of compression. Higher

compression results in smaller files but less precise data.
• Anti-aliasing: An extra filter that enhances the quality of the image.

• No Anti-aliasing: The image is rendered at the requested resolution, no anti-alias filter is
applied.

• Normal Quality: This level of anti-alias means that the file is rendered at double
resolution and each cluster of 4 (2 x 2) pixels is averaged into 1 output pixel.

• Best Quality: This level means the file is rendered at 4x the resolution and each cluster
of 16 (4 x 4) pixels is averaged into 1 output pixel.

• Page Range: One preview file per selected PDF Page. The name of the image will get a suffix
to indicate the page number (' _p1', ' _p2', …).

To specify a page selection, the typical syntax is valid. Some examples:

• To select pages 3 to 8: type 3-8
• To select pages 1 to 5: type 1-5 or type -5
• To select pages 6 till the last page, type 6-
• To select pages 2 to 5 and also 12 to 19, type 2-5,12-19

Note:  For a multi page file, the ink coverage is not calculated per page but in ranges of
pages. When the PDF has more than 100 pages, ink coverage is not calculated.

XML tab

• Create XML report: An XML file that describes the input file, typically to be interpreted by
other systems (DAM, MIS, ERP, inspection, etc.)

Learn all about the format of this output XML in below page.

Note:  Learn about different types of metadata in Esko's file formats in the chapter "PDF
formats and their Metadata", in the section on PDF+ in Automation Engine on page 51.
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7.75.1.  XML specification of Metadata+

Main components in Metadata+

Metadata+ is an XML serialization of an extended version of ISO 21812-1.

• The document root node is DPartRoot.
• The document root contains a single Assembly DPart Node.

• The DPM/Root/Metadata element contains admin data like project, job and customer
data.

• The DPM/Root/AssemblingIntent defines which components are included in this
assembly.

• The DPM/Root/Production/RunList contains the URL of the PDF that was used to derive
these metadata.

• The DPart child nodes of this node can be Assembly DPart Nodes or Component DPart
Nodes.

Attention:  In the current implementation, the Assembly level DPart nodes are omitted.
This is because Esko editors do not yet add this kind of metadata to documents.

• A Component DPart Node describes a physical entity.

• The Root/@Amount node defines how many components are used in the assembly from
which it is referred.

• The Root/Intent/MediaIntent defines the substrate of this component.
• The Root/Production/Resource/ShapeDef defines the shape of the produced component.

This can be a reference to a CAD file.
• The DPart child nodes of a Component DPart Node are Side DPart Nodes.

• A Side DPart Node describes a printed surface of a component.

• The Root/Intent/@eg:Side attribute defines the side.
• The Root/@Start and Root/@End attributes define start and end page in the PDF for the

graphics of this side of the component.
• The Root/Production/ColorantControl element defines the colorants that are used on the

side of the component and their order. Root/Production/Resource/Color elements define
the characteristics of these colorants.

• The Root/Production/Resource/eg:InkCoverage element defines ink coverage data.

Diagram
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The above text and diagram reflect the most general case. In simpler cases the structure can
be condensed, for example the Assembly DPart Node can be omitted for a single part product.

Example

<?xml version="1.0" encoding="UTF-8" standalone="no" ?>
<DPartRoot ID="0001" NodeNameList="Root DocPart" xmlns:cip4="http://www.CIP4.org/
JDFSchema_2_0" xmlns:eg="http://www.esko.com/EskoXJDF">

  <DPart DParts="0003" ID="0002" ParentRef="0001">
    <DPM>
      <cip4:Root cip4:ExternalID="1-079055-01">
        <cip4:Production>
          <cip4:Resource>
            <cip4:RunList cip4:NPage="1">
              <cip4:FileSpec URL="file://eskw190090/ExampleJobContainer/
Products/4000/1-079055-01/1-079055-01.pdf" eg:SmartID="y4t7s"/>
            </cip4:RunList>
          </cip4:Resource>
        </cip4:Production>
        <cip4:Metadata cip4:DescriptiveName="Wintercollection 2019"
 cip4:JobID="Wintercollection 2019" cip4:ProjectID="Bubbles Winter 2019">
          <cip4:Sender cip4:ContactTypes="Customer">
            <cip4:Company cip4:CompanyID="4000" cip4:OrganizationName="Bubbles bvba"/>
          </cip4:Sender>
        </cip4:Metadata>
      </cip4:Root>
    </DPM>
  </DPart>

  <DPart End="0" ID="0003" ParentRef="0002" Start="0">
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    <DPM>
      <cip4:Root>
        <cip4:Intent cip4:ProductType="ProductPart"/>
        <cip4:Production>
          <cip4:Resource>
            <cip4:Color cip4:ActualColorName="white screen" cip4:ColorBook="designer"
 cip4:ColorBookEntry="white screen" cip4:ColorType="Opaque" cip4:Lab="100.000000
 -128.000000 -128.000000" cip4:Part="S1" cip4:PrintingTechnology="Unknown"/>
          </cip4:Resource>
          <cip4:Resource>
            <cip4:Color cip4:ActualColorName="Cyan" cip4:ColorType="Normal"
 cip4:Lab="64.146841 -18.246758 -33.574261" cip4:Part="C1"
 cip4:PrintingTechnology="Unknown"/>
          </cip4:Resource>
          <cip4:Resource>
            <cip4:Color cip4:ActualColorName="Magenta" cip4:ColorType="Normal"
 cip4:Lab="47.603270 71.332470 1.368770" cip4:Part="M1"
 cip4:PrintingTechnology="Unknown"/>
          </cip4:Resource>
          <cip4:Resource>
            <cip4:Color cip4:ActualColorName="Yellow" cip4:ColorType="Normal"
 cip4:Lab="90.036958 -13.226733 83.807520" cip4:Part="Y1"
 cip4:PrintingTechnology="Unknown"/>
          </cip4:Resource>
          <cip4:Resource>
            <cip4:Color cip4:ActualColorName="PANTONE Dark Blue C"
 cip4:ColorBook="PANTONE GoeGuide Coated" cip4:ColorBookEntry="PANTONE Dark Blue C"
 cip4:ColorType="Normal" cip4:Lab="20.856725 29.076063 -68.454417" cip4:Part="S2"
 cip4:PrintingTechnology="Unknown"/>
          </cip4:Resource>
          <cip4:Resource>
            <cip4:Color cip4:ActualColorName="die cut" cip4:ColorBook="Visualizer
 Standard Finishes" cip4:ColorBookEntry="die cut" cip4:ColorType="Normal"
 cip4:Lab="47.999999 66.000004 46.000005" cip4:Part="S3"
 cip4:PrintingTechnology="Unknown"/>
          </cip4:Resource>
          <cip4:Resource>
            <cip4:ColorantControl ColorantOrder="S1 C1 M1 Y1 S2 S3" ColorantParams="S1 C1
 M1 Y1 S2 S3"/>
          </cip4:Resource>
          <cip4:Resource>
            <cip4:ShapeDef CutBox="0.0 0.0 461.026770 237.599980">
              <cip4:FlleSpec URL="shower gel medium.DAE"/>
            </cip4:ShapeDef>
          </cip4:Resource>
          <cip4:Resource>
            <eg:InkCoverage>
              <eg:InkCov cip4:Part="S1" eg:Mm2="53.315034" eg:Pct="0.391088"/>
              <eg:InkCov cip4:Part="C1" eg:Mm2="2458.345685" eg:Pct="18.032998"/>
              <eg:InkCov cip4:Part="M1" eg:Mm2="543.030848" eg:Pct="3.983359"/>
              <eg:InkCov cip4:Part="Y1" eg:Mm2="588.284119" eg:Pct="4.315311"/>
              <eg:InkCov cip4:Part="S2" eg:Mm2="551.882149" eg:Pct="4.048287"/>
              <eg:InkCov cip4:Part="S3" eg:Mm2="334.312166" eg:Pct="2.452320"/>
            </eg:InkCoverage>
          </cip4:Resource>
          <cip4:Resource>
            <cip4:RunList cip4:SourceMediaBox="0.000000 0.000000 294.292914 517.719685"
 cip4:SourceTrimBox="28.346457 28.346457 265.946457 489.373229"/>
          </cip4:Resource>
        </cip4:Production>
      </cip4:Root>
    </DPM>
  </DPart>

</DPartRoot>

The component DPart node
The component DPart node contains:
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XML node Value Example

DPart/DPM/Root/
Production/Resource/
RunList/FileSpec/@URL

DPart/DPM/Root/
Production/Resource/
RunList/FileSpec/
@eg:SmartID

[URL of Input] the
complete URL of the PDF
file

[SmartID]the smartID of
the PDF file

<cip4:FileSpec URL="file://
AEserver01/ExaCont/
Prods/40/79055/1-079055-01.pdf"
eg:SmartID="12bxg5d"/>

DPart/DPM/Root/
Production/Resource/
RunList/@NPage

The number of pages in
the document

<cip4:RunList cip4:NPage="1">

DPart/DPM/Root/Metadata/
Sender/Company/
@CompanyID

DPart/DPM/Root/Metadata/
Sender/Company/
@OrganizationName

[Job Customer ID]

[Job Customer Name]

<cip4:Company
cip4:CompanyID="4000"
cip4:OrganizationName="Bubbles
bvba"/>

DPart/DPM/Root/Metadata/
@DescriptiveName

DPart/DPM/Root/Metadata/
@JobID

DPart/DPM/Root/Metadata/
@ProjectID

[Job Name]

[Order ID]

[Project ID]

<cip4:Metadata
cip4:DescriptiveName="Wintercollection
2019" cip4:JobID="Wintercollection
2019" cip4:ProjectID="Bubbles Winter
2019">

DPart/DPM/Root/ExternalID [Product Part Name]
(in case the PDF is a
product)

<cip4:Root
cip4:ExternalID="1-079055-01">

DPart/@DParts List of side DPart node
ID's

<DPart DParts="0003" ID="0002"
ParentRef="0001">

The Side DPart node
The Side DPart node contains:

XML node Value Example

DPart/@ID

DPart/@Start

DPart/@End

This node's ID

the start page of the PDF
described by this node

the end page of the PDF
described by this node

<DPart End="0" ID="0003"
ParentRef="0002" Start="0">

DPart/DPM/Root/Production/
Resource/ColorantControl/
@ColorantParams

defines all the colorant
identifiers

the ordering of the
colorant identifiers

<cip4:ColorantControl
ColorantOrder="S1 C1 M1 Y1 S2 S3
S4" ColorantParams="S1 C1 M1 Y1
S2 S3 S4"/>
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XML node Value Example
DPart/DPM/Root/Production/
Resource/ColorantControl/
@ColorantOrder

DPart/DPM/Root/
Production/Resource/Color/
@ActualColorName

DPart/DPM/Root/Production/
Resource/Color/@Part

DPart/DPM/Root/Production/
Resource/Color/@ColorBook

DPart/DPM/Root/Production/
Resource/Color/@ColorType

DPart/DPM/Root/
Production/Resource/Color/
@ColorBookEntry

DPart/DPM/Root/
Production/Resource/Color/
@PrintingTechnology

DPart/DPM/Root/Production/
Resource/Color/@Lab

Actual name of the
separation in the PDF

The colorant identifier

the ink book of this
separation

Any of Normal, Opaque,
Technical, Varnish

Name of the separation
in the ink book

The printing method of
the separation

The Lab values of the
separation

<cip4:Color
cip4:ActualColorName="PANTONE
Dark Blue C"
cip4:ColorBook="PANTONE
GoeGuide Coated"
cip4:ColorBookEntry="PANTONE
Dark Blue C"
cip4:ColorType="Normal"
cip4:Lab="20.856725 29.076063
-68.454417" cip4:Part="S2"
cip4:PrintingTechnology="Unknown"/
>

DPart/DPM/Root/Production/
Resource/eg:InkCoverage/
eg:InkCov/@Part

DPart/DPM/Root/Production/
Resource/eg:InkCoverage/
eg:InkCov/@eg:Pct

DPart/DPM/Root/Production/
Resource/eg:InkCoverage/
eg:InkCov/@eg:Mm2

The colorant identifier

The inkcoverage as % of
the trim box area

The ink coverage value in
square mm

<eg:InkCov cip4:Part="C1"
eg:Pct="50.0" eg:Mm2="100.0"/>

DPart/DPM/Root/Production/
Resource/Runlist/
SourceMediaBox

DPart/DPM/Root/Production/
Resource/Runlist/
SourceMediaBox

The bounding box of the
media box (in pt)

The bounding of the
trim box (relative to the
mediabo)

<cip4:RunList
cip4:SourceMediaBox="0.000000
0.000000 246.103914 469.530707"
cip4:SourceTrimBox="4.251969
4.251969 241.851946 465.278738"/
>

DPart/DPM/Root/Production/
Resource/ShapeDef/FileSpec/
@URL

DPart/DPM/Root/Production/
Resource/ShapeDef/@CutBox

The relative URL of the
structural design object

The bounding box of the
(non-rotated) structural
design object

<cip4:ShapeDef CutBox="0.0
0.0 461.026770 237.599980">
<cip4:FlleSpec URL="shower gel
medium.DAE"/> </cip4:ShapeDef>
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More Examples
Click this link to download these example XML files:

• The example shown on this page: EXA_1-079055-01.xml
• A duplex printed folding carton: FC_dpm.xml
• A duo-label: LabML_dpm.xml
• A display: Display_dpm.xml

7.76.  Export Step and Repeat to JDF Layout
This task exports a Step and Repeat layout to a "JDF Layout" file that contains references PDF
1.5 files containing the stations, masks and marks.

You can choose the JDF Version: 1.2 or 1.3.

Create MIME file: Select this to get the JDF and the referenced PDF files all together in a MIME
packed file.

7.77.  Export to 3D

Concept

This task creates 3D files which you can view in 3D viewers. The input file needs to be a
Normalized PDF or PDFSTA (Station file) that links to a structural design file: an ArtiosCAD ARD
file or a Collada file (DAE or ZAE).
 

 

About Structural Design Files
A structural design file (2D and 3D) contains all the cut and crease lines for a specific shape.
It can also contain folding angles that define how it should be folded into its final shape. A
structural design file does not contain the graphics, only the definition of the shape.

The link between a graphics design and its structural design (shape) can be done in an editor
(ArtPro, PackEdge or Adobe Illustrator (using the Esko Data Exchange plug-ins). ARD files can
also be linked to a graphic using the Load Structural File task.
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3D data can be created by using one of these structural design file formats:

• ARD files, created in ArtiosCAD or Studio Toolkit for Boxes

• .ZAE files, created in Studio Toolkit for Flexibles.

• .DAE or .ZAE Collada files. These can have a printable part (an Esko extension to the
Collada format). Such Collada files can be created in Studio Designer, Studio Toolkit for
Shrink Sleeves, Studio Toolkit for Labels and ArtiosCAD.

 

 

7.77.1.  Export to 3D Settings

 

 

• Export to single output file:
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• When not selected, an output file is produced for each page and for each input file that
contains a link to a structural design file.

• When the input file is a multipage file, the page number will be added as suffix to the
output file name.

• When the output file matches the input file name (e.g. when exporting to PDF and no
output name is specified), the output file name will get "_3D" as suffix.

• When selected, one output file is produced.

• When a scene is selected, the input files/pages matching the parts of the scene will be
used in the output.

• When no scene is selected,

• and the input files/pages contain different printable parts of 1 Collada file, then the
Collada file is used as scene and the input files/pages matching the printable parts
of Collada file will be used in the output.

• and the first input file does not refer to a Collada file, then only the first input file is
used in the output and the other input files/pages will be ignored.

• Scene: A scene allows to combine multiple task input files into a combined shape. These
input files could be

• multiple input PDFs containing the same structural design,
• one input PDF with three pages referring to one part of a scene,
• multiple input single page PDFs referring to one part of a scene,

Note:  A scene is a .ZAE file that you can create in Esko ArtiosCAD and Studio Toolkit. It
contains links to multiple .ARD or Collada files.

• Output File Type: Choose from these file formats:

• Tiff Image. A 2D image.

• PDF File with 3D Design: Enables to view the 3D in Adobe Reader or Acrobat
Professional (version 8.0.1 or later).

• U3D File: A common exchange format for 3D objects that you can place in Acrobat
Professional (version 8.0.1 or higher).

• Collada file: A common exchange format for 3D objects that can also be viewed in Esko
Studio Viewer and in Esko WebCenter's integrated 3D Viewer.

Settings per File Type:

• Exporting to Collada

• Choose Collada File as File Type and specify the Resolution of the image(s).

• Define the View Angle from which the object should be rendered. You can either specify
them manually here or inherit the angles from the scene file (using the angle that the file
was saved with in Illustrator, Studio or PackEdge).

• Adapt the Perspective. A high value has the effect of a camera with a wide angle lens,
close to the object. A low value has the effect of a camera with a zoom lens, further away
from the object. The default is 45 degrees.
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Note:  The object will always fit completely inside the exported image.

• Choose White or Black as Background Color.
• Include Printable Parts: Deselect this to make a 3D that only serves to be viewed. Select

it to allow the receiver to edit it, for example to place variant graphics.
• Exporting to TIFF

• Choose Tiff Image as File Type and specify its Resolution.
• Define the Width / Height of the image. The TIFF image will always be square and will

contain the whole shape.
• Define the View Angle and Perspective.
• Choose a Background Color: White, Black or Transparent (useful when placing the

image in others).
• Exporting to PDF with 3D Design

• Choose PDF File with 3D Design as File Type and define its Width, Height and
Resolution.

• Show Footer: Select it to add a (custom) Footer Text.
• Define the View Angle and Perspective.
• Choose White or Black as Background Color.

• Exporting to U3D File

• Choose U3D File as File Type and define its Resolution.
• Define the View Angle and Perspective.
• Choose White or Black as Background Color.

7.78.  Export to ArtPro File
This task exports a Normalized PDF file to an ArtPro file.

Choose the ArtPro Version:

• an ArtPro 10.x/9.x/8.x file
• an ArtPro 7.5/7.0 file. These do not contain version-specific information or blend modes

(the file will be flattened).

Copy linked files next to output file: Select this to copy the linked images next to the created
ArtPro file.

7.79.  Export to EPS/DCS File
The task settings are spread over five tabs:
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• Output

• Color Management: These settings are identical in the Color Management tab of the
PostScript Export task.

• Rasterize: These settings are identical in the Rasterize tab of the PostScript Export task.

• Compression: These settings are identical in the Compression tab of the PostScript Export
task.

• Advanced: These settings are identical in the Advanced tab of the PostScript Export task.

7.79.1.  Output

 

 

• PostScript version: Choose between 2 or 3.

• Output type:

• EPS. This creates an EPS file with an RGB preview. Select PostScript 3 and deselect color
management (in the tab 'Color management') to create a 'deviceN' EPS. In all other cases
a CMYK composite EPS will be created.

• Single DCS file. This creates an EPS DCS file with multiple separations. The RGB preview
of the DCS file is used when placing the EPS DCS file. In addition, a grayscale composite
or color CMYK preview can be added for composite printing.

• Multiple DCS file. This creates a master EPS DCS file referring to multiple separations
(one file per ink). The names of the 'Multiple DCS' files consist of the name of the original
EPS DCS file followed by _C, _M, _Y, _K or _1, _2, _3, ... (for all non-process inks). The files
have an extension .x.

The RGB preview of the Master DCS file is used when placing the EPS DCS file. In
addition, a grayscale composite or color CMYK preview can be added for composite
printing.

• Preview Resolution: This is the resolution of the RGB preview used when placing the EPS
DCS file. A higher value will produce a finer, more detailed preview but will also increase the
files size of the EPS DCS. The default and minimal value is 72 ppi.

• Resolution: If you do not know where the EPS will be placed, you best request a high
resolution file (the default is 4.000 ppi.). Mind that, the higher the resolution, the bigger the
size of the EPS file will be.
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• Page number: Select a page if you only want to export that page of your input file.

• Scale: Allows you to scale the file, for example at 50%.

• Vert.  and Hor. Distortion: Use one of these fields if you want a different scaling in either
direction (max 90%).

• SmartMarks: If you want to add any, select or define a set.

• Account for job margins: Select this to also include the data between the borders (Trim
Box) and the margins (Media Box).

• Hide trap layer(s) in output: Select this if you do not want those objects in the output file.

7.80.  Export to Normalized PDF File
This task converts a GRS file to a Normalized PDF file. GRS is a legacy Esko file format.

 

 

External References

External references have to be converted. Choose your preference:

• Write local external references to the output folder and other external references to
their original folder.

When exporting, external references in subfolders or neighboring folders will be written to
the output folder. External references in for example central folders will be written in their
original folder.

• Write all external references to the output folder.

• Write all external references to their original folder.

When converting again, you can choose to:
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• Reconvert if recently updated: Only updated references will be reconverted, all other
conversions will be used as they were.

• Use previous conversions: The existing conversions will be used. Potential updates will not
be considered.

• Always reconvert: All external references will be converted at all times.

Embed External Images

Referenced external files in GRS format can be converted to referenced files in Normalized PDF
file format. Define which images you want to have converted:

1. All images.
2. Images with uncompressed data size smaller than 640 kB (as specified in Configure

> Processing Preferences > Embedded Images). This option is identical to the option in the
Images tab of the Normalize PostScript / PDF / Illustrator 8.0 File task.

3. None.

Copy Other Images to Output Folder

Indicate what should happen with the external images. You can have them copied to the
output folder, or you can choose to leave them in their original folder.

Fail when fonts are not found

When the fonts used in the file are not found the task will fail, when the toggle is not selected,
the task will end with a warning.

Fail when external references are not found

The task will fail when not all external files were found.

7.81.  Export to Normalized PDF File (Embed All)
You can use this task to create a self-contained version of a Normalized PDF file with
references or of a PDFPLA file.

This task embeds all the external references, images and fonts into the Normalized PDF output
file.
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Note:  The Export to Normalized PDF task only allows to embed images.

7.82.  Export to PDF File

Concept

This task exports Normalized (layout) PDFs to a native PDF. This task is often used to make a
PDF of a specific version or with specific color settings to match the device it will be used for.
This task is also often used to make a self-contained version of a PDF with external references,
which makes it easier to exchange this data to someone else.

Factory settings

The Default ticket of this task offers Factory settings. Selecting one is a quick way to
define the many ticket parameters. After selecting such a 'preset', you can still change any
parameters.

• PDF for data interchange. Use to send this graphic data out.

• (PDF 1.3): Offers high compatibility but slow and less editable. Use this if it needs to be
opened in Acrobat 4 or lower, or if a RIP requires this format.

• (PDF 1.4): For interchange with recent applications, well editable. For example Acrobat 5
and higher.

• (PDF 1.5): For interchange with recent applications, well editable. For example Acrobat 6
and higher.

• (PDF 1.6): For interchange with recent applications, well editable. For example Acrobat 7
and higher.

• PDF/X: PDF/X is a standardized subset of PDF designed specifically for reliable
interchange of prepress data. It is used for RIP'ing and imposition.

• (PDF/X-1a:2001 (ISO/DIS 15930-1)): PDF/X-1a ensures complete data exchange using
CMYK and spot color data.

• (PDF/X-3:2003 (ISO/DIS 15930-3)): PDF/X-3 ensures complete data exchange suitable
for coloured managed workflows.

• PDF for Illustrator CS2 or higher: For a PDF file meant to be edited in Adobe Illustrator
CS2 or higher.

Attention:  This version improves the editability in Adobe Illustrator, but does not
guarantee full editability.

• PDF for viewing/proofing

• CMYK Composite: Useful when using hard copy proofers, or when the result doesn't
have to be editable or when the result is used for soft-proofing. It is not useful to serve
as final output.

• RGB: Useful for soft-proofing ; a smaller file, and faster to generate.
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• DeviceN: Data interchange file for proofing/viewing (all separations present). Adobe
Acrobat Reader 7.0 or later is required to view the overprint settings correctly.

Note:  Even though, for trapping reasons, Acrobat 7 Professional and higher allow to define an
ink as Opaque ("Ink Manager"), this has no influence on the PDF preview.

Detailed settings

The many ticket parameters are divided over seven tabs:

• Output on page 293
• Device on page 296
• Color Management on page 296
• Inks, similar to the tab Inks/Separations in the "Export to PostScript" task.
• Rasterize, similar to the tab Rasterize in the "Export to PostScript" task.
• Compression on page 298
• Advanced on page 299.

7.82.1.  Output

 

 

• PDF Version:

• PDF 1.6: The Acrobat 7 file format.
• PDF 1.5: The Acrobat 6 file format.
• PDF 1.4: The Acrobat 5 file format.
• PDF 1.3: The Acrobat 4 file format.
• PDF for Illustrator: Select this if the generated PDF 1.4 file will be opened in Adobe

Illustrator CS2 or higher. Because Adobe Illustrator only supports an (undocumented)
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subset of PDF 1.4 features, some objects and/or color-spaces will be split up,
transformed and/or pre-ripped in order to correctly represent them in Illustrator.

• PDF/X-1a:2001 (ISO/DIS 15930-1) and PDF/X-3:2003 (ISO/DIS 15930-3). Learn more
about these versions here.

Note:  You can find an (old) white paper about using PDF/X-4 on this link.

• Password security: Learn more in Password Security on page 294.

• Output type

• Composite: Select this to create a composite file which, if no color management is used,
produces a 'DeviceN' PDF for data interchange. DeviceN means that its colors can be
combinations of the standard CMYK process colors and/or spot colors. This guarantees
perfectly separable PDF files which can also be proofed on a composite PostScript 3
device. Such a PDF file will both proof and separate correctly. Color management for
spot color objects must then be handled by the device.

• Separated: Select this to create a PDF with multiple pages, one page per ink.

• Emulsion Up: Select Right Reading (= emulsion up) or Wrong Reading (= emulsion
down).

• Image: Select Positive or Negative print mode.

• Vert.  and Hor. Distortion: Use one of these fields if you want a different scaling in either
direction (max 90%).

• Scale: Allows you to scale the file, for example at 50% to get a smaller MB size when E-
mailing the PDF.

• SmartMarks: Add SmartMarks if you want, for example to add the ink coverage on a proof
PDF.

• Account for job margins: Select this to also include the data between the borders (Trim
Box) and the margins (Media Box).

• Hide trap layer(s) in output: Select this if you do not want those objects in the output file.

• Page Range: When your input file has multiple pages, define here if you want All or a
selection of these pages in your output PDF file.

Password Security

Note:  The options in this dialog depend on the PDF version that you chose in the Output tab of
the 'Export to PDF' task).
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• Compatibility: The security features depends on the Acrobat version that you want to
output. Your choice defines the Encryption level.

• Require a password to open the document: If this is what you want, enter a password.
Communicate this password to the people that you allow to open this file.

• Permissions (some options depend on the selected Compatibility):

• Use a password to restrict permissions: If you want to use any of the below options,
enter a specific Permissions Password and communicate it to the right people.

• Printing Allowed: Select None if no-one is allowed to print this file. Select a Resolution
if the receiver may print it at that level of quality.

• Changes allowed:

• Select None to prevent users from making any changes, not even filling in signature
or form fields.

• Select Inserting, deleting and rotating to allow such changes, as well as create
bookmarks and thumbnail pages.

• Select Any except extracting pages to allow users any changes except extracting
pages.

• Select Enable copying of content to allow the user to do this.

• Select Enable text Access to allow visually impaired users to read the file with screen
readers. This option does not allow users to copy or extract any contents.
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• Enable plaintext metadata: This allows searching the file's properties while still
protecting its content.

7.82.2.  Device

You can make a PDF 'device specific' by adding a description of the required dot gain
compensation curves inside that PDF.

Attention:  These curves are not calculated, but stored as 'PDF standard transfer
curves'. Opening the PDF in Acrobat will not show any difference.

You can create Dot Gain Compensation curves (DGC) with Esko Curve Pilot.

• Single Curve: Select one DGC curve (.dgc file) that will be applied to all your data.

• Automatic: Allows you to select one of these types:

• A Screen-Based DGC table (.scrdgc file), to apply dot gain compensation selectively,
depending on the dot shape, screen ruling, angles and even Contone or Linework
properties.

• A DGC Strategy (.icpro file), does the same but also offers ink-based dot gain
compensation.

• A Press sync file (*.prsync). These curve values are inserted as a transfer curve in the
PDF.

Note:  You can also apply both a single curve and an automatic DGC. This then results in a
cumulation of both effects.

7.82.3.  Color Management

 

 
When you choose not to apply any color management when creating the PDF, you can still
embed the document's profile (see below).

When creating a composite PDF, you can choose to Use Color Management with these
options:
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• Convert to: Select to which color space all inks should be converted: CMYK, RGB or Gray
values.

• Use Link Profile: "Link profiles" describe a transformation from one device-dependent
color space to another. This is actually a concatenation of a forward transformation of one
profile and a backward transformation of another profile. A link profile takes complete care
of the color management, so all other options are then disabled.

• Source profile: If any CMYK objects need to be converted, choose a 'source profile'. The list
shows all CMYK print profiles in the color database. The source profile defines the target
that the destination profile is supposed to match.

• Destination profile: Choose a color profile for your destination color space. The list shows
all print profiles in the color database. These profiles are either measured in Color Engine
Pilot or imported ICC-profiles.

• Rendering intent

• Relative (no background): Choose this if you do not want any background simulation.
The white point of the source will be mapped on the white point of the destination
process. This rendering intent takes into account the ability of the human eye to adapt to
the surrounding white.

• Absolute (background): Choose this if you want background simulation and you want
an exact color match, including the paper simulation.

• Perceptual: This will result in no background simulation (white of reference color space
is mapped on white of destination color space). Choose this when you don't care too
much about an exact color match but when want the pictures at least to look nice on
your proofer. It will give a visually pleasing result. If the gamut of the source is wider than
the proofer, the entire gamut is shrunk so that it fits inside the gamut of the proofer.

• Saturation: Choose this if you care especially about saturated colors. This rendering
intent will map saturated colors on saturated colors.

• Black Mapping:

• When selected, the CMY part of the composite colors are converted separately from the
black component. As a result, the type of black separation (Skeleton black, UCR, GCR...) is
preserved by the conversion. It is still possible that the black percentage changes slightly
due to different dot gain in the color profiles.

• When not selected, the converted CMYK colors are completely re-separated into the
black behavior that is built into the destination profile.

• Use the document profile as Source profile if available: If a document profile is defined,
then that one will be used as a source profile. The one chosen from the above Source
Profile list will be overruled.

• Embed the Destination profile as an intermediate color space:

• When not selected, the colors in the PDF file are not tagged with an ICC color profile. The
document is device dependent and its colors will only be reproduced accurately if the
PDF file is output on the device that is specified in the Destination Profile. This choice
is preferable when you are sure the PDF file will be sent to the device specified in the
Destination Profile.

• When selected, the colors in the PDF file are tagged with an ICC color profile. The
document then becomes device independent, and its colors will be reproduced
accurately even on devices with a color space different from the one specified in the
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Destination Profile. In this case, the Destination Profile is an intermediate color space
between the Source Profile and the color profile of the device that will eventually process
the PDF file. This choice is preferable when the PDF file will be sent to an unknown
device.

Embed the document profile as PDF Output intent: The output intent is an ICC profile that
specifies the intended output device. When selected, the document profile will be saved as the
'PDF Output Intent'. For some PDF flavors (PDF-X/3), an output intent is mandatory and this
option is always on.

When no document profile was set explicitly, the default document profile is used instead
(crom_offs). When the document profile is a Color Engine Pilot profile, it will first be
converted to an ICC profile.

7.82.4.  Compression

 

 

General

• Optimized lossless image compression: Selecting an overall lossless image compression
seldom results in the smallest overall file size. This optimization chooses the smallest
lossless compression method for every image separately ( JPEG2000, Flate, FlateDiff, LZW,
LZWDiff, CCITT3, CCITT4 or Run Length). Its choice depends on the image type and on the
compression methods that are allowed for the chosen PDF version.

Selecting this option disables the compression methods for Bitmaps and Contones. It
also sets the encoding to Binary, which we advise to keep, otherwise the resulting file will
become larger.

Attention:  Selecting this option considerably slows down this task, so only use it
when the size of the file is critical.

• Crop images on clip mask: When selected, all information outside the clip mask will not be
exported.

• Encoding

• Binary: The image data is represented as binary data. This results in compact files. Such
files are not editable in a common ASCII editor. Nor can these files be transferred using a
communication protocol that relies on control characters in the data stream itself.

• Hex: This forces the output to remain editable with an ASCII editor. It can then also can
be transferred using whatever communication protocol is available. The drawback is that
hexadecimal image data can take up to twice as much size as binary data.
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• ASCII 85: Encodes binary data in an ASCII base-85 representation. This encoding uses
nearly all of the printable ASCII characters. The resulting expansion factor is 4:5, making
this encoding more efficient than hexadecimal.

Bitmaps

• Downsample: Referenced images are sub-sampled approximately to the specified
value. This reduces the size of the output PDF file. The unit is the one defined in Edit >
Preferences. Be aware that 1–bit (copydot) images cannot be downsampled.

• Compression: Choose the type: None or CCITT group 3 / 4, Run Length, LZW (Diff), Flate
(ZIP) (Diff).

Contones

• Downsample: The images referenced in your design are sub-sampled to approximately the
specified value. This allows to reduce the size of the generated PDF file. The unit is the one
defined in Edit > Preferences.

• Compression: Choose the type: None or LZW (Diff), JPEG(2000), Flate (ZIP) (Diff).

JPEG compressions allow to specify the quality of the compression..

Text and Lineart

• Compression: Choose the type: None or LZW or Flate (ZIP).

7.82.5.  Advanced

 

 

Fonts

Choose what to do with the fonts used by your input file's live text:

• Contourize fonts: To convert all text into lineart.

• Embed BG and Type1 and CID fonts

Note:  Protected CID fonts will be referenced by name.

Split Complex Paths: When a device requires that you create an old version of PDF (1.3), it
may also require that you split very complex paths into smaller ones.
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Note:  These are workarounds for typical PostScript level 1 path limitations. Only use these
when absolutely necessary.

• Filled and stroked paths at: Use this option to split linework with more than x points into
several smaller linework parts. This decreases the complexity of the linework. A suitable
value for the selected Device type is calculated automatically.

• Clip paths at: Use this option to split linework masks for images with more than x points
into several smaller linework parts. This decreases the complexity of the masks.

Workaround

• Limit file name to 31 characters: Select this when the system that will read your output
file is limited to 31 characters.

• Ignore varnish inks: Select this to exclude varnish inks in your output.

• Resolve pure black overprint: Overprints are normally resolved, but by default, pure black
is left untouched. Select this option when you also want pure black to be resolved. This
option is only available when Use Color Management is selected.

• Resolve once identical external files: Instead of resolving the complete file and all its
external references, identical external files will be resolved only once.

• Resolve once identical one-ups in Step & Repeat file: Instead of resolving the complete
Step & Repeat file, identical one-ups will be resolved only once.

• Suffix for PANTONE ink names: Enter a suffix for PANTONE ink names. The default is 'C'.
For example: PANTONE 123 so becomes PANTONE 123 C . Existing suffixes will be replaced
by this one.

• Split multi page job into multiple files: Every page of a multi page file will be output as a
separate PDF file.

• Add Ruling, Angle and Dot Shape information in PDF Data section: Select this if the non-
Esko RIP that will read the PDF will want to get such screening information from inside the
PDF itself. This makes the PDF device-dependant.

• Add Ink Coverage data in XMP: Select this to add such data into the PDF's metadata. Mind
that calculating the ink coverage will slow down the task.

7.83.  Export to PostScript File

Factory settings
The Default ticket of this task offers Factory settings. Selecting one is a quick way to
define the many ticket parameters. After selecting such a 'preset', you can still change any
parameters.

• PostScript for press (separated)

• PostScript for press (DeviceN composite): This mode (only supported by PostScript 3
devices) uses the PostScript 'DeviceN' color-space to produce high-fidelity colors. These
colors are combinations of the standard CMYK process colorants and/or spot colors,
guaranteeing perfectly separable PostScript code that can be proofed on a composite
PostScript 3 device.
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• PostScript for viewing / proofing (CMYK composite)

7.83.1.  Output

 

 

Device type: The selected device type also determines the PPD that will be used.

Output type:

• Separated: Select this to generate multiple pages, one for each ink in the file.

• CMYK Composite: Select this to generate a composite PostScript file, typically for proofing.
All spot colors are converted to CMYK.

• Composite: Select this to generate a file for PostScript 3 devices, since they support
'deviceN' color-space to produce high-fidelity colors. These colors are combinations of
the standard CMYK process colors and/or spot colors, guaranteeing perfectly separable
PostScript code which can also be proofed on a composite PostScript 3 device.

The generated PostScript file will proof correctly and separate correctly. Color management
for spot color objects must be handled by the device.

Emulsion Up: Select Right Reading (= emulsion up) or Wrong Reading (= emulsion down).

Image: Select Positive or Negative print mode.

Enter a Vertical and/or Horizontal distortion in percentages (between 90 and 110 %).

Add SmartMarks if you want.

Account for job margins: Select this to also include the data between the borders (Trim Box)
and the margins (Media Box).

Hide trap layer(s) in output: Select this if you do not want those objects in the output file.

Page Setup

• Select a Paper size. The list is based on the page sizes supported by the selected .PPD.

• Orientation: (Disabled when 'Tile job' is selected.)

• Alignment: (Disabled when 'Tile job' is selected.)
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• Enter the Number of copies.

Scale & Tile

• Enter a Scale factor (percentage).

• Fit job on page scales the file so it fits the selected paper size.

• Shrink oversized jobs to paper size.

• Select 'Tile job' to obtain a tiled output if the file is too big to fit on the selected Paper
size. It then exports a large file to a series of smaller pages (tiles). The user can then cycle
through the tiles, and see how many tiles there are.

Overlap: The value you enter here is the amount of overlap in all four directions between
adjacent tiles.

Page Range: When your input file has multiple pages, define here if you want All or a selection
of these pages in your output PDF file.

7.83.2.  Device

Most of these options depend on the PPD belonging to the selected Device Type.
 

 

Resolution: Select one that fits the purpose of the PostScript file.

Dot Shape: Define if you want a specific dot for this file.

Halftoning: When the Output type is 'CMYK Composite' or 'Composite', you can choose to
include screen information (LPI and angle).

• Use Printer Defaults: From the output device.

• Take over from job: From the input file.

• Some PPDs offer other dot shapes.

Dot Gain Compensation: Select a Single and/or Automatic curves (made in Curve Pilot). This
will be added as 'transfer curve'. Learn more here.

Note:  When a DGC curve is selected, the file will be flattened to ensure that the correct Dot
Gain Compensation is applied to transparent objects. This may result in a larger file.

302



7Automation Engine

Roll fed devices:

• Account for Media Width allows the task to find the best printing orientation (when
Rotation is set to Auto). For roll-fed devices, mostly film-setters, a media width (film width)
can be specified.

• Extra Gap: Allows you to specify extra width for the film or paper feed.

Device specific options: These depend on the selected PPD. Learn more in the
documentation of your output device.

7.83.3.  Color Management

These options are enabled when you choose the Device type 'CMYK composite'.
 

 

Convert to:

• Choose to convert all inks to CMYK or Gray values.

• Use Link Profile: "Link profiles" describe a transformation from one device-dependent
color space to another. This is actually a concatenation of a forward transformation of one
profile and a backward transformation of another profile. A link profile takes complete care
of the color management, so all other options are then disabled.

Source profile: If any CMYK objects need to be converted, choose a 'source profile'. The list
shows all CMYK print profiles in the color database. The source profile defines the target that
the destination profile is supposed to match.

Destination profile: Choose a color profile for your destination color space. The list shows all
print profiles in the color database. These profiles are either measured in Color Engine Pilot or
imported ICC-profiles.

Rendering intent

• Relative (no background): Choose this if you do not want any background simulation. The
white point of the source will be mapped on the white point of the destination process. This
rendering intent takes into account the ability of the human eye to adapt to the surrounding
white.

• Absolute (background): Choose this if you want background simulation and you want an
exact color match, including the paper simulation.

Black Mapping:

• When selected, the CMY part of the composite colors are converted separately from the
black component. As a result, the type of black separation (Skeleton black, UCR, GCR...) is
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preserved by the conversion. It is still possible that the black percentage changes slightly
due to different dot gain in the color profiles.

• When not selected, the converted CMYK colors are completely re-separated into the black
behavior that is built into the destination profile.

Use the document profile as Source profile if available: If a document profile is defined,
then that one will be used as a source profile. The one chosen from the above Source Profile
list will be overruled.

7.83.4.  Inks / Separations

The name of this tab depends on the output type you selected in the Output tab.

• If you there choose CMYK Composite or Composite, the Inks tab appears:
 

 

• If you there choose Separated output, the Separations tab appears.
 

 

All Inks: Deselect this to open an ink-list panel where you can select specific inks.

Note:  The Inks panel only shows the inks that are present in the input file(s) for the first task
in your workflow. When no input files are selected yet, you will not be able to “preselect” inks
(for example when building workflows in the Tickets view).
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Use technical inks in output: Select this option to also output the (non hidden) technical inks.

Convert all inks to CMYK:

In the Inks panel, use Merge Ink With to output inks on top of each other in the same output
file. The ticket proposes this automatically when you have different rulings for 1 ink. You
can set this manually by clicking in the Merge with column and selecting the ink it has to be
merged with.

7.83.5.  Rasterize

 

 

Rasterisation resolution: Enter the resolution for the objects that will be 'resolved' (converted
to image data).

Output as image: Select this to make an image of the input file (with the above set resolution).

Attention:  All objects in a technical ink will remain linework, they will not be rasterized.
This linework is put on top of the rest of the newly generated image. This can have side-
effects when mixing technical and non-technical inks (typically when using technical
inks for anything else than die cut lines).

Anti-aliasing: This smoothens the staircase effect in images generated from line-art objects
that were pre-processed. This increases the readability of small text that is converted to image
data.

Convert vignettes to image: Select this to avoid blends and banding in vignettes when
exporting to PostScript. This converts all vignettes to images.

Vignette noise: When exporting to PostScript, some (parts of) vignettes will be converted to
images. This happens when the vignettes overlap other objects with translucency or when
there are overprints between a vignette and other objects.

When 'Convert vignettes to image' is selected, all vignettes are converted to images regardless
of any overlap with other objects. Vignettes that are converted to images may have tone jumps
in the final result. To reduce this banding effect, noise is applied on the image. Define the
amount of noise in this field.

7.83.6.  Compression
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Encoding:

• Binary: The image data is represented as binary data. This results in compact files. Such
files are not editable in a common ASCII editor. Nor can these files be transferred using a
communication protocol that relies on control characters in the data stream itself.

• Hex: This forces the output to remain editable with an ASCII editor. It can then also can
be transferred using whatever communication protocol is available. The drawback is that
hexadecimal image data can take up to twice as much size as binary data.

• ASCII 85: Encodes binary data in an ASCII base-85 representation. This encoding uses
nearly all of the printable ASCII characters. The resulting expansion factor is 4:5, making this
encoding more efficient than hexadecimal.

Compression: Choose None, LZW or Flate (PostScript 3 devices).

Downsampling: Use this to downsample the images referenced in the file to (approximately)
the specified value. This will result in a smaller PostScript file. It will also be generated faster.

Please be aware that 1–bit copydot images cannot be downsampled.

7.83.7.  Advanced

Split Complex Paths
When a device requires that you create an old version of PostScript (level 1), it may also require
that you split very complex paths into smaller ones.

• Filled and stroked paths at: Use this option to split linework with more than x points into
several smaller linework parts. This decreases the complexity of the linework. A suitable
value for the selected Device type is calculated automatically.

• Clip paths at: Use this option to split linework masks for images with more than x points
into several smaller linework parts. This decreases the complexity of the masks.

Workaround
• Limit file name to 31 characters: Select this when the system that will read your output

file is limited to 31 characters.

• Ignore varnish inks: Select this to exclude varnish inks in your output.

• Resolve pure black overprint: Overprints are normally resolved, but by default, pure black
is left untouched. Select this option when you also want pure black to be resolved.

This option is only available when you selected 'CMYK composite' as 'Output' tab.

• Resolve once identical external files: Instead of resolving the complete file and all its
external references, identical external files will be resolved only once.

• Resolve once identical one-ups in Step & Repeat file: Instead of resolving the complete
Step & Repeat file, identical one-ups will be resolved only once.
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• Suffix for PANTONE ink names: Enter a suffix for PANTONE ink names. The default is 'C'.
For example: PANTONE 123 so becomes PANTONE 123 C . Existing suffixes will be replaced
by this one.

• Suppress hairlines at clips : Due to the PostScript limitation of the maximum number of
points allowed for a path, complex paths will be cut into smaller pieces. When the PostScript
file is used for an old PostScript RIP, 'hairlines' can so become visible. To avoid this problem,
select this option.

• Split multi page job into multiple files: Every page of a multi page file will be output as a
separate PS file.

• Image to paper edge: This moves the origin of output file to the lower left corner of the
paper or film. Select this option to align your file to the edge of the paper or film to use the
full area.

Note:  When exporting to a paper PostScript device, there is typically a border on the
output page on which nothing can be imaged. Parts of your design that are located in that
border area will be lost.

• Avoid tabular number problem: When digits are written as tabular numbers, exporting to
some PostScript RIPs may result in bad positioning of the numbers. Select this to avoid that
tabular numbers are not correctly placed at the text base line.

• Disable path clipping: Select this if you do not want paths to be clipped on the
'borders' (Trim Box) of the file.

• Map spot color separations to CMYK: Select this when you export a file containing spot
colors to pre-separated PostScript for systems that are limited to separations of process
colors (for example a Scitex Brisque workflow).

Spot color separations can only be handled on such systems by mapping them to a specific
process separation (not converting, just mapping). Spot colors are then exported as a C, M,
Y or K separation according to a simple rotating name principle (C->M->Y->K->C->M...).

Spot colors which are named exactly after process colors remain unchanged.

• Omit “Process” for CMYK in %% PlateColor comment: Select this when the file will be
sent to a device that does not understand "Process".

You must select this option when outputting to an Image Setter and when your different
separations all have the Angle and Rulings of the K separation (Black).

• Split separated output into multiple files: Instead of writing one file containing all
separations, the task will write one file per separation.

• Force Black Overprint: Select this if you want all 100% black objects to overprint in your
PostScript file.

7.84.  Extract Inks

Concept

This task writes a PDF that only contains the inks that you here decided to keep, by defining
their Name or on their Printing Method.

The resulting PDF will look the same as if you opened the input file in the Automation Engine
Viewer and there made the same selection of inks.
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This task is typically used to build (parts of) workflows that you only want to execute on specific
inks. This is especially useful when the PDF will be output on a hybrid press. For example: a
workflow that automatically sends the 'Flexo' inks to a different RIP than the 'Screen' inks.

Note:  Learn more about such a workflow in the dedicated section about Hybrid Press Workflow
on page 1734.

 

 

Another example where this task is useful is when you want to generate separate file reports
per 'group' of inks.

Task Settings

You define which inks you want to keep, based on their Name or on their Printing method.

Click on  to select one or multiple printing methods (a list defined in the Configure tool).

Click + if you want to add extra criteria. Click Alt and then ... button to add sub-criteria.

Learn more on how to add such criteria in the page that describes how to make (smart) filters in
the Pilot.

Some examples:

• Only keeping the inks with the Printing method 'Flexo':
 

 

• Only keeping the inks that do not have the Printing method 'Flexo':
 

 

• Keeping the Flexo Pantone inks and/or inks which name contains 'cut' or 'crease':
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7.85.  Fill Printing Lanes

This task is launched from the browser client of Automation Engine (the QuickStart
deployment). It is part of the production workflow of a Production Job.

Find eLearning modules and documentation on https://www.esko.com/en/support/product?
id=Automation%20Engine.

7.86.  Fork

This Workflow Control is documented in the chapter Workflows. See Fork and Join on page
782.

7.87.  Image to Screened Separations

This task is documented in the chapter on Imaging Engine. Find a direct link here.

7.88.  Image to Unscreened Separations

This task is documented in the chapter on Imaging Engine. Find a direct link here.

7.89.  Import Die
This task is used to import step & repeat template files into the 'dies' database of Automation
Engine (the QuickStart deployment). They there appear in the Die Gallery.

Supported input files:

• Resulting in a 'Template Die':

• SRT files, created in Adobe Illustrator with the DeskPack plugin 'PowerLayout Standalone'.

• PDF files created in ArtPro+ .

• Resulting in a 'Numeric Die':

• XML files, when the format is valid (containing the mandatory XML nodes). A numerical
die consists of one or more grids. A grid consists of a cell with specific dimensions and a
rotation and is repeated a number of times. Find a specification and example below.

Important:  When importing a die that results in a die database entry with the same name as
an existing entry, the existing entry will be overwritten (i.e. the entry is updated).
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Note:  This task has no file output.

Specification of the Input XML file

• For all tags expecting a distance value, the value should be expressed in 'mm'.

• The XML file must contain one or multiple elements containing the die information.
When there are multiple elements, multiple dies will be created / updated.

• The default name for this root node is called 'Die'. You can specify the name of the XML
element (node or attribute) by:

• any combination of:

• a fixed value
• a SmartName

• an XPath expression
• a public parameter.

Note:

• When the XML element name is not an XPath expression (i.e. not prefixed with
'xpath:'), each element in the XML with local name (i.e. name of the XML node or
XML attribute without the optional namespace prefixes) equal to the specified XML
element name is used to create or update a die entry in the database.

• When the XML element name is an XPath expression or resolves to an XPath
expression, all elements selected by evaluating the XPath expression are used to
create or update a die entry in the database.

Parameters defining the die

You can specify the name of the XML element or attribute to use to update a die parameter by:

• any combination of a fixed value and/or a SmartName
• an XPath expression, relative to the element

Table: Main Parameters defining the Die

Element Name in
UI

Usage Description

Name Name Optional Name of the die. Default name is the name of the input
XML file.

VSize Vertical
Die Size

Optional Default value is the maximum height of all the grids.
The height of a grid is calculated as: <grid vertical
offset> + ( <grid cell height> + <grid
vertical gap>) * <grid number of rows> - <grid
vertical gap>/2 (where <grid vertical offset> equals half
of the vertical gap in normal cases).

HSize Horizontal
Die Size

Optional Default value is the maximum of the most right side of
all grids. The right side of a grid is calculated as: <grid
horizontal offset> + (grid cell width> + <grid

310



7Automation Engine

Element Name in
UI

Usage Description

horizontal gap>) * <grid number of columns> -
<grid horizontal gap> .

Grid Grid Mandatory This is a sub-node. There can be one or more.

• The 'Grid' sub-nodes can be contained under an
optional 'Grids' node.

Note:  This 'Grids' node was required up to AE v18.1
but as of v18.1.1, the list of 'Grid' nodes can be directly
placed under the 'Die' root node.

• On it's turn a grid consists of a number of parameters,
which can be a name of an XML element, an attribute or
an XPath expression.

• In this case, the XPath expressions are relative to the
'Grid' element.

• See the table below for these grid-specific parameters.

Table: Parameters for the sub-node 'Grid'

Element
name

Name in
UI

Usage Description

VSize ,
HSize

Vertical
Cell Size ,
Horizontal
Cell Size

Mandatory The height and width of the basic cell used in the grid (sizes
are prior to any rotation).

VGap ,
HGap

Vertical
Gap ,
Horizontal
Gap

Mandatory The vertical and horizontal gap between the different
repetitions of a grid cell.

Angle Rotation
Angle

Optional The rotation angle of the cell (positive values are clockwise).
Value must be a multiple of 90 degrees. Default: no
rotation.

NRows Number
of Rows

Optional The number of rows in the grid (i.e. the number of vertical
repetitions of the grid cell). Value must be an integer larger
than 0. Default : 1

NCols Number
of
Columns

Optional The number of columns in the grid (i.e. the number of
horizontal repetitions of the grid cell). Value must be an
integer large than 0. Default: 1

Voffset Vertical
Offset

Optional The vertical offset of the first grid cell. Default value:
VGap/2

Hoffset Horizontal
Offset

Optional The horizontal offset of the first grid cell. Default value: 0
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Example

This XML will create (or update) 2 dies.

7.90.  Import Image
The task converts pixel images to the Esko CT or LP file format.

You can also use it to convert RGB images to CMYK, probably for easier processing in the
workflow.

You can also use prit to convert CMYK CTs with Inkswitch or BlackSmith.
 

 

Mask/Path Settings
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• Select Keep Pixel Masks to keep the original pixel mask in the output image.

• Select Keep Clipping Path to keep the original clipping path.

Preview Settings

• Create Thumbnail. Small RGB image used in an 'Info' panel in the Pilot or in the "File-Open"
dialogs of Esko editors.

• Create Preview. Only used in PackEdge's low-quality view mode.

Keep Indexed

If the colors in the image are reduced ("indexed"), select this if you want to keep that in the
output image.

RGB Conversion Method

There are two ways to convert RGB data to CMYK:

• Device Link Profile

This allows you to select a Process Link, made in Color Engine Pilot. This option will give you
the best result.

"Link profiles" describe a transformation from one device-dependent color space to
another. This is actually a concatenation of a forward transformation of one profile and a
backward transformation of another profile. A link profile takes complete care of the color
management, so all other options are then disabled.

• Device Profile

This enables you to select a source and a destination (proofer) process. Use this option if
you did not make a Process Link in Color Engine Pilot but you still want a better color result.
The process links will be made for you.

RGB Profile: Source profile used for conversion.

CMYK Profile: Destination profile used for conversion.

Rendering Intent:

• Relative (no background): Choose this if you do not want any background simulation.
The white point of the source will be mapped on the white point of the destination
process. This rendering intent takes into account the ability of the human eye to adapt to
the surrounding white.

• Absolute (background): Choose this if you want background simulation and you want
an exact color match, including the paper simulation.

• Perceptual: This will result in no background simulation (white of reference color space
is mapped on white of destination color space). Choose this when you don't care too
much about an exact color match but when want the pictures at least to look nice on
your proofer. It will give a visually pleasing result. If the gamut of the source is wider than
the proofer, the entire gamut is shrunk so that it fits inside the gamut of the proofer.

• Saturation: Choose this if you care especially about saturated colors. This rendering
intent will map saturated colors on saturated colors.

Note:  For BGCMS profiles, Perceptual, Relative and Saturation are in fact identical.

CMYK Conversion
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Choose the conversion Method and its Profile.

Learn more about these conversions in the documentation of Color Engine Pilot.

7.91.  Import JDF Layout
This task handles JDF files generated by JDF compliant imposition programs (i.e the "LayCrimp
ICS"). It reads the JDF layout and generates an imposed Normalized PDF per sheet side. The 1-
up files referenced in the fully populated RunList in the JDF are converted to Normalized PDF
files and saved in the output folder of the task. The JDF file must be version 1.2 , 1.3 or higher.

The JDF file contains two parts:

1. A page list, referring to PDF or PostScript files.
2. Geometrical layout info.

This task converts all PDF and PostScript files and creates 1 Normalized PDF file per sheet side.

Most tabs in this task ticket are identical to those in the 'Normalize PostScript/PDF/Illustrator 8.0
File' task.

• The 'Sheets' tab differs a little from the Sheets tab in the task Export Imposition to GRI File,
but has the same functionality.

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

• The 'Page Boxes' tab is an extra tab.

7.91.1.  Sheets

Indicate which sheet sides you want to import from the JDF layout.

For the front as well as the back sheets, you can either select All sheet surfaces or select a
Range of sheets.

 

 

7.91.2.  Page Boxes

• Trim Box:
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• Plate: Sets the Trim Box of the output PDF to the JDF Plate Media and Plate
TransferCurve CTM. If not present in the JDF, select 'Paper'.

• Paper: Sets the Trim Box of the output PDF to the JDF Paper Media and TransferCurve
CTM. If not present in the JDF, select 'Surface Contents Box'.

• Surface Contents Box: Sets the Trim Box of the output PDF to the 'Surface Contents
Box' as defined in the JDF (default setting before AE 16.1).

• Media Box:

• Plate: Sets the Media Box of the output PDF to the JDF Plate Media and
TransferCurveSet CTM. If not present, it uses the JDF Paper Media. If not present, it
uses the JDF Surface Contents Box as defined in the JDF.

• Fit: Sets the Media Box of the output PDF by fitting the margins around all objects
(default setting before AE 16.1).

Note:  When importing JDF files from Tilia Labs, you may want the Trim Box on 'Paper' and the
Media Box on 'Plate'.

7.92.  Import JDF Step & Repeat
This task creates a Step & Repeat (PDFPLA) file based on a JDF file.

• When the JDF file contains a link to PDF 'station' files, the task performs a tabular Step &
Repeat.

• When the JDF file contains a link to a CAD file and to its PDF 'station' files, the task performs
a CAD-based Step & Repeat.

Note:  The JDF should always contain a list of the input files.

7.92.1.  Tab 'General'

• Output Format: Choose the type of PDF you want to create.
• Unit:
• Limit Bleed: The bleed mask is created by spreading the die shape. Use this option to limit

that bleed to a specific distance.
• SmartMarks. If you wish, select or define a set of SmartMarks.

• Load Mark Set in bottom layer: Select this if you want to make sure the marks are
"behind" the graphics.

• Screen Registration: When selected, the origin of the screening will be reset for each
station on the layout. This guarantees that the exact same screening will be applied for each
station. This is for example required when printing stamps. When not selected, screening
will be done continuously throughout the complete layout.

Attention:  This option defines an attribute in the PDF that is only supported by
Imaging Engine or FlexRip. It is ignored by any other RIP..

315

http://tilialabs.com/phoenix.html


7 Automation Engine

Attention:  Screen registration is not available when you choose the output format
PDF.

7.92.2.  Tab 'CAD Options'

• Mapping: When the CAD file is a CFF2 or DXF file, you here select the set of mapping rules.
These rules map line styles (cut, crease, bleed), layer names and color numbers onto
ArtiosCAD line types. These sets of mapping rules can be created in Esko PackEdge or Plato.
Learn more in their user documentation, more specifically in their section on placing files
(PackEdge) or on importing CAD data (Plato).

• The CAD Style changes the appearance of the (imported) ArtiosCAD type lines.

Note:  This CAD Style is only applied on lines from the design (ARD) that was stepped in the
layout file (MFG). Lines manually drawn next to the placed designs (the so called "objects at
layout level") will always be ignored by the task.

The styles you can select here were also created in PackEdge or Plato. Learn more in their
user documentation, more specifically in the section on placing ArtiosCAD files, and the
option for "CAD Style".

• Include CAD info for Digital Flexo Suite:

If you are using the Esko Digital Flexo Suite (DFS), select this option to add the technical inks
data into the header of the output file (this is usually the cut and crease lines). This data is
then visible in the Esko Bitmap Viewer and also embedded in the LEN files created by an
Esko RIP.

The DFS can export this information into ACM files for an Esko Kongsberg cutting table. In
Esko PlatePatcher workflows, this information can be used to print onto the plastic sheet
where the pieces of flexo plate are re-assembled. These technical lines can also represent
text that is then added onto the (back of the) flexo plates, using a pen on the Kongsberg
table.

Attention:  This option is disabled when you choose the output format (native) PDF.

7.92.3.  Tab 'Sheet'

• Sheet Size: If you want to use a custom sheet size instead of the sheet size defined in the
JDF file, then select Set custom sheet size and enter its dimensions.

• CAD Layout Position: The position on the sheet of the bounding box of all cut lines in the
CAD layout in the JDF.

If you want to use a different position than the one defined in the JDF file, then select Set
custom position.

Note:  Take into account the point of Origin from which the repetition will be built. This is
defined in the JDF and is always bottom left.

• Position on Sheet: click or drag the inner blue rectangle (the bounding box of the CAD
Layout) in a position versus the outer grey rectangle (the sheet).
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• Offset: Define by how much the CAD Layout should be offset from the sheet corner,
horizontally and vertically.

7.92.4.  Tab 'Plate'

• Plate Size : Select Set custom plate size when the plate size needs to be different than the
sheet size. Then enter your custom plate size below (and possibly also the sheet position
and offset).

• If you want, enter horizontal and/or vertical Shrink values (in percentage) to compensate
for printing distortion (especially in Flexo).

The default value is 100, both horizontally and vertically, which means no distortion
compensation. Learn more about when and how they are applied in the topic 'shrink' on this
page.

• Define the Sheet Position by clicking or dragging the sheet (inner rectangle) to its position
versus the plate (outer rectangle).

• Offset: When enabled, add a H and/or V offset of the sheet versus the plate.

Note:  Take into account the point of Origin  from which the repetition will be built.
This is defined in the JDF and is always bottom left.

7.93.  Import JDF Stripping

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.94.  Import Substrate Sizes from XML

This task is documented in the separate chapter Gang Run Printing for Sign & Display on page
871. Find a direct link here .

7.95.  Import Order Material from XML

Concept

Note:  'Order Material' is a term first used in AE's browser client, the one used in the
QuickStart deployment. An order material is the substrate that is mentioned on the order ;
it is what needs to be used to print on or produce with. The name this material has on the
order is typically the term that is used in the MIS/ERP, which is probably also the one that your
customer uses when placing this order.
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This task allows to use an XML file to import Order Materials into the Automation Engine
database. When the material already exists (in the Automation Engine Order Materials
database), it will update its properties.

These materials can then be used in the Add to Products task.

This XML file typically comes from a business system: the MIS/ERP that also manages the stock
of printing material.

Note:  This task can not delete an order material. You need to do this manually in the Order
Materials view.

Usage

The task panel serves to map the language in the XML to the required terms in Automation
Engine. The result will appear in the view .

 

 

• XML Element Name: You first need to specify the name of the XML element that contains
the specification of an order material. You can specify it by any combination of a fixed value
and a SmartName, by an XPath expression or by a public parameter.

Note:  When you import an order material with the same name as one that already exists, it
will be overwritten.

• XML Element/Attribute Name: This name of the XML element or attribute is used to
update an Order Material Parameter. You can specify it by any combination of a fixed
value and a SmartName, or by an XPath expression (then relative to the above specified
XML Element Name).

When the name of the XML element or attribute ...

• is empty, the order material parameter is not modified.
• is an XPath expression (starts with xpath:), the order material parameter is updated with

the result of the XPath expression. When the XPath expression does not select any XML
element or attribute, the order material parameter is not updated.
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• is not an XPath expression, the task searches for a direct child element with a matching
local name. If not found, the task searches for the attribute with a matching name. If not
found, the order material parameter is not modified.

• Click Edit to map any of these parameters:

Table: Data Type of Parameters

Order Material Parameter Data Type

description string

name string

thickness number in mm

weight number in gram

7.96.  Inspect Artwork

This task is documented in the separate chapter Quality Control tools on page 992. Find a
direct link here.

7.97.  Inspect Barcodes

This task is documented in the separate chapter Quality Control tools on page 992. Find a
direct link here.

7.98.  Inspect Braille

This task is documented in the separate chapter Quality Control tools on page 992. Find a
direct link here.

7.99.  Inspect Spelling

This task is documented in the separate chapter Quality Control tools on page 992. Find a
direct link here.

7.100.  Inspect Text

This task is documented in the separate chapter Quality Control tools on page 992. Find a
direct link here.
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7.101.  Integrate via External Hot Folder
This task allows to integrate external (prepress) applications into your workflow. The only
requirement is that the external application works with hot folders.

1. In the ticket, you define the location of the hot folder used by the external application,
as well as the Result subfolders in which the external application will output processed
files (the OK Folder), failed files (Error Folder) or files that resulted in warnings (Warnings
Folder).

Attention:  You need to define a different folder for each output state. This can not
be the same folder.

2. When you select a file and launch this task, the task first copies the file to the external hot
folder.

3. The external application picks up the files in its hot folder and processes them. The
processed files are saved in the subfolder that matches the processing result: OK, Warning
or Error.

4. Automation Engine monitors the OK, Warning and Error folders for any files that have
been processed.

Important:  As mentioned above, these have to be three different folders.

5. When Automation Engine detects a file in the OK folder, it copies it to the Output folder
defined in this ticket. Depending on your settings, Error or Warning files might also be
copied into the Output folder, or they might be deleted.
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In the Error area of the ticket, you can define an amount of time after which the external
processing should automatically be considered as failed. To do this, enable the option "Error
when no result after" and select a time period.

7.102.  Interact using JDF

This task is documented in the chapter Integrating with External Systems. Find a direct link here.

7.103.  Interact using JMF

This task is documented in the chapter Integrating with External Systems. Find a direct link here.

7.104.  Integrate with WebCenter

This task is documented in the chapter Integrating with WebCenter. Find a direct link here.

7.105.  Interact with Database

This task is documented in the chapter Integrating with External Systems. Find a direct link here.

7.106.  Interact with SAP
This task is mentioned in the chapter Integrating with External Systems. Find a direct link here.

7.107.  Interact with Web Service

This task is documented in the chapter Integrating with External Systems. Find a direct link
here.

7.108.  Join

This Workflow Control is documented in the chapter "Workflows". See Fork and Join on page
782.
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7.109.  Join XML Files

This task is documented in the chapter Integrating with External Systems. Find a direct link
here.

7.110.  Link Product To Job

This task is documented in the chapter Products on page 548. Find a direct link here.

7.111.  Load Structural File

Concept

This task loads a structural design file into a graphics file.

The structural file is loaded in a dedicated new layer named Structure_[name of
structural file]. The structural file is put in a technical ink (as defined in the CAD Style,
see below).

Tip:  The output file can be used as an input file for the Export to 3D task.

Note:  When the input file is a normalized PDF that already contains a structural file (one that
was loaded in Esko PackEdge, ArtPro, DeskPack or by an Automation Engine task), then the
task ends with an error.

 

 

Supported Types of Structural Design Files
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This task can load these types of structural files:

• CAD files: ARD, CF2, DXF files. For CF2 or DXF files, you have to indicate a Mapping file to
map their file attributes onto ArtiosCAD-like line types (to become cut, crease or bleed lines
or to be ignored). The CAD Style file is needed to define their appearance, for example the
color they get. Mappings and CAD styles can be defined in Esko editors.

• Collada files: DAE, ZAE file. These files need to have a printable area. When the file has
multiple printable areas, the area that matches the size of the selected page box gets
selected. When the file has no or multiple matching printable areas are found, the task ends
with an error.

• Esko Flexible file: BAG file. This file type was created before ZAE was supported.

Important:  The structural file is not rotated.

Positioning
• Reference: The structural object will be positioned in relation to the selected page box

(Media, Crop, Trim, Bleed, Art Box).

Note:  The task ends with a warning when the dimensions (bounding box) of the structural
file do not match the size of the selected page box.

• Position: Additionally, you can use the align tool for more specific 9-point-positioning. The
smaller square in the graphic represents the selected type of Box.

• Fit trim box to the structural design: Optionally, you can fit the trim box to the structural
design.

Note:  When you select this, the margins will keep their original size (i.e. the media box will
change).

Note:  All page boxes, except the Media Box, are placed relative to the top left of the Trim Box.
The Media Box is defined as a margin around the Trim Box (top - bottom - left - right).

7.112.  Manage Color
With this task, you can:

• convert a CMYK file to another CMYK profile,
• re-separate a CMYK file so that it contains less CMY and more K, while keeping the image

looking the same,
• both convert and re-separate your CMYK file.

This task takes PDF and Normalized PDF files as input. When working with regular PDFs, it
will automatically normalize them using the Normalize ticket set in the Configure tool (see
Processing Preferences on page 203).

7.112.1.  Converting to another CMYK Profile

You can convert a file to another CMYK profile if for example you want to print it on a different
substrate, on a different press, or even with a different printing process (offset, digital
printing...).
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In Actions, select Convert color space to convert your input file to another CMYK profile. This
displays extra parameters below it.

1. Select the profiles to use when converting your input file.
You can choose either:

• individual source and destination profiles (this is the default option). In this case:

1. In Use, select Source and Destination Profiles.
2. In Source CMYK Profile, select the source profile to use for the conversion in case

you are not using your input file's profile.

This can be an Esko or an ICC profile and you can use a SmartName (resolving to the
full profile name) to set it. By default this is ISOcoated_v2_eci.icc.

3. If your input file has a CMYK profile and you want to use it for the conversion, select
Use document profile if available.

When processing a file without a profile, the task will use the Source CMYK Profile
you selected.

4. Choose what Destination CMYK Profile to convert your file to.

This can be an Esko or an ICC profile and you can use a SmartName (resolving to the
full profile name) to set it. By default this is ISOcoated_v2_eci.icc.

• an ICC device link (which contains a source and a destination profile). In this case:

1. In Use, select ICC Device Link.
2. Select the ICC Device Link to use.

You can browse to it, enter its full name including the .icc extension, or use a
SmartName resolving to its full name.

Note:

• You can create ICC device links in 3rd-party applications (for example ColorLogic or
Alwan).

• When using an ICC device link, you cannot use certain color management options
(See 'black point compensation' (point 3) and 'keeping colors pure' (point 4)).

2. Choose the Rendering Intent to use when converting the colors.

A Rendering Intent is a part of the color strategy that handles the conversion of out-of-
gamut spot colors and of the background color.

Each of the four rendering intents available does this in a different way, so you should
choose the one that is more adapted to the way you are printing and the result you want to
achieve:

• Use the Relative Colorimetric rendering intent if you don't want to simulate the source
background (the point that has 0% of all inks in the source profile).

This will proof your file as if the proofer substrate was exactly the same as the substrate
defined in your source profile.

For example: your press prints on cream colored card stock whereas your proofer prints
on bright white paper, but you don't want to simulate the cream background on your
proof.
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With this rendering intent, colors from the source profile that cannot be reproduced by
the proofer will be converted to the closest color(s) the proofer can reproduce.

In some cases several colors will be converted to the same color, which means that you
can sometime lose some detail, especially in dark saturated areas and the dark parts of
gradations.

 

 

Note that typically the proofer profile has a bigger gamut than the press profile, so there
are not many colors that the proofer cannot reproduce.

• Use the Absolute Colorimetric rendering intent if you want to simulate the source
background to get as exact a color match as possible.

For example: you do want to simulate the cream colored card stock used on your press
on your proofer substrate, to see how the final output will look like (this doesn't only
affect the white but all the colors in your file).
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As with the Relative Colorimetric rendering intent, colors from the source profile that
cannot be reproduced by the proofer will be converted to the closest color(s) the proofer
can reproduce, meaning you can sometime lose some detail, although there are typically
not many press colors that a proofer cannot reproduce.

• Use the Perceptual rendering intent if you are not trying to get an exact color match but
want the proof to look visually pleasing.

If there are colors from the source profile that cannot be reproduced by the proofer, this
will shrink the source gamut to fit inside the gamut of the proofer, so that all colors are
converted (even the colors already in the proofer's gamut), but the relationship between
colors is kept.

 

 

This means that colors won't be really accurate, but you won't lose detail in dark
saturated areas or gradations.

This rendering intent is most commonly used in commercial printing (for newspapers,
magazines, posters...).

• Use the Saturation rendering intent if you mostly want to make sure the colors on your
proof are saturated enough.

326



7Automation Engine

Colors from the source profile that cannot be reproduced by the proofer will be mapped
onto close saturated colors that are in the proofer's gamut.

This rendering intent is most commonly used for business presentations containing
graphics, or cartoons/comics.

Note:  You can only use a Perceptual or Saturation rendering intent if you are working
with ICC source and destination profiles.

You can also set the rendering intent with a SmartName, resolving to 2 (for Perceptual), 3
(for Relative Colorimetric), 4 (for Saturation) or 5 (for Absolute Colorimetric).

3. If you cannot reproduce the same range of black on output, select Use black point
compensation to avoid losing some detail in the shadow areas.

This can be the case for example if you originally printed a job on coated paper, but now
need to print it on uncoated (as the uncoated paper will absorb more of the ink and give
less of a sharp, saturated result).

 

 

 

 

Coated Uncoated

Without black point compensation, some of the details in the darkest areas can get lost.
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Black point compensation shrinks the whole black range proportionally, so that both the
shadows details and the relationships between different tints of black are kept.

 

 
4. If you want to keep certain colors pure after conversion, click Keep Colors Pure... and select

Yes for the colors you want to keep pure (or use a SmartName resolving to YES).

Keeping a color pure means that the conversion will not use other inks to reproduce that
color.

So for example a 100% yellow object will be converted to the percentage of the output
yellow that gives the closest color on print, but will never be made of 97% yellow and 3%
magenta.

This helps you avoid unwanted printing effects, like having small dark dots in an otherwise
smooth color patch (also called "contamination").
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Removing those small dots increases the color difference slightly but avoids graininess on
print.

You can choose to keep primary colors (Cyan, Magenta, Yellow) and/or secondary colors
(Red, Green, Blue) pure. Secondary colors are made of a combination of primary colors (for
example green is a combination of cyan and yellow).

You may want to keep certain colors pure and not others depending on the results you get
with your particular job or press.

• When you keep a primary color pure, all tints of that color are kept pure (so an object
that is 50% yellow will stay only yellow). Objects that are already multicolor (for example
50% yellow + 15% magenta) will be converted as usual.

• When you keep a secondary color pure, all tints made of equal amounts of primary
colors are kept pure (so for example 50% cyan + 50% yellow is kept pure, but 50% cyan +
60% yellow is not).

By default, the primary colors are kept pure.

Note:  When using the Absolute Colorimetric rendering intent, the colors are not kept
pure in the very light colors, in order not to interfere with background simulation.

5. Select what objects in your file you want to convert in Apply on. This can be either:

• Images and Linework,
• Linework only,
• Images only.

You can also set this with a SmartName, resolving to images_and_linework,
linework_only or images_only (SmartNames are case insensitive).

6. Select Keep registration color (400%) if you use marks in your file and if you don't want
them to be converted to the new profile (you want them to stay 100% of each CMYK color).

7. Select Flatten document if you are experiencing unexpected results in color conversions (if
after conversion the color of some blend modes or other objects on top of each other looks
different).

Attention:  We recommend you only use this in case of conversion problems, as it
will remove any transparencies in your file.
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Note:  Flattening your file turns vignettes into images. This means that:

• If you selected Flatten document, vignettes will be color converted when you chose to
convert Images and Linework or Images only.

• If you didn't, they will be converted when you chose to convert Images and Linework or
Linework only.

7.112.2.  Reseparating your CMYK File

Reseparating a file is replacing some amount of Cyan, Magenta and Yellow in the file (that
would give grey) by a certain amount of Black, giving the same grey color.

Objects that are only Cyan, Magenta or Yellow (or only two of these colors) are kept as they are.

This can help you save on CMY inks, have a more stable output (less risks of color casts in
neutral areas) or have more detail in the shadow areas.

In Actions, select Reseparate to reseparate a CMYK file so that it contains less CMY and more
K, while keeping the image looking the same.

This displays extra parameters below it.

1. Choose the profile to use when reseparating your input file:
a) In CMYK Profile, select the profile to use in case you are not using your input file's

profile.

This can be an Esko or an ICC profile and you can use a SmartName (resolving to the full
profile name) to set it. By default this is ISOcoated_v2_eci.icc.

b) If your input file has a CMYK profile and you want to use it for reseparating, select Use
document profile if available.

When processing a file without a profile, the task will use the CMYK Profile you selected.
2. Select what type of reseparation you want to do in Purpose:

• Ink Saving replaces as much CMY as possible by Black.

This is a good choice if you want to save on CMY inks.

• GCR (Gray Component Replacement) replaces CMY by Black in the grey and the
saturated areas.

This is a good choice if you want to avoid color casts in the grey areas, and to avoid
having too much ink in the dark saturated areas, which could cause problems with the
substrate.

This is selected by default.

• UCR (Under-Color Removal) only replaces CMY by Black in the dark neutral areas.

This is a good choice if you want to avoid color casts in the grey areas, and to have more
detail in the shadow areas.

In the example below, you can see the results of applying ink saving on your file. The first
row shows the original file, and the second row shows the file after applying ink saving.
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1. Original file, CMYK separations
2. Original file, CMY separations
3. Original file, K separation
4. File after ink saving, CMYK separations
5. File after ink saving, CMY separations
6. File after ink saving, K separation

You can see that after ink saving, the file contains a lot less CMY and a lot more K.

You can also set type of reseparation to do with a SmartName, resolving to ink_saving,
GCR or UCR (SmartNames are case insensitive).

3. In Range, choose how much of the CMY inks that can be replaced by Black you want to
actually replace.
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This depends on the Purpose you chose:

• For Ink Saving, this is how much CMY inks in all areas of the file you want to replace.

• For GCR, this is how much CMY inks in the grey and saturated areas of the file you
want to replace.

• For UCR, this is how much CMY inks in the grey areas of the file you want to replace.

Note:  You can set all percentage values in this task with SmartNames.

4. In Total Ink, select the maximum amount of ink (CMYK) that you want to print.

If you don't limit the amount of ink, you can get a maximum of 400% (100% Cyan + 100%
Magenta + 100% Yellow + 100% Black), which tends to cause problems on most substrates
(slow drying, web growth, or even a risk of tearing).

Additionally, limiting the maximum amount of ink used can make printing jobs less
expensive.

The maximum percentage of ink you should use depends on your printing process and
substrate. For example for newsprint, you may only want to have a maximum of 240%,
while you may be able to use 280 to 320% on a glossy substrate.

The default Total Ink percentage set in the task is 310%.
5. Define the minimum and maximum amount of Black that you want to have in your output

file:
a) In Start K, define from which (minimum) final Black value you want to start reseparating.

If replacing CMY by Black in a certain color gives a Black percentage lower than this, the
CMY won't be replaced.

This is to avoid having really small Black dots, which can be prone to high dot gain,
making them less stable than the equivalent CMY dots.

b) In Max K, define until which (maximum) final Black value you want to start reseparating.

If replacing CMY by Black in a certain color gives a Black percentage higher than this, the
CMY won't be replaced.

This is to avoid having too dark shadows and losing detail.
6. Select what objects in your file you want to reseparate in Apply on. This can be either:

• Images and Linework,
• Linework only,
• Images only.

You can also set this with a SmartName, resolving to images_and_linework,
linework_only or images_only (SmartNames are case insensitive).

7. Select Keep registration color (400%) if you use marks in your file and if you don't want
them to be reseparated (you want them to stay 100% of each CMYK color).

8. Select Flatten document if you are experiencing unexpected results after reseparating a
file (if after reseparation the color of some blend modes or other objects on top of each
other looks different).
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Attention:  We recommend you only use this in case of reseparation problems, as it
will remove any transparencies in your file.

Note:  Flattening your file turns vignettes into images. This means that:

• If you selected Flatten document, vignettes will be color converted when you chose to
reseparate Images and Linework or Images only.

• If you didn't, they will be converted when you chose to reseparate Images and Linework
or Linework only.

7.112.3.  Converting and Reseparating your File

When converting and reseparating your file(s) at the same time, you need to:

1. Select the Source profile, Destination profile and Rendering Intent for the conversion.

Note:  In this case, you cannot use an ICC device link.

2. Select what type of reseparation you want to do and set the appropriate options.
3. Select on which objects to perform both the conversion and the reseparation, whether to

keep objects in registration color untouched, and whether to Flatten your file.

Attention:

• When using one Manage Color task to both convert and reseparate, the conversion
will try to keep the black channel unchanged, so as not to affect the reseparation.

• When using two Manage Color tasks after each other, one for conversion and one
for reseparation, this will not be the case, so the output will be different.

If you want to perform both conversion and reseparation on your file(s), we
recommend you use one Manage Color task for both instead of a task for each in your
workflow.

7.113.  Manage Milestone

The Manage Milestone task is documented here in the chapter on Jobs on page 495.

7.114.  Manage Product Status

This task is documented in the chapter on Products on page 548. Find a direct link here.
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7.115.  Map Data

This task is documented in the chapter Integrating with External Systems. Find a direct link
here.

7.116.  Mark as Proof

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.117.  Mark File (link)

This Workflow Control is documented in the chapter "Workflows". See Mark File and Select
Marked File on page 772.

7.118.  Merge PDF Files
This task combines multiple PDF files into one single PDF.

Multiple native PDF files can be merged into a single native PDF file. Multiple normalized PDF
Files can be merged into a single normalized PDF File.

Take the following notes into account when using this task:

Note:

• Normalized and native PDF files cannot be mixed together.
• The page sizes of the normalized PDF files must be the same.
• The output PDF will only be normalized if all the input files are normalized files and have the

same media and trim boxes. In case there is a mismatch in size, the task will fail.
• For normalized PDF files, the XMP information of the first file will copied into the resulting

PDF file. Then it will be updated with information from the other normalized PDF files.
• All pages of all incoming PDF files are added in the same order as the inputs of the task. To

control the order of the files, use the Workflow Control Sort.

7.119.  Modify Workflow Parameter Values

This Workflow Control is documented in the chapter "Workflows". See Modify Workflow
Parameter Values on page 753.
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7.120.  Normalize PDF File

Note:  Learn about the concept of 'Normalization' in Normalized PDF and XMP in Automation
Engine on page 43.

7.120.1.  Colors

You here define how (non-process) colors will be converted during Normalization.

Note:  The conversion uses the technology from Esko's Color Engine.

Objects With Profile Tags: Choose how to convert non process color images that have an
embedded ICC profile:

• Ignore Tag: To use the Default RGB Profile or Default Gray Profile (that you define below)
to convert the RGB or gray images. This disregards the images' own profiles.

• Convert Using Profile Tag: To use the images' own profiles to convert them to CMYK.

• Rendering intent

• Relative (no background): Choose this if you do not want any background simulation.
The white point of the source will be mapped on the white point of the destination
process. This rendering intent takes into account the ability of the human eye to adapt to
the surrounding white.

• Absolute (background): Choose this if you want background simulation and you want
an exact color match, including the paper simulation.

• Perceptual: This will result in no background simulation (white of reference color space
is mapped on white of destination color space). Choose this when you don't care too
much about an exact color match but when want the pictures at least to look nice on
your proofer. It will give a visually pleasing result. If the gamut of the source is wider than
the proofer, the entire gamut is shrunk so that it fits inside the gamut of the proofer.

• Saturation: Choose this if you care especially about saturated colors. This rendering
intent will map saturated colors on saturated colors.

Default CMYK Profile: Select the default profile to use for CMYK objects without an embedded
color profile. It will be used as a source profile for color-space conversions.

You can choose any CMYK profile in the Color Engine database.

Default RGB Profile: Select the default profile to use for RGB objects without an embedded
color profile. It will be used as a source profile for color-space conversions.

You can choose any RGB profile in the Color Engine database.

Default Gray Profile: Select the default profile to use for gray objects without an embedded
color profile. It will be used as a source profile for color-space conversions.

You can choose:

• any gray profile in the Color Engine database
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• Convert to Black Channel, if you want your grayscale object to only have a value in the
Black separation when outputting it to CMYK.

Output Color Profile: Enter the color-space of the output device (for example proofer or
press) .

You can choose any CMYK profile in the Color Engine database.

7.120.2.  Separations

You here define the ink attributes.

Note:  The settings in this tab only affect the Normalized PDF output file. They are ignored
again if the file is later output as a native PDF.

• Use ink attributes from file if available: If the input file contains rulings, angles and dot
gain compensation, select this option to use these attributes. Other settings in this tab will
be overruled. This option is relevant when you normalize PDF files that were exported from
earlier normalized files.

• Choose your Preferred Ink Book. When you type an ink name in the table, the task will first
look up its color information (CMYK, RGB, or LAB values) or the ink type (Technical, Varnish,
Opaque...) directly in the PDF. If it cannot find it there, it will look it up the Preferred Ink
Book that you define here.

For example, if you type 154 as ink name, and your preferred ink book is Pantone Colors
Uncoated, the task will automatically suggest the PANTONE 154 Uncoated ink.

• In the Inks panel, click an (empty) item in any column to change or add or select a new
value.

• The Ink Book column shows the first ink book containing this ink (or your Preferred Ink
Book if it contains the ink). To select another ink book, click the name of the ink book.

• If the Ruling, Angle and Dot Shape information are defined for this ink, they will be shown
automatically. If they aren't, you can enter them manually.

Note:  You can also specify Default Values to use when a ruling, angle or dotshape is
not specified (in the file or in the above panel).
 

 

• If the Ink Type shown is not correct, click it to change it.

• Do the same for any remaining inks you want to define.

• If you want, you can change the ink order using the Move Up and Move Down buttons.

7.121.  Normalize PostScript / PDF / Illustrator 8.0 File
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7.121.1.  Pages

 

 

Page selection

Define which pages you want to keep in your output PDF file. Select All Pages or specify a
Range.

Split Up a Multi-Page File

Select this to split the multi-page input file into multiple output files.

• Maximum Pages per File: Define the amount of pages you want in each output PDF file.
The last output file can have less pages than this value. Each output file is saved with a
numbered suffix (*_001, *_002, *_0001_001…) or it gets the Output Name.

• First Page number in Output

You can here define the "label" of the first page in the output. For example: when you
normalize a 4 page document, and set '3' in this field, the pages will be labeled 3-4-5-6.

Merged Tiled CT Files to one CT

Some ArtPro files include tiled CT images. Large size graphics can so contain thousands of
these small CTs.

Select this toggle to merge these tiles back into one CT. This so improves the editability and
processing of the output file.

This option has no effect when you import a file that has no tiled CTs.

Merge Separated File to Composite Page

This option merges separated PostScript or PDF files (single- or multi-page) to a composite PDF
file.

• Optimize Merged File. Use this option when you need to edit the resulting file.
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• Password: When normalizing password protected PDF files, enter its password here.

7.121.2.  Color Management

 

 

Destination Color Space
You here define the color space of the output file.

• Color Space: Choose CMYK or Grayscale.

• Destination Profile: Choose a color profile. Only CMYK and Grayscale profiles are
supported. Choose between standard ICC profiles and Esko profiles made in Color Engine
Pilot.

• Use PDF Output Intent if available: In some PDF files, the 'PDF Output Intent' is defined,
this is the intended output color space. For example PDF/X-3.

If you want to use the color space as defined in this 'Output Intent', select this option. If
you selected it for a file without PDF 'Output Intent', the chosen Destination Profile will be
used.

• Set Document Profile: A Document Profile is the color space of the process inks used in
the document.

• Always: You can 'tag' a Normalized PDF file with its Document Profile. This means that
the file knows what its Document Profile is, which can make color conversion further in
the workflow more correct.

If you selected 'Use PDF Output Intent if available', the Document Profile will be the
same as the PDF Output intent (if the imported file had one).

• From PDF File: (available when 'Use PDF Output Intent' is selected). The Document
Profile is taken from the PDF file, if there is an output intent defined in the PDF file. If
there is no Output Intent defined in the PDF file, then the Document Profile is not set
(untagged).

• Never: The Document Profile is not set.
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Spot Colors
• PANTONE Inks

• Keep all: No PANTONE inks will be converted to process inks.
• Convert all: All PANTONE inks will be converted to process inks.
• Keep list: All PANTONE inks will be converted except for those listed in the tab Inks.

Method

• Use destination profile: PANTONE and Designer inks will be converted using the
selected Destination Profile. This gives the most accurate color reproduction.

• Pantone+ Color Bridge Coated: Pantone inks will be converted to process inks
according to a fixed conversion table provided by PANTONE. The result is independent of
the selected Destination Profile.

• Other Inks

• Keep all: No other spot color inks will be converted to process inks.
• Convert all: All other spot color inks will be converted to process inks.
• Keep list: All other spot color inks will be converted except those listed in the Inks tab.

RGB
RGB will always be converted to process inks.

• Convert: Select a conversion method:

• Source to destination profile: You here need to specify both the Source Profile (RGB)
and the Destination Profile (CMYK or Grayscale).

• With link profile: You here need to specify a 'Device Link Profile' created in Color Engine
Pilot. This link profile determines both the Source and Destination profiles.

• Source Profile / Link Profile: Select one from the list.

• Objects with RGB Profile Tags: RGB objects in a PostScript or PDF file may be tagged with a
Color Profile.

• Ignore tag: The embedded Color Profile will be ignored. The Source / Link Profile defined
above will be used for the conversion of RGB objects.

• Convert using profile tag: The Color Profile is used as a Source Profile (overruling the
Source / Link Profile selected above).

CMYK and Gray
Objects in a PostScript or PDF file may be tagged with a Color Profile. The color percentages of
untagged objects will always be preserved.

Both for CMYK and Gray tagged objects, you have a choice:

• Ignore tags, preserve percentages: The Color Profile tag will be ignored, the percentages
will be those of the object's color.
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• Convert, preserve appearance: The objects' color profile will be taken into account. This
means that their color values will change.

7.121.3.  Inks

 

 

• Use rulings, angles and dot gain compensation from file if available:

When this option is selected:

• The angle, ruling and Esko dotshape are taken from the halftone specification in the PDF.
• If the PDF contains Esko XMP, the Ink Type and Printing Method are taken from this Esko

XMP.

This option is mainly used for this case. PDF files containing Esko XMP are typically
created by using the DeskPack plug-ins in Adobe Illustrator or by the AE task “Export to
PDF File”.

For inks that have information in the input file, the settings defined in this ink panel of the
task or in the Job setup are not used.

• Force ink settings from Job setup : If inks were defined in your Job setup, you can use
this toggle to make sure that this task uses those ink parameters.

• Apply Screen Swap Table: You can create 'screen swap' tables in the application
'ScreenFilter'. Select one to map PostScript screening to Esko screening.

• Map PANTONE Inks to: Select this to map all Pantone inks from the input file to a Pantone
ink book of your choice. For example: to map Pantone 123 U to Pantone 123 C .

• Use ClassicColors ink book: When the input file has inks with names that also occur in the
book 'ClassicColors' (for example "green"), select this option to map them to those in that
ClassicColors book (in stead of becoming a 'designer' ink).
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• Search Custom Ink Names: Define here the task should search for inks in its ink books
when you type in an ink name in the Inks table.

• Choose Only in the ink book 'designer' to search for ink names from the 'designer' ink
book only.

• Choose First in <selected ink book> and then in 'designer' to search in another ink
book of your choice first, and only use the designer ink book if no match is found there.

• Inks table:

• Double-click the fields in this table to edit them. The task will not change the inks that
you here deselect.

• Default values, used when a ruling, angle or dotshape is not specified: The task
uses these default values when they are not specified elsewhere (for example in the
PostScript file, in the Job setup, etc.).

7.121.4.  Overprint

Note:  This tab is only relevant when importing PostScript files.

 

 

• Strict overprint behavior

When normalizing composite files, this option controls how zero percentage inks are
handled.

Attention:  This option must be used when you want to process test files like the
Altona test suite or other test suites which verify correctness of overprint behavior.

When 'Strict Overprint' is used, all zero percentage inks of a color are kept and
correspondingly affect the overprint behavior. Choose from:

• Never strict overprint behavior: All zero percentage inks are removed.

• Always strict overprint behavior: The task honors the overprint parameter 100%
according to the rules mentioned in the "PostScript Language Reference" (in case of
PostScript / EPS /AI import) and "PDF Reference Manual" (in case of PDF import).

• Only strict overprint behavior for PDF: The task honors the overprint parameter 100%
according to the rules mentioned in the "PDF Reference Manual" (in case of PDF).

• Overprinting default is non-zero overprinting
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Select this option to prevent overprinted objects with zero CMYK values from knocking out
CMYK objects beneath them.

• Default: Choose the overprint mode that the conversion needs to apply.

• Opaque: Ignores any overprint in your file.

• Darken (Esko): Converts all overprint to Esko Overprint.

• PS Overprint: All overprint in the file is imported as PS overprint. This is the default
setting.

• Pure Black

Define the overprint mode for objects containing 100% black only. Possible Pure Black
overprint modes in the list:

• Default: As it is defined in the file.

• Force opaque: Forces Opaque for objects in 100% black and knocking out all
underlying inks.

• Force PS overprint: Forces PS overprint for objects in 100% black.

• Force darken (Esko): Forces the Esko darkening mode for all objects in 100% black.
The black color is so printed on top of other colors, instead of erasing the color
underneath.

• Rich Black

Define the paint mode for objects containing 100% black and at least one other ink.

• Default: As it is defined in the file.

• Force opaque: Sets the overprint mode to opaque for all objects containing 100%
black and at least one other ink.

• Force PS overprint: Keeps the PS overprint for objects in 100% black and at least one
other ink (overprint objects stay in overprint and opaque objects stay opaque).

• Force darken (Esko): Sets the Esko 'darken' overprint for all objects in 100% black
and at least one other ink.

• White

Define how you want whites to be handled:

• Keep PS overprint: Keeps the PS overprint for objects in white (overprint objects stay
in overprint, opaque objects stay opaque).

• Opaque: Forces all objects in white to opaque.

7.121.5.  Images
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• Embed all images: Select this if you want to embed all 1–bit, 8–bit and native images into
the output file. When not selected, only images with uncompressed image data smaller
than 640 kB will be embedded.

Note:  This is the only option in this tab that is relevant when normalizing PDF files.

• Optimize DCS LineWork: When DCS linework is not optimized, the result can be difficult
to edit afterwards. However it will be correct when viewed in extended preview or RIP'ed.
Select this option to trigger an additional operation that combines the elements on each
DCS plate to a composite and a more editable result.

• Search for preconverted Files: This option forces the task to look for the CT, LP or GR*
equivalent for the original EPS file. If this equivalent is not found, it will use the EPS instead.

• Link external images (OPI, DCS, Helios, ...): This option forces the task to look for
referenced images.

• Fail if not Found: Select this option if you do not want the task to continue when it cannot
find an image. When not selected, the task will create an output file but one with missing
images.

• Images: This option determines how images are treated when the task is run:

• Reconvert: This forces the system to regenerate the images on-the-fly.
• Use most Recent: This forces the system to use the existing images of a previous

conversion of the same file.
• Use masks

• PS mask: This forces the system to take the PostScript (PS) mask present in the EPF file.
The mask available in the external image is discarded. If no PS mask is present in the file,
no mask will be taken.

• External mask if any, PS mask otherwise: This forces the system to take the mask
present in the external image. The PS mask is discarded. When the external image has
no mask, but there is a PS mask available in the EPF file, this PS mask will be taken.

• External mask if any, no mask otherwise: This forces the system to take the mask
present in the external image. The PS mask is discarded. When the external image has
no mask, no mask will be taken.

• No masks: The PS mask and the mask of the external image are discarded.
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• Joined external and PS mask: This forces the system to join the available PS mask in
the EPF file and the available mask in the external image.

• Search directories: You can here specify a list of directories where the system should look
for referenced images.

Use the  'Add' and  'Remove' buttons to create this list.
• Path Translation...: This option serves to create a list that helps translating network paths

from one platform to another. Click the button to open a dialog and define three columns:

• From platform: Click on the field to select a platform from which the files are to be
retrieved: (Windows) NT, Mac, Unix or VMS.

• From path: Define the syntax of the path(s) of the platform you want to retrieve files
from. For example Mywork:BigCustomer:job1 .

• To path: Define the syntax of the paths so that the destination platform understands.
For example Mywork/BigCustomer/job1 .

An example: when going from Mac to Windows NT, the path translation can look like this:
 

 
• File Translation...: The same kind of translation can be done for file names.

7.121.6.  Page Size

 

 

Note:  The units are those defined in Edit >  Preferences >  Units.

• Page Size: Select the page size (Media Box) that you want for the output PDF file. Choose
'PS page size' to keep the size of the input PostScript or PDF file.

• Reader's Spread: When the input file has a reader's spread format, choose from:

• No: To force the reader's spread in the file into single page output.
• Yes: To force the file into reader's spread format. When the file contains no reader's

spread info, the single pages will be set as double pages.
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• Scale: If you want, enter a vertical and/or horizontal scale.

• Rotate: If you want, choose a rotation. The origin for rotation is bottom left and the
available rotations are counterclockwise.

• Offset: These fields allow to move the content of the file in regards to the page size. The
anchor point for the offsets is bottom left. A positive offset moves the content of the file up
and/or to the right. A negative one moves the content of the file down and/or to the left.

7.121.7.  Other

 

 

• Substitute Missing Fonts

• Roman Fonts by: Choose a default replacement font for any missing Roman fonts.

• Japanese Fonts by: Choose a default replacement font for any missing Japanese fonts.

• Fail if Font Not Found: Select this to make the task fail when a font is not found.

• Images

• Import 1-bit images as:

• Embed: Images become internal black and white bitmaps.

• Linked file: Images are imported as external referenced LP files (Esko native bitmap
files).

• Contours: Images are contourized during import.

• CT display images: Choose Yes to have the task also create a display image for the
generated CT files.

• Output file display images: Select the type of display from the list: None, Thumbnail
or Image and Thumbnail.

• Miscellaneous

• Device resolution: The resolution that the task uses internally during normalization.
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Normally the produced output is not dependent of this internal resolution. However, in
some rare cases, for example when converting RIP'ed test strips or device specific tests,
it is important that this value is the same resolution as used on the RIP device that will be
used to output.

• Virtual Memory limit: The default value is 50 Mb. The maximum you can set is 1
gigabyte (1024 Mb).

• Convert text to contours. Select this to convert all text to line work.

• Workaround Options

• Skip images: Select this to import the (E)PS file without linking to external images or
converting embedded images.

• Preserve Quark trapping: Select this to force the task to keep the trapping strokes
made by QuarkXpress.

• Disable optimizations: When not selected, the task performs a recognition of vignettes
and an optimization for Photoshop multitone images (whenever possible). Disabling
such optimizations was useful when an older version of the task could not yet perform
the optimization of the (E)PS file that a new DTP application had exported.

• Show PS comments: When selected, all 'PS comments' present in the (E)PS file are
mentioned in the task Details and in its Log file.

• Disable OPI: This option is useful when importing QuarkXpress (E)PS files that contain
high resolution Tiff files for which the option 'Include tiff, omit ...' or 'Include
all' was activated.

When importing such a file, and if Link External Images is selected, the matching of
the TIFF files will surely fail. It fails because at the time the (E)PS file was generated, OPI
commands were also inserted for the TIFF files. Therefore the system will try to link to
images for the Tiff files. To overcome this, select this option.

• Show external images searches: Select this to see, in the task's log file, the path(s)
where the task finds and links to external images.

• Optimize Illustrator Patterns: Adobe Illustrator writes patterns in a different way than
PostScript does. This option normally results in less linework in the output file, which
then speeds up the further processing. However, sometimes the optimization itself may
take some time.

• Use PostScript rules for color conversion: Select this to make sure that all color
management will happen using PostScript rules, instead of Esko's BGCMS. Selecting this
option grays out most options in the Color Management tab.
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• Object Based Color Conversion: 'Object by object' color conversion does not take
overprint and transparency interaction between objects into account, and may therefore
produce undesirable results. However, it may greatly improve editability.

7.121.8.  Output

• Keep Layers. Select this to keep the input file's layer information. This works for Illustrator
8 files (not v9 nor higher) and for PDF 1.5 or higher.

• Fit Media Box (margins). Select this to automatically fit the margins.

• Image Directory. When the task creates new image data, you can here indicate where
these images should be written.

The default offered SmartName [Job CT URL] will create them in a 'CT' folder that is
created in the root of the input file's Job Folder. Leave the field empty to have the image
files written next to your output file. Or select your own (central) folder and possibly add
SmartNames to that path.

7.122.  Normalize TIFF/IT File

This old technology is still supported but no longer commercially available.

Please find its documentation in the manual of Automation Engine 14.1 or older  (as part of the
Reference Guide).

7.123.  Optimize and Clean (PSFix)
PSFix is an Esko technology that optimizes and cleans files that were imported from PS or PDF
files. A typical feature is the removing of redundant objects. The resulting file is easier to edit
and process.

This task is typically executed right after a conversion to Normalized PDF.

7.123.1.  General
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• Delete

• Spurious Contours: These are

• Single points that only have a fill attribute.
• Single points that have a stroke attribute with butt or square caps.
• Contours that contain two points and that have a mask attribute, but do not mask

out any object. These contours can be created by accident or generated by PostScript
printer drivers.

• Double Contours: This removes double contours by recombining the fill and stroke
attribute of two identical objects into one object again. Double contours are created
when importing PostScript files, in which case an object with a fill and a stroke attribute
is split into two objects with each one attribute.

• Gross Clipping: This deletes the objects whose bounding boxes fall completely outside
the bounding box of the clipping path. This also works on composed text and externally
referenced objects.

• Useless Clips: This deletes useless clipping paths, objects that are totally clipped away or
objects that are totally covered by other objects.

• Hidden Objects: This deletes objects that are completely covered with another object.
The designer did not want to delete them or could not delete them on a certain page, as
they may have been components of a master page.

• Contours outside margins: This deletes contours outside the margins.

• Clean up unused inks: This removes all unused inks from the list of inks (separations).

• Clean up unused inks and colors: This removes all unused inks and also unused colors
(items in the color palette of the editing application).

• Strokes

• Regenerate Strokes: This searches objects that contain 20 points or less and converts
them to the equivalent strokes.
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Select 'Complex Objects too' if you want the task to search all objects that might be
degenerated strokes, so also those with more than 20 points.

• Minimal Linewidth: This defines the minimal width of strokes.
• Correct

• Blend to CT: This converts all blends to externally referenced CT images at a defined
Resolution (1 image per blend).

In PostScript files, blends are constructed by a large amount of contours that lie close
to each other and that have slightly different colors. The more accurate the blend, the
more contours and colors it is made of. This leads to large file sizes and decreases the
processing speed.

Note:  After this conversion, the display of the blend can be different. However, the
conversion does not affect the printed result.

• Simplify Linked Mask Objects: This tries to reduce the number of linked contours for
complex mask objects. This option is only useful for linked mask objects with a large
number of contours (>50).
 

 
• Fix bleed: This task can automatically create bleed. Bleeds for linework objects are

created in a new layer called "Bleedlayer". This layer can always be removed to return
to the original file. This is not possible with images. Images are modified in their original
location.

• Bleed Distance: This is the minimal amount of bleed that is required. For any object
that does not have this amount of bleed the correct bleed will be created.

• Gap: Any object inside the 'borders' (Trim Box), and that is closer than this distance
to the borders will be considered to require bleed. Typically, this value will be
small. It makes sure that objects which do not really touch the borders because of
inaccuracies in the design, are taken into account for bleed creation anyhow.

• Maximum Image Scale: There are two possible to fix bleed for images:

• When an image is larger than its clip mask, the task creates bleed by extending
the clip mask of the image. Hidden pixels so become visible and the missing bleed
problem is fixed.
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• When the image is not larger than its clip mask, the only way in which bleed can be
created is by scaling the image. The position of the image inside the page does not
change, but it is disproportionately scaled to create the correct bleed. To avoid an
unacceptable distortion of the image this parameter determines how much scaling
of an image is allowed. Set the value to 0 to prevent any scaling.

In order for the bleed-fixing to work properly it is imperative that the borders of the file
are set correctly (see the tab Borders on page 350).

• Put knocked-out technical inks object in overprint: This forces objects in technical
inks in overprint mode.

7.123.2.  Borders

 

 

• Adjust Borders: Select this to enable these options:

• Fit borders to: Choose All inks or one from your input file (for example its ink 'CAD'). For
a multipage file, when borders need to fit to a specified ink, the borders will be adjusted
to the largest page.

• Auto Fit Borders on Trim Marks: When the task can detect trim marks, the borders
will be set accordingly. For a multipage file, when borders are fitted to trim marks, the
borders will be adjusted to the first page.

Note:  The task recognizes trim marks that have an offset of at least 1 mm and have a
length of at least 1 mm.

This option is useful when the trim size of the input file is unknown or unreliable (for
example a missing or wrongly defined trim box in a PDF file). Even when the desired trim
size is known to the user, it can still be interesting to see if the automatically determined
border size corresponds to the desired one: a difference between the two is likely to
point to an error.

Note that the intelligent placement of files in FastImpose and Plato allows users to
neglect to work with accurately set borders. However, if you want to fix wrong bleeds it is
a requirement to have the borders defined correctly.
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• Move Borders: You can manually move any of the borders for Even and/or Odd pages.

• Auto Fit Margins on Trim Marks: To fit the Media Box to any trim marks.

• Fit Margins: To fit the Media Box to any objects in the file.

• Set Margins: To define a specific value for the Media Box.

7.124.  Optimize PDF

Concept

In ArtPro+, next to editing the open file, the user can also create a list of actions to be executed,
i.e. an Action List. He can execute this action list interactively - in the editor itself - or he can
execute that action list in background, as a task on AE. That task is the task Apply PDF Action List.

This task 'Optimize PDF' is different. It avoids that someone first has to create an Action List.

This 'Optimize PDF' task allows to combine many of those actions and then execute them in
background. You define all the wanted actions in the ticket and then launch it.

To use this 'Optimize PDF' task, you do not have to create an Action List.

Every time you launch an Optimize PDF ticket, AE first creates, hidden in background, a
temporary Action List for this task.

To do this, AE uses the PAL processor, a technology that wrapped the ArtPro+/NDL kernel into
a version that AE can then use in background. Learn more about the PAL Processor in Which AE
task Uses which Technology? on page 64.

General Behavior

• The Esko editor ArtPro+ reads and writes PDF+ files. Learn more about PDF+ in PDF+ in
Automation Engine on page 51.

• Input and output files:

• When the input is a regular PDF file, the output is a PDF+ file.

• When the input file doesn't have a document profile, a profile will be embedded
in the output file. This ICC profile is defined in the Configure tool >  Processing
Preferences > PDF+ Processing.

• When the input is a normalized PDF file, the output is a normalized PDF file.

• Multipage: When the input file has multiple pages, the actions are applied on all pages.

• SmartNames: Mind these rules when using SmartNames:

• When the input field represents a distance, the SmartName value needs to end with a
unit (in, mm, cm, dm, mil, pt).

• When the input field represents a density (for example when outlining a page box), the
SmartName value needs to either represent a fraction (between 0 and 1) or a percentage
value (and then also end with '%').

• Order of execution: The actions are applied in the order as you see them in the ticket:
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• The order of the tabs listed on the left.
• Within each tab: top to bottom.
• When multiple settings in one action: also top to bottom, except when stated otherwise

(see the 'Remove' actions).

• In a ticket, tabs where any kind of action is selected are indicated with a check mark:
 

 

• Marks: When the input file contains PDF marks, the PDF marks will be updated to reflect
the updated state of the document (layers, separations, page boxes).

Attention:  Any SmartMarks from a normalized PDF input file will not be updated by
this task.

• Unused Separations: When the input file contains unused separations (especially in the
case of normalized PDF), these will be removed from the output.

7.124.1.  Tab 'Processing Step Layers'

About Processing Steps

• What is a Processing Step?

"Processing Steps" is a methodology to store PDF objects in a PDF that will be used for
additional processing beyond the step of printing, for example embossing, gluing, cutting,
folding, etc.

Learn more in the pages PDF+, Successor of Normalized PDF on page 51, PDF+ File's Info Dialog
(the section on layers) and Processing Steps - Groups and Types on page 61.

• Why use Processing Steps?

• Because this information in the PDF can improve your workflow. This of course relies on
applications and devices that pick up this type of PDF object.

• Giving layers the attribute of a type of processing step (for example the type 'embossing')
enables to no longer use the attributes 'technical' and 'varnish' that you could set for
‘Inks’. Those extra ink-type attributes are Esko proprietary attributes restricted to use in
normalized PDF. PDF+ enables to skip using those and instead use this ISO conform way
to use layers for this purpose.

Set Processing Step Type for Layer

• Setting a Layer to the Type 'Processing Step'

• Defining the name of the layer:

352



7Automation Engine

• Either type the name or select it from the list of layers of the input file.
• Layer names can contain wildcards (*) and SmartNames. It can be a comma

separated list of layer names.
• The matching to layer names is not case sensitive. For example: the layer 'tech' will

also match to 'Tech'.

• Defining the type of processing step: The matching layer(s) will be set to the type of
processing step that you selected from the list.

Attention:  In case you use a SmartName in this field or type in a value, be aware
that this field is case sensitive!

Note:  The types in the list are those defined in the ISO standard. You can not define
custom ones.

• The task also moves this type of layer(s) on top of all artwork layers.

• Removing the processing step type from a layer

When you set the field for 'processing step type' to 'None' (not case sensitive) or you leave it
empty, then the layer(s) will be converted into normal layers (i.e. the processing step type is
removed).

In this case, the layer order does not change.

Create Processing Step Layer from Separation

You can also create such a type of layer by using the data present in a specific separation.

• Separation Name: The objects that have a fill or a stroke in that separation (not case
sensitive) are moved to this layer. These objects are also set to overprint.

• Layer Name: The specified layer (case sensitive) will be moved on top of all artwork layers.
When that layer doesn't exist yet, it will be created.

• Processing Step Type: The specified layer will be set to the specified type.

7.124.2.  Tab 'Layers'

Note:  About defining the name of the layer:

• Either type the name or select it from the list of layers of the input file.
• Layer names can contain wildcards (*) and SmartNames. It can be a comma separated list

of layer names.
• The matching to layer names is not case sensitive. For example: The layer 'tech' will also

match to 'Tech'.

Rename Layers

Select or define the name of the old layer and then define its new name it should get.
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Remove Layers
Specify the layers that need to be removed from the input file.

• by Name

• by Processing Step

Keep Layers
Specify the layers that were defined in the list of 'Remove Layers' but that should not be
removed.

• by Name

• by Processing Step

Add Layers

This allows to add empty layers. They are added on top of the other artwork layers.

• A comma separated list of names is here not supported (it will be seen as one name with
comma's in it).

• The layer will not be added when the input file already contains a layer with the same name.

• Exception: The name matching is case sensitive, i.e. the layer is still added when the
input file contains a layer with a name that only differs in case from the specified name.
Example: you can add a layer 'side' when there is already a layer 'Side'.

Update Layer Printability

Learn more about the printability of layers in the ArtPro+ user guide (Document Settings >
Layers).

• Don't Change Layer Printability: This (default) setting does not make any changes. This
is useful when you want to keep the non-printable layers. For example layers that contain
base information that is used for aligning or editing.

• Make All Layers Printable

• Remove Non Printable Layers: This removes all non printable layers and their objects.

7.124.3.  Tab 'Separations'

Note:  About defining the name of the separation:

• Either type the name or select it from the list of separations of the input file.
• Separation names can contain wildcards (*) and SmartNames. You can also define a comma

separated list of separation names.
• The matching of a separation name is not case sensitive (ignores the case). For example:

typing 'gold' will also match with 'Gold'.

• Remap Separations
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• Old and New Separation Name:

Define the name of the separation to be renamed (old name) and its new name.

When the new separation does not exist yet, it will be created (and listed at the end of
the separation list).

• New Separation Book: Optionally, you can select the ink book of the target separation
from the list.

• When using a SmartName or typing in a name, there is no check if that ink book
exists.

• You can remap multiple inks:

• By using wildcards. For example, rename 'PMS*' to 'HKS*'.

• By using comma separated lists. When both the old and the new separation name are
a comma separated list and both lists have the same number of comma separated
parts, then the old name and new name lists are split where each part of the source
is mapped on the corresponding part of the new name. For example: When old name
'A,B' and new name is 'X,Y', then A will become X and B will become Y.

• When the separation book is also a comma separated list, these will be split in
the same way. Otherwise (not a list), the separation book will be used for each
mapping.

• Convert Separations to CMYK

• Specify the (spot) colors that you want to convert to process colors (CMYK).
• Process colors that are needed for the conversion but that are not yet in the file will be

added to the output file (at the end of its list of separations).
• Except for: Specify the separations that were defined to be converted but that should

not be converted.

• Spot Color Lookup

Choose which CMYK values should be used for the conversion of that spot color:

• Look in Ink Books Only: To use the CMYK values as defined in the Esko CMS (not
available for custom inks).

• Use Colors in File: To use the CMYK values that are saved in the PDF file.

7.124.4.  Tab 'Remove Separations'

You can select the separations by their Name or by their Printing Method.

Note:  Selection by printing method does not support wildcards (*).

• Remove Separations
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• Keep Separations. All separations that you specified in the above 'remove' section will be
removed unless you have specified it here.

7.124.5.  Tab 'Separation Properties'

• Apply Separation Type

Attention:  The types Varnish and Technical are only valid in normalized PDF files.
When asking to set these types on other PDF files, the task will not make any type
changes and end in warning.

• Apply Printing Method

Printing methods can be defined in the Configure panel (Pilot >  Configure) or in ArtPro+
(Edit >  Options. This list of methods is synchronized when the editor is set up to use the AE
server.

7.124.6.  Tab 'Document'

When selected, these actions will be applied in the order as they appear in this tab. For
example: first increasing the line width and then outlining the strokes,

• Merge similar path & text: Select this to combine a path or text box that is composed of
different identical objects (shape, size and position) on top of each other, into one object.

• Contourize text: Select this to replace editable text by a group of paths and compound
(merged) paths.

Note:  This function does not work on Dynamic Marks or protected objects.

• Increase line width: Select this to increase the stroke width of all objects that have a stroke
width smaller than the specified minimum value.

• Minimum Line Width: Define the minimal width that all strokes should have.

• Outline Strokes: Select this to replace stroked objects by a group consisting of a path (the
fill object) and compound path (the outlined) stroke.

• Clean up groups & clipping masks: Select this to remove redundant groups and clipping
masks (for example a group as sole component in another group).

• Execute clipping masks: Select this to crop objects on their clipping mask, and then to also
remove the clipping mask and anything that was clipped away. During the process, affected
strokes and live text are contourized.

7.124.7.  Tab 'Page Boxes'

The 5 PDF Page Boxes:
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1. Media Box: This is the page format.
2. Crop Box: This includes the Bleed box and all marks.
3. Bleed Box: This is the trimmed page plus the bleed.
4. Trim Box: This is the net document format.
5. Art Box: The Art box can be used to specify any section of the page.

• Adjust Page Box

Select the type of Page Box and how you want to adjust its Size or Position.

• Based on:

• Select Absolute (Background) if you want to define the selected page box
independently of the file's contents or existing page boxes.

• Select Content if you want to base the selected page box on the file's contents. This
takes clipping paths and masks into account.

Note:  Default directions (positive values) are horizontally to the right and vertically
upwards.

Note:  Use a negative value to reduce the page box size or a reverse offset.

Note:  The task first executes the alignment and only then the offsets.

Note:  You can adjust multiple page boxes.

Learn more in the ArtPro+ user guide.

• Outline Page Box

This makes page boxes visible by giving them a colored stroke. This allows to inspect page
boxes in applications that have no means to visualize them.
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7.125.  Optimize PDF Document
This task enables you to make some prepress-specific changes to a PDF document. It so avoids
having to stop a workflow task to do such edits in an interactive application.

The output will be PDF when the input file is a native PDF. The output will be Normalized PDF
when the input is a Normalized PDF or a PDFPLA file.

7.125.1.  Document

• Optimize Document

• Preserve fonts: Select this make sure your fonts will print or display correctly. Choose a
method:

• Embed Fonts: This embeds all used fonts.

• Embed & Rename: This embeds 'Base 14 Fonts' under a different name (their name
in the Esko PDF Library), and all other fonts under their existing name. This prevents
Acrobat from replacing the document font with a local font of the same name when
using live text.

Note:  'Base 14 Fonts' are: Courier, Courier Bold, Courier Oblique, Courier Bold-
Oblique, Helvetica, Helvetica Bold, Helvetica Oblique, Helvetica Bold-Oblique, Times
Roman, Times Bold, Times Italic, Times Bold-Italic, Symbol and Zapf Dingbats.

• Vectorize: This converts all text to outlines.

• Apply document's rotation flags: In a PDF file, a 'rotation flag' specifies by what angle
the contents should be rotated when previewing or printing the file.

Some older applications and devices ignore or mishandle this rotation flag. If you are
sending your file to such an application or device, select this option to execute the
rotation specified in the rotation flag.

• Outline strokes: Select this to convert the strokes to outlines. Choose Dash Only to only
converts dashed strokes into individual outline objects. This can significantly improve
trapping.

• If you want to change the strokes' width in your document, select Increase line width
and enter a Minimum Line Width. All strokes with widths below this value will be
enlarged to that width.

• Rotate File: Select this to rotate the contents of your file (clockwise). This may be needed to
make the contents fit on a certain device.

• If Apply document's rotation flags is not selected, this changes the rotation flag's value
but does not rotate the file's contents.

• If Apply document's rotation flags is selected, this rotates the file's contents.

• Adjust Page Box: Use this to change some or all of the document's page boxes, or add
page boxes in your document. Learn more in Adjust Page Box on page 359.
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• Outline Page Box: Use this to outline some or all of the document's page boxes. They then
become visible on proof for example. Learn more in Outline Page Box on page 360.

Adjust Page Box
To add or change a page box:

1. Click Add to open the Adjust Page Box dialog.
 

 
2. Select the Page Box to add or change.
3. Choose what you want the new size to be Based on:

• Choose Absolute (Background) if you want to define the page box size independently
of the file's contents or existing page boxes.

• Choose Content if you want to base the page box size on the file's contents. This takes
clipping paths and masks into account.

• Choose Media Box, Crop Box, Trim Box, Bleed Box or Art Box if you want to base the
size of the selected page box on that of another one.

4. Define the new Width and Height.

• If you have chosen to use an Absolute size, enter the page box's Width and Height.
• If you have chosen to base the page box size on the file's Content or on another page

box, you can adjust the width and height in Increase Width and Increase Height.

Note:  Use a negative value to reduce the page box size instead of extending it.

5. If you want, enter an Horizontal Offset and / or a Vertical Offset.

• A positive horizontal offset will move the page box to the right, a negative one to the left.
• A positive vertical offset will move the page box to the top, a negative one to the bottom.

Note:  This is applied after the Alignment was done!

6. Choose the page box's Alignment (relatively to the old page box):
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7. Apply your changes to either All Pages or only to the Odd or Even Pages.
8. Click the Add button to confirm.

Note:  You can adjust multiple Page Boxes.

Outline Page Box
To outline a page box:

1. Click Add to open the Outline Page Box dialog.
 

 
2. Select the Page Box to outline.
3. Define the Ink for the stroke to use.

Type an Ink Name, use a SmartName or click the color patch to open a color picker.
4. Enter the ink Density to use.
5. Specify the Stroke Width to use.
6. Click the Add button.

7.125.2.  Layers

• Action 1: Rename Layers
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Click Add and enter the Old and the New Layer Name. You can use SmartNames and / or
wild cards (to replace part of the layer name).

Tip:  You can also merge layers by renaming a layer to an existing layer's name, or by
renaming several layers to the same name. This works for layers that are directly on top of
each other in the file.

• Action 2: Remove Layers

Click Add and enter the names of the layers you want to remove. You can use SmartNames
and / or wild cards.

 

 

Except for: When using a wild card to remove layers, use this parameter to keep certain
layers, even if they match the name entered in Remove Layers.

 

 
• Action 3: Add Layers

Use this to add empty layers to all pages of your PDF.

Click Add and enter the name of the layer to add. Repeat as necessary.
• Update Layer Print-ability: Select how to handle the print-ability of layers in your output

file:

• Don't Change Layer Print-ability
• Make All Layers Printable
• Remove Non Printable Layers.

7.125.3.  Images

• Downsample Images

Select this to lower the resolution of the file's images.

• Choose what resolution you want to Downsample bitmap (black & white or one-bit)
images to, if their resolution is above a certain resolution.

• Choose what resolution you want to Downsample contone (grayscale or color) images
to, if their resolution is above a certain resolution.

• Crop Images
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The tasks can remove unused image data from the PDF by cropping images on the
bounding box of their clip path. Cropping images is done to make PDFs smaller.

Split images area when at least ... % of the images is clipped away: This parameter
defines how the task will crop the image, depending on how much of it is clipped away (for
example for images that have multiple clipping paths on them).

• If the part of the images that is clipped away is less than the value you enter here, the
images will stay together and be cropped to the bounding box of the combined clipping
paths.

• If the part of the images that is clipped away is greater than the value you enter here,
the images will be split into multiple clipped images, each cropped to the rectangular
bounding box of its clipping path.

• Recompress Image Data

• For Color, Gray Scale and Soft Mask Images, you can choose between the JPEG and ZIP
compressions.

• For Bitmap Images, you can choose between the CCITT Group 3, CCITT Group 4, ZIP,
and Run Length compressions.

7.126.  Optimize PDF Separations
This task enables you to make changes to the separations of a PDF file.

The output file will be PDF when the input file is a native PDF. The output file will be
Normalized PDF when the input file is a Normalized PDF or a PDFPLA.

When the input is a multi-page file, all requested functionality is executed on all pages.

7.126.1.  Colors

You here define how to convert the file's (non-process) colors.

Note:  The conversion is done by Esko Color Engine.

• Embed Profiles Mode: The task uses embedded profile(s) as source profiles for
conversions. Choose from:

• Do not change: This doesn't make any changes to embedding of color profiles.

• Embed: This embeds all color profiles.

• Embed & Overwrite: This re-embeds all color profiles, overwriting profiles that were
already embedded.

• Remove All Embedded: This removes all embedded profiles.

• Convert RGB, LAB, Gray to CMYK: Select this to convert all non-process color spaces
(except spot colors) to CMYK.

Note:  This will generate errors and/or warnings when trying to convert non-separable
blend modes.
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• Fail When Converting Color Spaces: Color converting objects that have transparency
effects (like blend modes) can generate visually unexpected results. When this problem
occurs, you can:

• Select this option if you want the task to stop with an error.
• Deselect this option if you want the task to only generate a warning.

• Default CMYK Profile: Select the default profile to use for CMYK objects without an
embedded color profile. It will be used as a source profile for Color Space conversions.

Note:  You can choose any CMYK profile in the Color Engine database.

• Default RGB Profile: Select the default profile to use for RGB objects without an embedded
color profile. It will be used as a source profile for Color Space conversions.

Note:  You can choose any RGB profile in the Color Engine database.

• Default Gray Profile: Select the default profile to use for gray-scale objects without an
embedded color profile. It will be used as a source profile for Color Space conversions.
Choose from:

• Any gray profile in the Color Engine database.
• Convert to Black Channel, if you want your gray-scale object to only have a value in the

Black separation when outputting it to CMYK.
• Output Color Profile: Enter the Color Space of the output device (proofer or press) in this

parameter.

Note:  You can choose any CMYK profile in the Color Engine database.

• Update spot color equivalents: This option handles CMYK values for spot color inks. You
can:

• Select this option to overwrite the CMYK values found in the file with the CMYK values
stored in the ink book.

• Deselect this option to use the CMYK values found in the file for spot color inks.
• Spot Color Lookup: Indicate where the task should look for the spot colors' information.

Choose from:

• Look in Ink Books First: The task first looks in the ink book you defined in Preferred
Ink Book.

If it doesn't find the spot colors' information in that ink book, it then looks for it in the
file.

• Look in Ink Books Only: The task only looks in the ink book defined in Preferred Ink
Book.

If the task does not find the spot colors’ information in that ink book, it ends in error.
• Use Colors in File: The task looks for the spot colors’ alternate color values (generally in

the CMYK color space) in the file, and uses those values.
• Preferred Ink Book: Choose the preferred ink book that will be used in this task.
• PANTONE Color Lookup: Choose the settings for the PANTONE colors conversion. Choose

from:

• Use destination profile: Use the color profile defined in the Output Color Profile to
determine CMYK equivalents of the PANTONE Color.

• HP Indigo CMYK x.x: Use CMYK equivalents for the HP Indigo Press.
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• Pantone+ Color Bridge Coated: Use the CMYK equivalents defined in the Pantone Color
Bridge Coated guide.

7.126.2.  Inks

Note:  This functionality is executed in the order as numbered: First Action 1, then Action 2,
etc.

Caution:  All ink-related parameters are case sensitive.

• Action 1: Remap Inks

Click Add to open the Remap Ink dialog, then enter the Old and the New Ink Name.

Tip:  You can also merge inks by remapping an ink to an existing ink's name, or by
remapping several inks to the same name.

Note:  If your original ink has a PANTONE Suffix, add it to the Old Ink Name, even if you
are changing this suffix. The reason for this is that when you use both the Remap Inks and
Pantone Suffix parameters, the task renames the inks first.

Pantone Suffix: Use this to change the suffix (for example CV, CVC, CU...) of PANTONE
colors. Choose from:

• Do not change.
• Convert: This changes the suffix to the one you select in the To list, for all PANTONE

colors.
• Convert If Found In Ink Books: This changes the suffix to the one you select in the To

list, for PANTONE colors found in the ink books you defined (in the tab 'Colors').

Note:  This option can also merge inks. For example if you have PANTONE 484 U and
PANTONE 484 C, and you change all the suffixes to C.

• Action 2: Convert Inks

Use this table to convert spot colors to CMYK. You can use wild cards (*) in the ink's name.

• Action 3: Remove Inks

Click Add and enter the names of the ink you want to remove. You can use SmartNames
and/or wild cards.

Except for: When using a wild card to remove inks, use this parameter to keep certain inks,
even if they match the name entered in Remove Inks.

For example, to create a PDF file for the die-cutter, you can remove all the inks except the
ink Die cut :
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Preserve Separation Interaction: Use this parameter to define what to do when the
separations you remove contain objects that knock out other separations.

• None: This only deletes knock-out objects that are only defined in the removed
separation(s).

Use this when removing separations that don't influence the final result (for example die
cut separations).

• Standalone: This converts knock-out objects that are only defined in the removed
separation(s) to white knock-out objects defined in one of the remaining separations.
The remaining separations keep looking the same.

This method is recommended for most use cases.

• For Versioning: This converts knock-out objects that are only defined in the removed
separations to white overprinting objects. Those are defined in a color space made from
the remaining separations of the file, and overprinting on all other separations.

This ensures that when re-adding separation layers for versioning, the final result looks
the same as the original file.

Note:  This may create objects in 'DeviceN' color spaces, which is something that some
applications cannot handle. Only use this method if you want to do versioning on your
file.

• Remove unused separations: Select this to remove unused separations (separations
containing no objects) from the file.

7.126.3.  Ink Properties

This tab allows to apply extra properties of Ink Type and Printing Method to the existing inks.
These properties can be used to steer behavior of tasks later on in the workflow, for example
when using the Extract Inks task based on printing methods.
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• Apply Ink Type

You can define the Ink Type for each Ink Name. You can use SmartNames and wild cards.

An Ink Type can be Normal, Opaque, Varnish or Technical. Limitations for Opaque can
be imposed by the CMS. Process colors (CMYK) can only be Normal.

Note:

• When using wild cards in the ink name, the inks matching that pattern will get the
specified properties. If an ink matches more than one pattern, the first one is taken.

• When matching, the letter case is ignored.

• Apply Printing Method

Set the Printing Method for a specified Ink Name. Choose from the list of printing
methods as defined in the Configure panel .

7.126.4.  Overprints

Use this these options to change the Overprint versus Knockout behavior of the inks.

• To Knockout

• All overprint objects: Select this to disable all overprints in your file.

Attention:  This can change the file's appearance.

• White text: Use this to set white text to knockout. In this context, 'white' means having a
fill or stroke of 0% of one or more inks.

• White vector: Use this to set white line art to knockout. 'White' here context means
having a fill or stroke of 0% of one or more inks.
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• Technical objects: Use this to set technical objects to knockout.

• Varnish objects: Use this to set varnish objects to knockout.

• Opaque ink vector: Use this to set line art in opaque ink to knockout. Opaque inks are
defined in the ink book, using the Color Engine Pilot.

• Opaque ink text: Use this to set text in opaque ink to knockout. Opaque inks are
defined in the ink book.

Caution:  When an ink is explicitly defined as "opaque" in the ink book, you
cannot make it "normal" with this task. You will get a warning if you try.

• To Overprint

• All knockout objects: This parameter changes all knockout objects to overprinting
objects, and modifies their color space(s), so that the file keeps the same appearance.

Attention:

• Only use this parameter in creating PDF versions.
• This parameter affects how you can place the file afterwards. If you place this

overprinting file on top of another file, all the channels of the bottom file that
are not present in the top file will be visible.

• Black text: Use this to set black text to overprint. You can choose to make:

• All black text overprint, or

• black text Smaller Than a defined value overprint.

• Black vector: Use this to set black line art to overprint.

• Technical objects: Use this to set technical objects to overprint.

• Varnish objects: Use this to set varnish objects to overprint.

• Opaque ink vector: Use this to set line art in opaque ink to overprint. Opaque inks are
defined in the ink book.

• Opaque ink text: Use this to set text in opaque ink to overprint. Opaque inks are
defined in the ink book.

7.127.  Outline Fonts
This task will contourize all fonts in the file and in all the files it refers to. Both live and
composed text will be contourized. ‘Internal’ text (executed SmartMarks for example) is already
contourized.

The task outputs a different PDF and by default adds the suffix _c to its name (use
SmartNames to overruled this behavior).
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Tip:  When the input file did not contain any fonts, the Details pane of the Task and its log file
mention this.

7.128.  Preflight Color for Digital Printing

This task is documented in the chapter Digital Printing Workflow  on page 1429. Find a direct
link here.

7.129.  Preflight Color for Equinox
You can use this task to decide which ink set to use when sending a print job to your expanded
gamut printing press.

Some print jobs can be printed just as well with less inks (reducing not only the ink cost but
also the print time needed), but it's often cumbersome and time consuming to check this
manually for every print job.

This task automates the checking and comparison process: it calculates the color accuracy you
can achieve with the ink set(s) you are thinking of using, to help you choose a cost-effective
solution that will still meet your quality standards.

Checking the Color Accuracy Achievable with a Certain Ink Set
If you want to check whether a certain file can be printed with a certain ink set and give a color
accurate result:

1. Choose a color strategy made for printing with that ink set.
2. Set your color deviation tolerance (above which Delta E value you would consider the print

not color accurate enough).
3. Send your file through the task.
4. The task outputs a detailed report: for each ink in your file needing conversion to your ink

set, you can see the percentages of the inks on press that would be used, and whether the
color accuracy would meet your tolerance.

Any ink that cannot be printed within your tolerance is given a "fail" status.

Your file only has an overall "pass" status if all its inks have a "pass" status. This means that
you can print it color accurately with that ink set.

See Task Parameters on page 369 for more information about setting up your task.

Comparing the Color Accuracy Achievable with Different Ink Sets
You would typically run your file through several Preflight Color for Equinox tasks in a
workflow: one task for each color strategy/ink set that you want to check.

Each task then outputs a report detailing the color accuracy you can achieve with that color
strategy/ink set, and gives an overall "pass" or "fail" status for printing your file with that ink
set.

This helps you can choose the smallest ink set that gives you a good color match for that file,
so that you can combine quality and cost-efficiency.
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Note:  The detailed information in the reports helps you take an informed decision in difficult
cases. The final decision always rests with you.

You can use this task:

• on the production floor, to help you maximize the speed and cost-efficiency of your
expanded gamut printing press while still printing your jobs with good color accuracy.

See Preflight Color for Production on page 374.

• if you have a sales office, you can use it to help you quote a competitive price to your
customers without skimping on quality (you can then pass on the ink set information to
your prepress/printing department, saving them the time it would have taken them to check
different ink sets).

If your sales office uses an MIS system, you can even integrate a Preflight Color for
Equinox workflow with your MIS system.

See Preflight Color for Cost Estimation on page 378.

7.129.1.  Task Parameters

Set up each task's parameters as follows:

1. Decide which ink set you want to check your file against, and select a Color Strategy whose
output profile uses this ink set.

Depending on whether you want to decide on an ink set for production or for cost
estimation, the exact color strategy you choose may be different.

See Preflight Color for Production on page 374 and Preflight Color for Cost Estimation on
page 378.

Attention:

• You can only select an Equinox color strategy. If you select another type of color
strategy (through a SmartName for example), the task will end in error.

You can create Equinox color strategies in Color Pilot, see the Color Pilot
documentation for details.

• The task will also end in error if it cannot find your chosen color strategy in the
color database (if for example it was deleted before you ran the workflow).

2. Select the Delta E Formula to use to calculate the color difference between the spot colors
in your file and how they can be reproduced using your chosen Color Strategy.

You can choose from:

CIELAB Delta E,
Delta E 94,
Delta E 2000,
CMC (1:1),
CMC (2:1),
Delta E 2000 (2:1:1).
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Note:  If your company is already using one of those formulas, we recommend that you
choose the same one. If not, you should choose Delta E 2000, which is the best reflection of
the visual difference between colors.

3. Choose how close (in Delta E) the output colors must be to the colors in your input file for
you to accept the print job as color accurate, and enter this number in Delta E Tolerance
for Spot Colors.

The default tolerance is 2 Delta E, as color deviations under this threshold are generally not
visible to the human eye.

7.129.2.  Preflighting a File's Colors

You can send either PDF or Normalized PDFs files through this task. When working with regular
PDFs, it will automatically normalize them using the Normalize ticket that is selected in the
Configure tool's Processing Preferences.

When running a file through this task:

1. The task calculates how to convert the file's separations to your chosen Color Strategy's
output profile.

It checks all separations except:

separations that should be output
as they are

• process separations
• other separations used in the output profile

(when checking against a multicolor profile)
• separations set to "Keep in Output" in

the color strategy (for example White or
metallics)

separations that never require color
management

• technical separations
• varnish separations

Note:

• Separations that have conversion values defined in your color strategy's exceptions list
are checked.

• The Preflight Color for Equinox task will only check opaque inks if you are using an
Equinox color strategy that is set to convert opaque inks.

• The task will only check unregistered inks if your Equinox color strategy is set to convert
unregistered inks.

For more information about Equinox color strategy options, please see the Color Pilot
documentation.

2. For each separation, it checks whether the color difference between the converted color
and the original color is within the Delta E Tolerance you have specified, and gives a pass or
fail status.
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3. It writes all of the pass or fail statuses for that file into an XML report, and gives an overall
pass or fail status for that color strategy (pass means that the color difference is within
your Delta E tolerance for all separations, but if at least one separation has a higher Delta E
then the overall status is fail).

You can see the preflight results in the Log Info or the XML report. See Color Preflight
Results on page 371 for more information.

4. When running your file through several Preflight Color for Equinox tasks in a workflow,
you can see which color strategies give a pass, and choose to use the smallest ink set that
still gives you a good color reproduction.

Note:

• To see more details on the color reproduction of each color strategy, you can either
check their XML reports manually or feed them to your MIS system.

• The final decision on what color strategy to use always rests with you.

If for example one of the color strategies gives you good Delta Es for all separations but
one, and that separation is only present in a very small and less important area of your
file, you can still decide to use that color strategy anyway.

If none of the ink sets/color strategies gives a good color reproduction, you may want to
(depending on the case) use one or more additional spot colors, print the file with one of
the color strategies anyway, tweak the color strategy in Color Pilot, adjust the file...

For more information about using several Preflight Color for Equinox tasks in a workflow,
see:

• Preflight Color for Cost Estimation on page 378
• Preflight Color for Production on page 374

Color Preflight Results

Processing Status
• After running the Preflight Color for Equinox task on your input file, the Tasks pane shows

the processing status (and not the preflight status).

Task status Processing status

 Successfully done Input file processed successfully (whether the Delta E
values for the ink conversions are within your required
tolerance or not)

 Done with warning Input file contains unregistered inks (inks that are not
part of an ink book in your color database)

 Failed The color strategy is invalid or doesn't exist

To see the preflight status (and detailed results), you should open the task's Log Info, or the
XML report it produced.

• When running the task in a workflow, the XML report is sent through a different output pin
depending on both the processing status and the preflight status.
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There are 5 output pins, corresponding to the following statuses:

Output pin Processing status Preflight status

 Pass Input file processed
successfully

With this color strategy, all
conversions are within your
Delta E tolerance

 Fail Input file processed
successfully

With this color strategy, at least
one of the conversions gives a
Delta E above your tolerance

 Pass
Unregistered

Input file contains unregistered
inks

All conversions are within your
Delta E tolerance

 Fail
Unregistered

Input file contains unregistered
inks

At least one of the conversions
gives a Delta E above your
tolerance

 Error The color strategy is invalid or
doesn't exist

Cannot preflight

Note:

Equinox color strategies have an option to convert unregistered inks or not (see the Color
Pilot documentation for more details).

• If your color strategy doesn't convert unregistered inks, the preflight either passes or
fails depending on the conversion values of the registered inks only.

• If your color strategy converts unregistered inks, the preflight either passes or fails
depending on the conversion values of both registered and unregistered inks.

For example: you have an input file containing registered inks that can be accurately
reproduced with CMYK, and an unregistered ink that cannot. You are preflighting it against a
CMYK ink set.

When using a color strategy that doesn't convert unregistered inks, the preflight will
succeed (the report will go through  Pass Unregistered).

However, when using a color strategy that converts unregistered inks, the preflight will fail
(the report will go through  Fail Unregistered).

Preflight Results Details in the Log
You can see the preflight results in detail in the task's Log Info.
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Under Results, it lists:

• which of the input file inks were converted by your chosen color strategy (certain ink types
are never converted)

Note:  If your input file contains a double strike of an ink (a percentage above 100%), this
ink will appear twice.

• the conversion values for those inks (in percentages of the printing inks)
• the Delta E achieved for each converted ink
• the overall PASS or FAIL status

Attention:  After running a workflow containing the Preflight Color for Equinox
task, make sure you open the task's Log Info and not the workflow's Log Info (as the
workflow's log only contains processing information).

Preflight Results Details in the XML Report
Each Preflight Color for Equinox task also generates an XML report containing detailed
results about the conversion to your chosen color strategy with your desired Delta E tolerance.
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It contains the same information as the log, but is formatted to be easily usable by an MIS
system (or Automation Engine's Join XML Files task, in preparation for sending to an MIS
system).

If you are reading this XML report yourself:

• you can find the overall status at the top of the file (for example Status="passed"),

• you can check which of the input inks were converted (ink types that are never converted
indicate the reason in their status, for example Status="IsProcessInk" or
Status="IsVarnish"),

• for the inks that were converted, you can see the resulting percentages of the printing inks
in DeviceColor, and the Delta E achieved.

7.129.3.  Preflight Color for Production

You can use the Preflight Color for Equinox task on the production floor, to help you
maximize the speed and cost-efficiency of your expanded gamut printing press while still
printing your jobs with good color accuracy.

When using this task to prepare for production, you want to decide on the ink set to use for
your print job, but you may also want to take into account any tweaks necessary to get the best
color result on your particular press.

This means that for each Preflight Color for Equinox task that you run on your file, you
should select a Color Strategy using your press profile as an output profile.

Tip:

When profiling your expanded gamut printing press in Color Pilot, you can easily generate:

• a color strategy with your press profile as output profile,
• additional color strategies with a subset of that profile's ink set as output profile (for

example, if you profiled your press with a CMYKOV ink set, you can also generate color
strategies to output to CMYK, CMYKO and CMYKV on that press).

See the Color Pilot documentation for details.

Example Workflow
One of the simplest ways to set up a workflow to check what ink set a file can be printed with is
to cascade several Preflight Color for Equinox tasks.
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1. This workflow first marks the input file with a tag (File to Preflight) then sends it to
the first Preflight Color for Equinox task.

2. This task checks whether printing the file with a CMYK color strategy would give a good
color accuracy.

Note:

Make sure the color strategies you use in all your Preflight Color for Equinox tasks:

• are Equinox color strategies,
• use (one of) your expanded gamut printing press(es)'s profile as output profile.

For information about generating color strategies outputting to several ink sets from an
expanded gamut printing press profile, see the Color Pilot documentation.

The task outputs an XML report detailing the color accuracy that can be achieved.

• If printing the file with CMYK would give good results, the report goes through the 
Pass output pin (the first green pin), and the workflow is finished.

• If CMYK doesn't give a good color accuracy, the report goes through the  Fail output
pin (the second green pin), and the workflow continues.

• If your file contains one or more unregistered inks (inks that do not exist in your color
database), it goes through one of the orange output pins (either  Pass Unregistered or

 Fail Unregistered depending on the Delta E values).

In this case, the workflow ends with a warning (regardless of the Delta E values, the file
isn't checked by any other Preflight Color for Equinox task).

Note:  You can also choose to include unregistered inks in the conversion check, and
not end the workflow with a warning straightaway. See Workflow Variant Supporting
Unregistered Inks on page 376).

• If the color strategy you have selected in your first Preflight Color for Equinox task
doesn't exist (if for example it was deleted before you ran the workflow) or is not an
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Equinox color strategy, the report goes through the red  Error output pin and the
workflow ends with an error.

3. If the first color strategy (CMYK) didn't give a good color accuracy, the XML report going
through the second output pin triggers the Select Marked File workflow control.

This is set to select the input PDF/Normalized PDF corresponding to that XML report (using
the File to Preflight tag and Only select when name matches: [File]).

See Mark File and Select Marked File on page 772 for more information.
4. That input PDF/Normalized PDF is then passed on to the next Preflight Color for Equinox

task, that checks whether printing the file with a CMYKO color strategy would give a good
color accuracy.

5. If this is not the case, the file is checked against a CMYKOV color strategy, then if necessary a
CMYKOGV one.

6. If none of the ink sets/color strategies gives a good color reproduction, the workflow ends in
a warning.

You can then check the different XML reports to help you make a decision about how to
print your file.

Depending on the case, you may want to use one or more additional spot colors, print the
file with one of the color strategies anyway, tweak the color strategy in Color Pilot, adjust
the file...

Workflow Variant Supporting Unregistered Inks
Depending on the way you work, you can choose to either have the workflow end in warning
if your input file contains unregistered inks (as described above), or calculate these inks'
conversion values as part of your color preflight.

To do this, you need to:

1. use Equinox color strategies set to convert unregistered inks (see the Color Pilot
documentation for more details),

2. amend your workflow so that  Pass Unregistered and  Fail Unregistered go to the
same places as  Pass and  Fail.

For example, for the first preflight task (Preflight for CMYK):

• instead of:

 

 

• if the task ends in  Pass, the
workflow ends successfully and the file
can be printed with CMYK

• if the task ends in  Fail, the input
file is picked up to be checked against
a bigger ink set by another Preflight
Color for Equinox task

• if the task ends in  Pass
Unregistered or  Fail Unregistered,
the workflow ends there, with a
warning state

• you would have:
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• if the task ends in  Pass or  Pass
Unregistered, the workflow ends
successfully and the file can be printed
with CMYK

• if the task ends in  Fail or  Fail
Unregistered, the input file is picked
up to be checked against a bigger ink
set by another Preflight Color for
Equinox task

Your workflow would then look like this:
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Note:

• If your color strategy doesn't convert unregistered inks, the preflight either passes or fails
depending on the conversion values of the registered inks only.

• If your color strategy converts unregistered inks, the preflight either passes or fails
depending on the conversion values of both registered and unregistered inks.

For example: you have an input file containing registered inks that can be accurately
reproduced with CMYK, and an unregistered ink that cannot. You are preflighting it against a
CMYK ink set.

When using a color strategy that doesn't convert unregistered inks, the preflight will succeed
(the report will go through  Pass Unregistered).

However, when using a color strategy that converts unregistered inks, the preflight will fail (the
report will go through  Fail Unregistered).

7.129.4.  Preflight Color for Cost Estimation

You can use the Preflight Color for Equinox task at your sales office, to help you quote a
competitive price to your customers without skimping on quality.

You can even connect it to your MIS system (for example CERM or Label Traxx), to get the print
job information automatically, then send the color preflight results back to the MIS.

When using this task for cost estimation, the main goal is to decide on the ink set needed to
print your job with a good color accuracy.

At that stage you don't need to worry about tweaking the print job to print on a
specific press so you can use a Color Strategy with a generic output profile (for example
ISOcoated_V2_eci.icc for the CMYK ink set).

Example Workflow
There are many ways you can set up a workflow that checks what ink set a file can be printed
with so you can quote a competitive price to your customers. For example, you can:

• Set up a cascading workflow that checks the file against each ink set, then check the
workflow's results to choose the ink set to use (this is similar to the production workflow, but
here you can use generic color strategies with the right ink sets, instead of color strategies
made for a specific expanded gamut printing press).

• Set up a workflow with one Preflight Color for Equinox task, where the color strategy and
Delta E tolerance are public parameters, and enter all the color strategies you want to check
as a semicolon-separated list (for example CMYK;CMYKO;CMYKOV;CMYKOGV). For each color
strategy you specify, your file will go through the task and you will get an XML report.

• Set up a workflow that integrates with your MIS system, so that you can automatically
launch the workflow on any file that comes into your MIS system for quotation, and get the
results back into your MIS system (this way you can do this from your sales office without
even needing to open the Automation Engine Pilot).

Workflow with MIS Integration
This example workflow is set up to:

• take a PDF file,
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• check it against a list of color strategies and a specific color tolerance (that are saved as
workflow parameters),

• join all XML reports into one and save it in a location that your MIS system monitors,
• end in OK for the color strategies that can be used to print within the color tolerance, and in

Warning for all other cases.

 

 

1. Preparation

The input file is paired with every color strategy that needs checking, and sent through the
workflow as many times as there are color strategies.

a. The input file is marked with the cp_InputFile tag so it can be picked up by the
workflow later on.

b. The Run Script task generates an XML file for each color strategy, containing the input
file name and color strategy name. Those XML files are marked as cp_tempfile.

c. The Data Splitter sends the XML files one by one to the rest of the workflow, where they
will each trigger a color strategy check.

2. Color Preflight

For each input file/color strategy pair, the Preflight Color for Equinox task checks the color
accuracy that can be achieved, and generates a detailed report.

For each XML file sent from the Data Splitter:

a. The Modify Workflow Parameter Values workflow control picks up the color strategy
name in the XML and saves it to the SelectedStrategy workflow parameter.

b. The Select Marked File workflow control picks up the input file and sends it to the
Preflight Color for Equinox task.

c. The Preflight Color for Equinox task checks whether converting the input file with the
current color strategy (from the SelectedStrategy workflow parameter) would give a
Delta E within the required Delta E tolerance (from the Tolerance workflow parameter).

It outputs an XML report detailing the color accuracy that can be achieved with that color
strategy, through the appropriate output pin.

d. If the file can be printed within the color tolerance using that color strategy, the State
workflow parameter is set to Pass. Otherwise it is not changed.

3. Reporting

The Data Collector collects all XML reports and sends them to the Join XML Files task, to
make a single big XML file for easy consumption by the MIS system. This file is saved in a
location that the MIS monitors.

4. Cleanup

The individual XML reports are marked as cp_tempfile and, together with the other
temporary files (the XML files produced by the Run Script task), they are deleted.
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5. Workflow End State

The Router directs each iteration of the input file to the right workflow end state based on
the State workflow parameter set by the Preflight Color for Equinox task.

• For color strategies that gave a Delta E within tolerance (the State is Pass), the file goes
to OK.

• For color strategies that didn't (the State still has an empty value), it goes to Warning.

The MIS system can then check the end state of the workflow and analyze the joined XML file
containing the color accuracy information for the input file checked with all color strategies.

Note:

Like all Automation Engine workflows, this workflow can be triggered by a JDF file dropped into
a "hot folder"/folder access point for example).

If the JDF contains information about the color strategies to check and the desired Delta E
tolerance, they will overrule those set in the workflow parameters.

At the end of the workflow, the MIS system will get a JDF back, containing processing
information and the location of the joined XML file.

7.130.  Preflight with PitStop

This task is documented in the chapter Quality Control tools. See Preflight with PitStop Task on
page 1045.

7.131.  Prepare for Inspection
This task takes a JDF Layout file and creates a JDF Inspection file that will be read by a (press)
inspection system. You can set specific measurement points in the design that the inspection
system will then monitor.

The task generates

• a JDF Layout file, now with extra information for the inspection system
• a TIFF preview of the to-be-printed material
• a TIFF preview of the shape of the resulting label after die cutting (the 'Cut Mask')
• a MIME file containing all output files.

Note:  The JDF Inspection file contains the layout of the sheet(s) and for each one-up PDF the
information about:

• the contour of the retained area (ClipPath)

• the location of the barcodes (IdentificationField)

• the location of the text areas (IdentificationField)

• the location and values of Spectrometer measurements (CIELabMeasurement)

Learn more in Settings on page 382.
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Example Workflow
 

 

• This example workflow starts by creating a PDFPLA step and repeat file.
• It then exports this file as a JDF Layout file. This creates a JDF file and a self-contained PDF

file for each one-up.
• The Prepare for Inspection task then uses this JDF layout to create the MIME file

containing the JDF file and the TIFF previews.

• The next task publishes this MIME file to a hotfolder to be picked up by the inspection
system.

Note:  Use the workflow control 'Router' to make sure that the correct files are used as
input file for the next step.

Example of Preview and Cut Mask
Example label (one-up):

 

 

Example preview: Note that the cut path is not visible in this preview:.
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Example Cut Mask:
 

 

7.131.1.  Settings

Document Tab
 

 

• Select what the task needs to create:
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• Create MIME pack: A self-contained set with all output files. When not selected, the
requested output files are created separately.

• Render Preview (TIFF): When not selected, a PDF preview is created.
• Render cut mask (TIFF): When not selected, a PDF preview of the cut mask is created.

• Preview Resolution: Define the resolution of the TIFF files.
• JDF Job ID: Use SmartNames to make this result in the job identification that the inspection

system should use to link the printed matter to this file.
• Inspection Parameters: Add extra parameters at will. For example the name of a profile

that will define the settings for the inspection system (for example "adhesive label").

Separations Tab
You can here define separations to be excluded, typically all the non-printable, technical inks
like “Die Cut”.

 

 

Note:  Using the Adobe Illustrator Plugin "Esko Data Exchange" " or the application Esko
PackEdge, you can include extra annotations inside the PDF file. These can serve to identify
areas with different inspection requirements, or could be locations for colour measurements,
including their expected LAB values and accepted tolerance. If such information is found inside
the PDF file, it is added to the output JDF file.

7.132.  Prepare for Viewer

This task is documented in the chapter Quality Control tools. See Prepare for Viewer Task on page
1005.
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7.133.  Prepare for WebCenter Viewer (OBGE)

This task type is by default hidden.

It is only used by a WebCenter OBGE when a WebCenter user uploads a document in
WebCenter.

It had different default behavior than the regular Prepare for Viewer task.

Only Esko staff can explicitly enable this task so that its task ticket becomes visible in
Automation Engine / OBGE.

7.134.  Prepare Graphics for Nesting
The Prepare Graphics for Nesting task is documented in the chapter Gang Run Printing for
Sign & Display on page 871. Find a direct link here.

7.135.  Prepare Station
This task prepares one ups for use in Step and Repeat editor or task.

Note:  Some of its features are also available in the more recent task Prepare Graphics for
Nesting.

 

 

• Create Station File:

Select this if you want the task to create a PDFSTA file instead of a Normalized PDF. See
down below how the sub-options are different when this is not selected.
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Attention:  PDFSTA files can only contain external references to Normalized PDF
files. So only select this option when the input file is also a Normalized PDF (or the
task will fail).

• Extract Die using Ink: When selected, the task creates a die line in the output file by
extracting all contours of the specified Ink. This die line will automatically be used in Esko
Plato or in tasks using Plato technology. When not selected, the trim box of the station
file will be used as die shape.

• Load CAD: Select this to place a CAD file into the station file (an ARD or a 1-up CFF2 file).

Note:  In case a layout CFF2 file is selected, the task will generate an error.

Note:  When you only need to load a CAD file into the PDF, consider using the Load
Structural File task instead.

Mapping: When loading a CFF2 CAD file, choose how the CFF2 line attributes should be
mapped to the ArtiosCAD line types. Select the appropriate CAD Style file to determine
in which separations the different CAD lines will appear.

Overview:

When loading a CAD file, the following sequence of operations takes place:

• The graphics file is placed in a station.
• When ‘Extract Die using Ink’ is selected, the die shape is extracted from the graphics.

If not, die shape is set to trim box.
• The CAD file is loaded and the outline of the CAD file is compared to the outline of

the die shape generated in the above mentioned step. The graphics is rotated in such
a way to create a maximal intersection of the CAD outline and the outline of the die
shape. Any rotation is mentioned in the task's log file.

Note:  In the Load Structural File task the CAD file is rotated and not the graphics.

• The CAD is taken as the die shape for the station.
• Limit Bleed: The bleed can be limited to a specific distance. The task create a bleed mask

by spreading the die shape.
• Graphics for Backside: Select this to load a graphics file that will become the backside of

the station file (also placed by external reference).

Note:  Keep the following in mind about positioning graphics on the back side:

• If the PDF contains objects in the ‘die ink’, the graphics for the back side are positioned so
that these objects are centered on the die of the front side.

• In the other case, the graphics on the back are positioned centered on the original
borders of the front side graphics (i.e. not fitted).

• SmartMarks: Select this to load a SmartMarks set. Note that this one set will be used for
both front and backside. Choose if you want to Add them to the current set or if they
should Replace it.

When not Creating a Station file, the task creates a normalized PDF and the options are
slightly different:
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• The input file is opened and changed as requested (so it is not placed externally).
• The only options available are now:

• Fit Borders to Ink: Borders can be fitted to objects in a specific ink

• Limit Bleed

• Placing SmartMarks.

7.136.  Print
This task serves to print the input file on a PostScript printer that was configured on the
Automation Engine server. Mind that in this case, this configuration is not part of an Esko tool,
but we mean the standard way to add printing devices on that Windows computer.

Attention:  These devices should be configured on the server using the System
Account of Automation Engine. By default this is the local user BGSYSTEM, but you
might have changed this (using the 'System Account' page in the Server Web tool). The
Print task will not be available for devices configured by other users.

The task's settings are very similar to those explained in the page on the Export to PostScript File
task.

7.137.  Print IMP File

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.
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7.138.  Print On Digital Press

This task is documented in the chapter Digital Printing Workflow  on page 1429. Find a direct
link here.

7.139.  Process PDF Spreads

Action

The ticket parameters depend on what type of Action you selected first.

• Split Reader Spread: To divide the reader spread pages in a multipage PDF into 'single'
pages (still in a multi-page PDF).

• Make Reader Spread: To change the 'single' pages in a multipage PDF into reader spread
pages.

• Make Printer Spread: To change the 'single' pages in a multipage PDF into reader spread
pages that can be used to create an imposition mock-up.

Settings for 'Split Reader Spread'

• Spread Position:

• Reference Box: Select a page box to choose how much of the page to include in, or
retrieve from a spread. For example select Crop Box to crop everything outside that box.

• Offset: Enter an exact offset distance from the above selected reference box. The offset
distance will extend beyond the box boundaries. This parameter is commonly used when
creating spreads of asymmetric files.

• Bleed Mode: Control the placement and size of bleeds. Choose from:

• Remove Bleed: Only the content of the reference box will be kept, any bleeds present
in the input file will be removed.

• Bleed from Bleed Box: The bleed will be the Bleed Box but only if the reference box
is the Trim Box.

• Bleed from Bleed Distance: This adds the specified bleed distance to the chosen
reference box. A bleed distance will extend beyond the borders of the Trim Box and
therefore will set the boundaries of the Media Box when output.

• Spread Structure:

• Flow Direction: Determine whether pages are arranged in numerical order from either
left to right or right to left. 'Left to Right' means that page one will be on the left hand
side of a two-page spread, with the second page on the right. 'Right to Left' means page
one will be on the right hand side of the spread, with page two on the left hand side.

• First Spread Contains: This controls how pages will be organized in the output file:

• Page 1 and 2
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To divide a spread into single pages. If you use this mode in conjunction with the
option Mixed Spreads (see below), you can split spread pages in a file while leaving
single pages intact.

Note:  Note: The reference page for this splitting action using 'Mixed Spreads' should
be a spread page, not one of the single pages.

• First page only

If you place the first page of the file on the right-hand side of the first spread page;
the left-hand side remains blank.

For files with an even number of pages, the last page will be also be placed on a
spread page, on the left-hand side, with an accompanying blank page.

The left / right positioning of pages on spreads is determined by the selection made in
the field Flow Direction. The description above assumes a left to right flow direction.

• Last and First page

In this mode, the last and first page of the input file are placed side by side on the first
spread page.

In a left to right flow direction setting, the last page will be on the left and the first
page on the right of the first spread page output.

In “Split Reader Spread” mode the task simply reverses the make mode. A file with
spread pages will have the spread pages split but the page on the left side of the first
spread will be output as the last single page of the output file.

• Even number of pages

Use this to prevent input files with an even number of pages from losing any pages
while being split.

The parameter produces different results depending on which of these spread types
it is combined with.

• Select 'Even Number of Pages' together with the spread type 'First Page Only'
to split the output file. The left side of the first spread and the right side of the last
spread will not be output.

• A combination of the Last and First Page spread type and the Even number of
Pages parameter will split a file successfully.

Note:  This option is active only when the Action 'Split Reader Spread' is selected and
with spread types 'First Page Only' and 'Last and First Page'.

• Mixed Spreads:

Use this option when you need to define the Reference page for input files that have
various paper sizes.

For example, if a file contains both an A4 page as page one and a two-page spread as page
two, enter page two as the reference page and indicate that this page has two pages on it.
All the spread pages are correctly detected and split correctly while leaving the single pages
intact.

• Auto Detect Spread Reference: To take the most frequently featured page size as the
Reference page.
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• Reference Page Number: To specify an exact page as the Reference Page. Use the
actual page number in the series of pages, not the page’s number label.

• Reference Page contains X One-Ups: Enter the number of single pages to be
positioned on the Reference Page.

Settings for 'Make Reader Spread'

Select this Action to, in a multipage PDF, create spread pages from single pages.

The options Spread Position and Spread Structure are the same as when you selected the
Action 'Split Reader Spread'.

Settings for 'Make Printer Spread'

Select this Action to create spread pages that can be used to make an imposition mock-up
from single pages.

The options Spread Position and Spread Structure are largely the same as when you selected
the Action 'Split Reader Spread'.

7.140.  Proof (FlexProof)
In the Device list, select the FlexRip - Proofer Output item that you added in the Configure tool.

7.140.1.  General

• Transformations

• Scale V / H: Enter a percentage to scale the design vertically and/or horizontally (the V-H
as you see the file in an editor or viewer).

• Rotate: Choose a rotation (counter clockwise).

• Select Fit On Paper to fit the design on the paper of the selected proofing Device.

•
: Choose if you want a positive or negative output file.

•
: Choose if you want mirroring or not.

• Original Size (incl. Margins): The ticket shows the original size of the input file, margins
included.

• Output Size (incl. Margins): The size shown here is the real output size, which is the
original size influenced by the scaling factors, distortions and the rotation.

• Marks: If you want you can add SmartMarks to your file. SmartMarks sets are created in
an Esko editor.

• Dot Gain Compensation:

389



7 Automation Engine

• Single Curve: Select a Dot Gain Compensation Curve (*.dgc).
• Automatic: Select a screen based Dot Gain Curve (*.scrdgc or *.icpro).

7.140.2.  Inks

• All inks: Deselect ‘All Inks’ to open the Inks list where you can select specific inks.

Attention:  In FlexProof tickets, when you want a composite (proofing) output, be
aware that de-selecting the 'All Inks' option will then output (proof) each selected ink
separately.

• In the column 'Merge Ink with', you can manually decide which inks should be merged
in the output file. This is common when you use different rulings of a same ink.

To do this, click in the column 'Merge Ink with' on the row of a specific ink and choose
the other ink from the list that pops up. Or click on the name of the column if you want
this change for all inks.

Alternatively, click 'Merge Similar Inks' to let the task propose such combinations
automatically for inks with a same name but with a different ruling or angle. Click Reset
Merge to reset these settings and force the proofing of each ink separately.

 

 
• Use technical inks in output. Select this to include the inks with Ink Type 'Technical'.
• Keep similar inks in their original separations. Select this when you are create separated

proofs and, instead of merging similar inks to one separation, you want each ink to print
separately. This should not be selected for a composite proof.

• Keep inks separated. Do not merge the inks (enabled when you choose 'Separate' as
Output Type (in the tab Output).

7.140.3.  Advanced

• Hold In Rip Queue: Select this to keep the task in the RIP-queue on hold until someone
manually releases it. Learn more in the page about the tool Queue Monitor.

• CT Resampling:

• Don’t resample: No re-sampling is done. This avoids most pixel shifts.
• Resample to highest CT resolution from job: Select this to fix the remaining pixel shift

problems, with the least up-scaling possible without data loss.
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• Resample to automatic chosen resolution: Select this to reduce broken dot problems,
by interpolating images to at least 1.000 ppi.

• Resample to output resolution: This is the slowest option, re-sampling all CT's to the
output resolution.

7.140.4.  Pre-RIP

This tab is only relevant when some objects in the file need to be simplified before they can
be sent to the RIP. The task takes this decision automatically. And even when this is done, the
options are best left to their default settings.

These are the special objects in a Normalized PDF that require such pre-processing:

• ‘Edge vignettes’: vignettes with alpha channels effects on the edge of the object.
• Barco Blends: blend objects in the legacy 'GRO' format.
• Warped CTs: warping done on external CTs.

Pre-RIP'ing creates an image (CT) of these special objects because the RIP can not interpret
them.

• Specify the CT Resolution for these new images.

• Custom: This default choice of 304.8 ppi guarantees the behavior of previous Esko
applications. This option is independent of the output resolution.

• Output: This creates the CTs at the same resolution as the RIP output resolution, with a
maximum of 1.000 ppi. This option provides an optimal RIP output, but may slow down
pre-RIP'ing and may require more disk space.

• Automatic: This create the CTs at a resolution as close as possible to 300 ppi, depending
on the RIP output resolution. The task calculates it in such a way that the RIP output
resolution is an integer multiple of this CT resolution.

• Anti-aliasing: Anti-aliasing smoothens the staircase effect that you get when an image is
created of lineart objects.

• Vignette Noise: Some vignettes or parts of vignettes will be converted to CTs. This happens
when they overlap other objects with translucency or overprint. To reduce the banding
effect, noise is applied on the CT, also known as 'grain'. The amount of noise can be
specified here.

• Blend to CT: Select this to convert legacy Barco Graphics blend objects into a CT.
• Smooth Blend: Select this to set the amount steps in the blend objects to 255. When

'Convert Blend Objects to CT' is activated and 'Smooth Blend' also, the generated CT will
ignore the original steps of the legacy (Barco Graphics) blend object. The amount of steps is
set at the maximum of 255.

• Resolve Transparency: Doing this as a pre-RIP stage can speed up the RIP'ing. Only select
this when needed.

• Convert Strokes: Select this if your output device requires you to do so.

7.140.5.  Output

• Configuration Set: Select a configuration file. These files represent specific behavior
of the selected output device. The list is filtered according the CMS license that the
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selected Dispatcher holds. For example: if it has a license for 4 channels, no multi-channel
configurations will be visible here.

• Output Folder: Leave this empty to use the output path as defined in the Dispatcher
('EskoLink queue' – 'Output' tab). If your EskoLink queue has no output path defined, you
can then define an output folder here.

• Output File: Leave this empty to get an output file name based on the input file. Edit this to
overrule this standard behavior. Only plain characters are allowed. Unsupported characters
(symbols) will be replaced by an _ .

• Output Type: Choose between

• Composite (Colored and Greyscale)
• Separate (Colored and Black & White)

• Colored: All inks are converted to CMYK values
• Greyscale: All inks are converted to grey values
• Black and White: If you want a Black & White proof.

• Anti-Aliasing: Anti-Aliasing smoothens the staircase effect you get in the generated CTs of
lineart objects that need pre-processing.

• Define the Number of Copies you need.
• Select 'Keep job files for relaunch purposes' to be able to proof files again without having

to RIP them again.

Note:  The files created for the proof (and the proof job on the Esko Proof Client) will then
have to be cleaned up manually.

• White Coloring

Attention:  You only see this option if one of your Configuration Sets connects to
an Epson Stylus Pro WT7900 proofer. See an example in this next page.

When you use an extra white ink to print on foil (transparent or metallic), this option allows
you to customize your white ink (for example, to get a cooler or warmer white).

Choose between:

• No Coloring: This uses the proofer's white ink to print objects in the white separation,
without applying coloring to this ink.

• Custom values: This allows you to color the proofer's white ink manually. Enter the
CMYK values to add to the white inks.

• Values from Color Management: This uses a Color Strategy to color the proofer's white
ink. This Color Strategy must have a white Extra Output Ink (called white) and map the
white separation used in the file to this white output ink.

Example: Color Managing White Ink for an Epson WT7900 Proof
For example, you want to print a file with an ink 'cool white' on your Epson Stylus Pro
WT7900 proofer.

1. In Color Engine Pilot’s Designer book:
a) Add your file’s white ink (here 'cool white'),
b) Add a generic white ink. Name it 'white'.
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2. Create a Color Strategy that will color manage your file’s white ink:
a) Add your generic white ink as an Extra Output Ink,

 

 
b) Map your file’s white ink (cool white) to your white output ink,

 

 
c) Make sure Extra Output Ink and Ink Mapping are selected in your Color Strategy.

 

 
3. In the Proof (FlexProof) ticket, go to the Output tab and:

a) select the Configuration Set corresponding to your Epson Stylus Pro WT7900 proofer,
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b) in White Coloring, select Values from Color Management.
4. In the ticket’s Color tab:

a) select Manage Color,
b) select Color Strategy,
c) choose the Color Strategy with white ink mapping you created in Color Engine Pilot.

7.140.6.  Color

If you do want to Manage Colors, then first select if this is for a Normal (simple) proof, or for
an Emulation proof.

For Normal Proof

• When you select to Manage Color for Normal Proof, the settings of the requested color
management are by default defined by the Color Strategy that you selected from the list.

When Color Strategy is not selected, the color management settings are entered with
profile settings.

• Then, Use the Document Profile as Source Profile if Available is set but as this document
profile may not be available, a backup of the source profile must still be chosen.

Choose the Process you want to simulate on the proof here. This process can be a
registered ICC profile or an Esko Profile.

There are some default Esko Profiles on the system, for example crom_offs (Cromalin
Offset). If you have measured an Esko Profile yourself, for example for your own Flexo
press, you will be able to select it here.

• Destination Profile

This is the profile for the proofer. Choose the proofer profile that describes the colors of
your proofer here (for example the characteristics of your proofer).

Both Esko Proofer profiles and ICC profiles of proofers are available in this list.

Also defaults are listed, for example ddcw_glossy, a description for a Digital Cromalin/
WaterProof on glossy paper.
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If you profiled your proofer using Color Engine Pilot, you will be able to select your proofer
profiles here as well.

Note:

The list of color strategies and destination profiles is filtered according to the CMS license
that the dispatcher holds.

If the Dispatcher has no CMS license, only “preview” and “linear” can be selected as color
strategies, whereas additional strategies are available with a 4-channel or multi-channel
license.

• Rendering intent

• Relative (no background): Choose this if you do not want any background simulation.
The white point of the source will be mapped on the white point of the destination
process. This rendering intent takes into account the ability of the human eye to adapt to
the surrounding white.

• Absolute (background): Choose this if you want background simulation and you want
an exact color match, including the paper simulation.

• Perceptual: This will result in no background simulation (white of reference color space
is mapped on white of destination color space). Choose this when you don't care too
much about an exact color match but when want the pictures at least to look nice on
your proofer. It will give a visually pleasing result. If the gamut of the source is wider than
the proofer, the entire gamut is shrunk so that it fits inside the gamut of the proofer.

• Saturation: Choose this if you care especially about saturated colors. This rendering
intent will map saturated colors on saturated colors.

• Black Mapping

This option is only available if you choose an Esko destination profile. Black will be mapped
onto black or, in other words, the black separation will only be printed with black ink.

In case you want to simulate a very dark black, which is darker than the black of your
proofer, you might want to deselect this option. In this case all 4 proofer inks will be used to
simulate the high density of the black.

• Handling Unregistered Inks

Unregistered inks are inks that are not present in your color management database. They
cannot be color managed which means that you cannot proof them accurately.

Therefore, we recommend you exclude them from the output, especially for contract
proofing.

Choose what to do in case some unregistered inks are still in the list of inks to be proofed:

• Deselect 'Generate an error if the job contains unregistered inks' if you want the task
to end with a warning. All the inks you chose to include in the output will be proofed, but
the unregistered inks will not be color accurate.

• Select 'Generate an error if the job contains unregistered inks' if you want the task to
end in error.

In both cases, you will also see a message in the log.
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Note:  When you select an Equinox source profile (or use a Color strategy with Equinox source
profile) with 'Manage color toggle selected, this task will perform a default check. This check
verifies if all the selected inks in the file are specified in the Equinox source profile. If they
are not specified, the task will end in error with a message such as: "Proofing aborted
because the following input inks are not found in the source profile:
glue cut"

For Emulation Proof

Attention:  You need an extra license to see this option.

 

 

In this mode, CMS options can be set twice:

• In the top section of the tab, you set the color management options for emulating the
conventional press on a digital press (conversion from the Source Profile to the Emulation
Profile).

• In the bottom section, you set the color management options for the output proofing device
(conversion from Emulation Profile to Destination Profile).

The preferred method is to use a Color Strategy for both conversions. Select the emulation
Color Strategy first, so that the list of color strategies for the output settings can be filtered to
have the same source profile as the emulation profile selected in the emulation step.

Alternatively, you can manually select the source profile, emulation profile and destination
profiles with their respective rendering intents.
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Tip:

If you select a multichannel printing profile in the Emulation Profile list (such as the seven-
channel IndiChrome Plus profile), you can use the button Output Inks... to enable or disable
the additional inks (for example, indiChr Orange, indiChr Green, and indiChr Violet).

This allows you to use a profile like IndiChrome Plus to generate output without one or more of
the additional inks (for example, without the IndiChrome Orange ink).

Handling Unregistered Inks

Unregistered inks are inks that are not present in your color management database. They
cannot be color managed which means that you cannot proof them accurately.

Therefore, we recommend you exclude them from the output, especially for contract proofing.

Choose what to do in case some unregistered inks are still in the list of inks to be proofed:

• Deselect 'Generate an error if the job contains unregistered inks' if you want the task to
end with a warning. All the inks you chose to include in the output will be proofed, but the
unregistered inks will not be color accurate.

• Select 'Generate an error if the job contains unregistered inks' if you want the task to
end in error.

In both cases, you will also see a message in the log.

Note:  When you select an Equinox source profile (or use a Color strategy with Equinox source
profile) with 'Manage color toggle selected, this task will perform a default check. This check
verifies if all the selected inks in the file are specified in the Equinox source profile. If they
are not specified, the task will end in error with a message such as: "Proofing aborted
because the following input inks are not found in the source profile:
glue cut"

7.140.7.  Verification

Note:  You can only set Verification options if you have chosen an Esko Proof Configuration
Set in the Output tab.

Print Verification Strip: To print a verification strip, select this option and fill in the options
that become available.

Strip Preset: A certain number of presets come with your color database. They contain
information about the strip and the measurement device to use, the tolerances in color
difference, etc.

You can select a preset here, that will fill in the options below, or you can select Custom and
fill the options in yourself. You can also start from a preset and change the other options (the
Strip Preset field will then show Custom).

Learn more about strip presets in the FlexProof/E documentation.

In Strip Type, choose between EskoStrip or Esko + Solid Color Strip. The 'Esko + Solid Color
Strips' contain the same patches as the 'EskoStrips', plus a 100% patch for every spot color
present in the job. When printing a color managed strip, you should use an 'Esko + Solid Color
Strip'.

Learn more about available strips in the FlexProof/E documentation.
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Apply Color Management to Strip: If you selected Manage Color in the Color tab, the Apply
Color Management to Strip option is available. Select it if you want to color manage the strip.

Verify strip (with Verification tool): This option is available if you have a Verification
license and if you are color managing your file. Choose what to use as a Reference for this
verification:

• Choose 'Manually load reference values' if you want to verify the color managed strip
against a standard (for example Ugra/Fogra) or a previous measurement.

You will need to load this standard manually in the Esko Verification tool.

• Choose 'Automatically load reference values from source profile' if you want to verify
the color managed strip against the source ICC profile (set in the Color Strategy used or
defined in the Color tab).

dE Formula: Choose the Delta E formula to use when verifying your strip. Choose dE CIE76,
dE CMC, dE 94 or dE 2000. If your company is already using one of those standards, we
recommend that you choose the same one. If not, you should choose the most recent one: 'dE
2000'.

Click Edit Tolerances... to set custom tolerances for the measurements. You can fill in:

• General dE Limits: The 'Delta E' values that the color patches and paper should not exceed.

• Primary color dE Limits: The maximum 'Delta E' values allowed for CMYK colors.

• Hue difference Tolerance Limits: The maximum 'Delta H' values for CMYK, CMYKRGB and
grayscale colors.

Note:  'Delta H' is the difference in hue between the expected color and the printed color.

• Tone Value Tolerance Limits

Note:  'Delta T' is the difference in colorimetric tone value between the colors.

• Chromaticness Tolerance Limits

Note:  'Delta F' is the difference in saturation (or "chroma") between the colors in your file
and the printed colors.

If you selected a Strip Preset, the tolerances may be automatically defined.

The verification will pass if the Delta E values are within the tolerances, or fail if they are bigger.

Strip Layout: Learn more in the Pack Proof documentation.

7.141.  Proof for Contract Approval

This task is part of the Pack Proof product. Learn more in the user guide of Pack Proof. .

7.142.  Proof for Content Approval

This task is explained in the chapter on Imaging Engine. Find a direct link here.
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7.143.  Proof IMP File (FlexProof)

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.144.  Proof to File - Unscreened

This task is documented in the chapter on Imaging Engine. Find a direct link here.

7.145.  Publish Imposition on WebCenter Chain

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.146.  Publish On WebCenter

This task is documented in the chapter Integrating with WebCenter. Find a direct link here.

7.147.  Relocate Job

This task is documented in the separate chapter on Jobs. Find a direct link here.

7.148.  Remove Job

This task is documented in the separate chapter on Jobs. Find a direct link here.

7.149.  Remove Product

This task is documented in the separate chapter on Products. Find a direct link here.
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7.150.  Resize Shape (Pre-release)

Concept

This task outputs a resized version of a Studio Toolkit .zae input file (an Archived Collada
format).

Note:

• The input file may only have one bag object.
• The bag object cannot be a Ponytail bag.

• The task will fail when the input file was made with a newer version of the software than the
one that this task uses.

Note:  Learn more about Studio on the Esko website.

Here's an example of a pillow bag as seen in Studio Toolkit:
 

 

Task Options

The ticket lets you specify new values for the dimensions of the bag, its seals and/or
dimensions of its package content.
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Not every option applies to every bag type. That is why you can first select the bag type of the
input file in Show parameters for:.

If you specify a value for an option that is not used for the type of bag in the input file, then this
value will be discarded.

The numeric input fields can be used for calculations, also when using SmartNames.

The output file is a Studio Toolkit Collada file with updated dimensions:

• In 3D, the model is resized, just as if you opened it in Toolkit, entered new dimensions and
saved it. However, the 3D orientation and height (distance to floor) are preserved.

Attention:  Any "Live Shaping" improvements in the input file are lost.

• In 2D, the technical drawing is also adjusted. The dimension lines are preserved and the
arrows preserved their relative position to the updated anchor points.

7.151.  Resize PDF for Output
This task allows to resize a PDF's pages or its contents before output to a proofer or RIP.

Output Page Size:

• Select 'Resize to a specific page size' to adjust the PDF markup for a given paper size.

• Deselect it if you only want to adjust the page contents (page boxes, etc.).

This option affects which parameters you see in Page Size and Page Content:

7.151.1.  Resizing to a Specific Page Size

When Resize to a specific page size is selected, you have these options:

1. In the Page Content area, select the Page Box to Use for positioning, scaling, etc.
2. Select how to Position this page box and its contents on the page:

• Don’t Fit: The file is placed “as is”.
• Center on Page: The file is centered in the selected page box.
• Scale to Fit (Reduce Only): The task scales the file down if necessary, so it fits in the

selected page box.
• Scale to Fit (Reduce & Enlarge): The task scales the file up or down if necessary, so it fits

in the selected page box.
• Scale to Fit (Disproportional): The task disproportionally scales the file up or down if

necessary, so that it fits in the selected page box.
• Use Proportional Tiling: The task tiles the file over several pages as necessary, but make

all tiles the same size.
• Gripper on Top: The task leaves space for the gripper at the top of the page.
• Gripper at the Bottom: The task leaves space for the gripper at the bottom of the page.

When selecting Use Proportional Tiling, you can enter the size of the Tile Overlap (where
two tiles are partly on top of each other).
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When selecting Gripper on Top / Bottom, enter the amount of space needed for the
gripper in Gripper Size.

3. Mirror page mirrors the page contents and the page boxes horizontally.
4. If you want, use the Scale parameter to scale the artwork before placing it on the page.
5. If you want, enter a Horizontal and/or a Vertical Distortion to apply to the artwork before

placing it on the page.

You can either enter the distorted output values (for example 97% or 103%), or the positive/
negative distortion values (for example -3% or +3%).

6. Select Clip on selected page box to clip away all artwork outside the page box that you
selected in Page Box to Use.

Note:  The artwork outside the selected page box is not deleted, just clipped away by a
clipping path (it is invisible but still present in the file).

7. Select Crop to fit if you want to crop your Page Box to the content of your original file.
 

 
8. In the Page Size area, select the page size you intend to print to in New Page Size.

This page size is used by the Scale and Position parameters.

• If you select a predefined page size, the option Orientation allows to select the
orientation of the paper that you intend to use. Choose either Portrait or Landscape.

• If you select Custom as a page size, you will see a Page Width and a Page Height fields
where you can enter the dimensions of the custom paper you intend to use.

9. Enter the Page Margins required by the output device.

The Page Margins value is used for the four sides of the page. These margins cannot be
used for exposing.

7.151.2.  Not Resizing to a Specific Page Size

If you don't select Resize to a specific page size, you can resize or reposition the PDF
contents:

1. In the Page Content area, select the Page Box to Use for positioning, scaling, etc.
2. Select Center content on page if you want to center the page contents on the page.
3. Select Mirror page if you want to mirror the page contents horizontally.
4. If you want, use the option Scale to define a scaling to apply to the artwork before placing it

on the page.
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5. If you want, enter a Horizontal and/or a Vertical Distortion to apply to the artwork before
placing it on the page.

You can either enter the distorted output values (for example 97% or 103%), or the positive/
negative distortion values (for example -3% or +3%).

6. In the Page Size area, use the option Set Orientation to alter the orientation of every page
without resizing it. Choose between Keep, Portrait or Landscape.

7. Use the options Rescale page boxes and Rescale page size to define what happens when
you scale the page contents:
a) Select Rescale page boxes to scale the page boxes together with the contents.

Deselect it to only scale the page contents and not the page boxes.
b) Select Rescale page size to scale the page size together with the contents.

Deselect it to only scale the page contents and not the page size.

7.152.  Resolve OPI
This task serves to replace the low-resolution images in a PDF with their high-resolution
versions that the PDF links to via OPI comments.

Repository tab

• Add the location(s) of the external folder(s) that contain(s) the OPI-files.

• If necessary, add the location(s) of the excluded folders. These folders will not be searched.

Note:  Use this option if all images can be found on the same volume and you want to
exclude all folders containing low-resolution files.

• Select 'Update OPI links only' to only update the links to the high-resolution images and to
not replace the links by embedding the high-resolution images.

Mapping tab

You can here specify a list of how file extensions should be mapped:

• Click Add and enter the original extension in the From field. If left blank, the extension in
the To field will be applied to all linked files.

• In the To field, enter the new extension to give the linked files, or a comma-separated list of
extensions to use as replacement for the original extension.

Note:  If you enter multiple extensions, the task searches for a file matching one of them.
Use the backslash ( \ ) to preserve a character (for example to use a comma as part of an
extension and not as a separator).

7.153.  Restore Job

This task is documented in the separate chapter on Jobs. Find a direct link here.
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7.154.  RIP IMP File to Screened and Unscreened Tiff File

Learn more in the dedicated document on "Commercial Print (Imposition) workflows in
Automation Engine". Find it next to the "Complete Manual" of version AE v18.1 on https://
www.esko.com/en/Support/Product?id=Automation%20Engine&ver=18.1.

7.155.  RIP to CDI LEN File
This task requests a FlexRip/C to create LEN files for a CDI.

First select the Device you added in the Configure tool (a FlexRip/C) .

This task has five tabs:

• General (see the same tab in the task 'RIP to Screened Tiff File')
• Inks (see the same tab in the task 'RIP to Screened Tiff File')
• Advanced (see the same tab in the task 'RIP to Screened Tiff File')
• Pre-RIP (see the same tab in the task 'RIP to Screened Tiff File')
• Output.

7.155.1.  Output

Note:  Parameters that have been specified in the Dispatcher Queue Settings are enforced in

this ticket. Some are preceded by an icon of a Dispatcher: .

 

 

• Configuration Set

• Name: Select a configuration file. These files contain specific behavior of the output
device.

• Plate Size: The plate size of the above selected configuration set is shown.
• Output File

• Path: Leave this empty to use the path as defined in the Dispatcher (EskoLink queue -
Output tab). If the EskoLink queue has no value for this path, you can define it here.
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• Name: Leave this empty to get output file names based on the input file. The default
output file name is [File]_[PageNrOfMultiPageFile]_[ShortInkName].
When changing this, be aware that only plain letters and numbers are allowed. Any
unsupported characters (symbols) will be replaced by an _ .

• Resolution of the output file:

• Perimeter: When a configuration set is chosen, this field is grayed out and shows
the CDI's 'perimeter' that was set in the device queue (in the Configure tool). When no
configuration is chosen, you can edit this field.

• Pixelclock: Choose the appropriate Pixelclock of your CDI. This field will most probably
be fixed as it does read what CDI type your device queue was based on (in the Configure
tool).

Note:  CDIs with ‘VariablePLL’ will not show the Pixelclock field nor the Perimeter field.

• Actual resolution: This field shows the actual resolution that will be used by the RIP.
This is the combination of the requested resolution and the effect of the perimeter on
that requested resolution.

Note:  The FlexRip rounds off any non-integer number (see the task's log file).

• Compression: Choose the compression method for the output files.

The LZW compression is most commonly used. CCIT group compressions are more
effective but take longer to generate (and to decompress on the receiving side).

7.156.  RIP to Screened and Unscreened DCS File
Select a Device that was configured in the Configure tool.

This task has five tabs:

• General (see the same tab in the task 'RIP to Screened Tiff File').

The ticket to RIP to an unscreened DCS file does not show the screening options.

• Inks.

• Advanced (see the same tab in the task 'RIP to Screened Tiff File').

• Pre-RIP (see the same tab in the task 'RIP to Screened Tiff File').

• Output.

Note:  Parameters that have been specified in the Dispatcher Queue Settings are enforced in

this ticket. Some are preceded by an icon of a Dispatcher: .

7.156.1.  Output

Note:  Parameters that have been specified in the Dispatcher Queue Settings are enforced in

this ticket. Some are preceded by an icon of a Dispatcher: .
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• Configuration Set

• Name: Select a configuration file. These files contain specific behavior of the output
device.

• Plate Size: The plate size of the above selected configuration set is shown.

• Output File

• Path: Leave this empty to use the path as defined in the Dispatcher (EskoLink queue -
Output tab). If the EskoLink queue has no value for this path, you can define it here.

• Name: Leave this empty to get output file names based on the input file. The default
output file name is [File]_[PageNrOfMultiPageFile]_[ShortInkName].
When changing this, be aware that only plain letters and numbers are allowed. Any
unsupported characters (symbols) will be replaced by an _ .

• Select a Resolution for the output files.

Single File DCS: When selected, all separations are first RIP'ed to separate files and then
included in a final single DCS file (in the end only one file is created). When not selected, a
DCS master file is created that refers to plate files, one for each separation.

• Compression: Choose the compression for the output TIFF files: Flate, LZW or CCITT Group.

The LZW compression is most commonly used. CCIT group compressions are more
effective but take longer to generate (and to decompress on the receiving side).

• Preview: Define the type and resolution of the preview files:

• For Placement Only: To use in a DTP application.

• Proofable Preview: For composite printing from a DTP application.

7.156.2.  Inks

• All inks: Deselect ‘All Inks’ to open the Inks list where you can select specific inks.

Attention:  In FlexProof tickets, when you want a composite (proofing) output, be
aware that de-selecting the 'All Inks' option will then output (proof) each selected ink
separately.
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• In the column 'Merge Ink with', you can manually decide which inks should be merged
in the output file. This is common when you use different rulings of a same ink.

To do this, click in the column 'Merge Ink with' on the row of a specific ink and choose
the other ink from the list that pops up. Or click on the name of the column if you want
this change for all inks.

Alternatively, click 'Merge Similar Inks' to let the task propose such combinations
automatically for inks with a same name but with a different ruling or angle. Click Reset
Merge to reset these settings and force the proofing of each ink separately.

 

 

• Use technical inks in output. Select this to include the inks with Ink Type 'Technical'.

• Keep similar inks in their original separations:

• Keep inks separated: When 'All inks' is selected, select this to avoid merged inks.

• Select 'Highlight modified values' to have all modified values highlighted and marked with
an asterisk.
 

 

7.157.  RIP to Screened and Unscreened PDF File
Select a Device that was configured in the Configure tool.

This task has five tabs:

• General (see the same tab in the task 'RIP to Screened Tiff File'). The ticket to RIP to
unscreened PDF does not show the screening options.

• Inks (see the same tab in the task 'RIP to Screened Tiff File')

• Advanced (see the same tab in the task 'RIP to Screened Tiff File')

• Pre-RIP (see the same tab in the task 'RIP to Screened Tiff File')

• Output.
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Note:  The fields in gray are the presets that are defined in the Dispatcher Queue settings.

7.157.1.  Output

Note:  Parameters that have been specified in the Dispatcher Queue Settings are enforced in

this ticket. Some are preceded by an icon of a Dispatcher: .

 

 

• Configuration Set

• Name: Select a configuration file. These files contain specific behavior of the output
device.

• Plate Size: The plate size of the above selected configuration set is shown.

• Output File

• Path: Leave this empty to use the path as defined in the Dispatcher (EskoLink queue -
Output tab). If the EskoLink queue has no value for this path, you can define it here.

• Name: Leave this empty to get output file names based on the input file. The default
output file name is [File]_[PageNrOfMultiPageFile]_[ShortInkName].
When changing this, be aware that only plain letters and numbers are allowed. Any
unsupported characters (symbols) will be replaced by an _ .

• Select a Resolution for the output files.

• Anti-Aliasing  (option appears when RIP'ing to unscreened files): Anti-Aliasing smoothens
the staircase effect you get in the image data generated from line-art objects that need pre-
processing.

• PDF Version: Choose a version:

• PDF for Illustrator: Select this version if the PDF 1.4 file will be opened in Adobe
Illustrator CS2 or higher. Because Adobe Illustrator only supports an undocumented
subset of PDF 1.4 features, some objects and/or color-spaces must be split up,
transformed and/or pre-RIP'ed in order to correctly represent them in Illustrator.

• PDF/X-1 a:2001 (ISO 15930-1)
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• PDF/X-3 - (ISO/DIS 15930-2)

• PDF 1.4 - Acrobat 5.0.

• Single / Multi File

When selecting 'single file' output, all separations are first RIP'ed to separate files first and
then included in the final PDF / PS file. When this option is not selected, the task creates a
Master file and also plate files that it refers to (one per separation).

• Softproofing

When selected, the task writes a composite PDF file that combines the different separations
in a single PDF page. This PDF file can be used for colored viewing in Acrobat.

The combination of 'Single file' with 'Softproofing', can lead to four situations:

• No soft-proofing, multi file: All separations are written in a different page, and all pages
are written in a separate output file.

• No soft-proofing, single file: All separations are written in a different page, and all pages
are combined in a single file.

• Soft-proofing, multi file: Separations are kept together per page, and all pages are
written in a separate output file.

• Soft-proofing, single file: Separations are kept together per page, and all pages are
combined in a single file.

• Compression: Choose a compression method.

• Encoding

• Binary: The image data is represented as binary data. This results in compact files. Such
files are not editable in a common ASCII editor. Nor can these files be transferred using a
communication protocol that relies on control characters in the data stream itself.

• Hex: This forces the output to remain editable with an ASCII editor. It can then also can
be transferred using whatever communication protocol is available. The drawback is that
hexadecimal image data can take up to twice as much size as binary data.

• ASCII 85: Encodes binary data in an ASCII base-85 representation. This encoding uses
nearly all of the printable ASCII characters. The resulting expansion factor is 4:5, making
this encoding more efficient than hexadecimal.

7.158.  RIP to Screened and Unscreened PostScript File
Select a Device that was configured in the Configure tool.

This task has five tabs

• General (see the same tab in the task 'RIP to Screened Tiff File'). The ticket for unscreened
output does not show any screening options.

• Inks (see the same tab in the task 'RIP to Screened Tiff File')

• Advanced (see the same tab in the task 'RIP to Screened Tiff File')

• Pre-RIP (see the same tab in the task 'RIP to Screened Tiff File')

• Output.
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7.158.1.  Output

Note:  Parameters that have been specified in the Dispatcher Queue Settings are enforced in

this ticket. Some are preceded by an icon of a Dispatcher: .

 

 

• Configuration Set

• Name: Select a configuration file. These files contain specific behavior of the output
device.

• Plate Size: The plate size of the above selected configuration set is shown.
• Output File

• Path: Leave this empty to use the path as defined in the Dispatcher (EskoLink queue -
Output tab). If the EskoLink queue has no value for this path, you can define it here.

• Name: Leave this empty to get output file names based on the input file. The default
output file name is [File]_[PageNrOfMultiPageFile]_[ShortInkName].
When changing this, be aware that only plain letters and numbers are allowed. Any
unsupported characters (symbols) will be replaced by an _ .

• Select a Resolution for the output files.
• Anti-Aliasing  (option appears when RIP'ing to unscreened files): Anti-Aliasing smoothens

the staircase effect you get in the image data generated from line-art objects that need pre-
processing.

• Single / Multi File

When selecting 'single file' output, all separations are first RIP'ed to separate files first and
then included in the final PDF / PS file. When this option is not selected, the task creates a
Master file and also plate files that it refers to (one per separation).

• Compression: Choose a compression method.
• Encoding

• Binary: The image data is represented as binary data. This results in compact files. Such
files are not editable in a common ASCII editor. Nor can these files be transferred using a
communication protocol that relies on control characters in the data stream itself.

• Hex: This forces the output to remain editable with an ASCII editor. It can then also can
be transferred using whatever communication protocol is available. The drawback is that
hexadecimal image data can take up to twice as much size as binary data.
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• ASCII 85: Encodes binary data in an ASCII base-85 representation. This encoding uses
nearly all of the printable ASCII characters. The resulting expansion factor is 4:5, making
this encoding more efficient than hexadecimal.

7.159.  RIP to Screened and Unscreened Tiff File
Select a Device that was configured in the Configure tool.

Note:  Options that are grayed out are values that were already defined in the Dispatcher
queue settings.

7.159.1.  General

 

 

• Transformations

• Scale V / H: Enter a percentage to scale the design vertically and/or horizontally (the V-H
orientation is the one that you see when the file is opened in an editor or viewer).

• Rotate: Choose a rotation (counterclockwise).

• Shrink: Use values from file: When the input file is a Plato file that has shrink values
defined inside the PDFPLA file, it will show these values here. Deselect this option to edit
and overrule those values.

Attention:  If you use both scaling and shrink (distortion) options, then both
these scaling values will be executed! For example: If your ticket requests a shrink
V 98% but also a Scale V 95%, then the output-size for V will be 98% of 95% (which
is 93.1 %). So the file is first scaled and then distorted.

•
: Choose if you want a positive or negative output file.
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•
: Choose if you want mirroring or not.

• Original Size (incl. Margins): The ticket shows the original size of the input file, margins
included.

• Output Size (incl. Margins): The size shown here is the real output size, which is the
original size influenced by the scaling factors, distortions and the rotation.

• Marks: If you want you can add SmartMarks to your file. SmartMarks sets are created in
an Esko editor.

• Screening (in tickets for screened output):

• Type: Choose the type of screening.
• Dotshape: Choose a dot shape. When dot shapes were defined in your input file, you

can use those by choosing 'JOB # (Dotshape(s) as defined in File)'. This option will
display in orange when the input file does not have any predefined dots (in its ink menu).

Attention:  When a dot shape is displayed in orange, you can select it but the
RIP's default dot shape will be used instead.

• Dot Gain Compensation

• Single Curve: Select a Dot Gain Compensation Curve (*.dgc).
• Automatic: Select a screen based Dot Gain Curve (*.scrdgc or *.icpro).
• Platemaking DGC: This displays the platemaking DGC (if any) defined in the FlexRip

Configurator tool.

Tip:  The compensations are also applied to the SmartMarks. To prevent this, consider using
specific inks or rulings for the inks used in your SmartMark objects.

7.159.2.  Inks

 

 

• Inks on separate TIFF files: This option only appears when you're outputting to a merging
device (as defined in the Configure tool). Select it to make sure that different inks end up on
different films.

412



7Automation Engine

• All inks: Deselect ‘All Inks’ to open the Inks list where you can select specific inks.

Attention:  In FlexProof tickets, when you want a composite (proofing) output, be
aware that de-selecting the 'All Inks' option will then output (proof) each selected ink
separately.

• In the column 'Merge Ink with', you can manually decide which inks should be merged
in the output file. This is common when you use different rulings of a same ink.

To do this, click in the column 'Merge Ink with' on the row of a specific ink and choose
the other ink from the list that pops up. Or click on the name of the column if you want
this change for all inks.

Alternatively, click 'Merge Similar Inks' to let the task propose such combinations
automatically for inks with a same name but with a different ruling or angle. Click Reset
Merge to reset these settings and force the proofing of each ink separately.

 

 
• Use technical inks in output. Select this to include the inks with Ink Type 'Technical'.
• Keep similar inks in their original separations
• Keep inks separated: When 'All inks' is selected, select this to avoid merged inks.
• Select 'Highlight modified values' to have all modified values highlighted and marked with

an asterisk.
 

 

7.159.3.  Advanced
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• Hold In RIP Queue: Select this to hold the task in the RIP-queue until someone manually
releases this task.

• Yellow Ruling:

• Don't change Y ruling: The ruling of the yellow ink is not adapted.
• Change Y ruling: Choose from: -15%, -7%, 0% (no change), + 7% and +15%.
• Change Y ruling stochastic: Same as above but the dot shapes are also adapted to the

Monet dot.
• CT Resampling:

• Don’t resample: No re-sampling is done. This avoids most pixel shifts.
• Resample to highest CT resolution from job: Select this to fix the remaining pixel shift

problems, with the least up-scaling possible without data loss.
• Resample to automatic chosen resolution: Select this to reduce broken dot problems,

by interpolating images to at least 1.000 ppi.
• Resample to output resolution: This is the slowest option, re-sampling all CT's to the

output resolution.

7.159.4.  Merge Queue

 

 

This tab appears when the configuration of the selected Device has the "Merge' function on
'Yes' (see its setting in the Configure tool).

Note:  'Merging' here means making an optimized layout of separations next to each other.

• Merge with other jobs: Select this to merge the separations that this ticket creates with
separations from other files that were also RIP'ed for this FlexRip device.

• Hold in Merge Queue: This will ‘hold’ the separations in the merger database. This means
they are ‘not to be considered for merging’. Use the tool "Merger Monitor" to see this
database and to manually release entries that were put on hold.

• Force after: Separations that were put on hold can automatically be released again after a
chosen time. This prevents having to wait too long before the ‘Minimum Fill %’ has been
reached. Learn more in FlexRip - Screened Output on page 186.

• Priority: Define the priority that entries will have in the merger database. Entries with a
high priority will be chosen sooner for merging with other entries.

• Restriction: The separations will only merge with other separations of files that have
received the same restriction value from this field. This value can be anything, whatever
makes sense for your workflow. Some examples:
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• fruit: The word 'fruit' could be used to make sure that these separations will only be
merged with other separations that were also sent with that word 'fruit'. The goal could
be that you wish to merge the separations of the 'banana', 'cherry' and 'apple' jobs all on
the same film.

• Bob. The word 'Bob' could be operator Bob's restriction to only get films with separations
of 'his own jobs'.

7.159.5.  Pre-RIP

 

 

This tab is only relevant when some objects in the file need to be simplified before they can
be sent to the RIP. The task takes this decision automatically. And even when this is done, the
options are best left to their default settings.

These are the special objects in a Normalized PDF that require such pre-processing:

• ‘Edge vignettes’: vignettes with alpha channels effects on the edge of the object.
• Barco Blends: blend objects in the legacy 'GRO' format.
• Warped CTs: warping done on external CTs.

Pre-RIP'ing creates an image (CT) of these special objects because the RIP can not interpret
them.

• Specify the CT Resolution for these new images.

• Custom: This default choice of 304.8 ppi guarantees the behavior of previous Esko
applications. This option is independent of the output resolution.

• Output: This creates the CTs at the same resolution as the RIP output resolution, with a
maximum of 1.000 ppi. This option provides an optimal RIP output, but may slow down
pre-RIP'ing and may require more disk space.

• Automatic: This create the CTs at a resolution as close as possible to 300 ppi, depending
on the RIP output resolution. The task calculates it in such a way that the RIP output
resolution is an integer multiple of this CT resolution.

• Anti-aliasing: Anti-aliasing smoothens the staircase effect that you get when an image is
created of lineart objects.

• Vignette Noise: Some vignettes or parts of vignettes will be converted to CTs. This happens
when they overlap other objects with translucency or overprint. To reduce the banding
effect, noise is applied on the CT, also known as 'grain'. The amount of noise can be
specified here.

• Blend to CT: Select this to convert legacy Barco Graphics blend objects into a CT.
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• Smooth Blend: Select this to set the amount steps in the blend objects to 255. When
'Convert Blend Objects to CT' is activated and 'Smooth Blend' also, the generated CT will
ignore the original steps of the legacy (Barco Graphics) blend object. The amount of steps is
set at the maximum of 255.

• Resolve Transparency: Doing this as a pre-RIP stage can speed up the RIP'ing. Only select
this when needed.

• Convert Strokes: Select this if your output device requires you to do so.

7.159.6.  Output

Note:  Parameters that have been specified in the Dispatcher Queue Settings are enforced in

this ticket. Some are preceded by an icon of a Dispatcher: .

 

 

• Configuration Set

• Name: Select a configuration file. These files contain specific behavior of the output
device.

• Plate Size: The plate size of the above selected configuration set is shown.
• Output File

• Path: Leave this empty to use the path as defined in the Dispatcher (EskoLink queue -
Output tab). If the EskoLink queue has no value for this path, you can define it here.

• Name: Leave this empty to get output file names based on the input file. The default
output file name is [File]_[PageNrOfMultiPageFile]_[ShortInkName].
When changing this, be aware that only plain letters and numbers are allowed. Any
unsupported characters (symbols) will be replaced by an _ .

• Select a Resolution for the output files.
• Compression : Choose the compression for the output TIFF file. Which compression to use

depends on the device you are creating the TIFF files for.

The LZW compression is most commonly used. CCIT group compressions are more
effective but take longer to generate (and to decompress on the receiving side).

7.160.  Route Approval Cycle

This task is documented in the chapter Integrating with Share & Approve on page 1547.
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Find a direct link here.

7.161.  Router

This Workflow Control is documented in the chapter "Workflows". Learn more in Router on page
767.

7.162.  Run ArtiosCAD Standard

What?

This task creates an ArtiosCAD ARD design based on an existing standard.

The task requires parameters as board information, units, grain direction, print side and
dimensions.

More Info

This task is set up by an Esko Solution Architect. Learn about Esko Solution Services on https://
www.esko.com/support/solution-services.

For more information, search for online articles on this topic in the Esko Knowledge Base.

7.163.  Run Script

This task is documented in the chapter Using Scripts on page 1697. See The Run Script Task on
page 1701.

7.164.  Select File

This Workflow Control is documented in the chapter "Workflows". Learn more in Select File on
page 756.

7.165.  Select Mark File

This Workflow Control is documented in the chapter Workflows. See Mark File and Select Marked
File on page 772.
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7.166.  Select Job

The Select Job workflow control is documented in the chapter Workflows on page 687. Find a
direct link here.

7.167.  Select Product

The Select Product workflow control is documented in the chapter Workflows on page 687.
Find a direct link here.

7.168.  Select Referenced File

This Workflow Control is documented in the chapter "Workflows". See Select Referenced File on
page 760.

7.169.  Send E-mail
This task uses your E-mail server to send E-mails.

Your mail server must first be correctly configured in the E-mail item in the Configure tool.

The E-mail can contain:

• Custom text, typed in this ticket
• Any information that Automation Engine has, by using SmartNames,
• The task's input files.

1. Enter the E-mail address(es) you want the E-mail to be sent To.
When you work in a Job context that has customer information filled in, check if you
can here use any of the customer E-mail addresses as a SmartName (category Job
Information).
You can also use SmartNames to add the E-mail address of the Task Owner (category Task
information). Learn more about SmartNames in this chapter.

Note:

• Multiple addresses in one field need to be separated by a semicolon " ; ".

• When you here use SmartNames, make sure they resolve to a valid E-mail address.

2. If you want, add extra E-mail address(es) in the Cc field (copy).
3. If you want, add extra E-mail address(es) in Bcc (blind copy). The recipients' E-mail address

will not be displayed to the receiver.
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4. Enter an E-mail Subject.
There are many SmartNames that can summarize the context of this message. An example:
Please check the attached file for job " [Job Name] ". Please mind its
due date: [Job Due Date] - [Job Due Time] .

5. If you want, you can change the sender of the E-mail in From. By default the E-mail address
of the Task Owner will be used.

Attention:  This field requires a valid E-mail address, not just a name, alias or user
name.

Note:  This ability to send E-mails on behalf of the task owner (or whoever you here filled
in) is subject to the configuration on your mail server. When in doubt, please consult your IT
administrator.

6. Enter your Message.
Combine custom text with SmartNames to add a lot of variable information.

7. About text encoding: By default, this task uses the system's local encoding. If you notice
unreadable characters when reading an Automation Engine E-mail in your E-mail program
(for example Asian characters), you best change the encoding to UTF-8.

This table shows how to enforce specific encodings:

Add this to the Message field: to...

#set ($SubjectCharSet="utf-8") set the encoding of the Subject to UTF-8.

#set ($ContentType="text/
plain;charset=utf-8")

set the encoding of the Message to UTF-8
and use plain text.

#set ($ContentType="text/
html;charset=utf-8")

set the encoding of the Message to UTF-8
and use HTML.

#set ($AttachmentsCharSet="utf-8") set the encoding of the file name of the
attachments to UTF-8.

8. If you want to include the task input files, select Attach input files.
Mind the size limits that your mail server has on attachments.

9. Select Ignore unresolved smart addressees if you want the task to continue when an E-
mail address is set via a SmartName that cannot be resolved.
Some examples of when this can happen: when a Job Parameter does not exist for this job,
when the SmartName has been deleted or when a Workflow Parameter does not exist in
this workflow.

10.In the ticket's menu item 'Advanced', you can set public parameters if you want users to
be able to fill in E-mail settings when they submit files from Shuttle.
Learn more in Using Public Parameters in Workflows on page 783.

11.Save your ticket. When you used many SmartNames, it will be valid for many situations and
workflows.

Attention:  Self-closing tags are not supported. For example <br/> or <address/
>. When setting up HTML E-mails, you have to use a separate opening tag and closing
tag (example <address> </address>), or the empty variant (example: <br>).
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7.170.  Send PostScript File to Device
This task sends a PostScript file to a PostScript device that was configured on the computer of
the Automation Engine server.

Use the drop-down list to select the PostScript device you want to output to.

7.171.  Set Priority

This Workflow Control is documented in the chapter "Workflows". See Set Priority on page
763.

7.172.  Share Job

This task is documented in the chapter Integrating with Esko Cloud. Find a direct link here.

7.173.  Sort

This Workflow Control is documented in the chapter "Workflows". See Sort on page 764.

7.174.  Split PDF File
This task splits multi page PDFs into single page PDFs or PDFs with a specific range of pages.
The task also generates a RunList that contains references to all output PDFs.
 

 

• Output in: Select where you want to output the generated PDFs and the RunList.

• File Name: Enter the name of the generated RunList. By default, this is [File].jdf.

• Split Mode: Choose how you want to split the pages of the input file.

• Split Pages: This mode splits the PDF into individual single page files.
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• Split In Groups: This mode splits the PDF into several files having the same number of
pages. Enter this number in the field Group Size.

Note:  If the task cannot output files having the same number of pages, the last output
file will have less pages. For example if you ask a PDF with 10 pages to split into files of 4
pages, the task will create 2 PDFs with 4 pages and 1 PDF with only 2 pages.

• Extract Pages: This mode extracts only the pages that you specify in the field Page
Ranges. You can specify either single page numbers or page ranges with a hyphen, for
example 1-3 to extract pages 1 to 3. You can add multiple numbers and ranges when
you separate them by a comma, for 1-3,7,14-22.

• Output as one multi page document: Select this if you want to output all of the
page ranges as one document.

• Output remaining pages: Select this if you also want to output the pages that you
did not include in the field Page Ranges as one multi page PDF.

• Remaining Pages File Name: This is where you define the name of those remaining
pages.

• Pages File name: Define the name of the output files here. You can use some SmartNames
that are specific for this field: [Page Label] and [Page Number]. By default the
SmartName [Padded Page Number] is proposed.

Note:  Padded page numbers help sorting files in alphabetical order. For example: a
standard page number is 1 as in mango_1.pdf. Asking a padded page number results in
mango_01.pdf. And when there are more than 99 pages, the padded page number result
will be mango_001.pdf.

• Copy XMP data: Enable this option to copy the XMP data of the input file into the output
files.

7.175.  Split XML

This task is documented in the chapter Integrating with External Systems. Find a direct link here.

7.176.  Start Approval Cycle on Share & Approve

This task is documented in the chapter Integrating with Share & Approve on page 1547.

Find a direct link here.

7.177.  Step & Repeat CAD based
This uses a CAD layout file as input file and places graphic files on the different designs in that
CAD layout.
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This task supports MFG files (Artios Manufacturing files) and CFF2 files.

7.177.1.  Tab 'General'

 

 

• Output Format

• PDFPLA: In this format, the placed stations are referenced files, they are not embedded
into the layout file. This keeps the layout file small but limits its use to applications that
support such external references: Esko editors, Esko RIPs or any next workflows steps in
Automation Engine that make use of this smart referencing.

Attention:  If the input file of this task was a native PDF, this output mode
will make the task end in error because a "PDFPLA can only contain
references to normalized PDF".

• Normalized PDF (embed all): In this format, because all data is embedded, the PDF can
be used to exchange this layout file to remote sites that also use tools that read this Esko
Normalized data. For example: off-site printers that also use an Esko RIP.

This file format is larger in Mb, however it is important to know that the technique
of "PDF forms" is used: each station is only embedded once into the output file. For
example if it contains 5 banana labels and 5 lemon labels, the size of the PDF will only be
slightly larger than the size of 1 banana PDF plus 1 lemon PDF file.

• PDF: This native PDF will have all data embedded and will also use "PDF forms" to
optimize its size (as explained here above). Choose this output type PDF when you need
to send this data to a non-Esko environment or device.
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Attention:  This output is only advised when the task input file is one or more
native PDF(s). The advantage is then that there is no 'on the fly' normalization
done on these native PDF stations ; they are untouched and are only placed into
the native layout PDF.

This PDF has in its XMP also a description of the contents of its grids, their station names
and amounts. Any distortion factor (here named "Shrink") will be calculated/executed in
the PDF.

Note:  Choosing this output type disables the options 'Screen Registration' and
'Include CAD info for Digital Flexo Suite'.

• Choose the matching icon for the origin of the plate.

• Select 'Limit Bleed' to limit any bleed to a specific distance. The bleed mask is created by
spreading the die shape.

Note:  Learn more about what happens when bleed from panels overlaps in Bleed and
overlap on page 261 and in Bleed Overlap Priority Decided by ArtiosCAD Artwork Panels on
page 262.

• Add SmartMarks by selecting a SmartMark set from the drop-down list. Or use a
SmartName to select it.

Select 'Load Mark Set in bottom layer' if you want to make sure the marks are positioned
in the bottom layer, to make them appear 'behind' the graphics.

• Screen Registration: When selected, the origin of the screening will be reset for each
station on the layout. This guarantees that the exact same screening will be applied for each
station. This is for example required when printing stamps. When not selected, screening
will be done continuously throughout the complete layout.

Attention:  This option defines an attribute in the PDF that is only supported by
Imaging Engine or FlexRip. It is ignored by any other RIP..

Attention:  Screen registration is not available when you choose the output format
PDF.

• Graphics Folder. Define the folder where the task can find the graphic files that should be
repeated (a.k.a. 'stations').

• When CAD data of station and substituted file do not match, set task status to:

• Provide info

• Generate a warning (the task will continue).

• Generate an error (the task will stop). The task will not create an output file.

7.177.2.  Tab 'CAD Options'
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Both Mapping and CAD Style are options you can define in the Esko Editors.

• Mapping: When the CAD file is a CFF2 or DXF file, you here select the set of mapping rules.
These rules map line styles (cut, crease, bleed), layer names and color numbers onto
ArtiosCAD line types. These sets of mapping rules can be created in Esko PackEdge or Plato.
Learn more in their user documentation, more specifically in their section on placing files
(PackEdge) or on importing CAD data (Plato).

• The CAD Style changes the appearance of the (imported) ArtiosCAD type lines.

Note:  This CAD Style is only applied on lines from the design (ARD) that was stepped in the
layout file (MFG). Lines manually drawn next to the placed designs (the so called "objects at
layout level") will always be ignored by the task.

The styles you can select here were also created in PackEdge or Plato. Learn more in their
user documentation, more specifically in the section on placing ArtiosCAD files, and the
option for "CAD Style".

• Include CAD info for Digital Flexo Suite:

If you are using the Esko Digital Flexo Suite (DFS), select this option to add the technical inks
data into the header of the output file (this is usually the cut and crease lines). This data is
then visible in the Esko Bitmap Viewer and also embedded in the LEN files created by an
Esko RIP.

The DFS can export this information into ACM files for an Esko Kongsberg cutting table. In
Esko PlatePatcher workflows, this information can be used to print onto the plastic sheet
where the pieces of flexo plate are re-assembled. These technical lines can also represent
text that is then added onto the (back of the) flexo plates, using a pen on the Kongsberg
table.

Attention:  This option is disabled when you choose the output format (native) PDF.

7.177.3.  Tab 'Sheet'

The sheet is the substrate that this layout will be printed on.

Sheet Size
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• Set custom sheet size: Select this when you do not want to use the size that is defined in
the CAD file. Then enter its size below.

7.177.4.  Tab 'Plate'

The sheet size is automatically extracted from the CAD template but neither Artios MFG nor
CFF2 files have a notion of 'plate'. As a result, the plate size and the position of the sheet on the
plate have to be specified in this Plate tab.

 

 

• Plate Size : Select Set custom plate size when the plate size needs to be different than the
sheet size. Then enter your custom plate size below (and possibly also the sheet position
and offset).

• If you want, enter horizontal and/or vertical Shrink values (in percentage) to compensate
for printing distortion (especially in Flexo).

The default value is 100, both horizontally and vertically, which means no distortion
compensation. Learn more about when and how they are applied in the topic 'shrink' on this
page.

• Define the Sheet Position by clicking or dragging the sheet (inner rectangle) to its position
versus the plate (outer rectangle).

• Offset: When enabled, add a H and/or V offset of the sheet versus the plate.

7.178.  Step & Repeat CAD based (Dynamic)
This task creates a final sheet layout containing a number of copies of 1 or more designs. For
example: a layout with 10 copies of a small box and 5 copies of a large box.

Note:  This task aims to replace the tasks 'Create Sheet Layout' and 'Step and Repeat CAD
based'.
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This task accepts various input file types. It outputs PDF+ file(s).

Note:  This task uses Esko's NDL (PDF+) based graphic kernel.

Input and Output File Types

Input file types

The task allows different types of input files. The task accepts multiple input files.

• PDF(+)
• Normalized PDF

• without CAD object info
• including CAD object info. This CAD object could have been added in Adobe Illustrator,

ArtPro, ArtPro+, PackEdge or by the task 'Load Structural File'.

• XML

Note:

• When the input file or all the input files are 2-sides PDF then duplex is performed
automatically. Mixing 1-side and 2-side documents is not supported.

• PDFSTA files are not supported.
• VDP jobs are not supported.

Output file type

• PDF+ file(s)

General Behavior

• Input file(s)

• When the input file(s) are PDF, the task uses the default XML values to create a station
(see below page on XML input).
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Note:  When the input file is a normalized PDF, then:

• Technical Inks become opaque inks.
• Protected objects, such as unsupported barcodes, DeskPack Dynamic Marks (DMK)

and SmartText objects are converted to linework.
• Supported barcodes are regenerated. When a barcode has live text in a font that is

not available on the system, OCR-B will be used.
• The default Color Profile is added as Document Profile. An existing profile is kept

when it is a supported format.
• All Normalized PDF XMP data is removed.
• When a linked normalized PDF is placed in the file, the linked file will be embedded.
• When a linked non-normalized PDF file is placed in the file, the linked PDF is kept as

linked placed art.
• When a supported structural design file is linked in the file (ARD, CF2), the link to the

structural design file is kept.
• When a missing or unsupported structural design file is linked in the document

(ZAE, DAE, BAG, DXF, DDES, VLM, …), the structural design object will be converted to
linework.

• When the normalized PDF contains links to unsupported images (EPS, DCS, …), the
conversion will fail.

• When the input file(s) are XML, the task supports multiple ways to define the stations.
Learn more in below page on XML input.

• CAD Layout

• Stations: ARD and CF2 file formats are supported as structural design files for the
stations. DXF is not supported.

Note:  Structural information in Stations is not mandatory but their names and
bounding boxes can help to attach a station to its place in layout.

• Layout: This task gets its CAD layout structure from MFG templates (the native format of
ArtiosCAD) or from CF2 layout templates or from PDF+ layouts created in ArtPro+.

• Output file

• The PDF+ file contains 2 layers: the CAD layer and a layer containing the placed stations.
• When Dynamic Marks from ArtPro+ are used an extra layer 'Dynamic Marks' is created,

containing static objects.
• The output file has a trim box (the sheet) and a media box (the plate).
• It contains these inks:

• all the inks of the input files
• all the inks created during import of the CAD layout template
• all inks that might be added by Dynamic Marks.

7.178.1.  Tab 'General'
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• Use the Backing Up option when working with a front and back. You can choose to Work-
and-Turn (rotate over a vertical axis) or Work-and-Tumble (rotate over a horizontal axis).

Note:  In order to make a CAD sheet with a front and a back, you need a multi-page PDF file.
The first page is placed on the front, the second on the back.

• Limit Bleed: The bleed can be limited to a specific distance. The bleed mask is created by
spreading the die shape. When this field is left empty, the bleed setting in the stations will
be left unchanged.

Note:  When using a SmartName, the resolved value should contain a number and a unit
((case insensitive): mm, cm, in, inch, mil, point, pt). When no unit is specified, the default value
mm is taken.

• Front Mark Set / Back Mark Set: Select a Dynamic Mark set to be put on the front or back
side of the layout.

Note:  Only Dynamic Marks created in ArtPro+ are supported. SmartMarks or Dynamic
Marks from DeskPack can not be used.

The marks in the output PDF of this task will be 'live' objects, which means they are still
editable when you open the output file in ArtPro+.

Note:  Unlike other 'Dynamic' S&R tasks, this task does not offer the “optimize output”
option (as described in the page of the as it exists in the task Add Dynamic Marks).

• Graphics Folder: This is the folder where the task searches the graphic files. This option is
only applicable when the input mode of the task is XML and when the XML does not offer a
full absolute path (only a partial path or only the name of the input file). Learn more in Using
XML as Input File on page 430.

7.178.2.  Tab 'CAD Layout'
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• Template: Select an MFG, CF2 or PDF+ template file.

Note:  A PDF+ template is a CAD template that was opened in ArtPro+, where marks could
be added, and bleed and overlaps could be defined.

• Select Set custom filling order to specify a filling order that is different than the one
defined in the selected template file.

• The filling order is defined by selecting a Start Position, Direction and type of Filling
Order. Learn more about using SmartNames to define these buttons in SmartNames of
Parameter Values on page 683.

Note:  The sequence of the designs is determined by taking the center points of the
designs and sorting these in rows and columns. Keep in mind that designs with different
sizes, or layouts with staggered designs can result in more rows or columns than
expected.

7.178.3.  Tab 'Sheet'
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• If you want to use a custom sheet size instead of the Sheet Size defined in the CAD file,
then select Set custom sheet size and enter its dimensions.

• CAD Layout Position: You here position the bounding box of all cut lines versus the sheet.
If you want to use a different position for the CAD Layout than the one defined in the
template file, then select Set custom position.

• Position on Sheet: Click or drag the inner square (the CAD Layout) in a position versus
the outer square (the sheet).

• Offset: Define by how much the CAD Layout should be offset from the sheet corner,
horizontally and vertically.

7.178.4.  Tab 'Plate'

 

 

The sheet size can be automatically extracted from the CAD template but neither Artios MFG
nor CFF2 file have a notion of 'plate'. As a result the plate size and position of the sheet on the
plate have to be specified in this Plate tab.

• Plate Size: Specify the plate's horizontal and vertical size.

• Shrink: To compensate for distortion on the output device or press, you can add vertical
and horizontal shrink values. This task applies the shrink factors as scale factors on the
complete document..

• Sheet Position: Click and drag the inner square (the sheet) to the right position on the
outer square (the plate) to position the sheet on the plate.

• Define any extra horizontal and vertical sheet Offset.

Tip:  When using SmartNames, make sure they return a value that the field expects. For
example a SmartName in the field 'Plate Size' should return a number.

7.178.5.  Using XML as Input File

Concept
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When the business system (MIS, ERP) provides an XML description, this task can fully automate
the folding carton step and repeat process.

When using XML input file(s), the task supports 2 modes:

• A v18.0 compatible mode supporting the XML format. Advantage of this mode is that you
can use the Product ID. This is used for example in flexo printing. Learn about this XML
specification below.

• A mode which is compatible with the XML used in the 'Dynamic' Step&Repeat tasks.
Advantage of this mode is that you can specify a page range (in case your input file is a
multipage file). This is used for example in VDP. Learn about this XML specification below.

Specification of the Mode based on the Element <JOB>

In the 18.0 compatible mode, the task scans the XML file for elements called <JOB>. Multiple
<JOB> nodes are allowed when these are placed under a <JOBS> node.

Attention:  All XML elements are case sensitive. For example, the element <JOB> must
be in capital letters.

An example:

It's also possible to combine multiple graphics in the XML file. In that case, multiple <JOB>
elements are gathered in one <JOBS> element. An example:

Each <JOB> element will create a station according to it's sub elements:

XML Element Description

Filename
(mandatory)

URL of the graphics. Both URLs and UNC paths are supported. Both absolute
URLs and relative URLs are supported. In case the URL is relative, the
Graphics Folder specified in the ticket is used to resolve the URL of the
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XML Element Description
graphics. Only one of FileName or ProductID may be specified. Some
examples:

<FileName>file://myserver/myfolder/mygraphics.pdf</FileName>

<FileName>\\myserver\myfolder\mygraphics.pdf</FileName>

<FileName>mygraphics.pdf</FileName>

<FileName>myfolder\mygraphics.pdf</FileName>

Product ID
(mandatory
if Filename
is not
used)

ID of the Product to use for the graphics. Only one of FileName or ProductID
may be specified. If a product contains multiple parts, the first part is used.
The second part will be used (if present) as back side graphic.

Note:  Describing products with multiple Parts in this way is not yet possible
in this version.

Quantity Number of times the graphics needs to be placed. Allowed values are either
a number or the keyword "Maximum" (the default, case insensitive, can
be abbreviated to "Max"). In case multiple graphics are using 'quantity =
maximum', they will be evenly placed on the number of matching placeholders.

DieShape Ink name of the die line of the graphics. Allowed values:

• the name of a spot color,
• 'TRIMBOX' (or 'BORDERS') will use the trim box of the PDF graphic.

• 'DEFAULT' will search for a CAD object inside the normalized PDF(STA)
file. When no CAD object is found, the trim box will be used. This also the
default value of this element.

Bleed The amount of bleed allowed outside the die shape. Sets a bleed mask, in
mm, starting from the die line. When no bleed is specified, no bleed mask
will be applied, unless the input is a PDFSTA file, in this case, the bleed setting
from the PDFSTA file will be used.

Page number Select a specific page from the specified PDF graphic. If no page is specified, all
pages of the graphics file will be loaded.

Specification for the <Runlist> Mode - compatible with Dynamic Step&Repeat

In the Dynamic Step&Repeat compatible mode, the task will scan the XML file for elements
called <RunList>, which contain one or multiple <RunListItem> nodes.

A <RunListItem> node consists of the following sub-nodes:

Node Description

FileName URL or UNC of the PDF graphic to be placed. Relative URL's are allowed, the
'Graphics Folder' will then contain the base path.
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Node Description

Repeats Number of copies required for this graphic. Allowed values are either a number
or the keyword "Maximum" (case insensitive, can be abbreviated to "Max").

FirstPage Number indicating the first page of the graphics to be used. Learn more in
Specification of RunList XML in Dynamic Step & Repeat tasks on page 455.

LastPage Number indicating the last page of the graphics to be used. Learn more in
Specification of RunList XML in Dynamic Step & Repeat tasks on page 455.

Extra XML Parameter when working Front and Back Graphics

Table: Back side handling in XML (all optional)

XML
Element

Description

BackGraphic UNC (or URL) of the PDF file to be used as back side. Example:

<BackGraphic>file://myserver/myfolder/mybackgrphic.pdf</BackGraphic>

Note:  No page selection is possible for the back graphic. Only the first page of
the back graphic PDF is used)

Other nodes as listed above (DieShape, BackGraphic) are optional.

7.179.  Step & Repeat Tabular
This task creates a step & repeat layout where the stations (one-ups) do not overlap ; their
bounding boxes do not intersect.

In this ticket, data can be entered

• manually, entering numeric values.
• using SmartNames. These can be

• Formulas. For example [VPLATE]. The names of these formulas are similar to those
used in Esko Plato.

• any other types of SmartNames. These can get their values from (job) parameters within
Automation Engine or they could retrieve these values from external databases, by doing
SQL queries. See an example in here. Learn more in Database Query SmartNames  on
page 645.

Note:  Some ticket fields only accept SmartNames of the category 'Step and Repeat'
whereas others also allow 'Global' SmartNames. Learn more in SmartName Categories on
page 599.

Comparing this task to the 'Dynamic' version

433



7 Automation Engine

Another tabular S&R task was created later than this one, mainly to serve workflows to digital
presses. Here 's a summary comparing their unique features:

• This Step & Repeat Tabular task:

• The marks you can add need to be SmartMarks (created in PackEdge or Plato)

• Offers formulas to specify the layout

• Outputs various output formats.

• The Step & Repeat Tabular (Dynamic) task:

• The marks you can add need to be Dynamic Marks (created in the Adobe Illustrator Plug-
in 'Dynamic Marks')

• Does not offer formulas to specify the layout

• Tailored for digital presses and/or VDP workflows
• Outputs Native PDF.

7.179.1.  Tab 'General'

 

 

• Output Format

• PDFPLA: In this format, the placed stations are referenced files, they are not embedded
into the layout file. This keeps the layout file small but limits its use to applications that
support such external references: Esko editors, Esko RIPs or any next workflows steps in
Automation Engine that make use of this smart referencing.

Attention:  If the input file of this task was a native PDF, this output mode
will make the task end in error because a "PDFPLA can only contain
references to normalized PDF".

• Normalized PDF (embed all): In this format, because all data is embedded, the PDF can
be used to exchange this layout file to remote sites that also use tools that read this Esko
Normalized data. For example: off-site printers that also use an Esko RIP.
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This file format is larger in Mb, however it is important to know that the technique
of "PDF forms" is used: each station is only embedded once into the output file. For
example if it contains 5 banana labels and 5 lemon labels, the size of the PDF will only be
slightly larger than the size of 1 banana PDF plus 1 lemon PDF file.

• PDF: This native PDF will have all data embedded and will also use "PDF forms" to
optimize its size (as explained here above). Choose this output type PDF when you need
to send this data to a non-Esko environment or device.

Attention:  This output is only advised when the task input file is one or more
native PDF(s). The advantage is then that there is no 'on the fly' normalization
done on these native PDF stations ; they are untouched and are only placed into
the native layout PDF.

This PDF has in its XMP also a description of the contents of its grids, their station names
and amounts. Any distortion factor (here named "Shrink") will be calculated/executed in
the PDF.

Note:  Choosing this output type disables the options 'Screen Registration' and
'Include CAD info for Digital Flexo Suite'.

• Origin: Define the point of origin from which the step & repeat is to be built.

 (top left),  (top right),  (bottom left),  (bottom right).
• Unit: Select a unit (mm or inch) to be used for all numeric fields in this task.
• SmartMarks: If you want to add marks to the step & repeat, select a SmartMarks set from

the drop-down list or use a SmartName.
• Select 'Load Mark Set in bottom layer' if you want to make sure the marks are positioned

in a newly created bottom layer, so that they appear 'behind' the graphics.
• Adjust masks for continuous printing:

When not selected, the top and bottom rows can have more bleed (top- and bottom bleed)
compared to graphics that occur in the middle of the layout.

When selected, the bleed of the top and bottom row of graphics will be truncated in the
same way as on the rows in the middle of the layout (i.e. truncate the bleed of the top and
bottom row of graphics as if there is a continuous set of rows of graphics). This is required
to enable continuous printing (around the drum).

• Screen Registration: When selected, the origin of the screening will be reset for each
station on the layout. This guarantees that the exact same screening will be applied for each
station. This is for example required when printing stamps. When not selected, screening
will be done continuously throughout the complete layout.

Attention:  This option defines an attribute in the PDF that is only supported by
Imaging Engine or FlexRip. It is ignored by any other RIP..

Attention:  Screen registration is not available when you choose the output format
PDF.

• Include CAD info for Digital Flexo Suite:

If you are using the Esko Digital Flexo Suite (DFS), select this option to add the technical inks
data into the header of the output file (this is usually the cut and crease lines). This data is
then visible in the Esko Bitmap Viewer and also embedded in the LEN files created by an
Esko RIP.
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The DFS can export this information into ACM files for an Esko Kongsberg cutting table. In
Esko PlatePatcher workflows, this information can be used to print onto the plastic sheet
where the pieces of flexo plate are re-assembled. These technical lines can also represent
text that is then added onto the (back of the) flexo plates, using a pen on the Kongsberg
table.

Attention:  This option is disabled when you choose the output format (native) PDF.

7.179.2.  Tab 'Plate'

 

 

Note:  In the entry fields of this and the next tabs, click  to open the SmartNames dialog.
Alternatively, right-click the field and directly choose a SmartName or formula from the offered
lists.

• Plate Size: Enter the horizontal and vertical plate size value, formula or SmartName. Learn
more in Using Formulas on page 444.

• Shrink: If you want, enter a shrink value, formula or SmartName. Learn more about when
and how shrink is applied in the page about the Create CAD Sheet task.

• Sheet Position: Position the sheet on the plate by moving the sheet (inner rectangle) versus
the plate (outer rectangle).

• Offset: Enter a value, formula or SmartName.

7.179.3.  Tab 'Sheet'
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• Sheet Size: Enter the horizontal and vertical sheet size value, formula or SmartName.

Learn more in Using Formulas on page 444.

7.179.4.  Tab 'Grids'

A tabular layout can be composed of one or multiple grids.

One same graphic can also be placed in more than one grid. For example one grid where its
stations are not rotated and another grid where the stations are rotated 180 degrees.

Grid Columns
 

 

Tip:  Right-click a table cell to discover several editing options.

The columns from left to right:

1. Grid number: Click the number to select the grid that you want to remove or edit.
2. File Name: The name of the one-up graphic repeated in this in this grid.
3.  Die Shape: You here define a die shape around each one-up in that grid. This will

mask out any objects outside that shape. Click the field to choose between 'None' or
'Borders' (Trim Box).

Note:  'None' also means that these graphics will be excluded from the SmartFlapping
process.

4.  Bleed : The value you type in here spreads the Die Shape with a bleed of this distance.
The die shape is spread but die shapes will not overlap.

5.  Vertical offset to the sheet : To define the top or bottom shift of the grid in relation to
the sheet, depending on the setup of the Origin.

6.  Horizontal offset to the sheet : To define the left or right shift of the grid in relation to
the sheet, depending on the setup of the Origin.

7.  Vertical step: To define the vertical distance between two stations on this grid. The
distance is calculated from the center point of the one-up to the center point of the next
one-up.
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8.  Horizontal step: To define the horizontal distance between two stations on this grid.
The distance is calculated from the center point of the one-up to the center point of the
next one-up.

9.  Vertical count: To define the number of times you want to repeat the one-up vertically.
10.  Horizontal count: To define the number of times you want to repeat the one-up

horizontally.
11.  Angle: To define the angle to rotate the one-up clockwise in this grid.
12.Head Turn / Stagger: This column shows icons that illustrate the head turn or stagger that

you defined for this grid (for example  or ). Learn more in Grid Settings on page 438.

Managing Grids

• Click Add Grid to add an extra grid at the bottom of the list.

Note:  When this ticket has multiple input files, it automatically adds enough grids to have
one for each input file (the ticket is automatically updated). Also see the below option 'Allow
Multiple Inputs'.

• To remove a grid, select it and click Remove Grid. There is no undo function.

• Select a grid and click Edit Grid to define advanced grid settings (staggering, head turns...).
Learn more in Grid Settings on page 438.

Other Options
• Allow to set left and right station bleed independently: When selected, 2 extra columns

appear, one for left bleed, one for right bleed.

Important:  Before selecting this option, first fill in a general Bleed (for which you first need
to define the Die Shape).

• Allow Multiple Inputs

Attention:  When you do not see this option in some older task-ticket, then open a
task ticket from the Tickets view, save it as a custom ticket and you will be able to use
this option.

This option decides what the task should do when you launch it on multiple files.

• Select this option to generate one step & repeat file containing all of the input files. Each
input file will be assigned to a different grid.

When there are multiple input files, their grid will by default be placed in alphabetical
order.

• Deselect this option to treat each input file separately. The task then generates a
separate step & repeat file for each input file.

Grid Settings
 

438



7Automation Engine

 

• Station: These options are the same as defined in the ticket's tab Grids. You can choose
where to define them.

• Geometry: These options are the same as defined in the ticket's tab Grids. You can choose
where to define them.

• Head Turn / Stagger

• Head Turn: Choose if and how you want to rotate certain stations on this grid by 180
degrees.

•
Choose  (first button) to keep all stations as they are, without rotating them
(default).
 

 
•

Choose  (second button) to rotate stations in alternating rows by 180°.
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•
Choose  (third button) to rotate stations in alternating columns by 180°.
 

 

•
Choose  (fourth button) to rotate stations both in alternating columns and in
alternating rows by 180°.
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• Stagger: Choose if and how you want to stagger (move) certain stations on this grid
horizontally or vertically.

•
Choose  (first button) to keep all stations as they are, without staggering them
(default).

•
Choose  (second button) to define a vertical stagger for this grid.

•
Choose  (third button) to define an horizontal stagger for this grid.

To define a horizontal or a vertical stagger:

1.
Choose  or .

2. In , enter a stagger value. Choose a unit or define a percentage of the width or
height of the station.

See this example of a 4 x 6 Step & Repeat with a 50% vertical stagger:

 

 
3. Stagger by x Columns/Rows. This value decides the amount of columns or rows

after which the stagger occurs. In above examples, this was the default value of 1, so
each column or row gets a different shift.

4. Restart after x Columns: You can choose to restart the staggering after a certain
number of rows or columns. This means that:

• For vertical staggering: the top station of that column is positioned at the same
height as the top station of the first column (it has the same vertical offset from
the top of the sheet).

See this example where the staggering restarts after 3 columns:
 

441



7 Automation Engine

 

• For horizontal staggering: the first (left most) station of that row is positioned at
the same horizontal offset as the first station of the first row.

• Select Continuous if you want to add extra stations to fill the blank space.

The example below is a 4 x 6 Step and Repeat (with staggering restarting after 3
columns), but the Continuous option added some stations vertically:

 

 

Note:  In the "Dynamic" variant of this task type, this option is named Add Partial
Labels. Learn more about this task in Step & Repeat Tabular (Dynamic)  on page
447.

• Use Up & Down together with Restart after to go back in the other direction
gradually instead of at once.

See this example where the staggering restarts after 3 columns, with the Up &
Down option selected:
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7.179.5.  Tab 'Rules'

You can modify the task's end status by setting up one or multiple smart rules.

An Example
Follow these steps to add a rule that prevents the creation of step & repeat files with more
than 6 inks:
 

 

1. In the tab 'Rules', click 'Add' to open the 'Add Rule' dialog:
2. Define the 'Condition':

• What: Enter the parameter you want to check (most probably a SmartName).

• Choose an 'expression' from the list.

• Enter a value for the parameter.
3. In Action, define what needs to happen when the Condition is met. Choose from:

• The task finishes with a warning

• The task finishes with a warning (there's no output).
4. Click OK to confirm. The resulting rule shows up in the tab 'Rules':

 

 
5. Add more rules if you want to. Their list will be checked from top to bottom.
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Tip:  You can choose to save tickets in which you switch off some rules and keep others
active.

7.179.6.  Using Formulas

Example of a Grid defining an Automatic Fill

1. First we need to define an absolute size for sheet and plate:
 

 
2. Now you can enter these grid settings:

 

 

Clarification of the formulas:

a. First you define the vertical  (and horizontal ) count of the grid: The vertical count is
the vertical size of the sheet divided by vertical size of the station:  VSHEET / VLABEL1.
For the horizontal count, use  HSHEET / HLABEL1 .

b. Then you are able to define the vertical  (and horizontal ) step: Vertical step is the
vertical sheet size divided by the vertical count:  VSHEET / VCOUNT1. For the horizontal
step, use  HSHEET / HCOUNT1 .

c. Now for the vertical  (and horizontal ) offset: You want to center the step & repeat
on the sheet. You can do that by defining the vertical offset as half the vertical step
minus the vertical size of the station: (VSTEP1-VLABEL1)/2. For the horizontal offset,
use (HSTEP1-HLABEL1)/2 .

Some of the fields work with formulas, a special set of parameters unique to this task.

There are two kinds of formulas: Global formulas that define the whole step & repeat and Grid
specific formulas that define individual grids.

Note:  When a step & repeat contains two different graphics, there will be at least two grids.
Each grid has its own number (see most left column).

Global formulas:
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• VPLATEFIT: Vertical plate size that fits around a step & repeat sheet and SmartMarks.
• HPLATEFIT: Horizontal plate size that fits around a step & repeat sheet and SmartMarks.
• VPLATE: Vertical plate size.
• HPLATE: Horizontal plate size.
• VSHEETOFFSET: Vertical offset of the sheet relative to the Plate.
• HSHEETOFFSET: Horizontal offset of the sheet relative to the Plate.
• VSHEETFIT: Vertical sheet size that fits around the step & repeat.
• HSHEETFIT: Horizontal sheet size that fits around the step & repeat.
• VSHEET: Vertical sheet size.
• HSHEET: Horizontal sheet size.
• SHEETTOP: Top position of the sheet relative to the Plate.
• SHEETLEFT: Left position of the sheet relative to the Plate.
• SHEETBOTTOM: Bottom position of the sheet relative to the Plate.
• SHEETRIGHT: Right position of the sheet relative to the Plate.
• NROFINKS: Number of non-technical inks (Technical inks will not be printed).
• NROFGRIDS: Number of grids.

Grid specific formulas (x = the grid number):

• VLABELx: Vertical size of non-rotated station.
• HLABELx: Horizontal size of non-rotated station.
• VSTEPx: Vertical step size, from center point to center point.
• HSTEPx: Horizontal step size, from center point to center point.
• VSIZEx: Vertical size of bounding box of rotated station.
• HSIZEx: Horizontal size of bounding box of rotated station.
• VCOUNTx: Number of vertical step & repeats in grid x.
• HCOUNTx: Number of horizontal step & repeats in grid x.
• ANGLE: Angle of the rotation.
• GRIDVSIZEx: Vertical size of the grid (top-bottom).
• GRIDHSIZEx: Horizontal size of the grid (left-right).
• TOPx: Top position of the grid relative to the sheet.
• LEFTx: Left position of the grid relative to the sheet.
• BOTTOMx: Bottom position of the grid relative to the sheet.
• RIGHTx: Right position of the grid relative to the sheet.
• BLEEDx: Distance to spread the grid die shape with.

7.179.7.  Using Database Queries: an Example

Many fields in this task can be defined by SmartNames. And SmartNames can get their values
by doing SQL queries to non-Esko databases. This means that your tabular Step & Repeat ticket
can automatically get (some of) its values directly from this external source ; no need for an
Esko user to type them in again.

We use this simple example of a database describing your dies:
 

 
First we need to create these SmartNames, then we add them into the task ticket.
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1. See this (old) example of how an SQL query SmartName is created to retrieve the value for
vertical gap.

Attention:  This page only summarizes how to do this. Learn more details in the
chapter 'SmartNames', specifically in 'Database Query SmartNames  on page 645'.

 

 

In this example, we created these SmartNames:
 

 

• DB_DrumH: Retrieves the value for the horizontal size of the drum.

• DB_DrumV: Retrieves the value for the vertical size of the drum.

• DB_GapH: Retrieves the value of the gap's horizontal size.

• DB_GapV: Retrieves the value of the gap's vertical size.

• DB_Teeth: Retrieves the number of cylinder teeth.

• DB_StepH: Retrieves the value of the die's horizontal step.

• DB_StepV: Retrieves the value of the die's vertical step.

2. Now use those SmartNames in a ticket of the Step & Repeat Tabular task. Use the Insert
SmartNames... button, or right-click, browse and select it.

The General tab can look like this:
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The Grids tab can look like this:

 

 

7.180.  Step & Repeat Tabular (Dynamic)
This dynamic version of the Step & Repeat Tabular task allows you full interactive control over
the positioning of files, much like if you would do this in ArtPro+ or in PowerLayout Standalone
(an Esko plug-in for Adobe Illustrator).

Attention:  The marks you add to this layout need to be 'Dynamic' marks. You can not
add 'SmartMarks' here (marks created in Esko PackEdge or Plato).
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Use this task when you do not use a template that was created in ArtPro+ or with PowerLayout
Standalone. If you do want to use such a template, then use the task Step & Repeat Template
based (Dynamic) on page 460.

The task outputs a PDF+ file, i.e. native PDF file.

Caution:  Make sure you define a specific name for the output file, this to avoid
overwriting the (first) input file.

Task Options

Selecting one of the items in this field displays their available settings in the field on the right.
As usual, many of these settings can also be set by using SmartNames.

Note:  Also buttons or icons can be set by SmartNames. Learn more in SmartNames of
Parameter Values on page 683.

Note:  Most all of the settings in this ticket are identical to those in PowerLayout Standalone.

• Job: Use the links to learn more about your options for the complete layout:

• Optimize Output: This option is described in the page of the task Add Dynamic Marks on
page 218.

• Split Output (incl. Blocks)

• Sheet and Plate

• Filling Order

• Marks

• Grid specific Options

• Grid selection: Use  to Add or Remove grids.

Note:  Grids are numbered sequentially. When there are 3 grids and you remove 'Grid 2',
then 'Grid 3' will automatically be renamed to 'Grid 2'.

• Preview: The preview shows the position of all grids. The selected grid is highlighted in
orange. Any others are displayed in blue.

7.180.1.  Assignment of Input Files

How this task assigns the incoming files to a grid depends on the type of input:

• A single PDF file with only a single page: This triggers an automatic Grid Filling, i.e. every
cell of the grid will be filled with the one-up input file.

• A single PDF file with multiple pages: The task creates only one grid with each page
placed once, in a single cell, not repeated.

Tip:  Use an XML input file to also repeat these pages. For example: a PDF has 3 pages, each
page contains a design variant / flavor of the design. The XML can then specify that it needs
1.000 bananas (page 1), 500 apples (page 2), etc. Learn more below.
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• Multiple PDF files: By default, the ticket automatically creates a grid for each PDF: the 1st
input file will be placed in the first grid, etc.

Tip:  Use the 'Sort' workflow control to change this sequence of input files as they enter this
task.

Attention:  There is an exception that is valid in a dynamic VDP workflow (where
each input file only needs to be output once): When the input files follow the naming
convention <SameFileName-Number>, they will be grouped together in a same grid.

For example, banana-001.pdf, banana-002.pdf , banana-003.pdf will be placed
in a same grid.

• An XML file for each grid. Learn more in the dedicated page Specification of RunList XML in
Dynamic Step & Repeat tasks on page 455.

7.180.2.  Splitting Output, Blocks and Gaps

To limit the size of the output PDF file, this task also uses the technique of "PDF forms": Each
input PDF file is only embedded once into the output file.

When used in a VDP context, where each station can contain a different graphic, this size can
become huge and easily reach the computer’s processing power limit. Tasks handling such files
require a lot of system memory and read/write operations, and this impacts the processing
speed. Some RIPs also have problems processing huge PDFs.

This is why you can choose to split this output. The task then creates a set of smaller PDFs
instead of a single large one.

Choose how you want to split the output file:

• No (Single File).

• Automatically. The task then calculates the number of sheets per file so that the output
file sizes stay within reasonable limits.

• On Number of Sheets. This way, each output file except the first and last one contains the
Number of Sheets (pages) specified.

• On Block Size of Grid 1 (only valid for output to digital presses):

Note:  Learn about the concept of Blocks and Gaps below.

A block with an optional gap must fit completely on sheets. This can be expressed by a
formula: (block_rows + gap_rows) mod grid_rows = 0. The task will fail when this is
not the case for the first grid.

Note:  In formulas, 'mod' stands for the 'modulo' operation: the remainder (leftover) after
division. For example "9 mod 3" results in 0, but "5 mod 2" results in 1. Learn more about
'mod' on this wiki page.

Use this mode when there is only one grid or if that condition is met for all grids. This
feature assumes that if the user took care to enter specific values for rows and gaps, that he
then likely will want to use those same numbers for splitting.

When defining this choice via SmartNames, the resulting value must match one of these: OFF,
AUTO, SHEETS, BLOCK.
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Blocks and Gaps: Concept and Examples

Note:  Some example use cases:

• You need to print 10.000 labels and deliver them on reels of 500 labels. You then define a
block of 500 a add a gap between those blocks (empty one-ups).

• You want those gaps to cover the complete circumference of the reel, to cover the labels
underneath and so protect them from any damage. In case of VDP each label might even be
unique.

Blocks are used to split jobs into fixed length segments and to control the filling order. They are
defined per grid. Each grid can have different block settings:

• Block Length is a number of rows.

• Gap Length is a number of rows ("zero" = no gap).

• Grid Height is the number of rows in a grid.

A gap works as a separator. It is represented by one or more empty rows inserted between two
blocks.

• If block length + gap length = grid height, then a gap will appear on each sheet
on the same place.

• If block length + gap length mod grid height > 0, then the gap will be floating ; it
will appear on different positions.

• If block length + gap length > grid height and block length + gap length
mod grid height = 0, then a gap will appear on the same position on the sheet but not
on each sheet.

Here are 3 examples of the above mentioned 3 cases:
 

450



7Automation Engine

 

7.180.3.  Sheet and Plate Options

The Sheet Size is the area where your one-up grids will be positioned within the Plate.

You can define:

• Plate Size: Define its horizontal and vertical size.

Note:  The plate size will correspond to the Media Box of the generated step and repeat
PDF.

Caution:  Take the printer's size limits into account when defining these values.

• Shrink: Shrink is used to compensate for plate distortion, later in the output process. Learn
more about when and how shrink is applied here.

• Sheet Size: This is the printable area on your plate.
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Note:  The sheet size will correspond to the Trim Box of the generated step and repeat PDF.

• Position on Plate: The blue square in the image represents the position of the sheet on the
plate. You can click or drag this blue square to match the desired alignment.
 

 

• Offset: Use this to fine-tune the position. The values are calculated versus the light gray
lines.

7.180.4.  Filling Order

Note:  We here refer to the one-up print items as 'items'.

These Filling Order options define how the items should be distributed over the grid. You can
specify:

• a starting point
• whether the grid should be filled by row or by column
• gaps (empty stations on the grid).

Options:

• Scope Settings:

• Same Settings for all Grids: This applies all the settings in this tab to each grid in the
layout. This automatically disables setting a filling order on grid level.

• Individual Settings for Each Grid: Select this to set the (different) filling order on grid
level.

• Start Content Filling: Choose where the first print item is printed (the next options then
decide how the other items will follow):

•
: Top left. When using a Parameter Value SmartName, its value should be TL .

•
: Top right. When using a Parameter Value SmartName, its value should be TR .

•
: Bottom left. When using a Parameter Value SmartName, its value should be BL .

•
: Bottom right. When using a Parameter Value SmartName, its value should be BR .

• Also specify whether the grid is to be filled by row  (SmartName value rows) or by

column  (SmartName value columns).

See the preview of your selected options on the right hand side.

• The Printing direction marked with an arrow indicates the direction that the paper/
substrate flows through the press.
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• In that preview, a black dot shows the first record.

• Some examples:

• The distribution starts on top left, with vertical flow:
 

 

• The distribution starts top right, with vertical flow:
 

 

• The distribution starts top left, with horizontal flow:
 

 

• Fill over: Choose if you want to distribute the items over the Complete Job or over Blocks.
Learn about the concept of blocks here.

• If you choose Blocks, the flow of variable data (the one-up variants) will run over blocks
of a specified size, then run over the next block when the previous one is complete.

The preview also shows the blocks:
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Block Size: You can define their size as the complete 'Job' or an amount of Sheets or
Rows.

• When, in 'Fill over', you selected 'Complete Job', then the Block Size will be 1 Job by
default.

You can set it to another unit if you still want to print in blocks, but without having the
flow of (variable data) items respect the block. This is useful if you want to add gaps (see
below).

 

 

• Gap between Blocks: This option is available if you have chosen to Fill over Blocks, or to
fill over the Complete Job but still have blocks (as explained above).

This option adds white space in between the blocks.

Gap Size: Define the size of this gap.

7.180.5.  Adding Marks

Use this tab to add Dynamic Marks to your layout.

Learn more about Dynamic Marks in the description of the task "Add Dynamic Marks on page
218".

7.180.6.  Setting specific Grid Options

• Specify the Cell Width and Cell Height for the one-up item ("cell").
• Set the grid Orientation and Clip Bleed.
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 defines the initial Orientation of the one-ups in this grid. Their orientation
within the layout can be changed further by the option Head Turn.

• Repeat
Define how many times you want to repeat the one-up (V & H) and define the gap between
these repeats (V & H).

• If wanted, specify a Head Turn and /or Stagger.
Learn more about these options here.

• Clip Bleed

Note:  Deselecting 'Clip Bleed' can cause one-ups to overlap. This can be useful in some
special layouts.

Note:  Learn more about what happens when bleed from panels overlaps in Bleed and
overlap on page 261 and in Bleed Overlap Priority Decided by ArtiosCAD Artwork Panels on
page 262.

Note:  Learn more about bleed in the manual of PowerLayout Standalone.

Keep Outer Bleed:

• Keep all (default)
• Keep horizontal outer bleed only
• Keep vertical outer bleed only

• Specify the Position of this grid using the positioning tool and Offset distances.
Define the positioning reference for this grid: Attach to the Sheet or the Plate area.

In below example, the top center of the (bounding box of the) layout will be placed on the
left bottom corner of the (bounding box of the) reference (that you defined in 'Attach to').

 

 

In 'Offset', you can still move the layout based on the above defined position. The direction
of the offset (up, down, left or right) depends on the positioning, and is indicated by the
arrows.

7.180.7.  Specification of RunList XML in Dynamic Step & Repeat tasks

Dynamic Step & Repeat tasks can use XML files to specify their input files (one-ups) and how
they should be placed on the layout. Such files typically come from external systems where
production planning was decided. This page describes the format that such a "RunList" XML file
needs to have.
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Structure
The XML file may contain only an XML header and a single root element RunList. UTF-8 coding
is needed to support non-ASCII characters in file paths.

Note:  While XML-files support UTF-8 encoding, all file names must follow the URL-encoding.
This means that all characters other than basic ASCII letters and numbers (A-Z, a-z, 0-9) and
a few punctuation marks ('-', '_', '.' and '~'), must be percent-encoded (for example a space is
noted as "%20"). Learn more about percent encoding in http://en.wikipedia.org/wiki/Percent-
encoding).

<RunList>
The RunList element can be used only at the root level and the current file format supports
only one RunList element per file.

This element is used as a container that holds together one or more nodes of RunListItem
(which describe one-ups for a specific grid).

It also contains an attribute Version, specifying the version of the RunList format. At this
moment only version 1.0 is supported.

Attention:  Each grid in the Step & Repeat must have an own RunList item and
because only one is allowed per file, this means that each grid must have its own XML
file.

<RunListItem>
This element is used to contain a reference to the one-up file. It contains following mandatory
elements:

Table: RunListItem for Step & Repeat Dynamic tasks

Element Format Description

FileName URL File specification of one-up file. It must be a valid URL (absolute path).
Note: Special characters must be properly coded (see common XML
rules).

FirstPage integer Index of the first physical page from the used page range. The first page
in PDF has index 1.

LastPage integer Index of the last physical page. Also this index starts from 1.

Example: Page range 1..1 means single page with index 1. Page range 1..2
means pages 1 and 2.

Repeats integer Number of page range repetitions (value must be greater than 0).

Note: Page range 1..3 is repeated in this way: 1, 2, 3, 1, 2, 3, 1, 2, 3,...

Under these conditions a reserved value -1 is allowed:

• Only one RunListItem in RunList

• FirstPage must be same as LastPage.

In this case the task will calculate the number of repeats automatically to
fill the complete grid.
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Element Format Description

Note:  Note: This feature is intended for 'static' jobs (not Variable Data
jobs).

Example

This example shows a RunList with two one-ups to be used in a grid:

• The first one-up is presented by a range of three pages (1-3) from the file A.pdf and needs
to be repeated two times.

• The second one-up is presented by a single page (1) from file B.pdf and needs to be
repeated five times.

The final order of pages used as one-ups will be: A1, A2, A3, A1, A2, A3, B1, B1, B1, B1, B1

<?xml version="1.0" encoding="UTF-8" ?>
<RunList version="1.0">
   <RunListItem>
      <FileName>file://server/JobContainer/Item1/A.pdf</FileName>
      <FirstPage>1</FirstPage>
      <LastPage>3</LastPage>
      <Repeats>2</Repeats>
   </RunListItem>
   <RunListItem>
      <FileName>file://server/JobContainer/Item1/B.pdf</FileName>
      <FirstPage>1</FirstPage>
      <LastPage>1</LastPage>
      <Repeats>5</Repeats>
   </RunListItem>
</RunList>

Grid Filling with an XML RunList

If the task input file consists of a single XML file,

• with only one <RunListItem>,

• where both the <FirstPage> and the <LastPage> are the same,

• and where the number of repeats is set to "-1",

then a special behavior is triggered, called Grid Filling. This means that every cell of the grid
will be filled with the specified static one-up.

7.181.  Step & Repeat Template based

Concept
This task creates a step & repeat file based on an template layout that was made earlier. This
mode makes it useful for all packaging print segments: labels, boxes, flexibles, etc. It is typically
used to make an identical layout but now for variant graphics with a same size as those placed
in the template.
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Note:  About the name of the output Step & Repeat file:

• When no name is specified, the output file name will be the name of the first task input file.
SmartNames based on this output file name will also follow that rule.

• When you choose the Output Format "PDF" and not "PDFPLA" (learn more below), the
system will avoid that you ever overwrite your input file PDF name ; it will, in the output file
name, automatically attach a suffix *_rep* to the name of your first input file.

• When you type in a specific output file name yourself, it will be honored, even when it then
overwrites a file.

Tab 'General'
• Output Format

• PDFPLA: In this format, the placed stations are referenced files, they are not embedded
into the layout file. This keeps the layout file small but limits its use to applications that
support such external references: Esko editors, Esko RIPs or any next workflows steps in
Automation Engine that make use of this smart referencing.

Attention:  If the input file of this task was a native PDF, this output mode
will make the task end in error because a "PDFPLA can only contain
references to normalized PDF".

• Normalized PDF (embed all): In this format, because all data is embedded, the PDF can
be used to exchange this layout file to remote sites that also use tools that read this Esko
Normalized data. For example: off-site printers that also use an Esko RIP.

This file format is larger in Mb, however it is important to know that the technique
of "PDF forms" is used: each station is only embedded once into the output file. For
example if it contains 5 banana labels and 5 lemon labels, the size of the PDF will only be
slightly larger than the size of 1 banana PDF plus 1 lemon PDF file.

• PDF: This native PDF will have all data embedded and will also use "PDF forms" to
optimize its size (as explained here above). Choose this output type PDF when you need
to send this data to a non-Esko environment or device.

Attention:  This output is only advised when the task input file is one or more
native PDF(s). The advantage is then that there is no 'on the fly' normalization
done on these native PDF stations ; they are untouched and are only placed into
the native layout PDF.

This PDF has in its XMP also a description of the contents of its grids, their station names
and amounts. Any distortion factor (here named "Shrink") will be calculated/executed in
the PDF.

Note:  Choosing this output type disables the options 'Screen Registration' and
'Include CAD info for Digital Flexo Suite'.

• You can add SmartMarks.

Attention:  If you use a template that contains macros from the old Esko application
QuickStep, these macros will be lost. You need to replace these macros with
SmartMarks.
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Tab 'Stations'

You here decide which files will replace the template stations in the output file.

Before you can define the new station in this ticket, you first need to select an input file before
opening the ticket. Then select the template (click the browse button and select it).

The ticket reads the template and lists the stations it found in the tab 'Stations':
 

 

• The stations (referenced files in the template)) are shown in the column 'In template'. The
task input files are listed in the column 'Replace by.

Changing or defining the "Replace by" stations: Click on any name of a file in the column
'Replace by' and you will see a list with options. These depend on whether the ticket you
have open already has input files or not.

• <do not substitute>: Select this to not replace that station. See the below described
option Delete station(s) ... to decide what happens then.

• To replace it with the first task input file

• To replace it with the second task input file
• Etc.

• Select.... After selecting a station in the 'Replace by' column, this button allows you to
browse to another file (that was not already an input file for this ticket). Alternatively, use
SmartNames.

• Delete station(s) in template file which have not been substituted.

• When selected, the not-replaced stations will, in the output file, be empty ("delete").
• When not selected, the not-replaced stations will, in the output file, be those from the

template ("keep").

• When the borders of a station file and substituted file do not fit, you can set the task
status to:

• Provide info: The task will end in status 'OK'. The task details and log file will mention
which stations did not have the same borders.

• Generate a warning: Same info is given, the task continuous, creates an output file but
ends in status 'Warning'.
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• Generate an error: Same info is given but the task stops and ends in status 'Error'.
There is no output file.

Tab 'CAD Options'

This tab is only enabled when you selected a CAD file as a template. The other types of
templates do not offer such information or do not allow it to be changed.

The options are identical as described in this page of the task Step & Repeat CAD based.

Tab 'Sheet'

The options are identical as described in this page of the task Step & Repeat CAD based.

Tab 'Plate'

This tab is only enabled when you selected a CAD file as template. The other types of
templates do not offer such information or do not allow it to be changed.

The options are identical as described in this page of the task 'Step & Repeat CAD based'.

7.182.  Step & Repeat Template based (Dynamic)

Concept
Use this task to place one-ups (print items) onto grids described in a template file.

Important:  This task is one of the "Dynamic" tasks. This means it uses the graphics engine
from ArtPro+ (NDL) and also means that the print marks are of the type Dynamic Marks.

To create a Step & Repeat PDF, this task needs this info:

• Specification of the layout, which could be made of one or multiple grids.
• Specification of the one-up(s) to be placed on those grid(s) ; their name and location.
• Specification of any other attributes, for example print marks.

This task can get these specifications from different types of files.

For example:

• When the task's input files are the one-up PDF files, then the template file indicated in the
ticket will need to provide the specification of the grid(s).

• But when the task's input file already describes all of the specifications listed above, then
the ticket does not need to have a template indicated. There is a JDF format that can
describe both the grids and the list of required one-ups to place.

These capabilities make it possible to use this task in 3 different modes.

3 Modes to Use this Task

• Where the input file(s) are the one-up PDF file(s). In the ticket, you then define the template
and any other settings. Learn more here.
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• Where the input file is an XML RunList (a list of one-ups to process). In the ticket, you then
define the template and any other settings. Learn more here.

• Where the input file is a JDF LanePrintJob" file. This type of JDF defines both the template and
the RunList. Learn more here.

Task Options - Job level
• Template: Select the template file that describes the grid(s).

When a template is selected, all other information in this task ticket is automatically filled in
with information from the template. You can not make changes to those fields..

These file formats are supported as template file:

• an SRT file, created in PowerLayout Standalone, an Esko plug-in for Adobe Illustrator.
Learn more in the manual of PowerLayout Standalone.

• a PDF with PowerLayout grid(s), created in ArtPro+.
• Optimize Output: This option is described in the page of the task Add Dynamic Marks on

page 218.
• Split Output options: Learn more in this page about the S&R Tabular (Dynamic) task.

All Other Task Options

Learn about all the other options in this page about the Step & Repeat Tabular (Dynamic) task.

Attention:  Filling Order is not applied globally. Therefore, when you specify the filling
order for each grid separately, ensure that the number of grids in this ticket matches
the number of grids in the template file.

Importance of the Order of the Input Files

The order of the input files is especially important when you work with templates. Input files
are considered alphabetically, i.e. the order in which you selected the one-up PDFs is not
relevant.

Tip:  Use the 'Sort' workflow control to change this sequence of input files as they enter this
task.

Learn more in this page valid for both S&R Dynamic tasks.

7.182.1.  Using PDF input file(s)

Concept

Template driven Step & Repeat is typically used when you have several same-size variations of
a one-up.

Below example shows that making that layout in an editor once is enough (PowerLayout grids
in ArtPro+ or PowerLayout plug-in in Adobe Illustrator). The next layouts with the other one-
ups can be done with this task using that initial layout as template.
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Note:  However you select the input files, they will be handed over alphabetically to the task.
The alphabetically first one will be assigned to grid 1, etc. This means that when the template's
grids have stations of a different size, that you may need the Sort step in front of this task to
control which input file is assigned to which grid.

About Marks

The marks in the output file can be the Dynamic Marks that were present in the template
(PDF from ArtPro+) or other they could be Dynamic Marks added by this task, or even a
combination. The marks will obviously adapt to the new input files (colors , etc.).

Marks from an SRT template will not adapt to the new input files ; those have become fixed
objects.

7.182.2.  Using RunList XML as input file

This is the same as described for the task Step & Repeat Tabular (Dynamic)  on page 447.
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See its dedicated page Specification of RunList XML in Dynamic Step & Repeat tasks on page 455

7.182.3.  Using JDF as Input File

Concept

When external systems have all the information that this task needs, which one-up(s) and
which grid(s) to use, they can deliver this information as a JDF LanePrintJob file. Find an example
and its specification below.

As with all system integrations, Esko's Solution Services can assist you in this project.

Note:  This mode, with a JDF input file, enables this task to replace the task Import JDF Layout
which uses a different graphics engine (BRIX, used in normalized PDF). This task is one of the
"Dynamic" tasks that use the NDL graphic engine from ArtPro+.

Note:  When this kind of JDF is the task's input file, then the Template field in the ticket should
stay empty.

Example of a JDF LanePrintJob file

See the example JDF file below. You can also download it from here. It creates this layout:
 

 

<?xml version="1.0" encoding="UTF-8"?>
<JDF xmlns="http://www.CIP4.org/JDFSchema_1_1" ID="0000" Type="ProcessGroup"
 Types="ImpositionPreparation" Status="Ready" 
   JobID="01234556" JobPartID="1" Version="1.3"  xmlns:eg="http://www.esko-graphics.com/
EGschema1_0">
 <ResourcePool>
  <eg:MultiGrid ID="Mg001" Class="Parameter" Status="Available" ProductID="MultiGrid124">
   <eg:Grid Grid="0" CellH="65"  CellV="150" GapH="0" GapV="0" NrH="1" NrV="3" Rotate="0"
 VOffset="0" HOffset="0"/>
   <eg:Grid Grid="1" CellH="150" CellV="65" GapH="0" GapV="0" NrH="2" NrV="6" Rotate="90"
 VOffset="10" HOffset="70"/>
   <eg:Grid Grid="2" CellH="65"  CellV="150" GapH="0" GapV="0" NrH="1" NrV="3"
 Rotate="180" VOffset="0" HOffset="370"/>
  </eg:MultiGrid>
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  <eg:LanePrintJob  ID="Pj001" Class="Parameter" Status="Available"  MediaWidth="480"
 MediaHeight="470" MediaMarginLeft="5.0">
   <eg:LaneRepeat>
    <eg:MultiGridRef rRef="Mg001"/>
    <eg:Lane  Lane="0" >
     <RunList PartIDKeys="Run">
      <RunList Run="1" NPage="1">
       <LayoutElement>
        <FileSpec MimeType="application/pdf" URL="file://myserver/mycontainer/myfolder/
ALCIS_SHOWER_BERRY.pdf"/>
       </LayoutElement>
      </RunList>
     </RunList>
    </eg:Lane>
    <eg:Lane  Lane="1" >
     <RunList PartIDKeys="Run">
      <RunList Run="1" NPage="1">
       <LayoutElement>
        <FileSpec MimeType="application/pdf" URL="file://myserver/mycontainer/myfolder/
ALCIS_SHOWER_KIWI.pdf"/>
       </LayoutElement>
      </RunList>
     </RunList>
    </eg:Lane>
    <eg:Lane  Lane="2" >
     <RunList PartIDKeys="Run">
      <RunList Run="1" NPage="1">
       <LayoutElement>
        <FileSpec MimeType="application/pdf" URL="file://myserver/mycontainer/myfolder/
ALCIS_SHOWER_KIWI.pdf"/>
       </LayoutElement>
      </RunList>
     </RunList>
    </eg:Lane>
    <eg:Lane  Lane="3" >
     <RunList PartIDKeys="Run">
      <RunList Run="1" NPage="1">
       <LayoutElement>
        <FileSpec MimeType="application/pdf" URL="file://myserver/mycontainer/myfolder/
ALCIS_SHOWER_ICE.pdf"/>
       </LayoutElement>
      </RunList>
     </RunList>
    </eg:Lane>
   </eg:LaneRepeat>
  </eg:LanePrintJob>
 </ResourcePool>
 <ResourceLinkPool>
  <eg:LanePrintJobLink rRef="Pj001" Usage="Input"/>
  <eg:MultiGridLink rRef="Mg001" Usage="Input"/>
 </ResourceLinkPool>
</JDF>

Specification of JDF LanePrintJob

eg:MultiGrid of
JDF[@Category]

Description Cardinality

eg:Grid Step & Repeat grid. 1-infinity

eg:Grid/@Grid The index of the grid (0 based numbering). 1

eg:Grid/@CellV The height (along the web) of the repetition
cell (mm).

1

eg:Grid/@CellH The width (across the web) of the repetition
cell (mm).

1

eg:Grid/@VOffset The vertical offset of this grid from the top of
the multi-grid (mm).

1
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eg:MultiGrid of
JDF[@Category]

Description Cardinality

eg:Grid/@HOffset The horizontal offset of this grid from the left
side of the multi-grid (mm).

1

eg:Grid/@Rotate The rotation (degrees clockwise) to be applied
to graphics in the cells.

Value should be 0, 90, 180 or 270 .

1

eg:Grid/@NrV The number of cells along the web. 1

eg:Grid/@NrH The number of cells across the web. 1

eg:Grid/@GapV The height (along the web) of the gap
between cells in the repetition (mm).

1

eg:Grid/@GapH The width (across the web) of the gap
between cells in the repetition (mm).

1

eg:LanePrintJob
of JDF[@Category=
"MISPRE.ImpositionPreparation"]

Description Cardinality

eg:LaneRepeat/eg:Lane/
RunList /RunList[@Run="1"]/
LayoutElement/FileSpec/@URL

Absolute file URL pointing to the PDF to
upload.

The PDF has to be stored on a network share
that is readable by the AE System account.

eg:LaneRepeat/eg:Lane/
@Lane

The lane (zero base indexed from left to
right).

1

eg:LaneRepeat/eg:Lane Element defining the Lane of a Lane-Repeat.
Lanes are numbered between 0 and NrH-1
from left to right.

It is allowed to omit lane elements. This will
result in an empty lane.

1-infinity

eg:LaneRepeat Repeat (a Step & Repeat PDF). 1

@MediaWidth The width of the media box. 1

@MediaMarginRight The margin provided on right of the trim box
with respect to the media box.

0-1

@MediaMarginLeft The margin provided on left of the trim box
with respect to the media box.

0-1

@MediaHeight The height of the media box. 1

@Bleed The amount of bleed. 0-1

Behavior
• When the task detects a JDF as input file, it checks if it has the JDF LanePrintJob format, and

if it contains information about the grids and lanes.
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Attention:  When such a valid JDF is detected, the field Template in the ticket
should stay empty. Otherwise, the task will end in error.

• These fields are mandatory in the JDF file:

• Grid and Lane index number
• CellH, CellV

• VOffset, HOffset

• MediaHeight, MediaWidth

• Rotate

• GapH, GapV

• NrH, NrV

• Bleed, MediaMarginLeft and MediaMarginRight are optional.
• When mandatory fields are missing or have a blank value, the task will end in error. For

example: Rotate="" , GapH=""
• When optional fields are missing or have a blank value, the task considers those elements

as missing. For example: Bleed="" , MediaMarginLeft=""
• No bleed will be applied if the attribute eg:Bleed is missing in the input.
• The grid index numbering should start from 0 and should be unique. The index numbering

of the grids should be in sequential order.
• The trim box is defined as union of all grids taking into account their size and position. It is

then enlarged to also contain the origin point [0,0].
• The media box size is defined by the MediaHeight and MediaWidth.
• The media box position is based on the size of the trim box.

• Vertically: center according to trim box.
• Horizontally:

• If no margin is defined, also center.
• If MediaMarginLeft is defined then that is the distance from the left side of media

box to the left side of the trim box.
• If MediaMarginRight is defined then that is the distance from the right side of

media box to the right side of the trim box.
• Finally, the media box is checked to verify that the complete trim box is inside. An error is

generated if it is not the case.
• GapH, GapV can also have negative values.
• The one-ups to be placed in lane depend on LayoutElement/FileSpec/@URL and

eg:LaneRepeat/eg:Lane.
• The PDF file path defined in the FileSpec/@URL in the input XML should be in URL or UNC

format. The task will end in error if the input PDF file path in the XML file is invalid or the file
doesn't exist.

• The task will place the one-ups according the provided lane number of the corresponding
provided grids columns (NrH), this in numerical order of the grid index starting from 0.

• Corresponding grid columns will be blank if the lane index number is not provided.
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• When any of the following conditions are not met, the task will end in error and show
relevant log messages:

• MediaWidth / MediaHeight must be > 0.0

• The media box must be >= the trim box
• CellH, CellV must be > 0.0

• NrH, NrV is whole number >= 1

• Bleed, if present, must be >= 0.0

• RunList's attributes with anything other than Run="1" NPage="1" will also result in error.

• FileSpec tag in LayoutElement is mandatory.

7.183.  Submit to Flexo CTP Device

This task is documented in the chapter Flexo CTP Workflow on page 1340. Find a direct link
here.

Note:  Until AE v18.1.1, this task was named 'Submit to CDI'.

7.184.  Submit to Gang Run
This task is documented in the chapter Gang Run Printing for Sign & Display on page 871. Find
a direct link here.

7.185.  Submit to HP SmartStream Production Pro Print
Server

This task is explained in the chapter Digital Printing Workflow  on page 1429. Here is a direct
link.

7.186.  Submit to Esko DFE

This task is documented in the chapter Digital Printing Workflow  on page 1429. Find a direct
link here.

7.187.  Submit to Kongsberg Table

This task is documented in the chapter Kongsberg Production Workflow. Find a direct link here .
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7.188.  Submit to Plate Merger

This task is documented in the chapter Flexo CTP Workflow on page 1340. Find a direct link
here.

7.189.  Submit XML to Gang Run
This task is documented in the chapter Gang Run Printing for Sign & Display on page 871. Find
a direct link here.

7.190.  Synchronize ArtiosCAD Boards

What?

This task synchronizes 'board' information received from a business system with the ArtiosCAD
'board' database.

More Info

This task is set up by an Esko Solution Architect. Learn about Esko Solution Services on https://
www.esko.com/support/solution-services.

For more information, search for online articles on this topic in the Esko Knowledge Base.

7.191.  Synchronize ArtiosCAD Companies

What?

This task synchronizes 'company' information received from a business system with the
ArtiosCAD 'company' database.

More Info

This task is set up by an Esko Solution Architect. Learn about Esko Solution Services on https://
www.esko.com/support/solution-services.

For more information, search for online articles on this topic in the Esko Knowledge Base.
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7.192.  Track Edit Session
Automation Engine can track and log interactive editing actions in Esko editors. Define in the
Configure tool for which editors you want this automatic tracking.

When you open a file that resides in an active Job (folder) in an Esko editor, this task will
automatically start logging many important editing actions. The task automatically stops when
someone closes the file in the editor.
 

 

This editing information can so also automatically

• be stored in the Task History.

• be made available by using Notifications, for example as an XML file to report to another
system. You could also save all notifications locally in the Job folder or centrally and you can
do this in one or several files. Learn more here.

Note:  This task cannot be launched interactively. It will start appearing when you configured it.
Keep in mind that the editor needs to be restarted to activate this setting.

Note:  When editing files in ArtPro, the task only records the timings of opening and closing the
file.

7.192.1.  Viewing the Edit Session Information in the Pilot

In the Pilot, the task's Details already show what is logged. An example:
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Note:  Notice in above screenshot how, when at the end the operator saved the file as *_BCK,
that the tracking task closed and immediately started a new one, now for the file with that
other name.

7.192.2.  Storing the Editing Information System-Wide

How can these edit logs be stored automatically?

• Make sure the task is automatically archived into the tool Task History.

• Alternatively, use the Notification tool to create a rule specific for this task:

• Either you save all these XML logs inside the Job folder. The SmartNames you use in the
output location allow you to choose if you want one (XML/TXT) log for each file or one
per day or etc.

• Alternatively, you save all these XML logs per customer or even system-wide. In that case
you just indicate an output path somewhere outside the Job folder.

Follow these steps to create such a rule:

1. Go to Configure > Notification > Rules
2. In the Tasks tab, select the task Track Edit Session.
3. Click Add. The Notification Rule Editor opens.
4. To get an XML, select the Action 'Create XML File in folder' .
5. Define the folder's Location and click OK.
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7.192.3.  Which Edit Actions are Logged?

These types of edits are logged:

• Which user opens which file from which workstation?
• Start and stop time of this editing session
• Was the file saved or closed? When and with what name?
• All loading, saving, placing, exporting functions
• All changes to inks, layers, pages, page sizes
• All changes to (Esko) barcodes
• HIFI color conversions
• All trapping actions, PSFix actions, InkWizard actions
• Creating and replacing of external references
• Die object edits: adding, turning, flipping, rotating
• Writing of task notifications (when closing the edit session)
• Any loss of connection with the server.

An example:

*** Start interactive PackEdge 7.0 ***
        Time 13/01/06 17:19  
        User wde@aeserver01  
        Automation Engine server AESERVER01  
        Loading file file://aeserver01/52355/Prod/52355_YummieBeer_back.pdf  
        Remove layer OMBRE  
        Trap with local ticket Default
        "Modified ink angle for C from 22 to 7 degrees" 
        "Created ink PANTONE 123 C (100 lpi, 7 degrees, dot ?, type Normal)"  
        "Created ink C (170 lpi, 75 degrees, dot ?, type Normal)" 
        "Created ink ROUGE (170 lpi, 45 degrees, dot ?, type Normal)"                  
        Placing file file://aeserver01/52355/Prod/52355_YummieBeer_collar.pdf  
        Changed page margins to top 3.998, bottom 9.998, left 4.001, right 66.001 mm  
        Changed page size to width 110.0024 mm and height 73.99 mm  
        PS-Fix: modified 2 contour(s)  
        Applied Job inkmapping  
        "Modified ink angle for C from 7 to 75 degrees"          
        "Removed ink M (170 lpi, 15 degrees, dot ?, type Normal)"          
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        Changed page margins to top 7.25, bottom 7.25, left 7.25, right 8.36 mm
        Exporting file file://aeserver01/52355/Prod/52355_YummieBeer_back.tif  
        Saving file file://aeserver01/52355/Prod/52355_YummieBeer_back2.pdf  
        *** End interactive PackEdge 7.0 ***  
        Time 13/01/07 17:22  
        Notification:Wrote XML file:E:\wdedata\52355\Prod\Edits\52355_YummieBeer_back.  
    

7.193.  Trap

Note:  This task uses the graphic kernel of PDF Action List Processor.

This task accepts PDF as input file (PDF+ and Normalized PDF).

This task will overwrite the input file when you didn't specify a different name or location.

The task used the units specified in the preferences of the Pilot.

All required values of SmartName fields are case-insensitive.

Task Settings

 

 

• Use Trap Settings from File: In ArtPro+, you can save trap settings, even per object.

• Never. You then define all options here in this ticket.
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• When Available: Select this when you want to use settings that are present in the input
file. The task ends in error when no such settings are found.

When using a SmartName, its value must be either 'When Available' or 'Never'. These fields
is case-insensitive. The default option selected is 'Never'.

• Trap Distance: Enter the width of the traps. The default width is 0.2 mm (or its equivalent
in your chosen unit).

• Truncate: Truncate the trap so that it doesn’t stick out on another color. Select 'On Center'
or 'On Edge'. When using a SmartName, its value must be either 'Center' (default) or 'Edge'.

• Joins: How should the sharp corners of the traps be handled? Select 'Round' or 'Mitered'.
When using a SmartName, its value must be either 'Round' (default) or 'Mitered'.

• End Caps: 'Object Dependent' means a logical continuation of the contour of the spread
object. 'Square' ends the trap at right angle to the adjoining object. SmartName values must
be 'Dependent' (default) or 'Square'.

• Image Traps:

• Original Data: When spreading an image, the task uses the underlying image data
(when the image is clipped) to create the trap. SmartName value must be 'Original'.

• Extend Data: The task automatically extrapolates the image along its clipping path edge
to ensure the trap looks as expected, even if there is no clipped image data outside the
visible image. SmartName value must be 'Extend'.

• Apply Pullback: When a color area is composed of multiple inks bordering to a very light
background, you can 'pull back' all inks except the darkest ink. This prevents individual inks
from that composed color to become visible in the background.

• Inherit Trap Settings: When set to 'yes', the same settings will be used as those set
above for trapping. SmartName value can be 'yes' (default) or 'no'.

• Pullback Distance:

• Truncate:

• Joins:

• End Caps:

• Close gaps smaller than: Some files contain very small unintentional gaps between
neighboring objects. These gaps prevent trapping of these objects.

The default value is 0.01 mm

7.194.  Trap with PowerTrapper
Learn about the concept of trapping in What is Trapping? on page 474.

This task uses the Esko technology "PowerTrapper" (as a part of Esko's graphic kernel 'BRIX').

Its input file needs to be a native or normalized PDF.
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The resulting trapping objects are created in a dedicated (new) layer.

The output of this task is a Normalized PDF file.

The task's many settings are spread over these tabs:

• Distance & Direction on page 474

• Color & Shape on page 477

• Processing on page 478

• Rules on page 479

• Output on page 481

7.194.1.  What is Trapping?

The trapping process is a safeguard against possible fluctuations in the printing process.
Minor discrepancies in registration and slight paper shifting can cause inks to misregister.

When two adjoining colored objects do not touch exactly, the printed result can show a white
gap, as well as areas with a dark overlap:
 

 

'Trapping' these objects causes the objects to slightly overlap each other:
 

 

In general, trapping is necessary when two adjoining color areas don’t share a common ink.

Adding a fine area where they join, made of a color that contains components of both
adjoining colors, can effectively 'trap' such areas.

7.194.2.  Distance & Direction
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1. Trapping: Choose between two modes:

• Normal Trapping: This selects adjoining color pairs, which are likely to cause registration
problems like ugly light gaps, and unwanted halo effects. Lighter colors are generally
trapped into darker colors to minimize the visual effect of the trap.

• Reverse Trapping: This mode avoids overprinting of inks. It prevents overprint of
adjoining color areas by trapping these color pairs with a white knockout (erasing) trap.
The white knockout trap is put on top of the lighter of the two colors. This is useful to
prepare a file for "Dry Offset" printing (example: printing on metal cans).

2. Trapping Distance: Enter the width of the traps. The default width is 0.2 mm (or its
equivalent in your chosen unit).

Below, you can define specific distances when trapping Into black, Into spot color, Into
image or adding a Pull Back (see below).

3. Minimum Ink Difference

Trapping is applied to two adjoining colors, when either:

• The two colors each consist of at least one ink but they have no common inks.
• The two colors have common inks but there is a difference of at least the Minimum Ink

Difference percentage for two or more inks making up these colors.

These differences in ink percentages must be in opposite directions.

Note:  An example: With the default minimum ink difference percentage of 10%, the
following two colors are trapped:

• 1st color: C 5%, M 10%, Y 50%, K 15%
• 2nd color: C 5%, M 10%, Y 85%, K 5%
• => These colors have 2 inks that differ 10% or more: K is 10% different, Y is 35% different.
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Increase the Minimum Ink Difference to trap colors that differ more ; lower it to trap
colors that are similar.

4. Image Trapping

• Automatic: This determines the most suitable trap direction automatically. It compares
the average lightness of the image with the lightness of the adjoining area, and then
traps the lighter color into the darker one.

• Always Towards Image: This always traps line art under adjoining images.

• Always Towards Line Art: This always traps images under adjoining line art.

Select 'Trap images to images' if you want images to be trapped with each other.

5. Pull Back

When a color area is composed of multiple inks bordering to a very light background, you
can 'pull back' ink to keep away all ink except the darkest ink. This prevents individual inks
from that composed color to become visible in the background, typically due to registration
errors during printing.

• Automatic: This creates pull backs on rich black or rich spot colors, when the color left
in the pull back area is not very different from the composed color.

• Only Pull Back Rich Black: This only creates pull backs on rich black.

• Do Not Pull Back: This never creates any pull back.

There will be automatic pull back for the darkest color. Select 'Also pull back light inks' to
create pull backs even when the pull back ink (i.e. the ink remaining in the pull back area)
is visibly different from the composed color. Select 'Pull back images and gradients' to
create pull backs on images and gradients.

6. Trap Decision

• Use Lightness: This uses the color luminance to define the trapping direction, except for
opaque inks, where it uses the inks order.

• Trap direction: from brightest to darkest.

• Treat Spot Colors as Opaque: Color luminance is used only for CMYK. For opaque and
spot inks, the trap direction is determined by the ink sequence.

• Trap direction for spot colors only: towards the separation that is listed the lowest in
list of inks.

• Trap direction goes from the process to the spot color if the spot color is below the
process color in the list of inks.

• Trap direction if the spot color is above the process color: from brightest to darkest.

• Use Separation Order: The trapping direction is determined by the ink sequence for all
inks, including CMYK.

• Trap direction: towards the separation listed the lowest in the list of inks.

• Use Reverse Separation Order: As above, but using the reverse ink sequence.

• Trap direction: towards the separation listed the highest in the list of inks.
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7. Overshoot Mode: See some visual examples in the PackEdge user manual (Menu > Trapper
>  PowerTrapper).

• Automatic: The centerline behavior is according the rules determined in the color pair
list.

• Never on Dark Areas: The centerline is forced not to get beyond the center of dark
areas.

• Never: The centerline is forced not to get beyond the center of any area.

7.194.3.  Color & Shape

 

 

• Trap Color Intensity: By default, the task uses the full color of the object to spread in the
trap area (100% trap color intensity). You can create a trap of a lighter color by reducing this
percentage.

• Image Trap Color: Choose how to trap your images:

• Use Original Image Data: When the image is clipped, the task uses the underlying
image data to create the trap. When there is no underlying image data (when the image
is not clipped), an empty trap is created.

• Extend Image Data: The task automatically extrapolates the image along its four edges
to ensure that the trap looks as expected, even if there is no clipped image data outside
the visible image.

• Use an Approximate Flat Color: Instead of using existing or extrapolated image data
in the trap, the task uses a solid color. A suitable color is determined by averaging the
image's colors along its boundary with the object to trap.

• Truncate Traps: Truncating the trap object avoids that it sticks out on another color.
Choose a mode:

• On Center: When a portion of a trap comes too close to the contour of another object, it
is limited to half the distance between the trapped object and the other object.

• On Edge: When a portion of a trap comes too close to the contour of another object, it is
truncated on the other object's edge.

• End Caps: Choose the shape of the ends of an open trap:

• Square: The trap ends at a right angle to the adjoining object.
• Round: This rounds the ends of the trap. This is typically only used in combination with

white knockout ('Reverse Trapping').
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Note:  We recommend that you do not to use 'Round End Caps' together with 'Truncate
Traps On Center', as this can generate some artefacts (the round caps are truncated).

• Object Dependent: The trap is a logical continuation of the contour of the spread
object.

• Trap Corners: Choose how sharp corners should be handled:
 

 

• Round: Corners end in a round cap.

• Beveled: Sharp corners are cut off.

• Mitered: If the distance from the base of the trap to the corner point is larger than

the  Miter Ratio multiplied by the trap distance, then the corner will be beveled,
otherwise it will remain sharp.

The default miter ratio is 4. This means that if the length of the sharp corner is more
than 4 times the Trapping Distance, the corner is cut off (beveled). If it is less than 4
times the Trapping Distance, the corner is left as it is.

• Truncate Traps: If you want to truncate traps into black differently, select Into black and
choose the truncation mode (On Center or On Edge).

7.194.4.  Processing
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• Color Pairs:

Before creating trap objects, PowerTrapper scans the file for color pairs where this will be
needed. A color pair can occur only once or it can occur many times. The task can trap all
hits (occurrences) of a color pair in the same way or it can recalculate the trap direction for
different hits.

• Each hit can have its own decision: This recalculates the trap direction for each hit of a
color pair.

• Use the same decision for all hits: This traps all hits of the same color pair in the same
direction.

• Use the same decision for objects smaller than: This uses the same trap direction for
hits of a color pair belonging to small objects, and recalculates the trap direction for hits
belonging to bigger objects.

Use the input field next to determine the maximum size of small objects.

• Objects:

To speed up the trapping, the task can safely ignore certain object types.

• Only selected objects

• Respect existing traps: If the file has already been trapped, select this option to keep
the existing trap layer out of the trapping process.

• Ignore bitmaps: Select this to keep bitmap pixel data from being trapped. Bitmap data
is contourized before trapping which may slow down trapping. Bitmaps with lots of small
isolated islands typically take a longer time to trap.

Note:  When you indicate an object type to ignore, it is ignored completely as if it did not
exist in the file. Also, the ignored objects do not truncate trapping areas resulting from
other objects below them.

• Small Gaps:

Some files contain very small unintentional gaps between neighboring objects. These
gaps prevent trapping of these objects. Although it is better to clean up such files before
trapping, PowerTrapper can ignore these gaps automatically.

To use this option, select Close when smaller than and enter the maximum size small gaps
can have.

Note:  If you set a big gap size, trapping may become slower and some small parts may be
ignored.

7.194.5.  Rules

This tab allows to add rules that define custom trapping settings for specific trapping pairs.

PowerTrapper first traps the trapping pairs that match such a rule (according to that rule) and
then traps the rest of the file according to the main trapping settings.
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When to use Rules?
In most cases the general trapping settings entered in 'Distance &Direction' give you excellent
results. You can refine them using rules.

Settings defined in rules overrule settings in the other tabs.

Note:  This is an advanced feature. We recommend it for experienced users.

Some example cases to custom rules:

• To set a different trap distance for a specific spot ink. Sometimes you need a larger trap
distance for spot inks if there is no other ink to help cover leaks on the press.

• To prevent trapping or ink pull back in specific cases. Depending on the type of the
adjoining colors, trapping and/or pull back may be undesirable.

• To force a specific trap direction. When adjoining colors have a similar lightness level,
PowerTrapper selects an arbitrary direction. You can use a rule to make it always use a
particular direction for a color pair.

• To specify a different shape and/or truncation mode for certain color pairs. For example,
you can choose to use 'On Center' truncation when trapping under a 100% black line and
'On Edge' truncation on all other color pairs.

Creating a rule
1. Click Add.
2. In the dialog, use the 'From' and 'To' lists to specify trapping pair that you want to apply this

rule to. Choose between 'Any Color, a particular ink (Process, Spot or Opaque), a particular
object (Image, Gradient or Empty Background) or the Registration Color.

Note:  When trapping a particular ink, you can also define its 'Minimum Density' and if the
Color must be pure (no other separation in the color object).

3. Choose the contents of the rule.

Most options are described in the previous pages. Here are some specific settings within
these rules:

• Direction Mode: Select 'Into Both Colors' to use bidirectional trapping. In that case, the
trap goes half the trapping distance in each direction.

• Horizontal/Vertical Distortion: Set the percentage of the trapping distance to be used
in V/H direction.

See an example where the trap was generated with no vertical distortion (so 100%, i.e.
using the entered trap distance) and horizontal distortion set to 50% (i.e. half the trap
distance).
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You can use the + or - buttons to add or remove criteria to your rule.
4. Click Add to confirm and add the rule.
5. After defining the rules, click OK to confirm this list of rules.

7.194.6.  Output

• Trap layer only: Select this to output a PDF containing only the trap layer.

• Load trap color pairs if present: Select this to make the task use a TCP file that was
created during a previous trapping action. The TCP file needs to have the same name as the
input file and needs to be present next to the input file.

7.195.  Unshare Job

This task is documented in the chapter Integrating with Esko Cloud. Find a direct link here

7.196.  Unzip
You can use this task to extract files from a zipped archive.

 

 

Note:  Many applications can create zip files, also the Zip task in Automation Engine.

• Define what needs to happen If the files already exist at the destination location:

• Fail. The task will not unzip and will end in an error status.

• Overwrite the files and give a warning.

• Overwrite the files.

• Character Set:

When a zip file was generated with non-standard encoding, unzipping such a file with this
Unzip task can fail. The task's log file then mentions a ‘MALFORMED’ exception. You can solve
this by specifying the character set that was used to create the file.
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For the list of character sets and the correct naming to be used in this task ticket, we refer to
this page of the online java documentation. When specifying a character set in this ticket, use
the name as is listed on that page, in the column “Canonical Name for java.nio API”.

7.197.  Upload Files to Esko Cloud Job Folder

This task is documented in the chapter Collaborating via Esko Cloud  on page 1471. Find a
direct link here.

7.198.  Upload Files to Share & Approve

This task is documented in the chapter Integrating with Share & Approve on page 1547.

Find a direct link here.

7.199.  Upload via FTP

This task is documented in the chapter Integrating with External Systems on page 1553. Find a
direct link here.

7.200.  Upload via SFTP

This task is documented in the chapter Integrating with External Systems on page 1553. Find a
direct link here.

7.201.  Upload To Cloud Storage

This task is documented in the chapter Integrating with External Systems on page 1553. Find a
direct link here.

7.202.  Verify Certification

This task is documented in the chapter Quality Control tools. Find a direct link here.
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7.203.  Version PDF
When working with various versions of a single PDF, such as multiple language versions or
versions containing minor differences, you can use this task to save on output material by:

• Combining a base file with multiple version files.

• Extracting separations or layers from the base file and replacing them by variants.

Combine Base with Version Files
By combining a Base File (the input file) with a number of Version Files, you can create
various flavours of the same file and save on output material.
 

 

You can use wild cards and/or SmartNames to specify folders or files.
 

 

Here's a typical example: Your base file contains graphics and only the CMY separations. Your
version files contain text in different languages in the black (K) separation. By combining the
graphics from your base file with the various language versions, you only need to make the
plates containing the separations for the graphics once.

Follow these steps:

1. In the Version Files table, click Add.
2. In the External File dialog, specify:

• The location of the Version Folder, which contains the version files.
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• The name(s) of the Version File(s), including their file extension.

• The name of the Output File, which is a combination of the base file and a version file.
3. Choose what you want to do with the Version Input File (base file or input file):

• If you want it to remain in the same place, choose Leave.

• If you want it to be deleted, choose Delete.

• If you want it to be moved to another folder, choose Move to and use the  button to
define the new location.

4. Select the desired Reference Page Box. Selecting the correct media box here can prevent
errors, such as double time stamps in the text of a page mark.

5. Determine the Order of the Base File and the Version file.
6. Separation Isolation: Select 'Isolated' to use the PDF construct "Form Isolation" to

combine the files, which will reduce the interaction between the content of the files. This is
helpful when the files contain information for different separations, rather than artwork to
be placed on top.

Note:  You cannot combine Normalized PDF files with other PDF files.

Extract Separations from Input file

This Action allows to extract a separation from the input file and map it to another separation.
This is done to limit the total number of separations for output.
 

 

For example: Map a 'black' Pantone color that is used for text to 'K' (typically black in CMYK).

Preserve Separation Interaction: Use this parameter to define what to do when the
separations you remove contain objects that knock out other separations.

• None: This only deletes knock-out objects that are only defined in the removed
separation(s).
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Use this when removing separations that don't influence the final result (for example die cut
separations).

• Standalone: This converts knock-out objects that are only defined in the removed
separation(s) to white knock-out objects defined in one of the remaining separations. The
remaining separations keep looking the same.

This method is recommended for most use cases.

• For Versioning: This converts knock-out objects that are only defined in the removed
separations to white overprinting objects. Those are defined in a color space made from the
remaining separations of the file, and overprinting on all other separations.

This ensures that when re-adding separation layers for versioning, the final result looks the
same as the original file.

Note:  This may create objects in 'DeviceN' color spaces, which is something that some
applications cannot handle. Only use this method if you want to do versioning on your file.

Extract Layers from Input file

This Action allows to extract layers from the input file and split the input file into a fixed
master and a variant part. The variable ink is often black.
 

 

You can also work with layers to extract the language layer from the input file and replace it
with the corresponding translation(s).

Note:  Work with wild cards to optimize your workflow: For example to only extract the
language layer, use 'lang_*' if you know that all language versions follow this name rule. This
will allow for the lang_EN, lang_FR and lang_ES layers to be automatically extracted from
the base file.
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7.204.  Wait

This task is documented in the chapter Workflows, in the section Inserting Wait Points on page
703.

7.205.  Wait for Action (Checkpoint)

This task is documented in the chapter Workflows, in the section Building Workflows # Inserting
Wait Points.

Find a direct link here.

7.206.  Wait for Approval on Share & Approve

This task is documented in the chapter Integrating with Share & Approve on page 1547.

Find a direct link here.

7.207.  Wait for Files

This task is documented in the chapter Workflows, in the section Inserting Wait Points on page
703.

7.208.  Wait for Files (via JDF)
Use this task when you are working with a JDF RunList, and when the files referenced in the
RunList are not ready yet.

Send the JDF RunList to this task, and it will check at a regular interval if the files are already
present. When it finds all the files, it ends in OK and passes them on to the next workflow task.

Example Workflow
1. The MIS system creates jobs via JDF, and sends the JDF RunList to your Automation Engine

workflow.
2. The Wait for Files (via JDF) task checks if all the files referenced in the RunList are where

they are supposed to be.
3. When the files are ready, the task finds them and passes them on to the next workflow task.
4. The rest of the workflow starts on the files.
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Parameters
• Look in Folder

By default, the tasks looks for the files at the location defined in the RunList. However, you
can here define a custom location where the task should look for them.

Tip:  For example, use the SmartName [URL of Folder of Input] if you know the files
will be end up in the same folder as the RunList.

• Stop waiting when time exceeds ...

Select this if you want the task to finish if the files referenced in the RunList haven't been
found after a specified time.

If you don't select this parameter, the task will wait indefinitely (or until it finds the files).

• Task ends in error when not all files were found

Select this if you want the task to finish with an Error state:

• When the time you set in the 'Stop waiting when time exceeds' parameter has passed,

• and when the task hasn't found the files referenced in the RunList at that specified time.

7.209.  Wait for Product Status

This task allows to hold a workflow until one or more Products have reached a certain status.

This task is documented in the chapter on Products on page 548. Find a direct link here.

7.210.  Zip
This task creates a zip file from the selected input file(s) or folder.

Choose the task's behavior in case the zip file already exists:

• Generate an error

• Replace the zip file.

Learn more in the Unzip Task.
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7.211.  Outdated and Soon Outdated Tasks in this
Version

7.211.1.  Concept of (Soon) Outdated Tasks

Concept
Some task technology in Automation Engine can become outdated after many years. There are
two possible reasons for this:

• the functionality is now available via a new and improved technology. For example a task
based on a new trapping engine replaces the old ones.

• the functionality is no longer used in today's prepress environment. For example a task to
normalize EPF files, an Esko file format that is not created any more.

Such tasks are first declared “Soon Outdated” and later become “Outdated”.

Note:  Before version 14.1, the term Deprecated was used for Soon Outdated tasks and the
term Obsolete was used for Outdated tasks.

Soon Outdated

A task is named Soon Outdated as a warning that it will no longer be available in the next
major version of the Automation Engine.

This gives you at least one year

• to replace this task by an alternative. This could be a newer task equivalent or a slightly
different workflow. The alternative is mentioned in this documentation.

• to contact Esko support in case the proposed alternative is not valid for you.

Outdated

A Soon Outdated task becomes Outdated in the next major version: it is then no longer
available in that software version.

• Customers who never used that task type will not see any tickets.
• Customers who had already created custom tickets of that task type will still see those

tickets but notice that they no longer work.

A Gradual Process with Many Visual Reminders

This two step process gives you the time to switch from using the old technology to the new
version or method.

The Pilot shows you in many places which task types are (to be Soon) Outdated.

• In the Tickets list:
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Also workflow tickets that contain outdated tasks will show a warning:
 

 

• In the task ticket itself, a colored top bar is added. A Soon Outdated task shows an orange
bar and the link for More Info brings you to the online help page that describes the
proposed alternative:
 

 
An Outdated task shows a red color bar and also a link with More Info:
 

 

• In the Workflow Editor. Colored text indicates (soon) outdated workflow steps:
 

 
Transitions that depend on an outdated step are shown in grey. That part of the workflow
also does not work any more:
 

 
These (soon) outdated steps are also mentioned in the Validate Workflow dialog. When
you there select such a warning, the corresponding step will also be highlighted in the
workflow editor with an arrow.
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7.211.2.  Add Parameters for Nesting (Soon Outdated)

Due to the changes in Gang Run Printing module, the Add Parameters for Nesting task will
soon be outdated. Learn more about outdated and soon outdated tasks in Concept of (Soon)
Outdated Tasks on page 488.

This old technology is still supported but no longer commercially available (since v16).

Find a link below to its old documentation.

Alternative

Use the Submit to Gang Run task as a replacement.

Note:  The Submit to Gang Run task does not create an XML file (formerly typically dropped
into a hotfolder). This information is now written directly into the gang run database.

Modify your workflows with the new task. Also convert nesting mechanisms via a hotfolder
into a Substrate queue in the Gang Run Printing view. Learn more in the chapter Gang Run
Printing.

Add Parameters for Nesting (Soon Outdated) - old documentation page

Note:  Learn about the alternative for this task in the above page Add Parameters for Nesting
(Soon Outdated) on page 490.

The old documentation can still be found in older manuals of Automation Engine. Follow these
steps to find it:

• Go to http://www.esko.com/en/Support/Product?id=Automation%20Engine.
• In Select product version, select 14.
• Open the AE Complete Manual.
• Go to the Reference Guide.
• Go to The Tasks and Workflow Controls > Deprecated and Obsolete Tasks > Add

Parameters for Nesting (Soon Outdated).

7.211.3.  Create Nested Layouts (Soon Outdated)

Due to changes in the Gang Run Printing module, the Create Nested Layouts task will
soon be outdated. Learn more about outdated and soon outdated tasks in Concept of (Soon)
Outdated Tasks on page 488.

The Create Nested Layouts task was used to create nested layouts before Automation Engine
offered the Gang Run Printing workflow mode.

This old technology is still supported but no longer commercially available (since v16).

Find a link below to its old documentation.

Alternative
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The functions and settings of this task are now divided over the Substrate settings in the
Gang Run Printing View and the Export Nested Layouts on page 278 task. In the substrate
settings you will find all the sheet specific settings and the nesting parameters. The Export
Nested Layouts on page 278 task holds all the output settings.

Note:  The nesting no longer happens in the task, but as part of a background process
triggered by the nesting server.

Modify the workflows and convert your hotfolder-based nesting into a Substrate queue in the
Gang Run Printing view. Learn more in the chapter Gang Run Printing.

Create Nested Layouts (Soon Outdated) - old documentation page

Note:  Learn about the alternative for this task in the above page Create Nested Layouts (Soon
Outdated) on page 490.

The old documentation can still be found in older manuals of Automation Engine. To find it, go
to

• http://help.esko.com/products/Automation%20Engine
• then, in "Version", select a version older than version 14
• click on the link to the Reference Guide
• go to The Tasks: an Overview > Deprecated and Obsolete Tasks > Create Nested

Layouts (Deprecated).

7.211.4.  Expand Variable Data to PPML File (Soon Outdated)

The Expand Variable Data to PPML File task will soon be outdated. Learn more about
outdated and soon outdated tasks in Concept of (Soon) Outdated Tasks on page 488.

This task was used in VDP workflows and used an older technology (the PPML file format).

Find a link below to its old documentation.

Alternative

Digital printing is a fast-evolving field, and the industry as whole is moving towards the PDF/VT
file standard as a replacement for the older PPML standard. Esko is supporting this trend.

Esko recommends you to migrate to the Dynamic VDP workflow.

The Dynamic VDP workflow is based on PDF/VT and includes a DeskPack plug-in for authoring
as well as an Automation Engine ticket for expansion.

Expand Variable Data to PPML File (Soon Outdated) - old documentation
page

Note:  Learn about the alternative for this task in the above page Expand Variable Data to PPML
File (Soon Outdated) on page 491.

The old documentation can still be found in older manuals of Automation Engine. To find it, go
to

• http://help.esko.com/products/Automation%20Engine
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• then, in "Version", select a version older than version 14

• click on the link to the Reference Guide

• go to The Tasks: an Overview > Deprecated and Obsolete Tasks > Expand Variable Data
to PPML File (Deprecated).

7.211.5.  Expand Variable Data to PPML File (DeskPack Only) (Soon
Outdated)

The Expand Variable Data to PPML File (DeskPack Only) task will soon be outdated. Learn
more about outdated and soon outdated tasks in Concept of (Soon) Outdated Tasks on page
488.

This task was used in VDP workflows started from Adobe Illustrator and used an older
technology (the PPML file format).

This task was documented in the page describing the non-DeskPack version: Find a link in
Expand Variable Data to PPML File (Soon Outdated) - old documentation page on page 491.

Alternative

As mentioned in Expand Variable Data to PPML File (Soon Outdated), the alternative here is also
to use the Dynamic workflow tools. This Dynamic workflow is based on PDF/VT and includes a
DeskPack plug-in for authoring as well as an Automation Engine ticket for expansion.

Expand Variable Data to PPML File (DeskPack only) (Soon Outdated) - old
documentation page
This task is the version of Expand variable Data to PPML file that can be started from DeskPack.

7.211.6.  Print on Digital Press (PPML) (Soon Outdated)

This task will soon be outdated. Learn more about outdated and soon outdated tasks in
Concept of (Soon) Outdated Tasks on page 488.

The Print on Digital Press (PPML) task was used to create variable print jobs on the DFE
server using the format PPML.

Find a link below to its old documentation.

Alternative

Digital printing is a fast-evolving field, and the industry as whole is moving towards the PDF/VT
file standard as a replacement for the older PPML standard. Esko is supporting this trend.

Esko recommends you to migrate to the Dynamic VDP workflow.

The Dynamic VDP workflow is based on PDF/VT and includes a DeskPack plug-in for authoring
as well as an Automation Engine ticket for expansion.
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Print on Digital Press (PPML) (Soon Outdated) - old documentation page

Note:  Learn about the alternative for this task in the above page Print on Digital Press (PPML)
(Soon Outdated) on page 492.

The old documentation can still be found in older manuals of Automation Engine. To find it, go
to

• http://help.esko.com/products/Automation%20Engine

• then, in "Version", select a version older than version 14

• click on the link to the Reference Guide

• go to The Tasks: an Overview > Print on Digital Press (PPML).

7.211.7.  Rip to WS4000 Series (Soon Outdated)

The Rip to WS4000 Series task will soon be outdated. Learn more about outdated and soon
outdated tasks in Concept of (Soon) Outdated Tasks on page 488.

This task was a used to generate JLYT output for a HP Indigo WS4000 press.

Find a link below to its old documentation.

Alternative

Your alternative is to use the more recent Print on Digital Press on page 1452 task. This task
links to the DFE that you configured in Digital Press on page 173.

Rip to WS4000 Series (Soon Outdated) - old documentation page

Note:  Learn about the alternative for this task in the above page Rip to WS4000 Series (Soon
Outdated) on page 493.

The old documentation can still be found in older manuals of Automation Engine. To find it, go
to

• http://help.esko.com/products/Automation%20Engine

• then, in "Version", select a version older than version 14

• click on the link to the Reference Guide

• In the search field, type WS4000. The result will show a link to the task's old documentation.

7.211.8.  Tasks that became Outdated in this Version 20.0

In this version of Automation Engine, these tasks were removed because they became
Outdated (they were earlier announced as "Soon Outdated"):

• Process Remote Proofs. This task was labeled 'soon outdated' in v16.
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Note:  Find its documentation in earlier versions of the Automation Engine manual.

Note:  Learn more about how and when tasks become outdated in Concept of (Soon) Outdated
Tasks on page 488.
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8.  Jobs

8.1.  Job Basics

8.1.1.  The Job Concept

What is an Automation Engine Job?

An Automation Engine Job represents an amount of work to be done for a certain order in your
business system. This can be a classic order management system but it could also come from a
web application that needs Automation Engine to execute some prepress tasks.

A Job is an entry in the Automation Engine Jobs database and has a unique name. In the Pilot,
Jobs are represented by this blue folder icon .

In Automation Engine, a Job consists of 2 things:

• data: files and folders, stored under the Job's Job Folder, in a Container.
• metadata: the parameters of that job order, usually how the order management system

describes this job. They can be general parameters like the job's name, order ID, customer
and due date but can also be parameters describing what to do with the input files to get to
the targeted result.

Jobs can be created manually by an Automation Engine user or automatically via some
integration with an external system.

A Job represents Work In Progress (WIP). This means that you should remove Jobs that are
'done'. Removing a Job from the Automation Engine Jobs database does not mean that you
have to delete the related data files.

Most Automation is based on Jobs

A lot of the automation that Automation Engine brings comes from the fact that tasks can
automatically use parameters from their Job context. Job parameters automatically become
SmartNames and the (workflow) task tickets can use those SmartNames to pick up their values.

Note:  Customers that do not use Jobs at all find a similar level of automation by using
Workflow Parameters. Learn more in Using Workflow Parameters on page 803.

Launching tasks on Jobs

Jobs can be managed manually in the Pilot, but several actions are also possible by launching
tasks.

• The Create Job task task allows to create and modify Jobs.
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• The Check Job Parameters task allows to check and correct barcode and ink parameters used
in designs.

• The Archive Job task and the Restore Job task allow to remove Jobs, store their data on a
different network place and, if needed later, restore them back, including their metadata.

• The Relocate Job task allows to move a Job's Job Folder to a different place. For example to
another Container that has more disk space.

Learn more about these tasks in Tasks you can Launch on Jobs on page 539.

Like all tasks, these tasks can also be triggered by an external system. Learn more in Integrating
with External Systems on page 1553.

8.1.2.  Types of Jobs

Conceptually, we can distinguish several types of Automation Engine Jobs. This categorisation
usually depends on these factors:

• What type of site are you? Does your company only do prepress or do you also produce?
And if you produce, do you also re-produce items that you produced before?

• Is your Automation Engine closely integrated with your order management system? If it is,
then Automation Engine best follows a similar process logic as in that system. Terms like
jobs, orders, products, items, milestones etc. will need to have the same meaning.

We distinguish 3 types of Jobs:

Attention:  The categorization of these job types does not appear in the user interface
of Automation Engine. Their names are only used here to illustrate different ways of
working with the tools Jobs and Products. Learn more about Products in Products on
page 548.

Type 1: A Prepress Job

The goal of a Prepress Job is to make a single one-up design print-ready. Typical steps are
preflight, making print-ready and approval. The result is a file that is ready to be produced.

Some variations:

• The production can then be done in-house (in another Job, under another order number) or
the print-ready file can be sent out to a company that produces.

• The resulting file can be registered as an Automation Engine Product.
• A Prepress Job can result in multiple files, but only when they belong to the same product

item, for example front and back graphics. They probably also share the same approval
cycle.

• At (flexo) prepress houses ('trade-shops'), the result could also be a set of plates.

The Job can be removed when the work is done.

Type 2: A Production Job

A Production Job is a job that uses one or multiple product items for a specific production
run. The product items were already approved and print-ready. The goal of this type of job is
output.
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A Production Job does not contain the one-up's data in its job folder, but links to one or
multiple Products. The job folder of a Production Job typically only stores the layout files or
other data that are unique to this specific production order. The product data stay in their
Product Data Zone.

The Job can be removed when the work is done. The Products are not removed, they stay 'live'
until a next Job links them in for another production run.

Type 3: An All-In-One Job

Some customers have Jobs in which they handle both the prepress work and the output
production. The one-up data is stored inside the job folder, not registered as a Product and the
workflow continues within this Job with the productions steps (layout, plates, send to press...).
Production related data is also kept inside this job folder.

In some cases, when the output is combined with other (already existing) items, this can mean
that the one-up data is copied from other (older) jobs into in this job folder.

The Job can be removed when the complete work is done.

Attention:  In this chapter, we will describe the use of Jobs without the use of the
Products tool.

8.1.3.  The Job Views

General Job Views
The Pilot and its Views were introduced in The Pilot's Main Window on page 76. We here
illustrate some job-related specifics:
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1. Type of View.

• The  Containers view shows the folder structure of your Containers but will show a
folder in blue when it is an active Job Folder. Double click any blue folder to select and
view that job.

• The  Job Overview shows all jobs (or a filtered list). You can combine this with Smart
Views.

• The  Last used Job view opens the last used job in the job specific view.
2. Info. This button opens the Job Setup of the selected job. Learn more in Job Setup

Parameters on page 504.
3. Search input field. Learn more in Job View Filters on page 499.
4. Job Overview. Define the columns and their order in View >  Select Columns in 'Jobs'....
5. Job Details. See some of the job's details. Learn more in Job Setup Parameters on page

504.
6. Amount of Jobs (selected).
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Note:  When you open the drop-down list, you can select another job that you recently used.
You can set the amount of remembered jobs in Edit >  Preferences >  Pilot.
 

 

Tip:  If you regularly switch between same views, consider using multiple view tabs (File >  New
Tab). For example:
 

 

Job View Filters

Basic Searching
When you type in a filter in the Search input field, the filter will be looked for in All of the
default attributes Order ID, Name, Project ID, Customer Job Reference.
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Tip:  You can use double quotes to restrict the search. For example

• FL 123 will list jobs that have both FL and 123 in at least one attribute.

• "FL 123" will only list jobs that have this exact string in at least one attribute.

Click Save to save this search. Decide if it is for all users or only yourself and if you want to add
it to your views bar.
 

 

Advanced Searching

If you want to search in other attributes, or if you want to create advanced search criteria, click
on the + button. A new search criterion appears.

See how the attributes drop-down list offers many more attributes:
 

 

In the drop-down list, select Other... to add even more attributes to this list. For example
Customer name.

Use the + button to continue adding search criteria. For example:
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You can even add 'logical operators' to your criterion. Hold Alt when clicking on the + to start
your criterion with All, Any or None. See this example where you are not sure which CSR
handles this job order:
 

 

Click Hide Criteria to hide the lines with the criteria but still have them active.

As shown above, you can save the (set of) search criteria. You can re-use it later as a Smart
View or pick it from the drop-down list in the search field:
 

 

Job Specific View
When you select a job from the drop-down list of last used jobs, or when you double click a
blue job folder, the view adapts and focuses on that job.

• The Pilot top bar mentions the name of the selected job.
• The Last Used Job drop-down list mentions the name of the job folder.
• The Folders pane shows the (blue) job folder, its subfolders and their files.
• The Tasks pane shows the tasks that were launched in this job context.
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• The list of favorite tickets also shows (blue) job tickets (saved for this job only).

 

 
All tasks that are launched in this view will run "in this job". Job-based SmartNames will now get
their values from this job.

8.1.4.  The Job Menu

Note:  When no job is selected, some of the menu options are unavailable.

• New Job.... Learn more in Creating a Job on page 503.

• Go to Job. When a job is selected in a list, use this to go to that job ('open' the job).

• Job Setup.... This opens the Job Setup dialog of the selected job.

• Find Job.... This opens a separate dialog to search for jobs. Learn more in Job View Filters on
page 499.

• Relocate Job. This moves the job folder of a (live) job. Select the ticket of the Relocate Job
task. Learn more in Tasks you can Launch on Jobs on page 539.

• Remove Job.... This removes the open or selected job(s) from the jobs database. You will
be asked to confirm and you can choose to keep the files and folders. Learn more about
removing multiple jobs and re-creating them in About Removing Jobs on page 537.

• Delete View Data.... This deletes all View Data present in the job folder. View data are
stored in hidden subfolders of files that were prepared for viewing in the Automation Engine
Viewer. You will be asked to confirm. You can choose to Also unmark subfolders that are
marked for Speed for Viewing. Learn more about this feature and View Data in Prepare for
Viewer Task on page 1005.

• Manage Job Filters.... This opens a dedicated dialog to manage job filters. Learn more in
Job View Filters on page 499.
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8.2.  Creating a Job

You can create jobs manually or they can be created automatically.

Creating a Job Manually

To create a job, you can first select an existing folder that will become the job folder, or you can
have a new job folder created while you create the job. Follow these steps:

1. In the Pilot, choose one of these methods to create a new job:

• go to Job > New Job...

• right-click (on an existing folder) and select New Job...

• click the Create Job icon 

• (select a folder and) use Ctrl + Alt + N  (Windows) or Cmd + Alt + N  (Mac).

2. In the New Job dialog, decide if you want to use an existing job as a template.

• If you don't use a template, click OK and fill in all the parameters in the next dialog.

• If you want to an existing job as a template, select it and decide which type of
parameters you want to include from that job in your new job. Then click OK.
 

 
The job you use as a template could be a job that is similar to the new one (for example
the 123-lemon job has many same attributes as the 234-banana job). It could also be
a job that you specifically created to be used as a template (the typical 'flexibles' job for
example).

The status, actions and confirmation dates of the milestones in the template job will not
be added to the new job. Their due dates will be relative to the creation date of the new
job. For example: you want the new job to also get the milestone 'proof ready' 2 days
after it was created.

3. A dialog opens with the Job setup. Now you can fill in all the parameters for the job.

If you started from an existing folder or used a template, several parameters will already be
filled in.
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Learn more in Job Setup Parameters on page 504.

Creating Jobs Automatically

In most cases, the Automation Engine Job originates in another system. Recreating that job
manually in the Pilot is not an efficient way of working. It is strongly advised to integrate
Automation Engine with that other system and so have the jobs come in automatically. This will
both win you time and reduce errors.

This integration can be based on an incoming file that describes the job or could be a bi-
directional link with that external system. In both cases, the Create Job task on page 1630 task
will create the Job in background (probably as part of a workflow task). Such an automated
workflow can also update Jobs with new or changed parameters.

Learn more in Integrating with External Systems on page 1553.

8.3.  Job Setup Parameters

You can fill in the job setup parameters while creating a job, or, when you are in a job context,
by going to Job > Job Setup....

In an existing job, you can add or modify parameters at any time, except the Order ID and
SubOrder ID. Learn more in Job tab on page 505.
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The parameters are spread over multiple tab sheets. The tab sheets Automation, Page
Assignment and Imposition only appear when you are using the module for page workflows.

Most job parameters are automatically offered as Job SmartNames. Learn more in SmartNames
on page 591.

The button Apply Job Setup... allows to copy parameters from other jobs. Select the job and
define which type of parameters you want to include from that job.
 

 
This is similar to how you can use a template job at the moment of job creation. Learn more in
Creating a Job on page 503.

8.3.1.  Job tab

The Job tab contains the main job order information:
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Thumbnail: When there is no thumbnail yet, it will automatically be set when one of these
tasks finishes with success: "Normalize PDF", Normalize PostScript / PDF / Illustrator 8.0 File" or
"Export ArtPro to PDF". To set the thumbnail manually, right-click the field and select a file (that
has a thumbnail embedded).

Order ID: order management systems typically define a job order by an identification number.
This is a mandatory field.

Caution:  You can not change it once the job is created.

SubOrder ID: often, a job order also has a sub number (or text). You can leave this field blank.

Caution:  You can not change it once the job is created.

Important:  An Automation Engine job needs to be unique. More specifically, the combination
of Order ID and Suborder ID needs to be unique.

Job Name: this is the name that you see in the job overview lists. This is a mandatory field. If
you do not enter a name here, the name will be "OrderID_SubOrderID".

Important:  Also the name of the job needs to be unique.

Note:  You can change the name after the job was created.

Note:  The job name will also be proposed as name for the job folder. Learn more below.

506



8Automation Engine

Description: a short text describing the job order. By using its SmartName version, this text
can for example also be picked up in a report PDF.

Due Date: the due date and time for this job order. This date is used in job filtering and also in
several tasks that allow choosing the Job Due Date as one of the choices for the task due date.
For example the Submit to Gang Run on page 929 task and the Publish on WebCenter task on
page 1533 task.

Project ID: the identification number of the project that this job order belongs to. Project
numbers are typically defined by the order management system or any other external system.
This parameter can be useful to find jobs that belong to a same project. This parameter can
match to a project on WebCenter.

Category: choose a category from the list. Categories are often used to help you find jobs or to
define the route of a workflow. Click the button Categories... to add new categories manually
or by loading a list from an XML file.

Note:  The format of the XML is for this use not specific. Most important to know is that only
the values will be loaded to become category names, not the element names. An example:
 

 

You can add more custom categories. Two are offered in this tab sheet: Custom Field 1 and
Custom Field 2. You can set four more in the tab Categorization. You can configure their
custom names in Configure - Jobs - Job Setup. See an example in the above screen shot.

Tip:  In the page about the tab Categorization, you can find a table with matching names of
categories, custom fields and their SmartName versions.

Last Actor: the last Automation Engine user that worked with this Job (launched a task,
opened a file). This is filled in automatically but you can set it manually too.

Job Folder: define the path of the job folder for this job. You can choose one of these methods:

• browse to an existing folder (somewhere in one of your containers).
• browse to the root of where you want to create the new job folder and click . By default,

the Job Name will proposed as name for the job folder. You can change that if you want to.

• Use the Smart Job Location defined in the Configure Tool: when this toggle is selected, the
location and name of the job folder will be calculated based on a job parameter or on the
default location for that customer. A preview of the folder's location and name can be asked
by clicking the Show Job Location button. Learn more in Smart Job Location on page 195.
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Tip:  The browse button can also be used to relocate an existing job folder. When you here
change the path of an existing job folder, you will be asked if you want to move or copy the
data to the new job folder.

8.3.2.  Customer tab

Customer ID: click Select... to open the Select Customers dialog. Choose one or add a new
customer. Learn more about creating customers in Customers on page 138.

Customer Name and Customer Description: these fields will be filled out automatically after
selecting a customer.

Customer's Job Reference: this is how your customer refers to that job, how they named
it (initially). When communicating with your customer, he will appreciate if you mention this
name (as well). You can for example add this name as a SmartName to a report PDF or add it
to a name of a file that you send him.

Customer Service Representative (CSR): select or type the name of the person in your sales
or service department who manages this customer account.

The E-mail address of the CSR that you selected is automatically displayed if it was used
before. You can also enter the E-mail address manually.

You can click the Contact... button to open an E-mail message with that E-mail address in the
To field (if an E-mail client is configured).

Tip:  All these parameters

• can be used to filter or search for a job.
• can be entered via XML/JDF/JMF. It is strongly advised not to re-enter these admin data

manually. Learn more on how this can be done in Integrating with External Systems on page
1553.

• exist as System SmartNames.

8.3.3.  Inks tab

This tab sheet allows to store ink specifications for this job.
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What you enter here serves as a minimal requirement for this job. This means that you can
for example only enter the angles for a specific set of ink names and leave all other fields or
columns blank.

As with most tab sheets, you can enter this data manually, copy these parameters from
another job (see the button Apply Job Setup...) or get them from an XML when using the
Create Job task on page 1630.

Use cases

Job ink parameters can be used in these cases:

• When you import design files, the task Normalize PostScript / PDF / Illustrator 8.0 File on page
336 offers to enforce these job ink parameters in the output file.

• In PackEdge or ArtPro, when you open a file that is located in a job folder, the editor will
check if the file's inks match the job ink parameters and show a warning when they don't.
You can also use the Load Job Parameters feature in the editor's Inks dialog to enforce the
job ink parameters.

• When you use the Check Job Parameter task, you can check and or modify the attributes of
the inks in the file.

• In page workflows, when you use the Variant Setup in the Imposition tab, the job's inks will
be used.

Note:  A job can only have one set of ink parameters.

Preferred Ink Book: When you then type an ink name in the table, Automation Engine
searches for the ink in your preferred ink book first. For example, if you type 154 as ink
name, and your preferred ink book is Pantone Colors Uncoated, Automation Engine will
automatically suggest the ink PANTONE 154 Uncoated .

Printing Method: You can set a printing method per ink. The list shows those defined in the
Configure tool.
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These are typical examples of how to make use of a Printing Method:

• In your Imaging Engine (RIP) task for a flexo device, you select only the inks of printing
method 'flexo'.

• You make a special ReportMaker PDF that focusses on the 'ink' used for embossing. In your
workflow, you use the Extract Inks task to select the wanted ink type before you start the
ReportMaker task.

Some tips on editing the ink list

• To start, click in the empty canvas under the column Ink Name and type in an ink name. For
example 'C'.

• You can define specify ruling, angle and dot shape per ink name or use the buttons at the
bottom of the tab sheet to specify them for all inks.

• Ruling uses the unit as defined in Edit >  Preferences... >  Units.

• To change all fields in a column with a same value, double click the column header (valid for
Ruling, Angle or Dot Shape).

8.3.4.  Parameters tab

This tab allows to store two types of job parameters:

• custom job parameters, with a name and value that you decide. They will also appear as a
SmartName.

• FlexRip/Proof job parameters. This is an older technology that allows enforcing job
parameters into the FlexRip or FlexProof task tickets. Learn more in FlexRip/Proof Job
Parameters on page 512.

Note:  With Imaging Engine, this concept is replaced by the use of SmartNames.

These job parameters can be created

• manually. Learn more in Creating and Modifying a Custom Job Parameter on page 510.

• by loading values from an XML file. Learn more in Loading Job Parameters from an XML File on
page 511.

• by using the Create Job task, where you use the (XML) input from an external system. Learn
more in Create Job task on page 1630.

Creating and Modifying a Custom Job Parameter
Use the buttons Add..., Modify... and Remove to manage your custom parameters manually.

Follow these steps to add a custom job parameter:

1. Click Add... to open the Add Job Parameter dialog.
2. Choose the Scope 'General'. Learn more about the other Scopes in FlexRip/Proof Job

Parameters on page 512.
3. Type in the Name and Value and click OK.

The SmartName version will be created automatically. To easily recognize which SmartNames
are job specific, their name starts with [jp. ] .
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Loading Job Parameters from an XML File
If you have an XML file that contains the custom job parameters, you can create them
automatically by loading them into your job setup:

1. In the Job Setup tab Parameters, click Load....
2. In the Load Job Parameters from XML dialog, click Browse and browse to your XML file.
3. Click OK. You now have a custom parameter for all value pairs the XML contains from the

root node. All elements and their values will be imported.
An example result after loading the XML file:
 

 

Tip:  If you have long parameter lists, you can use the search field to help you filter them.
The value is checked in Scope, Name and Value.

Job parameters also become SmartNames. See the automatically created SmartNames of
these custom job parameters (for this job '1236'):
 

 
Learn more about using SmartNames in SmartNames on page 591.
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FlexRip/Proof Job Parameters

Creating Job Parameters for FlexRip or FlexProof
1. Click Add... to open the Add Job Parameter dialog.
2. Choose the Scope of a specific type of FlexRip or FlexProof.
3. Check the parameters that you want to enforce during RIP'ing and define their value. For

example:
 

 

Click OK. The job parameters for this type of FlexRip/Proof will be added as one line.

Using Job Parameters for FlexRip or FlexProof

When you now select a file in that job and open a task ticket for that particular FlexRip/Proof,
you will see fields that are marked by an orange icon . These are fields that are overruled by
the job parameters.

For example:
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Note:  With Imaging Engine, this concept is replaced by the use of SmartNames.

8.3.5.  Bar Codes tab

In the Bar Codes tab you can create parameters for multiple bar codes of different types.

Tip:  One file can have for example a retail bar code and also a general purpose bar code that
will be used for a filling station.

As with most tab sheets, you can enter this data manually or get them from an XML file when
using the Create Job task on page 1630.

Tip:  When selecting a bar code, the specified parameters are shown in the Details area.

Similar to the Inks tab on page 508, these parameters can be used to enforce their
parameters into the bar codes of the job files that you opened in PackEdge or ArtPro. Also
here, the Check Job Parameter task can be used to check or correct the bar codes in the files
versus the parameters you specify here.

See this example where the job parameters are enforced  into the bar code in PackEdge:
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We now briefly describe the available parameters. We refer to the documentation of your editor
for more details.

Type

Selecting a Type is a mandatory choice.

Note:  When you define more than one bar code, the checking mechanism with the editors
and the Check Job Parameter task will recognize the type of bar code and check accordingly.

Sub Type

Some bar code types offer sub types. For example a Datamatrix code.

Code

The validity of the code is not checked here. This is done in the editors.

Composite Code

A Composite Code is a 2D symbol placed on top of a GS1 barcode, that encodes extra
information (batch number, expiration date...).

Output Resolution

Enter the resolution (in ppi) that you will use to RIP your bar code. This parameter helps
preventing unwanted levels of rounding in the bar width. )
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Bar Width Reduction (BWR)

Use this parameter to adjust the width of the bar code bars, in order to compensate for ink
bleeding when printing on your substrate.

Your printer or customer will usually provide you with the value to use. For example if your
printer tells you that the line width will increase by 0.01 mm, you should use a Bar Width
Reduction value of 0.01 mm.

Important:  This field expects a value in millimeters (mm).

Important:  If you use a comma as a decimal symbol, it will be replaced by a dot.

Tip:  You can enter a negative value if you want to print thicker and not thinner bars.

Device Compensation

Use this if your printer gave you a separate device bleed value. This parameter adjusts the
bar's width to compensate for bleed caused by the plate or film making process.

Important:  This field expects a value in millimeters (mm).

Note:  If you use both a Bar Width Reduction and a Device Compensation value, the
software will add them together to adjust the bar's width.

Tip:  You can enter a negative value if you want to print thicker and not thinner bars.

Narrow Bar

This parameter determines the width of the narrowest bar of your bar code (and affects the
width of your bar code proportionally). For GS1 bar codes, this affects the size (height and
width) of your bar code proportionally.

Magnification

Use this parameter to increase or decrease the bar code size proportionally. For example:
enter 1.25 for a magnification of 125%.

Important:  The value needs to be between 80% and 200%.

Ratio
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The Ratio is the factor between the width of the narrowest bar and the width of the widest bar
in your barcode. For example, enter 3 if you want your widest bar to be three times as wide as
your narrowest bar.

8.3.6.  Step&Repeat tab

Specific JDF
This tab with Step and Repeat parameters is only useful in a workflow where you receive
a JDF from an external system that describes the Step and Repeat via “JDF for Stripping for
Packaging”. Such a JDF will not only create the job but also store those specific Step and Repeat
parameters in this tab.

These parameters also become job parameter SmartNames and can so be picked up by Step
and Repeat tasks. They will appear as [jp.steprepeat. ].

Note:  The task Import JDF Step & Repeat on page 315 uses the JDF itself as input. In that case
the values shown here are just informational and the task does not use SmartNames.

Also via XML?

Step & Repeat specifications can also come from external systems via an XML file or database
queries or HTTP calls. In such cases, these parameters do not end up in this tab sheet and they
also become other types of SmartNames. Learn more about this in Integrating with External
Systems on page 1553.

Manual entry

You can also enter values manually here but that usage is not different than when you would
add them in the custom Parameters tab sheet.

8.3.7.  Categorization tab

Attention:  This tab only appears if you created custom categories in the Configure tool
(see further).

The Categorization tab allows you to manage up to four extra custom Job Categories (you
already have three category fields in the Job tab).

You can use these custom categories as extra ways to search jobs. And you can also use their
SmartNames in task tickets.

Creating and modifying a Custom Category

Go to Tools >  Configure >  Jobs >  Job Setup and type the name of custom category.

Managing their Values
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To manage the list of values you can choose for each category, click the corresponding
Manage... button, and add or remove items to the list. In this dialog, you can also load lists of
items from an XML file by clicking Load....

Overview of Custom Categories and their SmartNames

Because there is already 1 standard Job Category, the number of your custom categories will
be 1 higher. See this overview:

Table: Names of custom Categories

name of Job setup
tab

name of category in
Job setup

custom field number name of SmartName

Job "Category" / Job Category

Job name you gave custom field 1 Job Category 2

Job name you gave custom field 2 Job Category 3

Categorization name you gave custom field 3 Job Category 4

Categorization name you gave custom field 4 Job Category 5

Categorization name you gave custom field 5 Job Category 6

Categorization name you gave custom field 6 Job Category 7

8.3.8.  Advanced tab

This tab sheet offers a feature to automatically start a task or workflow when you create or
update a job that uses this job as a template.

Caution:  This is an old feature. Please check below for the alternative ways to reach
the same goal.

If you wish to use this, check the toggle and select the Task Type and Ticket Name.

When is a job updated?

A job is updated in these cases:

• when the JDF that created the job is sent again to Automation Engine. Learn more about JDF
in Integrating with External Systems on page 1553.

• when a Create Job task is launched again on the same job.

When is this feature useful?

This feature can be useful when you have jobs that are created automatically via JDF without
the automatic launching of tasks at that moment. Your JDF can then specify that a job needs to
be used as a template. And that template job can have this parameter active to launch a task.

Alternative methods

There are other ways to launch a workflow in a job that was just created or updated.
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The Create Job task on page 1630 can

• be part of a workflow, so right after this step where the job is created your workflow
continues with more steps.

• can be started automatically by an Access Point. Learn more in Access Points on page 1561.

• also has a tab sheet with this same feature. Learn more in Create Job task on page 1630.

8.3.9.  Automation tab

Note:  This tab is only offered in page workflows.

The Automation tab offers tools to automate your page workflow. When a certain job related
event happens, a specific task can be launched automatically, which then can lead to a next
status in the workflow.

You can do this for Normalization, Proofing and Exposing.

 

 

• Choose how you want to normalize the file when a page is delivered. Select a single task
or a workflow.

• Choose when you want to launch a proofing output task: when a sheet side, a variant or
an imposition is complete. Select a task.

• Choose when to expose your job: when a plate, a separation set or an imposition is
ready (complete and approved if required). Select a single task or a workflow.

8.3.10.  Page Assignment tab

Note:  This tab is only offered in page workflows.

This tab offers settings to automate the assigning of incoming PDF files to Page slots.

Learn more in Page Assignment via Naming Convention.

Learn more about the Pages tool in Working with Pages.
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8.3.11.  Imposition tab

Note:  This tab is only offered in page workflows.

• Variant Setup

When working with variants, this allows you to select the correct use case and variant
separation from the list. Learn more in Variant Setup, a section of Working with Plates.

• Output prerequisites

These settings allow you to decide when a separation can be considered as being ready.

• When no page is rejected: This is called "implicit approval". The plate status in the
Plates View will indicate 'ready for ripping' if all the pages of the plate are assigned and
if no page is rejected. When a page for that plate is unassigned or rejected, the output
task on a plate will fail.

• When all pages are approved: This is called "explicit approval", it is more strict than
"implicit approval". The plate status in the Plates View will only indicate 'ready for
ripping' if all the pages of the plate are approved. When not all the pages on that plate
are approved, the output task on a plate will fail.

Learn more in Task status information.

Learn more about the Plates tool in Working with Plates.

8.4.  About Job Folder Location

8.4.1.  General Note on Data Structure

Automation Engine allows you to choose your own data structure

As mentioned in "Containers (an Introduction)", Automation Engine will work with the data
structure you have.

This freedom also brings requests for advice on what data structure could serve your specific
needs the best. The more you learn about the available tools ( Jobs, Products, SmartNames,
Workflow Parameters etc.) the more you will learn what is (no longer) important in that data
structure.

Historical View on Data Structure

Before there were workflow automation servers like Automation Engine, prepress managers
built up their own logic in the prepress data structure. Prepress operators browsed many
folders in the network to open a file in their workstation editor and then saved it again, often
with a changed name.
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Very typical was the habit to write information about the files into both their name and their
location. For example: a final version was named "name_final.pdf" or written in a folder
"Final". Or a file was named "lemon_c_m_y_k_pms123.pdf". Or when the job was ready to
be archived they moved the whole job folder to a share "For Archive".

Then came workflow servers like Automation Engine where the information is (automatically)
stored in database fields. And the user can see information via a dedicated interface: the Pilot.
You can for example list all jobs of the category "NON-FOOD" or you can use the "i" button to
see the PDF's inks (XMP metadata).

Does this mean that the data structure and the file naming is less important than before? No,
actually the opposite is true.

Why is it still Advised to have a Logical Data Structure?

There are two main reasons why a logical data structure is more important than ever:

• for the people that do not use the Pilot.

Are there non-prepress users looking directly at your prepress data structure? If those
people are not using the Pilot interface, they will still want to get information from the
location or from the name (like in the 'old days').

Note:  We advise to check if those colleagues will not prefer to install a local Pilot and
benefit from that information-rich view. Remember you can use User Access Rights to limit
heir access. And they could even benefit from using the Viewer.

• for external systems that look at, use or deliver the data.

What other systems are looking at your data structure or at files that come from there?
What systems send you data into that data structure?

The integration of Automation Engine with many other systems is the main reason that your
data more than ever needs to be well structured and named. Learn more in Integrating with
External Systems on page 1553.

For these reasons we advise to:

• investigate thoroughly what data structure will serve your needs and those of the system(s)
you (will) integrate with. This includes avoiding copied data.

• use all the tools that can automate the creation of those folders and file names (templates,
SmartNames, Smart Job Location etc.).

8.4.2.  FAQs on Job Folder Location

Can I Move a Job Folder?

As explained in The Job Concept on page 495, a job is a temporary object. But even during its
short life time, it can happen that you want to move the physical data to another place in the
network.

In this case, it is very important that you use one of the tools in Automation Engine to do this. If
you use the OS tools (Windows Explorer, Mac Finder etc.), Automation Engine will not be aware
of this move and its database field for the job folder will still refer to the old path.
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You can relocate a job folder

• manually, one by one. By using the browse button in the Job tab on page 505 of the job
setup. You will have the choice to move or copy the folder.

• by using the Relocate Job task. You can launch this task on multiple jobs (for example on a
smart filtered selection).

Can I Rename a Job Folder?

To rename a job folder you can use the same manual relocation tool as mentioned above.

1. In the Job tab of the job setup, in the field with the job folder path, change the name of the
folder.

2. Click OK. The resulting dialog offers a choice on what to do with the original folder and files.
 

 
3. Make your choice and click OK.

What happens when I Remove a Job Folder from a live Job ?

When Automation Engine can not access the job folder of a job that you are trying to open or
use, a warning dialog will mention "Could not retrieve the list of files". The Pilot will show
the job folder in yellow.

This is the same warning that you will get when there is network problem and Automation
Engine can for example not access a complete Container.

When Automation Engine can again access that folder again, with the place and name it was
expecting, the job folder will again be shown in blue and ready for use.

Note:  In the Configure tool, there is a feature that allows to remove all "dangling jobs" (jobs
that have no more link to their job folder). Learn more here.

8.4.3.  Good Practices regarding Job Folder Location

Creating all your job folders under 1 same root folder can result in a slow Automation Engine
Pilot and even slow tasks. We advise not to do this.

Here is an example setup that certainly causes too many subfolders in one same folder:
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To keep your system healthy, it is good practice to use subfolders in your data structure.

Here is some advise on what logic you could use to decide that data structure:

About using Subfolders per Customer Name
We do not advise this, mainly because customers tend to change their names. It looks like a
good idea at first, but Esko has seen many customers migrating away from this structure.

About using Subfolders per Customer ID
We do not advise this. It is true that using a customer ID is more stable, but it also has some
disadvantages:

• That customer ID number is often meaningless to the Esko users.
• Because legal regulations may require your company to keep track of order history, it is

possible that old customers may not be deleted in the business system. That is why, when
your customer changes his name, some business systems then change the ID anyway.

• Another reason to not base your folders on customer ID is that customer companies also
merge.

These reasons show that we again face the same issues as when we use the customer's name.

About Using Subfolders per Type of Job Order
We do advise to base a data structure on types of jobs.

If you have prepress orders (creating and getting a one-up print ready) and production orders
(outputting existing approved data), then structure them in separate folders or even different
Containers.

Or you can use the product or production type: labels, carton, digital, flexo, offset etc. A typical
way to set this up is by using the SmartName of a Job (custom) Category.

About Using Subfolders per Order Range
We do advise to create a data structure where you split folders based on the job's Order ID.

For example: all jobs in the 1000 range in one folder, all jobs in the 2000 range in the next
folder, etc. This is a straight forward structure that will not allow more than 1000 subfolders in
one folder. Use String Extract SmartNames on page 624 to set this up.

This is considered to be the best practice.

For example:
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Note:  All these principles also apply to folders where you store Products (Product Data Zone).
Learn more in the dedicated chapter on Products on page 548.

8.5.  Uploading Files to Jobs

There are many ways to upload files onto a job folder.

• Manually:

• using the Pilot

• drag and drop files or folders from outside the Pilot onto a job (sub)folder in the Pilot.
Or use copy/paste shortcuts.

• right-click a job (sub)folder and choose Upload Files.... Learn more here.

• right-click a job (sub)folder and choose Upload Files from FTP Site.... Learn more
here.

• using Shuttle, as start of a workflow in this job. Learn more here.

• Automatically:

• from Access Points on page 1561. Any of the 5 types of Access Points can upload data
to a job (sub)folder (and launch a workflow). The Folder Access Point can also be a
subfolder of the job folder. Learn more in Integrating with External Systems on page 1553.

• using the Download WebCenter Document task on page 1541. When your Automation
Engine is connected to a WebCenter, this task logs on to WebCenter and downloads
documents from a specified WebCenter project. Learn more in Integrating with WebCenter
on page 1526.

• from WebCenter,

• by synchronizing the WebCenter project with an Automation Engine job. When
a WebCenter project has a workflow connection with an Automation Engine
job, documents can be copied to that job when synchronizing. Set this up in the
Configure page of the WebCenter project.

• by using WebCenter's Sync Workflow task in a WebCenter workflow. Learn more in
the WebCenter documentation.
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8.6.  Milestones: Tracking Job Status

8.6.1.  Concept

Milestones represent important moments in the life of an Automation Engine job. Each job has
at least one Milestone: the moment it was created. You can add Milestones, predefined ones or
custom ones. Each Milestone has a due date and several other attributes (see below). The goal
of a Milestone is that is gets confirmed.

Note:  The Job Due Date that you set in the job setup is not automatically created as a
Milestone.

A Milestone has these attributes:

• a Name. For example "Approved".
• a Due Date. This is the time that this Milestone is expected to be confirmed. It could

represent when deliverables are expected (plates, print production, shipping, invoicing). Or
it could stand for the time an action is expected to be finished, for example "Approved" in 3
days.

• a status. Users can decide on the status Confirmed or not (still "pending").
• a set of Actions. You can optionally attach Actions that need to be done to get that

Milestone confirmed.
• a Responsible user.

Milestones can be created and managed

• manually, by a user in the Pilot.
• by copying them from a template job (manually or via the Create Job task on page 1630).
• by the Manage Milestone task.
• by an external system, using JDF/JMF. Learn more in Integrating with External Systems on page

1553.

How can you Use Job Milestones?

Milestones can be used

• as the basis for status feedback to external systems. This is the main reason to invest in
setting up and using Milestones.

Automation Engine focuses on reporting what happens with a job but not on job
organization or job distribution: that is the task of the order management system. What
is important is that Automation Engine reports back to such systems and that this ideally
happens without manual intervention of prepress users (who have other things to focus
on). Learn more in Informing Other Systems of the Milestones Statuses on page 536.

• in the Pilot,

• when filtering jobs. For example you want to remove all jobs that have a milestone
"Finished" confirmed more than 2 weeks ago.

• as visual help when tracking the status of jobs.
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8.6.2.  The Milestones View

This view is different when you are using it in the Job Overview mode or in the Last Used Job
mode.

Both these views use these icons for different milestone statuses:

•  indicates the time the job was created.
•  indicates the current time on the time line.
•  indicates a pending milestone (not confirmed).
•  indicates a selected milestone.
•

 indicates an overdue milestone: the current time is later than the due date of the
(pending) milestone.

•  indicates a milestone that contains one or more Actions that are not all completed.
Learn more in Working with Milestone Actions on page 531.

•  indicates a pending milestone of which all Actions are completed.
•

 indicates a confirmed milestone. A milestone must be completed before it can be
confirmed.

In Job Overview Mode
When you are in Job Overview mode, you can see all milestones of a (filtered) list of jobs.

The Milestones view offers two types of overview.

The Timeline View

The Timeline View  shows you the milestones for a defined period.
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Use these buttons to define the time period you are viewing:

•
 to show 1 day, 7 days, 14 days or 31 days.

•  to show the previous week, previous day, the current day, the next day or the
next week.

From the menu Milestones, use Go to Date... to specify a specific date in the center of your
view.

Select a milestone to see Milestone Details in the bottom pane.

Tip:  When hovering over a milestone icon, you will see its name and more details:
 

 

Tip:  Double click a milestone icon to open the milestone view for that specific job.

The Status View

The Status View  shows the milestones and their status in columns.

 

 

Go to View > Select Columns... to choose which milestones will be shown here and to define
the order of these columns.
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If no icon appears in a milestone column, this means that this milestone is not defined for that
job.

In Job Mode
In Last Used Job mode, the Milestones view shows all the milestones for a specific job.

 

 

Select a milestone to see it selected in the time line and to see details below about any actions
for this milestone.

Printing out the Job's Milestones

You can use Milestones >  Print Milestones... to print (or save to PDF) a view of a job's
milestones. You can define the printer's page format but the content of the page is fixed. The
page shows some major job info and the milestones' timeline and overview.

An example:
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Note:  The thumbnail of the job shown in this printout is the one you can (manually) add in the
Job tab sheet of the job setup.

8.6.3.  Adding Milestones to a Job

Adding a Milestone Manually

1. Select your job and open the Milestones view.
2. Click , or go to File > New Milestone.

 

 
3. From the Milestone Name list, select the milestone you want to add to this job. If the one

you want is not yet in the list, click Manage... and create it there. Learn more in Manage
(Custom) Milestones on page 529.

4. If you want, add a Description for your milestone.
5. Define a Due Date and time. This is a mandatory field.
6. If you want, add a Reminder. Choose an absolute time or a time relative to the due date. At

that time, a reminder will be E-mailed to the Responsible user.
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7. Select the user that is Responsible for this milestone. This is a mandatory field when you
set a reminder.

8. Click OK.

Copying the Milestones from another Job

When you create a new job (manually or via the Create Job task on page 1630 or via JDF),
you can copy the properties of another job (template) to that new job. This can include the
milestones of that other job.
 

 

The copied milestones will be set relative to the creation date and time of the new job.

For example, a typical job for your customer FruitCo has a job due date of 9 days after job
creation and during that period it includes 3 custom milestones. The due date of the new
job that copies those milestones will then be set to 9 days after its creation date. And its
milestones will be created relative to the new creation date.

8.6.4.  Manage (Custom) Milestones

There are many predefined milestones, but you can also create custom milestones.

In the Milestones view (in Last Used Job mode):

1. Go to Milestones > Manage Milestones. This dialog shows you all your milestones and
their attributes:
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2. Click the Add button.

 

 
In this dialog:

• enter a Name for your custom milestone.

• you can also enter a Nickname, this is the name that will be shown in the Pilot interface.
This is also useful when your milestones are managed by JDF/JMF. Learn more in
Integrating with External Systems on page 1553.

• if you want, choose a Color and / or browse to an Icon to help recognize this milestone.
Icons can be based on JPEG/PNG/GIF files and will be automatically scaled to a fitting
resolution.

• you can also enter Comments. For example to explain all users how this milestone
should be used or if an external system is using this milestone information.
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• if you use the Products on page 548 tool, define if this milestone can also be used as
Products status.

• click OK. Your custom milestone now appears in the list and is ready to be added to
jobs..

Note:  You can safely remove milestones that you already used in jobs. Those jobs will not
loose their (local copy) of the milestone.

8.6.5.  Working with Milestone Actions

Concept

A milestone represents a status that you want to reach. A milestone can also list what Actions
need to be done to reach that state. A milestone can only be confirmed when all its actions
were set to completed.

Some customers use these tools extensively and ask their users to base their daily work on the
milestone actions appearing in their To Do List. These users then use custom filters when over-
viewing (their) actions. They typically filter their actions based on user, state and urgency.

Creating Milestone Actions

To add an action to a milestone:

1. Select the milestone in the Milestones view.
2. Click  or go to Milestones > New Action... or right-click on the canvas in the bottom part

of the Pilot.
3. In the New Action dialog, enter what needs to be done, who needs to do it and by when.

 

 

The user that needs to do the action can later change the State from Pending to In Progress,
Completed or Aborted.
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Working with Milestone Actions

Milestone actions appear

• in the Milestone view, when in job mode. See a screen shot here.

• in the To Do List, as Milestone Actions. The To Do list offers some more functionality on
these actions:
 

 

• Right-click to open, delete or create a new action.
• Right-click or click  to Forward the action to another user.

• Check 'I am currently handling this item' to change the state to In progress.

Open (double-click) the action to use these extra tools:
 

 

• Change the State.

Note:  Because the names of these states are shared with CheckPoint Actions, choosing
Accept or Reject will for a milestone action result in Done.

• Change the Due Date.

• Add a Message.
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For example: a user opens his to do list in the morning and uses a filter showing all the actions
on his name that have a due date before noon, in the state Pending or In Progress. He can
also use the column due date to sort by urgency.

8.6.6.  Using Milestone Statuses to Filter Jobs

The filters that you make in Job Overview mode can also be based on milestones.

See this example of a filter that was saved as a Smart View named "Still Need Plates
Today". It only shows jobs with an unconfirmed milestone "Plates Ready" that has a due date
today:
 

 

Learn more on creating such filters in Job View Filters on page 499.

8.6.7.  Using Milestones in Workflows: the Manage Milestone Task

Concept

Using milestones in workflows enables these principles:

• Milestones can help control a workflow. A workflow can check the status of a milestone
before continuing (in a specific direction). Use the workflow control Router to do this. See
an example here. Learn more in Router on page 767.

Tip:  When you also work with the Products tool, then check if the dedicated Wait for
Product Status task is a better alternative.

• The Manage Milestone task helps to automate working with milestones. This task serves
to create and confirm milestones as a workflow step. This enables a lot of automation when
working with milestones. And you can also use it to hold workflows. Learn more below.

See an example of a workflow that automatically confirms four milestones:
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The Manage Milestone Task
You can use this task to automatically decide one or multiple of these milestone attributes:
 

 

• Set all pending actions of the following milestone in state "Completed": Select the
milestone you want to set as "Completed". Learn more about Milestone Actions in Working
with Milestone Actions. This setting is mandatory.

• Create the milestone if it does not exist: If the above selected milestone you selected
was not yet added to the job, check this option to add it (otherwise the task will fail). The
milestone will be created with the status "Completed".

• Automatically confirm the milestone:

• Check this option to set the above selected milestone as "Confirmed" and have the
workflow continue with its next step(s) or with any task that was waiting for this
milestone to be confirmed.

• Do not check this option if you are still waiting for a confirmation. The task will then
serve as a hold-point: it will pause the workflow until that milestone is confirmed.

• In the Workflow Editor, this step then will jump up and down, as a signal that a user
intervention is needed:
 

 
Right-click the file-icon and choose to Open Milestone... or to Show in Tasks View.

• In the Tasks view, you will see the phase User intervention needed.
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Click on the red text to open the milestone dialog where you can change any setting.
 

 
If you check Confirm Milestone (and click OK), the workflow will continue. If you can
not confirm this milestone yourself but for example need the help of someone else,
then type in a description and change the responsible user.

• In the Milestones view, right-click to open the milestone or directly click in the
column Confirmed to change it to Yes.
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Tip:  Some customers make the manual confirmation of a milestone easy by offering the users
a favorite ticket that only (creates and) confirms a milestone. This is useful when that user is
aware of a status that Automation Engine has no information on.

For example: A plate room operator checks plates that come out of the developer. He reads
their job number on the plate and types it in as a job filter in his simplified Pilot. He then
launches the appropriate favorite ticket: Plates OK or Plates NOT OK.
 

 
This information can now automatically change a workflow and/or be sent out to the system
that does the press planning. Learn more about such feedback in the next section.

8.6.8.  Informing Other Systems of the Milestones Statuses

The milestone status of an Automation Engine job is often more important to external people
than to users of the Pilot. Many parties want to be kept up to date about the latest status in
prepress, both colleagues and customers.

External systems are not always interested in all prepress details. You can choose to only
inform them on some specific milestones.

These are tools that help inform other systems and their users:

• Add a notification to your Manage Milestone task. This can be an E-mail notification or
the same message can also be written in an XML file for an external system to read. Learn
more about the type and content of such messages in Task Notifications on page 92.

• Or you can use one of many tools dedicated to help integrate Automation Engine with
external systems. Typical methods are

• write out XML files
• write directly in the database of the external system
• when the external system is capable of subscribing to JMF signals, you can set up the

automatic sending of JMF signals when a milestone is confirmed.

For more information on these feedback tools, see the dedicated chapter Integrating with
External Systems on page 1553.
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8.7.  About Removing Jobs

Concept

An Automation Engine job represents a Work In Progress. It is expected that you remove the
job when the work is done.

Removing a job means that it is removed from the Automation Engine jobs database. You have
the option to keep the job folder data.

When you remove a job,

• all finished tasks in that job will be deleted. If you wish to keep those tasks, use the Task
Cleanup Rules on page 165 to move them (earlier) to the Task History on page 151 tool.

• if that job still has unfinished tasks, you will be asked before removing the job to confirm
that they can be cancelled and deleted.

• all Actions for that job in the To Do List will be deleted.

• any setup of Hot Folders in that job folder will be removed.

• when you choose to not delete the job folder, all the job's setup parameters will be stored in
a subfolder 'config' (this is the information that was inside the database).

• the job will disappear from the Pilot's Job Overview.
• in the Containers view, the blue colored folder icon will turn back into a standard yellow

folder icon. You will be able to restore it later.

Note:  The Archive Job task allows to remove the job (from the database) and move the job
folder to a different place in the network. Learn more in The Archive Job Task on page 541.

You also have tools to reactivate the job, to recreate it back into the jobs database. See below.

Manual and Automatic ways to Remove Jobs

You can remove jobs

• manually, using the Pilot. Learn more below.
• by use of a workflow. This is usually a combination of the Select Job workflow control

followed by the Remove Job task. Use the links to learn more.

• fully automatic, by having an external system launch a workflow that removes jobs. Also JDF
can remove jobs directly. Learn more in the chapter Integrating with External Systems on page
1553.

Removing a Single Job

To remove a single job, select the job and press Delete. You can also right-click (or go to the
menu Job) and choose Remove Job....

You will be asked to confirm. You can choose to also remove the job folder and its contents.
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Caution:  There is no way to Undo the removal of the files and folders.

Removing Multiple Jobs

In the Job Overview mode, you can select multiple jobs and remove them in the same way as
described above. You will also get the option to keep or remove (all) their job folder data.

Note:  It is good practice to use a smart filter when you select multiple jobs to be deleted. For
example: all jobs that have their milestone 'finished' confirmed more than a month ago.

Note:  There is no "Remove Job" task, so you can not remove jobs as a workflow step.

In Edit  >  Preferences, you can decide to avoid getting (many) questions when you remove
multiple jobs:

• questions about jobs being in use by other users. A job is 'in use' when a user has this job
open in his Pilot.

• questions about jobs containing unfinished tasks.

 

 
Learn more in Pilot Preferences on Multi Job Removal.

Recreating a Job that was Removed

When a job was removed but the job folder data is still available, you can recreate that job back
into the jobs database.

There are two ways to recreate a job:

• Recreating a job manually. Follow these steps:

1. In Containers view, select the yellow folder that used to be the job folder of a removed
job.
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2. Right-click (or go to the menu Job) and choose New Job.... When a previous job setup is

detected in that job folder (in the subfolder 'config'), you will be able to recreate that job.
Choose to Reuse the previous setup.
 

 
3. Click Recreate. The renewed job will be opened and will contain the previous job setup

parameters, subfolders and local (blue) job tickets.

• Recreating one or multiple jobs with the Restore Job task.

Learn more in The Restore Job Task on page 543.

8.8.  Tasks you can Launch on Jobs
These are the tasks that you can launch only on Automation Engine jobs:

• The Relocate Job task moves the job folder of a job to another place.

• The Archive Job task removes a job and exports all its data and metadata into a ZIP file.

• The Restore Job task re-creates a job from a ZIP file that was created by the Archive Job task.

• The Check Job Parameters task checks or correct the input file's barcode and inks according
its job parameters.

• The Remove Job task is used to remove jobs as a step in a workflow. This task is then
preceded by the Select Job  on page 758 workflow control.

Like all tasks, these tasks can also be triggered by an external system. Learn more in Integrating
with External Systems on page 1553.
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The Create Job task is documented in the chapter Integrating with External Systems on page
1553.

8.8.1.  The Relocate Job Task

Concept
This task allows to change the location of an Automation Engine job. The job itself does not
change, only the path of its job folder.

Restriction:  You can not launch this task as part of a workflow.

Task Options

 

 

• Enter the New Job Location. Keep in mind to end the location with the name of the job
folder.

• You can choose to:

• Copy the files to the new location.
• Move the files from the original job folder to the new one.
• Not copy or move the files. The relocated job will then have an empty job folder.

Warning:  If you move a job folder without using a tool from Automation Engine, the
job setup field for the job folder will not be updated and the Pilot will show warnings.
Automation Engine will keep trying to retrieve your missing files and this can slow down
your server.

Relocating Multiple Jobs

In Job Overview mode, (filter and) select the jobs you want to relocate. Right-click and choose a
Relocate Job ticket:
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8.8.2.  The Archive Job Task

Concept
The Archive Job task removes a job from the jobs database and exports the data in a form that
enables to restore the job later.

Typical for this task is that it exports the job metadata as well, these are the job setup
parameters. This metadata makes it possible to restore the job (back) later.

Note:  The job's metadata is exported in a subfolder named 'config'.

Note:  When you launch the Zip task on a job, the task only ZIP's the data inside the job folder,
not the job's metadata.

Note:  When archiving (removing) a job, the tasks that were launched in that job will be
deleted. If you want to keep these tasks, use the Task History on page 151 tool. This tool allows
setting up rules that automatically move those tasks to a separate database (before archiving
the job).

Task Options
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• Output in: define where you want to write this archive data. For example some customers
use a 3rd party backup/archive solution that scans specific network folders for new
incoming data. This system then archives that data online or writes it on a backup medium.

• File Name: define the name of the file in which all data will be stored. When you do not
choose to generate a ZIP file, this will be a folder with subfolders.

• Generate ZIP file: deselect this option if you want to move the job folder to the above
location without ZIP'ing all data.

• Generate XML: select this option to generate an XML file that describes this job. Such an
XML file can be useful for a 3rd party archive solution that for example uses it to build up its
search database.

• Apply XSL: select this option if you want to format the XML file using an XSL style sheet
from a 3rd party archive solution.

• Keep Job and Job Folder (Export Job): deselect this option if you want to delete the job
folder once it is successfully archived.

Select this option if you still want to keep the job in the job database and also keep the job
folder in its original location. Here are some examples when to choose this:

• To use this task as a job backup tool.
• To exchange that job with another Automation Engine. For example to send to a job to

another plant of your company (that also has Automation Engine) or to share the job
with Esko Customer Service.

Archiving Multiple Jobs

In Job Overview mode, right-click the selected jobs and choose your Archive Job ticket.

Here is an example of a smart way to archive multiple jobs. The filter lists all jobs that have
their milestone "Job Finished" confirmed this week:
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Using the Archive Job Task in a Workflow

You can end a workflow by archiving the job that the workflow was launched in.

Here is an example:
 

 
Notice these steps:

• After the plate making stage, the workflow waits for 2 weeks.
• It then sets the milestone "Ready for Archive" but without the option to confirm it. This

triggers a request for a user intervention (learn more about this option the Manage Milestone
task).

• When a user confirms this milestone, the workflow continues and archives the job.

8.8.3.  The Restore Job Task

Concept
This task allows to restore jobs back to the Automation Engine job database that were
previously archived using the Archive Job task.

Note:  When the Restore Job task is a step in a workflow, it will only have the error output pin.

Possible Input Types
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The input file for this task can be

• a ZIP file created by the Archive Job task.

• a job folder created by the Archive Job task.

Important:  The ZIP file or the folder need to be created by a version of Automation Engine
that is equal or lower than yours.

• an XML file that refers to the location of a ZIP or folder created by the Archive Job task.

The root node of the XML needs to have an XML attribute named "Location". The value of
this attribute is the URL to the ZIP or archived job folder. Here is an example XML (it looks
like the XML generated by the Archive Task):
 

 

Task Options
 

 

• Output in: Define where you want to place the restored job folder. Use [Job URL] when
you want to restore the job to its original location and with its original job folder name.

Note:  When you restore to a server that has a different name (typically a new AE server),
then avoid using SmartNames that result in a value that contains that name of the old
server. For example, [Job URL] will try to restore to a path containing the name of the old
server. Consider defining an output path that also uses [Server], the SmartName for the
name of the current server.

• Job Name: Define the name of job once it is restored. Use [Job Name] when you want the
job's original name.

• Order ID and SubOrder ID: Similar to the job name, define a new ID or use SmartNames to
use the ID's of the original job.
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• Due Date: Set the job's new due date.

• Delete archived data: Select this option if you want to delete the archive data after
restoring the job.

• You can choose to Launch a workflow when the job is restored. The advantage of this
function is that the chosen workflow will be launched in the context of the restored job. This
means that all the used SmartNames will get their value from that job.

Important:  If the Restore Job task itself is part of a workflow, the workflow that is chosen
in this task will start immediately, as a separate workflow. It will not wait for the workflow
that contains the Restore Job task to finish.

Note:  This functionality is used when using 3rd party (hotfolder based) archiving solutions.

8.8.4.  The Check Job Parameters Task

This task serves to check if your file matches specific parameters as defined in your job setup.
You can also use it to automatically correct the file according those parameters.

Note:  For the task to function properly, the file should be part of an Automation Engine Job.

 

 

For Barcode settings, you can select:

• Auto Correct when you want to correct the file with what is specified in the job's Bar Codes
tab on page 513 .

For example, your Normalized PDF includes an Esko barcode of type EAN-13 and code
123456789012, and your job parameters specify an EAN-13 with code 5449000050205,
then this task will automatically correct the barcode number in the PDF to 5449000050205.

• Stop with Error when you want the task to stop with an error if the barcode in the job's Bar
Codes tab on page 513 does not match the barcode in the file.

Note:  This task only checks barcodes created in Esko PackEdge or by using Esko's barcode
plug-in for Adobe Illustrator (DeskPack). If the task does not find such a barcode, the task will
end in a warning.
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Note:  You cannot use this task to check and auto correct barcodes in normalized PDFs
generated by ArtPro.

For Inks, you can select:

• Auto Correct when you want the task to correct attributes of the file's inks according what
is specified in the job's Inks tab on page 508.

• Auto Correct (Strict Checking): Same as ‘Auto Correct’ but now also the order of the inks is
corrected (according the job's ink parameters).

In this strict setting, the task will finish with an error if it finds unexpected inks (inks that are
in the file, but not defined in the job parameters) and with a warning if it finds missing inks
(inks that are not in the file but defined in the job parameters).

• Stop with Error when you want the task to stop with an error if the job's ink parameters are
different than those in the file.

Table: Some example situations when checking inks

Missing ink (ink specified in Job Parameters
but not in file)

Always results in Warning

Wrong sequence of inks Results in Error in case of strict checking,
otherwise: no message

Unexpected ink (ink in file which is not in Job
Parameters)

Results in Error in case of strict checking,
otherwise: no message

8.8.5.  The Remove Job Task

The Remove Job task serves to remove one or multiple jobs.

Tip:  Learn more about what happens when jobs are removed in About Removing Jobs on page
537.

 

 

Using the Remove Job Task in a Workflow

This task needs a job as input. This is why, in a workflow, you typically use the workflow control
Select Job in front of this task.
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Having Jobs Removed by an External System

Any task can be launched by an external system. In workflows where jobs are created
automatically through integration with an external system, that same system can also decide
when to remove jobs. For example a business system triggers the Remove Job task right after
it invoiced the job. Learn more in Integrating with External Systems on page 1553.

Only Removing the Job from the Database or also Removing the Files?

You can choose to also Delete the files and folders. This will delete the whole job folder.

Note:  In a workflow, when this option is active, the Remove Job task step does not have an
output pin and so represents an end point for that workflow.

Note:  When the files and folders were not deleted, you can later still recreate the removed job
with the same job settings as before. To do this, select the ex-job folder and choose New Job
or launch the task Restore Job.

What about the Job's Tasks?

As usual, when a job is removed, the Task Cleanup Rules are applied. These rules decide which
tasks move to the Task History and which ones are deleted. After applying these task cleanup
rules (if any), any remaining tasks of this job are deleted.

8.9.  Automated Creation of Jobs

Most of the job setup parameters originate in another system, often the order entry part of the
business system. It could also be a web-portal where job specifications were first entered.

When someone already entered this data manually, we advise to not re-enter that data. We
therefore strongly advise to get your jobs created automatically.

The chapter Integrating with External Systems on page 1553 explains how this can be done. It
describes the many available techniques and also offers exercises.

Here is a summary of how jobs can be created automatically:

• by the Create Job task on page 1630 that, as part of a workflow, picks up the job setup
parameters via SmartNames or from an external (XML) file(s).

• by an Access Point that interacts with the external system and launches a workflow that uses
the found information in the Create Job task.

• via JDF/JMF commands from an external system, sent directly to Automation Engine's JDF
channel.
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9.  Products

9.1.  Products Basics

9.1.1.  The Products Concept

What is an Automation Engine Product?

An Automation Engine Product is a one-up graphics production item stored in the Automation
Engine Products database. A Product represents a Stock Keeping Unit (SKU). A Product is what
you Step&Repeat on a plate or press, possibly combined with other Products.

As explained in The Job Concept on page 495, a Job is a to do item for Automation Engine. A Job
is not a thing, it is an activity with a specific goal. A Job is temporary, you delete it when the Job
is done. A Product does represent a thing and is not temporary, you expect it to come back in
other production (output) orders. For example, you could have 200 Jobs, 20.000 Products and
20.000.000 files.

In Types of Jobs on page 496, we also describe that a Product is the result of a "Prepress Job-
Order", in which the goal is to get a design ready for production and customer approved. From
that moment on, the Product can be used in many "Production Job-Orders", where the only
task is to produce (output) it.

It is easier to integrate Automation Engine with a business system when both use the same
concepts. It will be easier to translate the incoming orders into a prepress (data) context. It will
also be easier to give feedback to that system about statuses in prepress.

The Main Principles when Working with Products

Working with Products typically means following this process:

• You first check your data structure. Working with Products requires that your Job data are
split from your Product data. Learn more about in Products Data Structure on page 553.

• Then you build up your Products database. Learn more about how to automate this in
Creating Products on page 570.

• Then you start linking Product(s) into your Jobs. This way, the Product data files are not
inside the Job Folder. Product data are independent: today they can be linked to Job 123
and next time to Job 456. They can even be linked to several Jobs at the same time.

In Automation Engine, this temporary relation to a Job is a temporary link between items in
the Product database and items in the Jobs database:
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Here is an example how this looks in the Pilot: the Job 440123 links to 3 Products:
 

 

Note:  You can work with Products without working with Jobs. However, in all classic print
production environments Esko advises to use the Jobs concept.

Product File Formats

These file formats are supported as Automation Engine Products:
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• PDF

Note:  Non-Normalized PDFs cannot be checked for barcode parameters. Learn more in The
Check Product Parameters task on page 586.

• ArtPro

• Adobe Illustrator (Esko DeskPack workflow).

Note:  You will only see a product part thumbnail when the AI file was saved as PDF
compatible.

It is possible to add other file types to the Products database, but it will become clear that
Automation Engine does not offer (m)any valuable features for such files (no thumbnail, few
tasks possible, provided parameters are irrelevant etc.).

Who typically uses the Products tool?

The Products tool benefits all customers that have product items coming back into production,
all environments that do some form of re-runs. These sites usually are printers/converters.

If your business is to produce an item only once, then you may conclude it is not worth to add
these files to the Products database. If you produce an item only once, you then probably end
by removing the Job and storing its data somewhere as a backup, just in case you need it again
for some unexpected reason.

Benefits of working with Products

• Data efficiency: no more needless copying or searching of data.
• A transparent data structure that supports the process logic of re-runs.
• A more user-friendly interface: thumbnails and colors indicating status.
• Automation Engine now speaks the same language as your business system, this enables a

higher form of integration, leading to even more automation.

What is the Products tool not?

The goal of the Products tool is not to make Automation Engine a Digital Asset Management
system (DAM).

These are some differences with a DAM:

• The Products database only stores one version. There is no automatic versioning tool.
• Searching for references is limited. You can see which Products are used in a Job and you

can see in which Jobs a Product is used.
• File support: the Products tool is designed for one-up graphics production files, not for

images or CAD or 3D or admin data.

Note:  You can use WebCenter as a DAM for your graphics production data. WebCenter offers
automatic versioning and supports all file formats. There are also standard available tasks to
up- and download data from WebCenter to Automation Engine in case you need it (back) for
production. Learn more in Synchronizing Products with WebCenter, a section of the dedicated
chapter Integrating with WebCenter on page 1526.
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Do I have to Install an Extra Database?

No. An installation of Automation Engine already provides the required database.

Note:  Product attributes are stored in the same database as the one that is configured for
Jobs (see Tools  >  Configure > Automation Engine Database >  Jobs).

Automated management of Products (and Jobs) via Integration

The goal of using the Products tool is to work more efficient. It is therefore important that you
automate the management of your Products. Creating them manually or changing their status
manually would again reduce efficiency.

You can automate managing (Jobs and) Products by integrating Automation Engine with your
order management system.

These should be your goals for such automation:

• All new Jobs and Products appear automatically.
• Jobs automatically link in their Products.
• Products statuses change automatically.
• Ideally, the business system makes a difference between Prepress and Production Jobs.
• Production Jobs should be fully automatic, the Product(s) they link to are already approved

so the only limitation should lie in how far you can fully automate the Step&Repeat.

See Tasks on Products to learn about tasks you can use in a Products workflow. As usual, these
tasks can also be triggered from an external system. Learn more in Integrating with External
Systems on page 1553.

9.1.2.  Global Products and Job Products

A Global Product is the one we described earlier: its data is not inside a job folder, it is
independent. Global Products can be linked into several jobs (even at the same time).

It is however possible to store the data of a product inside a job folder. We then call it a Job
Product, it can only be used in that job. Some Prepress Service Providers (trade shops) or
commercial printers, who don not normally produce re-runs, use this concept.

Like Tickets, the global version is visualized with a yellow icon  and the job (local) version with
a blue icon . See some examples in Products Views and Menu on page 559.

See this example of a Job Product, notice how the product file is located inside the job folder:
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9.1.3.  Products can have Multiple Parts

A Product can be a combination of multiple Product Parts. These parts then come together on
press or later in finishing and so end up as 1 SKU in your warehouse.

Some examples:

• A bicycle helmet is sold in a plastic wrap that also contains a paper sheet with product
information. The sheet was printed in 2 print runs: first the front in 2 colors (front.pdf) and
then the back in 1 color (back.pdf). This front-back printing made these 2 Product Parts
become 1 Product (after cutting). 1 Product is kept in the warehouse (1 SKU), 1 Product is
ordered by your customer.
 

 

Note:  There could be other Products that use the same front Part but a different back Part
as their (language) variant.

• A booklet is glued to a label. These 2 Product Parts come together in finishing and so
become 1 SKU, 1 Product to be ordered.
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These are Not Multiple Parts of one Product:

At first glance, these 3 labels look like Parts of a same Product. This may look that way to the
brewery, for whom the product is the beer bottle.

 

 

But, for the label printer, these are 3 different Products.

• They do not come together in printing or in finishing.
• In the warehouse, they are 3 separate SKUs.
• They can be ordered separately: your customer can for example order 6.000 front labels,

3.000 French back labels and 3.000 Spanish back labels.

9.2.  Products Data Structure

Important:  This page illustrates data structures to work with Global Products (where the
product data is not inside a job folder).

Splitting Product data from Job data

When jobs link to product (data) it is important that they do not share any folders. This data
separation can be achieved in many ways.

Here are 2 examples:
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• On the left, an example where the data split between jobs and products happens quite
high in the container.

• On the right, an example where this data split is done per customer.

Note:  Using customer names for folder has its disadvantages too. Customer tend to
changes names for example. Learn more about your options in Good Practices regarding Job
Folder Location  on page 521.

Organization of Product data

Once your product data is split from the job data, you can freely decide how to structure that
product data.

See these 2 examples:
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• On the left all the product data is in 1 same folder FruitCo Products. This is usually not
advised because it quickly leads to having too many files in a same folder (slow browsing,
general system slowness etc.). And if you want to select a file related to a product file, you
will again have to browse, even when they are in subfolders like Originals or Proofs.

If you create further subfolders that avoid having too many files in one folder, then this is a
valid way to organize your data.

• On the right each product has its own folder. This is advised. When each product has its
own folder, you can

• use subfolders to store related files.
• choose whether you store the actual product file in its root folder (as in above example)

or in its own dedicated subfolder, for example named Production file.

Attention:  The more structure and consistency you have, the easier it will be for other
systems to also benefit from this data structure. They can then rely on finding files in
specific places and will also be able to provide you files in specific (sub)folders.

Note:  When creating Product (Parts) via JDF, see Products JDF setup to learn about extra
possibilities.

The Product Data Zone (PDZ)

A product has one or more Product Parts and each part refers to a specific product part file.
So when we talk about the product data we more precisely mean the product part data. Learn
more in Product (Part) Properties on page 566.

The place where the product part file and its related files are located is also referred to as the
product part Data Zone. In the Pilot, when working with products, you sometimes want to
launch tasks on files related to that product. For example: selecting its report file and launching
the E-mail task. That is why it is advised to see more data in the Pilot than just the product part
file.

The Depth of a Data Zone

The Data Zone is not just the folder where the product part file is located, it can be a larger
zone. How large this zone is is decided by its Depth.

The reason to set this depth is to control how much data the Pilot users will see and have
access to when selecting a product in the Pilot.

The depth of a product part data zone is decided when the product is created. It then takes the
value as defined in Tools > Configure >  Products > Product Part Data Zone. Learn more in
Configuring the Data Zone Depth.

Here are some examples:

9.2.1.  Examples of Data Zone Depth

Example 1: a Product Part with a Data Zone Depth of 1
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The product shown below was created with a data zone depth of 1. See how, when you select
the product thumbnail, the Data Zone pane not only shows the folder Esko where the product
part file is located in, but also 30001, which is 1 folder higher. If the depth was 0, you would
only see the folder Esko and so have no direct access to other product's related files.
 

 

Another place where this depth is visible is in the properties of the product part. Notice how
the definition of File in this case starts with (1) folder name:
 

 

Note:  In this properties dialog, it is possible to manually change this depth. This might be
useful when a wrong depth was used at product creation time. In above case you could for
example remove Esko/ from the File definition and it to the Data Zone path.

Example 2: a Product Part with a Data Zone Depth of 0

As in the above example, the product has its own folder and subfolders. But here, the actual
part file is not stored in a subfolder, but it is located in the root of that product folder. See how
the PDF is in the folder 22004 :
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This indicates a Data Zone depth of 0. There is no need to, when you select the product, to see
a folder higher than 22004.

Note:  In the Data Zone pane, folders below the selected part are always visible.

In the product part setup, notice how in this case the definition of File only contains the name:
 

 

Example 3: another Product Part with a Data Zone Depth of 0

In this example many product part files share a same folder, they do not each have their own
folder and subfolders. Here's how it looks in Container mode:
 

 

See below how, when the product thumbnail is selected, the Data Zone pane only shows the
file's parent folder FruitCo Products. Also here, there is no need to see 'higher', the related
files are in the folders below:
 

 
In the product part setup, the definition of File does not contain a folder name:
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Example 4: a Product with 2 Parts with a Data Zone Depth of 1

Note:  Multi-part products were introduced here.

This example shows a product that has 2 parts. Each product part file is stored in its own folder
but they share a common root folder.

See below how, when you select a part, the Data Zone pane also shows 11106, which is 1 level
higher than the folder the part file is located in:
 

 
In the product part setup, the definition of File contains 1 folder name:
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9.3.  Products Views and Menu

Note:  In the Files view you can not see if a file is a Product Part. Use the here described view
modes to work with products:

9.3.1.  The Products Gallery View

 

 
In Container mode, select the Products view to see

• the Product Gallery: a view on all or a filtered list of your Products. Choose the thumbnail
view  or the list view .
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• the Data Zone pane (switch it on or off in the menu Product). This shows the data zone of
the selected product. Learn more in Products Data Structure on page 553.

• the Tasks pane (switch it on or off in the menu View). This shows all tasks launched on any
of the viewed products.

• the Launch Favorites pane (switch it on or off in the menu View). This shows your favorite
tasks available for the file type of the selected product(s).

Note:  A thumbnail mentions N/A when the thumbnail is not available. The reason for this can
be

• because the product is an "empty" product: in JDF workflows, it is possible to create a
product part that has no link to a file yet.

• because the product part file is not a supported graphics file type (as we listed here).

The Products List View
The list view  offers the same functionality but shows the Product Gallery in columns:
 

 
Go to View > Select Columns in >  Product Gallery...  to customize which columns you see.
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Tip:  You can also right-click on a column title and deselect that column there.

Note:  You can choose different columns for product parts (when also viewing the Parts pane).

Working in the Gallery view

Tip:  You can select multiple products by using Command-click (Mac) or CTRL-click (Windows)
or by using SHIFT-click to select a series.

You can use the Products Gallery view to

• create a new product ( ). Learn more in Creating Products on page 570.
• get information about products:

•  indicates a Global Product,  a Job Product. Learn more here.
• To see if a product is linked to one or more jobs, you need to open the product's

Properties. Learn more in Product (Part) Properties on page 566.
• In thumbnail view, the color of the top bar indicates the status. Learn more about

statuses and their colors in Product Properties. When a product has multiple parts that
do not have the same status, this bar will be shown in grey. Learn more about multi-part
products below.

• In thumbnail view, a number in the top right corner indicates that the product has more
than one product part. Learn more below.

• In thumbnail view, the text fields describe the main product attributes. Use View > 
Select Thumbnail info in >  Product Gallery... to customize the information that is
shown there.

• manually change product properties. Press  or right-click the product(s) and choose
Product Properties.... Learn more in Product (Part) Properties on page 566.

• launch tasks on one or multiple products. Select the product(s), choose a favorite ticket or
right-click and choose New Task or Launch with.

Note:  A task that you launch on a product part that is linked to a job will run in the context
of that job. This is important when you use job related SmartNames in the task's ticket(s).

Note:  If a product is linked to more than one job, the task will run in the context of the job
that this product was most recently linked to. Learn more in Product Setup on page 566.
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Viewing Multiple Parts

When you select a product that has more than 1 part, an extra pane opens that shows those
parts. This happens automatically when you activated the function 'Show Parts' from the
menu Products.
 

 

Tip:  You can re-size this Parts pane, the Pilot will remember its size.

Note:  In the Data Zone pane, the file(s) representing the selected product part(s) will be
highlighted in grey (and vice versa).

Note:  The name of the main product thumbnail is the name of the first product part (as
defined in its properties). Learn more here.

Note:  The thumbnail info of a product part can be different than for the main product
thumbnail. Set this info in View >  Select Thumbnail info in >  Parts....

By seeing the separate parts, you have all the above mentioned functionality also available on
product parts.

If however you want the functionality (a task or managing properties) to happen on all parts,
then there is no need to view or select any parts. For example launching a task on the main
product thumbnail will automatically launch this task on all parts.

Filtering and Searching

The filter and search tools enable to quickly make smart product selections. You can also save
these filters as a Smart View.

You can search and filter products in the same way as you do with Jobs. Learn more in Job View
Filters on page 499.

More Functionality in this View

A lot of functionality is offered when you right-click one or multiple products:

• Use New Task and Launch with... to launch a task or workflow on your selected product(s).
Learn more in Launching a Workflow on a File on page 731.

• Use Open..., Open With and View... to open the product part file in a chosen application or
in the Automation Engine Viewer.
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• Use File Info... to see the metadata of the product part file.

• All other features are described in The Product Menu on page 564.

9.3.2.  The Product(s) in a Job View

When in Last Used Job mode, the Products view shows which products are linked into that
job.

When this job is a "prepress job", your goal will be to get that product approved and ready
for output. When this job is a "production job", you will probably work on step & repeat (in an
editor or via tasks) and/or output tasks. Learn more about these job types in Types of Jobs on
page 496.

See this an example of a production job that needs to output 2 labels:

 

 

Notice how

• the 2 products have a status 'approved', which is typical when you start outputting them.
• a Step & Repeat task was launched on the 2 products.
• the resulting pdfpla file was output in the job's subfolder "Step&Repeat".
• that pdfpla file was selected to launch the Prepare for Viewer task.

Using the Data Zone pane to see All Related Data

In job mode, the Data Zone pane always shows the job folder. When a product is selected, you
will also see the product's data zone.

In this example, selecting the 'mango' product made the Data Zone pane also show folder
'200108' and its subfolders:
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Note:  The data zone of a product is decided at its creation time. Learn more in Products Data
Structure on page 553.

In job mode, the Data Zone pane offers access to all the data relevant for that job:

• When you want to access a file in the job folder, browse to it in the (blue) job folder.
• When you want to access a product part file, click on the product part thumbnail and

choose your action from there.
• When you want to access another file in the product's data zone, select the product part

thumbnail to visualize it's data zone and then browse in those (yellow) product folder(s).

Hiding the Files View

The fact that you can access all data using the Data Zone pane, means that there is no more
need to see the Files view (when you work with products).

Also, when you use the Products view and then switch to another job, the Files view will again
be shown. To avoid that you need to click on the Products view again, you can choose to hide
the Files View.

To do this, right-click on the Files view and choose Remove from Views Bar.

Tip:  To see the Job Setup while staying in the Products view, select the blue job folder icon
and use the shortcut CTRL-ALT-J (Windows) or Command-Alt-J (Mac).

9.3.3.  The Product Menu

Tip:  Many of the features offered in the Product menu are also offered when you right-click
on a selection that you made.
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• New Product... allows you to browse to a file, create it as a product and link it to the job you
are in. Learn more in Creating Products Manually on page 570.

• Upload as Product... does the same as above but also uploads the chosen file to its
new product data zone. You can use this for example when the file is still on your local
computer, on a CD/DVD drive or already in a Container but not yet in its proper product
place. Learn more in Uploading As a New Product on page 571.

Note:  These features are also available when you right-click on an empty piece of canvas in
the Product Gallery.

• Link Products.... Use this feature to manually link product(s) to the job you are in.

• Product Properties... opens the setup of the product and its parts. Learn more in Product
(Part) Properties on page 566.

• Go To File shows you the product part file in the Files view of the Container mode.

• Explore Folder... opens a disk explorer view of the folder of the selected product part file.

• Link to Job... enables a quick way you to link a product(s) to a job from a list of most recent
used jobs (or choose Select Job... to select any other). You will get a warning when the
product is already linked to that job.

• Unlink Product. In Job mode, use this to remove the selected product(s) from that job. This
does not delete any files.

• Hide / Show Parts. Learn more in the Products Gallery View about working with Products
that have Parts.

• Manage Product Filters.... If you saved filters in your Products view, manage them here
and decide if you want to add them in the Views bar (as a Smart View).

• Manage Statuses.... This is where you can add or modify custom product statuses. This list
also contains Milestone names that were allowed to be used as product status. The way to
add or modify them is the same as described in Manage (Custom) Milestones on page 529.
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9.4.  Product (Part) Properties

Product properties are the attributes that are stored in the Automation Engine Products
database.

The concept is very similar to the Job Setup fields for Jobs. Most of the properties also become
available as SmartNames, in a dedicated category Product Information. Learn more on how
to use SmartNames here.

Note:  The SmartNames view allows to specifically test product part SmartNames. Learn more
in Also Show Product (Part) Parameter SmartNames on page 607.

The properties are divided in general product properties (Product Setup) and properties specific
to each product part (Product Part Setup).

Note:  The concept of multi-part products was introduced here.

You can also use the Product Properties dialog to manually Add or Remove Parts. You can
use the arrow buttons to sort the parts. A product will get its name and thumbnail from the
product part that is highest in this list.

9.4.1.  Product Setup

General tab

 

 

• Name: For global products, the product name has to be unique. For job products, the name
has to be unique within a job. For example there can be multiple job products with the
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same product name as long as they exist in different jobs. Learn more about global and job
products here.

• Product ID: This is the product identification code, often (only) a number. The same remark
as mentioned above about uniqueness is also valid here. The maximum length of a product
ID is 32 characters.

• Customer Name: Select the customer that this product belongs to.
• Customer's Product Reference: This is the name your customer uses for this product. It

can be useful as a search filter or for example to mention on a report file for this customer.
• Custom Fields: You can define up to three custom fields to help you search the products

database or to use them as SmartNames.
• Description: You can add a description (maximum 128 characters).
• Order Material:

An Order Material is the material that your customer wants a Product to be printed on. It's
the name of the material as your customer understands it and probably also the name he
used when he was ordering the production job. This name is the name of that material as it
is mentioned on the job order.

Note:  It is possible that you internally use another name for this material, but in
Automation Engine (the browser client used in the QuickStart deployment), we refer to that
one as the (real) 'Print Material'.

You can select it from the list that shows those you also see in the View Order Materials.

Note:  When you type in a name of a material that does not exist yet, it will be seen as a
new one and created.

• Status: Choose the products status from the list. Learn about standard and custom
statuses in The Product Menu on page 564.

Tip:  You can use the Wait for Product Status on page 487 task to hold and continue a
workflow based on this status.

Jobs tab

This is where you see which job(s) that this product is currently linked to, and when that link
was made.
 

 

Attention:  If the product is linked to more than one job, a task that is launched on that
product will run in the context of the job that this product part was most recently linked
to.
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Ordered Copies is an attribute that can be set when you use the The Link Product to Job task
on page 582. This number is picked up in the SmartLayout function of Esko's Step & Repeat
editor Plato (learn more in Working with Products in Editors on page 577). This number also
becomes a SmartName that for example can add its value to a report file.

Parameters tab

You can here add custom parameters that also become available as SmartNames.

When you have long lists of parameters, use the search field to quickly find parameters based
on their Name or Value.

Attention:  Mind that these parameters need to reflect what is specific for this product
(range). Parameters that relate to how you output this product (Step&Repeat, press...)
are probably more job related parameters and so belong in the job setup.

9.4.2.  Product Part Setup

You can specify more and different properties for a product part because

• a part refers to a file. Some part properties relate to the file's location and its graphics
characteristics.

• a product can have several parts with different properties (for example the front has the
barcode and the back only has one ink).

Most properties also become available as SmartNames (in the category Product Information).

See this example of a product with 2 parts:
 

 

General tab

• Data Zone: This is the path to the folder containing the product part. This could also be a
folder one or more levels higher. Learn more about the important concept Data Zone in
Products Data Structure on page 553.

568



9Automation Engine

• File: This is the name of the file for that product part.

Note:  If the parts file is in a subfolder within the parts data zone, you can include a folder
name in this field: subfoldername/file. Learn more in Products Data Structure on page
553.

• Name: This is the name of the product part. This can be different than the file name.

• Custom Fields: You can add up to 3 custom fields.

Barcode tab

If the product part file has an (Esko) barcode, you can specify its properties here. The barcode
can be checked and corrected using the interaction with Esko editors or by using the Check
Product Parameters task. The details and usage is identical as with jobs: learn more in the Job
Setup Barcodes tab.

Status tab

Each product part can have its own status. This is relevant when a product has multiple parts.

Note:  A product will automatically get the status of its parts when there is only one part or
when the status of all its parts is the same.

The set a status, pick it from the list or use the The Manage Product Status task on page 584
task. If the status you choose has a Nickname, than that is the name you will see. Learn more
about creating statuses in The Product Menu on page 564.

You see when and by whom the status of this product part was last changed. An extra note can
also help clarify why the status was changed.

Tip:  When the change was done by the The Manage Product Status task on page 584 task, the
user name includes the name of the server.

Parameters tab

You can set custom parameters per product part. Their SmartName version shows up in the
category Product Part Parameters and their name starts with [ppp. ].

When you have long lists of parameters, use the search field to quickly find parameters based
on their Name or Value.

Inks tab

The inks in the product part file can be checked and corrected by the interaction with Esko
editors or by using the Check Product Parameters task. Details and usage is identical as with jobs,
learn more in the Job Setup Inks tab.

Note:  JDF workflows that create product (parts) can also specify such ink properties.
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9.5.  Creating Products

Products can be created

• manually, using the Pilot

• by making a file a product part file
• by uploading a file to a new place and then making that file a product part file.

• automatically

• by using the Add To Products  on page 224. The task then defines the product properties
based on the file's URL or metadata or out of some XML file(s) etc.

• by direct JDF/JMF commands. This technique communicates directly to the server
software. For more information on JDF contact Esko Solution Services or find some basic
answers in the chapter Integrating with External Systems on page 1553.

Note:  You can also use above tools to modify products (except the upload method).

Note:  Removing products is described in this separate page.

9.5.1.  Creating Products Manually

Note:  Learn about the difference between global and job products here.

Creating a Global Product

Follow these steps to manually create a new product:

1. In the Pilot, go to Container mode and Products view and click on . Alternatively, go
to Product > New Product...  or right-click on an empty part of the canvas in the Product
Gallery pane and choose New Product... .

2. The dialog first asks you to select the file that you want to add as product part file. Make
your selection and click OK to continue.

Important:  When you select multiple files, the next steps will create them as parts of a
same product.

Important:  If you select a file that is located in an (active) job folder, you will automatically
create a job product.

3. Now define the product's properties, both of the product and of the product part(s). Learn
more in Product (Part) Properties on page 566.

Tip:  At this point, you can use the Add button to add extra product parts.

4. Click OK to confirm and create the product. The new product appears in the product gallery.

Note:  You will get a warning when a product part with the same name or ID already exists.
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Creating a Job Product

To create a job product, you can use the same steps as above but you start in Last Used Job
mode (you are in a job and you select a file located somewhere in that job folder).

9.5.2.  Uploading As a New Product

Upload as Product... does the same as creating a new product but also uploads the selected
file to its new product data zone.

You can use this for example when the file is still on your local computer, on a CD/DVD drive or
already in a Container but not yet in its correct product place.

Much like Creating Products Manually, follow these steps to upload one or multiple file(s) as a
new product (parts):

1. In Container or Last used Job mode, go to the menu Product >  Upload as Product... or
right-click on an empty part of the canvas in the Product Gallery pane and choose Upload
as Product...  .

2. Select the file(s) and fill in their properties (same steps as when Creating Products Manually
on page 570).

3. In the product part setup, there is now one extra field where you have to define the
Destination of the file. Choose the Use the Smart Product Location as set in Configure
or browse to where you want to store the product part.
 

 
The Smart Product Location is a tool that can define the location and name of the product
part based on a product parameter or on the default location for that customer. Learn
more in Smart Product Location on page 208.

Note:  The Smart Product Location can be checked by clicking on Show Product
Location.

4. Confirm with OK.

9.5.3.  Creating Products Automatically

You can create products automatically by using the The Add to Products task on page 580.

You can launch this task

• as a user in the Pilot, after selecting an input file. This is advised when you use a task ticket
in which SmartNames already fill in many properties automatically.

• or this task can be part of a workflow that selects the input file(s) and also provides the
values for the required product properties.

To automate the creation of products, you typically create workflows that combine the The Add
to Products task on page 580 with some of these tools:
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• the Select File on page 756 and the Select Referenced File on page 418 workflow control
(when the file path is mentioned in an XML or CSV).

• Using Regular Expressions on page 656.
• the Data Splitter on page 270 workflow control.
• System Value SmartNames. Learn more in Creating System Value SmartNames on page

619 and see an Example of Looking for the Product Part URL on page 621.

Some of these are used in these examples of the two main types of product creating
workflows:

Example Workflow 1: Building your Products Database from your Existing
Data
When you start to work with the products tool, you may already have a lot of data that
you want to add to your products database. With this existing data, your goal is to launch
workflows that create many dozens or hundreds of products in one go.

Attention:  Based on what you learned in Products Data Structure, you can decide to
first re-arrange your data structure or to keep the data in their existing folders before
you start creating your products.

Tip:  It is good practise to first test this import on a part of your data, for example limited to
one of your customers. We advise to also test your output workflows with some of that first set
of products. You might learn details that you want to change before importing all your other
products.

See this example where all the 200* folders contain one product part file in their root folder:

 

 

This is the workflow we will use to automate creating these products:
 

 

We first use a smart way to select only the part file we need. We then add it as a product. We
then set the status.
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These are important steps and settings in this workflow:

1. First manually select all the 200* folders and then launch or open your workflow.
2. The Data splitter (default settings) will split that group of folders and will so launch the

Select File step on every separate folder.
3. In Select File, use these settings:

 

 

• File Type: in this example the type we want is a normalized PDF.

• In Select other Files, we select all those that are in the URL of what this step received as
input: that (single) 200...- folder.

• Do not Look in subfolders to avoid selecting the other PDFs or any report files.
4. In the Add to Products task, make sure to indicate the customer. We know the customer

because we make a manual selection under the product folders of a specific customer.

Tip:  When you do not set the customer via a SmartName, this workflow ticket becomes
customer specific. In such cases we advise to add that customer name to the name of your
workflow ticket.

5. We propose to already set a status. When these data were produced earlier, you can for
example set their status to 'Approved'.

Tip:  When you are testing these workflows, make sure to check the Updating options in the
Add to Products task.

Example Workflow 2: Adding New Incoming Designs as Products

When Should a New Design become a Product?

The concept of products allows to add them to the database very early. As soon as you have a
representation, a new design, you can add this file as a product part.
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You can use the product status to indicate what stage this product is in, for example New or
Preflight OK or Waiting for Approval etc.

Changing the Product Part File During Prepress Stages

You can also change the product part file during a workflow. For example you first use the
design file as the product part file but once you import or normalize or start editing you then
move that original design file to a subfolder original and update the product part with the
more recent (normalized) PDF file.

Note:  To update a product you use the same Add to Products task but use specific settings in
its Updating tab.

Creating a Product in a Job Context or Not

It is your choice to add the product while you are in a job context (in Last Used Job mode) or
not (in Container mode).

As mentioned in Types of Jobs on page 496, when you do not work in a job context, it will be
difficult to give feedback to your business system. However, many such systems do not give
you a job-order number to do prepress work on new designs. Many of them only send you job
numbers for 'production jobs' in which you output already approved products.

In that case, you still have a choice to create your own 'prepress jobs'. A reason to do that is
consistency, because then everything that your users do in prepress (with Automation Engine)
happens in a job context.

Tip:  But how do you name those self-created prepress jobs? You could base their name
on the name of the product they are supposed to create. For example if you know you are
preparing a new product that should be named 7890, then you could do this work in a job
named Preparing_7890 .

Avoid Changing a Product Name or ID: Get it Right from the Start
It is very important to get the product name and ID as soon as possible. You do not want
to create a product and later change its name or ID. If this name is not sync with what the
business system expects then there will be no or little integration possible. For example if
you send the business system an early JPEG of the new design, it will need to have the correct
name: the name of the item that this system expects.

In an ideal situation, your business system sends you a prepress job and in there mentions the
name and ID of the product that it expects you to create.

In all other cases, to get this correct product name or ID, you will probably need to get this
information from people working with the business system. It is in that admin department that
this number was created. In the business process, those colleagues made the decision that
you should prepare and output a new design or variant, so they will have a record of that item
number (and name).

Example Workflow
Your new designs can come in via many different ways. An important tool to help automate
creating them as a product are Access Points on page 1561. An Access Point can detect a new
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incoming design and immediately launch a workflow that moves the file to the right folder for
the product part and then adds it to the product database.

See this example:

• A Folder Access Point detects new designs coming in from the customer FruitCo.
 

 
• This access point launches this workflow:

 

 

1. The found data is moved away from the access point folder to an 'arrival hall' for new
designs for this customer:
 

 

Important:  We use this intermediate place because we first want to check what the
correct name and ID for this product will be.

2. The CheckPoint task asks a user to check with the admin department what the correct
name and ID needs to be. When needed, the user manually changes the name of that
design file.

3. The next Move task is now able to move the design to a new own product folder. The
folder is decided by using SmartNames, based on the customer name and on the first 6
characters of the designs name.

4. Now that we have the file in the right place and with the right name, we create the
product.
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5. A preflight is executed on the file.
6. The status we set depends on the preflight result.

Note:  You can of course extend this workflow with steps like editing and proofing. The goal
of this 'prepress job' is to have an approved product item. An other job should then serve to
output this product, possibly together with others.

Note:  There are countless variations of how new designs can be processed. To create smart
ways of automating their import to the products database, we advise to study all the possible
tools mentioned in Creating Products Automatically on page 571.

9.6.  Linking Products to a Job

A global product can be linked to one or multiple jobs. A job product can only be linked to one
job.

You can link a product to a job

• manually, using the Pilot, in Products view,

• in Container mode, by right-clicking one or multiple products, choosing Link to Job
and selecting the job from the list of recently used jobs (or by using the dedicated menu
item).

• in Last used Job mode, by right-clicking in the Products panel, choosing Link
Products... and selecting the one(s) you want (or by using the dedicated menu item).

• in Last used Job mode, in the Data Zone panel, by selecting a file in the job (sub)folder
and choosing the menu itemProduct >  New Product.... This will create a job product
and automatically link it to this job.

• automatically,

• by using the The Link Product to Job task on page 582.

• by using JDF/JMF commands. This technique communicates directly to the server
software. For more information on JDF contact Esko Solution Services or find some basic
answers in the chapter Integrating with External Systems on page 1553.

Which Job(s) is this Product Linked To?

You can see the job(s) that a product is linked to

• in the product's properties. Learn more in Product Setup.

• in  the list view. Learn more in Products Views and Menu on page 559.

Which Product(s) does this Job Link to?

You can only see which products a job links to by opening the job in Last Used Job mode.
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9.7.  Launching Tasks on Products

Launching tasks on products is very similar to launching tasks on files.

Here is some information specific to launching tasks on products:

• As with files, you can right-click on products and launch tasks from there. You can also
launch Favorites.

• Launching a task on a product will launch it on all its product parts. If you want to launch
a task on a specific part, use Show Parts to see the Parts panel and make your specific
selection there.

• In Last used Job mode, in Products view, when you select one or more products and
launch a task, it will run in the context of that job. The SmartNames will relate to that job.

• In Container mode,

• tasks launched on products check if those products are linked to a job and will run in
the context of that job. See an example where two products were selected and the
ReportMaker task was launched:
 

 
• when a product is linked to multiple jobs, the task will run in the context of the job that

the product was last linked to. Learn more in the Product Setup on page 566.

• In a workflow, you can use the Select File on page 756 task to select all the product parts of
the job (context) that that workflow is running in. The next workflow step is then launched
on those product parts.

9.8.  Working with Products in Editors

Editors that have been configured to be a client of your Automation Engine server, will show
extra tools that help you work with products.

Easy Access to Open Products in Editors
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Esko editors like ArtPro, PackEdge and Plato that communicate with an Automation Engine
server, offer an easy way to open product part files.

In their Open dialog, extra Job and Product lists help avoid a lot of browsing:

• You can select a job first and then the products linked in that job appear in the list of
products:
 

 

• You can press Search... to open a dedicated Select Job or Select Product dialog.

• You can click on the drop-down arrow to pick one from the memory of last used jobs or
products.

• When you open a product that has multiple parts, an extra dialog will open to let you
choose which part you want to open.

Tip:  When you are editing a product and you want to update it with your changes, then you
best use Save and not Save as. Saving as another name and/or in another folder will not
change the product part's URL.

Editors Checking a Product's Barcode and Ink Parameters

As mentioned in the chapter on Jobs on page 495, Esko editors check if the file's barcode and
ink settings match those that were defined in the file's job setup (in Job Ink parameters and Job
Barcode parameters).

The same principle and tools are valid when your editor opens a product part file that has
properties for barcode and/or inks.

Note:  When both the file's product part and the file's job have such parameters defined, then
the product part parameters are checked.

Note:  When an editor is checking product parameters, the dialogs use the same wording: they
also mention "Check Job Parameters" when they check product parameters.

And, as with job parameters, there is also a dedicated task to check or correct such product
parameters. Learn more in the Check Product Parameters task.

In Esko Plato: Fast Ways to Load Products onto a Layout

Esko's Step & Repeat editor Plato offers extra tools that also avoid searching and browsing
when you put stations on the layout.

For this to work, Plato first needs to be aware in which job you are working. This is done in the
Layout Setup dialog:
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• When you create a Manual Layout, the dialog Place Station offers the same job and
products lists as in the Open dialog, as shown above.

• When you create a new grid based layout, your right-click to add a station now also offers to
add the product parts (that are linked in that job):
 

 

• When you create a SmartLayout, you can choose to Load All Products... that are linked
into that job. Customers who often make layouts with many different files will quickly see
the benefit of this function:
 

 

In Esko Plato: Using the Product Parameter "Ordered Copies"

When you load a product part in SmartLayout, Plato also checks the Product Setup parameter
Ordered Copies and automatically fills it in in the SmartLayout dialog.

An example: This product is linked into 3 jobs but for job 440123 there are 7.500 Ordered
Copies:
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When Plato works in the context of job 440123, and when you use that product in your
SmartLayout, that number of ordered copies will be filled in automatically:
 

 

Learn more about Plato here.

9.9.  Tasks specific for Products

Note:  We here list the tasks. There are also workflow controls that are specific to Products.
Those are documented here, in the chapter Workflows on page 687.

9.9.1.  The Add to Products task

Attention:  This task requires you to be familiar with the manual setup of Products on
page 548.

You can use this task to create a product (part) or to add or modify parameters of a product
(part). You can not delete product (part) parameters using this task. Learn more below on how
to update fields.

The setup fields can be filled with SmartNames, typed in values or values chosen from a list.

Select item to set up: There are different tab sheets for product and for product part setup.
Every product hast at least one product part, so both are important.
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Setting Up the Product
• General: You here define the main product properties. This tab is similar to the General tab

when you manually define a Product Setup. Learn more about each field in Product Setup
on page 566.
 

 
• Parameters: You can here define custom product parameters. This tab is identical to the

Parameters tab in the Product Setup. Learn more about each field in Product Setup on
page 566.

• Updating: When a product with the same Product ID or Product Name already exists, this
task will update that product. Define the rules here.
 

 

• Update: If you want the existing product to be updated with the info from the task.
• Do not update: If you do not want the existing parameters to be updated.
• Update and provide a warning.
• Do not update and provide an error.

Link Global Product to the current Job: If you enable this the product in the task will be
linked to the current job context.

• Create Customer automatically when it does not exist yet. Indicate if you want this.

Note:  Mind that a customer exists when the Customer ID already exists.

581



9 Automation Engine

Setting Up the Product Part

The settings for the product part as very similar to the ones for the product, that we explained
here above.

For the part, there are extra settings for the part's File:

• Update: If you want to update the product part with your task input file.

• Do not update: When the product part should not be updated with your task input file.

• Update and provide a warning.

9.9.2.  The Link Product to Job task

The Link Product to Job task allows to link one or multiple products to a job.

It also allows to specify the Ordered Copies. This is the amount of product items that need to
be produced in that job order.
 

 

Select Job

The job to link to can be indicated via its Name or via the combination of OrderID and
SubOrderID. You can select a specific job from the list but typically you will enter a SmartName
here.

Note:  When the job does not exist, the task generates an error.

Ordered Copies

Enter the amount manually or use a SmartName. Learn more in Product Setup and in using the
ordered copies parameter in Esko Plato.

Attention:  When the input file belongs to a product that was already linked to that job,
you can still use this task to (only) update the amount of ordered copies.

About the Task Input File
• When the input file is a product part of an existing Global Product, the product is linked to

the specified job and the ordered copies is set for that job (if the product was not yet linked
to the specified job).

• When the input file is a product part of an existing Job Product, the task generates an error.
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• When the input file is not yet a product part, the task generates an error.

9.9.3.  The Remove Product task

Concept

This task removes a product from the products database. It is typically used in a workflow
where it is preceded by the Select Product workflow control.
 

 
As described in The Products Concept on page 548, products should be removed from the
database when they are no longer relevant to your production. This decision is often taken
by the business system. You can set up an automated workflow where that business system
triggers a workflow that removes the product(s) that the business system described in an
XML file. Learn more about triggering tasks from a business system in Integrating with External
Systems on page 1553.

Attention:  This task does not remove only parts from a product. This means that also
when the input of this task is a product part, it will be the product that this part belongs
to that will be removed. This means that this task cannot be used to only remove part(s)
of a product.

General Behavior
• When the input file is a product with multiple parts, then that product and all its parts are

removed from the database (and optionally from the file system, learn more below).
• When the input file is a product part, the product that that part belongs to is removed.
• When the input file is a product part which is shared by multiple products, then all those

products and their parts are removed. There will be no warning if that is the case.
• When multiple inputs are specified, the task removes all corresponding products and all of

their parts.
• When an input product name or ID matches both with (one or more) Job Products and also

with (one or more) Global Products, then

• when this task runs in the context of a job, then only the matching job product of that
job will be removed.

• when this task does not run in a that job context, all the matching global product(s) will
be removed.

• When the input file is not a product (part), then, in a workflow context, the output of the
task is the input file and is put on the Error pin.

Options
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• Remove file. This will also remove the file of that product part.

• Remove complete data zone. This will also remove the complete data zone of the selected
product. Learn more about data zones in Products Data Structure on page 553.

Warning:  A data zone can overlap with the data zone of other products! There will
not be a warning or error in such a case!

Attention:  We advise to only choose to remove the complete data zone when you
are sure you have a backup of those data.

Learn more about removing products in Removing Products on page 588.

9.9.4.  The Manage Product Status task

The Manage Product Status task allows to set the status of a product.
 

 

You can add an extra comment.

Tip:  Adding a comment is most useful when the status change was a user's decision. For
example a comment that mentions that the customer couldn't approve via E-mail or web due
to network problems and so exceptionally called you to confirm that he approves the file.
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This task is often used to automatically set the product status during a workflow. See some
examples in Creating Products Automatically on page 571.

9.9.5.  The Wait for Product Status task

The Wait for Product Status task allows to hold a workflow until (all) the input product part(s)
reach the status specified in the ticket.
 

 
This task will wait until all Product Parts reach that status.

Learn more about product (part) status in The Product Menu on page 564 and Product (Part)
Properties on page 566.

Note:  This task ends in error

• when none of the input files are product parts.
• when one of the input product parts is deleted from the products database while the task is

waiting.

This task is typically used to prevent output before the product part(s) are approved. See this
example workflow:
 

 
Notice how the input of the Wait for Product Status task is defined by the Select File on page
756 task that has a specific option to select all the product parts in the job:
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9.9.6.  The Check Product Parameters task

Note:  The concept and tools explained here are very similar to those in the The Check Job
Parameters Task on page 545.

The Check Product Parameters task allows to make sure that the barcode and/or inks of the
task's input file match the properties specified in its Product Part Setup. You can use the task
just to check the file or you can use it to automatically correct the file.

 

 

Note:  The input file must be a Product Part file.

Important:  When no output file name or folder were specified in the ticket, the Auto Correct
actions will overwrite the input file.

For Barcode settings, you can select:

• Auto Correct when you want to correct the file according to what is specified in its Product
Part Setup.
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For example, your normalized PDF includes an Esko barcode of type EAN-13 and code
123456789012, and your product part specifies EAN-13 and code 5449000050205, then
this task will automatically correct the barcode number in the PDF to 5449000050205.

• Stop with Error when you want the task to stop with an error if the barcode in the Product
Part Setup does not fully match the barcode in the file.

Note:  This task only checks barcodes created in Esko PackEdge or by using Esko's barcode
plug-in for Adobe Illustrator (DeskPack). If the task does not find such a barcode, the task will
end in a warning.

Note:  You cannot use this task to check and auto correct barcodes in normalized PDFs
generated by ArtPro.

For Inks, you can select:

• Auto Correct: For each ink in the input file, the task checks if the characteristics of the ink
match the settings in product part parameters. If they don't match the file is corrected.

• Auto Correct (Strict Checking): Same as above but also generates an error if the file's list
of inks and the order of inks is not exactly as defined in the product part parameters.

• Stop with Error: This is a strict check on the list of inks, their order and their characteristics.

9.10.  Publishing Products to WebCenter

You can use the Publish On WebCenter on page 399 task to publish files from within an
Automation Engine container to a WebCenter project.

When you launch that task on an Automation Engine product,

• the product part file will be stored as a project document
• the product part file will also be stored as a document in the Bill Of Material of that

WebCenter project. The product (part) properties can be stored as WebCenter document
attributes.

Note:  The reverse is not possible: it is not possible to push WebCenter document attributes
to Automation Engine product parameters.

Learn more about this in Publishing Products to WebCenter, a page in the dedicated chapter on
Integrating with WebCenter on page 1526.

9.11.  Backing Up and Archiving Products

Backing Up Product Data

As explained in The Products Concept on page 548, data belonging to products are important
data that you want to keep online for a long time. This is why we advise to schedule a regular
backup of your product data. This can be done with many specialized (non-Esko) backup
applications.
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Additionally, we advise to use the database backup tools of Automation Engine. The products
database contains the properties of all your products. Remember that you can not restore
selections of this database, restoring is done on the complete database. And remember that
the products database is not a separate database but a database table in the jobs database.

Note:  Some customers also use the Pilot to back up the product part files. You can select all
or groups of products in your products gallery and launch tasks that can copy that data to a
near-line disk or off-line to some device (CD/DVD). You can launch the Create PAF / JPG / XML
(LinkEdge) on page 242 task (on normalized PDFs) or the Copy task or you can create workflows
that copy the whole product part data zone. If you accidentally lost product data, it will then be
easy to recuperate a selection of that copied data.

Archiving Product Data

As explained in The Products Concept on page 548, a product should stay in your database as
long as a job-order can come in that needs (to output) it. Ideally, the business system informs
you when its users have decided that a product item is 'end-of-life'.

Some customers keep some outdated products in the database to use them as basis for new
designs. When you do this, mind that exceptionally large databases may cause your system to
slow down.

Tip:  When you do keep outdated products in the database, make sure to give them a status
that is easy to recognize, for example end-of-life or do not output.

Another reason to remove old products is to avoid the risk of using them again in production.

Tip:  You can reduce that risk by using a workflow that checks the status before outputting. See
an example in The Wait for Product Status task on page 585.

Important:  The Archive Job on page 229 task archives and restores job folders and job
products. Global product files are not stored inside job folders and will not be archived by this
task.

In summary, there is no specific task or procedure to archive products. We advise to stick to
these general rules:

• Make regular backups of all your product data and database.
• Remove products from the database when you can.
• Use the product status to help indicate if a product can still be used for output.

9.12.  Removing Products

What Happens when you Remove a Product?

When you remove a product, the product and all its parts are removed from the product
database. The product part files on disk are not removed.

Removing a Global Product does not leave a memory of the product (part) parameters. When
you make the file a product (part) again, it will not propose you any previous settings.
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This is different when the product was a Job Product that was removed together with the job.
When you remove a job it always stores a memory of all its settings in a subfolder and this is
also done for settings of any job products. When you then use that ex-jobfolder to (re-)create a
job, the old product(s) are re-created in this job as job products and will have all their product
(part) settings again.

When do you Remove a Product?

As mentioned in The Products Concept and in Backing Up and Archiving Products, (global)
products are created to be used for a long term.

It makes sense to remove a product when you are sure it will never need to be produced
(output) again. In other words, when there are no more benefits of having it in a database:
when you don't link it into jobs anymore or you don't use its SmartNames any more.

Removing a Product when in Container mode
In the Product Gallery, select the product(s) and press Delete or use the right-click or menu
function Product >  Remove Product. A dialog will ask you to confirm.

By default, you can not remove products when they are still linked to a job. However, you
can force this removal by using the option to also remove those job-links at the moment you
remove the product(s). This is the option Also remove from linked jobs or Also remove
linked products from all linked jobs.

 

 

Removing a Product when in Job mode

When you are in a job's Products view and you select a linked product, pressing Delete serves
to Unlink the product from that job. However, the resulting dialog offers an option to Also
remove the product from the products database:
 

 
When you are asking to remove a product that is still linked to other jobs, you will see this
warning:
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If you want to remove products that are linked to multiple jobs, you need to do this in
Container mode (in the Product Gallery).
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10.  SmartNames

10.1.  Concept

What is a SmartName?

A SmartName is a variable that refers to a value. You use them by inserting them in input fields
all across Automation Engine. For example the SmartName [File] refers to the name of the
task's input file, and the SmartName [Date] refers to the date the task is launched.

SmartNames are shown in green and between square brackets. For example  .

Where can SmartNames be used?

Note:  Not all SmartNames can be used everywhere. Learn about limiting the places where
they can be used in SmartName Scopes on page 602.

• In Task Tickets, Workflow Steps and Access Points

See an example of a ReportMaker ticket:
 

 
The output file will be written in the Job Folder, in a subfolder 'Reports'. The output file
name will start with the name of the input file name plus the suffix '_reportcard_' and
ending with the date when this task is launched.

Tip:  You here also see how you can make combinations of SmartNames and regular (static)
text.

The report template that will be used starts with the customer's ID number and ends with
'_Report_Template'. This makes the ticket smart enough to select the template that this
customer prefers.

• In some fields of the Job Setup

In this example a SmartName defines the code of the bar code in the Job Setup (the code is
a variable that will be coming in from an XML file):
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• As Workflow Parameters in Workflow Steps

When your workflow contains Workflow Parameters, you can pick them up as Workflow
Parameters SmartNames in task tickets of tasks used in that workflow. Learn more about
Workflow Parameters in Workflow Parameters.

• Inside SmartMarks

See this example of how a SmartMark (here in PackEdge) uses a Smart Text that also
picks up 2 SmartNames:
 

 
• Inside the setup of other SmartNames
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Some examples:

• You can create a custom SmartName that extracts the first 5 characters from the [Job
Name]

• In below example, a conditional SmartName 'EXA_Which_Site_Is_Closest' compares
the value of two other SmartNames
 

 
• Inside some fields in the Customer setup
• In Configure, in some setup fields of Jobs and Products

Advantages

SmartNames are a crucial part of Automation Engine's power. They bring speed and error
reduction to your workflow through these effects:

• Consistency. Folders and file names will be consistent, no typing errors.
• Automation. You will rarely need operator intervention to edit workflows.
• Integration. SmartNames can pick up their value from other systems without human

intervention.
• Organisation. Making workflows smart means you need to prepare less workflows. Smart

workflows adapt to the input files and the variable job instructions.

When you first install or update Automation Engine, you already get many Default
SmartNames. You can also make your own.

In the next chapters, we first give an overview of the general principles. Then we describe the
different types of SmartNames in more detail. We both explain the default ones and then show
you how to create your own.

10.2.  General Principles

10.2.1.  Using a SmartName

There are 2 ways to use an existing SmartName:

• click on  to open the SmartName Browser. Choose a category, select the SmartName
and click Insert.
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• When you want to insert multiple SmartNames, press ALT while clicking Insert. Then, the
SmartName Browser will not close.

• You can filter the shown SmartNames by entering text in the search filter top-right. Use
double quotes (") when an exact match is required.

• You can even combine search filters. For example when you type '123 exa', you ask to
see SmartNames that contain both 123 and exa in their name or Tag (learn about tags
here) . Add a semicolon '123 ; exa' to see SmartNames that contain 123 or exa.
 

 

• Click Refresh to make sure that the most recent created SmartNames are also shown (or
press CRTL-R or CMD-R).
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• Click New SmartName if you want to create a new one from here, while keeping this
dialog open.

• right-click in the field, choose Insert SmartName... and choose a SmartName from the
offered categories.
 

 

Important:  In both ways, make sure you first position your cursor in the exact place where
you want to insert the SmartName.

Tip:  It is possible to select and cut, copy and paste SmartNames.

10.2.2.  The SmartNames View

The SmartNames View in your Pilot is where you

• see all your SmartNames, both the default ones that came with Automation Engine and the
ones you created extra

• add filters to help find and organize them
• create, modify or delete SmartNames (if you have the User Access Right. Learn more in

Access Rights on page 144).

• test your SmartNames ("resolve").
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As usual, you can control the columns in this view. To do this, go to the menu View >  Select
Columns in 'SmartNames'... (by default they are all shown).

You can add a Description to your custom SmartNames. This quickly reminds you what they
are for, without the need to open and analyse them.

Tip:  The SmartNames View is not available when your Pilot is in Jobs Overview mode.

Tip:  When you choose Tools >  SmartNames, the SmartName View opens as a separate
window.

Type - Category - Scope - Private - Tags (Overview)

We here briefly describe what these columns mean. Find more detailed descriptions on some
of them in the next pages.

• Type. The type is a very important distinction. It defines what kind of technique the
SmartName will use to get (resolve) its value. Will it get the value from a database inside
Automation Engine? Or by asking the database of an external system? Or from an XML file
or from another SmartName? All types are documented in SmartName Types (Overview) on
page 598 and later in even more detail.

• Category. Categories are an old way of helping you filter and group SmartNames. We
recommend using Tags instead (see further).
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• Scope. By default the Scope of a SmartName is global. This means you can use it
everywhere. Defining a different (smaller) Scope for a SmartName means that you want to
limit the zone where it can be used. For example: if you define the Scope 'Step and Repeat'
then you indicate that this SmartName makes no sense to be used outside that concept of
Step and Repeat. More on this in SmartName Scopes on page 602 .

• Private. You can save a SmartName as Private. Private SmartNames are not visible
when applying SmartNames in a ticket. They do not appear in the list or the SmartName
Browser. Two example use cases:

• the SmartName is only used as a sub-component of one or more other SmartNames
(that users will see and use)

• you are still testing a new SmartName in the SmartName View and you do not want
other users to already use it.

• Tags. Adding custom tags to a SmartName helps you filter and group them. Learn more on
this in SmartName Tags on page 603.

The right panel

On the right side of the SmartNames View, you can add more SmartNames to the list and you
can test them extensively. Learn more in Testing SmartNames on page 606.

Advanced Search Criteria for SmartNames

As in many other Views in the Pilot, you can use Advanced Search Criteria. To activate this,
type in the Find field or press CMD-F (Mac) or CTRL-F (Windows). You see the criteria of the
current filter. Click the + or - to add or remove extra lines of criteria.

This screen shot is an example of a filter that shows all SmartNames with exam in their Tag.

 

 

Click Save to save this filter. Define if this filter is for yourself or for all users. Decide if you want
to Add to my views bar.
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See an example of custom Smart Views:
 

 

10.2.3.  SmartName Types (Overview)

 

 

Later in this document we describe each type in detail. Here is an introduction:

Database Query SmartNames
These retrieve a value from an external database. This is useful when there is no other way
that the external system can send the information to Automation Engine (via XML or CSV or E-
mail ....)

Learn more on in Database Query SmartNames  on page 645.

String Extract SmartNames
These SmartNames extract a part of a string of characters (text or numbers). For example:
when the input is '123-abc', then extracting all characters before the '-' will result in '123'.

Note:  The string from which the value of the SmartName is extracted can contain other
SmartNames. For example: extracting the first 5 characters of the [JOB ID].

Learn more on in String Extract SmartNames on page 624.

598



10Automation Engine

System Value SmartNames
These retrieve a value from one of Automation Engine's own databases. You get these when
you install or update your Automation Engine server software. For example [Access Point
E-mail Sender] (only valid in the context of an Access Point)

Learn more on in System (Value) SmartNames on page 614.

Script SmartNames
These use JavaScript to define a value.

Learn more on in Script SmartNames  on page 647.

XMP Path Query SmartNames
These retrieve a value from the XMP (metadata) section of a PDF. For example when it was last
modified or the PDF version number.

Learn more on in XMP path Query SmartNames on page 635.

Xpath Query SmartNames
These use XPath Queries to retrieve a value from an XML. The Xpath Builder is a great help to
construct these Xpath expressions.

Learn more on in XPath Query SmartNames on page 629 .

Conditional SmartNames
These return a value based on a condition. For example a SmartName 'Trapping size' has these
conditions: if the workflow parameter 'Printprocess' is 'flexo', then return '0,2' and if the
workflow parameter is 'digital' then return '0'.

These SmartNames are also often used to route workflows in one or the other direction.

Learn more on in Conditional SmartNames  on page 639.

CSV Text Extract SmartNames
These extract a value from a CSV file. For example take the value from field 5 on line 2.

Learn more on in CSV Text Extract SmartNames on page 627.

10.2.4.  SmartName Categories

SmartNames are sorted into categories, so you can find them more easily. The SmartName
View and the SmartName Browser show you these categories and their members:
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CTP Flexo

These SmartNames are useful when working with the View modes of the category CTP Flexo.

Date
Use SmartNames of this category to insert the [Date] or [Time] of their execution.

File Information
These SmartNames return file-related information from within the file itself (for example
[Media Box Width] ) or from within the Automation Engine database ([File Type],
[Folder of File], [SmartID] ...). The most popular one is [File], representing the name
of the ticket's input file.

Global
This is a full list of all the SmartNames that can be used anywhere throughout Automation
Engine. The ones with a limited Scope will not be listed here.

JDF
These SmartNames are only used in tasks where JDF constructs are used. Learn more about
JDF in What about JDF? on page 1555.
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Job Information
These SmartNames refer to most of the fields in a Job setup, including the details of Customer
and CSR for that Job. Information on the location of the Job is part of the category Path
Information. Any custom Job Parameters are also a separate category.

Job Parameters
When you are in a Job context of a Job that has custom Job Parameters, you will see them
here. Their name automatically starts with 'jp. '

Miscellaneous
• Some SmartNames return the name of the Automation Engine server(s). They are useful

when you use Assistant servers.

• [Auto-Number1] will add a sort-number to a group of output files. This helps sorting files.
Learn more here.

Page Information

These SmartNames offer information on the (PDF) page attributes, typically height and width.
You typically use these in the (page) imposition related tasks like the Export Imposition to PDF
File.

Path Information
These SmartNames correspond to the Job's location. Learn more in System (Value) SmartNames
on page 614.

Tip:  If these SmartNames are greyed out (unavailable), it means that the field you want to
insert them into is not a path field.

Plate Information

These SmartNames offer information on the plate attribute of a (page) imposition. You typically
use these in the task Export Imposition to PDF File.

Product Information
These SmartNames are only useful when you use the Products on page 548 tool in Automation
Engine. Much like the category Job Information, this category relates to the many fields in the
Products database of Automation Engine.

Learn more about setting them up in Product (Part) Properties on page 566.

Task Information
This category of SmartNames allows to insert task related information (Task Name,
Operator, Application Version...). Learn more in System (Value) SmartNames on page
614.

Workflow Context
These SmartNames pick up specific names or paths of folder or files in a workflow context.
They help avoiding that you have to make complex workflows or create complex custom
SmartNames to achieve the same result.
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Learn more in System (Value) SmartNames on page 614.

10.2.5.  SmartName Scopes

Depending on where you are in Automation Engine, different SmartNames may be available
for use.

Global SmartNames
These SmartNames are available everywhere where SmartNames are offered.

SmartMarks SmartNames
These SmartNames are only available when using SmartMarks. In Concept on page 591, find
an example where a SmartName was used to decide the Smart Text in a SmartMark.

Step and Repeat SmartNames
These SmartNames are only available in Step and Repeat tasks, excluding the 'Dynamic' S&T
tasks.

Mark Information
These default SmartNames are only available in the task Add Marks to Imposition (page
workflows only).

Stripping SmartNames
These default SmartNames are only available when retrieving values from JDF files (with the
Import JDF Stripping task).

Imposition SmartNames
These default SmartNames are only available when working with impositions (for example, in
the Export Imposition to PDF File ticket).

Unit Text Field SmartNames
SmartName enabled unit text fields are available in tasks where units have to be entered. You
can do unit conversions and simple arithmetic using the operators +, -,* and  / . You can
also use parenthesis ( ) if necessary while calculating. PowerTrapper, Change Imposition
Layout and Create CAD sheet and a few examples of tasks that offer such unit text fields.

Some examples:
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10.2.6.  SmartName Tags

Creating a Tag

The Scope of a SmartName defines where it can be used. The Category of a SmartName helps
filtering. Adding Tags to a SmartName is an extra tool that enables you to organize them via
custom filters.

Note:  Tags are also shown in a separate column in the SmartNames View.

You can add one or more Tags when you save a new SmartName. When the Tag already exists,
it will appear in light blue:
 

 

Tip:  In the Tags field, press the space bar to get a drop-down list of all the Tags that were
already created on your Automation Engine.

To add a Tag to an existing SmartName, select it, right-click and choose Info to edit and add
one or more Tags.

To remove a Tag from a SmartName, select it and press the Delete button.

Tagging multiple SmartNames
1. In the SmartNames View, (filter and) select the SmartNames you want to tag.
2. Right-click and choose Tags.... A dialog will show what Tags they already have in common:

Tags that are not assigned to all selected SmartNames are shown in grey.
 

 
3. To add a Tag to all selected SmartNames, add the Tag and click OK.
4. To remove a Tag from all selected SmartNames, delete the Tag and click OK.
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Filtering SmartNames on Tags

To filter SmartNames on Tags,

• in the SmartNames View, select the search field and type the name of a Tag.

Tip:  It is also possible to add a search row by pressing the Add "+"  button in the Scope bar,
and choosing Tags from the attributes list (that pops up on the left).
 

 

• when selecting a SmartName from the SmartNames browser, enter the Tag in the search
field.

To filter on multiple Tags, separate the names by a space. For example to filter on SmartNames
that have both examples and OLH as Tag, type "examples OLH" into the search field.

 

 

To filter on SmartNames that have either examples or OLH as a Tag, then separate the Tags by
a semicolon ";" (see screen shot).

Renaming a Tag

To rename a Tag, follow these steps:

1. Go to the SmartNames View, filter on the Tag.
2. Select all SmartNames that contain that Tag.
3. Right-click and choose Tags....
4. Double click the Tag to edit it and type the new name.
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5. Click OK.

10.2.7.  Creating a SmartName (General)

These are the general steps to create a new SmartName. Find more detailed instructions per
SmartName type further in this document.

1. In your Pilot, select Views > SmartNames.
2. Click on the Create a new SmartName icon  in the toolbar. Alternately, choose File > 

New SmartName.

This opens the SmartName setup dialog:
 

 

Note:  Click  to select the attribute from a drop-down list.

3. Select the Type. We introduced the available types in SmartName Types (Overview) on page
598. See further in this document for a detailed setup instruction per type.
Depending on which Type you choose, the dialog adapts to offer different options.

4. Select the Scope. We introduced the available scopes in SmartName Scopes on page 602.

Note:  You can easily change the Scope later ; this does not affect the setup options.

5. Set all the required attributes. This is a general introduction ; see the specific settings per
type further in this document.

6. Check the Result value (bottom left in the dialog).
 

 
Depending on the example input data (file), you can already here see the example result
with the already chosen settings.

7. Formatting Options... . You can still change the formatting of that result (text, number,
data and time). Learn more details in Formatting SmartNames  on page 649.
For example your SmartName already extracts a date out of an XML, but you also want to
change the format of that date from 25-Aug-14 to 25-08-14.

8. Click Save and enter a logical Name and a suitable Description.
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When you use Save As..., the dialog stays open. This is very useful when creating multiple
variations of a SmartName one after the other.
SmartName Tags on page 603 explains all about adding Tags.
Decide if your SmartName should stay Private. Learn more about Private SmartNames in
The SmartNames View on page 595.

9. Click OK.
You can use Save As... in the Add SmartNames dialog to enter a new name for the
SmartName. This is useful when creating multiple variations of a SmartName one after the
other from the same dialog.

10.Check the result of your new SmartName in more situations or tasks. Learn more in
SmartName Relations and Dependencies on page 610.

10.2.8.  Testing SmartNames

While creating new SmartNames you will want to test them. Instead of having to test them in a
often complex workflow, you can use tools available in the SmartNames View.

This part of the View contains 2 main sections:

 

 

• Include SmartNames From: This part serves to show extra SmartNames that were not
appearing in your list yet. Choose if you also want to show Workflow Parameters and/or
Product (Part) Parameters. Learn more in Also Show Workflow Parameter SmartNames on
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page 607 and Also Show Product (Part) Parameter SmartNames on page 607. The reason
that you also want to see them here is to test them as well. The next feature enables that:

• Resolve all using: This part allows you to test your SmartNames. You can test them on a
task or on a file. Learn more in Test your SmartNames with 'Resolve All Using' on page 608.

Also Show Workflow Parameter SmartNames
Follow these steps to show extra Workflow Parameters in your list of SmartNames:

1. In Include SmartNames From, check A workflow and browse to the workflow that has the
Workflow Parameters you want to see here.
They will immediately appear in your list of SmartNames (unless you have a filter setting
that prevents that).

2. Tip: When your list shows many SmartNames already, it is possible you do not easily see
them appear. Because they are here all shown starting with the prefix wfp, you can easily
check their presence by typing a name filter 'wfp'. Alternatively, you could also use the
Category filter Workflow Parameters.
 

 

Also Show Product (Part) Parameter SmartNames

Note:  This feature is only useful when your are using Automation Engine's Products on page
548 tool.

Follow these steps to show extra Product (Part) Parameters in your list of SmartNames:

1. In Include SmartNames From, check A product part: and browse to the product file that
has the Product (Part) Parameters that you want to see here.
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They will immediately appear in your list of SmartNames (unless you have a filter setting
that prevents that).

2. Tip: When your list shows many SmartNames already, it can be hard to find them back in
the list. Because they are here all shown starting with the prefix pp, you can easily see them
appear by typing a Name filter 'pp' or 'ppp'. Alternatively, you could also use the Category
filter Product (Part) Parameters.
 

 

Test your SmartNames with 'Resolve All Using'
The Resolve All Using tool in the SmartNames View enables testing your SmartNames. The
basic principle is that you give an example input which is then tested on all SmartNames.
 

 

Tip:  If the SmartName you want to test is a Workflow or Product (Part) Parameter, then
first make it appear in the list by using the feature Include SmartNames from. Learn more
on in Also Show Workflow Parameter SmartNames on page 607 and Also Show Product (Part)
Parameter SmartNames on page 607.

"Resolve all using:" - An example:

1. Make sure the SmartName you want to test is visible in the list.
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2. If you want to test the SmartName by using it in a task, then first make sure you have a
finished task given a certain input. Then check A task and browse to the task in your task
monitor dialog. If you want to test the SmartName by using it on a file, check A file and
browse to that file.

3. Click Show to start resolving all your SmartNames with the selected file or task. This also
adds an extra column to your SmartNames View.The example in this screen shot shows
how the selected file 666-2712_ReportCard.pdf made the SmartName [Everything
before the _ ]' resolved (resulted) in the 666-2712 .
 

 

Set example values
This is useful for SmartNames that have dependencies. For the selected SmartName, you can
type in a manual value instead of needing to select a file or a task as input example.

Tip:  Not all SmartNames allow you to enter an example value. This will for example work
for most System type SmartNames and for the CSV Text Extract type SmartNames. This
is because the value of these SmartNames is a "given" and can be overruled by your new
example value. The value of SmartNames that are "calculated" can not be overruled ; the
resolving mechanism will simply calculate them when needed.

See an example in the below screen shot.

• You made a custom SmartName [File - only part before _], which is a string
extract with the _ (underscore) as separating character.

• This SmartName of course a depends on the system SmartName [File]. If you then select
the main SmartName [File], you will be able to set an example value.

• In our example, we enter the value "coco_765869".
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• See how this value is shown as a manually entered example value: the  icon indicates
this.

• See how the SmartNames (that depend on the SmartName [File] ), also react and
resolve a value: the SmartName [File - only part before _] results in 'coco'.

 

 

Remove all Examples Values

Click this to remove all the example values from your SmartNames View.

Show results as Plain text

In some exceptional cases it can be necessary to insert a SmartName although the user
interface does not offer to insert this SmartName in this place. Use this function to see the
SmartName as plain text so you can then select, copy and paste it anyway in the dialog or
ticket where you really want it. Test carefully, because these cases are really exceptional.

A 'plain text' version of a SmartName looks a bit like XML code. For example [Folder
of File] is in plain text written as <<filefolder/>> and [Product Name] as
<<bstpr:productname/>>.

Reload Resolved Values
This 'refresh' function is useful when the input for you test has changed in the meantime.

For example you are setting up SmartNames that are reading parts of an XML file and you
already did a test here. You typically want to test again after you know that the content of the
XML file changed (your test will show new values).

10.2.9.  SmartName Relations and Dependencies

In SmartNames View, when you right-click on one or on a selection of multiple SmartNames,
you get these extra functions:
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Tip:  Most of those are also available from the View menu.

Attention:  How SmartNames relate to each other is very important when you need
to manage many of them. Such checks are very important especially when you plan to
rename or delete a SmartName!

Highlight Related SmartNames

Choose this function to highlight all SmartNames that need one or more of the currently
selected SmartNames: 'Need' can mean that the one you selected is based on the other(s) or
it can mean that the other(s) are based on the one you selected. This highlighting is a feature
that stays active until you switch it off again.

For example: see this screen shot of the ones related to the SmartName [File]:
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Select Related SmartNames

Choose this function to select all SmartNames that need one or more of the currently
selected SmartName. In this example [Fuel Cost] also gets selected because it [Fuel Cost
no km] needs it (to extract the unit 'km').
 

 

Select Dependencies

Choose this function to select all SmartNames that are used in the currently selected
SmartNames. If you select the SmartName [Fuel Cost no km] in the example below and
then activate Select Dependencies, the SmartName [Distance] will also get selected. This is
because [Distance] is used in the definition of [Fuel Cost no km].
 

 

Display Selected SmartNames Only
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This function is no longer about selecting but about limiting the SmartNames that are
displayed. This function helps when the selected ones are spread far out over your long list of
SmartNames. See how the limited focus is also shown at the top.
 

 
When you want to see all your SmartNames again, then simply choose the function Display
All SmartNames.

Display Unused SmartNames
When it's time to cleanup your SmartNames you will want to know which ones are not being
used (any more). Choose this function to display only the unused SmartNames. You will first
get this warning dialog:
 

 

Press continue to start the search. When done, decide what to do with them (delete? tag as
'unused'?).

10.2.10.  Exporting and Importing SmartNames

SmartNames can be exchanged by exporting and importing (workflow) tickets that use those
SmartNames.

Learn more about exporting and importing (workflow) tickets in Exchanging Workflows on page
725.

Caution:  SmartNames of custom Job Parameters ( [jp. ] ) will not be imported. When
you import a workflow that uses them, they will not be added into the job setup tab
'Parameters'.

Why Exchange SmartNames?
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Exchanging SmartNames is typically done

• with other people (during an Esko training or to send to Esko Customer Service).
• with other servers (colleagues that use another Automation Engine server in another plant

of your company).

How to Recover a SmartName that was Deleted?

Your SmartNames are a standard part of the Automation Engine backup data. When you want
to restore SmartNames that were (accidentally) deleted, you can get them back by restoring a
backup of that configuration. The deleted SmartName of course has to be part of that backup.

Learn more about backups and how to restore them in The AE Server Admin web page (:9999) on
page 1781.

10.3.  System (Value) SmartNames

We will first list the default SmartNames of this type (System SmartNames), then show you
how to create your own (System Value SmartNames) and end with some examples.

10.3.1.  Default System SmartNames

We here describe the System type SmartNames that come with an install or update of your
Automation Engine server.

Remember:  In SmartNames View, the column Description already describes the
SmartName briefly.

Note:  Default System type SmartNames can not be changed. You can not double click and
open them. You can not copy them.

• Access Point Customer, Access Point E-mail Sender, Access Point E-mail Subject,
Access Point Host, Access Point Name, Access Point User can all be used when using
(specific) Access Points.

• Access Point Path: the path to the folder on the (S)FTP server that will be scanned.

• Access Point Protocol: describes the used file transfer protocol. For example 'FTP' or
'GDRIVE' (for a Google Drive Access Point).

• Application Name and Application Version: mentions the name and or the version of
your Automation Engine software.

• Assembly: Assembly method as defined in the JDF file (Assembly/@order), only used in
page imposition tasks.

• Auto-Number1: the main reason to use this SmartName is to add control over sorting
the files in the workflow. If you choose as output file name [File]_[Auto-Number1]
then each output file will get an (increasing) number. For example: your task input files are
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banana, lemon and mango.pdf. Then the output file names will be banana_1.pdf,
lemon_2.pdf and mango_3.pdf.

Attention:  This SmartName is only valid when the task has multiple input files and
if those are grouped as one 'token'. This is often the case in page workflows. Learn
more about tokens in Understanding Tokens (Grouping of Output Files). That page
explains how you can group input files into one 'token' by using the Data Collector.

Note:  Notice that this SmartName is not related to version numbering!

• Back: the distance between the center of the back of the section and the trim box of the
page (typically used to add collating marks to a page imposition).

• Backing up: the "backing up" method of the press (turn or tumble) as defined in the JDF file.

• Book Name and Book Number: name and number of the book (ImposeProof only).

• CDI Device Name: name of CDI device (used in the CTP Flexo view modes).

• CSR for the Job: name of the customer service representative of the Job.

• Customer's Product Reference: name that your customer gives to the Product item.

• Customer's Job Reference: name that your customer gives to "his" job order.

• Date: the current date, formatted YYYYMMDD .

• Device ID, Device Model Description, Device Model name, Device Model Number,
Device Type: as defined in the JDF file, used for page imposition "Stripping" tasks.

• E-mail Address of the CSR for the Job: the e-mail address of the customer service
representative for the Job.

• Extension of File: the extension of the input file.

• File: the name of the input file without extension.

• File Type: the file type of the input file, for example PDF or PDFSC (= Esko Normalized PDF).

• Folder URL: the URL of the folder of the input file, the full path. Formerly known as [File
URL] .

• First Folder of File: the name of the first folder of the input file. For example: When the
Folder URL is file://aeserver01/ShareThatYouMadeContainer/FirstFolder/
SecondFolder/banana.pdf here, the First Folder of File is 'FirstFolder'.

• Folder of File: the name of the folder of the input file. In above example this is
'SecondFolder'.

• Folder of First Input of Master Workflow: name of the folder of the input file of the most
outer workflow.

• Folder of Input: the name of the folder of the input file (same as Folder of File).

• Folio: the page name of the current page (relates to Mark Information).

• Folios: a range of page names (folios) containing prefixes and suffixes (for example
~A~,~C~-~E~,~G~).
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• Imposition Name: the name of the imposition (page workflows).

• Ink Name: the name of the ink(s) (relates to Plate Information).

• JDF Device ID and JDF Device Name: the ID and name of the machine or software (RIP or
workflow) that interprets JDF.

• JDF Sheet Name and JDF Signature name: the sheet and signature name in the JDF file.

• Job Category ...: the category of the Job as defined in the Job setup, maximum 7 categories.

• Job Colors: the numbers of colors in the job (file) as found in the JDF file.

• Job Colors Mode: the Job color mode ('Black&White' or 'Full') as found in the JDF file.

• Job Container Name: the name of the Container where the Job has its Job Folder.

• Job Container URL: the URL of the Container where the Job has its Job Folder.

• Job CT URL: the URL of the "ct" folder of the Job (= where image files can be created during
normalization).

• Job Customer Contact 1, 2, 3 : the name of the 1st, 2nd and 3rd contact of the Customer
of the Job.

• Job Customer Description: the description of the Customer of the Job.

• Job Customer E-mail 1, 2, 3: the e-mail address of the 1st, 2nd and 3rd contact of the
Customer of the Job.

• Job Customer ID and Job Customer Name: the ID and name of the Customer of the Job.

• Job Customer Info 1, 2, 3, 4, 5: the 1st etc.. info of the Customer of the Job.

• Job Description: the description of the Job.

• Job Due Date: the due date of the Job (YYYYMMDD).

• Job Due Time: the due time of the Job (HHMMSS).

• Job File Format: the file format of the Job (standard format is Esko normalized PDF).

• Job ID (internal) and Job Name: the internal ID and the name of the Job.

• Job Temp URL: the URL of the "temp" subfolder of the Job Folder.

• Job URL: the URL of the Job's Job Folder.

• Layer Name: the name(s) of the layer(s).

• Layer Names: the names of the layers used in this sheet (page imposition workflows).

• Layer Number: the number(s) of the layer(s).

• Local Server: the name of the server where the task runs.

• Mark Height and Mark Width: height and width of the current mark.

• Master Server: name of the Automation Engine master server. This is the one that runs the
"task manager".

• Media Box Height and Media Box Width: the height and width (mm) of the Media Box of
the first page of the input file.
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• Merged Plate Name: This the name of the same as the CDI Job name, ending with an
extension ".par". This is also the name as it appears in the queue of the CDI's "Expose"
application. This name is defined in the Create Merged Plate task.

• Name (without extension) of originating Input of (enclosing) Workflow: the name of
the first input of the (enclosing) workflow.

Note:  The "enclosing workflow" is the workflow that the task, in which the SmartName is
used, is part of.

• Name of first Input of Master Workflow: the name of the first input of the (most outer)
workflow.

• Name of Folder of Job: the name of the Job Folder.

• Name of Folder of originating Input of (enclosing) Workflow: the name of the folder of
the first input of the (enclosing) Workflow.

• Name of originating Input of (enclosing) Workflow: the name of the first input of the
(enclosing) Workflow.

• n-th Input File: the index number of the input file (the how many'th it is).

• Number of Pages: the number of pages of the input file.

• Number of Pages (RunList): the number of pages in the RunList.

• Operator: the Automation Engine user that launched the task.

• Order ID: the Order ID of the Job.

• Padded Page Label: the page label padded with zeros (extra zeros in front).

• Padded Page Number: the page number padded with zeros (extra zeros in front). Only
used in the Split Pages task.

• Page Label: the label of the page. Only used in the Split Pages task.

• Page Height: and Page Width: the vertical and horizontal trim size of the page.

• Page Number: the page number (starting from 1) or page range if the 'One Ups' contain
more than one page.

• Page Numbers: a range of page numbers. For example: 1-5,7,9-11  .

• Page Range: the range of imposed pages available in the output file (ImposeProof only).

• Paper Height and Paper Width: the vertical and horizontal size of the paper (page
workflows).

• Plate Height and Plate Width: the vertical and horizontal size of the plate (page
workflows).

• Plate Template Name: the name of the plate template (page workflows).

• Press: the name of the press as defined in the JDF file (Device/@FriendlyName or Device/
@DeviceID).

• Print Group Name: the name of the print group (collection of sheets) or sheet. This is used
in (Black & White) page workflows.
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• Product Customer Description, Product Customer ID and Product Customer Name: the
description, ID and name of the customer for that Product.

• Product Custom Field 1, 2, 3: the custom field 1, 2 and 3 of the Product.

• Product Description, Product ID and Product Name: the description, ID and name of the
Product.

• Product Ordered Copies: the amount of ordered copies that were ordered of this Product
Part in this Job.

• Product Part Custom Field 1, 2, 3: the custom field 1, 2 and 3 for the Product Part.

• Product Part Data Zone: the URL of the Data Zone of the Product Part.

• Product Part Name: the name of the Product Part.

• Product Part Status: the status of the Product Part (the Esko system name).

• Project ID: the Project ID of the Job.

• RunList Name and RunList Number: the name of the RunList and its number in the
imposition.

• Section Number: the number of the section, starting from 1 (this is related to Marks).

• Server: the name of Automation Engine's (Master) Server.

• Sheet Colors and Sheet Colors Mode: the number of colors in the sheet and their color
mode ('Black&White' or 'Full'), as found in the JDF file (page workflows).

• Sheet Descriptive Name: a short description of the sheet as defined in the JDF file
(StrippingParams/@DescriptiveName), used in page workflows.

• Sheet Index: the index of the sheet (starting from 0), used in page workflows.

• Sheet Name (scope 'Stripping'): the name of the sheet as defined in the JDF file
(StrippingParams/@SheetName), used in page workflows.

• Sheet Name (scope 'Plate Information'): the name of the sheet, used in page workflows.

• Sheet Number: the number of the sheet (starting from 1), used in page workflows.

• Sheet Side: the side of the sheet: Front or Back (used in page workflows).

• Sheet Side SmartID: the SmartID of the sheet side (unique identification number).

• Short Task ID and Short Workflow Task ID: the short version of the task ID number and
the (most outer) workflow task ID number. For example: '5439'.

• Signature Name: the name of the signature as defined in the JDF file (StrippingParams/
@SignatureName), used in page workflows.

• SmartID: the SmartID of this file's version (unique identification number calculated from a
combination of an identifier of the file itself and of its external references).

• Stripping Part Number: Stripping part number as defined in the JDF file, used in page
workflows.

• Sub Order ID: the sub order ID of the Job.
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• System Defined: this is used when outputting .imp files (page impositions). It is a
combination of the imp name, sheet number, sheet side and layer name.

• Task ID (internal): the ID of the task in Automation Engine, the long version. For example:
'afbdf6ac-8d82-4eee-af4d-b2408041640f'.

• Task Name: the Esko system name of the task (workflow) ticket. For example the Add
SmartMarks task is called "batchbrix.smartmarks".

• Task Owner E-mail: the e-mail address of the owner of the task.

• Ticket Name: the name of the ticket of the task (the name you gave the ticket).

• Time: the current time (when the SmartName is calculated), formatted HHMMSS.

• Trim Box Height and Trim Box Width: Height and width of the Trim Box (mm) of the first
page of the input file.

• URL of first Input of Master Workflow: the URL of the first input file of the (most outer)
workflow.

• URL of Folder of Input: the URL of the folder of the input file.

• URL of Folder of originating Input of (enclosing) workflow: the URL of the folder of the
first input of the (enclosing) workflow.

• URL of Input: the URL of the input file.

• URL of originating input of (enclosing) workflow: the URL of the first input of the
(enclosing) workflow.

• Variant Name and Variant Number: the name(s) and number(s) of the variant(s) (used in
page imposition workflows).

• Web (scope 'Imposition'): this is the index of the web in the print group (used in page
workflows).

• Web (scope 'Plate Information'): this is the number of the web (for multi-web printing in
page workflows).

• Workflow Task ID (internal): the ID of the (most outer) workflow task.

• Work Method: the working method for 'backing up' Back to Front (page workflows).

• Work Style: the name of the work style defined in the JDF file (StrippingParams/
@WorkStyle).

10.3.2.  Creating System Value SmartNames

As we introduced in SmartName Types (Overview) on page 598, a System SmartName is a
query to one of Automation Engine's own databases. Think of it as a question to Automation
Engine.

As you can see in Default System SmartNames on page 614, there are already a lot Default
System SmartNames. Still, there are still some cases where it makes sense to create your own
extra System Value SmartNames.
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Concept
When creating your own System Value SmartName, your question can be one of these 3:

• "Give me the Job URL, the full network path to the Job's Job Folder"
• "Give me the Product Part URL, the full network path to the Product Part file"
• "Give me the Product Part Data Zone URL, the full network path to the Product Part Data

Zone"

These questions usually come up in these 2 cases:

• when you receive a file and you want to store it in a Job or Product related folder
• when you want to get a file from (under) those places.

In both cases, you need to add 1 or more parameters in your question that you do know. For
example: "Where is the Job Folder if I tell you that the Order ID is 12345 and the Customer ID is
67888 ?"

Note:  In a perfect world, you have a perfect data structure that is very logic and it never
changes. Then you would maybe not have these questions. However, it can for example
happen that your data Containers fill up and you may not be sure on which one the Job Folder
was created. Or the files that you receive need more analysis to interpret where they belong to.

Creating a System Value SmartName - Generic Steps
We here only show the basic generic steps to create such a SmartName. See further for 3
specific examples.

1. In the SmartNames View, click on 
2. Choose the Type 'System Value'.
3. Choose a Scope. If you are not sure, choose Global. Learn more about SmartName Scopes

on page 602.
4. Which System Value: choose the type you are you are looking for.

A list of attributes will appear. These will help to find what you want.
5. Check the attribute(s) that you do know, one could be enough.
6. Enter the value of each checked attribute. This will probably also be a SmartName.

You obviously need to prepare these SmartName(s) first.
7. Check the Result value already shown below left. This will only be possible when you are

in SmartNames View and are using the Resolve all using tool. Learn more in Test your
SmartNames with 'Resolve All Using' on page 608.

8. Click Save as... to save your SmartName.

Example of Looking for the Job URL

Example: Finding the Job URL by using the name of an incoming design file

• You have created a Job '1237' and you are waiting for the customers design file.

• You receive a design file via E-mail or FTP. Your customer does not know what Job name you
already created. The name of the design file is '78999_Banana.pdf'. This name starts with
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how the customer names this job/design: the Customer 's Job Reference, followed by a free
name reflecting the design variant (here the banana flavor).

• The setup of your Job '1237' also includes this Customer 's Job reference '78999' (this
information came in earlier via your business system).

• You created a SmartName 'EXA FILE_ALLBEFORE_', a String Extract SmartName
that extracts from a file name all characters before the '_' . Learn more in String Extract
SmartNames on page 624.

• Your System Value SmartName SmartName now needs the settings as in this screen shot:
 

 

• Save your SmartName with a logical name. For example 'Find Job via Cust Ref Nrs
in Design File'.

Example of Looking for the Product Part URL

Example: Finding the full Product Part URL by asking the Product ID

• Your business system sends you an XML with a list of product items on which you need to
launch a workflow.

• Business systems often do not know how your prepress data isstructured. The XML
mentions the Product ID but does not know the exact path to that Product Part. So you
need to find out that URL.

• For example, we look for the full URL of the Product ID '12345'. What the business
system does not know is the folder and the name of the PDF. The PDF name is
'tomato_juice.pdf', it has no reference to the Product ID.
 

 

• You first need to create a SmartName that extracts the Product ID from the XML. See this
example:
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Learn more about extracting values from an XML file in XPath Query SmartNames on page
629.

• Your System Value SmartName then uses that Xpath Query SmartName:
 

 
See (below left) how the Result shows the complete URL to the PDF. This is what we were
looking for.

• Save your SmartName with a logical name. For example 'Find ProdPart URL via Prod
ID in XML file'.

Example of Looking for the Product Part Data Zone URL

Example: Finding the Product Part Data Zone URL by using the name of an
incoming design file
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• You have a workflow where you business system creates new Products on your Automation
Engine, even before the design file has arrived.

• One of those is the Product '6662712_Yolo_Juice' that is waiting for its design (and has
no thumbnail display yet). The number before the underscore is the product ID.
 

 

• You have a Folder Access Point (or E-mail or FTP or WebCenter) that you scan for incoming
designs.

• When a design comes in, you first want to copy it to the right destination: to its Product
Part Data Zone.

• You need a System Value SmartName as in this screen shot:
 

 

• Save your SmartName with a logical name. For example 'Find ProdPart DataZone URL
via ProdID in Design File'.

• Your Copy or Move File ticket now uses this SmartName:
 

 

• You probably want to continue your workflow with the Manage Product Status task to
change the status of this Product Part to 'Design File Arrived'.
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10.4.  String Extract SmartNames

When automating your workflow, you will quickly feel the need to extract a part of a file name
or a network path. String Extract SmartNames offer to do just this.

Note:  A String is a series of characters. These can be numbers, text or even symbols.

10.4.1.  Creating a String Extract SmartName

To create a String Extract SmartName, follow these steps:

1. In SmartNames View, click on .
2. Choose the Type 'String Extract'.
3. Choose a Scope. If you are not sure, choose Global. Learn more about SmartName Scopes

on page 602.
4. In Extract part of..., decide from what you will extract something. In the canvas, you can

• type. This is mostly done to test your SmartName while creating it (you see the result
below left)

• insert SmartNames. This is the most typical use, for example to extract parts of a
[File] or a [Folder URL].

• right-click and choose an option: Cut, Copy, Paste, Clear Contents or Insert
SmartName.
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5. Define what you want to extract. Choose from these 3 methods:

• Start from character. Learn more in Start From Character on page 625.

• Use separation character. Learn more in Use Separation Character on page 626.

• Use regular expression. A "Regular Expression" is a standard language in computer
science. It enables very specific ways to extract parts of a string. Learn more in Using
Regular Expressions on page 656.

Caution:  Results can vary if your input string is considered as a text or as a
number! This is decided in the Formatting Options. The default is that your string
is assumed to be text. Learn more about this in Formatting SmartNames  on page
649.

Note:  The Result will update itself only after you changed a setting or clicked somewhere
in a different field. Tip: press the 'Tab' button to make sure that the Result is re-calculated.

6. Click Save to save your SmartName and close the dialog. Click Save As... to save your
SmartName but keep the dialog open (to create more SmartNames).

Start From Character
This method allows to decide the start and end character that you extract. Some examples:
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Example 1: "First 5"

Your input string is '874095620banana' and you want to extract the first 5 characters.

Choose Start from character. For Start from Character choose '1' and for Number of
Characters choose '5'. This will result in '87409'.

Note:  This method is mostly used to extract the first characters of a file name. To extract the
last part of a file name, you need to use Regular Expressions. Learn more in Using Regular
Expressions on page 656.

Example 2: "All except the first 3"

Your input string is '8740956202537435'. You want to extract all of the characters except the
first 3.

Choose Start from character. For Start from Character choose '4' and for Number of
Characters leave the default setting to '999'. This will result in '0956202537435'.

Use Separation Character
This method allows to separate the string into parts every time a certain Separation
Character occurs, and extract one of the parts.

You can choose a Separation Character from the list but you can also type in a different
one.
 

 

The String Part is where you choose which part of the string you want to extract.

Example 1: "Everything before the (first) underscore"

Your input string is '12345_678901' and you want to extract everything before the underscore
'_'.

Choose Separation Character '_' and set the String Part to '1'.

This will result in '12345'.

Example 2: "The 3rd part"

Your input string is '87409_5620_27_923' and you want to extract the number '27' which is
the 3rd part of the string (if you separate it with the '_').

Choose Separation Character '_' and set the String Part to '3'.
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This will result in '27'.

Note:  If you want the part after the last '_', then this is not possible using the Use separation
character. To do that, you need to use the method 'Use regular expression'. Learn more in
Using Regular Expressions on page 656 .

Example 3: "Everything after the '@' "

Your input string is 'Franky.Fruit@FruitCo.com' and you want to extract everything after
the '@'.

In Separation Character, type in '@' and set the String Part to '2'.

This will result in 'FruitCo.com'.

Use Regular Expression (link)
Learn all about Regular Expressions in a separate section of this chapter, in Using Regular
Expressions on page 656.

10.5.  CSV Text Extract SmartNames

A CSV Text Extract SmartName allows you to create a SmartName that finds a value in a
specific field of a CSV file. We will first illustrate the generic steps to create such a SmartName
and then show a concrete example.

Note:  Although the name of this SmartName type contains the word 'text', the value that is
extracted can also be a number or any other character type.

10.5.1.  Creating a CSV Text Extract SmartName

To create a CSV Text Extract SmartName, follow these steps:

1. In SmartNames View, click on .
2. Choose the Type 'CSV Text Extract'.
3. Choose a Scope. If you are not sure, choose Global. Learn more about SmartName Scopes

on page 602.
4. Define where your CSV can be found and set some options:

• CSV Source: Define the path and name of the CSV file. You typically use SmartNames
here.

• Text Encoding: Indicate the Text Encoding of the CSV file. The default encoding is
Unicode UTF-8.

• Field Separator: Indicate which character is used to separate the fields in the CSV. If
you're not sure, open your CSV in a simple text editor.
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• Quote Character: Indicate if the value in the CSV contains quotes that you do not want
to keep. For example: in the CSV a value is written as "25000" but you want to extract
only the 25000.

• Ignore line breaks: Check this option if the CSV only contains one record (column).

• Ignore first line: Check this option if the first line of the CSV contains the names of the
columns. Use Select Field... to preview the effect of this.

5. Define which specific field in the CSV you want to extract.

• Type the number of the field and line in Extract text from field ... on line ....

• or click on Select Field... to get a preview of your CSV file and there click the field you
want to extract. The field and line number will then be entered automatically.

Note:  A preview of your CSV file will only appear if the field CSV Source can already find
your CSV input file.

6. Check the result in Result.
7. If needed, set any Formatting Options. Learn more in Formatting SmartNames  on page

649.
8. Click Save to save your SmartName and close the dialog. Click Save As... to save your

SmartName but keep the dialog open (to create more SmartNames).

10.5.2.  Example

• You are working with the Products tool and have set up some integration with your
business system. You have set up a workflow where your Jobs are created automatically.

• You also get (from another system) a CSV file with the ordered copies (amount) that a
Product is to be produced in that Job context. The CSV is written in the Job Folder, in a
subfolder CSV and with a specific name. The screen shot shows how the CSV Text Extract
SmartName can be set up:
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• This SmartName [Find Amount in local CSV] can now be used in your automated
workflow where you use the Link Product to Job task.
 

 

10.6.  XPath Query SmartNames

As mentioned in SmartName Types (Overview) on page 598, XPath Query SmartNames
use "XPath queries" to extract a value from an XML file. XPath, the XML Path Language, is a
standard query language for selecting nodes from an XML.
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In Automation Engine, there are many tasks that can read parts of an XML, often without the
need to create a SmartName first. You can there directly enter an 'inline' XPath expression in
the ticket's input field. See for example the Create Job task.

Tip:  Many of such tasks and tools are described in the chapter Integrating with External Systems
on page 1553.

To help you build such XPath queries, Esko offers the The XPath Builder  on page 631. This
tool is available throughout Automation Engine, wherever you can create XPath queries.

10.6.1.  Creating an XPath Query SmartName

To create an XPath Query SmartName, follow these steps:

1. In SmartNames View, click on .
2. Choose the Type 'XPath Query'.
3. Choose a Scope. If you are not sure, choose Global. Learn more about SmartName Scopes

on page 602.
4. The large canvas is where you define your XPath Expression. Initially, there is an example

expression about 'vsize'. It will be removed automatically when you have used the Edit
button and created your own. In this canvas, you can:

• Type an XPath expression (if you know how to do this).
• Click on Edit to open the XPath Builder. This tool helps you create an Xpath expression.

Learn more in The XPath Builder  on page 631.

• Click on Insert SmartName to insert SmartName(s) into your XPath expression. This is
in most cases not needed.

• Right-click and choose an option: Cut, Copy, Paste, Clear Contents or Insert
SmartName.

 

630



10Automation Engine

 
5. Separator: If the XPath Expression returns multiple elements, decide what character you

want to use as separator.
6. XML Source: Define the path and name of the XML. Or keep the default SmartName [URL

of Input].
7. Result: See the result of your XPath Expression. This is possible when the XML Source can

be found. The Result is also visible when you are in SmartNames View and are using the
tool Resolve all using and have manually selected an example XML. Learn more in Test your
SmartNames with 'Resolve All Using' on page 608.

8. Formatting Options: Learn more in Formatting SmartNames  on page 649.
9. Click Save to save your SmartName and close the dialog. Click Save As... to save your

SmartName but keep the dialog open (to create more SmartNames).

10.6.2.  The XPath Builder

Introduction

XPath is a language that describes how to locate elements and attributes in XML (Extensible
Markup Language) files. You can find a full specification on http://www.w3.org/TR/xpath/ and a
tutorial on http://www.w3schools.com/xpath/.

Think of an XPath Query SmartName as a String Extract SmartName but then to get a
string from an XML file.

The XPath Builder is an XML editor available in the Pilot. Anywhere in the Automation Engine
where there is a field that allows an XPath Expression, you can access the XPath Builder by
clicking on its icon .

Note:  If you are an expert in building XPath expressions, you can also directly type XPath
expressions in this field. The syntax for doing this is  "XPath:" followed by a valid XPath
expression for the input file. Example: 
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The XPath Builder panel
 

 

• On top of the panel, you see the resulting XPath Expression that is probably a result of
what you have clicked below.

Attention:  This top field also offers to add SmartNames to this expression (see the
icon on the right).

• Adding SmartNames to your XPath expression is only supported when you
use this tool while you are creating a SmartName (see Creating an XPath Query
SmartName on page 630).

• Adding SmartNames to your XPath expression is not supported when you are
creating an 'inline' XPath expression. Several tasks allows this and show this by
offering an  icon in that field. For example the Create Job task. It does not
matter if you type that SmartName in yourself or click  to use this Builder
tool to add it to your XPath expression.

• The large canvas shows the Example XML Content.

• When possible, the example XML is automatically taken from the context. For example
when you open the XPath builder from the XPath Query SmartName dialog, then the
input file is used as an example XML.
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• When no example XML is available automatically, right-click in the canvas to see these
extra ways to get and manage XML content: Cut, Copy, Paste, Clear and Paste from
File....

• Use CTRL-F (Windows) or CMD-F (Mac) to open a Find tool. This is very handy when your
XML is a large file and you quickly want to find the string you want to select.

Note:  This area has XML syntax highlighting: specific colors indicate a specific kind of node.

• On the right you have tools that help you create the XPath Expression by offering smart
selections and even help you edit the XML content.

Building XPath Expressions

Select XML node
To build an XPath Expression, make sure that the Select XML Node button is clicked.

Simply click on an XML node to automatically create an XPath to that node. The resulting XPath
is shown in the XPath Expression field at the top.

Note:

• The created XPath will be an "absolute XPath" from the root node to the selected node.
• The selected node will be highlighted in yellow.
• When the selected node is used in a list, an index number will be used in the XPath. For

example: /PurchaseOrders/PurchaseOrder[1]/Address[2]/Street/text().

• The generated XPath takes namespaces into account by using the local-name
function. For example:  /*[local-name()='PurchaseOrder'][@*[local-
name()='PurchaseOrderNumber']='99503']/*[local-name()='Address']
[@*[local-name()='Type']='Billing']/*[local-name()='Street']/text()

Note:  By selecting Enforce namespaces, the XPath Builder will verify any used
namespace.

Add Condition

To add certain conditions to the XPath, click Add Condition. Then click on the desired XML
node to add it as a 'predicate' to the XPath Expression.

Note:

• You can also add a condition by clicking on the desired XML node while holding the Alt key.
• The predicate nodes are highlighted in green.
• When using predicate nodes, the indices in the XPath are replaced with predicates. For

example: /PurchaseOrders/PurchaseOrder[@PurchaseOrderNumber='99503']/
Address[@Type='Billing']/Street/text()).

• When using predicates, it is possible that the XPath Expression selects multiple XML nodes.
The number of matches is displayed beneath the XPath Expression.
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Options
• Select siblings. Select this option to select all occurrences of the selected element at this

level.

Tip:  This option is especially relevant when working with 'repeating content' in the Map
data task. You there need to Select siblings to avoid that only the first element would be
repeated (you would so get a list of only 1).

• Enforce namespaces. Select this option to enforce XML namespaces ('xmlns').

Tip:  XML namespaces provide a method to avoid element name conflicts. In XML, element
names are defined by the developer. This often results in a conflict when trying to mix XML
files from different XML applications.

• Use prefixes. Check this option if you want to use XML namespaces in your Xpath
Expression in a shorter way.

Note:  This option overrules the option Enforce namespaces.

Tip:  This option is especially useful when querying XMP.
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Editing Example XML Content

Format XML

Under Example XML Content, click on Format XML to format the example XML. This can be
used to make the XML more readable. It will typically remove unnecessary spaces and lines.

Edit XML
To edit the example XML, follow these steps:

1. Under Example XML Content, click on Edit XML.

Note:  This will make the XML content editable. Also, the buttons Revert and Apply will
become visible.

2. Edit the XML in any way you want.
3. When finished making changes, click Apply.

Note:  The changes will be automatically validated. If the XML is not valid, an error message
will appear and the location where the parse error occurred will be visible and highlighted in
a red color.

4. Before you click Apply, you can click on Revert to undo all changes made to the XML
content.

Note:  You can undo/redo the last edits using (on Windows) Ctrl-Z and Ctrl-shift-Z or (on
Mac) Command-Z and Command-Shift-Z.

Note:  If you clicked Apply but did this in error, you can still click Cancel.

Note:  It is also possible to edit the XPath Expression itself manually. When you do this, take
the following into account:

• After editing the XPath, press Enter to validate the updated XPath Expression.
• If the updated XPath Expression is not valid, an error message will be displayed beneath

the XPath Expression.
• The corresponding XML nodes will be highlighted in grey.

10.7.  XMP path Query SmartNames

XMP stands for ‘eXtensible Metadata Platform’. It allows embedding data about a file, known as
metadata, into the file itself. It is a standard defined by Adobe.

Esko also uses XMP as format for metadata in many of its processed files (Normalized PDF,
View data, LEN and other RIP output).

Important:  When Automation Engine processes native PDF files (so including PDF+ files),
without normalizing them, then there is no XMP metadata added to the PDF file. You can then
use the task Export PDF Info to export the PDFs metadata to an XML file.
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Note:  A full specification of how Esko uses XMP is available as part of the Automation Engine
Online Help, Find this document in the section below named "Related Documentation".

Because XMP is actually XML embedded in a file, you can also use SmartNames to query that
metadata. XMP path Query SmartNames are very similar to Xpath Query SmartNames. The
main difference is that the source file is not a XML but a file with embedded XMP. The way to
that metadata is also an Xpath Expression.

Tip:  When using an XMP XPath SmartName in the Output field of a this task ticket, and the
XMP XPath cannot be resolved (because there is an error in the SmartName or the queried
data cannot be found), the output file is saved in a /xmp_unresolved subfolder.

10.7.1.  Creating an XMP path Query SmartName

When creating an XMP path Query SmartName, it is typical is that we first need to indicate
our example input file, the one that contains the example XMP.

To create an XMP path Query SmartName, follow these steps:

1. In SmartNames View, in Resolve all using, check A file and browse to your (example) file
that has the XMP metadata.

2. In SmartNames View, click on .
3. Choose the Type 'XMP path Query'.
4. Choose a Scope. If you are not sure, choose Global. Learn more about SmartName Scopes

on page 602.
5. The large canvas is where you define your Xpath Expression. Initially, there is an example

expression about 'vsize'. If 'vsize' is mentioned in the XMP of the input file you
selected, it will already return a Result value (below left). This example expression will be
removed automatically when you have used the Edit button and created your own. In this
canvas, you can

• type an Xpath Expression (if you know how to do this).
• click on Edit to open the XPath Builder and create your expression there. Learn more in

The XPath Builder  on page 631.

• click on Insert SmartName to insert SmartName(s) into your Xpath Expression. This is
in most cases not needed.

• right-click and choose an option: Cut, Copy, Paste, Clear Contents or Insert
SmartName.

6. Separator: If the XPath Expression returns multiple elements, decide what character you
want to use as separator.

7. Result: See the result of your XPath Expression.
8. Formatting Options: Learn more in Formatting SmartNames  on page 649.
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9. Click Save to save your SmartName and close the dialog. Click Save As... to save your
SmartName but keep the dialog open (to create more SmartNames).

10.7.2.  Examples

Remember the many System SmartNames on 'Size'

There are many SmartNames that you no longer need to create yourself via XMP queries.
Remember these default (system type) SmartNames with Scope Page Information that may
already deliver exactly what you were looking for:
 

 
Learn more about them in Default System SmartNames on page 614.

What if my file does not have the XMP information I'm looking for?

For example: you want to get the 'vsize' of a native PDF. Your workflow does not create a
normalized PDF version of it (where you would automatically get that extra XMP). In that case,
you can use the LinkEdge task to create an XML containing the same XMP as you would find
inside a normalized file.

The next step is then to use an Xpath Query SmartName to get that specific XMP information
from inside that XML file. Learn more on how to do this in XPath Query SmartNames on page
629.

Which application created this file?

Most files with metadata will have a note about which application created the file. Follow these
steps:

1. Follow the generic steps as explained in Creating an XMP path Query SmartName on page
636.

2. In the example XML, use CTRL-F or CMD-F to find for the string 'CreatorTool'.
3. Select the node. For example: see how the 'CreatorTool' is selected in the example below:
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4. Click OK.
5. Check the Result and Save your SmartName.
6. Tip: to shorten this name, create another String Extract SmartName or a Regular Expression.

Which options were used when RIP'ing this file?

It can be useful to see with what resolution or distortion your RIP file was made. There are
tools to quickly detect that in Automation Engine, but your remote print site may not have
those tools. It can therefore be useful to extract that value and use it in a file name or (FTP)
folder name.

Follow the similar steps as in above example. See the screen shot to detect even more RIP
options in the XMP of a LEN file (made with FlexRip or Imaging Engine).
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10.8.  Conditional SmartNames

Conditional SmartNames base their value on one or more conditions. The condition can be
very basic or can be built up of several criteria and sub criteria. You can also define the order
in which the conditions need to be met.

After documenting how to create a Conditional SmartName, we illustrate their power with
some examples.

10.8.1.  Creating a Conditional SmartName (generic)

To create a Conditional SmartName, follow these steps:

1. In SmartNames View, click on .
2. Choose the Type 'Conditional'.
3. Choose a Scope. If you are not sure, choose Global. Learn more in SmartName Scopes on

page 602.
4. The dialog initially contains 2 blocks.

• A "conditional block". Each conditional block has one or more criteria and ends with the
Return value for that block.

• You can create extra conditional blocks using the buttons Add / Remove (Windows)
or  + -  (Mac).

• You can also right-click in the line If xxx of the following are true: and Duplicate
that block. Use the functions Move Up / Down or drag and drop the blocks to define
their order.

• The order of the blocks is the order that they will be checked, from top to bottom.
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• Learn more details in Setting up a Conditional Block on page 640.

• An "alternative block". When none of the above conditions match, this is what the
SmartName's return value will be. Type in the value (or use another SmartName).

5. Check the result in Result.
6. If needed, set any Formatting Options. Learn more in Formatting SmartNames  on page

649.
7. Click Save to save your SmartName and close the dialog. Click Save As... to save your

SmartName but keep the dialog open (to create more SmartNames).

10.8.2.  Setting up a Conditional Block

To set up a conditional block, follow these steps:

• If All - Any - None of the following are true. Choose the relation between the condition
and your (one or more) criteria.

• Per criterion, you need to

• select the attribute from the drop-down. Choose between the SmartName File or any
Other SmartName.

• select the text or number expression from the drop-down list. You can choose any of the
following expressions from the drop-down, depending on whether it is a text or numeric
condition:
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• For a text criterion, choose from the following expressions:

• Contains, begins with, ends with, is and is empty.

Use ' ' (space) for 'AND' and ';' for 'OR'. For example, a text criterion specifying:

• " 'Inkname' contains 'Pantone C' ": this will resolve all ink names that contain
'Pantone' and all that contain 'C'.

• " 'Inkname' is 'C; M; Y; K;' ": this will resolve the ink names that are
specifically any of these.

• Use double quotes to specify the exact text corresponding to the attribute.
For example: " Inkname contains "reflex blue" ": this will only resolve for
"reflex blue".

• For a number criterion, choose from the following expressions: equals, is greater
than, is less than, and is between. Some important notes:

• If the attribute does not correspond to a number, it will be ignored.
• You can use standard unit symbols and unit conversions are done in background.

For example: if you specify "equals 5 mm" then this is not a problem when the file's
XMP is defined in in (inches).

Note:  Unit conversions only work with units of the same kind. For example if the
specification is "equals 5 mm" then this will fail to resolve when the XMP mentions
"6 ppi" or just "6".

• Note:  Number expressions will not resolve to text strings. For example: "Job
Name equals  MyJobName " will be ignored because equals is used for numbers,
not text.

•
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Note:  Quotes ( " ) and semicolons ( ; ) are not accepted as values in the text and number
conditions.

• Adding criteria: You can add a criterion to a condition by clicking the +.

• Adding sub criteria. When you hold Alt while clicking the +, your new criterion will be a
sub-criteria of the one above. See Examples on page 642 where we use it to exclude some
attributes that were selected in the one above.

10.8.3.  Examples

Plate distortion depending on cylinder size

A Job Category is used to define size of the cylinder on which the product will be printed. This
circumference has an effect on the distortion that is required for the plate. A Conditional
SmartName defines the distortion setting for the RIP.
 

 

ReportMaker Template depends on the Customer

The ReportMaker ticket uses a SmartName to select its template. A conditional SmartName
checks who the customer is.

642



10Automation Engine

• First we check if it is our biggest customer 'FruitCo' (ID 777).
• Then we check if it is any customer of the group 'SuperToy' (any of those 3 IDs).
• If it is none of the above, we use a generic template for all other customers:

 

 

Dot Gain Compensation depending on the Press and type of flexo plates

If the press chosen for the Job is the flexo press Nilpeter, then the DGC file depends on the
category where the type of plates is defined: conventional flexo plates or digital flexo plates
(CDI):
 

 

Find the French only version (using a sub criterion to exclude some
attributes)

643



10 Automation Engine

Our SmartName is looking for Jobs that are in the French language, but not in combined
language versions. See how the extra sub criterion (ALT-'+') excludes the categories that
contain the Canadian and Belgian version Jobs that combine French with another language:
 

 

Smart preflight checking a workflow parameter 'Print Process' to check
allowed line width

Our workflow includes PitStop preflight. It is Smart Preflight because it uses SmartNames.
Our example shows how the preflight profile will check line width but have it depend on
the print process that the file will be printed in. The print process is defined as a workflow
parameter.

• This is our workflow parameter: [wfp.Print Process]
 

 

• This is how we set up our conditional SmartName (3 print processes each get a condition on
line width (mm)):
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• This is how our SmartName is used inside the PitStop Profile (there named 'variable'):

 

 

10.9.  Database Query SmartNames

10.9.1.  Concept

Database Query SmartNames ask a question to an external database. They pick up
information from other systems, typically business systems (planning, production...). They only
ask information, they do not write information into that external system.
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Note:  Database Query SmartNames may not be used to pick up information from a
database from Automation Engine itself. For such use cases, you use the System (Value)
SmartNames. Learn more in System (Value) SmartNames on page 614.

Some typical examples when you use Database Query SmartNames:

• In the Tabular Step & Repeat task. You can fill its many fields with Database Query
SmartNames and so pick up all the required values. Narrow-web label printers often use
this and base their queries on press type and die-shape.

• As a RIP option that you pick up from an external system. For example your business
system that created your Job may have informed you about main production decisions like
the press, the amount of plates and their size. But the distortion factor may need to be
picked up from another external system closer to the press room. In that case, you use a
Database Query SmartName in your RIP's setting for distortion.

How do Database Query SmartNames compare to the other tools that access
databases?

• A Database Access Point also does a database query but its other main feature is that it
triggers a workflow, and maybe you do not want that to happen at the moment you pick the
information.

• The Interact with Database task can read and write into external databases and can be
used as any step of a workflow. But it does not return you the values immediately, you get
them in a separate XML file from where you need to pick them up again (then via Xpath
Query SmartNames).

Note:  In cases where that XML is already available, it is advised to use the information from
the XML. For example: the XML that was used to create the Job, is stored in the Job Folder
and it also contains all the Step & Repeat information. In that case it is advised to pick up
that Step & Repeat info locally instead of asking it again to an external system (which always
means network traffic and small delays).

Basically, Database Query SmartNames is the preferred tool when you only want to pick up a
value and when an extra return-XML has no added value.

10.9.2.  Creating a Database Query SmartName

First set up the link to that external database

Setting up a link to an external database is done in Tools > Configure > External Databases.
Learn more on this in Configuring links to External Databases.

Now create the Database Query SmartName

To create a Database Query SmartName, follow these steps:

1. In SmartNames View, click on .
2. Choose the Type 'Database Query'.
3. Choose a Scope. If you are not sure, choose Global. Learn more in SmartName Scopes on

page 602.
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4. Choose the External Database from the drop-down list. If you need to create, change or
test the link to an external database, click Configure.

5. Write your SQL Command in the canvas. You can Insert SmartNames into your command.

Note:  Esko does not provide training in SQL commands. Contact your own IT database
specialist to help set these up.

 

 
6. Check the Result. The result will be (re-)calculated when you click any option outside the

canvas.
7. If needed, set any Formatting Options. Learn more in Formatting SmartNames  on page

649.
8. Click Save to save your SmartName and close the dialog. Click Save As... to save your

SmartName but keep the dialog open (to create more SmartNames).

Learn more about integrating with external databases

Learn more about using SQL commands in the chapter Integrating with External Systems on
page 1553, in the sections

• Database Access Point on page 1573

• Interact with Database task on page 1625

• An elaborate example.

10.10.  Script SmartNames

Script SmartNames use JavaScript to get a value. Typically, other SmartNames are inserted
into the script.

JavaScript is a standard scripting language. Learn more on http://en.wikipedia.org/wiki/
JavaScript_syntax or on http://www.w3schools.com/js/js_syntax.asp.
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Attention:  Before you create a Script SmartName, check if it can be built using
standard tools as

• a Conditional SmartName

• a Regular Expression (in a String Extract SmartName).

10.10.1.  Creating a Script SmartName

To create a Script SmartName, follow these steps:

1. In SmartNames View, click on .
2. Choose the Type 'Script'.
3. Choose a Scope. If you are not sure, choose Global. Learn more in SmartName Scopes on

page 602.
4. The canvas initially shows a JavaScript template that returns the value "hello".

Attention:  This template is important. The script needs to be a function returning a
value that is called from the body of the script. Learn more in this Esko KB article.

Replace it with your own JavaScript. You will probably Insert SmartNames into your script.
See some examples in Examples on page 649.
 

 
5. Check the result in Result. The result will be (re-)calculated when you click any option

outside the canvas.
6. If needed, set any Formatting Options. Learn more in Formatting SmartNames  on page

649.
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7. Click Save to save your SmartName and close the dialog. Click Save As... to save your
SmartName but keep the dialog open (to create more SmartNames).

10.10.2.  Examples

The following examples are just a few basic samples of what a JavaScript can do. If you need
help, Esko has specialists available through Esko Solution Services (Not Esko Customer Service).

Calculating: Multiply

This JavaScript multiplies the values of 3 Job Parameters (number SmartNames):
 

 

Extracting a few lines from a text:

This JavaScript returns the first 2 lines of a SmartName, in this case the Job Description:
 

 

10.11.  Formatting SmartNames

A lot of data that end up in SmartNames can come from external systems. And a lot of
information that you send back out to external systems may also be decided by SmartNames.
These systems can store their information in a different language, in a different regional
format or even a specific custom format. That is why it may be needed to change the format of
a SmartName.
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The formatting options are different whether your data is a Text, a Number or a Date or
Time.

Note:  A data string that contains both numbers and text characters is seen as Text. For
example: 789_87_banana is Text.

The option Formatting Options... is available when you create any SmartName.

10.11.1.  Text Formatting

When, in Formatting Options..., you select the Data Format 'Text', you get the following
options:
 

 

• Remove leading and trailing spaces: If your SmartName value includes space characters
at the beginning or end, use this option to remove those spaces.

• Text Case:

• Keep the original case of the SmartName value.

• change the text case using Make Upper Case or Make Lower Case.

• Specify any special Encoding of the SmartName value. Choose

• None to leave it like it is.

• XML Encoding. If your SmartName output will be used inside an XML file, your value can
contain a character that has a special meaning in XML (a 'reserved character'), then this
encoding will replace that character by a by an XML entity reference. For example '10<20'
will be formatted to '10&lt;20'.

• URL Encoding. Similar to the above, this will replace the reserved characters for URLs
with the typical 'percent encoding'. For example 'Digital Flexo' will be formatted to
'Digital%20Flexo'.
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• Custom Encoding: Use it to define custom replacements of characters or strings. Click
Edit and add one or more lines of rules. The rules will be executed from top to bottom.
For example:
 

 

• First all '// will be replaced by a '-' (needed when you use this text to become a
Windows-supported path)

• then all ' ' (spaces) will be replaced by a Dollar sign
• then all '@' will be replaced by 'at'
• then all words 'Limited' will be replaced by 'Ltd.'

The Result will update after a new setting as soon as you click in a different field.

10.11.2.  Number Formatting

When, in Formatting Options..., you select the Data Format 'Number', you get the following
options:

First check or define the Input Format Options.

Why first? Because this might already have an effect on the Result that you will be checking
when you start the actual (output) formatting options.

The Input Format Options allow you to inform Automation Engine how your input is
constructed, how it should be interpreted.
 

 
For example: Your input is '123456,789' and you want to indicate now that your Decimal
Separator is the ' , ' (comma) and that there is no Thousands Separator (None). You will
already see a change in the Result.
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(Output) Formatting Options

Now define how you want this Result formatted.

Note:  If the Result is already what you want, this means that the default settings in the
Formatting Options panel may already be the ones you want.

 

 

• Decimals: Indicate how many decimals you want. Select Auto to keep the number of
decimals like it was in the original value of the SmartName. See in above screen shot how
the setting 'decimals: 2' takes one decimal away and rounds the number to '79'. Another
example is to round values with too detailed numbers like '67,5000000000 to shorter ones
like '67,5' (one decimal left).

• Decimal Separator: Select the type you want. In above screen shot we confirm that the
comma is the one we want (to keep).

• Thousands Separator: Select the type you want. See in above screen shot how it adds the
point in between '3' and '4'.

Note:  The decimal and thousands separators cannot be identical.

• You can choose to Add leading zeros to the value of the SmartName to get a certain
number of Needed Digits. If the value of the SmartName has less digits in the integer part
than the specified number of needed digits, leading zeros will be added until the number of
needed digits is reached. For example, if the number of needed digits is 5, "123" becomes
"00123".

• You can choose to Convert the value of the SmartName to another unit.

• Length. Choose, in both directions, from Millimeters, Centimeters, Decimeters,
Meters, Inches, Mils and Points

• Angle. Choose, in both directions, from Radians and Degrees.
• File Size. Choose, in both directions, from Bytes, Kilobytes, Megabytes, Gigabytes and

Terabytes.
• Resolution. Choose, in both directions, from Pixels per Inch, Pixels per Millimeter,

Pixels per Centimeter, Lines per Inch, Lines per Millimeter and Lines per
Centimeter.
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• Time. Choose, in both directions, from Milliseconds, Seconds, Minutes, Hours, Days
and Weeks.

10.11.3.  Date and Time Formatting

When, in Formatting Options..., you select the Data Format 'Date and Time'.

It is very important that you first check or define the Input Format Options....

Input Format Options
Date and Time descriptions appear in many different formats. Before a SmartName value can
be re-formatted, it will be required to first explain Automation Engine how your input value is
constructed. This is what you do in Input Format Options.

 

 

Format: ISO 8601

Select this when your input date and time is in this standard format. This will be the case
when the date was constructed by Automation Engine. For example: your input data is
'2014-09-27T16:30:00.00+02:00' (September 27 2014, 4:30 PM in the time zone UTC+2).

Format: Unix Time (in milliseconds)

Select this when your input date and time is in this standard format. Unix time is used widely
between computers, it is the amount of seconds that have passed since 1 January 1970. For
example: '1410532200000' (milliseconds).
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Format: Custom

Select this when your input date and time is in any other format than the 2 above mentioned
standards.

• Language: the language that you select here affects the list of default custom date and time
formats in the Custom Format drop-down list.

• Custom Format: indicate here how your custom input is constructed. You can specify the
custom format using the following notation: E = name of day of week, d = day of month, M =
month, y = year, h/H = 12/24 hour, m = minute, s = second, a = AM/PM, z = time zone. Learn
more in this Example on page 654.

• Time Zone: If you want, you can select the Time Zone of the original value of the
SmartName.

Output Formatting Options
Once your input format is well understood by Automation Engine, you define the output
Formatting Options.

You here have the same options as in Input Format Options on page 653.

Note:  If your Date and Time serves a field in any Automation Engine database, it needs to be
formatted according ISO 8601.

Example
You have a workflow where your MIS sends you an XML every time a new Job has to be created
on Automation Engine (see an example of such workflows in  Examples of integrating with an
external system).

The XML from the MIS mentions the Job's Due Date but has its own particular way of
mentioning the date and time. We will need to reformat it to the standard ISO 8601 (that
Automation Engine requires in this example).

Follow these steps to get the result as shown in the screen shot:
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• In the setup of the SmartName, you see our input value 'Wednesday, October 1 2014,
3:35 AM'. Normally this date would in this canvas not be written out like this but it would
show up as another SmartName, one that picks up that date from the XML that we
mentioned earlier.

• Click Formatting Options..., do not check or change any settings there yet.

• Click Input Format Options..., Choose Custom and English.

• In Custom Format, type the string that you see in the screen shot. This is what those codes
mean:

• 'EEEE': 'E' means 'day of the week. 4 times 'E' means the day is written out in full text.

• then there is a comma and a space
• 'MMMM': 'M' means 'month'. 4 times 'M' means the month written out in full (text).

• then a space followed by 'd', meaning the day of the month (number)

• then a space followed by 'y', meaning the year, in (full) number

• then again a comma and a space
• then 'h:mm', meaning the hour (in 12 hour system), followed by a colon, followed by the

minutes
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• then a space and 'a', meaning 'AM'.
• Indicate that this time is one from the New York time zone.
• Click OK to confirm and close the Input Format Options dialog.
• Now set the (output) Formatting Options: Choose the ISO 8601 format  and choose the

same New York time zone
• Check the Result: you should see a ISO 8601 format of the custom description that we

received.
• Save the SmartName with a logical name.
• This SmartName (date) is one that we can now use in the Create Job task, for the Job Due

date.

10.12.  Using Regular Expressions

Regular Expressions are text patterns that are used to match strings. They can contain a mix
of plain text and special characters to indicate what to match. Find more information about
this standard tool on Wikipedia.

In Automation Engine, they are used for special cases where SmartNames do not offer a
solution. You can use Regular Expressions in

• String Extract SmartNames
• Some tasks: Select File, Select Marked File, Wait for Files, Download from EskoCloud ...
• Some Workflow Controls: Data Splitter, Sort and Router (when using 'matches' or 'does

not match').
• In Configure > Smart Job Location (when setting up a rule, in the field 'Matches'. )

Note:  Above tools also offer the RegEx Builder, a tool that helps you build the expression.

10.12.1.  A Selection of Useful Characters in Regular Expressions

Character Description Example

^ Beginning of the string. ^abc will only
lead to a match if the string begins
with abc.

^C matches "Cyan" but doesn't
match "PANTONE 120 C".

| OR cat|dog matches "cat" or "dog"

$ End of the string. xyz$ will only lead
to a match if the string ends with xyz.

120$ matches "PANTONE 120" but
doesn't match "PANTONE 120 C".

. The . matches any single character. ab.d matches "abcd" as well as
"ab9d" or "ab-d".

[abc] Brackets enclosing a set of
characters indicates that any of the
enclosed characters may match the
target character.

[abc] matches "a", "b" or "c" but
doesn't match "x" or "y".
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Character Description Example

[^abc] The ^ inside the brackets means that
none of the enclosed characters may
match the target character.

[^abc] matches "x" or "y" but
doesn't match "a", "b" or "c".

[a-zA-Z] The - inside the brackets is used to
show a range of characters.

[a-zA-Z] matches all upper
and lowercase characters, [0-9]
matches all digits.

\d matches a numeric character (digit)
(exactly the same as [0-9]).

\d\d matches "96" but doesn't
match "5a".

\D matches any non-numeric character
(exactly the same as [^0-9]).

\D\D matches "A+" but doesn't
match "A4".

\s matches a whitespace. \d\s matches "5 " but doesn't match
"5a".

\S matches any non-whitespace
character.

\s\S matches " 6" but doesn't match
" ".

\w matches an alphabetic (word)
character (exactly the same as [a-zA-
Z0-9]).

\w\w matches "9d" but doesn't
match "5+".

\W matches any non-alphabetic
character (exactly the same as [^a-
zA-Z0-9] or [^\w]).

\W\W matches "+ " but doesn't match
"5+".

? The ? matches the character to its left
0 or 1 times.

esk\w? matches "esk" as well as
"esko" but doesn't match "eskonv".

* The * matches the character to its
left 0 or more times.

c* matches "", "c", "cccc" etcetera.
esk\w* matches "esk" as well as
"Esko".

+ The + matches the character to its
left 1 or more times.

c+ matches "c", "cccc" but not "". esk
\w+ matches "esko" as well as "Esko"
but doesn't match "esk".

{n} The {n} matches the character to its
left exactly n times.

a{3} matches "aaa" but doesn't
match "aa" or "abc". ab{3}c matches
only "abbbc" .

{n,} The {n,} matches the character to its
left at least n times.

a{3,} matches "aaa" or "aaaaaa" but
doesn't match "aa" or "abc".

{n,m} The {n,m} matches the character to
its left at least n times, but no more
than m times.

a{3,5} matches "aaa", "aaaa" or
"aaaaa" but doesn't match "aa" or
"aaaaaa".

\ Escapes characters with a special
meaning. The \ can precede a special
character (like * or [ ) if you want to
search for it literally.

esko\\artwork\*nv matches "esko
\artwork*nv". \?$ matches "?" at the
end of a line.
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Some examples based on the above list

Regular Expression Matches Doesn’t Match

\d{6}-\w{5}-\d{1,3}\.pdf 312454-ESKO4-1.pdf

235682-USA12-23.pdf

31245A-ESKO4-1.pdf

312456-USA-23.pdf

PANTONE \d+ C$ PANTONE 120 C

PANTONE 15 C

PANTONE 120 U

PANTONE 15 CU

[Yy].* Yes

y

N

no

(Cyan)|(Magenta)|(Yellow) Cyan

Yellow

Black

Cyan SpotColor

10.12.2.  Using Parentheses to Extract

Use ( ) in the regular expression to define what to extract
Parentheses are used to define what you want to extract (to "capture a group").

Example:

• Input string: lemon

• Regular expression: le(mo)n

• Output: mo

What if I want to extract multiple groups?

Automation Engine does not support this. Only the first group in the string between ( ) will be
extracted.

Example:

• Input string: lemonandmango

• Regular expression: le(mo)na(nd)man(go)

• Output: mo

What if the input string already contains ( ) ?
When the input string already contains a set of parentheses, you have to "escape" those
characters, by adding a \ in front of them.

Example:

• Input string: ab(cd)e We want to extract the group between the ( ) .

• Regular expression: .*\((.*)\).*

In human language: something, then an open parentheses, then the group we want to extract,
until there's a closing parentheses, followed by something.

658



10Automation Engine

• Output: cd

10.12.3.  Examples from Users

These examples came from some customers. You may find more on Esko's Knowledge Base.

Note:  These examples were documented here before the RegEx Builder was introduced in v18.

Extracting the last character of a string

The SmartNames function Start From Character on page 625 makes it easy to extract the first
x characters of a string. With Regular Expressions, you can extract the last character(s). See
this example (you can change the number to extract more (last) characters):

Example input string: banana

Regular expression: .*(.{1})

Output: a

Extracting the server name from the SmartName 'Operator'

Example input string: Chantal@AESERVER01

Regular expression: (.+)@.+

Output: Chantal

Extracting the domain from an E-mail address

Example input string: michael.jackson@esko.com

Regular expression: .+@(.+)\.[a-z]+

Output: esko

Extracting the part of a file name after the last underscore

Example input string: Banana_v03_271265_p003.pdf

• with the file extension

• Regular expression: .*_(.*)

• Output: p003.pdf

• without the file extension

• Regular expression: .*_(.*)\..*

• Output: p003

Extracting the part of a file name between the 2nd and 3rd underscore
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Example input string: Banana_v03_271265_p003.pdf

Regular expression: [^_]*_[^_]*_(.*?)_.*

Output: 271265

Extracting a number from a file name

Example input string: Cosmo453_Advertisement_4.pdf

Convention in human language: something_something_number.pdf

Regular expression: .+_.+_([0-9]+).pdf

Output: 4

Defining a specific file selection - containing an 'exclude'

Some typical examples for use in the Select File task:

• To select all files except files where the name contains _report :

(?!.*_report).

• To select all files but exclude MAC files (starting with . ) :

(?!\.).*

• To select all ArtPro files, but exclude the automatically generated backup file:

(?!.* BU).*\.ap

Defining a specific file selection

• To select the file and the report of the file:

<file/>.pdf|<file/>_report.pdf

• To select only files with specific extensions. For example only the ARD and MFG files:

.*\.ard|.*\.mfg

10.12.4.  The RegEx Builder

Much like the XPath Builder helps to build XPath commands, the RegEx Builder will help you
create Regular Expressions.

To open the RegEx Builder:

• In an input field that allows many types of input data, click on .
• In an input field that only allows regular expressions only, click on .

• For example: When you create a SmartName of the type 'String Extract':
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We will use examples to explain the functionality in this tool.

Important:  Do check these examples in the below order. They explain different features, from
basic to more advanced ones.

RegEx Example 1 - Extracting the Domain Name from an E-mail Address

1. Open the RegEx Builder. The top part shows a 'Pattern Editor'.

You can choose to hide it. However we will use it in these examples.
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2. Add a text example in the field below. In our example, a typical E-mail address:

 

 
3. Analyse the pattern in your example text and re-create that pattern in the top field. To get

the domain name from this E-mail address ('esko'), we need everything after the '@' and
before the last '.' .

Follow these steps:

• After the text pattern (by default present and highlighted in green), type an '@'
• then click the Text button to add another text pattern

• then add a '.'

• then click Text to add another text pattern.

Notice how the Regular Expression has started building itself.
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4. We need the text right after the '@', so we select the 2nd text pattern. This highlights it in

blue. We then click on Extract Selection.
 

 

Note:  You can also right-click the selected pattern and choose Extract Selection from
there.

5. The regular expression was updated. The part of the example text that this expression
matches is highlighted in green.
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6. When you see that the correct part of your example will be extracted, this means that the

regular expression - that was automatically built - is correct. This expression will indeed
extract the domain name from an E-mail address.

Tip:  In this case, the pattern editor helped us create the regular expression. This also works
vice versa: You can write or paste an expression in its field and when you then press 'Enter',
the matching pattern will appear in the pattern editor above.

7. Optionally, to further test that expression, you can add more examples. In every example,
you want to see the part that will be extracted highlighted in green:
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8. Click OK to close this panel and have the regular expression copied to the field from where

you opened this tool.

RegEx Example 2 - Extracting a Number at the End of a File Name

Attention:  We here describe the case where the number always appears after a
known separator character. This number could be a page number for example.
Example 4 shows what you could do when there is no character that you can use as a
separator.

Follow these steps:

1. Add one or multiple examples of such file names in the below field (one per line). We here
add 3 examples.

2. Then construct the pattern that re-occurs in these names:

• Anything ('Text')

• followed by a '_'

• followed by a Number

• followed by a '.'

• followed by another Text for the file extension.
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Important:  In above image, you can notice that a text pattern can contain both letters and
digits.

3. In the pattern field, select what you want to extract (the number pattern) and click on
Extract Selection.

The examples highlight that result in green:
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Notice how the 3rd example does not match the definition of the patterns. This is because it
has no characters in front of its '_' .

4. Click OK to close this panel and have the regular expression copied to the field from where
you opened this tool.

RegEx Example 3 - Extracting everything after the first underscore

Note:  This example explains the option Match as few characters as possible.

Follow these steps:

1. Add one or multiple examples of file names containing multiple underscores (one per line).
2. Construct the pattern. We want to extract everything after the first '_' , no matter how

many '_' there are in that name!

• We start by adding a text pattern,
• then type an '_'
• and then add another text pattern.

 

 
3. See above how the 3 examples show a different result. They seem to use the last

underscore to decide the split of the name.
4. We need to specify that it is the first underscore that will decide the extraction. To do this,

click on the small arrow on the right of the first text pattern. There, activate the option
Match as few characters as possible. Click OK.
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Note:  See below how this option inserts a '?' in the regular expression and in that one text
pattern. In RegEx terms, this is also known as "non greedy".

5. Select the first text pattern and click Extract Selection.
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6. We now see the result we want. In each example, only everything before the first '_' is
highlighted.
 

 
7. Click OK to close this panel and have the regular expression copied to the field from where

you opened this tool.

RegEx Example 4 - Extracting a number without a separator character

Note:  This one is very similar to example 2, but here we also need the option Match as few
characters as possible that we introduced in example 3.

1. We now have names of which we only want the numbers at the end of the file. We enter
some examples and create the pattern:

• Some text pattern,
• followed by some number
• and then a '.'
• followed by some text (the file extension).
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2. Notice in the above image how the text pattern tries to grasp all the characters possible (see

the green part in the examples). It has to leave one number at least because there is still a
number pattern before the '.' .

Note:  This is a good example of the RegEx term "greedy".

Note:  We mentioned earlier that a text pattern can contain both letters and digits.

3. By forcing the initial text pattern to match as few characters as possible (= the opposite of
"greedy"), the numbers pattern now contains all numbers at the end of the file name. This is
what we were looking for:
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Note:  The effect of this option is only visible after clicking OK in that 'Options' dialog. What
you see above is when you re-open that 'Options' dialog.

4. Click OK to close this panel and have the regular expression copied to the field from where
you opened this tool.

RegEx Example 5 - Extracting the last 6 characters or less, when another
pattern allows it
We want to extract the last 6 characters, also when the input string has less than 6 (then
we extract as many as there are). We also show how another pattern influences the result,
depending if it's "greedy" or not.

Follow these steps:

1. After opening this editor, we enter these 6 example lines:
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2. Click on Text to add a second text pattern. In that one, set the Minimum Number Of
Characters to '1' and the Maximum to '6'.

This is what you see before you click OK:
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3. Click OK to confirm these options. Then, select the second pattern (darker blue) and then
click Extract Selection to see what this pattern currently extracts.

See how, in all example lines, the resulting expression still only extracts the last character
(green highlight):
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The reason that we don't see the last 6 characters in green is because of the other text
pattern. That first pattern is also still "greedy": it tries to match as many characters as
possible, which only leaves the minimum of 1 character for the second text pattern.

4. In the first text pattern, we now select the option Match as few characters as possible.
This is how we tell it to "not be so greedy". We also set its Minimum Number Of
Characters to '1'.

The combination of these 2 options means that this pattern will always take 1 character,
possibly more, but leave the priority to the other patterns.

This is what you see before you click OK:
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5. Click OK to confirm those options.

Now again select the 2nd pattern (darker blue) and click Extract Selection.

Our example lines now show that this expression extracts what we wanted:
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6. You saw above that patterns can influence each other. To also understand what the 1st
pattern really does in our example, select it and click Extract Selection.

Our example lines now show that it minimally takes one character and then takes as many
extra characters as the second pattern allows to take (which wants 6 maximum).
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7. Before you click OK to close this editor and transfer the expression, make sure that the field
Regular Expression: contains the expression you wanted ; in this case you want the one
from the second pattern.

So, as you did in step 4, select the second pattern again and click Extract Selection to make
sure the expression is .+?(.{1,6}).
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Then click OK to close this editor and have that regular expression copied to the field from
where you opened this tool.

RegEx Example 6 - Extracting the last line of a multiline input

Note:  This example uses the option Dot matches all.

Our input (file) is a multiline document and we want to extract only the last line.

1. Our example text has 5 lines. When we set the option Multiline example, it is now seen as
only 1 example.
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2. Add a text pattern *below* the first one. Set the option 'Dot matches all'. In Regular

Expressions, the regex dot character matches by default all characters excluding line break
characters.

Activating this option makes it also see the line breaks. The below text pattern is now seen
as the last line of text:
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3. Click OK to close this panel and have the regular expression copied to the field from where

you opened this tool.

RegEx Example 7 - Selecting a specific range of files

This is an example that can be used in the Select File task.

In our example, we want to select all files except files starting with a '.' (the hidden MacOS files)
and files of which the name ends with '_report' .

1. In this task, the RegEx Builder is slightly different. You can add several rows of patterns. See
the word 'or' on its left side:
 

 
2. Construct this pattern:

• We add the first text pattern to define all files starting with a '.'
• Below that first pattern, we add a second one

• that specifies a text ending with '_report',
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• followed by a '.'

• and then a pattern representing the file extension.

 

 
3. We add a few examples below. We see the first effect of our regular expression:

 

 
4. The result is not yet what we want. The file lemon_REPORT.ai was not matched. We

correct this by indicating that this expression needs to be Case insensitive:
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5. Now the regular expression matches all the files that we do not want:
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6. By setting the option Exclude patterns, we reverse the logic. The patterns that we
described are now used to exclude files from our selection. We now get the result we
wanted:
 

 
7. Click OK to close this panel and have the regular expression copied to the field from where

you opened this tool.

10.13.  SmartNames of Parameter Values

The chapter "SmartNames" describes the many ways how to create a SmartName that will
resolve in a string like "flexo" or "123". But how do you create a SmartName that resolves in
Parameter Values that are not a text string?

For example you want a SmartName to decide a button in the interface that indicates to rotate
90 degrees. Or you want a SmartName to decide an internal value that is shown in a drop-
down list, for example "any user".

We illustrate both cases with an example:

Creating a SmartName that selects a Button in the user interface

Some buttons in task tickets can be transformed into SmartNames. For example step & repeat
tasks have many buttons that you can also set via a SmartName.

Follow these steps to create such a SmartName:
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1. Select the button and then right-click the button to see if the option Copy Parameter Value
appears. If so, select that option.

Below an example of the Orientation buttons for the marks that you can set in the task
Add Marks to Imposition. See below how you can Copy their Parameter Value and how
the list of buttons also offers to be decided by a SmartName.

 

 
2. Go to the dialog where you create the SmartName, right-click and Paste the Parameter

Value.

An example: Let's create a Job Parameter (which always becomes available as a
SmartName). We here show the manual creation but it would normally be created
automatically based on input from an external system. In the Job Setup, we create the Job
Parameter Text Mark Rotation and for its Value we paste (Ctrl-V) the Parameter Value of
the button. The screen shot shows that the resulting value is "270".
 

 
3. Now use that SmartName in the Ticket instead of the button. Click on the SmartName icon

and select it.
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Creating a SmartName of an Automation Engine internal value

This example shows how to create a SmartName that will return the value of "Any user" (a
choice from a drop-down list):

1. Right-click the interface value and see if the option Copy Parameter Value appears. If so,
click the option.
 

 
2. Go to the dialog where you are creating the SmartName and Paste the value there. You will

see it appear as "Any User...@".

An example workflow: Your Jobs are created via XML files that you receive from your
business system. The XML contains the name of the Esko user that should handle this
Job and therefore should receive an item in his To Do list (from the Wait for Action
(Checkpoint) task that is automatically started when the Job is created). The Create Job
task maps that user to the custom Job Category 5. The Wait for Action (Checkpoint) task
then picks it up as the SmartName Job Category 5.

For this to work, the business system needs to know exactly how to write the Automation
Engine User names. In our example, the business system also needs to learn how to tell
Automation Engine that the To Do of a Job is for Any User. In that case, the business system
needs to mention in the XML that the Job is for "Any User...@", because only that value
will match the drop-down choice Any user.

This screen shot shows how the Create Job task created the correct string in the custom Job
Category named ForWhichOperator:
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And the SmartName of this Job Category is then used in the To: field of the Checkpoint task:
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11.  Workflows

11.1.  Workflow Basics

Automation Engine enables you to create very powerful and automated workflows. You can
customize them to do exactly what makes sense in your environment. You can make them
extra smart by using SmartNames, subworkflows, routing, integration points with external
systems and much more.

A step in a workflow is an Automation Engine Task performing an action on an input file to
produce an output file. It can be also be a Workflow Control. Workflow controls can be about
deciding which route the workflow will take or about file management (selecting, sorting etc.)
or about other administrative decisions in the workflow.

Here is an example introducing some main tools:
 

 

1. A Transition is the green line that connects each step in the workflow. It is a graphical
representation of an output file of a step being used as the input for the next step.

2. By default each step has an OK and Error Output Pin. When a step ends in the OK state,
the output file will be sent to the step connected to the OK output pin. When a step errors
out the workflow will continue with the step connected with the Error output pin. In the
example workflow above the Preflight with PitStop task has 2 extra pins, matching the
possible Preflight statuses.

3. This subworkflow handles the approval process. This sub-workflow opens when you
double click it.

4. Here we used the workflow control Router.
5. See how this Router shows 3 output pins. When hovering over them with your mouse you

see their name, in this case the route to 'Off site printing'

Workflows can be started

• manually, by an Esko user,

• using the Pilot
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• using the Shuttle client tool or the Shuttle plug-in on board Esko editors or Adobe
Illustrator.

• automatically

• by an Access Point
• by an external system that was integrated with Automation Engine. This could be

WebCenter or any non-Esko system.

Note:  Learn more about Access Points and integrations in Integrating with External Systems
on page 1553.

11.2.  Building Workflows using the Workflow Editor

You can open the workflow editor from the Pilot using  (from the Tickets view) or 
(from the Files view).

11.2.1.  The Workflow Editor Window

The workflow editor window consists of these main areas:

 

 

1. The workflow editor menus. Learn more in The Workflow Editor Menus on page 689.
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2. The workflow editor tool bar. Learn more in The Workflow Editor Tool Bar on page 691.
3. The files pane shows the files that you selected before opening this workflow (only when

opened from the Files view) or it shows the files that you launched this workflow on.
4. The favorites bar shows your favorite workflow steps that you often use when building

workflows. Add new ones by drag and dropping new steps or custom tickets into the bar. To
remove any, right-click and click 'remove'.

5. The canvas shows your workflow. You can monitor your workflow while it is processing files
and you can diagnose a finished workflow.

6. The tasks pane lists all the types of tasks and workflow controls that you can use in a
workflow. You simply drag and drop them onto the canvas. You can easily find tasks by
using the filter and the search field.

11.2.2.  The Workflow Editor Menus

Some menu options are only available while creating a workflow, others are only available for a
saved workflow ticket.

Use this
menu...

to ...

File • Launch a file into the workflow (when you selected a file before building the
workflow).

• Launch a file into the workflow and keep the workflow editor window open
(Launch And Monitor).

• Select one or multiple files to launch in the workflow (Select File...).

• Save your workflow and all its parameters in a Ticket (Save Ticket).

• Save your workflow under a different name (Save Ticket as...).

• Save your workflow on your client computer (Export Ticket...). Learn more
about exporting workflows in Exchanging Workflows on page 725.

• Show information about the workflow ticket (Show Info): the Name of
the ticket, the Task Type, the Tags, whether or not the ticket is Public, a
Description of the ticket.

• Open the selected step.

• Show Parameter Inspector. Use this tool to easily manage the ticket
parameters of all the used tasks. Learn more in The Parameter Inspector on
page 730.

• Find: puts your cursor in the search field of the tasks pane and clears any
previously entered text string.

• Search: puts your cursor in the search field of the tasks pane or highlights
any previously entered text string.

• Close this workflow editor window.
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Use this
menu...

to ...

• Print your workflow canvas on a network printer (only available for a saved
workflow ticket)

Edit • Undo or Redo your latest changes. The menu option also mentions which
type of change it can undo. For example: 'Undo Change Parameters' or
'Undo move' etc.

• Cut, Copy or Paste the selected step(s). You can also copy-paste between
multiple workflow editor windows. You can define where the copy will be
placed by using the right-click function.

• Select All workflow steps.

• Delete the selected step.

View • Change the zoom of the workflow to its Actual Size. Alternatively, you can
also Zoom In, Zoom Out, or Zoom to Fit in the window. Check the available
shortcuts.

• Show / Hide Favorites, Files, Tasks and Sticky Notes. Learn more about
sticky notes here.

• Show / Hide Grid shows or hides the canvas grid. Activate Snap to Grid to
more easily align your workflow steps on the canvas.

• Expand or Collapse the Queue. When a workflow is running, a Queue is the
vertical list of icons of workflow items that are being processed by a same
step. These items represent (grouped) files or concepts like Job, Plate etc. If
the amount of these icons is disturbing, choose to collapse that queue.

Advanced • Add / Remove this workflow ticket to / from your Favorites bar.

• See a processing Log (when the workflow is running). You can also send the
Log contents as an E-mail.

• Set up Task Options: Priority, Hold / Release, Launching a separate task
per input file and Annotations.

• Set up Notification Rules. Learn more in Creating a Notification Rule on page
199. Tip: check if using the separate Send E-mail task is a better alternative.

• Manage Workflow Parameters... and Workflow Parameter Values.... Learn
more about these in Using Workflow Parameters on page 803.

• Manage Public Parameters for the selected step or check and Modify
Public Parameter Values for the whole workflow. Learn more in Using Public
Parameters in Workflows on page 783.
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Use this
menu...

to ...

• Validate the current workflow (including all subworkflows). Any problems will
be shown and explained in a separate dialog.

11.2.3.  The Workflow Editor Tool Bar

The tool bar offers buttons to:

• perform specific actions on the workflow ticket: . All available actions are explained
in The Workflow Editor Menus on page 689.

•
launch the workflow on the selected files  (only when you opened the workflow editor

from the Files view). Press Alt to see the button change to  and Launch and Monitor
the workflow (without closing the workflow editor).

•
change the zoom in the workflow canvas (zoom in  , zoom out  , zoom to fit  ),

Tip:

You can also use these shortcuts:

• Ctrl + Space (on Windows) or Space + Cmd (on Mac) to activate the zoom in tool, then
click or drag in the window.

• Ctrl + Alt + Space (on Windows) or Cmd + Option + Space (on Mac) to activate the zoom
out tool, then click in the window.

• Scroll your mouse up or down to move the whole workflow up / down in the window.
Add Shift to move left-right.

•
delete the selected step(s) ( ).

•
show / hide certain areas of the window: Files  (when opened from the Files or Tasks

view), Favorites , Tasks , Tickets  and Resources .

Tip:  Use Ctrl + click or click and drag to select multiple steps.

11.2.4.  Building a Workflow from Scratch

1.
In the Tickets view, click  to open the workflow editor.

The canvas shows these two workflow controls by default:  and .
2. Drag and drop the desired steps from the tasks pane onto the canvas.
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Note:  If the tasks pane is not visible, click View > Show Tasks.

Note:  To find a task quickly, use the filter and the search field.

 

 
3. If you want to give one or more steps a more descriptive name to make the workflow self

documenting, double-click the name underneath the icon and change it.
You can still see the original name of the step by hovering over the step.
 

 
4. Connect your steps with one another. To do this, click on a step's green output Pin and drag

it onto the next step.

This will link the two steps with a green arrow, called a Transition.

 

 

Note:  Remove the transition by selecting the end part and dragging it away from the step
that it was connected to.
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Note:  You can connect a step's output to multiple other steps. These steps will receive the
same input file and will execute in parallel. See an example below ;
 

 

Note:  When you move your mouse to a point where multiple transitions come together,
they will split up to make it easier for you to pick one of them (see below). When you want
to move them together, hold the Alt button to select and move them together.
 

 

Tip:  Learn more about keeping your workflow clean in Visual Optimizations of a Workflow on
page 697.

5. Double-click each step and fill in its parameters in its ticket. Click OK to close the ticket.
There is no need to save these tickets. Their settings will be saved inside the workflow ticket.

6. Save your workflow using either:

• File > Save or Ctrl + S,
• File > Save As... or Ctrl + Shift + S.

Note:  Until your workflow is saved, you can undo your changes. In Edit >  Undo you can
read which change can be undone.

Note:  Until you save your changes, the name of the workflow will show an * behind it's
name.
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Tip:  Before saving your workflow, it is good practice to check its validity. Use Advanced 
>  Validate Workflow or Ctrl + Alt + V.

11.2.5.  Building a Workflow using Custom Tickets

Compared to building a workflow from zero, using already made custom tickets as workflow
steps adds these extra possibilities:

Using the Ticket Browser

In the tool bar of the workflow editor, click  to open the Ticket Browser pop-up.

 shows the complete list, sorted per task type.  shows only the tickets of the selected task
type.

 

 

1. Use the Categories filter and /or the search field to quickly find your custom ticket.
2. Select and drag the ticket onto your workflow canvas.
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Note:  Alternatively, you can choose to not use this Ticket Browser, but use the Tasks pane
and activate Show Custom Tickets (right-click in the list).
 

 

Custom Tickets in your Workflow can be Copies or References

When you add a custom ticket onto your workflow canvas, it is by default a copy of that ticket.
This means that any changes you make to that ticket will not be reflected in the original ticket
and vice versa..

When you hold Ctrl + Shift or Cmd + Alt (Mac only) while you drag a custom ticket onto your
workflow canvas, a reference to that ticket is added to your workflow. This means that any
changes you make to the ticket will also be done in the original ticket and vice versa.

Note:  This is equally valid when your ticket is a workflow ticket.

Referenced tickets also show their original name, with a small arrow in front. In this example
you see 3 workflow steps: a copied ticket on the left, a referenced one in the middle and on the
right a referenced one that was renamed in this workflow:
 

 

Note:  If the ticket that you refer to in your workflow uses any SmartName containing [ ...
originating Input ... ], be aware that this will reflect to the input of the ticket that you
refer to, not of the workflow that refers to it.

Adding a Part of another Workflow to your Workflow

If you want to add parts of a workflow to another workflow, follow these steps:

1. Open both workflows in a workflow editor.
2. Select a part of one workflow and choose Copy.
3. Click on the canvas of the other workflow and choose Paste.
4. Add the desired transitions and save your new workflow.
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Note:  If you plan to reuse workflows or parts of a workflow several times, we advise to create
subworkflows. Learn more in Subworkflows on page 700.

11.2.6.  Configuring Output Statuses

For each workflow task step, you can customize what to do when the task results in warnings
or errors. You can also choose to add extra output pins.

Right-click the workflow step and select Configure Outputs....

Note:  The offered options and the precise words are different per type of task.

• Warning handling

• Select OK on Warning to send the files to the (Finished) OK output pin.

• Select Error on Warning to send them to the (Finished with) Error(s) output pin.

• Select Dedicated handling of Warning to send them to the (Finished with) Warning(s)
output pin.

• Add an extra output pin where the task's inputs will be (when no errors occur). This
is useful when the output file of your task is different from the input file and when you
(also) want to continue working on the input file. Typical examples are when you create a
ReportMaker PDF or a Step& Repeat and you (also) want to continue launching steps on the
one-up.

See this example, where the 2nd green output pin 'Inputs' allows further steps on the one-
up:
 

 

• Add an extra output pin where the task's reports will be put. Tasks that also output a
separate report file (like the Preflight tasks) offer this extra choice. You can then connect
that extra 'Reports' pin to the workflow step that will handle that report file.

See this example where the Preflight report goes to its own output pin 'Reports':
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11.2.7.  Visual Optimizations of a Workflow

Workflows can become very complex. The following tools help to visually optimize them, which
will make it easier to understand them.

Aligning Workflow Steps on a Grid
You can align your workflow steps on a grid. To do this, hold the Shift key while dragging a step
to the desired position. It will snap to a place on the grid.
 

 

Hiding and Showing Transitions
To optimize the overall look and readability of a workflow, you can hide specific transitions.
See this example where the transitions to one Send E-mail step make the workflow look more
complicated than it is:
 

 
To hide the transitions to a (less important) step:

1. Right-click on the desired workflow step.
2. Click Hide Transitions. All transitions going to this workflow step will now be hidden. All

other new transitions made to this step will automatically be hidden as well.

See this example where all transitions to the Send E-mail step are hidden:
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If you want to see which transitions were hidden, click on the step (start or end). The hidden
transitions will be revealed in a grey color:
 

 

To reveal the transitions again, right-click the step and choose Show Transitions.

Distributing the Space between Workflow Steps

To distribute the space between all (or selected) steps evenly and also to align them on a grid,
proceed as follows:

1. Right-click anywhere in the workflow window.
2. To align the tasks horizontally, click Horizontal Distribute Space or use Ctrl + Shift + H.
3. To align the tasks vertically, click Vertical Distribute Space or use Ctrl + Shift + V..

For example, this workflow needs some realignment:
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This is the result after distributing the space:
 

 

Adding Sticky Notes

Right-click anywhere on your canvas to add a Sticky Note to your workflow. Use these notes
to add background information and so help users understand the workflow. They can serve as
warnings or to remind users why some parts are constructed that way.

An example:
 

 

Click the icon on the top bar to choose a color:
 

 

Tip:  To move the note, click the top bar and drag it to the new location.
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Customizing the Canvas Background

You can choose a custom canvas background for all your workflows. Right-click on the canvas,
choose Change Canvas Background... and browse to an image on your local computer.

Choose Clear Canvas Background to remove it again.

11.2.8.  Subworkflows

A subworkflow is a workflow that is part of its master workflow. It is included in the workflow
ticket of the master workflow. A subworkflow can also include another subworkflow. You can
create workflows several levels deep.

These are two main reasons to create a subworkflow:

• The master workflow will look less complex when a part of its flow is represented by only 1
workflow step.

• To stop creating the same (parts of) workflows again. If you notice that you keep creating
the same or similar (parts of) workflows, then consider building that recurring part once and
then copying it as a subworkflow into the other workflows.

In this example we see that the complete approval workflow is represented by a subworkflow
named "SUBWFL Approval":
 

 

Double clicking the subworkflow step opens it in the same workflow window. Notice the
indication of the path:
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The Difference between a Subworkflow and a Referenced Workflow

A referenced workflow is not included in the master workflow, it is not copied on board. It is a
link to a separate (workflow) ticket.

Note:  Learn about adding referenced tickets or workflows in Building a Workflow using Custom
Tickets on page 694.

The advantage of a referenced workflow is that by updating your referenced workflow you
so automatically update all the master workflows that refer to it. See some examples in Good
Practices for Building Workflows on page 726.

See this example where the approval part of the workflow is added as a reference. Notice the
small arrow and extra name of the original workflow ticket:
 

 

When you double-click a referenced workflow step, it will open in a separate window.
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Building a Subworkflow
To add a subworkflow into your workflow:

1. In the workflow editor, drag a Workflow  task into your workflow. Or use an existing
workflow ticket ; in that case skip step 3.

Tip:  To find it quickly, select the category Workflow in the tasks pane or type 'workflow' in
the search field.

 

 
2. Double-click the workflow step.

The workflow step opens in a new canvas, where you can build your subworkflow. The extra
level in the path indicates that this is a subworkflow:

 

 

Note: This is an example of a path indication of a workflow with 2 levels of

subworkflows:

3. Build your subworkflow: drag and drop steps into its canvas, add transitions, open each
step to change its parameters. There is no need to save at this point.

4. In the workflow path, click on your master workflow to go back to it (in above example: click
on ).
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5. Save your master workflow. Your subworkflow(s) will be saved as a part of it.

11.2.9.  Inserting Wait Points

Sometimes you want the workflow to wait a while before continuing with the next task. There
are several ways to do this:

The Wait Task
Use the Wait task in a workflow to postpone the next task to a relative or absolute time.
 

 

A few examples of workflows where this task is useful:

• Your workflow sends a proof to a proofing device. You want to wait 30 minutes and then
send the user a To Do to go and pick up the proof.
 

 

• A Folder Access Point launches a workflow on incoming design files. These design files
have been backed up already somewhere else. That is why you can delete them from the
Automation Engine Container when you are sure that the workflow no longer needs them
(for example after 4 hours).
 

 

• Every night you want to clean up a specific type of files that you consider temporary. You
have built this into your workflows, where a Wait task is set to release between 3 and 5 AM,
and is followed by a Delete task.

The Wait for Files Task
Use this task when you want to process files that are not present yet.

Note:  Instead of using this task as a step in a workflow, consider if using an Access Point is not
a better way to wait for files (and then start a workflow on those files).

703



11 Automation Engine

This task looks for files at a regular interval, and when it detects them, it passes them to the
next workflow step.

You can define which files it should look for, how long the task should wait for them to appear
and what to do if the files are not found after that time period.

Warning:  In a workflow, this kind of type of task can put some strain on the workflow
engine, especially when used a lot. So if your case can be solved by using an Access
Point, than we strongly advise to do so.

In any case, do not create workflows that use this task in a loop! For example: A Wait
for Files task that waits for any specified period and, when it doesn't detect the files by
then, the workflow then loops back to that same Wait for Files step, which then waits
some more etc. Such constructions create a massive amount of tokens and this blows
up the memory consumed by the workflow engine.

An example of what not to do: When the Wait for Files step was unsuccessful, a Router
step does a check of the number of files in that output pin and if (for example) it is 0 or
less, the workflow goes back to the same Wait for Files step. Such a setup is a guarantee
for major problems with the workflow engine of your Automation Engine!
 

 

Important:  In many cases, a better solution is to let the workflow fail and use other workflow
steps or tools to continue your logic (To-Do action, notification, etc.).

1. Select the File Type of the file(s) you want to wait for.

You can either:

• choose to wait for Any file type,

• select a specific file type from the list,

• select several file types (see below).

To select one or more file types:

a) Choose Select File Types... in the File Type list.
This opens the Select File Types dialog.

b) In this dialog, select the files types you want from the Available File Types column.
c) Click  to send them to the Selected File Types column.
d) Click OK when you are done. You will see the selected file types listed in parentheses.

2. Use the File Name Matches parameter to search on file names.
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You can use wildcards, SmartNames or a Regular Expression. You can also browse to a
file with a name close to what you need, and add wildcards and/or SmartNames to that
example name.

3. Define where to look for the files in Look in Folder.
Choose to Look in subfolders or not.

4. Define when the task may Stop waiting for the specified files:

1. When a certain number of Files or Pages are collected,
2. After a certain time if the files haven't been found (when time exceeds ...). To set a

custom time, select other... from the dropdown list and define a custom date and time.

When you selected this option, this extra option becomes available:

• Task ends in error when not all files were found. Select it if you want the task to
finish with an Error state when it has not yet detected all files at the time that you set
in Stop waiting when time exceeds ....

Depending on what you choose, the task will finish either after it has found all the files/
pages, or after a specified time if it can not detect all the files/pages.

Note:  If you do not give the task a time limit, and it can not detect all the files, it will run
indefinitely.

The Wait for Product Status Task
This task allows to hold a workflow until one or more Products have reached a certain status.

This task is documented in the chapter on Products on page 548. Find a direct link here.

The Wait for Action (Checkpoint) Task

Concept
Use this task to hold your automated workflow for any form of user intervention.

This task adds a 'Wait for Action' item in the To Do List.

When a user checks and completes that required action, he 'releases' that item. He can choose
to let the workflow continue, to abort it or to have it take another route in the rest of the
workflow.

Tab 'Message'
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You here define what you want to communicate to which user.

• To: From the drop-down list, choose a specific user or the Task owner (the user who
launched the task) or choose any user (all users then get the To Do item in their list).

If you use a SmartName to specify the user, make sure it resolves to the method
"name@domain" (for example "franky@aeserver01" or "franky@fruitco-domain").

Note:  Also the choices any user and Task owner can also be accessed through a
SmartName. This SmartName needs to resolve to their internal Parameter Value "Task
Owner...@" and "Any User...@". Learn more about this in SmartNames of Parameter
Values on page 683.

• Subject: This subject line is shown in the To Do List overview.

• Message: Optionally, add extra information.

• Due Date: Setting a due date becomes useful when you want to sort of create filters in the
To Do List overview (learn more in The To Do List View on page 111). Choose from the drop-
down list to set a relative or an absolute time ('On').

Tab 'Parameters'

Concept
A To Do item that was created by the Wait for Action task can be extended with additional
parameters.

There are 3 types of parameters that you can add:

• Workflow Parameters make it possible to change the value of a workflow parameter in a
To Do item. Learn more here.

• Info parameters make it possible to show extra information in a structured way (name,
value). Learn more here.

• Link parameters allow to add hyperlinks to the To Do item. These can be links to an
external web site, an E-mail address or even a task in the Tasks view. Learn more here.

You can add several parameters of several types.

The order in which you add them in this tab is the order in which they will appear in the To Do
item. To change this order, simply 'drag-and-drop' the parameter up or down.
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Adding a Workflow Parameter to a To Do

Settings

Note:  Find some examples below.

• Click Add. The Edit Parameter dialog opens.
• Type: Select Workflow Parameter. Learn all about workflow parameters here.
• Workflow Parameter: The name of the existing workflow parameter that you allow to be

changed in this To Do.

Type in the name or click  to pick it from a list.

If the workflow parameter does not exist yet, you will be informed about this when closing
this 'Edit Parameter' dialog. That message will allow you to create it or not (yet).

• Style: How should this workflow parameter be presented in the To Do item?

• As a Text Field: Fill in any text as the value for this workflow parameter.

• Placeholder Text: This text is shown in the text field when the value of the workflow
parameter is still empty.

• As a Combo Box: The parameter is presented in the To Do as a combo box. The user,
after clicking Edit, can pick a value from a list of predefined values.

• Placeholder Text: This text is shown and selected in the combo box when the value
of the workflow parameter is still empty.

• Values: A comma separated list of values. Do not use spaces. These are the values
from which the user can choose.

Note:  A running workflow can decide another value than those in this list. When the
value of the workflow parameter is not present in the list of values, and the value is
not empty, the value will be added to the combo box and will be shown and selected
in the To Do item.

• As a Checkbox: The parameter is presented in the To Do item as a checkbox. The user,
after clicking Edit, can either select or deselect the checkbox.

• Checkbox Text: The text that will be displayed to the right of the checkbox.
• Unselected Value: The value that will be given to the workflow parameter when the

checkbox is not selected.
• Selected Value: The value that will be given to the workflow parameter when the

checkbox is selected.

Note:  In case the value of the workflow parameter is not equal to the unselected value
nor to the selected value, then the value will be set to the unselected value.

• Label: In the To Do item, this text will appear in front of the parameter.
• Info Text: In the dialog Edit Workflow Parameter, this extra text can help to clarify this

parameter or its effect.

Some Examples
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• Using a Text Field:
 

 

Resulting To Do item:

1. = Extra area in the To Do dialog where these extra parameters appear.
2. = Label
3. = Placeholder Text
4. = Info Text
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Attention:  Notice how the user needs to click Edit to change a value.

• Using a Combo Box:
 

 

Resulting To Do:
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• Using a Checkbox:
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Resulting To Do:
 

 

Adding extra Info to a To Do

Settings

• Info: The value of the To Do parameter.

• Label: The text that will appear in front of the To Do parameter.

Note:  Contrary to workflow parameters, this information is read-only ; the value can not be
edited in the To Do item.

Example
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Resulting To Do:

When the value that the SmartName retrieved from the MIS is 'Flexo 6col':
 

 

Adding a Link to a To Do

Settings

• Click Add. The Edit Parameter dialog opens.

• Link Type: The type of hyperlink.
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• External Link: Fill in the URL in the URL field. This can be a hyperlink to an
external website (example: https://www.esko.com) or to an E-mail link (example:
mailto:someone@example.com).

Note:  The scheme http:// or https:// is mandatory for the URL to be correct.
www.esko.com is not a valid URL. The URL also needs to be URL encoded.

• Task Link: This is a link to a (finished) Automation Engine task. The value needs to be the
Task ID (internal) of that task (learn below how to retrieve that value). In the To Do item,
when you then click on such a link, the task with that internal ID will be selected in the
Tasks view. See an example below.

• Link Text: It is possible to specify a text that will be shown in stead of the actual hyperlink.
When you leave this empty, the URL will be shown in the hyperlink.

• Label: This is the text that, in the To Do item, will appear in front of the link.

Example of a Task Link

Some automated tasks are not monitored by users, and nobody notices when they go wrong.
To alert the users and make them analyse why this specific task had a problem, you can add
the following settings to that automated workflow:

In this example, we want to make sure we are aware when something goes wrong with the
'Create Job' step in our workflow. This workflow could for example be triggered by a business
system of be started by Esko Cloud.

1. When that step ends in error (or warning), redirect the workflow to these 2 extra steps:
 

 
2. In the workflow editor, go to Advanced  > Manage Workflow Parameter, Add a workflow

parameter and Name it "Task ID from Previous task". Leave the Value empty and
click OK and close the dialog.
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3. Open the ticket of the step Manage Workflow Parameter Values. Click Add and click  to
select the workflow parameter you just created. Set the New Value of this parameter to the
SmartName Task ID (Internal). This will pick up the internal ID of the previous task in the
workflow, in our example the 'Create Job' task. Click Add and OK.
 

 
4. Open the ticket of the step Wait for Action (Checkpoint).

• In the tab Message, add the subject "Check why the previous task failed".

• In the tab Parameters, click Add and select

• Type: Link and Link Type: Task Link.

• Task ID (internal): Open the list of SmartNames. Select the category 'workflow
parameters', select the one you made earlier and click Insert:
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• Link Text: In our example, we leave the default text that will appear as the text that
the user will need to click on ("Show in Tasks View").

• Label: Type 'Check why the previous task failed'.

• Click OK, OK and select File >  Save to save the workflow ticket (or choose Save As... and
save it as Favorite).

Note:  In this workflow, we did not edit the step 'Create Job'. This is fine because we
want to have that step end with an error anyway.

• In the Pilot, in Files view, choose the Containers mode, select any input file or folder and
launch this workflow.

• You should quickly see that the step 'Create Job' failed and that a To Do item was
created.

• Go to the To Do List view, select or open the item that was just created:
 

 

• Click on the blue hyperlink. It should open the Tasks view and have the task selected
that failed. The task's Details or Log file will mention what the problem was.
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Tip:  When you right-click a token, you can ask to see the value of the workflow parameters
at that point in the workflow. In our example, this visualises the internal ID that we used to
find that task.
 

 

Tip:  In the To Do item, hover your mouse over the hyperlink to see what it resolves to:
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Tab 'Output States'
 

 

• Output States: You here define in what state this To Do item can be released. In a
workflow, these output states are shown as output 'pins' with that (custom) name.

• Click Add to add a new output state. Enter a Name and Description (optional) for the
output state.

• Choose the Type from the list of symbols.

Note:  When this task is used as a step in a workflow, the Type only defines the small
icon that will be used for the output pin. The state of the workflow only depends on
which next step in the workflow that that output pin links to.

For example: When choosing a (red) 'Error' symbol for a state that you named 'Not OK',
then this does not yet mean that the workflow ends in error.

• Whatever the type of output pin (green, orange, red), it can be linked to any next step
in the workflow, possibly a specific branch for that state.

• When there is no next step, then indeed the workflow will end with the same state as
the one you choose here.

• Show workflow parameters dialog. When selected, clicking the button of an output
status in the To Do message will first open this dialog. This allows you to add comments
or make changes to these parameters before that chosen output state is confirmed. See
an example below.

• Release automatically: Select this if you want the task to end after a specific time to a
specific state.

Example of Output States that first Ask for More Info

1. Add the workflow parameters to the workflow ticket that contains the 'Wait for Action' step.
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2. In the Wait for Action (Checkpoint) step, they appear in the tab Parameters:

 

 
3. The next tab Output States is where we define how a user can decides how to end the

resulting To Do action. Here are the 3 states we added and their settings:
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a. The output state 'File OK - Continue':

When a user clicks this button, the To Do action will end and close.
 

 
b. The output state 'Conditional OK':

• Show workflow parameters dialog is selected.

• When the field Parameters is left empty, all workflow parameters will be presented.
When you select one, as was done here, only that one will be shown.

 

 
c. The output state 'Reject':

• Show workflow parameters dialog is selected.

• Again, only one parameter was selected: again only the one that is relevant to the
choice of rejecting the file.
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4. As a result, when the workflow runs the step 'Wait for Action', this is how the To Do action

will present itself:
 

 
5. You can at any point click the button Edit and see or edit the provided parameters. But in

this case we configured the decision buttons on top so that we don't need to click Edit any
more.

6. When the user clicks ...

• 'File OK - Continue', the To Do action is released with this state and the dialog
closes.

• 'Conditional OK', the dialog opens that allows us to edit the workflow parameters. We
only see the parameter that was chosen. Add a comment and click Release this To Do
action to this output state.
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• 'Reject', the same dialog opens, now with the other parameter that is relevant to this
output state.
 

 

Using the To Do list to Distribute Work

Example of a workflow combining a To Do for "Any user" with one for "Task
Owner"

It is possible to use the To Do List to distribute tasks. The first user who picks up a To Do action
can become the owner of the rest of the workflow.

See this example of a workflow that is launched by a Folder Access Point: the first Checkpoint
task sends the To Do to Any User. The second Checkpoint task sends it to the Task Owner:
 

 

The Folder Access Point launches this workflow with a non-specified user:

 

 
Learn more about Access Points in Access Points on page 1561.

This is how the result looks like in the Tasks view:
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• At first, the user was "UPLC" (the system user when no user is specified in an Access Point).

• The first To Do became visible in the list of All users.

• This first To Do was handled by the user "wde", which made him/her the Task Owner from
that point on in the workflow.

• The second To Do goes to the Task Owner, which is still "wde".

11.2.10.  Routing in Workflows

Simple Processing Routing
As mentioned in Building a Workflow from Scratch, transitions can route your files to different
workflow steps. Automation Engine will automatically check the format of the files going
through this step, and send them to the appropriate step(s) for that file format.

See this example where the PDF will go to the trapping step:
 

 

However, to keep an easier visual overview of your workflow, we advise to use a Router
workflow control instead (learn more in Automatic Routing on page 725).

Routing in Subworkflows
When a subworkflow has multiple end steps, an extra type of routing becomes possible. The
end steps of your subworkflow correspond with the outputs of the their workflow step in your
master workflow.
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For example, this subworkflow ends with two 'OK' end steps that were renamed to "Small
Press" and "Big Press".
 

 

In the master workflow, you can see that they correspond to the two green output pins of the
subworkflow step "Layout".
 

 

This means that:

• files sent to the "Small Press" end of your subworkflow will go through the "Small
Press" output pin in your master workflow,

• files sent to the "Big Press" end of your subworkflow will go through the "Big Press"
output pin in your master workflow.

Routing via To Do List Action Items
Users can decide the route of the workflow (files) through Action items in their To Do List.
They can also choose to forward the To Do Action item to another Automation Engine user.

Learn more about Workflows creating Actions in a user's To Do List in The Wait for Action
(Checkpoint) Task on page 705. Learn more about using the To Do List in The To Do List View on
page 111.

In the Pilot Tasks View
In the Tasks view, the Wait for Action (Checkpoint) task shows the Phase "User intervention
needed". Below right, the icon  shows that one (extra) item is added to this user's To Do
List.
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You can click either of these elements to Release the item to one of the outputs that were
defined in the Wait for Action (Checkpoint) task. This will close the To Do item.

 

 

In the Workflow Editor
In the workflow editor, the user will see User intervention needed as the file status and the
Checkpoint task step will jump up and down:

 

 

The workflow editor will also show one To Do  (for this workflow).

To route (and close) the To Do item, you can

• right-click the file icon and select one of the outputs defined in the Checkpoint task.
 

 
• right-click the file icon and select Open To Do... and there select one of the outputs offered

in the Release button
•

click the To Do icon  to open the item in the To Do List and there select one of the
outputs.

Note:  In the To Do List, make sure the Actions Filter shows the Wait for Action items.

724



11Automation Engine

In Shuttle
In the client application Shuttle, Checkpoint tasks and To Dos can be handled in the same way
as you do in the Pilot Tasks View.

Attention:  The user name you used in the Checkpoint task and the user name used
in Shuttle to connect to Automation Engine must match.

Note:  Learn more about Shuttle in Working with Shuttle on page 819.

Automatic Routing

The Router workflow control  enables a workflow to automatically decide the route that
your workflow (files) should follow.

The criteria that you define to route to a specific output Pin can be based on many different
types: the file type, the number of separations, the value of a Job Parameter, etc.

For example: routing files based on their File Type:

 

 

... and so send each file type to an appropriate next task in the workflow:

 

 

In the above example, ArtPro files are routed to their own normalization task, while Native or
Normalized PDF files are sent directly to the Trap task.

Learn more about the Router in Router on page 767.

11.2.11.  Exchanging Workflows

The two main reasons to export and import workflows are

• to exchange them with other plants of your company that also use Automation Engine.

725



11 Automation Engine

• to exchange them with Esko Customer Service.

Exchanging workflow tickets is done in the same way as for single tickets:

1. Export the workflow to a ZIP file (in Tickets view or in the Workflow Editor).
2. Send the ZIP file to the other Automation Engine (onto a client computer of that server).
3. At the receiving site, in Pilot Tickets View, select Import, browse to the ZIP file, and click OK.

Attention:  The Automation Engine software version on the server that imports the ZIP
may not be on an older version than the Automation Engine server that created the ZIP.

What about references?

As mentioned in Functionality in the Tickets View, references will also be copied into the ZIP
file. These references are not just files like templates but also SmartNames, profiles, scripts,
referenced workflow tickets etc. See a full list of included references in here.

Attention:  Workflows that include referenced (blue) Job Tickets can not be exported.
An error message will appear.

Note:  Exchanging workflows is often done just to exchange the SmartNames used in those
workflows. Learn more in Exporting and Importing SmartNames on page 613.

11.2.12.  Good Practices for Building Workflows

Below tips help you build a workflow that is sustainable and easy to maintain. They also avoid
extra work and cost when you upgrade or migrate server computers.

Note:  Some of these tips are also present as an Esko Knowledge Base article. Find these and
more on http://help.esko.com/knowledgebase.

Avoid Absolute Paths and Server Names

Do you know the name of your file server in five years from now? Probably not. That is why we
recommend to avoid using that computer name in your Tickets and Workflows.

For example when you define a template for the ReportMaker task. See below example of a
Ticket with an absolute path to one specific template. If you have many such tickets, and the
location of the templates changes, you then have to adjust all your ReportMaker tickets.
 

 

This can be avoided by using a SmartName in the path. When the path changes, you then only
have to update the SmartName.
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The SmartName can be a String Extract SmartName that contains the path or even just the
server name:

 

 

The same principle applies to other tasks with references to files or folders like Compare PDF,
Create CAD Sheet and Select File. If you copy a PDF file to an external system, a CIP3 file to
a press, a TIFF file to an imaging device, a JPEG preview to an MIS, a ZIP file to an archiving
system etc., always avoid using server names and fixed locations.

Note:  You can keep it even more generic. For example if your templates are saved on the
Automation Engine server, you can use the system SmartName [Server] to make your
path smart. No need to create an extra SmartName in this case, but you will have to keep the
templates on the Automation Engine server when you migrate to new hardware.

Some typical situations where you better use SmartNames in paths:

• ReportMaker templates
• CAD files repository
• Image Mark files in SmartMark sets
• Files loaded in ArtPro Action Lists
• PDF, XML, JPEG communication with MIS/ERP
• TIFF, LEN, PS data sent to output devices
• Defining the file location of a Product.

For some situations, there is a default solution:

• In the Create Job ticket, use the Smart Job Location instead.
• Save PitStop Profiles in the default "PitStop Root" container (only visible in the PitStop

ticket).
• FastImpose templates have a default location on the Automation Engine server.

Annotate
If you are implementing a temporary workaround or even misusing a task to achieve your
goals, make sure that you later remember why you did this. There might be a better solution or
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less strict requirements in a next version of Automation Engine. An exotic part of the workflow
for which you don't remember why or how you did it, is a part that nobody later dares to
change or remove. It will cause problems sooner or later.

The best way to manage this is to document on the spot. Automation Engine provides plenty of
possibilities to do so:

• Description field for tickets and workflows
• Tags for tickets and workflows (also helps filtering)
• Renaming the workflow steps
• Description field for SmartNames
• Tags for SmartNames
• Sticky Notes in workflows

 

 
 

 

Note:  Documenting your experiences while building a workflow is not only a great help for
yourself and your colleagues but also for anybody at Esko Customer Service.

Use Referenced Tickets and Workflows

Referenced Tickets
You probably use several Export to PDF tickets. We advise to not copy-paste such a ticket in
your workflows but to add a reference to this ticket. Then, when you decide to change a setting
(for example "outline fonts"), you only have to change this single ticket and all the workflows
that use it will so adapt and use these latest settings.
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Learn more about referenced tickets in Building a Workflow using Custom Tickets on page 694.

Reoccurring Workflows Parts
When part of a workflow is identical in other workflows, we advise to create it as a separate
workflow and then refer to it from the master workflow(s).

For example, a part of your workflow sends feedback about a file to the business system. You
probably use this part in several workflows. We advise to create it once and use it many times
as a workflow step in various master workflows. We again advise to not copy it but to add it
to the master workflow as a reference. This way, when settings change, you will only have to
adapt it once.
 

 

Workflows can get gigantic. When launching such a workflow, the Pilot will read all the settings
of all the tasks in this workflow, even in the subworkflows. This is why launching bigger
workflows seems slow. See an example of such huge workflows that you should try to avoid
creating:
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However, at the moment of launching, the Pilot will not immediately read the settings of a
referenced workflow. This adds an extra reason to divide such huge workflows into several
referenced workflows. The master workflow will not only react quicker, but will be much more
structured and easier to understand.

Here is a good example of a master workflow that quickly visualises the logic workflow process
steps:
 

 

Learn more about copied and referenced subworkflows in Subworkflows on page 700.

11.3.  Launching and Diagnosing Workflows

11.3.1.  The Parameter Inspector

The Parameter Inspector enables you to quickly view or change the ticket parameters of your
workflow steps, without having to open and close each workflow step separately.

Open it by choosing Show Parameter Inspector... from the workflow editor File menu or by
choosing the same option after a right-click on the canvas.

Note:  The parameter inspector is not available for workflows that were already launched
(running or finished).
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The window stays open while you navigate through the steps. The steps are shown in
alphabetical order. You can navigate through the steps by selecting them in the parameter
inspector or by clicking on steps in the workflow editor canvas.

 

 

The parameter inspector does not show

• steps that have no parameters (Start - Stop - Warning - Error - Cancel)
• subworkflow steps. Double click the subworkflow step on the canvas to see its own steps

appear in the same parameter inspector window.
• referenced steps.

When available, you can

• choose Save As... to save the selected ticket as a separate task ticket.
• choose  to set extra options that you can also set when you open the ticket separately:

Notification Rules, Manage Public parameters and Map Output Parameters.

11.3.2.  Launching a Workflow on a File

There are several ways to launch a workflow on a file: from the Pilot, from the Workflow Editor,
from Shuttle, via Access Points or via JDF/JMF.

Note:  Learn more about launching workflows from external systems in Integrating with
External Systems on page 1553.

Launching a workflow from the Pilot's Files View is very similar to launching a single Ticket.
Follow these steps:

1. In the Files view, right-click the file(s) you want to process and select:

• New Task . You can then select the workflow and change its settings before launching it.
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• Launch with. You can then select the workflow and launch it without changing its
settings.

Note:

If you don't have the access right Tickets: Show All Tickets and their Parameters (Public
and other), you will only see Launch with. You will also only be able to select public
workflow tickets. Learn more in Access Rights on page 144.

2. Select the workflow ticket to use.

• If you have launched workflows previously, the most recent workflow tickets you used
are listed under Workflow.
 

 

• If you don't need a recently used workflow, select Other...

In the Select Ticket dialog that opens, select the workflow ticket you want to use and
click OK.

Tip:  Type Workflow in the search field to quickly filter to the task type Workflow.

Tip:  If you hold the Alt, the OK button changes into Launch.
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3. Some variations are possible:

• To keep the workflow editor window open and monitor the workflow while it is
executing, hold Alt while clicking Launch to Launch and Monitor (the Launch button

changes to ).
• If you choose New Task, the workflow editor opens. Fill in the settings you want to use in

each workflow step and click the Launch  button.
• If you choose Launch with and you don't have the access right Tickets: Show All

Tickets and their Parameters (Public and other), then

• if the ticket does not contain public parameters, the workflow is launched on the file
as soon as you select the workflow ticket.

• if the ticket contains public parameters, it will open for you to fill them in. You will only
see the public parameters. Click the Launch button when you are done.

In this example the user is asked to decide 2 public parameters:
 

 

Note:  If a workflow is launched on files that are linked to several Jobs, a separate workflow will
be launched for each Job context. This can happen for example when you use the Files view or
Shuttle or a Folder Access Point.

11.3.3.  Using Favorite Workflow Tickets

Note:  In Creating Favorite Tickets on page 86, you can read how to build and launch Favorite
tickets for single task tickets. You can do the same for workflows tickets, including sorting and
grouping them. We here repeat some information and add specifics about working with favorite
workflows.

Favorite tickets are links to tickets that you use a lot. They show up in the Favorites pane, both
in the Files and in the Tickets View. You can use Pilot > View >  Favorites to show or hide the
Favorites pane.
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Favorites tickets show up depending on

• the file type you selected first.
• the user that is logged in. They are your personal favorites.

Tip:  You can copy and paste favorite tickets from one user to another. In Pilot >  Tools > 
Users, right-click a user name and choose Copy or Paste Favorites.

Adding Favorite Workflow Tickets
There are 3 ways to create a favorite (workflow) ticket:

• when you first save a workflow or use 'save as', then check Add to Favorites.

• in the Tickets view, right-click a ticket and select Add to Favorites. Use Shift to select
multiple tickets.

• both in the Files and in the Tickets View, in the Favorites pane, right-click and choose Add
Favorite....
 

 

The Add Favorite Dialog

When selecting a (workflow) ticket to add as a favorite, these 2 tools help you filter your list of
tickets:

1. Instead of seeing All Tickets, use the drop-down list and select one of the tickets filters that
you created earlier and saved into your Smart Views. Learn more about Smart Views here.

2. Type in a filter in the search field. What you type will be used to filter in all the columns.
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There is No Need to add Many Favorites of Same Task Type

When you click on the right side of the favorite, a drop-down list will show you all tickets of the
same task type (with a maximum of 10). This easy access to similar tickets means that you do
not have to create a favorite of those other similar ones (when you also use them often).
 

 
When the ticket that you look for is not in that list (remember that maximum 10 are shown),
you can choose Other... and select it there.

Adding a Favorite based on a SmartName
Right-click a favorite and choose Edit Favorite.
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Click  to pick a Task Type and or Name of the favorite ticket from a list.

Click  to define the Task Type and or the Name by a SmartName.

An example:

This favorite ticket will create a report file that uses a template chosen according to the
category of job it is. It will pick a ticket with a name that mentions the Job Category:
 

 

Click Check to test what that Name (or Type) field will resolve to. That is the name of the ticket
that will be picked up. So make sure a ticket with that exact name (and of that type) does exist.
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After you click OK to close this dialog, the pane of Favorites in your Pilot will show what the
actual name is for this ticket, in this case based on the job it belongs to.
 

 

When the SmartName's Resolved Value does not match an existing ticket name, then that
favorite will be shown as <Unresolved>. It is unusable, not in this specific context as required
by this SmartName.
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Launching Favorite Workflow Tickets
There are various ways to launch a favorite (workflow) ticket:

Launch Immediately

1. Select file(s).
2. Hold the Alt button.
3. Click on your favorite. The task is launched.

Choose a Ticket of the Same Task Type and Launch Immediately

1. Select file(s).
2. Hold the Alt button.
3. Click on the right-side of a favorite to open the drop-down list of tickets of the same task

type.
4. Move your mouse down to the chosen ticket.
5. Click on the chosen ticket. The task is launched.
6. Release the Alt button.

Open the Favorite Ticket in the Workflow Editor

1. Select file(s).
2. Click on your favorite.
3. In the workflow editor, check or change the settings and then launch or 'launch and

monitor'.

Choose a Ticket of the Same Task Type and Open it in the Workflow Editor

1. Select file(s).
2. Click on the right-side of a favorite to open the drop-down list of tickets of the same task

type.
3. Move your mouse down to chosen ticket.
4. Click on the chosen ticket.
5. In the workflow editor, check or change the settings and then launch or 'launch and

monitor'.

11.3.4.  Building and Launching a Workflow On The Fly

If you build a workflow from the Tickets view, you cannot launch it until you finished building
it. Your Workflow Editor will not have a Files pane to select files and then launch it. Working
this way is typically something done by Automation Engine administrators while building the
workflows. Once the workflow is ready for testing, users can then go to the Files view, make a
file selection, select the workflow ticket and launch it.

However, you do not always have to prepare a workflow ticket before you can launch it. It is
possible to build the workflow and launch it on a file without first saving the workflow ticket.
Follow these steps to do this:

738



11Automation Engine

1. In the Files view, select the file(s) you want to launch your workflow on.

Note:  If you need to select files from different ( Job) folders, then first select those in one
same folder, then choose New Task or New Workflow to open a Workflow Editor and there
use the Select File tool to select the files from any other folders (see step 4).

2.
Click  to open the workflow editor.
You can see the file(s) you selected in the Files pane of the Workflow Editor.
 

 
3. Build your workflow and define the settings of every step.

4. If you want, select more files. Right-click in the Files pane and choose Select File....
 

 
In the dialog that appears, select files from folders in Jobs or Containers.

5.
Click the Launch  button. Hold Alt to Launch and Monitor and keep the
workflow editor open.

6. If you kept the workflow editor open, continue by changing the workflow settings,
relaunching or launching on different files. When ready, save your workflow ticket.

11.3.5.  General Workflow Task Options

Task Options are options that will be used when you push the Launch button in the workflow
editor. These settings are not saved into the workflow ticket.

Open Task Options from the menu Advanced in the workflow editor:
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• Priority: Choose the general priority with which you want to launch this workflow. The
default is Normal.

Note:  To choose High or Immediate, you need a special User Access Right.

Note:  You can also choose to set the priority of only a part of the workflow. Learn more in
Set Priority on page 763.

• Hold: Check this when you want to hold the workflow when you launch it. The workflow will

start but immediately go into 'pause' mode. You can then later decide when to use the 
button to start it for real.

• Release: When you decided to use Hold, you can set a time when the workflow should be
released automatically. Choose a relative or absolute time.

• Launch a separate task per input file: Choose this option when you selected multiple
input files but when you still want to launch a separate workflow task per input file.

• Annotation: When testing many workflow tasks or many versions of a workflow, it can be
useful afterwards to read some notes that you added before launching it. Once the task was
launched, you can read these annotations from this same menu or you can read them in
the Tasks view when you right-click the main workflow task line.

For example: "This task was only launched to create the temporary files
that I need to test the next one"

11.3.6.  Relaunching Your Workflow with Different Settings

You can relaunch a workflow from the Tasks view and from the Workflow Editor (skip step 1):

1. In the Tasks view, double-click the main Workflow line to open your workflow in the
workflow editor.
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Tip:  The workflow can be opened and relaunched even when it is still running.

Tip:  If you double-click any sub-step of the workflow, only that ticket will open. You can also
relaunch just that separate single step (if the input files are still available).

2.
In the workflow editor window, click the Edit Workflow button  if you want to make
any changes.
When you are finished making changes, and if you want to keep the new settings before you
try them out, save your workflow now.

Note:  As soon as you make one change, the name of the workflow ticket in the top bar will
show an asterisk * behind the name to indicate that it has been changed.

3.
Click Launch  or press Alt while clicking Launch to Launch and Monitor .

11.3.7.  Diagnosing a Workflow in the Tasks Pane

You can check the processing status of a workflow in the Pilot’s Tasks pane. The Tasks pane
appears in the Files, Products and Tasks View.

 

 

Attention:  The Tasks pane does not show the Workflow Controls that may be part of
your workflow. To diagnose them, use the Workflow Editor.

Workflow Status

The workflow status can be

• : running, when one or more steps are waiting to be handled.
• : success, when all steps finished successfully.
• : warning, when one or more steps finished with a warning.
• : failed, when one or more steps finished with an error.
• : cancelled, when a user cancelled the processing.

Right-Click and Diagnose Further

Right-click or Cmd-click any task line to see many functions available for that task or its related
files.

The availability of the functions depends on
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• if the task is already finished or not
• if the task is the initial 'workflow' task type or any sub-step of that workflow.

 

 
These functions are documented in Functionality on items in Tasks View on page 118.

Some specific notes:

• Delete. If you decide to manually delete tasks, then you best delete the main workflow
task step so that all related task steps are also cleaned up. In general we advise to use
the automated version based on the standard Task Cleanup Rules that you set up in the
Configure tool.

• Move to History. Same comments as above for the Delete function. Learn more about
storing task details in Task History on page 151.

11.3.8.  Diagnosing a Workflow in the Workflow Editor

General View

In the workflow editor, you can see your file(s)  going from step to step, with their processing
Phase displayed in blue text.

Note:  This icon  can represent a single file or a collection of related files.
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• Click  to see the Details of the main workflow task (names of output files, stranded files,
reading of workflow parameters...).

Tip:  If you want the details of a specific workflow step, then first select one of the output
files of that step and then right-click and choose Details.

•
Click  to see the To Do Action items associated with this workflow.

Output Pins and Widgets
A number in the output pin of a step indicates the number of files that ran through it.
 

 

Click on the number to open a widget showing the file names.

Note:  The items in these output widgets are actually more than files, technically we name
them tokens. A token could consist of one file, or many files or even be empty. Learn more
technical detail in Understanding Tokens (Grouping of Output Files) on page 746
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Inside the widget, right-click the name of a file (token) to see more options. Many of these
options were explained in Diagnosing a Workflow in the Tasks Pane on page 741.
 

 

Note:  You can also right-click the icons  of files that are still being processed and get more
options there.

Note:  To check the Workflow Parameter Values of a (collection of) file(s): learn more in Using
Workflow Parameters on page 803.

Seeing the Followed Path

In an output widget, click on a file name to see which path it followed. In this example we
clicked on lemon_report.pdf. The name is highlighted in blue and the path that this file
followed so far is shown in yellow.
 

 

Seeing the Related Files

Clicking on a file name also helps diagnosing the relations between files. In below example we
clicked on lemon.pdf in the 'Error' widget. This highlights all related files in a light blue color.
These relations were created during their processing.
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Note:  Files that are related to each other in a workflow will also share the same workflow
parameters at that specific step of the workflow. Learn more in Using Workflow Parameters on
page 803.

Diagnosing an Error

In below example, we right-clicked on a file in the 'Error' widget and asked the Open Details ....
This explains the error: the zip was not created because it already exists (and the ticket had
the setting to fail in that case). Sometimes, you will need to Open Log ...  to find what you are
looking for.
 

 

Details is meant for the user and is translated. Log info is mainly for Esko service people, it is
more complex and also not translated.

In this example, you could now continue with these steps:

1.
Click on  to edit the workflow.

2. Double click the Zip task, change the setting that generated the error and click OK to
confirm and close the ticket.
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3.
Launch this changed workflow: click  or press Alt and click .

4. If you prefer this new setting, save your workflow.

Error Files or Invalid Files

See the open widgets of this example workflow:
 

 

• In the widget of the Start step, broccoli.pdf and Presentation.pptx are shown in grey
because they are not valid for the next step in the workflow.

• broccoli.pdf is invalid because it has a size of 0 Kb.
• Presentation.pptx is a PowerPoint file and that is not a valid input file type for the

next step.

Note:  Both file names would be shown in black when the next step would for example be a
Copy or Move File task.

• banana.pdf and lemon.pdf are valid PDFs.
• Sprouts.pdf: Based on its extension '.pdf', the file was valid for the next step but it still

resulted in an error (the task detected that the file was not really a PDF file).

11.3.9.  Understanding Tokens (Grouping of Output Files)

Concept

Automation Engine internally decides how files are grouped as they progress through a
workflow. When a workflow step has more than one input file, it then depends on what
workflow step it is whether those files are handed over to the next step as separate files or as a
group.

Automation Engine groups output files by attributing them a same token (an internal ID
number). This token is not shown in the user interface. Files will seem grouped because they
were attributed a same token. The next step in the workflow receives one or multiple such
groups from the previous one. The next workflow step(s) typically starts a task per such group,
technically 'per token'.

This internal behavior of the software is visualised in the widgets that list the output files of
a workflow step. You can also see how the system works with groups or tokens in the list of
Tasks.
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Example

An example:
 

 

1. Each task type or workflow control has its own way of attributing tokens:

• This workflow is launched on 3 input files. The step 'Start' always attributes them the
same token and so hands them over to the next step(s) as one group containing of 3
files. See how selecting one of them in the widget (dark blue) also highlights those that
have the same token (light blue).

• The workflow splits off into 2 steps that process this group differently: The step
Optimize PDF Separations only shows one icon of a token , while the step Optimize
and Clean (PSFix) shows 3 such tokens. This different behavior is decided in the
software ; it is not a task setting you can change.

2. The list of Tasks shows how a task is started for each token.
3. In the widget that shows the output of the Optimize PDF Separations task, selecting one of

its items shows that the 3 output files are still grouped. They still have the same token. This
type of task did not split the group: it keeps them grouped for a next step.

4. In the widget that shows the output of the Optimize and Clean (PSFix) task, selecting one
of its items shows that the 3 files are no longer grouped. This is because this type of task
always attributes its output files an individual token: they will be handed over to a next step
as separate items.

Note:  An item in a widget is not always a file. It can also be a folder or even only some internal
number.

Controlling this grouping - Controlling how tokens are attributed
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Sometimes you want control over these groups. You may want to change the built-in behavior.

Some examples:

• When you want separate files in stead of a group.

For example: When your workflow starts with a Step & Repeat task.

• With this type of task, you will get this result by default:
 

 
The S&R task here receives them as a group and so combines them on a same layout.

• If you do not want this (if you want a layout per input file), you can solve this by adding a
Data Splitter in front:
 

 
• When you want to overrule the built-in grouping logic.

Some examples:

• When you want specific grouping of RIP output files before they become input files for
the task 'Prepare for Viewer'. This grouping decides how the Viewer will open them.

Learn more in Data Splitter.
• When you want to control which files should be ZIP'ped or FTP'd together.

Learn more in Data Collector.
• When you want to collect files that were created from a source file in that workflow.

Learn more in Fork and Join.

About Empty Tokens
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Automation Engine v18.1 started an important change in the behavior of AE workflows:

In case an output pin of a task or workflow control has no output file, a workflow can now
continue with a so called ‘empty token’, where in previous versions, the workflow would have
stopped.
 

 

This change was made to avoid that a workflow stops ('stranding') where it did not make sense
to stop. Workflow steps that do not really need an input file, should not be blocked from
starting when there is no such file.

Attention:  This means that after an upgrade to 18.1, some workflows can now
continue where before they used to stop. So check your workflows after this upgrade ;
you might have to adapt some!

11.3.10.  Checking the Resources your Workflow contains

Concept

In the workflow editor, the Resources pane allows to show and search the resources in your
workflow. Click  to show or hide this pane.

Note:  This resources pane is also available when you open a workflow in the Tickets or the
Tasks view.
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A workflow can use many different kind of resources. This tool can detect these resources:

• Files

• ReportMaker template file. In above example, this is the template file used in the
ReportMaker step.

• SmartNames

• All types, including public parameters, workflow parameters, ...
• Workflow parameters appear in red when they are requested in a ticket but missing in

the list of workflow parameters of this workflow.

• Referenced workflow tickets

• Marks sets

• Dynamic Marks
• SmartMarks

• Action list files

• PDF Action List
• ArtPro Action List
• PitStop Profile
• PitStop Action List

• CAD resource files

• CAD Style
• CAD DXF Tune
• CAD Tune

• Global Vision inspection tasks resource files

• Compare Barcode Profile
• Braille Language
• Spelling Language
• Compare Artwork Profile
• Compare Text Profile
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• Other resource files

• Notification Template
• Script files (.bat, etc.)
• Tiling Template
• Cutting Flow
• Print Rule Set

Using the Resources pane

• When a same resource is used in several workflow steps, for example a SmartName, it will
also be listed several times.

• When you select a resource, the workflow step where it is used is also selected and scrolled
into view.

• When you click on an already selected resource, an animation draws extra attention to the
workflow step where it is used.

• When you double-click a resource in the list, the workflow step where it is used is opened
and ready to be edited.

• SmartName parameters that are missing within this workflow appear in red, typically <<pp.
or <<wfp. parameters.

• Use the filter in the resources pane to filter the list of resources. The entered text will be
looked for in the resource name, resource category. For SmartNames it also takes the ID of
the SmartName into account.

This helps to quickly answer the FAQ "Where is SmartName <<xyz>> used in this workflow?"

• When changes are made to the workflow, the list of resources is immediately updated to
reflect the new situation.

• You can edit custom SmartNames directly from within the resources pane. Right-click the
SmartName resource and select Edit SmartName.... You can edit and save the SmartName
in that dialog.

11.3.11.  Pausing or Cancelling Your Workflow

While monitoring your file’s progress in the workflow editor, you can:

•
click  to pause your workflow (at the end of the task that is currently running),

•
click  to make your paused workflow run again,

•
click  to cancel your workflow’s processing.

11.4.  Workflow Controls
Workflow Controls are steps in a workflow. Instead of executing a task on an input file, they
make workflow decisions on routing, file selection, file order etc.

•
 Start: Every workflow needs to start with this step. By default it is present on every

new workflow canvas.
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•
 Modify Workflow Parameter Values: Use this to modify workflow parameter values

at some point during the workflow. Learn more in Modify Workflow Parameter Values on page
753.

•
 Select Referenced File: Use this to easily select files that are referred to in an XML file.

Learn more in Select Referenced File on page 760.
•

 Set Priority: Use this to assign a different priority to parts of your workflow. Learn
more in Set Priority on page 763.

•
 Sort: When the order of the input files is important in the next workflow step, use this

one to manage that order. Learn more in Sort on page 764.
•

 Router: This step enables automatic routing of files based on many possible criteria.
Learn more in Router on page 767.

•
 Mark File: Use this step to mark files that you will select later in the workflow using

the Select Marked File workflow control. Learn more in Mark File and Select Marked File on
page 772.

•
 Select Marked File: Use this step to select the files that you marked earlier in the

workflow using the Mark File workflow control. Learn more in Mark File and Select Marked
File on page 772.

•
 Data Splitter: Use this step when you want to send the files one by one to the next

task instead of grouped. Learn more in Data Splitter.
•

 Data Collector: Use this step to collect all incoming files before sending them to the
next task as a group. Learn more in Data Collector.

•
 Fork: Use this to tag incoming and related files with a group tag. This is useful in

special cases where you want detailed control over how Automation Engine groups files in a
workflow. Learn more in Fork and Join.

•
 Join: Use this to select the files tagged as a group by the Fork workflow control. Learn

more in Fork and Join.
•

 Cancel Workflow: When a file is sent to it, this step cancels the processing of the
entire workflow. This is useful when you also want to stop not just the branch of the
workflow where this step is used, but all branches. For example: when the previous step
Manage Product Status results in 'not approved' then the next step is Stop.

•
 OK: By default, there is already one OK step in the canvas. You can add more and

route files processed successfully to the appropriate OK step. When a subworkflow ends
with multiple OK's, they will show up in the master workflow as multiple green output pins.

•
 Warning: Add this step at the end of your workflow to route files that generated a

warning during processing. For example preflight tasks or approval processes typically also
offer a warning as end type.
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•
 Error: Add this step at the end of your workflow to route files that generated an error

during processing.

Note:  A task that has one or more files ending with an error automatically triggers an error
status for both that task and the whole workflow. That is why it is not necessary to add this
Error workflow control and connect to it from the error output pin of a task.

To see which files caused this error, you can also click on the error output pin and open the
output widget:
 

 
Learn more in Diagnosing a Workflow in the Workflow Editor on page 742.

11.4.1.  Modify Workflow Parameter Values

This workflow control allows to modify values of workflow parameters during the workflow.
Learn more about workflow parameters in Using Workflow Parameters on page 803.

Concept

The typical reason to modify a workflow parameter during a workflow is that there is new or
changed information that was not there earlier or at the start of that workflow. Some example
cases:

• The new or changed information is based on a user's decision. For example the decision
how to release a To Do Action item. See an example below.

• The new or changed information is coming from an external system (and was not available
earlier).

Note:  Mind these exceptions:

• New information coming from WebCenter does not need this separate workflow
control. The tasks that communicate with WebCenter offer their own built-in tool to
map their output parameters to workflow parameters. Learn more in Modifying Workflow
Parameters During a Workflow on page 814.

• When, during a workflow, an external system sends an updated XML with new or
modified parameters, check if you can use the feature Using Workflow Parameter Values
from XML  on page 810. This feature loads that XML at every step of the workflow, not
just at the start. This means that the incoming updated XML can trigger an updated
workflow parameter without the use of this separate workflow control.
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Using the workflow control 'Modify Workflow Parameter Values'
To use this workflow control, proceed as follows:

1. Select and drag the Modify Workflow Parameter Values workflow control onto your
workflow canvas. Double-click it to edit.

2. Click Add to add workflow parameters or double-click existing ones to modify.
3. Use  to select an existing parameter or type the desired workflow parameter name and

provide a new value. This can be a fixed value, a SmartName or an XPath expression that
retrieves the new value from the workflow control's XML input. Learn more on Xpath in The
XPath Builder  on page 631.

When the input file is a JSON file, you can here also enter a JSONPath expression. Learn
more in JSONPath Expressions on page 755 .

Attention:  As mentioned in The XPath Builder  on page 631 , adding SmartNames
or JSONPath expressions to your XPath expression is not supported when you are
creating this kind of an 'inline' XPath expression.

4. Click Add to confirm.

Note:  When the parameters list contains a new one, you will be asked to Confirm.

5. Click OK to close. Save your workflow.

Example: Capturing the To Do decision as a Workflow Parameter
Our workflow asks a user to decide if the output will be done on the old or on the new printer.
This decision should also be mentioned on the Report PDF.

• See how the To Do output Pin 'New faster Printer' routes to the workflow control
that sets the value of the workflow parameter 'Printer Decision by User' to 'New
Faster Printer'.

 

 

• The ReportMaker template needs to pick up that workflow parameter. Those templates are
created in PackEdge. Because PackEdge SmartMarks can not pick up workflow parameters,
you first need to create a SmartName of that workflow parameter and then use that
SmartName in the template. Follow these steps to do this:

1. In Pilot, in the SmartNames View, in Include SmartNames From, check the option A
workflow and select the workflow that contains the desired workflow parameter.

2. Click  to create a new SmartName.
3. Set the Scope to Global and the SmartName Type to String Extract.
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4. Click  Insert SmartName and select the category Workflow Parameters.
5. Select the desired workflow parameter [wfp. ] and click Insert.
6. Save the SmartName.
7. Open the ReportMaker template in PackEdge and open the SmartMark palette.
8. Select Text Mark from the Add SmartName palette.
9. Click the Smart Text... button, select the category SmartNames (Global) and select the

SmartName you just created.
10.Save the ReportMaker template
11.Use this template in the ReportMaker task. The resulting PDF can now mention what the

user decided in his To Do. Here is an example of how this can look like:
 

 

Visualizing the Workflow Parameter Values of a Step Output
To visualize the Workflow Parameter Values of a selected file, you can:

• choose the menu item Advanced > Workflow Parameter Values. This dialog stays opens
while you click on output files.

• right-click on the desired step output and select Workflow Parameter Values.

Using above mentioned example, see the workflow parameter values of the Report PDF. The
small icon  indicates that the value was modified during the workflow:
 

 

Note:  The set of workflow parameters can be different for each step output. For more info,
see Using Workflow Parameters on page 803.

JSONPath Expressions

Concept

When the input file is an XML, you can directly type in an XPath expression in some fields of
the task's options. Those fields also offer to click on  to open a panel to help you build that
XPath expression with the correct syntax.
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In the exact same way, when the input file is a JSON file, you can there type in a JSONPath
Expression. And when you click on , the same panel opens to help you build that
JSONPath Expression.

Attention:  This button is not available in all tasks. It is only available in these workflow
controls: Modify Workflow Parameter Values, Select Job and Select Referenced File.

Learn all about this panel that helps you build JSONPath expressions in The XPath Builder  on
page 631. Its features are equally valid for JSON data.

Note:  Unlike XPath, it is not possible to create JSONPath SmartNames.

Example
 

 

11.4.2.  Select File

This task allows you to select one or a group of files on which you launch the next workflow
step.
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Note:  In an input field, when the matching icon is present, you can use SmartNames or
Regular Expressions or browse to define a folder. You can also use * as wild card character.

1. Define what file types you want to select in the File Type list. You can:

• choose to select Any file type,

• pick one of the default file types,

• choose Select File Types and pick them in the Select File Types dialog.
2. Define which files you want to select:

• Select task's input files will select all input files (of the selected File Type if you
specified one).

Use the Only select when name matches option if you want to filter the input files to
select based on their name.

• Select marked files will select files you have marked earlier in the workflow (using the
Mark File task).

Use the Only select when name matches option if you want to filter the marked files
based on their name.

• Select Product Parts linked to a Job with name will select Product Parts linked to a job
of your choice. Specify the job name in this option.

Use the Only select when File name matches option if you want to filter the Product
Parts based on the name of the file they contain.
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See the chapter Products on page 548 more information about Products and Product
Parts.

• Select other will select other files or folders (that have not been processed by the
workflow).

1. Choose to select Files or Folders.
2. Use the Name Matches option to select those files or folders based on their name.

This is not case sensitive.
3. Define where the files or folders to select are located in Look in Folder. Choose to

Look in subfolders or not.
3. If you want, you can choose to make the Task end in Error when no files were selected.

11.4.3.  Select Job

The Select Job workflow control serves to select a job in a workflow. It actually selects the Job
Folder. The next task in the workflow will use that job folder as input.

This workflow control is typically followed by a Remove Job or Archive Job task.

Note:  The job context and any job related SmartNames in the following workflow will still be
those from the job that the workflow was started in originally.

You can choose to select a job using the Job name or by using the combination of the Order ID
and sub order ID.
 

 

The Job name, Order ID and sub order ID can be specified by:

• Entering a value.
• Inserting SmartNames.
• Selecting a job using the Select button. The Job name, Order ID and sub order ID will then

be filled in automatically.

• Entering an XPath expression. You can enter one manually or click XPath to use the Xpath
Builder where you create an XPath expression that gets a value from an XML file. Learn
more about creating Xpath expressions here.

• When the input file is a JSON file, you can here also enter a JSONPath expression. Learn
more in JSONPath Expressions on page 755 .

Attention:  As mentioned in The XPath Builder  on page 631 , adding SmartNames
or JSONPath expressions to your XPath expression is not supported when you are
creating this kind of an 'inline' XPath expression.
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Attention:  The Select Job workflow control only handles one input file at the time.
When you want to select the jobs of multiple input files, you need to use a Data
Splitter step in front of it.

11.4.4.  Select Product

Concept
The Select Product workflow control is typically used in a workflow where the next step is to
change the status of the selected product (part) or to remove the product.

It can select one or multiple products or product parts. It's outputs are the URLs of all parts of
the selected products.

You can select a product by its ID or Name or select a product part by its name.
 

 

Ways to Identify the Product(s)

In the input field, you can type in values, Select a product from the list or use SmartNames.

You can also add an XPath expression, in which case the input file of this workflow control has
to be an XML file. The XML file can be one with or without XML namespaces. Click on XPath to
open the XPath Builder and select the XML value matching the product (part).

This is an example where the expression results in one value, the first one of that XML element.
Notice the [1] in the expression:
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In this next example, the user manually removed the [1] in the expression and confirmed
with Enter (or click OK and re-open the XPath Builder). You can see that the expression now
selects all the values. In such a case, where the XPath expression resolves to a list of values,
each individual entry in the list is used to select that list of products.
 

 

Learn more about the XPath Builder in Creating XPath Expressions  on page 1618.

Options

• Provide a warning when no products were selected. When no products were selected
and when this option is not checked, there will be no warning status and the OK output pin
will show zero outputs.

• Ignore unexisting products. When this option is enabled, products that do not exist in
the database will not be selected. When this option is disabled, selection of an unexisting
product will lead to an error.

11.4.5.  Select Referenced File

Use the workflow control Select Referenced File to easily select files that are referred to in an
XML file.
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Note:  The XPath button offers to use the Xpath Builder. Learn more about creating Xpath
Expressions here.

When the input file is a JSON file, you can here also enter a JSONPath expression. Learn more
in JSONPath Expressions on page 755 .

Attention:  As mentioned in The XPath Builder  on page 631 , adding SmartNames or
JSONPath expressions to your XPath expression is not supported when you are creating
this kind of an 'inline' XPath expression.

• Select by: You can indicate (via SmartNames or XPath) which XML content to take to build
up the corresponding file path(s) and name(s). You can choose between:

• Folder and File Name: Choose this option if the source XML contains entries that define
the file path and file name separately. If this option is chosen, specify both the Folder
and the File Name.

• File Path: Use this when each file in the source XML has a fully specified absolute file
path.

• Also select input files: Select this option to also add the step's input file(s) to the group of
output files.
 

 

• Don't group output: When this option is selected, the selected files will be offered
separately to the next step in the workflow instead of as a group.

When Don't group output is not selected (so output is grouped) and Also Select Input
Files is selected, the task will generate a group for each output:
 

 

• Provide a warning when no files were selected: Select this option to get a warning when
no files are selected.

• Ignore unexisting file or folder: Select this option to prevent workflow errors when one
or more file paths refer to non-existing files. When selected, the non-existing files will be
ignored.
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Example 1: Folder and File Name
Our example XML refers to one file in a first Job and then to 3 files in another Job:

 

 

We used the Edit button to get to these settings:
 

 

After the Select Referenced File step ran, you will notice these 4 files on the OK output pin of
the workflow control (assuming the files exist).

• file://loppem/ExampleJobContainer/Jobs/Order-2014-100024/PDF/
Design1.pdf

• file://loppem/ExampleJobContainer/Jobs/Order-2014-100025/PDF/
Design1.pdf

• file://loppem/ExampleJobContainer/Jobs/Order-2014-100025/PDF/
Design2.pdf

• file://loppem/ExampleJobContainer/Jobs/Order-2014-100025/PDF/
Design3.pdf

Example 2: Absolute File Path
This example XML contains several absolute file paths:

<?xml version="1.0" encoding="UTF-8"?>
...
  <FileSpec>file://AEserver01/Food/Jobs/1234/PDF/design1.pdf</FileSpec>
  <FileSpec>file://AEserver01/Food/Jobs/1234/PDF/design2.pdf</FileSpec>
  <FileSpec>file://AEserver01/Food/Jobs/1234/PDF/design3.pdf</FileSpec>
...

We chose the option File Path and used the Edit button to get to this setting:
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The output pin of the Select Referenced File step will show these 3 file paths:

• file://AEserver01/Food/Jobs/1234/PDF/design1.pdf
• file://AEserver01/Food/Jobs/1234/PDF/design2.pdf
• file://AEserver01/Food/Jobs/1234/PDF/design3.pdf

Example 3: Using SmartNames
This example XML has a different structure:

<?xml version="1.0" encoding="UTF-8"?>
<Order id="2014-102457">
  <Customer id="JuiceCo"/>
  <Design>
    <File>PDF/design1.pdf</File>
    <File>PDF/design2.pdf</File>
  </Design>
</Order>

In this case, we find the Folder via a SmartName, based on the Order ID, and the File Name via
an Xpath:
 

 

This is the resulting selection ; the part of the path including the Job number was found via the
SmartName, followed by what the XML defined in <File> :

• file://AEserver01/Food/Jobs/102457/PDF/design1.pdf
• file://AEserver01/Food/Jobs/102457/PDF/design2.pdf

11.4.6.  Set Priority

Use the Set Priority workflow control to assign a different priority to a part or a specific branch
of a workflow.

You can set the priority to:

• Workflow (to use the general priority assigned to the workflow)

Note:  By default, the general workflow priority is set to Normal. You can change it by going
to Advanced > Task Options... in the workflow editor window.

• Low
• Normal
• High
• Immediate.

The chosen priority is shown in blue right under the workflow control:
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Example
In this example, the most urgent operation is RIP'ing the files and outputting them to the
device. Creating a PDF report or a JPEG is less urgent. All the workflow steps following the "Set
Priority" step will get this high priority, that whole workflow branch:

 

 

11.4.7.  Sort

Use the Sort workflow control to define the order of the files in a file set. You do this because
the order is important in the next workflow step.

 

 

You can sort the files by:

• file name.

• workflow inputs. Files that entered the workflow first will be at the top of the list.

• modification date. This helps you to select the oldest or newest data.

• SmartName. The value of a SmartName is calculated per file and that value determines the
order.

For every of these methods, you can sort in ascending or descending order.
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Keep ... file(s): Use this if you only want to send a specific number of sorted files to the next
workflow step.

Sort by file name

Use a Regular Expression to define the part of the file name that you want to sort on. The
dropdown list shows two example regular expressions:

• (.*) matches the entire file name

• .*?([0-9]+) matches the number in the file name (for example to sort files named
cover1.pdf, page_2.pdf, etc.).

Learn more about regular expressions in Using Regular Expressions on page 656.

• Sort numerically

Select this option if you are using a regular expression to extract a number from file names.
The results will then be sorted numerically and not as text. For example, a value of 10 will be
sorted after 9 when this option is selected. When you don't sort numerically, the values are
considered as text: then 10 will come before 9 (as text, the first character 1 comes before 9).

• Accept non-matching files

Select this option if you also want to sort files that don't match the criteria. For example
your regular expression is based on numbers but the name of one file name doesn't
contain numbers.

Any non-matching file(s) will be put at the top of the sorted list.

If you don't use this option and a file does not match, all your files will go to the error
output pin.

Sort by workflow inputs

Files that entered the workflow first will be at the top of the list. You can sort in ascending or
descending order and optionally define how many files you want to keep.

Sort by modification date

This method can be used to select the oldest or most recent data. See this example where we
used the settings descending and Keep 1 file to sort and end up with only the most recent
file:
 

 

Sort by SmartName

Select the SmartName you want to sort on. This list only offers custom SmartNames.
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Numerical versus text based sorting works as described above for Sort by file name. The
same is true for the handling of non matching files.

Example: Sorting by Page Number

In this workflow, the Data Collector collects the pages of a page list after Normalizing, and
sends them to the Sort workflow control. Learn more about Data Collector here.

The Sort workflow control then sorts them in the right order, before sending them to the
Create Imposition task. The files are sorted on file name, in ascending order, using a
Regular expression to extract the number in the file name (and with the Sort numerically
option):

 

 

Example: Sorting by SmartName, Numerically and As Text
In this example, you want to sort your files by the number that they contain. The number is
always mentioned after an underscore. You created a SmartName that extracts, from a file
name, everything after the underscore.

This is the result when you Sort numerically:
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This is the result when you don't Sort numerically ; the part of the name after the underscore
is now considered as text:

 

 

11.4.8.  Router

The Router workflow control  serves to automatically decide the route that your workflow
(files) should follow.

Let's take the example where a Router decides the workflow track based on the size of the
incoming file. When the file is smaller than 5 MB, the file will be sent out via E-mail, otherwise
via FTP.

• These are the settings in the Router:
 

 
Two rules were defined and the Route to names were customized.

Note:  The rules are executed from top to bottom. Their order can be changed with Move
Up / Move Down.

• This is the workflow:

Notice how (when the mouse hovers over the Router step) the name of the middle output
pin appears and how it matches the name that was defined in the Route to column of the
Router settings.
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Routing can be based on many different criteria (see the list below). Several of them offer these
generic options:

• Treat as numeric value: When you select this, the options in the value column offer
numeric possibilities (is less than, is greater than, etc.). This option is not there when it is
obvious that the value is numeric.

• Case sensitive: Select this if you want to match the exact case of the value.

Note:  If a value has to match, wildcards and Regular Expressions can be used in the value field.

Routing Based on Job Parameter Value

Choose this to route your file based on a Job Parameter. The Parameter Name drop-
down list offers the parameters of the Job setup tab Parameters and also those of the tab
Step&Repeat.

Note:  You can also type in the parameter. This is not advised to avoid typing errors. However
this can be useful when you build the workflow and router settings outside of a Job context in
which you will be using it. In that case the parameters will not show up in the drop-down list
yet.

An example:
 

 
Notice how you do not always need an Error route and how same routes can be chosen for
more than 1 value.

Routing Based on Job Field Value

Choose this to route your file based on one of the Job setup fields listed in the Field Name
drop-down list. The list also includes the custom Job Categories you may have defined.
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The field Job Operation Context can only have these 2 values: update or creation. This
value was useful in cases where we now advise to use the Create Job task as a workflow step.
Learn more in the Advanced on page 1637 tab of that task.

Routing Based on Number of Files

Choose this to route collections of input files based on the number of files in that collection.

Some examples:

• When you get not 1 but 2 files, you want to route to the recto/verso (front/back) workflow.
• You created various Tabular Step & Repeat tickets, one for each amount of Grids that they

offer. You use the Router to route to the Step & Repeat ticket with the same number of
grids as the amount of input files.

Routing Based on Milestone

Choose this to route based on the fact if a certain Milestone is Set or Not Set.

For example: you have a workflow where someone from the administration department uses
the Pilot to select a Job and set the Milestone 'OK from Admin department to Print'. The
Router checks if this OK was already given before continuing the workflow to the press.
 

 

Routing Based on File Name

Choose this to route files based on their name. Choose to Include the file extension or not.

For example: You agreed with the person sending you design files that no trapping will be done
if he ends the file name with 'notrap'. You created an Access Point that launches a workflow
that starts with this Router:

 

 

Routing Based on File Type
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Choose this to route files based on their type.

For example: this Router categorizes many file types into specific routes:

 

 

Routing Based on File Size

Choose this to route files based on their size.

Select Consider the combined size of all files in the collection if you want to match the size
of the whole file collection and not of its individual files.

See an example in the above introduction.

Routing Based on Number of Pages

Choose this to route files based on their number of pages.

Select Consider the combined page count of all files in the collection if you want to match
the page count of the whole file collection and not of its individual files.

For example: if the file has 2 pages, then you know it is a recto/verso (front/back) file.

Routing Based on Page Orientation

Choose this to route files based on their orientation (Portrait, Landscape or Square).

Some examples:

• your RIP does not have an auto-rotate function. Your workflow will then need to make sure
that you send the data in the wanted orientation.

• you want to know if a file fits on an output sheet. Before you compare the sizes, you will
want to know which side is the longest. If your output sheet is 100 horizontal by 60 vertical,
you best only compare sizes when your input file is also in landscape mode.

Routing Based on Page Size

Choose this to route files based on their page size.
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In Pagebox to use, you can choose either Trimbox or Mediabox. For images, both settings
Trimbox and Mediabox will have the same result. The image size will be used for the
comparison.

This is typically used to route files to the output device with the right size. For example to send
small files to the small proofer, and bigger ones to the big proofer.

An example: When you want to route a file to a right printer:

• When a file fits on A4 paper = "is less then or equal to 210x297 mm"

• When a file fits on A3 paper = "is less then or equal to 297x420 mm"

Note that router entries have an order. In above example, a 100x100 mm file both fits A4 and
A3 paper, but A4 is chosen because it comes first in the list of criteria.

Attention:  Both page orientations of the input file are always checked! The page size
that you here define is the size of a surface that the file can fit in or not, no matter how
it is orientated.

"Is less than or equal to" means "Does the file fully fit in the specified surface
(in portrait or landscape)?"

"Is greater than" means "Does the file fully cover the specified surface (in portrait
or landscape)?"

For example: 'Page size' 'is equal to' '210 x 297 mm' will therefore match A4 files
both in portrait and landscape mode.

Routing Based on Number of Separations

Choose this to route files based on their number of separations.

For example: when a flexo job has more than 6 inks, you use a different SmartMarks set. It
then uses one with smaller rectangles for the color strips. You use a Router that checks the
number of separations. If it detects more than 6 inks, the next step is the Step & Repeat ticket
that uses the set of SmartMarks with the smaller rectangles.

Select Consider the combined separation count of all files in the collection if you want to
match the number of separation of the whole file collection and not of its individual files.

Note:  This counts the number of unique separations. For example, if you have a CMYK+Red
and a CMYK+Green file, the collection’s combined separation count will be 6.

Routing Based on Separation Name

Choose this to route files based on the name of their separation(s).

You can check if any (one or more), all or none of the separation names match or contain
parts of a specified string.

For example:

• when 'any' separation names 'contain' the text string 'pantone', then route to the
part of the workflow where you process the files that are not CMYK-only.

• when 'all' separation names 'does not contain' the text string 'Die', then route to
the Checkpoint task that will add an Action to the To Do List. The Action will ask the user to
add that separation.
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Routing Based on Layer Name

Choose this to route files based on the name of their layer(s).

For example: you sometimes receive PDFs with several layers of black text in different
languages. The Router checks if the file has any layers with these names: FR, SP, EN, DE, IT, or
PT. If so, it routes them to the workflow where you first use Version PDF to create PDFs with
only 1 language in black (k): name_cmy_FR_k.pdf, name_cmy_SP_k.pdf, etc.

You can check if any, all or none of the layer names match. When using any, only one layer
name needs to match for the file to be considered matching.

Routing Based on SmartName Value

Choose this to route files based on a SmartName value.

For example: the Router checks the workflow parameters 'Print Process' or 'Preflight
Yes or No'. The values of these parameters decide what route the file needs to follow.

Find a good example in Launching a workflow with parameters from an XML on page 1669. Step
5 of that example illustrates how the Routers use SmartNames.

Note:

Routing on SmartNames requires more resources from Automation Engine. If you have an
alternative, we advise you to use another routing method instead.

If your SmartName only contains Job related parameters, and you have many input files, we
advise to add a Data Collector in front of your Router. This will group the files into a collection
and allow the Router to perform the SmartNames check only once.

11.4.9.  Mark File and Select Marked File

These 2 workflow controls are used as a pair. First you use Mark File to tag files, then you use
Select Marked File to select those files later in your workflow.

You can have several pairs of Mark File and Select Marked File in your workflow, as long as
each pair has its own tag.

Mark File Settings
In Mark all incoming items with tag, enter the tag to set on all files passing through this
workflow control.

Select Marked File Settings
In Select all items with tag, use the drop-down list to select a tag that you entered earlier in
the corresponding Mark File workflow control.

You can filter the selection of tagged files. Select Only select when name matches and enter
what name the file should match. You can use SmartName(s), Regular Expressions or an asterisk
* as a wildcard.

If you are working with subworkflows, you can choose to Also search workflows containing
this workflow (to search 'up'). Learn more about subworkflows here.
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Note:  When no files are found, an empty token will be put on the 'warning' output pin. This
allows to continue a next step originating from that warning status.
 

 
Learn more about tokens in Understanding Tokens.

Example
A typical example is launching tasks on the one-up PDF after your workflow was already
working on the Step & Repeat version. In this case, you can tag the one-up file with Mark File,
later select it with Select Marked File and then for example archive it:

 

 

Note:  You need to use the exact same tag in the Mark File and the Select Marked File step. It
is case-sensitive, so we advise to always use the drop-down list.

11.4.10.  Data Collector

Use the Data Collector workflow control

• to collect incoming files from different routes in the workflow and then offer them to the
next step as a group

• to wait for files till all expected ones have arrived, and then send them to the next step
(without grouping them).

For a Data Collector to know when it has collected all necessary data can be an intensive
process when workflows are rather complex, not just in amount of workflow steps and routes,
but especially when many files and workflow parameters are involved.

Note:  This workflow control is actually a 'Token Collector'. It collects tokens in a workflow. We
strongly advise to first learn about tokens and file grouping in Understanding Tokens (Grouping
of Output Files) on page 746.

Warning:  Do not make a workflow where you connect the output pin of a Data
Collector with the input pin of another Data Collector. The behavior of such a loop is
unspecified and so not supported.

Example
In this example, the Data Collector waits for all of the files to arrive (one-ups and their reports),
then groups them and sends them as one token to the Zip task.
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The result is one ZIP file containing all the one-ups and also their reports.

 

 

Settings

• Error Policy

Define what needs to happen when errors appeared earlier in the workflow, before this
Data Collector step:

• Fail when errors occur. When a token arrives that came from a step with an error state,
it will end up on the Error output pin. When the token did not come from an error state
in this workflow, it will end up on the OK output pin.

• Ignore errors (and continue): All output token(s) always end up on the output pin OK.

• Grouping

• Group all collected data:

• When selected, all incoming data are collected into one group. The output pin will
show that group as one token.

In the above example, see how, in the output widget of the Data Collector, a mouse-
click on box1.pdf also highlights all the other members of the group in light-blue
(and as usual also highlights the related files in previous workflow steps).

• Deselect this option when you want to use a Data Collector as a wait point in your
workflow. It then serves to hold the workflow until all previous steps are finished.
Once all expected tokens have arrived, the Data Collector allows the workflow to
continue, using the same input items (tokens) as they entered the Data Collector
(whether they were separate items or already grouped).

In this case, each incoming token will also appear as a separate token on the output
pin.

• Merge workflow parameters from all collected data:

This option is disabled when you did not select Group all collected data. Any incoming
workflow parameters then remain attached to their specific file set.
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• Select this option to also merge workflow parameters from the incoming tokens
(default setting). The 1 output token will hold 1 set of values for its defined workflow
parameters.

Warning:  Merging workflow parameters can create unwanted effects in your
workflow!

Some steps in a workflow can set or change the value of workflow parameters.
The token then continues with that new value.

It is not only the dedicated task Modify Workflow Parameters Values that can set
these values, also the tasks Checkpoint - To Do and Integrate with WebCenter can
do that.

When that token then arrives at the Data Collector, the values that its
workflow parameters then have will be those in its output token(s).

However, when these tokens arrive from different routes, how should the
workflow engine decide of which token it should choose that parameter and
its value?

See the below page to learn more on this complex matter. It uses some
examples to illustrate why the result of this 'merge' option is unpredictable.

• Deselect this option to keep any workflow parameter values only valid for their
specific token.

See the below page to see some examples.

Important:  Having this option deselected can have a positive effect on the
performance of the workflow. So if your workflow ticket does not require this merging
of workflow parameters, we advise to deselect this option.

Note:  When it not advised to use it, why is it the default setting in this task ticket?
Because, before this option existed, this was the built-in behavior in the Data
Collector. From v20 on, it is an option in this task's ticket and we advise to not use it.

Examples of the Challenges in Merging Workflow Parameters

The Problem with Merging Workflow Parameters
The Data Collector is typically used to collect data from several routes. And back-tracking
information in very complex workflow is a very intensive action for a workflow. Of course it's a
lot easier when a workflow is only 1 linear route: a same file can only be collected once and its
workflow parameter's last set value is the only one arriving in the Data Collector.

In the Data Collector, the option to Merge workflow parameters from all collected data
raises these 2 challenges:

• Unpredictable result:

Except in very simple workflows, it is not clear which parameter values will be part of the
grouped token that the Data Collector outputs.

When different workflow routes end up in the Data Collector, and when, for a same
workflow parameter, each route sets a different value, which value should then be taken?
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And also, does it still matter at that point in the workflow? Maybe the values were already
'used' by earlier workflow steps...

The workflow engine tends to keep the first value that arrived at the Data Collector but
the problem is that timing within a workflow can not be controlled. You can not predict
the moment of execution of specific steps within a workflow. The time that a workflow
step starts is always influenced by the load of the workflow engine at that specific time,
by available memory of the server computer, etc. When asked to find a value or choose
between values for a same parameter, the workflow engine tends to pick the first value
arriving, but because we can not control the time they arrive, we can not be 100% sure
which one that will be.

Conclusion: When, in different routes, different values were set for a same parameter, the
resulting parameter value is unpredictable.

• Load on the workflow engine:

The back-tracking that the Data Collector needs to do to find all relevant data, can, in
specific and complex workflows, lead to an extreme load on the workflow engine.

A Data Collector collects, i.e. it searches back in the workflow routes for the tokens it should
collect. But it also collects the tokens' parameters and the value of those parameters
that it should hand over to the next step in the workflow, as part of its grouped output
token. When you have a large workflow, with several routes, where parameters were
modified, where you may have added more than one data collector, this becomes a massive
investigation to be done back in the workflow.

See some examples and resulting advice below. The examples are minimal, i.e. they only show
what is relevant for this explanation.

Setup of our Example Workflow
 

 

1. Our example workflow has 3 workflow parameters: print, flavor and copies. In our
case, their initial value is empty.

2. Each input file is sent to 2 routes. In each route, the value of one or more workflow
parameters is modified.

Note:  We here use the step Modify workflow parameter values, but , as mentioned above,
there are more task types that can set values of workflow parameters.

3. The Data Collector groups the files coming out of these routes. This is where the below
examples show the different cases: What happened to the workflow parameters in these
routes? Should the Data Collector look them all up and merge them for the output token?
Are they really all still relevant to the next steps in the workflow? And what if a token
received different values for a same parameter?
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4. We use the Copy or Move File task as a little trick to quickly see the resulting parameter
values. We have it create a file which name contains the value of the workflow parameters.
 

 

Restriction:  Unfortunately, in the workflow editor, you can not use the tool Workflow
Parameter Values to help analyse what is happening in below examples. This tool uses another
algorithm that does not show the result of this option to merge parameters.

.

.

.

.

.

.

.

Example 1a - Non-overlapping Parameters - Merge NO
 

 

• For sake of simplicity, the workflow was started with 1 input file. The result would be the
same with multiple input files (and then at least the Data Collector would indeed 'group' at
least these 2).

• After splitting into routes, the top workflow control sets the value for the workflow
parameter print to flexo . The bottom one sets a value for the 2 other parameters,
flavor and copies. The parameters do not overlap once they arrive at the Data Collector.
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• The Data Collector groups and is not asked to merge the incoming workflow parameters,
which in this case would be easy as they do not overlap. So which ones will he keep then,
in the group output token, those that came from the top route or those from the bottom
route?

• The name of the output file shows us that the workflow did 'receive' the value flexo for the
parameter printfrom the top route, but that it's not aware of the changes done to other 2
workflow parameters in the bottom route. It didn't even check them after it already received
a value from, in this case, the top route.

• The result actually could have been be the reverse as well: that the parameters from the
bottom route were used, and not those from the top one.

• Conclusion: A simple re-run of this workflow could have a different result. Any other activity
in the workflow engine could slow down any workflow step or route and so change the
sequence in which they arrive at the Data Collector. The result is unpredictable.

.

.

.

.

.

.

.

Example 1b - Non-overlapping Parameters - Merge YES
 

 

• Same workflow, same input file(s). The only difference is that we ask the Data Collector to
also merge the workflow parameters.

• At the end of the workflow, the name of the output file now shows that all 3 workflow
parameters were successfully merged into the output token.

• Conclusion: This may look good but we were lucky: It is not always realistic to keep the
parameters unique over their route, and, most important, this workflow was very simple. A
real workflow would have become noticeably slower.

Example 2a - Overlapping Parameter Values - Merge NO
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• In this case, both routes set a value for the parameter flavor.
• The Data Collector is not asked to merge parameters. It can take either one of the values. It

picks one route to check back on and as soon as it finds a value, that one will be taken.
• This time, we see that the value cocos was chosen to be forwarded with the output token.
• Relaunching this workflow in realistic circumstances can as well result in the value banana.
• Conclusion: It can not be predicted which value will be taken.

.

.

Example 2b - Overlapping Parameter Values - Merge YES
 

 

• Also in this case, both routes set a value for the parameter flavor.
• Now, the Data Collector is asked to merge parameters. It therefore will check back in the

workflow and assemble all the values for all workflow parameters.
• Both routes were investigated and all parameters from both routes were merged.
• In the result, notice how now the parameter copies got a value as well (from the bottom

route). And that the values for the other 2 parameters came from the top route.
• Relaunching this workflow on a busy server can have a different result.
• Conclusion: A request to merge means that the Data Collector needs to do a lot more

investigation but still it can not be predicted which value will be taken.

Resulting Advice
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The process of merging workflow parameters can be problematic to the workflow engine
and its result can not even be predicted.

Therefore,

• we advise to build your workflows in a way that you do NOT need to ask to merge workflow
parameters. As mentioned, this also benefits the processing of the workflow engine in
general.

• we advise that, if in some simple workflow you do need this option, that you thoroughly test
it. Be aware that the results are unpredictable and that it increases the processing load of
the workflow engine.

11.4.11.  Data Splitter

Use the Data Splitter if you want the next step in the workflow to process each file
individually.

Attention:  Only use this task when necessary ; when the default behavior of the
workflow is not what you want. This kind of splitting can create a very large amount of
extra 'tokens' and that significantly increases the complexity and load of the workflow
engine.

Important:  We advise to first learn about how a workflow can process files in groups in the
page Understanding Tokens (Grouping of Output Files) on page 746.

Example
In this example, the Data Splitter (with the default setting One by one) sends the unzipped files
to the Checkpoint task one by one. This way, 5 To Do Actions are created. The user needs to
decide for each file if it needs manual or background trapping:
 

 

Without the Data Splitter in this workflow, there would only be one To Do Action. The Action
item would provide a link to the 5 files, but they would need to share the same decision.

Split and Create a (new) Group

You can also use the Data Splitter to split the collected files and group them according to a
criterion you define.
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You can group the output by using a Regular Expression or a SmartName.

The dropdown list by default offers 2 regular expressions:

• (.*) matches the entire file name without the extension

• .*_pag([0-9]+).*? matches the number directly after _pag in the file name (use this for
example for files named page_1.pdf, pagina_2.pdf, etc.).

Only the file name will be matched, without the extension. Learn more about regular
expressions in Using Regular Expressions on page 656.

Example: Grouping the RIP output to Prepare for Viewing

The Automation Engine Viewer enables viewing of RIP'ed data when they were prepared for
viewing together, as a group. When you have a folder containing RIP output of several jobs,
it is important that you send the right groups of separations to the Prepare for Viewing task.
You can use the Data Splitter and group the separations by using a SmartName:
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Note:  You can use the same principle in a workflow where you use the Create Wrapper file
task.

11.4.12.  Fork and Join

Note:  We advise to first learn about file grouping in Understanding Tokens (Grouping of Output
Files) on page 746.

The Fork workflow control automatically tags every input file with a same token as all the files
that the workflow generates from those initial files in the next steps, this until you Join them
again. This creates a Group Tag: These related files all get a same token.

The Join workflow control then groups all the files with the same tag.

Example of Group Tagging
Our example workflow creates a ZIP containing the one-up PDF and its report PDF. This is easy
to set up when the workflow starts with only one file. This is different when your workflow
starts with multiple files:

 

 
In above example,

• we have 2 input files that will travel through this workflow together. This example starts
with an 'Optimize and Clean' step, just as an example of a task that outputs more than one
file.

• the Fork step then starts tagging each input file and each file created from that file with a
same token. In this example this is the input file and its report file that is created in the next
step.

• the Join step creates 2 groups based on those tokens:

• one group is the lemon.pdf and the lemon_report.pdf

• another group is the banana.pdf and the banana_report.pdf

• these groups then become the inputs for the Zip task. You now have a Zip file per group: 2
Zip files.

Without the Fork and Join steps, you get 4 ZIP files: one for every file. If you use a Data
Collector to group all of them, you get 1 ZIP of all 4 files.

With these Fork and Join steps, you can get the ZIP files of the 2 'related / grouped' files.
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Note:  This Fork and Join combination so enables special cases that you can not solve by
using the more general Data Collector or Data Splitter.

11.5.  Using Public Parameters in Workflows

Note:  Public Parameters are not only available for Workflows but also for single Task Tickets.
This is documented in Using Public Parameters  on page 92. We here only add the specifics
about using public parameters in workflows.

11.5.1.  Concept

Most Task Tickets offer many settings ('parameters'). And Workflows can be quite complex
combinations of many such Tickets. That is why, when an administrator creates a workflow, it
can be useful to not show this whole complexity to every day users of those workflows.

This can be done by making only some parameters public. Thus, the daily user can only see
and modify a limited set of parameters that he understands and is allowed to change.

For example:

A user wants to launch a workflow and needs to check or change only a few settings. Instead of
having him open the workflow and open several steps to change only 5 parameters, you offer
him this simple dialog, where he is asked to define the 5 parameters that you made public to
him:
 

 
When the user presses OK, the workflow starts and uses the chosen settings.

Available from many Client Applications

This functionality is available for users launching workflows from these applications that have a
connection with the Automation Engine server:

• Automation Engine Shuttle
• Automation Engine Pilot
• ArtPro, Neo
• PackEdge, Plato, FastImpose
• DeskPack (Adobe Illustrator)
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Important:

• Client applications only show Public tickets and workflows, no matter what user is logged
in. In other words, they only show the same list of tickets that a user sees who does not
have the User Access Right "Tickets: Show all Tickets and their Parameters (Public and
other)".

• If those public tickets and workflows do not have any public parameters, the user will not be
able to open them to change any parameters. They will be launched right after he selected
the (workflow) ticket.

Preference to have the Pilot show Only Public Parameters

In the Pilot, in Edit > Preferences the option Show only Public Parameters in Tickets can
help you prevent users from opening workflows in the workflow editor and so having access to
all settings.
 

 

• When this option is not checked, users will be able to open workflow tickets and see all
steps and settings. If they can make changes and save the ticket depends on their User
Access Rights.

• When this option is checked, a users that opens a workflow ticket will only be shown a
dialog with the public parameters of that workflow. When that workflow has no public
parameters, the user will see this dialog:
 

 

About Public Parameters in a Workflow Ticket that is Not Public

It is possible to set public parameters in a workflow ticket that is not saved as public. This can
be useful when the non public workflow ticket is referenced inside a master workflow that is
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public. The public parameters of the referenced subworkflow will show up in the list of public
parameters of the master workflow.

11.5.2.  Creating Public Parameters in a Workflow

Creating public parameters in a workflow is very similar to creating them for a single task
ticket, as explained in Making a Parameter Public on page 93.

A summary:

1. In the workflow editor, select a step and open the ticket.
2. Right-click the parameter you want to make public and choose Make Parameter Public.

We here right-clicked in the field for Trapping Distance:
 

 

Note:  Not all parameters of all tickets can be made public.

3. Right-click the same parameter again and choose Modify Public Parameter.... Decide here
if you want the parameter to be a free or predefined value.

Note:  You can also skip this step and later manage this and all other public parameters in
the Manage Public Parameters dialog. You can also use both dialogs.

4. Save your ticket to also save these changes to your public parameters.

Note:  Public parameters belonging to steps that you later deleted from the workflow are
not removed. You can remove them using the Manage Public Parameters dialog.
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Next step is to manage the workflow parameters in a special dialog where you will define more
precisely how they will present themselves to the user.

11.5.3.  Conditional Availability of Public Parameters

Concept
Some parameters depend on others. An extra tool offers to disable or even hide parameters
depending on the state of others.

Below examples illustrate the functionality.

At the end of this page, we mention some limitations.

Example 1: Conditional Availability of one Parameter

This example shows the basic principle: When the parameter 'Add Overlaps' is not enabled, the
parameter 'Overlap Distance' becomes irrelevant. However, he user still sees this option and
can even fill it in.
 

 
We will use the blue circle button  to make this dialog more user friendly.

• Click the  of the parameter 'Overlap Distance'.

• The dialog Conditional Availability allows to Show / hide this parameter, or to just Enable
/ disable it.

• To only disable it, deselect the option Show when the following criteria are met, select
the Enable option and set the criteria when this parameter should be enabled. In our
example, this is when the user selected the parameter 'Add overlaps'.
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• In the list of criteria, the dialog automatically already lists the other parameters in that

group of public parameters that can be used as a condition.

Note:  Not all types of public parameters can be used to build a condition on. Learn more at
the end of this page.

• Click OK. Notice how the blue circle button  now changed to , indicating that a condition
has been set for this parameter.
 

 
Also, when you select that parameter, the other parameter(s) that were used as criteria for
the condition will be highlighted in light blue:
 

 

Note:  When you remove a parameter that was used to set a condition, then those
conditions will also be removed from those parameters: the blue circle button of the
inflicted parameters will change back from  to .

• Now click Preview. See how when no overlaps are asked for, the distance parameter is
disabled (greyed out):
 

 
• If you prefer to not just disable an option that became redundant, but even hide it, then set

one or more criteria for the Show option:
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The preview will then show you this:
 

 

Example 2: Conditional Availability of Multiple Parameters
• You can also set a same condition for multiple parameters.

• Select multiple parameters, right-click any of them and choose Conditional Availability.
 

 

• The dialog shows message you that what you now apply will be valid for all the selected
parameters.
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• Similar to the settings we showed above, using the Show or the Enable option, you can
now get these example results:
 

 

Example 3: Conditional Availability of a Group of Parameters
• This time we organized 4 parameters in 2 groups and gave these groups a good name:

 

 

• This results in this preview:
 

789



11 Automation Engine

 
• Because the overlap options only make sense when overlaps are requested, we can now set

this condition on group level, instead of setting the same condition for each of those option
parameters.

We now click the  of the group 'Overlap options'.
• We choose to only show that group when 'Add overlaps' is selected:

 

 
• See the result in both cases:

 

 

Example 4: Combination
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• Building on the above example, we add an extra condition within that group:
 

 

• When the group 'Overlap options' is shown, now see the result with either value of the
parameter 'Overlap on both sides':
 

 

Limitations

These are parameters that require a fixed value, for example yes-no, top-right-bottom-left, etc.)
or whose value is another kind of clear unmistakable value, for example (a part of) a text or
number, etc.

Some parameters however result in values that cannot be used to base a condition on, for
example a numeric field where the value is also defined by its unit or a table, or for example a
table of names of layers to be removed. Such parameters cannot be used in a condition ; they
will automatically not present them themselves in this dialog.
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Note:  You can use a parameter based on a table when you created predefined settings. for
that table. This way, you can base a condition on whether 'Table 1' was selected or 'Table 2',
etc.

11.5.4.  Managing Public Parameters in a Workflow

Once you have made parameters public in your workflow steps, you can open the Manage
Public Parameters dialog to get an overview and make changes.

1. In the workflow editor, go to Advanced > Manage Public Parameters...

The dialog shows all public parameters of this workflow, sorted by workflow step:

 

 

• The left pane shows the workflow steps for which you have made parameters public.

• The middle pane shows the public parameters of the workflow step that was selected
on the left. They are greyed out when they are already used in the right pane. When
parameters are not used in the right pane, they will not be public parameters.

• The right pane shows all the public parameters in detail (name, type of value, etc.). They
are default organized in Groups matching the (custom) name of the step where they
came from. This is where you build the dialog that the users will see and use to decide
the values before launching the workflow.

• The Preview button shows how the end-user will see the panel you are building here.

To help you trace their origin, selecting items in the panels also shows selections of related
items in the other panels.
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2. You can

• drag parameters from the middle to the right pane to make them public. For example
dragging the parameter Trapping Distance into the group "background trapping".

• click on  to remove the parameter or group from the right pane. It will then not be
public anymore.

• re-arrange the order of your public parameters or groups (drag them up or down).
• click on  to change the default name of the group.

 

 
• change the settings of the public parameters. Define in 'Prompt as' is what the user

will see. Instead of Allowing the user to set a value, you can offer the user a choice of
predefined values.

In below example the user will get a drop-down list to choose between Flexo normal
and Flexo large. The user making this choice when launching the workflow will not see
the actual values of 0,2 and 0,3 mm.
 

 

Use the buttons Move Up / Down to define the order of the Predefined Settings in the
drop-down list that the end-user will see.
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Learn more about editing and re-designing this pane in Making Presets to Simplify the Users’
Choices on page 96 and Example of Further Customizing the Public Parameters Dialog  on page
796.

11.5.5.  Making Presets to Simplify the Users’ Choices

Presets are customized combinations of parameters. They limit the amount of decisions that
users have to make.

Example

Let's assume you want users to use different trapping settings when printing offset versus
dry offset. You can collect those trapping settings in a Preset, so that users will only have to
choose between 'offset' and 'dry offset'.

We start from a dialog of a workflow ticket where the trapping step has 3 public parameters:
 

 

1. Click  to remove the (default) Group named "Trap with PowerTrapper"
2. Click Add Group.

A new "Untitled Group" is created. Click  to change its name.
3. Click Add Preset.

A new "Preset" is created. Click  to change its name.
By default, two example values will appear. The preset was renamed to 'Choosing
Process to Decide Traps':
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4. Define what the users will see:

a) in Prompt as, enter the text that users will see (replacing 'Type the name of the
preset here (e.g. “Paper Size”)')

b) enter the values that the users will choose from (replacing 'Type a value here (e.g.
A4)'). In our example, we add 'Offset' and 'Dry Offset'.

Click Add if you want to add extra values (not the case in our example).

5. Drag the parameters from the dialog’s middle pane onto one preset item. This will make
them automatically appear under each preset item (here both under Offset and Dry
Offset).
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6. Define the parameters values for each preset item.

See the above screen shot for a good example.
7. Use the buttons Move Up / Down to define the order of the Presets in the panel that the

end-user will see.
8. Click OK to confirm and close the dialog.
9. Save your ticket to also save these public parameters.

This is how the resulting dialog will look like to the users of the client applications:
 

 

11.5.6.  Example of Further Customizing the Public Parameters Dialog

In this example, we further customize the public parameters dialog by reorganizing the Groups
and adding a Preset to combine parameters.

Step 1 - Example Workflow and its Initial Public Parameters Dialog
This is our example workflow:
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We created public parameters in 4 steps. This is the initial Manage Public Parameters dialog,
where the groups match the workflow steps:
 

 

If you don't customize this, the resulting dialog, that will be shown to the users launching a
task, will look like this:
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In this dialog, you can see

• that the items on the left pane of this dialog match the groups in the Manage Public
Parameters dialog.

• that when there are multiple groups, an extra one named 'All' is automatically created.
This group offers all parameters together.

• that the parameter 'Trap size' is offered as a choice of presets. This was illustrated earlier.

In the next steps we will further optimize this dialog for the end user.

Step 2 - Customizing the Groups and the Text that the User will See
• In the group "check file",

• rename the group to "Who to Check",
• change Prompt as to 'User to Check the File in Editor',
• set the Default Predefined Setting to 'Any User'.

 

 
• Press Add Group  to created a new group and name it "E-mail to Customer" .

• In the right pane, drag the parameters from the groups "Export to PDF File" and
"Send E-mail" into this new group.

Tip:  You can press Shift to select and drag multiple parameters.

• Remove these two groups that are now empty: "Export to PDF File" and "Send E-
mail". This is the result:
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Note:  An alternative way to do this, is to first delete the 2 groups, then create the new
one and then drag the 5 parameters from the middle pane into the new group.

Step 3 - Adding a Preset and Combining Parameters
In the new Group "E-mail to Customer", we now combine 2 parameters into a new Preset:

• Press Add Preset. A new preset appears at the bottom of the bottom group. Rename it to
'PDF pixel version'.

• Set the Prompt As to 'Convert to Image'
• Press Add to add a third parameter and rename the 3 parameters to 'No', 'Yes (304

ppi)' and 'Yes (120 ppi)'.
• Drag the parameters 'Output as Image' and 'Rasterization Resolution' onto the

first value of this new preset.
• Adapt the parameter values as shown in this screen shot:
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For the user launching the workflow, the resulting dialog already looks a bit simpler:
 

 

In this example, the list of parameters is not that long. That is why you could also decide to only
offer the All view in this dialog. You can do this easily by moving all parameters into one group.
The result can look like this:
 

 

Note:  Many tasks have Tickets with a conditional user interface: where settings depend on
another setting. For example settings that only become available after you first make another
choice. Example: 'Apply color conversion?'. If 'Yes', then there is the choice 'Convert
to CMYK' or 'Convert to RGB'.

These kind of conditions can not be created in the Manage Public Parameters dialog. If you
wish to recreate such a user decision, you have to create a preset that offers a choice for each
combination. In our example this would mean a drop-down list with these 3 choices: 'No
color conversion', 'Convert to CMYK' and 'Convert to RGB'.

11.5.7.  Launching a Workflow with Public Parameters

Launching a workflow with public parameters is very similar to how it is done with single task
tickets.

Learn more about all variants of launching workflows from Shuttle client applications in Using
Shuttle to Upload and Process Files on page 101.

800



11Automation Engine

Here are some examples:

Example when launching from Shuttle:

Drop the input file on the workflow in the Launch panel.
 

 
If you drop a file on the launch field of a workflow that has public parameters, a dialog will
open asking you to decide these public parameters:
 

 
Click Launch when ready.

Example when launching from PackEdge:

Choose File >  Launch Workflow from the menu, select the workflow, decide the public
parameters and press Launch.
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Example when launching from ArtPro

In the Launch Workflow dialog, ArtPro offers extra functionality to convert the ArtPro file
before it enters the workflow and to set a Job or Product context (which is important when
using SmartNames).
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11.6.  Using Workflow Parameters

11.6.1.  Concept

Workflow Parameters are parameters that are specific for a workflow. Their values are picked
up by steps in the workflow.

For example: You print displays and you mostly use the same output workflow. Your workflow
ticket has 3 workflow parameters: substrate, sheet size and quantity. The values of
these parameters can be typed in by a user or can be picked up from an external source.

Workflow parameters show up as SmartNames starting with [wfp. ]. Much like Job and
Product parameters, you can use them by inserting them in the SmartName enabled field in
your workflow steps.

In many cases, you could accomplish the same by using Job or Product parameters, but some
Automation Engine customers choose to not use the Jobs or Products concept.

Workflow Parameters are Loaded at Workflow Start-Up, but can Change
Later
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Workflow parameters and their values are loaded when the workflow starts up. However they
can change during the workflow. This can happen via a user intervention or more automated
steps. Learn more in reading their value from an XML file and in modifying workflow parameters
during a workflow.

Managing Workflow Parameters
In the workflow editor, go to Advanced / Tools > Manage Workflow Parameters....
 

 

• The Manage Workflow Parameters dialog is where you Add, Remove and Edit workflow
parameters.

• This dialog lists all the workflow parameters defined in the current workflow and all of its
subworkflows.

Note:  If you are in a subworkflow, the workflow parameters defined in the master workflow
will not be shown in this dialog.

• You can keep this dialog open while making changes in the current or subworkflow(s) and
while navigating to and from subworkflows. The list of workflow parameters is instantly
updated to reflect changes.

Workflow Parameters can be Different per Group of Files

Workflow parameters do not have to be valid for all files in that workflow ; they can be different
per file or per group of files.

For example: The banana and lemon displays share the same substrate and sheet size,
but have a different value for the parameter quantity.

Workflow parameters are valid for one file or for a group of files. You can see such grouping
of files when you open a Widget and select an item in its list. This will not only highlight the
selected item (in blue) but also the other items belonging to that group (in light blue).

Note:  Such a group is decided by the workflow system. It attributes "tokens" to each output
file (an internal ID number). Files with a same "token" will in that part of the workflow seem to
be grouped. Learn more about this concept in Understanding Tokens (Grouping of Output Files)
on page 746.

For example: When you select lemon.pdf, lemon_report.pdf also gets highlighted. This
means that they belong together in a group. This means that they share the same workflow
parameters (at that point in the workflow).
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As mentioned above, these groups are created automatically by the file management logic in
the workflow steps. However, sometimes a setting lets you decide how these groups need to
be created. A typical example is the Data Collector on page 773.

When you right-click on an item in a widget and select Workflow Parameter Values, you will
see the values for that group of files at that point in the workflow. An example:
 

 

Workflow Parameters versus Public Parameters

Public Parameters serve to simplify the decisions users have to make when they launch
workflows from client applications. Workflow Parameters serve to make your workflow more
automated.

Workflow parameters are also SmartNames, public parameters are not.

In the Manage Public parameters dialog that is shown to the user launching the workflow,
workflow parameters show up as a separate parameter group named Workflow Parameters:
 

 

You can easily remove workflow parameters from the list of public parameters using the
Manage Public Parameters dialog. Learn more about public parameters in Using Public
Parameters in Workflows on page 783.

Note:  There is an exception: If you use workflow parameters values from an XML file, the
workflow parameters will not be public.
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11.6.2.  Most Typical Use Cases for Using Workflow Parameters

1. Automating workflows by Loading Workflow Parameters from an XML file

This is the case where the order management or production planning system sends
Automation Engine an XML with the details of the output workflow. These production specifics
are automatically picked up and serve as parameters for the workflow. Learn more in Using
Workflow Parameter Values from XML  on page 810.

2. Using Workflow Parameters as a Smart Public Parameter

When users enter the value of workflow parameters manually, it usually resembles the case
of a using public parameters, but then also taking advantage of the referencing power of a
SmartName.

For example:

Your users need to decide if the workflow is flexo or digital. You want them to answer this
one question as a public parameter:
 

 
This is only 1 question but we will use the answer for 3 different decisions in our workflow,
once in each of below workflow steps:
 

 

Here is an example how this can be done. We also illustrate two different levels of complexity:

• You use the value of the workflow parameter as text. For example the Preflight task,
depending on the user's answer, uses the profile flexo.ppp or digital.ppp . In this case
you pick up the workflow parameter as a SmartName:
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In the same way, the ReportMaker task uses flexo.pdf  or digital.pdf as template.
One decision from the user so already decided values in 2 tickets.

• You can also use value of the workflow parameter inside another SmartName. For
example this conditional SmartName to define the trapping distance:
 

 

You then use that conditional SmartName in the trapping task:
 

 

In this example, when you do not use a workflow parameter, the user launching the task would
have to decide 3 different public parameters. Now, the user is only asked 1 decision.

11.6.3.  Creating Workflow Parameters Manually

Follow these steps to create workflow parameters manually:

1. Open the (sub)workflow in the workflow editor.
2. Open Advanced / Tools  > Manage Workflow Parameters....
3. In the Manage Workflow Parameters, click on Add and fill in the Name and Value.
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Note:  You can leave the value empty at this time. The value has to be defined at the latest
by the time the workflow is launched (for example when a user who launches the workflow
fills in the value in the dialog of public parameters).

In the dialog, the column Workflow shows if the workflow parameter is present in the
current workflow or was created in a subworkflow.
 

 

Note:  If you need to add many workflow parameters and if their names are already
present in an XML file, you can load that list of names by using the button Load Workflow
Parameters from XML.... Learn more here.

4. Save your workflow to also save your workflow parameters.

11.6.4.  Loading Workflow Parameters from XML

Instead of typing them in manually, you can load Workflow Parameters from a XML file.
You can select all parameters from the XML file or only those of a specific XML Element. After
loading them, you can keep the values that came from the XML file or change them.

This is an example of a valid XML file:
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Follow these steps to load only the items of the XML Element 'production' :

1. Open the (sub)workflow in the workflow editor.
2. Open Advanced / Tools  > Manage Workflow Parameters....
3. Click Load Workflow Parameters from XML....
4. Browse to the XML file, select it and click Open.

A dialog pops up asking you to specify an XML Element or to leave the field blank to select
all items in the Root Element of the XML file.

5. In that dialog, type in the element name production and click OK to confirm.
This will load these workflow parameters:
 

 
6. If you want you can make any modifications like changing a value or even removing a

parameter.
In our example, we don't need the parameter 'finishing' so we can remove it.

7. Save your workflow to also save your workflow parameters.

11.6.5.  Using Workflow Parameters

Once you have created them, you use the workflow parameters by picking up their SmartName
version in the workflow step ticket.

1. Open the (sub)workflow in the workflow editor.
2. Double-click the ticket in which you want to use a workflow parameter.
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3. Click on  in the SmartName-enabled field where you want to add the workflow parameter.
In the SmartNames Browser, select the Category 'Workflow Parameters'
 

 
4. Select the workflow parameter [wfp. ] that you want and click Insert (or double-click) to

add it to the ticket.
5. Click OK to confirm and close the ticket.
6. Save your workflow.

11.6.6.  Using Workflow Parameter Values from XML

Workflow parameters and their values can be defined by an XML file.
 

 
This is an example of a valid XML file:
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In this concept, there are 2 differences versus creating workflow parameters manually or loading
them once from an XML:

• the workflow will load and re-read this XML file at every step of the workflow. This also
means

• that you will probably not use the step Modify Workflow Parameter Values in this workflow
because its modifications would be overruled.

• that, during the workflow, the XML file can be updated with new or changed values.

• the resulting workflow parameters will not be public parameters. The concept here is that it
is not a user who decides the values, but an XML file.

Note:  A subworkflow gets the workflow parameters from its parent workflow that loads an
XML, unless it loads values from an XML file itself.

Example

Follow these steps to set up a workflow where workflow parameters values are used from an
XML file:

Attention:  Before we can ask a workflow to use the XML file, we first have to insert
the workflow parameters as [wfp. ] SmartNames into the workflow step tickets. To
be able to do that, we will first load a sample of that XML and so create these required
SmartNames first.

1. Open the (sub)workflow in the workflow editor.
2. Open Advanced / Tools  > Manage Workflow Parameters....
3. Click Load Workflow Parameters from XML.... Browse to your sample XML file, select it

and click Open.
A dialog pops up asking you to specify an XML Element or to leave the field blank to select
all items in the Root Element of the XML file.

4. Using the example XML mentioned in Loading Workflow Parameters from XML, type in the
element production in that dialog and click OK to confirm.
This will load these workflow parameters and create a [wfp. ] SmartName of each of
them:
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5. From that list, remove any parameters that you will not be using.

Note:

• The Values in this list will not be used anyway, they will come from the XML file (see step
7).

• The Names in this list are the basis for the [wfp. ] SmartNames. So do not delete
them if you need the SmartName version.

6. Use the resulting SmartNames in your workflow step tickets (as shown in Using Workflow
Parameters on page 809).
An example:
 

 
7. In the Manage Workflow Parameters dialog, check Use values from XML file. You will be

asked to confirm this step. Click OK.
8. Select the XML file using Browse or use SmartNames. This is the place and name that the

workflow will look for at the start of every step of the workflow.
9. Save your workflow to also save this setup of your workflow parameters.

11.6.7.  Changing the Value of a Workflow Parameter

You can easily change the value of a workflow parameter by using the Edit or  (Mac) button
in the Manage Workflow Parameters dialog.
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When would you change the value of a workflow parameter?

When you are testing a workflow while staying in the workflow editor. You edit the parameter

value, relaunch the workflow (  ) and monitor the result.

Tip:  When using values from an XML file, some administrators use this "edit and test" method to
learn how the XML file should look like.

Changing the value of a workflow parameter from a referenced subworkflow

If you edit the value of a workflow parameter that is defined in a referenced workflow, its value
will be overruled with the new value without changing that value in the referenced workflow.
In the Manage Workflow Parameters dialog, a pencil icon  will appear next to the workflow
parameter that was overruled.

For example, our workflow named Check Trap Proof Flatbed has a referenced
subworkflow named SUBWFL Approval in which a workflow parameter ApprovalType has
the value WebCenter:
 

 

When you now edit this value, for example into hard copy proof, this icon  will appear
next to the value to indicate that this parameter was overruled:
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11.6.8.  Modifying Workflow Parameters During a Workflow

The Value of a workflow parameter can be modified while the workflow is running. This can be
done because

• the value changed or was empty before and has now 'arrived'. This change can be decided
by a user or by an XML file from an external system.

• the new value did not exist yet because it is based on an result of a previous workflow step.

These workflow steps can modify workflow parameters:

• The workflow control Modify Workflow Parameter Values. Learn more in Modify Workflow
Parameter Values on page 753.

• The Integrate with WebCenter task.
• The Create or Modify WebCenter Project task.
• The Publish on WebCenter task.

These WebCenter related tasks are then part of workflows that use the result of their
interaction with WebCenter as a workflow parameter value in one of the next steps of that
workflow.

Using the Integrate with WebCenter task
Some Actions in the Integrate with WebCenter task allow you to use the output of the Action
to modify the value of a workflow parameter.

To do this, you need to Map one of the task's Output Parameters to a workflow parameter.

For example, a workflow asks WebCenter what the approval status is of a document and then
uses that status information in the next part of the workflow:

1. In the workflow editor, in the Integrate with WebCenter ticket, select an Action. For
example 'Get Document History'.

2. Click on the Tools icon  and choose Map Output Parameters.... A dialog will open.
3. Double-click an Output Parameter. For example Document approval status.
4. Define to which workflow parameter this Output Parameter needs to be mapped to. Select

it from the drop-down list or from the SmartNames Browser or type in a (new) name. If the
workflow parameter does not exist yet, you will be asked to confirm its creation.

 

 

Learn more about the Integrate with WebCenter task here.
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Using the Create or Modify WebCenter Project Task
The Create or Modify WebCenter Project task allows you to modify the value of a workflow
parameter with the value of the Project ID of that WebCenter Project.

To map the Project ID to a workflow parameter, use the same Map Output Parameters
dialog as explained above (point 2).

For example, you did not create the WebCenter project but you want to know the ID of this
project because you will publish data to that project later in your workflow.

Learn more about the Create or Modify WebCenter Project task here.

Using the Publish on WebCenter Task
The Publish on WebCenter task allows you to modify the value of a specific workflow
parameter with the value of the Document Version ID of the published document in
WebCenter.

To map the Document Version ID to a specific workflow parameter, use the Map Output
Parameters dialog, as explained as explained above (point 2).

For example:

You use WebCenter in your approval workflow. You have already published your production
PDF twice to WebCenter and the customer still wants changes. You make more changes and as
usual overwrite the PDF before publishing again to WebCenter.

Now the customer checks this 3rd version and changes his mind: he says that he liked version
2 better. This is a problem because nobody has version 2 any more. Remember that the
document versions that WebCenter keeps are versions of only the View Data.

This can be solved when, after publishing your PDF, you ask WebCenter the document version
ID and then make a copy of your production file and add that version number in its name. In
this way, you also keep versions of your production PDFs.

Learn more about the Publish on WebCenter task here.

11.7.  Automated Launching of Workflows

These tools allow to launch workflows automatically:

• Access Points launch a workflow after they detected a signal from 'outside'. There are 5
types of Access Points. The Folder Access Point is the most classic example and is also often
referred to as a 'hot folder'. Access Points have their own View in the Pilot.

Learn more in Access Points on page 1561.

• WebCenter can also launch workflows on Automation Engine (when they are in the same
LAN). WebCenter can do this as a specific step in its own workflow, there called 'Submit
Workflow'.

Learn more in the WebCenter documentation. Here is a direct link to this specific topic (in
v14.0).
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• Some external systems can launch a workflow on Automation Engine via JDF or JMF
commands. Although most of this functionality is also available through use of XML, some
MIS vendors prefer to use JDF/JMF because of specific additional features.

Learn more in What about JDF? on page 1555.

11.8.  Migrating Old Task Chains

Old Workflow Technology
The Esko product BackStage, a predecessor of Automation Engine, had a limited workflow
technology where workflows were only linear and were named Task Chains.

For example:
 

 

If you still have such task chains, they will still work but Esko strongly advises to migrate them
to Automation Engine Workflows. See below how to do this.

Note:  Depending on your version and configuration, it is still possible that your Automation
Engine offers some task chains by default. Page printing workflows still offer Export to PDF
File Chain (Mark as Proof) and Publish Imposition on WebCenter Chain as chains of
multiple steps. Also, a 'FlexRip plus InkPlanner Chain' ticket is still available (until you can add it
to a workflow with an Imaging Engine step).

Migrating old Task Chains to new Workflows

You can not automatically convert task chain tickets into workflow tickets, but the workflow
editor offers a tool that helps you migrating a task chain to a workflow that will keep all your
settings.

Follow these steps to migrate a task chain to a workflow:

1. In the Pilot, click on  New Workflow.
2. In the workflow editor, in the Tasks pane, select your task chain ticket.
3. Drag and drop your task chain ticket into the top part of the workflow editor window. A grey

area will appear, showing you a message where to drop the ticket.
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4. This starts a conversion tool that extracts all compatible steps:

 

 

• Each extracted step keeps all of its ticket settings.
• The step is named after the name of the task chain.
• The steps are not connected. You are invited to optimize your workflow construction.

There may be better ways to build your workflow in the current version.

Note:  When the chain contains 'outdated' steps (FKA 'obsolete), a warning appears:
 

 
When you click OK, the chain is migrated but the outdated step will disappear after a few
seconds. This means that you should replace that step with a corresponding step that is

available in your current version. For example you should replace the old Mark File  by

Mark .

5. Based on these extracted steps, build your new workflow.

In below example we removed the old Export to PDF step because this functionality is now
available on board the ReportMaker ticket:
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6. Save your new workflow.
7. Test it and, when ready, delete the old task chain from your list of Tickets.
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12.  Working with Shuttle

12.1.  What is Shuttle?

The Automation Engine Shuttle is a client tool for easy submission of files to Automation
Engine workflows. Shuttle also allows monitoring of the workflows.

The Shuttle functionality is also integrated in ArtPro, Neo, PackEdge, Plato, FastImpose and in
Adobe Illustrator as a DeskPack plug-in. This enables to launch tasks from inside these editors.
This setup is described in this documentation.

12.2.  Installing Shuttle

The Shuttle is one of the client tools that you can download with the Automation Engine
Server Web Page.

Open this Server Web Page by entering http://<name of your master server>  or
http://<name of your master server>:9999 in the address field of your browser. You
can find this tool in the section Client Apps, in the page Main.

If the Shuttle application is already installed on your computer, the system will check if you
have the appropriate version and download updates if necessary.

12.3.  Shuttle Setup

12.3.1.  Configuring Shuttle in Automation Engine

1. In the Pilot, go to Tools > Configure.
2. Select Shuttle in the left pane.
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3. Enter the Port to use for communication between your Automation Engine server and the

Shuttle clients.

Note:  By default this is port 5182, but if this port is already used by other processes, you
should enter the next available port.

4. Click on  and select an Upload Folder.

This is where Shuttle clients will upload files that are not located in a Container (except the
Shuttle plug-in, that will always upload files to the DeskPackContainer).

Note:  The Upload Folder must be located in a Container.

5. Select 'Start Shuttle server automatically when Automation Engine is started' if you
plan to make frequent use of the Shuttle technology.

6. Select 'Use the task history to re-launch using the same public parameters' if you want
Shuttle to propose to use the same public parameters when you launch a same file on the
same workflow. The Shuttle then checks prior tasks both in the Tasks Monitor and in the
Task History tool.

7. Click the Start button to start Shuttle server.

The Shuttle server now makes Automation Engine’s workflows, tasks and files accessible to
the Shuttle clients.

8. Save your settings.

Note:  If you need to make changes to this Setup, you must Stop the Shuttle server first.

12.3.2.  Making Tickets Public

Only Public tickets (of single tasks or workflows) can be launched from Shuttle (or from the
client applications using Shuttle).

Learn about making (workflow) tickets public here.
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Note:  Default tickets and (blue) Job tickets can not be made public.

12.3.3.  Shuttle Clients Connecting to Any Server

The Shuttle (in all its forms) can connect to one or more Automation Engine servers.

1. Launch Shuttle (standalone or the editor plug-in).
2. Open the Preferences.

In... go to...

Adobe Illustrator • (Mac)Illustrator > Preferences > Esko > Shuttle Preferences...

• (Windows) Edit > Preferences > Esko > Shuttle Preferences...

ArtPro ArtPro > Preferences... or use Command + K

PackEdge/Plato (Windows) Edit > Preferences >  Server&Resources

Neo Neo > Preferences... or use Command + , (comma)

FastImpose
Standalone

Tools > Shuttle Preferences...

3.
In the Servers tab (Advanced tab for Neo), click  at the bottom of the Servers list.
 

 
This dialog opens:
 

 
4. Enter your User Name and Password.
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• When connecting to an Automation Engine server, enter the User Name and Password
you use to log in to the Pilot (the password can be blank if your server is configured to
accept this).

You will have the same access rights in Shuttle as you have in the Pilot (for example the
right to set processing priorities or not).

5. To connect to a server not broadcasting over the 'Bonjour' network (Automation Engine
servers or non-Bonjour-enabled Nexus servers):
a) Select Manual in the Browse Method list
b) Enter your server’s name or IP address in Server Address
c) Fill in the Server Port used by your server.

Note:

When connecting to an Automation Engine server, enter the port you defined in
Configure).

6. Click Add.

This adds a connection to your server in the Servers list.

•
To remove the connection to a server, select it in the Servers list and click .

• To check or edit a server’s settings, double-click it in the Servers list.

Note:

If you are using the Shuttle plug-in with other DeskPack plug-ins, and you have set up a server
connection with the Server Connection Assistant, you will see this connection in bold in the
Shuttle plug-in’s Servers list (after restarting Illustrator).

You will be able to change the user name and password if necessary, but you will not be able to
remove this connection from the Shuttle plug-in.

Learn more about the Server Connection Assistant in the Adobe Illustrator Client documentation.

12.3.4.  Shuttle Clients Connecting only to Automation Engine

The Shuttle clients in PackEdge, Plato and FastImpose Server can only connect to one
Automation Engine server.

1. Launch the application.
2. Open the Preferences.

• In PackEdge or Plato, go to Edit > Preferences or use Ctrl+Alt+Shift+P.
• In FastImpose Server, go to Tools > Options...

3. In the Server&Resources tab (the Server tab for FastImpose Server):
a) Select Connect to Automation Engine Server.
b) Enter the Automation Engine Server Name and click Check.

You should see a message saying the server is up and running.
c) Select 'Login with the following user account settings', and fill in the User Name and

Password you use to login to the Pilot.
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If the connection is successful, you will see a green dot and the message 'Connected as
user ...'
 

 

Tip:  If you are a Pilot on the same computer, or another Shuttle client (either PackEdge,
Plato or FastImpose Server), you can select 'Login automatically with user name and
password from other application connected to the server'.

This way, if you are already logged in to the Pilot or the other client application, you won't
need to log in when starting PackEdge / Plato / FastImpose Server.

4. Restart your application.

12.4.  Launching the Automation Engine Shuttle
When you launch the Shuttle application, the window shows a list of launched Tasks and a
Launch Panel where you can define one or multiple drop areas that each launch a specified
workflow:
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• To open a new window, go to File  >  New Window. You could use dedicated Shuttle
windows for each of your Workflows.

• Use the View menu to hide or show parts of this window:

• View > Tasks hides/shows the Task monitor.

• View > Launch Panel hides/shows the Launch Panel.

• View > Status Bar hides/shows the Status Bar indicating the progress.

• When closing, Shuttle saves the settings of the windows.

12.5.  Working with the Automation Engine Shuttle
Starting the Shuttle will ask you to login to the Automation Engine server.

Note:  Whether this user can also start up a Pilot is decided by a specific User Access Right.
Learn more in Access Rights on page 144.

Menu items

• File: To launch one or more files on the one defined workflow (after browsing for files), or to
open and close Shuttle windows.

• Edit: To cut, copy or paste text in the search field. To select and delete tasks. Or to define
Preferences (see below).
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• View: To show or hide the Task Monitor, the Launch panel and the Status Bar.

• Task: To open or show the output file of the selected Task, to release or cancel the Task, or
to add Annotations and show the task's Details.

• Tools: To open the To Do List.

• Window: To minimize, zoom or switch between Shuttle windows.

• Help: To see the About window or to access this online documentation.

Setting the Preferences for Shuttle

On Mac, select Preferences... in the Application menu. On Windows, go to Edit >
Preferences...

In the Preferences dialog, set the units for Dimension, Resolution, Ruling and the number of
Decimals to use.

Select 'Always show launch dialog' if you want to see the Public Parameter dialog when
starting a new task, even if there aren't any public parameters. This allows you to change these
parameters before launching the task.

 

 

12.5.1.  The Task Monitor

The Task Monitor is the part that shows the Automation Engine tasks that were launched both
from Shuttle and Pilot clients. One row represents or a single task or one step of a workflow.

You can filter the displayed list tasks:

• By filtering on a Job context from the Job selected from the drop-down list in the toolbar.

Select Other... if you want to select a Job other than the recently used ones in the list. Select
All Jobs to clear the current filter.

• By typing in a value in the filter. Learn more about creating filters in Using Filters.

Note:  In Shuttle, you cannot open or edit a task. This is only possible in a Pilot.

825



12 Automation Engine

Tip:  You cannot hide the columns displayed in the Task Monitor. However, you can change
their order and width.

Tasks asking for User Intervention

Workflows that including a Wait for Action task will show when they reached this step in
the column Phase. This allows the Shuttle user to intervene and decide how the workflow
continues.

 

 

To intervene,

• Click on the User intervention needed link.

• In the resulting To Do window, choose to Forward or Release. Learn more in User
Intervention from the Shuttle on page 829.

Context menu options

Right-click on a task to access these options:

• Open Output File: To open the task's output file with the appropriate application (if
possible).

• Show Output File in Finder / Explorer: To see the folder that contains the output file in
(Mac) Finder or (Windows) Explorer.

• Release: To release a task that is on hold.

• Cancel: To cancel a running task.

• Delete: To delete a finished task. You will be asked to confirm.

• Annotation...: To add or modify an annotation.

• Details: To see a dialog with detailed information about the task (step).

Tip:  These options are also available via the Task menu.

12.5.2.  The Shuttle Launch Panel

The Launch Panel is where you drop one or multiple files as input files for that workflow. Each
drop area launches a specific workflow and is indicated with a large arrow.
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• Click  to add an extra drop area.

Note:  To remove a drop area:

• Click . This changes the user interface in editing mode.

• Click  on the top left corner of the drop area that you want to delete.

• To leave the editing mode, click again on  or press Escape.

• Below each drop area, select the desired workflow from the drop-down list.

Attention:  Only Public tickets are listed.

Note:  The drop areas and their assigned workflow are saved when you close Shuttle.

12.5.3.  Launching a Workflow from the Automation Engine Shuttle

1. If the Launch Panel is not visible in the Shuttle window, go to View > Launch Panel.

2. Submit one or more files in one of these ways:

• Drag and drop the desired file(s) onto a drop area.
• Go to File  > Launch... and select the files.

• Use the keyboard shortcut CMD-L (Mac) or Ctrl-L (Windows) and select the file(s).
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Note:

• If a file was previously launched on the same workflow, a dialog will open and ask if you
want to reuse the public parameter values from the previous launch. If you choose to
reuse these values, they will be used as default parameter values. You can still edit these
values if necessary.

• The selected file(s) will be uploaded to the root folder of the selected Job. When no Job is
selected, it will be copied to the Upload Folder defined in the Configure panel.

• If a file with the same name is already present in the upload folder, a dialog will warn
you about overwriting the file. You can then choose to either Replace the existing file, or
Cancel the launch.

3. If the workflow has Public Parameters, the New Task dialog will ask you to fill them in.
Learn more in Using Public Parameters in Workflows on page 783.
An example:
 

 
a) Click Task Options to define general task options. You can:

• Set the Priority of the task (Low, Normal, High or Immediate).

• Select Hold to keep the task from being launched until someone releases it (via a
right-click or via the Task menu).

Alternatively, use 'Release at' to hold the task until a specific time, after which it will
automatically be released.

Note:  You can later change this automatic release setting by selecting Release via
the right-click menu in the Task Monitor or via the Task menu.

• Select 'Launch a separate Task per input file' to launch a separate task or workflow
for each input file.

• You can also set an Annotation for the task.

 

828



12Automation Engine

 
4. Click Launch to launch the workflow.

The task will immediately appear in the Task Monitor.

12.5.4.  User Intervention from the Shuttle

When the launched workflow contains a Wait for Action (Checkpoint) step, a User intervention
needed link appears in the Task monitor when that step is reached..

1. Click on the User intervention needed link to open the To Do dialog.
 

 
2. Optionally, select 'I am currently handling this to do item' to mark that you are handling

this item (other users are so also informed).
3. Decide how you want to Release this item. The offered choices are those that were decided

in the ticket of the 'Wait for Action (checkpoint)' task.
Select the wanted output state. The To Do window will close and the workflow will continue
processing.
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4. In stead of releasing the item, you could Forward or Delete it.

• Click Forward, choose the user and set other details. The other user then needs to
decide how and when the workflow continues.

• Click Delete to delete this item and also end the processing of the workflow.
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13.  ArtPro automation using ArtPro
Action Lists

13.1.  Automating ArtPro Processing

Automation Engine can automate the processing of ArtPro native files. This can be a single
action or a list of actions. Such lists of actions could formerly have been run as (parts of) Nexus
workflows.

All this processing is initiated by one task, the Apply ArtPro Action List task. This task takes native
ArtPro files as input, processes them and can then output either ArtPro files or convert them to
a range of vector formats. Several actions can also process other file formats or even gravure
TIFFs.

Note:  This workflow is in some documents referred to as "ArtPro Processor on Automation
Engine".

The task runs an ArtPro Action List that defines the chain of actions to be executed. Such
"Action Lists" can be created and edited by using the ArtPro Action List Editor.

About Converting Nexus Workflows into Automation Engine Workflows:

In Nexus Manager, you can select a part of a Nexus workflow and choose 'Save as Action list'.
However, you still may have to adapt settings to get an identical result (fonts, marks, etc.).

Especially when you have complicated Nexus Processor workflows with file dependencies and
"Select File" activities, your similar Automation Engine workflow will probably be a combination
of small action lists and Automation Engine workflow controls like Router, Select File, etc.

13.2.  The ArtPro Action List Editor

The ArtPro Action List Editor allows you to create and manage ArtPro Action Lists (*.aal files)
that you can then launch with the Apply ArtPro Action List task.

13.2.1.  Installing the ArtPro Action List Editor

This tool is one of the client tools that you can download from the Automation Engine Server
Web Page.

• Open the Server Web Page by entering http://<name of your server>  or http://
<name of your server>:9999 in the address field of your browser.

831



13 Automation Engine

• Find this tool in the section Client Apps, in the page Tools. Click Download to install it on
your client computer (Mac or Windows). Run the .exe or dmg to install the application.

• When opening the installer editor for the first time, the Edit Preferences dialog asks you to
enter the name of your Automation Engine server and a valid user name and password.

13.2.2.  Working with ArtPro Action Lists

There are 2 ways to open the ArtPro Action List Editor:

• Start it from the desktop shortcut or application icon on your client computer. Then use the
menu options.

• Or select an Action List in the Apply ArtPro Action List task and click the Edit... button to
open it directly in the editor.
 

 

When you open an Action List, the dialog contains 3 main parts:
 

 

• (Left) The library of Available Actions: This section shows two columns. The left one offers
to filter by category. The next column shows the full or filtered list. You can drag and drop
actions from this column to the Selected Actions section.

• (Middle) Selected Actions. This shows the actions in this (opened) action list (of which the
name is shown in the title bar). You can double click in the column Label to add a label that
helps to identify these unique actions, for example when using public parameters.

• (Right) Options for the selected action. This displays the all settings for the selected
action. Edit them as wished. When you close the window, you will be asked to save the
changes you made.

Action List Menu Options
Here is a quick overview of the menu options in the ArtPro Action List Editor:

1. In the File menu:

• New / Open / Save Action List...
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• Import NeXML File.... Use this to import Nexus workflow tickets.

• Save Action List As...: Apart from defining a (new) name, notice that you will
be proposed to save the *.aal file in its default location \\AEServerName
\bg_data_custom_v010\dat\ArtPro Action Lists .This is also the folder that the
Apply ArtPro Action List task looks in.

2. Edit menu:

• Cut / Copy / Paste / Delete: Use this option to cut / copy / paste / delete action(s) from
the Selected Actions section. You can multi-select and use the available shortcuts.

• Select All. To select all Selected Actions in the current action list.

• Edit Preferences.... To set your server, units or language preferences.
3. View menu: Hide / Show Library: To hide or show the library of Available Actions.
4. Window: Because you can open multiple action lists at the same time, each in their own

dialoyou can here select the one to be active.
5. Help menu: The About  shows the software version of this tool.

Creating an Action List
To create an action list:

1. In the File menu, choose New Action List.... A dialog opens for the new Action List:
Untitled.aal*.

2. Add actions and define their parameters:

• In the first column of the Available Actions section, select All to view all the available
actions in the second column. Or filter the actions by category of by typing in a filter. .

• Double click or drag actions from the second column of the Available Actions section to
the Selected Actions section.

• To remove an action, select it in the Selected Actions section and press Delete.

• Select an action in the Selected Actions section to view its parameters in the Options
for "selected action" section. Edit these parameters as wished.

3. Click Save Action List As in the File menu to save this action list with a proper name.

Note:  Action lists have to be stored in the folder \\AEServerName
\bg_data_custom_v010\dat\ArtPro Action Lists to appear in the task's drop-down
list.
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13.3.  Handling Fonts in ArtPro Files

Important:  All fonts used in ArtPro files that are handled by Automation Engine should either
be:

• embedded
• referenced and located in a folder accessible to the Automation Engine server.

When a font is not accessible, you will get an error when trying to add or edit text, update text
objects using ArtLink, export the file to PS or PDF, etc.

ArtPro Files coming from a Nexus on Mac OS

Type of ArtPro file in Nexus workflows Consequence on fonts in Automation
Engine

ArtPro files created, edited or opened in
ArtPro.

These ArtPro files have all fonts and outlines
embedded (subset). They can be opened,
repeated, output… in any ArtPro action list
without any font problems.

Exception: ArtPro files containing ArtLink'ed
text containing a character that was not
embedded (not yet used in the ArtPro file and
the font is not available).

ArtPro files created by a Nexus workflow (files
that have not been opened and saved by
ArtPro).

These files do not contain any font
embedding.

Therefore, they cannot be used to generate
PDF export, unless: 

• You add a Text to Paths action before
outputting the file to PDF.

• You add all the necessary font folders in
your first action (see below). Note: you can
also add fonts and images folders in the
'Export PDF' action (in Images > File & Font
settings).

ArtPro files created by a Nexus workflow
starting with a PS/PDF import.

Referenced fonts are not available during this
workflow!

Any action that needs text outlines (Generate
Marks, Print to File, Export PDF,…) will error.

To avoid this, you need to:

1. Insert a Save action immediately followed
by an Open ArtPro file action.
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Type of ArtPro file in Nexus workflows Consequence on fonts in Automation
Engine

2. In the Open ArtPro file action, define the
necessary font folder.

Handling the Fonts Correctly in an ArtPro Action List
In general, opening an ArtPro file does not need the glyphs from the characters in the file,
because ArtPro always stores the vectorized representation of the complete text block in the
file.

When using ArtPro action lists and importing PDF files with non-embedded fonts, the fonts
need to be available on the Automation Engine server. Follow these steps to make them
available:

1. Create a fonts folder in an Automation Engine Container (a Windows network share made
'Container').

2. Move the fonts from the Mac to that folder (on Windows) using a third party font conversion
tool (for example CrossFont).

3. In your action lists, adapt the parameters of actions that need font resources (for example
the Importing action).

Note:  We recommend using TrueType fonts.

Caution:  When copying any font, make sure that you have the appropriate licenses to
install and use this font!

13.4.  The Apply ArtPro Action List Task
This task enables processing single or multiple actions on ArtPro native files.

Note:  Learn more about this concept in the introduction of this chapter.

The task launches an ArtPro Action List that you created earlier in the ArtPro Action List Editor.
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• You can define the action list by SmartNames or by Selecting it from the drop down list, in
which case you can also see and edit the parameters that were made public.

• The Edit... button opens the action list in your locally installed ArtPro Action List Editor.

• Click  to refresh the list and update the panel (it does not change any parameter
values).

Click  while holding the Shift key to revert the parameter values in the panel to the
values that were saved in the action list.

• Click New... to type in a name and then open the ArtPro Action List Editor.

Learn about all the available actions in these action lists in Available Actions on page 837.

13.4.1.  Using SmartNames in the Apply ArtPro Action List task

Note:  Learn about SmartNames in the dedicated chapter SmartNames on page 591.

In an action list value field, you can right-click or click on  to use SmartNames to define the
value. There is even a dedicated 'ArtPro' category:
 

 

This task has access to Automation Engine SmartNames linking to ArtLink parameters in ArtPro
files.
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Note:

• The SmartNames are resolved when the ArtPro file is opened.
• You can not use SmartNames that require their value from the Automation Engine task

itself (for example TaskID). You can use SmartNames based on file location or file name.

• You cannot use a Workflow Parameter directly as an ArtLink parameter.

Tip:  You can however make it a public parameter and then use the workflow parameter
there.

• When an ArtPro file is saved in a Job and linked to a Job Parameter, the information is only
kept within that Job. When the same file is saved outside that Job, this Job parameter info is
lost.

• When a Global Product is linked to multiple Jobs and Job SmartNames are used, any of these
values can be stored in the file. The ArtPro actions do not update the parameter to the
current Job.

13.5.  Available Actions

Note:  Many actions are identical or very similar to functionality in ArtPro. In those cases, this
documentation only offers a basic explanation and refers to a more detailed description in the
ArtPro user guide.

13.5.1.  Adjust Stroke Width

This action allows to change the width of all (selected) strokes.

You can use this for example to give hairlines a minimal width. To do this, first use the Select
Objects action to select all strokes smaller than the minimum width, then use this Adjust
Stroke Width action to change their width.

13.5.2.  Apply Pictures

This action replaces a picture (= an image or a placed ArtPro File) with another picture. You can
replace an earlier selected picture or all pictures in the file ("apply on all objects").

This function may be useful to replace the graphics in a step and repeat template with another
graphics file.

• Center Picture on: For ArtPro and PDF files, choose which box is to be used to center the
graphics when applying the picture (file) to the object(s) in the file.

• Remove Unused Separations: Removes all empty separations after the Apply Pictures.

• Place Single Separation ArtPro File in Single Separation: Defines how to insert ArtPro
files with only one separation. When this option is not selected, objects in this ArtPro file
with 100% of the single separation are considered to be registration color and thus get
100% of every ink in the ArtPro file after insertion. When this option is selected, the file is
inserted in one single separation instead.
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13.5.3.  ArtLink

ArtLink enables automatic generation of multiple variants of a template file based on database
information (a .txt or .csv file). You can choose to create different variants as different files or
add the variation as extra layers.

The template file needs to be made in ArtPro. You there select objects and link them to
parameters in the database file or add automatic parameters based on job content. Please
see to the ArtPro user guide (File menu > Parameters (ArtLink) for a full description of the ArtLink
module.

In the next pages we describe how an action list needs to be set up in order to automatically
generate ArtLink versions with the ArtPro Action List Editor.

Example of Using ArtLink in an Action List
In our example, an input folder contains an ArtPro template file "ice cream template.ap", a
database file "ice cream.txt" and also an "images" folder with the various images that will be
used for the versioning (strawberry, lemon, lime, orange, peach and tomato).

The action list should contain a Select File action and an ArtLink action. Be aware that the
ArtLink action has an embedded Open and Save action, so there is no need to also add those
to the list.

See how the Select File action selects both the .ap and the .txt file:
 

 

Note:  When you do need to add an Open ArtPro file action (maybe in an Update ArtLink
workflow), then make sure you only selected the .ap file in the preceding action.

Setting the ArtLink Action
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(ArtPro) Template
In our example, we here do not need to select the ArtPro template because this was already
done by the Select File action. You could however do this when the ArtPro File with the links is a
fixed file.

Additional Resources
Additional Resources allows to locate the Color and Ink Book that needs to be used, similar
as you would load these in ArtPro when colors or inks need to be defined from a library (for
example: PANTONE™ library).

File & Fonts Settings...
Since the ArtPro template file may contain images (on the same or a different server) and
fonts, this dialog enables working with root folders, folder mapping and font folders. The fonts
are obviously necessary if variable text needs to be generated based on the database file.
Learn more about the File & Fonts Settings... in the page on the Open ArtPro File action.

Save ArtPro
Use the Template Editor in the Output button to define the name and place of the files
generated by ArtLink.

Our example will generate six files, each with a variable extension:. Alnk_1 to .Alnk_6.

Choose if you also want a Preview and at what resolution.

Save Records
You here define if the results of the different records should be saved as multiple ArtPro files
("Files") or as one single ArtPro file containing different Layers ("Layers"). In that case, use the
Template Editor to define the name of these different layers.

The Database File
Our example uses a this text file (exported from a database):
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PANTONE;ice;barcode;pict

"300";"Blue Curacao Ice Cream";"54327719";":~images:strawberry"

"399";"Margharita Ice Cream";"54327627";":~images:lemon"

"370";"Caipirinha Ice Cream";"54327719";":~images:lime"

"orange";"Tequila Sunrise";"543277726";":~images:orange"

"1645";"Peche Mignon Ice Cream";"54327733";":~images:peach"

1797";"Bloody Mary Ice Cream";"54327740";":~images:tomato"

The first line describes what variables will be used. Each below line describes the values of
these variables for one output file:

• PANTONE: the color entry in the color book to be used

• ice: a text string

• barcode: the value of a barcode to be used

• pict: an image to be used

Note:  The images are described as ~images:xxx. "~" describes the current position of
the template file and "images" is a subfolder located relative to the current position of the
template file. Images will also be searched through the Files & Folders settings, so the full exact
path is not always necessary.

The Results
After processing, our example will have generated six ArtPro files. They will vary in color, text
string, bar code and the image.

The Template Editor allows the use of parameter values from the database records. The value
of the SmartName [n-th Input file] can for example be used as a template key for the
Save ArtPro file template.

13.5.4.  Borders

The Borders action allows to modify the size of the current file. You can choose which page
box you want to modify.

Note:  When you want to modify multiple page boxes, you need to set multiple 'Borders'
actions in the action list.

The square buttons in the window allow to set the direction of the size change versus the
current file size.

It is also possible to calculate a difference to the current size of the page box selected in the
option "start from Box". In this case the Vertical / Horizontal Size fields needs to be left to
0, while you enter the changes in the Extra V/H Size  fields. These values can be positive or
negative and serve to make the current box size larger or smaller, again with the direction
depending on the selected square button.

For example: a file was imported from PostScript with the bleed of 3 mm contained in the file
size. To change the borders to a correct Trim box (usable to start Step & Repeat or Imposition),
choose start from Trim box and set both Extra V/H Size  fields to -3 mm.
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13.5.5.  Certified PDF

Note:  Check whether Automation Engine's (more recent) PitStop PDF Preflight tasks are a better
option for you workflow.

This action allows to integrate the Certified PDF workflow functionality in these action lists.
It allows to import Certified PDF, edit and export as Certified PDF with information about
edits and changes to the document. Certified can be divided in three parts: Input, Output and
Certified ArtPro sessions.

Certified ArtPro Sessions
Automation Engine can work in Certified Mode, by selecting Certified PDF enabled.

User name, Short User Name, etc. provide the information about the person or application
that is editing the PDF document. This information is stored in Certified PDF each time when a
new session is started.

Note:  When Certified PDF enabled is selected, the field "User name" is mandatory.

Working in Certified mode affects all following Open/Save actions. Whatever the Certified
options are, Automation Engine is now recording the history of changes made to the file and
saves them on-board the ArtPro file.

Learn more about versions and sessions in the ArtPro User Guide (ArtPro menu > Certified
ArtPro).

13.5.6.  Clip

This action uses the front-most selected path as a cutting form to adjust the shape of the
underlying paths. Any part of the underlying paths that falls outside the front-most one will be
cropped. It so masks out the selected paths underneath.

The original paths are modified. For a more detailed description, see the ArtPro User Guide.

13.5.7.  Clip to Border

This action clips all the objects to the edge of the selected Border (page box).

Objects located completely out of the page box are removed. Objects located partially inside
the selected page box are clipped to the page box.

Choose All to apply on all objects. Choose Selections Only to apply it to the selected objects
only.

13.5.8.  Close ArtPro File

This action closes the currently open ArtPro file and so removes it from the application's
memory.
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Attention:  When you end your action list with a Save ArtPro file, it is no longer
required to also add a Close ArtPro file action right after it (as was necessary in Nexus).

There is one case however where this is still required: when your action list re-opens a
file that you just saved, you may create this sequence of actions: save - select -
open. In such a case, you need to add a close action after the save action: save -
close - select - open.

13.5.9.  Create ArtPro File

This action creates a blank ArtPro file which can be used later to add pictures, insert other files,
etc.

13.5.10.  Create Layer

This action creates a new layer in the current ArtPro file. Further processing takes place in the
newly created layer.

A typical example is a double burn workflow, where multiple files are imported (CMYK of first
version, K of second version, K or third version, etc.). To make later editing easier, set a Create
Layer action before each of the imports, so layering the final output file. Define the name of
the layer in the Template Editor dialog.

Move objects to this layer enables to move the selection to the newly created layer.

In Position, choose to create the layer on top or at the bottom of the file's list of layers.

13.5.11.  Delete

This action allows to delete objects, separations or layers from the current file.

• Objects

• Delete objects. Choose All or Selection Only to define what you want to delete.
Deleting all objects could be used to delete the contents from a file but keep all its page
boxes for another document (or picture) to be imported or placed. Learn more about
selections in Select Objects.

• Delete Links. Select this to (also) delete links in the file.

• Separations

• Separations mode. Select Leave as is to leave the separations untouched. Select
Remove to define which separations to remove. Select Only Include to define which
separations to keep. The Delete Unused Separation option is not influenced by this
setting.

• Technical / Varnish / Opaque. Use these to define if such types of separations should
be removed or included.
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• Separations list. When the Separations mode is set to Remove, all separations defined
in this list are deleted from the file. When the Separations mode is set to Only Include,
only the here defined separations are kept and all others are removed.

Use + and - to add or remove separations. Separation names can contain wildcards (*).

• Delete Unused Separations. When selected, unused separations are deleted,
regardless of the choice in the above Separation drop-down list.

• Layers

• Delete Layers. When selected, all layers defined in the list are deleted from the file.

Use + and - to add or remove layers. Layer names can contain wildcards (*).

• Delete Unused Layers. When selected, unused layers are deleted.

• Delete Non-Printing Layers. When selected, non-printing layers are deleted.

Note:  When the settings request to delete all layers, the first layer will still remains and a
warning is shown.

13.5.12.  Difference

This action is used to calculate the differences between two ArtPro files. This function is useful
to verify that the graphics of two different language versions fit, to find out what changes a
customer made to the new label, to verify that corrections on files have been executed, etc.

Note:  Learn about more recent tools to compare files in the chapter Quality Control tools on
page 992.

File & Font Settings.... Since this action actually opens two ArtPro files, in some cases it may
be necessary to specify Root Folders, Folder Mapping and Fonts folders. Learn more in the
action Open ArtPro File on page 859.

Learn more in ArtPro User Guide (File menu > Create Differences).

13.5.13.  Export CIP3

This action creates a CIP3 file of the current file.

A CIP3 file is used to transfer data about a specific file through the production process. Besides
a preview which can be used to extract ink key settings, a CIP3 file contains information about
separations, ink coverage, file dimensions, etc.

You can choose the Oversampling and the Resolution of the preview that will be included in
the CIP3 file.

13.5.14.  Export Illustrator

This action exports the current ArtPro file to an Adobe Illustrator native file (v3, 5 or 7.0).
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About Transparencies and Flattening
Learn about this in the ArtPro User Guide (File menu > Export Illustrator).

Compatibility and Restrictions
Learn about this in the ArtPro User Guide (File menu > Export Illustrator).

Downsample Images
You can here choose to sample the images in the file 2, 4 or 8 times or not at all.

13.5.15.  Export Macroflex

Learn more about this feature in the ArtPro User Guide (File menu > Export Macroflex).

13.5.16.  Export Mount-O-Matic

Learn more about this feature in the ArtPro User Guide (File menu > Export Mount-O-Matic).

13.5.17.  Export PDF

This action converts the active ArtPro file to a vector PDF file.

Learn more in the ArtPro User Guide (File menu > Export PDF).

13.5.18.  Export Picture List

This action exports an ASCII text file with information about the name, position and size of the
bounding box, the picture center and page box of placed pictures. You can use a Picture List
file in the action Import Picture List.

Choose whether you want to add mapped pictures in this file.

13.5.19.  Fit Borders

This action adjusts the document size and the selected page boxes to all the objects present in
that file.

Note that when All is selected, all page boxes will be set to the same size.

13.5.20.  Fit to Border

This action fits all or the selected objects to the edge of the selected page box.
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When Scale Proportionally is selected, all objects are scaled proportionally, until the bounding
box of the selected object reaches the selected border, either in vertical or in horizontal
direction.

When Scale Proportionally is not selected, the selection is scaled to fit the borders both
vertically and horizontally. This is sometimes used when creating flexo sleeves.

The scale factor can be rounded off using the Scale round to value. For example, when set to
5, the scale is rounded down to the closest multiple of 5. When set to 0, no rounding is applied.
The up-scaling can be limited using the Limit scale to field.

Select Notes to also transform notes along with the rest of the file, so that the positioning of
the notes inside the file remains the same.

13.5.21.  Fit to Paper

This action fits the file to the most appropriate paper size from a list of paper (or plate) sizes.

Click + to add paper sizes.

In Box, define which page box is to be used to determine the optimal paper size.

In Layout, define how to position the file versus the selected page box. Fit To Page also scales
the file to the optimal to fit on the optimal paper size.

Rotate to fit allows to rotate the file when searching for the optimal paper size.

13.5.22.  Fix Thin Parts

Learn about this feature in the ArtPro User Guide (chapter 'Prepress menu' - 'Thin parts').

13.5.23.  Flatten Transparencies

This action serves to flatten blend modes and overprints. It can also be found as a section on
board the actions 'Export PDF' and 'Print' .

This technology replaces all blend modes by "normal" objects and still maintains the final
result. The blend is calculated to whatever is underneath at that time and is adapted in a line-
art object (if possible) or an image.

Learn more in the ArtPro User Guide (Prepress menu > Flatten transparencies, and also in the
ArtPro menu > Preferences > General: Flatten) .

Ignore Overprints On Placed Art: This option allows to ignore overprints on top of placed art.
When this option is not selected, overprints on top of placed art (example: a Step & Repeat)
results in a failed action.

13.5.24.  Full Step and Repeat

The Full Step and Repeat action is based on ArtPro's Interactive Step And Repeat. This
functionality allows you to create a repetition of one single file at a time, based on either count
or fill size.
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General

Learn more in the ArtPro User Guide (Prepress menu > Step and Repeat Interactive).

Cut Marks. When selected, cut marks are automatically generated around the repeat block,
based on the used box size. When bleed is applied in between labels, double cut marks
automatically appear. The cut marks are filled with registration color.

Pattern

This option is used to make nested Step and Repeat: the second row or column is shifted each
time and the step distance can be decreased so the labels fit into one another.

Learn more in the ArtPro User Guide (Prepress menu > Step and Repeat Interactive).

Advanced

Page Box
Choose which page box needs to be used to step and repeat. By default, this is the Trim Box.

Place Single-Separation ArtPro File in Single Separation
This option defines how to handle repeating ArtPro files with only one separation. When
this option is not selected, objects in the ArtPro file with 100% of the single separation are
considered to be registration color, and thus get 100% of every ink in the ArtPro file after
repetition. When this option is selected, the file is placed in one single separation.

File & Font Settings
Provides access to the root folders, folder mapping and fonts folders when the file to be
stepped is an ArtPro file. Learn more in Open ArtPro File.

13.5.25.  Generate Marks

This action adds marks to the file, based on the dimensions of the chosen page box.

Learn more in the ArtPro User Guide (Prepress menu > Marks).

13.5.26.  Generate Strokes

This action creates strokes around all (selected) objects.

Separation Name / Ink book
Strokes generated by this action get 100% coloring of the separation name entered here and
overprint for all other separations. When the separation does not exist yet, it is created, in
which case the specifications for the ink are searched in the defined Ink book.

Apply on All / Selections
Choose whether strokes should be applied on all objects or only on the selected objects.

Add Stroke to Crop / Trim / Bleed Box
Allows to add a stroke on the selected page box.

Learn more in the ArtPro User Guide (Window Menu > Stroke).
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13.5.27.  Gravure Job Ticket

This action export files for gravure systems from Hell Gravure.

When the parameters can not be retrieved from the job ticket, you can here define the
Resolution and Oversampling rate. Each job ticket and thus every separation can have a
different value.

For separations with a resolution above 600 ppi and without oversampling, you can select
PackBits Compression for HiRes. Otherwise, you can Compress the TIFF using LZW, or leave
the separation uncompressed (if you did not select Compress TIFF). PackBits compression
results in lower compression rate, but will be calculated much faster than LZW compression, so
it is the best solution for high resolution files.

When selecting Separation Count in ArtPro File and Ticket Folder must match, the gravure
job ticket will check if the separation count in the ArtPro file matches with the ticket count in
the folder.

When the size of the ArtPro file and the job ticket size don't match, this action can generate a
warning or error:

• Select Error when ArtPro job and job ticket size don't match to get an error. Also, no file
will be generated.

• Deselect Error when ArtPro job and job ticket size don't match to get a warning instead
and still have a Gravure Job Ticket output file generated.

For more specific information, please contact Hell Gravure.

13.5.28.  Gravure Tiff

This action outputs ArtPro files directly as TIFF data for gravure printing. It creates one TIFF file
per separation.

Learn more in the ArtPro User Guide (File menu > Export Gravure TIFF).

13.5.29.  Grid Step and Repeat

This action allows to create a repetition of different ArtPro (or other supported) files that have
the same size and that are all placed in the same folder.

In the action list, first the one-up files are defined using a Select File action, after which you use
this Grid Step and Repeat action.

This repetition can be executed by starting it on a layout file, a comma separated text file that
contains the positioning of the different files).
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Learn more in the ArtPro User Guide (Prepress menu > Step and Repeat Grid).

13.5.30.  Gridwarp

This action allows to calculate complex warping of documents based on a source grid and a
destination grid. It can handle the warping of all object types including gradations and images.
It is typically used to warp the graphics of conic cups, metal containers, etc.

Grid Warp requires two files, an ArtPro file and a grid file. This action is therefore similar to the
ArtLink action where two files are first selected by the Select File action.

Click  to select a Grid file. When no grid file is available, the grid defined in the ArtPro
file itself will be used (when available). This allows to set up grid warp in ArtPro, and let
Automation Engine do the calculation.

13.5.31.  Import Picture List

This action enables to import an ASCII text file that contains information on name, position and
size of the bounding box of placed pictures.

Learn more in the ArtPro User Guide (File menu > Import Picture List).

13.5.32.  Importing

This action allows to import PostScript 3 and PDF files into the native ArtPro file format.

When a file is imported, typically all objects are made editable and all paths in the PostScript
or PDF document are converted to internal ArtPro paths. Text however will in some cases
be converted to outlines (depending on the settings in the Font Settings dialog box and
depending on 'Creator' of the PS or PDF file).

About Importing Screening Parameters
• Detecting Esko screens

When importing a PS/ PDF file that contains Esko screens, these screenings are recognized
and automatically converted to a PostScript screening with the correct Esko dot shape.

• Different rulings / dot shape per separation

In ArtPro files, it is not possible to have screens with different rulings or dot shapes per
separation, like you can in other Esko applications. When importing such a file, these
settings are split up into different ArtPro screening parameters. The affected objects are
then split up accordingly and put on top of each other in overprint.

About Importing Normalized PDF
Normalized PDF files can be imported just like any other PDF. Keep in mind that in Normalized
PDF, image links are included as EskoLinks.

Page Settings
When opening the Import PostScript/PDF dialog box, the Page button is selected.
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• Import Page.

When Import Page is not selected, all pages will be imported.

When Import Page is selected, only one page of the multipage document will be imported,
the one here specified. You can enter a numeric value (a page number) as well as a string (a
page label).

For PS files, the PS import has to jump to the right page of the file before starting import
of only a selected page (Selected Only). However, some applications define crucial
information at the beginning of the PS file on page 1. For example: Quark defines all
fonts on page 1. Therefore, page 1 is also interpreted (without generating output) before
importing the selected page (First and Selected). In some poorly constructed PS files, the
information needed for the selected page is scattered over the pages in front of it. In that
case, use the option Until Selected.

• Ruler at top left

Learn more about these options in the ArtPro User Guide (File menu > Importing PS/PDF).

• Multiple Page Offset

Learn more about these options in the ArtPro User Guide (File menu > Importing PS/PDF).

• Import Separated File as Multipage

This option should be switched off in an action list. It relates to importing a separated file,
for example files using the %PLATECOLOR command to identify the separation name or
older separated PostScript files.

Learn more about these options in the ArtPro User Guide (File menu > Importing PS/PDF).

Font Settings

Learn more about these options in the ArtPro User Guide (File menu > Importing PS/PDF).

Color Settings

Learn more about these options in the ArtPro User Guide (File menu > Importing PS/PDF).

Blends, Shadings and Gradations

These settings define how gradients, blends and shadings are handled when importing
PS / PDF. To recognize gradations from most popular applications, we advise to select both
Recognize Gradations and Convert Shadings into gradations.

Learn more about these options in the ArtPro User Guide (File menu > Importing PS/PDF).

Links

This determines how links are handled upon import. We distinguish these types of links:

• OPI links (%%ALDImage commands) in PS or PDF files.
• References to EPS images in PS documents.
• EskoLinks.

Learn more about these options in the ArtPro User Guide (File menu > Importing PS/PDF).
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OPI

This section is used to reroute linked images. The rerouting can be done based on the name of
the image or based on its path. There are two main reasons why rerouting may be needed:

• Low resolution images need to be replaced by (or rerouted to) high resolution images.
• Missing images need to be rerouted to their correct (current) location.

Note:  Rerouting can only be done when OPI links are available for the images and the options
Use Link and Place All or Use Link and Import EPS are selected.

• Perform OPI swap

When this option is not selected, all below settings are ignored and no rerouting takes place
for OPI links.

• Sample Extension / Hires Extension

The fields Sample Extension and Hires Extension are used to swap the extension of the
linked image. This is typically used for OPI servers which are set to add or replace an
extension when they generate low resolution images from high resolution images.

Every extension entered in the Sample Extension field is cut off from the linked file before it
is searched. Every extension entered in the Hires Extension field is added to the linked file
before it is searched.

Some examples: when the Sample Extension field contains “.lay” and the Hires Extension
field is empty and the image that is linked is “image.lay”, then the system actually searches
for “image”, the “.lay” extension is cut off.

When the Sample Extension field contains “.lr” and the Hires Extension field contains “.hr”,
and the image that is linked is “image.lr”, then the system actually searches for “image.hr”,
the “.lr” extension is cut off and the “.hr” extension is added.

It is also possible to enter multiple extensions, separated by spaces. When the extension of
a file referred to in the link matches an extension entered in the Sample Extension field, the
extension is cut off and, when present, it is replaced by the extension in the Hires Extension
field at the same position. Extensions that only need to be cut off and not replaced should
be at the end of the list.

For Example:

• Sample Ext. field: “.lr .low .lay”

• Hires Ext. field: “.hr .high”

This results in:

• “.lr” is replaced by “.hr”

• “.low” is replace by “.high”

• “.lay” is cut off.

• Sample Folder / Hires Folder

Similar to the fields Sample Extension and Hires Extension, these fields serve to reroute the
search for an image to a folder different from the folder determined in the OPI link. In OPI
swapping environments, this is typically used for OPI systems that generate low resolution
images of high resolution images with a same name but in a different folder.
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Note:  For example: all low resolution images are stored in a folder “ForLayoutUse”
and all high resolution images are stored in the folder “Originals”, both under the same
subdirectory, then “ForLayoutUse” would be filled in the field Sample Folder, while
“Originals” would be filled in the field Hires Folder.

When the OPI link in the file is then: E:/CustomerX/Images/ForLayoutUse/Image, the
system will search for and use: E:/CustomerX/Images/Originals/Image .

It is also possible that one path is changed twice. To do this, enter multiple entries in the
fields Sample Folder or Hires Folder separated by spaces. This requires that there are no
spaces in names of folders that need to be replaced.

Note:  For example, when the Sample Folder contains “LR Customer” and the Hires
Folder contains “HR”, then the OPI path E:/JOBNR/ImagesCustomer/LR/Image is
replaced by E:/JOBNR/Images/HR/Image .

In above examples, it is clear that all OPI paths were generated by a system on Windows.
The above would work for cases where the workstation creating the PS or PDF file with OPI
links is based on Windows and has the same mount point and drive letter for the image
server as Automation Engine. As in the first example, for both Automation Engine and the
Windows workstation, E:/ is the network drive for the image server entered at the mount
point where the CustomerX folder is the first available subfolder.

Most prepress workstations are on Mac OS. And when workstations are on Windows, they
would often have a different mount point to the image server than Automation Engine. In
these cases, the Folder Mapping mechanism can be used to remap the drives for the OPI
paths.

Note:  An example to illustrate this: Suppose the Image Server uses this structure for the
images: E:/Server/Images/…

And suppose that the Images folder has been made available to the Macs as Image
Server.

And suppose that the Server folder has been made available to the Automation Engine
server and that this folder is mounted as a network drive under G:/.

When now an OPI link on the Mac is defined as: ImageServer:image then Automation
Engine actually needs to find: G:/Images/image To achieve this, we would enter “Image
Server:” in the field Client, while entering “G:/Images/” in the field Server. Then click
Add to add this definition to the mapping list.

It is possible to have multiple OPI folder mappings active at the same time. The system
equally automatically converts between Mac and Windows notation of subfolders (: and /).

• Search missing images in... Root Folder

When a linked file cannot be found at its original or rerouted location, the file will be
searched for in the folder or volume that is defined as Root folder and in all its subfolders.
Click  to define a Root Folder. Click  to remove it.

Note:  The more subfolders the Root folder contains, the more time it will take to search
through all these. Therefore, setting a complete hard disk of a huge folder tree as root
folder is possible, but not advised.
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Note:  Be aware that the action uses the first instance of the file that it finds, which may not
be what you wanted.

For example: suppose the image to be found is called “logo.TIFF” and it is not found at its
location, after which the searching starts. Suppose these two customer folders contain an
image with that name: RootFolder/CustomerA/Images/logo.TIFF and RootFolder/
CustomerB/Images/logo.TIFF.

The system always picks the first instance of the name that it finds, in this case the logo of
customer A.

• Exclude Folders from Search

The here defined folders will be excluded from the search. For example you here define all
folders named "ForLayoutUse", which contain low resolution files.

Image Settings
• Vectorise Bitmaps: Always / Most / Never

When importing a PostScript or PDF file containing 1-bit images or a 1-bit image is detected
via OPI, this setting defines how to handle those.

Learn more about this option in the ArtPro User Guide (File menu > Importing PS/PDF).
• Make Images Internal

After importing, all TIFF and JPG pictures (placed in the PostScript or PDF file or extracted
by Automation Engine) can be automatically converted into Internal Images in ArtPro,
by selecting the option Make Images Internal. It is only used in exceptional cases. Esko
advises to not use this feature. For more information on internal images, see the ArtPro User
Guide (Contone Menu).

• Extract included images

If an image has to be extracted on disk during PS/PDF import (see also Links), a file is
saved to disk. During Import, identical images are detected and deleted. This means that, if
Automation Engine extracts images from the PS or PDF file and writes them to disk, these
images are compared and if the same image is used several times, only one of them is
kept. The comparison is done after writing the TIFFs and before making them internal (if
necessary). This comparing can take some time but results in faster editing and smaller file
sizes.

Click the Template Editor button to define the location and name of the extracted images
of the PS or PDF file. When these fields are empty, the images are saved to the folder of
the current file. We advise to use the document page number in the template, as otherwise
some files can be overwritten with multipage PS import.

• Resolution / Detect Image Resolutions

Learn more about this option in the ArtPro User Guide (File menu > Importing PS/PDF).
• Use Original Name

Learn more about this option in the ArtPro User Guide (File menu > Importing PS/PDF).
• Use Photoshop clipping path

Learn more about this option in the ArtPro User Guide (File menu > Importing PS/PDF).
• Recognize TIFF Channels

Learn more about this option in the ArtPro User Guide (File menu > Importing PS/PDF).

General Settings
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• Clip Text

Learn more about this option in the ArtPro User Guide (File menu > Importing PS/PDF).
• Merge Equal Paths

Learn more about this option in the ArtPro User Guide (File menu > Importing PS/PDF).
• Merge Equal Layers

Learn more about this option in the ArtPro User Guide (File menu > Importing PS/PDF).
• Ignore Page Commands

Learn more about this option in the ArtPro User Guide (File menu > Importing PS/PDF).
• Keep Strokes

Learn more about this option in the ArtPro User Guide (File menu > Importing PS/PDF).
• Autostroke CAD lines in ARD files

When selected, CAD lines in ARD files are converted to strokes.
• Memory

This parameter indicates how much virtual memory is allocated for this Import action to
store its variables, key words, dictionaries, etc. The proposed default should be sufficient
to perform the function. However, when the error message appears mentioning VMError,
then increase this value and try again.

Certified PDF

• Importing file types other than PDF

The 'Sessions' log indicates that no input profile was applied, The session then begins after
the import.

• Importing non-Certified PDF

When importing a non-Certified PDF file and Certified Import is selected, the action
certifies the PDF and imports the Certified PDF instead of the original PDF. Unless
Overwrite input file on re-preflight is selected, a new certified PDF is saved (according to
the settings in the Template Editor dialog) and this certified PDF is imported. This is saved as
a separate session.

• Importing Certified PDF

• When Re-Preflight if profile does not match is selected:

When the input profile and the embedded profile do not match, the file is re-preflighted
(when comparing two profiles, their content is checked, not just their name). When they
do match, the session log indicates that both profiles are identical.

• When Re-Preflight if profile does not match is not selected:

The Certified PDF is imported without re-preflighting it. The task details indicate the
profile it was originally certified by.

• Re-preflighting

When re-preflighting, the action creates a new session, preflights the file and closes the
session. The file is saved according to the settings in the Template Editor dialog.

• Overwrite input file on re-preflight

When selected, no new PDF file is created, it then replaces the original PDF file.
• Get all bounding boxes for preflight report
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When selected, this forces the action to obtain bounding boxes for the last preflight
report. It then gets full information for every report item along with the bounding box of
the area where the error or warning occurred. The action then takes longer because this
causes an additional preflight of the input file.

Cruise Controls (ArtCruise)

Cruise Controls allow you to control the status of many aspects of this Import action. This
status also maps to the status of the Apply ArtPro Action List task that uses this action.

The many controls are available in seven categories. The right window shows the selected
controls, each with a green, orange or red circle in front. The color determines the severity of
the control: red refers to error level, orange to warning level and green to note level.

Note:  When a cruise control topic results in an error, the Import action will continue until it is
completed.

To change the severity level for a cruise control topic, select it and choose the wanted severity
level from the drop-down list. To add a topic to the list on the right, double-click it in the left
window. To remove a topic from the list, right-click it and select “Delete Control” or select it and
press Delete / Cmd - Backspace.

The buttons Save Controls, Clear Controls and Load Controls respectively allow to save all
the selected controls with their severity level to a file, clear the list or load controls and their
severity level from a previously saved file.

When the import action has finished, the saved file contains a complete Cruise Report (similar
to a preflight report). You can view this report in ArtPro and there navigate to the object that
triggered that specific entry in that Cruise Report.

When Save Report is selected, a PDF report is saved to the location specified in the Template
Editor. You can use a Select File action to select that report PDF and use an E-mail action to
mail it as an attachment.

Learn more about cruise control in the ArtPro User Guide (File menu > Cruise Control).

13.5.33.  Ink Coverage

This action calculates the file's ink coverage and provides it in a text file (use the Template
Editor to specify its name and location).

Per separation in the file, a value is given as a percentage and as a surface coverage (for
example in square mm). A total surface value is also mentioned.

The accuracy of the calculation is determined in samples per inch.

Note:  In the case of pictures, ink coverage only works when these are mapped pictures or
when placed ArtPro pictures contain a separated preview. In other cases an average value is
used. On board ArtPro, this average value can be adapted in the paint style.

13.5.34.  Ink Coverage Check

This action verifies if the amount of ink does not exceed the Ink Limit.
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You can specify the area (page box) and resolution at which that area of the file needs to be
rasterized for checking. You can exclude special separations such as opaque, die or transparent
ones.

13.5.35.  Insert ArtPro file

This action inserts an ArtPro file or picture into the file that is currently being processed.

The inserted file can either be

• a fixed file (which name is selected in the Select ArtPro File dialog)

• a file specified by a preceding Select File action).

• a file that was generated earlier in the action list. For example the result of a Difference
action that needs to be inserted in a new ArtPro file (placed as picture).

The insertion is done on the bottom right quadrant of the current position of the ruler,
determined by the position of the ruler in the Importing action, the position of the ruler in an
opened ArtPro file or the position of the ruler after the Move Ruler action.

File:

Click  to specify a file or specify it in a preceding Select File action in the action list.

Overwrite separation angles and frequency
When inserting an ArtPro file, new separations are added. When there are identical
separations, this option overwrites the angles and frequency of the current separations with
those of the file that is being inserted.

Merge Layers with Same Name
When selected, the content of layers in the inserted ArtPro file is merged with content of layers
in the current file that have the same name.

Ignore Screening Errors
Because Extended Screenings are stored differently in newer versions, opening a file from an
old version may result in a conversion of the screening. If this conversion fails, the action fails,
unless the Ignore Screening Errors option is selected. Because a conversion error means that
the screening settings have changed, we advise to use this option only for action lists that do
not have any screened output or when other screening settings are defined in the action list
itself.

Place as picture using
This is used to place image files or to treat an ArtPro file as a picture (which could be done
when the content of the ArtPro file is not available, for example for trapping or internal
modifications).

These picture types are supported: EPS, DCS, TIFF, PSD, ArtPro, PS, PDF and TIFF/IT.

When this option is selected, choose the page box from the list. At the time of inserting, a
rectangle is created of the same size as the border of the chosen page box, in which the file is
placed as a picture. Use the option Align picture on to define on what page box the placed file
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should be positioned. The top left corner of the selected page box is placed in the center of the
ruler.

For example: combining both options allows you to place the inserted file positioned on its
trim box (top left corner of the trim box in the center of the ruler), but placing it inside it's bleed
box.

Place Single-Separation ArtPro File in Single Separation
This option defines how to handle inserting ArtPro files with only one separation. If this option
is not selected, objects in the ArtPro file with 100% of the single separation are considered to
be registration color. Thus they get 100% of every ink in the ArtPro file after insertion. If this
option is selected, the file is inserted in one single separation instead.

Recognize TIFF Channels
This option allows to recognize TIFF channels when inserting a TIFF File.

This option is also part of the Import action. Learn more in the ArtPro User Guide (File menu >
Importing PS/PDF > Image settings).

13.5.36.  Join

This action joins the two nearest open points of the selected paths with a straight line. This is
repeated until no open points are left.

13.5.37.  Layer Versioning

This action allows to create multiple ArtPro files from a single file, based on its layers. The Base
Layers re-appear in every output file. Version Layers only appear in one specific output file.
This can be used, for example, to split up a file with layers “Base graphic”, “Base Text” “English”
“French” “German”, into 3 files: everyone having the Base layers and one with the French, one
with the German and one with the English layer.

Base Layers
Click + or - to add or remove selected layers. Specify their name after double clicking the
default name. You can use wildcards (*).

When you Select by Range, you can, for example, define that layer 1 - 3 are base layers.

Version Layers

Version Layers can be defined by a user or you can choose to use All Non Base Layers.

Each version layer entry will create an output version. Use the Template Editor (Output
button) to define their names. For every version, you can define what layers need to be used.

The option Ignore Case In Layer Names defines whether the matching of the layer names is
case sensitive or not.

Select Fail if extra Layers found if you want to the action to fail when layers are found other
than the ones defined in the versions and base layers.

856

https://www.esko.com/en/Support/Product?id=ArtPro
https://www.esko.com/en/Support/Product?id=ArtPro


13Automation Engine

You can define if the output ArtPro file needs to be saved with a preview and if the Certified
PDF information should be included.

13.5.38.  Make Compound

This action makes one single object of all the selected paths.

Where paths are overlapping, a look-through window to the background is created. 

Learn more in the ArtPro User Guide (Object Menu > Compound).

13.5.39.  Make Thumbnail

This action creates a TIFF or JPEG thumbnail version of an ArtPro file.

The maximum resolution you can set is 120 ppi. You can add Noise for Gradation. There is no
oversampling. Choose the preferred Compression.

13.5.40.  Modify Layers

This action allows to change the settings of layers. Add any number of layers, specified by
name. You can use wildcards (*).

When Matching is selected, all layers matching the entered string are affected. When it not
selected, all layers not matching that string are affected. This for example allows to select all
layers except “varnish*” .

Use the check boxes to set layer(s) to (in)visible, (un)locked or (non-)printing.

When a layer name is not found, the line is ignored. However, when the Abandon option is
selected, the rest of the action list is abandoned.

Layers with hidden, locked or non-printing checks stay like that until other Modify Layers
actions remove the check or until the action list closes the ArtPro file.

13.5.41.  Modify Paint

This action allows to modify the paint (in percentage of a given separation) of all or selected
objects, change its overprint, or modify the start and end color of gradations.

13.5.42.  Modify Screen

This action applies user defined screening parameters to all or selected objects.

Use a Screening set allows to select a screening set as saved in ArtPro, based on the name in
the Screen field. The file can be selected using the Browse button. Learn more in the ArtPro
User Guide.
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These screening parameters are PostScript based. Use the Dot Code field to enter a PostScript
string to set your own personalized screening.

13.5.43.  Modify Separations

This action allows to change settings for separations.

Rename C/U/CV/ CVC/CVU/CVP to
This allows to rename different CVC flavours to having a same extension.

Delete CMYK Flags
CMYK flags indicate what separations should be handled as CMYK (for placing pictures,
importing PS files, etc.) even if they are replaced by spot colors. Select this to delete them.

Separation list
Click + or - to add or remove specific separations and a specific action to apply on those. You
can use wildcards, for example: “Die*”.

Rename
Enter the original and the Set to (target) name and select the option Rename.

Attention:  Renaming is not the same as remapping (see below).

Create
Enter a name and select the option Create.

Set to
• Remapping

To remap a separation, enter its Name and the name of the target separation in Set to
(and make sure you do not select 'rename'). When the target separation does not exist, the
action will fail.

• Convert to CMYK

To convert a separation to CMYK, enter its Name and enter CMYK in Set to.

• 0 / Trans

A separation is set to knockout when you enter “0” in Set to. All objects containing “trans”
for that separation are then changed to “0”.

When you enter “trans”in Set to, the separation is set to overprint, changing all “0” values
to “trans”. The Apply on Selections Only can be used to set the desired separation to 0%
or Trans only for the selected objects.

• Opaque / Technical / Varnish

Sets the attribute of that separation to either opaque, technical or varnish (transparent).
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This attribute is used in JDF export and in the action Vector Trapping.

13.5.44.  Move Ruler

The ruler position of a file depends on how the ruler position was set when importing or
opening that file.

The Move Ruler action moves the ruler within the current file to a new position based on an
offset versus the current position or versus a chosen page box.

This is very useful when pictures or other files need to be added to the current file at an offset.

13.5.45.  Nested Step and Repeat

This action is based on ArtPro's module PowerStepper. It is used to step and repeat based on a
multi-step CAD file: MFG (ArtiosCAD), CFF2 or a DDES file. These files decide the position of the
stations, their rotation and any possible nesting. Learn more in the ArtPro User Guide (Prepress
menu > Step and Repeat Nested).

The action typically needs two files as input: the CAD file and the ArtPro file. The CAD file can
also be specified within this action.

Nested Layout File Format
Instead of selecting an ArtPro file, you can also select a ‘layout’ file: a file describing the names
of the station files and where to place them.

Layout files are tab-separated text files with a small header. An example:

ArtPro Nested S&R Layout V1.0

JokerBoxBerries.aw 1-3 5

JokerGreen3.aw 4 6-7

The first line identifies the file as a ‘layout’ file that can be used for Nested S&R. It is followed
by an empty line. Each next line contains the file name of a station and the station numbers
at which it should be placed. In above example, the file ‘JokerBoxBerries.aw’ is placed at
station numbers 1 through 3 and 5 and the file ‘JokerGreen3.aw’ is placed at station numbers
4 and 6 through 7.

When using a layout file, you can provide the station files using a Select File action before this
action and then deselect the option Filenames in Layout File must match.

13.5.46.  Open ArtPro File

When this action is the first one in an action list, it opens the input file of the task. When this
action is preceded by a Select File action, it opens the selected one.

An ArtPro file can contain, next to its line art content, also a CT portion (internal images).
Alternatively, an ArtPro file can contain linked images (not embedded).

This action offers functionality related to used images, used fonts and color management.
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Root Folders
When images were used that reside on a Mac workstation or on a server which can not be
made accessible to Automation Engine, the Root Folders functionality can be used to define
where these images are.

An example: a root folder was defined as: E:/AE/AP_files. When an ArtPro file is opened
that contains linked images which were previously stored on a local Mac, they first need to be
copied to this folder or a subfolder of this folder.

When you define multiple root folders, the action then searches through all these folders and
their subfolders until the image is located. You can drag and drop lines to re-arrange their
order.

Note:  When you defined one, click on the folder icon on the right to open the Template Editor
and add SmartNames to your definition.

Attention:  The folders that the Automation Engine server needs to access do not have
be (part of) Containers. However, they have to be accessible for Automation Engine's
system user (which is by default "BGSystem").

Folder Mapping
Folder Mapping can be used when images reside on a server that can be mounted by
Automation Engine (also see above note on AE's system user).

An example: In an ArtPro file, the path of an externally linked image is defined as:
Intel_Mac:images:image1.

On the Automation Engine server, this file server will be mounted at a different mount point
with a different name. Typically the image server would be mounted to a drive letter, for
example G:.

To allow Automation Engine to automatically locate images on the Image Server, you can use
Folder Mapping to substitute a portion of the path name used in the ArtPro file with another
name. In our example, Intel_Mac would be substituted with G:/, which would instruct
Automation Engine to find above image as G:/images/image1.

To define a Folder Mapping, enter the respective On Client field (how the local Mac sees the
file server) and its respective On Server field (how Automation Engine sees the file server) and
click Add.

Fonts Folders...
When the ArtPro file contains live text, you can use Fonts Folders to allow Automation Engine
to extract the outline information from the Mac fonts for trapping, printing, exporting, ArtLink
functionality, etc. Please note this is only valid for Type 1 fonts and TrueType fonts.

Although the ArtPro file format contains all the outline information for its live text, the font is
still important for special functionality like ArtLink, Regmarks, etc. Click on the folder icon next
to a font folder to open the Template Editor and add SmartNames to your path.

Color Management
When enabling color management, you can select a color management settings file that was
previously saved by ArtPro. This file contains all ICC profiles and settings to determine how
color has to be treated throughout the rest of the action list, including ICC profiles for proofing,
printing, etc.
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When the option Stop when working space profiles are different is selected, the action
stops when the ArtPro file itself contains a working space different from the one defined in the
Color settings file.

Map Pictures
When selected, images are converted to mapped pictures when possible. Learn more in the
ArtPro User Guide (Window menu > Paint Style > Mapped Picture).

Ignore Screening Errors
Learn more in Insert ArtPro File.

Make image names SMB Compatible
Select this option to replace all a hash tags ( # ) in names of linked images by an underscore
( _ ). This will make them compatible with a Windows file server. When you do this, the ArtPro
file should be saved to make its image links point to the renamed images.

13.5.47.  OPI Generation

This action generates low resolution images from high resolution images. This is typical in a
page imposition workflow.

When a file is printed with Omit Images, the Importing action can then recognize the OPI
comments in the PostScript or PDF file and reroute back to the high resolution images.

13.5.48.  Optimizing

This action deletes (parts of) the contours that are not needed to produce correct print
output. The function is used to clean or flatten a document, removing all the superfluous and
unnecessary paths. For each path the action checks all the contours on top of it and decides
which objects should be cut, united or left untouched to maintain the same structure in the
file.

Optimizing is especially useful to eliminate unnecessary contours from an imported PostScript
file, to perform faster trapping, faster printing, etc.

Attention:  Keep in mind that objects are typically less editable after optimization We
therefor only recommend to use this action for complicated graphics.

13.5.49.  PowerTrapper

The PowerTrapper action offers these main options:

1. Choose your trapping settings in the tabs Distance & Direction, Color & Shape and
Processing.

2. Optionally, click Add Rule to add trapping rules.
3. Save your trapping settings as a Trap Preset to easily reuse them on another file.
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Learn more in the ArtPro User Guide (Prepress menu > PowerTrapper).

13.5.50.  Print to File

This action converts the ArtPro native file format to a composite or separated EPS file,
depending on the Device Type that has been chosen.

In an action list, the Print to File action can be simply followed by a Close File action, or the
Automation Engine task that launches this action can continue with an FTP or a Copy task that
then sends the output file to a device. .

General Concepts
Learn more in the ArtPro User Guide (File menu > Print : General Settings > General Concepts).

Device Type
Learn more in the ArtPro User Guide (File menu > Print : Device Types).

Other Settings and 'More Settings'
Learn more about all other options in the ArtPro User Guide (File menu > Print : General Settings -
Settings).

Note:  Some paragraphs in the ArtPro User Guide refer to options in ArtPro Action Lists as
'Nexus' options.

13.5.51.  PrintCheck

This action creates an image of the complete file. This image serves print control systems.

You can choose the resolution (no maximum) and set a noise level for gradations. You can
choose the format, compression and the page box to be converted.

13.5.52.  Regmarks

The action allows to select a 'marks' file you made earlier and add these marks to the current
file. This marks file is a blank ArtPro file containing only marks. Its job size is not relevant.
The marks will automatically adapt to the job size of the current file and the inks will also be
adapted.

You can select a fixed file by using the Select File button in this action, or you can select a
variable marks file by using the Select File action before this one.

Learn more about building a marks file in the ArtPro User Guide (File menu > Import marks').

Choose on what page Box the marks need to be applied or choose to use the bounding box of
prior made selections.
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When Merge Layers is selected, layers in the marks file and in the current file with the same
name will be merged together.

13.5.53.  Reorder Layers

This action allows to change the order of layers.

Layers with a name that matches one of the entries are placed in the specified order. Other
layers are placed underneath in their original order.

Use the + and - buttons to add or remove layer names. A name can contain a wildcard (*).

When two different layers match the same entry, their relative order depends on the original
order.

When a layer name matches different entries, the best match is chosen. For example: a layer
name "Trap layer" matches more with “Trap*” than with “*”.

Select Ignore Case when the matching should ignore any case difference in the names.

13.5.54.  Reorder Separations

This action allows to change the order of the separations in the file's Separations list.

Separations with a name that matches one of the entries are placed in that specified order.
Others are placed underneath, in their original order.

Use the + and - buttons to enter names. A name can contain a wildcard (*).

When a separation matches two different entries, it is placed at the topmost position. When
two different separations match the same entry, their relative order depends on the original
order.

Reverse order is useful for some special printing processes like dry offset. When selected, no
other re-ordering can be done.

13.5.55.  Rich Black

This action allows to add extra color to black objects (all or selected). Typically, the black is
enriched with cyan.

Density is the value of the chosen ink that you will add. Min. density decides which black
objects you want to enrich. For example: You can add 50% cyan to black objects with a
minimum density of 90%.

Select Pure ink only to only enrich objects that only contained black (till then).

13.5.56.  Save ArtPro File

This action saves the currently processed file as an ArtPro file.

Output
Use the Template Editor to set a (smart) location and name.
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Compatibility
Choose the file's compatibility. Saving as an older file format may trigger a conversion of object
types that did not exist yet in that older format. For example: a v9.0 file saved as v7.5 will not
contain blend modes ; that file will be flattened before saving.

Include Preview
Select With Preview to get a (separated) preview included in the ArtPro file. This preview is
useful when making Step & Repeating this file in ArtPro. The default Resolution is 72 ppi.

Save Hidden Layers
When this option is not selected, layers with a “hidden” state will not be included in the saved
file.

Profiles
Embed entire profile in ArtPro files allows to include the used Color Management profile
in the ArtPro file. This is useful when moving files to another system. The option Don't embed
profiles for imported pictures with embedded profiles disables embedding profiles that are
already embedded in the pictures.

Flattener Options
When saving the file as v7.5 or older, the file will be flattened with the settings in Flattening
Options. When the flattener generates images, their location and name is defined by the
Template Editor. Learn more in the ArtPro User Guide (in Prepress menu > Flatten transparencies,
and also in ArtPro menu > Preferences > General: Flatten).

Certified PDF sessions information
Select Include Certified PDF information to include Certified PDF information in the ArtPro
file. This also happens when saving as ArtPro 7.5 file, but that information is ignored when
opening that ArtPro 7.5 file.

Select Save Certified PDF Information to save the Certified PDF information in a separate
XML file. Use the Template Editor to define its name and location.

13.5.57.  Select File

This action is used in an action list to define a selection of file(s) which should be used as input
for the next action in the list.

Select Options
Select Options show the list of criteria that you created. Use + and - to add or remove
criteria. The name automatically summarizes its main settings (as shown below in Select Item
Options).

From Inputs / From Actions
• From Inputs: the files you select are searched from the inputs files of the ArtPro Action List

task that this action is part of.

• From Actions: the files you select are searched from the output files of all or a specified
action in this action list. You can specific that action by typing in the Label that you gave it.
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Select By Name
• whose name

The system selects a file based on its name. Choose a selection parameter from the list. You
can also use Regular Expressions in this input field. The Template Editor allows to specify
smart names.

• Position From... To... 0 To 500

This field work in combination with the option Whose name contains.... Using the position
fields, you can specify what character positions of the file name will be checked. For
example: With Whose name contains as “APR” from position 2 to 4, files which have APR
on character position 2 to 4 are searched and selected. Mind that the first character is seen
as on position 0, so in this case the 3rd, 4th and 5th characters are searched.

Select By Documenttype
• File Type

An ArtPro, PDF or PS file that also matches the other criteria.

• Number of Separations

Specify the Number of Separations that the selected file should have.

• Number of Pages

Specify the Number of Pages that the selected file should have.

• Page Box

Specify a size of a chosen page box that the selected file should have.

• Orientation

Specify the page orientation that the selected page box of the selected file should have.

13.5.58.  Select Objects

This action allows to select and deselect objects.

First
Choose what should be done prior to the selection:

• Do nothing means leaving the current selection as is. This is useful when combining
multiple Select Objects actions.

• Invert Selections inverts the current selection prior to applying the one in this (new) select
action.

• Select All or Deselect All allows to start from scratch with either everything selected or
everything deselected.

(De-)Selecting
The radio buttons at the bottom define whether the criteria you enabled means that you want
to select or deselect these objects.
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• Using Within Selections in combination with Select will search for objects that match the
defined criteria inside the current selection. Objects that do not match these criteria are
deselected.

• Using Within Selections in combination with Deselect will search for objects inside the
selection that match the defined criteria. Objects that do not match these criteria remain
selected.

Use Fail if Number of Selections... to have the action fail if the number of selections is higher
than, lower than or equal to the entered value. Use this for example to have the action fail if
any selected text is smaller than 7 pt..

Paint Style
• Flat Paints. Allows to (de)select Flat Paints. Specify which ones in the option Matching

(see below).

• Gradations. Allows to (de)select Linear, Circular or Multistep gradations. This can be
used in combination with the Matching option (see below).

• Matching. The Matching panel allows to specify objects with a Flat Paint or a Gradation
within the defined percentage range. Separation names can contain wildcards. Enable
Overprint to specify objects that are transparent for that specific separation.

• Pictures. Allows to (de)select placed, mapped or pattern pictures.

• Images Type. (De)selects all placed files of the chosen file type.

• Images Color. (De)selects all placed files of the chosen color type

Transparency
• Blend Mode. (De)selects all objects with the specified Blend Mode. Choose All to (de)select

all objects containing any blend mode.

• Opacity. (De)selects all objects with the specified opacity.

• Opacity Masks. (De)selects all objects containing a soft mask.

• Objects / Groups with Transparency. (De)selects all objects or groups containing any
transparency.

• Overprint. (De)selects all objects containing overprint.

Objects
• Text. (De)selects all text with the specified point size. Vectorized Text also (de)selects text

that was converted to outlines during import or by using the action Text to paths.

• Font Name. (De)selects all text items or text blocks containing the specified font. A text
item containing more than one font, is selected completely if the specified font is used.

• Screen Name. (De)selects all items using the specified screen settings.

• Object Name. (De)selects objects with that name. For example a layer from an imported
MFG file that was imported as a sub-layer in ArtPro.

• Strokes. (De)selects the strokes as specified.

• Traps. (De)selects all traps created by automatic trapping. A trap that was edited is no
longer recognized as a trap and thus not (de)selected.
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• Barcodes. (De)selects all barcodes containing barcode information. Mind that some
transformations make barcodes invalid (un-proportional scaling for example). A warning is
given when transforming and when the bar code is no longer selected with this function.

• Thin Part Fixes. (De)selects the thin part fixes done in ArtPro.

• Slices. (De)selects all slices (used for rid Warping).

• Open Paths. (De)selects all paths that are open.

• Blends. (De)selects all blends.

• Link. (De)selects all objects containing a link for ArtLink.

• Objects Inside / Outside bounding box. (De)selects objects inside or outside the specified
pagebox.

• Layers. (De)selects objects that are in a layer that (does not) match the entered name. The
layer name can contain wildcards.

13.5.59.  Separate

This action separates the file into its separations and places them under and next to each
other in a single ArtPro file.

You can define the V / H Gap to be left in between the separations. The number of Columns
defines how many separations you want to place next to each other.

Note:  When you want to print this kind of “separated” file, make sure you select the option All
Separated Pages on Same Film (in the More Settings of the Print to File action).

13.5.60.  Set Station Numbers

This action allows to set station numbers onto an step and repeat file. It is based on the
Station Number part of the Nested Step And Repeat action.

Use the square buttons to define the origin for the Offset. By default, the station numbers are
centered on the bounding box of a station.

Use the Template Editor to define a smart text for the station numbers.

Learn more about station numbers in the ArtPro User Guide (Prepress menu > Step and Repeat
nested > Station Numbers).

13.5.61.  Spread

This action allows to apply a spread on all or selected objects. It is based on the Interactive
Trapping function in ArtPro. Learn more in the ArtPro User Guide (Prepress menu > Interactive
Trapping).

When a Spread is applied:

1. The paint style of the original object is changed to 0% for every separation.
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2. A slightly larger Spread object is generated.
3. The Spread object gets the paint style of the original object, but is changed to “trans” for

every separation that had a 0% value.
4. If the original object had a blend mode, the original and spread object are grouped and the

blend mode is applied on the group.

13.5.62.  Tabular Step and Repeat

This action allows step and repeat in a tabular way. Learn more in the ArtPro User Guide
(Prepress menu > Step and Repeat Tabular).

This action can step ArtPro, TIFF, EPS, DCS and PDF files. These can be an input file of the action
list itself or can be picked up by a prior Select File action.

When an ArtPro file and a marks file are bundled in a folder, the Select File action would then
select the ArtPro file (or any other of the supported formats), and be followed by a Select File
action to select the marks (ArtPro) file that will be used to generate the register marks.

In Use Box, you define which page box needs to be used as reference for the step distance.

Settings
• Count. H and V amount of instances of the stepped file.

• Begin Pos. H and V offset to the ruler position for the first instance of the stepped file.

• Step. When left on (0,0), the step distance is equal to the (below) selected page box of the
stepped file.

• Angle Setting. Rotation of the stepped file.

• Cut Marks. Adds Cut Marks to any of the stepped instances.

• Keep Bleeds. Keeps the bleed of the stepped file in the step and repeat file. Bleeds are
always kept outside of the step and repeat job size. Note that bleeds overlap when the step
distance is set to the Trim box.

• Place Single-Separation ArtPro File in Single Separation. When this option is not
selected, objects in this AP file with 100% of the single separation are considered to be
registration color and thus get 100% of every ink in the repetition. When this option is
selected, the file is inserted in one single separation instead.

• File & Font Settings. This gives access to the root folders, folder mapping and fonts folders
when the file to be stepped is an ArtPro file. Learn more in the Open ArtPro File action.

• Color Management Settings. When you wish to enable color management for the step
and repeat file, select a color management settings file (that was previously saved in
ArtPro). This file contains all ICC profiles and settings to determine how color has to be
treated throughout the rest of the action list (example: proofing of the step and repeat
document), including ICC profiles for proofing, printing, etc.

13.5.63.  Text to Paths

This action automatically converts all the (selected) text to outlines. This is useful when
exporting ArtPro files to environments where the fonts are not available.
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Note that when importing PS or PDF files, text could already have been converted to outlines
(when the option Convert to Real Text was not set during Importing).

13.5.64.  Transform

This action applies a transformation to all or selected objects in the file. You can move
(Distance), Scale, Rotate or Shear objects.

Options
• Repeat. Use this to execute the transformation multiple times.

• Copy. This copies the contents of the file before executing the transformation. If at the
same time repetition is set, there will be multiple copies.

• Apply on:

• Path, Paint, Soft Mask: These options determine if the objects and their contents
are transformed, or only the contents without the objects, or the objects without the
contents. For example if a clipping path with an image would be transformed and Path is
not selected, then only the image itself is transformed and not the clip path.

• Notes. Transforms the notes along with the rest of the file, so that the positioning of the
notes inside the file remains the same.

• Scale Strokes. When not selected, the stroke width does not change when scaling. When
selected, the stroke remains a stroke and its width is changed for the same percentage as
the parent path was scaled. For example, scaling an object with a 3 mm stroke to 150%,
results in an object with a 4.5 mm stroke. When scaling is un-proportional, the stroke width
is scaled proportionally, by the geometric mean of vertical and horizontal scaling (= the
square root of the product of vertical and horizontal scaling).

• Center Paint (only available if the Apply on: Paint and Soft Mask is off). When selected,
it transforms the path only, but then repositions the paint based on the center point of the
path: the point in the paint that was on the center point of the original path is placed on
the center point of the transformed path. For example, this can be used when scaling or
distorting step and repeat files, without scaling the contents of the paths, but still retaining
their position inside the paths.

• Use Ruler. When selected, the center of the ruler is used as the center for rotation and
scaling. When not selected, the center of the selected objects is used.

13.5.65.  Trim & Bleed

This action calculates a trim and/or bleed for all objects in the file. It is mostly used when step
and repeating. Learn more in the ArtPro User Guide (Prepress menu > Step and Repeat Nested).

13.5.66.  Unite

This action creates a union of all or selected paths. Typically, you first use the action Select
Objects followed by this one.
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Learn more in the ArtPro User Guide (Objects menu > Path > Unite).

13.5.67.  Update ArtLink

The Update ArtLink action is comparable to the ArtLink action. While the ArtLink action
creates as many versions as there are records in the database file, the Update ArtLink action
does not create any files or versions. It modifies an object on-board an ArtPro file by updating
its ArtLink that was already put there earlier. This action opens the ArtPro file and so re-reads
information from the specified database record(s) (defined in the Record Number field) or
from an the XML file.

Learn about most of its settings on the page of the action ArtLink on page 838 .

Additional Key Values
The Additional Key Values allow to define values for specific keys. These keys are defined
from the action list rather than coming from the database file. For example: this can be
useful to set the name of the operator. You can also use the Template Editor and even insert
SmartNames.

13.5.68.  Vector Trapping

This action offers an alternative (older) version of trapping technology than the PowerTrapper.

For a full description of its different settings, we refer to the ArtPro User Guide (Prepress menu >
Automatic Trapping).

Note:  In the ArtPro user guide, the trapping modes Packaging and Commercial are often
referred to as 'version 1' and 'version 2'.

13.5.69.  Vectorize File

This action converts images into line-art.

Learn more in the ArtPro User Guide (File menu > Import - Vectorize...).

13.5.70.  White Underprint

This action allows to create a white background underneath the selected objects. This white
background is often needed when printing on transparent or metal material.

Learn more in the ArtPro User Guide (Prepress menu > White Underprint).
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14.  Gang Run Printing for Sign & Display

14.1.  What is Gang Run Printing?
Gang Run Printing enables you to efficiently match graphic designs to be printed with the
available substrate (to have as little substrate waste as possible and faster turnaround), with:

• Nesting,
• Ganging,
• Tiling.

This is especially useful when printing Sign and Display material and for shorter production
runs.

It takes into account the designs' sizes, shapes and ordered quantities to produce layouts on
substrate sheets.

14.1.1.  Nesting

Nesting is laying out several graphic files in the most efficient way so that waste is minimized.

When working with non-rectangular graphics, their bounding boxes may overlap in the layout.

 

 

For more information about nesting in Gang Run Printing, see Creating Nested Layouts on the
Nesting Server on page 877.

14.1.2.  Ganging

Ganging is combining several different graphic files, in one print job, even if those files belong
to several orders (for example if one order doesn't fill a whole substrate sheet).
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This helps drive production costs down and helps you offer a competitive price to your
customers.

14.1.3.  Tiling

Tiling is splitting oversize graphics into rectangular pieces (tiles) for printing. These tiles are
separate files that the Gang Run Printing mode can then nest with other tiles or even other
graphics.

A typical example are billboards:
 

 
This example could be tiled into these 10 smaller parts:
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Typical for tiling are the overlaps. We distinguish 3 classic concepts:

• Standard overlap: a side without overlap is placed on top of the overlap of the
neighbouring tile:
 

 

• When producing wallpaper or murals that are applied with a double cut, you need an
overlap on both sides:
 

 
See a video of an example here.

• When producing wall prints in thick material or tiles that are inserted in a framework, you
might not need any overlap. This could be an example:
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14.1.4.  Manual or Automated Gang Run Printing

• In the Esko editor i-cut Layout, you can perform manual Gang Run Printing: selecting and
preparing each graphic individually, then finding layouts (the most efficient layouts are
calculated automatically).

When working in i-cut Layout, you can tweak the results if necessary. Learn more in the i-cut
Layout manual.

• In Automation Engine, you can automate all parts of the workflow: the preparing of he
graphics, the submitting to Substrate Queues, their nesting settings and the output of the
resulting layouts.

When working automatically in Automation Engine, you can process more graphics in
parallel, and you don't need an operator to keep checking when to generate layouts (this is
done automatically).

14.2.  Working with Gang Run Printing
Here is an overview of how you can work with the Pilot's Gang Run Printing mode.

 

 

1. You first prepare your graphics and submit them to be nested on a particular substrate, in
your chosen quantity.
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You do this through an input workflow, that should contain the Prepare Graphics for
Nesting task and the Submit to Gang Run task.

Learn more in Preparing and Submitting your Graphics (Input Workflow) on page 875.

Optionally, you can add the Create Tiles task to split the prepared graphics into tiles before
submitting them.

2. Once the graphics are submitted, they go in a substrate queue and the nesting server
calculates the best possible nested layouts, based on the sheet or roll sizes and their
nesting settings. All this is set up and can be monitored in the Pilot's Gang Run Printing
view.
Learn more in Creating Nested Layouts on the Nesting Server on page 877.

3. Once the nesting server has decided one or more optimal nested layouts, it delivers them
to your output workflow, that creates production files (layout PDFs, cut files and reports).
The output workflow must contain the Export Nested Layouts task. You can make this
workflow copy the production files to a specific folder where they are picked up by the
press.

Learn more in Getting Production Files out of your Nested Layouts (Output Workflow) on page
881.

14.2.1.  Preparing and Submitting your Graphics (Input Workflow)

 

 

Preparing your Graphics
The nesting is based on the graphic's cut path, so before you submit graphics to a substrate
queue you need to make sure they have a cut path. You may also want to add bleed and
SmartMarks. This what the Prepare Graphics for Nesting task is for.

Learn more about the task's options in Prepare Graphics for Nesting on page 907.

Identifying or Extracting a Cut Path
As mentioned, the cut path defines how graphics can be nested.

For example, cardboard cut-outs of a tree (as below left) will be nested and cut differently
than postcards of a tree (as below right). Depending on the case, your tree graphic will need a
different cut path (shown in red).
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The cut path is typically provided in the file as a contour line in a spot color.

For graphics that don't already contain a cut path, you can generate one from the white
background, the trim box, or use a separate file.

Adding Bleed
If your file doesn't already have bleed outside the cut path or trim box, you can generate some
using the Prepare Graphics for Nesting task.

Adding SmartMarks
SmartMarks are marks that automatically update based on changes to the sheet size, the
number of inks on the sheet, etc. You can use them as regular marks or as production controls.
There are many types of SmartMarks: registration marks, barcodes, text, placeholders for
eyelets, etc.

You typically add SmartMarks to your nested layout in your output workflow (mostly for cutting
the sheet), but in some cases you need to add some SmartMarks to your graphic in your input
workflow.

For example:

• You can add eyelet marks to a graphic that will be used for a large eyeleted banner. You
need to add the eyelet marks before tiling the graphic to fit the substrate.

• When defining the cut path in the input workflow, you can add text on this cut path for easy
processing after cutting (for example to indicate the job-order and customer reference, or
the order the tiles must be glued in...).
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Tiling Oversize Graphics
When the final printed object is too big to fit on your largest substrate size (for example when
printing billboards), you can split the graphic into rectangular tiles (fitting the substrate size)
that can later be glued back together.

You can do this with the Create Tiles task. This task allows adding overlaps to be able to glue the
tiles on top of each other.

Submitting your Graphics
Once your graphics are ready, you can send them to the 'nesting server' using the Submit to
Gang Run task.

Note:  This task also allows to submit ARD file (CAD) files to be nested on a layout.

The most important things to define in this task are:

• how many copies you want of that graphic,
• on which substrate you want it printed (and optionally on which substrate size),
• if you have a specific due date to get that graphic printed.

Note:  Substrates are organized into substrate queues, which not only define the substrate to
use but also how its entries will be nested.

Learn more in Working with Substrate Queues on page 879.

14.2.2.  Creating Nested Layouts on the Nesting Server

 

 

Automatic Calculation of Nested Layouts
Once your graphic(s) arrive in the substrate queue, the nesting server calculates possible
layouts to nest those graphics, together with any graphic(s) already in the queue.

The nesting server tries to find the most optimal layout(s) possible, based on these settings:

• the nesting settings you set up,
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• the different possible substrate sizes (if applicable),

• the minimum fill percentage for that substrate queue,

• the use of any grouping keys (custom labels added to graphics when you submit them, to
control the grouping of graphics for nesting).

When the minimum fill is reached, the nesting server sends the layout(s) to the output
workflow to generate production files. All graphics that have been nested in these layouts are
then removed from the substrate queue.

If it isn’t reached, the graphics stay in the substrate queue until new graphics are submitted to
the queue, at which point the nesting server calculates possible layouts again.

Outputting a Partial Quantity of a Graphic’s Order
Sometimes the nesting server cannot fit all of the ordered copies of a graphic on layout(s) that
satisfy the substrate queue settings.

In this case, rather than generating an extra layout with the remaining copies, the nesting
server only outputs the quantity that does fit on the optimal layouts.

For example, if 10 copies of a graphic are ordered but only 8 fit on a layout satisfying the
minimum fill, the nesting server does not generate a layout with only the remaining 2 copies.
These 2 will stay in the substrate queue.

 

 

Once new graphics are submitted to that queue, the nesting server will again try to generate a
nested layout with those remaining 2 copies and the new incoming graphics.
 

 

When Time becomes More Important Than the Minimum Fill
As your customers expect their printed goods to be delivered by a certain date and time,
sometimes you cannot wait for the minimum fill to be reached. In this case, you can either:

• manually force a layout to be generated from the remaining urgent graphics,
• enter a due date when submitting these graphics. The graphics will then be force-nested in

time for that due date.
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In both cases the nesting server generates a layout ignoring the minimum fill. However, it may
also use other graphics from the queue in the layout to still raise the substrate’s fill percentage.

Working with Substrate Queues
A substrate queue acts like a printer queue to which you can send files you want to nest and
print on a particular substrate.

Substrate Queues Based on Material Types
For each type of substrate material you have in your stock (and still plan to use), you should
have a substrate queue.

For example:

In your stock you have 2 piles of PVC substrates, one with thickness 3 mm and one with
thickness 5 mm. For these you should set up 2 substrate queues with for example these
names:

• PVC 3mm

• PVC 5mm

Substrate Queues Based on Nesting Settings
It can also be useful to define substrate queues based on how the graphics will be nested and
printed.

• If you have an expensive substrate, you can set the nesting server to always nest the
graphics so that the substrate waste is minimal.

• If your graphics need to be nested on a material that will be printed in offset, you could aim
for less plates (so less layouts) and accept the higher waste factor.

So if some graphics need to be nested differently (even if it is on the same material), you might
need to create a different substrate queue for each type of printing/processing.

For example:

In your stock you have a pile of 250 g/m cardboard both for business cards and door hanger
orders.

Business cards and door hangers will be cut differently:

• business cards will be cut by a paper guillotine,
• door hangers will be cut on a cutting table.

The way graphics are cut influences the way they need to be nested. Since nesting settings are
attached to a substrate queue, you need different substrate queues.

In this case you should set up 2 substrate queues:

• Cardboard for Business Cards

• Cardboard for Door Hangers

Grouping Certain Graphics Together

Even when graphics are to be printed on the same substrate or using the same printer, you
may still want control with which other graphics they are nested. Using grouping keys allows
you to do this without the need to set up separate substrate queues for this.
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When submitting the graphics, you can add grouping keys to help control which group of
graphics can be considered to end up on the same layout. To the nesting server, these key
words act like limitations in its freedom to decide nesting groups.

Even when submitting them to the same substrate queue, the nesting server will only nest
graphics together that have the same value for a same grouping key.

Some examples:

• In your stock you have 1 pile of photo paper type "220 gsm". Depending on the order, some
graphics printed on this paper need to be laminated, some don’t. You can use a grouping
key called “Lamination”, with the values “Yes” or “No”, to prevent laminated graphics being
mixed with normal graphics.

In this case you only need to set up 1 substrate queue, for both regular and laminated
graphics.

• A similar case is when you do not want to mix graphics that need varnishing with graphics
that don't.

• Some customers do not want to mix graphics from different customers. In that case they
use the customer ID as grouping key.

Note:  Find a step by step example of a workflow using grouping keys here.

Substrate Sizes
If you have a substrate material in several sizes (sheet or roll), you can add these sizes to the
substrate queue for that material.

For example:

In your stock you have 3 piles of substrates:

• 1 pile of cardboard 2000x1000mm
• 1 pile of cardboard 750x1200mm
• 1 pile of polystyrene 750x1200mm

For this stock you should set up 2 substrate queues:

• Cardboard (with 2 substrate sizes)
• Polystyrene (with 1 substrate size)

Keeping Track of your Stock

Keeping Track of Stock or Not
Per substrate size, you can decide to keep track of its stock. For sheets this is done in units and
for rolls in length.

When you select this option for a substrate size, you first manually enter its current quantity.
Then, every time the nesting server uses that size for a nested layout, it will be subtracted from
the available quantity. In this workflow, Automation Engine will refuse to create a layout for a
size that is out of stock.

When you choose to not have the Gang Run Printing mode keep track of your stock, the
nesting server then always considers that substrate size 'available'.

Learn more about this setting in Adding Sheet Sizes or Adding Roll Sizes.
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Substrate Offcuts
The nesting server always tries to create layouts with as little waste as possible. However, an
approaching due date might force you to produce a sheet or roll that has a significant empty
area that could actually be re-used.

Such rectangular left-overs are often called "offcuts". When the substrate is not that cheap,
many users store those offcuts in stock and manually add them as a smaller sheet or roll size
of that substrate queue, together with their current quantity.

Learn more about offcuts in this page about nesting settings.

Manual or Automatic way to Keep Track of Stock

• Manual means that a person checks your stock and manually types in those latest amounts
directly in the Automation Engine Pilot, in the definition of each substrate size.

• Automatic means that a person checks your stock and manually types in those latest
amounts in your stock management system, typically a part of your business system. This
business system then updates Automation Engine by sending an XML that is picked up by
the dedicated Import Substrate Sizes from XML task.

Note:  Learn more about using XML in Automating your Workflow Using XML on page 905.

14.2.3.  Getting Production Files out of your Nested Layouts (Output
Workflow)

 

 

Every substrate queue is linked to an output workflow. You can build this workflow to your own
needs, but it should at least contain the Export Nested Layouts task.

As soon as the nesting server has found one or more optimal nested layouts for your substrate
queue, it delivers them to its output workflow, which is started automatically.

The output workflow then generates production files:

• A PDF file for the press, containing the nested layout including marks for printing and
cutting, but without technical inks.

• A CUT file for the cutting table, containing the combined cut path of the nested graphics.
You can choose from many different formats.

• (Optionally) a nesting report, in PDF format (which is useful for a cutting table operator)
and/or in XML format (which is useful for a business system). Learn more in the Export
Nested Layouts task.
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14.3.  The Gang Run Printing View
The Gang Run Printing view is part of the category Sign & Display. It gives an overview of all
graphics that have been submitted for nesting on each of the available substrate queues.

 

 

1. Substrate queues.

• Select one to see which one-ups are in this queue at the moment.

Note:  One-ups can be graphics but can also be CAD files.

• Or choose All Substrate Queues to see the contents of all of them. In the contents view
('2'), make sure you see the column Substrate queue so you can still see which queue
these items are in. The column Order ID will show which ones belong to the same order.
You could choose to sort by any of these columns.

• Right-click All Substrate Queues to start creating queues. or click the settings-button at
the bottom.

2. One-Ups submitted for nesting on the selected substrate queue. Once they have been
nested (and are no longer needed for other layouts), the output workflow starts for the
layout they belong to and then they disappear from this list.

3. Details of the selected one-up.

From this view, you can:

• Create or change substrate queues and their characteristics,

• have an overview of all one-ups submitted to each substrate queue, and their state,

• change the parameters they were submitted with or even move them to another queue.

• control the printing flow (for example you can put some graphics on hold, or force-print some
of them).
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14.3.1.  Working with Substrate Queues

When submitting graphics (or CAD files) to be nested on a substrate, they become an entry in
the corresponding substrate queue.

Substrate Queues are shown in the Gang Run Printing view. A number indicates how many
entries have been submitted to that queue. For example: .

The "nesting server" then calculates the best possible nested layout(s) for these entries, based
on:

• the quantity that was ordered,
• the sheet sizes and nesting settings that you defined for that substrate queue.

When a substrate queue is busy calculating layouts, its icon becomes animated .

You can also pause a substrate. This stops its automatic calculations. The icon changes to .
Learn more here.

Important:  We strongly recommend that you define your substrate queues before submitting
graphics to them.

If you submit graphics to a substrate queue that is not defined yet in the list of Substrate
Queues (by entering an unknown substrate in the Submit to Gang Run task), then this substrate
queue will be created automatically in the Substrate Queues list, but it will miss crucial
parameters (such as sheet sizes and a link to an output workflow).

In such a case, the nesting server is not able to calculate layouts for it and a warning sign on

the substrate icon  indicates that the substrate queue isn't properly configured. In this case,
make sure to add the missing parameters.

Adding a Sheet Substrate Queue
1. Click the action button  at the bottom of the Substrate Queues list and select New

Substrate Queue...

You can also

• go to File > New Substrate Queue... or press Ctrl + N on Windows / Cmd + N on Mac.

• right-click any other queue and choose New Substrate Queue....
2. In the New Substrate Queue dialog, select the icon for the type 'Sheet' click OK.

Attention:  In this page, we continue explaining how to set up a Sheet based
substrate queue. Learn how to add a Roll based substrate queue in 'Adding a Roll
Substrate Queue on page 894'.

3. In the New Substrate Queue dialog, enter a Name for this substrate queue.

Note:  Substrate queue names (and also names of their sizes, see below) are often used
in names of output files. That is why it is advised to avoid too special characters in these
names.

883



14 Automation Engine

4. Material: When you are using a Kongsberg table to cut the print results, this field serves
to communicate the exact name of the material to the cutting table. It is then already part
of the job specification on iPC. Mind that only the formats i-script and JDF (Kongsberg) will
contain this name of the material and so allow the cutting table to select the right material
settings.

Click  to see a list with all materials that are currently configured on your Kongsberg tables
(that you added as a Device). Select the one you want for this substrate queue and click OK.

Note:  If you type in a name of a material that is not yet in that list, it will appear with that
name in iPC. You can there choose to add it to the list in iPC.

When you leave this field blank, the name of the substrate queue will be used instead.

Note:  This field has no use when you do not use a Kongsberg table.

5. Click Add to add a Sheet Size for this queue. Learn more in Adding Sheet Sizes on page
884.

Attention:  You need to define at least one sheet size per substrate queue,
otherwise graphics sent to this substrate queue will not be nested and printed.

6. Click Nesting Settings... to define how this queue will create a nested layout. Learn more in
nesting settings.

7. In Output Workflow, select the output workflow that will be launched on the nested
layout(s).

Attention:  You need to define an output workflow here, otherwise you won't get
production files for the files you submitted to this substrate queue!

Note:  An output workflow will be launched as soon as a nested layout is made that fits the
queue's settings.

8. Click OK to save your substrate queue.

Note:  It is possible to save your substrate queue without having defined all the necessary
settings (for example if you haven't linked a workflow to your substrate), but you will get a

warning message and the substrate queue icon  will show a warning sign.

If this is the case, you need to edit your substrate queue to define the missing settings. When

you are done, you should see this default icon for a substrate queue: .

Adding Sheet Sizes
For every sheet size you want to add:

1. Click Add (on Windows) or + (on Mac).
2. In the Add Sheet Size dialog, enter a Name for the sheet size.
3. In the Size parameters, enter the sheet's width and height.

The units used here are those you defined in the Pilot Preferences (in Edit > Preferences >
Units on Windows or Automation Engine > Preferences > Units on Mac).
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4. Enter the Margins to use.

The margins won't contain nested graphics, but can contain marks.
5. Usage: Select one of these extra selection criteria, next to size.

• Preferred:

• Will be used whenever possible.
• Typically for offcuts and scrap material that you want to be used first.
• Other use case: You have a roll-fed printer and 2 widths of paper rolls. When you

have the wide roll mounted, you may set that one as your preferred one. This avoids
having to switch these rolls too often. And when you mount the other roll, you then
set that one as your preferred one.

• Standard:

• Default value
• Only when the graphics can not be positioned on 'preferred' sheets.

• Exceptionally:

• Typically for expensive sheets. You want good control over when this special material
is used.

• Only used when there are graphics that don’t fit on the other substrate sizes.

Note:  One of the above will only be considered when the submit task had the Substrate
Size on 'Any'.

6. If you want, you can keep track of the stock you have of that sheet size.

To do this, select Keep track of stock and enter the number of sheets you currently have
Available in Stock. Every time the nesting server uses that sheet size for a nested layout, it
will be subtracted from the available quantity.

Attention:

• When Keep track of stock is selected and the stock reaches 0, the nesting server
no longer create layouts that need that sheet size.

This can cause graphics to be stuck in the substrate queue (when this was the
only sheet size defined for that substrate queue, or when you chose to nest the
graphics on that sheet size specifically).

When you again get sheets available in that size, you should re-edit the available
quantity.

As introduced in Keeping Track of your Stock on page 880, the stock of sheet (or
roll) sizes can also be controlled from an external system. Learn more in Import
Substrate Sizes from XML on page 913.

• When Keep track of stock is not selected, no quantity is shown. The nesting
server then also does not check this and will so always be willing to create a
layout using this size.

7. Click OK.
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The resulting list of sizes also show a column Available in Stock. When Keep track of
stock was not selected for a size, no number will be shown.
 

 

Defining Nesting Settings for Sheets

Minimum Fill Tab

• Enter a Minimum Fill if you only want to output the sheet when it's filled to a certain level.
By default, the minimum fill is set to 75%.

Attention:  Do not put 100% here as only the graphics inside the cut path count as
fill. The margins, gutters etc. all count as waste.

Note:  When nesting is based on an irregular shape, be aware that a minimum fill may need
to be set quite low. Here is an example of a layout that looks rather full but still only has a
fill rate of 38%:
 

 

Note:  Some users still prefer to put this % to a very high level because they deliberately
want to avoid any nesting happening automatically. They prefer to use the tools in the 'Show
Layouts' view to have full manual control over their creation.
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• Overrule Minimum Fill: Set the hours and minutes before the due date at which you no
longer want to wait for the minimum fill, because the job-order becomes too urgent.

Layout Tab

• Select the Nesting Type to use for the layout:

• Minimal Waste tries to reduce the waste in material to a minimum.

• Minimum Layouts aims to generate as few layouts as possible, potentially at the cost of
having some more waste.

Tip:  Having fewer layouts can reduce setup time, making this option interesting for
offset printing.

• Guillotine Cut generates layouts that can be cut on a guillotine cutting table (which can
only cut in straight edge-to-edge movements).

This usually reduces the number of cuts per layout but may increase the number of
layouts and the waste.

In the example below, the layout on the left can not be cut on a guillotine table. The one
on the right can, but includes one graphics or copy less:

 

 

• Select the Search Method to use for calculating the layout.

Depending on if you are running a test or processing graphics for production, you can set
the layout search from Very Fast to Slow (Very Accurate) (the faster the search, the less
accurate the result can be).

• Graphics Order: (disabled when choosing Minimal Layouts). Once the calculation for the
chosen nesting type is done, the system needs to decide in which order the one-ups will be
placed.

• Any: The order of the one-up on the layout(s) is based on its size, taking the largest one
first.

• By Submit Date: This will nest the graphics in the order in which they are were
submitted to the substrate queue.

The position where the graphic is placed is decided by the nesting software. This means
that the graphic will likely to be placed near the previously placed graphic (although
there is no 100% guarantee). In case of guillotine nesting, which has a more strict notion
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of rows and columns, selecting this option will be more clearly reflected in the output
rows and columns.

Note:  When graphics have different sizes, it can happen that no space is found for some
graphic but that the next graphic can be placed. For example: A sequence of A, B, C,
D, E, F comes in, producing a layout with A, B, D and a layout with C, E, F.

Note:  Before v18.1, this choice was called 'Respect the graphics order'.

• All other methods: By Order ID, By Customer ID, By Custom Field 'x': The order of
placing is, as mentioned above, based on the size, but you can here select a method
that the system will use to group all graphics that have the same value for that selected
method.

Note:  Custom fields that are used as a grouping key are not available here (grouping
keys are used to sort graphics over different sheets).

Attention:  When, for example, you choose 'By Order ID', but these ID's are
(almost) all different, then the system cannot really make any groups... The
groups will then be groups of '1'. And then it will fall back on deciding the
sequence by size (the default). Note that it will not check the order ID values to
decide the sequence, it only uses the value to try to make these groups!

• Depending on the Nesting Type you selected, you can set extra options:

Table:

When you selected... …you can set:

Minimal Waste or Minimum
Layouts

• the Fill Starting Point on Sheet
(where the first graphic will be
placed): at the Top Left, Top
Right, Bottom Left or Bottom
Right,

• the Primary Fill Direction (in
which direction the sheet will be
filled): Horizontal or Vertical.

Guillotine Cut the direction of the First Cut:
Horizontal, Vertical or Don't care.

• A Gutter is the distance between the cut-paths of 2 stations. If it is zero, then these
stations have a common cut-line.

• If the graphics in your files have a bleed outside the cut path, you can clip it away by
entering the bleed distance in Bleed Clipping Mask.

Note:  An example: When there is a gutter of 10 mm, then both stations better not have
more than 5 mm bleed. To avoid that their bleeds overlap, set a mask to clip the bleed to
5 mm or less.
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• Maximum Overrun: When choosing the Nesting Type 'Minimum Layouts' or
'Guillotine Cut', you can choose to allow the nesting server to print a few extra copies of
some of the graphics, so that you have more printed sheets with the same layout.

Allowing some overrun increases the chance of getting the least amount of layouts. This
reduces the amount of plates needed for offset printing, so reducing the amount of
needed press setups.

• If you want to do this, set a Maximum Overrun. For example set a Maximum
Overrun of 10.0% if you don't mind printing up to 10% more of some of the graphics
to have less layouts.

• If you only want to print the exact ordered quantity of each graphic, and don't mind
the number of layouts, keep the Maximum Overrun at 0.0%.

• An example:

You need to print 100 "BLUE" graphics and 10 "RED" graphics, on a sheet size that can
fit 10 graphics.

• If you don't allow overrun, you will have 2 layouts:

• A layout with 9 "BLUE" and 1 "RED" graphics, to be printed 10 times (giving 90
"BLUE" and 10 "RED" graphics).

 

 

• A layout with 10 "BLUE" graphics, to be printed 1 time (for the remaining "BLUE"
graphics).

 

 

• If you allow a Maximum Overrun of 20.0%, you will have only 1 layout, with 9
"BLUE" and 1 "RED" graphics, to be printed 12 times.

This gives 108 "BLUE" graphics (8% more than ordered) and 12 "RED" graphics
(20% more than ordered).
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• In Rotation, specify if the nesting server is allowed to rotate the graphics in the layout to
get a better fit. You can choose:

• Allow Any Angle,

• Allow 180 degrees (clockwise),

• Allow 90, 180 or 270 degrees (clockwise),

• Not Allowed.

Offcuts Tab

Concept

• Offcuts are unused rectangular parts of a sheet that were cut off but that you still want use.

Selecting 'Save offcuts' in this tab outputs offcut areas as XML files. This can be one XML
file per layout PDFPLA file that this task creates. The XML file describes one or multiple
offcut areas.

An example: The XML from this PDFPLA layout would describe 2 offcuts areas:
 

 

• When you use the task 'Import Substrate Sizes from XML' on such an XML file, that offcut
sheet size will appear in the list of Sheet sizes of that Substrate Queue. They so become
available for the nesting server.

An example: See how next to the manually defined sizes 'Large' and 'Small', there are also
various sizes named after their custom size:
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• We can distinguish different workflows in using offcuts:

• Automatic: The system decides to use the offcut sheets as soon as they become
available as a sheet size.

• Manual: You decide when it's time to start using (specific) offcuts.

Learn more below about these workflows.

• You can also work with offcuts that you already made in I-Cut Layout. Learn more below.

Settings

• Save offcuts. Select this to have the system save offcut areas as an XML file. Mind that one
XML file can describe multiple offcut areas.

See below description on what to do with these XML files (importing them automatically or
manually).

• Minimum Width and Height. Enter a value to limit offcuts to those that minimally have
this size (in both directions). For example: '500 mm'

• Restrict amount of offcut sizes. Select this to restrict how many different sizes of offcuts
you want.

• Extend Minimum Size with Steps: An example: Enter '100 mm' to only save offcuts
that are any step of 100 mm larger than the here above specified minimum size. This
will then only create offcuts with size 500, 600, 700... etc.. This fixed set of possible sizes
reduces the amount of offcut sheet sizes.
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When this setting is not selected, the system will save any size of offcut sheet.

• Safety Margin: You can add an extra margin around the (bounding box of the) printed area.
This will make the offcut smaller.

Note:  The offcut size can also be reduced by any i-Cut marks that also take up some space
on the sheet.

Automatic or Manual workflow

The difference between the two is how and when you import those XML files into Automation
Engine's database of sheet sizes:

• Automatic workflow

To see the offcut sheet sizes automatically appear in your list of sheet sizes, add the task
Import Substrate Sizes from XML to the output workflow of that substrate queue and make
sure it imports the offcut XML files.

An example:

• In this output workflow, see how the task Export Nested Layouts also has a dedicated
output pin for the XML files that describe offcuts:
 

 

Attention:  The output pin 'Offcuts' requires an 'Export Nested Layouts' ticket
from AE v18.1.1 or later. To see the 'offcuts' pin on workflow tickets that you
made sooner, just open and close that ticket to make this pin appear.
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• When this workflow sends those XML files to the Import Substrate Sizes from XML task,
they will automatically appear in the list of sheet sizes of that queue. See an example
above in the first picture that shows the 8 offcuts that were imported. Their parameters
are defined in the ticket of the Import Substrate Sizes from XML task.

Note:  Offcut (or other) sheet sizes that have 0 in stock are not removed automatically.

These offcuts can be used by the system from the moment they appear. When you do not
want that to happen, you could for example add a 'Wait' step before importing, or make a
dedicated Substrate Queue for offcuts, or pause a queue and first check its contents etc. Or
you can have full manual control, as we describe next.

• Manual workflow

When you want full control over when and how the offcuts are used, then just manually use
the Import task when you want, and on the XML files you want.

For example: Each Friday afternoon, you want to produce using the offcuts of that week.

An example:

1. This time, the output workflow does not include the Import Substrate Sizes from XML task.
We'll only import them Friday noon.
 

 

See how this example moves the offcut files to a separate folder: You could do this for
example to make it easier to access or select them, or to avoid that they get imported
somehow...

2. At the time you want to use the offcuts, go to their folder in the Files view in the Pilot.

When you didn't specify an output folder, these XML files are by default written in
\ExampleJobContainer\SnDTemp .

Select the ones you want to import and launch this type of workflow that also moves or
deletes the imported ones, this to avoid that you import them again.
 

 

Note:  Notice that you need to use the 'Mark File' tools because this Import task does
not report any output files.

About the Name of an Offcut XML file

Their name is decided by the field 'Output Name' in the 'Export nested Layouts' task. Learn
more here.
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The below table shows an example when using the default set of SmartNames in this field:

Table: Default (SmartName based) name of an Offcut XML file

Part type Part Meaning Example

SmartName wfp.substrate Name of the substrate
queue

CBstndrd 4mm

SmartName wfp.substrate.size Name of the sheet size
that was selected to
produce

Large 3000x1500

SmartName wfp.substrate.size.quantity Amount of offcut sheets
of this size output by this
workflow task

1

SmartName shortid Short ID nr of the task
that produced this offcut

2712

Fixed OFFCUT_ Automatically added to
help identify the XML file

OFFCUT

Resulting name: CBstndrd 4mm_Large 3000x1500_1_2712_OFFCUT.xml

Note:  One XML file can have the description of multiple offcut sheet sizes. This is why we can
not add the size to name.

Offcuts already made in i-cut Layout

When you already made one or more offcuts in the editor i-cut Layout, they will be saved in
the resulting PDFPLA.

When, in Automation Engine, you launch the task Export Nested Layouts on that PDFPLA file,
those offcuts will also be exported as an XML file.

Linking a Workflow to Your Substrate Queue
Select the output Workflow to launch on the layouts that the nesting server created. This
workflow minimally needs the Export Nested Layouts task.

This output workflow will be launched either:

• when the minimum fill percentage for that substrate queue is reached,

• in time for the submitted graphics's due date (if they have one),

• when you force print one or more graphics from the substrate queue.

Attention:  You must link an output workflow to your substrate queue, otherwise you
won't get production files for the graphics you submitted to that substrate queue!

Adding a Roll Substrate Queue
Adding a substrate queue for a roll is very similar to adding one for a sheet, as explained in
Adding a Sheet Substrate Queue on page 883.

When you add a New Substrate Queue, you there select the icon for the type Roll.
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We here list the other differences:

Adding Roll Sizes
Adding a Roll Size is identical to Adding Sheet Sizes on page 884, with these differences:

1. The Size is the width of the web (across the roll).
2. You can define a Min and Max length (along the roll):

Attention:  Nesting on roll will:

• generate a layout in case the layout exceeds the minimum length and reaches
the minimum fill percentage. In case the due date has expired, a layout will be
generated even if the minimum length is not reached.

• reject graphics that exceed the maximum length (these graphics can't fit on the
substrate).

• always set the Primary Fill Direction or First Cut to the direction across the roll.

Note:  In case the PDF file for printing needs a different orientation, use the rotation option
in the Export Nested Layouts task.

3. Usage: A use case to have a type of roll as 'Preferred' roll size, is that you prefer continue
using this roll that was mounted already than going through a roll-change. So temporarily it
is your preferred substrate.

4. Stock: With roll sizes, the stock is the amount of meters left on all your rolls of the same
type of substrate. It is a 'global' stock for that roll. It is not the amount of rolls or the amount
per roll.

Defining Nesting Settings for Rolls
Roll Nesting Settings are identical to Sheet nesting settings, with these differences:

• The Primary Fill Direction is always vertical, across the roll.

• Fill Starting Point on Roll: choose the icon for Top Right or Top Left. The filling will always
be across the roll.

• When the nesting type is Guillotine cut, there is no First Cut setting. It will then always be
across the roll.

Linking a Workflow to Your Substrate Queue
This is identical as we explained for sheet type substrates queues.

Editing a Substrate Queue
1. Double click the substrate queue that you want to edit.

Tip:  You can also go to File > Open or press Ctrl + O on Windows / Cmd + O on Mac, or
click the action button  and select Open.

2. In the Edit Substrate Queue dialog, you cannot change the substrate queue Name, but
you can edit all the other settings.
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Note:  If you want to change the substrate queue name, we recommend you duplicate the
substrate under your chosen name and then delete the original substrate queue.

3. You can add, modify or delete sheet or roll Sizes.

• To add a sheet size, click Add (on Windows) or + (on Mac) and define the sheet or roll size
settings (for sheets or for rolls).

• To modify a size, select it, click Edit (on Windows) or  (on Mac), and change the
settings.

• To delete a size, select it and click Remove (on Windows) or - (on Mac).
4. Click on Nesting Settings... to check or change nesting settings for this substrate queue.
5. Check or change the Output Workflow that this queue will launch on the nested layouts.
6. Click OK to save your changes or Cancel to revert.

Note:  After changing the settings, the nesting server will automatically re-calculate nesting
layouts for the graphics in that substrate queue, even if no new graphic was submitted.

Duplicating a Substrate Queue
1. Select the substrate queue that you want to duplicate, click the action button  and select

Duplicate....

You can also

• go to File > Duplicate... or press Ctrl + D on Windows / Cmd + D on Mac.

• right-click any other queue and choose Duplicate....
2. In the Duplicate Substrate Queue dialog, enter a Name for the new substrate queue.
3. The queue settings are the same as the old substrate queue's, but you can modify them if

necessary.

See:

• Adding Sheet Sizes on page 884 or Adding Roll Sizes on page 895.

• Defining Nesting Settings for Sheets  on page 886 or Defining Nesting Settings for Rolls  on
page 895.

• Linking a Workflow to Your Substrate Queue on page 894.
4. Click OK to save your new substrate queue.

Deleting a Substrate Queue
1. Select the substrate queue that you want to delete and press the delete key.

Tip:  You can also go to File > Delete or click the action button  and select Delete.

2. In the dialog that pops up, click Delete to confirm that you want to delete that substrate
queue.
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Note:  When you confirm to delete, also a queue that still has graphic entries will be
deleted.

Pausing and Resuming a Substrate Queue
• Right click the name of a substrate queue and choose Pause Substrate Queue to stop the

queue from calculating layouts. Any already running calculations will still continue until
finished.

The icon will change to .

• Right click the name of a paused substrate queue and choose Resume Substrate Queue to
reactivate the automatic calculations. This action itself is also a trigger to recalculate.

The icon will change back to .

14.3.2.  Working with Substrate Queue Entries

Overview of Substrate Queue Entries

List of Entries per Substrate Queue

The name of each substrate queue is followed by a number that indicates how many entries
its has (graphics or CAD). For example: .

Select the substrate queue to see a list of its entries on the right, including some printing
information. Select an entry to see a bottom pane showing some Details.

Tip:  When this list is long, use the filter in the menu bar to easily find back entries. You can
filter on File Name, File Path, Customer ID and Substrate Size.

Printing Information

For each entry, you will see this information, defined by the settings that were chosen when
submitting the entry to that queue:

• the File Name of the entry and the page to be printed,

• the File Path,

• the Customer ID,

• the Submit Date,

• the Due Date,

• the Substrate Queue. This can be important when viewing All Substrate Queues.

• the Substrate Size it should be printed on (if this was defined when submitting the entry),
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• the Quantity ordered,

• the Remaining Quantity to be printed (if some copies of the entry have already been
included in a nested layout, this is what remains in the queue). When this number drops to
'0', this entry is removed from this queue.

• the State of the entry in this substrate queue (learn more on states of entries below),

• the date it was submitted (Submit Date),

• the Rotation,

• (if used) Custom labels. These may have been used as grouping key or just serve a labels
(here and in the report PDF). Learn more about their use in the page about the 'extra' tab of
the 'Submit' task.

If you want to find a specific entry in this overview, you can filter the list using the search field

, or sort the entries by clicking the column header. The sorting order
has no influence on the output.

Tip:  You can also show / hide or reorganise columns by going to View > Select columns in
'Gang Run Printing'...

For example, you can also show columns with your labels and grouping keys and use that to sort
entries.

States of Queue Entries

The entry is waiting to be placed on a layout.

When the nesting server calculates possible layouts, it will try to include all of the
entries in this state in the most efficient layout(s) possible.

A typical reason when an entry has this state for a long time is that the minimum fill
percentage is not reached.

The entry is on hold.

Entries in this state will not be included in the layout calculations.

Someone requested this entry to be forced out. This forces it to output regardless of
the fill percentage of the layout(s) that it is placed on.

It is still in this queue because not all related layouts were exported yet.

The entry checked and rejected by the nesting server. It can not placed on a layout.
The Details pane below explains why:

• Because it is too big. It could be that:

• The entry is too big for any available size of that substrate. In this case,
consider either defining a bigger sheet size (if you have some available), or
choosing a different substrate in Edit mode or when re-submitting this entry to
the queue.

• The entry is too big for the substrate size that you chose when submitting it to
the queue. In this case, choose a bigger size, or set the entry to be nested on
Any size of your substrate. Do this in Edit mode or when submitting it to the
queue.
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• The entry is too big to fit within the rotation possibilities of this substrate
queue. In this case, change the rotation parameter to Allow any angle (when in
Edit mode) or change it in the Submit to Gang Run task (which can overrule the
setting of the substrate queue).

If none of these solutions help, you need to tile your entry before submitting it to
the substrate queue.

• Because the file (or its backside) can not be found.

• Because the cut path is not closed. The system fails to create a closed outline
based on the selected cut path.

• Because the system failed to set cut path using the selected ink name.

• Because the number in stock of the requested substrate size is insufficient.

Managing Substrate Queue Entries
By default, entries in a substrate queue will automatically be sent to the output workflow

• either when they were placed on a layout with the desired minimum fill

• or when their due date has come (or the time that was set before their date).

You can however also manage these entries manually. Right-click them or use the menu bar
to chose a function:

• Select one or more and click the Hold button . An entry that is on hold will not be
considered in the calculation of layouts, even when its due date has passed. In the column
'State', the icon changes to: .

Note:  Alternatively, you can choose to put the whole queue on hold. This will stop the
queue from calculating new layouts, even when new entries come in.

Note:  You will notice that if you delete or put a queue entry on hold that was already
placed on a layout, that this triggers a re-calculation of the layouts (unless the queue was
put on hold). You can see this more visual when you work with the Layouts Gallery.

• To release entries that are on hold, select them and click the Release button . In the
column 'State', their icon changes back to the (default) icon  ('waiting').

• Force out: This forces the creation of one or multiple layouts containing that entry
regardless of the fill percentage of the layout(s). Select one or multiple entries and click the

Force out button .

Attention:  To get a better substrate usage, some other entries that you didn't select
may be printed along with the entries you forced out. In this case, you will see that
either these entries (also) disappear from the list, or that their Remaining Quantity
is reduced.

Entries that are on hold will not be included. If you want to force out an entry that is on
hold, you need to release it first.
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Tip:  When, even after a while, still nothing happens with the entries that you forced out,
check if the substrate size that was requested for those entries:

• (still) exists
• still has stock left (learn more in Keeping Track of your Stock on page 880).

• Show Layouts: This opens the layouts gallery and shows the layouts that this entry was
placed on. Learn more in Viewing and Choosing Nested Layouts on page 901.

• To remove entries from the queue, select them and click the Delete button . You will be
asked to confirm.

Note:  This will not delete the file of that entry. It only removes it from that substrate queue.

Note:  You will notice that if you delete or put a queue entry on hold that was already
placed on a layout, that this triggers a re-calculation of the layouts (unless the queue was
put on hold). You can see this more visual when you work with the Layouts Gallery.

• Edit: This allows to make changes to how this entry was submitted. Alternatively you could
remove the entry and use the tasks to re-submit it with the different settings.

Select one or multiple entries and choose Edit.

Important:  Currently, you can only edit multiple entries when they are in a same substrate
queue.

You can adapt these settings:

• Quantity: Type in the new (absolute) value.

Attention:  The entry will immediately disappear from the queue when the new
quantity is

• less than the remaining quantity
• 0
• a negative number rounded off to '0' .

• Substrate Size

• Scale

• Rotation

• Due Date

• Custom fields

Note:  When you selected multiple entries before clicking 'Edit', some of their settings may
have different values. When that is the case, the value field will be greyed out and mention
'Mixed'. You can overrule this by simply typing in or selecting a new value which will then be
used for all entries in your selection.
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Note:  When a user clicked Edit, the queue is automatically locked: 

When you click OK to confirm the changes, the queue becomes actives again and:

• All layout proposals that contain the selected one-up(s) are removed from the list of
layout proposals.

• A new nesting calculation is triggered on the substrate queues to which the affected one-
ups belonged.

Note:  The substrate queue will be locked while one of its entries is in this 'Edit' mode.

Note:  The changes that you here make to the quantity will also be updated in the Orders
view.

Note:  You can't edit an entry when another user is already 'editing' it. A message will
appear. It will also mention the name of the user that is blocking the access.

• Move to: This allows to move one or multiple entries to another substrate queue.

Right-click the entries (of a same substrate queue), select 'Move to...' and choose the new
Substrate Queue and Size.

Note:  The substrate queue will be locked while one of its entries is in this 'Move To' mode.

Note:  You can't move an entry when another user has already opened that dialog. A
message will appear. It will also mention the name of the user that is blocking the access.

• Go to File: This opens the Files view and selects the file for that queue entry. This can be
useful to launch some task on it or to check related files.

• Info (or click ): This opens the XMP (metadata) dialog of the file for that queue entry. This
can be useful to check its dimensions or inks.

14.3.3.  Viewing and Choosing Nested Layouts

Concept

Concept
Nested layouts that do not have the required minimum fill will not be output automatically.
Still, you can open a gallery view to see these layouts that are considered to be not good
enough yet. And you can even select them to print anyway.

There are 2 main use cases:

• When you want to check the nesting process of a specific substrate queue in detail, you
want to see the gallery of all layouts that that queue calculated for all its entries.

• When you wonder why a specific entry is still waiting in a substrate queue, you want to see
the gallery of only the layouts that this queue entry is part of.
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Manual Control over Layouts

Some customers prefer to always check the layouts visually and then manually decide when
which ones are good enough to print. To avoid that any automatic nesting takes place, they
typically put the minimum required fill percentage very high (for example 95%).

Working with the Layouts Gallery

Opening the Layouts Gallery

• Right-click a substrate queue and choose "Show Layouts" (or use Alt-Cmd-Down) to see
the layouts that were calculated of all entries in that queue (that have the status 'waiting').

• Right-click an entry in a substrate queue and choose "Show Layouts" (or use Alt-Cmd-
Down) to see only the layouts that contain that entry.

 

 

The Layouts Gallery

This gallery automatically refreshes when any changes occur. These changes can be caused by:

• one or more new entries in a queue
• one or more queue entries were put on 'hold'
• one or more queue entries were deleted
• the queue was resumed after being paused
• the settings of the queue were changed.

See this example, the numbers are explained below:
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Important:  You can choose how the layouts are sorted in this gallery. Right-click one of them
and choose to Sort by:

• Waste

• Due Date

1. Click '< Substrate Queues' (or use ALT/Cmd-Up) to return the list of queues and their
entries.

2. Name of the substrate queue.

Tip:  Just like in the list of substrate queues, the icon adapts to the queue's state (active /
paused / animated when calculating).

Double click the queue name to open the dialog with the queue's settings.

Attention:  When you make any changes to a queue's settings, a layout calculation
will be done right after you close this dialog.

3. The amount of one-ups of which the layouts are currently shown.
4. Click 'Pause Substrate Queue' to prevent it from calculating (new or different) layouts.

When paused, click 'Resume' to resume the calculations (one will be done instantly).
5. Below each preview, three lines describe the layout:
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• Top line: The name of the Sheet or Roll Size used for this layout (the name as defined in
the substrate queue).

• Middle line:

• copies: How many times this layout needs to be printed to produce the required
quantities.

• one-ups: How many different files (graphics or CAD) are present on this layout.

Note:  CAD files (ARD) are visualized with a random selected color.

• placed items: The total amount of placed items on this layout.

• Bottom line: The percentage of waste on this layout.

Note:  Any possible offcuts are visualised in the display by a thin light red line.
 

 
Offcuts are also visualised in this way when opening the PDFPLA file in the Viewer or I-cut
Layout.

6. The right pane shows details of the selected layout.

• Substrate Queue, Substrate Size, Copies, Waste: See above.

• Due Date

• Grouping: These are the values of the parameters that were involved in grouping these
one-ups onto a same layout. For example the grouping keys used in the Submit to Gang
Run task.

• Contains: How many different one-ups are present on this layout.

• One-Ups: The file name and the amount of times it is placed on the selected layout.
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Attention:  When you asked to see the layouts of only a selection of items in the
substrate queue, the names of these files will here be highlighted. For example:
 

 

When you select a name of a one-up, the bottom pane shows more details. For example:

• Quantity: Total amount of copies of this one-up that was ordered to be printed
(output).

• Remaining Quantity: Amount of copies of this one-up still to be printed.

• Placed Quantity: Amount of copies of this one-up placed on this layout.

• Resulting Quantity: Amount of copies of this one-up still to be printed once this
layout is printed (how many then still need to be produced).

7. How many layouts are shown (and how many are currently selected).

Printing a Layout from the Gallery
Although the layouts in this gallery do not meet the required fill percentage, you can still
choose to print them.

To do this, select one or multiple layouts and click  in the menu bar. Alternatively, right-click
them and choose Print.

This will remove those layouts from the gallery and start the output workflow assigned to this
substrate queue.

Attention:  The layouts that were not selected will not be printed, even when they
contain the same one-ups.

Note:  Requesting to Print a layout will fail when this queue is calculating at that moment.

Choosing to print one or more layouts changes the content of the layouts gallery. This is why
the substrate queue then also automatically recalculates a new set of layouts.

14.4.  Automating your Workflow Using XML
The use of XML enables many ways to integrate Automation Engine's Gang Run Printing mode
with an external system, typically the system that manages orders, production details and
stock.

This bidirectional communication via XML results in a high form of automation.

We can distinguish a basic and an advanced level of such integration:

• Basic use of XML in Gang Run Printing
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• An XML file describing a job is sent to Automation Engine (typically a Folder Access
Point). The XML informs the workflow of the name of the graphic file (only one per XML)
and also what to do with it (substrate, quantity, etc.). This is illustrated in detail in the
example Basic XML driven workflow on page 985.

Note:  These XML files can be very simple and serve a workflow where you mostly get
orders for copies of one graphic at a time. See the below 'advanced' section to read
about more complex XML files that ask the nesting server to calculate layouts for a list of
files.

• A dedicated task uses an XML file to update the list of the available substrate sizes and
also of their current quantity in stock. Learn more in Import Substrate Sizes from XML on
page 913.

• The task that exports the nested layouts into print and cut files also writes report files.
You can choose to have them in XML form, so that an external system can use them
for production status (how many were already nested?) or for post-production cost-
calculation (material usage/waste). Learn more in Export Nested Layouts on page 947.

• Using XML for Advanced Communication with the Nesting Server

The dedicated Submit XML to Gang Run task enables these advanced forms of XML based
communication:

• The business system sends XML files that represent 'nesting requests', possibly of
complex orders. They can be about different graphics, each with their own quantity,
substrate, etc. By doing this, the business system can ask the nesting server possible
layouts for estimation purpose only. It then uses the return data for its own cost
calculation and maybe production preparation.

• After the layouts have been exported, the feedback XML to the business system
describes the whole order and includes references to the actual production files.

Here 's a schema about this workflow:
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The XML files that the business system sends must match a detailed specification.

Learn more in Submit XML to Gang Run on page 936.

14.5.  The Gang Run Printing Tasks

Note:  In a standalone setup of Device Manager, several of these tasks are not available.

14.5.1.  Prepare Graphics for Nesting

Use this task to prepare individual graphics for Gang Run Printing. You can create a cut path,
extend the graphics and add SmartMarks.

This task supports these input file types:

• PDF (single page or multipage),
• Normalized PDF (single page or multipage).
• TIFF (CMYK or grayscale),
• JPEG (CMYK or grayscale. Progressive JPEG compression is not supported.),
• PSD (CMYK or grayscale),

Typically, you use this task before a Submit to Gang Run task in an input workflow. The input
workflow prepares the graphics and submits them to a substrate queue on the nesting server
(see Working with Gang Run Printing on page 874 for an overview of the whole Gang Run
Printing process).

Create Cut Path From
In Create Cut Path from, define what to use as a cut path, and how to generate one.
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If you want to... do the following...

use an Ink as cut path 1. Select Ink.

Note:  Only objects with a 100% fill or stroke of this ink are
taken into account to make the cut paths.

2. Enter the name of the ink to use in the field below.

Tip:

• If the ink to be used for the cut path has different names in
different input files (for example if you have customers using
names in different languages like cut, découpe, taglio...),
you can add several ink names, separated by a comma ( , ).

Their order is important because the task will use the first
ink it finds in the list as cut path!

• You can use wildcards and/or SmartNames to define ink
names. For example use Pantone* if you want to use any
Pantone ink used in the file as a cut path.

Tip:

When building a workflow using an example file, click  to
select one or more of the inks from the example file.

If you always receive CMYK graphics with one spot color used
for the cut path, select ANY SPOTCOLOR.

3. Define what to do if the ink(s) you defined are not found in the
file:

• If you want to use the trim box as cut path instead, select
Create cut path from trim box.

• If you want the task to end in error, select Generate an
error.

use the Trim Box as cut
path

Select Trim Box.

use the cut path defined
in an external ARD, PDF
or Normalized PDF File

Select File and Browse to that file (or use SmartNames to define
the path to the file).

create a cut path from the
contour of the graphic on
its White Background

Select White Background.

Note:  This will include both the contour of the design on the
white background and the contours of any "white holes" in the
design in the cut path. You can then remove the "white holes"
contours using the Remove holes option.
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Optimize Cut Path
This Optimize... dialog offers ways to optimize the shape of your cut path.

Important:  Especially when you created the cut path with the From White Background
method, you typically need to optimize the automatically generated cut path contours to
facilitate and speed up the cutting process.

You can:

• Remove holes in your cut path.

Select this if the cut path was extracted from a white background and your graphic contains
white. This option makes sure that the white parts in your graphic are not considered part
of the background (which would create holes in your graphic).

• Smooth small jagged edges in your cut path.

Select Smooth cut path and enter the desired minimum distance. Any point that deviates
from the cut path by less than that distance will be smoothed.

• Remove small objects from your cut path.

Select Remove small contours and enter the minimum contour size. Any objects smaller
than this will be removed from the cut path.

• Move the cut path inwards or outwards.

Select Offset cut path and enter a positive offset value (to move it outwards) or a negative
one (to move it inwards).

• Make Round corners.

Both inside and outside corners will get rounded with the defined Radius.

This is especially advised to shorten the production time on a cutting table. Also when the
cut path serves to help peel off self-adhesive labels from a matrix.

Note:  A corner needs to be formed by one same line. This option does not work when the
corner is formed out of two different lines.

Cut Path's Ink Name
In Cut Path's Ink Name, enter the ink name to use for the cut path you just defined.

• If you defined the cut path based on an ink in your file, this will rename that ink to the name
you enter here.

Note:  Only objects with a 100% fill or stroke of this ink are taken into account to make the
cut paths.

Tip:  Use this to standardize cut path ink names across files (especially when your files come
from different customers).

• If you defined the cut path from the file's trim box, white background, or an external file,
this will add the cut path in that ink in your graphic file.

Later in the input workflow, the cut path ink name you enter here will be used to identify the cut
path in the Submit to Gang Run task.
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Extend Graphics
If you want to extend the graphics, choose one of these modes:

Create Bleed

If the graphic contains no bleed, you can add some here. Select Create Bleed and choose from
these Options:

• the Bleed Distance (the distance outside the cut path).

• the Bleed Type. You can choose between:

• Choose Clone to take the part of the graphic just inside the cut path and clone it to the
outside of the cut path.
 

 

• Clone From: choose the distance on the inside of the cut path from which data will be
cloned. This is useful in cases where graphic elements are very close to the cut but are
not required to bleed out. This can avoid unwanted effects. An example:
 

 

This option works on cut paths with any shape (free form or rectangular).

Note:  When an RGB image is cloned, the cloned bleed will contain CMYK information.
The image data within the cut path remains unchanged.

• Choose Mirror to take part of the graphic (as much as the bleed distance) and mirror it
to the outside of the cut path. This option is only useful on rectangular cut paths.
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The visual effect is less distracting and is advised with large bleeds or when the bleed
remains visible (as in below example of a photo canvas).

Extend Content

This mode mirrors the graphic content over the 4 sides and corners of the original cut path,
and extends the cut path. This can be used to create a hem for a flag, banner or canvas.

 

 
In the Options,

• Set the Hem Size, defining how much the cut path needs to be extended.
• Define the shape for the Corner: square, round, bevel or cut-out. Use Edit... to control the

shape with a SmartName. Learn more about using SmartNames for buttons in SmartNames
of Parameter Values on page 683.

• For round and beveled corner shapes you can supply a Bevel Distance.
• In Limit Bleed, you can add bleed on the extended cut path. As the hems are created by

mirroring the graphics, the bleed will also make use of those mirrored graphics.

Use backside graphic

In this case the graphic is extended with content taken from the backside graphic. This is useful
when producing banners that have a printed front and back.

Its Options are identical as mentioned above in Extend Content, except for these that are
specific for this method:

• Backside Graphic:
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• Even Pages: Select this when the backside of the graphic is the even page of the
multipage PDF that was selected as input file for this task.

• File: Select this to indicate a separate PDF that will serve as backside graphic in the
production process.

• Glue area: This area will knock out the graphics on the back side, so creating a non-printed
area where glue will be applied.

An example result:
 

 

Use solid color

In this case the graphic is extended with a solid color. This might be useful when the graphic
also ends in a solid color (on all 4 sides).

Its Options are identical as mentioned above in Extend Content, except for this one that is
specific for this method:

• Solid Color: Type in the values of C, M, Y and K that will define the solid color.

SmartMarks
You can add SmartMarks to the resulting graphics (a SmartMarks set that you created in an
Esko editor i-cut Layout or PackEdge).

For example, you can add a Text on Cut Path mark to automatically add the name of the
graphics file and other info on the cut path, for example in the bleed zone. This information is
then visible on the cutting table and so helps organize your printed graphics after cutting. An
example:
 

912



14Automation Engine

 

Note:

Before you can do this, you need to:

1. Make sure your i-cut Layout or PackEdge application is connected to your Automation
Engine server.

2. Create and save a SmartMarks set in i-cut Layout or PackEdge (this automatically
saves it to the correct location on your Automation Engine server: \\AEservername
\bg_data_marks_v010\dat).

See the i-cut Layout or PackEdge manual to learn more about connecting to an Automation
Engine server and creating a SmartMarks set.

14.5.2.  Import Substrate Sizes from XML

Concept

This task allows to use an XML file to

• import (and create) substrate sizes into the Gang Run Printing database
• update substrate size information (for example the available quantity).

This XML file typically comes from a business system: the MIS or ERP that also manages the
stock of printing material. Such an XML file is very useful for example to regularly import a list
of left-over stock entries (a.k.a. "offcuts").

Usage

The task panel serves to map the language in the XML to the required terms in Automation
Engine for these substrate parameters. The result will be visible in the list of substrate queues
or in the details of their substrate sizes.
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XML Element Name: You first need to specify the name of the XML element that contains the
substrate size information.

Then, for each Size Parameter, select and click Edit to specify the corresponding XML
Element or Attribute that is used in the XML file.

The Size Parameter 'Name' is the name of the substrate size and the Size Parameter
'Substrate' is the name of the substrate queue that that size will be added to (or be updated
when already there).

Important:  Substrate queues mentioned in the XML file that do not exist yet in Automation
Engine are automatically created using the default nesting settings. Note that you will still need
to complete their settings by adding an output workflow.

Important:  All sizes are assuming the units as defined in the Pilot's Preferences.

These examples illustrate the XML specifications:

Example XML to Import Sheet Substrate Sizes

In this example, as shown in above screen shot, the XML Element Name is 'Size' and there
are 2 such elements. Their XML attributes are also those that the default task ticket proposes.
The 2 substrates described in this XML file are sheets. That is defined by their attribute Type
'P' (for 'Plano').
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Note:  The parameters for margins are not mandatory. When they are not present the
substrate size will fall back on the default settings (0).

Note:  The element 'Ranking' defines the sheet size 'Usage': possible values are '1' for
'Preferred', '5' for 'Standard' (=default), '9' for Exceptional.

Example XML to Import Roll Substrate Sizes

To define a roll size, the XML file needs XML attributes that the ticket then maps to

• Type, which for a roll is 'R'

• Width

• Roll Minimum Length and Roll Maximum Length.

An example (the default ticket will map these to the right Size Parameters):
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Method and Example XML to Update the Available Quantities of Substrate
Sizes

Note:  For sheets, the quantity is the number of sheets. For rolls the quantity is the amount of
units (as defined in Preferences).

In the task ticket,

• the Size Parameter "Available quantity" allows to define a stock quantity of a substrate
size.

• the Size Parameter "Use available quantity" allows to define whether the quantity of that
size should be tracked (counted) when nesting layouts use that substrate size.

See an example (same syntax for sheet or roll):
 

 

The above example created or updated this Roll Size in this Substrate Queue:
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For the Size Parameter "Use available quantity" (in this XML described as
<UseAvailableQuantity>), you can set these values:

• 0 : this disables Keep track of stock.
• 1 : this enables Keep track of stock (used in above XML example).
• 2 : this deletes the substrate size (for example because all left-over pieces have been used

in production).
• 3 : same as value 2.
• 4 : this disables Keep track of stock and removes the substrate size if the quantity defined

in the XML <=0.
• 5: this enables Keep track of stock and removes the substrate size if the quantity defined

in the XML <=0.

Note:  When using the values 4 or 5, the MIS (business system) only needs to pass 1
parameter to manage the stock: the one that maps to Available quantity. And when that
quantity is <= 0, Automation Engine will also remove that substrate size. That way, there is
no need for the MIS to explicitly mention the value 2.

So depending on the logic the MIS applies,

• it can either use the value 0 or 1 and at a certain time also use 2 if it wants to remove a
substrate size. Automation Engine then does not remove the substrate size unless it is
explicitly told so (by that value 2).

• or the MIS can focus on the value of the available quantity and in its XML consistently
use the value 4 or 5. When that available quantity reaches <=0, Automation Engine then
automatically also removes the substrate size.
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Important Note when you used this task before v 14.1

In Automation Engine v 14.0 this task was named "Import Sheet Sizes from XML". In v 14.1,
dedicated support for roll sizes was added and this task was renamed to "Import Substrate
Sizes from XML".

Also, since v 14.1, the default ticket for the task Import Substrate Sizes from XML
was adapted: SheetSize was renamed to Size, Sheet Name was renamed to Name,
SheetHeight was renamed to Height and SheetWidth was renamed to Width.

This means that if you used the default ticket in v 14.0, that the default ticket in v 14.1 will
generate an error.

To correct this situation, choose one of the following approaches:

• adapt the XML files to make sure they use the new names (advised).
• copy the default ticket to a new ticket, adapt the names to the old names and use this new

ticket.

14.5.3.  Create Tiles

Use this task to tile oversize graphics, used for example for billboards, into smaller graphics
to be printed. You can select the size and number of the tiles, and allow for an overlap if
necessary.

You can send these graphic file formats to this task:

• PDF (single or multipage),
• Normalized PDF (single or multipage),
• TIFF (CMYK or grayscale), 8-bit TIFF also supported.
• JPEG (CMYK or grayscale. RGB JPEGs result in CMYK PDF. Progressive JPEG compression is

not supported),
• PSD (CMYK or grayscale).

Note:

• For each image file or single page PDF, the task outputs a multipage PDF in which each page
contains a tile.

• For multipage PDFs, the task outputs a multipage PDF (in which each page contains a tile)
for each page of the input multipage PDF.

1. In Method, choose how to determine the number and size of the tiles:

• If the tile size is the most important (if for example you can only print a certain size),

choose Use Fixed Tile Size and enter the horizontal  and vertical  Tile Size.

Note:  The last tiles might be smaller (depending on the tile size and the size of the
original file).

Select Allow Rotation if you don't mind having the graphic rotated by 90 degrees in case
this fits better and generates less tiles.

• If the number of tiles is more important to you than their size, choose Use Grid and

enter the Number of Tiles you want horizontally  and vertically .
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• If you don't know the exact number or size of the tiles you want, but you can only
print up to a certain size, choose Automatic Tiling and enter the Maximum Tile Size

horizontally  and vertically .

The number and size of the tiles are calculated to have the least waste and the least tiles
possible, within that maximum size.

All tiles will have the same size, except when adding an overlap (see below).

Select Allow Rotation if you don't mind having the graphic rotated by 90 degrees in case
this fits better and generates less tiles.

• If you have a tiling template that you have created in i-cut Layout and want to use here,
choose Use Template and select your template in the Template list.

Note:

To do this, you need to:

1. Make sure your i-cut Layout application is connected to your Automation Engine
server.

2. Create and save the template in i-cut Layout (this automatically saves it to
the correct location on your Automation Engine server: \\AEservername
\bg_data_custom_v010\dat\tiling).

See the i-cut Layout manual for more information about connecting to an Automation
Engine server and creating a tiling template.

With a tiling template:

• you can see exactly how your graphic will be tiled when creating the template in i-cut
Layout (if you create the template from the same/a similar graphic that you will use in
Automation Engine),

• you make sure you have consistent tiling in i-cut Layout and Automation Engine (for
example if you use i-cut Layout for some graphics orders and Automation Engine for
others).

Attention:  If you want to add overlaps to your tiles when using a template,
you need to already add them in the template in i-cut Layout. You cannot add
overlaps to tiles created from a template in this Create Tiles task.

If you enable Fit graphics to grid, your graphic will be scaled to match the grid size, both
vertically and horizontally. This can result in non-proportional scaling!

2. Open Tiling Sequence... to define the sequence of the tiles (not available when you use a
template).
a) In Tile Start Position, select where you want the first overlap to be: on the top left ,

top right , bottom left  or bottom right  tile.

Note:

You can use SmartNames for most options of this dialog. For button options like Tile

Start Position, Direction and Pattern, you can set a SmartName by clicking , and
edit it by clicking Edit...
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Tip:

To know what the SmartName should resolve to to get a certain value for a parameter,
do the following:

1. Right-click the parameter value and select Copy Parameter Value.

• For a parameter with a field to edit (like Overlap), enter the desired value in the
field then right-click in that field.

• For a parameter with buttons (like Tile Start Position), right-click the button of
your choice.

2. Paste this in a text editor.

For example, the SmartName to get a top left  Tile Start Position should resolve
to tl.

b) In Direction, select whether the overlaps should run horizontally  or vertically

.

Depending on the Tile Start Position you chose, horizontal overlaps can run from left to

right  or from right to left , and vertical overlaps can run from top to bottom

 or from bottom to top .
c) In Pattern, choose whether you want the overlaps to run snake-wise  or in zig-zag

.

The exact snake-wise or zig-zag pattern depends on what Tile Start Position and
Direction you selected.

For example, when starting on the top left tile  and running horizontally  with

a snake-wise pattern , you will get something like this:
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We advise that you run a test to determine exactly what pattern works best for your
graphic.

Note:  When using overlaps, the direction is often decided by physical laws like the
direction of rain and wind.

Note:  When using a vertical snake direction, the tiles in the uneven columns will be
rotated 180 degrees. This is done to optimize color consistency between rows when
printing on large printers. You can see this rotation in their page in the output multipage
PDF and also in the tiling report. See this illustration where 2 columns of tiles will be
created with a 180 degree rotation:
 

 

3. Define what to use as Cut Path.

Note:  Whereas the Prepare Graphics for Nesting task allows you to generate a cut path if
the graphic doesn't contain one, the Create Tiles task needs the cut path to be already
available, either as an ink or by using the trim box as cut path.

Note:  The task actually checks this information first because it is the cut path that decides
the size of the input graphic that should be tiled. This overall size then influences the
required number of tiles (unless you set a fix number).

If you want to... do the following...

use an ink as cut path 1. Enter it in the Cut Path field.
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If you want to... do the following...

Tip:

• If the ink used for the cut path has different names in
different input files (for example if you have customers
from different countries using names like cut,
découpe, taglio...), you can add several ink names,
separated by a comma ( , ).

The order you use is important as the task will use the
first ink it finds in the list as cut path!

• You can use wildcards and/or use SmartNames to
define ink names. For example use Pantone* if you
want to use any Pantone ink used in the file as a cut
path.

Tip:

When building a workflow using an example file, click  to
select one or more of the inks from the example file.

If you always receive CMYK graphics with one spot color
used for the cut path, select Any SpotColor.

2. Define what to do if the ink(s) you defined are not present
in the file:

• If you want to use the trim box as cut path instead,
select Create cut path from trim box if no ink is
found.

• If you don't want to use the trim box but want the task
to end in error, leave Create cut path from trim box if
no ink is found deselected.

use the trim box as
cut path

Leave the Cut Path field empty.

If you always want to use the trim box as cut path (usually
for rectangular graphics like business cards), you don't need
to select Create cut path from trim box if no ink is found
(as this option is only applicable when you want an ink as cut
path as your first choice).

The task will tile the graphic that is inside the cut path. The tiles created will have a cut path
in the same ink as the input graphic's cut path (if the cut path is created from the trim box,
this will be the Cut ink.

4. Graphics for large banners or billboards are often not supplied in the size at which they will
be printed. In that case, you can Scale the tiles here.
For example, enter 1000% if your input graphic is only 10% of the size you will need it to be.
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5. If the input file (the non-tiled full graphic) has a bleed, the resulting tiles will show that bleed
on their outside sides (except those surrounded by other tiles). You can limit that bleed on
the tiles by setting a maximum bleed in Bleed Clipping Mask.
See this example of a full graphic with a bleed. The trim box is shown in red. This graphic
will be tiled in 4 tiles:
 

 
Here is the below left tile:
 

 
In this example the bleed of the full graphic is similar to tile's overlap. But sometimes this
bleed can be too large for a tile. That is why you can reduce that original bleed by setting a
Bleed Clipping Mask on tile level.

Note:  In i-cut Layout, in the Tiling dialog, this same function is named Tile Bleed.

6. If you want, you can add SmartMarks to the tiles. SmartMarks sets can be created in i-
cut Layout or PackEdge. We advise to create them in i-cut Layout because it offers extra
SmartMarks fields that are specific for tiling.

You can for example add SmartMarks containing glueing instructions in the overlap zones.
Below page illustrates a typical example.

7. If you want to include overlaps (we mentioned a few types when introducing Tiling on page
872), select Add Overlap and click Options...

a) Enter the Overlap Distance.
b) You can choose to add an Overlap on both sides of each tile (using the overlap distance

on both sides).
In this case, you can not add a glue area.
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c) If you want, also add a Glue Area.
This is an extra area that is not printed:
 

 
d) Click OK.

Attention:  Adding overlaps and glue areas increases the size of a tile (except if it
is the last one on the grid). If you selected the tiling method Use Fixed Tile Size or
Automatic Tiling, you should take these extra distances into account.

8. If you want a report detailing how the graphic was tiled, select Create tiling report and click
the Options... button to define some options like the report Size and the used Units.
See (part of) an example of a report in below described example.

Example of SmartMarks for Tiles

Concept
This page shows how to add specific tiling related information into the glue or overlap areas
of a tile. A typical example is to put the number of the neighbouring tile in this area. This helps
those who apply the tiles.

See this (first page of a) tiling report where we added red squares to help you recognize the
SmartMarks we added:
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Notice that tile nr. 3 only has these marks in its glue area on the right. This is because the
SmartMarks know that this tile has no glue area on any other side.

The next image zooms in on this mark (a view from I-cut Layout or PackEdge), both in contour
and preview mode. Its shows an overlap of 10 mm and a glue area of 20 mm. Notice that the
text appears mainly in the glue area, but also partially in the overlap. And to make sure it can
always be read, a white rectangle is placed behind the text area:
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How to Create this SmartMark Set

Note:  In below instructions, we assume you have basic knowledge of both i-cut Layout and
SmartMarks.

Follow below steps to create a set of SmartMarks as shown above.

1. You can use any of your files that may need tiling. Choose one and write down its size (V-H).
2. In i-cut Layout, create a New layout. Set the height and width to that of the file you choose

to use. In our example we will create a layout of 4000 mm by 6000 mm. The name or place is
not important. Click OK.

3.
In Graphics mode, click on  to Add a Graphic. Select the file you chose in
step1 and click OK.

4. In the list of Graphics, double click the thumbnail of the graphic.
5.

While in Graphic View ( ), choose Tools >  Tiling.
6. In the Create Tiling Grid dialog, specify a number of tiles: set 3 vertical and 3 horizontal

and click OK.
7. In the Tiling dialog, select Include Overlaps and click on Set Up Overlaps.... Set an

Overlap of 10 mm, deselect Overlap on both sides and set a glue area of 20 mm. Set a Tile
Bleed of 3 mm (though we will not use this in the SmartMark). Keep the dialog open.

8. Select a tile that is surrounded by other tiles on all 4 sides. The Tiling dialog shows the
settings for this tile:
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The SmartMark set that we will make needs to add marks on every overlap that the tile has,
no matter what tile it is, so no matter of that tile has overlaps on one or two or more sides.
To do this, we need to simulate a tile that has an overlap on all 4 sides.

9. Select the central tile (tile 5). In the Tiling dialog, make sure all 4 sides have an overlap.
Based on above example, you therefore need to manually add a 10 mm overlap to also the
left and bottom side:
 

 
We can now use this tile 5 to create our SmartMark set.

10.In the Tiling dialog, click on Create Tiles. The 9 tiles are created and added to the list of
Graphics.

11.In the list of Graphics, scroll down to tile 5 and double click its thumbnail to open it . Then
go to Production >  SmartMarks. See how the  SmartMarks dialog already shows many
named objects, including 4 Overlap and 4 Glue objects.
 

 
12.We now start adding the marks. We start with the one on the right side, though the order

is not important. In the SmartMarks dialog, select the named object Right Overlap, then
click on  and choose to add a Text Mark.

Note:  In this example, we will position the text inside the overlap area. You can also put it
in the glue area, but often users avoid any printing the glue area.

13.In the Text Mark dialog,

• As Text: keep Automatic Size selected and add the text as shown below. To insert the
smart text fields, click on Smart Text, scroll down to the category i-cut layout, choose
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tiling and in  Options, choose to insert (in two times) [Right Tile] and [Current
Tile number].
 

 
Click on Style, set the font size to 36 and align the text centered (H & V).

Note:  This font size may be too large when you create tiles with smaller glue areas. This
could cause the text to enter in the tile area itself. To avoid this, choose Smart Text and
in the category Typographic choose Automatic Point Size and set a minimum and
maximum size.

• In Inks, choose Darkest to avoid too much ink in this glue area. Also select Ignore
Technical Inks.

• In Position, attach this text mark to the Right Overlap. Position it as shown below. Add
a small offset versus the (left) end of the overlap area. Make sure you rotate the text 90
degrees.
 

 

Click Apply.

14.As good practice, rename the text mark to a logical name like "Text Mark - Name of
Right Tile". To do this, select the text mark, then right-click it to enable renaming it.

15.Now add a white rectangle below this text box. Add the mark of category rectangle and
manually drag and drop it onto the text mark. It should appear as shown here:
 

 
In the SmartMark Options - Rectangle dialog:

• in the Rectangle tab: select Fit (to object) to create a rectangle that adapts to the text
box (both V and H). Set an Extra Height and Width of 1 mm.
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• in the Inks tab, select Knockout.

• in the Position tab, position the rectangle central versus the text mark object.
 

 

Click Apply.

16.Save your SmartMarks set with a logical name.
17.Now repeat the above steps 11 to 14 for the 3 other sides.
18.Save your SmartMarks set again (and close i-cut Layout).
19.In Automation Engine Pilot, test this SmartMarks set by using it in the Create Tiles task.

14.5.4.  Submit to Gang Run

Use this task to submit a graphic file to a substrate queue, where it will be nested with other
graphics to optimize substrate usage.

You can also submit ARD files (1-up CAD). This is useful for example when you want to fill a
sheet with samples of shapes and send that merged resulted to a Kongsberg cutting table to
cut these samples.

In this task, you can specify parameters (quantity, scale factor...) for nesting graphics based on
their cut path.

You can send these file formats to this task:

• TIFF (CMYK or grayscale),
• JPEG (CMYK or grayscale, progressive JPEG compression is not supported),
• PSD (CMYK or grayscale),
• PDF (single page or multipage),
• Normalized PDF (single page or multipage),
• ARD files (1-up CAD).

Learn more in:

General Tab on page 930

Back Tab on page 932

Substrate Tab on page 933

Extra Tab on page 933

929



14 Automation Engine

General Tab
1. Define how many of each input graphic you want to print.

You can either:

• Enter the Quantity to print.
• Select Maximum Fill if you want to print as many copies as will fit in one sheet.

2. Typically, graphics for large banners or billboards are not supplied in the size at which they
will be printed out. In this case, you can Scale them up here.
For example, enter 1000% if your graphic is only 10% of the size you will need it to be.

3. Define the Rotation. This is helpful when all or some of the graphics are only allowed a
specific rotation.
You can either:

• Use the rotation that was Set by the Substrate Queue.
• Force a 0, 90, 180 or 270 degrees clockwise rotation. This choice overrules the substrate

queue nesting settings.
• Force Allow Any Angle: You don't care, you let the software decide. Also this choice

overrules the substrate queue nesting settings.
• Select a SmartName.

Note:  The Gang Run Printing view also shows the rotation for each entry in that queue.

4. Define what to use as Cut Path.

Note:  Whereas the Prepare Graphics for Nesting task allows you to generate a cut path if
the graphic doesn't contain one, in the Submit to Gang Run task the cut path needs to be
already available, either as an ink or by using the trim box as cut path.

If you want to... do the following...

use an ink as cut path 1. Enter it in the Cut Path field.

Tip:

• If the ink used for the cut path has different names in
different input files (for example if you have customers
from different countries using names like cut,
découpe, taglio...), you can add several ink names,
separated by a comma ( , ).

The order you use is important as the task will use the
first ink it finds in the list as cut path!

• You can use wildcards and/or use SmartNames to
define ink names. For example use Pantone* if you
want to use any Pantone ink used in the file as a cut
path.
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If you want to... do the following...

Tip:

When building a workflow using an example file, click  to
select one or more of the inks from the example file.

If you always receive CMYK graphics with one spot color
used for the cut path, select Any SpotColor.

2. Define what to do if the ink(s) you defined are not present
in the file:

• If you want to use the trim box as cut path instead,
select Create cut path from CAD object or trim box if
no ink is found.

• If you don't want to use the trim box but want the
task to end in error, leave Create cut path from CAD
object or trim box if no ink is found deselected.

use the trim box as
cut path

Leave the Cut Path field empty.

If you always want to use the trim box as cut path (usually for
rectangular graphics like business cards), you don't need to
select Create cut path from CAD object or trim box if no
ink is found (as this option is only applicable when you want
an ink as cut path as your first choice).

gang run ARD files ARD files can only be submitted when the field Cut Path
from Ink is left empty and when the option Create cut path
from CAD object or trim box is selected. When this is not
the case, the submit task ends in error with the message
"Only default cutting path is allowed".

5. If you want to set a due date (when the sheet with the nested graphics needs to be printed),
select Due Date and choose when you want the due date (and time) to be.

• If you set a due date, the nesting server will always generate a nested layout that includes
this graphic before your due date, even when the minimum fill has not been reached.

Tip:  In your substrate queue settings, you can choose to generate the nested layout
and send it to the output workflow a specific time before the due date. This allows time for
printing, finishing, packing...

• If you don't set a due date, the nesting server will only generate a nested layout when
the minimum fill is reached.
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Select... to...

Immediate generate a nested layout including your graphic immediately
(this is the same as when you use Print Now in the Gang Run
Printing view).

Today set the due time to a certain time today (this is the default
option).

The nesting server will generate a nested layout including your
graphic the specified amount of time before the due time.

Tomorrow set the due date to a certain time tomorrow.

The nesting server will generate a nested layout including your
graphic the specified amount of time before the due time.

In ... hours set the due time a certain number of hours after the task is
launched (you can set this with a SmartName).

In ... days set the due date a certain number of days after the task is
launched (you can set this with a SmartName).

You also need to set the due time.

On set the due date to a specified date (and time) in the future.

Job due date set the due date to the due date specified in the Job setup (only
valid when the graphics are stored in a Job folder).

Select
SmartName...

set the due date using a SmartName.

This opens the SmartNames dialog where you can select your
SmartName.

Note:

• See the separate chapter SmartNames for information about
SmartNames and how to create custom ones.

• Your SmartNames must resolve to a value in
the ISO 8601 standard format (for example
2014-09-27T11:08:00+02:00).

• If your due dates are supplied in a different format (for
example 27/09/14), use the formatting options for date and
time SmartNames to convert this format to the ISO standard.

Back Tab
• You can here specify what to print on the back of each graphic:

932



14Automation Engine

• No graphics: choose this if you don't want any back side for the graphic.
• Even pages of multipage file: choose this to print the odd pages of the file on the front,

and the even pages on the back (this only works with multipage PDFs).
• Graphics from front side: choose this to print the same graphic on the front and on the

back.

If your graphic has an irregular shape, you can select Flip horizontally so both graphics
face the same direction and have the exact same contour for cutting.

Note:  If your graphic contains text, you shouldn't flip it as this will make the text
unreadable.

• Other graphics: choose this to print different graphics on the back, and Browse to these
graphics.

Tip:  Give the graphics to print on the back a consistent name, and use SmartNames to
retrieve them (for example, [File]_back.[Extension of File]).

Substrate Tab
1. Choose the Substrate Queue to send your graphics to.

Attention:

You should choose (one of) the substrate(s) you have defined as a substrate queue in
the Gang Run Printing view.

If you submit your graphics to a non existent substrate, a substrate queue will
be created automatically for this substrate, but it won't be ready to process your
graphics (so your graphics will be stuck in the queue until you configure it properly).

2. If this substrate has several sizes defined, you can choose the name of the Substrate Size
to use.
Leave this on Any to let Automation Engine find the best fit.

Attention:  You here define the Name of the substrate size as defined in the setup
of the substrate queue. Do not enter actual size information here.

Extra Tab
In this tab you can enter:

1. A Customer ID identifying the customer who ordered the graphics. Whether it is also used
as a grouping key is one of the settings the Configure tool.

2. An Order ID: Every graphic file that you here submit with the same Order ID will show up as
part of one same order in the Orders View. When working with the Job concept, a logic value
would be the SmartName [Order ID]. When you don't enter a value, a system generated
ID will be used.

3. Your desired values for the custom fields that you defined in the Configure tool.

You can use both customer ID and custom fields either as:

• labels in the reports from the nested layouts or the graphics ,
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• grouping keys to define which graphics can be nested together.

Example 1: Using Custom Fields as Labels
You get graphics orders from national and international customers. You are using different
shipping companies for national and international orders.

When generating layouts, you want to indicate which graphics are for national and for
international shipping, so the cutting operator can store the finished graphics in the right
places.

1. In the Configure tool, define a Custom Field as Shipping.

The corresponding Custom Field parameter in this task tab will now be called Shipping
instead.

2. When launching the task on graphics from international orders, enter International in
that parameter, otherwise enter National.

3. In your output workflow, choose to generate a layout PDF report in the Export Nested
Layouts task.

4. In the layout report, you will see for each graphic name:

• the label National if the copies of this graphic need to be shipped nationally,

• the label International if the copies of this graphic need to be shipped internationally.
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5. If you open the report in an application that can show PDF layers (for example Adobe
Reader), you will see that the report has a layer called Shipping.

If you hide the layers above this layer (so it only shows the layers Base and Shipping), you
will see that:

• graphics that need to be shipped nationally are shown in the color of the National label
(purple in the example below).

• graphics that need to be shipped internationally are shown in the color of the
International label (green in the example below, cut paths are shown in red).

 

 

Note:  The way the software chooses the 'random' color for the color patches is identical
to how it is done when SmartMarks can use a "random color based on". A specific value
(text?) will always return a same color based on that value.

Example 2: Using Custom Fields as Grouping Keys
You need to print different graphics on the same substrate, but some will need to be laminated
and some not.

1. In the Configure tool, define a Custom Field as Lamination, and select Use as grouping
key.
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The corresponding Custom Field parameter in this task tab will now be called Lamination
instead.

2. When launching the task on graphics to be laminated, enter Yes in that parameter,
otherwise enter No.

3. The nesting server will generate layouts with either:

• only graphics to be laminated,
• only graphics that shouldn't be laminated.

Note:  If you generate a layout report, it will have the label Yes if the graphics on that layout
need to be laminated, No if they don't.

See an elaborate example on using grouping keys and how they show up on reports in step 10
of the below example on Working with Grouping Keys on page 973.

14.5.5.  Submit XML to Gang Run

Concept
The Submit XML to Gang Run task was designed to enable a business system (MIS, ERP...) full
interaction with Automation Engine's Gang Run Printing mode.

The business system writes an XML file that serves as the input file of the Submit XML to
Gang Run task. This XML is minimally a request for information about a nesting layout,
possibly of a combination of different graphics (known as ganging). The MIS can then interpret
the detailed response XML that it gets back (for example if the waste factor is acceptable).
The MIS so decides if and when to re-send that XML file, but now using an extra option to also
request links to the actual production files of the nested layout(s).

Let's have a closer look at the two main steps in this process:

• Request for Nesting information

To assist with estimating the cost of producing specific jobs, the MIS asks Automation
Engine's "Nesting Server" a detailed calculation of a layout of (a batch of) graphics on a
specified Substrate Queue. The business system wants answers to these questions: How
much material will be consumed with this substrate size and this quantity? What will be the
waste factor?
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The nesting server calculates and creates the requested layout files and also launches its
assigned output workflow. The XML attribute production="FALSE" indicates that the
response XML can happen immediately, because it does not have to wait for the production
files to be created. The MIS interprets the Response XML.

• Request to Nest and Produce

When the XML contains the attribute production="TRUE", the response XML will contain
links to the production files. To enable this, the response XML is only sent when the
workflow that created them has finished.

 

 

Using the Submit XML to Gang Run Task
The task ticket has no interface options. Everything needs to be defined in the input XML file.

As usual, this task can also be triggered by the external system, for example by using a Folder
Access Point.
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Here is some background on what happens when the task is launched:

• The graphics ("<jobs>") listed in the XML enter into the specified Gang Run Substrate
Queue(s).

• The "Nesting Server" starts calculating possible layouts. Depending on any specified
grouping keys (learn more in Working with Substrate Queues) it is possible that other graphics
that were already present in those substrate queues join the nested layout.

• The nesting server decides and creates an optimized layout.
• When all graphics ("<jobs>") for a certain NestingRequest have been placed, a

NestingResponse output XML file is written (on the requested location defined in the
input XML file).

• The MIS monitors the URL that it specified as ReturnURL and reads the NestingResponse
XML as soon as it becomes available.

Note:  As with the Submit to Gang Run task , the "<jobs>" listed in the XML can also refer to
ARD files.

Examples of a Nesting Request XML

Example Nesting Request for 3 Jobs and 2 Substrates

In our example, your customer with ID 123456 asks you what it will cost to produce the
following items, before noon of 5th of June of 2014:

• 10 items of AmericanCars_7 on Dibond-4mm, 1100x2400 mm
• 12 items of AmericanCars_2 on Dibond-4mm, 600x1100 mm
• 12 items of AmericanCars_1 on Forex-3mm, any size

Your company's sales price will depend on how much it will cost yourself to produce these
items. Surely, you want to produce them the most cost-effective way. To get this information,
your MIS creates this XML file:
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Note:  This example shows that a NestingRequest can contain multiple jobs, possibly on
multiple substrates, possibly on a specified, a non-specified or on multiple substrate sizes.
This allows the XML to describe a production order containing multiple components as 1
NestingRequest.

This is a conceptual difference with the Submit to Gang Run task, which can also report back an
XML file but always on 1 single job. The nature of the XML version of this task is the ability to
calculate and feedback on batches of jobs.

Examples with front and back graphics:

Attention:  In the 2 below examples, only one <JOB> element of the XML is shown:

• Using the same graphic on the back but flipped:
 

 
The same graphic is used a back-graphic, but will be flipped.

• Using a specific graphic for the back and filling the sheet:
 

 

Nesting Request for a Roll substrate

There is no difference in the nesting request XML when the substrate is a roll.

XML documentation

Technical summary
The Submit XML to Gang Run task always outputs a return XML. Its path is specified by the
ReturnURL= element in the input NestingRequest XML.

Once the nesting request has been processed fully, the nesting server writes a
NestingResponse_[date].xml file in the specified ReturnURL folder. This response can
always be linked to the original request via the id= attribute. The (MIS) system that submitted
the NestingRequest should monitor that ReturnURL folder and so pick up the response to
its request.
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When adding the attribute production="TRUE" to the input XML, the return XML will also
include references to the actual production files.

Documentation of the XML for the Submit XML to Gang Run task

XML Element Description

NestingRequest
(mandatory)

Mandatory root element (max 1). Many sub elements can be specified
directly under this element and/or under a sub-element JOB. In the first
case they serve as 'global' parameter, in the second as a job-specific
one. A job parameter overrules a same type already specified 'globally'.

Id  (mandatory) The Id attribute of the element NestingRequest comes back in the
NestingResponse output XML file. Based on this Id, the MIS knows
which response matches which request.

ReturnURL A file:-based URL that specifies the folder where the
NestingResponse output XML file will be written once all jobs have
been nested.

production="FALSE" Attribute of the element ReturnURL. Default setting.

production="TRUE" Attribute of the element ReturnURL. As described in Concept, this
attribute means that the response XML will wait for the workflow to
finish to also add the references to the files produced by the Export
Nested Layouts task.

DueDate To be defined in ISO 8601 format.

GroupingKey(n) Add up to 4 grouping keys to help control groups of nested jobs.

Tip:  Using the NestingRequest Id as grouping key prevents these
jobs from being nested with any job that is not part of this request.

JOBS (mandatory
when more than
1 JOB element)

Contains one or more JOB element(s).

JOB (mandatory) Contains the definition of a graphic. At least 1 JOB element must be
present.

FileName 
(mandatory

A file:-based URL indicating the one up graphics to be nested. A sub
element of a JOB element.

Substrate The name of the Substrate Queue that will calculate the layout(s).

Attention:  This element can be specified as global setting
under the NestingRequest element. When it occurs under
a JOB element, it is valid for that job only, and overrules any
global values appearing under the NestingRequest element.

SubstrateSize The name of the sheet or roll Size of the specified substrate queue.
Same remark as for Substrate: can be used as global or job element.

Quantity Desired quantity for the specified job(s). Same remark as for
Substrate: can be used as global or job element.

Rotation Rotation of the graphic. When not specified, the rotation setting
specified in the substrate queue ("nesting settings") will be used.
Possible values are:
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XML Element Description
• sub : use the rotation settings as defined by the substrate queue's

nesting settings.

• 0 or 90 or 180 or 270 : fixed rotation angle (clockwise). This will
overrule the rotation setting specified in the substrate queue's
nesting settings.

• any : this allows any rotation for the graphic. This will overrule the
rotation setting specified in the substrate queue's nesting settings.

Same remark as for Substrate: can be used as global or job element.

Scale To scale the graphic. Value unit is percentage. No scale = 100. Same
remark as for Substrate: can be used as global or job element.

DieShape The die shape for the graphic. Allowed values: the name of a spot color,
the keywords TRIMBOX , BORDERS or DEFAULT.

TRIMBOX (or BORDERS) will use the trim box of the PDF graphic.
DEFAULT will search for a CAD object inside the normalized PDF(STA)
file ; if no CAD object is found, the trim box will be used.

Bleed The amount of bleed (in mm) allowed outside the die shape. If no bleed
is specified, no bleed mask will be applied, unless the input is a PDFSTA
file, in which case the bleed setting from the PDFSTA file will be used.

Page Number Page selection of the multi-page PDF. Can only be used inside a JOB
element.

SameGraphic Value on 1 means that the (front) graphic defined in FileName will be
used as back graphic. Can only be used inside a JOB element.

FlipGraphic Only valid when value of SameGraphic is on 1. FlipGraphic on 1
defines that the back graphic will be flipped around the vertical axis
(mirrored). Mind not to flip graphics that contain text. Can only be used
inside a JOB element.

RectoVerso When the input file is a multipage PDF, this will use the uneven pages as
front pages and the even pages as back pages. This element overrules
any use of the elements SameGraphic and FlipGraphic. Can only be
used inside a JOB element.

BackGraphic A file:-based URL indicating the graphic to be used as back graphic.
Can only be used inside a JOB element.

Example of a Nesting Response XML
A NestingResponse XML file contains 2 main elements: Sheets and Jobs.

• The Sheets element describes which (part of) sheets were used to nest the given files. It
refers to the files by a <Job id=""> element.

• The Jobs element lists all jobs that were nested.

The below example shows these 3 sheet elements:

• The first sheet element states, in UsedSheets, that it will take 6 sheets of Forex-3mm
900x900 to deliver the wanted Quantity of 12 AmericanCars_1. The MIS can calculate
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that such a sheet places 2 of these graphics. The waste is 0,54 m2. The MIS can calculate
that this is 11%.

• The second sheet element states, in UsedSheets, that it will take 12 sheets of
Dibond-4mm 600x1100 to deliver the wanted Quantity of 12 AmericanCars2. The MIS
can calculate that only 1 fits on such a sheet. The waste is 2,56 m2. The MIS can calculate
that this is 32%.

• The third sheet element states, in UsedSheets, that it will take 2 sheets of Dibond-4mm
1100x2400 to deliver the wanted Quantityof 10 AmericanCars_7. The MIS can calculate
that such a sheet places 5 of these graphics. The waste is 0,82 m2. The MIS can calculate
that this is 16%.
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Response XML for a Roll substrate
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A response XML for roll substrates is the same as for sheet substrates, except for an extra
RollLength element in each Sheet Element.

An example (only one Sheet element is unfolded):
 

 

Example of a Response XML after the Production Workflow
As mentioned earlier, the NestingResponse output XML can be extended to contain
references to the actual production files.

Note:  Production files are the files generated by the Export Nested Layouts task, as part of
the Output Workflow of the Substrate Queue.

To do this, the MIS must add the attribute production="TRUE" to the ReturnURL element of
the NestingRequest XML.

An example:
 

 

As a result, each /NestingResponse/Sheets/Sheet element will be extended with a
FileList element.

For each production file, there will be a File element attached to the FileList element.

Example of a NestingResponse XML with references to production files:
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Using Workflow Parameters in this Process

Concept
Having these production files created on specific folders and with specific names will be
important for the MIS to recognize and read them.

You can organize the production files that were created by a NestingRequest by using
some workflow parameters that are available in the workflow that was launched on the
generated Nested Layout files. See an example below where we picked some from the list of
SmartNames.
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Also the Grouping Key's and custom fields used in the Submit to gang Run task can be used
to help determine names of folders and files. Note that these only appear in the list of
SmartNames after you first used that workflow ticket.

Example
• In Pilot > Configure > Gang Run Printing, we renamed the customfield 4 to OrderId and

confirmed that we want to use this field as a grouping key.

• In the Export Nested Layouts ticket of the workflow that the substrate queue launches on
the generated nested layouts, set up the Output Folder for the Production Files as in this
example:
 

 
 

 

Note:  Learn more about these SmartNames in this page about the 'Export Nested Layouts'
task.

• As a result, the production files are organized in a folder structure that makes it easy for the
MIS to find the files related to its initial NestingRequest:
 

 

Workflow Extensions

Concept

Production files that are mentioned in the NestingResponse output XML can then be picked
up again in an Automation Engine workflow for further processing. You can use the workflow
control Select Referenced File to do this.

Example workflow
This enables a lot of extensions to the workflow. In this example we select the production files
and ZIP them before sending them to an external system or partner. You can also choose to
delete those files locally.
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14.5.6.  Export Nested Layouts

Use this task to create production files (a PDF print file and a cutting file) from your nested
Gang Run Printing layouts.

Typically, the Export Nested Layouts task is the main step of your Gang Run Printing output
workflow.

When working with Gang Run Printing:

1. You submit the graphics to be nested and printed through the input workflow.
2. The nesting server automatically nests the graphics on the substrate, and sends the resulting

nested layouts to the output workflow that is linked to that substrate queue.
3. The output workflow generates production files from the nested layouts.

Note:  In a workflow, this task has five output pins: Print Files, Cutting Files, Offcuts, Inputs
and Error. This makes it easy to redirect each type of file to the right place.

If you ask to Create Reports, the task will show an extra output pin for these report files.

Attention:  The output pin Offcuts requires an 'Export Nested Layouts' ticket from AE
v18.1.1 or later. To see the 'offcuts' pin on workflow tickets that you made sooner, just
open and close that ticket to make this pin appear.

Learn more in:

• Production Files Tab on page 948

• Sheet Tab on page 950

• Reports Tab on page 953

Managing the Nested Layout PDFPLA files

The nested layouts that the nesting server creates are written as PDFPLA files on a central
folder. By default, this folder is ExampleJobContainer/SnDtemp. To optimize data traffic, we
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advise to have this folder on a disk away from your system drive. You can change this folder in
the configure panel.

These PDFPLA files are not cleaned up automatically. We advise to build this cleanup into your
output workflow. This is easily done as in below example, where you delete this PDFPLA input
file that arrives on the "Inputs" output pin:
 

 

Production Files Tab
The task will output:

• PDF print files that are to be printed. When the input PDFPLA file only contains CAD data
(you only submitted ARD files to the Gang Run), the option Save Print Files is skipped.

• Cutting files. These are used by cutting tables to print the printed sheet or roll. There are
many formats available.

Note:  Every resulting layout is a single page PDF print file, unless you are printing front and
back (in which case the back graphic(s) will be on a second page).

1. In Save Cutting Files, choose the cutting file format you want to generate (i-cut, HPGL,
PDF, MFG, ACM or JDF for Kongsberg cutting tables or JDF for guillotine cutters).

Tip:

• If you have several cutting tables and you don't know yet which one you will use, you
can generate several file formats: choose Select File Types..., select all the file types you
want to generate and click OK.

• If you want to check your cutting files for quality control, you can also output a PDF file
and inspect it in Acrobat.

When generating an ACM file (for an Esko Kongsberg table), you can select Print Side Up to
cut with the print side visible.

For all cutting file types except JDF, you can influence the knife or cutting head's cutting
sequence:

• Leave Sequence lines deselected if you want to use the original cut paths for the cutting
lines (this way, common lines between graphics are only cut once, but every graphic is
still cut individually).
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• Select Sequence lines if you want the vertical and horizontal cutting lines to be
concatenated so that the knife can cut longer lines at once (the cutting process is
faster when the knife doesn't need to be lifted and brought down, and accelerate and
decelerate many times).

 

 

If you selected Sequence lines, you can choose to Cut Across Gaps to cut longer lines at
once even if there is a gutter between your graphics.

Attention:

When you export an i-cut file, make sure you have i-cut marks in your file as they
are needed to define where to start cutting.

Other SmartMarks in your file will not be used for that purpose when working with
an i-cut file.

Learn more about i-cut marks in the i-cut Layout manual.

Note:  When the PDFPLA only contains CAD data (you only submitted ARD files to the Gang
Run), then all structural lines get exported when choosing MFG or ACM (using the default
ArtiosCAD sample making output). With all the other cutting formats, only the cut and
crease lines get exported.

2. By default, all inks with the ink type "technical", including the ink used for the cut path,
are considered structural inks, and are included in the cutting file but not in the print file.
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If you want to include other inks from your graphic in the cutting file but not in the print file,
enter their names in Add Extra Structural Inks.

When adding several inks, you should separate their names with a comma, for example
Crease,Kiss-cut. You can also use wildcards (*) and SmartNames.

3. If you want to give your output files a specific name, enter it in Output Name. By default,
the output files have an automatically generated name containing unique identifiers. The
default ticket proposes you to use smart workflow parameters. It also proposes to end the
name with a unique ID like [ Short Task ID ]. This will prevent that output files overwrite
each other (which can happen for example when several layouts are generated):
 

 

Table: Meaning of SmartNames useful in this workflow:

SmartName (wfp) meaning

substrate This is the name of the substrate queue.

substrate.size This is the name of the sheet (or roll) size.

substrate.size.quantity This is the number of times the nested layout
needs to be printed in order to get to the requested
quantity of the submitted graphics.

substrate.size.type This is the substrate type: Sheet (value P for plano)
or Roll (value R).

customer.id Mind that this one will only appear when you
selected the option Use the Customer field as
grouping key in the Configure tool. This is the one
you used as ‘CustomerId’ in the Submit to Gang Run
task (tab 'Extra').

Note:  When multiple copies of the same layout need to be printed, the number of copies
will automatically be added to the PDF file name.

4. Define where to save the production files and the report(s):

• If you want to save all output files in the same folder, select Save all files in the same
folder, and browse to that Output Folder.

• Otherwise, deselect Save all files in the same folder and browse to your specific folder
for the Print Files, Cutting Files and Report Files.

When you didn't specify an output folder, the files are by default written in
\ExampleJobContainer\SnDTemp .

Sheet Tab
1. If you want, you can add SmartMarks to the nested layout (a SmartMarks set that you

created in i-cut Layout or PackEdge).
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You can for example use a SmartMarks set containing registration and/or cut marks. You
can use SmartNames to enter your SmartMarks set's name.

2. When the nesting server generates a nested layout, it places the layout on the sheet based
on the settings of the substrate queue (sheet size and margins and nesting settings).

However, for printing and finishing purposes, you may want to reposition the nested
layout on the sheet. In Center Layout on Sheet you can choose to center the layout either
Vertically, Horizontally, or Vertically and Horizontally.

In the example below, the nested layout (left) has been centered both vertically and
horizontally (right).

 

 

Attention:  The option is ignored when an offcut area has been found. Learn about
offcuts in the page about offcuts (part of the nesting settings of a (sheet) substrate
queue).

3. If you are working with substrate rolls or large sheets, you can choose to fit the final PDF
that will be printed (the "sheet" file containing your nested layout) to one or both of the
layout's dimensions.

This way, you can cut closer to the layout and have less substrate waste (for rolls) or save
the remaining blank area as an offcut so you can reuse it (for large sheets).

For Fit Sheet, choose either:

• To Layout Height to fit the sheet height to the height of your nested layout.
 

 

• To Layout Width to fit the sheet width to the width of your nested layout.
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• To Layout Width & Height to fit the sheet height and width to the height and width of
your nested layout.
 

 

Note:  When using the option Fit Sheet, no offcuts will be generated.

4. If you are printing front and back, define how the sheet will be turned in Backing Up: either
Work-and-Turn or Work-and-Tumble.

This influences how the back graphics will be placed in your final PDF.

Front (at left) and back (at right) with Work-and-Turn:
 

 

Front and back with Work-and-Tumble:
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Reports Tab
Reports can help production and finishing and can also serve as feedback to your business
system.

XML Reports
• Select For every layout if you want an XML report describing the layout: its size and

substrate, the graphics used, their quantity, cut files, URLs, etc.

• Select For every graphic if you want an XML report of each graphic used in that layout.
This file describes the layout that this graphic was used in, how many times it was used,
remaining quantity, etc.

Example of XML Report of a Layout:
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Table: Clarification of above XML Report of a Layout

Part of
Element

Element Meaning

LAYOUT TotalLength In mm, the total length of the cut path. This enables to get an idea
how long a cutting table would take to cut this path.

LAYOUT COPIES The amount of times that his layout will need to be printed (as
calculated by the nesting server).
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Part of
Element

Element Meaning

LAYOUT YIELD The surface of used substrate material by this layout ((WIDTH *
HEIGHT) * %)). The % of used material is shown in the PDF report
( ).

JOB NUMBERUP Amount of times this <JOB> (graphic) is present on this layout.

JOB REMAINING Amount of times this <JOB> (graphic) still needs to be printed to
produce the requested amount.

JOB VSIZE and
HSIZE

In mm, V and H size of surface that this <JOB> (graphic) occupies
on this layout (bounding box), before any rotation. See also below
illustration.

POSITION V and H In mm, V and H position of this <JOB> (graphic), calculated from
the top left of he bounding box of the graphic to the top left of the
layout. See this example (to keep the overview, all cut paths were
based on the graphic's trim box and not on 'white background'):
 

 

JOB Folder URL of file that was submitted to the nesting server. This is typically
the output file of the Prepare Graphics for Nesting task.

JOB ExtId Esko internal ID, not useful to non-Esko systems.

JOB ForceOut Y indicates that this layout was made after someone used the Print
now button or after a deadline was reached. This element is not
present when the layout was made because the nesting server
reached a minimum fill.

JOB Id Esko internal ID, not useful to non-Esko systems.

JOB PageCount Total number of pages of the file in JOBNAME.

JOB PageNr Number of page of file in JOBNAME that was placed on this layout.

JOB Rotation Rotation of this graphic as it was set in the Submit to Gang Run
task. Sub means "Set by Substrate Queue", Any means "Force
Allow Any Angle" and 0, 90, 180 or 270 (clockwise) means those
specific angles were decided there. See in above illustration how the
rotation is done using the top left corner as axis.

JOB Substrate Name of the substrate queue that this layout was made for.
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Part of
Element

Element Meaning

JOB SubstrateSize Mind that this is the name of the substrate size as defined for that
substrate queue.

Example of XML Report of a Single Graphic:

 

 
In addition to above table for the XML report for layout, this table shows specifics for the XML
report of a single graphic:

Table: Clarification of above XML Report of a Single Graphic

Part of
Element

Element Meaning

JOB Quantity Remaining quantity for the nesting server to put on other layouts to
reach the requested amount for this graphic.

JOB DieShape Name of the cut path as defined in the Submit to Gang Run task.

JOB Bleed Maximum bleed for this graphic. This value is the one set as Bleed
Clipping Mask in the nesting settings of the substrate queue.

Layouts COPIES The amount of times that his layout will need to be printed (as
calculated by the nesting server).

Layouts NUMBERUP The amount of times this graphic is placed on this layout.

956



14Automation Engine

Part of
Element

Element Meaning

JOB ExtId Esko internal ID, not useful to non-Esko systems.

JOB ForceOut Y indicates that this layout was made after someone used the Print
now button or after a deadline was reached. This element is not
present when the layout was made because the nesting server
reached a minimum fill.

JOB Id Esko internal ID, not useful to non-Esko systems.

JOB PageCount Total number of pages of the file in FileName.

JOB PageNr Number of page of file in FileName that was placed on this layout.

JOB Rotation The value indicates the rotation of this graphic as it was set in the
Submit to Gang Run task. Sub means "Set by Substrate Queue", Any
means "Force Allow Any Angle" and 0, 90, 180 or 270 means those
specific angles were decided there.

PDF Report
A PDF report can be made For every layout. Such a report is typically used as instruction for
the cutting table operator.

The template of this PDF is fixed, but you can define:

• the Report Size (A4 or Letter),

• the Report Resolution used for the graphics preview in the report (in ppi),

• the Units used in the report (mm or inch).

An example:
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A PDF report shows following information:

• (on top) name of the layout and, when not 1, the amount of copies this layout needs to be
printed.

• preview and size of the layout
• an area with text:

• the first line mentions this information: name_of_substrate,
name_of_substrate_size, # =
amount_of_copies_this_layout_needs_to_be_printed,  used_material % , 
wasted_material %

• URLs to the print and cut file(s).

• below right, a thumbnail showing the back graphics ( ). When there are no back graphics, a
 icon is shown instead.

• a list of the graphics on this layout. Per graphic:

• a patch with an arbitrary chosen color that is also used in the PDF layer "Dummy
Colors" (learn more below),

• name and size of the graphic file on the layout,
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• amount of times the graphic is placed on this layout / total requested amount. When
maximum fill was chosen, only the amount in this layout is shown.

• (when used) custom labels: their name and a patch with an arbitrary chosen color. See
further below to learn how hiding PDF layers visualises which graphics have these labels.

Layers in Layout Reports

When graphics look much alike, it can be helpful to not see the preview but see dummy colors
in stead. This makes it much easier to see which one is placed where. An example:
 

 

In these PDF reports, the preview of the graphics is a separate layer. You can see or hide layers
by switching them on or off in Acrobat. You can also have your workflow create extra versions
of this report by removing the preview layer for example. See such a workflow in this step of one
of the examples at the end of this chapter.

Also the custom labels are shown in a separate layer (learn about custom labels in Overview of
Substrate Queue Entries on page 897). See this report example in Adobe Acrobat of a layout
containing graphics with two custom labels, one for finishing (need for lamination) and one for
shipping (type of transport). Only the Base layer and the Transport layer are shown:
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By hiding some layers, it quickly becomes visible which graphics need their transport by air and
which ones by road. This quick visual helps your colleagues in the packing and shipping.

See more examples of PDF reports in Step 10 of the example on Working with Grouping Keys on
page 973.

14.6.  The Orders View

Concept

This view is targeted to customer service people or production floor managers who want
to track orders that used the Gang Run mode and that then (typically after printing) will be
produced on a Kongsberg cutting table.

Note:  Learn more about using Automation Engine to manage your production on a Kongsberg
table in the chapter Kongsberg Production Workflow on page 1407.

All information in this view is updated live. It shows the status of all parts of a job Order that
was processed by a Gang Run queue. It helps to monitor orders, especially those where multiple
graphics need to be printed and cut.

This workflow and View is also valid when you submit ARD or MFG CAD files to a Gang Run queue.
For sake of convenience, this view describes both graphics or ARD / MFG input files as 'One-
Ups'.
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• An Order is created when you submit file(s) to a Gang Run queue and you there specified an
Order ID (in the tab 'Extra').

Note:  An example: When you have 7 one-ups residing in a same Automation Engine Job
and you first submit 5 of them and later the 2 remaining, then:

• Order ID = [Job Name]_[Short task ID] will result in 2 different orders (the task IDs
are different).

• Order ID = [Job Name] will assemble all 7 one-ups in one same order.

To get feedback from the Kongsberg table in this Orders view, the substrate queue needs
to, in its Export Nested Layouts task, create a cutting file of the type "JDF file for Kongsberg".
Only this JDF file format can provide that feedback.

• An Order is Done when all ordered quantities are produced by one or multiple Kongsberg
cutting tables, on one or multiple sheets. When later, extra one-ups enter the gang run
queue that use that same Order ID, the state changes from  (Done) back to  (Partially
Done).

• An Order is removed from this list when it was removed by the automatic clean up tool as
configured for Device databases or when its total number of ordered copies changed to 0 (see
the note below).

Columns
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Note:  As in many views in the Pilot, you can

• re-arrange columns by dragging their title to a new position
• sort them by clicking on a column title
• right-click a column title and choose to Hide this one or any other. In the list that appears,

select Select Columns... if you want to change or re-arrange multiple items.

• use filters and optionally save them as a Smart View.

• define your preferred unit in Edit >  Preferences >  Units.

• Order ID: ID defined in the Submit to Gang Run task that was launched on the one-ups in this
order.

• Customer Name: Name of the customer of which the Customer ID was defined in the
Submit to Gang Run task that was launched on the one-ups in this order.

• Quantity: Total of all ordered copies, as requested in the General tab of the Submit to Gang
Run task, for all one-ups belonging to this order. For example: The Quantity of the order is
44 when it expects 44 fruit displays in total, of which 22 apple and 22 banana variants.

When a one-up is submitted to the Gang Run with quantity "Maximum Fill", its (part in the)
ordered Quantity is counted or shown as " 0 " until the nesting has taken place. Only then,
the amount of this one-up that was placed on the layout is added to the total amount of
one-ups for the order.

Attention:  When one or more one-ups are deleted from a Gang Run substrate
queue, or when the quantity was there changed through the Edit mode, the order's
details in this view will automatically adapt:

• The Remaining Quantity of those one-ups is subtracted from the total amount
of ordered copies (Quantity).

• When the total ordered amount of copies for an order reaches zero, the order is
removed.

• The one-ups that, by removing them from the Gang Run, are no longer ordered
are also removed from the list of one-ups shown in the right pane.

• In Gang Run: Amount of ordered copies (of which the one-ups are still) present in a Gang
Run queue.

• In Output Workflow: Amount of ordered copies (of which the one-ups are still) in the
output workflow of a Gang Run queue.

• Queued on Table: Amount of ordered copies present in an iPC's My Jobs list (still to be
produced).

• Done: Amount of ordered copies produced on a Kongsberg table.

• Status. General status of the order:

•  In Gang Run: When all ordered copies are still in the Gang Run queue.

•  Done: When all ordered copies are produced by one or multiple Kongsberg tables.

•  Partially Done: This is the status shown in all other cases.

• Created Date: Date when order was created, i.e.: when the (first) one-up was submitted for
this order.
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• Due Date: Due date of the first submitted one-up for this order.

• Finished Date: Date when the order reached the status Done.

The Right Pane: Pie Chart and Details

• A colored pie chart shows the percentage of ordered copies in one of these states:

•  In Gang Run: Part that is still in the substrate queue, waiting to be merged.

•  In Output Workflow: Part that are in the workflow where print and cutting files are
being made of the nested layout.

•  Queued on Table: Part that has its cutting file present as a job in a Kongsberg queue
(iPC).

•  Done: Part that has been produced on the Kongsberg table. These numbers are
updated each time you close or suspend a job in iPC.

• Click  to see the amount and the names of all the One-Ups that were submitted and the
amount and names of all the Layouts that substrate queues created for this order.

• "In Gang Run" shows the amount and the names of one-ups that are still in their substrate
queue. Click  to switch to the Gang Run Printing view and see the substrate queue where
the related one-ups still are. When you here click on the name of the one-up, the same view
opens but that one-up is also selected.
 

 

Tip:  Use the arrow buttons  in the Pilot tool bar to come back to this previous
view.

• "In Output Workflow" shows the amount and the names of layouts that the gang run
created but that have not yet arrived in a Kongsberg queue (iPC). Click  or on a layout
name to open the Tasks view and see only the corresponding tasks.
 

 

• "Queued on Table" shows the amount and the names of layouts that are present in a
Kongsberg queue (iPC). Click  or on a layout name to open the Table Queues view and see
that item selected.
 

 

Seeing Overruns

When the percentage of copies of one-ups in one part of the chart is larger than 100%, the part
above 100% is shown in a slightly darker color. This visualises the size of the overrun.
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See this example where 25 were ordered but 31 were produced ("Done" = 124%):
 

 

The amount of copies can become larger than 100% in these cases:

• When the gang run queue places more copies on a sheet than initially ordered (see the
option Maximum Overrun in the Substrate Queue's Nesting Settings).

• When the Kongsberg table operator decides to cut more sheets than initially ordered.
• When more sheets are submitted to the Kongsberg table than initially ordered. This can

happen when you overruled the number of copies in the Submit to Kongsberg table task.
For orders with a large number of copies, in stead of there leaving the option Copies to its
default value From Input File, you could edit that field and for example submit half of the
copies to table A and then launch the task again and submit the other half to table B.

14.7.  Examples

These examples will help you build and understand some typical workflows.

• This example shows a basic workflow. It uses the Shuttle and shows how to uses Public and
Workflow parameters.

• This example shows how grouping keys help control the nesting. It uses a Folder Access
Point and SmartNames to extracts parameters from the names of the incoming files.

• This example shows how a workflow that is based on delivery of XML files. All required
parameters are defined in the XMLs, including references to graphics.

14.7.1.  Basic workflow using the Shuttle

Summary
In this example, a user will use the Shuttle to drop PDF files onto a "Submit to Gang Run"
workflow. He will be asked to specify some options for that workflow. All the rest, including the
output of nested layouts, will happen fully automatic.

This example specifically guides you in using workflow parameters that also become public
parameters.

We assume you have been introduced to the tools we use in this example:

• The Pilot. To create the workflows and the substrate queue.

• The Workflow Editor.
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• Public parameters.

• Workflow parameters.

• The Shuttle. This basic client tool enables to drag and drop files onto Automation Engine
workflows.

Step 1 - Create the Substrate Queues
In the Pilot, create these 3 substrate queues:

• PVC (sheet)

• AluComp 8 mm (sheet)

• Vinyl Roll 2 mm (roll)

For each of these substrate queues,

• add minimally 1 substrate size
• in their Nesting Settings, set the minimum fill to 50%

• we do not have an output workflow yet, so leave that setting open. The icon of the substrate
queue will show a warning sign, but we will ignore and solve this in step 5 of this example.

Step 2 - Create the Submit Workflow
The "submit" workflow is the workflow that will be launched on the files dropped on the
Shuttle. Typically it prepares your PDFs and ends with the Submit to Gang Run task.

The workflow that we here create is one of many possible variations. More important is the
way we create the workflow parameters and public parameters.

Here is our example:

 

 

Follow these steps to create this workflow:

1.
In the Pilot Tickets view, click  to open the workflow editor and create a workflow. First
simply add and connect the above steps. We will add details later, including the Router's 3
different output pins. Learn more about creating workflows here.

2. Save your workflow as "GRP_EXA1_Submit".
3. Go to the menu Advanced > Manage Workflow Parameters. Click Add to add these 3

parameters, their value is at this point less important:
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When finished, close this dialog. We can now use these new workflow parameters in the
tickets.

4. The Router uses the new (workflow) SmartName [wfp.Substrate] that you just created.
We route based on the name of the substrate queue, a decision taken by the Shuttle user.

Note:  You can use "is equal to" and enter their name in detail or use "contains" if this is
easier.

 

 
5. Next we have 2 different Prepare Graphics for Nesting steps. This is only a suggestion ;

their only difference could for example be the way they create the cut path or the
SmartMarks they add. In our example, the bottom step is used for roll-output.

6. Connect the Router output pins to their matching Prepare Graphics for Nesting step.
7. In the Submit to Gang Run step, add the other 2 workflow parameters for Quantity and

Scale as shown here:
 

 
8. Workflow parameters automatically become public parameters. Follow the next steps to

fine-tune the dialog in which they will be shown to the Shuttle user. Still in the workflow
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editor, go to the menu Advanced > Manage Public Parameters. The dialog will already list
the workflow parameters. We only need to add some details.
 

 
9. Add the specifics as shown in above screen shot. Click OK to confirm.
10.Save your workflow and close the workflow editor.

Step 3 - Create the Output Workflow
The output workflow is the one launched by the substrate queue on the nested layouts that it
created.

We will use below example. Just like with the 'Submit' workflow in Step 2, this is also just one of
many possible variations. Again, the most important here is how we use workflow parameters.
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Follow these steps to create such a workflow:

1. As you did in the previous step, just simply add the workflow's steps. We will add details and
more transitions later. The "Remove Preview Layer" step at the end is actually an Optimize
PDF document ticket that was renamed. Learn more about creating workflows here.

2. Save your workflow as "GRP_EXA1_Output".
3. Go to the menu Advanced > Manage Workflow Parameters. You will see 4 substrate

related parameters that were added by default. This is because we used the Export Nested
Layouts step in this workflow. In this example, we do not need any others. Close the dialog.
 

 
We will now use one of these workflow parameters in the tickets:

4. Much like in Step 2, the Router should use the (workflow) SmartName [wfp.substrate].
 

 
5. The 2 Export Nested Layouts only differ in the set of SmartMarks that they add. The Vinyl

route uses the bottom one. Here is an example of how we use the workflow parameter
[wfp.substrate] in output file names and folders:
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6. The default output pins of both Export Nested Layouts steps (print, cut, report and input

files) connect to an own end OK step that was renamed.
7. The Report files of the Export Nested Layouts steps continue to an Optimize PDF

document step that creates an extra report in which the preview layer was removed:
 

 
Learn more about layout reports and their layers in here.

8. Save your workflow and close the workflow editor.

Step 4 - Add the Output Workflow to the Substrate Queue
Now complete the setup of the 3 substrate queues.

For each substrate queue, follow these steps:

1. double click the substrate queue to open and edit it.
2. in Output Workflow, select the workflow we created in Step 3 ("GRP_EXA1_Output").
3. click OK.

Here is an example of the PVC substrate queue:
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Step 5 - Add the Submit Workflow to the Shuttle
Our Gang Run workflow is now ready for use from the Pilot.

When you set up a Folder Access Point and have it launch the submit workflow on the PDFs
that you drop on that folder, you will not have an opportunity to specify important parameters
like Quantity and Substrate Queue...

That is why we will here use the Shuttle. This tool enables us to have the user that drops the
files answer some quick questions about the wanted parameters.

Follow these steps to set this up:

1. On your client, start the Shuttle and login with an Automation Engine user name and
password.

2. Use the Shuttle's View menu to make sure you see the Launch Panel.
3. Click left-below on the  icon to create a launch pad for a workflow. Files that you drag and

drop onto this pad will be launched on an Automation Engine workflow.
4. Select the workflow from the list. We here only need the submit workflow, the one we

named "GRP_EXA1_Submit".
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Step 6 - Test and Monitor
We test our workflow by dropping files on the Shuttle and defining the public parameters.
All the rest happens fully automatic. Many of below steps only serve to illustrate how you can
monitor this workflow in more detail.

1. On your local PC or any place you can access in your network, select files that will share the
same production parameters. In our example we select 3 PDFs of which we need 10 prints
on PVC sheet material.

2. Drag and drop these files together on the launch pad of our submit workflow.
3. A New Task dialog will appear asking you only to define the values for the public

parameters:
 

 

Note:  The way they appear in this dialog (name, order, default value) is as we set up in Step
2 in the Public parameters dialog.

4. Set the Quantity to 10, change the Substrate to PVC and click on Launch You will see the
tasks start in the Shuttle's Tasks view.

5. Just for information, we have a look at the Substrate Queue in the Pilot, which is waiting for
more graphics to reach its minimum fill.
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6. We go back to the Shuttle and now drag and drop the same 2 files + 2 other files on that

workflow launch pad. This time we will want a different quantity and scale.
7. Because Shuttle recognizes files, it now first asks if you want to be shown the parameters

again that you used the last time for that same file:
 

 
We here click on Reuse.

8. A New Task dialog opens and shows the parameters that we used previously for the
mentioned file. For the 4 files that we are dropping now, set the Quantity to 20, keep
(reuse) the Substrate to PVC, and change the Scale to 200. Then click on Launch.

9. In the Pilot, we can monitor the PVC substrate queue. In our example, it reaches a minimum
fill and so starts creating layouts on which it then launches the output workflow.

Tip:  You can force this layout-creation by using the  Print Now button or by lowering the
Minimum Fill percentage in the substrate queue’s nesting settings.

10.When files are disappearing from the substrate queue, you can go to the Tasks view to
monitor their output. Double click (one of) the launched output workflow(s) to open the
workflow editor. This is how one of them looks in our example:
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Here's a view of the report file with the preview:
 

 

14.7.2.  Working with Grouping Keys

As explained in Working with Substrate Queues, Grouping Keys can help control which graphics
end up on the same layout.
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In this example we will submit a group of PDFs to be nested but we will make sure there are no
layouts with graphics from different customers nor layouts that combine graphics who need
lamination and others that don't.

Where can we get that information from a PDF (it's customer and whether it
needs to be laminated)?

There are multiple ways to get such information:

• When using the Shuttle, a user could type in the customer name (as a public parameter).
This concept was illustrated in the previous example Basic workflow using the Shuttle on page
964.

• When the PDF resides in a Job Folder of an Automation Engine Job, then the customer and
production parameters will be available as Job Parameter SmartNames. However, many
customers using the Gang Run Printing mode choose to not use this Job concept.

• These parameters can also be part of an XML that your MIS (business system) sends to
Automation Engine. This is a powerful automated workflow that is illustrated in the example
of an XML driven workflow.

• In this example, we will assume that those parameters are part of the name of the PDF
input files that are dropped on a Folder Access Point. SmartNames will extract those fields
from the file name and workflow tickets will then use those SmartNames as values.

Tools used in this example
Next to the Gang Run Printing view, we also make use of

• String Extract SmartNames
• A Folder Access Point
• Building Workflows.

Step 1 - Set up the Grouping Keys
Grouping keys can be created in the Configure panel. Learn details about this panel in Gang
Run Printing on page 189.

For this example, follow these steps:

1. In the Pilot, go to Tools >  Configure.
2. In the Gang Run Printing item of this Configure panel,

 

974



14Automation Engine

 

• name the Custom Field 1 "Lamination Yes No" and select the option Use as
grouping key

• select the option Use the Customer field as grouping key.
3. Save these settings (File > Save) and close the panel.

We will use these grouping keys in Step 4, when we pick them up in the Submit to Gang Run
ticket.

Step 2 - Create the SmartNames
We will use these 4 files:

PDF file name Preview

Stevens_Dog_LamNo_36.pdf

Stevens_Entrance_LamYes_36.pdf

ZooWorld_Flamingo_LamYes_90.pdf

ZooWorld_elephant_LamYes_20.pdf

Notice how the PDF file names are constructed as
CustomerName_DesignName_NeedForLamination_Quantity.pdf. We will use
SmartNames to extract the needed information from the file name.

Note:  To give you an idea when selecting your own graphics for this example, know that above
samples are all approximately 200 mm by 200 mm.

String Extract SmartNames

Follow these steps to create the required SmartNames (find more details in Use Separation
Character on page 626):

1. In the Pilot's SmartNames view, click  to create a new SmartName.
2. Keep the default type String Extract.
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3. Click Insert SmartName and in the category File Information, select the File and Insert it
onto the canvas.

4. In Extract part, select use separation character.
5. In Separation Character, select the underscore character.
6. In String Part,

a. select 1, click Save As... and name it Underscore_Sep_Part1.
b. select 2, click Save As... and name it Underscore_Sep_Part2.
c. select 3, click Save As... and name it Underscore_Sep_Part3.
d. select 4, click Save As... and name it Underscore_Sep_Part4.

7. Now test the SmartName by, in the Extract part of... canvas, replacing [File] by typing
an example of such a complete file name. Then change the String Part settings below to
immediately see the result below in the dialog. There is no need to save at this point.

8. Click Cancel to close the dialog.
9. Back in the SmartNames view, see the resulting 4 SmartNames:

 

 
The screen shot also shows the description (added in the save-dialog). We also used the
function Resolve all using and selected a valid example file. This allows to preview the
Results in the extra column. Learn more on this in this page in the chapter on SmartNames.

Step 3 - Create the Substrate Queue
1. In the Pilot's Gang Run Printing view, go the menu File >  New Substrate Queue....
2. Choose Sheet or Roll (not relevant for this example) and click OK.
3. Set the name to "PVC" and add a Size of 2500 x 1250 mm. In Nesting Settings..., set the

Minimum fill to 45%. We will add the output workflow later in Step 7.
4. Click OK to confirm and close.

Step 4 - Create the Submit Workflow

The "submit" workflow is the workflow that will be launched on the files that are dropped onto
the Folder Access Point. Typically it prepares your PDFs and ends with the Submit to Gang
Run task.

The workflow that we create in this step is one of many possible variations. More important is
the way we use the SmartNames.

Here is our example:
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Follow these steps to create this workflow:

1.
In the Pilot's Tickets view, click  to open the workflow editor and create a workflow.
First simply add and connect the above steps. We will add details later. Learn more about
creating workflows here.

2. Save your workflow as "GRP_EXA2_Submit".
3. In the Prepare Graphics for Nesting step, use White Background to base our cut path on

(with our example PDFs). Choose bleed and SmartMarks as you wish. We propose to write
the resulting prepared files in a specific folder and with a specific name like [File]_Prep.

Note:  Notice that this will add another suffix with an underscore to the input file name.
This will not break the extraction logic that the SmartName uses.

4. In the Submit to Gang Run step, use the SmartNames:

• in the tab General, add the SmartName that uses the extracted value for Quantity:
 

 

• in the tab Substrate, do not use a SmartName for the substrate but we pick PVC from
the list.

Attention:  This makes our submit workflow one that is only fit for this substrate
queue. We will remember this in Step 5 when we define the name of the Folder
Access Point that will start this workflow.

• in the tab Extra, add the SmartName that uses the extracted value for Customer ID and
for the custom field Lamination Yes No (that we created in Step 1):
 

 
5. Save your workflow and close the workflow editor.
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Step 5 - Create the Folder Access Point
Creating Folder Access Points is documented in detail in Creating or modifying a Folder Access
Point on page 1564.

Follow these steps to create what we need for this example:

1. In the Pilot, go to Tools >  Access Points.
2. Click on , choose the type "Folder" and click OK.
3. Choose a logic name. Remember that the workflow it will launch is specific for the substrate

queue "PVC". We therefore advise to put that important fact in the name. For example:
"GRP_EXA2_PVC".

4. In Folder settings, choose the folder that will serve as Access Point for the incoming PDFs.
5. In Automatic Actions, define a processing folder and choose to Launch a Workflow and

select "GRP_EXA2_Submit" (the one we created in Step 4).
 

 
6. Click OK to close the dialog.
7. Check the updated list of Access Points. Notice whether it is Active or not.

Step 6 - Create the Output workflow
We still need to define what needs to happen to the layouts that our Substrate Queue "PVC"
will create.

We will create this basic example (a simplified version of the one we already used in Example 1):
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Follow these steps to create this output workflow:

1.
In the Pilot Tickets view, click  to open the workflow editor and create a workflow. First
simply add and connect the above steps. Learn more about creating workflows here.

2. Save your workflow as "GRP_EXA2_Output".
3. In the Export Nested Layouts step, the only thing that is specific in this example is the

smart definition of the Output Name of (all) our Production File(s):
 

 

• the SmartName [wfp.substrate] is a workflow parameter that is created
automatically when you use this task type in a workflow. Click on  and select it from
the list of SmartNames, from its category "Workflow Parameters".

• the SmartName [wfp.Lamination Yes No] is also one that we want to add here but
it will not yet appear in the list of SmartNames. Remember that this one started as a
custom field (and grouping key) that we created in Step 1.

This custom field will only appear automatically as a SmartName Workflow Parameter
after the nesting server passed this information a first time to this output workflow. This
means that we first have to run the whole workflow once and can then come back to this
part of the workflow to pick up that new SmartName.
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At this time, we will continue without adding that extra SmartName [wfp.Lamination
Yes No], but we will come back to this ticket in Step 9.

4. Much like in the previous example, the Report files continue to an Optimize PDF
document step that creates an extra report in which the preview layer was removed (same
settings as in previous example).

5. Save the workflow.

Step 7 - Add the Output Workflow to the Substrate Queue
Although the output workflow is not final yet, we can already complete the setup of the
substrate queue by adding it's name to the queue's setup.

Follow these steps:

1. Double click the substrate queue "PVC" to open and edit it.
2. In Output Workflow, select the workflow we created ("GRP_EXA2_Output").
3. Click OK.

Step 8 - Test a first time
We now do a test-run of our whole example workflow, starting with the Folder Access Point.

Follow these steps:

1. Drop the 4 files described in Step 2 on the folder that the Folder Access Point is
monitoring.

2. Unless a minimum fill is not reached, all the rest should happen automatically.

• The Pilot's Tasks view should show the 4 submit workflows, one for each input file.
 

 

• Shortly after, the Gang Run Printing view should these show graphics entering our PVC
substrate queue.
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• If, after a few minutes, these jobs are not output automatically, you can force the layout-

creation by using the  Print Now button or by lowering the Minimum Fill percentage
in the substrate queue’s Nesting Settings.

• Once output workflows have started (we only need one), we can open one of them and
add the extra workflow parameter SmartName (see next step).

Step 9 - Add the Custom Workflow Parameter to the Output Workflow
After this first execution of this workflow, we can pick up the extra workflow parameter and
start using it inside the workflow tickets.

Follow these steps:

1. In the Pilot Tasks view, double-click (one of the ) finished output workflows to open them in
the workflow editor.

2. Go to Advanced >  manage Workflow Parameters and notice that we now have 2 extra
workflow parameters:
 

 
3. Double click the step Export Nested Layouts. In the tab Production Files, in the field

for Output Name, click on  and see the new workflow parameter SmartNames. Select
[wfp.Lamination Yes No] and insert it to the Output Name field. This should be your

result: .
4. Close the Export Nested Layouts step and choose Save Ticket as... to save it with the

same name it had before: "GRP_EXA2_Output". Confirm to replace the ticket with the
same name.

The workflow is now complete.
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Step 10 - Test Again and See Result of Grouping Keys
We now test the completed workflow again. We will also indicate the effect of the grouping
keys that we used.

Follow these steps to test the whole workflow:

1. Remove any remaining graphics in the PVC substrate queue.
2. As we did in Step 8, again drop the 4 input PDF files onto the Folder Access Point.
3. Now monitor what is happening in the Pilot's Gang Run Printing view: we see all 4 graphics

and also see that the custom fields created Step 1 are appearing as extra columns:
 

 
4. In this example, the combination of the grouping keys and the queue's nesting settings

makes that no layouts are decided (and no output workflows are launched).

To force this output, we select all 4 graphics and click the Print Now button . The nesting
server calculates and creates layouts.

5. In the Tasks view, we see the output workflows start, one for each created layout. Below
we show the output PDF reports of each of these workflows. Open it by double clicking the
Report PDF on the Report Files output pin:
 

 

Layout 1: the "Dog" file

This file used the grouping key values "Stevens and "LamNo". No other file shared both of
those, so the output depended solely on the queue's minimum fill percentage.
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The resulting report shows us
 

 

• only "dog" signs, no other graphics, not even the "Entrance" file that was also for customer
Stevens.

• a fill rate of 31,1 %, lower than the queue's minimum fill rate of 45%.

• below right, the report mentions the custom fields as 2 extra labels.

Layout 2: the "Entrance" file

This file used the grouping key values "Stevens and "LamYes". There were 2 other graphics
with "LamYes", but they had a different customer grouping key. So also here, the output
depended solely on the queue's minimum fill percentage.

The resulting report shows us
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• only "entrance" signs, no other graphics, not even the "dog" file that was also for customer
Stevens.

• a fill rate of 39,42 %, lower than the queue's minimum fill rate of 45%.

• below right, the report mentions the custom fields as 2 extra labels.

Layout 3: the "Flamingo & Elephant" files

These graphics used the grouping key values "ZooWorld and "LamYes". No other file shared
both of those, so the output depended solely on the queue's minimum fill percentage.

The resulting report shows us
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• only the 2 graphics from customer ZooWorld, no other files. Although there was some
extra space available on the sheet, we here do not see the "Entrance" job that also had the
grouping key LamYes, because it did not have the same grouping key for customer ID.

• a fill rate of 38,57 %, also lower than the queue's minimum fill rate of 45%.
• below right, the report mentions the custom fields as 2 extra labels.

14.7.3.  Basic XML driven workflow

Summary
In this example, we simulate a business system that writes XML files onto a Folder Access
Point. These simple XML files contain both a reference to a graphic file and parameters that
describe what to do with it.

As explained in Automating your Workflow Using XML on page 905, the difference with using
the Submit XML to Gang Run task is that these XML files are much simpler and also that we here
stick to descriptions of 1 graphic file at the time.

In this example we assume you have read the previous examples and are thus familiar with
these tools in the Pilot:

• creating a Folder Access Point
• working with Substrate Queues
• working with the Workflow Editor and Workflow parameters.

Note:  In this example, the workflow parameters get their value from the input XML file.
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Step 1 - Content of XML files

Incoming XML Files
The business system sends XML files that have a simple structure. They only list the name of
the graphic file and some production parameters. They are all for the same substrate queue
and size. In our example, we use 10 different XML files:

• 6 XML files represent large graphics of "American Cars" for the customer "ToyToy". Some
graphics need scaling, some need different quantities. Here is one example:
 

 

• 4 XML files represent smaller graphics for displays of movie characters for the customer
"MovieWorld". Here is one example:
 

 

They share a same value for the element "LaminationYesNo" that we will again use as a
grouping key. So in our final output, we do allow these graphics to appear on a same layout.
Learn more about using grouping keys in the previous example.

Graphic Files Data Structure

In this example, the business system does not know the exact place of the graphics data (full
URL).

In our example, all graphics data are available as PDF in a folder named after the customer.
This means that the file name and the customer name will suffice because we will use those as
SmartNames to find the data.

Step 2 - Set up the Grouping Keys
This step is identical to the one in the previous example, except that in this example we will not
use the Customer field as grouping key. So that option needs to be switched off.

We will here only use the custom field that we named "Lamination Yes No".
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Step 3 - Create the Substrate Queue
In this example, we only need one substrate queue. Learn how to create Substrate Queues
here.

Very similar to how we did it in the previous examples, follow these steps:

1. Create a substrate queue of the type Sheet and name it "AluComp 8 mm".
2. Add a substrate size with the name "2500x1250" and give it those dimensions (in mm).
3. In Nesting Settings, set the minimum fill to 50%.
4. We do not have an output workflow yet, so leave that setting open. The icon of the

substrate queue will show a warning sign, but we will ignore this for now and solve this in
step 7. Click OK to close.

Step 4 - Create the Submit Workflow
This submit workflow is very similar to the one we created in step 4 of the previous example. We
here only list the differences.

Follow these steps:

1. Create a workflow with these steps (you can already rename them as we did here):
 

 
2. Save this workflow as "GRP_EXA3_Submit".
3. Still in the workflow editor, go to Advanced >  Manage Workflow Parameters.... In this

menu,

a. click Load Workflow Parameters from XML file... and select one of the XML files that
the business system sends. In the dialog that asks to select an XML element, leave the
field blank and click OK. This creates the [wfp. ...] SmartNames that we will use later.

b. select Use values from XML file and keep the default path [URL of Folder of Input]/
[File].xml. This tells the workflow that the values for those workflow parameter
SmartNames are those as specified in the input file of the workflow.

This should be the result:
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Learn more on using XML when working with workflow parameters in Using Workflow
Parameters on page 803.

Close the dialog and save your workflow again.
4. In the Select File step,

• select Select other Files

• in name matches, enter the SmartName [wfp.FileName]

• in Look in Folder, enter a path that uses the SmartName [wfp.Customer].

 

 
5. The Router  serves to find if the graphic file already has a Separation Name that can serve

as cut path.
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6. The two Prepare Graphics for Nesting steps differ in their setting Create Cut Path from:

• one uses an Ink Name:
 

 
• the other one creates the path from the White Background.

 

 

Choose bleed and SmartMarks as you wish. We propose to write the resulting prepared files
in a specific folder and with a specific name like [File]_Prep.

7. In the Submit to Gang Run step, use the SmartNames:

• in the tab General, use the SmartName [wfp.Quantity] to define the Quantity.
• in the tab Substrate, use the SmartNames [wfp.Substrate] and [wfp.Size] to

define the Substrate and Substrate Size.
• in the tab Extra, use the SmartName [wfp.LaminationYesNo] to define the value for

the custom field Lamination Yes No.
8. Click OK to close the step. Save your workflow and close the workflow editor.

Step 5 - Create Folder Access Point
Setting up this Access Point is very similar to the one we set up in the previous example.

Follow those same steps and mind these 2 differences:

• The behavior of (the workflow started by) this Access Point is decided by the values in the
XML files, so its name can be generic, for example "GRP_HOT_SINGLE_XML".

• In Automatic Actions, the workflow to launch is "GRP_EXA3_Submit" (the one we created
in the previous step).

Step 6 - Create the Output Workflow
The output workflow can be identical to the one we used in the previous example. It was named
"GRP_EXA2_Output".
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The only SmartName we use in this output workflow is to help name the output production
files.

Step 7 - Add the Output Workflow to the Substrate Queue
Follow these steps:

1. Double click the substrate queue AluComp 3.4 mm to open and edit it.
2. In Output Workflow, select the workflow "GRP_EXA2_Output" (yes the same one as in our

previous example).
3. Click OK.

Step 8 - Test
All we need to do to test this workflow is dropping the XML files onto the Folder Access Point.

For every XML, one graphic file should appear in the substrate queue.

Depending on the size of the graphics and the nesting settings, some or all graphics might
automatically end up on a layout and continue to the output workflow.

Here is an example result of one of the output workflows:
 

 
The Reports output pin shows us a link to the report PDF shown below (and also lists the other
report data in XML form).
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15.  Quality Control tools

15.1.  Concept and Overview

Quality Control tools serve any of these reasons:

• to prevent unnecessary work. For example preflighting incoming designs and refusing to
start prepress work on those that did not match a specific basic profile.

• to check the work you have done. Once you have started preparing, editing or outputting
files, there are many reasons to check if what you have done is as intended. Detailed
inspection and comparing helps preventing many errors.

These tools can be interactive tools or Automation Engine tasks that report a status.

Learn more in

• Automation Engine Viewer on page 992

• PitStop Preflight on page 1042

• Global Vision Inspection Tasks on page 1051

• Other QC Tasks on page 1090.

Note:  This is not an overview of all Esko QC tools. This only describes the tools available
through Automation Engine.

15.2.  Automation Engine Viewer

15.2.1.  Introduction

What is the Automation Engine Viewer?

The Automation Engine Viewer is a QC tool that enables you to view, check and compare
graphic production data.

The Viewer is started from within the Automation Engine Pilot, and can so be used by anyone
on a Mac or Windows computer in your network. It is not uncommon that staff from outside
the prepress department like CSRs also use this tool.

Supporting many File Formats, Comparing and more

The Viewer supports many different file types: PDF, AI, ArtPro, images and even bitmap RIP
data. Learn more in Supported File Types on page 994.
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You can compare files and analyse their differences, even when they have different file types
and even when they have a different size. Learn more in Comparing Files on page 1026.

Other Esko Viewers

• The Esko Bitmap Viewer is similar to the Automation Engine Viewer, but only supports RIP
data. It is a standalone application and is only available on Windows.

• The Esko WebCenter Viewer is similar to the Automation Engine Viewer, with added
functionality for comments and approval and it also supports CAD and 3D files. This tool
runs in a web browser.

Started from the Pilot

To open a file in the Viewer, choose any of these methods:

• Click the word View next to the file.
 

 

• Right-click the file and select View....

• Select the file and go to File > View.

• When the Viewer is already open, you can also open the file from there.

Here 's an example of a file open for inspection in the Viewer:
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The Concept of Prepared View Data

Foremost, a viewer tool must be reliable, it must show data in a correct way. The Viewer does
this by using the same technology as the Esko editors and RIPs.

The next main challenge for any viewer is to combine these features:

• opening files fast, even when they are big.
• being able to zoom in very deep, to show high detail, preferably also fast.

This is why you have a choice: to open files in the Viewer with or without first creating
Prepared View Data. Learn more in Working with Prepared View Data on page 1004.

Limiting who can use deep zoom

When a user does not have the User Access Right for deep zoom, then

• you can only view file that has prepared view data.
• your zoom is restricted.

This can help you avoid that a group of users, that does not need a too detailed view, would
cause load problems on the server by accidental deep zooms.

Learn more in Defining User Access Rights and Working with Prepared View Data on page 1004.

Supported File Types
The Automation Engine Viewer supports these file types:
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Graphic files, both with and without prepared View Data

Esko normalized data:

• Esko PDF

• Esko PDFPLA

Non-normalized graphic files:

• PDF (which includes PDF+)
• ArtPro
• AI (when PDF compatible)
• (E)PS. For Adobe Illustrator ‘EPS’ file types,

the same restrictions are valid as in
PackEdge.

Images, both with and without prepared View Data

Supported:

• Esko CT

• Image EPS

• DCS/EPS
• PSD
• TIFF (< 600 ppi)
• JPEG

Not Supported:

• images with Progressive Scan compression
• images including linework
• RGB images

This data can be viewed when you first use
the Image Import task.

RIP'ed data (Digital Film files), only with prepared View Data

• Esko LEN/LENX
• TIFF (> 600 ppi)
• DCS 2.0 (> 600 ppi)
• VIEW (Imaging Engine print simulation files)

Note:

• To be able to open TIFF, LEN or print simulation files from Imaging Engine with the
Automation Engine Viewer, you can prepare view data for your files using either:

• the Make all output files ready for viewing option in your Imaging Engine task,
• the Prepare for Viewer task.

See the documentation of your Imaging Engine task (in the chapter RIP'ing with Imaging
Engine) for more information.

• You cannot prepare LENX files for viewing with the Prepare for Viewer task. However, you
can either:

• use the Make all output files ready for viewing option in your Imaging Engine task,
• view them in the Bitmap Viewer (without preparation).

How different Graphic File Types are Streamed to the Viewer

The data shown in the Viewer are always pixels, referred to as 'View Data'. Usually, you need
to zoom in quite deep to see these pixels appear. This is also because these pixels can be
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(re-)created on the fly: when you zoom in further, you are automatically shown a new set of
view data that again guarantees an optimal view.

The way that graphic files (non-images) become these pixel data is different for these groups of
files:

• Normalized files. These are automatically converted to view data the moment you open
them in the Viewer.

• PDF native, (E)PS and AI files are automatically normalized first before they are converted
to view data.

• ArtPro native files. Here you have the choice to also have them normalized first or to have
them shown in the Viewer using the same technology that visualizes them in ArtPro. Both
methods are fully automatic.

• Prepared View Data. You can prepare this view data beforehand, so that when you open
the file in the Viewer, it opens instantly. Learn more about this important topic in Working
with Prepared View Data on page 1004.

When the view data was not prepared, it will be created automatically when you open the
file in the Viewer. The time this takes depends on the available power on the server and on
the size of the file (Horizontal -Vertical + the amount of inks).

Learn more about controlling these automatic normalization steps and more in the Viewer topic
in the Configure panel (Tools >  Configure >  Viewer).

Starting the Viewer from the Pilot

Started from a Pilot

You can use as many Viewers as you have Pilot connections. Opening the Viewer does not
allocate an extra Pilot connection.

Note:  You can even open multiple Viewers on the same workstation by opening a second Pilot
(File >  New window) and opening a file in the Viewer from there. Mind that this not required
when comparing files. Learn more in Comparing Files on page 1026.

Note:  Opening the viewer itself takes some time, so do not close the viewer when regularly
viewing files.

"View" Statuses in the Pilot
The View column can display any of these Viewer related statuses:

• (-). A dash indicates that the file is not viewable. For example TXT, XML, PAF, TCP, non-PDF
office documents, etc.

• . The word 'View' in black indicates that the file is viewable when its file type as
indicated by the file type extension corresponds with its real file type.

• . This indicates that the file can be viewed and that prepared view data are
available. The file will open quickly. Learn more in Working with Prepared View Data on page
1004.

• . This indicates that the file can be viewed. Because no view data were prepared, they
will be created on the fly while opening the file in the Viewer.

• . This indicates that the file can not be viewed because it has prepared data that
are outdated. Solve this by deleting the view data or by preparing new view data. Learn how
in Working with Prepared View Data on page 1004.
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Digital Film (RIP'ed) Files

To view digital film files in the Viewer, the situation is slightly different.

• For LEN files, you always need prepared view data.

• . This indicates that the file has up-to-date view data and can be viewed.

• . This indicates that the file has no view data. It can therefore not be viewed
in the Viewer.

•  indicates that the .LEN files have view data, but that the view data is not in
sync with the original file and can therefore not be viewed.

• For TIFF files, the behavior depends on the resolution of the file:

• A TIFF file with a resolution lower than 600 ppi can be viewed without having prepared
view data.

• A TIFF file with a resolution higher than 600 ppi must have up-to-date prepared view data
to be able to view it.

Note:  The resolution is only checked after you clicked on . A warning will be shown
when no view data are found when required.

Learn more in Working with RIP data on page 1038.

15.2.2.  User Interface

Viewer Window Overview
The Viewer offers many powerful tools that make it easy to navigate, inspect and compare files.
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1. The File Selector on page 999.
2. The Toolbar on page 1000.
3. The (Top) Tools Panel on page 1000.
4. The Navigator Panel on page 1002.
5. The View Panel on page 1002.
6. The Channels Panel on page 1003.
7. The Info Panel on page 1003.

Note:  Several tool-buttons show a small arrow in their lower-right corner. Right-click them
(Windows) or use the CMD key (Mac) to see their extra options. An example:
 

 

Tip:  Hover the mouse over a button icon to read a short explanation (and often also a tip).
 

 

Tip:  Hover the mouse on the right of the view area and drag the divider to give the left or right
part more space. The resulting width of the tools panel will be remembered and restored for
each user.
 

 

Tip:  You can open or collapse the tool panels by clicking on their small white arrow:
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The File Selector
You can open files by clicking on  in the Pilot. You can also open files by using the file
selector on board the Viewer:

• Click on  to select a file from within a Job or Container.

• Click on the drop-down icon to select a file from the list of recently viewed files.

• Click on the arrows to scroll through the recently viewed files or to see other pages of an
open file.
 

 

Note:  You can navigate through these files by using the keyboard shortcuts End, Home and
Page Up / Down.

Limiting How Many Files you can Open

Each file that you have opened is a "file streaming session" from the Automation Engine server
to this Viewer client.

Attention:  Mind that when you compare 2 files, that this is counted as 2 file streaming
sessions.

To prevent that the server allocates too much computer memory to any Viewer, the following
tools serve to optimize that server memory:

• When you close the Viewer, all file streaming sessions to that Viewer are closed.
• When, in the drop-down list, you click on ... Reset file list ..., all file streaming sessions are

also closed. Choose this when you want to continue using the Viewer with other files than
those recently viewed.

• If there is no recent activity on a file already opened in the Viewer (zooming, measuring),
then this file streaming session will be closed. Mind that this does not automatically close
the file in the Viewer.

• By default, an Automation Engine server only allows a maximum of 4 file streaming sessions
for all connected Viewers. An administrator can change this number in the Server Admin web
tool, in the item 'Processing Capabilities' of the Server Setup. When the maximum is reached
and an extra session is requested, the user will get a warning dialog that the maximum of
sessions was reached.

999



15 Automation Engine

Note:  An example: You have set a limit of 4 file streaming sessions.

• Pilot user 1 opens a file in his Viewer and compares it with another one. The total streaming
sessions at this moment is 2.

• Then, users 2 and 3 also each open 1 file in their Viewer. The total streaming sessions at this
moment is 4.

• Then, user 2 gets up from his workstation to get a coffee but leaves the Viewer and the file
open. He stays away 5 minutes. Before he is back, his file streaming session automatically
closes, which brings the total streaming sessions at that moment back to 3.

• Then, user 3 also starts to compare his file with another one. The total streaming sessions
at this moment is 4.

• Then, user 2 is back at his workstation. His file is still open in the Viewer but the streaming
session for that file was already closed on the server a few minutes ago. He tries a zoom in.
He gets an error that the maximum of 4 session is already reached.

The Toolbar
 

 

•  The progress bar shows the progress of view data being streamed to your Viewer.
Learn more in Working with Prepared View Data on page 1004.

•  Multi-page options (only shown when viewing a multi page file). Learn more in
Working with Multi-Page Files on page 1036.

•  The compare tool allows you to compare two files. Learn more in Comparing Files on
page 1026.

•  The annotations panel becomes available when your files has XFDF annotations. Learn
more in Working with Annotations on page 1035.

•  The information button opens a dialog that shows the file's XMP metadata (the same one

as when you when you select a file in the Pilot and click  in the Files view).

Note:  Any barcodes mentioned in the XMP are of barcodes created with Esko tools. The
barcode measurement tool on-board this Viewer can also detect and measure other
barcodes.

•  The print button allows to print what you see in the Viewer. Learn more in Print on page
1016.

•  The help button opens the Viewer's online help in the local default browser.

•  The close button closes the file that is being viewed (only the file, not the Viewer tool
itself).

The (Top) Tools Panel
The top tools panel offers the Viewer's most used tools. You can customize which tools you see
by right-clicking it and selecting or deselecting some tools.
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Note:  You can select a tool even when it is not currently available in the Viewer. For example,
the Page list tool can be added to the top tools panel while working on a single page file for
which this tool is not activated. This tool will then automatically appear in the panel the next
time it can be used.

•
Click  on the right to hide or show all the right side panels (Tools, Navigator, View,
Channels, Info).

•
Click  to show or hide the panel. Hiding the top tools panel automatically shows the right
side panels and vice-versa.

The top tools panel can offer the following tools:

Page List Tools

These are only shown when viewing multi-page files. Learn more in Working with Multi-Page Files
on page 1036.

Inspect Tools
•

 Zoom tool. Right-click it to see extra options.

•
 Zoom out tool.

•
 Pan tool.

Select the tool and drag the image by holding down the left mouse button and moving the
mouse. You can temporarily switch to the Pan tool by holding down the space button.

Learn more in Zoom and Pan on page 1007.

Measure Tools
•

 Ruler. Learn more in Measure Distances and Angles on page 1013.

•
 Caliper. Learn more in Measure Heights and Widths on page 1014.

•
 Densitometer. Learn more in Measure Color on page 1015.

•
 Calculate screening and angle. Learn more in Working with RIP data on page 1038.

•
 Inspect barcode. Learn more in Checking Barcodes on page 1017.

•
 Inspect braille. Learn more in Checking Braille on page 1018.

Compare Tools

The compare tools are automatically shown when you activated the  Compare mode.

Learn more in Comparing Files on page 1026.
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The Navigator Panel
The Navigator panel shows a preview that indicates your current zoom and many other
viewing choices. Click on the preview to reposition your (same size) zoom area.

Tip:  You can resize the navigator panel:
 

 

The View Panel
The View panel offers the following tools:

•  Previous view: Shows you the previous view. Hold the Shift key to go to the first view.

•  Next view: Shows you the next view. Hold the Shift key to go to the last view.

•
 Rotate view tool. Hold down the Shift key when clicking to reverse the rotate direction.

Or use the keyboard shortcuts Ctrl + Shift + '+' (90 degrees CW) and Ctrl + Shift + '-' (90
degrees CCW).

•  Mirror view: Mirrors the current view (Ctrl + M).

•
 Invert view: Inverts the current view (typically used when viewing only one channel).

•  Background Color: Allows to change the background color of the image and/or the
surrounding viewer window. This can be useful when evaluating an image that will be
printed on a material that is not white. Setting a color for the image does not affect the
channels or any color measurements.

•  Show margins (trim box): Shows the file’s trim box as a blue dashed line. Learn more in
Change Clipping on page 1008.

•
 View from back: Mirrors the current view and also reverses the sequence in which

the channels are shown. This is useful when viewing files that are printed on the back of a
transparent material and therefore contain areas using opaque ink.

•  Set overprint highlight color: Highlights the overprints in a color of your choice. Learn
more in Highlight Overprint  on page 1012.

•
 Seamless view: Simulates a seamless layout. Learn more in Seamless View.

•
 Total Area Coverage: Shows the sum of all separation-densities at a certain point or

area in your document. Learn more in Using Advanced View tools on page 1023.

•
 Flexo Plate: Shows a single separation as a flexo plate, by simulating both the color

and the missing too small percentages. Learn more in Using Advanced View tools on page
1023.
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•
 Flexo Print: Shows the effect of highlight dot gain on the file. Learn more in Using

Advanced View tools on page 1023.

•
 Break Out: Shows an area of a single separation where the percentage is lower than

the first visible dot. Learn more in Using Advanced View tools on page 1023.

•
 Registration Error: Shows a simulation of the file printed with registration errors.

Learn more in Using Advanced View tools on page 1023.

The Channels Panel
The Channels panel shows the file’s channels (separations, inks) and offers extensive
separation viewing possibilities.

• Click  to switch between a Composite view and a tiled view of the individual separations.

• Right-click  to choose the kind of tiling to use: Automatic, Horizontal or Vertical.
 

 

• You can switch channels off and on. You can change their display color and transparency.
You can map channels so they here appear as one.

Learn more in How to Inspect Channels.

The Info Panel
The Info panel displays:

• file information: Size and Trim Size
• viewing conditions: current Magnification (zoom), mouse position, results from the ruler.

To change the units, click on one of the small triangles and select the unit (pt, mm, cm, inch).
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15.2.3.  Working with Prepared View Data

Concept
As mentioned when introducing the Viewer and also when explaining how different files are
streamed to the Viewer, preparing view data can be important to guarantee both speed and
detail when viewing files.

When you regularly experience significant delays when opening files, then consider preparing
view data first. Files with prepared view data always open fast.

Zooming and panning will be faster on files with prepared view data. The load on the server is
also smaller when using prepared view data.

Note:  When a (deep) zoom needs a resolution that is higher than the prepared one, the data
for that zoom area will automatically be streamed from the server. You may notice this delay
(visible in the progress bar).

Tip:  Ctrl-Shift-V displays the current view resolution.

Workflow

The Prepare For Viewer task creates prepared view data. Depending on your workflow, the size
of the files and how consistent viewing delays are, you can choose to launch this task in one or
more of these ways:

• Ad hoc (manually), by selecting a file in the Pilot and launching the Prepare For Viewer task.
When you often use this, consider making it a favorite ticket.

• Automatic, as part of workflow tickets. For example, when you often check RIP data in
the Viewer, then consider adding the Prepare For Viewer task as a workflow step after the
RIP'ing step. Some users also add a Wait for Action (CheckPoint) task to create a QC step in
the users' To-Do list. An example:
 

 
• Automatic, for all files in a specific folder. For example, when you check all files arriving

in a specific folder, you can have that folder automatically launch the Prepare For Viewer task
on all incoming files. This way, you win time when opening those files in the viewer. Learn
more in Speed Up For Viewing on page 1006.
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Make sure your Prepared View Data is Up-To-Date

As mentioned in Starting the Viewer from the Pilot, you will not be able to view a file when it
has prepared view data that is outdated (older than the source file). This will be indicated by a
specific status in the View column: .

View data typically becomes outdated because the source file has a more recent modification
date. So make sure you only create the prepared view data as a last step before checking it in
the viewer.

Attention:  Prepared view data becomes useless when the source file was manually
moved or renamed.

Note:  When you move a source file with the Copy or Move File task, then the view data will
follow automatically.

Learn more in Managing View Data on page 1007.

Prepare for Viewer Task
This task creates view data that will be used when you open its input file(s) in the Automation
Engine Viewer. The supported files types are those that the Viewer supports.

Attention:  In many cases, you do not have to use this task before opening a file in the
Viewer. Learn more about this choice and workflows using prepared view data here.
Find an introduction to the Automation Engine Viewer here.

 

 

• Resolution for non-images:

• Optimal: The task uses a smart algorithm to decide the optimal resolution for the view
data (the one that offers the best balance insuring both speed and detail). The calculated
resolution is mentioned in the tasks 'details' and log file.

• Custom: Specify the resolution yourself.

Attention:  We advise to only set a custom resolution in cases where you found
that the optimal setting created a too small or too large set of view data.

• Anti-aliasing: This smooth-ens the staircase effect when images are generated from line-
art objects.
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• Merge Similar Inks: This merges inks that have a same name but have a different ruling or
angle.

Attention:  We strongly advise to enable this option when viewing ArtPro files or
Normalized PDF files generated by ArtPro.

• Automatic grouping of input files into digital film sets: When digital film separations
(RIP'ed files) are grouped into sets, they will open together in the Viewer and can so be
inspected as a composite image. See some examples in Working with RIP data on page
1038.

• When this option is not selected, the list of task input files that the user manually
selected or that a workflow created for this ticket will be grouped regardless of their
file names. This is how you can for example get a composite view of these files (where
not all have the same name before the suffix with the ink name):
 

 
• When this option is selected, the grouping is done automatically based on the file

names of the task input files. Using above example, you would then get 2 groups for
composite viewing: one with only 3 separations from the Shrek files and one with one
separation from the GreenMan file.

Speed Up For Viewing
As mentioned in Concept of View Data, you can have prepared view data created automatically
for all new files in a subfolder of a Job Folder.

Attention:  Using this option will generate view data as soon as a file is written in this
folder. And when a file in this folder is updated, its view data will be regenerated. This
can lead to overhead on the server when view data are generated that will not be used.
Therefore, as a more optimal alternative, consider inserting a Prepare for Viewer task
at the right place in your workflows.

• To add this functionality to a folder, right-click any folder in a Job folder and select Speed
Up for Viewing. The folder will get a specific icon . From that moment on, Automation
Engine will automatically launch the Prepare for Viewer task on all new or modified files
(that the Speed Up for Viewing task supports as input files).

The ticket of the Prepare for Viewer task that is used for these automatically launched
tasks is defined in the Configure tool.

Tip:  When you are creating Jobs based on a template Job that has a subfolder with the
attribute "Speed Up for Viewing", then this attribute will be inherited in the folder in the
new Job.

Note:  When, in such a folder, a file is opened and being edited in Esko PackEdge or Esko
Plato, you do not want to have view data re-created every time you click Save. That is why
the Prepare for Viewer task only starts and updates the view data once the file is closed in
the editor.
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• To stop this functionality, right-click the folder and select Speed Up for Viewing to switch it
off again. This attribute is also removed automatically when the Job is removed, exported or
archived.

Managing View Data
The Prepare for Viewer Task creates the prepared view data in a hidden .view folder next to the
input file.

Warning:  Accessing that hidden folder and deleting, moving or renaming this view data
manually will create Viewer errors.

The size of the view data depends on the chosen resolution and on the size and amount of
channels of the source file.

Because this data is not small and temporary by nature, the following mechanisms help to
clean up the prepared view data:

• When you demote a Job (by removing, exporting or archiving it), all view data in that job
folder is automatically deleted.

• You can manually delete the (hidden) prepared view data, by:

• right-clicking a file and choosing Delete View Data. This removes the prepared view data
for that selected file only.

• right-clicking a folder and choosing Delete View Data. This removes the prepared view
data for all files in that folder and its subfolders.

15.2.4.  How To

This is an overview of frequently used tools that you can use on all types of files.

Zoom and Pan

Zooming
•

Double click  the zoom tool itself to zoom. If a selection was already made (for example
when measuring), the zoom will fit that selection to the window.

• Scroll the mouse to zoom in/out with the location of the mouse point as center.
• For a marquee zoom, hold down the right button and drag the mouse.
• Right-click (ctrl-click on a Mac) to see extra options:

 

 
• About the Zoom to 1:1 view:
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• First use Set Monitor Resolution to inform this viewer about the current monitor. This
value is saved per user per client computer. Learn more in this KB article.

• Then define what a click on  Zoom to 1:1 view means. Choose to make it Zoom to
real size or choose to make it Zoom to 1:1 pixel to zoom to the resolution of the image,
offering a lot of detail.

• Use  and  in the View panel to see a previous or next view.

Panning

Select the  pan tool and drag the image by holding down the left mouse button and moving
the mouse. You can temporarily switch to the pan tool by holding down the space button.

While panning, you can still use these ways to zoom in/out with the mouse point as the center:

• double-click to zoom in
• right-click to zoom out
• scroll to zoom in/out.

Keyboard Shortcuts

• No matter which tool you have selected, you can always use the right mouse button to
zoom in:

• combine it with a right-click to zoom in by a factor 2.
• combine it with holding down the Ctrl button to zoom out by a factor 2.

• Ctrl-'Arrow' pans the image 25% of the window size in the direction of the used arrow.
• Ctrl-Shift-Spacebar temporarily switches to the pan tool to allow one drag pan.
• In the View panel, when clicking  and  to see a previous or next view, hold Shift to go

the very first / last view.
• Photoshop style keyboard shortcuts:

• Ctrl-'+' zooms in with a factor 2.
• Ctrl-'-' zooms out with a factor 2.
• Ctrl-'0' fits the file in the window.

• PackEdge style keyboard shortcuts:

• F5 zooms in with a factor 2.
• F6 zooms out with a factor 2.
• F7 temporarily switches to the pan tool to allow one drag pan.
• F8 temporarily switches to the zoom tool to allow one drag zoom.
• F9 fits the file to fit in the window.

Change Clipping
The trim box is often used as the basis for step and repeat of a one-up. It is good practice that
the trim box corresponds to the bounding box of the die line.
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Click  to see the trim box as a blue dashed line. This allows you to check if the trim box
correctly fits the die line.

In below example, we see that the trim box fits on the 'CAD' line. Also notice the size values in
the Info panel:

 

 

Right-click  to see extra options:

• to clip (hide) what is outside the trim box.
• to set a different color for the trim box.
• other options relate to multi-page documents. Learn more in Working with Multi-Page Files

on page 1036.

Inspect Channels

Note:  We already mentioned some basic functionality when introducing The Channels Panel on
page 1003.

Selecting Channels to View

Click  to view or hide one, multiple or all channels.

Right-click the  of a single channel to view only this channel.

Channel Definition

Especially when comparing files based on their channels, it is important to know the exact
definition of the channels.

Hover with your mouse over the channel's color patch to you see what defines it:

• its name
• its RGB display values

1009



15 Automation Engine

• its ruling, angle and dotshape (when defined).

 

 

Changing the Appearance of a Channel

Double-click a channel to open its Channel Colors dialog.
 

 

The top part shows the Original Color Definition and is read-only.

The bottom part allows you to change the way the channel is displayed. This is for example
useful when the file contains a white separation because it will be printed on clear plastic. To
see that separation better in the Viewer, you might want to display it as pink. To do this, set
new RGB values, or double click the color path and to pick a color.

Use the drop-down list to choose a color of another channel in the file. Select Opaque to make
the selected channel displayed opaque.

A channel of which you changed the display is marked with an asterisk (*)
 

 

Note:  These display changes are not remembered the next time you open this file in the
Viewer.

Use the  arrows at the bottom to browse through all channels, so that you can modify
several channels without reopening this dialog.

Use the  button to reset the display to the channel's original color definition.

Changing how Single Channels are Displayed

Click  to display a single channel in black instead of its own color.

Note:  This setting is remembered the next time you open the Viewer.
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A right-click on  also offers to show single channel as black with show all effect. This view
uses black rather than a grey value for a display pixel that represents a partially covered area.
This makes it easier to detect areas with small dots in RIP'ed files. An example:
 

 

Changing the Sequence of the Channels

Opaque inks cover previously printed inks, so the sequence when viewing these channels is
also important. You can change their display sequence by using the  buttons. Moving a
channel down means putting it later in the printing sequence, which would put it on top of the
other channels.

Tip:  You can also change the sequence by dragging the colored box of a channel to a different
position.

Note:  This display sequence does not have any influence on the actual printing sequence, only
the display in the Viewer is affected.

When you changed the channel sequence, click on  to reset it to the original channel
sequence. Right-click  to choose what you are resetting (channel order, color definitions or
both).

Merging or Splitting the Display of Similar Inks
Inks with a same name are by default shown as one same ink, even when they have a different
ruling, angle or dot shape defined.

If you want to see such inks as separate channels, disable the setting Viewing Preferences > 
Merge Similar Inks in the Viewer item of the Configure panel. After a restart of the Viewer, you
can then click  to unfold the channel and change view settings for the separate ones:
 

 

Learn more in Matching Channels on how to insist considering them as one channel while
comparing.
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Keyboard Shortcuts
• Hold down Ctrl and press one of the number keys to select the corresponding channel and

deselect all other channels. 1 is the first channel, 2 is the second etc.

When you have more than 9 channels, use Ctrl-Shift-0, Ctrl-Shift-1,... , Ctrl-Shift-9 to select
channels 10 to 19.

• Ctrl-0 selects all channels.

• Ctrl-N selects a single channel. When multiple channels are selected, the first channel will
be selected. When a single channel is selected, the channel after the currently selected will
be selected, or when the currently selected is the last, the first will be selected.

Highlight Overprint

Click  to get a clear indication of all areas where two or more active channels are
overlapping (keyboard shortcut Ctrl-H).

 

 

This tool is useful when checking trapping:
 

 

To change the highlight color, click the Overprint Highlight color patch and choose a custom
one.
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Measure Distances and Angles
To measure between two points:

1.
Select the ruler tool .

2. Click the first point.
3. Either click the second point, or drag the cursor to it.

A dashed line visualizes the distance.

Tip:  To constrain the tool to angles of multiples of 45°, hold down the Shift key while
deciding the second point.

The measurements appear both in a pop-up and in the Info panel:

• The distance between the two points (D).

• The angle measured relative to the axis (A).

• The start and end location (X and Y).

• The horizontal (W) and vertical (H) distances traveled from the horizontal and vertical axes.

See this example where a trap is measured (use the same method to for example measure the
distance to a finishing mark):
 

 

You can also:

•
Right-click  to show/hide measurements, change the ruler angle or change the display
color.
 

 

• Change the units used by clicking the small arrow in the Size line of the Info panel, or using
Ctrl + U.
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Tip:  You can combine the ruler tool with other view tools. For example: click on a point, then
change the view (by zooming out, panning or turning back to a previous view), and then click
the second measuring point.

Measure Heights and Widths

Use the  caliper tool to measure the height or width of multiple, typically aligned, (text)
objects. You can measure freely or you can use fixed preset sizes.

Click  to activate it and start measuring using the last chosen style.

Right-click the tool to choose a style or to manage fixed presets.

• Free Selection (default)

• Click on a first point of measurement.
• Move or drag to the second point.

Tip:  You can use all zoom and scroll functions while you are navigating to the first or
second point.

• Click on the second point. While moving the mouse, a pop-up displays the current gap
size and the X / Y coordinate.

Tip:  As an alternative to the two-click procedure, this tool also offers a click-drag-release
selection. This is useful when you want to select the border of the view area, where
clicking accurately can be difficult. With the click-drag-release selection, you can release
the mouse outside the view area to snap accurately to that border.

When releasing the mouse, the area outside the selection will be dimmed to highlight
the selected area:
 

 
Also, the Info panel shows the Width or Height, in  .

To adjust the width or height, simply drag the lines that appeared. Click between the
lines to move the caliper selection (both lines).

•
Right-click  and choose Save if you want to use this gap size later.

• Fixed selection

This style offers a fixed gap size. Use this when you want to check (text) objects versus a
pre-determined size.
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•
Right-click  and choose Change if you see no list of gap sizes yet.

• Use the dialog to Add or Delete gap sizes. Define their orientation as either Height or
Width. Click OK to close.

• Start using the selected gap size.

Tip:  The caliper selection will disappear if you switch to another tool. You can also clear
it explicitly by choosing Clear in the tool's right-click menu.

Measure Color

Select the  densitometer tool and either click a point in your file, or click and drag a
rectangle, to measure the color.

The measured dot percentage in that point or area are shown in the Channels panel, and the
location in the Info panel.

Tip:  Double-click the densitometer to make a measurement based on the current selection or,
when no selection is active, based on the current view.

By default, the measured densities are also shown in a pop-up near the location you measured
(right-click the tool to hide or show this pop-up).

In below example, you might be interested in the Total Area Coverage of that specific area (as
shown in the result for 'All' channels: 334%):
 

 

Note:  There is a dedicated tool to check TAC. Learn more in Total Area Coverage on page 1023.

When viewing Digital Film files (RIP data), you can change the units in the pop-up. Click the
small arrow next to the current unit and select your preferred units.
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Keyboard Shortcuts
• You can clear a selection by pressing Ctrl + D.

•
To quickly measure the whole file, press Ctrl + A and double-click  .

Print
In case you want to share information that is visible in the Viewer to people who do not have
access to the Viewer, you can use the  print option. You can for example send them a
printout or E-mail them a PDF file to indicate a measurement that you were discussing.

Note:  An elaborate annotation and approval workflow is available in Esko WebCenter.

Click  and choose which part of the file you want to print:
 

 

• Current view. Your current view/zoom, all selected channels. Also any visible measurement
results will be included.
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• Current window. Whatever the Viewer window shows will be printed (possibly extended to
fill the chosen page size). Also, any annotations will be included too.

• Image area. By default this is the whole file, no matter what the current view or zoom is.
You still have extra parameters to define the area and to choose all or only the selected
channels.

15.2.5.  Working with Graphics

Checking Barcodes

Use the  Check Barcodes tool to detect and check 1D/Linear, QR or DataMatrix codes. The
tool scans the selected area similar to how an actual barcode scanner would.

To check a barcode, click on  to activate the tool and use the left mouse button to click-
drag-release a rectangle around the barcode. Alternatively, you can first select an area and

then click .

Note:  When the area you selected contains more than one barcode, the check will only show
the result of one barcode.

Note:  For rotated barcodes, make sure the selected area contains the complete barcode.

The result appears in the Channels panel and in a pop-up near the barcode.

The measured result of a valid 1D/Linear barcode will show the Type, Value, Magnification (in
%) and Bar Width Reduction (in mm). The last two are only shown when their value is not 0.

Note:  To see an easy to read tool-tip describing the results, hover your mouse over the
barcode results (in the pop-up or in the Channels panel).
 

 

Measuring Bar Width Reduction (BWR)

The measured BWR can be slightly different from what was entered when creating the barcode
(in PackEdge, ArtPro or Adobe Illustrator (DeskPack). This is due to the resolution of the pixel
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data that are being measured. Typically, a difference in width of 1 pixel causes a different result
in the Automation Engine Viewer or when using the Inspect Barcodes task.

This table shows the maximum deviation that can occur when measuring BWR:

Automation Engine Viewer Inspect Barcodes task

Without prepared
view data

Prepared view
data at 600 ppi

600 ppi 300 ppi

Max. Dev. (mm) 0.0300 0.0125 0.0100 0.0110

Note on reading Pharma codes

A Pharma barcode can be read in 2 possible directions.

When using this ‘Inspect Barcodes’ tool, it will show 2 values. Next to those values, an arrow
indicates which direction was used to measure:
 

 
When a Pharma barcode is placed vertically,

• 'Top to bottom' equals 'right to left' when you would rotate the barcode 90 degrees CW.
• 'Bottom to top' equals 'left to right' when you would rotate the barcode 90 degrees CCW.

Checking Braille

Use the  Check Braille tool to detect and translate braille from a selected language.

To check braille, click  to activate the tool and use the left mouse button to click-drag-
release a rectangle around the braille. Alternatively, you can first select an area and then click

.

The result appears in the Channels panel and in a pop-up near the braille.
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When the braille contains multiple lines of text, the result will add a line number in square
brackets before the text of each line.

When the selected area contains more than one block of braille, the results from all blocks will
be shown. An extra number will indicate the number of the block. The tool-tip also helps to
visualise this:
 

 

Language selection
Braille is written in a specific language. The translation therefore depends on which language
the braille was originally coded in.

Right-click  to select that language. You can choose to do this before or after you measured
the braille. By default, English is selected.

Seamless View

Click  Seamless view to check how well the file is suited for seamless printing.

By default, the seamless repetition is made around the trim box. When no trim box is defined
(in the XMP metadata), the repetition will be made around the image’s boundaries.
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Activating this tool immediately shows a seamless repetition and offers these extra options:

•  to decide the color of the seamless guide lines.

•  to show or hide the seamless guide lines (keyboard shortcut Ctrl-R).

•  to set the seamless trim box to the current selection. Learn more below.

•  to reset the seamless trim box. Learn more below.

•  to enable a seamless view after you first manually defined an overlap zone. Learn more
below.

Checking if Screening is Seamless
When viewing screened data in this view, you can then zoom in to the relevant edges and check
if the file will print seamless:
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Tip:  You can use Seamless Screening in Imaging Engine to stretch the screen slightly so the dots
fit together at the edges.

Tip:  When the guide lines disturb the view, click  to hide them.

Learn more about viewing RIP'ed data in Working with RIP data on page 1038.

Making the Seamless Crop Area Smaller

To select a different area for the seamless repetition (smaller than the trim box), use the 
seamless crop tool.

This tool has two functions:

• When no selection is active, a click on  sets the current selection to be identical to the
current seamless crop area. Initially this will be the trim box, or, when none is defined, the
image boundary. You can now modify the selection to the wished trim area by dragging the
corners or sides. When done modifying, click  again to confirm. A new seamless view is
calculated and shown.

• When you already have an active selection (a rectangle in a black dashed line) that is
different from the current seamless crop area, a click on  sets the seamless crop area to
be identical to that selection.

To revert to the original seamless crop area, click .

Seamless View with an Overlap

The  Overlap option helps to check files that do not have a rectangular clipping but a die

line with a specific shape. Combined with , you use the tool to define the overlap that you
need to see the effect of a seamless print.

An example:

The file we are viewing is a label that has already been repeated for a narrow-web layout. The
staggered cut type repetition makes it necessary to define an overlap:
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Follow these steps to use an overlap in order to reach a seamless view:

1. Open the file and click  to activate seamless view (based on the trim box). The view is not
seamless yet (as in the left side of above example).

2. Click on  to enable working with an overlap.
3. Click on  to enable moving guide line(s).
4. With your mouse, approach the guide line(s) that you want to drag and move (maybe zoom

in as well).
5. When the mouse cursor changes into a double arrow, define the overlap by dragging that

guide line to the wanted new position (in an example like the above, drag the top and/or
bottom guide line inwards).

6. Click on  again to confirm that this is the new crop area you want to see in a seamless
view. A new view is calculated that now should look seamless (as in the right side of above
example).

Keyboard Shortcuts

• Ctrl-R toggles the seamless guide lines on and off.
• Ctrl-D clears the current selection.

Compensating Distortion

What is Distortion?
Distortion in graphic files is done to pre-compensate the distortion that will happen when
it is printed, for example in flexo printing. Such distortion is typically done when RIP'ing, the
last step before printing, but in some workflows the digital file is already distorted (or scaled)
before the RIP'ing.

The Viewer uses the file’s XMP metadata to detect if and by how much the file was distorted (V
and/or H).

The Compensate Distortion Tool

The Viewer offers a  Compensate Distortion tool to be able to measure the file correctly
and to be able to compare files with and without distortion. The tool only appears when the
file's XMP mentions distortion or scaling.

Note:  When comparing files, you should compensate the distortion before aligning the files.

Click  to activate or  to deactivate the distortion compensation. The tool-tip of this button
mentions what the distortion is:
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When distortion compensation is active, the size and resolution are also adjusted in the Info
panel. Here is an example where the file has a vertical distortion of 96.70% :

 

 

Compensating Scale and/or Distortion
In some workflows scaling is done instead of distortion. The viewer allows to compensate the
(XMP) scaling in the same way as it does for distortion.

When you open a file where the XMP mentions both distortion and scaling, right-click  to
choose what you want to have compensated: distortion, scaling or both.
 

 

Using Advanced View tools

Showing or Hiding Advanced View Tools
Right-click the background of the View panel to show or hide these Advanced View Tools.
 

 

Enabling Flexo Tools for Screened Data too

Because the 3 Flexo related tools  are specifically designed for non-screened data,
they are by default disabled for screened data (their buttons are greyed out).

However, these Flexo Tools can be useful for screened data too, but only if you use them at a
zoom ratio where the individual screen dots are not visible. Right-click the background of the
View panel and select the option to enable them for screened data too.

Attention:  In these tools, when entering (percentage) decimal values, use a point, not
a comma.

Total Area Coverage

The  Total Area Coverage (TAC) tool helps to identify areas where the total amount of ink in
the selected channels is larger than a given percentage.
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The percentage can be adjusted between 0 and 400%. You can use the slider or enter a new
value in the TAC Level percentage (default is 270%).
 

 

In the image area, the area exceeding the defined TAC is highlighted in a set color. The rest of
the Artwork is dimmed.

Click on the color patch to pick another highlight color. You can also change the level of
dimming (edit the percentage field or click the word Artwork and use the slider that pops up).

Flexo Plate

The  Flexo Plate tool simulates how the selected channel would look when imaged as a flexo
plate. This simulation is characterized by a First Visible Dot percentage and by a Plate Color
selection.
 

 

Here is an example in a Cyrel Red color:
 

 

Note:  This mode is possible when viewing single channels but also when using  "View
channels in separate windows".

To change the First Visible Dot percentage, click the value and enter a new percentage or use
the slider that pops up.

To change Plate Color, click the current choice to pick one from the drop down list.

Flexo Print

The  Flexo Print tool helps to predict the effect of the flexo printing process in the highlight
areas by applying a non-linear curve to the selected channels. The effect is shown immediately.
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The curve has three adjustable parameters that you can change by typing a new value or by
using the slider that pops up when you click on the parameter name.

• First Visible Dot. Under this value the output is zero (the "break out" value).

• First Dot Print as. This is the output value at the First Visible Dot percentage. This value is
typically somewhat higher than the First Visible dot percentage, creating what is typically
called a bump-up effect.

• Range. This is the highest affected input value. Between the First Visible Dot and the Range
percentage, the effect of the bump-up is linearly decreasing. Percentages above the Range
value are displayed unchanged.

Break Out

In flexo printing, the  BreakOut tool helps locating areas where the percentage of a single
separation is lower than the First Visible Dot.
 

 

The image is dimmed and the areas below the First Visible Dot are shown in a highlight color.

The First Visible Dot is best adjusted by clicking the current value and typing a new.

The options Highlight color and Artwork dimming are identical as described for Total Area
Coverage on page 1023.

Tip:  You can still use the densitometer to measure the actual percentages.

Registration error

The  Registration Error tool simulates the effect of print registration errors by randomly
offsetting the visible channels by a specified distance (the Max Error). This simulation for
example helps to check if the trapping is sufficient.
 

 

The effect is shown immediately. Here is an example:
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When you change the value of the Max Error, click Try Again to see the new effect. This
allows using zoom and pan tools to visually inspect the effects of a given registration error on
different parts of the design.

Note:  The tool randomly shifts all channels with the Max Error distance, but all under a
random angle.

If you want to see another random simulation, click Try Again.

15.2.6.  Comparing Files

Intro

The viewer allows to compare files and inspect their differences.

To compare two files, open a first file ("Current"), then click the  Compare button and
choose a second file ("Reference") from the dialog.

In compare mode, an extra toolbar offers to rotate, mirror or invert the reference file or align
the 2 files.

The extra buttons in the Channels panel (and also the Top Tools bar) offer several ways to view
the differences.
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Tip:  While comparing, you can still use other tools like changing view windows, zooming,
panning, rotating, measuring etc.

You can stop comparing and close the reference file by clicking  again.

Two Ways of Comparing

The Viewer offers 2 comparison modes:

• Compare Channels. This is the default mode. It shows differences that it finds in channels
with identical definitions. Learn more here.

• Compare HSV. This mode compares colors. Learn more here.

File Types and Precision

You can compare files that have a different file type. For example comparing an AI design with
its final production PDF or comparing that one-up PDF with its step & repeat version, or even
with its RIP'ed version.

Some file types require a conversion before they can be shown in the Viewer. These
conversions can cause small, insignificant differences. Here are some general guidelines
regarding differences in different file types:

• Be aware of hidden file conversions as described in How different Graphic File Types are
Streamed to the Viewer on page 995.

• Do not compare prepared with non-prepared files. Especially the 'Compare Channels'
mode will detect differences due to the different sets of pixels in the Viewer.
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• When you need to compare an Esko normalized file with its (original) non-normalized
version, you can set up a workflow where you always keep the first file version right after
the normalization, before you start to edit it, and then compare that file with the (final)
edited version.

Note:  The tool to Calculate Screening and Angle ( ) is disabled when you are comparing
files and at least one of the files is not RIP data (a PDF for example).

Comparing Files that have Different Channels

The Channels panel shows you when the compared files have different channels:
 

 

• (+) means that the channel is only present in the current (first) file.

• (-) means that the channel is only present in the reference (second) file.

Alternatively, you can also use the Compare HSV mode to compare files with non-matching
channels.

Difference View Modes and Options
•

 to view only the current version (the file you opened first).

•
 to view only the reference version (the file you opened later, to compare).

Tip:  Use Ctrl-S to toggle between the view of the current and the reference file.

•
 to view both files on top of each other, highlight the differences and dim all other

areas. Right-click this button to choose other variations and extra options. Learn more
below.

•
 to view a blinking mode that switches the view of each file at a fixed interval.

•
 to view both files on top of each other. This is typically used when the two files

together form a complete layout, for example a left and right page of a reader spread. Or
when two (similar) parts of a package design are created separately, but you here want to
check how they align.

•
 to view both files side by side, as an alternative way of comparing. The displays in each

split window stay synchronized when you work with channel selection or change views and
zooms. Right-click this button to select a different tiling orientation or to decide whether
you want to see a third window with the differences.
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Extra Options when Viewing Differences
 

 
Right-click the (currently active) View Both icon to choose variations or other options:

• While viewing both files, choose how you want to see the differences:

• Select  to see both files and the differences highlighted.

• Select  to see both files dimmed and the differences highlighted.

• Select  to only see the highlighted differences. This mode is especially useful to spot
small differences in the Navigator panel or when zoomed out viewing the entire file.

• Change the Highlight Colors.

• Choose the Compare Mode.

•  Compare: Channels. This (default) mode shows differences that it finds in channels
with identical definitions. Learn more in Matching Channels on how to define if similar
channels should be compared or not.

•  Compare: HSV. This mode compares colors. It looks at the two files as your eyes do or
as a camera or scanner would. For example a green object will not be seen as different
even when in the one file it is colored as a PMS color and in the other as an exact same
color mix of cyan and yellow.

•  Compare: Automatic: With this setting, the 'Channels' mode is used when the
definition of all visible channels is equal in the two compared files. When this is not the
case, the 'HSV' mode is used.

• Hide/Show Difference Adjustment options in this Channels panel. Learn more in
Difference Adjustments on page 1030.

• Channel Matching. Learn more in Matching Channels on page 1030.

Using Difference View Combined with Measuring

The measurements of dot percentage, pixel count, screen ruling and angle change depending
on the selected difference view mode. When the view shows both files, the measurement
results also show any different values in between brackets (if any).
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Difference Adjustments

Compare Modes
These modes are described above in Extra Options when Viewing Differences on page 1029.

Difference Threshold
When comparing files that are not perfectly aligned or that have minor tonal differences, you
can specify a threshold on when a difference should be highlighted. This allows you to make a
distinction between minor and major differences.

Type a percentage in Difference Threshold or use the slider that appears when you click on
the small arrow.

Here is an example where the lines that are due to a file conversion disappear when changing
the threshold to 5:
 

 
 

 

Matching Channels
Sometimes you may want to compare channels that do not have a same channel definition.
For example:

• A channel that is actually the same but has a different display color in the 2 compared files.
For example an ink 'Cut' that was defined to look green in one file and pink in the other.
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• Channels that are related but have different ink names in the 2 files. For example '123'
and 'Pantone 123 C'.

The Channel Matching dialog allows you to make manual matches or define automatic
matching rules.

The dialog opens when you select it from the list of  'View Both' options, or when you click
on a channel name (when in compare mode).

Note:  When selecting a new file for comparison, you might be prompted to open the dialog if
the compared files contain non-matching channels.

 

 

• Initially, the 2 columns list the channels of the 2 open files.
• Above the horizontal line are the channels that are already matched. Their names are

shown in bold and they are placed opposite to the channels they match to.

Tip:  Hover the mouse over a color patch and you will be shown the full channel definition.

Automatic Channel Matching Rules

Choose which rule this automatic matching should follow:

• Match only if identical: Only channels that have identical names, ruling, angle, dot shape
and display colors are matched automatically. For example, in the above screenshot, notice
on the left how a second black ink (K) is not matched because it has a different ruling or
angle.

• Ignore display RGB differences: Channels are automatically matched when their name,
ruling, angle and dot shape matches. Differences in display colors are ignored.

• Also use smart name matching: In addition to ignoring display color differences, this
setting also matches channels that have a different ruling, angle or dot shape or have
related names. Some examples:

• An ink 'K' at 120 LPI will match to the other file's ink 'K' at 66 LPI.
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• Inks with names that only differ in use of upper and lower case. For example: 'Kiwi
Green' will mach to 'Kiwi green'.

• Inks with names that only differ in color book specification. For example: '660' will
match to 'Pantone 660 C' and 'Cyan' will match to 'Process Cyan'.

• Inks with names that are known abbreviations of each other. For example 'C' and
'Cyan'.

The effect of the chosen rule is immediately shown in the two columns.

Note:  Select Make this setting the default when you not only want to apply this rule to the
current file, but during every comparison (without need to open this dialog).

Manually Matching Channels

When the automatic matching does not yet match all the channels that you want to compare
directly, you can also manually match channels.

To do this, select the source and the target channel (one in each column) and then press  or ,
depending on which way you want the mapping to go.
 

 

Channels that changed are marked with an asterisk (*).

To revert a channel to its original definition, select it and click .

Alignment Tools
Alignment tools help you compare files with different sizes, or files with the same size where
the content is offset differently from the trim box.
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You can align such files by using these tools:

•
 Rotating, mirroring or inverting the reference file might already help to align.

• Click  to choose any of these methods:

• To align both files on a specific corner.
• To align both files with the help of the ruler tool. Learn more in Align from Ruler, Auto Align

from Ruler and Auto Align.
• Click  for a quick access to Auto Align.
• Click  to align based on their margins (trim box). When no trim box information is

included in the file's XMP, the file's boundary is used instead.
• Use  to indicate an offset manually.
• Click  to use the alignment settings for other pages in this file.

Align from Ruler
You can use the ruler tool to indicate a point in each file that you want to align.

1. While viewing the differences, zoom in on an area where you will indicate two alignment
points that represent the same position in their file, for example a corner of an object.

2.
Click  to view only the reference file.

3. Click  and select  Align From Ruler from the list. A pop-up dialog will remind you how
to proceed ; click OK to close it.

When your mouse cursor is at this moment showing a  zoom or  pan tool, click  to
turn it into a + cursor.

4. In this reference file, click to indicate the first alignment point.
For example you can select a corner (shown here in a red circle):
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5.

Click  or use Ctrl + S to switch to the current file. Use shortcuts for a one-time zoom or
pan.

6. Indicate the corresponding point, that will now be in a different position.
In our example, that same corner (shown here in a blue circle):
 

 
7. Click  again to align the files according the alignment points indicated.

Switch back to the "View Both"  mode to see how well this worked:
 

 

Note:

Depending on how precisely you defined the second point, you may have to zoom in and
repeat the steps above to align your files with more precision.

Alternatively, you can align your files more automatically using the Auto Align from Ruler or
Auto Align tools.

Auto Align from Ruler

 Auto Align from Ruler is used the same way as the Align from Ruler tool, but is more
accurate at a high resolution.

When the data surrounding the alignment points match, the tool will be able to increase the
alignment precision (and have a good alignment with fewer iterations).

Auto Align
Auto Align (Ctrl + L) does not use the ruler, but uses the currently visible view of the two
compared images to attempt an automatic alignment.

1034



15Automation Engine

Using this tool repeatedly with one or more zoom-ins can be a very easy and fast way to align
two files.

For convenience, a separate tool button  is available to perform an automatic alignment

without having to open the  alignment pop-up menu.

When a ruler selection is active, clicking  performs an Auto Align from Ruler, otherwise it
does an Auto Align based on the current view.

15.2.7.  Working with Annotations

Based on XFDF

The five "Inspection" tasks generate XFDF files that contain inspection annotations. These XFDF
files are written in a hidden subfolder.

When viewing a file in the Automation Engine Viewer that has such XFDF data, the 
Annotation list button appears in the tool bar.

Click  to see the file's annotations in the Annotation list panel.
 

 

The Annotation List Panel

• Click its toolbar icons to choose the type of annotations that you want to see detailed. Tool-
tips mention their type. They are greyed out when no such annotations are available.

• Each annotation is assigned a specific number and color.
• Select an annotation in the panel to see it's colored rectangle highlighted in the main

window. When Fit view to selected annotation is selected, the window will also zoom in to
that object or found difference.

• For multi-page files, the panel shows the annotations of all pages.
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• Annotations can show as outdated when the modification date of the viewed file is newer
than the date when the inspection task was run on that file (modification dates of any
referenced files from the input file are not taken into account).

Learn more about the content of the annotations in the pages on their respective task: Inspect
Barcodes, Inspect Braille, Inspect Spelling, Inspect Artwork, Inspect Text.

Caution:  When you move or copy the input file using the Copy or Move File task or the
Publish on WebCenter task, the hidden folder with the XFDF file will be moved as well.
However, when you move the input file with other tools, Automation Engine is not
aware and the XFDF file will not move along and will so not be found from the new file
location.

15.2.8.  Working with Multi-Page Files

When opening a multi-page file, extra viewing tools become available:

Page List Panel

Click  to open the Page List panel. Right-click  to define the size of the thumbnails.

Click on a thumbnail to see that page in the main window.
 

 

Note:  The Top Tools bar also offers , a tool to mark pages. However this tool is only useful
in the Esko WebCenter Viewers.
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Keyboard Shortcuts

• End. Go to last page (last file when multiple files open)

• Home. Go to first page (first file when multiple files open).

• Page Down. Go to next page.

• Page Up. Go to previous page.

Reader Spread View

Click  to enable a Reader Spread view, showing pairs of pages as they will appear in the final
printed result.

Attention:  The compare mode is disabled while reader spread view is enabled (and
visa versa).

A reader spread shows two pages stitched together on their trim boxes. First and last pages
are shown with an empty (white) area next to it.

Clicking  now shows the previous / next reader spread.

In reader spread view, one page is the active page. That page has its page number highlighted

in the Page list panel and, when clicking , its trim box is shown.
 

 

In the View panel, right-click  to use these page related options:
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• choose to show the margins (trim box) of both pages when in reader spread view.
• choose to only clip on margins in reader spread view.
• choose to show the margins of the two pages in different colors.

Comparing Multi-Page Files
When comparing two multi-page files, the Viewer presents an option panel:

 

 

• Compare to page. Select which page in the reference file you want to compare with the
current page in the current file. By default, this is the page with the same page number (if
this page exists).

• Decide which (other) pages should be compared:

• Current page only.

• Current and following pages. As long as there are pages in both files, it continues
comparing their next pages.

• All pages. Same as above, but now also compares the pages before the current one, if
any.

15.2.9.  Working with RIP data

A Composite View of RIP'ed Separations

Note:  As mentioned in Supported File Types, RIP'ed files require prepared view data before you
can open them in the Automation Engine Viewer.
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When you want to see a composite view of all RIP'ed separations of a file, you do not need to
multi-select these files in the Pilot and click 'View'. You only need to select one of them and
click 'View'. The viewer will automatically load the other separations. Alternatively, you can also
select one of them from within the Viewer.

This mechanism does require that the "Prepare for Viewer" task was launched on all files
together and that the option 'Group Digital Film' was enabled.

Measuring Screen Ruling and Angle

When viewing RIP data, the Top Tools panel also offers , the Calculate Screening and Angle
tool.

Restriction:  This tool is disabled when you are comparing files and at least one of the files is
not RIP data (a PDF for example).

Similar to the  densitometer, you can click on a point or click-drag an area to be measured,

or you can double-click  to make a measurement based on the current selection or, when
no selection is active, the current view.

The results show up in a pop-up and in the Channels panel. Click the small triangle to choose
the measurement units or use Ctrl-Shift-U:
 

 

Note:  When no ruling or angle can be measured, no values are shown for that channel
(because there's no such data in that area or there's only 100% data).

Changing the Orientation of the Screen Angle

Right-click  to change the way measured screen angles are shown:

• Screen Orientation from XMP (default). Same orientation as in the file's XMP ( ), which is
usually the angle as it is intended to be printed. The XMP of files created by Imaging Engine
14.1.1 and later will have an indication of the orientation. When no XMP orientation info is
found, "Screen Orientation CW" is used.

• Screen Orientation (C)CW. You can also choose to see the screen angle CW (clockwise,
downwards counting) or CCW (counter-clockwise, upwards counting).
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Checking Registration Errors while Viewing Dots

The  registration error tool is also available when viewing RIP data.

Here is an example where a white gap appears on a file that was trapped with 0.2 mm, while
simulating a max error of 0.3 mm:
 

 

Extra Set of View Data for Print Simulation

When using advanced screening effects, it is possible that the dot on screen does not look like
the dot when printed.

Esko RIPs allow creating an extra set of view data that simulate the printed dots. This is an
extra option in the tab 'Output' of an Imaging Engine task ticket.

An example. On the left we see a Concentric screen at 27% (with its typical ring-shaped holes).
On the right we see its print simulation, where the holes were filled with ink:
 

 

Learn more about creating print simulation view data in the user guide of Imaging Engine, in
Inspecting Screens with Advanced Screening Effects on page 1126.

Note:  For the Automation Engine Viewer, both the RIP files and the extra print simulation files
(with an extension .view) still need to be prepared for viewing.

15.2.10.  Keyboard Shortcuts

Note:  Many of these keyboard shortcuts are also mentioned on the page describing the
related topic.

On a Mac, as a standard practice, replace below mentioned Right-click by ctrl-click and
replace Ctrl- by cmd-.
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Table: Keyboard Shortcuts

Ctrl-Down Arrow Pan 1/4 window down

Ctrl-Left Arrow Pan 1/4 window left

Ctrl-Right Arrow Pan 1/4 window right

Ctrl-Up Arrow Pan 1/4 window up

End Go to last file or page

Home Go to first file or page

Page Down Go to next file or page

Page Up Go to previous file or page

Ctrl-Shift-Spacebar Temporarily shift to pan mode (hand)

Ctrl Switches the zoom in tool to a zoom out tool

Ctrl-'+' Zoom in by a factor 2

Ctrl-'-' Zoom out by a factor 2

Ctrl-Shift-'+' Rotate view 90 degrees clockwise

Ctrl-Shift-'-' Rotate view 90 degrees counter clockwise

Ctrl-0 Show all channels

Ctrl-1 to Ctrl-9 Show channel 1 to 9

Ctrl-Shift-0 to Ctrl-
Shift-9 Show channel 10 to 19

Ctrl-A Select all

Ctrl-D Clear selection

Ctrl-H Toggle overprint highlight on/off

Ctrl-L Auto align

Ctrl-M Mirror view

Ctrl-N Toggle between channels showing them one at a time

Ctrl-O Open (current) file

Ctrl-R Toggle seamless view guide lines on/off

Ctrl-S Toggle between current and previous view (in difference view mode)

Ctrl-U Toggle size units

Ctrl-Shift-U Toggle resolution and screen ruling units

Ctrl-Shift-V Displays (2 seconds) the current view resolution

F1 Show online help

F2 Previous view
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Shift-F2 Next view

F5 Zoom in

F6 Zoom out

F7 Temporarily shift to pan tool. Returns to previous tool after one pan
operation

F8 Temporarily shift to zoom tool. Returns to previous tool after one zoom
operation

F9 Zoom to fit image in current view

Table: Mouse Shortcuts

Right button + click Zoom in by a factor 2

Right button + drag Zoom in on the selected area

Right button + Ctrl + click Zoom out by a factor 2

Double-click Screening and

Angle tool 

Measure screen ruling and angle centered in current
selection

Double-click Densitometer Measure dot percentage for current selection (if any present)
or current view

Double-click Zoom tool 
Zoom to fit selection (if any present) or full image

15.3.  PitStop Preflight

15.3.1.  Preflight Concept

Preflighting can be done for several reasons:

• Just to check a file (no "fixes" done).
• To check and correct ("fix").
• To do more than just fixes, to edit a file through one or many "actions".

There also several ways to make preflighting a part of your workflow:

• You can send the design back for others to correct it.
• You can correct what was found to be wrong and continue the workflow.
• Right before sending the file to output, you can do (another) final check, now to prevent

outputting wrong data.

Tools
Automation Engine's PitStop Profile Editor is where you can create and manage
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• PitStop Profiles: A set of rules that a file's content should adhere to.

• PitStop Action Lists: A set of changes you want to execute on a file.

In Automation Engine, you can use these profiles or action lists by using the Preflight with
PitStop task.

15.3.2.  The PitStop Profile Editor

You can create and manage PitStop PDF Profiles and Action Lists in Automation Engine's
PitStop Profile Editor.

You can find an extensive documentation on PitStop on https://www.enfocus.com/en/support/
manuals/pitstop-server-manuals.

We here limit our description to topics specific to Automation Engine:

Setting Up the PitStop Profile Editor
This tool is one of the client tools that you can download from the Automation Engine Server
Web Page.

1. Open this Server Web Page by entering http://<name of your server>  or http://
<name of your server>:9999 in the address field of your browser. You can find this tool
in the section Client Apps, in the page Tools.

2. Click Download to install the PitStop Profile Editor on your client computer.

• On Windows:

1. Double-click the downloaded Automation Engine PitStop Profile
Editor.exe.

2. Click Next and click Yes to confirm the installation.
3. Browse to the install location, by default C:\Esko.
4. Click Next and click Finish.

• On Mac:

1. Double-click the downloaded Automation Engine PitStop Profile
Editor.dmg.

2. Double-click the resulting .pkg file.
3. Click Continue and click Change Install Location to specify an install location.
4. Click Install and fill in your credentials to confirm.
5. When "The installation was successful" appears, click Close to finish the

installation.
3. Start the application from:

• (Windows)All Programs > Esko > Automation Engine PitStop Profile Editor > PitStop
Profile Editor.

• (Mac)Applications > Automation Engine PitStop Profile Editor > PitStop Profile
Editor.

4. In Edit > Preferences, fill in the host name of your Automation Engine server. This is
needed to make this tool see the profiles and action lists on that server. 
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Smart Preflight: Using Variable Names in PitStop Profiles
Juts like when using task Tickets, you can reduce the number of profiles and action lists by
using SmartNames . In PitStop terminology, this concept is named "Smart Preflight".

Follow these steps:

1. Use the Pilot to create SmartNames. Learn more in Creating a SmartName (General) on page
605.

2. In the PitStop Profile Editor, select one of the PDF Profiles and click on . Choose New
and choose any of its options.

3. In the open profile, enable one of the options in the category CHECK ON.
a) Choose any of the Available Checks.
b)

Click on  and choose Enable Variable Names('Variable Names' is PitStop's
term for SmartNames).

4. Click on  the blue SmartName icon to open a list with all global SmartNames.
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5. Select a Variable (SmartName) and click OK.

You can use a SmartName in fields that require

• text
• numbers
• measurements with a size in "mm", "cm" , "in", "p" (picas) or "pt" (points)

Attention:  Measurements needs to include the unit! For example "210 mm".
When no unit is specified, it assumes points as unit.

For example, to represent A4 dimensions, the SmartName should resolve to
"210 mm" and "297 mm". If the SmartName resolves to "210" and "297", the
dimensions will be seen as 74 mm x 105 mm .

• a toggle that sets a check-box to on or off.

• Off = a SmartName value "0", "FALSE" or empty.
• On = a SmartName value "1", "TRUE" or anything else.

15.3.3.  Preflight with PitStop Task

Basics of the Preflight with PitStop task

The Preflight with PitStop task allows you to preflight a PDF file in Automation Engine using
technology from Enfocus. This KB article shows which version of PitStop is used internally in this
"Preflight with PitStop" task.
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Attention:  When the input file is a normalized PDF, the task does not allow to run
profiles with the option "Allow Fixes" selected. It then also does not allow to run
action lists, regardless whether these actions change the file or not.

Note:  This task uses the latest Enfocus PitStop Server preflight technology (its version number is
mentioned in the report).

Preflight Result States

As a workflow step, this task by default offers four output pins where your input files can end
up (hover your cursor over a pin to see its default name):
 

 

• Finished OK: When the preflight resulted in an OK status (no warnings or errors were
found).

• Finished with Warnings: When the preflight resulted in warnings (but no errors).

• Finished with Errors: When the preflight resulted in one or more errors.

• Error: When the task encounters an error unrelated to the preflight status.

Learn more about controlling task statuses here.

Preflight Tab
You can use this task to run one or more Action Lists and/or run a preflight Profile.

Attention:  An Enfocus preflight profile can also contain action lists.
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You can create action lists and profiles in the PitStop Profile Editor that comes with Automation
Engine.

• Action Lists: Use Add or Remove to define which action lists you want to run. Use Move
Up / Down to change the order in which they will be executed.

• Profile: If you want to check the PDF against a profile, select a preflight profile from the list.

Note:  You can use Variable Names inside profiles or action lists. This makes the profile or
action list 'smart'. Learn more about this concept of Smart Preflight in Smart Preflight: Using
Variable Names in PitStop Profiles on page 1044

Extra Task Status Options When Used as a Single Ticket

When you open a single ticket (when it is not a step in a workflow), extra options appear (as in
above screen shot):

• In When rules are violated, choose what happens when preflighting results in errors: Task
ends with warning or Task fails.

• In When warnings appear, choose what happens when preflighting results in warnings:
Task ends OK, Task ends with warning or Task fails.

Attention:  Learn more here about controlling the statuses when this task is a workflow
step.

Certified Tab

Concept of Certification

Certifying a PDF means that you embed a 'proof of preflight' in the PDF. The generator of a PDF
can so embed a proof of having done a preflight with a specific profile.

The receiver of that PDF (for example a printer) can then check whether the generator did this
required QC step before sending him that file. Some industry partners may even only accept
PDF files with specific PitStop Certifications.

Here is an example of how a certification is documented on board the preflight report:
 

 

Whereas a regular PDF only contains Acrobat metadata, an Enfocus Certified PDF contains a
lot of additional information ("Enfocus metadata"), such as the used preflight profile and the
version history.
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You can also use this task to remove an (earlier made) certification or to insist to keep it.

The certification itself can be checked separately by the Verify Certification task, for example at
the start of the workflow at the printer.

Note:  To learn more about the certification concept and workflow, search for
"Understanding Certified PDF" in the PitStop (Pro / Server) reference guides.

Options
 

 

• Set Certify to

• Make Certified to certify the file according the profile selected in the tab "Preflight".

• Keep Certified to preserve the existing (un)certified status of the file.

• Make Uncertified to remove all the certified information from the file.

When choosing Make Certified or Keep Certified, you can define these extra parameters:

• Add a User name, E-Mail or Session Comment to the certified PDF.

• Allow to roll back: Enable this if you want the users to be able to roll back to previous
versions of the file (for example to compare). When you disable this, the certification history
will still be in the file but users can not roll back to previous versions.

Attention:  Because the roll back option stores extra data, the PDF file size can
increase drastically.

Report Tab
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• Decide if you want to Generate a report and where this Report should be written.
• Settings for the generated report:

• Units: Choose from Inch, mm, cm, Point or Pica.
• Language: Choose one from the list.
• Type: Choose if you want a PDF or XML report, or both.

Preflight Report Contents

A preflight report contains the Errors and Warnings found during the preflight, and also lists
the Fixes it may have done.

An example of the first page of a PDF report:
 

 

Tip:  You can make reports appear on their own task status output pin. Learn more in
Configuring Output Statuses  on page 696.
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Color Tab
 

 
Preflighting often includes color conversions. Unlike normalized PDFs, native PDFs can contain
objects in RGB or device independent color spaces.

When the action list or profile includes a color conversion, you can here specify the default ICC
profile that will be used for objects that were not tagged with one yet.

To do so, select Enable Color Management and choose an ICC profile for the object types in
Grayscale, RGB, CMYK or Lab.

15.3.4.  Verify Certification Task

Note:  The concept of certification is described in this page about the tab 'Certify' in the 'Preflight
with PitStop' task.

Certifying a PDF stores the preflight information on board the PDF file. This includes the
preflight profile, the preflight report and the information whether the PDF has subsequently
been modified.

If you do not re-certify a PDF after it has been modified, it is no longer certified.

You can certify a PDF using PitStop Pro, PitStop Server or by using the 'Preflight with PitStop'
task.

The Verify Certification task checks if the PDF file was certified to comply with the settings of
the profile that you indicated in Verify against a Profile.
 

 

The task's status will be 'Verification OK' when the profile that was used to certify the PDF is
identical or stricter than the profile selected in this task.
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15.4.  Global Vision Inspection Tasks

15.4.1.  Introduction

Automation Engine offers a set of tasks that use technology from the company Global Vision:

• Inspect Artwork compares files.
• Inspect Barcodes detects and decodes barcodes in the file.
• Inspect Braille detects and decodes braille in the file.
• Inspect Spelling checks spelling (of a chosen language).
• Inspect Text checks text rules.

Profiles

Several of these tasks ask you to select an inspection Profile. You can change and create such
profiles using the Global Vision profile Editor.

These Tasks Require a Software License from Global Vision

To enable these Inspection tasks, you need to get a license from Global Vision and then have it
installed on Automation Engine. You can also purchase this license via Esko, as a subscription.

Learn more in the Configure panel where you do this.

15.4.2.  Recurring Options in Global Vision Tasks

The following options are available in several Global Vision tasks:

Resolution

Several tasks first rasterize the files to RGB files and then inspect that data (PNG files). This
option allows you to define the resolution of these RGB images. The minimum supported
resolution is 72 ppi, the maximum is 2400 ppi.

Note:  The default resolution is 300 ppi. Do not set this higher when it is not necessary.
Creating high resolution raster data is a significant load for the server. See this other note with
specific information about a different resolution that is used to inspect barcodes.

Note:  Low resolutions like 72 ppi may not be good enough to detect differences. Especially
braille needs a higher resolution.

Note:  These RGB images are written in a central temporary folder that is automatically
deleted when the task ends successfully.
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Region

This option allows you to indicate the region in the master file that you want to have inspected.
All artwork outside that region will be ignored during the inspection. This region can be
rectangular or have the shape of a (die-)line.

Tip:  Smaller regions will also create smaller rasterized data and so speed up the inspection.
This is also true when you select or ignore specific inks or layers (see below).

Note:  In case of the Inspect Artwork task, this is the region of the master file that you want to
compare with the sample file(s). Adding to below mentioned general rules, learn more specifics
in Compare Artwork Tab on page 1059.

Several regions match to the standard PDF page boxes:
 

 

• Trim Box. The area after cropping to an area with all content. When no trim box is defined,
the crop box will be chosen. When no crop box is defined, the media box will be chosen.

• Media Box. This is the entire "real" page and may be larger than the actual crop box.

• Visible Objects. Automatically crops to the area with all content, starting from the crop box.

• Crop Box. Adobe Acrobat uses this size for screen display and printing. When no crop box is
defined, the media box will be chosen.

• Shape. Locates the largest object in center of the master file and uses that shape as region.
This might be a rectangle or a circle (labels, pages...) or a specific shape typically defined by
a die-line (boxes). An example:
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Alternatively, you can define the shape in the Options... dialog:

• Define shape by Inks. Use this when you want to specify the shape by using the
bounding box of all data in the here defined ink. You here typically define the ink of the
die line. All objects inside the shape (contour) that can be formed out of the data in that
ink will be inspected. Process inks are not supported to define a shape.

Click on  to get a list of the inks of the input file. Use Ctrl/cmd- or Shift-select to select
multiple inks.

Note:  In case of the Inspect Artwork task, although you here selected them from the
input file, the ink(s) will serve to find a region in the master file.

Note:  The input field is not case sensitive.

Attention:  When specifying multiple inks (for example "die,cut,knife"),

• only the first one of which a shape can be made will be used.
• when none of them can be used as a shape, the task will result in an error.

• Define shape by Layers. Similar to above Inks. All objects inside the shape (contour) that
can be formed out of the data in that layer will be inspected.

Ignoring Ink or Layers

Ignoring an ink or layer means that their data will not be part of the raster image and so not
part of the inspection.

• Ignore Inks. Click on  to have them read from the task input file (you can multi-select
in this dialog). Use this for example if you have made a difference in the ink used for text.
In such case, you could here choose to ignore that ink to check if there are any unwanted
differences in the other inks.

• Ignore Layers. Same as above "Ignore Inks", but to ignore layers. You can for example
ignore the layer that contains the images.

Attention:  It is also common to here ignore the ink or layer that was used to define
a region based on a shape. For example: inspect the region defined by the shape of
the ink "die line" and also here also add the ink "die line"'to ignore it from the
comparison.
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Report

All "Inspect" tasks write report(s).

• Report File. Define the report's location and name. When you use SmartNames to define
a relative path, the report will be created relative to the parent folder of the input file. The
task will fail when the report tries to overwrite the input file.

Tip:  You can configure an extra output pin to see the report appear on its own pin. Learn
more in Configuring Output Statuses  on page 696.

• Report Type. Choose whether you want a PDF and/or an XML report.

• A PDF report contains several pages, showing and describing what it found during the
inspection. The first page shows the bounding box of the region that was inspected.

The first page of the report shows a preview of the RGB data. It also shows bounding box
around the region that was inspected (in pink). When any inks or layers were ignored,
this data will also not be shown here.

• An XML report contains the file URLs and details of what was found during the
inspection.

• Add annotations output pin. This will add an extra workflow step output pin so it becomes
possible to launch specific tasks on the XFDF annotation file (if the type of task writes it).
learn more about working with these annotation files in Inspection Results as Annotations in
Viewers on page 1054.

15.4.3.  Inspection Results as Annotations in Viewers

The five "Inspection" tasks generate XFDF files that contain inspection annotations. These XFDF
files are written in a hidden subfolder.

These annotations show up in the Automation Engine Viewer. Learn more in Working with
Annotations on page 1035.

These annotations can also show up in the WebCenter Viewer. Learn more in the below page
about Seeing Inspection Annotations in the WebCenter Viewer on page 1054.

Seeing Inspection Annotations in the WebCenter Viewer
There are 2 ways to see the annotations in the WebCenter Viewer:

• When publishing an inspected file from Automation Engine to WebCenter.
• When launching the inspection from WebCenter itself.

Publishing an Inspected File to WebCenter

When you ran an inspection task in Automation Engine and you then use the Publish on
WebCenter task, you can select its option Publish Annotations to make sure that also the XFDF
file is published to the chosen WebCenter project.

When you then view the document in the WebCenter Viewer, the annotations will also be
visible.
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Launching the Inspection from WebCenter

In this case, WebCenter triggers the inspection(s) (and creation of the XFDF). It does this as part
of a WebCenter Task that triggers a workflow on its own OBGE (or on an external Automation
Engine).

We illustrate this workflow by means of an example:

Attention:  This example assumes you are familiar with creating WebCenter Tasks.
Learn more in the WebCenter documentation.

Here are the main steps to set up this workflow:

1. In your WebCenter project (template), define a WebCenter Task that contains a Submit
Workflow that will launch the inspection task(s) on a graphics file.

2. The Submit Workflow step in that WebCenter Task links to a workflow that uses inspection
tasks where you configured an extra output pin in for the annotation file. This XFDF file is so
forwarded to the Integrate with WebCenter task (more details on this task in below steps).
For example:
 

 
3. The Submit Workflow step in that WebCenter Task needs to use the Workflow

Parameters "Add Document properties" See an example:
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Optionally, also use Add all Document Attributes. This can for example be useful to
communicate the document's language to the spelling inspection.

4. In workflow that is being submitted, in the Integrate with WebCenter ticket(s), the action
"Upload Document Annotations" is used.

In the Options of that action, use the workflow parameter [wfp.document.versionid].
This is needed to associate that (set of) annotations with that document version. An
example:
 

 

15.4.4.  Inspect Artwork

Note:  This is one of several inspection tasks that use technology from the company Global
Vision. Learn about the general concept and setup in the Introduction on page 1051.
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Concept and Workflow

Concept

This task compares one or more 'sample' files to a 'master' file. It selects the defined region of
interest, aligns the files and then compares them. It supports multi-page inspections as well as
step & repeat files.

Comparing files is typically done

• to make sure files are identical when you ignore a specific ink or layer.
• to make sure only the intended differences are there.

The tasks detects these types of differences:

• Text changes (moved, missing, broken, added)
• Font changes (size, style)
• Graphics (deletion, insertion, change)
• Color
• Registration

Technique

The task prepares RGB raster data of the sample and master file at a custom resolution and
then compares that raster data.

This task compares colors, meaning the way as if a human eye or a camera or a scanner looks
at the files. For example if the task sees that a green object is the exact same color in both
master and sample file, it will not see this as a difference, no matter what separations that
green color is made up of.

Note:  In the Automation Engine Viewer, the default compare mode is one that compares
separations ('channels'). In that mode, the Viewer will detect a difference if the same green
object is in one file made up of a Pantone ink and in the other file a mix of CMYK. The Viewer
also offers the mode to compare HSV values, which is similar to the mode this task uses.

Note:  This task is similar to the Compare PDF task.

The found differences are mentioned in the report file but are also written as an XFDF file (a
standard Acrobat comments file). When you open the inspected sample file in the Automation
Engine Viewer, the viewer will read this XFDF file and show its contents in the annotations list.
Learn more in Working with Annotations on page 1035.

Smart comparing

The task automatically uses these features:

• Rotation detection. The task detects if the sample file is a rotated version of the master file
and takes this into account when inspecting.

• Skew correction and alignment. This is for example useful when one of the files is a scan
that was slightly angled when being scanned.
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• Repeat detection. The task automatically detects if a file is a repeated area inside the other
file. Such detected repeats are mentioned and shown in the report file.

Supported File Types

The sample and the master files can be any of these file types:

• PDF
• Normalized PDF
• PDFPLA
• AI Adobe Illustrator (when PDF compatible)
• TIFF (1-bit and 8-bit. Multichannel images are not supported)
• LEN
• JPEG
• PNG
• BMP
• Folder

Detailed Reporting

A detailed PDF report lists and visualises the found differences. An XML report details the
coordinates of where differences were found. Learn more in Report Tab on page 1060.

Status and Workflow Output Pins

The sample file (task input file) is also the task output file. This makes it easy to continue your
workflow with this file. It will be placed on one of these output pins:

• Match. When no differences were found.

• Mismatch. When one or multiple differences were found.

• Error. When the task itself could not function properly. For example when no profile was
selected, when the master file could not be found or when the files could not be matched.

See an example (to help visualize the output pins, an end status step was created with the
same name as the status):
 

 

Tip:  To get that extra output pin for the report(s) as in above example, you will need to
configure it as mentioned in the page about the inspection report.
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Integration with Automation Engine Viewer

When opening the sample file in the Automation Engine Viewer, the area where differences
were found are shown in red rectangles and automatically become part of the Annotations
list. Learn more in Working with Annotations on page 1035.

Compare Artwork Tab
• Compare With. Indicate the master file you that want to compare your input sample file(s)

with.

Note:  This field needs a full URL (path). When using SmartNames, make sure you also
define a file extension.

When the task input is a folder, you here also need to define a folder. The first file in the
master folder is compared with the first one in the sample folder. The second master one to
the second sample one, etc. When the amount of files in the input folder is not equal to that
in the master folder, the task ends in error. The task does not check files in subfolders.

• Compare Resolution. This option is present in several Global Vision tasks. Learn more in
Generic Option "Resolution".

• Profile. An inspection profile is a collection of parameters that define how (precise) to
inspect. Profiles differ (slightly) in thresholds of what you consider as differences. They are
centrally located *.ini files that you can adapt using the "Global Vision Profile Editor". You can
there both adapt the default inspection profiles or create your own.

Attention:  The profiles listed below are the default ones from Global Vision. You
might use a (test-)version that already offers other profiles that were fine-tuned for
Esko prepress workflows.

• None. The task will end in error when you do not select a profile.
• Booklet. Choose this setup to compare multi-page files. It will compare all pages of the

sample file with each same-number page of the master-file. Alternatively, for a slightly
more precise inspection, choose Digital and select Multipage.

• Digital to Scan. Choose this profile to compare a digital artwork file to a scanned master
file.

• Digital. Choose this profile to compare revisions or variations of digital artwork.
• Proof. Choose this profile to compare files that are supposed to be the same. This is

typically to compare digital artwork against a digital proof. Also use it to compare a
proof against a printed hard copy. This profile uses refine, auto distort and smoothing to
compensate for changes in the image.

• Scan to Scan. Choose this profile to compare scanned files.

Note:  The parameters of the chosen profile are listed on the last page of the report.

• Multipage. By default only the first page of a document is inspected. Select this option to
compare all pages of the input multi-page sample file to each same-number page of the
master file.

Note:  The task will end in error when the sample file and the master file do not have the
same number of pages.
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Note:  This option is ignored when the profile 'Booklet' is chosen (or any other custom
profile that already uses the multipage parameter in its configuration).

• Region. This option is present in all Global Vision tasks. Learn its basics in Generic Option
"Region". As this task has both a master and sample file(s), these following notes are
important:

Note:  When using a region based on a Shape, the task looks for the content of the defined
shape in the master file and looks for that similar content in the sample file. This also done
when choosing regions based on Trim or Media Box: the content in that box of the master
file will be looked for in the sample file and then compared.

Caution:  Even when you select an ink or layer from the list of those in the input
sample file, this ink or layer is used to find a shape in the master file.

• Ignore Inks and Ignore Layers. These options are present in several Global Vision tasks.
Learn more in Generic Options "Ignore Inks or Layers".

• Configure. This button opens the item in the configure panel where you can activate the
software license that you acquired from Global Vision.

Report Tab
This option is present in several Global Vision tasks. Learn more in the Generic Option "Report".
We here only mention some specifics for this task.

Caution:  The last page of the PDF report summarizes the parameters of the profile
chosen in the task ticket. Any parameters that were chosen separately in the Esko ticket
(like resolution), and that overruled parameters in that profile, are not mentioned here.
This means that the here mentioned 'Desired DPI' is possibly not the one that was
really used for inspection.

15.4.5.  Inspect Barcodes

Note:  This is one of several inspection tasks that use technology from the company Global
Vision. Learn about the general concept and setup in the Introduction on page 1051.

Concept and Workflow
This task inspects all barcodes in a file. It scans and decodes them and verifies their grade
(quality level) against the minimum grade chosen in the ticket.

A barcode quality problem could for example be that it is too small or it could have too little
color contrast, a QR code could miss some parts, etc.

You can also check if the barcodes defined in the Product or Job database are present in the
file.

The main advantage of this task is that you do not have to open these files and check them
visually or use a device to verify them. The detailed report is also a useful step in your quality
control process.
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Note:  You can use the Global Vision Profile Editor to compare barcodes in a master and sample
file.

This task also checks the barcode "quiet zones". For 2D barcodes, a specific grade is given for
these zones, one for each side, 100% when the zone is big enough.

Supported Barcodes

Attention:  Add-on codes and composite codes are not supported. UPC-A or EAN-13
add-on codes are recognized but are not graded.

• 1D/Linear codes:

• PharmaCode
• RSS/GS1 Databar Omnidirectional Stacked
• RSS/GS1 Databar Expanded
• RSS/GS1 Databar Limited
• RSS/GS1 Databar Stacked
• RSS/GS1 Databar Expanded Stacked
• RSS/GS1 Databar Omnidirectional
• RSS/GS1 Databar Truncated
• UPC-E
• UPC-A
• EAN 13
• EAN 8
• Code 39
• Code 93
• Code 128
• GS1 128
• MSI
• Interleaved 2 of 5
• Codabar
• ITF-14
• ITF-16
• Telepen (only decoding supported)
• Code 11 (only decoding supported)
• UPC-A add-on codes (only decoding supported)

• 2D codes:

• Data Matrix
• GS1 Data Matrix
• QR
• MicroQR

Detecting Rotated Barcodes

For linear barcodes, the option "Support Rotation" in the profile needs to be enabled in
order to be guaranteed that a rotated barcode is detected. If the option is not enabled, linear
barcodes can only be detected when in 0, 90, 180 and 270 degree angles.
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However, because linear barcodes can be sheared, it is possible that rotated barcodes are still
detected even if the option "Support Rotation" is not enabled.

Rotated 2d barcodes with an angle other that 0, 90, 180, 270 degrees can not be guaranteed to
be detected.

Supported File Types

The input file types supported by this task are the same as described here for the Inspect Artwork
task, here excluding the type 'Folder'.

Status and Workflow Output Pins

The task input file is also the task output file. It will be placed on one of these output pins:

• OK. When all barcodes are conform to the chosen minimum barcode grade and, when that
option is selected, all the barcodes described as product or job barcode are found (with
their specified parameters). Learn about these options in this next page.

• Not OK (status 'Warning'). When one or more barcodes are not conform the chosen
minimum grade, or, when that option is selected, when a barcode described as product or
job barcode is not found or has different parameters. This is also the status when the input
file has no barcodes.

• Warning. When all barcodes are conform the chosen minimum grade, and, when that
option is selected, when a barcode described as product or job barcode is not found or has
different parameters.

• Error. When the task itself could not function properly. For example when no profile was
selected, or no license was available.

See an example (to help visualize the output pins, an end status step was created with the
same name as the status):
 

 

Tip:  To get that extra output pin for the report(s) as in above example, you will need to
configure it as mentioned in Configuring Output Statuses  on page 696.

Integration with Automation Engine Viewer

When opening the inspected file in the Automation Engine Viewer, the detected barcodes are
indicated in red rectangles and is detailed in the Annotations list. Learn more in Working with
Annotations on page 1035.

Note:  Due to used resolutions, small differences can occur when comparing BWR measured
by the task with BWR measured interactive in the AE Viewer. Learn more here.
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Check Barcodes Tab
• Minimum Grade. Select the minimum grade (quality level) to which all found barcodes

must comply. Choose a letter or a number. Numbers deliver more detail. Learn more below
and in Barcode Profile Parameters on page 1080.

• Grades in Letters (ISO 15416:2000)

Table: Overview of Barcode Grades in Letters

Grade Meaning

A

These barcodes should scan easily the first time with most scanning
equipment. The aim should be to produce codes of this quality
whenever the printing processes and materials allow this.

B
Codes of this quality may read after a single scan. If a second scan is
required, the probability of success is very high.

C

This is the minimum quality that most barcodes should achieve. It
means that re-scanning might be required to get a successful read.
Flatbed scanners, which read the barcode at several places, are
recommended with codes of this quality.

D
This grade is only acceptable for ITF-14 barcodes printed on
fiberboard.

F F is fail.

Barcode Individual Grade Parameters (Letters)

The overall grade of a barcode is determined by its individual grade parameters. The
overall grade is equal to the lowest grade of any of these individual ones:

Table: Value of Individual Grade Factors in overall Barcode grade (Letters)

Barcode
Group
Type

Individual
Grade
Parameter Meaning

1D/
Linear

Minimum
Reflectance

Pass or fail grade (A or F) and the min
reflectance value (darkest part of the
barcode).

1D/
Linear

Symbol
Contrast

The difference in contrast between the
darkest and the lightest part of a barcode
(%).

1D/
Linear

Minimum
Edge
Contrast

Pass or fail grade (A or F) determined by the
minimum contrast between a space and its
adjacent bars.

1D/
Linear Modulation

The ratio between symbol contrast and
minimum edge contrast.

1D/
Linear Defects

The amount of discrepancies in the
reflectance of a barcode.
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Barcode
Group
Type

Individual
Grade
Parameter Meaning

1D/
Linear Decode

Pass or fail grade (A or F) determined by
whether the barcode was generated correctly
(i.e. sufficient spacing between bars).

1D/
Linear Decodability The ease of barcode identification.

2D Modulation
The contrast difference between light and
dark regions.

2D Decode

Pass or fail grade (A or F) determined by
whether the barcode was generated correctly
(for example sufficient spacing between
bars).

2D
Axial Non-
Uniformity

The difference in length of the two axis of the
barcode.

2D
Grid Non-
Uniformity

The vector deviation of the barcode from an
ideal position.

2D

Fixed
Pattern
Damage

The damage done to the pattern of a
barcode.

2D

Unused
Error
Correction

The amount of unused error correction
embedded in the barcode.

• Grades in Numbers (ISO 15416:2016)

This new calculation method can in some cases result in a higher averaged score for the
above parameters using this interpolation method compared with the method using
letters (ISO 15416:2000).

Find more details about the decimal grades method in http://www.aisvision.com/
files/2815/1602/9515/ISO_15416_December_2016_Changes.pdf and in https://www.sis.se/api/
document/preview/921309/.

There are 41 possible grades: 0.0 , 0.1, 0.2 up to 4.0 (source http://www.axicon.com/
fractional-grading.html).

Table: Value of Individual Grade Factors in overall Barcode grade (Numbers)

Grade
Symbol
contrast ModulationDecodabilityDefects Decode

Rmax/
Rmin

Min.
Edge
Contrast

0.0
<
15%

<
30%

<
20%

>
30% Fail < 2 < 15%

0.1
to
0.9

15%
to
19%

30%
to
39%

20%
to
24% NA
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Grade
Symbol
contrast ModulationDecodabilityDefects Decode

Rmax/
Rmin

Min.
Edge
Contrast

1.0
to
1.9

20%
to
38%

40%
to
49%

25%
to
36%

26%
to
30%

2.0
to
2.9

39%
to
54%

50%
to
59%

37%
to
49%

21%
to
29%

3.0
to
3.9

55%
to
69%

60%
to
69%

50%
to
61%

16%
to
20%

4.0
>=
70%

>=
70%

>=
62%

<=
15% Pass >= 2

>=
15%

• Profile. An inspection profile is a collection of parameters that defines how (precise) to
inspect. They are centrally located *.ini files that you can adapt using the Esko tool "Global
Vision Profile Editor". You can there both adapt the default inspection profiles or create your
own.

When unsure, use the Default profile. Selecting None will result the task to end in error.
• Compare barcode data with job or product barcode data. When this option is selected,

the task will, after having checked the minimum grade, also check if all barcodes specified
in the Product Part Properties or in the Job Setup of the input file are present as such in this
file. Not just their type or code, but also all the other parameters entered in those product
or job parameters.

This table shows you how the terms in Automation Engine's product and job parameters
map to the terms used by Global Vision (that are also used in the reports).

Automation Engine term Global Vision term

BOBST Laetus Pharma Code

CLF-8 Laetus Pharma Code

CODABAR Codabar

CODE-128 Code 128

CODE-39 Code 39

CODE39_EXTENDED Code 39

DATAMATRIX DataMatrix

EAN-13 EAN 13

EAN-8 EAN 8

GS1-128 GS1 128

GS1_DATABAR-OMNIDIRECTIONAL GS1 Databar Omnidirectional

GS1_DATABAR-EXPANDED GS1 Databar Expanded

GS1_DATABAR-EXPANDED_STACKED GS1 Databar Expanded Stacked

GS1_DATABAR_LIMITED GS1 Databar Limited
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Automation Engine term Global Vision term

GS1_DATABAR_STACKED GS1 Databar Stacked

GS1_DATABAR_STACKED_OMNIDIRECTIONAL GS1 Databar Stacked Omnidirectional

GS1_DATABAR_TRUNCATED GS1 Databar Truncated

GS1_DATAMATRIX GS1 DataMatrix

GS1_US-COUPON-INTERIM UPC-A + GS1 Databar Expanded
Stacked

HIBC-39 Code 39

HIBC-128 Code 128

ITF-14 ITF-14

ITF-16 ITF-16

INT_2_of_5 Int. 2 of 5

KURANDT Laetus Pharma Code

LAETUS_PHARMA Laetus Pharma Code

MS_7 EAN 8

MSI MSI

MARKS_AND_SPENCER EAN 13

NDC_HRI UPC-A

PLESSEY MSI

PZN Code 39

PZN8 Code 39

PARAF_ITALY Code 39

QR QR

MicroQR Micro QR

UPC-A UPC-A

UPC-E UPC-E

UPC-SCS Int. 2 of 5

• Region. Learn more about specifying an inspection region in Generic Options.

• Resolution. This option is present in several Global Vision tasks. Learn more in Generic
Option "Resolution". Make sure the resolution is high enough to detect barcodes.
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Attention:  The resolution you can specify here does not influence the accuracy with
which the barcode is inspected. This resolution is used to render the complete file
before inspecting any barcodes. The higher this resolution, the longer it will take to
render the complete file.

To set a high accuracy of inspection of the barcode itself, you can define a higher
resolution in the barcode profile that you are using. This can be done via the Global
Vision Profile Editor.

This means that it’s possible to inspect the file at for example a resolution of 300 ppi,
but that the barcode is inspected at 1.200 ppi.

Setting different resolutions in the profile leads to different results. An example:

An 'Inspect Barcodes' task that inspects at 300 ppi, can result in a narrow bar width
of

• 0.48 mm when the profile resolution is set to 300 ppi
• 0.46 mm when the profile resolution is set to 600 ppi
• 0.45 mm when the profile resolution is set to 1.200 ppi.

• Ignore Inks. When you are sure your barcodes do not contain specific inks, you can here
ask to ignore those inks. This can speed up the task. Learn more in Ignoring Ink or Layers on
page 1053.

• Ignore Layers. Same as above, but for layers.

• Configure. This button opens the item in the configure panel where you can activate the
software license that you acquired from Global Vision.

Report Tab
This option is present in several Global Vision tasks. Learn more in the Generic Option "Report".
We here only mention some specifics for this task.

Note:  Pharma codes (folder and gluer) return a different number when read upside down. The
report mentions both possible numbers. For example "121" might show up as "121 86".

Attention:  These reports do not include information about the comparison with
Product or Job barcode data. Those details are part of the task's log file.

• The PDF report first shows a summary of all found barcodes and their grade. It then
describes the barcodes in detail.

• The XML report also contains all details about the found barcodes.

15.4.6.  Inspect Braille

Note:  This is one of several inspection tasks that use technology from the company Global
Vision. Learn about the general concept and setup in the Introduction on page 1051.
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Concept and Workflow
This task detects braille, translates it to a chosen language and displays information such as
the language, number of dots, number of characters, number of lines, dot spacing, character
spacing, word spacing and line spacing values.

Braille should comply to the Marburg Medium braille specification. Braille that does not comply
might get misinterpreted. For example wrongly grouping dots of different characters into one
character, or not detecting certain dots to be part of the braille, or not recognizing the braille at
all.

The task can also compare the found braille to a given text.

Note:  You can use the Global Vision Profile Editor to compare braille data between a master
and sample file.

Supported File Types

The input file types supported by this task are the same as described here for the Inspect Artwork
task, except the type 'Folder'.

Status and Workflow Output Pins

When finished, the task input file will be placed on one of these output pins:

• OK. When no error occurred and when the compare option is not enabled.

• Not OK (status "warning"). When the option compare was used and found a mismatch.

Attention:  A mismatch will not be shown in the report file (the actual comparison is
done with the report data). Mismatches are mentioned at the bottom of the task log
file. For example:

INFO: GlobalVisionTask.INFO.ComparingWithBrailleData
ERROR: GlobalVisionTask.Message.BrailleDataDifference (< correct text >, <
 mismatch >)

• Error. When the task itself could not function properly. For example when no license was
available.

Tip:  To get an extra output pin for the report(s), you will need to configure it as mentioned in
the page about the inspection report.

Integration with Automation Engine Viewer

When opening the inspected file in the Automation Engine Viewer, the detected braille is
indicated in red rectangles and is detailed in the Annotations list. Learn more in Working with
Annotations on page 1035.
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Check Braille Tab
• Language. Braille is written in a specific language. Some braille characters mean different

things in different languages. Select the language in which you think that the braille code is
written. You then will get the correctly translated version in that language.

Note:  A language translation set is an XML file that describes mapping of characters. Some
(pharma) companies create their own mapping style. You can use the Global Vision Profile
Editor to export and add custom languages.

• Compare. Enable this option to compare the text resulting from all the detected and
translated braille with the text written in this field or resolved by a SmartName in this field.
To indicate a new line in the text, add a space in the text field.

Attention:  The comparison is done with the text in this field, not with text present
inside an external file.

Note:  If your file has separate groups of braille that you want to compare with a text you
defined here in this field, you can work with layers. Add the different groups of braille to
different layers in your file and use the option Select Layers to control which translated
braille you here compare with the here defined (smart) text.

• Region. Learn more about specifying an inspection region in Generic Option 'Region".
• Resolution. Make sure the resolution is high enough to detect braille. 72 ppi for example

will not be sufficient to detect the braille objects. Learn more in Generic Option "Resolution".
• Select Inks. Braille is usually present in a specific ink or layer. Specify one or more inks

that contain the braille data. Once braille is found in one ink, all braille is expected to be
in that ink (all braille in another selected ink will then be ignored). The list of inks does not
determine the order in which the inks are searched.

• Select Layers. Same as Select Inks, but for layers. Except that when you specify multiple
layers, that not just the first (found) layer will be checked.

• Configure. This button opens the item in the configure panel where you can activate the
software license that you acquired from Global Vision.

Report Tab
This option is present in several Global Vision tasks. Learn more in the Generic Option "Report".

15.4.7.  Inspect Spelling

Note:  This is one of several inspection tasks that use technology from the company Global
Vision. Learn about the general concept and setup in the Introduction on page 1051.

Concept and Workflow

Concept

This task checks the spelling of the text in the input file. You need to specify the language the
text is written in. This can also be a custom dictionary.
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Attention:  This task only checks spelling of live text objects (not of contourized text).

Supported File Types

This task supports PDF, Normalized PDF, PDFPLA, AI (when PDF compatible), TXT, DOC(X), RTF,
XML, HTML and XLS(X) files.

Status and Workflow Output Pins

When finished, the task input file will be placed on one of these output pins:

• Match (status "OK"). When the spelling was correct.

• Mismatch (status "Warning"). When the spelling was not correct.

• Error. When no live text was found or when the task itself could not function properly (for
example when no license was available).

Tip:  To get an extra output pin for the report(s), you need to configure it as mentioned in the
page about the inspection report.

Integration with Automation Engine Viewer

When opening the inspected file in the Automation Engine Viewer, the spelling violations are
indicated in the Annotations list. Learn more in Working with Annotations on page 1035.

Check Spelling Tab
• Language. Select the language the text is written in.

Note:  You can customize a language (dictionary) by using the Global Vision Profile Editor.

• Region. Learn more about specifying an inspection region in Generic Option "Region".

Tip:  When your file contains live text in more than one language, you could organize the
different texts in specific layers and then specify a layer selection in this task.

• Select Layers. You can specify one or more layers that contain the text in the selected
language.

Report Tab
This option is present in several Global Vision tasks. Learn more in the Generic Option "Report".

15.4.8.  Inspect Text

Note:  This is one of several inspection tasks that use technology from the company Global
Vision. Learn about the general concept and setup in the Introduction on page 1051.
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Concept and Workflow

Concept

This task compares the text in the input file with the text in another file. You select a profile
that defines how should be compared and what should be seen as a difference (for example if
you consider a font type or font size change a difference).

Attention:  This task only detects and compares live text objects (not contourized text).

Supported File Types

This task supports PDF, Normalized PDF, PDFPLA, AI (when PDF compatible), TXT, DOC(X), RTF,
XML, HTML and XLS(X) files.

Note:  For XLS(X) files only the visible text is checked, so not the text outside the visible part of
the cell.

Status and Workflow Output Pins

When finished, the task input file will be placed on one of these output pins:

• Match (status "OK"). When the text matches.
• Mismatch (status "Warning"). When the text does not match.
• Error. When one of the files has no live text or when the task itself could not function

properly (for example when no license was available).

Tip:  To get an extra output pin for the report(s), you need to configure it as mentioned in the
page about the inspection report.

Integration with Automation Engine Viewer

When opening the inspected file in the Automation Engine Viewer, the found differences are
indicated in the Annotations list. Learn more in Working with Annotations on page 1035.

Compare Text Tab
• Compare with. Indicate the file (full URL) that contains the text that you want to compare

with the text from the input file. For example: your input file is a PDF and you compare it
with a Word file containing the original text.

• Profile. Select a profile that defines what should be seen as a difference and other
parameters. Learn more about these profiles in the Global Vision Profile Editor.

• Region. Learn more about specifying an inspection region in Generic Option 'Region".
• Select Layers. You can specify one or more layers that contain the text.

Report Tab
This option is present in several Global Vision tasks. Learn more in the Generic Option "Report".
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15.4.9.  Global Vision Profile Editor

Concept and Workflow
The Global Vision Profile Editor is a version of Global Vision’s standalone application ArtProof/
ScanProof. This Esko version has a different interface and functionality.

The main reason for an Esko user to use the Global Vision Profile Editor is to be able to test
and manage the Profiles that are used in Automation Engine's Inspection tasks.

You can also use its interactive tools to compare artwork, inspect barcodes, translate braille,
inspect text or spelling.

Caution:  This application is very memory intensive, especially when you open files
that are large in dimensions, or if you request a high resolution. Check if your local
computer has enough memory on http://www.esko.com/systemrequirements (section
Automation Engine - Client).

License from Global Vision

As with the Inspection tasks, you need a license from Global Vision to use this application. This
was introduced here.

How to Install

This application is one of the tools that you can download from the Automation Engine server
web page.

• Open this server web page by entering http://<name of your master server> or http://
<name of your master server>:9999 in the address field of your browser.

• Download this application from Client Apps >  Tools.
• When asked for the Host Name, enter the name of your Automation Engine server where

you have installed your license from Global Vision.

General Working

This application first creates rasterized files at a chosen resolution and then inspects these
files.

PDF files or AI files are first opened in a Prepare PDF window. You can there for example choose
to ignore inks or layers before the file is being rasterized.

File Support

• PDF and AI files (when PDF compatible)
• RIP data: TIFF, LEN
• Pictures: BMP, PNG, JPG

The Inspect Text and Inspect Spelling modes also support these file types:
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• DOC, XLS, XLSX, XML, HTML

Interface Overview
1.  File Menu. To load files or change the resolution that artwork files will be rasterized

with.

Tip:  You can also load files via double-clicking inside the master or sample panel. Also do
this if you loaded a wrong file and want to replace it with another.

2.
 Reset Interface. To clear the inspection window and all the loaded files. Do this before

starting to inspect a completely different set of files.
3.  Back. To close the inspection window.
4.

Editor Modes. To choose to compare , inspect barcodes  or translate braille .
5. Action. To choose the type of action for that mode.
6. Profile. To choose the specific profile for that mode and action.

Note:  Choose Manage at the bottom of the list when you want to add, copy, rename or
delete a profile without activating any inspection mode. Be aware that 'Apply' also saves the
made changes!

7.  or  or  to start the inspection.
8.  Cancel Inspection. To stop the inspection while running.
9.

 Configure Inspection Parameters. When in inspection mode, use this one to view or
make changes to the selected profile and re-execute the changed profile.

Note:  If you want save the changes to the profile, then select 'Manage' from the Profile's
drop-down list.

Note:  This icon is disabled when the chosen profile is one that was installed with the
application (those are read-only). Use 'Manage' from the Profile's drop-down list to make a
custom copy of such a profile. You can then view and make changes to that new profile.

10.
 Help. To change various preferences. The Hi-Contrast option is explained in Comparing

files  on page 1074.

Prepare PDF Window
When loading PDF or AI files, they are first opened in a Prepare (Master/Sample) PDF
window. This is where you can still rotate or crop the file or hide selected separations or layers
before the file is rasterized. These changes do not modify the original PDF/AI file.

Tool bar
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•  , Marquee Zoom (drag an area), Central Zoom In/Out and Total
View. These functions only affect the view in this dialog ; they do not decide what will be
rasterized.

•  Reload file. Choose this to discard any changes made so far and re-opens the file in this
"Prepare PDF" window.

•  Accept. Click accept to confirm any changes you made, start the rasterization process.
When done, the PDF Prepare window closes and the resulting raster data is shown in the
(master or sample) "Inspection" window.

•  Close. Choose this to cancel this preparation and close this window.

Left Panels
• Enable overprint. In prepress environments, leave this enabled.
• You can choose to limit the region to the file's Media, Trim or Crop Box.
• Layers and Separations:

Click the  eye icon to hide them in this view and exclude them from the raster data. Click
again to show / include them again.

Right-click the name of a layer or separation to enable or disable "Use Shape as Region".
Select this when you want this (die) layer or separation to be used as shape to be inspected.
When no shape can be extracted from the chosen layer or separation, the crop box will be
chosen.

Note:  Only one layer or separation can serve as region shape at a time.

• Process. The process inks cannot be used to extract a region based on a shape. You can
only double click them to hide/show them in this view and exclude/include them from the
raster data.

Comparing files

Note:  This is a quick start guide. We also assume you have read the introduction pages of the
Inspection tasks and of the Profile Editor.

1.
Select the Compare mode .

2. Choose the Action 'Compare'.
3. Choose the Profile you want to inspect with. Learn more in Compare Profile Parameters on

page 1077.
4. In , choose the resolution at which you want to inspect.
5. In , load a master and sample file.

Note:  When a file is loaded, click  next to the name of the master or sample file to get
information about the raster data or to change the appearance of the file in this window.

When loading PDF (compatible) files, the Prepare PDF window will open. Learn more about
this extra step in Prepare PDF Window on page 1073.

6. Once a file is loaded, you can use the Inspection toolbar to make some changes before you
start the inspection. For PDF files, you could already have done some of those changes in
the Prepare PDF window.
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•
 Define which region you want to have inspected. Select an option and a blue

dashed line will indicate the resulting region.

• Crop Box. This is typically the whole file. Learn more about PDF boxes in recurring
options.

• Marquee. Select it and then drag an area. Optionally, when you want to target a

block of text in a single ink, click on  Crop Contents to crop to the content in that
marquee.

• Visible Objects.

• Shape. Select this option then click in the center of the shape you want. When no
shape can be found, the largest object in the middle will be used as shape.

Note:  The last used type of region stays selected for the next loaded master file.

•
 To Reload the file. In case of a PDF file, the Prepare PDF window will open again.

•
 To Rotate or Mirror the file.

Note:  The application already detects rotations between master and sample
automatically.

•  Marquee Zoom and  Total View. The chosen view does not affect the region to
inspect.

7. Click  to start the inspection. The region that you defined in the master will be looked for
in the sample and then compared.

Note:  Click  to cancel the inspection.

8. When the inspection is finished, an inspection window and a panel shows you the found
differences found in the sample file.

• Use the Inspection window toolbar to help visualise the result:

•
 Click the small arrows to speed up or down the flashing of the differences.

•
 to show only the master or  to show only the sample image. In these modes,

you can click on the flash-button itself  to change (back) to a combined view with
flashing differences.

•
 to show or hide the whole difference image.
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Note:  In  Preferences, the option Hi-Contrast Difference Image enables a
difference view that uses a blue background (re-run the inspection to get this option
to take effect).
 

 

•
 to show or hide an edge difference image.

•
 to show or hide the mask (change the color in  Preferences).

•  to show or hide the box around the difference.

•  to show or hide the number of the difference.

• Repeats found: Valid when one of the images is a step & repeat file of the other. Learn
more about the parameters for detecting repeats in Compare Profile Parameters on page
1077.

• Differences found: Changes, Insertions or Deletions. Click the item to zoom in to that
difference. An  icon appears to indicate that you have inspected that difference.
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Note:  You can group differences to be seen as one difference. See this example where
the movement of the letter "L" was detected as 2 differences. Press Alt and drag a
rectangle around their red rectangles to group them as one difference . Mind that there
is no 'undo' function.
 

 

9. Optionally, you can

• choose another profile and start the inspection again.
•

click  to check the current profile. When you change parameters, click Apply to run
the inspection again with your changed settings (this does not save the changes to the
profile). Learn more about the parameters in Compare Profile Parameters on page 1077.

Note:  To save the changes you made a profile, select 'Manage' from the Profile's drop-
down list, make the changes there and click 'Apply' there.

Compare Profile Parameters

General

• Difference grouping (pixels). The radius for grouping differences together (0 to 999).
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Text
This relates to text in PDFs, even when contourised. Also scans saved as PDF.

• Low contrast. Parameters typically for areas with color on color, like a black text on top of
an image.

• Minimum detection size (pixels). Ignores differences detected below this amount of
pixels.

• Maximum difference shift (pixels). Maximum allowable pixel tolerance before an item
is seen as a difference.

• Sensitivity. Sets the sensitivity to detect differences. Enter a value or use the slider.

• Advanced

• Reduce image noise and imperfections. This produces a less pixelated image. Mind
that a higher value may inhibit difference detection (0 to 20).

• Correct text kerning and image shift. Reduces detection of small changes in text
kerning and image shifts (0 to 5).

• High contrast. Same type of parameters as above for low contrast, but here for high
contrast areas, for example a black text on a white background.

Artwork
These parameters are valid for all objects other than text. You can set the same type of
parameters as those for "Text", as described above.

Color

Enhanced color detection (digital). Enable this option when you are comparing digital files
and you want to use an enhanced method of detecting color differences.

• Minimum detection size (pixels). Ignores differences detected below this amount of
pixels.

• Sensitivity. Sets the sensitivity to detect differences. Enter a value or use the slider.

Repeat Detection

When comparing a file with a repeated version of that file, use these parameters to fine-tune
the detection of the repeats and their content.

• Find repeating shapes. Matches comparable images by their shape (5% to 99%).

• Find repeating content. Checks how similar their content is, by checking the maximum
amount of allowable differences between repeats (5% to 99%). Mind that values greater
than 30 may degrade the quality of repeat detection.

Scan
These parameters are relevant when the file is a scan of a printed sample.

• Ignore edges (pixels). Increases the mask area along the edge of the image (0 to 50).
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• Mask creases (pixels). Used in conjunction with Shape extraction. Increases the mask area
along the inner die lines of the master to eliminate crease differences from being detected
(0 to 50).

• Correct distortion, rotation and skew. Enable this to automatically compensate for any
angular misalignment or distortion differences between the master and sample.

FAQs

• How to Ignore Registration Differences?

Change one or both of these parameters:

• Increase the Minimum Detection Size.
• Increase the Maximum Difference Shift.

Inspecting Barcodes

Note:  This is a quick start guide. We also assume you have read the introduction pages of the
Inspection tasks and of the Profile Editor.

Attention:  We here only list the main differences with comparing files, as we describe
here.

1.
Select the mode 'Inspect Barcodes' .

2. Choose the Action 'Inspect Master' or 'Inspect Sample'.

The barcode inspection is only done on 1 file, but in case you earlier loaded and compared
a master and a sample image, you can choose which one to inspect. This way, you can use
the barcode inspection as an extra inspection after you did a compare.

3. Choose the Profile you want to inspect with. Learn more in Barcode Profile Parameters on
page 1080.

4. In , choose the resolution at which you want to inspect.

Linear barcodes can be hard to detect when you choose a very low resolution.
5. In , load a master or sample file (or double-click the left or right background window).
6.

Once a file is loaded, you can use the Inspection toolbar  to
make some changes before you start the inspection. For PDF files, you could already have
done some of those changes in the Prepare PDF window.

7. Click  to start the inspection.
8. When the inspection is finished, the inspection window highlights the decoded barcodes.

The highlight color represents their grade (gray for barcodes where grading is not
supported). A side panel shows details on the selected barcode (in a blue dashed line
rectangle).
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9. Optionally, you can

• choose another profile and start the inspection again.
•

click  to check the current profile. When you change parameters, click Apply to run
the inspection again with your changed settings (this does not save the changes to the
profile). Learn more about the parameters in Barcode Profile Parameters on page 1080.

Note:  To save the changes you made a profile, select 'Manage' from the Profile's drop-
down list, make the changes there and click 'Apply' there.

Barcode Profile Parameters

Note:  On this page, we use the term 'linear' for 1D/Linear barcodes.

Linear

• Process

Disable this if you do not want linear barcodes inspected.

• Scan Gap Horizontal

This is the number of columns to skip between 2 scans when detecting vertically oriented
linear barcodes. A higher value increases detection speed but may reduce accuracy
of detection. Adjust this parameter if there are issues with detecting vertical oriented
barcodes.
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• Scan Gap Vertical

This is the number of rows to skip between 2 scans when detecting horizontally oriented
linear barcodes. A higher value increases detection speed but may reduce accuracy of
detection. Adjust this parameter if there are issues with detecting horizontal oriented
barcodes.

 

 

• Min. Quality Score

This is the minimum number of scan lines that must be decoded properly. The lower, the
higher the detection rate but also a higher chance of false positives. The default value is 5.

• Min. Vicinity Horizontal (pixels)

When a same barcode is detected twice (same type, same decoded value, same
orientation), this is the minimum horizontal distance in pixels between them to merge the
detection of the duplicate barcodes.

• Min. Vicinity Vertical (pixels)

Same as above, but the vertical distance.

• Edge Threshold

This is the minimum transition value used to detect the transition between spaces and bars.
Use low values to detect high contrast barcodes and high values for low contrast codes.

• Ignore quiet zone

Enable/disable quiet zone verification for barcodes that require a quiet zone.

• Support Rotation

Enable/disable detection of non-90-degree-rotated linear barcodes (barcodes not at 0, 90,
270 degree orientations).

• Support Negative Barcodes

Enable/disable detection of barcodes in (white) knockout.

• Ignore Checksum

Enable/disable checksum verification for UPC/EAN barcodes.

• Grade Output Format: An older method uses letters to grade the quality of the barcode.
The ISO 15416:2016 implements a new calculation method resulting in decimal numeric
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grades. This is more precise. The inspection report will show the grading in the format that
was selected in this profile.

• ISO/IEC 2016 Standard (uncheck for 2000 standard). The '2000' standard sticks to
rounded numbers ; the '2016' one uses decimals values as well.

• Include in Grading: Data Structure

If checked this will include Data Structure grading in overall grading.

Note:  The overall grading is determined by the lowest ISO grading parameter. Non ISO
grading parameters are not included in the overall grading by default.

Example: If 'Include in Grading: Data Structure' is checked and it receives a grading of D,
and D is the lowest grading, then the overall grading will be D.

• Include in Grading: Quiet Zone

If checked this will include Quiet Zone grading in overall grading.

• Include in Grading: Narrow Bar

If checked this will include Narrow Bar grading in overall grading.

• Include in Grading: Wide to Narrow Ratio

If checked this will include Wide-to-Narrow-Ratio in overall grading.

• Fail Grading if BWR out of the specified range

Will fail the grading if Bar Width Reduction is out of specified range (adjustable ; default is
minimum BWR set at -0.10 and maximum BWR at 0.10).

Linear Types

Enable or disable the type of linear barcodes that you want to have detected.

Data Matrix

• Process

Disable this if you do not want data matrix codes detected and inspected.

• Max. Number Codes

This is the maximum expected number of data matrix codes with unique sizes that can be
detected in an inspection. The higher this value, the slower the detection.

• Scan Gap

This is the horizontal scan gap. A higher value increases detection speed but may reduce
accuracy of detection. Adjust this parameter if there are issues with detecting data matrix
barcodes.

• Detection Level

This is the general level of the effort the algorithm spends on detection. A higher value
increases accuracy but decreases detection.

• Edge Threshold

This is the minimum transition value used to detect the transition between light and dark
cells. Use low values to detect high contrast codes and high values for low contrast codes.
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• Min. Size Cell (pixels)

This is the minimum size in pixels of a data matrix cell. Increase this value to remove small
data matrix candidates and to avoid small artifacts being detected as false codes.

 

 

• Max. Size Code (pixels)

This is the maximum size of the data matrix code in pixels. Use it to remove big data matrix
candidates and speed up detection of codes. Decrease this value if larger data matrix codes
are mis-detected.

• Max. Skew Angle

This is the maximum data matrix skew angle in degrees. Increase this value to allow
detection of skewed or rotated data matrix codes.
 

 

QR

• Process

Disable this if you do not want QR and Micro QR codes inspected.

• Scan Gap Horizontal

Same as mentioned above for linear barcodes.

• Scan Gap Vertical

Same as mentioned above for linear barcodes.

• Min. Quality Score

Same as mentioned above for linear barcodes.

• Edge Threshold
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Same as mentioned above for data matrix codes.

General

• Red Light Simulation

Enable/Disable red light simulation when grading barcodes.

• Filters

Adjust these filters when there are issues with barcode detection due to noise. None = No
filtering (default), 1x = filter one time, 2x = filter two times.

• Smooth Filter. Enable/disable smoothing the image with a Gaussian filter. The effect is
blurring the image to remove noise and ease barcode detection on degraded images.

• Median Filter. Enable/disable using a Median filter to remove noise and ease barcode
detection on degraded images. This filter removes noise while preserving barcode edges.
 

 

• Open Filter. Enable/disable using an Open filter to remove small light noise such as thin
straight vertical lines on barcode and ease barcode detection.
 

 

• Close Filter. Enable/disable using a Close filter to remove small dark noise and ease
barcode detection.

FAQs

Should I get the same grade results at different resolutions?
Grade results can be different when done at a different resolution, especially the
Decodability. Decodability measures bar/space ratios against the standard.

An example: at 600 DPI, wide barcode bars may be 10 pixels and narrow bars 5 pixels,
resulting in a wide to narrow bar ratio of 2. At 300 DPI, wide barcode bars may be 5 pixels and
narrow bars 2 or 3 pixels, resulting in a different wide to narrow bar ratio. Especially when

1084



15Automation Engine

the narrowest bar is very small (1 or 2 pixels), the decodability may be different. In general, a
higher DPI produces more accurate grade results.

Translating Braille

Note:  This is a quick start guide. We also assume you have read the introduction pages of the
Inspection tasks and of the Profile Editor.

Attention:  We here only list the main differences with comparing files, as we describe
here.

1.
Select the mode 'Inspect Braille' .

2. Choose the Action 'Translate Master' or 'Translate Sample'. The braille inspection is only
done on 1 file, but in case you already loaded a master and a sample, you can choose which
one to inspect. This way, you can use the braille inspection as an extra inspection after you
did a compare.

3. Choose the Profile you want to inspect with. For braille, the profile only defines what
language the braille is written in and should be translated back to.

4. In , choose the resolution at which you want to inspect. Braille can be hard to detect
when you choose a very low resolution.

5. In , load a master or sample file (or load them via double-clicking the left or right
background window).

6.
Once a file is loaded, you can use the Inspection toolbar  to
make some changes before you start the inspection. For PDF files, you could already have
done some of those changes in the Prepare PDF window.

Learn more about this toolbar in the pages on Comparing files  on page 1074.
7. Click  to start the translation.
8. When the inspection is finished, the inspection window highlights the found braille and a

side panel shows details on the selected group of braille (in the blue dashed line rectangle).
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Tip:  In the Braille Details panel, you may need to use the slider under the Translation
characters to read more of the translated text.

Braille Profile Parameters

The Braille Language Editor enables you to add, modify or delete braille characters of a
chosen language.

Comparing Text

Note:  This is a quick start guide. We also assume you have read the introduction pages of the
Inspection tasks and of the Profile Editor.

Attention:  We here only list the main differences with comparing files, as we describe
here.

1.
Select the mode 'Inspect Text' .

2. Choose the Action 'Compare'.
3. Choose the Profile you want to compare with. Learn more in Text Compare Profile

Parameters on page 1087.
4. In , choose the resolution at which you want to inspect.
5. In , load a master and load a sample file (or double-click the left or right background

window).
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6.
For each loaded file, you can use the Inspection toolbar  to
make some changes before you start the inspection. For PDF files, you could already have
done some of those changes in the Prepare PDF window.

Learn more about this toolbar in the pages on Comparing files  on page 1074.
7. Click  to start the comparison of the text.
8. When the inspection is finished, a side panel lists the found differences. Select one to zoom

in to that difference.

Text Compare Profile Parameters

Tip:  Hover with your mouse over the parameters to see the tool tips with more info.

Difference Types

Indicate whether these text parameters can cause a difference or not.

Languages

These parameters are important to set the text reading order. All languages are supported in
different orientations, but the profile requires one choice:

• Left to Right. For standard western text.
• Right to Left. For example for Arabic, Hebrew and Farsi.
• Asian. For texts where characters represent words (and often left to right).

Reading Order

Choose a Correction Level (see the tool-tips).

Templates

Using an Inspection Template enables to find smaller fragments of text that may be repeated
across a carton. The template can also instruct to inspect only a specific section

These templates are "Quality Review of Documents" templates (QRD), a standard used in the
EMA (pharma) world.

Choose between

• None.
• Carton/label.
• Custom. Pick one from the offered list.

.

Advanced

• Table and Line processing. Choose whether you want to ignore or check underlines and
tables.

• Microsoft Word Document Options. Choose whether you want to ignore any content in
headers/footers in Word documents.
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Checking Spelling

Note:  This is a quick start guide. We also assume you have read the introduction pages of the
Inspection tasks and of the Profile Editor.

Attention:  We here only list the main differences with comparing files, as we describe
here.

1.
Select the mode 'Spell Check' .

2. Choose the Action 'Inspect Master' or 'Inspect Sample'. The spell check is only done on
1 file, but in case you already loaded a master and a sample, you can choose which one
to inspect. This way, you can use the spell check as an extra inspection after you did a
compare.

3. Choose the Profile you want to inspect with. These are dictionaries. Learn more in Spell
Check Profile Parameters on page 1088.

4. In , choose the resolution at which you want to inspect.
5. In , load a master or sample file (or double-click the left or right background window).
6.

Once a file is loaded, you can use the Inspection toolbar  to
make some changes before you start the inspection. For PDF files, you could already have
done some of those changes in the Prepare PDF window.

Learn more about this toolbar in the pages on Comparing files  on page 1074.
7. Click  to start the spelling check.
8. When the check is finished, a side panel lists the found problems. Click on one to zoom in to

that problem.

Spell Check Profile Parameters

When spell-checking, the only profile parameter is the choice of language (dictionary).

To create a custom dictionary, go to Manage in the Profile's list, select and copy a default one
and save it with a different name.

When you opened a custom dictionary, use the buttons or right-click the dialog to add/modify/
delete a word. You can also first copy an external list of words and then paste that clipboard
list in this dialog.
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Shortcut Keys

Table: Shortcut Keys Global Vision Profile Editor

Key Function

CTRL/CMD - M Load master file.

CTRL/CMD - S Load sample file.

CTRL/CMD - S when in
Inspection mode

Opens the chosen profile.

F11 When in Inspection window of the Compare mode, navigates
to the next difference. (On Mac, you may need to switch off the
system preferences default for F11.)

Mouse Track Wheel • On Windows: Scroll up to magnify the image. Scroll down to
reduce the magnification.

• On Mac: Scroll down to magnify the image. Scroll up to reduce
the magnification.

Left mouse button After taking a marquee zoom, hold down and move within the
window to pan the view.

ALT + Select/Drag
Rectangle

When in Inspection window of the Compare mode, to group
differences.

SHIFT + Select/Drag
Rectangle

Marquee zoom.
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15.5.  Other QC Tasks

15.5.1.  Check Print Rules (PRC)

Print Rule Checker (PRC) is an old technology on board the Esko editor PackEdge. It checks the
file, completely or partially, for potential printing problems or violations of standard printing
conventions. These checks can include insufficient line thickness, wrong halftone densities, the
use of too many inks, and various other production related issues.

The Check Print Rules (PRC) task checks the file according a rule set that you made in
PackEdge. The task adds the results of its checks into the Normalized PDF file. When you then
open this file in PackEdge, you can quickly see a full report of these checks and use dedicated
tools to quickly navigate to the parts where rules were violated.
 

 

Task options:

• Select the Ruleset from the drop-down list. These were created in PackEdge and saved in a
default central folder. Learn more about defining such rule sets in the PackEdge user guide.

Note:  In this background task version of PRC, rules on 'Small Parts' and 'Close Objects' are
not checked.

• PRC Report. Enable this also get a .txt report that describes the used rule set and the found
infringements.

• Decide what the state of the task should be when rules are violated: Task ends with a
warning  or Task fails .

15.5.2.  Compare PDF

Concept and workflow
This task compares the input PDF file(s) to a reference PDF file. It creates TIFF files of each
separation and then compares those.

You can see the found differences in a separate layer or file and also in an XML report.

Note:  The Inspect Artwork task also serves to compare files but is more elaborate.
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The task can have these output states:

• Match: No differences were found.
• Mismatch: Differences were found.
• Error: The task itself malfunctioned (reference file was not found, no license was

available...).

Task Options

• Compare

• Compare With. Define the reference file with which you want to compare the input PDF
file(s).

• Select the Compare Region (of both input and reference file) within which you want to
compare. Learn more about page boxes here.

• Set the Compare Resolution for the automatically created TIFF files. Enter a value
between 50 and 300 ppi.

• Set the Noise Tolerance. The compare resolution defines in what detail you compare the
files. This noise tolerance however defines how strict you want to compare: what do you
consider as a difference? If you do not want the most strict form, you can here define a
tolerance.

The distance in this field represents the maximum (horizontal or vertical) distance
between isolated pixels for them to be ignored. An isolated pixel is a pixel that is
different in both files but that has all surrounding pixels equal in both files. The higher
you put the value, the more tolerant you are against noise. The more you allow noise,
the less strict the comparison will be. The default is '0 mm' (no differences allowed, most
strict).

An example: A comparison shows 2 isolated pixels that are 10 mm apart and also 2
isolated pixels that are only 2 mm apart. If you now set the noise tolerance to '5 mm',
then the set of isolated pixels that are 10 mm apart will be ignored in the comparison.

• Ignore Separations. Add the names of separations to ignore during the comparison.
For example for multilingual variants you may want to ignore the separation(s) that
contain(s) text.

Tip:  Double-click on a line in the canvas and use the small drop-down list to select
separations of the ticket's input file.

• Differences

• Output in: Define the folder where you want to save the file containing the found
differences and the report file. When you type in a name, it will be created as a subfolder
of the input file.

Note:  This field is thus only valid when you enable one or both of the below options.

• Select Create Differences layer if you want to add the found differences in a separate
layer.

Note:  When page boxes are different and/or separations do not match, the task will
report a mismatch but will not create a difference layer.
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In Layer File, when you use the SmartName [File], the extra layer will be added to
your input file. Alternatively, you could browse to an existing PDF file or use SmartNames
to have a new one created automatically, for example "[file]_Diff".

• Select Report differences to file to save the differences in a separate XML report file.
This XML file has the extension *.comp. When the files don’t match, this report contains
the coordinates of the mismatched pixels for each separation.

Note:  In the Esko editor Neo, you can insert these .comp files on top of the opened PDF
to see the coordinates of where differences were found.

Tip:  You can configure an extra output pin to see your report appear on its own pin.
Learn more in Configuring Output Statuses  on page 696.
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16.  RIP'ing with Imaging Engine

16.1.  Copyright Notice
© Copyright 2020 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are
the property of Esko Software BV. The material, information and instructions are provided
on an AS IS basis without warranty of any kind. There are no warranties granted or extended
by this document. Furthermore Esko Software BV does not warrant, guarantee or make any
representations regarding the use, or the results of the use of the software or the information
contained herein. Esko Software BV shall not be liable for any direct, indirect, consequential or
incidental damages arising out of the use or inability to use the software or the information
contained herein.

The information contained herein is subject to change without notice. Revisions may be issued
from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system,
or published, in any form or in any way, electronically, mechanically, by print, photoprint,
microfilm or any other means without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®
 Colors displayed in the software application or in the user documentation may

not match PANTONE-identified standards. Consult current PANTONE Color Publications for
accurate color. PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. ©

Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to
distribute for use only in combination with Studio Visualizer. PANTONE Color Data and/or
Software shall not be copied onto another disk or into memory unless as part of the execution
of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org).
All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk
Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP
are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric
Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).
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Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign,
PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the
United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are
registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark
Office.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered
trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Kortrijksesteenweg 1095

B – 9051 Gent

info.eur@esko.com

16.2.  What is Imaging Engine?

An Adobe PDF Print Engine Based RIP
Imaging Engine is Esko's Raster Image Processor (RIP), based on the industry standard Adobe
PDF Print Engine.

On top of Adobe PDF Print Engine, Imaging Engine includes Esko's renowned color
management, screening, dot gain compensation and output formats.

You can use Imaging Engine to both proof and RIP your files.

A RIP Integrated Seamlessly into Automation Engine
Imaging Engine is completely integrated into Automation Engine. This means that the
Automation Engine Pilot is your single point of contact for using Imaging Engine (you do not
need to launch or use any separate software).
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You can run the Imaging Engine tasks on any PDF or Normalized PDF.

A Powerful Multi-Files Processing RIP
Taking advantage of Adobe PDF Print Engine's capabilities (64-bit, multi-threaded, multi-
process architecture), Imaging Engine is powerful and highly scalable.

You can add more RAM and cores to your server hardware to process more files in parallel, and
faster.

Note:  The amount of parallel processing you can do also depends on your license.

16.3.  Using Imaging Engine for Proofing and RIP'ing
Files coming from a graphic designer often need a lot of prepress work before being printed.
You can do this prepress work in Automation Engine for example.

After that, you can use Imaging Engine to both proof and RIP your files. When using the same
solution for both proofing and RIP'ing, your proof will look much more like your final print than
if you had used two different solutions.

Proofing with Imaging Engine
You can use Imaging Engine for both content proofing and contract proofing.

• You typically make a content proof to check whether the contents of your file (layout, text,
barcodes...) are correct.

• You can make a physical content proof with Imaging Engine's Proof for Content Approval
task (this uses the Esko Proof Server and your proofer of choice).

• You can make a digital content proof with Imaging Engine's Image to Content Proof (RGB)
task (this generates a high resolution preview file).

• You typically make a contract proof once you are satisfied with the content proof, to check
that the colors of your proof also look as expected, and to show it to your customer as final
proof before printing.

To ensure that your proof is as color accurate as possible, you color manage your job when
making a contract proof.

You can do this with Imaging Engine's Image to Unscreened Proof task.

Tip:

If you also want to unquestionably verify the color accuracy of your proof against your
customer's criteria when contract proofing, we recommend you use Pack Proof together with
Imaging Engine.

See the Pack Proof documentation for more information.

RIP'ing with Imaging Engine
After the proof is approved, the RIP is the last essential step to make sure your files are ready
to send to your output device.
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Imaging Engine can generate screened or unscreened files, depending on the device you want
to use.

• You typically need screened output to send to a platesetter or filmsetter (for offset or flexo
for example).

You can do this with Imaging Engine's Image to Screened Separations task.

• You typically need unscreened output to send to a device that will take care of the
screening, or a device that doesn't need screened input (for gravure for example).

You can do this with Imaging Engine's Image to Unscreened Separations task.

See Screened or Unscreened Output? for more information.

You can also use Imaging Engine to generate ink distribution data for the files you want to send
to your offset press (so that the press can automatically calculate the amount of ink needed
for each separation of your RIP'ed files, without needing manual adjustments from the press
operator).

You can do this with the Calculate Ink Key Settings (CIP3) task.

16.4.  What Does Imaging Engine Do?
When proofing with Imaging Engine, you can:

• perform general file transformations to make sure the output is as expected (select the
right page box, rotate/invert/mirror the file as needed, apply a distortion to pre-compensate
for substrate distortion...),

• color manage objects in your file, or the whole file, so they look as expected on press (for
contract proofing),

• rasterize the vector graphics to continuous tone bitmaps,

• output your file either directly to your proofer, or to the file format needed for your proofing
workflow or device (TIFF, PDF or JPEG).

When RIP'ing with Imaging Engine, you can:

• perform general file transformations to make sure the output is as expected,
• rasterize the vector graphics to continuous tone bitmaps,

• if needed, screen those bitmaps at the correct resolution for your output device and with the
screening settings most applicable to your printing method,

• add dot gain compensation to compensate for plate and/or press dot gain,

• output your file to the file format needed for your imaging device (TIFF, LEN, LENX, or PDF).

Note:

Make sure you have done all other necessary prepress before sending your file(s) to Imaging
Engine, either in your editor of choice or in Automation Engine.

For example if you are working with a file that has different versions or languages, and you
need to merge one of the "language" separations with one of your base separations, you can
do this using a PDF action list before sending your file to Imaging Engine.

You can make this PDF action list in ArtPro+, and use it in Automation Engine's Apply PDF
Action List task. See the Automation Engine - Merging Separations using PDF Action Lists
knowledge base article.
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16.4.1.  Color Management

Color management is making sure that colors are reproduced consistently at different stages
of the printing process.

This consistency is especially important for specific "brand" colors, that have to look the same
when printed on different substrates (cardboard, paper, plastic...).

Devices and Color Spaces
Different devices (a digital camera, computer monitor, proofer, press...) display or reproduce
colors in different ways.

Colors in photographs are generally defined in the RGB color space (Red, Green, Blue), and
monitors also use RGB to display colors.

Proofers and presses use CMYK (Cyan, Magenta, Yellow and Black -or "Key") for printing, and
sometimes additional inks (for example Orange, Green and Blue, to be able to reproduce more
colors, or one or two spot colors -generally Pantone inks- used in a particular file).

Files coming from a graphic designer may contain CMYK, spot colors and sometimes images in
RGB.

Devices' Profiles
Even within one color space, different devices can reproduce colors differently. For example,
two CMYK proofers from different brands may print completely differently.

A device's gamut is the totality of the colors that device can reproduce (for example, the area
shown in light green below).
 

 

This is captured in the device's profile, which describes all the colors achieved when using
different combinations of percentages from the base colors (RGB, CMYK, or CMYK + extra
colors).

To create a profile for a press or proofer, you need to print and measure a profiling chart
containing these combinations of percentages.
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See the Color Engine Pilot documentation for more information about creating profiles.

Imaging Engine support the following types of device profiles:

• Esko profiles, created in the Color Engine Pilot,
• ICC profiles, created in a third party application and written in a standard format.

Using Profiles for Color Management
You need to have a profile for each of your devices to perform color management.

Note:

Proofers and presses' profiles need to reflect the device's exact printing characteristics (inks,
substrate...).

So if for example you change your substrate, you need to make a new profile taking that
substrate into account.

Once you have made the profiles, you can perform a controlled conversion of the colors
between the different device profiles.

For example if you are printing a photograph, you need to convert its colors from the digital
camera's RGB profile (the source profile) to the printer's CMYK profile (the destination
profile).

This means that every color in the source profile is converted to the closest possible color that
can be reproduced by the destination profile.
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Note:

If you want to proof a file that will be printed on your press, you are trying to reproduce your
press' colors on your proofer.

This means that the press profile is your source profile, and the proofer profile is your
destination profile.

Color Strategies
If you want to refine your color management, you can use color strategies.

A color strategy is a bundle of color management settings that contains at least the source
and destination profiles of the devices you are using, and can contain other color management
settings (dot gain compensation curves, settings like rendering intent for converting out-of-gamut
spot colors and the background color, other settings for converting specific spot colors, etc).

Your company's color management expert can create these color strategies in the Color Engine
Pilot, and you can simply select the one you need in your proofing ticket.

For more detailed information about Color Strategies, see the Color Engine Pilot documentation.

Rendering Intents
A Rendering Intent is a part of your color strategy that handles the conversion of out-of-gamut
spot colors and of the background color.

Each of the four rendering intents available does this in a different way, so you should choose
the one that is more adapted to the way you are printing and the result you want to achieve:

• Use the Relative Colorimetric rendering intent if you don't want to simulate the source
background (the point that has 0% of all inks in the source profile).

This will proof your file as if the proofer substrate was exactly the same as the substrate
defined in your source profile.

For example: your press prints on cream colored card stock whereas your proofer prints on
bright white paper, but you don't want to simulate the cream background on your proof.
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With this rendering intent, colors from the source profile that cannot be reproduced by the
proofer will be converted to the closest color(s) the proofer can reproduce.

In some cases several colors will be converted to the same color, which means that you
can sometime lose some detail, especially in dark saturated areas and the dark parts of
gradations.

 

 

Note that typically the proofer profile has a bigger gamut than the press profile, so there are
not many colors that the proofer cannot reproduce.

• Use the Absolute Colorimetric rendering intent if you want to simulate the source
background to get as exact a color match as possible.

For example: you do want to simulate the cream colored card stock used on your press on
your proofer substrate, to see how the final output will look like (this doesn't only affect the
white but all the colors in your file).
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As with the Relative Colorimetric rendering intent, colors from the source profile that cannot
be reproduced by the proofer will be converted to the closest color(s) the proofer can
reproduce, meaning you can sometime lose some detail, although there are typically not
many press colors that a proofer cannot reproduce.

• Use the Perceptual rendering intent if you are not trying to get an exact color match but
want the proof to look visually pleasing.

If there are colors from the source profile that cannot be reproduced by the proofer, this
will shrink the source gamut to fit inside the gamut of the proofer, so that all colors are
converted (even the colors already in the proofer's gamut), but the relationship between
colors is kept.

 

 

This means that colors won't be really accurate, but you won't lose detail in dark saturated
areas or gradations.

This rendering intent is most commonly used in commercial printing (for newspapers,
magazines, posters...).

• Use the Saturation rendering intent if you mostly want to make sure the colors on your
proof are saturated enough.
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Colors from the source profile that cannot be reproduced by the proofer will be mapped
onto close saturated colors that are in the proofer's gamut.

This rendering intent is most commonly used for business presentations containing
graphics, or cartoons/comics.

Note:  You can only use a Perceptual or Saturation rendering intent if you are working with
ICC source and destination profiles.

The Color Management Database
All your profiles, color strategies and inks are stored in a color management database (also
called "CMS database").

You install this color management database when installing Automation Engine. You can install
it on your Automation Engine server or on another server (the server you install your color
management, curves and screens databases on is called the "resources server").

After this, the profiles, color strategies and inks in your color management database are
automatically available in the Imaging Engine tasks.

Important:

If you are using Imaging Engine for proofing, you should also install the Color Engine Pilot when
installing Imaging Engine.

This will enable you to create your own profiles, color strategies and inks, and to access
PantoneLIVE inks (if you have a PantoneLIVE license).

PantoneLIVE
PantoneLIVE ® is a database of Pantone inks in the cloud. It contains information about how
different tints of an ink look like, and how the ink will look like on different substrates.

Because it is in the cloud, the same color data is accessible to every actor of the packaging
production, globally (while being protected by a login). This ensures that you get predictable
and accurate color every step of the way, saving time and costs.

To use PantoneLIVE inks, you need the Color Engine Pilot and a PantoneLIVE license.

After logging on to the PantoneLIVE cloud from the Color Engine Pilot, you will be able to
download PantoneLIVE ink books from the cloud, and use PantoneLIVE inks in your files.

Please see the Color Engine Pilot documentation for more information about accessing
PantoneLIVE ink books.
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Note:

If you don't have a PantoneLIVE license, any PantoneLIVE ink in your files will be treated as an
unregistered ink (an ink not present in your color database), and you will not be able to proof
or RIP it accurately.

In this case you should ask the file's designer to replace the PantoneLIVE ink by an ink that is
present in your color management database.

16.4.2.  Rasterizing Vector Graphics to Bitmaps

Files coming from a graphic designer may contain vector graphics or "linework" (especially for
fonts or logos).

Vector graphics are highly scalable without any loss of quality (as they are not based on pixels
but on mathematical formulas), but they are not printable.

 

 

To be able to print those graphics, you need to rasterize them with a RIP (Raster Image
Processor). This means converting them to bitmap images, or "contones" (continuous tone
images), which are based on pixels.

 

 

Low-resolution bitmaps can look pixellated, but Imaging Engine generates high-resolution
bitmaps.

In Imaging Engine, you can choose to:

• output your files as contones if you need unscreened output (you can do this with the Image
to Unscreened Separations and the Image to Unscreened Proof tasks).

• screen those contones to get "halftones" if you need screened output (you can do this with
the Image to Screened Separations task).

16.4.3.  Screening

1103



16 Automation Engine

What is Screening?
When printing an image on press, each ink (Cyan, Magenta, Yellow, Black and any additional
ink) is laid out separately on the substrate, and the super-imposition gives the final colors.

At a high detail level, the press can either print ink or not print ink, so to create differences
of color intensity within one ink, you use a small scale pattern of dots of varying size, called a
screen.

 

 

When viewed from a regular distance, this pattern looks like a lighter or darker shade of that
color, depending on how big the dots are (what percentage of the area they cover).

 

 

Screen Ruling
The screen can also be coarser or finer, so that you have to be more or less far away to see it
as shades of a color. This depends on how many lines of dots can fit in a certain measurement.
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This is expressed in lines per inch (lpi), lines per centimeter (lpcm) or lines per millimeter
(lpmm), and is called the screen ruling.

 

 

A low screen ruling as below left looks very coarse, and the quality improves as the screen
ruling gets higher.

 

 

Screen Angles and Moiré

What is Moiré?
When placing the screens of two or more separations on top of each other, a visually
disturbing effect called moiré can occur.

 

 

This is caused by the way the screen patterns are positioned relative to each other.
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The most noticeable moiré patterns happen when the screens have a very small difference in
angle between them:

Screens with a 10° angle difference Screens with a 20° angle difference

 

 

 

 

Screen Angles
To minimize moiré, the different separations' screens are placed at a sufficiently big angle from
each other.

For CMYK, the most "visible" inks (Cyan, Magenta and Black) are placed at 30° intervals, and
Yellow at a 15° interval.

 

 

The exact screen angles used depend on the printing process:
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• Basic offset angles are: Y at 0 degrees, C, M, and K at 15, 45 or 75 degrees depending on the
application.

• Basic flexo angles are: Y at 7.5 degrees, C, M and K at 22.5, 52.5 or 82.5 degrees depending
on the application (or Y at 82.5 degrees, C, M and K at 7.5, 37.5 or 67.5 degrees depending
on the application).

Flexo angles are different from offset angles due to the anilox roll used in flexo presses (a
cylinder which is engraved with millions of small cells that carry a thin film of ink which is
deposited on the plate).

Putting the flexo screens on angles based on a 7.5° offset is needed to prevent moiré
between the screen and the pattern of the inking cells of the anilox roll.

Rosettes
When overlaying the screens of the different separations at their respective screen angles, you
get a type of moiré which is much less visible and distracting at a normal viewing distance. This
is called a rosette pattern.

A rosette pattern can be clear centered or dot centered.

• Clear centered rosettes (also called hole centered rosettes) (below left) are built up around a
hole, and generally considered to be more stable.

• Dot centered rosettes (below right) are built up around a dot, and can give a more saturated
result.

 

 

Yellow Moiré

In four color printing, you may get "yellow moiré" or "4 color moiré" because the Yellow
separation is only at a 15° angle from the Cyan.

This is typically less visible than other types of moiré, but may be a problem if:

• the yellow becomes contaminated by other inks on your press,
• you are printing lots of yellows, light greens and/or skin tones.

If you run into this problem, you need to adjust your yellow screen pattern so that it interferes
less with other separations' screen patterns.

You can do this in Imaging Engine by automatically adjusting the yellow screen ruling.

Screen Angle Range
Conventional screens can either work with a 90° or a 180° screen angle range.

Modulo 90 Screens
Modulo 90 screens are screens that only work with screen angles between 0° and 90°.
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This is because when you rotate such a screen 90°, it looks exactly the same.

 

 

When working with such screens, you cannot place two different separations at angles that are
90° apart (if you did, the smallest registration error would cause severe moiré).

You need to place all separations between 0° and 90° (typically the most visible separations are
placed 30° apart, and the least visible 15° from other separations).

Modulo 90 screens are usually screens that have a symmetrical dot shape, for example the
Circular dot.

However, some modulo 90 screens can have an asymmetrical dot shape, like the Rugby dot.

Modulo 180 Screens
Modulo 180 screens are screens that work with screen angles between 0° and 180°.

Such screens look the same when rotated 180°, but not when rotated 90°.

 

 

When working with such screens, you can place all separations between 0° and 180° (typically
separations are placed 60° apart).

Modulo 180 screens are usually screens that have an asymmetrical dot shape, such as the
Eccentric series of screens.

Note:  You can check the characteristics of a screen in ScreenManager: in the screen details, a
modulo 90 screen only lists angles from 0° to 90°, while a modulo 180 screen lists angles from
0° to 180°.

1108



16Automation Engine

Types of Screens Supported
Imaging Engine supports different types of screens:

• screens with standard dot shapes,

• screens with advanced dot shapes,

• stochastic (FM) screens,

• legacy screens (screens that you have from an old version of FlexRip or Nexus RIP),

• custom screens (screens you have created in the Print Control Wizard, ScreenManager or HD
Flexo).

Depending on your particular license, some of these screens will be included in your Imaging
Engine, and others can be purchased as an option.

Please check the sales material of your product to know what is included.

Screens have a short name and a long name. For example R -> Round Fogra (R being the short
name and Round Fogra the long name). When selecting a screen, they are listed alphabetically
by short name.

Note:

Imaging Engine's halftone phase origin (the point where it starts screening the input file) is the
top left corner.

This is the same origin point as FlexRip and Nexus RIP, so you should be able to re-run old jobs
and get the same alignment (you may notice 1 pixel difference with old Nexus jobs).

Screens with Standard Dot Shapes
Depending on your license, your Imaging Engine product may include the following screens:

Circular (Euclidean) (short name: C)

This screen uses circular dots, that grow continuously circular until 100%.

The circular dot is typically used for flexography and letterpress.

This dot gives good results in many situations. However in some printing conditions the holes
in the shadows can fill in, which can result in unstable or high dot gain, and cause a loss in
tonal range.

In this case consider using the Round Fogra dot instead.

Double Circular (short name: F)

This screen has circular dots in the highlights and mid-tones, and circular holes in the
shadows.
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Note that this screen can cause irregular ink bridging ("bridges" between dots) around the
mid-tones, which can give unstable dot gain in that tonal range.

In this case use the Round Fogra dot instead.

Paragon Euclidean (short name: PAREUC)

Paragon screens are designed for offset and flexo environments, to eliminate rosette drift
and suppress red and green patterns.

This is a Paragon screen with a round dot in the highlights, a checkerboard pattern in the 50%
region, and a negative round dot in the shadows.

 

 

Round Fogra (short name: R)

This screen uses the Round Fogra dot, that closely resembles the elliptical and circular dots,
and can be used the same way. It is also a better alternative for square dots.

It goes from a round dot to a round hole, with a square/diamond shape in the mid-tones.

As with elliptical dots, the touching of the dots at the four corners at 50% (leading to a 50%
intensity jump) is avoided by using a more elongated dot shape so that the dots first touch
around 45% forming a chain and touching for the second time around 55%. This causes less
artefacts and less dot gain when printing.

The Round Fogra dot can be used for virtually all printing processes. It is very popular for
offset printing, but it can also be used for flexography, letterpress, silk screen printing and
for making films for offset-helio conversion. Only chemical etching gravure cannot be done
with this dot shape.

Screens with Advanced Dot Shapes
Depending on your license, your Imaging Engine product may include screens with advanced
dot shapes.

Rugby (short name: D)

This screen has a special dot shape and is used for screen printing. Rugby dots are shaped
like a rugby ball, or a diamond with round edges, which dramatically reduces the interference
of the dots with the mesh structure of the silk screen.
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The dots touch around 35% to form chains. At 65%, a negative dot with rugby shape appears.
This dot shape is fully symmetrical.

Elliptical (short name: E)

This screen uses a more elliptical version of the Round Fogra dots.

For these dots, the first touching point is around 35%. Between 35% and 65%, a chain is
formed with the same orientations as for the Round Fogra dots.

Helio (short name: H)

Helio dots continuously grow square, even above 50%, forming "helio walls".

 

 

This dot is needed for the classic gravure etching processes only. The dot shape is highly
optimized for both contone reproduction and linework areas.

Convex helio dots are the standard helio dots. The dot is as square as possible.

 

 

However in some circumstances the etching process smoothes out the square shape of the
dots, which can cause the helio walls to break during printing (especially at the highest dot
percentages), resulting in bad print quality.
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On film On plate

 

 

 

 

In this case, you should use concave helio dots instead:

Helio Concave (short name: G)

Concave helio dots are designed to avoid the helio walls breaking that sometimes happen
with standard helio dots.

In the concave helio screens, the square-shaped screen dots are replaced by more pillow-
shaped dots.

 

 

When etching the cylinder, the sharp ends are rounded off and the final result is closer to a
square than the result of the standard helio dot.

On film On plate

 

 

 

 

This dot shape will be useable up to slightly higher screen levels than the standard helio dot.

Line (short name: L)

This screen use lines instead of dots.
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The advantages of using line screens are:

• there is no tonal jump because the lines never touch,
• the rosette patterns disappear completely, which gives the illusion of a higher ruling.

Paragon Diamond35 (short name: PARDIA35)

Paragon screens are designed for offset and flexo environments, to eliminate rosette drift
and suppress red and green patterns.

Paragon Diamond35 is a screen with diamond shaped dots.

 

 

Paragon Elliptical35 (short name: PARELL35)

This is a Paragon screen with elliptical dots.

 

 

Square (short name: S)

This screen uses square dots in the highlights, forms a checkerboard at 50% and has square
holes in the shadows.

 

 

At 50%, the tonal jump can be very noticeable, especially when the printing process causes
the holes to fill (for example in Flexo), which results in a large dot gain. If the tonal jump is too
obvious, use Round Fogra or elliptical dots instead.

Eccentric 0 (short name: X0)

Eccentric dots are a series of more or less elongated dots, X0 being the most elongated (the
furthest from a round shape). A screen with X0 dots is close to forming lines.
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Because of the more or less elongated shape of the dots, different eccentric dots have
different touching points. The dots form a chain between the two touching points.

Eccentric 0 has a first touching point at 5% and a second touching point at 95%.

Note:

Eccentric dots have specific advantages for the flexo printing process:

• The flexo process is characterized by a high dot gain. Eccentric dots tend to lower this dot
gain, as well as the tonal jumps caused by dot gain.

• The more eccentric the dot is (X0 and X1 dots), the less noticeable rosette patterns it
generates. The difference in rosette patterns between eccentric dots and conventional
round or circular dots is more striking in flexo than in offset or gravure, due to the lower
rulings used in flexo.

Eccentric 1 (short name: X1)

Eccentric 1 dots are slightly less elongated than X0 dots.

 

 

Eccentric 1 has a first touching point at 10% and a second touching point at 90%.

Eccentric 2 (short name: X2)

Eccentric 2 dots are less elongated again.

 

 

Eccentric 2 has a first touching point at 20% and a second touching point at 80%.

Eccentric 3 (short name: X3)

Eccentric 3 dots are only slightly elongated.
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Eccentric 3 has a first touching point at 30% and a second touching point at 70%.

Eccentric 4 (short name: X4)

Eccentric 4 dots are the least elongated of the eccentric dots. They are close to Round Fogra
dots.

 

 

Eccentric 4 has a first touching point at 40% and a second touching point at 60%. At 50% the
dots form a checkerboard.

Stochastic (FM) Screens
In "stochastic" (or Frequency Modulated) screens, dots are not placed on a regular grid pattern
like in conventional (Amplitude Modulated) screens.

In a conventional screen, the dot size grows with the intensity (you have bigger dots at 50%
than at 25%). In a stochastic screen, the dot size stays the same, but you get more dots per
area as the intensity increases.

The advantages of stochastic screens are:

• sharper images,
• the full elimination of disturbing rosette patterns,
• no color shift caused by small registration errors (those errors are less visible than the same

errors with conventional screens, which can reduce press preparation time),
• the possibility to combine more than 4 separations without moiré.

FM (short name: FM)

The FM screen is a first order stochastic screen (dots have the same size all over the density
range), that uses square dots.

 

 

Each FM dot size corresponds to a specific set of rulings, for different output resolutions. You
can find more information in the Imaging Engine Screen Rulings look-up table.
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Monet (short name: M)

The Monet screen also uses dots of the same size all over the density range, but unlike the FM
screen, it can have square and/or rectangular dots. It is optimized for offset printing.

In many cases, it can also be used in combination with a Rugby dot for silk screen printing.

 

 

If you experience high dot gain when using a Monet screen, we recommend you switch to an
Organic screen.

Each Monet/Monet for Flexo dot size corresponds to a specific set of rulings, for different
output resolutions. You can find more information in the Imaging Engine Screen Rulings look-up
table.

Monet for Flexo (short name: MF)

This screen is based on the Monet screen.

The Monet for Flexo screen has holes in the shadows that are bigger than the dots in the
highlights, so they don't fill up as much with dot gain (not increasing the shadows' darkness
too much).

 

 

This is especially beneficial for printing processes with high dot gain such as flexo.

Each Monet/Monet for Flexo dot size corresponds to a specific set of rulings, for different
output resolutions. You can find more information in the Imaging Engine Screen Rulings look-up
table.

(Older) Monet for Flexo (short name: MFOLD)

The Monet for Flexo screen used in FlexRip and versions of Imaging Engine up to 16.0.2 has
been renamed to Monet for Flexo - with perimeter info for FlexRip (short name: MFOLD)
from Imaging Engine 16.1.

• If using this screen gave you satisfactory results, you can continue using it as before.
• If you experienced problems with the grey levels not being linear enough throughout the

tonal range (such as the mid-tones being too light), you can use the new Monet for Flexo
(short name: MF) screen instead (available from Imaging Engine 16.1).

Organic (short name: O)

Unlike first order stochastic screens like FM, Monet or Monet for Flexo, where the single dots
are left on their own, the organic dots are combined in clusters, forming organic-like random
structures. This reduces the dot gain around the mid-tones.
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However, Organic screens can generate noise in images, giving a grainy appearance. If you
experience this problem, we recommend you switch to a Monet screen.

The Organic screen is optimized for offset printing.

 

 

Legacy Screens
If you have some screens that you got with an old version of FlexRip or Nexus RIP, they will still
be available in Imaging Engine.

Note:

Those are pre-calculated screens that were created for specific printing environments or to
solve specific problems. They can only perfectly match certain sets of conditions.

Today, you can get the same effects, fine-tuned for your particular printing conditions, by
creating custom screens in HD Flexo and/or ScreenManager.

See the HD Flexo and/or ScreenManager documentation for more information.

Conventional (AM) Screens

TwinBeam (short name: CD0)

The TwinBeam screen was developed for the CDI. It uses round dots that are exposed by two
laser beams.

 

 

CDI MultiBeam Optimized (short name: CD1)

The CDI MultiBeam Optimized screen was also developed for the CDI, as an improvement to
the TwinBeam screen. It uses round dots that are exposed by several laser beams.

 

 

Endless (short name: CO)
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This screen was used in combination with cylindrical sleeves on the CDI, to make several
copies of a job print continuously on the substrate, without broken dots at the edges of each
job.

For best results, we recommend you use the seamless screening functionality to create a
custom seamless screen instead of using the Endless dot.

This screen uses a circular dot shape.

 

 

Groovy (short names: GVY1 to GVY5)

Groovy screens put a line pattern in the dark areas of the screen only. The lighter areas have a
Double Circular dot pattern.

 

 

The transition between the normal screen pattern and the line pattern is smooth, leading to a
smooth gradation on print between the lower density (non-groovy) and higher density areas
(groovy).

They improve solid rendering in flexo printing (the lines help even out the ink distribution)
and have their best performance on foils. Performance on other substrates (paper, metal) is
heavily dependent on the printing circumstances.

You can choose between different groovy screens:

Long name Short name Pattern
angle

Pattern
ruling

Transition
start

Maximum
pattern
percentage

Pattern

Groovy1 GVY1 Close to 45
degrees

3 times the
original
ruling

95% 45% Lines

Groovy2 GVY2 Close to 45
degrees

3 times the
original
ruling

90% 45% Lines

Groovy3 GVY3 Close to 45
degrees

4 times the
original
ruling

95% 45% Lines
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Long name Short name Pattern
angle

Pattern
ruling

Transition
start

Maximum
pattern
percentage

Pattern

Groovy4 GVY4 Close to 45
degrees

4 times the
original
ruling

90% 45% Lines

Groovy5 GVY5 Close to 45
degrees

3 times the
original
ruling

93% 45% Eccentric1

Transitional (AM/FM) Screens

Circular Samba (short name: CS)

Samba screens are transitional screens, that were designed to solve problems in the highlights
in flexo.

They have a stochastic part in highlights and shadows, a conventional part in the mid-tones
and the transition between both contains a pattern that is gradually going from stochastic to
conventional over a large number of intermediate patterns.

 

 

SambaFlex (short names: CS4 to CS45)

Like Samba screens (which they are based on), SambaFlex screens are transitional screens,
going from stochastic to conventional and back.

 

 

SambaFlex screens support seven different minimum dot sizes, for every imagesetter
resolution. These sizes cover a very broad range, from hardly visible dots until dots so big that
they can only be used for artistic effects.

• Screens with a small minimum dot size (like CS4) have almost unnoticeable stochastic
effects.

• Screens with a bigger minimum dot size (like CS45) have a coarser stochastic pattern, and
less dots in the highlights. The transition point in the highlights shifts up to higher dot
percentages.

SambaFlex Highlight (short names: CS4H to CS45H)
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These screens are based on the SambaFlex screens, and only have a stochastic part in the
highlights. In the shadows, they stop at the darkest point, whether it is 100% or not (for these
screens it is usually 95%).

 

 

Custom Screens
In Imaging Engine, you can also use any custom screen you created in the Print Control
Wizard, HD Flexo or ScreenManager application. You will recognize those custom screens
because:

• Screens created with the Print Control Wizard have a short name beginning with CRS
(CRS01, CRS02...).

CRS (or "Crystal") screens are developed exclusively for use with the CDI Crystal imager series
and the XPS Crystal exposure unit series.

See Crystal Screens on page 1120 for more information.

You can find more information about creating a screen with the Print Control Wizard in the
Print Control Wizard documentation.

• Screens created in HD Flexo have a short name beginning with HD (HD01, HD02...).

For more information about creating a screen with HD Flexo, please see the HD Flexo
documentation (available from within your application).

• Screens created in ScreenManager have a short name beginning with SCR (SCR01,
SCR02...).

For more information about creating a screen with ScreenManager, please see the
ScreenManager documentation (available from within your application).

Crystal Screens

Crystal screens are Esko's latest screening technology, developed exclusively for use with the
CDI Crystal imager series and the XPS Crystal exposure unit series, for a high quality flexo printing
workflow.

You can create Crystal screens using the Print Control Wizard application, that will guide you in
creating custom screens and curves for your specific printing setup, to ensure better quality
control.

For more information about creating a custom Crystal screen, see the Print Control Wizard
documentation.

Screen Characteristics
Crystal screens use multiple Esko screening technologies:

• Pixel+ technology, where each dot is made of individual pixels, that are "boosted" on the CDI
to make printable dots,
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• a transition from solid dots in the highlights to Pixel+ dots in the rest of the tonal range (for

the Crystal C variant of the Crystal screens),
 

 
• FM screening in the highlights (used in your custom screen when it benefits your specific

printing setup),
• support dots at single or double ruling (used in your custom screen when it benefits your

specific printing setup).

When using Crystal screens, you don't need to use object-based screening (different screens
for individual objects in your file), as they give good results in all areas:

• They provide a smooth transition from the solids into the shadows and mid-tones, with
reduced dot bridging.

 

 

 

 

dot bridging with a circular dot no dot bridging with a crystal screen
• They produce stable highlights that fade out to zero more smoothly than with other

screening technologies.

The Screens Database

All your screens are stored in a screens database.

You install this screens database when installing Automation Engine. You can install it on your
Automation Engine server or on another server (the server you install your screens, curves and
color management databases on is called the "resources server").

After this, the screens in your screens database are automatically available in the Imaging
Engine tasks.
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Seamless Screening

What is Seamless Screening?
You can use seamless screening if you want to print several copies of a job continuously on
your substrate (typically using flexo sleeves, that you image using a CDI or other CTP device).

Seamless screening makes sure the screening is continuous between jobs in the horizontal
direction, so that there are no broken dots at the edges of each job (that could cause a visible
join or moiré effects).

 

 

How Does it Work?
Imaging Engine starts from the requested screening parameters (resolution, dot shape, screen
angle and ruling), and if necessary modifies them slightly to ensure there are no broken dots at
the horizontal seam between jobs.

This modification can be a slight scaling and/or rotation, and gives a result which is very close
to the requested screening parameters. Depending on your file and parameters, there may be:

• a ruling difference of maximum 2 lpi,
• an angle difference of maximum 1 degree,
• in some cases, a slight horizontal or vertical shift near the seam,

This shift is typically no bigger than 1 pixel, except when using a high resolution with a low
ruling (like 4000 ppi and 80 lpi, or 2000 ppi and 40 lpi), where it can be slightly more.

• a rosette shift over a distance of at least 1 meter.

A rosette shift is when the rosette pattern gradually shifts from clear centered to dot
centered (or vice-versa), over a certain distance.

Since seamless screening makes sure that the rosette pattern is identical on both sides of
the seam, the most variation occurs in the middle of the file.
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In most cases (for example when using a 400 mm wide CDI sleeve), this will not be
noticeable.

For 2 meter wide files, the rosette pattern will be different in the middle of the file (for
example, it will go from clear centered on one edge, to dot centered in the middle, and back
to clear centered on the other edge, as in the example above).

Note:  You can find information about any modification made to your screening parameters to
make your screen seamless in the Imaging Engine task's log file.

What Screens Can You Use it With?
You can use seamless screening with any dot shape/screen except:

• stochastic screens,
• Groovy screens,
• Samba or SambaFlex screens,
• Paragon or other legacy Artwork Systems screens.

Tip:

If you need a seamless Samba screen, do the following:

1. In ScreenManager, create a custom screen that has the same properties as the Samba
screen:

• with highlight effects enabled,
• with the transition method set to "Traditional PerfectHighlight",
• with the same transition point as the Samba screen (for example, to replace the Samba

screen "CS25", set the transition point to 25).
2. Make that custom screen seamless.
3. Use that custom screen in Imaging Engine, with the seamless screening option.

See the ScreenManager documentation for more information.

The following screens cannot completely be made seamless:

• AutoBlend screens (that use stochastic screening in the highlights and conventional
screening in the rest of the range): the stochastic part of the screen will not be seamless.

• HD Flexo screens with advanced screening effects (for example a highlight effect or
surface screening): the dot, screen ruling and angle will be seamless, but not the advanced
screening effects. For example:

If your screen has a highlight effect that removes some dots to decrease tone in the
highlights, the same dots will not be removed on both sides of the seam.
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If your screen has microcells that perforate dots and solids to improve ink lay down, the
microcell pattern will not repeat continuously near the seam.

 

 

Screened or Unscreened Output?
When RIP'ing your files with Imaging Engine, you can produce either screened or unscreened
output.

• You typically need screened output to send to a platesetter or filmsetter (for offset or flexo
for example).

Run the Image to Screened Separations task on your input file to produce screened output (a
screened file per separation).
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• You typically need unscreened output to send to a device that will take care of the
screening, or a device that doesn't need screened input (for gravure for example).

Run the Image to Unscreened Separations task on your input file to produce unscreened
output (an unscreened file per separation).

 

 

Quality Control for Screened Output

Inspecting Screened Files with the Bitmap Viewer
Once you have generated screened files with Imaging Engine, you can inspect them with the
Bitmap Viewer.

The Bitmap Viewer is a powerful quality control tool that will help you verify the content and
printability of your screened files before you make plates from them.

It is a separate application, that you should have installed as part of your Imaging Engine
installation.

Using the Bitmap Viewer
You can open the Bitmap Viewer from:

•
your desktop (using its shortcut icon ),

• your output file in Automation Engine (as explained below).

The first time you want to open a file in the Bitmap Viewer from the Automation Engine Pilot,
do the following:

1. Right-click the file to open and select Open With then Other...
2. In the Select Application dialog that opens, click Register...
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3. In the Register dialog that opens, click Browse... and browse to the executable of your
Bitmap Viewer application.

If you installed it in the location proposed by default, the path should look like either:

• C:\Esko\BitmapViewer_x64\BitmapViewer.exe if you have installed the 64-bit
version of the application,

• C:\Program Files (x86)\BitmapViewer\BitmapViewer.exe if you have installed
the 32-bit version of the application.

4. Click OK.
5. Click Open in the Select Application dialog.

The next time you want to use the Bitmap Viewer, you can just right-click your file, select Open
With, and select BitmapViewer.

Inspecting Screens with Advanced Screening Effects

What is an Advanced Screening Effect?

If you are using HD Flexo screens or custom screens created in ScreenManager, those screens
may contain advanced screening effects to help improve your printing quality.

Advanced screening effects modify specific parts of your screen, to improve how the plate
interacts with the ink and paper, and achieve a better printed result in those areas.

Typically they are applied in the highlights (highlight effects), or the shadows (surface
screening effects).

For example:

• PerfectHighlights screens have very small "support dots" in the highlights, that are not
printable but improve the highlights' stability.
 

 
• Groovy screens have grooves in the solids (or in the dots and solids), to improve ink lay-

down and print more evenly (the grooves will fill up when printing).
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This helps prevent "pin holes" created by too much ink in the solids.

Plain solid Solid with surface
screening effect

Digital file

 

 

 

 

Printed result
(with white ink)

 

 

 

 

• Cell centered / Platecell screens have holes in the dots that grow as the dots grow (the
dots are "cell centered"), while the solids are perforated by a uniform pattern (the "platecell"
pattern). This also improves ink lay-down.
 

 

• Microcell screens have a specific type of holes ("microcell" holes) in the dots and solids.
This also improves ink lay-down.
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• P+ Microcell screens use a pattern composed of single pixels to create holes in the dots
and solids. These screens are used on certain CDI devices, for example for Full HD Flexo.
 

 

• Concentric screens have ring-shaped holes in the dots, to print with a thinner ink layer and
improve the color of the printed result.
 

 

For more information about advanced screening effects and how to use them, please see the
HD Flexo and/or ScreenManager documentation.

Performing Quality Control on Screens with Advanced Screening Effects

While screening effects improve print quality, screens with those effects do not look like your
printed sheets.

For example, the holes in the solids that you see in your screened file will not be there on your
print, and tone readings in LEN or LENX files will not match printed tones.

This makes it difficult to perform quality control on such screens.

Imaging Engine offers a solution for this problem: when you are making your screened files for
production, you can create print simulation files at the same time.

1128



16Automation Engine

These print simulation files look like your production files, but with the advanced screening
effects removed, so you can open them in the Bitmap Viewer and check exactly how your
output will look like.

For example (you can see the screens with advanced effects on the left, and the print
simulations on the right):

PerfectHighlights screen at 2.5% (with support dots), and print simulation (with support dots removed)

Groovy screen at 100% (with grooves), and print simulation (with grooves removed)

Note:  This also applies to predefined groovy screens (GVY1 to GVY5).

Platecell screen at 100% (with platecell pattern), and print simulation (with pattern removed)

Microcell screen at 57% (with microcell holes), and print simulation (with microcell holes removed)
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P+ Microcell screen at 100% (with pixel pattern), and print simulation (with pattern removed)

Concentric screen at 27% (with ring-shaped holes), and print simulation (with rings removed)

Attention:

Measuring the print simulation version of a concentric screen in the Bitmap Viewer will
give slightly higher percentages than on the final print.

This is because unlike surface screening effects (groovy, platecell, microcell...), the main
effect of concentric screening is not to improve ink lay-down but to print with a thinner
ink layer.

16.4.4.  Dot Gain Compensation

What is Dot Gain?
When printing a job, the dots tend to print larger on the press than on the plate, which makes
the output darker than the original file.

Original job

 

 

Plate  
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Print

 

 

This is due to different factors:

• the type of ink: the more fluid the ink is, the more it will spread under pressure of the press.
• the type of substrate: paper with a rougher and more porous surface (like uncoated paper)

reflects less light, making the printed area look darker.
• the type of press:

• offset presses typically print at a 67% density for a 50% dot,
• flexo presses have an even higher dot gain as they put more pressure on the substrate,
• gravure presses have a dot gain similar to offset presses for small dot sizes (up to about

30%) and a sharply increasing dot gain for higher percentages (70% prints as solid).

What is Dot Gain Compensation?
To compensate for dot gain and have the printed output look like the original file, you use dot
gain compensation (DGC). This consists in making the dots on the plate smaller, so that with
dot gain they print to the correct density.

Dot on plate Dot on press

Without DGC

 

 

 

 

With DGC
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Dot Gain Compensation Curves
You apply dot gain compensation by using a dot gain compensation curve, which defines which
percentage to use on plate for each desired percentage on press.

In the example below, you see how a press prints without any dot gain compensation in the
dot gain curve at left: a 20% on the plate prints to 57% on press. 57% on the plate would print
to almost 90% on press.

At right, you see the dot gain compensation curve used to make the press print to the
expected value in the job: to print a 57% on press, a 20% will be used on the plate. To print a
20% on press, you would need about 5% on the plate.

press

plate

plate

press

Dot gain curve Dot gain compensation curve

Creating a Dot Gain Compensation Curve
You can create dot gain compensation curves in Curve Pilot (for more information, see the
Curve Pilot User Guide: https://www.esko.com/en/support/product?id=Curve%20Pilot).

Dot gain compensation curve files have the .dgc extension.

Using a Dot Gain Compensation Curve
You can apply a dot gain compensation curve on all or some separations of your job in the
Image to Screened Separations and Image to Unscreened Separations tasks in Imaging Engine.

DGC Curve Strategies

Different Dot Gains within a Job
When using a single dot gain compensation curve, the same dot gain compensation is applied to
the complete job, without making any compensation difference in the screening parameters,
the inks or the type of content (continuous tone images or line work).

However, dot gain is influenced by those factors.

Screening parameters

The following parameters influence dot gain:
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• The dot shape: for example square, round and elliptic dots have slightly different dot gain
characteristics.

Stochastic screens produce more dot gain in the mid-tones than conventional screens.

See Types of Screens Supported on page 1109 for more information about dot shapes and
screens.

• The screen ruling: dot gain only happens on the perimeter of the printing dots, which
means that higher rulings always result in higher dot gain.

For example, a double ruling means double dot gain.

Inks

Dot gain compensation on a Yellow separation is often less important and less needed than
dot gain compensation on a Cyan separation.

The viscosity of the ink also has a big influence.

Continuous tone images or line work

Sometimes, images have been pre-compensated for dot gain in an image editing program, so
they need less dot gain compensation than linework.

Dot Gain Compensation Curve Strategies
A dot gain compensation curve strategy contains several dot gain compensation curves,
and defines when to apply which curve (it can have different curves per separation, dot shape,
ruling, for continuous tone images or line work...).

Creating a Dot Gain Compensation Curve Strategy
You can create dot gain compensation curve strategies in Curve Pilot (see the Curve Pilot
documentation for more information).

Dot gain compensation curve files have the .icpro extension.

Using a Dot Gain Compensation Curve Strategy
You can apply a dot gain compensation curve strategy in the Image to Screened Separations and
Image to Unscreened Separations tasks in Imaging Engine.

Each job separation or object is automatically compensated with the appropriate dot gain
compensation curve.

Note:  You can also use legacy screen-based DGC files (.scrdgc) as dot gain compensation
curve strategies in Imaging Engine.

PressSync Curves
PressSync curves are predefined compensation curves that can cover the dot gain
compensation needs of most presses, while significantly reducing the complexity of dot gain
compensation in workflows.

Slope and Mid-tone Compensation
Curves are defined by a letter and a number.

• The letter (A to H) describes how the press behaves in the highlights and shadows (the
slope): an A curve makes the press print darker in the highlights and lighter in the shadows
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(for presses who have the opposite problem), while an H curve, on the contrary, makes the
press print lighter in the highlights and darker in the shadows.
 

 

An E curve is halfway in between and has a straight slope: it corrects the output the same
way throughout the range. Use it for presses whose output is consistent in the highlights,
mid-tones and shadows.

• The number indicates how much the 50% dot (mid-tone) prints to: an E20 curve
compensates the 50% dot to 20%, while an E70 curve compensates 50% to 70%.
 

 

Creating a PressSync Curve
You cannot create PressSync curves, they are predefined. There are 400 different PressSync
curves, to match most dot gain compensation needs.

If you wish, you can see each PressSync curve on a graph in PressSync Pilot (for more
information, see the Curve Pilot User Guide: https://www.esko.com/en/support/product?id=Curve
%20Pilot).

Using a PressSync Curve
You can apply a PressSync curve as press curve on all or some separations of your job in the
Image to Screened Separations and Image to Unscreened Separations tasks in Imaging Engine (you
just need to enter the letter and number of the PressSync curve).
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PressSync Curve Sets
A PressSync curve set contains several PressSync curves, each assigned to an ink (a process ink
or any spot color defined in Esko's CMS database).

Creating a PressSync Curve Set
You can create PressSync curve sets in PressSync Pilot (see the PressSync Pilot documentation
for more information).

PressSync curve sets files have the .prsync extension.

Using a PressSync Curve Set
You can apply a PressSync curve set as press curve in the Image to Screened Separations and
Image to Unscreened Separations tasks in Imaging Engine.

Each job separation is automatically compensated with the appropriate PressSync curve.

The Curves Database
All your dot gain curves, dgc curve strategies, PressSync curves and PressSync curve sets are stored
in a curves database (also called "DGC database").

You install this curves database when installing Automation Engine. You can install it on your
Automation Engine server or on another server (the server you install your curves, screens and
color management databases on is called the "resources server").

After this, the dot gain curves, curve strategies, PressSync curves and curve sets in your curves
database are automatically available in the Imaging Engine tasks.

16.4.5.  File Formats

Imaging Engine can output to the following formats:

For Proofing
• TIFF, a bitmap file format widely supported by image-processing, publishing, DTP and other

applications.

Imaging Engine can generate composite TIFF proofs (with the Image to Unscreened Proof
task).

• PDF, a multifunctional file format, supported by most graphics-related applications.

Imaging Engine can generate composite PDF proofs (with the Image to Unscreened Proof
task).

• JPEG, an image file format widely used for photographs and preview images (with the Image
to Content Proof (RGB) or Image to Unscreened Proof task).

• Imaging Engine can also generate proofs directly into your proofer's format for immediate
proofing (with the Proof for Content Approval task).
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For RIP'ing
• TIFF, a bitmap file format widely supported by image-processing, publishing, DTP and other

applications.

You can output to screened or unscreened TIFF (with the Image to Screened Separations or
Image to Unscreened Separations tasks).

• PDF, a multifunctional file format, supported by most graphics-related applications.

You can output to screened or unscreened PDF (with the Image to Screened Separations or
Image to Unscreened Separations tasks).

• LEN, a bitmap file format developed for Esko's Cyrel Digital Imager, or "CDI".

LEN files have high resolutions of 2100 ppi or more. They are always screened. You can
output to LEN files with the Image to Screened Separations task.

You can then send your LEN files to your flexo plate making software (Automation Engine's
Automated Flexo Plate Making module, the Digital Flexo Suite, or Grapholas), which will use
them to expose flexo plates on the CDI drum.

• LENX, an encrypted version of the LEN file format developed exclusively for Esko's CDI
Crystal imager series and Crystal screens.

LENX files always have a resolution of 4000 ppi. You can use the Image to Screened
Separations task to generate them (they are always generated when you use Crystal screens).

Note:  The file formats you can generate with your Imaging Engine software depend on your
license. Please contact your Esko sales representative for more information.

Composite and Separated Files
With Imagine Engine, you can generate either composite or separated files.

Composite Files
Composite files are files that contain several separations.

Imaging Engine can generate composite PDF and composite TIFF files (from the Image to
Unscreened Separations and Image to Unscreened Proof tasks).

JPEG output (from the Image to Content Proof (RGB) and Image to Unscreened Proof tasks) is
always composite.

When generating composite output from:

• a single page input file, you get a single page output file containing all of the separations
you choose to output (after excluding technical inks for example).
 

 
• a multi-page input file, you get one output file per page of the input file, containing all of the

separations you choose to output from that input file page.
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In the example below, the input file has 2 pages, containing respectively Magenta and
Yellow, and Yellow and Cyan. When outputting to composite files, you get 2 one-page files,
each containing the separations of the corresponding page in the input file.

 

 

Separated Files
Separated files are files that only contain one separation each. Imaging Engine can generate
separated PDF, TIFF, LEN and LENX files.

You can generate separated output using the Image to Unscreened Separations and the Image to
Screened Separations tasks.

When generating separated output from:

• a single page input file, you get one output file per separation of the input file that you
choose to output (after excluding technical inks for example).

In the example below, the input file has one page with a Magenta and a Yellow vignette.
After RIP'ing, you get 2 files (one for each separation), each containing a single channel
bitmap.

Unscreened separated output
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Screened separated output

• a multi-page input file, you get one output file per page of the input file and per separation
that you choose to output.

In the example below, the input file has 2 pages, each containing a Magenta and a Yellow
vignette. After RIP'ing, you get 4 files (one for the 1st separation of the 1st page, one for the
2nd separation of the 1st page, etc.), each containing a single channel bitmap.

Unscreened separated output
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Screened separated output

16.4.6.  Calculating Ink Distribution

If you print with an offset press, there is an extra quality step you can perform once your files
have been proofed and RIP'ed and are production ready.

With Imaging Engine, you can generate CIP3 files, which are technical files containing
information about the ink distribution in your production ready files.

When you send those CIP3 files to the press, the press software knows the amount of ink
needed for each separation of your RIP'ed files, and where in the file it is needed.

It can then automatically calculate how to distribute the ink among the different print heads,
without needing manual adjustments from the press operator.

This is faster and more accurate, and helps keep your prints "clean".

You can create CIP3 files using the Calculate Ink Key Settings (CIP3) task.

16.5.  Imaging Engine Installation and Configuration

16.5.1.  Licensing

To use the Imaging Engine functionality in Automation Engine, you need an Imaging Engine
license (in the form of a product key file).

If you don't have this license, you will not be able to configure Imaging Engine in the Automation
Engine Pilot, or see the Imaging Engine tasks.
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Depending on the license you have, you will be able to output to some or all of the supported
output formats (TIFF, PDF, LEN and LENX), and you may be limited to a certain output file size or
not (for LEN files).

For more information about the available licenses and which would fit your production best,
please talk to your Esko sales representative.

16.5.2.  Installation

Installation or Upgrade?

Software Version
This document covers the installation of / upgrade to the latest version of Imaging Engine
(and related applications):

Product version Imaging Engine 20

Current release Imaging Engine June 2020 Release

also called Imaging Engine 20.0

For more information about the released version and build number of each of the applications,
please see the Released versions page on the installation DVD.

Installation or Upgrade?
If...

• no Esko software has been installed on your computer yet, you need to perform a new
installation of Imaging Engine 20.0.

See Installation Overview on page 1140.

• Esko RIP or proofing software is installed on your computer, you need to upgrade to
Imaging Engine 20.0 instead.

See Upgrade Overview on page 1149.

Installation Overview
To use Imaging Engine, you will need to first license then install the following applications:

application: before installing, please check:

Automation Engine the Automation Engine system requirements
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application: before installing, please check:

Note:

You should have already installed Automation
Engine before starting to install the Esko Proof
Server and Imaging Engine.

See the Automation Engine installation
documentation for details if needed.

the Esko Proof Server (if you are planning
to proof using Imaging Engine and the Esko
Proof Server)

the Esko Proof Server system requirements

Imaging Engine the Imaging Engine system requirements

You can either install these applications on the same server, or on two or three different
servers.

General installation procedure:

1. Make sure you have the relevant DVDs.

• To install the Esko Proof Server, you need the Esko Software - Proof Server 18.0
Installation DVD.

• To install Imaging Engine, you need the Esko Software - Imaging Engine 20 Installation
DVD.

Note:  If you downloaded the software from MySoftware.esko.com, you will need to mount
the corresponding .iso files as virtual DVDs, or unpack the .iso files first.

2. Make sure you have the relevant licenses.
You need a product key file for Imaging Engine 20 (which includes all necessary licenses). If
you do not have a product key file yet, contact Esko Customer Support.

3. On all servers on which you want to install Esko software, prepare for the installation.
4. On your license server (which can be either your Automation Engine server or a central

license server), activate your licenses.
5. If you want to install the Esko Proof Server, perform the steps listed in Installing the Esko

Proof Server on the server on which you want to install it.
6. On the server on which you want to install Imaging Engine, perform the steps listed in

Installing Imaging Engine.

Preparing for the Installation
Before you install Imaging Engine 20.0 on your system, check the following:

• You need to have Administrator privileges.

• You need Internet access.

• Your computer must meet the minimum requirements for the installation, as described on
www.esko.com/en/SystemRequirements/.
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• Data Execution Prevention (DEP) must not block the installation. See How to Change the
Data Execution Prevention (DEP) Settings on page 1142.

• The Password Policy must not block the installation. See How to Change the Password Policy
on page 1142.

• You must make sure your anti-virus software is not blocking the installation or
configuration.

How to Change the Data Execution Prevention (DEP) Settings

Data Execution Prevention (DEP) is a security feature that helps prevent damage from viruses
and other security threats by monitoring your programs to make sure they use the computer's
memory safely.

Before installing Imaging Engine, make sure that DEP does not block the installation.

1. In Control Panel, click System > Advanced System Settings.
2. Click the Advanced tab.
3. Under Performance, click Settings.
4. Click the Data Execution Prevention tab.
5. Select Turn on DEP for essential Windows programs and services only.
6. Click OK.
7. Restart the computer.

How to Change the Password Policy

A password policy is a set of rules designed to enhance computer security by encouraging
users to employ strong passwords and use them properly.

Before installing Imaging Engine, make sure that the password policy on your system does not
block the installation.

1. In Control Panel, click Administrative Tools.
2. In the Administrative Tools window, double-click Local Security Policy.
3. In the Local Security Policy window, double-click Account Policies > Password Policy.
4. In the right pane, double-click Password must meet complexity requirements.
5. Select Disabled.
6. Click OK.

Activating the Licenses
Imaging Engine 20 is protected with licenses. These licenses are distributed as a product key
file (in .html).

You need to activate the product keys in the product key file using the Network License
Manager application, on the server that you are using as a license server (this can be either
your Automation Engine server or a central license server).

You should have installed the Network License Manager as part of your Automation Engine
installation. See the Automation Engine installation guide if needed.

You need:

• A product key file for Imaging Engine 20 (which includes all necessary licenses). If you do not
have a product key file yet, contact Esko Customer Support.
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• Internet access on the server that you are using as a license server.

• An Esko ID in order to activate the licenses. You can get one at http://www.esko.com/
licensing/CreateAccount.

On the server that you are using as a license server:

1. Open the Network License Manager.
Depending on your operating system, you can do this by:

• going to Start > All Programs > Esko > Network License Manager > Network License
Manager,

• clicking Network License Manager on your Apps screen.
2. In the Esko Network License Manager, do one of the following:

• drag your product key file in the area marked Drag your Product Key File or your
Response file here,

• click the Activate button.
3. Follow the instructions of the Activate License Wizard.
4. When asked about the product keys, choose I have received an HTML file containing my

Product Keys.
5. Click Browse to select the product key file.
6. When asked, fill in your Esko ID and Password.
7. Click Finish.

The licensed products you can use are now visible in the Network License Manager.

Installing the Esko Proof Server
If you are planning to proof using Imaging Engine and the Esko Proof Server, you now need to
install the Esko Proof Server.

You need the Esko Software - Proof Server 18.0 Installation DVD for the installation. Use the
following procedure to install the Esko Proof Server:

1. Open the Esko Software - Proof Server 18.0 Installation window:

• If you insert the Esko Software - Proof Server 18.0 Installation DVD into the DVD drive, or
mount the corresponding .iso file, the window appears automatically.

• If you unpacked a downloaded .iso file, or if the window doesn't open automatically,
double-click setup.exe in the root folder.

2. Select the installation language.
3. Click Proceed to the installation.
4. On the Esko Proof Server 18.0 Installer page:

a) If you activated your licences on a central license server (not the server on which you are
installing the Esko Proof Server), connect your Esko Proof Server server to this license
server.
See How to Connect to the License Server on page 1144 for details.

b) Run the system readiness check.
See How to Perform the System Readiness Check  on page 1144.

c) Proceed with the software installation.
See How to Install the Esko Proof Server on page 1144.
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d) If you are installing the Esko Proof Server on a separate server (not your Automation
Engine server), make sure that Automation Engine can send files to the Esko Proof Server
share.
See Giving Automation Engine Access to the Esko Proof Server Share on page 1145 for
details.

How to Connect to the License Server

If you activated your licences on a central license server, you need to connect to this license
server from your Esko Proof Server.

1. On the Esko Proof Server 18.0 Installer page, click on Install, update or repair the
License Server (Network License Manager component).

2. Follow the instructions of the installation wizard.
If the wizard asks you to restart the computer, do so, then relaunch the installation.

3. Back on the Esko Proof Server 18.0 Installer page, click Activate the licenses to open the
Network License Manager.

4. In the Esko Network License Manager, go to Tools > License Client Configuration.
5. In the License Client Configuration dialog:

a) Enter the name of the server that you are using as a license server.
b) Click Apply.
c) Click Exit.

6. Close the Network License Manager and go back to the Esko Proof Server 18.0 Installer
page.

How to Perform the System Readiness Check

Before you install the Esko Proof Server, a System Readiness Check is required. This checks
whether the operating system is suited for installing and running the Esko Proof Server.

1. On the Esko Proof Server 18.0 Installer page, click on Run the Esko Proof Server 18.0
System Readiness Check.

2. At the end of the Readiness Check, read the resulting messages carefully.
3. If the Readiness Check resulted in a problem with:

Options Description

The password policy Change the password policy.

The Data Execution Prevention (DEP) Change the DEP Settings.

4. Click Exit.

How to Install the Esko Proof Server

1. On the Esko Proof Server 18.0 Installer page, under Installation or upgrade of the Proof
Server component, click Install or upgrade the Proof Server and Profiles components.

2. Follow the instructions of the installation wizard.
If the wizard asks you to restart the computer, do so, then relaunch the installation.

3. During the installation of the Esko Profiles, select the proofing devices for which you want to
install profiles.

1144



16Automation Engine

If you are not sure which proofing devices you own, you can select Esko Profiles at the top
to install all the profiles, but this is not recommended.

4. At the end of the Esko Profiles installation, click Finish.
5. During the installation of the Esko Proof Server, select Server and Client as the features

you want to install.
6. At the end of the Esko Proof Server installation, click Finish, and restart your computer as

directed by the installer.

Giving Automation Engine Access to the Esko Proof Server Share

If you installed the Esko Proof Server on a separate server (that has no other Esko software),
you need to make sure that Automation Engine can send files to the Esko Proof Server share.

Note:  If you installed the Esko Proof Server on the server where Automation Engine is
installed, this is done automatically.

Do the following:

1. On the Automation Engine server, check under which user Automation Engine is running.

Automation Engine runs as a service under either a local user or a Windows domain user.
You can see which user that is:

• in Automation Engine's Server Admin, under System Account (see the Automation
Engine documentation for more details).

• in your Automation Engine server's Task Manager (in Processes, select Show processes
for all users, and check which user the bgmd.exe process runs under).

Tip:  By default (if you haven't changed it when/after installing Automation Engine), this is
the local user BGSYSTEM, with the default password BGSYSTEM.

2. On the server where you installed the Esko Proof Server, locate the ProofFolder share in
which Automation Engine will send files to be printed by the Esko Proof Server.

If you used the default installation location (C:\Esko), this is C:\Esko\ProofFolder.
3. Give the Automation Engine user Full Control on this share.

• If the Automation Engine user is a local user:

1. Make sure the same user exists on the Esko Proof Server computer (with the same
password).

2. Open the ProofFolder's sharing properties (right-click it, select Properties and go to
the Sharing tab).

3. Add the user to the share with full rights (click Share..., type the user name and click
Add, select Read/Write as Permission Level and click Share to confirm).

• If the Automation Engine user is a Windows domain user:

1. Open the ProofFolder's sharing properties (right-click it, select Properties and go to
the Sharing tab).

2. Add the user to the share with full rights (click Share..., type the user name and click
Add, select Read/Write as Permission Level and click Share to confirm).
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Installing Imaging Engine
You need the Esko Software - Imaging Engine 20 Installation DVD for the installation. Use
the following procedure to install Imaging Engine 20.0:

1. Open the Esko Software - Imaging Engine 20 Installation window:

• If you insert the Esko Software - Imaging Engine 20 Installation DVD into the DVD
drive, or mount the corresponding .iso file, the window appears automatically.

• If you unpacked a downloaded .iso file, or if the window doesn't open automatically,
double-click setup.exe in the root folder.

2. Select the installation language.
3. Click Proceed to the installation.
4. Under Imaging Engine/Pack Proof 20.0 installation, including related tools (Color Pilot,

Curve Pilot, HD Flexo Screens and ScreenManager), click Install.
5. On the Imaging Engine 20.0 Installer page:

a) If you activated your licences on a central license server (not the server on which you are
installing Imaging Engine), connect your Imaging Engine server to this license server.
See How to Connect to the License Server on page 1146 for details.

b) Check and install the prerequisites.
See How to Install the Imaging Engine Prerequisites on page 1147.

c) Proceed with the software installation.
See How to Install Imaging Engine on page 1148.

d) Install the Bitmap Viewer.
See How to Install the Bitmap Viewer on page 1149.

How to Connect to the License Server

If you activated your licences on a central license server, you need to connect to this license
server from your Imaging Engine server.

1. On the Imaging Engine 20.0 Installer page, click on Install the Network License
Manager.

2. Follow the instructions of the installation wizard.
3. Back on the Imaging Engine 20.0 Installer page, click Activate the licenses to open the

Network License Manager.
4. In the Esko Network License Manager, go to Tools > License Client Configuration.
5. In the License Client Configuration dialog:

a) Enter the name of the server that you are using as a license server.
If your license server is also the server you are installing Imaging Engine on, you can
enter localhost here.

b) Click Apply.
c) Click Exit.

6. Close the Network License Manager and go back to the Imaging Engine 20.0 Installer
page.
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How to Install the Imaging Engine Prerequisites

Before you install Imaging Engine, you need to install the Imaging Engine prerequisites.

1. On the Imaging Engine 20.0 Installer page, click on Check and install the Imaging
Engine/Pack Proof System prerequisites.
This checks whether the operating system is suited for installing and running Imaging
Engine 20.0, and starts the Imaging Engine 20.0 prerequisites installation.

2. If:

• you see an error message about the Windows version, your operating system is not
suited for running Imaging Engine 20.0.

Check the System Requirements again and install Imaging Engine 20.0 on a suitable
operating system.

• you see the message Ready to install the prerequisite components for the
Imaging Engine software. Do you want to start the installation?, click
Yes.

3. The installation wizard for the prerequisite components will check the licenses, list the
prerequisite components to install on the system, request confirmation for the installation
and then install the required components.

Follow the instructions of the installation wizard.

The installation wizard will install the following components:

• Microsoft Visual Studio Redistributables
• Message Passing Interface service

If you are prompted to reboot your computer, do so and restart this installation procedure.
4. If the installer cannot find a running Automation Engine 20.0 server on the local machine,

you will see the Enter Server name window, prompting you to enter the name of the server
running your Automation Engine.

Note:

• You should be able to access this server from your Imaging Engine machine.

• You can still use the local machine as Automation Engine server (if
Automation Engine 20.0 is installed on it); start up Automation Engine, and leave the field
in the Enter Server name window blank.

The installer then checks if the server you entered has a running Automation Engine 20.0
server.

If you get the following error: then:

ERROR - Imaging Engine
 requires Automation Engine 20.0 
The provided master server does not
 have Automation Engine 20.0 running 
Checked server: [yourservername]

Automation Engine 20.0 is not running on
the server you entered.

1. Check that you entered the server
name correctly.
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If you get the following error: then:

2. Make sure Automation Engine 20.0 is
running on it.

3. Restart the Imaging Engine
prerequisites installation.

ERROR - Imaging Engine
 requires Automation Engine 20.0 
The provided master server does
 not have Automation Engine 20.0
 installed 
Checked server: [yourservername]
 (version [yourserverversion])

Automation Engine 20.0 is not installed
on the server you entered.

1. Check that you entered the server
name correctly.

2. Install Automation Engine 20.0 on it.
3. Restart the Imaging Engine

prerequisites installation.

5. Click Exit when the installation wizard is finished.

How to Install Imaging Engine

1. On the Imaging Engine 20.0 Installer page, click Install the Imaging Engine/Pack Proof
20.0 products.

2. Follow the instructions of the installation wizard.
3. Read the End user license agreement carefully and select Yes, I accept the license

agreement.
4. When asked to select the products to install on this system, select Imaging Engine and the

desired related products (for example ScreenManager, Curve Pilot, Color Pilot...).

• The products available depend on your license.

• The System Components group cannot be deselected and will be installed on all
systems.

• The products' Common Components that are used by several products (for example
DGC Data and Color Management System) will only be installed once (each product's
installer will check if the necessary components are present, and update them if
necessary).

• You should already have installed the screens and the printing conditions database
during your Automation Engine installation (as part of the Automation Engine Common
Components), either on your Automation Engine server or on a central resources server.

The printing conditions database is where the Print Control Wizard tool saves any printing
condition that you make.

See the Automation Engine installation guide if needed.
5. Select a Destination Folder for the chosen products or use the default folder.
6. If you are not installing as the default Automation Engine system user (user name

BGSYSTEM, ask Esko support its default password), you will be prompted to enter your
current credentials (user name and password).
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These will be stored and remembered during subsequent updates / upgrades of the
software.

7. At the end of the installation, click Finish.

How to Install the Bitmap Viewer

You can install the Bitmap Viewer either on the server hosting Imaging Engine, or on a separate
computer.

1. On the installation page, click Install the Bitmap Viewer 20 (64-bit) software.
2. Follow the instructions of the installation wizard.
3. Select the Destination Directory or use the default folder.
4. Select the file types you want to associate with the Bitmap Viewer or keep the defaults.
5. Select the language to use or leave Automatic selected to use the computer's language.
6. Click Install.
7. When all components have been installed, close the installation window and eject the DVD.

Upgrade Overview
You can upgrade from any working previous version of Imaging Engine or FlexRip.

In case you need help with the upgrade (especially from older FlexRip versions), contact Esko
Customer Support.

Note:

Make sure no users are using the system or are connected to the server.

When upgrading, it is advised that all users save their work and create a backup.

To upgrade Imaging Engine, you will need to first license then install the latest version of the
following applications:

application: before upgrading, please check:

Automation Engine

Note:

You should have already upgraded
Automation Engine before starting to upgrade
the Esko Proof Server and Imaging Engine.

See the Automation Engine installation
documentation for details if needed.

the Automation Engine system requirements

the Esko Proof Server (if you are planning
to proof using Imaging Engine and the Esko
Proof Server)

the Esko Proof Server system requirements

Imaging Engine the Imaging Engine system requirements
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Note:

If you have a distributed setup (these applications are installed on two or three different
servers), you should keep the same setup for the upgrade.

If you want to change your setup, you should back up your work, uninstall and perform a fresh
installation instead.

General upgrade procedure:

1. Make sure you have the relevant DVDs.

• To upgrade the Esko Proof Server, you need the Esko Software - Proof Server 18.0
Installation DVD.

• To upgrade Imaging Engine, you need the Esko Software - Imaging Engine 20
Installation DVD.

Note:  If you downloaded the software from MySoftware.esko.com, you will need to mount
the corresponding .iso files as virtual DVDs, or unpack the .iso files first.

2. Make sure you have the relevant licenses.
You need a product key file for Imaging Engine 20 (which includes all necessary licenses). If
you do not have a product key file yet, contact Esko Customer Support.

3. On your license server (which can be either your Automation Engine server or a central
license server), activate your licenses.

4. If you want to upgrade the Esko Proof Server, perform the steps listed in Upgrading the Esko
Proof Server on the server on which you want to upgrade it.

5. On the server on which you want to upgrade Imaging Engine, perform the steps listed in
Upgrading Imaging Engine.

Activating the Licenses
Imaging Engine 20 is protected with licenses. These licenses are distributed as a product key
file (in .html).

You need to activate the product keys in the product key file using the Network License
Manager application, on the server that you are using as a license server (this can be either
your Automation Engine server or a central license server).

You should have installed the Network License Manager as part of your Automation Engine
installation. See the Automation Engine installation guide if needed.

You need:

• A product key file for Imaging Engine 20 (which includes all necessary licenses). If you do not
have a product key file yet, contact Esko Customer Support.

• Internet access on the server that you are using as a license server.

• An Esko ID in order to activate the licenses. You can get one at http://www.esko.com/
licensing/CreateAccount.

On the server that you are using as a license server:

1. Open the Network License Manager.
Depending on your operating system, you can do this by:
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• going to Start > All Programs > Esko > Network License Manager > Network License
Manager,

• clicking Network License Manager on your Apps screen.
2. In the Esko Network License Manager, do one of the following:

• drag your product key file in the area marked Drag your Product Key File or your
Response file here,

• click the Activate button.
3. Follow the instructions of the Activate License Wizard.
4. When asked about the product keys, choose I have received an HTML file containing my

Product Keys.
5. Click Browse to select the product key file.
6. When asked, fill in your Esko ID and Password.
7. Click Finish.

The licensed products you can use are now visible in the Network License Manager.

Upgrading the Esko Proof Server
If you are planning to proof using Imaging Engine and the Esko Proof Server, you now need to
upgrade the Esko Proof Server.

You need the Esko Software - Proof Server 18.0 Installation DVD for the installation. Use the
following procedure to upgrade the Esko Proof Server:

1. Open the Esko Software - Proof Server 18.0 Installation window:

• If you insert the Esko Software - Proof Server 18.0 Installation DVD into the DVD drive, or
mount the corresponding .iso file, the window appears automatically.

• If you unpacked a downloaded .iso file, or if the window doesn't open automatically,
double-click setup.exe in the root folder.

2. Select the installation language.
3. Click Proceed to the installation.
4. On the Esko Proof Server 18.0 Installer page:

a) If you are using a central license server, connect to it.
See How to Connect to the License Server on page 1144 for details.

b) Run the system readiness check.
See How to Perform the System Readiness Check  on page 1144.

c) Proceed with the software upgrade.
See How to Upgrade the Esko Proof Server on page 1152.

How to Connect to the License Server

If you activated your licences on a central license server, you need to connect to this license
server from your Esko Proof Server.

1. On the Esko Proof Server 18.0 Installer page, click on Install, update or repair the
License Server (Network License Manager component).

2. Follow the instructions of the installation wizard.
If the wizard asks you to restart the computer, do so, then relaunch the installation.
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3. Back on the Esko Proof Server 18.0 Installer page, click Activate the licenses to open the
Network License Manager.

4. In the Esko Network License Manager, go to Tools > License Client Configuration.
5. In the License Client Configuration dialog:

a) Enter the name of the server that you are using as a license server.
b) Click Apply.
c) Click Exit.

6. Close the Network License Manager and go back to the Esko Proof Server 18.0 Installer
page.

How to Perform the System Readiness Check

Before you install the Esko Proof Server, a System Readiness Check is required. This checks
whether the operating system is suited for installing and running the Esko Proof Server.

1. On the Esko Proof Server 18.0 Installer page, click on Run the Esko Proof Server 18.0
System Readiness Check.

2. At the end of the Readiness Check, read the resulting messages carefully.
3. If the Readiness Check resulted in a problem with:

Options Description

The password policy Change the password policy.

The Data Execution Prevention (DEP) Change the DEP Settings.

4. Click Exit.

How to Upgrade the Esko Proof Server

1. On the Esko Proof Server 18.0 Installer page, under Installation or upgrade of the Proof
Server component, click Install or upgrade the Proof Server and Profiles components.

2. Follow the instructions of the installation wizard.
If the wizard asks you to restart the computer, do so, then relaunch the installation wizard.

3. The installation wizard may install HotFixes as part of the Proof Server and Profiles
components upgrade.

4. At the end of the Esko Proof Server installation, click Finish.

Upgrading Imaging Engine
You need the Esko Software - Imaging Engine 20 Installation DVD for the upgrade. Use the
following procedure to upgrade to Imaging Engine 20.0:

1. Open the Esko Software - Imaging Engine 20 Installation window:

• If you insert the Esko Software - Imaging Engine 20 Installation DVD into the DVD
drive, or mount the corresponding .iso file, the window appears automatically.

• If you unpacked a downloaded .iso file, or if the window doesn't open automatically,
double-click setup.exe in the root folder.

2. Select the installation language.
3. Click Proceed to the installation.
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4. Under Imaging Engine/Pack Proof 20.0 installation, including related tools (Color Pilot,
Curve Pilot, HD Flexo Screens and ScreenManager), click Install.

5. On the Imaging Engine 20.0 Installer page:
a) If you are using a central license server, connect to it.

See How to Connect to the License Server on page 1146 for details.
b) Check and install the prerequisites.

See How to Upgrade the Imaging Engine Prerequisites on page 1153.
c) Proceed with the software upgrade.

See How to Upgrade Imaging Engine on page 1154.
d) Update the Bitmap Viewer.

See How to Update the Bitmap Viewer on page 1155.

How to Connect to the License Server

If you activated your licences on a central license server, you need to connect to this license
server from your Imaging Engine server.

1. On the Imaging Engine 20.0 Installer page, click on Install the Network License
Manager.

2. Follow the instructions of the installation wizard.
3. Back on the Imaging Engine 20.0 Installer page, click Activate the licenses to open the

Network License Manager.
4. In the Esko Network License Manager, go to Tools > License Client Configuration.
5. In the License Client Configuration dialog:

a) Enter the name of the server that you are using as a license server.
If your license server is also the server you are installing Imaging Engine on, you can
enter localhost here.

b) Click Apply.
c) Click Exit.

6. Close the Network License Manager and go back to the Imaging Engine 20.0 Installer
page.

How to Upgrade the Imaging Engine Prerequisites

Before you upgrade Imaging Engine, you need to upgrade the Imaging Engine prerequisites.

1. On the Imaging Engine 20.0 Installer page, click on Check and install the Imaging
Engine/Pack Proof System prerequisites.
This checks whether the operating system is suited for installing and running Imaging
Engine 20.0, and starts the Imaging Engine 20.0 prerequisites installation.

2. If:

• you see an error message about the Windows version, your operating system is not
suited for running Imaging Engine 20.0.

In this case you need to perform a fresh installation on a suitable operating system
instead. Check the System Requirements.
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• you see the message Ready to install the prerequisite components for the
Imaging Engine software. Do you want to start the installation?, click
Yes.

3. The installation wizard for the prerequisite components will check the licenses, list the
prerequisite components to upgrade on the system, request confirmation for the upgrade
and then upgrade the required components.

Follow the instructions of the installation wizard.

The installation wizard will upgrade the following components:

• Microsoft Visual Studio Redistributables
• Message Passing Interface service

If you are prompted to reboot your computer, do so and restart this installation procedure.
4. The installer then checks if Automation Engine 20.0 is running on your Automation Engine

server.

If you get the following error: then:

ERROR - Imaging Engine
 requires Automation Engine 20.0 
The provided master server does not
 have Automation Engine 20.0 running 
Checked server: [yourservername]

Automation Engine 20.0 is not running on
the server you entered.

1. Check that you entered the server
name correctly.

2. Make sure Automation Engine 20.0 is
running on it.

3. Restart the Imaging Engine
prerequisites installation.

ERROR - Imaging Engine
 requires Automation Engine 20.0 
The provided master server does
 not have Automation Engine 20.0
 installed 
Checked server: [yourservername]
 (version [yourserverversion])

Automation Engine 20.0 is not installed
on the server you entered.

1. Check that you entered the server
name correctly.

2. Install Automation Engine 20.0 on it.
3. Restart the Imaging Engine

prerequisites installation.

5. Click Exit when the installation wizard is finished.

How to Upgrade Imaging Engine

1. On the Imaging Engine 20.0 Installer page, click Install the Imaging Engine/Pack Proof
20.0 products.

2. Follow the instructions of the installation wizard.
3. Read the End user license agreement carefully and select Yes, I accept the license

agreement.
4. When asked to select the products to install on this system, select Imaging Engine and the

desired related products (for example ScreenManager, Curve Pilot, Color Pilot...).

• The products available depend on your license.
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• The System Components group cannot be deselected and will be installed on all
systems.

• The products' Common Components that are used by several products (for example
DGC Data and Color Management System) will only be installed once (each product's
installer will check if the necessary components are present, and update them if
necessary).

• You should already have installed the screens and the printing conditions database
during your Automation Engine installation (as part of the Automation Engine Common
Components), either on your Automation Engine server or on a central resources server.

The printing conditions database is where the Print Control Wizard tool saves any printing
condition that you make.

See the Automation Engine installation guide if needed.
5. At the end of the installation, click Finish.

How to Update the Bitmap Viewer

1. On the installation page, click Install the Bitmap Viewer 20 (64-bit) software.
2. Follow the instructions of the installation wizard.
3. Select the Destination Directory or use the default folder.
4. Select the file types you want to associate with the Bitmap Viewer or keep the defaults.
5. Select the language to use or leave Automatic selected to use the computer's language.
6. Click Install.
7. When all components have been installed, close the installation window and eject the DVD.

16.5.3.  Configuration in the Automation Engine Pilot

After installing all the software components required for Imaging Engine, you need to launch
the Automation Engine Pilot and perform some configuration:

1. Connect your Automation Engine server to your Imaging Device and perform general
Imaging Engine configuration.
See Imaging Engine Configuration on page 1156.

2. If you are planning to proof using Imaging Engine and the Esko Proof Server, you also need
to connect those two components.
See Connecting Imaging Engine to the Proof Server on page 1158.
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Imaging Engine Configuration

Note:

• You need to perform this configuration before you can use Imaging Engine.
• If you have already configured Imaging Engine, you can only edit the configuration while it is

not processing files (if it is processing files while you try to change the configuration, you will
see a warning, and will have to wait until the processing is done).

To connect your Automation Engine server to your Imaging Device:

1. In the Automation Engine Pilot, go to Tools > Configure.
2. Select Imaging Engines in the left pane.
3. Go to File > New or press the Insert key (on PC).

This creates an Imaging1 entry under Imaging Engines and shows settings in the right
pane.

4. In the right pane's General tab:
a) In Host Name, enter the name of the server running your Imaging Engine and press

Enter or Tab (or click the Connect button next to Imaging Engine).
b) Check that you see a green dot  with the message Imaging Engine is up and running.

If you see... it means that...

a grey dot  with the message
Imaging Engine is starting up on
host

you need to wait a few minutes
before you can use Imaging Engine.

a red dot  with the message No
license for Imaging Engine on host

your Imaging Engine license is
missing.

Please check your licenses.

a red dot  with the message No
Imaging Engine available on host

the server you have entered doesn't
have Imaging Engine or even
Automation Engine installed.

Please check if you have entered the
server name wrong.

You may see other error messages in some cases, but you will always get some advice as
to what you need to do (for example with the  Missing resource for Imaging Engine
on host message, you will get advised to Please reinstall the Imaging Engine).

Note:  You can Stop and Start Imaging Engine from here for troubleshooting purposes,
but this is generally not necessary, as Imaging Engine starts automatically, and will
restart automatically in case of a crash or after being force quitted.

c) Set the Number of Workers. This is the number of parallel processes used to work on
multiple pages of a file, or multiple files at the same time.
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Note:

The maximum number of workers you can set depends on your license and on the
number of cores on your server.

Please see the system requirements page for details.

5. In the Settings tab:
a) Select what kind of Rosettes you want to use in the Image to Screened Separations task:

• Clear Centered rosettes are generally considered to be more stable. This is the
default.

• Dot Centered rosettes can give a more saturated result.

You can see which imaging device and which kind of rosettes have been used for each
file in that file's log.

b) Enable (check) Minimum Ruling if you want to enforce a minimum ruling, and optionally
edit the minimum ruling value. The default value in an Imaging Engine device is 65 lpi.
You can enter a minimum ruling as low as 1 lpi.

Note:  The minimum ruling value has no effect unless Minimum Ruling is enabled
(checked).

c) Enable (check) Maximum Ruling if you want to enforce a maximum ruling, and
optionally edit the maximum ruling value. The default value in an Imaging Engine device
is 300 lpi.

Note:  The maximum ruling value has no effect unless Maximum Ruling is enabled
(checked).

Note:  When both Minimum Ruling and Maximum Ruling are enabled (checked), the
minimum ruling value cannot be higher than the current maximum ruling value. In case
Minimum Ruling is enabled last, the minimum ruling value is decreased automatically
to the current maximum ruling value; in case Maximum Ruling is enabled last, the
maximum ruling value is increased automatically to the current minimum ruling value.

d) Check that Jump to nearest ruling is selected under the Exact Ruling not
Available list. This is the default setting, ensuring that the closest available ruling value
will be used when the exact requested ruling value is not implemented. In case using the
exact requested ruling value is a hard constraint, select Task fails under the Exact
Ruling not Available list.

e) If you use Jump to nearest ruling, you can additionally enable (check) Maximum
Ruling Difference to edit the maximum ruling difference value that you can tolerate.
The default maximum ruling difference in an Imaging Engine device is 10 lpi.

To clarify the usage of these parameters and their inter-workings, a few representative
examples are shown below. In all the examples, available rulings are assumed to be 65, 70,
80, 90, 100, 110, 120, 130, 135, and 140 lpi.

Example 1: The requested ruling is 75 lpi. Minimum Ruling is disabled (unchecked); the
actual minimum ruling value does not matter. Jump to nearest ruling is selected with
a maximum ruling difference of 10 lpi. The nearest available rulings to 75 lpi observing the
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maximum ruling difference of 10 lpi are 70 and 80 lpi. The lower value of 70 lpi will be used.
The task will succeed.

Example 2: The requested ruling is 60 lpi. Minimum Ruling is enabled (checked); the actual
minimum ruling value is 68 lpi. Jump to nearest ruling is selected with a maximum
ruling difference of 5 lpi. The nearest available ruling to 60 lpi observing the maximum
ruling difference of 5 lpi is 65 lpi. This value cannot be used because it is lower than the
minimum ruling of 68 lpi. The task will fail.

Example 3: The requested ruling is 60 lpi. Minimum Ruling is enabled (checked); the actual
minimum ruling value is 68 lpi. Jump to nearest ruling is selected with a maximum
ruling difference of 10 lpi. The nearest available rulings to 60 lpi observing the maximum
ruling difference of 10 lpi are 65 and 70 lpi. The value of 65 lpi cannot be used because it
is lower than the minimum ruling of 68 lpi. The value of 70 lpi is higher than the minimum
rulung and can be used. The task will succeed.

Example 4: The requested ruling is 145 lpi. Maximum Ruling is disabled (unchecked); the
actual maximum ruling value does not matter. Jump to nearest ruling is selected with
a maximum ruling difference of 10 lpi. The nearest available ruling to 145 lpi observing the
maximum ruling difference of 10 lpi is 140 lpi. This value will be used. The task will succeed.

Example 5: The requested ruling is 145 lpi. Maximum Ruling is enabled (checked); the
actual maximum ruling value is 138 lpi. Jump to nearest ruling is selected with a
maximum ruling difference of 10 lpi. The nearest available rulings to 145 lpi observing the
maximum ruling difference of 10 lpi are 140 and 135 lpi. The value of 140 lpi is higher than
the maximum ruling and cannot be used. The value of 135 lpi is lower than the maximum
ruling and can be used. The task will succeed.

6. In the Queue tab, enter a name for your Imaging Engine Queue.
7. In the left pane, select the Imaging1 entry, go to File > Rename and give it a meaningful

name.

You can also select it and press F2 (on PC).
8. Go to File > Save or use Ctrl+S (on PC) to save your configuration.

Connecting Imaging Engine to the Proof Server
This configuration will connect your Automation Engine server (and Imaging Engine) to your
Esko Proof Server, so that Imaging Engine can send files to the Proof Server, for proofing on
your device.

For more flexibility, you can connect to several Proof Servers, and have access to all the
workflows configured on these Proof Servers. When sending files through Imaging Engine's
Proof for Content Approval task, you can then select which workflow of which Proof Server
you want to use.

Important:  You need to perform this configuration before you can use the Proof for Content
Approval task.

1. In the Automation Engine Pilot, go to Tools > Configure.
2. Select Proof Servers in the left pane.
3. For each Proof Server that you want to connect to:

a) Click Add at the bottom of the right pane.
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b) In the New Proof Server pop-up, enter the name of the server on which your Proof
Server is running, and click Add.

Note:

If you get an error message like The shared folder "ProofFolder" on the host
is not writable for the user BGSYSTEM, it means that Automation Engine
cannot access the Proof Server share (where it needs to send files to proof).

In this case, follow the steps in Giving Automation Engine Access to the Esko Proof Server
Share on page 1145.

c) In the Status column, check that your Proof Server is Running.
You also can Remove the connection to a Proof Server if needed.

4. Go to File > Save or use Ctrl+S (on PC) to save your configuration.

16.6.  The Imaging Engine Tasks
Imagine Engine consists of:

• three proofing tasks: Proof for Content Approval, Image to Content Proof (RGB) and Image to
Unscreened Proof,

• two RIP'ing tasks: Image to Screened Separations and Image to Unscreened Separations,

• a task to help the press calculate the ink needed to print the RIP'ed files: Calculate Ink Key
Settings (CIP3).

For a general introduction to each task's purpose, see Using Imaging Engine for Proofing and
RIP'ing.

Using SmartNames and Public Parameters in the Imaging Engine Tasks
Use the Imaging Engine tasks as you would use other Automation Engine tasks. For most of the
settings, you can also use public parameters (so an operator can define them through Shuttle)
and/or SmartNames.

You can use SmartNames everywhere you see the SmartName icon , and you can use
SmartNames in public parameters even for settings without that icon (for example if the
setting is a button).

Important:  SmartNames values must resolve to a value that is valid for that setting at the
moment the task runs. Any invalid SmartName value will make the task end in error.

Tip:

• SmartNames are case insensitive (for example it doesn't matter whether your SmartName
resolves to AngleAndRuling or angleandruling).

• To know what value a SmartName must resolve to for a specific setting:

1. select the setting value you want (for example Scale : Fit to page size),
2. right-click that value (Fit to page size) and select Copy Parameter Value,
3. paste the value in a text editor (in this example it is FitSize).
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For more information about SmartNames and public parameters, see the SmartNames and
Using Public Parameters sections of the Automation Engine manual.

16.6.1.  Proof for Content Approval

You can use the Proof for Content Approval task for generating a content proof and sending
it automatically to your proofer. You typically make a content proof to check whether the
contents of your file (layout, text, barcodes...) are correct.

At that stage, you are typically not checking the color accuracy of your proof yet, so the Proof
for Content Approval task only performs some default color management, based on the
ISO standard, in the background (for example to convert RGB objects to CMYK so they are
printable).

When you are satisfied with the content proof and want to make a contract proof with color
management, you can use the Image to Unscreened Proof task.

Proofing with the Proof for Content Approval Task

The Proof for Content Approval task  sends the ready-to-proof files to the workflow of

your choice on the Esko Proof Server , who then proofs it automatically on the proofer
connected to that workflow. This proofer can be one of many types of proofing devices
supported by the Esko Proof Server.
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Note:

To use this task, you need to have created a Proof Server workflow in the Esko Proof Client, and
that workflow must:

• be connected to the Admin user,
• be connected to a physical CMYK proofer (you cannot use the predefined "Esko

Linearization" workflow for example).

Tip:

To make sure your Proof Server workflow is connected to a CMYK proofer:

1. Open the Proof Client.
2. In the System Manager view, select your workflow's Output Device.
3. Go to the Media tab at right, and expand the Print Configuration settings.
4. In Calibration Set, select an EPL (linearization file) made for your device's CMYK ink set.

To be sure that your selected EPL is made for CMYK, check that you see Color mode:
CMYK under the Calibration Set list.

5. Save your output device settings.

See the Esko Proof Client documentation if needed.

For information about creating a Proof Server workflow, please see the Esko Proof Client
documentation.

Attention:

You can use several Proof Servers, but in this case, make sure that every workflow has a
unique name, even across Proof Servers.

If there are workflows with the same name on several Proof Servers, you will not be
able to send files to those workflows through the Proof for Content Approval task.

Task Parameters
In the Device field, select the imaging device that you configured.

Then use the tabs at left to show more settings to fill in. See:

• General on page 1162,
• Proofer on page 1164,
• Transformations on page 1165,
• PDF Objects on page 1167,
• Document Inks on page 1167,
• Output on page 1175,
• Summary on page 1179.

Using the Proof Server Workflow Parameters
If you are using a Proof Server workflow that already has proofing parameters defined (for
example the number of copies to print, or the rotation or scaling to apply to your file), those
parameters will be filled in by default in the Proof for Content Approval task, so that you
don't have to go check them in the Proof Server workflow and copy them into the task.
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Note:  This is not the case if you are using a SmartName or a public parameter to select your
Proof Server workflow.

You can of course change those parameters as desired in the Proof for Content Approval
task.

General
1. Define what Page Box of the input PDF you want to proof.

You can either select Media Box, Trim Box, or insert a SmartName  that must resolve to
either media or trim.

After selecting your file's page box you will see its dimensions under the Page Box option.
2. If your input file is a multi-page PDF, select which Pages you want to proof:

a) First select All pages, Odd pages only or Even pages only in the Pages option.

You can also insert a SmartName resolving to either All, Even or Odd.
b) Then you can refine your selection by entering page numbers or a Page Range.

You can separate page numbers by a comma, or use a dash to indicate a page range (for
example 3,6-9). You can also use a SmartName resolving to page numbers and/or page
ranges using this same format.

Note:

• Page numbers are always physical pages. If your document starts with page 5, you
should not use 5 but 1 to get the first page.

• If you enter page numbers that are not part of your document, they will be excluded
from the output (all the other valid pages will be proofed).

• If you enter the same page(s) more than once (for example 1,1-2), it/they will only be
output once.

• Pages are proofed in the order of the document (entering 5-1 will be automatically
changed to 1-5).

3. If you want to invert your output so it is compatible with the output device or software

system that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to
invert the output), or to 0 or false (to leave the output as it is).

Tip:  If that setting is already defined in your Proof Server workflow, it will be filled in by
default. You can of course change it as desired.

4. If you want to mirror your output so it is compatible with the output device or software

system that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to
mirror the output), or to 0 or false (to leave the output as it is).
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If that setting is already defined in your Proof Server workflow, it will be filled in by default.
You can of course change it as desired.

5. If you want to add a SmartMark to your output file(s), select it in the SmartMark list, or use
a SmartName that will resolve to the SmartMark name.

A SmartMark is a mark whose content is variable, so you can make it display information
about that specific job. For example, you can include some of the parameters used during
RIP'ing in your output file(s) by using a SmartMark.

You need to:

a) First create the SmartMark you want to use in PackEdge (see the SmartMarks section in
the PackEdge manual for details).

You can create either:

• a SmartMark with proof-specific parameters,

Use this SmartMark
parameter in
PackEdge:

to display this value from the Imaging
Engine parameters:

Device the imaging device you used

Image whether you inverted your output

Emulsion whether you mirrored your output

V Scale the vertical scaling you applied to your
output file(s)

H Scale the horizontal scaling you applied to your
output file(s)

Color Strategy this will show Custom as the Proof for
Content Approval task doesn't perform
full color management (it only applies a
default source and destination profile)

Source Profile the default source profile
applied to your input file(s)
(ISOcoated_v2_300_eci.icc)

Destination Profile the default destination
profile of your output file(s)
(ISOcoated_v2_300_eci.icc)

Resolution the resolution of your output file(s)

• another type of SmartMark (for example a corner mark).

If your PackEdge application is linked to your Automation Engine server, your SmartMark
will automatically be saved in the correct location and will be available in Imaging Engine.
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b) Then select that SmartMark in your Imaging Engine task.

The SmartMark will be added to each proof generated from your input file.

Proofer
This is where you select the Esko Proof Server workflow to which the task sends your RIP'ed
output.

• In the Proof Server Workflow list, you can see all of the valid workflows found on the Proof
Server(s) you are connected to.

Note:

To be valid, your Proof Server workflow must:

• be connected to the Admin user,

• be connected to a physical CMYK proofer (you cannot use the predefined "Esko
Linearization" workflow for example).

Tip:

To make sure your Proof Server workflow is connected to a CMYK proofer:

1. Open the Proof Client.
2. In the System Manager view, select your workflow's Output Device.
3. Go to the Media tab at right, and expand the Print Configuration settings.
4. In Calibration Set, select an EPL (linearization file) made for your device's CMYK ink

set.

To be sure that your selected EPL is made for CMYK, check that you see Color mode:
CMYK under the Calibration Set list.

5. Save your output device settings.

See the Esko Proof Client documentation if needed.

For information about creating a Proof Server workflow, please see the Esko Proof Client
documentation.

Imaging Engine checks whether the Proof Server and the selected workflow are available
when defining ticket settings and when (re-)launching the task.

The task will end in error if it can't access the Proof Server workflow or if the workflow is
invalid.

Attention:

If you are connected to several Proof Servers, make sure that every workflow has a
unique name, even across Proof Servers.

If there are workflows with the same name on several Proof Servers, you will not be
able to select any of those workflows here (the name will be greyed out).

You can:
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• select a workflow from the list,
• use SmartNames (that must resolve to the name of a valid Proof Server workflow),
• set the workflow using public parameters.

Tip:

When you select a workflow from the list, its proofing parameters (number of copies to
print, rotation or scaling to apply to your file...), will be filled in by default in the Proof
for Content Approval task, so that you don't have to go check them in the Proof Server
workflow and copy them into the task.

You can of course change those parameters as desired in the Proof for Content Approval
task.

Transformations
Use the Transformations settings to scale or rotate your output relative to your input file.

Tip:

If you are using a Proof Server workflow that already has scaling and/or rotation parameters
defined, those parameters will be filled in by default, so that you don't have to go check them
in the Proof Server workflow and copy them into the task.

You can of course change those parameters as desired.

1. If you want to Scale your input file's contents, select either:

• Scale by percent and enter the vertical  and horizontal  scaling percentages to
use (they must be between 10% and 1000%).

Note:

By default, you enter the vertical scaling percentage and the horizontal one is calculated
automatically to keep the proportions.

If you want to enter the horizontal scaling percentage manually, click  to unlink it from
the vertical one first.

However, if you do this then link the percentages again, the last percentage you
entered will be kept, and the other one will be recalculated automatically to keep the
proportions.

• Fit to page size to fit your output to the substrate defined in your Proof Server workflow,
while keeping the proportions (this will fit it to either the width or the height of the
substrate, while making sure everything is on the substrate).

• Fit to page width to fit it to the width of the substrate defined in your Proof Server
workflow, while keeping the proportions.

If you added SmartMarks to your output, they will be taken into account when fitting the
proof to the substrate's width or size.
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Note:

If you have chosen to print borderless in your Proof Server workflow, the task will take this
into account when fitting your output to the substrate, and make your output slightly larger
to cover the whole substrate width or height.

You can only print borderless if your proofing device supports it. Please check the Esko Proof
Client documentation and your proofing device documentation for more information about
borderless printing.

If you don't want to scale your file's contents, leave Do not scale selected.

You can use SmartNames resolving to not (Do not scale), ByPercent (Scale by percent),
FitSize (Fit to page size) or FitWidth (Fit to page width).

When entering SmartNames for vertical and horizontal scaling percentages, they must
resolve to the numerical value (without the % sign).

2. If you want to rotate your file, select the Rotation you want to apply here.

You can choose to either:

• use a fixed rotation (this can be 0°, 90° Counter Clockwise, 90° Clockwise or 180°; any
other value will give an error),

• rotate your file if necessary to fit, or fit better, on the substrate (select Minimal Media
Consumption). This can be useful when using narrow rolls of substrate for example.

If it did fit on the substrate already, this option makes sure that the largest dimension of
the file will be placed in the substrate width, to use less substrate material when cutting.
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Note:

• If you have chosen to print borderless in your Proof Server workflow, the task will take
the extra space into account when rotating your file to fit (or fit better) on the substrate.

• You can use a SmartName that resolves to 0, 90 (for 90° Counter Clockwise), 180, 270
(for 90° Clockwise), or minimal.

• When using a fixed rotation, you need to use a numerical value (ninety will not work).

• This is a public parameter, that you can fill in when submitting files through Shuttle.

PDF Objects
• If you experience issues with a font that doesn't look smooth enough at your selected

resolution, your font may have font hinting errors.

Font hinting is the rendering of the outline (vectorized) font to pixels. For certain fonts, this
rendering sometimes doesn't give a visually pleasing result, especially at low resolutions. In
the image below, the top font has font hinting errors, the bottom font doesn't.

 

 

Choose how to handle files containing font hinting errors:

• Leave Generate an error if the job contains font hinting errors selected if you want
the task to end in error when encountering font hinting errors. You can also use a
SmartName resolving to true.

• Deselect Generate an error if the job contains font hinting errors if you want to
output your file anyway, whether it has font hinting errors or not (your task will end with
a warning). You can also use a SmartName resolving to false.

This may lead to reduced quality rendering of the text, but it will not generate incorrect
characters in your output file.

Document Inks

Selecting Which Separations to Proof
Use the Document Inks settings to select which separations of the input file(s) you want to
proof.
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For example, you can use these settings to exclude technical and/or varnish inks from your
output.

You can choose to proof either:

• All separations.

• A number of separations you select Manually.

• A number of separations you select by using selection criteria.

Selection criteria are rules that you define to select separations automatically for you when
the task is launched on a file.

Selecting separations manually is the easiest option, but you can only do it on a file by file basis
(when you launch the task on a single input file).

Using selection criteria is more advanced but also more powerful than selecting separations
manually, and you can do it anytime (when launching the task on one or more input files, when
using the task in a workflow, when defining ticket settings...).

Therefore, we recommend that you first try selecting separations manually when running
the task on individual files, then switch to using selection criteria to automate your workflow
further.

Tip:

To get used to working with selection criteria, try the following on a few of your files:

1. select the separations you want to output manually,
2. then change Select Inks to by using selection criteria and see which rules have been

created based on your manual selection.

For more information, see Selecting Inks Manually on page 1168 and Selecting Inks Using
Selection Criteria on page 1170.

Tip:  You can also make the ink selection parameter public so that an operator can set it
through Shuttle as needed for each job. See Selecting Inks though Shuttle on page 1173 for more
information.

Proofing Files with Unregistered Inks
Unregistered inks are inks that are not present in your color management database, so there is
no information about these inks apart from their RGB values in the input file.

If your input file contains PantoneLIVE inks and you don't have a PantoneLIVE license, those inks
are also considered to be unregistered inks.

When content proofing with the Proof for Content Approval task, unregistered inks (and
unlicensed PantoneLIVE inks) are output without making the task error, but their color on the
proof may be inaccurate.

However, when you want to make a color managed proof with the Image to Unscreened Proof
on page 1193 task, we recommend you replace all unregistered inks in your input file by inks
from your color database before proofing.

Selecting Inks Manually

Note:  You can only select inks manually when you are launching the task on a (single) file, not
when you are defining a generic ticket without an input file.
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When choosing to Select Inks Manually, you will see a table containing all of your document's
inks, showing each ink's:

Ink Name

Ink Book If an ink book is not present in your color database, it will show here as
<unregistered "">.

Ink Index The Ink index is the order in which the file's inks will be printed (the ink
with ink index 1 is at the bottom of the document and will be printed
first).

If your file has several of the same ink, they will have the same ink index,
and the next ink will have the next one (for example two Cyans will both
have ink index 1, then Magenta will have ink index 2).

This means that when selecting inks for processing, both Cyans will be
selected together and handled the same way.

Tip:

To find the ink index of a file:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink has an
index of 1, the second of 2, etc.).

Note that if you reorder the inks by one of the columns (for example by
Ink name), they won't be ordered by ink index anymore. You will need to
close that dialog and reopen it to see the ink index order again.

Spot Ink Index The Spot Ink index is the order in which a spot ink will be printed (when
counting only spot inks and not process inks).

For example, if the first 4 inks of the document are CMYK, the first spot
ink will have 5 as Ink Index but 1 as Spot Ink Index.

As for the ink index, if your file has several of the same spot ink, they will
have the same spot ink index, and will be handled together when you
select them.

Ink Type This can be for example Normal, Technical, Varnish...

Printing Method If you have set a Printing Method for an ink it will be shown here (this
can be for example Offset, Gravure, Flexo... or any custom printing
method you configured).

See the Automation Engine documentation for more information about
printing methods.

Select the ink(s) you want to proof, or select the toggle in the table header to select/deselect all
inks.
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Selecting Inks Using Selection Criteria
If you don't want to select inks manually every time, you can define some rules to automatically
select certain inks in your input file(s).

You can do this:

• either when running the task on one or more files, or when creating a task ticket to use
later,

• by choosing to Select Inks by using selection criteria in the Document Inks settings.

How Does it Work?
You select the inks to be output by checking a combination of criteria:

1. You define what to check. You can check any of the following ink characteristics in your
criteria:

Ink name

Ink book

Ink index The Ink index is the order in which the file's inks will be printed (the
ink with ink index 1 is at the bottom of the document and will be
printed first).

To find the ink index of a file:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink has an
index of 1, the second of 2, etc.).

Note that if you reorder the inks by one of the columns (for example
by Ink name), they won't be ordered by ink index anymore. You will
need to close that dialog and reopen it to see the ink index order
again.

Spot ink
index

The Spot ink index is the order in which a spot ink will be printed
(when counting only spot inks and not process inks).

For example, if the first 4 inks of the document are CMYK, the first
spot ink will have 5 as Ink index but 1 as Spot ink index.

Ink type This can be for example Normal, Technical, Varnish...

Printing
method

If you have set a Printing method for an ink it will be shown here
(this can be for example Offset, Gravure, Flexo... or any custom
printing method you configured).

See the Automation Engine documentation for more information
about printing methods.
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For example, you can check whether the Ink book is process, whether the Ink name is
yellow...

You can use as many criteria as you want.
2. You define how to combine your criteria into a rule. For example:

• If you want to output only process yellow, you should check for inks that match both of
the criteria:

Ink book is process
Ink name is yellow

• If you want to output both all process inks and all yellow inks, you should check for inks
that match either of the criteria:

Ink book is process
Ink name is yellow

• If you don't want to output any process inks or any yellow inks, you should check for inks
that match neither of the criteria:

Ink book is process
Ink name is yellow

How Do I Build Rules?
Build your rules the following way:

1. Choose how to combine the criteria in your rule:

• Select All of the following are true if you want to only select the inks that match all of
the criteria you define.

• Select Any of the following are true if you want to select all the inks that match at least
one of the criteria you define.

• Select None of the following are true if you want to only select the inks that match
none of the criteria you define.

2. Define your first selection criterion.

You can select an ink based on its:

• Ink name: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink book: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink index: you can define if it equals/is less than/is greater than the number you
enter, or is is between the two numbers you enter (in this case the ink indexes you enter
as boundaries are also selected).

• Spot ink index: you can define if it equals/is less than/is greater than the number you
enter, or is is between the two numbers you enter (in this case the spot ink indexes you
enter as boundaries are also selected).

• Ink type: you can define if it is a piece of text (alphanumerical characters).

1171



16 Automation Engine

• Printing method: you can define if it is a piece of text (alphanumerical characters).

For example, you could use: to:

All of the following are true

Ink book is designer

select all inks from the "designer" ink
book

None of the following are true

Ink name is crease

exclude an ink called "crease"

None of the following are true

Ink type is Technical

Ink type is Varnish

exclude all technical and all varnish inks

Tip:

• You can enter several values to check for: just use a semicolon (;) between them.

For example, to check for both inks called Cyan and inks called Magenta, choose Ink
name is and enter Cyan;Magenta.

• When launching the task on a file, you can also click  to select one or more of the Ink
names/Ink books/Ink types/Printing methods used in your input file(s).

A criterion will automatically be created based on your selection.

3. Click + to add more criteria and define them.

To remove a criterion, click - next to it.

Tip:  If you are launching the task on a single input file, you will see a table listing the Selected
document inks, and another table with the Document inks that are not selected under the
rules you defined.

Attention:  If no ink is selected, you cannot launch the task.

Switching How You Select Inks
You can switch between the two methods of selecting inks (manually and using selection
criteria), and this will keep the same inks selected.

Switching from Selecting Inks Manually to Selecting Inks Using Selection
Criteria

When switching from selecting inks manually to selecting inks using selection criteria, the task
will translate your manual ink selection into rules, so that the same inks are selected (you can
see them in the Selected document inks table).

The rules you get are based on the characteristics of the inks you selected.

For example, if you selected all the process colors but no spot color in your file, for an offset
job, you will get the following rule:
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All of the following are true

Ink name is Cyan;Magenta;Yellow;Black
Ink book is process
Ink type is Normal
Printing method is Offset

Note:

If you...

• first selected inks using selection criteria,
• then switched to manual selection without changing the selection,
• then switched back to selection criteria,

... then your rules will be kept.

If you did change the selection in manual mode, the task will automatically generate new rules.

Switching from Selecting Inks Using Selection Criteria to Selecting Inks
Manually

When switching from selecting inks using selection criteria to selecting inks manually, all the
inks selected by the rules you defined (the inks in the Selected document inks table) become
selected manually.

Note:  You can only switch to selecting inks manually when you are launching the task on a
(single) file.

Selecting Inks though Shuttle
If you want to be able to decide which inks to proof when submitting your input file through
Shuttle, do the following:

In Your Imaging Engine Ticket
1. To make the ink selection a public parameter, you can either:

• Right-click Select Inks and choose Make Parameter Public.

• If you (are currently launching the ticket on a file and) have chosen to select inks manually,
right-click the preview table under Select Inks and choose Make Parameter Public.
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• If you have chosen to use selection criteria, right-click the rules builder under Select Inks
and choose Make Parameter Public.

 

 

Note:  You will not be able to create rules using Shuttle, you will only be able to select
inks manually.

• Go to Advanced > Manage Public Parameters..., find the Ink Selection parameter at
the bottom of the list, and drag it to the right hand side.

 

 
2. By default, the public parameter that appears in Shuttle will be called Ink Selection. You

can change its name by:

• right-clicking one of the elements mentioned above, selecting Modify Public Parameter
and entering a new name,

• if you are using the Manage Public Parameters window, entering the new name in
Prompt as.

3. Make sure your ticket is also Public.

In Shuttle
The ink selection parameter may look a bit different depending on which Shuttle you are using
(the Shuttle standalone application or a Shuttle plug-in in an Editor application).

• In the Shuttle standalone, the ink selection parameter will look like this:
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The table shows a preview of all inks in your input file, with their characteristics.

• To proof all inks from your input file, either leave all inks selected in the preview table, or
select All inks at the top (this will hide the preview table).

• To only proof certain inks, make sure All inks is not selected, and deselect the input inks
that you don't want to proof.

• In ArtPro+ for example, the ink selection parameter will look like this:
 

 

By default, all the inks from your input file will be proofed, but you can remove any ink you

don't want to proof using the  button.

Output
Use the Output settings to define how many copies of your proof you want, and how to handle
images that have a different resolution than the output resolution.
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Note:

Imaging Engine uses the output resolution defined in your Proof Server workflow, where you
need to decide whether quality or speed is more important to you.

• If you have chosen High Quality in your Proof Server workflow, Imaging Engine will output
your file(s) at the maximum resolution supported by your proofing device (you can check
this resolution in the Proof Client).

You would typically use this for your final output, where quality is much more important
than speed.

• If you have chosen Standard in your Proof Server workflow, Imaging Engine will output your
file(s) at 50% of the maximum resolution supported by your proofing device.

• If you have chosen Fast, Imaging Engine will output your file(s) at 25% of the maximum
resolution supported by your proofing device.

You would typically use this for drafts, where you don't need high quality yet but want a fast
result.

For more information, please see the Esko Proof Client documentation.

1. If you experience problems with jagged edges, for example in small text, you can set an
Anti-aliasing factor to smooth those edges.

In the example below, you can see the difference between output without anti-aliasing (on
the left), and with anti-aliasing applied (on the right).
 

 

You can adjust the amount of anti-aliasing applied by choosing a factor of either 2, 3 or 4
(note that using a higher anti-aliasing factor may slow down processing).

You can also set this with a SmartName resolving to None (if you don't need anti-aliasing), or
to the anti-aliasing factor you want (for example 2).

Attention:  Because anti-aliasing changes the output sampling to smooth the jagged
edges, you cannot resample your images (with the Image Resampling option) if you
use anti-aliasing.

2. If your input file contains images, the images' pixels may not map exactly to output pixels if:

• the images' resolution is different from the output resolution you chose,
• scaling and rotation effects change the size and placement of the images' pixels.

In such cases, you need to resample these images to be able to output them at the same
resolution as the rest of the file.

In the Image Resampling option, choose the resampling method you want to use (you will
have to make a trade-off between processing time and image quality).

1176

https://esko.com/en/HelpDocuments?language=en-us&productname=imagingengine&versionname=16&docname=otherdocs&filename=Esko_Proof_Client_141.pdf


16Automation Engine

• Choose Auto Resampling to upsample the images to an automatically calculated
resolution (generally half or a third of the output resolution) before smoothing them.

When using this, images are a lot less pixellated and fuzzy.

 

 

This method is quite slow but gives images of a good quality, so it is recommended in
most cases.

You can also use a SmartName resolving to ResampleAuto.
• Choose Full Resampling to upsample the images to the full output resolution.

This is the slowest method but gives the highest quality images (not pixellated and only
slightly fuzzy).
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Use this if Auto Resampling doesn't give you the results you want.

Attention:

Resampling to full resolution can require significant amounts of memory when
the output resolution is high (especially from 4000 dpi).

If you want to do this, we recommend that you have at least 8GB of RAM
available for each worker (see the installation documentation).

You can also use a SmartName resolving to ResampleFull.
• Choose None if you don't want to resample your input file's images.

Note:

If you upgraded from a previous version of Imaging Engine, in some cases you may have
saved a ticket with a less optimal resampling method (From File or PDF Interpolation) in
your older version. These methods are deprecated from Imaging Engine 18.1.1.

When processing a file with such a ticket, Imaging Engine will use the Auto Resampling
method instead. You will get a warning about this.

3. Enter the number of Copies you want to print (at least 1).

You can use SmartNames and/or public parameters.
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Tip:

If the number of copies to print is already defined in your Proof Server workflow, that
number will be filled in by default.

You can of course change it as desired.

4. Select Keep job files for relaunch purposes if you want to be able to proof jobs a second
time without having to RIP them again.

In this case, the files created for proofing will not be automatically cleaned up. When you
don't need to keep them anymore, you will have to delete them manually from the \\[Esko
Proof Server]\ProofFolder share.

You can set this option with a SmartName resolving to true to keep the files, or false to
discard them.

Note:

To re-proof files that you have kept using this option, do the following:

1. Double-click the Send to Proof Server sub-task that was run on the job you want to
reuse.

2. This reopens the ticket with a limited number of settings. Change your desired setting as
necessary (for example the number of Copies).

3. Click Launch.

If you didn't select the Keep job files for relaunch purposes, you will see The job
cannot be reprinted as the files from the job were not kept when
reopening the ticket.

Summary
This shows a summary of all the settings you defined in the ticket.

• To show the settings from a tab, click + (on PC) or  (on Mac) beside the tab name in the
right pane.

Click Expand All to show the settings from all tabs.
• To hide the settings from a tab, click - (on PC) or  (on Mac) beside the tab name in the right

pane.

Click Collapse All to hide the settings from all tabs.

16.6.2.  Image to Content Proof (RGB)

Use the Image to Content Proof (RGB) task if you need a high-resolution preview file.

You can use this for digital content proofing, to check whether the contents of your file
(layout, text, barcodes...) are correct. This is particularly useful in cases where a physical content
proof would not be practical (for example if the customer is far away).
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At that stage, you are typically not checking the color accuracy of your proof yet, so the
Image to Content Proof (RGB) task only performs some default color management in the
background (for preview purposes).

When you are satisfied with the content proof and want to make a contract proof with color
management, you can use the Image to Unscreened Proof task.

Task Output
The Image to Content Proof (RGB) task generates a high-resolution RGB preview file, in the
JPEG format.

Task Parameters
In the Device field, select the imaging device that you configured.

Then use the tabs at left to show more settings to fill in. See:

• General on page 1180,
• Transformations on page 1181,
• PDF Objects on page 1182,
• Document Inks on page 1182,
• Output on page 1190,
• Summary on page 1193.

General
1. Define what Page Box of the input PDF you want to proof.

You can either select Media Box, Trim Box, or insert a SmartName  that must resolve to
either media or trim.

After selecting your file's page box you will see its dimensions under the Page Box option.
2. If your input file is a multi-page PDF, select which Pages you want to proof:

a) First select All pages, Odd pages only or Even pages only in the Pages option.

You can also insert a SmartName resolving to either All, Even or Odd.
b) Then you can refine your selection by entering page numbers or a Page Range.

You can separate page numbers by a comma, or use a dash to indicate a page range (for
example 3,6-9). You can also use a SmartName resolving to page numbers and/or page
ranges using this same format.

Note:

• Page numbers are always physical pages. If your document starts with page 5, you
should not use 5 but 1 to get the first page.

• If you enter page numbers that are not part of your document, they will be excluded
from the output (all the other valid pages will be proofed).

• If you enter the same page(s) more than once (for example 1,1-2), it/they will only be
output once.

• Pages are proofed in the order of the document (entering 5-1 will be automatically
changed to 1-5).
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3. If you want to invert your output so it is compatible with the output device or software

system that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to
invert the output), or to 0 or false (to leave the output as it is).

4. If you want to mirror your output so it is compatible with the output device or software

system that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to
mirror the output), or to 0 or false (to leave the output as it is).

Transformations
Use the Transformations settings to scale or rotate your output relative to your input file.

1. Choose whether to Scale your input file's contents. Select either:

• Scale by percent and enter the vertical  and horizontal  scaling percentages to
use (they must be between 10% and 1000%).

Note:

By default, you enter the vertical scaling percentage and the horizontal one is calculated
automatically to keep the proportions.

If you want to enter the horizontal scaling percentage manually, click  to unlink it from
the vertical one first.

However, if you do this then link the percentages again, the last percentage you
entered will be kept, and the other one will be recalculated automatically to keep the
proportions.

• Do not scale if you don't want to scale your file's contents.

You can use SmartNames resolving to not (Do not scale) or ByPercent (Scale by percent).

When entering SmartNames for vertical and horizontal scaling percentages, they must
resolve to the numerical value (without the % sign).

2. If you want to rotate your file's contents, select the Rotation you want to apply here.

This can be:

• 0°

• 90° Counter Clockwise

• 180°

• 90° Clockwise

Any other value will give an error.
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Note:

• You can use a SmartName that resolves to 0, 90 (for 90° Counter Clockwise), 180 or
270 (for 90° Clockwise).

• You need to use a numerical value (ninety will not work).

• This is a public parameter, that you can fill in when submitting files through Shuttle.

PDF Objects
• If you experience issues with a font that doesn't look smooth enough at your selected

resolution, your font may have font hinting errors.

Font hinting is the rendering of the outline (vectorized) font to pixels. For certain fonts, this
rendering sometimes doesn't give a visually pleasing result, especially at low resolutions. In
the image below, the top font has font hinting errors, the bottom font doesn't.

 

 

Choose how to handle files containing font hinting errors:

• Leave Generate an error if the job contains font hinting errors selected if you want
the task to end in error when encountering font hinting errors. You can also use a
SmartName resolving to true.

• Deselect Generate an error if the job contains font hinting errors if you want to
output your file anyway, whether it has font hinting errors or not (your task will end with
a warning). You can also use a SmartName resolving to false.

This may lead to reduced quality rendering of the text, but it will not generate incorrect
characters in your output file.

Document Inks

Selecting Which Separations to Proof
Use the Document Inks settings to select which separations of the input file(s) you want to
proof.

For example, you can use these settings to exclude technical and/or varnish inks from your
output.

You can choose to proof either:
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• All separations.

• A number of separations you select Manually.

• A number of separations you select by using selection criteria.

Selection criteria are rules that you define to select separations automatically for you when
the task is launched on a file.

Selecting separations manually is the easiest option, but you can only do it on a file by file basis
(when you launch the task on a single input file).

Using selection criteria is more advanced but also more powerful than selecting separations
manually, and you can do it anytime (when launching the task on one or more input files, when
using the task in a workflow, when defining ticket settings...).

Therefore, we recommend that you first try selecting separations manually when running
the task on individual files, then switch to using selection criteria to automate your workflow
further.

Tip:

To get used to working with selection criteria, try the following on a few of your files:

1. select the separations you want to output manually,
2. then change Select Inks to by using selection criteria and see which rules have been

created based on your manual selection.

For more information, see Selecting Inks Manually and Selecting Inks Using Selection Criteria.

Tip:  You can also make the ink selection parameter public so that an operator can set it
through Shuttle as needed for each job. See Selecting Inks though Shuttle on page 1188 for more
information.

Selecting Inks Manually

Note:  You can only select inks manually when you are launching the task on a (single) file, not
when you are defining a generic ticket without an input file.

When choosing to Select Inks Manually, you will see a table containing all of your document's
inks, showing each ink's:

Ink Name

Ink Book If an ink book is not present in your color database, it will show here as
<unregistered "">.

Ink Index The Ink index is the order in which the file's inks will be printed (the ink
with ink index 1 is at the bottom of the document and will be printed
first).

If your file has several of the same ink, they will have the same ink index,
and the next ink will have the next one (for example two Cyans will both
have ink index 1, then Magenta will have ink index 2).

This means that when selecting inks for processing, both Cyans will be
selected together and handled the same way.
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Tip:

To find the ink index of a file:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink has an
index of 1, the second of 2, etc.).

Note that if you reorder the inks by one of the columns (for example by
Ink name), they won't be ordered by ink index anymore. You will need to
close that dialog and reopen it to see the ink index order again.

Spot Ink Index The Spot Ink index is the order in which a spot ink will be printed (when
counting only spot inks and not process inks).

For example, if the first 4 inks of the document are CMYK, the first spot
ink will have 5 as Ink Index but 1 as Spot Ink Index.

As for the ink index, if your file has several of the same spot ink, they will
have the same spot ink index, and will be handled together when you
select them.

Ink Type This can be for example Normal, Technical, Varnish...

Printing Method If you have set a Printing Method for an ink it will be shown here (this
can be for example Offset, Gravure, Flexo... or any custom printing
method you configured).

See the Automation Engine documentation for more information about
printing methods.

Select the ink(s) you want to proof, or select the toggle in the table header to select/deselect all
inks.

Selecting Inks Using Selection Criteria
If you don't want to select inks manually every time, you can define some rules to automatically
select certain inks in your input file(s).

You can do this:

• either when running the task on one or more files, or when creating a task ticket to use
later,

• by choosing to Select Inks by using selection criteria in the Document Inks settings.

How Does it Work?
You select the inks to be output by checking a combination of criteria:

1. You define what to check. You can check any of the following ink characteristics in your
criteria:

Ink name
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Ink book

Ink index The Ink index is the order in which the file's inks will be printed (the
ink with ink index 1 is at the bottom of the document and will be
printed first).

To find the ink index of a file:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink has an
index of 1, the second of 2, etc.).

Note that if you reorder the inks by one of the columns (for example
by Ink name), they won't be ordered by ink index anymore. You will
need to close that dialog and reopen it to see the ink index order
again.

Spot ink
index

The Spot ink index is the order in which a spot ink will be printed
(when counting only spot inks and not process inks).

For example, if the first 4 inks of the document are CMYK, the first
spot ink will have 5 as Ink index but 1 as Spot ink index.

Ink type This can be for example Normal, Technical, Varnish...

Printing
method

If you have set a Printing method for an ink it will be shown here
(this can be for example Offset, Gravure, Flexo... or any custom
printing method you configured).

See the Automation Engine documentation for more information
about printing methods.

For example, you can check whether the Ink book is process, whether the Ink name is
yellow...

You can use as many criteria as you want.
2. You define how to combine your criteria into a rule. For example:

• If you want to output only process yellow, you should check for inks that match both of
the criteria:

Ink book is process
Ink name is yellow

• If you want to output both all process inks and all yellow inks, you should check for inks
that match either of the criteria:

Ink book is process
Ink name is yellow

• If you don't want to output any process inks or any yellow inks, you should check for inks
that match neither of the criteria:

Ink book is process
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Ink name is yellow

How Do I Build Rules?
Build your rules the following way:

1. Choose how to combine the criteria in your rule:

• Select All of the following are true if you want to only select the inks that match all of
the criteria you define.

• Select Any of the following are true if you want to select all the inks that match at least
one of the criteria you define.

• Select None of the following are true if you want to only select the inks that match
none of the criteria you define.

2. Define your first selection criterion.

You can select an ink based on its:

• Ink name: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink book: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink index: you can define if it equals/is less than/is greater than the number you
enter, or is is between the two numbers you enter (in this case the ink indexes you enter
as boundaries are also selected).

• Spot ink index: you can define if it equals/is less than/is greater than the number you
enter, or is is between the two numbers you enter (in this case the spot ink indexes you
enter as boundaries are also selected).

• Ink type: you can define if it is a piece of text (alphanumerical characters).

• Printing method: you can define if it is a piece of text (alphanumerical characters).

For example, you could use: to:

All of the following are true

Ink book is designer

select all inks from the "designer" ink
book

None of the following are true

Ink name is crease

exclude an ink called "crease"

None of the following are true

Ink type is Technical

Ink type is Varnish

exclude all technical and all varnish inks
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Tip:

• You can enter several values to check for: just use a semicolon (;) between them.

For example, to check for both inks called Cyan and inks called Magenta, choose Ink
name is and enter Cyan;Magenta.

• When launching the task on a file, you can also click  to select one or more of the Ink
names/Ink books/Ink types/Printing methods used in your input file(s).

A criterion will automatically be created based on your selection.

3. Click + to add more criteria and define them.

To remove a criterion, click - next to it.

Tip:  If you are launching the task on a single input file, you will see a table listing the Selected
document inks, and another table with the Document inks that are not selected under the
rules you defined.

Attention:  If no ink is selected, you cannot launch the task.

Switching How You Select Inks
You can switch between the two methods of selecting inks (manually and using selection
criteria), and this will keep the same inks selected.

Switching from Selecting Inks Manually to Selecting Inks Using Selection
Criteria

When switching from selecting inks manually to selecting inks using selection criteria, the task
will translate your manual ink selection into rules, so that the same inks are selected (you can
see them in the Selected document inks table).

The rules you get are based on the characteristics of the inks you selected.

For example, if you selected all the process colors but no spot color in your file, for an offset
job, you will get the following rule:

All of the following are true

Ink name is Cyan;Magenta;Yellow;Black
Ink book is process
Ink type is Normal
Printing method is Offset
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Note:

If you...

• first selected inks using selection criteria,
• then switched to manual selection without changing the selection,
• then switched back to selection criteria,

... then your rules will be kept.

If you did change the selection in manual mode, the task will automatically generate new rules.

Switching from Selecting Inks Using Selection Criteria to Selecting Inks
Manually

When switching from selecting inks using selection criteria to selecting inks manually, all the
inks selected by the rules you defined (the inks in the Selected document inks table) become
selected manually.

Note:  You can only switch to selecting inks manually when you are launching the task on a
(single) file.

Selecting Inks though Shuttle
If you want to be able to decide which inks to proof when submitting your input file through
Shuttle, do the following:

In Your Imaging Engine Ticket
1. To make the ink selection a public parameter, you can either:

• Right-click Select Inks and choose Make Parameter Public.

• If you (are currently launching the ticket on a file and) have chosen to select inks manually,
right-click the preview table under Select Inks and choose Make Parameter Public.

 

 

• If you have chosen to use selection criteria, right-click the rules builder under Select Inks
and choose Make Parameter Public.
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Note:  You will not be able to create rules using Shuttle, you will only be able to select
inks manually.

• Go to Advanced > Manage Public Parameters..., find the Ink Selection parameter at
the bottom of the list, and drag it to the right hand side.

 

 
2. By default, the public parameter that appears in Shuttle will be called Ink Selection. You

can change its name by:

• right-clicking one of the elements mentioned above, selecting Modify Public Parameter
and entering a new name,

• if you are using the Manage Public Parameters window, entering the new name in
Prompt as.

3. Make sure your ticket is also Public.

In Shuttle
The ink selection parameter may look a bit different depending on which Shuttle you are using
(the Shuttle standalone application or a Shuttle plug-in in an Editor application).

• In the Shuttle standalone, the ink selection parameter will look like this:
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The table shows a preview of all inks in your input file, with their characteristics.

• To proof all inks from your input file, either leave all inks selected in the preview table, or
select All inks at the top (this will hide the preview table).

• To only proof certain inks, make sure All inks is not selected, and deselect the input inks
that you don't want to proof.

• In ArtPro+ for example, the ink selection parameter will look like this:
 

 

By default, all the inks from your input file will be proofed, but you can remove any ink you

don't want to proof using the  button.

Output
Use the Output settings to define what type of output you want and where to output it.

You can set these through public parameters or using SmartNames.

1. Enter your output File Name and output Folder.
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Note:

• You can use Imaging-specific SmartNames for the File Name.

By default, it is set to:

• [File] for single page input files (which gives output file names like Myfile.jpg),

• [File]_p[Page] for multi-page input files (which gives output file names like
Myfile_p1.jpg).

• The File Name and Folder can contain special characters (except \ / : * ? < > " |).

• The whole path to the output file (including the container, Folder and File Name) can be
up to 255 characters.

• You can set a local or remote URL for the output Folder, but it must be an absolute path.

• If your output folder doesn't exist yet, the task will create it if the location you request is
valid (you should place this folder on an Automation Engine container accessible by your
Automation Engine user).

If the output folder creation fails, please check the task log for the full list of conditions
and adapt your output folder path accordingly.

2. Define what to do if a file of the same name already exists in your output folder:
a) Click Set Overwrite Policy...
b) Choose what to do If files exist already. You can either:

• Extend the file name if you want to keep the existing output file and give the new
output file a different name. In this case, your new output file name consists of:

• the Output file name (the File Name you set earlier) - which is what the file
would be called if no file with the same name existed,

• a custom suffix that you can define using plain text and/or SmartNames (by
default, this is _c, for "copy"),

• an automatic suffix made of the three last digits of the task ID,

Tip:

To see the task ID of your tasks:

1. Go to the Pilot's Tasks pane (in the Files or Tasks view).
2. Go to View > Select Columns in 'Tasks'...
3. In the Columns dialog, select Task ID in the Available columns list and click 

to move it to the Show these columns: list.
4. Click OK.
5. You now have a Task ID column in the Tasks pane, listing the task ID of all the

tasks.
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• the file extension.

For example, your input file is called file.pdf and you have left the tasks' output
File Name to its default value (the SmartName [File]).

The first JPEG you generate will be called file.jpg.

If you generate output from this input file again, with the task 3668, and you have set
the overwrite policy to Extend the file name with the default Output File Name + _c
+ ID name, the new output file will be called file_c668.jpg

• Overwrite the existing file(s).

• End the task in error.

Note:  If you use a SmartName to set this, it must resolve to extend or 0 (for Extend the
file name), overwrite or 1 (for Overwrite), or error or 2 (for End the task in error).

c) Click Set.
3. The output File Type is always a JPEG File.

See File Formats on page 1135 for more information.
4. Choose the Compression to use for your output file(s).

You should choose a compression method based on the compression speed and the
compressed file size. Typically, faster compression methods compress the file less, so the
output file is bigger.

They are sorted from very high compression, which reduces the file size a lot but loses a lot
of detail (JPEG Limited Quality), to very low compression, which doesn't lose much detail
but doesn't reduce the file size much (JPEG Extreme Quality).

Attention:

When using a SmartName to set the output file's Compression, it must resolve to
one of the following (case insensitive): JPEGLimited, JPEGLow, JPEGStandardLow,
JPEGStandard, JPEGStandardHigh, JPEGHigh, or JPEGExtreme.

Setting any other value will make the task error.

5. Set the Resolution of your output files.

Note:

• The Resolution unit is taken from the general Automation Engine Preferences.

• You can enter values from 1 to 25400 ppi (or equivalent in your unit). SmartNames must
also resolve to a value in that range.

• Values in another unit than the one from the general Preferences will be recalculated,
and values like 300ppi + 500ppm will be calculated correctly.

6. If you experience problems with jagged edges, for example in small text, you can set an
Anti-aliasing factor to smooth those edges.
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In the example below, you can see the difference between output without anti-aliasing (on
the left), and with anti-aliasing applied (on the right).
 

 

You can adjust the amount of anti-aliasing applied by choosing a factor of either 2, 3 or 4
(note that using a higher anti-aliasing factor may slow down processing).

You can also set this with a SmartName resolving to None (if you don't need anti-aliasing), or
to the anti-aliasing factor you want (for example 2).

Summary
This shows a summary of all the settings you defined in the ticket.

• To show the settings from a tab, click + (on PC) or  (on Mac) beside the tab name in the
right pane.

Click Expand All to show the settings from all tabs.
• To hide the settings from a tab, click - (on PC) or  (on Mac) beside the tab name in the right

pane.

Click Collapse All to hide the settings from all tabs.

16.6.3.  Image to Unscreened Proof

You can use the Image to Unscreened Proof task for contract proofing. You typically make a
contract proof once you are satisfied with the physical or digital content proof.

At the contract proof stage, you color manage your job to ensure that your proof is as color
accurate as possible, then send it to your customer for final approval before printing.

Tip:

If you also want to unquestionably verify the color accuracy of your proof against your
customer's criteria when contract proofing, we recommend you use Pack Proof together with
Imaging Engine.

See the Pack Proof documentation for more information.

Task Output
The Image to Unscreened Proof task generates unscreened but color managed output, in a
file that you can send to a proofer. You can choose to output separated TIFF files, or composite
TIFF, PDF or JPEG files (one file with all the separations).
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In the example below, processing a file containing the lime green Esko star generates one
multi-channel unscreened file containing the Cyan, Yellow, Magenta and Black channels, where
the Magenta channel is empty.

 

 

Task Parameters
In the Device field, select the imaging device that you configured.

Then use the tabs at left to show more settings to fill in. See:

• General on page 1194,

• Proofer on page 1196,

• Transformations on page 1197,

• PDF Objects on page 1198,

• Document Inks on page 1199,

• Color Management on page 1207,

• Output on page 1210,

• Summary on page 1219.

General
1. Define what Page Box of the input PDF you want to proof.

You can either select Media Box, Trim Box, or insert a SmartName  that must resolve to
either media or trim.

After selecting your file's page box you will see its dimensions under the Page Box option.
2. If your input file is a multi-page PDF, select which Pages you want to proof:

a) First select All pages, Odd pages only or Even pages only in the Pages option.

You can also insert a SmartName resolving to either All, Even or Odd.
b) Then you can refine your selection by entering page numbers or a Page Range.

You can separate page numbers by a comma, or use a dash to indicate a page range (for
example 3,6-9). You can also use a SmartName resolving to page numbers and/or page
ranges using this same format.
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Note:

• Page numbers are always physical pages. If your document starts with page 5, you
should not use 5 but 1 to get the first page.

• If you enter page numbers that are not part of your document, they will be excluded
from the output (all the other valid pages will be proofed).

• If you enter the same page(s) more than once (for example 1,1-2), it/they will only be
output once.

• Pages are proofed in the order of the document (entering 5-1 will be automatically
changed to 1-5).

3. If you want to invert your output so it is compatible with the output device or software

system that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to
invert the output), or to 0 or false (to leave the output as it is).

4. If you want to mirror your output so it is compatible with the output device or software

system that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to
mirror the output), or to 0 or false (to leave the output as it is).

5. If you want to add a SmartMark to your output file(s), select it in the SmartMark list, or use
a SmartName that will resolve to the SmartMark name.

A SmartMark is a mark whose content is variable, so you can make it display information
about that specific job. For example, you can include some of the parameters used during
RIP'ing in your output file(s) by using a SmartMark.

You need to:

a) First create the SmartMark you want to use in PackEdge (see the SmartMarks section in
the PackEdge manual for details).

You can create either:

• a SmartMark with proof-specific parameters,

Use this SmartMark
parameter in
PackEdge:

to display this value from the Imaging
Engine parameters:

Device the imaging device you used

Image whether you inverted your output

Emulsion whether you mirrored your output

V Scale the vertical scaling you applied to your
output file(s)
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Use this SmartMark
parameter in
PackEdge:

to display this value from the Imaging
Engine parameters:

H Scale the horizontal scaling you applied to your
output file(s)

Color Strategy the color strategy you applied to your
output file(s)

Source Profile the source profile contained in the color
strategy you applied to your output file(s)

Destination Profile the destination profile contained in the
color strategy you applied to your output
file(s)

Resolution the resolution of your output file(s)

• another type of SmartMark (for example a corner mark).

If your PackEdge application is linked to your Automation Engine server, your SmartMark
will automatically be saved in the correct location and will be available in Imaging Engine.

b) Then select that SmartMark in your Imaging Engine task.

The SmartMark will be added to each output file generated from your input file.

Proofer
If you already know the Substrate Size you will proof your output files on, select it here.

Tip:  The size you select here can be used to scale the input file's contents to the substrate
automatically (to do this, select Fit to page size or Fit to page width in the Transformations
tab).

• You can either:

• Select your Substrate Size from a list of predefined sizes.
• Enter the substrate's Width and Height yourself to define a Custom substrate.

Note:

• By default, the Substrate Size is set to Custom, with the Width and Height values of an
A3 page.

• The Width and Height unit is taken from the general Automation Engine Preferences.

You can set those values using public parameters and/or SmartNames. If you use
SmartNames, make sure that:
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• the SmartName for Substrate Size resolves to one of the substrate sizes offered in the
list (when using a SmartName here, the Width and Height options will show 0, but the
task will use the correct dimensions when it runs).

• the SmartNames for Width and Height resolve to a numerical value, without any unit
(the default task unit, mm, will then be used, regardless of the unit set in the general
Automation Engine Preferences). When using a SmartName in one or both of these
options, the Substrate Size will show Custom.

If one or more of the SmartNames resolves to an invalid value, the task will fail.

Transformations
Use the Transformations settings to scale or rotate your output relative to your input file.

1. If you want to Scale your input file's contents, select either:

• Scale by percent and enter the vertical  and horizontal  scaling percentages to
use (they must be between 10% and 1000%).

Note:

By default, you enter the vertical scaling percentage and the horizontal one is calculated
automatically to keep the proportions.

If you want to enter the horizontal scaling percentage manually, click  to unlink it from
the vertical one first.

However, if you do this then link the percentages again, the last percentage you
entered will be kept, and the other one will be recalculated automatically to keep the
proportions.

• Fit to page size to fit your output to the substrate you defined in the Proofer settings,
while keeping the proportions (this will fit it to either the width or the height of the
substrate, while making sure everything is on the substrate).

• Fit to page width to fit it to the width of the substrate you defined in the Proofer settings,
while keeping the proportions.

If you added SmartMarks to your output, they will be taken into account when fitting the
proof file to the substrate's width or size.

If you don't want to scale your file's contents, leave Do not scale selected.

You can use SmartNames resolving to not (Do not scale), ByPercent (Scale by percent),
FitSize (Fit to page size) or FitWidth (Fit to page width).

When entering SmartNames for vertical and horizontal scaling percentages, they must
resolve to the numerical value (without the % sign).

2. If you want to rotate your file's contents, select the Rotation you want to apply here.

This can be:

• 0°

• 90° Counter Clockwise
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• 180°

• 90° Clockwise

Any other value will give an error.

Note:

• You can use a SmartName that resolves to 0, 90 (for 90° Counter Clockwise), 180 or
270 (for 90° Clockwise).

• You need to use a numerical value (ninety will not work).

• This is a public parameter, that you can fill in when submitting files through Shuttle.

PDF Objects
Use the PDF Objects settings to define:

• how to color manage RGB objects in your input file,
• what dot gain compensation to apply to your input file's images.

All parameters in this tab are public parameters, that you can fill in when submitting files
through Shuttle.

1. In Default RGB Profile, specify the profile to use if no profile is specified for a certain RGB
object in the input file. The default is srgb.icc.

You can use a SmartName that resolves to the full profile name.
2. Select Use PDF transfer curves if you want to use:

• the Dot Gain Compensation curves attached to the images in your input PDF. These curves
compensate for the unwanted characteristics of the device that created the images
(scanner, digital camera...).

• the Color Correction curves added by ArtPro+ version 20 and higher. These curves
allow you to correct individual separations for color deviations on proof from the
reference proof. The correction will be applied on both the proof and the production
files.

Note:

You can only use the correction curves if the Color Correction curves option is enabled in
the global Imaging Engine configuration.

Please contact Esko Support for assistance.

You can use a SmartName that resolves to true (to use the input file's curves) or false (to
not use them).

3. If you experience issues with a font that doesn't look smooth enough at your selected
resolution, your font may have font hinting errors.

Font hinting is the rendering of the outline (vectorized) font to pixels. For certain fonts, this
rendering sometimes doesn't give a visually pleasing result, especially at low resolutions. In
the image below, the top font has font hinting errors, the bottom font doesn't.
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Choose how to handle files containing font hinting errors:

• Leave Generate an error if the job contains font hinting errors selected if you want
the task to end in error when encountering font hinting errors. You can also use a
SmartName resolving to true.

• Deselect Generate an error if the job contains font hinting errors if you want to
output your file anyway, whether it has font hinting errors or not (your task will end with
a warning). You can also use a SmartName resolving to false.

This may lead to reduced quality rendering of the text, but it will not generate incorrect
characters in your output file.

Document Inks

Selecting Which Separations to Proof
Use the Document Inks settings to select which separations of the input file(s) you want to
proof.

For example, you can use these settings to exclude technical and/or varnish inks from your
output.

You can choose to proof either:

• All separations.

• A number of separations you select Manually.

• A number of separations you select by using selection criteria.

Selection criteria are rules that you define to select separations automatically for you when
the task is launched on a file.

Selecting separations manually is the easiest option, but you can only do it on a file by file basis
(when you launch the task on a single input file).

Using selection criteria is more advanced but also more powerful than selecting separations
manually, and you can do it anytime (when launching the task on one or more input files, when
using the task in a workflow, when defining ticket settings...).

Therefore, we recommend that you first try selecting separations manually when running
the task on individual files, then switch to using selection criteria to automate your workflow
further.
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Tip:

To get used to working with selection criteria, try the following on a few of your files:

1. select the separations you want to output manually,
2. then change Select Inks to by using selection criteria and see which rules have been

created based on your manual selection.

For more information, see Selecting Inks Manually on page 1200 and Selecting Inks Using
Selection Criteria on page 1201.

Tip:  You can also make the ink selection parameter public so that an operator can set it
through Shuttle as needed for each job. See Selecting Inks though Shuttle on page 1205 for more
information.

Handling Unregistered Inks
Unregistered inks are inks that are not present in your color management database. Since there
is no information about these inks apart from their RGB values in the input file, they cannot be
color managed or proofed accurately.

Therefore, we recommend you exclude them from the output, especially for contract proofing.

Choose what to do in case some unregistered inks are still in the list of inks to be proofed:

• If you want the task to end with a warning, leave Generate an error if the job contains
unregistered inks deselected.

All the inks you chose to include in the output will be proofed, but the unregistered inks will
not be color accurate.

• If you want the task to end in error, select Generate an error if the job contains
unregistered inks.

In both cases, you will also see a message in the log.

Note:  If your input file contains PantoneLIVE inks and you don't have a PantoneLIVE license,
those inks will be treated as unregistered inks.

Selecting Inks Manually

Note:  You can only select inks manually when you are launching the task on a (single) file, not
when you are defining a generic ticket without an input file.

When choosing to Select Inks Manually, you will see a table containing all of your document's
inks, showing each ink's:

Ink Name

Ink Book If an ink book is not present in your color database, it will show here as
<unregistered "">.

Ink Index The Ink index is the order in which the file's inks will be printed (the ink
with ink index 1 is at the bottom of the document and will be printed
first).
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If your file has several of the same ink, they will have the same ink index,
and the next ink will have the next one (for example two Cyans will both
have ink index 1, then Magenta will have ink index 2).

This means that when selecting inks for processing, both Cyans will be
selected together and handled the same way.

Tip:

To find the ink index of a file:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink has an
index of 1, the second of 2, etc.).

Note that if you reorder the inks by one of the columns (for example by
Ink name), they won't be ordered by ink index anymore. You will need to
close that dialog and reopen it to see the ink index order again.

Spot Ink Index The Spot Ink index is the order in which a spot ink will be printed (when
counting only spot inks and not process inks).

For example, if the first 4 inks of the document are CMYK, the first spot
ink will have 5 as Ink Index but 1 as Spot Ink Index.

As for the ink index, if your file has several of the same spot ink, they will
have the same spot ink index, and will be handled together when you
select them.

Ink Type This can be for example Normal, Technical, Varnish...

Printing Method If you have set a Printing Method for an ink it will be shown here (this
can be for example Offset, Gravure, Flexo... or any custom printing
method you configured).

See the Automation Engine documentation for more information about
printing methods.

Select the ink(s) you want to proof, or select the toggle in the table header to select/deselect all
inks.

Selecting Inks Using Selection Criteria
If you don't want to select inks manually every time, you can define some rules to automatically
select certain inks in your input file(s).

You can do this:

• either when running the task on one or more files, or when creating a task ticket to use
later,

• by choosing to Select Inks by using selection criteria in the Document Inks settings.
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How Does it Work?
You select the inks to be output by checking a combination of criteria:

1. You define what to check. You can check any of the following ink characteristics in your
criteria:

Ink name

Ink book

Ink index The Ink index is the order in which the file's inks will be printed (the
ink with ink index 1 is at the bottom of the document and will be
printed first).

To find the ink index of a file:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink has an
index of 1, the second of 2, etc.).

Note that if you reorder the inks by one of the columns (for example
by Ink name), they won't be ordered by ink index anymore. You will
need to close that dialog and reopen it to see the ink index order
again.

Spot ink
index

The Spot ink index is the order in which a spot ink will be printed
(when counting only spot inks and not process inks).

For example, if the first 4 inks of the document are CMYK, the first
spot ink will have 5 as Ink index but 1 as Spot ink index.

Ink type This can be for example Normal, Technical, Varnish...

Printing
method

If you have set a Printing method for an ink it will be shown here
(this can be for example Offset, Gravure, Flexo... or any custom
printing method you configured).

See the Automation Engine documentation for more information
about printing methods.

For example, you can check whether the Ink book is process, whether the Ink name is
yellow...

You can use as many criteria as you want.
2. You define how to combine your criteria into a rule. For example:

• If you want to output only process yellow, you should check for inks that match both of
the criteria:

Ink book is process
Ink name is yellow

• If you want to output both all process inks and all yellow inks, you should check for inks
that match either of the criteria:
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Ink book is process
Ink name is yellow

• If you don't want to output any process inks or any yellow inks, you should check for inks
that match neither of the criteria:

Ink book is process
Ink name is yellow

How Do I Build Rules?
Build your rules the following way:

1. Choose how to combine the criteria in your rule:

• Select All of the following are true if you want to only select the inks that match all of
the criteria you define.

• Select Any of the following are true if you want to select all the inks that match at least
one of the criteria you define.

• Select None of the following are true if you want to only select the inks that match
none of the criteria you define.

2. Define your first selection criterion.

You can select an ink based on its:

• Ink name: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink book: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink index: you can define if it equals/is less than/is greater than the number you
enter, or is is between the two numbers you enter (in this case the ink indexes you enter
as boundaries are also selected).

• Spot ink index: you can define if it equals/is less than/is greater than the number you
enter, or is is between the two numbers you enter (in this case the spot ink indexes you
enter as boundaries are also selected).

• Ink type: you can define if it is a piece of text (alphanumerical characters).

• Printing method: you can define if it is a piece of text (alphanumerical characters).

For example, you could use: to:

All of the following are true

Ink book is designer

select all inks from the "designer" ink
book

None of the following are true

Ink name is crease

exclude an ink called "crease"

None of the following are true exclude all technical and all varnish inks
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For example, you could use: to:

Ink type is Technical

Ink type is Varnish

Tip:

• You can enter several values to check for: just use a semicolon (;) between them.

For example, to check for both inks called Cyan and inks called Magenta, choose Ink
name is and enter Cyan;Magenta.

• When launching the task on a file, you can also click  to select one or more of the Ink
names/Ink books/Ink types/Printing methods used in your input file(s).

A criterion will automatically be created based on your selection.

3. Click + to add more criteria and define them.

To remove a criterion, click - next to it.

Tip:  If you are launching the task on a single input file, you will see a table listing the Selected
document inks, and another table with the Document inks that are not selected under the
rules you defined.

Attention:  If no ink is selected, you cannot launch the task.

Switching How You Select Inks
You can switch between the two methods of selecting inks (manually and using selection
criteria), and this will keep the same inks selected.

Switching from Selecting Inks Manually to Selecting Inks Using Selection
Criteria

When switching from selecting inks manually to selecting inks using selection criteria, the task
will translate your manual ink selection into rules, so that the same inks are selected (you can
see them in the Selected document inks table).

The rules you get are based on the characteristics of the inks you selected.

For example, if you selected all the process colors but no spot color in your file, for an offset
job, you will get the following rule:

All of the following are true

Ink name is Cyan;Magenta;Yellow;Black
Ink book is process
Ink type is Normal
Printing method is Offset
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Note:

If you...

• first selected inks using selection criteria,
• then switched to manual selection without changing the selection,
• then switched back to selection criteria,

... then your rules will be kept.

If you did change the selection in manual mode, the task will automatically generate new rules.

Switching from Selecting Inks Using Selection Criteria to Selecting Inks
Manually

When switching from selecting inks using selection criteria to selecting inks manually, all the
inks selected by the rules you defined (the inks in the Selected document inks table) become
selected manually.

Note:  You can only switch to selecting inks manually when you are launching the task on a
(single) file.

Selecting Inks though Shuttle
If you want to be able to decide which inks to proof when submitting your input file through
Shuttle, do the following:

In Your Imaging Engine Ticket
1. To make the ink selection a public parameter, you can either:

• Right-click Select Inks and choose Make Parameter Public.

• If you (are currently launching the ticket on a file and) have chosen to select inks manually,
right-click the preview table under Select Inks and choose Make Parameter Public.

 

 

• If you have chosen to use selection criteria, right-click the rules builder under Select Inks
and choose Make Parameter Public.
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Note:  You will not be able to create rules using Shuttle, you will only be able to select
inks manually.

• Go to Advanced > Manage Public Parameters..., find the Ink Selection parameter at
the bottom of the list, and drag it to the right hand side.

 

 
2. By default, the public parameter that appears in Shuttle will be called Ink Selection. You

can change its name by:

• right-clicking one of the elements mentioned above, selecting Modify Public Parameter
and entering a new name,

• if you are using the Manage Public Parameters window, entering the new name in
Prompt as.

3. Make sure your ticket is also Public.

In Shuttle
The ink selection parameter may look a bit different depending on which Shuttle you are using
(the Shuttle standalone application or a Shuttle plug-in in an Editor application).

• In the Shuttle standalone, the ink selection parameter will look like this:
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The table shows a preview of all inks in your input file, with their characteristics.

• To proof all inks from your input file, either leave all inks selected in the preview table, or
select All inks at the top (this will hide the preview table).

• To only proof certain inks, make sure All inks is not selected, and deselect the input inks
that you don't want to proof.

• In ArtPro+ for example, the ink selection parameter will look like this:
 

 

By default, all the inks from your input file will be proofed, but you can remove any ink you

don't want to proof using the  button.

Color Management
This is where you apply color management to your output file(s). To do this, you use a color
strategy containing your color management settings.

You can apply two types of color management, depending on the type of proof you want to
make:

Standard Proof

If you are making a standard proof, you are creating a proofing file that you will later send to a
proofer, to try and reproduce your press' output. In this case, we recommend that you:

1. Get the profile of the proofer you want to use, and use it as destination profile in your
color strategy.

2. Use your press profile as source profile in your color strategy.

See Color Management for Standard Proof on page 1208.

Emulation Proof

If you are working with both a regular press and a digital press, and you want to be able to
move jobs between presses, you need to make sure they have comparable output.

This can be useful if you want to use your digital press instead of your main press to reprint a
few copies of a job, or to print short run jobs (with the same results as on the regular press) in
general.
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In this case, you should make an emulation proof, that takes both presses into account when
proofing. It will:

• first simulate how your regular press prints on your digital press,
• then simulate that simulation on your proofer.

This will help you find out which colors can or cannot be reproduced on your digital press, as a
digital press can have a narrower gamut than both a regular press and a proofer.

See Color Management for Emulation Proof on page 1209.

Color Management for Standard Proof
If you are making a standard proof, you are creating a proofing file that you will later send to a
proofer, to try and reproduce your press' output. In this case, we recommend that you:

1. Get the profile of the proofer you want to use, and use it as destination profile in your
color strategy.

2. Use your press profile as source profile in your color strategy.

See Color Strategies on page 1099 for more information about color strategies.

You can either select an existing color strategy (that you have created in the Color Engine Pilot),
or create a new (basic) color strategy on-demand.

Note that when creating a basic color strategy on-demand, you will only be able to use it for
the current task (you will not be able to store it, edit it later or reuse it).

• If you have created a color strategy in the Color Engine Pilot, select it in the Color Strategy
list.

To be available in this list, your color strategy must be stored in the color database defined
for your Automation Engine server (if your Esko software is set up correctly, the Color
Engine Pilot saved it in the right place automatically).

You can also select your desired color strategy through a public parameter, or using a
SmartName. The SmartName for the color strategy must resolve to one of the available
color strategies.

Note:  When you output to JPEG or to composite TIFF with JPEG compression, you can only
select color strategies that have a CMYK destination profile.

The default color strategy is linear.
• If you want to create a basic color strategy on demand:

a) Select Create Custom Strategy... in the Color Strategy list.
b) Select a Source Profile and a Destination Profile.

Note:

If your input file contains a document profile, and you want to use that as the source,
select Use document profile if available (or use a SmartName resolving to true).

If the input file does not contain a document profile, the Source Profile you selected will
be used instead.

Note:  When you output to JPEG or to composite TIFF with JPEG compression, you can only
select a CMYK destination profile.
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c) Select a Rendering Intent.

See Rendering Intents on page 1099 for details on how each rendering intent handles the
conversion of out-of-gamut spot colors and of the background color, and which to use in
which case.

Note:  You can only use a Perceptual or Saturation rendering intent if you are working
with Esko source and/or destination profiles.

d) Click OK.

Once you have selected or created your desired color strategy, the task shows the Source and
Destination profiles used in the strategy.

Color Management for Emulation Proof
If you are working with both a regular press and a digital press, and you want to be able to
move jobs between presses, you need to make sure they have comparable output.

This can be useful if you want to use your digital press instead of your main press to reprint a
few copies of a job, or to print short run jobs (with the same results as on the regular press) in
general.

In this case, you should make an emulation proof, that takes both presses into account when
proofing. It will:

• first simulate how your regular press prints on your digital press,
• then simulate that simulation on your proofer.

This will help you find out which colors can or cannot be reproduced on your digital press, as a
digital press can have a narrower gamut than both a regular press and a proofer.

 

 

1. Select Emulation Proof to display color management settings for an emulation proof.
2.

Under Analog Press, select your first color strategy .

This color strategy should have:

•
your regular press profile  as Source Profile (or the profile for a printing standard you
want to match, for example ISOcoated_V2_eci.icc),

•
your digital press profile  as destination profile (Emulation Profile).
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To be available in this list, your color strategy must be stored in the color database defined
for your Automation Engine server (if your Esko software is set up correctly, the Color
Engine Pilot saved it in the right place automatically).

You can also select your desired color strategy through a public parameter, or using a
SmartName. The SmartName for the color strategy must resolve to one of the available
color strategies.

Note:

You will only be able to choose a color strategy with a destination profile  that is the same
as the source profile of the second color strategy (see below).

To choose a color strategy with a different destination profile, you need to first select a
second color strategy that has that profile as source profile.

3.

Under Digital Press, select your second color strategy .

This color strategy should have:

•
your digital press profile  as Source Profile,

• the profile of the proofer you want to use (or a profile with the right ink set if you don't

know which proofer you will use yet)  as Destination Profile.

Note:  When outputting to JPEG or TIFF, you can only select color strategies that have a CMYK
destination profile.

To be available in this list, your color strategy must be stored in the color database defined
for your Automation Engine server (if your Esko software is set up correctly, the Color
Engine Pilot saved it in the right place automatically).

You can also select your desired color strategy through a public parameter, or using a
SmartName. The SmartName for the color strategy must resolve to one of the available
color strategies.

Output
Use the Output settings to define what type of output you want and where to output it.

You can set these through public parameters or using SmartNames.

1. Enter your output File Name and output Folder.
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Note:

• You can use Imaging-specific SmartNames for the File Name.

By default, it is set to:

• [File] for single page input files (which gives output file names like Myfile.tif),

• [File]_p[Page] for multi-page input files (which gives output file names like
Myfile_p1.tif).

This is a good default for composite output.

For separated output, we recommend you use:

• [File]_[ShortInk] for single page input files (which gives output file names like
Myfile_C.tif),

• [File]_p[Page]_[ShortInk] for multi-page input files (which gives output file
names like Myfile_p1_C.tif).

• The File Name and Folder can contain special characters (except \ / : * ? < > " |).

• The whole path to the output file (including the container, Folder and File Name) can be
up to 255 characters.

• You can set a local or remote URL for the output Folder, but it must be an absolute path.

• If your output folder doesn't exist yet, the task will create it if the location you request is
valid (you should place this folder on an Automation Engine container accessible by your
Automation Engine user).

If the output folder creation fails, please check the task log for the full list of conditions
and adapt your output folder path accordingly.

2. Define what to do if a file of the same name already exists in your output folder:
a) Click Set Overwrite Policy...
b) Choose what to do If files exist already. You can either:

• Extend the file name if you want to keep the existing output file and give the new
output file a different name. In this case, your new output file name consists of:

• the Output file name (the File Name you set earlier) - which is what the file
would be called if no file with the same name existed,

• a custom suffix that you can define using plain text and/or SmartNames (by
default, this is _c, for "copy"),

• an automatic suffix made of the three last digits of the task ID,
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Tip:

To see the task ID of your tasks:

1. Go to the Pilot's Tasks pane (in the Files or Tasks view).
2. Go to View > Select Columns in 'Tasks'...
3. In the Columns dialog, select Task ID in the Available columns list and click 

to move it to the Show these columns: list.
4. Click OK.
5. You now have a Task ID column in the Tasks pane, listing the task ID of all the

tasks.

• the file extension.

For example, your input file is called file.pdf and you have left the tasks' output
File Name to its default value (the SmartName [File]).

The first TIFF you generate will be called file.tif.

If you generate output from this input file again, with the task 3668, and you have set
the overwrite policy to Extend the file name with the default Output File Name + _c
+ ID name, the new output file will be called file_c668.tif

Tip:

• If you are working with the Bitmap Viewer, we recommend you keep the default
overwrite policy (Output File Name + _c + ID), which is compatible with the
Bitmap Viewer.

• If you are not, you can define the custom suffix as you wish. For example, you
could use date and time SmartNames.

• Overwrite the existing file(s).

• End the task in error.

Note:  If you use a SmartName to set this, it must resolve to extend or 0 (for Extend the
file name), overwrite or 1 (for Overwrite), or error or 2 (for End the task in error).

c) Click Set.
3. Select the output File Type you want. This can be a TIFF File, a PDF File or a JPEG File.

See File Formats on page 1135 for more information.
4. Select how you want to output your files in File Assembly.

• For TIFF files, you can choose to output either composite or separated files.

• To output Composite files, select 1 File Per Page in File Assembly (or use a
SmartName that resolves to FilePerPage).

The Output Type is then automatically set to Composite.
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• To output Separated files, select 1 File Per Separation in File Assembly (or use a
SmartName that resolves to FilePerSeparation).

The Output Type is then automatically set to Separate.
• For PDF and JPEG files, the task always generates Composite files.

The File Assembly is automatically set to 1 File Per Page, and the Output Type set to
Composite.

Note:

• Every output file that Imaging Engine generates contains XMP metadata (information
about file creation, separations, calibration curves, etc.).

You can view this XMP metadata by selecting your output file in the Automation Engine

Pilot's Files view and clicking .

For more information about XMP metadata, see the XMP Metadata white paper.

• TIFF files produced by Imaging Engine are fully compatible with Esko's Bitmap Viewer and
DotSpy.

• Separated files are shown in the correct separation in the Bitmap Viewer (as it can read
the separation information in the XMP data) and in grayscale in other viewers.

When proofing them, they are also in the correct separation (for example the proofer
proofs the Magenta file using the Magenta cartridge).
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Tip:

With separated output, you can easily see how color management affects your output
separations relative to the input separations.

• If you are using a linear Color Strategy (that doesn't color manage process colors), the
process separated output files will contain the same objects as the corresponding
separations in the input file.

In the CMYK example below, each solid object in an input separation is the same in the
output separation (for example the Cyan bar is still only 100% Cyan).

 

 

• If you selected something other than linear in the Color Strategy (you are color managing
all separations of your file), the process output separations will be different from the
corresponding input separations.

In the CMYK example below, each solid object in an input separation is now made up of
several output separations (for example the Cyan bar is now 60% Cyan, 36% Magenta
and 22% Black, and appears in these three separated output files).

 

 

5. Choose the Compression to use for your output file(s).

• For TIFF output, you can choose between lossless and lossy compression. Lossless
compression preserves all the detail in the file, while lossy compression removes some
detail.

We recommend you use lossless compression for the final output, and lossy
compression only for previews and thumbnails.

For both compression types (lossless and lossy), you should then choose a compression
method, based on the compression speed and the compressed file size. Typically, faster
compression methods compress the file less, so the output file is bigger (note that TIFF
files can be a maximum of 4GB).
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If you want
lossless
compression...

choose either:

• PackBits, a fast lossless compression method for
graphic files.

Tip:  Use this if you want fast output and file size is
not too much of an issue.

• LZW, a lossless compression method for graphic files
and other files.

Tip:  This compression method works best for files
with large images.

If you want lossy
compression...

choose one of the JPEG compression methods (those
are more suitable for images like photographs and
natural artwork than sharp edged or flat color images
like line art or lettering, as JPEG compression tends to
introduce noise into solid color areas).

They are sorted from very high compression, which
reduces the file size a lot but loses a lot of detail (JPEG
Limited Quality), to very low compression, which
doesn't lose much detail but doesn't reduce the file size
much (JPEG Extreme Quality).

• For PDF output, all available compression methods are lossless.

You should choose a compression method based on the compression speed and the
compressed file size. Typically, faster compression methods compress the file less, so the
output file is bigger (note that PDF files can be a maximum of 12GB).

Choose either:

• PackBits (see above).

• Flate, a lossless compression method similar to zipping, based on the LZW
compression.

Tip:  This compression method works best for images with large single color areas or
repeating patterns.

• JPEG 2000, a compression method based on JPEG and suitable for large images (the
version of JPEG 2000 used by Imaging Engine is lossless).

• For JPEG output, all available compression methods are lossy.

You should choose a compression method based on the compression speed and the
compressed file size. Typically, faster compression methods compress the file less, so the
output file is bigger.

They are sorted from very high compression, which reduces the file size a lot but loses a
lot of detail (JPEG Limited Quality), to very low compression, which doesn't lose much
detail but doesn't reduce the file size much (JPEG Extreme Quality).
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Attention:

• When using a SmartName to set the output file's Compression, it must resolve to
one of the following (case insensitive):

• PackBits, LZW, JPEGLimited, JPEGLow, JPEGStandardLow, JPEGStandard,
JPEGStandardHigh, JPEGHigh, or JPEGExtreme for TIFF output,

• PackBits, Flate or JPEG2000 for PDF output,

• JPEGLimited, JPEGLow, JPEGStandardLow, JPEGStandard,
JPEGStandardHigh, JPEGHigh, or JPEGExtreme for JPEG output.

Setting any other value, or an unsupported compression for the file type you
chose, will make the task error (with the message Unsupported combination of
output type and compression in the log).

• If you have already set the Compression but decide to change the output File
Type, by default the task will either:

• keep the same Compression (if it is supported for the new output File Type),

• or (if it isn't), set it to the first Compression available for this File Type.

You can still change it as desired.

6. Select Make all output files ready for viewing if:

• you are generating separated (TIFF) files,
• you are doing quality control using the Automation Engine Viewer,

• you want to be able to open your output files in the Automation Engine Viewer without
needing to use a Prepare for Viewer task.

If you don't use this option, you can still use a Prepare for Viewer task later to be able to
view your output files in the Automation Engine Viewer. However, this will take more time
than already preparing the files for viewing in your Imaging Engine task.

As with the Prepare for Viewer task, you will see View (Prepared) next to the prepared
files in the Pilot, and you will be able to zoom in to the files up to their full resolution.

Note:  If you use this option together with composite output files (via SmartNames or Public
Parameters), the task will error out.

7. Set the Resolution of your output files.

Note:

• The Resolution unit is taken from the general Automation Engine Preferences.

• You can enter values from 1 to 25400 ppi (or equivalent in your unit). SmartNames must
also resolve to a value in that range.

• Values in another unit than the one from the general Preferences will be recalculated,
and values like 300ppi + 500ppm will be calculated correctly.
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8. If you experience problems with jagged edges, for example in small text, you can set an
Anti-aliasing factor to smooth those edges.

In the example below, you can see the difference between output without anti-aliasing (on
the left), and with anti-aliasing applied (on the right).
 

 

You can adjust the amount of anti-aliasing applied by choosing a factor of either 2, 3 or 4
(note that using a higher anti-aliasing factor may slow down processing).

You can also set this with a SmartName resolving to None (if you don't need anti-aliasing), or
to the anti-aliasing factor you want (for example 2).

Attention:  Because anti-aliasing changes the output sampling to smooth the jagged
edges, you cannot resample your images (with the Image Resampling option) if you
use anti-aliasing.

9. If your input file contains images, the images' pixels may not map exactly to output pixels if:

• the images' resolution is different from the output resolution you chose,
• scaling and rotation effects change the size and placement of the images' pixels.

In such cases, you need to resample these images to be able to output them at the same
resolution as the rest of the file.

In the Image Resampling option, choose the resampling method you want to use (you will
have to make a trade-off between processing time and image quality).

• Choose Auto Resampling to upsample the images to an automatically calculated
resolution (generally half or a third of the output resolution) before smoothing them.

When using this, images are a lot less pixellated and fuzzy.
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This method is quite slow but gives images of a good quality, so it is recommended in
most cases.

You can also use a SmartName resolving to ResampleAuto.
• Choose Full Resampling to upsample the images to the full output resolution.

This is the slowest method but gives the highest quality images (not pixellated and only
slightly fuzzy).
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Use this if Auto Resampling doesn't give you the results you want.

Attention:

Resampling to full resolution can require significant amounts of memory when
the output resolution is high (especially from 4000 dpi).

If you want to do this, we recommend that you have at least 8GB of RAM
available for each worker (see the installation documentation).

You can also use a SmartName resolving to ResampleFull.
• Choose None if you don't want to resample your input file's images.

Note:

If you upgraded from a previous version of Imaging Engine, in some cases you may have
saved a ticket with a less optimal resampling method (From File or PDF Interpolation) in
your older version. These methods are deprecated from Imaging Engine 18.1.1.

When processing a file with such a ticket, Imaging Engine will use the Auto Resampling
method instead. You will get a warning about this.

Summary
This shows a summary of all the settings you defined in the ticket.

• To show the settings from a tab, click + (on PC) or  (on Mac) beside the tab name in the
right pane.

Click Expand All to show the settings from all tabs.
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• To hide the settings from a tab, click - (on PC) or  (on Mac) beside the tab name in the right
pane.

Click Collapse All to hide the settings from all tabs.

16.6.4.  Image to Screened Separations

Use this task if you need screened output to send to a platesetter or filmsetter (for offset or
flexo for example).

Task Output
The Image to Screened Separations task generates one file per separation, in either PDF, TIFF,
LEN or LENX format.

For example, you can send screened LEN separations to the CDI.

In the example below, processing a file containing the lime green Esko star generates screened
files for the Cyan, Yellow and Black separations.

 

 

Task Parameters
1. In the Device field, select the imaging device that you configured.
2. If you have made a Printing Condition in the Print Control Wizard, you can use it in Imaging

Engine. See Working with Printing Conditions from the Print Control Wizard on page 1221.

If you don't have (a license for) the Print Control Wizard, the Printing Condition option is
not visible.

3. Use the tabs at left to show more settings to fill in. See:

• General on page 1223,

• Transformations on page 1225,

• PDF Objects on page 1226,

• Document Inks on page 1227,

• Output on page 1235,

• Separations on page 1246,

• Post-RIP on page 1279,
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• Summary on page 1280.

Working with Printing Conditions from the Print Control Wizard
If you have made a printing condition in the Print Control Wizard, you can use it in Imaging
Engine.

What is the Print Control Wizard?
The Print Control Wizard is an application designed to help you optimize your print quality.

Based on your exact production workflow, your current print quality and the standard you
want to print towards, the Print Control Wizard calculates the best possible screens and curves
that you can use to achieve great results on press.

This helps you avoid common problems, for example a lack of smoothness in the transition
from highlights to paper, or from shadows to solids, and makes getting good printing quality
time after time easier.

See Print Control Wizard for more information.

What is a Printing Condition?
The Print Control Wizard generates a printing condition based on your production workflow
settings and the measurement results of a print sample made with those settings.

This printing condition:

• describes your exact production workflow (plate-making workflow and printing setup) and
the way it prints,

• includes the standard you want to print towards (an ISO standard, linear printing...),
• results in the best possible curve(s) and screen(s) to achieve the quality of that standard

with your production workflow.

If you do not have a license for the Print Control Wizard but you think it might be a good fit for
your workflow, please contact your Esko representative.

Using a Printing Condition

After making your printing condition in the Print Control Wizard, you use it when RIP'ing your jobs
with Imaging Engine to get great results on press.

Important:

• You can only use a printing condition if the icPrintingCondition license is available.
• You can only use a printing condition that you have completed (you can see a green check

 in the Print Control Wizard).

If you are still working on your printing condition in the Print Control Wizard, you will not be
able to select it in Imaging Engine yet.

• After making a printing condition for your production workflow, you should always use it in
Imaging Engine when printing with that production workflow.

If you make changes to your workflow (for example you print on a different substrate, or
you switch to a different ink vendor), we recommend you make a new printing condition in
the Print Control Wizard.
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There are different ways to select a Printing Condition:

• By selecting the Printing Condition from the drop-down list.

• By using a SmartName that resolves to an available Printing Condition. The task will fail if
the SmartName does not resolve to a printing condition.

• By using a public parameter. The public parameter input follows the same rules as a
SmartName.

The default selection is None.

Selecting a Printing Condition

When you select a Printing Condition, the following settings will be automatically filled in the
Image to Screened Separations Ticket.

• The output File Type will be set to LEN/LENX.

• The output Resolution will be set to 4000ppi.

• No Plate Curve will be selected and press curves from the input filecannot be used (as the
Printing Condition will already have a curve).

• Default Screen and Curve parameters are provided by the Printing Condition.

• if the selected Printing Condition is an old Printing Condition (generated using PCW) the
PressCurve will be a prsync file and you will be able to select a different PressCurve.

• if the selected Printing Condition does not include default values for screens or curves,
you will be able to select the dot, ruling, Angle set and PressCurve manually. (But the
selected parameters will be applied only to the screens without default values from
Printing Condition)

• You can choose to use all the Screen and Curve values or only angles or rulings or both
from the file rather than the Printing Condition.

• You will still be able to set custom values for each separation manually by changing it in
the preview table.

• In the ink preview table, you will see the Screen based on values from the input file, Printing
Condition and custom settings.

• Print simulations files will be generated by default, but you can choose not to generate them.

• Dot cleanup will be selected and the printing condition will set the Ruling and Minimum Dot
Size. Pixels will be used as the Minimum Dot Size Unit.

If you choose a different Printing Condition, the settings will change according to the new
Printing Condition.

Note:  The custom values set by using the preview table will remain the same even if you
change the Printing Condition.

The settings automatically filled by the Printing Condition cannot be changed except for Dot
cleanup and Print Simulation settings. If you change the Ruling or Minimum Dot Size to a
different value, a warning will be shown.

If you select a Printing Condition and then unselect it and change to ‘none’, all settings will
remain except for the default Screen and Curve parameters and Dot cleanup settings.
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Using a SmartName

Using a SmartName will affect the same settings as a printing condition, but you will be able
to overrule the defaults provided for the following settings:

• Default Ruling and Minimum Dot Size for Dot Cleanup.
• Default PressCurve, Angle Set, Dot and Ruling.

General
1. Define what Page Box of the input PDF you want to RIP.

You can either select Media Box, Trim Box, or insert a SmartName  that must resolve to
either media or trim.

After selecting your file's page box you will see its dimensions under the Page Box option.
2. If your input file is a multi-page PDF, select which Pages you want to RIP:

a) First select All pages, Odd pages only or Even pages only in the Pages option.

You can also insert a SmartName resolving to either All, Even or Odd.
b) Then you can refine your selection by entering page numbers or a Page Range.

You can separate page numbers by a comma, or use a dash to indicate a page range (for
example 3,6-9). You can also use a SmartName resolving to page numbers and/or page
ranges using this same format.

Note:

• Page numbers are always physical pages. If your document starts with page 5, you
should not use 5 but 1 to get the first page.

• If you enter page numbers that are not part of your document, they will be excluded
from the output (all the other valid pages will be RIP'ed).

• If you enter the same page(s) more than once (for example 1,1-2), it/they will only be
output once.

• Pages are RIP'ed in the order of the document (entering 5-1 will be automatically
changed to 1-5).

3. If you want to invert your output so it is compatible with the output device or software

system that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to
invert the output), or to 0 or false (to leave the output as it is).

4. If you want to mirror your output so it is compatible with the output device or software

system that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to
mirror the output), or to 0 or false (to leave the output as it is).

5. If you want to add a SmartMark to your output file(s), select it in the SmartMark list, or use
a SmartName that will resolve to the SmartMark name.
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A SmartMark is a mark whose content is variable, so you can make it display information
about that specific job. For example, you can include some of the parameters used during
RIP'ing in your output file(s) by using a SmartMark.

You need to:

a) First create the SmartMark you want to use in PackEdge (see the SmartMarks section in
the PackEdge manual for details).

You can create either:

• a SmartMark with RIP-specific parameters,

Use this SmartMark
parameter in
PackEdge:

to display this value from the Imaging
Engine parameters:

Device the imaging device you used

Image whether you inverted your output

Emulsion whether you mirrored your output

V Distortion the vertical distortion you applied to your
output file(s)

H Distortion the horizontal distortion you applied to
your output file(s)

Resolution the resolution of your output file(s)

Dot shape the screen or dot shape you used on your
separation(s)

Screen Angle Direction the screen angle direction you chose to
output your file(s)

Plate Curve the plate curve you applied to your
separation(s)

Correction Curve the correction curve you applied to your
separation(s)

Screen based DGC the curve strategy you applied as a press
curve to your separation(s) (if you used a
curve strategy)

DGC the single curve you applied as a press
curve to your separation(s) (if you used a
single curve)

• another type of SmartMark (for example a corner mark).
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If your PackEdge application is linked to your Automation Engine server, your SmartMark
will automatically be saved in the correct location and will be available in Imaging Engine.

b) Then select that SmartMark in your Imaging Engine task.

The SmartMark will be added to each output file generated from your input file.

Transformations
Use the Transformations settings to rotate or distort your output relative to your input file.

1. If you want to rotate your file's contents, select the Rotation you want to apply here.

This can be:

• 0°

• 90° Counter Clockwise

• 180°

• 90° Clockwise

Any other value will give an error.

Note:

• You can use a SmartName that resolves to 0, 90 (for 90° Counter Clockwise), 180 or
270 (for 90° Clockwise).

• You need to use a numerical value (ninety will not work).

• This is a public parameter, that you can fill in when submitting files through Shuttle.

2. If you want to apply Distortion to your file's contents:
a) Select the type of distortion to apply: No distortion, Flexo distortion or Values from

file.

You can also use a SmartName that resolves to Not, Flexo or File.

Note:  If you selected Values from file and the input file contains distortion values, you
will see these in the fields below (greyed out).

b)
If you want to apply Flexo distortion, enter the vertical  and horizontal  distortion
percentages to use.

You can enter numerical values, or insert SmartNames that resolve to numerical values
(without the % sign).
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Note:

• The values should be within the 90%-110% range. If you enter a percentage outside
of this range it will be automatically adjusted to the nearest value in the range (for
example 85 will be adjusted to 90%).

However, if you use a SmartName that resolves to a percentage outside the range,
the task will end in error.

• You can enter a simple formula and it will be calculated automatically (for example
you can enter 100+2 and this will be changed to 102%). This only works with
numerical values and not with SmartNames.

PDF Objects
Use the PDF Objects settings to define:

• how to color manage RGB objects in your input file,
• what dot gain compensation to apply to your input file's images.

All parameters in this tab are public parameters, that you can fill in when submitting files
through Shuttle.

1. In Default RGB Profile, specify the profile to use if no profile is specified for a certain RGB
object in the input file. The default is srgb.icc.

You can use a SmartName that resolves to the full profile name.
2. Select what output profile you want to use when converting RGB objects to CMYK:

• If you want to use the output profile from the input file (if there is one available), leave
Use output intent from file selected (it is selected by default).

• If you don't want to use the output profile from the input file, deselect Use output
intent from file and specify the output profile to use in Output Color Profile.

This output profile will also be used if there is none available in the input file.

The default is ISOcoated_v2_300_eci.icc.

For the Use output intent from file option, you can use a SmartName that resolves to
true (to use the file's profile) or false (to not use it).

For Output Color Profile, you can use a SmartName that resolves to the full profile name.
3. Select Use PDF transfer curves if you want to use:

• the Dot Gain Compensation curves attached to the images in your input PDF. These curves
compensate for the unwanted characteristics of the device that created the images
(scanner, digital camera...).

• the Color Correction curves added by ArtPro+ version 20 and higher. These curves
allow you to correct individual separations for color deviations on proof from the
reference proof. The correction will be applied on both the proof and the production
files.
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Note:

You can only use the correction curves if the Color Correction curves option is enabled in
the global Imaging Engine configuration.

Please contact Esko Support for assistance.

Aside from these curves applied on individual images or separations, you can still apply:

• a plate curve (to compensate for the dot growth or reduction -for example in Digital
Flexo- happening when making the plate)

• and/or a press curve (to compensate for the dot gain on press)

... to the full file(s) before output.

You can use a SmartName that resolves to true (to use the input file's curves) or false (to
not use them).

4. If you experience issues with a font that doesn't look smooth enough at your selected
resolution, your font may have font hinting errors.

Font hinting is the rendering of the outline (vectorized) font to pixels. For certain fonts, this
rendering sometimes doesn't give a visually pleasing result, especially at low resolutions. In
the image below, the top font has font hinting errors, the bottom font doesn't.

 

 

Choose how to handle files containing font hinting errors:

• Leave Generate an error if the job contains font hinting errors selected if you want
the task to end in error when encountering font hinting errors. You can also use a
SmartName resolving to true.

• Deselect Generate an error if the job contains font hinting errors if you want to
output your file anyway, whether it has font hinting errors or not (your task will end with
a warning). You can also use a SmartName resolving to false.

This may lead to reduced quality rendering of the text, but it will not generate incorrect
characters in your output file.

Document Inks
Use the Document Inks settings to select which separations of the input file(s) you want to RIP.

For example, you can use these settings to exclude technical and/or varnish inks from your
output.
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You can choose to RIP either:

• All separations.
• A number of separations you select Manually.
• A number of separations you select by using selection criteria.

Selection criteria are rules that you define to select separations automatically for you when
the task is launched on a file.

Selecting separations manually is the easiest option, but you can only do it on a file by file basis
(when you launch the task on a single input file).

Using selection criteria is more advanced but also more powerful than selecting separations
manually, and you can do it anytime (when launching the task on one or more input files, when
using the task in a workflow, when defining ticket settings...).

Therefore, we recommend that you first try selecting separations manually when running
the task on individual files, then switch to using selection criteria to automate your workflow
further.

Tip:

To get used to working with selection criteria, try the following on a few of your files:

1. select the separations you want to output manually,
2. then change Select Inks to by using selection criteria and see which rules have been

created based on your manual selection.

For more information, see Selecting Inks Manually on page 1228 and Selecting Inks Using
Selection Criteria on page 1229.

Tip:  You can also make the ink selection parameter public so that an operator can set it
through Shuttle as needed for each job. See Selecting Inks though Shuttle on page 1233 for more
information.

Selecting Inks Manually

Note:  You can only select inks manually when you are launching the task on a (single) file, not
when you are defining a generic ticket without an input file.

When choosing to Select Inks Manually, you will see a table containing all of your document's
inks, showing each ink's:

Ink Name

Ink Book If an ink book is not present in your color database, it will show here as
<unregistered "">.

Ink Index The Ink index is the order in which the file's inks will be printed (the ink
with ink index 1 is at the bottom of the document and will be printed
first).

If your file has several of the same ink, they will have the same ink index,
and the next ink will have the next one (for example two Cyans will both
have ink index 1, then Magenta will have ink index 2).

This means that when selecting inks for processing, both Cyans will be
selected together and handled the same way.
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Tip:

To find the ink index of a file:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink has an
index of 1, the second of 2, etc.).

Note that if you reorder the inks by one of the columns (for example by
Ink name), they won't be ordered by ink index anymore. You will need to
close that dialog and reopen it to see the ink index order again.

Spot Ink Index The Spot Ink index is the order in which a spot ink will be printed (when
counting only spot inks and not process inks).

For example, if the first 4 inks of the document are CMYK, the first spot
ink will have 5 as Ink Index but 1 as Spot Ink Index.

As for the ink index, if your file has several of the same spot ink, they will
have the same spot ink index, and will be handled together when you
select them.

Ink Type This can be for example Normal, Technical, Varnish...

Printing Method If you have set a Printing Method for an ink it will be shown here (this
can be for example Offset, Gravure, Flexo... or any custom printing
method you configured).

See the Automation Engine documentation for more information about
printing methods.

Select the ink(s) you want to RIP, or select the toggle in the table header to select/deselect all
inks.

Selecting Inks Using Selection Criteria
If you don't want to select inks manually every time, you can define some rules to automatically
select certain inks in your input file(s).

You can do this:

• either when running the task on one or more files, or when creating a task ticket to use
later,

• by choosing to Select Inks by using selection criteria in the Document Inks settings.

How Does it Work?
You select the inks to be output by checking a combination of criteria:

1. You define what to check. You can check any of the following ink characteristics in your
criteria:

Ink name
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Ink book

Ink index The Ink index is the order in which the file's inks will be printed (the
ink with ink index 1 is at the bottom of the document and will be
printed first).

To find the ink index of a file:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink has an
index of 1, the second of 2, etc.).

Note that if you reorder the inks by one of the columns (for example
by Ink name), they won't be ordered by ink index anymore. You will
need to close that dialog and reopen it to see the ink index order
again.

Spot ink
index

The Spot ink index is the order in which a spot ink will be printed
(when counting only spot inks and not process inks).

For example, if the first 4 inks of the document are CMYK, the first
spot ink will have 5 as Ink index but 1 as Spot ink index.

Ink type This can be for example Normal, Technical, Varnish...

Printing
method

If you have set a Printing method for an ink it will be shown here
(this can be for example Offset, Gravure, Flexo... or any custom
printing method you configured).

See the Automation Engine documentation for more information
about printing methods.

For example, you can check whether the Ink book is process, whether the Ink name is
yellow...

You can use as many criteria as you want.
2. You define how to combine your criteria into a rule. For example:

• If you want to output only process yellow, you should check for inks that match both of
the criteria:

Ink book is process
Ink name is yellow

• If you want to output both all process inks and all yellow inks, you should check for inks
that match either of the criteria:

Ink book is process
Ink name is yellow

• If you don't want to output any process inks or any yellow inks, you should check for inks
that match neither of the criteria:

Ink book is process
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Ink name is yellow

How Do I Build Rules?
Build your rules the following way:

1. Choose how to combine the criteria in your rule:

• Select All of the following are true if you want to only select the inks that match all of
the criteria you define.

• Select Any of the following are true if you want to select all the inks that match at least
one of the criteria you define.

• Select None of the following are true if you want to only select the inks that match
none of the criteria you define.

2. Define your first selection criterion.

You can select an ink based on its:

• Ink name: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink book: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink index: you can define if it equals/is less than/is greater than the number you
enter, or is is between the two numbers you enter (in this case the ink indexes you enter
as boundaries are also selected).

• Spot ink index: you can define if it equals/is less than/is greater than the number you
enter, or is is between the two numbers you enter (in this case the spot ink indexes you
enter as boundaries are also selected).

• Ink type: you can define if it is a piece of text (alphanumerical characters).

• Printing method: you can define if it is a piece of text (alphanumerical characters).

For example, you could use: to:

All of the following are true

Ink book is designer

select all inks from the "designer" ink
book

None of the following are true

Ink name is crease

exclude an ink called "crease"

None of the following are true

Ink type is Technical

Ink type is Varnish

exclude all technical and all varnish inks

1231



16 Automation Engine

Tip:

• You can enter several values to check for: just use a semicolon (;) between them.

For example, to check for both inks called Cyan and inks called Magenta, choose Ink
name is and enter Cyan;Magenta.

• When launching the task on a file, you can also click  to select one or more of the Ink
names/Ink books/Ink types/Printing methods used in your input file(s).

A criterion will automatically be created based on your selection.

3. Click + to add more criteria and define them.

To remove a criterion, click - next to it.

Tip:  If you are launching the task on a single input file, you will see a table listing the Selected
document inks, and another table with the Document inks that are not selected under the
rules you defined.

Attention:  If no ink is selected, you cannot launch the task.

Switching How You Select Inks
You can switch between the two methods of selecting inks (manually and using selection
criteria), and this will keep the same inks selected.

Switching from Selecting Inks Manually to Selecting Inks Using Selection
Criteria

When switching from selecting inks manually to selecting inks using selection criteria, the task
will translate your manual ink selection into rules, so that the same inks are selected (you can
see them in the Selected document inks table).

The rules you get are based on the characteristics of the inks you selected.

For example, if you selected all the process colors but no spot color in your file, for an offset
job, you will get the following rule:

All of the following are true

Ink name is Cyan;Magenta;Yellow;Black
Ink book is process
Ink type is Normal
Printing method is Offset
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Note:

If you...

• first selected inks using selection criteria,
• then switched to manual selection without changing the selection,
• then switched back to selection criteria,

... then your rules will be kept.

If you did change the selection in manual mode, the task will automatically generate new rules.

Switching from Selecting Inks Using Selection Criteria to Selecting Inks
Manually

When switching from selecting inks using selection criteria to selecting inks manually, all the
inks selected by the rules you defined (the inks in the Selected document inks table) become
selected manually.

Note:  You can only switch to selecting inks manually when you are launching the task on a
(single) file.

Selecting Inks though Shuttle
If you want to be able to decide which inks to RIP when submitting your input file through
Shuttle, do the following:

In Your Imaging Engine Ticket
1. To make the ink selection a public parameter, you can either:

• Right-click Select Inks and choose Make Parameter Public.

• If you (are currently launching the ticket on a file and) have chosen to select inks manually,
right-click the preview table under Select Inks and choose Make Parameter Public.

 

 

• If you have chosen to use selection criteria, right-click the rules builder under Select Inks
and choose Make Parameter Public.
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Note:  You will not be able to create rules using Shuttle, you will only be able to select
inks manually.

• Go to Advanced > Manage Public Parameters..., find the Ink and Screening Selection
parameter at the bottom of the list, and drag it to the right hand side.

 

 
2. By default, the public parameter that appears in Shuttle will be called Ink and Screening

Selection. You can change its name by:

• right-clicking one of the elements mentioned above, selecting Modify Public Parameter
and entering a new name,

• if you are using the Manage Public Parameters window, entering the new name in
Prompt as.

3. Make sure your ticket is also Public.

In Shuttle
The ink selection parameter may look a bit different depending on which Shuttle you are using
(the Shuttle standalone application or a Shuttle plug-in in an Editor application).

• In the Shuttle standalone, the ink selection parameter will look like this:
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The table shows a preview of all inks in your input file, with their characteristics.

• To RIP all inks from your input file, either leave all inks selected in the preview table, or
select All inks at the top (this will hide the preview table).

• To only RIP certain inks, make sure All inks is not selected, and deselect the input inks
that you don't want to RIP.

• In ArtPro for example, the ink selection parameter will look like this:

 

 

By default, all the inks from your input file will be RIP'ed, but you can remove any ink you

don't want to RIP using the  button.

Note:  This public parameter also enables you to choose the screening parameters to use for
the inks you want to RIP. See Selecting Screening Parameters though Shuttle on page 1263 for
more information.

Output
Use the Output settings to define what type of output you want and where to output it.
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You can set these through public parameters or using SmartNames.

1. Enter your output File Name and output Folder.

Note:

• You can use Imaging-specific SmartNames for the File Name.

By default, it is set to:

• [File]_[ShortInk] for single page input files (which gives output file names like
Myfile_C.tif),

• [File]_p[Page]_[ShortInk] for multi-page input files (which gives output file
names like Myfile_p1_C.tif).

• The File Name and Folder can contain special characters (except \ / : * ? < > " |).

• The whole path to the output file (including the container, Folder and File Name) can be
up to 255 characters.

• You can set a local or remote URL for the output Folder, but it must be an absolute path.

• If your output folder doesn't exist yet, the task will create it if the location you request is
valid (you should place this folder on an Automation Engine container accessible by your
Automation Engine user).

If the output folder creation fails, please check the task log for the full list of conditions
and adapt your output folder path accordingly.

2. Define what to do if a file of the same name already exists in your output folder:
a) Click Set Overwrite Policy...
b) Choose what to do If files exist already. You can either:

• Extend the file name if you want to keep the existing output file and give the new
output file a different name. In this case, your new output file name consists of:

• the Output file name (the File Name you set earlier) - which is what the file
would be called if no file with the same name existed,

• a custom suffix that you can define using plain text and/or SmartNames (by
default, this is _c, for "copy"),

• an automatic suffix made of the three last digits of the task ID,

1236



16Automation Engine

Tip:

To see the task ID of your tasks:

1. Go to the Pilot's Tasks pane (in the Files or Tasks view).
2. Go to View > Select Columns in 'Tasks'...
3. In the Columns dialog, select Task ID in the Available columns list and click 

to move it to the Show these columns: list.
4. Click OK.
5. You now have a Task ID column in the Tasks pane, listing the task ID of all the

tasks.

• the file extension.

For example, you are working with a CMYK input file called file.pdf and you have
left the tasks' output File Name to its default value (the SmartName [File]).

The first TIFF files you generate will be called:

• file_C.tif

• file_M.tif

• file_Y.tif

• file_K.tif

If you generate output from this input file again, with the task 3669, and you have set
the overwrite policy to Extend the file name with the default Output File Name + _c
+ ID name, the new output files will be called:

• file_C_c669.tif

• file_M_c669.tif

• file_Y_c669.tif

• file_K_c669.tif

Tip:

• If you are working with the Bitmap Viewer, we recommend you keep the default
overwrite policy (Output File Name + _c + ID), which is compatible with the
Bitmap Viewer.

• If you are not, you can define the custom suffix as you wish. For example, you
could use date and time SmartNames.

• Overwrite the existing file(s).

• End the task in error.
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Note:  If you use a SmartName to set this, it must resolve to extend or 0 (for Extend the
file name), overwrite or 1 (for Overwrite), or error or 2 (for End the task in error).

c) Click Set.
3. Select the output File Type you want.

This can be:

• a TIFF File,

• a PDF File,

• a LEN File (if you do not have a license for the Print Control Wizard),

• a LEN/LENX File (if you have a license for the Print Control Wizard).

If you choose this, the task will generate either LEN or LENX files depending on other
settings:

• If you are using a printing condition, the output files are always LENX.

• If the screening settings in your input file contain one or more Crystal screens, the
output files are also LENX, as Crystal screens can only be used with the LENX format.

However, you can still generate LEN files if you either:

• choose not to use the dot shape from your input file,

• make exceptions to use other screens than the Crystal screens from your input file.

• If you select a CRS (Crystal) screen in the ticket (in the default screening settings or with
an exception), the output files are always LENX.

• In other cases, the output files will be LEN.

Important:

• When outputting a job to LENX files, you need to set the output resolution to 4000
ppi (otherwise you will get an error when launching the task on a file or running it in a
workflow).

• To make plates from your LENX files, you need a CDI Crystal with version 18.1 of the
Grapholas/Digital Flexo Suite software.

See File Formats on page 1135 for more information.
4. The task generates separated output for all file types. This means you get one output file per

page of the input file, and per output separation.

The File Assembly is automatically set to 1 File Per Separation, and the Output Type set
to Separate (for all file types).
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Note:

• Every output file that Imaging Engine generates contains XMP metadata (information
about file creation, separations, calibration curves, etc.).

You can view this XMP metadata by selecting your output file in the Automation Engine

Pilot's Files view and clicking .

For more information about XMP metadata, see the XMP Metadata white paper.

• TIFF files produced by Imaging Engine are fully compatible with Esko's Bitmap Viewer and
DotSpy.

• LEN files produced by Imaging Engine are fully compatible with Esko's CDI (Cyrel Digital
Imager), just as LEN files produced by FlexRip.

• LENX files produced by Imaging Engine are compatible with version 18.1 of the
Grapholas/Digital Flexo Suite software accompanying your CDI.

5. Choose the Compression to use for your output files.

Note:

For screened output, all available compression methods are lossless (so you don't lose any
of the high-resolution detail).

You should choose a compression method based on the compression speed and the
compressed file size. Typically, faster compression methods compress the file less, so the
output file is bigger.

Note that TIFF files can be a maximum of 4GB, PDF files 12GB, and LEN files are unlimited.
Files using stochastic screening are generally larger.

• For TIFF output, choose either:

• PackBits, a fast lossless compression method for graphic files.

Tip:  Use this if you want fast output and file size is not too much of an issue (if you
have a fast network for example).

• LZW, a lossless compression method for graphic files and other files.

Tip:  This compression method works best for files with large images.

• CCITT Group 4, a lossless compression method only used for files containing black
and white.
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Tip:

• This compression method works best for files with a lot of text.
• Use this if having a small output file is more important than processing speed (for

example, if you want to store your screened files on a server to rerun jobs later, or
if you are working with really large input files that may give screened TIFFs of over
4GB).

• For PDF output, choose either:

• PackBits (see above).

• Flate, a lossless compression method similar to zipping, based on the LZW
compression.

Tip:  This compression method works best for images with large single color areas or
repeating patterns.

• CCITT Group 4 (see above).
• For LEN or LENX output, choose either:

• Flate (see above).

• no compression (None).

Tip:  The Compression method offered by default for the output File Type you select (LZW
for TIFF, PackBits for PDF and Flate for LEN or LENX) is generally the best for this file type.

Attention:

• When using a SmartName to set the output file's Compression, it must resolve to
one of the following (case insensitive):

• PackBits, LZW or CCITT-G4 for TIFF output,

• PackBits, Flate or CCITT-G4 for PDF output,

• Flate or None for LEN or LENX output.

Setting any other value, or an unsupported compression for the file type you
chose, will make the task error (with the message Unsupported combination of
output type and compression in the log).

• If you have already set the Compression but decide to change the output File
Type, by default the task will either:

• keep the same Compression (if it is supported for the new output File Type),

• or (if it isn't), set it to the first Compression available for this File Type.

You can still change it as desired.

6. If you are using a screen with advanced screening effects, select Save print simulations to
also generate print simulations files (that you can use for easier quality control).
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Print simulation files look like the screened files you are making for production, but with
the advanced screening effects removed, so you can open them in the Bitmap Viewer and
check exactly how your output will look like.

See Performing Quality Control on Screens with Advanced Screening Effects on page 1128 for
more information.

Note:  If you are using a printing condition, Imaging Engine will generate print simulation
files by default (as the Crystal screens in your printing condition may contain advanced
screening effects such as Pixel+ and/or support dots).

Imaging Engine creates one print simulation file for each screened separation, and saves
the print simulation files in the same place as your screened separations. Print simulation
files have a .view extension.

For example, if you are generating the following screened separations:

• file_C.tif

• file_M.tif

• file_Y.tif

• file_Y.tif

and you choose to also generate print simulation files, you will have the following files
alongside your screened separations:

• file_C.view

• file_M.view

• file_Y.view

• file_Y.view

You can then open these .view files in the Bitmap Viewer for quality control.
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Tip:

The first time you want to open a print simulation file in the Bitmap Viewer, do the
following:

1. Right-click the print simulation file and select Open With then Other...
2. In the Select Application dialog that opens, click Register...
3. In the Register dialog that opens, click Browse... and browse to the executable of your

Bitmap Viewer application.

If you installed it in the location proposed by default, the path should look like either:

• C:\Esko\BitmapViewer_x64\BitmapViewer.exe if you have installed the 64-bit
version of the application,

• C:\Program Files (x86)\BitmapViewer\BitmapViewer.exe if you have
installed the 32-bit version of the application.

4. Click OK.
5. Click Open in the Select Application dialog.

The next time you want to use the Bitmap Viewer, you can just right-click your file, select
Open With, and select BitmapViewer.

You can also compare the print simulation file and the corresponding screened separation
in the Bitmap Viewer (see the Bitmap Viewer documentation for information about
comparing files).
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Tip:

You can also compare your print simulation files to your input file(s) in the Automation
Engine Viewer.

To be able to open print simulation files in the Automation Engine Viewer, you need to
either:

• use the Make all output files ready for viewing option in your Imaging Engine task,

• use Automation Engine's Prepare for Viewer task after your Imaging Engine task in your
workflow.

Note:  If you use the Image to Screened Separations task in a workflow and choose to
generate print simulations files, they will go through an extra output pin called Preview
Files.
 

 

7. Select Make all output files ready for viewing if you are doing quality control using the
Automation Engine Viewer and:

You are generating
TIFF or LEN files.

Use this option to be able to open your output files in the
Automation Engine Viewer without needing to use a
Prepare for Viewer task.

If you don't use this option, you can still use a Prepare for
Viewer task later to be able to view your output files in the
Automation Engine Viewer. However, this will take more
time than already preparing the files for viewing in your
Imaging Engine task.

You are generating
LENX files.

You need to use this option to be able to view LENX files
in the Automation Engine Viewer, as LENX files are not
supported by the Prepare for Viewer task.

This prepares both your RIP'ed files and your print simulation files (if you are using them) for
viewing with the Automation Engine Viewer.
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As with the Prepare for Viewer task, you will see View (Prepared) next to the prepared
files in the Pilot, and you will be able to zoom in to the files up to their full resolution.

Note:

• If you are generating PDF files, you can view them in the Automation Engine Viewer
without preparation.

However if you are generating print simulation files for those PDFs (see above), you still
need to prepare your files for viewing (as the Automation Engine Viewer doesn't open
print simulation files natively).

• You can also view TIFF, LEN and LENX files in the Bitmap Viewer without preparation.

8. Set the Resolution of your output files.

• The Resolution unit is taken from the general Automation Engine Preferences.

• You can enter values from 1 to 25400 ppi (or equivalent in your unit). SmartNames must
also resolve to a value in that range.

• Values in another unit than the one from the general Preferences will be recalculated,
and values like 300ppi + 500ppm will be calculated correctly.

Depending on the Resolution you set here, you will have different screen Rulings available
in the Separations tab.

Note:

• If you are using a printing condition, the output file type is set to LENX and the resolution
to 4000 ppi automatically.

• If you are outputting to LENX files, you need to set the resolution to 4000 ppi (otherwise
you will get an error when launching the task on a file or running it in a workflow).

• If you have an input file with screening settings specifying Crystal screens or HD Flexo
screens, and you try to process it with a saved ticket in which:

• the input file's dot shape is used (and not overriden by any exception),

• the resolution is set to something else than 4000 ppi,

you will also get an error.

9. If your input file contains images, the images' pixels may not map exactly to output pixels if:

• the images' resolution is different from the output resolution you chose,
• scaling and rotation effects change the size and placement of the images' pixels.

In such cases, you need to resample these images to be able to output them at the same
resolution as the rest of the file.

In the Image Resampling option, choose the resampling method you want to use (you will
have to make a trade-off between processing time and image quality).
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• Choose Auto Resampling to upsample the images to an automatically calculated
resolution (generally half or a third of the output resolution) before smoothing them.

When using this, images are a lot less pixellated and fuzzy.

This method is quite slow but gives images of a good quality and reduces the risk of
broken dots a lot, so it is recommended in most cases.

 

 

You can also use a SmartName resolving to ResampleAuto.
• Choose Full Resampling to upsample the images to the full output resolution.

This is the slowest method but gives the highest quality images (not pixellated and only
very slightly fuzzy), with no risk of broken dots.

 

 

Use this if Auto Resampling doesn't give you the results you want.

Attention:

Resampling to full resolution can require significant amounts of memory when
the output resolution is high (especially from 4000 dpi).

If you want to do this, we recommend that you have at least 8GB of RAM
available for each worker (see the installation documentation).

You can also use a SmartName resolving to ResampleFull.
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• Choose None if you don't want to resample your input file's images.

Note:

If you upgraded from a previous version of Imaging Engine, in some cases you may have
saved a ticket with a less optimal resampling method (From File or PDF Interpolation) in
your older version. These methods are deprecated from Imaging Engine 18.1.1.

When processing a file with such a ticket, Imaging Engine will use the Auto Resampling
method instead. You will get a warning about this.

Separations
Use the Separations settings to define the screening and dot gain compensation to apply to the
separations that will be output (the separations you selected in the Document Inks tab).

You can:

• use the settings saved in the input file,
• apply general settings to all output separations, by either specifying an explicit Dot, Ruling

and/or Default Press Curve or by selecting a Printing Condition,
• apply specific settings to certain separations.

1. Use Seamless screening if you are printing several copies of a job continuously on the
substrate, and want to minimize moiré at the seam between jobs.

See Seamless Screening on page 1122 and Using Seamless Screening on page 1252 for more
information.

2. If your input file contains screening settings, you can have the task use (some of) those if
desired.

In Use From File, select which setting(s) to use:

• select None if you want to ignore any screening settings present in the input file and
only use settings you define here,

• select All if you want to use all the screening settings (dot shape, ruling and angle)
present in the input file (this is selected by default),

• select Angle only if you want to use the screen angles defined in the file, but use the dot
shape and ruling defined here,

• select Ruling only if you want to use the ruling defined in the file, but use the dot shape
defined here (the task then uses offset angles for your separations),

• select Angle and ruling if you want to use the angles and ruling defined in the file, but
use the dot shape defined here.

You can use SmartNames resolving to none, all, angle, ruling or angleandruling.
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Note:

If your input file...

• has specific screening settings for certain objects,
• was exported as Normalized PDF from either ArtPro (14.1 or later) or ArtPro+ (14.1.1 or

later),

... then Imaging Engine will screen these objects with their specific settings when using the
input file's settings.

For objects in the file that don't have any screening settings assigned, Imaging Engine will
use the Default Screening Settings you define here.

For information about assigning screening settings to specific objects in ArtPro or ArtPro+,
see the ArtPro or ArtPro+ documentation.

3. Click Advanced Screening Settings... to set options to modify your chosen screen.

See Using Advanced Screening Settings on page 1254.
4. Define Default Screening Settings for the settings you are not taking from your input file

(or as a back-up if some settings you wanted to take from the file are missing).

The settings you define here are applied to all separations (but you will still be able to define
specific settings per separation later).

Note:  If you are using a Printing Condition, the default Dot and Ruling for every separation
are taken from the Printing Condition. In that case, Dot and Ruling will show "set by
Printing Condition" and will not be editable.

a) In Dot, select the screen/dot shape to use.

You can choose from a list of screens installed on your Automation Engine server (on the
screens server).

Screens have a short name and a long name. For example R -> Round Fogra (R being the
short name and Round Fogra the long name).

• Screens with a short name beginning with CRS are custom screens created in the
Print Control Wizard. Please see the Print Control Wizard documentation for more
information.

Note:  You can only use a CRS screen when outputting your job to LENX files at a
resolution of 4000 ppi.

• Screens with a short name beginning with HD are custom screens created in HD
Flexo. Please see the HD Flexo documentation for more information.

Note:  You can only use an HD Flexo screen when outputting your job to LEN files at a
resolution of 4000 ppi.

• Screens with a short name beginning with SCR are custom screens created
in ScreenManager. Please see the ScreenManager documentation for more
information.
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• Screens with a short name beginning with another prefix are predefined screens:

• screens with standard dot shapes,

• screens with advanced dot shapes,

• stochastic (FM) screens,

• legacy screens you have from an old version of FlexRip or Nexus RIP (any legacy
screen for which you have a license will have been copied to your Automation
Engine server during installation).

Tip:

• When selecting a screen, they are listed alphabetically by short name.
• When using a SmartName to set the screen, it should resolve to either the screen's

short name or its long name (not both).

b) Select the Angle Set for the task. You can choose either Offset (the default), Flexo -7.5,
and Flexo +7.5. You can also use a SmartName resolving to one of these values.

Note:

Some angle sets are not available for certain dots. When this is the case, you will see
(not available for the selected dot) next to the angle set, and it will be grayed
out.

For example, when using a CO (Endless), CD0 (TwinBeam), or CD1 (CDI MultiBeam
Optimized) dot, you cannot use the Offset Angle Set.

c) Select the Ruling to use.

Note:

Displayed values under the Ruling selection list depend on the Dot you selected, on the
Angle Set for the task, and on the Resolution you entered in the Output settings.

If you have used SmartNames for the Dot and/or Resolution, you will not see Ruling
values to choose from, and you will need to enter a ruling manually (which must be a
valid ruling for the dot shape and output resolution your SmartNames resolve to).

If you have specified the Angle Set through a SmartName, you will see all rulings
available for all angle sets, each followed by the application type in parentheses, i.e. 43
lpi (Flexo only), 57 lpi (Offset only), etc.

When using a SmartName for the Ruling, make sure it resolves to the ruling value in lpi
but without the unit (for example it should resolve to 150 for 150 lpi).

This ruling is applied to all separations, but you can change the yellow ruling to minimize
yellow moiré.
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Note:

You can make the screening parameters (dot shape, ruling, and angles) public so that they
are editable in other applications, such as Automation Engine Shuttle and PackEdge.

To make these parameters public, right-click anywhere inside the exception rules table of
the Separations > Exceptions tab, and select Make Parameter Public from the context
menu.

If the task already contains a single input file, you can alternatively right click anywhere
inside the inks preview table of the Separations tab, or even anywhere inside the inks
preview table of the Document Inks tab.

Document inks and screening parameters are grouped together for preview, and making
either one public implies that the other one will be made public as well.

5. If desired, you can apply a Plate Curve to all output separations.

A plate curve is used to compensate for the dot growth or dot reduction (for example in
Digital Flexo) happening when making the plate. You can choose either:

• None if you don't want to apply any plate curve.
• Single Curve if you want to apply one curve for all separations.

In this case, select the .dgc curve to apply at right. You can choose from a list of curves
available in the curves database.

• Curve Strategy if you want to apply a curve strategy (a file created in Curve Pilot that
contains several curves to apply in different cases: it can have different curves per
separation, dot shape, ruling, for continuous tone images or line work...).

In this case, select the .icpro curve strategy or legacy .scrdgc screen-based DGC file
to apply at right.

You can choose from a list of curve strategies available in the curves database.

For more information, see:

• Dot Gain Compensation Curves on page 1132,

• DGC Curve Strategies on page 1132,

• The Curves Database on page 1135.

Note:  If you are using a printing condition, no Plate Curve is used (as the printing condition
contains dot gain compensation curves).

Note:

• You can use SmartNames resolving to the exact name of the Single Curve or Curve
Strategy (including the extension).

• This will set the Plate Curve type to Unknown in the ticket, but will resolve to the correct
curve type if the SmartNames are correct.

6. If your input file contains objects that have a press curve assigned, you can choose to use
those curves if desired: select Use press curves from file.
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Tip:

Select this if you have assigned dot gain compensation curves from Imaging Engine's curves
database to your input file's objects using ArtPro 14.1 or later.

See the ArtPro documentation for more information.

For objects in the file that don't have a press curve assigned, Imaging Engine will use the
Default Press Curve you define here.

Note:  If you are using a printing condition, it is not possible to use the press curves from the
input file (as the printing condition contains dot gain compensation curves).

7. Define the Default Press Curve you want to use on the output separations (or on the
objects that do not have a press curve assigned if you selected Use press curves from file).

Note:  If you are selecting a Printing Condition, the Default Press Curve is set to the
PressSync curve from the Printing Condition. It can still be changed afterwards.

This curve is used to compensate for the dot gain on press. You can choose either:

• None if you don't want to apply any press curve,
• Single Curve if you want to apply one curve for all separations (you can still define

exceptions for some of the separations later).

In this case, select the .dgc curve to apply at right. You can choose from a list of curves
available in the curves database.

• Curve Strategy if you want to apply a curve strategy (a file created in Curve Pilot that
contains several curves to apply in different cases: it can have different curves per
separation, dot shape, ruling, for continuous tone images or line work...).

In this case, select the curve strategy to apply at right (you can select a .icpro curve
strategy, a .prsync PressSync curve set or a legacy .scrdgc screen-based DGC file).

You can choose from a list of curve strategies available in the curves database.
• PressSync if you want to apply a PressSync curve (a predefined curve applicable to your

printing environment).

In this case, select the letter and number of the PressSync curve.

For more information, see:

• Dot Gain Compensation Curves on page 1132,

• DGC Curve Strategies on page 1132,

• PressSync Curves on page 1133,

• PressSync Curve Sets on page 1135,

• The Curves Database on page 1135.
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Note:

• You can use SmartNames resolving to the exact name of the Single Curve, Curve
Strategy (including the extension) or PressSync curve.

• This will set the Default Press Curve type to Unknown in the ticket, but will resolve to the
correct curve type if the SmartNames are correct.

8. When launching the task on a single file, you can see the file's separations and the settings
that will be applied to them in a table.

You can also use this table to define custom screening and dot gain compensation settings
for specific separations: click in the Dot, Ruling, Angle or Press Curve column, and enter/
select the value you want to use for that ink.

Your custom values are shown in italics.

Note:  If you enter a Ruling or Angle value that is not valid for the separation's Dot shape,
Imaging Engine will change it to the closest valid ruling or angle when RIP'ing.

If you want to go back to the previous setting, right-click the value you just set and select
Clear Custom Value.

Tip:  You can use this table to make your ink selection and screening parameters public, so
that an operator can set them through Shuttle when submitting a job. See Selecting Screening
Parameters though Shuttle on page 1263 for details.

9. If you notice a dot gain compensation problem in your job, and you want to compensate for
it without changing your main curves, you can apply some corrections (to all separations).

See Corrections on page 1265.
10.If you are setting up a task ticket to use in a workflow for example, you can create a rule to

always apply a specific setting to a specific separation.

You can do this if for example you have a curve you want to use for Yellow in all your jobs,
or to use specific screens for specific spot colors...

See Exceptions on page 1275 to know how to create rules.

Tip:

Applying a specific setting to a specific separation manually (in the preview table) also
automatically creates a rule. So if you are not used to working with rules yet, you can:

1. Take a file containing the separations you usually work with, and open the task on it.
2. In the Separations table, set your desired screening and/or dot gain compensation

settings on your separations manually.
3. The task automatically creates the corresponding rules in the Exceptions tab (if you

change your settings again, these rules will be updated).
4. Save your ticket. You can now use it on other files that need the same settings for those

separations.
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Using Seamless Screening
If you want to use seamless screening, we recommend you do the following:

1. When preparing your input file, make sure that its horizontal dimension matches the sleeve
size around the drum.
 

 

You can check this in PackEdge for example.

 

 
2. When RIP'ing your file with the Image to Screened Separations task, select the following

Separations settings:
a) Select Seamless screening.
b) Select a Dot shape/screen that is compatible with seamless screening.
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Note:

You can use seamless screening with any dot shape/screen except:

• stochastic screens,
• Groovy screens,
• Samba or SambaFlex screens,
• Paragon or other legacy Artwork Systems screens,
• HD Flexo screens with advanced screening effects (the dot, screen ruling and angle

can be made be seamless, but not the advanced screening effects).

Dot shapes/screens that are not compatible with seamless screening are shown in grey
with the mention (not available for seamless screening).

Attention:  If you chose to use all the screening settings specified in your input file
(including the dot), and that dot is not compatible with seamless screening, the task
will end in error.

RIP'ing a file with seamless screening is slightly slower since the screens need to be
generated dynamically.

However the processing time depends mostly on other factors (the number and type of
screens that need to be processed for each separation, the resolution, the presence of
advanced effects in the screens...).

3. After RIP'ing your file, you can inspect it in the Bitmap Viewer.
a)

Click  in the Bitmap Viewer to show the file repeated continuously (in the horizontal
and vertical direction).

The seam lines are indicated in green.

 

 
b) Zoom in on the horizontal seam lines to check that the screening is seamless.
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4. If desired, you can also check the exact ruling and angle that were used to make the screen

seamless:
a) Click  in the Bitmap Viewer to open the Info window.
b) For each separation, you can see the Ruling, Angle and Dot shape used under Screens

and DGC.

Using Advanced Screening Settings
In the Advanced Screening Settings dialog, you can set options to modify your chosen screen.

1. When working with AM Screening, you can minimize yellow moiré by changing the ruling of
the yellow separation.

To do this:

a) In Change Y Ruling, select Yes (conventional).

When using a SmartName to set this, it must resolve to conventional (or to no if you
don't want to use yellow moiré reduction).

b) Choose by how much to change the ruling: -15 %, -7 %, +7 % or +15 %.

When using a SmartName to set this, it must resolve to -15, -7, +7 or +15.

Note:

• If your file doesn't contain a yellow separation, yellow moiré reduction won't be applied.
The task will run as normal but you will get a warning in the log.

• You cannot set yellow moiré reduction options when using a Paragon dot, as Paragon
dots already have built-in yellow moiré reduction.

Tip:

• If you encounter four color moiré when printing with a yellow spot color, or with a light
color other than yellow, you can adjust that color's ruling using an exception.

• If you want to minimize yellow moiré by changing the yellow screen to a Monet screen
(instead of changing the yellow ruling), you can also do this with an exception.
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2. In Screen Angle Direction, choose how Imaging Engine should read the screening angles
(whether you are using angles from your file, default angles or specific angles per separation).

• Choose Clockwise (FlexRip Compatible) to read all angles as clockwise.

For example, if you are using the angles from your file, and your file specifies a 75° angle
for Cyan, this will be read as 75° clockwise.

If you were previously using FlexRip, we recommend you use this option to get
consistent output. This is the default option.

• Choose Counter Clockwise (Nexus Compatible) to read all angles as counter clockwise.

In this case, the same 75° Cyan angle from your file will be read as 75° counter clockwise.

If you were previously using Nexus, we recommend you use this option to get consistent
output.

• You can use SmartNames resolving to CW for clockwise or CCW for counter clockwise.

Note:

If you use a different angle direction than your screen was designed for, Imaging Engine
will create a custom screen on-the-fly, based on your original screen and the screen angle
direction you chose.

See The Effect of Changing a Screen's Angle Direction on page 1259 for details.

Attention:

Certain screens can only be used with a clockwise Screen Angle Direction (see
Clockwise Only Screens on page 1260).

• If you have selected a counter clockwise direction, you will not be able to select
one of those screens.

• If you select one of those screens, then select a counter clockwise angle direction,
you will get a warning that this screen doesn't support counter clockwise angles
and that the dot will be changed to Round Fogra.

If desired, you can keep your selected screen but change the angle direction back
to clockwise by clicking Cancel in the Advanced Screening Settings dialog.

Attention:

When using older Image to Screened Separations tickets (saved in a version of
Imaging Engine earlier than 14.1.1), the screen angle direction in your output may
not be the same as before in certain cases.

See Screen Angles in Older Tickets on page 1261 for more information.

3. Choose a Screening Model if:

• you are using the screening settings from your input file,

• your input file contains overlapping objects that have different screens assigned.
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The Screening Model you choose determines which screen to use for which separation of
the overlapping objects.

• Choose Esko for screening results similar to what you would have obtained using
FlexRip.

If your input file contains images or shadings showing through flat tint objects because
of transparencies, the screening of the image of shading will be used for the parts
showing through.

For example, the file below contains an image object, with two (yellow) flat tint objects
above it. The yellow object on the left is opaque, but the one on the right has a
transparency applied, so that the image shows through it.

 

 

The input file contains the following screening information: Round Fogra dot for the
image, and Rugby dot for the yellow objects.

When RIP'ing this file using the Esko Screening Model, you get the following screened
file for the Yellow separation:
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• The area highlighted in red consists of the parts of the image that either don't have
another object on top, or have a transparent object on top.

These parts are screened using the screening information of the image object (the
Round Fogra dot).

• The areas highlighted in blue consists of the (parts of the) flat tints objects that are
either opaque, or that are not on top of the image.

These parts are screened using the screening information of the flat tint objects (the
Rugby dot).

Note:

• This is the default option when launching a new ticket on your input file(s).
• When re-running old FlexRip jobs using this option, you will get a screening identical

to what you used to get with FlexRip in most cases.

In certain particular cases, there are slight differences due to some improvements in
the screening model.

See Imaging Engine - Differences between Esko (FlexRip compatible) screening in Imaging
Engine and FlexRip in the Knowledge Base for more details.

• Choose Adobe for screening results similar to what you would have obtained using
Nexus.

If your input file contains overlapping objects that have different screens assigned, the
screening of the top object will be used (even in case of images or shadings showing
through flat tint objects because of transparencies).
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With the same example as above (an image object, with two yellow flat tint objects above
it, one opaque and one with a transparency) ...

 

 

... you get the following screened file for the Yellow separation when RIP'ing with the
Adobe Screening Model:

 

 

• The area highlighted in red consists of the parts of the image that don't have another
object on top.

These parts are screened using the screening information of the image object (the
Round Fogra dot).
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• The areas highlighted in blue consists of the flat tints objects that are either on top of
the image, or not on top of anything.

These parts are screened using the screening information of the flat tint objects (the
Rugby dot).

Note:

• Older versions of Imaging Engine (before 16.0.2) used this screening model by
default.

When using an Image to Screened Separations ticket you saved in such an Imaging
Engine version, the screening model will be automatically set to Adobe to give you
consistent results.

• When re-running old Nexus jobs using this option, you will get a screening identical to
what you used to get with Nexus in most cases.

In certain particular cases, there are slight differences due to some improvements in
the screening model.

See Imaging Engine - Differences between Adobe® (Nexus compatible) screening in Imaging
Engine and Nexus in the Knowledge Base for more details.

• You can also use a SmartName resolving to Esko or Adobe.
4. Click Set to confirm your choices.

Changing a Screen's Angle Direction

The Effect of Changing a Screen's Angle Direction

If you use a different angle direction than your screen was designed for, Imaging Engine will
create a custom screen on-the-fly, based on your original screen and the screen angle direction
you chose.

The way it creates it depends on your type of screen:

• If your original screen only works with angles between 0 and 90° (it is a modulo 90 screen),
the screen will be mirrored along the horizontal axis to produce the other angle direction.

In the example below, a 15° counter clockwise screen angle is mirrored horizontally (along
the blue axis) to give a 15° clockwise angle.

 

 

• If your original screen works with angles between 0 and 180° (it is a modulo 180 screen), the
screen angle is simply translated into the other angle direction.
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In the example below, a 15° counter clockwise screen angle becomes a 165° clockwise
angle.

 

 

Note:  You can check the characteristics of a screen in ScreenManager: in the screen details, a
modulo 90 screen only lists angles from 0° to 90°, while a modulo 180 screen lists angles from
0° to 180°.

Clockwise Only Screens

You cannot change the Screen Angle Direction for screens that have the following
characteristics:

• they only work with screens angles between 0 and 90° (modulo 90 screens),

• they contain surface screening effects.

When using a screen with a surface screening effect, the pattern frequency and orientation of
the effect should be adapted to your inking system (for example, your anilox roll).

For modulo 90 screens, changing the screen angle direction would change the surface
screening pattern's orientation, which would affect how the screen prints.

 

 

This applies to the following screens, that were designed for, and can only be used with, a
clockwise angle direction:

Screen types Which are clockwise only?

Groovy screens

(short names: GVY1 to GVY5)

All groovy screens

HD Flexo screens

(short names starting with HD)

HD Flexo screens that use surface screening
effects

Note:  You can check this in HD Flexo: any
screen that mentions Enhanced Shadows
and Solids has surface screening effects.

Full HD Flexo screens All Full HD Flexo screens
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Screen types Which are clockwise only?

(short names starting with HD)

Custom screens created in ScreenManager

(short names starting with SCR)

Any custom screen that is modulo 90 and uses
surface screening effects

Note:  You can check the characteristics of a
screen in ScreenManager.

Screen Angles in Older Tickets

When using older Image to Screened Separations tickets (saved in a version of Imaging
Engine earlier than 14.1.1), the screen angle direction in your output may not be the same as
before in certain cases.

This is because the screen angles are reinterpreted according to the screen angle direction
setting (available from Imaging Engine 14.1.1).

When Will the Angles Stay the Same?
The screen angles in your output will stay the same as before if you relaunch your old tickets
without opening them.

This is the case when:

• You launch an old ticket on a file using the Launch with option in the Pilot (right-click the
file in the Files view, select Launch with, then select your old ticket).

• You run a file through an old workflow containing your old ticket (from the Pilot, from
Shuttle, or from another application connecting to Automation Engine).

• You relaunch an old file with its original ticket settings (right-click the entry corresponding to
your old file and ticket in the Pilot's Tasks list and select Relaunch).

When May the Angles Change?
If you open an old ticket and then launch it on a file, the direction of the screen angles in your
output may be different from your previous output with that old ticket.

This can be the case when:

• You launch an old ticket on a file using the New Task option in the Pilot (right-click the file in
the Files view, select New Task, then select your old ticket; it opens automatically).

• You open the old ticket in the Tickets view (next time you launch it on a file, the screen
angles in your output may be different).

When opening an old ticket, you will get a message warning you that the screen angle direction
will be set to clockwise by default. This means that Imaging Engine will read all angle values in
the files and/or the ticket as being clockwise values.

In most cases, this will give the same output as before, but we recommend you review the
following if you are concerned about whether your output will be consistent with previous
versions of Imaging Engine:

Working with Screen Angles from the Input File

If you use the screen angles defined in your input file, we recommend you do the following to
keep your output consistent with previous versions of Imaging Engine:

• Use a clockwise screen angle direction if you work with Normalized PDF files.
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• Use a counter clockwise screen angle direction if you work with standard PDF files.

Otherwise, you may get different output than previously, as illustrated by the example below:

Input file Output in older Imaging Engine
versions

Output in Imaging
Engine 14.1.1 onwards

Normalized PDF file
with Cyan at 45°

45° clockwise, which could be displayed
in the ticket as either:

• 45° clockwise
• 135° counter clockwise

... depending on what you chose in the
Preferences of your old Imaging Engine
version.

Standard PDF file
with Cyan at 45°

45° counter clockwise, which could be
displayed in the ticket as either:

• 45° counter clockwise
• 135° clockwise

... depending on what you chose in the
Preferences of your old Imaging Engine
version.

For both Normalized
PDF and standard PDF
files:

• 45° clockwise if you
set a clockwise screen
angle direction.

• 45° counter
clockwise if you set
a counter clockwise
screen angle direction.

Working with Default Screen Angles

The default screen angles are the angles used for the separations whose screening settings are
not:

• taken from the input file,
• defined using an exception.

When reopening an older ticket that used default screen angles for some separations, your
output will be:

• the same as before when working with modulo 180 screens,

• different when working with modulo 90 screens.

For more details, please see Angle interpretation: behaviour for existing IE tickets in the
Knowledge Base.

Working with Screen Angles from Exceptions

If you have set your screen angles using exceptions, we recommend you choose a clockwise
screen angle direction to keep your output consistent with previous versions of Imaging Engine.

Note:

If you had chosen to display your angles as counter clockwise in the Preferences of your old
Imaging Engine version, the angles will look different in your ticket (as the ticket will now
display the clockwise equivalent of your angles).

However, the output will be the same.
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Selecting Screening Parameters though Shuttle
To be able to set screening parameters for each ink when submitting an input file through
Shuttle, do the following:

In Your Imaging Engine Ticket
1. Make your ink selection and screening parameters public in one of the following ways:

• If you have opened your Image to Screened Separations ticket without an input file,
you can either:

• Go to Advanced > Manage Public Parameters..., find the Ink and Screening
Selection parameter at the bottom of the list, and drag it to the right hand side.

 

 

• Go to the Exceptions tab, right click the rules table at the top, and choose Make
Parameter Public.

Note:  You will not be able to create rules using Shuttle, you will only be able to select
inks and screening parameters manually.

• Use the Document Inks tab (see Selecting Inks though Shuttle on page 1233 for
details).

• If you have opened your Image to Screened Separations ticket on an input file (even a
dummy file), you use any of the above options, or:

• Go to either the Separations tab or the Exceptions tab, right click the preview table
at the bottom, and choose Make Parameter Public.

2. By default, the public parameter that appears in Shuttle will be called Ink and Screening
Selection. You can change its name by:

• right-clicking one of the elements mentioned above, selecting Modify Public Parameter
and entering a new name,

• if you are using the Manage Public Parameters window, entering the new name in
Prompt as.

3. Make sure your ticket is also Public.

In Shuttle
The ink selection and screening parameters may look a bit different depending on which
Shuttle you are using (the Shuttle standalone application or a Shuttle plug-in in an Editor
application).
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• In the Shuttle standalone, they will look like this:
 

 

The table shows a preview of all inks in the input file, with their characteristics, and the
screening parameters that will be used for each ink.

You can decide which inks to RIP, and with which parameters:

• To RIP all inks from your input file, either leave all inks selected in the preview table, or
select All inks at the top (this will hide the preview table).

• To only RIP certain inks, make sure All inks is not selected, and deselect the input inks
that you don't want to RIP.

By default, the screening parameters saved in the ticket are used, but you can change this
by clicking the ticket icon  and entering the value you want to use.

You can enter values for the Ruling, Angle and Dot Shape as you would in the Separations
tab.

• In ArtPro for example, the ink selection and screening parameters will look like this:
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By default, all the inks from your input file will be RIP'ed, but you can remove any ink you

don't want to RIP using the  button.

By default, the screening parameters saved in the ticket are used, but you can change this
by selecting Override (Parameter Name) and entering the value you want to use.

Corrections
If you notice a specific dot gain related problem in your job, you can use the Corrections
settings to compensate for that problem without changing your general dot gain compensation
settings (that you may also use for other jobs).

You can:

• apply a correction curve,
• correct dot gain problems in the highlights,
• correct dot gain problems in the shadows.

Note:

The corrections you define here are applied to all output separations. If you need to apply a
different correction to a specific separation, we recommend you create a curve strategy in
Curve Pilot for this purpose.

When doing this, the tools in Curve Pilot help you keep your gray balance in check when
changing the dot gain compensation for specific separations.

Please see the Curve Pilot documentation for more information.

1. If needed, select a Correction Curve to apply to all the separations that will be output.

You can use this for example to handle press fluctuations, or to modify the transition point
when using transitional screens.

• None if you don't want to apply any plate curve.
• Single Curve if you want to apply one curve for all separations.

In this case, select the .dgc curve to apply at right. You can choose from a list of curves
available in the curves database.

• Curve Strategy if you want to apply a curve strategy (a file created in Curve Pilot that
contains several curves to apply in different cases: it can have different curves per
separation, dot shape, ruling, for continuous tone images or line work...).

In this case, select the .icpro curve strategy or legacy .scrdgc screen-based DGC file
to apply at right.

You can choose from a list of curve strategies available in the curves database.

Note:  In case you select the option Curve Strategy, the option Range Correction (see
below) will not be available or applied. Also if a SmartName resolves to a an .icpro or .srdgc
file any Range Correction defined will not be applied.

For more information, see:

• Dot Gain Compensation Curves on page 1132,

• DGC Curve Strategies on page 1132,
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• The Curves Database on page 1135.

Note:  You can use SmartNames resolving to the exact name of the Single Curve or Curve
Strategy (including the extension). In the ticket, this will set the Correction Curve type to
Unknown, but it will resolve to the correct curve type if the SmartNames are correct.

2. Choose when to Apply the Correction Curve:

• Before Press Curve
• Between Press & Plate Curve
• After Plate Curve
• you can also use a SmartName resolving to BeforePress, BetweenPressAndPlate or

AfterPlate.

The order in which you apply your dot gain compensation curves makes a difference to your
final result. In the example below, you can see what happens to the 50% value depending
on the order of the curves:

• When applying the correction curve first (Before Press Curve):

1. The Correction Curve changes the initial 50% value to 60%.

output

 input

2. For that 60% value, the Press Curve gives 48%.
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output

 input

3. For that 48% value, the Plate Curve gives a final value of 53%.

output

 input

• When applying the correction curve Between Press & Plate Curve:

1. The Press Curve changes the initial 50% value to 40%.
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output

 input

2. For that 40% value, the Correction Curve gives 49%.

output

 input

3. For that 49% value, the Plate Curve gives a final value of 54%.

1268



16Automation Engine

output

 input

• When applying the correction curve last (After Plate Curve):

1. The Press Curve changes the initial 50% value to 40%.

output

 input

2. For that 40% value, the Plate Curve gives 46%.
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output

 input

3. For that 46% value, the Correction Curve gives a final value of 56%.

output

 input

3. After your curves have been applied, you can also use the Range Correction to correct dot
gain problems in the highlights and/or shadows.

• Select Minimum Correction if you only want to correct the highlights.
• Select Maximum Correction if you only want to correct the shadows.
• Select Minimum & Maximum Correction if you want to correct both highlights and

shadows.
• You can also use a SmartName resolving to Minimum, Maximum or MinimumAndMaximum.
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Note:

• If you have already applied a highlights and/or shadows correction in your plate curve or
default press curve you don't need to make that correction again here.

• Correcting your highlights and/or shadows does not affect your mid-tones. If you want to
correct your mid-tones, you can use a correction curve.

4. If you have problems with the highlights (for example they print unevenly, giving you
missing or partial dots), you can do the following to correct them:
a) Enter the Minimum Dot that you know your plate can safely print. In the screened files,

Imaging Engine will not generate dots any smaller than what you enter here.

Note:

• The Minimum Dot must be within the 0%-30% range. If you enter a percentage
outside of this range it will be automatically adjusted to the nearest value in the range
(for example 32 will be adjusted to 30%).

• When using a SmartName, it must resolve to a number between 0 and 30 (without
the % sign). If you use a SmartName that resolves to a percentage outside the range,
the task will end in error.

• You can enter a simple formula and it will be calculated automatically (for example
you can enter 10+2 and this will be changed to 12%). This only works with numerical
values and not with SmartNames.

b) In How to Handle Minimum Job Tones, enter the range of input file tones that typically
gives you problems on output (for example, you may find that tones between 0% and 1%
in your input file typically give you missing or partial dots on output).

Note:

• The Minimum Job Tones range always starts at 0% and can go up to 10%. If you enter
a percentage outside of this range it will be automatically adjusted to the nearest
value in the range.

• When using a SmartName, it must resolve to a number between 0 and 10 (without
the % sign). If you use a SmartName that resolves to a percentage outside the range,
the task will end in error.

• You can enter a simple formula and it will be calculated automatically. This only works
with numerical values and not with SmartNames.

c) Decide how to treat this range of problematic tones to prevent output problems. You can
either:

• Not print those small percentages (select Drop To 0%).

In this case, anything in that range will be rendered at 0% (so removed from the
output), and the first percentage above that will become the Minimum Dot.
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In the example below, the Minimum Job Tones are 0% to 5% and the Minimum Dot
is 10%.

If you select Drop To 0%, the 0% to 5% range in your input file becomes 0% in the
output, and the first percentage after that (5.01%) becomes 10% (the Minimum Dot).

Higher percentages follow the dot gain compensation you applied (the combination
of the plate curve, press curve and correction curve you have set). Note that the
transition between your highlights correction and the combined curve is smoothed to
give you better printing results.

 

 

• Increase those small percentages so they meet the threshold to become your
Minimum Dot on output (select Hold To Minimum Dot).

In this case, anything in that range (except 0%) will be rendered at the percentage you
entered as Minimum Dot.

With the same example, if you select Hold To Minimum Dot, 0% will stay 0%, and the
0.01% to 5% range in your input file will become 10% in the output (the Minimum
Dot).

Higher percentages follow the dot gain compensation you applied (the combination
of the plate curve, press curve and correction curve you have set). Note that the
transition between your highlights correction and the combined curve is smoothed to
give you better printing results.
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5. If you have problems with the shadows (for example you lose detail in the darkest areas, or

you get pin holes in the solids from laying down too much ink), you can do the following to
correct them:
a) Enter the Maximum Dot that you know you can safely print for a good result in the

shadows. In the screened file, Imaging Engine will not generate dots any bigger than
what you enter here.

Note:

• The Maximum Dot must be within the 70%-100% range. If you enter a percentage
outside of this range it will be automatically adjusted to the nearest value in the range
(for example 68 will be adjusted to 70%).

• When using a SmartName, it must resolve to a number between 70 and 100 (without
the % sign). If you use a SmartName that resolves to a percentage outside the range,
the task will end in error.

• You can enter a simple formula and it will be calculated automatically (for example
you can enter 70+5 and this will be changed to 75%). This only works with numerical
values and not with SmartNames.

b) In How to Handle Maximum Job Tones, enter the range of input file tones that typically
gives you problems on output (for example, you may find that tones between 97% and
100% don't show enough details on output).
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Note:

• The Maximum Job Tones range can start from 90% and always go up to 100%. If
you enter a percentage outside of this range it will be automatically adjusted to the
nearest value in the range.

• When using a SmartName, it must resolve to a number between 90 and 100 (without
the % sign). If you use a SmartName that resolves to a percentage outside the range,
the task will end in error.

• You can enter a simple formula and it will be calculated automatically. This only works
with numerical values and not with SmartNames.

c) Decide how to treat this range of problematic tones to prevent output problems. You can
either:

• Make those large percentages solid (select Raise To 100%).

In this case, anything in that range will be rendered at 100%, and the first percentage
below that range will become the Maximum Dot.

In the example below, the Maximum Job Tones are 95% to 100% and the Maximum
Dot is 90%.

If you select Raise To 100%, the 95% to 100% range in your input file becomes
100% in the output, and the first percentage below that (94.99%) becomes 90% (the
Maximum Dot).

Lower percentages follow the dot gain compensation you applied (the combination
of the plate curve, press curve and correction curve you have set). Note that the
transition between the combined curve and your shadows correction is smoothed to
give you better printing results.
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You can use this if you don't want your darkest shadows to be screened (for files
containing linework for example).

• Decrease those large percentages so they become your Maximum Dot on output
(select Hold To Maximum Dot).

In this case, anything in that range (including 100%) will be rendered at the
percentage you entered as Maximum Dot.

With the same example, if you select Hold To Maximum Dot, the 95% to 100% range
in your input file will become 90% in the output (the Maximum Dot).

Lower percentages follow the dot gain compensation you applied (the combination
of the plate curve, press curve and correction curve you have set). Note that the
transition between the combined curve and your shadows correction is smoothed to
give you better printing results.

 

 

You can use this if you want your darkest shadows to be screened (for files containing
images for example).

6. You can see the number of corrections you applied next to the Corrections tab at left.

For example, if you apply a Correction Curve, a Minimum Correction (on the highlights),
and a Maximum Correction (on the shadows), you will see Corrections (3).

Exceptions
Use the Exceptions tab if you want to always apply specific screening and dot gain
compensation settings to certain separations (for example spot colors).

These specific settings overrule your more general screening and dot gain compensation
settings (for example, you can apply a default press curve to your input file, but choose to use a
different press curve for a specific separation).

You can do this anytime (when launching the task on one or more input files, when defining
ticket settings, when setting up a workflow...).
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You do this by setting up rules. This works as follows:

• You create a rule for each separation or set of separations that need specific screening and/
or dot gain compensation settings.

• Within each rule:

1. You select the separation(s) you want to apply specific settings to. You do this by setting
criteria that a separation has to match to be selected.

For example if you want to select all process inks, you can set that the ink book must be
process for the inks to be selected.

You can use the following ink characteristics in your criteria:

Ink name

Ink book

Ink index The Ink index is the order in which the file's inks will be printed
(the ink with ink index 1 is at the bottom of the document and
will be printed first).

To find the ink index of a file:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink
has an index of 1, the second of 2, etc.).

Note that if you reorder the inks by one of the columns (for
example by Ink name), they won't be ordered by ink index
anymore. You will need to close that dialog and reopen it to see
the ink index order again.

Spot ink
index

The Spot ink index is the order in which a spot ink will be
printed (when counting only spot inks and not process inks).

For example, if the first 4 inks of the document are CMYK, the
first spot ink will have 5 as Ink index but 1 as Spot ink index.

Ink type This can be for example Normal, Technical, Varnish...

Printing
method

If you have set a Printing method for an ink it will be shown
here (this can be for example Offset, Gravure, Flexo... or any
custom printing method you configured).

See the Automation Engine documentation for more
information about printing methods.

2. You define the screening and/or dot gain compensation settings to apply to the selected
separation(s).

• If you have several rules, you can reorder them in order of priority (the top one is applied
first).

To define a rule manually, you need to do the following in the Exceptions tab:

1. Click + at the bottom of the table.
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2. In the Rules Properties dialog, enter a Rule Name.
3. Under If separation matches, define one or more criteria to select your desired

separation(s).

You can use the following elements:

• Ink name: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink book: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink index: you can define if it equals/is less than/is greater than the number you
enter, or is is between the two numbers you enter (in this case the ink indexes you enter
as boundaries are also selected).

• Spot ink index: you can define if it equals/is less than/is greater than the number you
enter, or is is between the two numbers you enter (in this case the spot ink indexes you
enter as boundaries are also selected).

• Ink type: you can define if it is a piece of text (alphanumerical characters).

• Printing method: you can define if it is a piece of text (alphanumerical characters).

Tip:

• You can enter several values to check for: just use a semicolon (;) between them.

For example, to check for both inks called Cyan and inks called Magenta, choose Ink
name is and enter Cyan;Magenta.

• Click + to add more criteria. You can also add sub-criteria by holding Alt while clicking +.

For example, if you want to make a rule for Process Yellow, you can use:

All of the following are true:
Ink name is Yellow
Ink book is Process

• When launching the task on a file, you can also click  to select one or more of the Ink
names/Ink books/Ink types/Printing methods used in your input file(s).

A criterion will automatically be created based on your selection.

4. Define the settings (Dot, Ruling, Angle and/or Press Curve) you want to use for the
selected separation(s).

Note:  If you enter a Ruling or Angle value that is not valid for the separation's Dot shape,
Imaging Engine will change it to the closest valid ruling or angle when RIP'ing.

5. Click Add.

You can see your rule and the settings you defined for the selected separation(s) in the
Exceptions tab table.
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Tip:  You can double-click your rule if you still want to edit it.

Note:

If you have defined specific settings for certain separations manually (when launching the
task on a single file), you can see that these settings have been automatically added as rules
in the Exceptions tab (and shown in italics).

A rule is added for each setting that you define (for example if you select a specific Dot and
Press Curve for Yellow, you will get one rule for the dot and one for the press curve).

6. Repeat steps 1 to 5 to define more rules if desired.

If you want to remove a rule, select it and click Remove.

You can see the number of rules defined next to the Exceptions tab at left.
7. If desired, you can reorder your rules (they are applied from top to bottom). To do this,

select a rule and click Move Up or Move Down (or drag it up or down).
8. When launching the task on a single file, you can see the file's separations and the settings

that will be applied to them in a table (make sure to leave the Preview option selected).

This is the same table as at the bottom of the Separations tab. It includes:

• the settings you have taken from the input file,

• the settings you have defined for all separations,

• the settings you have defined for specific separations,

• the settings defined by your exception rules.

As in the Separations tab, you can use this table to define specific screening and dot gain
compensation settings for certain separations.

Click in the Dot, Ruling, Angle or Press Curve column, and enter/select the value you want
to use for that ink.

Your custom values are shown in italics.

Note:  If you enter a Ruling or Angle value that is not valid for the separation's Dot shape,
Imaging Engine will change it to the closest valid ruling or angle when RIP'ing.

If you want to go back to the previous setting, right-click the value you just set and select
Clear Custom Value.

Note:

When launching your Imaging Engine ticket on a file from Automation Engine Shuttle, you
cannot see the exceptions defined in the ticket (Shuttle always displays the parameter values
found in the input file).

However, if you modify some public parameter values in Shuttle then launch the ticket,
when you go to back to the Automation Engine Pilot and open the ticket, you will see all your
modified parameters saved as exceptions.
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Post-RIP
When a job is RIP'ed with screening, it can happen that very small or broken dots (sometimes
called "scum dots") appear in highlight areas.

These dots can be smaller than the minimum dot size that can be held on a flexo plate, which
can cause "dragging" and other unwanted effects when the job is printed.

You can use Post-RIP settings to clean up areas of the output files where:

• Halftone dots are smaller than a certain minimum dot size.
• Advanced screening effects like support dots and surface screening patterns are broken or

different from the intended pattern.

This is typically the result of a resolution mismatch between the input file and the screen
ruling applied.

Note:  The Post-RIP tab is only available if you have a dot cleanup license.

The cleanup algorithm adapts itself to the screen(s) used by the task:

• For screens with surface screening effects (micro-cells, patterns or line perforations in dots
and solids to improve ink lay-down), dot cleanup will preserve the surface screening.

• For screens with support dots (non-printing pixels that support isolated printing dots), dot
cleanup will replace pixel residues by a supporting dot.

• For screens with Pixel+ pixels used to form halftone dots, dot cleanup will preserve the
isolated pixels and the minimum dot size will be interpreted as the minimum number of
isolated Pixel+ pixels.

1. To perform post-RIP dot cleanup, select Clean up dots in highlights.
This makes the parameters below available.

Note:  If you are using a printing condition, Imaging Engine will always perform dot cleanup
in the highlights.

2. Enter the Ruling used in the area of your job where you want to perform the dot cleanup.

Note:

• Ruling refers to the plate resolution (digital ruling), and may be different from the screen
ruling set in the Separations tab.

• If your job contains several screen rulings, enter the ruling used in the areas where dot
cleanup is particularly required, or the most widely-used ruling in the job.

• If you are using a printing condition, the Ruling is automatically set to the ruling used in
your printing condition.

The Ruling cannot be lower than 1 lpi. A SmartName for ruling must resolve to a number
higher or equal to 1 (lpi). The default value for a new task is 150 lpi.

3. In Minimum Dot Size, enter the smallest screen dot size that your job can have.

The Minimum Dot Size cannot be lower than 2 pixels. The default value for a new task is
1%. A SmartName for the minimum dot size must resolve to a number (in your chosen unit)
that corresponds to a minimum of 2 pixels, otherwise the task will fail.
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A SmartName defining the dot size unit must resolve to %, pixels, or μm.

The Minimum Dot Size is also a plate specification provided by the plate manufacturer for
the plate resolution.

Note:

• If you are using a printing condition, the Minimum Dot Size is the minimum dot size used
in the screen from your printing condition.

• For HD Flexo or Full HD Flexo screens which use highlights or a minimum dot size, the
Minimum Dot Size must be the minimum dot size for that screen.

For example, for an HD Flexo screen whose name contains "C16", the Minimum Dot
Size should be set to 16 pixels.

Note:

• If the task also contains a minimum dot correction set in the Separations > Corrections tab,
both actions will be performed independently; the post-RIP dot cleanup will be performed
last.

• The post-RIP dot cleanup may in some cases cause a loss of detail in the highlights.

When using hybrid screens (with transition point features), you should check that the
cleanup action does not interfere with your screen design below the transition point in the
highlights.

For more information, see this knowledge base article.

Summary
This shows a summary of all the settings you defined in the ticket.

• To show the settings from a tab, click + (on PC) or  (on Mac) beside the tab name in the
right pane.

Click Expand All to show the settings from all tabs.
• To hide the settings from a tab, click - (on PC) or  (on Mac) beside the tab name in the right

pane.

Click Collapse All to hide the settings from all tabs.

16.6.5.  Image to Unscreened Separations

Use this task if you need unscreened output to send to a device that will take care of the
screening, or a device that doesn't need screened input (for gravure for example).

Task Output
The Image to Unscreened Separations task generates one file per separation, in either PDF or
TIFF format.

In the example below, processing a file containing the lime green Esko star generates
unscreened files for the Cyan, Yellow and Black separations.
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Task Parameters
In the Device field, select the imaging device that you configured.

Then use the tabs at left to show more settings to fill in. See:

• General on page 1281,

• Transformations on page 1283,

• PDF Objects on page 1284,

• Document Inks on page 1286,

• Output on page 1293,

• Separations on page 1301,

• Summary on page 1317.

General
1. Define what Page Box of the input PDF you want to RIP.

You can either select Media Box, Trim Box, or insert a SmartName  that must resolve to
either media or trim.

After selecting your file's page box you will see its dimensions under the Page Box option.
2. If your input file is a multi-page PDF, select which Pages you want to RIP:

a) First select All pages, Odd pages only or Even pages only in the Pages option.

You can also insert a SmartName resolving to either All, Even or Odd.
b) Then you can refine your selection by entering page numbers or a Page Range.

You can separate page numbers by a comma, or use a dash to indicate a page range (for
example 3,6-9). You can also use a SmartName resolving to page numbers and/or page
ranges using this same format.
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Note:

• Page numbers are always physical pages. If your document starts with page 5, you
should not use 5 but 1 to get the first page.

• If you enter page numbers that are not part of your document, they will be excluded
from the output (all the other valid pages will be RIP'ed).

• If you enter the same page(s) more than once (for example 1,1-2), it/they will only be
output once.

• Pages are RIP'ed in the order of the document (entering 5-1 will be automatically
changed to 1-5).

3. If you want to invert your output so it is compatible with the output device or software

system that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to
invert the output), or to 0 or false (to leave the output as it is).

4. If you want to mirror your output so it is compatible with the output device or software

system that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to
mirror the output), or to 0 or false (to leave the output as it is).

5. If you want to add a SmartMark to your output file(s), select it in the SmartMark list, or use
a SmartName that will resolve to the SmartMark name.

A SmartMark is a mark whose content is variable, so you can make it display information
about that specific job. For example, you can include some of the parameters used during
RIP'ing in your output file(s) by using a SmartMark.

You need to:

a) First create the SmartMark you want to use in PackEdge (see the SmartMarks section in
the PackEdge manual for details).

You can create either:

• a SmartMark with RIP-specific parameters,

Use this SmartMark
parameter in
PackEdge:

to display this value from the Imaging
Engine parameters:

Device the imaging device you used

Image whether you inverted your output

Emulsion whether you mirrored your output

V Distortion the vertical distortion you applied to your
output file(s)
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Use this SmartMark
parameter in
PackEdge:

to display this value from the Imaging
Engine parameters:

H Distortion the horizontal distortion you applied to
your output file(s)

Resolution the resolution of your output file(s)

Plate Curve the plate curve you applied to your
separation(s)

Correction Curve the correction curve you applied to your
separation(s)

Screen based DGC the curve strategy you applied as a press
curve to your separation(s) (if you used a
curve strategy)

DGC the single curve you applied as a press
curve to your separation(s) (if you used a
single curve)

• another type of SmartMark (for example a corner mark).

If your PackEdge application is linked to your Automation Engine server, your SmartMark
will automatically be saved in the correct location and will be available in Imaging Engine.

b) Then select that SmartMark in your Imaging Engine task.

The SmartMark will be added to each output file generated from your input file.

Transformations
Use the Transformations settings to rotate or distort your output relative to your input file.

1. If you want to rotate your file's contents, select the Rotation you want to apply here.

This can be:

• 0°

• 90° Counter Clockwise

• 180°

• 90° Clockwise

Any other value will give an error.
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Note:

• You can use a SmartName that resolves to 0, 90 (for 90° Counter Clockwise), 180 or
270 (for 90° Clockwise).

• You need to use a numerical value (ninety will not work).

• This is a public parameter, that you can fill in when submitting files through Shuttle.

2. If you want to apply Distortion to your file's contents:
a) Select the type of distortion to apply: No distortion, Flexo distortion or Values from

file.

You can also use a SmartName that resolves to Not, Flexo or File.

Note:  If you selected Values from file and the input file contains distortion values, you
will see these in the fields below (greyed out).

b)
If you want to apply Flexo distortion, enter the vertical  and horizontal  distortion
percentages to use.

You can enter numerical values, or insert SmartNames that resolve to numerical values
(without the % sign).

Note:

• The values should be within the 90%-110% range. If you enter a percentage outside
of this range it will be automatically adjusted to the nearest value in the range (for
example 85 will be adjusted to 90%).

However, if you use a SmartName that resolves to a percentage outside the range,
the task will end in error.

• You can enter a simple formula and it will be calculated automatically (for example
you can enter 100+2 and this will be changed to 102%). This only works with
numerical values and not with SmartNames.

PDF Objects
Use the PDF Objects settings to define:

• how to color manage RGB objects in your input file,
• what dot gain compensation to apply to your input file's images.

All parameters in this tab are public parameters, that you can fill in when submitting files
through Shuttle.

1. In Default RGB Profile, specify the profile to use if no profile is specified for a certain RGB
object in the input file. The default is srgb.icc.

You can use a SmartName that resolves to the full profile name.
2. Select what output profile you want to use when converting RGB objects to CMYK:
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• If you want to use the output profile from the input file (if there is one available), leave
Use output intent from file selected (it is selected by default).

• If you don't want to use the output profile from the input file, deselect Use output
intent from file and specify the output profile to use in Output Color Profile.

This output profile will also be used if there is none available in the input file.

The default is ISOcoated_v2_300_eci.icc.

For the Use output intent from file option, you can use a SmartName that resolves to
true (to use the file's profile) or false (to not use it).

For Output Color Profile, you can use a SmartName that resolves to the full profile name.
3. Select Use PDF transfer curves if you want to use:

• the Dot Gain Compensation curves attached to the images in your input PDF. These curves
compensate for the unwanted characteristics of the device that created the images
(scanner, digital camera...).

• the Color Correction curves added by ArtPro+ version 20 and higher. These curves
allow you to correct individual separations for color deviations on proof from the
reference proof. The correction will be applied on both the proof and the production
files.

Note:

You can only use the correction curves if the Color Correction curves option is enabled in
the global Imaging Engine configuration.

Please contact Esko Support for assistance.

You can use a SmartName that resolves to true (to use the input file's curves) or false (to
not use them).

4. If you experience issues with a font that doesn't look smooth enough at your selected
resolution, your font may have font hinting errors.

Font hinting is the rendering of the outline (vectorized) font to pixels. For certain fonts, this
rendering sometimes doesn't give a visually pleasing result, especially at low resolutions. In
the image below, the top font has font hinting errors, the bottom font doesn't.

 

 

Choose how to handle files containing font hinting errors:
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• Leave Generate an error if the job contains font hinting errors selected if you want
the task to end in error when encountering font hinting errors. You can also use a
SmartName resolving to true.

• Deselect Generate an error if the job contains font hinting errors if you want to
output your file anyway, whether it has font hinting errors or not (your task will end with
a warning). You can also use a SmartName resolving to false.

This may lead to reduced quality rendering of the text, but it will not generate incorrect
characters in your output file.

Document Inks
Use the Document Inks settings to select which separations of the input file(s) you want to RIP.

For example, you can use these settings to exclude technical and/or varnish inks from your
output.

You can choose to RIP either:

• All separations.
• A number of separations you select Manually.
• A number of separations you select by using selection criteria.

Selection criteria are rules that you define to select separations automatically for you when
the task is launched on a file.

Selecting separations manually is the easiest option, but you can only do it on a file by file basis
(when you launch the task on a single input file).

Using selection criteria is more advanced but also more powerful than selecting separations
manually, and you can do it anytime (when launching the task on one or more input files, when
using the task in a workflow, when defining ticket settings...).

Therefore, we recommend that you first try selecting separations manually when running
the task on individual files, then switch to using selection criteria to automate your workflow
further.

Tip:

To get used to working with selection criteria, try the following on a few of your files:

1. select the separations you want to output manually,
2. then change Select Inks to by using selection criteria and see which rules have been

created based on your manual selection.

For more information, see Selecting Inks Manually on page 1286 and Selecting Inks Using
Selection Criteria on page 1288.

Tip:  You can also make the ink selection parameter public so that an operator can set it
through Shuttle as needed for each job. See Selecting Inks though Shuttle on page 1291 for more
information.

Selecting Inks Manually

Note:  You can only select inks manually when you are launching the task on a (single) file, not
when you are defining a generic ticket without an input file.
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When choosing to Select Inks Manually, you will see a table containing all of your document's
inks, showing each ink's:

Ink Name

Ink Book If an ink book is not present in your color database, it will show here as
<unregistered "">.

Ink Index The Ink index is the order in which the file's inks will be printed (the ink
with ink index 1 is at the bottom of the document and will be printed
first).

If your file has several of the same ink, they will have the same ink index,
and the next ink will have the next one (for example two Cyans will both
have ink index 1, then Magenta will have ink index 2).

This means that when selecting inks for processing, both Cyans will be
selected together and handled the same way.

Tip:

To find the ink index of a file:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink has an
index of 1, the second of 2, etc.).

Note that if you reorder the inks by one of the columns (for example by
Ink name), they won't be ordered by ink index anymore. You will need to
close that dialog and reopen it to see the ink index order again.

Spot Ink Index The Spot Ink index is the order in which a spot ink will be printed (when
counting only spot inks and not process inks).

For example, if the first 4 inks of the document are CMYK, the first spot
ink will have 5 as Ink Index but 1 as Spot Ink Index.

As for the ink index, if your file has several of the same spot ink, they will
have the same spot ink index, and will be handled together when you
select them.

Ink Type This can be for example Normal, Technical, Varnish...

Printing Method If you have set a Printing Method for an ink it will be shown here (this
can be for example Offset, Gravure, Flexo... or any custom printing
method you configured).

See the Automation Engine documentation for more information about
printing methods.

Select the ink(s) you want to RIP, or select the toggle in the table header to select/deselect all
inks.
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Selecting Inks Using Selection Criteria
If you don't want to select inks manually every time, you can define some rules to automatically
select certain inks in your input file(s).

You can do this:

• either when running the task on one or more files, or when creating a task ticket to use
later,

• by choosing to Select Inks by using selection criteria in the Document Inks settings.

How Does it Work?
You select the inks to be output by checking a combination of criteria:

1. You define what to check. You can check any of the following ink characteristics in your
criteria:

Ink name

Ink book

Ink index The Ink index is the order in which the file's inks will be printed (the
ink with ink index 1 is at the bottom of the document and will be
printed first).

To find the ink index of a file:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink has an
index of 1, the second of 2, etc.).

Note that if you reorder the inks by one of the columns (for example
by Ink name), they won't be ordered by ink index anymore. You will
need to close that dialog and reopen it to see the ink index order
again.

Spot ink
index

The Spot ink index is the order in which a spot ink will be printed
(when counting only spot inks and not process inks).

For example, if the first 4 inks of the document are CMYK, the first
spot ink will have 5 as Ink index but 1 as Spot ink index.

Ink type This can be for example Normal, Technical, Varnish...

Printing
method

If you have set a Printing method for an ink it will be shown here
(this can be for example Offset, Gravure, Flexo... or any custom
printing method you configured).

See the Automation Engine documentation for more information
about printing methods.
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For example, you can check whether the Ink book is process, whether the Ink name is
yellow...

You can use as many criteria as you want.
2. You define how to combine your criteria into a rule. For example:

• If you want to output only process yellow, you should check for inks that match both of
the criteria:

Ink book is process
Ink name is yellow

• If you want to output both all process inks and all yellow inks, you should check for inks
that match either of the criteria:

Ink book is process
Ink name is yellow

• If you don't want to output any process inks or any yellow inks, you should check for inks
that match neither of the criteria:

Ink book is process
Ink name is yellow

How Do I Build Rules?
Build your rules the following way:

1. Choose how to combine the criteria in your rule:

• Select All of the following are true if you want to only select the inks that match all of
the criteria you define.

• Select Any of the following are true if you want to select all the inks that match at least
one of the criteria you define.

• Select None of the following are true if you want to only select the inks that match
none of the criteria you define.

2. Define your first selection criterion.

You can select an ink based on its:

• Ink name: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink book: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink index: you can define if it equals/is less than/is greater than the number you
enter, or is is between the two numbers you enter (in this case the ink indexes you enter
as boundaries are also selected).

• Spot ink index: you can define if it equals/is less than/is greater than the number you
enter, or is is between the two numbers you enter (in this case the spot ink indexes you
enter as boundaries are also selected).

• Ink type: you can define if it is a piece of text (alphanumerical characters).
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• Printing method: you can define if it is a piece of text (alphanumerical characters).

For example, you could use: to:

All of the following are true

Ink book is designer

select all inks from the "designer" ink
book

None of the following are true

Ink name is crease

exclude an ink called "crease"

None of the following are true

Ink type is Technical

Ink type is Varnish

exclude all technical and all varnish inks

Tip:

• You can enter several values to check for: just use a semicolon (;) between them.

For example, to check for both inks called Cyan and inks called Magenta, choose Ink
name is and enter Cyan;Magenta.

• When launching the task on a file, you can also click  to select one or more of the Ink
names/Ink books/Ink types/Printing methods used in your input file(s).

A criterion will automatically be created based on your selection.

3. Click + to add more criteria and define them.

To remove a criterion, click - next to it.

Tip:  If you are launching the task on a single input file, you will see a table listing the Selected
document inks, and another table with the Document inks that are not selected under the
rules you defined.

Attention:  If no ink is selected, you cannot launch the task.

Switching How You Select Inks
You can switch between the two methods of selecting inks (manually and using selection
criteria), and this will keep the same inks selected.

Switching from Selecting Inks Manually to Selecting Inks Using Selection
Criteria

When switching from selecting inks manually to selecting inks using selection criteria, the task
will translate your manual ink selection into rules, so that the same inks are selected (you can
see them in the Selected document inks table).

The rules you get are based on the characteristics of the inks you selected.

For example, if you selected all the process colors but no spot color in your file, for an offset
job, you will get the following rule:
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All of the following are true

Ink name is Cyan;Magenta;Yellow;Black
Ink book is process
Ink type is Normal
Printing method is Offset

Note:

If you...

• first selected inks using selection criteria,
• then switched to manual selection without changing the selection,
• then switched back to selection criteria,

... then your rules will be kept.

If you did change the selection in manual mode, the task will automatically generate new rules.

Switching from Selecting Inks Using Selection Criteria to Selecting Inks
Manually

When switching from selecting inks using selection criteria to selecting inks manually, all the
inks selected by the rules you defined (the inks in the Selected document inks table) become
selected manually.

Note:  You can only switch to selecting inks manually when you are launching the task on a
(single) file.

Selecting Inks though Shuttle
If you want to be able to decide which inks to RIP when submitting your input file through
Shuttle, do the following:

In Your Imaging Engine Ticket
1. To make the ink selection a public parameter, you can either:

• Right-click Select Inks and choose Make Parameter Public.

• If you (are currently launching the ticket on a file and) have chosen to select inks manually,
right-click the preview table under Select Inks and choose Make Parameter Public.
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• If you have chosen to use selection criteria, right-click the rules builder under Select Inks
and choose Make Parameter Public.

 

 

Note:  You will not be able to create rules using Shuttle, you will only be able to select
inks manually.

• Go to Advanced > Manage Public Parameters..., find the Ink Selection parameter at
the bottom of the list, and drag it to the right hand side.

 

 
2. By default, the public parameter that appears in Shuttle will be called Ink Selection. You

can change its name by:

• right-clicking one of the elements mentioned above, selecting Modify Public Parameter
and entering a new name,

• if you are using the Manage Public Parameters window, entering the new name in
Prompt as.

3. Make sure your ticket is also Public.

In Shuttle
The ink selection parameter may look a bit different depending on which Shuttle you are using
(the Shuttle standalone application or a Shuttle plug-in in an Editor application).

• In the Shuttle standalone, the ink selection parameter will look like this:
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The table shows a preview of all inks in your input file, with their characteristics.

• To RIP all inks from your input file, either leave all inks selected in the preview table, or
select All inks at the top (this will hide the preview table).

• To only RIP certain inks, make sure All inks is not selected, and deselect the input inks
that you don't want to RIP.

• In ArtPro+ for example, the ink selection parameter will look like this:
 

 

By default, all the inks from your input file will be RIP'ed, but you can remove any ink you

don't want to RIP using the  button.

Output
Use the Output settings to define what type of output you want and where to output it.

You can set these through public parameters or using SmartNames.

1. Enter your output File Name and output Folder.
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Note:

• You can use Imaging-specific SmartNames for the File Name.

By default, it is set to:

• [File]_[ShortInk] for single page input files (which gives output file names like
Myfile_C.tif),

• [File]_p[Page]_[ShortInk] for multi-page input files (which gives output file
names like Myfile_p1_C.tif).

• The File Name and Folder can contain special characters (except \ / : * ? < > " |).

• The whole path to the output file (including the container, Folder and File Name) can be
up to 255 characters.

• You can set a local or remote URL for the output Folder, but it must be an absolute path.

• If your output folder doesn't exist yet, the task will create it if the location you request is
valid (you should place this folder on an Automation Engine container accessible by your
Automation Engine user).

If the output folder creation fails, please check the task log for the full list of conditions
and adapt your output folder path accordingly.

2. Define what to do if a file of the same name already exists in your output folder:
a) Click Set Overwrite Policy...
b) Choose what to do If files exist already. You can either:

• Extend the file name if you want to keep the existing output file and give the new
output file a different name. In this case, your new output file name consists of:

• the Output file name (the File Name you set earlier) - which is what the file
would be called if no file with the same name existed,

• a custom suffix that you can define using plain text and/or SmartNames (by
default, this is _c, for "copy"),

• an automatic suffix made of the three last digits of the task ID,

Tip:

To see the task ID of your tasks:

1. Go to the Pilot's Tasks pane (in the Files or Tasks view).
2. Go to View > Select Columns in 'Tasks'...
3. In the Columns dialog, select Task ID in the Available columns list and click 

to move it to the Show these columns: list.
4. Click OK.
5. You now have a Task ID column in the Tasks pane, listing the task ID of all the

tasks.
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• the file extension.

For example, you are working with a CMYK input file called file.pdf and you have
left the tasks' output File Name to its default value (the SmartName [File]).

The first TIFF files you generate will be called:

• file_C.tif

• file_M.tif

• file_Y.tif

• file_K.tif

If you generate output from this input file again, with the task 3669, and you have set
the overwrite policy to Extend the file name with the default Output File Name + _c
+ ID name, the new output files will be called:

• file_C_c669.tif

• file_M_c669.tif

• file_Y_c669.tif

• file_K_c669.tif

Tip:

• If you are working with the Bitmap Viewer, we recommend you keep the default
overwrite policy (Output File Name + _c + ID), which is compatible with the
Bitmap Viewer.

• If you are not, you can define the custom suffix as you wish. For example, you
could use date and time SmartNames.

• Overwrite the existing file(s).

• End the task in error.

Note:  If you use a SmartName to set this, it must resolve to extend or 0 (for Extend the
file name), overwrite or 1 (for Overwrite), or error or 2 (for End the task in error).

c) Click Set.
3. Select the output File Type you want. This can be a TIFF File or a PDF File.

See File Formats on page 1135 for more information.
4. For both TIFF and PDF, you can choose to output either composite or separated files.

• To output Composite files, select 1 File Per Page in File Assembly (or use a SmartName
that resolves to FilePerPage).

The Output Type is then automatically set to Composite.
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• To output Separated files, select 1 File Per Separation in File Assembly (or use a
SmartName that resolves to FilePerSeparation).

The Output Type is then automatically set to Separate.

Note:

• Every output file that Imaging Engine generates contains XMP metadata (information
about file creation, separations, calibration curves, etc.).

You can view this XMP metadata by selecting your output file in the Automation Engine

Pilot's Files view and clicking .

For more information about XMP metadata, see the XMP Metadata white paper.

• TIFF files produced by Imaging Engine are fully compatible with Esko's Bitmap Viewer and
DotSpy.

• Separated files are shown in the correct separation in the Bitmap Viewer (as it can read
the separation information in the XMP data) and in grayscale in other viewers.

When proofing them, they are also in the correct separation (for example the proofer
proofs the Magenta file using the Magenta cartridge).

5. Choose the Compression to use for your output files.

• For TIFF output, you can choose between lossless and lossy compression. Lossless
compression preserves all the detail in the file, while lossy compression removes some
detail.

We recommend you use lossless compression for the final output (for files you will
send to a third party RIP for example), and lossy compression only for previews and
thumbnails.

For both compression types (lossless and lossy), you should then choose a compression
method, based on the compression speed and the compressed file size. Typically, faster
compression methods compress the file less, so the output file is bigger (note that TIFF
files can be a maximum of 4GB).

If you want
lossless
compression...

choose either:

• PackBits, a fast lossless compression method for
graphic files.

Tip:  Use this if you want fast output and file size is
not too much of an issue.

• LZW, a lossless compression method for graphic files
and other files.

Tip:  This compression method works best for files
with large images.
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If you want lossy
compression...

choose one of the JPEG compression methods (those
are more suitable for images like photographs and
natural artwork than sharp edged or flat color images
like line art or lettering, as JPEG compression tends to
introduce noise into solid color areas).

They are sorted from very high compression, which
reduces the file size a lot but loses a lot of detail (JPEG
Limited Quality), to very low compression, which
doesn't lose much detail but doesn't reduce the file size
much (JPEG Extreme Quality).

• For PDF output, all available compression methods are lossless.

You should choose a compression method based on the compression speed and the
compressed file size. Typically, faster compression methods compress the file less, so the
output file is bigger (note that PDF files can be a maximum of 12GB).

Choose either:

• PackBits (see above).

• Flate, a lossless compression method similar to zipping, based on the LZW
compression.

Tip:  This compression method works best for images with large single color areas or
repeating patterns.

• JPEG 2000, a compression method based on JPEG and suitable for large images (the
version of JPEG 2000 used by Imaging Engine is lossless).

Attention:

• When using a SmartName to set the output file's Compression, it must resolve to
one of the following (case insensitive):

• PackBits, LZW, JPEGLimited, JPEGLow, JPEGStandardLow, JPEGStandard,
JPEGStandardHigh, JPEGHigh, or JPEGExtreme for TIFF output,

• PackBits, Flate or JPEG2000 for PDF output.

Setting any other value, or an unsupported compression for the file type you
chose, will make the task error (with the message Unsupported combination of
output type and compression in the log).

• If you have already set the Compression but decide to change the output File
Type, by default the task will either:

• keep the same Compression (if it is supported for the new output File Type),

• or (if it isn't), set it to the first Compression available for this File Type.

You can still change it as desired.

6. Select Make all output files ready for viewing if:
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• you are generating separated TIFF files,
• you are doing quality control using the Automation Engine Viewer,

• you want to be able to open your output files in the Automation Engine Viewer without
needing to use a Prepare for Viewer task.

If you don't use this option, you can still use a Prepare for Viewer task later to be able to
view your output files in the Automation Engine Viewer. However, this will take more time
than already preparing the files for viewing in your Imaging Engine task.

As with the Prepare for Viewer task, you will see View (Prepared) next to the prepared
files in the Pilot, and you will be able to zoom in to the files up to their full resolution.

Note:

• If you are generating separated PDF files, you can view them in the Automation Engine
Viewer without preparation.

• You can also view separated TIFF files in the Bitmap Viewer without preparation.

• If you use the Make all output files ready for viewing option together with composite
output files (via SmartNames or Public Parameters), the task will error out.

7. Set the Resolution of your output files.

Note:

• The Resolution unit is taken from the general Automation Engine Preferences.

• You can enter values from 1 to 25400 ppi (or equivalent in your unit). SmartNames must
also resolve to a value in that range.

• Values in another unit than the one from the general Preferences will be recalculated,
and values like 300ppi + 500ppm will be calculated correctly.

8. If you experience problems with jagged edges, for example in small text, you can set an
Anti-aliasing factor to smooth those edges.

In the example below, you can see the difference between output without anti-aliasing (on
the left), and with anti-aliasing applied (on the right).
 

 

You can adjust the amount of anti-aliasing applied by choosing a factor of either 2, 3 or 4
(note that using a higher anti-aliasing factor may slow down processing).
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You can also set this with a SmartName resolving to None (if you don't need anti-aliasing), or
to the anti-aliasing factor you want (for example 2).

Attention:  Because anti-aliasing changes the output sampling to smooth the jagged
edges, you cannot resample your images (with the Image Resampling option) if you
use anti-aliasing.

9. If your input file contains images, the images' pixels may not map exactly to output pixels if:

• the images' resolution is different from the output resolution you chose,
• scaling and rotation effects change the size and placement of the images' pixels.

In such cases, you need to resample these images to be able to output them at the same
resolution as the rest of the file.

In the Image Resampling option, choose the resampling method you want to use (you will
have to make a trade-off between processing time and image quality).

• Choose Auto Resampling to upsample the images to an automatically calculated
resolution (generally half or a third of the output resolution) before smoothing them.

When using this, images are a lot less pixellated and fuzzy.

 

 

This method is quite slow but gives images of a good quality, so it is recommended in
most cases.

You can also use a SmartName resolving to ResampleAuto.
• Choose Full Resampling to upsample the images to the full output resolution.

This is the slowest method but gives the highest quality images (not pixellated and only
slightly fuzzy).
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Use this if Auto Resampling doesn't give you the results you want.

Attention:

Resampling to full resolution can require significant amounts of memory when
the output resolution is high (especially from 4000 dpi).

If you want to do this, we recommend that you have at least 8GB of RAM
available for each worker (see the installation documentation).

You can also use a SmartName resolving to ResampleFull.
• Choose None if you don't want to resample your input file's images.

Note:

If you upgraded from a previous version of Imaging Engine, in some cases you may have
saved a ticket with a less optimal resampling method (From File or PDF Interpolation) in
your older version. These methods are deprecated from Imaging Engine 18.1.1.

When processing a file with such a ticket, Imaging Engine will use the Auto Resampling
method instead. You will get a warning about this.

10.If you are working with Gravure, Imaging Engine can help you optimize the processing time
of your engraving machine by indicating the empty spaces in your output separations, so
that your engraving machine can skip them.

Note:  This is only possible when working with separated output files (when you have set
File Assembly to 1 File Per Separation).
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You can do this the following way:

a) Select Write skip areas to file (or use a SmartName resolving to true).
b) In Threshold, enter the number of lines that need to be empty before an area is skipped

(each line being 1 pixel wide).

You can select any (integer) number that is at least 1, but we recommend you use a large
enough number so that it makes sense to lift the engraving head for that amount of
empty space (the default threshold is 240 empty lines).

You can also use a SmartName resolving to your desired number of lines.

In the example below, the whole area at the bottom of the Cyan separation can be
skipped.

 

 
c) The task outputs a skip area file (.svs) per output separation (whether you output to

TIFF or PDF), even for separations that have no empty areas (so the engraving machine
will know it cannot skip anything in those separations).

Those .svs are generated in the same output folder as your output separations. If you
are using the task in a workflow, the task has a separate output pin for the .svs files.

d) When sending your output separations to your engraving machine software, make sure
you also send the .svs files.

Separations
Use the Separations settings to define the dot gain compensation to apply to the separations
that will be output (the separations you selected in the Document Inks tab).

You can:

• apply general curves to all output separations,
• apply specific curves to certain separations.

1. If desired, you can apply a Plate Curve to all output separations.
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A plate curve is used to compensate for the dot growth or dot reduction (for example in
Digital Flexo) happening when making the plate. You can choose either:

• None if you don't want to apply any plate curve.
• Single Curve if you want to apply one curve for all separations.

In this case, select the .dgc curve to apply at right. You can choose from a list of curves
available in the curves database.

• Curve Strategy if you want to apply a curve strategy (a file created in Curve Pilot that
contains several curves to apply in different cases: it can have different curves per
separation, dot shape, ruling, for continuous tone images or line work...).

In this case, select the .icpro curve strategy or legacy .scrdgc screen-based DGC file
to apply at right.

You can choose from a list of curve strategies available in the curves database.

For more information, see:

• Dot Gain Compensation Curves on page 1132,

• DGC Curve Strategies on page 1132,

• The Curves Database on page 1135.

Note:

• You can use SmartNames resolving to the exact name of the Single Curve or Curve
Strategy (including the extension).

• This will set the Plate Curve type to Unknown in the ticket, but will resolve to the correct
curve type if the SmartNames are correct.

2. If desired, apply a Press Curve to all output separations.

This curve is used to compensate for the dot gain on press. You can choose either:

• None if you don't want to apply any press curve,
• Single Curve if you want to apply one curve for all separations (you can still define

exceptions for some of the separations later).

In this case, select the .dgc curve to apply at right. You can choose from a list of curves
available in the curves database.

• Curve Strategy if you want to apply a curve strategy (a file created in Curve Pilot that
contains several curves to apply in different cases: it can have different curves per
separation, dot shape, ruling, for continuous tone images or line work...).

In this case, select the curve strategy to apply at right (you can select a .icpro curve
strategy, a .prsync PressSync curve set or a legacy .scrdgc screen-based DGC file).

You can choose from a list of curve strategies available in the curves database.
• PressSync if you want to apply a PressSync curve (a predefined curve applicable to your

printing environment).

In this case, select the letter and number of the PressSync curve.

For more information, see:
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• Dot Gain Compensation Curves on page 1132,

• DGC Curve Strategies on page 1132,

• PressSync Curves on page 1133,

• PressSync Curve Sets on page 1135,

• The Curves Database on page 1135.

Note:

• You can use SmartNames resolving to the exact name of the Single Curve, Curve
Strategy (including the extension) or PressSync curve.

• This will set the Press Curve type to Unknown in the ticket, but will resolve to the correct
curve type if the SmartNames are correct.

3. If desired, you can also apply a specific press curve to a specific separation (when launching
the task on a single file).

To do this, click that separation's Press Curve in the table and select the curve you want to
use instead.

Your separation-specific curve is shown in italics.

If you want to go back to the previous curve, right-click the curve you just set and select
Clear Custom Value.

4. If you notice a specific problem in your job, and you want to compensate for it without
changing your main curves, you can apply some corrections (to all separations).

See Corrections on page 1304.
5. If you are setting up a task ticket to use in a workflow for example, you can create a rule to

always apply a specific press curve to a specific separation.

You can do this if for example you have a curve you want to use for Yellow in all your jobs,
or to use specific curves for specific spot colors...

See Exceptions to know how to create rules.

Tip:

Applying a specific press curve to a specific separation manually (in the table) also
automatically creates a rule. So if you are not used to working with rules yet, you can:

1. Take a file containing the separations you usually work with, and open the task on it.
2. In the Separations table, set your desired press curves on your separations manually.
3. The task automatically creates the corresponding rules in the Exceptions tab (if you

change your press curves again, these rules will be updated).
4. Save your ticket. You can now use it on other files that need the same press curves for

those separations.
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Corrections
If you notice a specific dot gain related problem in your job, you can use the Corrections
settings to compensate for that problem without changing your general dot gain compensation
settings (that you may also use for other jobs).

You can:

• apply a correction curve,
• correct dot gain problems in the highlights,
• correct dot gain problems in the shadows.

Note:

The corrections you define here are applied to all output separations. If you need to apply a
different correction to a specific separation, we recommend you create a curve strategy in
Curve Pilot for this purpose.

When doing this, the tools in Curve Pilot help you keep your gray balance in check when
changing the dot gain compensation for specific separations.

Please see the Curve Pilot documentation for more information.

1. If needed, select a Correction Curve to apply to all the separations that will be output.

You can select any single curve (.dgc) available in your curves database. You can also use
SmartNames resolving to the exact .dgc file name (including the extension).

2. Choose when to Apply the Correction Curve:

• Before Press Curve
• Between Press & Plate Curve
• After Plate Curve
• you can also use a SmartName resolving to BeforePress, BetweenPressAndPlate or

AfterPlate.

The order in which you apply your dot gain compensation curves makes a difference to your
final result. In the example below, you can see what happens to the 50% value depending
on the order of the curves:

• When applying the correction curve first (Before Press Curve):

1. The Correction Curve changes the initial 50% value to 60%.
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output

 input

2. For that 60% value, the Press Curve gives 48%.

output

 input

3. For that 48% value, the Plate Curve gives a final value of 53%.
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output

 input

• When applying the correction curve Between Press & Plate Curve:

1. The Press Curve changes the initial 50% value to 40%.

output

 input

2. For that 40% value, the Correction Curve gives 49%.
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output

 input

3. For that 49% value, the Plate Curve gives a final value of 54%.

output

 input

• When applying the correction curve last (After Plate Curve):

1. The Press Curve changes the initial 50% value to 40%.
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output

 input

2. For that 40% value, the Plate Curve gives 46%.

output

 input

3. For that 46% value, the Correction Curve gives a final value of 56%.
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output

 input

3. After your curves have been applied, you can also use the Range Correction to correct dot
gain problems in the highlights and/or shadows.

• Select Minimum Correction if you only want to correct the highlights.
• Select Maximum Correction if you only want to correct the shadows.
• Select Minimum & Maximum Correction if you want to correct both highlights and

shadows.
• You can also use a SmartName resolving to Minimum, Maximum or MinimumAndMaximum.

Note:

• If you have already applied a highlights and/or shadows correction in your plate curve or
press curve you don't need to make that correction again here.

• Correcting your highlights and/or shadows does not affect your mid-tones. If you want to
correct your mid-tones, you can use a correction curve.

4. If you have problems with the highlights (for example if they are grainy or print unevenly),
you can do the following to correct them:
a) In Minimum Dot, enter the smallest percentage that you know won't give you any

printing problem. In the unscreened files, Imaging Engine will not generate percentages
any smaller than what you enter here.
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Note:

• The Minimum Dot must be within the 0%-30% range. If you enter a percentage
outside of this range it will be automatically adjusted to the nearest value in the range
(for example 32 will be adjusted to 30%).

• When using a SmartName, it must resolve to a number between 0 and 30 (without
the % sign). If you use a SmartName that resolves to a percentage outside the range,
the task will end in error.

• You can enter a simple formula and it will be calculated automatically (for example
you can enter 10+2 and this will be changed to 12%). This only works with numerical
values and not with SmartNames.

b) In How to Handle Minimum Job Tones, enter the range of input file tones that typically
gives you problems on output (for example, you may find that tones between 0% and 1%
in your input file give you grainy images on output).

Note:

• The Minimum Job Tones range always starts at 0% and can go up to 10%. If you enter
a percentage outside of this range it will be automatically adjusted to the nearest
value in the range.

• When using a SmartName, it must resolve to a number between 0 and 10 (without
the % sign). If you use a SmartName that resolves to a percentage outside the range,
the task will end in error.

• You can enter a simple formula and it will be calculated automatically. This only works
with numerical values and not with SmartNames.

c) Decide how to treat this range of problematic tones to prevent output problems. You can
either:

• Not print those small percentages (select Drop To 0%).

In this case, anything in that range will be rendered at 0% (so removed from the
output), and the first percentage above that will become the Minimum Dot.

In the example below, the Minimum Job Tones are 0% to 5% and the Minimum Dot
is 10%.

If you select Drop To 0%, the 0% to 5% range in your input file becomes 0% in the
output, and the first percentage after that (5.01%) becomes 10% (the Minimum Dot).

Higher percentages follow the dot gain compensation you applied (the combination
of the plate curve, press curve and correction curve you have set). Note that the
transition between your highlights correction and the combined curve is smoothed to
give you better printing results.
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• Increase those small percentages so they meet the threshold to become your
Minimum Dot on output (select Hold To Minimum Dot).

In this case, anything in that range (except 0%) will be rendered at the percentage you
entered as Minimum Dot.

With the same example, if you select Hold To Minimum Dot, 0% will stay 0%, and the
0.01% to 5% range in your input file will become 10% in the output (the Minimum
Dot).

Higher percentages follow the dot gain compensation you applied (the combination
of the plate curve, press curve and correction curve you have set). Note that the
transition between your highlights correction and the combined curve is smoothed to
give you better printing results.
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5. If you have problems with the shadows (for example you lose detail in the darkest areas),
you can do the following to correct them:
a) In Maximum Dot, enter the highest percentage that you know you can safely print for

a good result in the shadows. In the unscreened files, Imaging Engine will not generate
percentages any higher than what you enter here.

Note:

• The Maximum Dot must be within the 70%-100% range. If you enter a percentage
outside of this range it will be automatically adjusted to the nearest value in the range
(for example 68 will be adjusted to 70%).

• When using a SmartName, it must resolve to a number between 70 and 100 (without
the % sign). If you use a SmartName that resolves to a percentage outside the range,
the task will end in error.

• You can enter a simple formula and it will be calculated automatically (for example
you can enter 70+5 and this will be changed to 75%). This only works with numerical
values and not with SmartNames.

b) In How to Handle Maximum Job Tones, enter the range of input file tones that typically
gives you problems on output (for example, you may find that tones between 97% and
100% don't show enough details on output).

Note:

• The Maximum Job Tones range can start from 90% and always go up to 100%. If
you enter a percentage outside of this range it will be automatically adjusted to the
nearest value in the range.

• When using a SmartName, it must resolve to a number between 90 and 100 (without
the % sign). If you use a SmartName that resolves to a percentage outside the range,
the task will end in error.

• You can enter a simple formula and it will be calculated automatically. This only works
with numerical values and not with SmartNames.

c) Decide how to treat this range of problematic tones to prevent output problems. You can
either:

• Make those large percentages solid (select Raise To 100%).

In this case, anything in that range will be rendered at 100%, and the first percentage
below that range will become the Maximum Dot.

In the example below, the Maximum Job Tones are 95% to 100% and the Maximum
Dot is 90%.

If you select Raise To 100%, the 95% to 100% range in your input file becomes
100% in the output, and the first percentage below that (94.99%) becomes 90% (the
Maximum Dot).

Lower percentages follow the dot gain compensation you applied (the combination
of the plate curve, press curve and correction curve you have set). Note that the
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transition between the combined curve and your shadows correction is smoothed to
give you better printing results.

 

 

• Decrease those large percentages so they become your Maximum Dot on output
(select Hold To Maximum Dot).

In this case, anything in that range (including 100%) will be rendered at the
percentage you entered as Maximum Dot.

With the same example, if you select Hold To Maximum Dot, the 95% to 100% range
in your input file will become 90% in the output (the Maximum Dot).

Lower percentages follow the dot gain compensation you applied (the combination
of the plate curve, press curve and correction curve you have set). Note that the
transition between the combined curve and your shadows correction is smoothed to
give you better printing results.
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6. You can see the number of corrections you applied next to the Corrections tab at left.

For example, if you apply a Correction Curve, a Minimum Correction (on the highlights),
and a Maximum Correction (on the shadows), you will see Corrections (3).

Exceptions
Use the Exceptions tab if you want to always apply specific press curves to certain separations
(for example spot colors).

The press curves you select in this tab will overrule your general press curve for those
separations.

You can do this anytime (when launching the task on one or more input files, when defining
ticket settings, when setting up a workflow...).

You do this by setting up rules. This works as follows:

• You create a rule for each separation or set of separations that need a specific press curve.
• Within each rule:

1. You select the separation(s) you want to apply a specific curve to. You do this by setting
criteria that a separation has to match to be selected.

For example if you want to select all process inks, you can set that the ink book must be
process for the inks to be selected.

You can use the following ink characteristics in your criteria:

Ink name

Ink book

Ink index The Ink index is the order in which the file's inks will be printed
(the ink with ink index 1 is at the bottom of the document and
will be printed first).

To find the ink index of a file:
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1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink
has an index of 1, the second of 2, etc.).

Note that if you reorder the inks by one of the columns (for
example by Ink name), they won't be ordered by ink index
anymore. You will need to close that dialog and reopen it to see
the ink index order again.

Spot ink
index

The Spot ink index is the order in which a spot ink will be
printed (when counting only spot inks and not process inks).

For example, if the first 4 inks of the document are CMYK, the
first spot ink will have 5 as Ink index but 1 as Spot ink index.

Ink type This can be for example Normal, Technical, Varnish...

Printing
method

If you have set a Printing method for an ink it will be shown
here (this can be for example Offset, Gravure, Flexo... or any
custom printing method you configured).

See the Automation Engine documentation for more
information about printing methods.

2. You choose the press curve to apply to the selected separation(s).

• If you have several rules, you can reorder them in order of priority (the top one is applied
first).

In practice, you need to do the following in the Exceptions tab:

1. Click + at the bottom of the table.
2. In the Rules Properties dialog, enter a Rule Name.
3. Under If separation matches, define one or more criteria to select your desired

separation(s).

You can use the following elements:

• Ink name: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink book: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink index: you can define if it equals/is less than/is greater than the number you
enter, or is is between the two numbers you enter (in this case the ink indexes you enter
as boundaries are also selected).

• Spot ink index: you can define if it equals/is less than/is greater than the number you
enter, or is is between the two numbers you enter (in this case the spot ink indexes you
enter as boundaries are also selected).

• Ink type: you can define if it is a piece of text (alphanumerical characters).
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• Printing method: you can define if it is a piece of text (alphanumerical characters).

Tip:

• You can enter several values to check for: just use a semicolon (;) between them.

For example, to check for both inks called Cyan and inks called Magenta, choose Ink
name is and enter Cyan;Magenta.

• Click + to add more criteria. You can also add sub-criteria by holding Alt while clicking +.

For example, if you want to make a rule for Process Yellow, you can use:

All of the following are true:
Ink name is Yellow
Ink book is Process

• When launching the task on a file, you can also click  to select one or more of the Ink
names/Ink books/Ink types/Printing methods used in your input file(s).

A criterion will automatically be created based on your selection.

4. Select Press Curve and choose the press curve to use for the selected separation(s).
5. Click Add.

You can see your rule and the Press Curve that will be applied to your selected
separation(s) in the Exceptions tab table.

Tip:  You can double-click your rule if you still want to edit it.

Note:  If you have defined specific press curves for certain separations manually (when
launching the task on a single file), you can see that these curves have been automatically
added as rules in the Exceptions tab (and shown in italics).

6. Repeat steps 1 to 5 to define more rules if desired.

If you want to remove a rule, select it and click Remove.

You can see the number of rules defined next to the Exceptions tab at left.
7. If desired, you can reorder your rules (they are applied from top to bottom). To do this,

select a rule and click Move Up or Move Down (or drag it up or down).
8. When launching the task on a single file, you can see the file's separations and the press

curves that will be applied to them in a table (make sure to leave the Preview option
selected).

This is the same table as at the bottom of the Separations tab. It includes:

• the curves you have defined for all separations,

• the curves you have defined for specific separations,

• the curves defined by your exception rules.

As in the Separations tab, you can use this table to define specific press curves for certain
separations.
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To do this, click that separation's Press Curve in the table and select the curve you want to
use instead.

Your separation-specific curve is shown in italics.

If you want to go back to the previous curve, right-click the curve you just set and select
Clear Custom Value.

Note:

When launching your Imaging Engine ticket on a file from Automation Engine Shuttle, you
cannot see the exceptions defined in the ticket (Shuttle always displays the parameter values
found in the input file).

However, if you modify some public parameter values in Shuttle then launch the ticket,
when you go to back to the Automation Engine Pilot and open the ticket, you will see all your
modified parameters saved as exceptions.

Summary
This shows a summary of all the settings you defined in the ticket.

• To show the settings from a tab, click + (on PC) or  (on Mac) beside the tab name in the
right pane.

Click Expand All to show the settings from all tabs.
• To hide the settings from a tab, click - (on PC) or  (on Mac) beside the tab name in the right

pane.

Click Collapse All to hide the settings from all tabs.

16.6.6.  Calculate Ink Key Settings (CIP3)

Use this task to generate ink distribution data for the files you want to send to your offset press.

If you send this data to the press along with your press-ready RIP'ed files, the press can
automatically calculate the amount of ink needed for each separation of your RIP'ed files,
without needing manual adjustments from the press operator.

In the example below, after the prepress is done, your file is both:

• RIP'ed by the Image to Screened Separations task to produce your press-ready files, which are
then copied to the platesetter queue,

• RIP'ed by the Calculate Ink Key Settings (CIP3) task to produce the ink distribution data,
which is then sent to the press room.
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Task Output
When sending a file to the Calculate Ink Key Settings (CIP3) task, it generates its ink
distribution data in the form of one or more (unscreened) CIP3 file(s), in the .ppf format.

This is a press standard format which can be used with many types of press (for example
Heidelberg, Man Roland, Creo, Komori...).

A CIP3 file contains:

• a low resolution version of the part of the input file it corresponds to (you can output a CIP3
file per separation, per page, per side of a two-sided file...),

• the ink distribution for that part of the file (an overview of how much of which separation is
used in which area of the file).

For example, for the following single page CMY input file:

 

 

... the task can generate a Cyan, a Magenta and a Yellow .ppf file, indicating where the ink
needs to be.
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Task Parameters
In the Device field, select the imaging device that you configured.

Then use the tabs at left to show more settings to fill in. See:

• General on page 1320,

• Transformations on page 1322,

• PDF Objects on page 1323,

• Document Inks on page 1324,

• Sizes and Offsets on page 1332,

• Production Data on page 1334,

• Output on page 1335,

• Summary on page 1339.

General
1. Define what Page Box of the input PDF you want to RIP.

You can either select Media Box, Trim Box, or insert a SmartName  that must resolve to
either media or trim.

After selecting your file's page box you will see its dimensions under the Page Box option.
2. If your input file is a multi-page PDF, select which Pages you want to RIP:

a) First select All pages, Odd pages only or Even pages only in the Pages option.

You can also insert a SmartName resolving to either All, Even or Odd.
b) Then you can refine your selection by entering page numbers or a Page Range.
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You can separate page numbers by a comma, or use a dash to indicate a page range (for
example 3,6-9). You can also use a SmartName resolving to page numbers and/or page
ranges using this same format.

Note:

• Page numbers are always physical pages. If your document starts with page 5, you
should not use 5 but 1 to get the first page.

• If you enter page numbers that are not part of your document, they will be excluded
from the output (all the other valid pages will be RIP'ed).

• If you enter the same page(s) more than once (for example 1,1-2), it/they will only be
output once.

• Pages are RIP'ed in the order of the document (entering 5-1 will be automatically
changed to 1-5).

3. If you want to invert your output so it is compatible with the output device or software

system that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to
invert the output), or to 0 or false (to leave the output as it is).

4. If you want to mirror your output so it is compatible with the output device or software

system that will process it, click .

You can also click  or Edit... to insert a SmartName that must resolve to 1 or true (to
mirror the output), or to 0 or false (to leave the output as it is).

5. If you want to add a SmartMark to your output file(s), select it in the SmartMark list, or use
a SmartName that will resolve to the SmartMark name.

A SmartMark is a mark whose content is variable, so you can make it display information
about that specific job. For example, you can include some of the parameters used during
RIP'ing in your output file(s) by using a SmartMark.

You need to:

a) First create the SmartMark you want to use in PackEdge (see the SmartMarks section in
the PackEdge manual for details).

You can create either:

• a SmartMark with RIP-specific parameters,

Use this SmartMark
parameter in
PackEdge:

to display this value from the Imaging
Engine parameters:

Device the imaging device you used

Image whether you inverted your output

Emulsion whether you mirrored your output
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Use this SmartMark
parameter in
PackEdge:

to display this value from the Imaging
Engine parameters:

V Distortion the vertical distortion you applied to your
output file(s)

H Distortion the horizontal distortion you applied to
your output file(s)

Resolution the resolution of your output file(s)

• another type of SmartMark (for example a corner mark).

If your PackEdge application is linked to your Automation Engine server, your SmartMark
will automatically be saved in the correct location and will be available in Imaging Engine.

b) Then select that SmartMark in your Imaging Engine task.

The SmartMark will be added to each output file generated from your input file.

Transformations
Use the Transformations settings to rotate or distort your output relative to your input file.

1. If you want to rotate your file's contents, select the Rotation you want to apply here.

This can be:

• 0°

• 90° Counter Clockwise

• 180°

• 90° Clockwise

Any other value will give an error.

Note:

• You can use a SmartName that resolves to 0, 90 (for 90° Counter Clockwise), 180 or
270 (for 90° Clockwise).

• You need to use a numerical value (ninety will not work).

• This is a public parameter, that you can fill in when submitting files through Shuttle.

2. If you want to apply Distortion to your file's contents:
a) Select the type of distortion to apply: No distortion, Flexo distortion or Values from

file.

You can also use a SmartName that resolves to Not, Flexo or File.
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Note:  If you selected Values from file and the input file contains distortion values, you
will see these in the fields below (greyed out).

b)
If you want to apply Flexo distortion, enter the vertical  and horizontal  distortion
percentages to use.

You can enter numerical values, or insert SmartNames that resolve to numerical values
(without the % sign).

Note:

• The values should be within the 90%-110% range. If you enter a percentage outside
of this range it will be automatically adjusted to the nearest value in the range (for
example 85 will be adjusted to 90%).

However, if you use a SmartName that resolves to a percentage outside the range,
the task will end in error.

• You can enter a simple formula and it will be calculated automatically (for example
you can enter 100+2 and this will be changed to 102%). This only works with
numerical values and not with SmartNames.

PDF Objects
Use the PDF Objects settings to define:

• how to color manage RGB objects in your input file,
• what dot gain compensation to apply to your input file's images.

All parameters in this tab are public parameters, that you can fill in when submitting files
through Shuttle.

1. In Default RGB Profile, specify the profile to use if no profile is specified for a certain RGB
object in the input file. The default is srgb.icc.

You can use a SmartName that resolves to the full profile name.
2. Select what output profile you want to use when converting RGB objects to CMYK:

• If you want to use the output profile from the input file (if there is one available), leave
Use output intent from file selected (it is selected by default).

• If you don't want to use the output profile from the input file, deselect Use output
intent from file and specify the output profile to use in Output Color Profile.

This output profile will also be used if there is none available in the input file.

The default is ISOcoated_v2_300_eci.icc.

For the Use output intent from file option, you can use a SmartName that resolves to
true (to use the file's profile) or false (to not use it).

For Output Color Profile, you can use a SmartName that resolves to the full profile name.
3. Select Use PDF transfer curves if you want to use:
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• the Dot Gain Compensation curves attached to the images in your input PDF. These curves
compensate for the unwanted characteristics of the device that created the images
(scanner, digital camera...).

• the Color Correction curves added by ArtPro+ version 20 and higher. These curves
allow you to correct individual separations for color deviations on proof from the
reference proof. The correction will be applied on both the proof and the production
files.

Note:

You can only use the correction curves if the Color Correction curves option is enabled in
the global Imaging Engine configuration.

Please contact Esko Support for assistance.

You can use a SmartName that resolves to true (to use the input file's curves) or false (to
not use them).

4. If you experience issues with a font that doesn't look smooth enough at your selected
resolution, your font may have font hinting errors.

Font hinting is the rendering of the outline (vectorized) font to pixels. For certain fonts, this
rendering sometimes doesn't give a visually pleasing result, especially at low resolutions. In
the image below, the top font has font hinting errors, the bottom font doesn't.

 

 

Choose how to handle files containing font hinting errors:

• Leave Generate an error if the job contains font hinting errors selected if you want
the task to end in error when encountering font hinting errors. You can also use a
SmartName resolving to true.

• Deselect Generate an error if the job contains font hinting errors if you want to
output your file anyway, whether it has font hinting errors or not (your task will end with
a warning). You can also use a SmartName resolving to false.

This may lead to reduced quality rendering of the text, but it will not generate incorrect
characters in your output file.

Document Inks
Use the Document Inks settings to select for which separations of your input file(s) you want
to generate ink distribution data.
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For example, you can use these settings to make sure that technical and/or varnish inks are
not taken into account.

You can choose to generate ink distribution data for either:

• All separations.
• A number of separations you select Manually.
• A number of separations you select by using selection criteria.

Selection criteria are rules that you define to select separations automatically for you when
the task is launched on a file.

Selecting separations manually is the easiest option, but you can only do it on a file by file basis
(when you launch the task on a single input file).

Using selection criteria is more advanced but also more powerful than selecting separations
manually, and you can do it anytime (when launching the task on one or more input files, when
using the task in a workflow, when defining ticket settings...).

Therefore, we recommend that you first try selecting separations manually when running
the task on individual files, then switch to using selection criteria to automate your workflow
further.

Tip:

To get used to working with selection criteria, try the following on a few of your files:

1. select the separations you want to output manually,
2. then change Select Inks to by using selection criteria and see which rules have been

created based on your manual selection.

For more information, see Selecting Inks Manually on page 1325 and Selecting Inks Using
Selection Criteria on page 1326.

Tip:  You can also make the ink selection parameter public so that an operator can set it
through Shuttle as needed for each job. See Selecting Inks though Shuttle on page 1330 for more
information.

Selecting Inks Manually

Note:  You can only select inks manually when you are launching the task on a (single) file, not
when you are defining a generic ticket without an input file.

When choosing to Select Inks Manually, you will see a table containing all of your document's
inks, showing each ink's:

Ink Name

Ink Book If an ink book is not present in your color database, it will show here as
<unregistered "">.

Ink Index The Ink index is the order in which the file's inks will be printed (the ink
with ink index 1 is at the bottom of the document and will be printed
first).

If your file has several of the same ink, they will have the same ink index,
and the next ink will have the next one (for example two Cyans will both
have ink index 1, then Magenta will have ink index 2).
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This means that when selecting inks for processing, both Cyans will be
selected together and handled the same way.

Tip:

To find the ink index of a file:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink has an
index of 1, the second of 2, etc.).

Note that if you reorder the inks by one of the columns (for example by
Ink name), they won't be ordered by ink index anymore. You will need to
close that dialog and reopen it to see the ink index order again.

Spot Ink Index The Spot Ink index is the order in which a spot ink will be printed (when
counting only spot inks and not process inks).

For example, if the first 4 inks of the document are CMYK, the first spot
ink will have 5 as Ink Index but 1 as Spot Ink Index.

As for the ink index, if your file has several of the same spot ink, they will
have the same spot ink index, and will be handled together when you
select them.

Ink Type This can be for example Normal, Technical, Varnish...

Printing Method If you have set a Printing Method for an ink it will be shown here (this
can be for example Offset, Gravure, Flexo... or any custom printing
method you configured).

See the Automation Engine documentation for more information about
printing methods.

Select the ink(s) you want to RIP, or select the toggle in the table header to select/deselect all
inks.

Selecting Inks Using Selection Criteria
If you don't want to select inks manually every time, you can define some rules to automatically
select certain inks in your input file(s).

You can do this:

• either when running the task on one or more files, or when creating a task ticket to use
later,

• by choosing to Select Inks by using selection criteria in the Document Inks settings.

How Does it Work?
You select the inks to be output by checking a combination of criteria:

1. You define what to check. You can check any of the following ink characteristics in your
criteria:
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Ink name

Ink book

Ink index The Ink index is the order in which the file's inks will be printed (the
ink with ink index 1 is at the bottom of the document and will be
printed first).

To find the ink index of a file:

1. select the file in the Automation Engine Pilot's Files view,
2.

click ,
3. in the Info dialog that opens, select Inks in the left panel.

The order of the inks at right is the ink index (the topmost ink has an
index of 1, the second of 2, etc.).

Note that if you reorder the inks by one of the columns (for example
by Ink name), they won't be ordered by ink index anymore. You will
need to close that dialog and reopen it to see the ink index order
again.

Spot ink
index

The Spot ink index is the order in which a spot ink will be printed
(when counting only spot inks and not process inks).

For example, if the first 4 inks of the document are CMYK, the first
spot ink will have 5 as Ink index but 1 as Spot ink index.

Ink type This can be for example Normal, Technical, Varnish...

Printing
method

If you have set a Printing method for an ink it will be shown here
(this can be for example Offset, Gravure, Flexo... or any custom
printing method you configured).

See the Automation Engine documentation for more information
about printing methods.

For example, you can check whether the Ink book is process, whether the Ink name is
yellow...

You can use as many criteria as you want.
2. You define how to combine your criteria into a rule. For example:

• If you want to output only process yellow, you should check for inks that match both of
the criteria:

Ink book is process
Ink name is yellow

• If you want to output both all process inks and all yellow inks, you should check for inks
that match either of the criteria:

Ink book is process
Ink name is yellow

• If you don't want to output any process inks or any yellow inks, you should check for inks
that match neither of the criteria:
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Ink book is process
Ink name is yellow

How Do I Build Rules?
Build your rules the following way:

1. Choose how to combine the criteria in your rule:

• Select All of the following are true if you want to only select the inks that match all of
the criteria you define.

• Select Any of the following are true if you want to select all the inks that match at least
one of the criteria you define.

• Select None of the following are true if you want to only select the inks that match
none of the criteria you define.

2. Define your first selection criterion.

You can select an ink based on its:

• Ink name: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink book: you can define if it contains/begins with/ends with/is a piece of text
(alphanumerical characters), or if it is empty.

• Ink index: you can define if it equals/is less than/is greater than the number you
enter, or is is between the two numbers you enter (in this case the ink indexes you enter
as boundaries are also selected).

• Spot ink index: you can define if it equals/is less than/is greater than the number you
enter, or is is between the two numbers you enter (in this case the spot ink indexes you
enter as boundaries are also selected).

• Ink type: you can define if it is a piece of text (alphanumerical characters).

• Printing method: you can define if it is a piece of text (alphanumerical characters).

For example, you could use: to:

All of the following are true

Ink book is designer

select all inks from the "designer" ink
book

None of the following are true

Ink name is crease

exclude an ink called "crease"

None of the following are true

Ink type is Technical

Ink type is Varnish

exclude all technical and all varnish inks
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Tip:

• You can enter several values to check for: just use a semicolon (;) between them.

For example, to check for both inks called Cyan and inks called Magenta, choose Ink
name is and enter Cyan;Magenta.

• When launching the task on a file, you can also click  to select one or more of the Ink
names/Ink books/Ink types/Printing methods used in your input file(s).

A criterion will automatically be created based on your selection.

3. Click + to add more criteria and define them.

To remove a criterion, click - next to it.

Tip:  If you are launching the task on a single input file, you will see a table listing the Selected
document inks, and another table with the Document inks that are not selected under the
rules you defined.

Attention:  If no ink is selected, you cannot launch the task.

Switching How You Select Inks
You can switch between the two methods of selecting inks (manually and using selection
criteria), and this will keep the same inks selected.

Switching from Selecting Inks Manually to Selecting Inks Using Selection
Criteria

When switching from selecting inks manually to selecting inks using selection criteria, the task
will translate your manual ink selection into rules, so that the same inks are selected (you can
see them in the Selected document inks table).

The rules you get are based on the characteristics of the inks you selected.

For example, if you selected all the process colors but no spot color in your file, for an offset
job, you will get the following rule:

All of the following are true

Ink name is Cyan;Magenta;Yellow;Black
Ink book is process
Ink type is Normal
Printing method is Offset
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Note:

If you...

• first selected inks using selection criteria,
• then switched to manual selection without changing the selection,
• then switched back to selection criteria,

... then your rules will be kept.

If you did change the selection in manual mode, the task will automatically generate new rules.

Switching from Selecting Inks Using Selection Criteria to Selecting Inks
Manually

When switching from selecting inks using selection criteria to selecting inks manually, all the
inks selected by the rules you defined (the inks in the Selected document inks table) become
selected manually.

Note:  You can only switch to selecting inks manually when you are launching the task on a
(single) file.

Selecting Inks though Shuttle
If you want to be able to decide which inks to RIP when submitting your input file through
Shuttle, do the following:

In Your Imaging Engine Ticket
1. To make the ink selection a public parameter, you can either:

• Right-click Select Inks and choose Make Parameter Public.

• If you (are currently launching the ticket on a file and) have chosen to select inks manually,
right-click the preview table under Select Inks and choose Make Parameter Public.

 

 

• If you have chosen to use selection criteria, right-click the rules builder under Select Inks
and choose Make Parameter Public.
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Note:  You will not be able to create rules using Shuttle, you will only be able to select
inks manually.

• Go to Advanced > Manage Public Parameters..., find the Ink Selection parameter at
the bottom of the list, and drag it to the right hand side.

 

 
2. By default, the public parameter that appears in Shuttle will be called Ink Selection. You

can change its name by:

• right-clicking one of the elements mentioned above, selecting Modify Public Parameter
and entering a new name,

• if you are using the Manage Public Parameters window, entering the new name in
Prompt as.

3. Make sure your ticket is also Public.

In Shuttle
The ink selection parameter may look a bit different depending on which Shuttle you are using
(the Shuttle standalone application or a Shuttle plug-in in an Editor application).

• In the Shuttle standalone, the ink selection parameter will look like this:
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The table shows a preview of all inks in your input file, with their characteristics.

• To RIP all inks from your input file, either leave all inks selected in the preview table, or
select All inks at the top (this will hide the preview table).

• To only RIP certain inks, make sure All inks is not selected, and deselect the input inks
that you don't want to RIP.

• In ArtPro+ for example, the ink selection parameter will look like this:
 

 

By default, all the inks from your input file will be RIP'ed, but you can remove any ink you

don't want to RIP using the  button.

Sizes and Offsets
Use the Sizes and Offsets settings to define the size and relative positioning of your file, plate,
press drum and paper.

Note:  The default unit for size and positioning is the Dimension unit you have set in your Pilot
preferences. You can type in a different unit and your values will be converted to that default
unit.

1. If you are working with XMP metadata in your input files, you can use the plate and paper
information from the metadata. To do this, select Use plate and paper values from file.

2. The File Width and Height information is calculated automatically, taking into account:

• the page box you are RIP'ing,

• the rotation you applied to your file,

• the distortion you applied to your file.

When launching the task on a single file, the calculated values are shown in the ticket
(unless any of the parameters used in the calculation are set using SmartNames).

3. For the Plate and Paper:
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• If you selected Use plate and paper values from file, the size and positioning will be
taken from the XMP metadata, and be uneditable (if the metadata doesn't contain this
information, it will not be included in the CIP3 files).

• Otherwise you will be able to edit them manually (if the file has metadata that contains
this information, it will still be filled in as a default).

Tip:  The number of decimals you can set depends on your Pilot preference. You can also
use simple calculations.

Note:

You will only be able to see the size and positioning values from the metadata when
launching the task on a single file.

When launching it on several files at once or creating a ticket, those values will be retrieved
when processing each file / when using the ticket.

4. You can always define the Press drum's Width, Height, H Offset (horizontal offset relative
to the right edge of the plate) and V Offset (vertical offset relative to the bottom edge of the
plate) manually.

When defining size and positioning values manually, you need to first select the component
you want to define (Plate, Press and/or Paper).

A preview shows the components you selected (File, Plate, Press and/or Paper), and the
size or offset you are currently defining is highlighted in blue.

For example, if you are entering the press drum width, you will see this:

 

 

If you are entering the vertical offset between the file and the plate, you will see this:

 

1333



16 Automation Engine

 

Production Data
Use the Production Data settings to add job tracking and paper information to your CIP3 files.
This can help press operators control the workflow.

1. Add job tracking information to your CIP3 files. You can use text and/or SmartNames to
add:

• the job name in Job Name Template,
• the code used for job identification in Job Code Template (this is optional),
• the sheet name in Sheet Name Template.

If you are working with several sheets, the Sheet Name Template needs to resolve to a
unique name for each sheet.

Note:

• Your press manufacturer may require you to enter this information in a specific format.
Please check your press user manual.

• If you use a SmartName that resolves to an empty value for Job Name Template or
Sheet Name Template, the task will end in error.

2. Enter the Paper Weight you are planning on using for printing your RIP'ed files.

The default paper weight unit is g/m². You can type in a different unit and the paper weight
will be converted to g/m².
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Note:

For both Paper Weight and Paper Thickness:

• You must use a numerical value (ninety will not work). The number of decimals you can
set depends on your Pilot preference.

• If you use a SmartName that doesn't resolve to a numerical value, the task will end in
error.

• The task will also execute simple calculations.

3. Enter the Paper Thickness you are planning on using for printing your RIP'ed files.

The default paper thickness unit is the Dimension unit you have set in your Pilot
preferences. You can type in a different unit and the paper thickness will be converted to
your default unit.

4. Enter the Paper Type you are planning on using for printing your RIP'ed files.

You can use text and/or SmartNames.

Output
Use the Output settings to define what type of output you want and where to output it.

You can set these through public parameters or using SmartNames.

1. Enter your output File Name and output Folder.

Note:

• You can use Imaging-specific SmartNames for the File Name.

By default, it is set to [File]_[Sheet Number]_[ShortInk] (which gives output file
names like Myfile_1_C.ppf).

• The File Name and Folder can contain special characters (except \ / : * ? < > " |).

• The whole path to the output file (including the container, Folder and File Name) can be
up to 255 characters.

• You can set a local or remote URL for the output Folder, but it must be an absolute path.

• If your output folder doesn't exist yet, the task will create it if the location you request is
valid (you should place this folder on an Automation Engine container accessible by your
Automation Engine user).

If the output folder creation fails, please check the task log for the full list of conditions
and adapt your output folder path accordingly.

2. Define what to do if a file of the same name already exists in your output folder:
a) Click Set Overwrite Policy...
b) Choose what to do If files exist already. You can either:
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• Extend the file name if you want to keep the existing output file and give the new
output file a different name. In this case, your new output file name consists of:

• the Output file name (the File Name you set earlier) - which is what the file
would be called if no file with the same name existed,

• a custom suffix that you can define using plain text and/or SmartNames (by
default, this is _c, for "copy"),

• an automatic suffix made of the three last digits of the task ID,

Tip:

To see the task ID of your tasks:

1. Go to the Pilot's Tasks pane (in the Files or Tasks view).
2. Go to View > Select Columns in 'Tasks'...
3. In the Columns dialog, select Task ID in the Available columns list and click 

to move it to the Show these columns: list.
4. Click OK.
5. You now have a Task ID column in the Tasks pane, listing the task ID of all the

tasks.

• the file extension.

For example, you are working with a single-page CMYK input file called file.pdf,
and you have left the tasks' output File Name to its default value ([File]_[Sheet
Number]_[ShortInk]). You are generating one CIP3 file per separation.

The first CIP3 files you generate will be called:

• file_1_C.ppf

• file_1_M.ppf

• file_1_Y.ppf

• file_1_K.ppf

If you generate output from this input file again, with the task 3669, and you have set
the overwrite policy to Extend the file name with the default Output File Name + _c
+ ID name, the new output files will be called:

• file_1_C_c669.ppf

• file_1_M_c669.ppf

• file_1_Y_c669.ppf

• file_1_K_c669.ppf

• Overwrite the existing file(s).
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• End the task in error.

Note:  If you use a SmartName to set this, it must resolve to extend or 0 (for Extend the
file name), overwrite or 1 (for Overwrite), or error or 2 (for End the task in error).

c) Click Set.
3. In File Assembly, select how you want to generate the CIP3 files:

• Select 1 File Per Separation if you want a CIP3 file for each separation of your input
file. If your input file is multi-page and/or two-sided, this will generate one CIP3 file per
separation, per page and per side.

For example, for a two-page file with two separations on each page, you will get a CIP3
file for each separation of the first page, and for each separation of the second page:

 

 

If your file is recto verso, you will also get CIP3 files for each separation on the back side
of the file:

 

 
• Select 1 File Per Surface if you want one CIP3 file for the front of your input file, and

another CIP3 file for the back (for two-sided input files). For a multi-page input file the
CIP3 file for each side contains all the pages of that side.

 

1337



16 Automation Engine

 
• Select 1 File Per Sheet if you want one CIP3 file for both sides of each page/sheet of

your input file.

 

 
• Select 1 File Per Job if you only want one CIP3 file for the whole input file (containing all

the separations, pages, and both sides).

 

 
4. In Side Control, select what you want to create CIP3 files for, in case your input file is two-

sided:

• only for the Front,
• only for the Back,
• for both sides (Alternate).

5. In Compression, choose whether to compress your output files. You can either:

• use the PackBits compression, a fast lossless compression method for graphic files.
• output Uncompressed CIP3 files.
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6. Choose the Encoding according to what your press supports: Binary, ASCII or ASCII85.
7. Set the Resolution of your output files.

Note:

• The Resolution unit is taken from the general Automation Engine Preferences.

• The default resolution is 72 ppi, but you can enter values from 1 to 300 ppi (or
equivalent in your unit). SmartNames must also resolve to a value in that range.

• Values in another unit than the one from the general Preferences will be recalculated,
and values like 72ppi + 100ppm will be calculated correctly.

8. If you experience problems with jagged edges, for example in small text, you can set an
Anti-aliasing factor to smooth those edges.

In the example below, you can see the difference between output without anti-aliasing (on
the left), and with anti-aliasing applied (on the right).
 

 

You can adjust the amount of anti-aliasing applied by choosing a factor of 2 to 8 (note that
using a higher anti-aliasing factor may slow down processing).

You can also set this with a SmartName resolving to None (if you don't need anti-aliasing), or
to the anti-aliasing factor you want (for example 2).

Summary
This shows a summary of all the settings you defined in the ticket.

• To show the settings from a tab, click + (on PC) or  (on Mac) beside the tab name in the
right pane.

Click Expand All to show the settings from all tabs.
• To hide the settings from a tab, click - (on PC) or  (on Mac) beside the tab name in the right

pane.

Click Collapse All to hide the settings from all tabs.
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17.  Flexo CTP Workflow

17.1.  Intro

Concepts, workflow, terminology etc.

17.1.1.  CDI (LEN) or Not CDI (TIFF)

Workflow to an Esko CDI

Automation Engine offers a range of tools that help automate platemaking on a CDI. Using
these tools brings these benefits:

• A view on the CDI device within the Pilot, including its job load and queue management.
• Automatic merging of LEN files onto a CDI plate.
• Detailed feedback from the CDI about the exposed plates, including waste factors.
• Easy monitoring of status of a plates of a specific job, even when spread over several CDI

plates or merged with separations from other jobs.
• Easy remaking of CDI plates (full or partial).

Workflow to a non-Esko Flexo CTP device

A big part of this workflow is also possible when making the flexo plate on a non-Esko device,
for example a CTP device from Kodak.

This device can also be used in the same Plate Merger system. These merged plates also
become visible on the Merged Plates view.

The main workflow differences are:

• The merged plate is a TIFF file i.s.o. a LEN file.

Note:  Remark that the RIP'ed data that you submit to the plate merger also in this case
need to be LEN files. The resulting merged plate will be TIFF.

Important:  LENX files are LEN files that contain Crystal screens. The plate merger will
error when he is asked to make a layout for a TIFF device, which does not have the required
'Crystal' technology.

• There is no feedback from the CTP device.
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Attention:  In this version, a workflow to a TIFF device still requires you to configure at
least one CDI device!

17.1.2.  Terminology

While learning about the involved tools, it is important to understand the used terminology,
especially the terms Press Plate and Merged Plate.

• CDI: Cyrel Digital Imager, Esko's digital flexo plate imager. Learn about CDIs on this web
page.

• DFS: Digital Flexo Suite. A set of interactive applications to manually prepare LEN files and
expose them on a CDI. Learn more on this web page.

• DFS Merger: The Merger is one of the applications of the DFS. An operator uses it to
prepare LEN files, merge them onto a layout, create a LEN file of that layout and send it to
the queue of the DFS Exposer.

One DFS Merger can drive several CDIs, unless it is installed on the PC of the CDI itself (in
which case it is called 'Grapholas Merger').

• LEN file: RIP output format that can be imaged on a CDI. Esko Imaging Engine or FlexRip/C
can create LEN files.

• Merging: Placing LEN files next to each other on a same layout, typically as many as
possible, to avoid wasting plate material.
 

 
• "Press Plate": A RIP'ed separation (LEN file) that can be merged before being imaged on a

flexo CTP.

The term "press" emphasizes that this a plate in the view of a printer: even when several are
merged with other Press Plates onto a CDI plate, they will be split/cut again after imaging
and processing, so that every Press Plate can end up as one plate on the press.

On the DFS, this is called an "image". The terminology in the DFS applications is focussed
purely on the CDI (not on the whole workflow up to the printer).

On Automation Engine, a LEN file becomes a Press Plate the moment it was submitted to
the Plate Merger.
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A "Press Plate Set" is a group of press plates that belongs to the same job.

• "Merged Plate": A LEN or TIFF file on which several Press Plates were merged. A Merged
Plate can contain several separations of a same job or even separations from other jobs.
After imaging and processing, a Merged Plate will be cut to end up with several plates for
the press operator.

On the DFS, this is called a "Plate", because this is one plate when being imaged on the CDI.

When the chosen device is not a CDI, the merger creates a TIFF file.

• Kongsberg: Esko Kongsberg cutting tables are typically used for their precision and
productivity in cutting for example plates with staggered cuts or PlatePatcher layouts.

17.1.3.  Manual Workflow (DFS only)

This page first illustrates the manual workflow where DFS uses local LEN files to make the
Merged Plates for a CDI.

 

 
These are the main process steps:

1. LEN files are written into the "working folder" of the DFS station. These files can be created
by an Imaging Engine or FlexRip, or could have arrived from a remote site.

2. The DFS Merger operator

• selects the CDI and plate type that the layout will be exposed on. He then selects the LEN
files ("images") from that "working folder" and loads them into the Merger.

• He then manually creates a layout for the selected CDI plate and/or uses the "Auto
Arrange" feature to get some help with that.

• He can use interactive editing functions like crop, cut, rotate etc.
3. When a final layout is made for that CDI, he presses "Expose!" to send it to the CDI's expose

queue (the Exposer application).
4. The CDI operator mounts a flexo plate on the CDI and uses the Exposer application to start

the exposure.
5. After exposure, the plate goes through its post processing steps and may be cut before

being sent to the press room or shipped to the printer.
6. DFS also writes HTML files containing the history of the exposed plates and their plate

usage. These can be used by an external system for job status or production statistics.
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17.1.4.  Automatic workflow (using AE)

In this workflow, Automation Engine replaces the use of a DFS Merger and provides extra tools
to view the history of this output.
 

 

1. LEN files arrive in Automation Engine. These were created by an Imaging Engine (or FlexRip).
2. Editing LEN files can be automated using the Add Margins and Crop tasks.
3. LEN files are submitted to a specific queue of the Plate Merger, together with parameters

defining how and when they should be merged. A Merge Queue typically represents a plate
type and can offer several sizes of that plate type.

Note:  You can also choose to add test strips or margins to the layout.

4. When the Merge Queue decided on a layout, it starts a workflow that creates the Merged
Plate LEN file and then submits that file to the CDI's expose queue.

Note:  In this workflow, creating the Merged Plate LEN file is a task on your Automation
Engine server and not on the standalone DFS computer.

When the selected device is not a CDI, the workflow creates a TIFF file on a dedicated output
folder.

5. The CDI operator uses the Exposer application to expose the Merged Plate.

Note:  When so configured in the Plate Merger configuration, any successful imaging of a
CDI plate automatically triggers a workflow that submits the related cutting XML file to the
Kongsberg's iPC. Learn more here.

6. In the Pilot's Views bar, the category 'Flexo CTP' offers some extra views that support this
workflow:

• The Merged Plates view shows all Merged Plates, in their different states. In this view you
can also easily resubmit plates back to the CTP queue, typically in cases where you need
to remake them. You can choose to resubmit the whole merged plate or only selected
press plates.
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• The Press Plates view helps you to overview which LEN separations are or have been part
of this workflow.

• The Press Plate Sets view adds an extra job order perspective.

7. Reporting back to business systems. This workflow can also automatically sends reports to
external systems, both about what's happening on the device and about the status of the
Job order. Learn more in Reporting to Business Systems on page 1347.

17.1.5.  Semi-Automatic Workflow (manual intervention)

 

 

Even when you use the tools in Automation Engine, you can still use the DFS Merger to
manually intervene. Some examples:

• When you want to use one of the partial flexo plates available in the plate room. Learn
more in Plate Merger on page 1359.

• When you want to optimize plate usage by adding (smaller) Press Plates ("Images") that only
recently arrived in the queue and have a lower priority.

Note:  This manual intervention to optimize the plate usage can sometimes be replaced
by using the option to reconsider already merged plates: this puts all its press plates back
into the automatic merger and so makes them re-merge with any (small) new arrivals in that
queue.

In the following cases, merging cannot be done by using the tools within Automation Engine. It
has to be done with the manual DFS Merger application, using local LEN files:

• In a DFS PlatePatcher workflow (corrugated).
• To manually crop LEN files.

Workflow steps:
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1. When using the DFS Merger in AE Manual mode, the DFS user first selects one of the existing
Plate Merger queues on Automation Engine. To prevent any conflicts, the selected merge
queue is automatically paused.

2. The DFS user loads the Press Plates ("Images") that are present in the selected merge queue
and manually creates a layout with (some of) those.

3. When finished, the DFS user clicks "Expose". This automatically makes Automation Engine
launch the workflow that was defined for that merge queue. From this point on, the
workflow is identical as when working fully automatic: a merged plate LEN file is made from
that layout and is then sent to the CDI expose queue.

Attention:  Limitations in the DFS Merger when in AE manual mode:

• It is not possible to manually Crop the LEN files in the DFS Merger when it is set in AE
Manual mode. Consider using Automation Engine's Crop LEN File task.

• You cannot use the Viewer in DFS/PlatePrep to view the LEN files. Use the
Automation Engine Viewer instead.

• Whether a LEN file is allowed to be rotated or not is controlled by the merge queue
setting and/or by the value set for 'Rotation' in the 'Submit to Plate Merger' task.
If rotation is not allowed, the rotation button in the DFS Merger application will be
greyed out.

17.1.6.  Introducing Flexo CTP related Views and Tasks

This page offers an overview of dedicated tasks and Pilot Views that enable the automation in
flexo CTP platemaking.

Find their detailed documentation in Flexo CTP related Views and Flexo CTP related Tasks.

Views and Tools
•  Devices. This view shows an overview of your configured CDIs or flexo CTP TIFF devices

(and possibly other device types). It shows their general status and also the content of their
expose queue.

Note:  This view is also available from the Tools menu, which means you can also open it as
a separate window next to the Pilot.

•  Plate Merger. This view is where you configure and monitor Merge Queues. A merge
queue calculates possible layouts of press plates (RIP'ed separations) onto a merged plate
(CTP plate layout).

•  CTP Queues. This view shows the device queues in a graphical way. You see details about
their queue items and you can manage them (delete, change order, resubmit or, when
possible, move to another queue).

Note:  This view is also available from the Tools menu, which means you can also open it as
a separate window next to the Pilot.

•  Press Plates. This view lists details about all press plates that were submitted to the plate
merger. It offers smart filtering, viewing and easy navigation to the job they belong to or to
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the merged plate they are/were part of. You can also resubmit press plates back to the plate
merger.

•  Press Plate Sets. This view shows the press plates in a job order context. For example a
CSR (Customer Service Representative) can here monitor all jobs needing flexo press plates
and see how many have been imaged yet.

•  Merged Plates. This view shows details about all merged plates. When you select one and
think you can (now) get a more optimized layout than the one you see, you can choose to
resubmit all its press plates back to the plate merger. Double click a selection to zoom in
and see a large preview of its layout and details about their press plates. In this view, you
can also resubmit a selection of press plates back to the plate merger.

Tasks
•  Add Margins to LEN file. Use this task to make sure there is enough room between press

plates on a merged plate. Alternatively, this can be also be done by adding Press Plate
Margins in the merge queue.

•  Crop LEN file. Use this task to crop LEN files to the first image pixel or to the staggered cut
line.

•  Submit to Plate Merger. Use this task to submit LEN files (press plates) to the plate merger.
•  Create Merged Plate. When the plate merger decides on a layout, it uses this task to create

the LEN or TIFF file of that layout.
•  Submit to Flexo CTP Device. This task submits the LEN of the merged plate to a CDI expose

queue. In case of a TIFF flexo CTP, it submits the TIFF file of the merged plate to a folder that
that device is monitoring.

17.1.7.  Main Steps in Setting Up this Workflow

Once you have a working setup of DFS (or Grapholas) software, then these are the main steps
to set up this workflow in the Pilot:

1. Create one or more Devices. In the Devices View, click  to add a device for every flexo
CTP you have.

2. Create Plate Merger queues. In the Plate Merger, click  to add a merge queue for every
type of flexo plate that you use on any of the configured devices.

• Pick the type of plate from the list that is automatically retrieved from the configured
CDI(s).

Attention:  In this version, even when making a merge queue that you will use
for a TIFF device, you still need to pick a plate type from a list of plates that are
configured on a CDI. This list is read from a CDI's DFS within your network. In
other words: to use a TIFF device in this workflow, you also require to have at
least one CDI configured.

• Then set all the other merger settings for every queue.

Tip:  When you have more than one CTP, it is not necessary to make a specific merge queue
for each CTP device. This would prevent the load balancing: the system can then no longer
decide to pick the least busy device.

3. Create an output workflow for the merge queue(s). In the Tickets view, create a workflow
that starts with creating the Merged Plate file (LEN or TIFF is automatically decided by the
chosen device) and that ends with submitting that file to a flexo CTP.
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Caution:  When adding more steps to this workflow, make sure to still respect the
required input files for both these mandatory task steps. Learn more in these notes
on Output Workflows.

4. Attach the workflow to the merge queue(s). Complete the setup of the merge queue(s)
by adding the output workflow that you created in the previous step.

5. Test. Select a group of LEN files, open a Submit to Plate Merger task, select the right plate
type and launch the task. When the fill rate is too small, use "Force Out" to see the next steps
in the workflow. You should see one or more new entries in the CTP queue.

6. Adapt your existing RIP workflows by adding a Submit to Plate Merger task at their end.

All the tools used in this workflow summary are described in detail in the pages on the Views
and Tasks.

17.1.8.  Reporting to Business Systems

When making digital plates, this type of information is often asked for:

• Statistics on plate usage: type, waste, etc.
• Statistics about the CDI: Till when is this CDI planned to be busy? How much time has it

been exposing this week and at what resolution?
• Job order information: Are all press plates for this job exposed on the CDI yet? What is the

plate usage/waste for this job?

All this information can be sent to any external system by workflows that are automatically
launched at specific events in a CDI workflow. Learn more in Plate Merger Configuration  on
page 1366.

This information can be delivered via XML files, web service calls, or even direct database
interaction. Learn more about such integration techniques in the chapter Integrating with
External Systems on page 1553.

17.1.9.  Removed CDI Related Tools

In Automation Engine 14, the "CDI View" and the "Make Plate on CDI task" enabled a minimal
connection to a CDI.

These tools were removed in AE v16 when the current tools became available.
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17.2.  Flexo CTP related Views

These tools and tasks and their concepts were introduced here.

17.2.1.  Devices (CDI)

Tip:  You can also open the view Devices as a Tool: Go to Tools >  Devices to monitor and
manage your devices in a separate window.

Adding a CDI Device

Follow these steps to add a CDI device:

1. In the Views bar, in the group 'Setup', open the view Devices.
2. Click . Select the category Flexo CTP - CDI and click OK.
3. In Server, type in the name or the IP address of the computer of that CDI (the one where its

Grapholas is installed).

Attention:  The computer that drives the CDI must be configured to use a fixed IP
address. This can be achieved by either setting a fixed IP address on that computer
or by preserving a fixed IP address on the DHCP server.

4. Click Add to confirm. The blue status box of the newly created device appears.

Note:  Older CDI devices show up in a lighter blue color.

Note:  Adding a CDI device requires a license per device.

Information and functionality
 

 
The device status box shows following information that it gets directly from the Exposer
application of that CDI:

• The name of the device. By default this is the name of the computer where the DFS or
Grapholas software was detected. Open the  Info panel to change it to a custom name.

• The amount of merged plates in the expose queue. This is the amount of jobs in its
expose queue (exposing and waiting).

• A device status icon.
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• : Retrieving the status.
• : The device is offline. There is no connection with the device's computer (switched off,

network problem, etc.).
• : The device is online. It could be idle or busy imaging.

•  The Estimated time when the current job load will be finished (how long the CDI is
scheduled to be busy).

Attention:  CDI's with a Grapholas version 12 up to 14.0 can not feed a correct
estimation of the exposing time to Automation Engine. Therefore, in this view, you
will not see this information for these older devices.

Right-click a status box to choose one of these options:

• Info (or press ). This dialog shows details about the device (version, settings, etc.). You can
add a Description to illustrate or help identify this device. Click Advanced Options for a
detailed technical list of its parameters.

• Delete (or press ). You will be asked to confirm.
• New Device.... An alternative to clicking .

CDI Device Status in an External Dashboard

Concept

Some customers are using a dashboard where they monitor their company's activity. This
dashboard can be a part of their business system or it can be custom-built. These sites often
also want to see the status of their CDI devices in that same interface.

Note:  To get detailed information about specific plate consumption and job status, learn more
in Tab 'Reporting' on page 1368.

The external system that shows the dashboard can ask Automation Engine for the CDI status
via HTTP GET calls. It can so collect the same information that you can see in the CDI Device
View:

• General device status (idle or exposing).
• The amount of merged plates in the expose queue. This is the amount of jobs in its

expose queue (exposing and waiting).
• The estimated time when the current job load will be finished (how long the CDI is

scheduled to be busy).

Regular updates of the status of all CDI queues can be retrieved via Server-Sent Events (SSE).

Syntax

• Getting the status of a specific CDI:

• In a browser, go to <name-of-AE-server>:4412/FPL/cdi/<name-of-CDI-device>
.

An example:
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• Continuously getting the status of all CDI's via Server-Sent Events (SSE):

• In a browser, go to <name-of-AE-server>:44111/CDI. You will first see an info page. In there,
click the link to the Server-Sent Events to see the live status of all CDI's.

• Per CDI device, the following information is returned:

• NAME: Name of the machine.

• IP: IP-address of the machine.

• STATE: OFFLINE: When the machine cannot be reached.

• IDLE: TRUE: When the machine is not exposing.

• IDLE: FALSE: When the machine is exposing.

• QUEUELENGTH: Number of entries in the expose queue.

• TIME: The time in seconds to empty the queue (on condition of continuously exposing
from now onwards).

An example:
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Ask your browser to view the source of this web page. This will reveal the JavaScript that
translates the incoming events to the readable table.

An example (in the browser 'Chrome'):
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17.2.2.  Devices (TIFF)

Note:  We here only describe the differences with adding an Esko CDI device, as described
above.

Adding a Flexo CTP TIFF Device

Follow these steps to add an offline Flexo CTP device that you will send TIFF files to.

1. In the Devices view, click on .
2. Select the category Flexo CTP - TIFF and click OK.
3. Fill in the device's properties:
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• Name: Type a name for this TIFF device.

• Image Width and Image Width: Define the (maximum) size of the output TIFF (merged
plate) for this device to expose.

• Compression: Select the compression for this output TIFF file.

• Negative background: Should this TIFF file have a negative background?

• Mirror: Should the data be mirrored on that TIFF file?

• Output Folder: Define where all output TIFF files (merged plates) for this device should
be written.

• Monitor output folder as plate queue: Select this to enable the device's status box to
show this information:

• Number of plates. This is the number of TIFF files currently in the output folder.
• A rough time estimate. There is no link with the device to obtain any idea how long

it will take to expose these plates. Therefor, the system uses a default estimate of 30
minutes per plate and 3 minutes in between plates.

• Click Add to confirm. An olive green status box of the new device appears.
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Important:  To change the name of a device, right-click the device's status box and
choose Rename.

17.2.3.  Press Plates

Note:  The terms "Press Plates" and "Merged Plates" were introduced in the page on
Terminology on page 1341.

Concept

This view lists all the Press Plates in rows. These are the LEN files that were submitted to the
Plate Merger. Select one to see a preview and some key information in a pane on the right.

When your Pilot is in a specific Job mode, you only see the press plates of that Job.

Depending on the type of information you are looking for, you may want to see the entries
grouped differently. An extra line then separates the groups. To set your preference, select any
entry, right-click and choose:

• Grouped by Press Plate Set. This groups all entries that were submitted together by the
same Submit to Plate Merger task. Because these entries are likely coming from the same
graphics file, the focus of this view is more on the delivery of these press plates: It helps
answer questions like 'Can we move them to the press?' or 'Can we ship them soon?'.

A similar view is offered in the Press Plate Sets view, but there you see a different kind of
information in the right pane.

• Grouped by Merged Plate. This groups all entries with the other press plates that are or
were part of the same merged plate. This focus of this view is more on the CTP device.

Columns

Note:  As in many views in the Pilot, you can

• re-arrange columns by dragging their title to a new position
• sort them by clicking on a column title
• right-click a column title and choose to Hide this one or any other. In the list that appears,

select Select Columns... if you want to change or re-arrange multiple items.

• use filters and optionally save them as a Smart View.

• define your preferred unit in Edit >  Preferences >  Units.

Several of these columns only get their value as the press plate progresses through its
workflow.

• File Name: Name of the LEN file.

• Folder: Full path where the LEN file resides.

• Order ID: The order ID of the Job that the LEN files of the press plates reside in.

• Resolution: Resolution of the LEN file.
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• Size: V-H size of the LEN file. (This is the size the plate merger uses when calculating
layouts).

• Device: Name of CTP device that the layout containing this press plate was made for. This
field is empty when the state is still "In Plate Merger".

• Ink name: As read from the LEN file's XMP metadata.
• Rotation: Rotation as requested in the Submit to Plate Merger task: 0, 90 or mq (= "Set by

Merge Queue").
• State of each press plate:

Tip:  Hover your mouse over a status icon to read its meaning.

Tip:  When using the filter, click CTRL to filter on multiple statuses.
 

 

•  In Plate Merger: Still an entry in a merge queue of the plate merger.
•  In Output Workflow: Part of a merged plate that is currently in its merge queue's

output workflow.
•  Queued on CDI: Part of a merged plate that is in a CDI expose queue.
•  Exposing on CDI: Part of a merged plate that is being exposed on the CDI.
•  Exposed: Part of a merged plate that was successfully exposed on the CDI.
•  Exposed (Warning): Part of a merged plate that was exposed on the CDI with a

warning.
•  Error (In output workflow): Part of a merged plate that encountered an error in its

merge queue's output workflow.
•  Error: Part of a merged plate that was exposed on the CDI with an error.
•  Cancelled: Part of a merged plate that was cancelled (removed) from the CDI's

"Exposer" queue.
•  Unknown: Status unknown.

• Imaging Technology: The technology that was requested for this LEN file when it was
submitted to the plate merger.

• Manufacturer, Thickness and Type: Plate specifications, as retrieved from DFS or
Grapholas during the workflow.

• Timing

• Due date: Time specified in the Submit to Plate Merger task. When none was specified, a
due date is set at 3 days after the submitting to the merger.

• Finished: Time when this press plate was finished exposing on the CDI.
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• Launched: Time when this press plate was submitted to the plate merger.

• Plate usage, retrieved from the layout XML created by the plate merger:

• Used Area: Area that this press plate uses on the merged plate.

• Waste: Area of this press plate that is not used area. (press plate margins, cut marks
area)

• % Used Area: % of used area of the merged plate that this press plate is part of.

• % Waste: % of unused area of the merged plate that this press plate is part of.

Note:  In previews of the merged plate, the waste area is shown in pink.

• When this press plate also requested a cutting workflow, these fields will get their values
when that workflow is executed on the Kongsberg:

• Cutting Flow: Name of cutting workflow chosen in the Submit to Plate Merger task.

• Cut State: (Not) Ready for Cutting, Done, Error or Cancelled.

• Custom fields (names defined in the Plate Merger item in the Configure tool).

• Internal ID numbers

• Merged Plate ID: A unique identifier for the merged plate that this press plate was
placed on. In the reporting XMLs, it is mentioned as an attribute for Plate id. For
example: <Plate id="56c3-2ef4-0001"> .

• Press Plate ID: A unique identifier for that press plate. In the reporting
XMLs, it is mentioned as the element <IdOnPlate>. For example:
<IdOnPlate>000070518_20151210152733_process_Yellow</IdOnPlate> . This
ID was first created by the RIP when it created the LEN file and then added it to it's XMP
metadata as <egPlate:plateid>.

Learn more in Interpreting the Reporting XMLs on page 1405.

Functionality

Right-click an entry to choose any of these actions (some are only available in specific statuses):

• Resubmit Press Plates: This resubmits all selected entries back to the plate merger (same
LEN files with same submit options). You will be asked to confirm.

This is useful when a part of a flexo plate was damaged or when your press operator
requests a new plate of only that specific separation.

Restriction:  The LEN file of the selected press plate still needs to exist (on the same folder).

Tip:  The Merged Plates view also offers to resubmit (parts) of a merged plate.

• Go to Job: When the Pilot is in Container mode, use this to have the Press Plates view go to
the Job mode of the Job that this press plate belongs to.

• Go to File: Opens the Files view and selects the LEN file of this press plate. This can be
useful to check its XMP metadata ( ).

• Show in Plate Merger: Shows this item in the Plate Merger Queue (when present there).
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• Go to Merged Plate: Opens the Merged Plates view, zooms in on the merged plate that this
press plate belongs to and selects that press plate in the preview (blue line).

• Show Related Tasks: This open the Tasks view and shows the workflow that was used to
create the merged plate and submit it to the CTP device.

• View. Opens the press plate's LEN file in the Automation Engine Viewer. This will require the
LEN file to have prepared view data (learn more in Working with RIP data in the AE Viewer).

Note:  If you wish to open LEN files in the DFS "View" application (aka "Esko Bitmap Viewer",
Windows only), then choose 'Go to File' and double-click the file there. This will open the file
in the application that you first instructed your local computer to 'open with'.

• Group by Press Plate Set: Use this to see the rows grouped by entries that were submitted
together.

• Group by Merged Plate: Use this to see the rows grouped by the merged plate they ended
up on.

Note:  You cannot select and delete entries in this view. They will be removed based on the
automatic clean up option in the Plate Merger item in the Configure tool.

17.2.4.  Press Plate Sets

Concept
This view is intended for CSRs (Custom Service Representatives). It adds an overview of Job
orders and the status of their required press plates in their workflow to the flexo CTP. This can
also include the workflow of cutting the flexo plate on a Kongsberg table.

In Container mode, this view shows all press plate sets, created in a Job context or not. In
Selected Job mode, it only shows those created in that selected Job.

Tip:  Especially in Container mode, it can be useful to work with Smart Views: one could focus
on plate status, another on plate waste, etc.

The Right Pane: Pie Chart and Details

Select an entry to see a graphical overview and some key information in the right pane.

• The pie chart shows in color how many press plates of the selected set are in which status:

•   In Plate Merger: How many are still in the Plate Merger, waiting to be put on a
merged plate.

•  In Output Workflow: How many were recently merged on a plate and are still in the
merge queue's output workflow.

•   Queued On CDI: How many are part of a merged plate that is in a CDI "Exposer"
queue.

•   Exposing: How many that are part of a merged plate that is current being exposed on
the CDI.

•   Expose Done: How many that were exposed on the CDI but are still to be cut on the
Kongsberg table (also see column "Cut State"). For TIFF devices, this status is already
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set shortly after the TIFF layout arrives in its output folder, i.e. where the workflow on
Automation Engine is done.

•   Expose Error: How many that experienced an error during exposing on the CDI.
•   Expose Cancelled: How many are part of a merged plate that was cancelled when

being exposed on the CDI.
•   Cut Error: How many where an error appeared during cutting on the Kongsberg

table.
•   Cut Done: How many where the whole workflow is done successfully. These were

exposed on the CTP and, if requested, also cut on the Kongsberg table.
• At the bottom of the right pane, click  to see the amount and the names of all the Press

Plates and (if available) Merged Plates for this set.

• "In Plate Merger" shows the amount and the names of the press plates that are still in
that state.
 

 
In case you wonder why they are still in the plate merger, click  or click on a specific
press plate name to open the plate merger view and select them in their merge queue,
where you can read details about their state.

Tip:  Use the arrow buttons  in the Pilot tool bar to come back to this previous
view.

• "In Error" lists the press plates of which some step in the workflow failed.

Columns

Note:  As in many views in the Pilot, you can

• re-arrange columns by dragging their title to a new position
• sort them by clicking on a column title
• right-click a column title and choose to Hide this one or any other. In the list that appears,

select Select Columns... if you want to change or re-arrange multiple items.
• use filters and optionally save them as a Smart View.
• define your preferred unit in Edit >  Preferences >  Units.

Columns describing a status (see above list) show the amount of press plates of this set are in
that status. The possible statuses are very similar to those described in the Press Plates view.

Functionality

• Go to Job: The view filters itself to the Last Used Job mode of the job that these press
plates belong to.
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• Go to Folder: The view switches to the Files view and selects the folder where the press
plates' LEN files are. This is for example useful to check their XMP metadata ( ) or to
manage their prepared view files.

• Show in Press Plates: Opens the Press Plates view and selects all press plates of this set.
This is useful to check more detail about the different press plates or to see the ID of the
merged plate(s) they ended up on.

• View: Opens all press plate's LEN files together in the Automation Engine Viewer. This will
require all LEN files to have prepared view data (learn more in Working with RIP data in the AE
Viewer).

17.2.5.  Plate Merger

Concept

LEN files are sent to the plate merger by submitting them to a specific Merge Queue. Each
merge queue has it own settings regarding plate type, size and merge parameters. For each
merge queue, the plate merger calculates if it can merge the press plates (LEN files) in that
queue onto a layout.

A plate merge queue starts to calculate possible layouts

• every time a new press plate enters the merge queue,
• every time a layout was decided, it then tries a next one,
• every time a press plate's due date is reached (or a time based on that due date),

• every time someone decides to Force Out one or more press plates.

• every time a merge queue setting was changed (one that is relevant for calculating layouts).

Press plates that you submit to a merge queue can be merged together on a same merged
plate,

• when they have the same value for plate type, resolution, imaging technology and cutting
workflow,

• and when they have the same value for custom Grouping Keys (that you can set up in the
Configure tool).

Attention:  The plate merger requires that the XMP metadata of the input LEN files
contain information on hsize, vsize and resolution. This is the case for LEN files
created by Imaging Engine or FlexRip version 14 or higher.

When a merge queue decides on a layout, the assigned output workflow is started. The first
task in that workflow creates a LEN or TIFF file of that new merged plate, the last one submits
that merged plate to the chosen flexo CTP device.

A Merge Queue Per plate Type

The best reason to have several merge queues is to have a merge queue for each plate type.

Also when you have more than one flexo CTP device, we advise to let a merge queue pick a
device automatically. This allows it to calculate more possible layouts, which improves the fill
percentage in the decided layout. Later in the workflow, the task Submit to Flexo CTP sends the
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merged plate LEN or TIFF file to the device that the merger created the layout for. Learn more
below about load balancing.

Some remarks and advice when you consider other reasons to create different merge
queues:

• Queues that start different workflows: For example, one queue could have an output
workflow including extra steps for quality control.

• However, a workflow itself can contain tools that decide conditional behavior (routers,
SmartNames, etc.), so we advise to first check if it is possible to have one merge queue
launching a workflow that includes different steps depending on the file's or its Job
parameters.

• Queues that are not different in their queue settings but have differences in the way their
output will be imaged (CDI parameters): For example, a merge queue that only handles
exposure of 2540 ppi or Pixel+ press plates.

• However, it is better to submit all these files to one same merge queue and use grouping
keys to control the files they are merged with.

Important parameters like resolution and imaging technology are grouping keys that the
system itself already uses automatically.

Learn about adding custom grouping keys in Submit to Plate Merger task on page 1395.

Working with Partial Plates

When you want to use partial plates with fixed sizes, you can use the automatic workflow.
Those sizes are then predefined in a merge queue. Mind that Automation engine is not keeping
track of the offcuts.

When you want to use partial plates with variable sizes, we advise to use the DFS Merger in
Automation Engine mode and create a layout for that unique size. Learn more about this
workflow in Using the DFS Merger in AE mode.

Adding Test Strips or Margins to the Merged Plate

The Plate Merger can also add test strips or margins (frames) to the merged plates. This is done
via a set of rules that you can set up in the Plate Merger Configuration. These rules are valid for
all merge queues.

Adding a Merge Queue
Follow these steps to add a new merge queue:

1. In the Plate Merger view, click the  icon (at the bottom) and choose New Merge Queue
(or use the File menu).

Note:  To create a merge queue similar to another one, select one and choose Duplicate.

2. Add a Name (or use the one that appears in the next step).
3. In Plate Type, click on  to see a list of all available types (on the configured CDI devices).

Select a plate type.
4. In Merge for, define for which sizes this queue needs to calculate layouts. This is decided by

the Device, Drum and Size fields.
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• Active: In this column, select or deselect the device that the merger can make layouts
for. Learn more below about adding extra devices to merge for.

• Device: Automatic is the default setting. The merger then checks all available CTP
devices and drum sizes to calculate which one offers the best fill percentage. In case the
fill percentage is very similar for multiple devices, the merger chooses the device with the
lowest queue load (see the estimated time in its device status box).

• Add or Remove extra devices. Some example cases to add specific devices:

• You have two or more CDIs of a different size and you use a plate type that is not
available for all of those. You could then make a merge queue for that plate type that
only merges for the CDIs where it can be used on.

• You can add all your devices and de-activate the one that you know will become
(temporarily) unavailable. Mind that the merger automatically detects when a CDI is
not online. However de-activating a device it here may be useful to prevent that more
jobs go to its expose queue. For example when you know that, in a few hours, that
CTP device will be offline for an intervention or maintenance.

• Drum. When you added a specific CDI in this list, the merger is automatically aware of
what drum is present when calculating a layout. A example situation to still add a specific
drum in this list, would be when you plan on changing the drum in the near future. That
way, you can have a merge queue that already makes layouts for the new drum size.

To specify a drum, double click a device / row, and in Edit Size Options, click on  in
Drum Name and select it from the list.

• Size. By default, the Drum Length and Drum Height will be used (as configured on the
CDI). If you want a smaller size, type it in (for example for partial plates with a recurring
size).

When a  warning sign appears next to the name of the device, hover your cursor over the
icon to read its meaning. It may be that the plate type for that queue is not recognized.

5. Merge Settings...

• Rotation: Define if you allow the merger to rotate the press plate 90 degrees on the
layout.
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• Auto-place Mode: Choose the main mode that this merge queue should base its
calculation on:

• Area Optimized: Layouts with the largest plate fill percentage.

• Cut Optimized: Layouts that are optimized for manual cutting. Press plates will be
placed in 'lanes' as much as possible, so enabling longer straight lines that are easy to
cut manually.

• Maximum Calculation Time. Each time a calculation is triggered, this is the maximum
time that the merge queue is allowed to spend on calculating a layout. When that
calculation results in a layout, the merge queue then continues and tries again for
that same period, now to make another layout with the remaining press plates. This
continues until the merge queue can create no more layouts (with its current settings).

This time is spent on each calculation for each device this merge queue is asked to
calculate for (30 seconds then means 30 seconds for each device).

When you have many press plates, increasing this time can help to create layouts with a
higher fill percentage.

Tip:  The default time is visible when you create a new merge queue.

• Cut Marks. Choose whether you want to add cut marks around each press plate (CDI or
TIFF device). These marks are identical to those offered in the DFS Merger.

Note:  In the DFS-style preview of a merged plate, these marks and lines are visible as
(small) green objects.

• None.

• Cutting Marks. Small marks indicating the corners. The marks will be as long as the
width of the Press Plate Margins (with a maximum length of 5 mm). An example:
 

 

• Solid Cutting Lines. Cutting lines around the press plates.

• Dotted Cutting Lines. Dotted cutting lines around the press plates.

• Press Plate Margins. You can add an extra empty area around each merged plate. This
is also where the cut marks are placed.

Note:  When you here add 10 mm, the space between 2 press plates will be 20 mm.
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Note:  When you add Cut Marks, 1 mm of press plate margins will be added
automatically. When you requested to add a text label to the press plate, a 4 mm margin
will be added to the side where the label needs to appear (unless there was already a
larger margin).

• Minimum Fill. Define the minimum fill for a merged plate.

Tip:  Based on your workflow and production needs, you will need to find a balance
between optimal plate usage and urgency of exposing the plates. Especially when your
merge queues often contain press plates of variable sizes, it may be beneficial to wait
until some (more) small ones are submitted to help fill the flexo plate (and so reduce
plate waste).

• Merge Automatically before the due date. Use this option to ensure that you make the
flexo plates by their due date (the time specified in the Submit to Plate Merger task). When
you need to ship the press plates by 5 PM, you could for example make sure that they
are merged by 3 PM, so leaving enough time for exposing, post-processing, cutting and
packing.

6. Workflow. Select the output workflow for this merge queue. As mentioned in the
introduction, this workflow needs to start with the Create Merged Plate task and end with the
Submit to Flexo CTP task. Only global workflow tickets are possible.

Caution:  In theory you can extend this workflow with other task steps but then
make sure you still respect the required task input files in this workflow:

• The layout that the merger calculates is an XML file. This first step of this
workflow, the task Create Merged Plate, needs that file as its input file.

• The output file of the task Create Merged Plate (also an XML file) needs to be the
input file for the task Submit to Flexo CTP.
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Note:  When the selected workflow is launched for the first time, a predefined set of
workflow parameters will be injected in this workflow and can so be used by the steps in
this workflow. The values of these workflow parameters will set every time the workflow
runs,

• cdi.drum: Name of the drum of the CDI as defined in the Expose application on the
Grapholas PC. Not available for TIFF devices.

• cdi.id: Internal id how the CDI or TIFF device is configured within the Automation
Engine server.

• cdi.name: Name of the CDI or TIFF device as configured in the Devices View.

• CutWF: Name of the cutting workflow used in the Submit to Plate Merger task.

• ImgTechn: Imaging technology set in the Submit to Plate Merger task.

• mq.mergerxml: URL of the input file of the workflow.

• mp.type: Plate Type as configured in the Merge queue.

• mq.name: Name of the Merge Queue.

• PlateType: Plate Type as configured in the Merge queue.

• Resolution: Resolution of the Merged Plate.

• User defined name of the grouping keys as defined in Configure > Plate Merger > 
Name Custom Field.

7. Click OK to confirm and create the merge queue.

Note:  You can also select an existing merge queue, right-click or click  and choose
Duplicate to create a similar queue.

Managing Merge Queues

Pausing a Merge Queue

Attention:  When your setup is a standalone Device Manager (i.e. not a full
Automation Engine), the merge queues will always be paused. You will also not be able
to Hold or Release items in these queues. Contact Esko to learn how to extend this
functionality.

Select a merge queue, right-click or click  and choose Pause Merge Queue to stop a merge
queue from trying to create layouts. The icon of the queue then changes to . Press plates can
still be added or removed, but no automatic merging will take place.

Choose Resume Merge Queue to activate the queue again ( ).

Pausing a merge queue is interesting in these cases:

• When, during busy production, you want to change some settings of that merge queue.
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• When you are used to work with layout proposals, you sometimes want to pause the queue
while investigating the proposals.

• When you use the DFS Merger in Automation Engine mode, the DFS will automatically pause
the merge queue that you selected there.

Tip:  There is no need to pause a merge queue because a CDI is down or offline. The merger
automatically detects this device status and will resume merging for that device as soon as the
CDI is available again.

Viewing and Managing Queue Entries (Press Plates)

To define which columns you wish to see, go to View >  Select Columns in ... or right-click on a
column header and (de)select the type. You can also drag columns to a different position.

Select an entry to see a panel with information on the press plate (LEN file), including its
submit date and due date.

The plate merger works fully automatic but there are some manual interventions you can still
do on selected press plates:

• Click  or right-click and choose Hold to prevent the merger from considering these
entries.

• Click  or right-click and choose Release to release these entries that were put on hold.
• Click  or right-click and choose Force Out to force the merger to create a layout instantly

including the press plate(s) you forced out. In this case, the queue's setting Minimum Fill is
ignored. The merger also tries to add other press plates to that layout (that were not forced
out but were in 'waiting' status).

The merger creates as many layouts as needed for all the forced out entries and then falls
back on its usual calculation schedule.

• Click  or right-click and choose Delete to remove the press plate from this merge queue.
• Click  or right-click and choose Info to see the XMP metadata of the press plate's LEN file.

Tip:  The dedicated view Press Plates offers more information and functionality on press
plates.

• Right-click an entry and choose Go to File to open the Files view and see the related LEN
file selected in its ( Job) folder.

An entry in a merge queue can have these statuses:

•  Waiting for the merger to be placed on a layout.
•  On Hold, not available for the merger until released again.
•  Forced Out. The queue entries that you forced out are still available in the queue with

this status until they disappear a few moments later (once the merger finished calculating
which other 'waiting' entries could also be put on the layout).

•  Rejected. Hover your mouse over the icon to read details. When a press plate remains
stuck in a merge queue, it most probably rejected by all targeted devices because of one or
several of these reasons:

• The press plate is too big for the device.
• The press plate’s resolution is not available on the device.
• The press plate’s imaging technology is not available on the device.
• The press plate’s imaging technology is not available for the plate type on the device.
• The press plate contains HD screens and the device does not have an HD Flexo license.
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• There are no devices available to merge for.
• The plate merger's output folder is low on disk space.
• The selected cutting flow file does not exist anymore.
• There is an unsupported drum installed. Sleeve and pre-mount drums are not

supported.
• The reason is unknown.

In some of the above cases, the reason for rejecting the item can disappear. For example:
When a CDI that was off-line becomes available again, the merger automatically detects
this. So the next time the merger calculates possible layouts, the items that were intended
for (only) that device will again change their status from 'rejected' to 'waiting'.

About Load Balancing

As mentioned above, when you allow a merge queue to create a layout for more than one CDI
("Device: Automatic"), then, if the plate fill percentage is very similar, the merger will choose
to create the layout for the device with the least work to do (based on the estimated time
mentioned in the device's status box).

This load balancing is not available for TIFF devices. When it has to choose between TIFF
devices there is currently no way to predict which one the system will choose.

Note:  If the merger has to choose between a CDI and a TIFF device (in a case where they
already have a similar waste percentage), it will choose the CDI device.

When the due date is more important than waste reduction

The plate merger's focus is on making layouts with the least waste. When submitting press
plates, you can also define a due date.

Follow these steps to make layout and output decisions (also) based on this due date:

1. In Plate Merger view, select a merge queue and select all entries in that queue.
2. Click  to put them all on hold.
3. Sort the list on due date by clicking on the header of the column "Due Date".
4. Select those that, for example, must be delivered within the next 3 hours.
5. Click  to release these entries.
6. Optionally, go see the layout proposals of this queue (unless the queue's already decided on

a layout and created merged plates).

Managing the Merger's Output Files

The plate merger creates many files in the folder that was defined in the Plate Merger item in
the Configure tool. You can there also define when these data should be cleaned up.

Plate Merger Configuration

Note:  Learn about the Plate Merger concept and View in the chapter Flexo CTP Workflow on
page 1340.

To configure your plate merger, go to Pilot >  Tools >  Configure >  Plate Merger.
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• Tab 'Setup' on page 1367
• Tab 'Reporting' on page 1368
• Tab 'Test Strips' on page 1371
• Tab 'Margins' on page 1374.

Tab 'Setup'

 

 

• Output Folder: This folder stores files created by the plate merger, in many subfolders.
These are the files you see when, in the Merged Plates view, you use the feature Open in
Browser.

The large LEN files that were created by the Create Merged Plate task also resides here. In
case of CDIs, their DFS Exposer application downloads them from this folder when he starts
exposing. For TIFF devices, the large layout TIFF file has its own output folder.

Caution:  Do not manually manage any of the files in this folder or its subfolders.

Click  to change the default path to a custom one.

Caution:  When changing this folder, make sure there are no more files in there that
are used by the merger.

• When you select Automatically delete files in subfolders (except reports), then
define in Clean up after after which time you want all these temporary files to be
deleted (merged plate LEN file, GIFs, XMLs, etc.).

Attention:  A merged plate cannot be resubmitted to be exposed again when its
related files in these folders have already been deleted.
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• Name Custom Field 1 - 5. Many of the Flexo CTP related views show columns. If you want
to use any of these 5 custom columns, enter their name here. The value of custom fields
can be set in the Submit to Plate Merger task.

• Select Use as grouping key if you also want to use that custom field as a grouping key
in the plate merger's merge queue. Grouping keys limit the plate merger's freedom to
decide which press plates can be considered to be placed on a same merged plate.

• Select Use the Customer field as grouping key if you want to avoid that press plates from
different customers (when specified) are placed on a same merged plate.

• Cutting Workflow.

When a merged plate was exposed on a CTP that will be cut on a cutting table, the here
selected workflow will automatically be started.

This workflow is launched on the XML that contains the cutting information that was
originally defined in the Submit to Plate Merger task.

• When you use a Kongsberg table, the workflow needs to submit that XML file using the
Submit to Kongsberg Table task.

• When your cutting table is not a Kongsberg, you need to create a workflow that selects
the cutting instruction file itself and then forwards that file to the cutting table. This can
be done by using the Select Referenced file task. An example:
 

 

Learn more about cutting flexo plates on a Kongsberg table in the chapter Kongsberg
Production Workflow on page 1407.

Tab 'Reporting'
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These 4 fields allow to automatically launch a workflow at those specific moments. These
workflows serve to send feedback to external systems, to inform them on statuses or deliver
information that helps cost calculation.

Note:  In stead of waiting for workflows to send this information, an external system can also
get such information on demand. Lean more in External Systems Requesting Information on page
1369.

The input file for these workflows is decided automatically. These input files are XML report
files containing specific information that is valid at that time.

Note:  These XML report files are picked up from a subfolder 'Reports' of the Output Folder
defined in the tab 'Setup'. These files are not deleted by the cleanup tool in that panel. You
could choose to have the workflow that you launch on them also delete them at the end (or
after a few months for example).

• When a merged plate is submitted on a flexo CTP device : This is each time a Submit to
Flexo CTP task sends a merged plate to a CDI "Exposer" queue or writes a TIFF in the output
folder for a TIFF device. This report is also available as a link in the task details of such a
Submit to Flexo CTP task.

• When a merged plate is exposed: Each time a merged plate is exposed, this XML can
deliver information about the device, plate usage, waste, etc. This workflow is also launched
when the merged plate was cancelled (removed from the CDI expose queue). In case of a
TIFF device, the state 'exposed' is already set right after the TIFF arrived in the output folder.

• When all press plates for a job are exposed: When all plates of a press plate set are
exposed (or cancelled), this XML can inform on which job, which plates, when, plate usage,
etc. This XML can for example describe the plate usage by the job's 5 press plates that
ended up on 3 different merged plates.

• When a merged plate is cut: Learn here how and when the CDI workflow communicates
plate cutting instructions to a Kongsberg cutting table (iPC). The workflow that you define
here will be launched each time such a flexo plate was cut. This signal to launch a workflow
can also be the case when the plate was exposed on a TIFF device and later cut on a
Kongsberg table.

Learn more about these XMLs in Interpreting the Reporting XMLs on page 1405.

The most simple workflow to launch on those XML files could be a "Copy or Move File" task
to make that XML file available to another system. Here is an example of a more advanced
workflow to feedback such events to a business system:
 

 

Note:  Learn more about delivering information to external systems in this dedicated chapter.

External Systems Requesting Information

Concept
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External systems (MIS, ERP, ...) are especially interested in how much flexo plate was used
for a job. They use this information to help decide the cost for that job. In stead of waiting
for workflows to send them this information, external systems can also get this and other
information on demand. Some want to see what is still waiting in the merge queues. Some
want to see the overall status of the CDI device(s).

1. Requesting info on how much plate was used for a job (cost, statistics)

An external system can do HTTP calls to request status information of all Press Plates of a
specific Job. To do this, the external system needs to execute an HTTP 'GET' request. It will get
an XML file as a result.

Syntax:

Tip:  As a test, you can also execute HTTP requests via a browser.

• Input:

Syntax of the URL to HTTP-GET the XML report:

http://<name-of-AE-server>:4412/FPL/job/<jobname>

• <name-of-AE-server> = the name of the Automation Engine server (the master
server).

• <jobname> = the Job Name of the job of which you want the XML report.

Example: http://<name-of-AE-server>:4412/FPL/job/1234banana

Note:  To get an XML where the list of Press Plates are listed per Press Plate Set, add the
parameter 'groupperset=1'. The "Images" (Press Plates) within the XML element 'Images'
will then be grouped per 'ImageSet'.

Example: http://<name-of-AE-server>:4412/FPL/job/1234banana?
groupperset=1

• Output:

An XML report describing all Press Plates related to that Job, including their current status.

2. Requesting info on what is still waiting in the merge queues (job load)
The amount of press plates that are still in merge queues also predict the work load for the
next hours.

Syntax:

• Go to http://<name-of-AE-server>:4412/FPL to see an information page.

• There, in the topic Live PlateMerger queue Updates(/MQ), click the link to see the 'Server
Sent Events'. The 'Server Sent Event' source can be reached at http://<name-of-AE-
server>:4412/MQ/SSE . An example:
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Per Merge Queue, the following information is returned:

• NAME : Name of the merge queue
• IDLE : "TRUE" when the merge queue is not merging/calculating proposals
• IDLE : "FALSE" when the merge queue is merging/calculating
• PAUSED : "TRUE" when the merge queue is put on hold
• PAUSED : "FALSE" when the merge queue is active
• QUEUELENGTH : Number of entries currently in that merge queue.

3. Requesting info from the CDI device

HTTP calls can also be used to retrieve information about the CDI Device status. This enables
to show what you see in the CDI Device view in your own custom dashboard.

Learn more in CDI Device Status in an External Dashboard on page 1349.

Tab 'Test Strips'

Concept
You can here define which test strips that the plate merger needs to add to the layouts it
makes. These test strips are LEN files that you created earlier.

Note:  LEN files can be used as test strip when they have sufficient XMP data. When your LEN
files are made by FlexRip 7 or older, contact Esko support for help.

Note:  Also when the merged plate will be a TIFF file, the test strip needs to be a LEN file.
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You also set up rules that define when which test strip needs to be added. These rules are valid
for all merge queues.

A test strip's position and orientation on the layout is fixed. Following the orientation as used in
the previews in the Pilot, the position of the test strip is always bottom left and vertical (rotate
-90). An example:
 

 

Note:  When calculating layouts, the plate merger first puts the test strip on the trial layout and
then checks how to fill the remaining area. The surface of a test strip is also calculated when
calculating the required fill percentage.

Attention:  On a merged plate, test strips are not counted as press plates (which
together represent the used plate area). This means that adding test strips increases
the waste area of a merged plate.

How to Add a Test Strip Rule

 

 

1. First register the test strip file. In Registered Test Strips, click Add, browse and select the
LEN file. The system will create a thumbnail and show you its Details.
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2. Then define a rule when this test strip should be used. In 'Define rules ...', click Add and
Name this rule.

3. Set the Conditions that need to apply for this test strip to be placed on the layout.

The most typical condition for such a rule is to add a test strip with the same resolution as
the other press plates on the layout. Other conditions usually are imaging technology, plate
type or adding them customer specific.

Note:  Creating these rules is very similar to creating filters in the Pilot. Learn more here.

See this example where one of the custom fields (that is also used as grouping key) helps to
decide if this merged plate needs a test strip or not:
 

 
4. Select the LEN file for this rule (from the list of the ones you registered earlier).
5. Optionally, add a Label to this test strip. This text will appear along its long side. A margin is

created automatically (on the side of the test strip where the label is added).

Tip:  It may be useful to add the plate name as a label above the test strip. This way, after
cutting, you can still find back which strip was used for which press plates. For example,
when you want to check a complaint on a certain press plate, then follow these steps to find
the test strip that was also on that same flexo plate:

1. In the Press Plates view, look up the press plate entry (filter via via job, orderid, id on
Plate, file name, etc.)

2. Right-click this entry and choose Go to Merged Plate.
3. Write down the Name of this merged plate. It is mentioned top right and has an

extension .par .
4. Use this name to find the test strip in the (physical) archive of your used test strips.

6. Click OK.
7. Click Move Up / Down to define the order in which multiple rules need to be executed. Put

specific ones at the top and general ones at the bottom.
8. (De-)select the toggle next to a rule to (temporarily) de-Activate that rule.
9. Use File >  Save to save your settings. These rules are then instantly picked up by all plate

merger queues.
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Tab 'Margins'
This tab allows to add extra margins around merged plates created by the Plate Merger. You
can add different margins per top, bottom, left and right side.

Note:  DFS applications refer to these margins as 'Frames'.

 

 

You can define these margins through a list of rules. Each rule can add margins for a specific
combination of a device and a drum size. Use the Add Up / Down buttons to define the order
in which the rules should be executed.

Tip:  A last rule could be one for Any Device and Any Drum. The plate merger will use this one
for all situations that were not specified in any rule set above.

The top, bottom, left and right sides match to the orientation that is shown when viewing the
merged plate as shown in these places:

• in the DFS "Exposer", in the Info dialog of that queue

• in the Merged Plates view

• in the preview dialog that opens when you select an entry, right-click and choose Open
Preview

• in the previews that, when you select an entry, are shown in the right side panes.

Working with Layout Proposals

Concept
When a merge queue has decided on a layout, the output workflow creates a merged plate.

However, there are several cases when you might want to see which Layout Proposals this
merge queue has calculated but rejects as a final merged plate because they are not fully
conform to the queue's Merge Settings (the required minimum fill %).

In the view Plate Merger, right-click any merge queue and choose Show Layout Proposals
(or use Alt/CMD-Down) to open a view that shows the layout proposals . You can there choose
which one you want to 'force' Expose. You can even edit a layout proposal before exposing it.
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These are typical cases where you may want to see and or change these layout proposals:

• Why is this press plate still pending in the merge queue?

You typically have double-checked the settings of the merge queue, but you still wonder
why the workflow does not continue.

• I want to understand in detail how this merge queue decides a merged plate.

Looking at the (rejected) layout proposals helps to understand how the settings of this
merge queue affect the layout calculations it makes.

• As a CTP operator, I want to see all layout proposals for a specific device, so I can
choose which merged plate to expose next on this device before its queue runs
empty.

Even in a workflow where you expect the best layout proposal to be chosen automatically,
a CTP operator might still want a moment of visual control over which proposal should
become the merged plate.

• I want a visual overview of layout proposals based on their urgency.

Sometimes, the urgency of a plate is more important than its waste percentage and you
manually want to decide this priority.

• I want to manually inspect or optimize the laser beam count of a layout.

Sometimes you can manually optimize the speed in which a plate will be exposed by re-
arranging press plates on the layout.

Inspecting and Exposing Layout Proposals
This view shows the layout proposals of one or all merge queues. You can inspect them. You
can choose to expose a selected one. You can not delete a layout proposal. The next page
explains how you can view a layout in detail and possibly make changes before exposing it.

Attention:  This view does not show all possible layouts ; there could easily be millions
of combinations. It only shows the best proposals, the ones with the least waste.

The top bar in this view is in a light yellow color. This can help remind you that you are looking
at proposals, not at Merged Plates.
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1. Click  < Merge Queues (or use ALT/CMD-Up) to leave this view and go back to the list of
press plates of this merge queue.

Note:  To avoid navigating back and forth, create an extra Tab to view both modes (File > 
New Tab).

2. Name of the selected merge queue. The icon indicates if the queue is active or paused.

• Double-click it to open the queue's settings.
• Right-click it to select a different merge queue. This avoids having to navigate away from

this view. You can also select this view for All Merge Queues.
3. This number shows the amount of press plates in this merge queue (no matter what state

they are in).
4. Click 'Request Auto Merge' to manually trigger the merger to (re-)calculate layout

proposals.

Tip:  When new press plates are submitted when the merge queue is paused, this view will
not change. You can then click this button to trigger a new calculation of proposals.

Note:  While the merger calculates, this button changes to 'Cancel Auto Merge'.
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Tip:  When, after a short while, you still do not see any change in the proposals, go see
the list of entries for this merge queue and check any error message(s) in their details
pane. They could show that entries are "too big" or request "unsupported imaging
technology".

5. Resume Merge Queue or Pause Merge Queue: A shortcut to pause or resume this merge
queue (without leaving this view).

6. Layout proposals can be shown in several ways.

Tip:  Use the  slider in the Pilot's top bar to change their display size.

Tip:  Use the arrow buttons to navigate through the proposals.

Right-click anywhere in the overview area and choose from:

• "Arrange by"

• by Device (as in above screenshot): Grouped per device. These are the devices that
are listed in the settings of the Merge Queue, in "Merge For".

• by Size: Grouped by size of the layout.

• by None: This shows all of them, now no longer in one horizontal list but in a
continuous display using any rows below.

• "Sort by": Choose which layout is shown first:

• Waste: The one with the smallest waste percentage.

• Due Date: The most urgent one.

• "Organize by Layout". Identical layouts are then shown in stacks that you can browse
through. This is especially useful when you have multiple CTP devices that are using the
same plate size. You then also typically arrange the view by plate Size.
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Note:  An example: You have two CDI Spark 5080 devices that use plates with the same
size. You asked to calculate layouts for both devices. You switched on 'Organize by
Layout' and 'Arrange by None':
 

 
When you click on the arrows beneath the stacked layout, a next layout in this stack is
shown. This other layout however will typically look identical. This is because the layouts
in a stack have the same layout of the same press plates.

What typically does change in a stack of layouts is the name of the device: these are
identical layouts made for more than device.

7. The amount of layouts (or layout stacks) shown in this arrangement (device/size).
8. The total amount of layouts (or layout stacks) shown for this merge queue.
9. • Device name (when not viewing 'Arrange by Device').

• Layout size (when not viewing 'Arrange by Size'). If this layout is chosen to be exposed,
this is then the size of the merged plate.

• Due dates, shown in red when it is overdue.

• Waste percentage.

10.Information about the selected layout proposal. Learn more in Merged Plates.

• Beams: This shows the average beam count for the entire layout. This gives an indication
how long it will take to expose this layout.

• Grouping: These are the values of the parameters that were involved in grouping these
press plates onto a same layout (both system level and custom grouping keys).

11.As mentioned above, not all layout proposals are shown, only the best ones.

The top screenshot on this page shows such an example:

• The selected proposal (bottom left) for the Spark 5080 shows that here are 4 press
plates for the 'Shrek' job: C, M, Y, K.

• Above, on the smaller plate for the Spark 2530, only one proposal is shown, including
only C, M, K. There are other layout proposals for this smaller plate, but showing those
here brings no extra value: Or they contain a same amount of press plates from a same
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set, or their waste percentage is (much) higher. Therefore, in this example, only this one
best layout is shown.

Choosing to Expose a Layout Proposal

When you want to output a layout proposal, right-click it and choose Expose.

This will remove it from this view and start the assigned output workflow for this merge queue
(creating a merged plate and sending it to the CDI).

When you choose to expose a layout, the current list of proposals disappears. This is because
the plate merger immediately recalculates new layout proposals, now using the left-over press
plates.

Note:  You can change a proposal before exposing it. Learn more below.

Inspecting and Changing a single Layout Proposal

Detailed View of a Layout Proposal

In the overview of layout proposals, double-click a proposal to open it in a different view where
you can inspect and change it.

 

 

1. Press < Layouts to go back to the overview of layout proposals.
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Attention:  When you leave this view, any possible changes to this layout proposal
will be lost.

2. Click Pause Merge Queue or Resume Merge Queue to pause or resume this merge
queue. Similar buttons are available when you are viewing All Merge Queues.

3. The Info button shows a right pane with details about the layout proposal (top) and about
the selected press plate (bottom).

4. The Press Plates button shows a right pane that assists you when manually placing the
press plates. Learn more in Working with the List of Press Plates on page 1384.

5. This is the width and height of the layout proposal. Use the numeric fields (including
calculator) or the cropping icons.

6. This is the X and Y position of the selected press plate. Use the numeric fields (including
calculator) to re-position it or use the icons to center it on the layout. Learn more here.

7. This is the beam count for this vertical lane of the layout. Learn more in Information on
Beams used per Lane of Press Plates on page 1381.

8. This indicates how many (selected) press plates there currently are on this layout.

Notice the different colors for sizes and margins:
 

 

1. Drum size (grey). This grey area is not visible when the layout is the size of the drum.
2. Layout size (when exposed, the size of the merged plate) (pink).
3. Merged plate margin (darker pink).
4. Press plate margin (grey around press plate).

In this mode, you can measure details, inspect beam counts, change the layout and choose to
expose it from this view.

Note:  Editing features that are not available here might be part of the separate application
"DFS Merger" (for example the tools for a PlatePatcher workflow).
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Information on Beams used per Lane of Press Plates

Attention:  Information on CTP laser beams is only available for CDI devices.

Sometimes, the urgency of a plate is more important than its waste factor. To help judge the
speed that the plate will exposed with, you also see the predicted amount of laser beams per
'lane' of press plates.
 

 

1. In the center of each press plate, the number in the black rectangle indicates the maximum

amount of beams that this device can expose this press plate with. For example .

Note:  This beam count is based on the angle, ruling and resolution of the LEN file.

Note:  No number is shown when the press plate has no screened data or when its XMP
metadata does not mention screening information.

Select a press plate to see more info in bottom part of the details pane on the right:

• Beams: This list all possible beam counts for the selected press plate.

• Select Allow all beams when you want the beam count only to be based on resolution.

Note:  In the "DFS Merger", this option is called "Testform".

Caution:  Enabling this option can cause moiré on the exposed plate.

Some examples cases where this can be useful:
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• When there are only solids in the press plates (0 or 100 %).
• When you do not want the presence of a halftone object to slow down the exposing

of the full plate. This could be an image in a test strip or for example a small image
that was triggered by a SmartMark. The quality of such images may be less important,
so you do not want them to slow down the exposing.

• When exposing a plate with only test charts where the halftone data is not important.

2. At the bottom of the layout proposal, a small number shows the highest possible common
beam count for all press plates in that specific vertical lane (in DFS referred to as 'Stripe'). A
random colored horizontal line above this number indicates the width of the lane.

This number is re-calculated every time the layout changes.

Note:  Sometimes, by swapping 2 press plates, you can increase the beam count for a lane,
and so expose the plate faster.

When this view cannot detect or calculate a number, it will show the default minimum of
'4'. An example: In above screenshot, the press plates of the 2 of the wine label repetitions
(bottom left) have no screened data and so the beam count for their lanes is '4'. Solve this
by selecting them (one by one) and selecting Allow all beams.

Note:  The beam count shown here is only a calculated prediction. The real beam count used
during the exposing is decided by the DFS when it reads the LEN file of the merged plate. This
view could for example show '4' because of press plates without screening, while the CDI itself
can decide it can and will be higher.

Changing a Proposal before Choosing to Expose it

This view not only allows close inspection of a layout proposal but you can also make changes
to its content or to its size. However, you can not save these changes. These changes only
serve to make a more optimized layout right before you choose to Expose it.

Tip:  All changes can be undone (use CTRL/CMD-Z).

Note:  To select multiple press plates:

• Hold CTRL/CMD while selecting.
• Click and drag an area. All press plates touched by this area will be selected.
• Use CTRL/CMD-A to select all.

Functionality:

• Moving press plates:

• By dragging: Select one or more press plates and drag them to another position. The
snapping tool helps you to position them accurately (see the assisting blue lines). A dark
red color indicates an overlap with other press plates or any position outside the layout
area.

Note:  When multiple press plates are selected, the movement is done on the bounding
box of the selection.

• Numerically: Select one or more press plates, enter a new value for X or Y in the details
pane and confirm by pressing Enter or Tab.
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When multiple press plates are selected, the position can be specified in an absolute or
relative manner:

• When the entered value starts with + or -, the value is interpreted as a relative value.
All press plates are moved, relative to their current position.

• When the entered value does not start with a sign, the value is interpreted as an
absolute value. All press plates are then moved to the exact position that was entered
(and are probably overlapping).

• Centering: Select one or more press plates and, in the X or Y fields, click on  (center
horizontally) or  (center vertically).

Note:  Press plates that overlap or are moved outside the layout area are highlighted in red.
Warnings will appear when you then choose to Expose.

• Rotating press plates:

Right-click your selection and choose Rotate to rotate them 90 degrees clockwise or, when
they already were rotated in this view, counter clockwise.

Attention:  Before rotating, the system checks two options used when submitting
these press plates to the plate merger:

• When one or more press plates were submitted with a forced rotation (0 or 90), a
warning appears. You can choose to Rotate Anyway or Cancel this request.

• When you submitted these press plates without allowing different rotations, the
plate merger might have decided to rotate them all, as a group. When such a
group rotation is detected, you will be asked to choose between Rotate Anyway
(only those you selected), Group Rotate (also those in the rotation group) or
Cancel.

• Swapping press plates:

Press CTRL/CMD and click to select 2 press plates. Then right-click this selection and choose
Swap to make them swap position. Their rotation will not be changed.

• Removing press plates:

Right-click your selection and choose Remove to remove these press plates from this layout
proposal.

• Changing the size of the layout area:

• Automatically: Cropping the merged plate. You can crop the (pink) layout area to fit to
the area taken by the press plates. This allows you to create a partial merged plate (in
case you choose to expose that layout). All required margins will remain.

To do this, click the crop buttons in the W or H input fields:

• Click  to crop and fit the layout horizontally.
• Click  to crop and fit the layout vertically.

• Numerically: Enter a new size in the W or H input fields. Remember you can use these
fields a s a calculator.

• Right-click a press plate and choose Go to File to see the LEN file of press plates selected in
the Pilot's Files view.
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• Right-click a press plate and choose Info to open the dialog showing the XMP metadata of
this LEN file.

• Right-click a press plate and choose View to open the related LEN file in the Viewer. This is
only possible when prepared view data is available. Learn more in Viewing RIP data.

• Right-click anywhere in the layout and choose Expose to start the output workflow for this
layout proposal.

Working with the List of Press Plates

In the right pane, the button Press Plates lists the press plates that were placed on this layout
proposal.

In the list, the icon  below their thumbnail indicates that this press plate is still present on the
layout proposal. Those without this icon were manually removed by someone in this view.

To place removed press plates back onto the layout, simply drag and drop their thumbnail onto
the layout.
 

 
In the list:

• Double click a thumbnail to select that press plate on the layout.
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• Use the search field to reduce the list or to find a specific press plate.

17.2.6.  Merged Plates

Concept

This view gives an overview of all Merged Plates that the Plate Merger created.

When your Pilot is in 'Last Used Job' mode, you will only see the merged plates of that Job.

Merged Plates are kept in this database until they are removed by the cleanup settings that you
define in the Plate Merger item in the Configure tool.

Note:  This view does not show merged plates that someone created manually in the DFS
merger using LEN files from a (local) "working folder". It does show merged plates that the DFS
merger made in "AE mode" (using press plates that were present in a Plate Merger queue).

Select a merged plate to see a preview and its key attributes in a right pane.
 

 
In the preview, the pink area represents the non-used area (waste).

Note:  Test Strips are also shown in the preview and are also counted as waste:
 

 

Columns
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Note:  As in many views in the Pilot, you can

• re-arrange columns by dragging their title to a new position
• sort them by clicking on a column title
• right-click a column title and choose to Hide this one or any other. In the list that appears,

select Select Columns... if you want to change or re-arrange multiple items.
• use filters and optionally save them as a Smart View.
• define your preferred unit in Edit >  Preferences >  Units.

Most columns are identical to those already mentioned in the Press Plates View. We here only
describe those specific for this view:

• Height and Width of the Drum.
• Total Area: Height x width, the maximum area that can be imaged (drum surface.)
• Total Used Area: Imaged area (the area occupied by press plates on the merged plate).
• Waste: Total non used area of the merged plate.
• Name: The grapholas parameter file (.par), containing detailed exposing parameters.
• Estimated: The estimated Exposing Time. For example 12:27 means 12 minutes 27

seconds.

Attention:  CDI's with a Grapholas version 12 up to v14.0 offer a more limited
interface with Automation Engine. The estimated expose time is then not accurate ;
it will often be too short.

• Creator: 'MQ' indicates this plate was created by a merge queue (Automation Engine). The
name of that merge is mentioned in Merge Queue Name.

• Merged By: It describes which technology was used to merge this plate. It can also indicate
who manually intervened.

• "AutoMergerProposal" indicates it was done by the automatic algorithm of the Plate
Merger.

• "Manual" indicates that someone manually intervened in the layout. The network IP
number indicates on which computer this was done. The user name is also mentioned.

• "_DFSMerger" indicates that the layout was decided in the application "DFS Merger".
• "_Pilot" indicates that the layout was manually changed in the Pilot before choosing

'Expose'.

Functionality

After selecting an entry, right-click or choose the icon in the tool bar to:

• Reconsider:

This resubmits all the press plates of this entry back to the plate merger and it removes the
entry from this CTP queue. It also removes the entry for that merged plate in the Merged
Plates view.

This feature is interesting when you think that you can get a better fill percentage on this
merged plate when some of the new (smaller) press plates that recently arrived in the
merge queue could also become part of the layout.

•  Resubmit Merged Plate: This resubmits the merged plate back to the CTP device.
A dialog opens where you can choose the device. By default it proposes the one that was
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used before. When you confirm this choice, you will immediately see it appear as a new
entry in the CTP Queues view, at the end of the queue of the chosen device queue. When
the chosen device is not compatible for this job (due to different imaging technology for
example), you will get a warning and you will not be able to resubmit.

Most typical use cases:

• when a flexo plate was damaged and you need to remake the whole plate again, in
exactly the same way.

• when the flexo plate (that you do not need to cut) is used for a very long print run and a
press operator asks you to create an extra exact copy of that flexo plate.

Attention:  This does require that the LEN (or TIFF) file of the merged plate has not
been cleaned up yet (see setting in the Plate Merger Configuration).

Note:  Resubmitting a merged plate also creates, for each press plate on that merged plate,
a new entry in the Press Plates view. It also affects the numbers in the Press Plate Sets view, in
its columns Merged Plates and Press Plates.

•  Resubmit Press Plates: This resubmits all the press plates on this merged plate to the
plate merger (those same LEN files with their same submit options).

The difference with the above "Resubmit Merged Plate" is that the press plates may this
time end up on a different kind of layout, on a merged plate that looks different.

Attention:  Note that, if the selected merged plate is still in the CDI "Exposer"
queue, that this does not remove it from that queue. Also for TIFF devices, this does
not remove any TIFF files from the output folder. If you do wish to also remove the
item in the CDI "Exposer" queue, then we advise to use the feature 'Reconsider
Merged Plates' that is available on items in CTP queues.

• Show in CTP Queues: This opens the CTP Queues View with this merged plate selected.

Note:  When you delete the queue entry there, its merged plate will still be part of the
Merged Plates view but its state will be on Done, with errors.

• Open Preview: This shows the merged plate as it would look in the DFS Merger.
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1. The red area indicates the merged plate margins, as set in the Plate Merger Configuration.
2. The light grey indicates the press plate margins, as set in Merge Settings of the used Merge

Queue.
3. The green objects indicate cut marks or lines, as set in Merge Settings of the used Merge

Queue.

Note:  This type of preview also shows a preview of any placed test strips.

• Open in Browser. This tool is not required in normal daily use, but can be helpful to easily
access the files created in background (in the folder as defined in the Configure tool), for
example to read the XML file.

Zooming in on a Merged Plate

Double click an entry to get a closer view of the content of that merged plate.
 

 

Click the < Merged Plates button to see this merged plate back in the main (list) view of the
merged plates.

Tip:  You might have landed on this view directly from another view (for example by using the
"Go to Merged Plate" option in the Press Plates view). If you then want to go back to that previous
view, use the toolbar button instead: .

When you select a press plate, its key info is added to the right pane.

You can use CTRL-click to select multiple press plates and see their names highlighted in the
panel.

Functionality:

After selecting one or multiple press plates, a right-click offers to:
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• Resubmit Press Plates: Also here you can resubmit the selected press plates back to the
plate merger, where they will start their workflow again from that point on. The way they
are submitted is identical as when they were originally submitted to the plate merger (same
plate type, imaging technology, grouping keys, etc.).

Attention:  This does not remove them from this merged plate and this does not
remove the merged plate. This function is therefor useful when the merged plate
was already imaged and you later want to image only some of the press plates
again.

• Go to Job: When the Pilot is in Container mode and when the selected press plate is part of
a Job, select this option to filter the Merged Plates view to only those of that Job.

• Go to File: Open the Files view and selects the LEN file of the selected press plate.

• Show in Press Plates: Shows the selected press plate in the Press Plates view.

• View. Opens the press plate's LEN file in the Automation Engine Viewer. This will require the
LEN file to have prepared view data (learn more in Working with RIP data in the AE Viewer).

Note:  If you wish to open LEN files in the DFS "View" application (aka "Esko Bitmap Viewer",
Windows only), then choose 'Go to File' and double-click the file there. This will open the file
in the application that you first instructed your local computer to 'open with'.

• New Task: Use this tool to select a task ticket to launch on the LEN file of the selected press
plate. This is for example how you can submit the selected press plate(s) back to the plate
merger but use different options than those that were used originally.

17.2.7.  CTP Queues

The CTP Queues view shows the queues of configured Flexo CTP devices, both the CDI and the
TIFF devices.

• The queue of CDI device shows what is present in the "Exposer" queue of that CDI. The
"Exposer" is the DFS/Grapholas application where you manage the queue and start the
actual exposing. This view automatically updates to show new or changed entries.

• The queue of a TIFF device shows the TIFF files that are currently in its Output Folder.

You can see these queues in a time line or in a list view mode.
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Note:  Go to Tools >  CTP Queues to open this view in a separate window. To avoid seeing only
Job specific entries, switch to Container view or Jobs Overview before doing this.

Note: When a CDI device is offline, this icon appears next to its name: 

•
 Time Line View Mode

• Each queue entry is visualized by a rectangle. Its default color is blue.

For a CDI device, it's length corresponds with the estimated duration to expose that job.

Attention:  CDI's with a Grapholas version 12 up to v14.0 offer a more limited
interface with Automation Engine. The estimated expose time is then not
accurate ; it will often be too short.

Entries in a queue of an (offline) TIFF device are always shown by a rectangle
representing 30 minutes. The time in between entries, representing a plate change, is a
default of 3 minutes.

• When an entry is being exposed, that entry moves gradually to the left of the red line.
For a TIFF device, the entries appear and disappear as the TIFF files appear of disappear
from their output folder.

• Use the slider  to increase or decrease the size of the queue entries.

Tip:  Click on the slider to select it. This is indicated by the blue bar: . At this
point you can use the arrow keys to increase or decrease the entries.
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• Select an entry to see its details on the right. You can use the left-right arrows to navigate
through the queue and change the selection. For TIFF files, only the resolution and size is
known.

• When your Pilot is in Last used Job mode, all the entries that relate to a different Job
are greyed out and can not be selected. Switch to Containers view to make sure you can
select any entry.

•  List View Mode.

This view makes it easier to read an entry's name or plate type. You can also click the
column headers to sort by that attribute.

Note:  When your Pilot is in Last used Job mode, this list only shows entries that belong to
the selected Job.

Conditional Coloring

Coloring the entries helps to get a quicker understanding of the queue's content. You could for
example assign a color per plate type or per resolution or per urgency (based on due date).

This conditional coloring is applied on all devices and is saved per user, so different users can
use different coloring rules.

Follow these steps:

• Right-click the name of any of the CTP devices and choose Conditional Coloring.

• Add one or more rules.

• Rules are executed top to bottom. Use Move Up / Down to change their order.

Managing Queue Entries

• Search and selecting. Type in the filter field to search on (parts of) a job name or plate type
properties. For example, search on the name of plate type or a resolution.

Tip:  Selections that you make remain active when you switch the  /  view modes. An
example: In the  List view mode, sort per column and then make a multiple selection.
Then switch to the  Time Line view mode where the selection is kept and then move the
selected entries to the front of the queue.

Tip:  You can also execute below mentioned actions on selections that you made with the
filter.

• Deleting queue entries. Select and press Delete (or right-click and choose Delete) to
remove entries from a queue. You will be asked to confirm.

Deleting a queue entry from a TIFF device deletes the TIFF file.

In the Merged Plates view, you can see how the merged plate still exists but has changed
its status to  'Cancelled'. The related press plates and press plate sets also get the status
'Cancelled'.

• Moving an entry to a different position in the queue. You can re-arrange entries in a
queue by using drag and drop, even on multiple selected entries.
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This functionality is not available for TIFF devices.

• Moving an entry to another queue. When a CDI needs to go in maintenance, or when you
manually want to balance the load, you can drag and drop one or multiple queue entries
into the queue of another CDI device.

Because a device is never exactly the same, the merged plate that changes device will
always be re-calculated. You will always get feedback and will be asked to confirm.

• The system does various checks if the new device is compatible for this job. When the
entry cannot be exposed on the other CDI, you get a warning and the entry will stay in its
original queue.

• When the entry can be exposed on the other CDI, you get an information dialog and the
entry will eventually show up at the back of that other queue (so not in the place where
you dropped it).

Note:  This is what happens in detail: All device specific data is removed from the layout
XML file and the output workflow of the merge queue (where it was originally made) is
launched again. This re-creates a merged plate and that LEN file is then submitted to the
new device where it appears as a new entry at the back of its queue.

This functionality is not available for TIFF devices.

• Reconsider Merged Plates.

This resubmits all the press plates of this entry back to the plate merger and it removes the
entry from this CTP queue. It also removes the entry for that merged plate in the Merged
Plates view.

This feature is interesting when you think that you can get a better fill percentage on this
merged plate when some of the new (smaller) press plates that recently arrived in the
merge queue could also become part of the layout.

17.3.  Flexo CTP related Tasks

Note:  In a standalone setup of Device Manager, several of these tasks are not available.

17.3.1.  Add Margins to LEN file task

Note:  The flexo CTP platemaking workflow, its terminology and the Plate Merger are described
in the introduction of this chapter.

Concept

This task adds margins to a LEN or LENX digital film file. These extra margins can so help plate
mounting or plate re-mounting (PlatePatcher workflow).

Using this task can also make sure that there is (just) enough space between press plates (LEN
files) on a merged plate. However, that can also be achieved by using the option Press Plate
Margins in the merge settings of a Merge Queue. That way, you are not changing the actual press
plate LEN files but only adding these extra margins in the calculation of the layout.
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Note:  When you want to add extra margins to a merged plate, then use the plate merger's
option to add margins to the merged plate.

Settings

Enter a value per side or use SmartNames to specify the value(s). SmartNames can help
automate the fact that your different printers may want different plate margins.

Note:  You can also enter negative values. That side will then be cropped with that distance.
You can however crop the file automatically with the Crop LEN File task.

Caution:  Some Step & Repeat tasks (and also Plato) offer an option to "Include CAD
info for Digital Flexo Suite" in the PDFPLA file. This is used to include the technical
inks data in the metadata of the output file. In the Bitmap Viewer and in the DFS Viewer,
you can see these as layers “Plato Cut” and or “Cut/Crease line registration”. A LEN
file made from that PDFPLA file will then have that information embedded. However,
launching this Add Margins to LEN file task or the Crop LEN file task on such a LEN
file will remove that metadata (layers) and end with a warning. Mind that this does not
remove the metadata / layer named “Staggered Cut”.

Note:

• If you want to view your LEN files after adding margins (for quality control), you can use:

• the Grapholas Viewer,
• the Bitmap Viewer,
• the Prepare for Viewer task and then open it in the Automation Engine Viewer.

• For LENX files, you can use:

• the Grapholas Viewer,
• the Bitmap Viewer.

Note:  To view LENX files in the AE viewer, you can not use the Prepare for Viewer task.
LENX files need to be prepared for this viewer as an option in the RIP. Learn more in this KB
article.

17.3.2.  Crop LEN File task

Note:  The flexo CTP platemaking workflow, its terminology and the Plate Merger are described
in the introduction of this chapter.

Concept

This task serves to crop a LEN (or LENX) digital film file to the bounding box of all visible objects
combined. By default, the task crops the LEN file to first pixel of that separation.

However, when there is a staggered cut line present in the file, the task crops to the bounding
box of that line (even if there are pixels outside the cut line). An example:
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Note:  A typical workflow might be to first use this task to crop the LEN files and then use the
Add Margins to LEN file task to add margins again (and maybe not on all 4 sides).

Caution:  Some Step & Repeat tasks (and also Plato) offer an option to "Include CAD
info for Digital Flexo Suite" in the PDFPLA file. This is used to include the technical
inks data in the metadata of the output file. In the Bitmap Viewer and in the DFS Viewer,
you can see these as layers “Plato Cut” and or “Cut/Crease line registration”. A LEN
file made from that PDFPLA file will then have that information embedded. However,
launching this Add Margins to LEN file task or the Crop LEN file task on such a LEN
file will remove that metadata (layers) and end with a warning. Mind that this does not
remove the metadata / layer named “Staggered Cut”.

Note:

• If you want to view your LEN files after cropping (for quality control), you can use:

• the Grapholas Viewer,
• the Bitmap Viewer,
• the Prepare for Viewer task and then open it in the Automation Engine Viewer.

• For LENX files, you can use:

• the Grapholas Viewer,
• the Bitmap Viewer.

Note:  To view LENX files in the AE viewer, you can not use the Prepare for Viewer task.
LENX files need to be prepared for this viewer as an option in the RIP. Learn more in this KB
article.
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Task Settings
Bleed:

• The bounding box of all pixels found in a separation is extended with this bleed. The task
then crops to that enlarged area.

• If there is a staggered cut line, the task crops to the area of the bounding box of the cut line,
enlarged with this bleed.

17.3.3.  Submit to Plate Merger task

Note:  The flexo CTP platemaking workflow, its terminology and the Plate Merger are described
in the introduction of this chapter.

Concept

This task serves to submit Press Plates (LEN files) to a Merge Queue of the Plate Merger.

Press plates that you submit to a merge queue can be merged together on a same merged
plate,

• when they have the same value for plate type, resolution, imaging technology and cutting
workflow,

• and when they have the same value for custom Grouping Keys (that you can set up in the
Configure tool).

Attention:  The plate merger requires that the XMP metadata of the input LEN files
contain information on hsize, vsize and resolution. This is the case for LEN files
created by Imaging Engine or FlexRip version 14 or higher.

Important:  LENX files are LEN files that contain Crystal screens. The plate merger will error
when he is asked to make a layout for a TIFF device, which does not have the required 'Crystal'
technology.

In a workflow, you can add this task after the RIP'ing task. See this example, where the LEN files
are first cropped and where also view files are created for the Automation Engine Viewer:
 

 

Tab 'General'
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• Merge Queue: Select or name one of the merge queues that you defined in the Plate
Merger view.

Note:  When a  warning sign a appears left of the selected name, hover your cursor over
the icon to read more about the problem.

• Rotation: Define how the press plate may be rotated on the merged plate:

• Set by Merge Queue: This leaves the decision to the merge queue, so allowing it more
variants in its calculation of the layout with the best fill percentage.

• Force 0: It will not be rotated, it will stay in the orientation as shown in the press plate
preview and as shown in the Automation Engine Viewer.

• Force 90: It will be rotated 90 degrees clockwise.

• Select SmartName: To find out what the parameter value is of an entry in a drop-down
list (or of an icon), select that entry from the list, then right-click that setting and choose
Copy Parameter Value. Then paste that value in any input field. You then can see what
the SmartName should resolve to.

Note:  A rotation (request) on the merged plate is never done on the input press plate
LEN file(s). On that level, it is only done when the merged plate LEN (or TIFF) file is created
(during the Create Merged Plate task).

• Imaging Technology: Select the imaging technology that these press plates need to be
imaged with. This field automatically serves as a grouping key.

This list shows all available technologies on all configured Devices (DFS Merger's). It is
automatically updated. Learn more about these technologies in the documentation of
PlatePrep.

For any output on a flexo CTP TIFF device, you need to select 'Standard'. Else, they will
appear in the plate merger but will be rejected immediately resulting in an error status. The
details pane will explain that the selected technology is not available on that device.

Note:  The technologies 'Speed' and 'Speed UV' require Grapholas v19.

• Due Date: When considering the layout of a merged plate, the merger's main criterion is
the fill percentage (learn more in Plate Merger on page 1359). However, when you here add
a due date, the merger also takes this time into account to make sure you that you have
these press plates on the CTP device on time (there as part of a merged plate).

Note:  The effect of setting a due date can be compared to the Force Out option in the
merge queue, but then as an automatic step at the specified time.

• None.

• Time setting: Select or specify an absolute or relative time.
• Job due date: The due date is taken form the due date of the Automation Engine Job that

the LEN files belong to (residing in its job folder).

Note:  When the job due date changes, the entries in the merge queue that were
submitted with the list option "Job due date" will adapt and reflect this new date. This
will only be done if the press plates are still in the Merge Queues. This will not be done if
the press plates were already sent to the CTP queues.
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Note:  When the due date you want is the one from the Job, then do not use the
SmartName version ; use this item in the drop down list to avoid any error due to
formatting problems.

• Select SmartName.

Note:  If you are using a SmartName for date or time, the resulting format needs
to be compliant with ISO 8601 (YYYY-MM-DDThh:mm:ssTZD) . For example:
2014-07-28T12:00:00+01:00.

Attention:  When you relaunch a Submit to Plate Merger task that had a due
date defined on an absolute time, it is then possible that that due date has already
passed. This will have the effect that the press plates, the moment they arrive the
merge queue, already have the status 'forced out', and therefor quickly disappear
again from that queue.

• Label: The text you enter here is placed on the merged plate, around each press plate. The
text label is placed on the chosen position, centrally. It uses the font "Arial" and the size is
4 mm. If there was not yet a margin of 4 mm, it will be created automatically on the side
where the label is placed.

• Position: If you defined a text label, then choose here in which margin around the press
plate that the label should be positioned. Top or Left means on top of or to the left of
the press plate as you would see it when viewing it placed on a merged plate and viewed
using the "Show preview" or the Bitmap Viewer. When using a SmartName, use t for Top
and l for Left.

Note:  If either the label text or position is based on SmartNames that cannot be
resolved for one input file, the task will fail for all input files.

Note:  Before AE v18.1.1, adding a label added a margin of 4 mm on all 4 sides of the
press plate.

• Allow different devices and rotations:

• When this option is not selected, all press plates that you here submit will end up on the
same device and have the same rotation.

• When this option is selected, they can end up on different devices and have different
rotations. This can result in layouts with less waste.

• Apply cutting flow:

Select this option when the merged plate will be cut on a Kongsberg cutting table.

• When that Kongsberg table was also added as a Device, then the workflow status will
include the status of the cutting on that table.. The status 'Exposing Done' will change to
'(Cut) Done' once that signal comes back from the Kongsberg table.

• When that Kongsberg table was not added as a device, the required cutting files will still
be created but you have to adapt your workflow so that they are provided to the table.
Learn more below on setting up this cutting workflow in the Configure tool (Plate Merger).

This off-line link means that the flexo CTP workflow can not be aware of the cutting
status. It therefor already sets the state of the (merged) Plate to 'Cut = Done' right after
the exposing is done on the flexo CTP.
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Note:  This option is not available when your setup is a standalone Device Manager.
Contact Esko to learn how to extend this functionality.

• Cutting Flow. Select the type of cutting from the drop down list. This field automatically
serves as a grouping key.

Note:  The .xwf files in this list are those on the central resource folder on the
Automation Engine server. This is the folder where the DFS merger writes .xwf files when
it is in "AE" mode.

The Cutting Flow that you define here will later be part of the XML file that, once the CDI
plate is made, can automatically be sent to the cutting table. Learn more in the Configure
tool, where to define that workflow to launch (in the tab Setup) and where to define any
reporting related to cutting (in the tab Reporting).

Tip:  To achieve a better fill rate, the Plate Merger by default merges press plates with and
without a cutting flow . However, the plate merger will not merge press plates that ask for a
different cutting flow.

In the special case you never want to mix press plates with and without a cutting flow, you
can use a grouping key to prevent this:

1. In Pilot >  Configure >  Plate Merger > (Setup), pick a custom field, give it the name (for
example "Manual Cutting") and select the option "Use as grouping key".

2. Then, when submitting press plates that may not be cut on a cutting table, put the value
for this custom field ("Manual Cutting") on "Yes".

• Job Info: This option is only available when your setup is a standalone Device Manager.
Consider using SmartNames to pick up job information that came from your MIS.

Tab 'Custom Fields'

• Custom Field 1 to 5: The name of these 5 custom fields is set up in the Configure tool. Their
name becomes the name of the columns in several of the CDI related Views. You can then
also use their values when filtering. A setting in the Configure tool decides whether they
will also be used as grouping keys.

17.3.4.  Create Merged Plate task

Note:  The flexo CTP platemaking workflow, its terminology and the Plate Merger are described
in the introduction of this chapter.

Concept

As mentioned in Main steps in setting up a Flexo CTP workflow and in the Plate Merger View, this
task is the first step of the workflow that the merge queue launches when having created a
layout.

The input file of this task is the XML file with all the details of that layout.

The task creates a LEN file of that layout. When the chosen device is a CTP TIFF device, this
layout file is a TIFF file.
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It also creates previews and other files that are all written in the Output Folder defined in the
Configure tool (where you can also define when these files need to be cleaned up).

Note:  Creating a large bitmap file is an intensive task for your Automation Engine server.
You will also notice that this task takes longer when it first needs to rotate press plates before
placing them on the layout.

By default, the Name is the name of the input XML file. Use SmartNames to change this. This
name will be used as the name for the job in the CDI's Exposer queue.

The output of this task is also an XML file. This one refers to the LEN file and other related files
it created.

When this was requested for its press plates in their Submit to Plate Merger task, this task also
creates the cutting instruction. This cutting file is also referred to in this task's output XML file.
Learn more about how and when this cutting information gets to the cutting table here.

Settings

• Name. Once the output file is submitted to the CTP,

• when to a CDI, this is the name of the entry in the CDI "Exposer" queue. By default,
the SmartName [File] will make the CDI job name equal to the name of the XML
layout file that the merger created: <name of AE server>_<date>-<time>_<sequal
number>_cdi .

• when submitted to a TIFF device, this is the name of the TIFF file written on the queue's
output folder.

17.3.5.  Submit to Flexo CTP Device task

Note:  Until AE v18.1.1, this task was named 'Submit to CDI'. Tickets that were made in those
older versions will still name this task like that.

Note:  The flexo CTP platemaking workflow, its terminology and the Plate Merger are described
in the introduction of this chapter.

Concept

This task submits a merged plate to a Flexo CTP Queue. The input file for this task is not the
actual LEN or TIFF file of the layout. The task's input file needs to be the output XML that was
created by the Create Merged Plate task.

As mentioned in Main steps in setting up a flexo CTP workflow and in the Plate Merger View, this
task is the last step in the workflow that a merge queue launches once it decided on a layout.

Note:  This task type can not be re-launched. To resubmit a merged plate to the CTP queue for
which it is intended, use the function Resubmit Merged Plate in the Merged Plates view.

In the Pilot, the task's Details pane offers a link to an XML report file. Learn more about what
you can do with these report files in Reporting to Business Systems on page 1347.
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17.4.  Using the DFS Merger in AE mode

Concept

This page illustrates the semi-automatic workflow that we introduced in the introduction of this
chapter.

Configuration

To make the DFS 'Merger' application see the merge queues on Automation Engine, the AE
server needs to be configured as "Workflow Server".

Note:  The communication between a DFS Merger and Automation Engine happens via JDF/
JMF.

Follow these steps to link a DFS Merger to an Automation Engine server:

1. In the DFS Merger, add the name of your Automation Engine server in Options > 
Preferences >  Merge tab >  Workflow Server.

2. Click OK.
3. Test the connection by loading some images from a merge queue (see below).

Workflow Steps

1. Click the  button. The title bar indicates you are now working in "AE Manual" mode. A
green background color also reminds you of this different mode.
 

 

Note:  To change the mode back to (local) "File Mode", simply click  again.

Note:  This button does not appear when there was a problem connecting to Automation
Engine when starting up the DFS Merger.

2. Click  to load images. A dialog opens that shows the AE merge queue(s) and their
contents:
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Note:  Locked items are shown in pink (for example images that you already loaded or
image sets being used in another DFS Merger).

• Queue: This dialog only shows the merge queues that contain images (press plates).

Note:  Press plates that in their merge queue have the status  "Rejected" are not shown
in this dialog.

• Image sets: Sets are groups of images that can be exposed together on the same plate,
typically because they have all their grouping keys in common. The columns already show
some attributes they have in common.

Note:  Test strips are not shown in this dialog. They do appear as a Loaded Image after
you clicked Load Selected Image Set. Learn more below.

• Images: Shows which images are in the selected image set.

• Filter: When you type a (part of an) image name in this field and click , you will only
see the image sets (middle pane) or merge queues (left pane) that contain images with
that (part of their) name. To remove the filter, empty the input field and click  again.

• Load Selected Image Set: Click this button to add all images of the selected image set to
the list of Loaded Images in the DFS Merger.

The attributes that these images share (as shown in the columns in Image sets) are
enforced into the DFS Merger. Also the margins and rotations that were requested on
Automation Engine are communicated to the DFS merger (the margins can here still be
overruled).

Note:  When your Automation Engine has a license for automatic merging by the merge
queues, clicking "Load Selected Image Set" also sends a signal to the selected merge
queue: To prevent any further automatic merging, this queue is paused. This way, that
merge queue only stays available for manual merging, until one of these actions is taken:

• "Load Selected Image Set" was clicked for an image set of another merge queue.

• The DFS Merger is no longer in "AE Manual" mode.

• The DFS Merger is closed.
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Note:  When the image set contains a test strip (as requested in the merge queue's
configuration), it will also appear in the list of Loaded Images.

• To easily recognize it, its thumbnail will be marked with a letter "T".
 

 

• You can manually place the test strip as any other image.

• When using CTRL-A (Auto Arrange Images), the test strip will be placed bottom left
and no other images will be placed on top of it, against that left side of the plate.
 

 

• When using CTRL-H (Auto Arrange New Images), the merger will try to place the test
strip in the same place it was placed on the previous plate layout.

Note:  Click  to check if new images arrived in the image set that you loaded.

3. Now, in the same way as you would do with local images, create a layout with the loaded
images.

Note:  When you have a partial plate that still has the full circumference (vertical size), you
can use that plate by first changing the plate's horizontal size.

4. When you are finished creating the plate layout and ready to send this layout to the CDI
"Exposer" queue, click . You will be asked to fill in a name of this job.

Attention:  The value you here type in can appear as the job name in the CDI
"Exposer" queue, but only if you also create a specific SmartName and use that
SmartName in the Create Merged Plate task. Learn more in Creating a SmartName for
the Merged Plate output File and Queue Entry on page 1403.

In this "AE" mode, when you click  (and confirm a name for the job),

• on Automation Engine, the merge queue of the placed images starts its output workflow
on this manually created layout.

• In the DFS Merger, the used images disappear from the list of Loaded Images and also
disappear from the "Select an image set" dialog, because they were also removed from
their merge queue.
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5. On Automation Engine, the Tasks view shows the output workflow. When that workflow is
finished, the new job appears in the CDI "Exposer" Queue that the layout was made for.

17.4.1.  Creating a SmartName for the Merged Plate output File and
Queue Entry

As mentioned in the page describing the DFS Merger in "AE Manual" mode, the name that you type
in after clicking  can be picked up by a SmartName so that it appears as the name of
the job in the CDI "Exposer" queue.

Follow these steps:

1. Create the SmartName as shown in this screenshot:
 

 
Learn more about creating such SmartNames in XPath Query SmartNames on page 629.

2. Use this SmartName in the Create Merged Plate task that is part of the workflow launched by
the merge queue.
 

 
3. Test.
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Note:  When your CDI plate production is mixing the automatic merger workflow with this DFS
manual merger workflow, you can create and use this conditional SmartName:
 

 
This one checks whether the CDI job name is part of the (automatic merger's) XML file or if it
was typed in by a DFS user (if so, it uses the one we created above).

17.5.  FAQs

Can I send the information that I see in the Views to my MIS ?
Yes, workflows can send that information to your MIS. Also, your MIS itself can get that info on
demand.

See the reporting options in Plate Merger Configuration  on page 1366.

What to do if a CDI plate is damaged after exposing?
It depends:

• When you want to re-make the exact same flexo plate:

Go to the Merged Plates view, select the item and press  ("Resubmit Merged Plate").
Learn more here.

• When you only need to remake specific parts of that flexo plate (specific press plates):

Go to the Merged Plates view, double click the item to zoom in and see its press plates.
Select the wanted press plates, right-click and choose Resubmit Press Plates. Learn more
here. Alternatively, go to Press Plates view, select the press plates there, right-click and
choose Resubmit Press Plates.

The resubmitted press plates are now back in the Merge Queue. Use "Force Out" if they are
urgent.
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• When you want to re-expose all the press plates that were on the damaged merged plate,
but it does not have to be the same layout:

Then go to the Merged Plates view, select the merged plate, right-click and choose
Resubmit Press Plates.

The press plates are now back in the Merge Queue. Use "Force Out" if they are urgent.

17.6.  XML technical details

This section adds detailed technical information to help you understand and interpret some of
the XML files that appear in this workflow.

17.6.1.  Interpreting the Reporting XMLs

Reporting XMLs were introduced on this page about the plate merger configuration.

Content wise, there are basically 3 types:

• an XML describing the merged plate that was queued to a flexo CTP.
• an XML describing the merged plate that was exposed on a flexo CTP.
• an XML describing, from a job order point of view, details about the current state of the

press plates of that job.

Their main content and structure is easy to understand. Below we only illustrate the terms that
require some explanation.

Attention:  Be aware that the terminology in these XMLs uses the vocabulary of the
DFS, i.e. a press plate is referred to as an image and a merged plate as a plate.

The root element of these XMLs is <FlexoPlateReport>.

Terms used when describing the XML element <Plate>

The XML element Plate refers to a merged plate that is processed on the CDI.

Below described statuses are those at the moment the XML report was created.

• <ExposeState>: Possible values are:

• MP:QUEUED: The merged plate resides in the "Exposer" queue of a CDI.

• MP:EXPOSING: The merged plate is being exposed on the CDI.

• MP:EXP: The merged plate has been successfully exposed on the CDI.

• MP:EXP_CANCELED: The merged plate entry in the "Exposer" queue has been removed
before exposing.

• MP:EXP_ERROR: The merged plate was not successfully exposed on the CDI or no
information could be obtained for the merged plate when consulting the DFS.
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• MP:RECONSIDERED: The merged plate has been reconsidered. It therefore no longer
exists.

• <CuttingState>: Possible values are:

• STC10:WAITING: The merged plate resides in the queue of an iPC (Kongsberg table).

• STC30::DONE_OK: The merged plate has been successfully cut on a Kongsberg table.

• STC50:DONE_ERROR: The merged plate was not successfully cut on a Kongsberg table.

Terms used when describing the XML element <Image>

The XML Element Image refers to a Press Plate.

• <State>: Possible values are:

• ST10:WAITING: The press plate is part of a merged plate that resides in the "Exposer"
queue of a CDI.

• ST20:EXPOSING: The press plate is part of a merged plate that is being exposed on the
CDI.

• ST30:EXP_OK: The press plate is part of a merged plate that has been successfully
exposed on a CDI.

• ST50:EXP_ERROR: The press plate is part of a merged plate that has not been
successfully exposed on a CDI.

• ST80:EXP_CANCELED: The press plate is part of a merged plate that has been removed
from the "Exposer" queue of a CDI.

• <Plate Id>:

The 3rd type of XML in the list above, the one that describes all the press plates ('images')
of a job, also describes on which merged plates ('plates') they were exposed on.

For each <image>, its <PlateId> text value refers to the <Plate> element, with that same
value for its attribute "id= ".

Attention:  When you move a job from one CDI device queue to the another CDI
device queue, it will get a new plate ID. Systems that interpret the "Submit to Flexo
CTP" XML reports will then need to listen to that new ID ; there will be no more
reporting info related to the old ID.

An example:

Plate id="587e-1458-0301" requeueId="587e-1414-1501"

"id" is the new one, "requeueId" was the original plate ID before it was moved to
another queue.

• <IdOnPlate>: This is a unique identifier for the press plate. In the views Press Plates and
Press Plate Sets, you can see (and filter on) them by using the column Press Plate Id.
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18.  Kongsberg Production Workflow

18.1.  Intro

This chapter describes the workflows where you use Automation Engine to send data to be
produced on an Esko Kongsberg cutting table.

Important:  This chapter assumes you are familiar with a Kongsberg cutting table and it's front
end application iPC (i-cut Production Console). Learn more in the On Line Help of Kongsberg iPC.

Note:  These workflows require that the version of iPC is v2.0 or higher.

18.1.1.  Workflow Overview and Types

Workflow Overview and related Pilot Views

When you set up a Kongsberg table as a Device in Automation Engine, you can send cutting
data to it's iPC by using the Submit to Kongsberg Table task.

The iPC operator sees these items appear in his "My Job List" and can decide when to start its
production. The iPC communicates back to Automation Engine about the status of this job and
the attributes used for its production.

Note:  Each iPC is dedicated to one table.

These Pilot Views are used in Kongsberg workflows:

•  Devices shows your Kongsberg tables (and CDI imagers), their general status and their
workload.

•  Table Queues shows the queue of each of your Kongsberg tables in a time line or list view.
You can re-order and delete entries.

•  Sheets shows a historical overview of all jobs that were processed on your Kongsberg
table(s). You can resubmit them and you can export (parts of) this history to an XML file to
be interpreted by external systems (order management, calculation, etc.).

•  Orders (part of the Views category Sign & Display). This view shows an overview of
the status of all parts of a Job order that were processed by the Gang Run Merger. It
helps to monitor orders where multiple graphics need to be printed and cut. This view is
documented in the chapter on Gang Run Printing for Sign & Display on page 871.

Workflow Types

Kongsberg tables are used in many different types of production. When using Automation
Engine in this workflow, we here categorize these workflows by how and which files you submit
to the iPC:
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• Submitting single CAD files. Each CAD file (ARD or MFG) becomes an item in iPC's My Jobs list.

• Submitting nested layouts. The iPC Job is a layout created by the Gang Run Printing module.
 

 

• Cutting CDI Plates. Typically done to cut DFS PlatePatcher plates (corrugated) or to produce
staggered cut plates (rotative sleeves).
 

 

18.1.2.  Submitting Single CAD Files

Concept
In this workflow, Automation Engine sends ARD of MFG files directly to the iPC. Each input file
arrives as one job in the iPC My Job list.

This workflow is often used when producing packaging, POP material or box samples.
 

 

These are its main steps:

1. The ARD or MFG file may be created in ArtiosCAD or exported from Plato or i-cut Layout.
The MFG may be the result of manual nesting done in those applications.

2. There may or may not be graphics involved:

a. From such interactive applications or via an Automation Engine task, the graphics (PDF
data) is exported as well and then printed. The printed sheet is made available at the
Kongsberg table.
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b. When producing blank samples of a box or shape, there are no PDF data and the
required material is available at the Kongsberg table.

3. The cutting file is sent to the iPC by using the Submit to Kongsberg Table task. You there
choose the table, the amount of copies and other production parameters.

Main Workflow Steps

1. Submit ARD or MFG files to iPC. Learn more in Submit To Kongsberg Table task on page 1419.
2. When successfully submitted, an entry appears in the Table Queues view.
3. The iPC operator places the printed or blank sheet on the table and starts the matching

cutting job. An entry appears in the Sheets View.

18.1.3.  Submitting Nested Layouts

Concept
This workflow merges files together before submitting them as one layout to the iPC. The
merging is done by the Gang Run Printing merger. This merger can also make layouts where
items are nested to optimize material usage.

This workflow is often used when producing signage.

 

 

Note:  ARD cad files sent to this merger will only merge with other ARD files.

Main Workflow Steps

1. In the Gang Run Printing merger, set up merge queues per substrate, define how and when
they can make layouts and how they should export the resulting nested layout.

Note:  This tool and workflow is explained in the chapter Gang Run Printing for Sign & Display
on page 871.

2. You then use the Submit to Gang Run task to send files to a substrate queue.
3. The substrate queue's output workflow needs to contain at least these tasks:

• The Export Nested Layouts task creates print files that are then printed (unless the layout
is of ARD files) and it also creates cutting files of the type "JDF (Kongsberg)".
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• The Submit to Kongsberg Table task then needs to submit the cutting files to the
Kongsberg table.

An example:
 

 
4. As soon as the JDF cutting file is submitted to the iPC, an entry appears in the Table Queues

View.
5. The iPC operator places the print on the table and starts the matching cutting job. An entry

appears in the Sheets View.

Tip:  To easily find which cutting job matches which print job,you can use the i-cut Marks in
I-cut Layout to add a special barcode to the printout that contains the name of the cutting
file. When the iPC operator then scans that barcode, iPC automatically loads the matching
cutting job.

Note:  See a more detailed example of such a workflow at the end of this chapter in Workflow
Example on page 1422.

18.1.4.  Cutting CDI plates

Concept

In this workflow you use a Kongsberg table to cut a flexo plate that you made on a CDI. This is
often used when the flexo plate contains separations with a staggered cut or contains small
parts of a DFS PlatePatcher workflow.

Note:  Learn more about using Automation Engine to automate your CDI workflow in the
chapter Flexo CTP Workflow on page 1340.
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The output workflow of a CDI Merge Queue creates a special XML file containing the cutting
instructions. When the CDI sends a signal that the (merged) plate was imaged, a workflow
starts that submits that XML file to the Kongsberg table.

Main Workflow Steps

1. A RIP creates LEN files, one for each separation that needs to be imaged on the flexo plate.
2. If needed, LEN files can be processed using specific Automation Engine tasks.
3. They are then submitted to a specific queue of the Plate Merger. Selecting the option Apply

cutting workflow triggers the generation of the cutting data further in the workflow.

Note:  The option Apply cutting workflow is also used as a grouping key in the Plate
Merger.

4. When the Merge Queue decides on a layout, it starts a workflow that creates a Merged
Plate LEN file. Now, as was requested when submitting its parts, also a cutting XML file is
created.

5. The merged plate LEN file is submitted to the CDI.
6. When the CDI signals that the plate was imaged, the cutting XML file is automatically

submitted to the Kongsberg's iPC (when this was so asked in the CDI Plate Merger
configuration).

Note:  The flexo plate cutting workflow is also possible when the Kongsberg table is not
known as a Device (i.e. its iPC is not on-line). Learn more in the description of the option
'Apply Cutting Workflow' in the Submit to Plate Merger task on page 1395.

7. The flexo plate is post-processed and then moved to the Kongsberg table.
8. The cutting job is already in the iPC My Jobs list. The iPC operator loads the plate and starts

the cutting.

18.2.  Kongsberg Related Views

These views were introduced in Workflow Overview and Types on page 1407. We here describe
them in detail.

18.2.1.  Devices (Kongsberg)

Tip:  You can also open the view Devices as a Tool: Go to Tools >  Devices to monitor and
manage your devices in a separate window.

Adding a Kongsberg Device

Follow these steps to add a Kongsberg table in this view:

1. In Devices View, click on .
2. Select the category Kongsberg Tables.
3. In Server, enter the name of the computer or the IP address of the iPC workstation of that

specific Kongsberg table.
4. Click Add to confirm. The status box of the newly created device appears.
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Note:  Adding a Kongsberg device requires a license per device.

Information and functionality
 

 
The device status box shows:

• The name of the device. By default this is the name of the iPC workstation. Open the Info
panel to change it to a custom name.

• The amount of jobs in its queue. This is the amount of jobs in iPC's My Jobs list
(processing and waiting).

Note:  These jobs could have been added via Automation Engine or manually by the iPC
operator.

• A device status icon.

• : Retrieving the status.

• : Offline, there is no connection with iPC computer (switched off, network problem)

Note:  Technically this means that Automation Engine can not contact the "Kongsberg
Queue Server" (KBQS).

• : The device is online (computer can be accessed, KBQS is running) but the iPC
application is not started.

• : Idle, the table is online and ready to produce (KBQS is running and iPC is started).

• : Producing. One job in the queue is in status 'started'.

• : Trying to connect to the device (to the KBQS service on the computer).

• The Estimated time when the current job load will be finished (how long the device is
scheduled to be busy). This time includes the manual table operations that are needed
between jobs.

Note:  This setup time is configured in iPC: Go to Edit >  Options >  Estimation Settings.

Double click a status box to open the device's Info panel.

Right-click a status box to choose one of these options:
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• Info (or press ). This dialog shows details about the device (version, settings, etc.). You can
add a Description to illustrate or help identify this device.

• Delete (or press ). You will be asked to confirm.

Note:  Deleting a device will not remove the related entries in the Sheets View.

• New Device.... An alternative to clicking .

18.2.2.  Table Queues

Concept

This view shows the content of the My Jobs list of the iPC of the Kongsberg tables that you
configured in the Devices view.

You can see these queues in a time line view or in a list view.

The total number of jobs is mentioned in the bottom bar.

When a table is not on-line, an  icon appears behind its name and the corresponding queue
will be shown empty. The view updates as soon as the table is on-line again.

When selecting a job (click or use arrow navigation), the right pane shows a preview and its key
properties. When ARD or MFG files were submitted, a preview will only be available after the
job was verified or saved in iPC.

This view is independent from whether the Pilot is in Container mode or in Selected Job mode
(it always shows the complete queue).

 

 

•
 Time Line View
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• The red vertical line represents the current time. After selecting an entry, you can use
your keyboard's arrow buttons to pan over the time axis to see details of the other
scheduled jobs in that queue.

• When a job is being processed on the table, the time line view shows that job entry
moving gradually to the left of the red line. When the job is completely produced on the
table, the entry will have moved completely to the left side and disappear from this view
once the iPC operator closes the job (confirms that all copies have been produced).

• The default color of a job entry is blue. Learn about conditional coloring below.
• The size of a job entry reflects the job's estimated duration. iPC can only deliver this info

when the job is Ready for production. Learn about the different statuses below.

When an iPC operator still needs to prepare that job in iPC, its estimated duration is not
available yet. It is then shown with a default width (corresponding to 10 minutes) and
filled with a striped pattern. See this example where the entry on the right is not ready

yet: .

• Use the slider  to increase or decrease the size of the queue entries.

• The space between each entry reflect the setup estimation time as configured on that
iPC (Edit >  Options >  Estimation).

• When you use the filter, the jobs that don't match the search criteria are dimmed.

• When the iPC operator starts a job that was not shown as the first one in this (and his)
queue, then that job automatically re-positions itself to the front of the queue.

•  List View

This view makes it easier to read details and to sort entries before selecting them. Most of
the information is retrieved from iPC.

Note:  As in many views in the Pilot, you can

• re-arrange columns by dragging their title to a new position
• sort them by clicking on a column title
• right-click a column title and choose to Hide this one or any other. In the list that

appears, select Select Columns... if you want to change or re-arrange multiple items.

• use filters and optionally save them as a Smart View.

• define your preferred unit in Edit >  Preferences >  Units.

The shown units follow the choice you made for this Pilot in Edit >  Preferences >  Units.

Possible statuses:

•  Waiting for verification: This is shown when status in iPC is "Pending for estimation"
or "Check if ready for production". *

•  Not ready for production: For example the job was submitted but iPC could not
determine the cutting line in the PDF because it was set in the wrong spot color.

•  Ready for production: In the queue to be produced.
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•  Started: Being produced.
•  Paused: For example because a new sheet is needed before continuing the job.
•  Suspended: The job was not (completely) done yet, but another job will be produced

first.

Conditional Coloring

In Time Line view, coloring the entries helps to get a quicker understanding of the queues. You
could for example set a color per type of Material or per Tooling Preset. See an example in
above screenshot.

Follow these steps to color entries (for all available Kongsberg tables):

• Right-click the name of any of the tables and choose Conditional Coloring.
• Add one or more rules.
• Use Move up/down to control the order in which they are executed. For example, when the

first rule colors some entries red, then the second rule can only affect the other entries, etc.

Deleting, Moving and Splitting Jobs

Tip:  Selections that you make remain active when you switch the  /  view modes. An
example: In the  List view mode, sort per column and then make a multiple selection. Then
switch to the  Time Line view mode where the selection is kept and then move the selected
entries to the front of the queue.

Attention:  There is no 'undo' for any of these functions.

Note:  When making these changes, both the related Views in the Pilot and the list of jobs on
the respective iPC stations update automatically.

Tip:  You can also execute below mentioned actions on selections that you made with the filter.

When entering a search text in the filter, the search is done on the job's Name and Material.

• Deleting Jobs. Select and press 'Delete' (or right-click and choose 'Delete') to delete jobs
from the queue. This also deletes them from the iPC job list. You will be asked to confirm.

Note:  When a job is open in iPC, it cannot be removed.

In the Sheets view, the deleted jobs will show up as  'Aborted'.
• Moving a job to a different position in the same queue. You can re-arrange the queue by

using drag and drop, even on multiple selected jobs. This also updates their order in the iPC
jobs list.

To move a job to the front of the queue, right-click the job and choose 'Cut Next'.
• Moving a job to a different queue. When a table needs to undergo maintenance, or when

you manually want to balance the production load, you can drag and drop one or multiple
queue entries to another table queue.
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Note:  When a job is open in iPC, it cannot be moved to another queue.

Note:  This function requires an iPC version higher than 2.0.

• Splitting a Job. Another way to manually balance the workload of your tables, is to split
a job. A job that requires a large number of sheets to be produced, can so be spread over
multiple tables.

Follow these steps:

1. In the queue (both in List or in Time Line view), right-click a job and choose Split Job....
2. The 'Split Job' dialog opens. By default, the job will be split in two parts each having half

of the total number of copies.

• Click + to split into more parts.

• Click - to remove the selected part.

• Slide the resize control (the small circle) to the left or right to modify the number of
copies of those parts.

• Enter the number of Copies in the edit field. Press 'Tab' to confirm the value. Press
'Enter' to Split the job and close the dialog.
 

 
3. Click Split to confirm and close the dialog.

Note:  When a job is open in iPC, it cannot be split.

18.2.3.  Sheets

Concept

The Sheets view gives a historical overview of all jobs that were produced on your Kongsberg
tables. It shows all closed jobs in iPC, both those successfully finished and those aborted
during cutting.

Each sheet is a row. Each entry gives information about a cutting job and how it was processed
on the table: start and finish time, number of copies produced, table name etc.

This view does not do live updates. To see updates of newly finished jobs, refresh the view via
View > Refresh or press F5 or CMD-R .

When a table was offline when it finished a job, the sheet entry will show up in this view once
the connection has been restored.
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Entries in this view are cleaned up automatically according to the rule set in the Configure tool
item for Devices database.

The details pane on the right shows a preview and some key properties of the selected sheet
(drag its left edge to enlarge it).

The bottom bar indicates how many sheets there are (total or selected or filtered).
 

 

Note:  As in many views in the Pilot, you can

• re-arrange columns by dragging their title to a new position
• sort them by clicking on a column title
• right-click a column title and choose to Hide this one or any other. In the list that appears,

select Select Columns... if you want to change or re-arrange multiple items.

• use filters and optionally save them as a Smart View.

• define your preferred unit in Edit >  Preferences >  Units.

Columns

• Name. This is the name of the cutting job.

Note:  When the name ends with .jdf, this means that this job was created by the Submit
to Kongsberg table task. Otherwise (where the name ends with .acm, .cut, .ard...),
this means that the job was manually added to iPC's My Jobs list or that a job entered by the
task was changed in iPC before being produced.

• Customer: When the sheet was created via a gang run queue that received a Customer ID
when files were submitted, then the corresponding customer name is used. When an ARD
or MFG was directly submitted to a Kongsberg table, the customer name is extracted from
the information inside the ARD or MFG file.
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• Customer ID: This is the ID that was specified in the Submit to Gang Run task. When jobs
with different customer IDs are nested on one sheet, the sheet's customer ID will be a
concatenation of all customer IDs.

• State: Final state of the job:  finished or  aborted.
• Operator: IPC user who started the job.
• Table Name: Name of the device on which the job was produced.
• Material: Name of the material used to produce the job.
• Copies: Total requested number of copies for this sheet/layout (as specified in the 'Submit to

Kongsberg table' ticket or as set in iPC).

Note:  This example of a workflow using Gang Run helps to understand the difference
between quantities and copies.

• Copies Produced: Number of successfully produced copies of this sheet/layout.
• Copies Rejected: Number of unsuccessful copies while producing this job.
• Estimated Duration: Estimated time to produce all copies of the job.
• Created Date: Time/date when the job was submitted in the table queue (ISO 8601 UTC).
• Started Date: Time/date when the table started cutting.
• Finished Date: Time/date when the job was finished or aborted.
• Media Height / Width: Height and width of the used sheet.

• When the job was submitted to iPC by Automation Engine, then this is the media size as
specified in the submitted JDF (the sheet size of gang run layouts, the sheet size from
submitted MFG files, the blank size of submitted ARD files)

• When the job was added by iPC, then iPC sets the media size.
• Mapping Preset: Used to import the job on iPC.
• Optimization, Cutting Profile, Production Setup, Tooling Preset: Attributes used to

produce the job.

Launching Tasks

When you right-click an entry, you can choose to launch a New Task on that entry.

• When you want to produce a sheet again, choose the Submit to Kongsberg task and define its
options. Choose "From Input File" when you want a value to be taken from the input JDF, it
will then be the same as the value used before.

• The Export Kongsberg Cutting History task does not base the data it exports on the entry that
you selected but only on the options that you set in the ticket. This task does require an
input file however, but does not use it for its output. This also means that there is no need
to launch this task from this view.

• Choose Other... to launch another task type. Once you have launched it, this task type then
also appears in the initial list.

Attention:  These tasks, with exception of the Export Kongsberg Cutting History task,
use the sheet's JDF file as input file (even when the sheet Name mentions another
file format0. These JDF files are present in the Media Root Folder as defined in the
Configure tool item for Device Databases..

18.2.4.  Orders

The Orders view is part of the Views category Sign & Display. This view is documented in the
chapter on Gang Run Printing for Sign & Display on page 871. Find a direct link here.
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18.3.  Kongsberg Related Tasks

18.3.1.  Submit To Kongsberg Table task

Concept

This task submits the input file to the My Jobs list of the chosen iPC (Kongsberg table). This
also creates an entry for this iPC job in the Table Queues view.

Note:  This page is part of a separate chapter on using Automation Engine in a Kongsberg
workflow. We advise to first learn about its concepts and workflow types in this intro.

In iPC, the order of the submitted jobs is decided by the priority of this task, as was selected in
the ticket: Low, Normal, High or Immediate. Submitted jobs with a same priority are in iPC
sorted by their due date.

Input File Types

• ARD or MFG files. One iPC job is created per input file. The task wraps the ARD or MFG in a
JDF file before sending it to the iPC. Learn more about this workflow in Submitting Single CAD
Files  on page 1408.

Note:  The media size of the JDF is set to the sheet size of the MFG file or to the bounding
box of all cut lines of the ARD file.

When available, the board description, grain direction and customer info is read from the
ARD or MFG file and used in the iPC job.

• JDF for digital cutting. This type of JDF file is created in these two cases:

• By the Export Nested Layouts task (used in the workflow started by a Gang Run Substrate
queue).

• Or by resubmitting a cutting job from the Sheets view.
• XML cutting request. This file is created by the CDI Plate Merger and describes how the

flexo plate should be cut. Automation Engine's workflow for CDI Imagers can submit such an
XML to the Kongsberg table at the moment it is informed that the CDI plate was imaged.
Learn more in Cutting CDI plates on page 1410.

Settings

• Kongsberg Table: Select a table (iPC) form the list of devices that you configured earlier.

Note:  The submitted job will also enter the queue even when the selected table is offline at
that moment (see its status in Device view).

• Kongsberg Job Name: Define the name of the job as it will appear in the My Jobs list of the
chosen iPC.
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• Due Date: You can set a due date for the job. This time will then be mentioned for that job
in iPC. You can choose an absolute or relative time.

When you select a due date "From Input File":

• When the input file is an ARD or MFG, or when the task is started from the Sheets view,
then the job is submitted without due date.

• Otherwise the value from the input JDF file is used (the cutting file type "JDF for
Kongsberg" created by the Export Nested Layouts task).

• Copies: Define the number of sheets to cut. When you keep the default "From Input File",
this number will be taken from the input file's attributes. When no such information is
available, the amount will be 1.

Note:  When the task is started by resubmitting it from the Sheets view, "From Input File"
then re-uses the previously used value (as present in the input JDF file).

• Material, Mapping Preset and Cutting Profile: Click  to select the wanted resource from
the list. This list is automatically updated with the resources you created in iPC.

Note:  When you here type in the name of a resource that does not exist, it will show up in

iPC's Job Info with this warning icon: .

Note:  Any changes that you do in iPC to a Job's resources are communicated to
Automation Engine. The updated settings automatically show up in the  Sheets and Table
Queues views.

18.3.2.  Export Kongsberg Cutting History

Concept

This task exports information about finished cutting jobs to an XML file. External systems can
use these XML reports to get job status information or calculate production statistics.

Note:  This tasks needs an input file. However, the only use of this input file is to resolve the
SmartName [File] in the setting File Name.

You can launch this task manually or as part of a workflow. An external system can decide to
launch it itself by using a Web Service Access Point.

Note:  The task always runs outside of a Job context, even when launched from within an
Automation Engine Job.

Settings

• Output in: When no folder is specified, the file is written in the root folder of the
ExampleJobContainer.

• File Name: Use SmartNames to define the name of the output XML. When that XML already
exists, it is overwritten and the task ends with a warning.

• [File] results in the name of the task's input file.
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• [File Number] is relevant when you use the advanced option Records per File (see
below).

• In Export history records that match the following criteria, create one or multiple rules
that specify which kind of data should be exported.

This filter tool is the same as used to create view filters in many places in the Pilot. See an
example on filtering here.

• Advanced.... These options define the structure of the XML.

• Columns: Click on  to select which columns you want to export into the XML file. By
default, all columns are exported.

Note:  When using a SmartName, it needs to resolve to the internal name(s) of the
column(s). To find these internal names, right-click in the Columns field, choose Copy
Parameter Value and paste this in a text file.

• Sort By: Select a column type by which you want to sort the jobs.

• Order: Select the order of the columns.

• Records per File: Define the maximum of records that the XML file may contain. When
there are more records than that number, extra XML files are created and they get an
extra number at the end of their name (using the SmartName [File Number]).

Example
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Note:  Dates and times are described in the format of ISO 8601 (YYYY-MM-DDThh:mm:ssTZD).

Note:  The elements JobID, JobPartID and ProductID do not relate to Automation Engine's Job
or Product concepts, but to terminology in iPC.

18.4.  Workflow Example

This example helps to clarify terms like quantity, copies, layouts, order, JDF and sheets.

We here illustrate a workflow where the Gang Run mode creates layouts of what needs to be
printed and where the printed sheets are then cut on a Kongsberg table.

Note:  This example workflow does not include steps like creating an Automation Engine Job,
arrival and preflighting of the graphics, an approval stage nor feedback to a business system.

Each step provides links to pages describing the used features.

18.4.1.  Step 1 - The Order
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Your sales department confirms a production order for 50 large Esko logos on thick PVC
material.

A PDF was delivered with a correct trim box. The PDF is small and needs to be printed 10 times
bigger.
 

 

18.4.2.  Step 2a - Submitting the PDF to the Gang Run

The PDF with the Esko logo is submitted to a gang run queue, requesting a Quantity of "50".
The Orders view immediately shows this new entry.

These steps are needed:

1. Create a substrate queue for the requested PVC material. Add available sizes and define its
nesting settings.

2. Create the queue's output workflow. You minimally need these steps and options:
 

 

• In the Export Nested Layouts step, set the option Save Cutting Files to "JDF File
(Kongsberg)".

• The output pin for the cutting files continues to the Submit to Kongsberg Table step.

• In the Submit to Kongsberg Table step, make sure you keep the option Copies to "From
Input File".

3. Attach the created workflow to the substrate queue.
4. In Files view, select the PDF and open a Submit to Gang Run ticket.

 

 

• Define a Quantity of 50 and Scale the file to 1000%. Request that the cut path will be
created from the file's trim box.
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• In the Extra tab, enter a logic Order ID.

5. Launch the Submit to Gang Run task.

18.4.3.  Step 2b - First Appearance in the Orders View

As soon as the PDF is submitted to a substrate queue, a new item appears in the Orders view.
This initial status shows that all of the requested quantity is still "In Gang Run".

Layouts are usually calculated quickly, after which the status changes again, which is why this
status is only visible briefly.
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18.4.4.  Step 3 - Quantity vs. Layouts

In our example that requests a Quantity of 50 logos, the substrate queue decides, based on its
substrate sheet size, to create 2 Layouts:

• 1 layout PDFPLA file with 8 logos, representing the sheet that needs to be printed 6 times
(totaling 48 logos).
 

 

• 1 layout PDFPLA file with the remaining 2 logos, representing the sheet that needs to be
printed 1 time.
 

 

18.4.5.  Step 4 - Files Created

The output workflow of the substrate queue starts with creating the files that are needed to
print and to cut this order.

The Export Nested Layouts task creates:

• 2 PDF files (one with 8 logos and one with 2 logos)
• 2 JDF files and 2 cutting files. Each JDF includes a reference to its own cutting file:

•
 one describes how to cut a sheet with 8 logos

•

 one describes how to cut a sheet with 2 logos.

In the Orders view, you can see the new status "in Output Workflow" and the names of the
created files:
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18.4.6.  Step 5 - Each JDF is a Job entry in the Table Queues view

A JDF (Job Definition Format) file describes what needs to happen and also assures the
bidirectional communication between Automation Engine and the iPC.

The output workflow ends by submitting the 2 JDF files to the Kongsberg table.
 

 

Two job entries immediately appear in the Table Queues view.

In below screenshot, see how one job entry looks much larger than the other. The selected
entry needs to cut 8 copies of the PVC "sheet" containing 6 logos and will therefore take much
longer to produce than the other one:
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18.4.7.  Step 6 - Logos are Printed and Moved to the Table

The 2 print PDF files created by the Export Nested Layouts task are printed.

The 9 sheets (8 copies and 1 copy) are made available near the Kongsberg table.
 

 

18.4.8.  Step 7 - The iPC Operator Produces the Jobs

The iPC operator places the printed PVC sheet on the table and starts the matching cutting job
for that type of sheet.
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18.4.9.  Step 8 - The Sheets View shows the Production Results

When the iPC has finished producing a job, this job appears in the Sheets view.

In below screenshot, the Sheets view shows that both jobs were produced and also shows how
many copies of that type of sheet were produced.
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19.  Digital Printing Workflow

19.1.  Intro
'DFE' stands for 'Digital Front End', the application that manages, feeds and monitors a Digital
Press.

Two types of DFE's are supported: The Esko DFE and the HP Production Pro.

Automation Engine typically sends print-ready layouts to a DFE, including layouts with Variable
Data (VDP).

Once you have created a Device for such a digital press in the Pilot's Device view, you can start
using the "Submit to ..." tasks.

19.2.  Devices (Digital Presses)

Attention:  Before 16.1, Automation Engine already offered the Print on Digital Press
task to print to a digital press. That task has similar functionality but does not use the
Devices view. The type of press and version of the DFE decide if that task or any of the
"Submit to …" tasks can be used..

Tip:  The Devices view can also be opened as a Tool: Go to Tools >  Devices to monitor and
manage your devices in a separate window.

Adding a Digital Press Device

Follow these steps to add a Digital Press device:

1. In Devices view, click on .
2. Select the type of DFE the press is using: Esko DFE or HP Production Pro.
3. Enter the name of the Server computer that this DFE is installed on and click Continue.
4. A list appears with one or multiple DFE's. Select the one you want and click Add.

The status box of the newly created device appears.

Information and Functionality
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The device status box shows following information that it receives from that DFE:

• The name of the device. By default this is the name of the computer where the DFE was
detected.

• A device status icon.

In below info on status, the term DFE is valid for both the Esko DFE as the HP Production
Pro:

• : The press is idle. The DFE is online, but the press is not producing (not printing).

• : The DFE is online but the press is stopped or down.

• : Retrieving the status of the DFE.

• : The DFE is offline. The device's computer is shut down or there is a network issue
preventing a connection to the DFE.

• : The press is producing (printing).

• : The press is paused.

Right-click a status box to choose one of these options:

• New Device.... An alternative to clicking .

• Delete (or press ). You will be asked to confirm.

• Rename.

• Info (or press ). This dialog shows details about the device (version, settings, etc.). You
can add a Description to help identify this device. Click Advanced Options for a detailed
technical list of its parameters.
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19.3.  Tasks related to Digital Printing

19.3.1.  Convert Colors for Digital Printing

You can use this task to convert PDF files’ colors before sending them to your digital press.

It takes both PDF and Normalized PDF files as input. When working with regular PDFs, it will
automatically normalize them using the Normalize ticket that is selected in the Configure
tool's Processing Preferences.

This task keeps your file's metadata intact (for example CAD information).

Tip:  We recommend you place this task towards the end of your workflow, as close to the
output device as possible.

Important:

Make sure your Automation Engine server and your Digital Front End server are using the
same color database (by default, they are each installed with their own color database).

This is needed to make sure you can use the same color strategy for converting your colors in
Automation Engine and for printing your job in the DFE.

See Using Shared Resources between Automation Engine and the DFE for more information.

Use Case
You would typically use this task as follows:

1. Set up a digital printing color strategy in your Color Engine Pilot application (or ask your
color expert to do this for you).

If desired, you can tweak that color strategy until it converts your spot colors exactly as you
want it to (for example, you can add conversion exceptions for specific spot colors).

For more information about setting up a color strategy, see the Color Engine Pilot
documentation that came with your Digital Front End software.

2. Then use your color strategy in this task to automate the conversion of all your file's
variants or "SKUs" (Stock Keeping Units), for example for different languages, sizes, flavors...

Parameters
1. Select the Color Strategy you want to use for the conversion. This must be a digital

printing color strategy created in the Color Engine Pilot application that came with your
Digital Front End software.

Typically, your color strategy doesn't only contain general color conversion settings, but
also color conversion exceptions, either for the spot colors you use the most, or for a whole
Pantone book (see the Color Engine Pilot documentation that came with your Digital Front
End software for more information about color strategy settings).
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These exceptions determine the exact percentages of the available output inks that will be
used to print the corresponding spot colors. These have often been adjusted by your color
expert to give you the spot color simulation you want.

2. In Undefined Spot Colors, choose what to do when the file contains a spot color for which
your color strategy has no exception.

• Select Do not convert (keep in output) if you want to leave the spot color untouched
in the output file. Do this for example if you are using certain spot colors as extra output
inks (typically white or metallic inks).

In this case, the task will end in a warning.

Tip:  Consider setting up your workflow so that:

• the output file gets sent to the next task automatically (if you are sure that those spot
colors are extra output inks),

• further processing of the output file is paused, so that you can check whether those
spot colors are actually extra output inks.

• Select Convert to convert that spot color to the color strategy's output profile using the
strategy's general color conversion settings.

• Select Generate error if you don't want to convert the file at all, and instead have the
task end in error.

Do this if you always make an exception for each spot color, so in this situation you want
to stop the workflow and investigate why this is not the case. You may want to either
replace the spot color in your file, or add an exception for that spot color in the color
strategy.

3. Select Flatten document if you are experiencing unexpected color results when converting
files containing overprints, transparencies or vignettes.

Flattening your file resolves its overprints and transparencies, and converts its vignettes to
images.

In the example below, the original file contains three objects:

• the background (sky),
• the lighthouse, which is knocking out on the background object,
• the wave, which is overprinting on both the lighthouse object and the background object.

 

 

Flattening your file replaces the parts of objects that were overprinting or transparent by
other objects. Those new objects have the color that was resulting from the overprint/
transparency, but are not overprinting or transparent.
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Attention:  We recommend that you:

• flatten files with overprints, transparencies or vignettes,
• don't flatten files that you still need to trap or edit afterwards.

If you need to both flatten and trap your file, make sure to do your trapping first,
and place the Convert Colors for Digital Printing task towards the end of your
workflow, as close to the output device as possible.

19.3.2.  Preflight Color for Digital Printing

You can use this task to decide which ink set to use when sending a print job to your HP Indigo
digital press.

Some print jobs can be printed just as well with less inks (reducing the number of clicks and
the print time needed), but it's often cumbersome and time consuming to check this manually
for every print job.

This task automates the checking and comparison process: it calculates the color accuracy you
can achieve with the ink set(s) you are thinking of using, to help you choose a cost-effective
solution that will still meet your quality standards.

Checking the Color Accuracy Achievable with a Certain Ink Set
If you want to check whether a certain file can be printed with a certain ink set and give a color
accurate result:

1. Choose a color strategy made for printing with that ink set.
2. Set your color deviation tolerance (above which Delta E value you would consider the print

not color accurate enough).
3. Send your file through the task.
4. The task outputs a detailed report: for each ink in your file needing conversion to your ink

set, you can see the percentages of the inks on press that would be used, and whether the
color accuracy would meet your tolerance.

Any ink that cannot be printed within your tolerance is given a "fail" status.

Your file only has an overall "pass" status if all its inks have a "pass" status. This means that
you can print it color accurately with that ink set.

See Task Parameters on page 1434 for more information about setting up your task.
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Comparing the Color Accuracy Achievable with Different Ink Sets
You would typically run your file through several Preflight Color for Digital Printing tasks in a
workflow: one task for each color strategy/ink set that you want to check.

Each task then outputs a report detailing the color accuracy you can achieve with that color
strategy/ink set, and gives an overall "pass" or "fail" status for printing your file with that ink
set.

This helps you can choose the smallest ink set that gives you a good color match for that file,
so that you can combine quality and cost-efficiency.

Note:  The detailed information in the reports helps you take an informed decision in difficult
cases. The final decision always rests with you.

You can use this task:

• on the production floor, to help you maximize the speed and cost-efficiency of your digital
press while still printing your jobs with good color accuracy.

See Preflight Color for Production on page 1439.

• if you have a sales office, you can use it to help you quote a competitive price to your
customers without skimping on quality (you can then pass on the ink set information to
your prepress/printing department, saving them the time it would have taken them to check
different ink sets).

If your sales office uses an MIS system, you can even integrate a Preflight Color for Digital
Printing workflow with your MIS system.

See Preflight Color for Cost Estimation on page 1441.

Task Parameters
Set up each task's parameters as follows:

1. Decide which ink set you want to check your file against, and select a Color Strategy whose
output profile uses this ink set.

Depending on whether you want to decide on an ink set for production or for cost
estimation, the exact color strategy you choose may be different.

See Preflight Color for Production on page 1439 and Preflight Color for Cost Estimation on
page 1441.
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Attention:

• You can only select a digital printing color strategy. If you select another type
of color strategy (through a SmartName for example), the task will end in error.

You can create digital printing color strategies in Color Pilot (or in any older Color
Engine Pilot 13.X version that came with your Digital Front End software).

See the Color Pilot documentation (or the Color Engine Pilot documentation that
came with your Digital Front End software) for details.

• Make sure your Automation Engine Server and your Digital Front End server are
using the same color database (by default, they are each installed with their own
color database).

This is especially important for production, as you want to check your file against
the exact color strategies you can use in the DFE to print it.

See Using Shared Resources between Automation Engine and the DFE for more
information.

• The task will also end in error if it cannot find your chosen color strategy in the
color database (if for example it was deleted before you ran the workflow).

2. Select the Delta E Formula to use to calculate the color difference between the spot colors
in your file and how they can be reproduced using your chosen Color Strategy.

You can choose from:

CIELAB Delta E,
Delta E 94,
Delta E 2000,
CMC (1:1),
CMC (2:1),
Delta E 2000 (2:1:1).

Note:  If your company is already using one of those formulas, we recommend that you
choose the same one. If not, you should choose Delta E 2000, which is the best reflection of
the visual difference between colors.

3. Choose how close (in Delta E) the output colors must be to the colors in your input file for
you to accept the print job as color accurate, and enter this number in Delta E Tolerance
for Spot Colors.

The default tolerance is 2 Delta E, as color deviations under this threshold are generally not
visible to the human eye.

Preflighting a File's Colors
You can send either PDF or Normalized PDFs files through this task. When working with regular
PDFs, it will automatically normalize them using the Normalize ticket that is selected in the
Configure tool's Processing Preferences.

When running a file through this task:
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1. The task calculates how to convert the file's separations to your chosen Color Strategy's
output profile.

It checks all separations except:

separations that should be output
as they are

• process separations
• other separations used in the output profile

(when checking against a multicolor profile)
• separations set to "Keep in Output" in

the color strategy (for example White or
metallics)

separations that never require color
management

• technical separations
• varnish separations
• separations set to "Do Not Print" in the

color strategy

certain separations that have
predefined conversion values set in
the color strategy

separations converted through a conversion
table

Note:  Other separations with conversion
exception values in the color strategy
(refined conversion values obtained with
measurements or custom conversion values
added manually) are checked.

For more information about separation
conversions values in color strategies, see the
Color Pilot documentation.

2. For each separation, it checks whether the color difference between the converted color
and the original color is within the Delta E Tolerance you have specified, and gives a pass or
fail status.

3. It writes all of the pass or fail statuses for that file into an XML report, and gives an overall
pass or fail status for that color strategy (pass means that the color difference is within
your Delta E tolerance for all separations, but if at least one separation has a higher Delta E
then the overall status is fail).

You can see the preflight results in the Log Info or the XML report. See Color Preflight
Results on page 1437 for more information.

4. When running your file through several Preflight Color for Digital Printing tasks in a
workflow, you can see which color strategies give a pass, and choose to use the smallest ink
set that still gives you a good color reproduction.
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Note:

• To see more details on the color reproduction of each color strategy, you can either
check their XML reports manually or feed them to your MIS system.

• The final decision on what color strategy to use always rests with you.

If for example one of the color strategies gives you good Delta Es for all separations but
one, and that separation is only present in a very small and less important area of your
file, you can still decide to use that color strategy anyway.

If none of the ink sets/color strategies gives a good color reproduction, you may want to
(depending on the case) use one or more additional spot colors, print the file with one of
the color strategies anyway, tweak the color strategy in Color Pilot, adjust the file...

For more information about using several Preflight Color for Digital Printing tasks in a
workflow, see:

• Preflight Color for Cost Estimation on page 1441

• Preflight Color for Production on page 1439

Color Preflight Results

Processing Status
• After running the Preflight Color for Digital Printing task on your input file, the Tasks

pane shows the processing status (and not the preflight status).

Task status Processing status

 Successfully done Input file processed successfully (whether the Delta E
values for the ink conversions are within your required
tolerance or not)

 Done with warning Input file contains unregistered inks (inks that are not
part of an ink book in your color database)

 Failed The color strategy is invalid or doesn't exist

To see the preflight status (and detailed results), you should open the task's Log Info, or the
XML report it produced.

• When running the task in a workflow, the XML report is sent through a different output pin
depending on both the processing status and the preflight status.

There are 5 output pins, corresponding to the following statuses:

Output pin Processing status Preflight status

 Pass Input file processed
successfully

With this color strategy, all
conversions are within your
Delta E tolerance
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Output pin Processing status Preflight status

 Fail Input file processed
successfully

With this color strategy, at least
one of the conversions gives a
Delta E above your tolerance

 Pass
Unregistered

Input file contains unregistered
inks

All conversions are within your
Delta E tolerance

 Fail
Unregistered

Input file contains unregistered
inks

At least one of the conversions
gives a Delta E above your
tolerance

 Error The color strategy is invalid or
doesn't exist

Cannot preflight

Preflight Results Details in the Log
You can see the preflight results in detail in the task's Log Info.

 

 

Under Results, it lists:

• which of the input file inks were converted by your chosen color strategy (certain ink types
are never converted)

Note:  If your input file contains a double strike of an ink (a percentage above 100%), this
ink will appear twice.

• the conversion values for those inks (in percentages of the printing inks)
• the Delta E achieved for each converted ink
• the overall PASS or FAIL status
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Attention:  After running a workflow containing the Preflight Color for Digital
Printing task, make sure you open the task's Log Info and not the workflow's Log Info
(as the workflow's log only contains processing information).

Preflight Results Details in the XML Report
Each Preflight Color for Digital Printing task also generates an XML report containing
detailed results about the conversion to your chosen color strategy with your desired Delta E
tolerance.

 

 

It contains the same information as the log, but is formatted to be easily usable by an MIS
system (or Automation Engine's Join XML Files task, in preparation for sending to an MIS
system).

If you are reading this XML report yourself:

• you can find the overall status at the top of the file (for example Status="passed"),

• you can check which of the input inks were converted (ink types that are never converted
indicate the reason in their status, for example Status="IsProcessInk" or
Status="IsVarnish"),

• for the inks that were converted, you can see the resulting percentages of the printing inks
in DeviceColor, and the Delta E achieved.

Preflight Color for Production
You can use the Preflight Color for Digital Printing task on the production floor, to help you
maximize the speed and cost-efficiency of your digital press while still printing your jobs with
good color accuracy.

When using this task to prepare for production, you want to decide on the ink set to use for
your print job, but you may also want to take into account any tweaks necessary to get the best
color result on your particular digital press.

This means that for each Preflight Color for Digital Printing task that you run on your file,
you should select a Color Strategy using your digital press profile as an output profile.
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Tip:

When profiling your digital press in Color Pilot, you can easily generate:

• a color strategy with your digital press profile as output profile,
• additional color strategies with a subset of that profile's ink set as output profile (for

example, if you profiled your digital press with a CMYKOV ink set, you can also generate
color strategies to output to CMYK, CMYKO and CMYKV on that press).

See the Color Pilot documentation for details.

Example Workflow
One of the simplest ways to set up a workflow to check what ink set a file can be printed with is
to cascade several Preflight Color for Digital Printing tasks.

 

 

1. This workflow first marks the input file with a tag (File to Preflight) then sends it to
the first Preflight Color for Digital Printing task.

2. This task checks whether printing the file with an EPM (CMY) color strategy would give a
good color accuracy.

Note:

Make sure the color strategies you use in all your Preflight Color for Digital Printing tasks:

• are digital printing color strategies,
• use (one of) your digital press(es)'s profile as output profile.

For information about generating color strategies outputting to several ink sets from a
digital press profile, see the Color Pilot documentation.

The task outputs an XML report detailing the color accuracy that can be achieved.

• If printing the file with EPM would give good results, the report goes through the  Pass
output pin (the first green pin), and the workflow is finished.
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• If EPM doesn't give a good color accuracy, the report goes through the  Fail output pin
(the second green pin), and the workflow continues.

• If your file contains one or more unregistered inks (inks that do not exist in your color
database), it goes through one of the orange output pins (either  Pass Unregistered or

 Fail Unregistered depending on the Delta E values).

In this case, the workflow ends with a warning (regardless of the Delta E values, the file
isn't checked by any other Preflight Color for Digital Printing task).

• If the color strategy you have selected in your first Preflight Color for Digital Printing
task doesn't exist (if for example it was deleted before you ran the workflow) or is not a
digital printing color strategy, the report goes through the red  Error output pin and
the workflow ends with an error.

3. If the first color strategy (EPM) didn't give a good color accuracy, the XML report going
through the second output pin triggers the Select Marked File workflow control.

This is set to select the input PDF/Normalized PDF corresponding to that XML report (using
the File to Preflight tag and Only select when name matches: [File]).

See Mark File and Select Marked File on page 772 for more information.
4. That input PDF/Normalized PDF is then passed on to the next Preflight Color for Digital

Printing task, that checks whether printing the file with a CMYK color strategy would give a
good color accuracy.

5. If this is not the case, the file is checked against an IndiChrome (CMYKOV) color strategy,
then if necessary an IndiChrome Plus (CMYKOGV) one.

6. If none of the ink sets/color strategies gives a good color reproduction, the workflow ends in
a warning.

You can then check the different XML reports to help you make a decision about how to
print your file.

Depending on the case, you may want to use one or more additional spot colors, print the
file with one of the color strategies anyway, tweak the color strategy in Color Pilot, adjust
the file...

Preflight Color for Cost Estimation
You can use the Preflight Color for Digital Printing task at your sales office, to help you quote
a competitive price to your customers without skimping on quality.

You can even connect it to your MIS system (for example CERM or Label Traxx), to get the print
job information automatically, then send the color preflight results back to the MIS.

When using this task for cost estimation, the main goal is to decide on the ink set needed to
print your job with a good color accuracy.

At that stage you don't need to worry about tweaking the print job to print on a
specific press so you can use a Color Strategy with a generic output profile (for example
ISOcoated_V2_eci.icc for the CMYK ink set).

Example Workflow
There are many ways you can set up a workflow that checks what ink set a file can be printed
with so you can quote a competitive price to your customers. For example, you can:
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• Set up a cascading workflow that checks the file against each ink set, then check the
workflow's results to choose the ink set to use (this is similar to the production workflow, but
here you can use generic color strategies with the right ink sets, instead of color strategies
made for a specific digital press).

• Set up a workflow with one Preflight Color for Digital Printing task, where the
color strategy and Delta E tolerance are public parameters, and enter all the
color strategies you want to check as a semicolon-separated list (for example
CMY;CMYK;CMYKO;CMYKOV;CMYKOGV). For each color strategy you specify, your file will go
through the task and you will get an XML report.

• Set up a workflow that integrates with your MIS system, so that you can automatically
launch the workflow on any file that comes into your MIS system for quotation, and get the
results back into your MIS system (this way you can do this from your sales office without
even needing to open the Automation Engine Pilot).

Workflow with MIS Integration

This example workflow is set up to:

• take a PDF file,
• check it against a list of color strategies and a specific color tolerance (that are saved as

workflow parameters),
• join all XML reports into one and save it in a location that your MIS system monitors,
• end in OK for the color strategies that can be used to print within the color tolerance, and in

Warning for all other cases.

 

 

1. Preparation

The input file is paired with every color strategy that needs checking, and sent through the
workflow as many times as there are color strategies.

a) The input file is marked with the cp_InputFile tag so it can be picked up by the
workflow later on.

b) The Run Script task generates an XML file for each color strategy, containing the input
file name and color strategy name. Those XML files are marked as cp_tempfile.

c) The Data Splitter sends the XML files one by one to the rest of the workflow, where they
will each trigger a color strategy check.

2. Color Preflight

For each input file/color strategy pair, the Preflight Color for Digital Printing task checks
the color accuracy that can be achieved, and generates a detailed report.

For each XML file sent from the Data Splitter:
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a) The Modify Workflow Parameter Values workflow control picks up the color strategy
name in the XML and saves it to the SelectedStrategy workflow parameter.

b) The Select Marked File workflow control picks up the input file and sends it to the
Preflight Color for Digital Printing task.

c) The Preflight Color for Digital Printing task checks whether converting the input file
with the current color strategy (from the SelectedStrategy workflow parameter)
would give a Delta E within the required Delta E tolerance (from the Tolerance
workflow parameter).

It outputs an XML report detailing the color accuracy that can be achieved with that color
strategy, through the appropriate output pin.

d) If the file can be printed within the color tolerance using that color strategy, the State
workflow parameter is set to Pass. Otherwise it is not changed.

3. Reporting

The Data Collector collects all XML reports and sends them to the Join XML Files task, to
make a single big XML file for easy consumption by the MIS system. This file is saved in a
location that the MIS monitors.

4. Cleanup

The individual XML reports are marked as cp_tempfile and, together with the other
temporary files (the XML files produced by the Run Script task), they are deleted.

5. Workflow End State

The Router directs each iteration of the input file to the right workflow end state based on
the State workflow parameter set by the Preflight Color for Digital Printing task.

• For color strategies that gave a Delta E within tolerance (the State is Pass), the file goes
to OK.

• For color strategies that didn't (the State still has an empty value), it goes to Warning.

The MIS system can then check the end state of the workflow and analyze the joined XML file
containing the color accuracy information for the input file checked with all color strategies.

Note:

Like all Automation Engine workflows, this workflow can be triggered by a JDF file dropped into
a "hot folder"/folder access point for example).

If the JDF contains information about the color strategies to check and the desired Delta E
tolerance, they will overrule those set in the workflow parameters.

At the end of the workflow, the MIS system will get a JDF back, containing processing
information and the location of the joined XML file.

Pre-configured Preflight Color Workflow
For an easy start with the Preflight Color for Digital Printing task, you can use the pre-
configured workflow made by Esko.

This workflow combines the ink set analysis from the Preflight Color for Digital Printing task
with other Automation Engine capabilities, so that you can automatically:
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• perform some PitStop preflight checks on your input file to determine whether your file's
objects are compatible with EPM (CMY) printing (for example check for Rich Black objects,
black-only images, etc.),

• analyze your file's spot colors to determine which ink set(s) you can print it with for a good
color match (CMY, CMYK or CMYKOGV),

• process multiple input files and/or multipage files if needed,
• get both a PDF report with a clear indication of the ink sets you can use, and an XML report

for your MIS or quoting/cost estimation system.

Esko will help you deploy this workflow. Please contact your Esko representative for more
information.

You can also request a custom workflow based on this pre-configured workflow (for your click-
based HP Indigo digital press), if this would fit your needs better.

Note:  This workflow can process most jobs, but is not suitable for jobs containing white
underprint, or jobs with more than 12 spot colors.

Requirements
You need the following as a starting point for deploying the Preflight Color pre-configured
workflow:

Software Requirements
Compulsory:

• Automation Engine 18.0 or later with the "Reporting and 3D" and "Processor" modules
• either Color Pilot 16.x or later, or Color Engine Pilot 13.x (included with HP SmartStream

Labels & Packaging Print Server 4.0 or later)

Optional:

• the "Automation Engine Connect" module, if you need to connect to an external system, for
example an MIS system

• the EPM (Enhanced Productivity Mode) option on your HP SmartStream Labels & Packaging
Print Server/HP Indigo digital Press, if you want to use CMY/EPM

Hardware Requirements
Please see the requirements for your version of Automation Engine:

• for Automation Engine 18.0: server and client system requirements

• for Automation Engine 18.1: server and client system requirements

License Requirements
"Automation Engine Check Color Strategy"

Preparation
You need to do some preparation to ensure that your Esko representative configures the
workflow optimally for your needs.
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Preparing Your Press Profiles
You need to:

• Make a list of all the HP Indigo digital presses and substrates you use.
• Make sure that for each press/substrate combination that you use, you have an accurate

and up-to-date press profile.

Your press profiles should be made with your full press ink set (CMYKOGV).

Your Esko representative will create CMYKOGV, CMYK and CMY (if you are using it) color
strategies based on your CMYKOGV profiles. These color strategies will be used in the
workflow to check which ink set(s) your jobs can be printed with.

Note:

You can create digital press profiles in your Color (Engine) Pilot application.

Your color database contains a number of predefined profiles for certain substrates (for
example HPI-CREAM-ANTIQ-CMYKOGV for the Fasson Cream Antique TOP substrate).

You can use these profiles for a faster start-up, but a profile made specifically for your press
will always be more precise.

Outlining Your Way of Working
Prepare the following information (that will be needed to configure your workflow):

• whether you work with EPM/CMY,
• whether you need to connect to an external system (MIS, quoting/cost estimation system...),
• whether you want your PDF reports in a language other than English,
• which ink names you want to exclude from the ink set analysis (technical inks, varnish

inks...),
• which Delta E formula and Delta E tolerance you use when assessing color matches.

If you are working with EPM, the workflow includes a set of additional checks to help assess
EPM suitability:

• checking for black-only images or gradients,
• checking whether the job contains only black, or no black,
• checking for Rich Black objects (fill or stroke),
• checking for very small black objects or strokes,
• checking for very small black text,
• checking for areas with high Total Area Coverage.

You will have the opportunity to discuss which of these checks to apply to meet your particular
needs with your Esko representative.

Workflow Overview
There are two variants of the pre-configured Preflight Color workflow:

• the main Preflight Color workflow, that can:

• perform some PitStop preflight checks on your input file to determine whether your
file's objects are compatible with EPM (CMY) printing (for example check for Rich Black
objects, black-only images, etc),

• analyze your file's spot colors to determine which ink set(s) you can print it with for a
good color match (CMY, CMYK or CMYKOGV),
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• get both a PDF report with a clear indication of the ink sets you can use, and an XML
report for your MIS or quoting/cost estimation system.

See Main Workflow on page 1446.

• the multipage Preflight Color workflow, that can do all of the above, but for multiple
input files and/or multipage files.

See Multipage Workflow on page 1448.

Main Workflow

The main pre-configured Preflight Color workflow variant can:

• perform some PitStop preflight checks on your input file to determine whether your file's
objects are compatible with EPM (CMY) printing (for example check for Rich Black objects,
Total Area Coverage, etc),

• analyze your file's spot colors to determine which ink set(s) you can print it with for a good
color match (CMY, CMYK or CMYKOGV),

• get both a PDF report with a clear indication of the ink sets you can use, and an XML report
for your MIS or quoting/cost estimation system.

Note:  If you have multipage files/multiple input files, you should use the multipage workflow
variant instead.

 

 

1. EPM Preflight Check
 

 

If you are using EPM, the workflow runs EPM preflight checks on your file. Those checks help
assess how suitable EPM is for printing your job.

Your Esko representative will have tailored these checks to your way of working.
2. Technical Inks Removal
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The workflow removes any technical/varnish... inks that don't need to be color converted.
3. Color Analysis

 

 

The workflow analyzes how accurately your job can be printed with CMY (if you are using
EPM), CMYK and CMYKOGV using the substrate and press you chose.

To do this, it converts your job's colors using the color strategies made for your press and
substrate.

4. Reporting
 

 

The workflow creates an XML report for your 3rd party system, and a PDF report for you.

The (final) XML report contains the results of the EPM preflight check, as well as the
information from the individual XML reports generated by each Preflight Color for Digital
Printing task (for CMY, CMYK and CMYKOGV).
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5. Cleanup
 

 

The workflow cleans up the input files and individual XML reports.

Multipage Workflow

The multipage variant of the pre-configured Preflight Color workflow does everything the main
workflow variant does, but can process:

• both single page and multipage files,
• both single files and multiple input files.

You should use this workflow variant when working with multipage files/multiple input files,
but when working with single one-page files, we recommend you use the main workflow (as it
is a little faster).

 

 

1. File/Page Splitting

The workflow checks the number of pages of the input file, and splits multipage files into
individual pages.

Then it feeds those pages (or any single page file that came in) individually to the rest of the
workflow.

2. Preflight and Color Analysis (Main Workflow)

This sub-workflow:

a) runs EPM preflight checks on your file (if you are using EPM),
b) removes any technical/varnish... inks that don't need to be color converted,
c) analyzes how accurately your job can be printed with CMY (if you are using EPM), CMYK

and CMYKOGV using the substrate and press you chose,
d) creates an XML report for your 3rd party system, and a PDF report for you.
See Main Workflow on page 1446 for more details.

3. Cleanup
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This part of the workflow collects all files, and:

• keeps the reports for you to review (it adds a review task to your To-Do list),
• deletes the input files and pages.

Using the Workflow(s)
Like with all Automation Engine workflows, you can run the pre-configured Preflight Color
workflow on your files from the Pilot, Shuttle, or automatically through a connection with an
upstream system.

If you are using the Pilot:

1. Select your one-up PDF and launch the pre-configured Preflight Color workflow.
Use the workflow name given by your Esko representative (for example
ColorPreflight_V1_main).

2. In the ticket that opens, choose the Substrate and Press you want to print your job with,
and click Launch.

3. The workflow automatically:
a) splits the file's pages to analyze them one by one (if you are using a multipage file and

the multipage workflow),
b) runs EPM preflight checks on your file (if you are using EPM),
c) removes any technical/varnish... inks that don't need to be color converted,
d) analyzes how accurately your job can be printed with CMY (if you are using EPM), CMYK

and CMYKOGV using the substrate and press you chose,
e) creates an XML report for your 3rd party system, and a PDF report for you.

4. Based on the report data, you can easily see what ink set(s) give you a good color match,
and decide on the best ink set to use based on cost and quality.
The report also contains more detailed information (about the Delta E values, EPM checks...)
if you need it. See PDF Report on page 1449 and XML Report on page 1451.

Workflow Reports

When using the pre-configured Preflight Color workflow, you get both:

• a PDF report with a clear indication of the ink sets you can use,
• an XML report for your MIS or quoting/cost estimation system.

PDF Report

The PDF report gives you a clear indication of the ink sets you can use, as well as more in-depth
information to help you make a decision even in difficult cases.
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1. This area contains the job information: input file name, date and time, substrate and press
chosen, and a thumbnail of the job.

2. You can see the ink set(s) that give you a good color match at a glance, with "traffic light"
indicators.

3. This area lists the input file's inks. Only spot colors are converted (see converted separations
for more information).

4. This shows the result of each EPM check ran by the workflow, and the values used where
applicable.

5. On the report's second page, you can see the conversion details for each of your input inks,
for the different ink sets. You can clearly see which conversion option(s) meet your color
matching tolerance.
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Note:  By default, this report is in English, but it can be generated in your language of choice
(ask your Esko representative).

XML Report

If you need to make the color conversion results available to an external system (for example
an MIS or quoting software), use the XML report.

Like the PDF report, the XML report contains both high-level information about which ink set(s)
give you a good color match for a particular job, and more in-depth data about EPM checks
and color conversion.

• When using individual Preflight Color for Digital Printing tasks, you get an individual XML
report per task, detailing whether your job's spot colors can be printed with the ink set
chosen in the task (see Color Preflight Results on page 1437).

• When using the pre-configured Preflight Color workflow, you get a single XML report,
that combines:

• the results of the EPM checks the workflow ran on your job,
• the information from the individual XML reports generated for each ink set.
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This combined XML report contains:

1. information about the job,
2. the settings used in the workflow (your color match tolerance, the values used in the EPM

checks, the substrate and press chosen),
3. the spot colors to convert,
4. the results of the EPM checks,
5. a "passed" or "failed" result for each ink set,
6. the spot color conversion details.

19.3.3.  Print on Digital Press

Attention:  Unlike the "Submit to …" tasks, this task currently still has more elaborated
functionality but does not use the Devices view. The type of press and version of the
DFE decide which type of task can be used.

Important:  This task can serve 2 kinds of DFEs:

• The HP SmartStream Labels and Packaging Print Server Powered by Esko. In below
pages, for sake of easy reading, we will name this the HP DFE.

• The Esko (Inkjet) DFE, a DFE serving several types of inkjet digital presses.

Note:  To see which version of the DFE engine software supports which version of Automation
Engine's Print on Digital Press task, check http://www.esko.com/systemrequirements.
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Working with a DFE (Digital Front End) Server
Automation Engine can use files in its Containers to create Print Jobs on a DFE Server.
Automation Engine monitors those print jobs until they are printed on the digital press.

In Automation Engine:

• use the Print on Digital Press task to create print jobs on the DFE server. This step typically
creates a step & repeat PDF and also executes color management.

• the Print on Digital Press (Track) task is started automatically and shows the status of the
print jobs on that DFE server, also of print jobs that were not created via this task.

Both these tasks show detailed feedback for each step of the DFE printing process in the Pilot's
Tasks pane.

Setup

Before using those tasks, you must connect your Automation Engine server to your DFE server.
This is done in the Configure panel (Digital Press). This task does not connect to devices that you
set up in the Devices view.

Note:  When your DFE server drives several digital presses, you also need to select the press to
connect to.

Supported File Types
The task can send these file types to a digital press:

Note:  'Static' print jobs are print jobs that are not VDP jobs.

For 'Static' print jobs: For Variable Data Print jobs:

• PDF
• Normalized PDF (self-

contained, so images
embedded)

Note:  This can be a one-
up or an already stepped
self-contained PDF.

• PDFPLA (Plato PDF)

• PDF/VT (for example generated by Adobe Illustrator, by using the
Dynamic VDP Plug-in).

• VDT (Variable Data Template), also made in Adobe Illustrator, by
using the Dynamic VDP plug-in.

Note:  Before PDF/VT, the Print on Digital Press (PPML) task was
used to have Automation Engine use PPML files to create variable
print jobs on the DFE server. This task has been declared 'Soon
Outdated'. Learn more in Print on Digital Press (PPML) (Soon Outdated)
on page 492).

Note:  If your MIS system stores print job parameters in JDF format, you can add that JDF file to
the input of the Print on Digital Press task.

About Variable Data Printing

When using a VDT file to print a VDP job, the expansion of the variable data (using the Variable
Data Database) happens on the DFE. This is typically used when executing the expansion in
Adobe Illustrator or Automation Engine takes too much processing resources.
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Note:

• A VDT file contains VDP objects (placeholders for the variable data) and must be expanded
to a PDF/VT file on the DFE server.

• A VDT file can be created with the Dynamic VDP DeskPack plug-in.

• Fonts used inside the VDT file must be installed on the DFE server.

Using the Print on Digital Press Ticket in a Workflow
Unlike most workflow steps, the Print on Digital Press step does not create output files to be
transferred to the next workflow step, but sends this output data to the DFE server.

This also means that this task step is always the final task in a workflow (branch).

In the workflow editor, you can see the number of files the task has successfully processed on
its output pin called Inputs.
 

 

Print on Digital Press Task Settings
 

 
Device: Choose the digital press you want to send your file to. This list contains all the digital
presses that you added in Configure.

Print Job Ticket: Choose the print job ticket you have created on the DFE server to process
and print jobs. In the list of tickets, notice the column indicating their Workflow Type:
Dynamic or Classic.

Note:  When using the Print on Digital Press task, make sure the DFE server is running and
that the Print Controller on the DFE is running. When your task is stuck, check if the Digital
Press connection is still OK (in the Configure tool).
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Note:  For all parameters in the below mentioned settings, you can choose the SmartName
[From Print Job Ticket]. This will use the parameter value as defined in the selected DFE Print
Job Ticket.

The value that the SmartName finds in the chosen Print Job Ticket is
then shown to the right of the input field, between parenthesis. For

example:

If you added a JDF file to the task input, you can choose [From JDF Ticket] to use the
parameter value defined in that JDF file.

We now illustrate the settings in the tab sheets:

General Tab
 

 

• Print Job Name: Keep the name if the input file or use a SmartName, Public Parameter or
Workflow Parameter to define a different one.

• Substrate: Shows the list of substrates available on the press.
• Copies: Enter the number of copies to be printed.
• Lead-in Sheets: Enter the number of Lead-in Sheets that need to be printed at the start of

the print run, or select <None> in case you don't want to use any.
• Lead-out Sheets: Enter the number of Lead-out Sheets that need to be printed at the end

of the print run, or select <None> in case you don't want to use any.
• Die Cut Layout Input Ink: Specify the ink of the input file of which its contents will be used

for the lead-in/lead-out sheet. This is typically a technical ink (for example Cutter).
• Die Cut Layout Print Ink: Specify the ink that will be used to print the lead-in/lead-out

sheets. This must be one of the inks of the selected Ink Set in the Color Management tab.

Note:  There is an exception to this rule for the HP DFE: if you print in CMY, you still use
Black.

• Comments: Use SmartNames or choose Custom to enter print job related comments. They
will be included with the file sent to the press, and become visible on the press's software
panel (if your press model supports it).
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Files tab
In this tab, you define the One-Ups. The available options depend on whether this is a Duplex
print or not.

For both part in this tab, you can choose Custom to define the settings here. Or you can
choose [From JDF Ticket] to have them decided by an input JDF file.

 

 

About the Task Input Files and One-Ups

• For pre-imposed PDFs or single-grid step and repeat files, only one file is needed to be
added here as One-Up. If you are using multi-grid step and repeat, add here as many file
entries as you will send to this task.

• In the Step and Repeat tab, you can map the here defined one-ups as input files for the
desired grid of the template step and repeat.

• In the case you use VDT Files, you also need to define a Database file and optionally an
Image path.

Note:  If the amount of the task's input files is not equal to the number of files specified in this
Files tab, you will get an error.

Here are some specifics per use case:

For a One Sided Print Job
For one sided print jobs, keep the Duplex print option disabled. In the One Up settings,
choose custom.

For a Duplex Print Job

Note:  Not all digital presses support duplex printing.

To create a duplex print job, select the option Duplex print. Then define the

Backing Up mode:
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• Select Tumble if you want the roll to be re-inserted into the digital press with rewinding.
• Select Turn if you want the roll to be re-inserted into the digital press without rewinding.

The One-Up Settings list allows you to Custom specify an input file for both the Front and the
Back side of the print job.

With duplex print jobs, the same Database File and Image Path is used for the same grid for
both Front and Back.

For a VDP Job
For VDP jobs, you also need to specify the source of the variable information. To do this, follow
these steps:

1. In One-Up Settings, choose Custom.
2. Click Add.
3. In the field for the database file, click Select.

In the Select Database File dialog, your Source can either be a 

• CSV File. This is used in case the job contains complex information such as names, serial
numbers or links to images. 

• Simple Database. In this case, you only use "Simple Counters". This is suited for jobs
that only require a simple sequence of numbers. Define how many records need to be
generated in the field Number of Records.

Learn more in the user documentation of your DFE.

Note:  Creating a VDP print job from a VDT file is supported for Dynamic Workflows (for
version support, check http://www.esko.com/systemrequirements).

Step and Repeat Tab

Concept

The Step and Repeat Settings can be defined

• here, in this tab of this task. To do this, select Custom and read below how to define the
settings. Disable the option Step and Repeat if you do not want to step and repeat.

• On the DFE, as part of the settings in the selected print job ticket. To do this, use the
SmartName [From Print Job Ticket]. The task then reads that DFE ticket and shows its
settings here, in read-only mode.

• by a JDF input file, using the SmartName [From JDF Ticket].

Note:  When using the PowerLayout DeskPack plug-in to send jobs to the DFE, you have
already created your step and repeat, so that input file will here be considered as a one-up.

Defining the Type of Step and Repeat in this Ticket

When you enabled the option Step and Repeat and you selected custom in Step and Repeat
Settings, you can define Template based or Tabular layouts.

Creating a Template based Step and Repeat
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If you want to step and repeat from a template, select one in the Template field.

Important:

• If you are working with multiple input files, you need to use a step and repeat template. You
cannot define a tabular step and repeat.

• Template based step and repeat is only supported when using a Print Job Ticket of the
Workflow Type 'Dynamic'.

Note:  Step and repeat templates and marks can be created in DeskPack (PowerLayout
Standalone & Dynamic Marks). Learn more on how to create these templates in the DeskPack
documentation.

If your template has multiple grids and you have selected multiple one-ups in the Files tab, the
task will automatically assign the first grid to the first one-up, etc. You can change this following
these steps:
 

 

1. Select a grid either by clicking it in the Sheet Preview or by using the arrows in the Grid
parameter.

2. In the list of One-Ups (that was specified in the files tab), select the one to go with this grid.
In this way you can assign the desired number of input files to a certain grid.

3. Repeat this for each grid and one-up you want to associate.

Note:  If the number of one-ups does not match the number of grids in the template, or if the
size of a one-up does not match the size defined in the template's grid, you will see a warning
icon in the sheet preview.

The Grid Details tab will automatically be filled with the data of the selected grid from the
template.
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When working with duplex print jobs, you need to specify an input file in the One-Up
parameter (Files tab) for both front and back. See this example:
 

 
 

 

Creating a Tabular Step and Repeat

This mode is available when you do not select a template. You can then specify all Grid Details
in this ticket and you can optionally specify Variable Data settings.

Learn more below in Grid Details and in Variable Data Tab on page 1461.
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Sheet Preview

The Sheet Preview shows a preview of the result of your grid settings. You can also select grids
by clicking on them in this preview.

Note:  When you selected a template via a SmartName, the preview will not be available.

Adding Finishing Marks and Defining Margins

Learn more below in Marks and Margins on page 1463.

Indication of Grid/Template Size and Actual Repeat Area

At the bottom of the dialog, you will see the Grid Size (if you defined a tabular step and
repeat), or the Template Size (if you used a template). This includes the margins you defined in
Marks and Margins.

The Actual Repeat Area shows the area actually used by the repetition, not including the
margins. The width and length values are calculated based on the step and repeat parameters,
including gaps. You cannot edit them.

Grid Details Tab

When you have only defined one One-up file in the Files tab, this is where you can define
tabular step and repeat settings for that single one-up.
 

 

Note:  If you are using a template, this tab will automatically be filled with data from the
template (which is then non-editable).

Repeat one-up using its: Choose whether to use the dimensions of the one-up's Trim Box or
Media Box to calculate the repetition grid.

You can see the One-up Size on the right.
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Clip on trim box with bleed of: Use this option to add bleed when clipping a one-up on the
Trim Box.

Note:  This value should not be larger than half of the gap defined in the corresponding
direction.

Orientation: Choose how to orientate the one-up.

Available Repeat Area: Define the width  and length  of the repeat area.

• The width can be set to Substrate Width (the width of the substrate you chose in the
Printing Properties) or to a Custom value.

• The length can be set to the Maximum Repeat Length or to a Custom value.

Repetition: This defines the number of horizontal  and vertical  steps in the repetition
grid. You can choose either:

• Maximum: The server will calculate the maximum amount of repetition steps possible
within the Available Repeat Area.

• Custom: Enter the repetition amount of your choice.

Gaps: The values you enter here (for a horizontal  and a vertical  gap) will be used as a
distance between the one-ups' borders in the repetition grid.

Note:  For seamless printing, the top and bottom margin have to be equal to half of the
vertical gap.

Variable Data Tab

Note:  This tab can only be used when you are working on a variable print job (for this you
need to have selected a Print Job Ticket of the Workflow Type 'Dynamic'.

Note:  To send variable print jobs, the HP DFE needs to be version 4.0 or higher.

Use this tab to define how to distribute your variable data over the grid of one-ups that you
built in the Grid details tab, or over the one-ups repeated according to the Template that you
chose.

Start: Choose where to start printing your variable data (where to print the first record):

 top left,  top right,  bottom left,  bottom right.

The preview on the right shows a black dot representing the position of the first record.

For example, this distribution starts on the top left:
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while this distribution below starts on the top right:
 

 

Choose also if the flow of variable data should run horizontally  or vertically .

The preview on the right reflects your choice.

Horizontal flow:
 

 

Vertical flow:
 

 

Note:  The Printing direction marked with an arrow shows the direction that the paper flows
through the press.

Note:  When you selected a button via a SmartName, the preview will not be correct.

Fill over: Choose if you want to distribute the variable data over the Complete Job or over
Blocks.

If you choose Blocks, the variable data flow will run over Blocks of a certain size, then run over
the next Block when the previous one is complete.
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You can see an example of Blocks in the preview.
 

 

Block Size: You can define the size in Grid Rows, Sheets, Feet or Meters.

If you have chosen to Fill over the Complete Job, then the Block Size will be 1.00 Job by
default.

You can set it to another unit if you still want to print in Blocks, but without having the variable
data flow respect the Block. This is useful if you want to add gaps (see below).
 

 

Add gap between blocks: This adds white space in between the Blocks. It is available when
you have chosen to Fill over Blocks, or to fill over the Complete Job but still have Blocks (as
explained above).

Gap size: This is available when you have selected Add gap between blocks. Define the gap
size in Grid Rows, Sheets, Feet or Meters.

Marks and Margins

Click on Marks and Margins to add marks and margins to your output.

Note:  You can also set marks and margins when you are not using step and repeat in your
print job (when the Step and Repeat option at the top of the dialog is deselected).

Marks

Choose if you want to add Finishing Marks to your print job. Finishing marks are used to
align the substrate for cutting. Select a set from the list or use [From Print Job] or any other
SmartName.

The list offers the marks that you made in 'Dynamic Marks' and, in case of an HP DFE, also the
default marks 1 x LabelRow, 1 x Sheet or 2 x LabelRow.
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Note:  These marks are all visible when Step & Repeat is active, or from within PowerLayout.
When Step & Repeat is inactive, only 1 x Sheet is shown.

Note:  If you are using a Step and Repeat template from the DFE, you can not add finishing
marks here. The marks from the template will be applied.

Note:  Second pass marks (also called "reinsertion marks") can not be controlled from
Automation Engine. Those can only be set on board the DFE ticket

Margins

 

 
You can define each margin (1, 2, 3 and 4) using the following:

• Gap (Length or Width): The size of a gap between one-ups.
• Gap (Length or Width) / 2: Half the size of a gap between one-ups. This is typically used for

top and bottom margins, as the bottom margin of one sheet plus the top margin of the next
sheet will be equal to one gap.

• Custom: a custom number (formulas are not allowed).

Note:  If you selected a finishing mark which size you defined in the DFE's configuration tool,
the corresponding margin will show up as Defined by Mark.

This means that the margin is automatically large enough to provide space for this finishing
mark. For example, if you, on a HP DFE, selected the default mark 1 x LabelRow, which is set
in the DFE configuration tool to need 8 mm of right margin, the right margin (4) will be set to
Defined by Mark and be 8 mm wide.

Transformation Tab
• Vertical Scale: Use this to scale the print job vertically (in the length).
• Horizontal Scale: Use this to scale the print job horizontally (in the width).
• Rotation: Choose the rotation of the print job (None, 90˚ CW, 180˚ or 90˚ CCW).

Note:  Rotation is disabled when Step and Repeat is enabled.
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• Mirror: Choose whether or not to mirror the contents of the print job.

Color Management Tab
• Ink Set: Choose the set of process inks that will be generated by the RIP. The list depends

on the press model.
• Use: Define if you want to use color management when RIP'ing the print job (to convert

the file separations to the ink set used by the press), and what kind of color management.
Choose <None> if you don't want to use any color management settings for this
conversion.

• When you do want use color management here, select a Color Strategy from the list (or
use a SmartName).

19.3.4.  Submit to Esko DFE

Note:  This task is only used as part of a pre-defined workflow used in the browser client of
Automation Engine (the QuickStart deployment).

Concept
This task submits a print-ready PDF or a JDF referencing print-ready PDF files to an Esko DFE.
An Esko DFE here means any DFE developed by Esko, so also those that were re-branded by
3rd party vendors and named "Powered by Esko".

Task Options

• Device: Select a device from the list of Esko DFE devices that you added in the Device view.
• Due Date: Choose a time when this job should be printed.

Note:  A due date specified by a SmartName must resolve to a valid ISO 8601 string, i.e. the
format yyyy-mm-ddThh:mm:ss . For example 2017-03-10T10:00:00 .

• Copies: Specify the number of frames to print.
• Print Job Ticket: Click on  to select one from the list of tickets on the DFE of the selected

device.
• Substrate: Click on  to select a substrate from the list of substrates specified on that DFE.
• Color Strategy: Click on  to select a color strategy from the list of strategies specified on

that DFE.

When the specified Print Job Ticket is of the type "Classic", only "Classic" Color Strategies
are allowed. When the specified Print Job Ticket is of type "Dynamic", all Color Strategies
are allowed.

Note:  The priority of the print job in the Esko DFE is inherited from the priority of this task.

19.3.5.  Submit to HP SmartStream Production Pro Print Server

Concept
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HP's Digital Front End "Production Pro" is used to drive HP Indigo presses. This task submits a
JDF file to the HP Production Pro. The JDF includes references to the print-ready PDF file(s) and
various options on how this job should be printed..

Typically, Automation Engine creates a step & repeat PDF including marks and submits that file
to the DFE in its original color space (process + spot colors).

Task Options

• Tab General

• Device: Select a device from the list of configured HP Production Pro devices that you
added in the Device view.

• Due Date: Choose a time when this job should be printed.

Note:  A due date specified by a SmartName must resolve to a valid ISO 8601 string, i.e.
the format yyyy-mm-ddThh:mm:ss . For example 2017-03-10T10:00:00 .

• Internet Input Method: Click on  to select the 'Internet Input method' from the list
of available methods that were specified on the HP Production Pro.

• Comments: Here, you can for example add instructions for the press operator. They will
appear on the Production Pro (Job >  Information >  Comments) and also on the HP
press interface.

• Tab Production

• Copies: Specify how many of the input file should be printed.

Note:  When his task is started from the browser client of Automation Engine (QuickStart
deployment), then this is typically a Step & Repeat PDF, there referred to as a frame or
sheet.

Attention:  When all the frames in the job are identical (so a static job, also
without LILO sheets), then this number of copies will reflect the number of
frames to be printed. This way the HP press operator can still easily overrule the
run length.

• Substrate: Click on  to select a substrate from the list of substrates specified on that
HP Production Pro. Alternatively, leave this field to the default 'Use value from internet
input method' or use a SmartName.

• Color Strategy: Click on  to select a color strategy from the list of strategies specified
on that HP Production Pro. Alternatively, leave this field to the default 'Use value from
internet input method' or use a SmartName.

• Lead-in Sheets: Enter the number of Lead-in Sheets that need to be printed at the start
of the print run, or select <None> in case you don't want to use any.

• Lead-out Sheets: Enter the number of Lead-out Sheets that need to be printed at the
end of the print run, or select <None> in case you don't want to use any.

• Die Cut Layout Input Ink: Specify the ink of the input file of which its contents will be
used for the lead-in/lead-out sheet. This is typically a technical ink (for example Cutter).
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• Die Cut Layout Output Ink: Specify the ink that will be used to print the lead-in/lead-
out sheets. This must be one of the inks of the selected PDF file.

Note:  There is an exception to this rule for the HP DFE: If you print in CMY, you still use
Black.

• Tab Transformation

• Rotation: Choose the rotation of the print job from the list.

• Mirror: Choose whether or not to mirror the contents of the print job.

19.4.  Using Shared Resources between Automation
Engine and the DFE

By default, Automation Engine and the Digital Front End are each installed with their own
resources (for color management, dot gain curves, step and repeat templates and marks).

However, when working with Automation Engine and the Digital Front End together, you need
to make sure they are using the same resources.

This is very important, as if you set some parameters in Automation Engine using resources
that are not available to the DFE, you will have trouble sending your job to print at the DFE
side.

Note:

You should only use one Color Pilot application for color management, that works with the
same color database that both Automation Engine and the Digital Front End use.

This should be the Color Pilot application that came with your Digital Front End software.

Before You Start
Before you start merging and redirecting resources, make sure that:

• Automation Engine, your Digital Front End server and Color Pilot are located in the same
Local Area Network,

• your DFE server's BGSYSTEM user has read and write access to the following shares on your
Automation Engine server:

bg_data_cms_v010
bg_data_dgc_v010
bg_data_custom_v010
bg_data_marks_v010

Cases
• If this is your first installation of both applications, you can just redirect your Digital Front

End to look at Automation Engine's resources.

See Using Shared Resources for Newly Installed Applications on page 1468.
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• If you have been working with Automation Engine and your Digital Front End for a while,
you probably have custom data in both sets of resources.

In this case you also need to merge your resources. See Using Shared Resources for Existing
Applications on page 1468.

19.4.1.  Using Shared Resources for Newly Installed Applications

If you have just installed both Automation Engine and your Digital Front End software for the
first time, their resources only contain default data.

In this case, you just need to make sure that your Digital Front End and Color Pilot software use
Automation Engine's resources.

1. Redirect your DFE server to use Automation Engine's resources instead of its own.
a) Open your DFE server's Configuration Tool by going to Start > All Programs > Esko >

[DFE Server Type and Version] > [DFE Server Type] DFE Configuration.
b) At the bottom of the Data tab, under Resources Search Path, click the Configure... link.
c) In the Resource Server location changed pop-up, select On another computer, and

enter the name of your Automation Engine server.
d) Click OK, and OK again in the Configuration Tool.

This makes sure the DFE uses Automation Engine's color database, curves database, Step
and Repeat templates database and marks database.

2. Check that your Color Pilot application uses the color database set in your DFE server
(which is the Automation Engine color database).
a) Go to Edit > Preferences... and click the Servers tab.
b) Under Esko Server, check or fill in the connection details for your DFE server (Server

Name, User Name and Password).
c) Click the Check Connection button. You should see Status: Connected (with a green

dot).
d) Click the Database tab and select Obtain from Esko server. The name of your DFE

server should be visible.
e) Click OK.
f) If you get prompted to restart your Color Pilot, click Restart Now to confirm.

19.4.2.  Using Shared Resources for Existing Applications

If you have been working with Automation Engine and your Digital Front End for a while, you
probably have custom data in both sets of resources.

In this case you also need to:

• copy the curves, Step and Repeat and marks data from your DFE server to Automation
Engine,

• merge your color databases, by exporting the data from your DFE's color database into your
Automation Engine's color database.

Note:  To minimize disruptions, you should do this when your DFE server and your Automation
Engine server are not in use.
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1. Copy your DFE's curves data to Automation Engine.

The curves data is typically located in C:\Esko\bg_data_dgc_v010 on your DFE server.

Merge it into your Automation Engine server's bg_data_dgc_v010 share (\\[AE Server
Name]\bg_data_dgc_v010).

2. Copy your DFE's Step and Repeat data to Automation Engine.

Step and Repeat templates are typically located in C:\Esko\bg_data_custom_v010 on
your DFE server.

Merge this folder into \\[AE Server Name]\bg_data_custom_v010.
3. Copy your DFE's marks data to Automation Engine.

The marks data is typically located in C:\Esko\bg_data_marks_v010 on your DFE server.

Merge this folder into \\[AE Server Name]\bg_data_marks_v010.

Note:  Some marks data is also present in the bg_data_custom_v010 folder, that was
merged in the previous step.

4. Open your Color Pilot application to merge the color databases.
5. Check that your Color Pilot uses the color database of your DFE server.

a) Go to Edit > Preferences... and click the Servers tab.
b) Under Esko Server, check or fill in the connection details for your DFE server (Server

Name, User Name and Password).
c) Click the Check Connection button. You should see Status: Connected (with a green

dot).
d) Click the Database tab and select Obtain from Esko server. The name of your DFE

server should be visible.
e) Click OK.
f) If you get prompted to restart your Color Pilot, click Restart Now to confirm.

6. Still in Color Pilot, export the data from your DFE server's color database.
a) Go to File > Export Library...
b) In the Export Library dialog, check that Export as one single archive is selected.
c) Browse to your desired location, change the name of the FilePacker (.fp) archive that

will be exported if you want, and click Export.
d) Depending on the amount of data, you may get a warning that the export can take a long

time. Click Yes.
7. Redirect your DFE server to use Automation Engine's color database instead of its own.

a) Open your DFE server's Configuration Tool by going to Start > All Programs > Esko >
[DFE Server Type and Version] > [DFE Server Type] DFE Configuration.

b) At the bottom of the Data tab, under Resources Search Path, click the Configure... link.
c) In the Resource Server location changed pop-up, select On another computer, and

enter the name of your Automation Engine server.
d) Click OK, and OK again in the Configuration Tool.

8. Restart Color Pilot.
Since Color Pilot takes the location of the color database from the DFE server, and the DFE
server takes it from the Automation Engine server, Color Pilot is now using Automation
Engine's color database.
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9. In Color Pilot, import the DFE color database archive into the Automation Engine color
database.
a) Go to File > Import...
b) Browse to the FilePacker archive of the DFE color database that you exported earlier and

click Open.
c) In the Import dialog, click Import All.

Note:

If some items with custom data are present in both color databases (like for example the
designer ink book), they will be merged.

Merging adds any data from the archive that wasn't present in the Automation Engine
database, but does not replace any data.

d) Click Close when the import is done.
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20.  Collaborating via Esko Cloud

20.1.  Concept and Terminology

20.1.1.  What is Esko Cloud?

Esko Cloud is the name of an Esko web architecture. It is used as basis for several Esko
products offering collaboration between partners, both internal or external.
 

 

• When the main goal is to share and approve data over the web, the Esko product is named
"Share & Approve". This product does not require Automation Engine. Therefore it is
not described in this manual. Find more information on https://www.esko.com/en/support/
documentation.

• Esko Cloud can also be used to exchange Jobs between Automation Engines in different
locations. This collaboration between AE sites is enabled by dedicated tasks and tools within
Automation Engine.

This workflow is what we describe in this chapter.
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Note:  "Cloud Connector" is the commercial name of the software module that enables this
collaboration.

20.1.2.  Concept of Collaborating Automation Engines

The main reasons to have Automation Engine's from different locations collaborate are:

• Spreading work-load over multiple sites.
• Offloading work to a location where cost of staff is lower.
• Offloading work to locations where staff has more specialized skills.
• Executing exceptional tasks (rare processing) in the site that has that software license.

The way these Automation Engine (Master) servers can collaborate is via Esko Cloud, an Esko
web architecture.

In this first version of this integration with Esko Cloud, the focus is on exchanging Jobs and
their data, i.e. these 2 use cases:

• As an AE user, I want to make a job available to other sites for collaboration.
• As an AE user, I want to see a list of the jobs on Esko Cloud so I can collaborate on a certain

job from another site.

Automation Engine users can also share (workflow) tickets to Esko Cloud.
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Important:  Esko Cloud stores all data per customer. This is why standardization of customer
IDs or names between all these locations is crucial. Learn more in FAQs and Tips on Customer
Consolidation on page 1507.

20.1.3.  What is a Group? What is a Location?

In the context of collaborating Automation Engine servers,

• a Location is the place where an Automation Engine master server is located.
• The Group is the company that owns several of these locations and that wants to set up this

collaboration. Typically it is this group that sets up its own (web)site in Esko Cloud.

Note:  It is however possible that a groups sets up more than one site in Esko Cloud. For
example to separate all files related to beauty products from those that are pharmaceutical
(and the involved staff).

In this chapter, we use the example of the group "SuperPrint" that has 4 locations that use
an Automation Engine:

• MEX001, in Mexico City, MX
• BER001, in Berlin, DE
• SYD001, in Sydney, AUS
• TOK001, in Tokyo, JP.

20.1.4.  What is Uploading? What is Sharing?

Uploading and Downloading Files

An Automation Engine user can, in the job folder of an active job, make a selection of files
and or folders and Upload these to Esko Cloud. This copies that data to the group's site in Esko
Cloud, more specific in the data zone of the customer of that job.

Note:  It is not foreseen to upload all data from a Job. You need to make a selection.

Note:  FAQ: Why is this only supported on files that are inside an active (blue) job? Because,
conceptually, when you initiate collaboration on data with other location(s), this means that
this job is 'busy'.

Note:  You can also upload job data to Esko Cloud for archiving reasons. Once it is in the cloud,
you can delete the data on Automation Engine.

Attention:  The job will be created automatically on Esko Cloud when it doesn't exist
there yet, but this is not the case for the job's customer. Before any uploading, you
first need to establish links between local and cloud customers. we also call this the
customer consolidation.

An Automation Engine user can, while being in a an active job, go to the view "Esko Cloud"
and see which files were uploaded to Esko Cloud. The user makes a selection and chooses to
Download to Job Folder. This copies the data to the selected job folder and, if needed, creates
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the same structure of subfolders as on Esko Cloud. This also overwrites any same file in the
same place.

Sharing and Unsharing Jobs

When you share a job, you create that job on Esko Cloud. This is not just a folder but also
includes all its meta-data (the 'Job Setup').

Sharing a job it does not move or copy any files.

You can also specify which other location(s) you want to share that Esko Cloud job with. You
thereby invite these locations to collaborate on that job. They will then also see that job and its
files on Esko Cloud.

You can only share jobs with other locations when their local customer was linked to a cloud
customer.

You can't share files, only jobs.

The location that shared the job is called the "Owner Location". Only the this location can
unshare it.

Unsharing a job remove the job and its files from Esko Cloud.

Can you Upload Files of a Job that is Not Shared yet with another location?

Sure you can. But no other location than yours will be able to see that job and those files until
you share it with that other location.

When the job does not exist yet on Esko Cloud, it will automatically be created.

Note:  As mentioned above, the customer of this local job needs to be linked first with its
counterpart on Esko Cloud.

20.1.5.  What is the Owner Location, Job Ownership?

The Owner Location of a job is the location that shared the job to Esko Cloud.

This location has the Ownership of that job.

Only this location can unshare it.

20.2.  The Importance of Standardisation between
Locations

Standardisation between Locations on Customer Names/IDs

In Esko Cloud, data is stored per customer.

It is crucial to avoid placing data of one customer in a folder of another customer. Therefore,
it is important that every local AE customer is linked to the correct customer in Esko Cloud. We
often refer to those as 'local customer' and 'cloud customer'.

1474



20Automation Engine

Note:  Esko Cloud is also able to share this data with the end customer, for example via the
tools in the product "Share & Approve". Obviously, it is then even more important to keep data
separate per customer.

That is why it is crucial that all your locations use the same name for a same customer (ID).

Note:  An example:

• On (one of) your Automation Engine servers, there is a local customer named 'Cola'. On
Esko Cloud, there are 2 cloud customers with more elaborate names like Best Cola and
Super Cola.

• It is crucial that the local customer 'Cola' is linked onto the correct cloud customer, so to
prevent Super Cola users seeing data from Best Cola and vice versa.

Managing this list of customers needs to happen on your company group level.

Standardisation between Locations on Folder Structure

It is also important that the different locations standardize on the structure of their Job folders
in Automation Engine.

The tool Smart Job Location and standardisation on where tickets write their output files can
help to achieve that.

Why is Customer Linking so Important?

Linking the customers from each local customer to the right customer on Esko Cloud will
mostly have to be done manually, by an operator. Esko software is reluctant to link local
customers automatically to cloud customers.

To share a job for collaboration with another site, the job must be assigned to a customer and
that customer must be linked to a counterpart in the cloud.

Only when the above is fulfilled, you can start uploading files into such a job or downloading
files from folders in Esko Cloud.

The correct linking of customers of course needs to assure that data from one customer does
not end up in the Esko Cloud folder of another customer.

When all up- or downloading of files happens in the Job context of the correctly linked
customer, then the risk of making mistakes is drastically reduced.

20.3.  Setup and initial Configuration

20.3.1.  Required Esko Products

Required Esko Products
• A license and an administrator user to set up an Esko Cloud site for your group.
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• 1 or more Automation Engine master servers, each connected to the internet.

To start collaboration, you need 2 or more Automation Engine master servers, each in a
different LAN, probably in a different location.

20.3.2.  Initial Configuration (v18.0.1)

Step 1 - Create your Site on Esko Cloud
First thing to do is to create your group's ('Share & Approve') site on Esko Cloud.

Note:  In most cases, an Esko support engineer will assist in setting this up.. The main steps
are described below. Learn more details in the documentation of the product 'Share & Approve'.

Note:  Each site on Esko Cloud is backed up by servers running Amazon Web Services.

Note:  In fact, several websites are made available and the choice of which one to use, might
depend on your group's geographical position. For example: https://approve.eu.demo.cloudi.city
for organizations with most locations in Europe, https://approve.as.demo.cloudi.city for
organizations with most locations in Asia.

Follow these steps:

1. In a standard web browser, use the administrative account of your group to log on to Esko
Cloud. That is where you can create and configure the site in the interface of 'Share &
Approve'.

As mentioned before, in this context of Automation Engine, we only use the interface of
Share & Approve to set up job collaboration between different locations. This means that
you need to:

2. Allow this site to connect with the Automation Engine servers in your group/company. Go to
Setup >  Automation Engine and check the box to allow connectivity:

 

 
3. Provide sufficient permissions to the group of Automation Engines for them to access the

Share & Approve site.

a. Go to Documents, click  to make sure you are in the root folder (top left). Then click
 (Share this space) and choose Manage Permissions (top right):
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b. Make sure the group of Automation Engines is invited and that this group has the right

permissions:
 

 

Note:  This group is the group of AE software servers, not their AE user accounts.

Step 2 - Create an Equipment entry for each Location

Concept - Summary

In the Share & Approve site that you created in previous step, you now need to create an
Equipment for each location.

Note:  On Esko Cloud, 'Equipment' can represent various things. In our context, they are not
(output) devices but software servers.

To gain access to Esko Cloud in an automated way, a token is needed to identify yourself.
The bearer of the token receives access. Once identified through that token, you get the
permissions of the user or machine or … that corresponds to the supplied token.

Learn below how to safely transfer that token to the Configuration panel of Automation
Engine.

Adding Equipment

1. Go to My Network >  Equipment' and click Add Equipment.
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2. In our context (AE servers using Esko Cloud to collaborate), only the fields Equipment Type

and Equipment Name are mandatory.

 

 

• Equipment Type: Select 'Automation Engine' from the list.

• Equipment Name: This is the name of the location of this AE server that all users will get
to see, including Automation Engine users.

Of all these fields, only the name of the equipment is important to the Automation
Engine server software.

Attention:  The name of an equipment is limited to 7 characters! That is because
this name is also used as a prefix to make local customer-IDs unique when they
are seen from another location.
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Attention:  You can not change this name later. So think wisely before deciding
them. Changing this name would mean removing the equipment first and
starting again with a new name, new token, etc. This is an unsupported workflow
change.

We strongly advise to not use the name of the computer on which the master
Automation Engine is running. A name like AeServer01 or vm-production-0012 is
quite meaningless to AE users in other locations.

Instead, we advise to use a name that refers to the location of that AE server, in a way
like IATA codes are used for airports. For example: Using 'BRU' for the equipment in
Brussels, or BRU01 and BRU02 when there would be multiple locations in that same city.

Note:  These names that are used to identify locations within the organization, will pop
up at several places in the user interface (Pilot). These names should make sense to the
users of AE.

Note:  Also, it is best to keep these names as simple as possible. Avoid special characters
in the name like /, space,*,?,# and similar.

• Location: Add a location name that is informational for users of this Esko Cloud site,
probably less cryptic than the equipment name. This field is not seen by Automation
Engine users.

• Code:

• Description: You could here mention the actual name of the AE server. Or any other info
that describes this location.

• Status: Indicates if this Esko Cloud site is currently connected to this Automation Engine.
3. Click Create. This also creates the token for that equipment:

4.
Click  to copy the token to your clipboard.

Attention:  Do not manually copy the characters of the token! This will not
be enough, The copy-to-clipboard button will copy more information than the
characters that are shown there.

Keep this copied data in your clipboard until you paste it in AE's Configure tool. See next
Step 3.

5. Example of a resulting list of Equipment:
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Step 3 - Bring the Token to AE's Configure tool

What does the Token do?

The Automation Engine stores the token and from then on uses it to gain access to Esko Cloud.

So when an Automation Engine tries to connect to Esko Cloud, it presents its token to the Esko
Cloud authentication mechanism (Okta).

The token is checked for validity and whether it corresponds to an equipment of type
'Automation Engine'. The Share & Approve site is set up in such a way that every equipment of
this type obtains the necessary permissions for file up- and downloading.

Conclusion: When Automation Engine presents its token, it gains access to Esko Cloud and
enables all functionality in Automation Engine related to this setup: Job (data) sharing, up- and
download of files inside a Job folder, sharing tickets.

How to Safely transfer the Token to the Automation Engine (Location) and
Use it

Safely transfer to the Automation Engine (location) it was generated for.

1. The responsible (administrator) for Esko Cloud connectivity within your organization, will
have a (power) user account that will allow him to log on interactively to Esko Cloud.

2. In that browser, he logs on to Esko Cloud and, in that UI of Share & Approve, navigates to
the page where he can create an 'equipment' for a specific AE location. He there generates
and 'captures' the corresponding token (using that 'copy' button).

3. The generated token is now automatically copied to his clipboard. Note that it is there is in a
readable format. This point is where our description in Step 2 ended.

4. To bring the token securely to the Automation Engine for which it is intended, the
Organization Administrator can open a remote control application (like 'TeamViewer') and
open a session to that Automation Engine server.
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5. He then asks the local AE administrator to start a Pilot and there open the Configure tool
(using his own local account and password). He goes to the item Esko Cloud and clicks Sign
In.

 

 
6. Now the Esko Cloud admin user can paste the token from his clipboard directly in the field

Token Details. This way, he makes sure the token was not exposed in clear text anywhere.

See this example right after the clipboard info was pasted:
 

 
7. Press Continue to see the resulting Esko Cloud connection:

 

1481



20 Automation Engine

 
8. He must then repeat this procedure for each location. As mentioned above, each

Automation Engine server requires its own token.

FAQ: How secure is the token stored?

Before the token is stored in the internal registry of that Automation Engine server computer
('CFS'), it is encrypted using a 'Certificate' (a private/public key pair).

This certificate is automatically generated at installation time and is stored in the 'Windows
Certificate Manager'.

To decrypt the token, you would need that same certificate that was used to encrypt it.
Because it is stored in the Windows Certificate Manager, it is pretty secure.

20.4.  Tools and Tasks

We here describe the tools and tasks that enable AE servers to collaborate via Esko Cloud.

In the chapter Workflow Examples, we show how they can be combined to automate this
workflow.

20.4.1.  On Customers

As mentioned in earlier sections, it is crucial that each local Automation Engine customer is
linked to the correct counterpart on Esko Cloud.

Starting to upload files or sharing jobs is simply not possible when the related customers are
not correctly linked yet.
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In the list of customers on your Automation Engine (i.e. your 'local customers'), the below
described tools become available when you select one or more customers or when you right-
click the empty canvas in that list.

Note:  Deleting a customer locally on or the cloud is always a manual action.

Note:  When you delete a customer on Esko Cloud, all jobs using this cloud customer will
automatically be unshared. And jobs that become unshared are automatically removed on the
locations that are not the owner location.

Link to Esko Cloud Customer...
Go to the view Customers. This shows all your local customers.

Notice the new column that shows an icon of a cloud. When it shows a cloud, it means that this
local customer has been linked to a customer on Esko Cloud.
 

 

• Select one, multiple or all customers, and click  (or right-click the selection and choose
Link to Esko Cloud Customer...).

• A panel appears where you are asked to manually decide with which cloud customer you
want to link. The local customer is shown on the left (icon of Automation Engine). On the
right, you see the cloud customer that most resembles this local one (icon of Esko Cloud).

Answer the question that is shown on top.
 

1483



20 Automation Engine

 

Note:  In this panel, apart from answering No or Yes, you can also click Next to skip this
customer and maybe make this decision later.

• When you answer No, another panel opens that shows more cloud customers that
resemble this one.
 

 

Note:  Click Show Criteria to see which criteria the system used to find similar customers.
Change them if that helps you find the one you are looking for.

In our example, the proposed customer YummyFruit is not the same company.

When none of the proposed ones matches or when this list is empty, click Create Esko
Cloud Customer.

• You are then asked to confirm:
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If this is what you want, click Create and Link.

• The system then checks the next customer and asks again if the customer on the right
matches the local one.
 

 
We compare them and we conclude that our local customer is the same as the one in the
cloud. We click Yes.

Attention:  Linking only creates a link. Linking does not change their own settings!

• The system links them and immediately shows us the next one of those we selected. In this
case, we see the icon in the middle that informs us that these 2 are already linked to each
other:
 

 

We still agree with this link. We click Yes.

• At any time, you can click previous to see the result of the previous comparisons. Or click
Next to postpone the decision for this customer.

• This next one was also already linked. It is also part of this comparison because it was part
of our selection when starting this tool.
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So we click Yes.

Note:  In this example, we can also click Done, which means we don't answer this last
question. But these two were already linked so that status will simply remain.

• The result: All our local customers are linked to some cloud customer.
 

 

Note:  In this Pilot view, you always see your local customers only. You do not see their

cloud counterparts. For a quick check, select all your customers, click  and go through
the pages of this wizard.

Note:  2 of them have a special ID that starts with BER001/C/. This is because they were
originally imported from Esko Cloud ; they were not first created locally. Learn more about
this naming structure in Import from Esko Cloud... on page 1487.

Note:  (05-Oct-2018) There is no functionality (yet) to remove a link. You can only re-link or skip
it.

Download Changes from Esko Cloud
This tool makes the selected local customer identical to the one it is linked with on Esko Cloud.

This changes the settings of your local customer.
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Attention:  There is no merging of information! Also fields that are empty in the cloud
will then become empty locally.

Upload Changes to Esko Cloud
This tool makes the customer on Esko Cloud identical to the selected local customer it is linked
with.

This changes the settings of your customer on Esko Cloud.

Attention:  There is no merging of information! Also fields that are empty locally will
then also become empty in the cloud.

Import from Esko Cloud...
• In the Customers view of the Pilot, click on  or right-click anywhere in the list of

customers and choose Import from Esko Cloud... to open the dialog where you can import
a customer from Esko Cloud.

Note:  This tool is also offered when you first selected local customers and then right-click.
Your selection will be ignored in that case.

 

 
The dialog shows the list of all Esko Cloud customers of your organisation.

Note:  The ID of a Esko Cloud customers is constructed as <location>/C/<local-id> :

• It starts with the name of the location from where it was first uploaded.
• Then followed by "/C". This refers to the fact that, on Esko Cloud, this is a "partner" of the

type "Customer".
• And then the actual ID of that customer (in above example we also added some part of

the name after the usual numbers in the ID).

• Select the one you want to import as local customer and click Import.
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Note:  When it was already imported, you will get a warning. You can not import it again
(unless you delete the local customer first).

• A dialog appears showing you all the fields of the selected customer. We advise to click
Import without making any changes here.
 

 

Caution:  If you change the ID in this panel, for example by removing the initial part
'BER001/C/', you then risk creating a double or conflicting customer name. Maybe
not today, but for example when your MIS later also creates such a local customer
with (accidentally) that same name.

• The customer now also appears in the list of local customers. And the  icon shows that it
is linked with the one you selected in the cloud.
 

 

Note:  In above picture, notice how the customer 'Cookies' is the only one that is not linked
to one on Esko Cloud.
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Import All Esko Cloud Customers
In the view 'Customers'. right-click anywhere in the list and select Import All Esko Cloud
Customers.

For each cloud customer that is not yet linked to a local customer, a local customer is created
and linked to that corresponding cloud customer.

You will be asked to confirm.

This tool launches the task "Download Customers from Esko Cloud". See the task's Details
pane for more information on what it did.

This task has no options.

Note:  This tool is typically useful in the beginning, when Esko Cloud is being set up in your
organization, or when you set up a new location.

Upload All Local Customers
In the view 'Customers'. right-click anywhere in the list and select Upload All Local
Customers.

You will be asked to confirm.

For each local customer that is not yet linked to a cloud customer, a customer is created on
Esko Cloud. And these two are then linked.

This tool launches the task "Upload Customers to Esko Cloud". See the task's Details pane
for more information on what it did.

This task has no options.

20.4.2.  On Files in Jobs

Upload Files to Esko Cloud Job Folder
This task uploads the selected file(s) to the matching job folder on Esko Cloud.

The input files need to be in an active (blue) Job.

When this Job does not exist yet on Esko Cloud, it will be created.

The files are placed in a folder matching the folder structure of the local job folder.

When same files are already in that same folder, they will be overwritten.

On Esko Cloud, a file's (modification) date is its time of arrival on Esko Cloud.

Special characters in names of files are supported.

This task has no options.
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About Task Status

• The task ends in success if all files were uploaded successfully.
• The task ends in warning if at least one file uploaded successfully and at least one could not

be uploaded.
• The task ends in error if no file was uploaded successfully.

The Details pane shows the path on Esko Cloud where the files arrive.

Download Files from Esko Cloud

The tool 'Download to Job Folder' in the View "Esko Cloud"

This launches the task on the files you selected in the view Esko Cloud to the local job folder.

The files on Esko Cloud are not removed.

Local same files will be overwritten.

The Task "Download Files from Esko Cloud"

• Task Options:

• Delete files from Esko Cloud after downloading: Select this to also delete the files on
Esko Cloud that were successfully downloaded.

• This task is by default used in the Esko Cloud Access Point. You can there define an extra
workflow to launch on the files once they arrived locally.

Select Files on Esko Cloud Job Folder

Concept
This task selects files that are on an Esko Cloud job folder, or the folder itself.

This task is typically used in a workflow ticket, where the selected files serve as input for next
steps like a Download from Job Cloud Folder task or the Start Approval Cycle on Share & Approve
task.

Note:  The output file of this is a temporary .json file that contains a list of references to the
files in the Job cloud folder.

Settings

• Names:

Learn more in the pages about Using Regular Expressions on page 656, JSONPath Expressions
on page 755, or SmartNames on page 591.

Note:  When using SmartNames, the resolved values should not already be encoded (to
avoid double encoding).

• Path: The task will search for the files with the here above defined names in this folder.

• Include subfolders
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20.4.3.  On Jobs

Sharing Jobs

Concept

Note:  This was introduced in What is Uploading? What is Sharing? on page 1473.

Sharing an Automation Engine Job to Esko Cloud creates that Job on Esko Cloud. You can go a
step further by also inviting other locations in your group to collaborate on this job.

Important:  Sharing a job does not upload files. It creates the job on Esko Cloud: the folder
and the job's metadata (inks, barcodes, etc.).

You can choose to:

• Share it with one or multiple locations in your group (those that were defined for your
group on Esko Cloud).

• Share it with no one, i.e. without defining any locations. Also then the job is created on Esko
Cloud, but only you, the location that shared it, can see it. You could for example choose
this to first collect all the job's data on the cloud, and only once you uploaded the right files,
only then share it with that other location.

Important:  Only jobs of which the customer was linked to a cloud customer can be shared to
Esko Cloud.

The Tool 'Sharing...'

The 'Sharing' tool

When you right-click the name of an open Job, or one or multiple jobs in the Jobs Overview,
choose Sharing... to share or unshare them.

We will illustrate the possibilities through some examples:

The 'Sharing' tool when you Selected One Jobs

The Sharing dialog opens:

• When the setting 'Share on Esko Cloud' is not selected, this means that this job is currently
not shared:
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Important:  This is also the setting to unshare a job: When you click OK when Share on
Esko Cloud is not selected, you are confirming that this is what you want: The job is (no
longer) shared.

• When 'Share on Esko Cloud' is selected, the field 'Share With' is enabled where you can
define who you want to share this job with.
 

 

• If you leave this field empty and click OK, you are only sharing this job on Esko Cloud and
only you as 'Owner Location' will be able to see it and have access to it.

• If you type in one or multiple names of locations (or pick them from the list that
appears), then the Pilot users in those locations will see this job on Esko Cloud and have
access to it.
 

 

Click OK to confirm.

The 'Sharing' tool when you Selected Multiple Jobs

In the Jobs Overview, select multiple jobs, right-click and choose Sharing.... The dialog now
shows the sharing attributes that these jobs have in common.

Some examples:
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• When your selection contains a mix of jobs that are shared and not shared, the Share on
Esko Cloud setting will be set to '-':
 

 

Change any setting and click OK to define a common behavior for all selected jobs.

Change nothing and click OK or click Cancel to not make any changes.
• In this example, all selected jobs are shared on Esko Cloud and there with 'MEX001' (and no

other location):

 

 
• When the selected jobs are all shared, but not all of them are shared to MEX001, then the

name of that location is shown in a gray color:
 

 
• This example shows 3 jobs with different settings in their column Shared With:

 

 
When we select all 3 of them and choose Sharing, this is what the dialog shows:
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This means that:

• some of these jobs are shared on Esko Cloud, but not all (the '-' setting),
• TOK001 is shown but in gray, so at least one job is shared to TOK001, but not all,

• MEX001 is shown but in gray, so at least one job is shared to MEX001, but not all.

• We use the same jobs but now we only select the '2017' and the '2018' job:
 

 
No the Sharing dialog shows this:
 

 
This means that:

• All job in our selection are shared on Esko Cloud ('v').

• TOK001 is shown in gray, so at least one job is shared to TOK001, but not all.

• MEX001 is shown but in black, so all jobs in our selection are shared to MEX001.

The Share Job task

This task is only available as a step in a workflow. When you want to share a job that you have
selected in the Pilot, this task type will not be offered. In that case, use the interactive tool
'Sharing...'.
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• Replace existing locations: When not selected, the changes you make in this task will be
added to the current way that job is shared. When selected, and when for example the field
Add Locations is left empty, the job will be unshared from all locations.

• Remove Locations: Click on the list icon or use a SmartName.

Note:  This field is case-sensitive. When defining multiple, it should contain a comma
separated list of location names.

• Add Locations: Click on the list icon or use a SmartName. When defining multiple locations,
it should contain a comma separated list of their names.

Note:  This field is case-sensitive. When defining multiple, it should contain a comma
separated list of location names.

Note:  You can still share with a location that shows a red status when checking the Network
(Server Admin Web Page > Server Checks ). Once that location becomes available again to
Esko Cloud, the sharing will be done.

Note:  The task first executes the Remove Locations, and afterwards the Add Locations.

The Unshare Job task

This task unshares the job or jobs that were selected or, in a workflow, that were specified as
input files.

The job will be removed from Esko Cloud, including the files it stored there.

This task has no options.

Synchronize Job - All Jobs
This function is available when you select a Job that was already shared on Esko Cloud. It
synchronizes all fields of the Job setup of this Job. For example: a change in the list of inks or
barcodes.

Normally, all changes in a job setup between the local and the cloud job (aka 'events') are
automatically exchanged.

However, this automatic synchronization between AE servers and Esko Cloud will (temporarily)
fail:

• When your Automation Engine server is unavailable (due to a software update, computer
reboot, etc.).

• In this case, the Automation Engine software will also repair this automatically: As soon
as the Automation Engine software re-starts, the server automatically launches a task
that does this synchronization and so makes up for any lost 'events'. There is an upload-
and a download version of this synchronization task.

• When there is no internet access for a while. This could be your own link to Esko Cloud or
it could be another location that lost its connection. During that network problem, this of
course prevents that location to send or pick up any changes in jobs on Esko Cloud.

• This is the case where you use the 'Synchronize Job' tools. You can either right-click a job
and choose Synchronize Job. Or you select Synchronize All Jobs from the menu Job.
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The Synchronize with Esko Cloud (Upload) task

When your Automation Engine server restores its connection to the internet, this task will
make sure that the changes you made locally are uploaded to Esko Cloud.

This task is started automatically by Automation Engine.

You can also trigger it yourself by using the Synchronize tools in the Job menu. Learn more in
Synchronize Job - All Jobs on page 1495.

Note:  When you open this task after it has been started, you will see task options. These
are only there for the use by Esko support staff. This enables them to test the effect of these
options in case something went wrong.

The Synchronize with Esko Cloud (Download) task

When your Automation Engine server restores its connection to the internet, this task will re-
download all Esko Cloud jobs on which your location is collaborating, to make sure you have
the latest job info, parameters and inks.

This task is started automatically by Automation Engine.

You can also trigger it yourself by using the Synchronize tools in the Job menu. Learn more in
Synchronize Job - All Jobs on page 1495.

Note:  When you open this task after it has been started, you will see task options. These
are only there for the use by Esko support staff. This enables them to test the effect of these
options in case something went wrong.

Pilot View 'Shared Files'

A new Pilot View mode to see a Job's Shared Files on Esko Cloud
In the 'Last used Job' mode of the Pilot (when you opened a Job), the extra view 'Shared Files'
becomes available in the category 'General'.
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This view shows this job's folder on Esko Cloud and the files it contains. These files can be put
there by all who have access to this job on Esko Cloud.

Tools in this View

Right-click a folder or a file to choose from these functions:

• Show in Job Folder: This takes you to the Files view of the local job folder and there selects
the local version of the file you selected on Esko Cloud.

• Download to Job Folder: This downloads the folder or file(s) to the local job folder, in a
same subfolder. It overwrites files with a same name.

• Delete: This removes the selected folder or file(s) from Esko Cloud.

Note:  If you want to remove the whole job from Esko Cloud, then use the Sharing... panel.
There, de-select the option Share on Esko Cloud and click OK. This will not only unshare it
but also remove the job and its files from Esko Cloud.

Smart Views on Sharing Status of Jobs
In the Job Overview, any job you can see there is a local job, a job on this AE server, on this
location.

Important:  This view does not show any jobs that are on Esko Cloud. It shows local jobs of
which some could have been created because they came in from Esko Cloud.

The Jobs overview offers extra columns that provide such information:

• Cloud Status: A cloud icon means that this local job was shared to Esko Cloud.
• Owner Location: Where this shared job originates.
• Shared By: The user in the remote location that shared this job.
• Shared With: With which locations this job was shared with.

See this example of the Jobs in the location BER001.

These are all the (live) jobs on the Automation Engine server in BER001:
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Smart Views offered when using Esko Cloud

You automatically get a few Smart Views that help filtering jobs in relation to Esko Cloud.

Note:  These extra views only appear after you have set up an Esko Cloud configuration in the
Configure tool and after a restart of the Pilot.

Double click the name of a Smart View to see how its filter is built up:

• Not Shared:

These are our jobs that are not shared on Esko Cloud.
 

 

• Shared:

These are all the jobs that our location has access to on Esko Cloud.

See how the filter uses 'None' to get a reverse effect:
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These jobs job are either:

• our own jobs that we shared on Esko Cloud (4 from BER001),
• or jobs that were shared to us. We were invited to see them, which then automatically

created this local version of that job (1 was shared to us by MEX001).

• Shared by My Location:

These are all the jobs that our location has shared on Esko Cloud.
 

 

• Shared by Other Locations:

These are all the jobs that were shared to us by another location.
 

 

Note:  If you don't want to use or see these Smart Views, just de-select them in Manage Job
Filters from the Job menu.

Smart Views on Cloud related Tasks
The first time a Pilot open after adding an Esko Cloud site in the Configure tool, some extra
Smart Views will be added that help you filtering cloud related tasks.

• The Smart View CloudJob-Import-failures shows the Create Job tasks that, after an
invitation to collaborate on a cloud job, failed to create a local job.

• The other Smart Views are about Tickets. Learn more in Smart Views on Cloud Tickets on page
1502.

If you don't want these Smart Views, just de-select them in Define Task Filters in the Task
menu.
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20.4.4.  On (Workflow) Tickets

Concept
You can submit (workflow) tickets to Esko Cloud. Only global (yellow) tickets, not (blue) Job
tickets.

The main use case is to make them available to other locations, to streamline ways of working.

By uploading these tickets to Esko Cloud, workflow administrators (in headquarters?) can
so make a catalogue of interesting workflow tickets available for all locations within the
organization.

A ticket on Esko Cloud also contains all its dependencies, like SmartNames, template files, etc.

Tickets on Esko Cloud are not related to any customer of job. They are there to be seen and
picked up by any other of your locations (not specific ones).

Mind that all steps are manual, i.e. there is no automatic synchronisation of versions of tickets.
This is because updating tickets on another location while they could be in use is not secure at
all.

However, the system does automatically keep track of any changes and show this with an icon
(see below). But it will not make any decisions itself.

You decide which tickets you want to submit to Esko Cloud and when. The receiving locations
decide when and what they want get.

There are no tasks doing this, only manual tools.

There is no record of history nor versioning of tickets.

The 'Cloud Status' in the Tickets View

The Tickets view in the Pilot is where you see the 'Cloud Status' of a ticket. This is the status
related to its counterpart on Esko Cloud.

This 'Cloud Status' is now also a category you can search or filter on.

Select the columns Cloud Status and Owner Location.

These are the possible states that a ticket can have:

•  Unlinked: This ticket is not on Esko Cloud. . In this filter, select this icon to see unlinked
tickets.

Note:  In their cloud status column, unlinked tickets do not show this icon but show no icon
at all.

•  Synced: The ticket on Esko Cloud is in sync with this local ticket.
•  Updated: Your location updated the ticket which is now newer than the one on Esko

Cloud. You need to consider submitting this newer version to Esko Cloud.
•  Outdated: Your local ticket is outdated. Another location updated the ticket on Esko

Cloud.
•  Needs Linking: In this case there are 2 problems:

• The ticket on Esko Cloud shows changes that are not present in the local one
• And there are changes in the local ticket that are not present in the one on Esko Cloud.
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There is no easy way to solve this. The only option would be to save a copy of your ticket
locally, then download the latest version from the cloud and then apply your changes again
to that latest version.

•  Removed: This ticket has been on Esko Cloud but is now no longer there. It has been
removed.

Important:  Only direct changes to the ticket are seen as modifications that will change the
cloud status to 'Updated'. Changes to a SmartName or to a referred ticket will not have an
impact on the cloud status of the main (workflow) ticket.

Importance of Time Synchronisation

Attention:  To know if a ticket is outdated or in sync, Automation Engine compares
modification dates. For this to work , the clock in the Automation Engine server should
differ no more than 20 seconds from the clock on Esko Cloud.

Submit to Esko Cloud...
Select one or multiple tickets, of any type.

The system 'ZIP's the ticket together with all its dependencies and then uploads this set to Esko
Cloud.

At each submit of a new "version", a change-log can be attached. This information is available
as a column in the dialog Import Ticket from Esko Cloud.

Get Latest Revision from Esko Cloud
To update a local ticket with the latest version of the cloud ticket, go to the Tickets view, make
a selection, right-click and choose the entry Get Latest Revision from Esko Cloud.

Import Ticket from Esko Cloud...
From the Tickets menu, select Import Ticket from Esko Cloud... to import a ticket from Esko
Cloud.

In case this import action would overwrite a local resource (a ticket, a referenced file, a
SmartName...), then you will be shown some details and asked to confirm.

Remove from Esko Cloud
In the Tickets view, select one or more tickets, right-click and choose Remove from Esko
Cloud.

You will be asked to confirm.

Only the Owner Location can remove a ticket from Esko Cloud. This is the location that
submitted it to Esko Cloud.
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At any other location where this ticket had already been downloaded, the ticket is kept as a
local ticket. The cloud status of the local ticket will change to  Removed.

Smart Views on Cloud Tickets

Some Examples
Some examples of how you can filter your local tickets based on their cloud status:

• Your local tickets that this location ('BER001') has submitted to Esko Cloud:
 

 

• Your local tickets that have a counterpart on Esko Cloud:
 

 

• Your local tickets that were downloaded from Esko Cloud, but who are out-of-sync because
their cloud version was updated:
 

 

• Your local tickets that were downloaded from Esko Cloud, but who are out-of-sync because
their local version was updated:
 

 

Smart Views offered at installation

Just like with Jobs, you are presented a few example Smart Views.

• The Smart View CloudJob-Import-failures shows the Create Job tasks that, after an
invitation to collaborate on a cloud job, failed to create a local job.

• The Smart View CloudTickets-All shows ...

• The Smart View CloudTickets-inSync shows ...

• The Smart View CloudTickets-locallyAdapted shows ...

• The Smart View CloudTickets-OutOfSync shows ...

Double click them to see how they are constructed.
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20.4.5.  Esko Cloud Access Point

Concept

On this page, we assume you already understand the main principles of Access Points as
described in the chapter Integrating with External Systems. Here's a direct link.

The most typical aspect of an Esko Cloud access point, and its main difference with the other
types of access points, is that the folder that will be scanned is not one specific folder but each
folder with that name in every job on Esko Cloud.

Setting up an Esko Cloud Access Point

Note:  We advise that you first establish the link between your Automation Engine and your
Esko Cloud site. Do this in the Configure tool.

Follow these steps to set up an Esko Cloud access point:

• In the Pilot, go to the view Access Points (part of the category 'Setup').
• In the toolbar, click  to create a new access point.
• In the dialog, choose the type "Esko Cloud" and click OK.
• Add a logic and clear Name. Optionally, add a Description of what this access point will do.
• In the tab Esko Cloud Settings:

• Account: This is the name of your configuration. When you still need to create one or
just see its details, click Configure.

• Folder: This is the name of the folder that will be monitored in every Esko Cloud job
folder that is accessible to this location. An example:
 

 

Attention:  The name of this folder is case sensitive.

Note:  There is no need to start this field with a "/" .
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Note:  When the folder is a subfolder of another one, use a "/" in between. For example:
Outsource/3D work .

• In the tab Automatic Actions:

• Move Files To: The files that are found in such a folder are moved to the corresponding
local job folder (which was created automatically).

• Action:

• None. Choose this option when you only want to use this Access Point to move the
files.

• Workflow. Choose this option when you want a workflow to start. Select the
workflow ticket from the offered list. The new accessed files will be used as input files
for this workflow. If these files are inside a Job Folder, the workflow will be run in the
context of that Job.

Attention:  Make sure your workflow can start with the type of files that will
arrive.

Options:

• Operator: Choose the operator that will be shown as operator for the workflow
task.

Tip:  If you do not want to assign one specific person, you could create an operator
named "Access Points" or "Automatic" and assign that one here. Also remember
that the Access Points Task Monitor shows you the tasks launched by the selected
Access Point.

Note:  If you leave this option blank, a system user "UPLC" will be used.

• Priority: Choose the priority for this workflow: Low, Normal or High. The default
priority is 'Normal'.

Folders which are named after one of your Esko Cloud locations

An Esko Cloud access point will not download files from a folder name that is the name of a
location, except when it is the name of its own location. In other words: It will consider and
download all files, except in subfolders named after other locations.

This setup enables an easy way of distributing files over several locations.

An example:

This local job folder has a sub folder 'External Work' that is being scanned by an access point
in each of 3 other locations, named 'MEX001', 'SYD001' and 'TOK001'.
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• The access point at each other location will download the 2 *.doc files in the folder
'External Work'.

• The location 'MEX001'

• will not download anything from the folders 'SYD001' or 'TOK001'

• but will download anything else in 'External Work', which in this case is all the files in
the folder 'MEX001': the 2 PDFs and the A3D file.

• The location 'SYD001'

• will not download anything from the folders 'MEX001' or 'TOK001'

• but will download anything else in 'External Work', which in this case is all the files in
the folder 'SYD001'.

• The location 'TOK001'

• will not download anything from the folders 'MEX001' or 'SYD001'

• but will download anything else in 'External Work', which in this case is all the files in
the folder 'TOK001'.

20.4.6.  Esko Cloud related SmartNames

This workflow introduces these new SmartNames:

• Esko Cloud Location: This is the name in the Esko Cloud configuration for this location with
Automation Engine.

• Job Owner Location: The location that has ownership of the job. In case it was shared, then
this is the location where the job was first shared to Esko Cloud.

20.5.  FAQs on Technical Setup

Which AE user executes these AE tasks?

Any AE user that uploads a file or shares a job to Esko Cloud will trigger a task run on behalf of
that user.

The Synchronize with Esko Cloud tasks however start automatically and are launched by a user
(aka 'operator') named auto@<name-of-location> .

All access to Esko Cloud is done through the use of the token. The Esko Cloud site so also get
confirmation on which 'equipment' is connecting to it.

Which communication lines are needed to enable collaboration between
Automation Engines in different locations?

In each location, the (master) Automation Engine server (AE 18.0.1 or higher) needs to be
connected to the internet.

With the necessary authorization and permissions, this allows one location to put data in a
particular place on Esko Cloud and another location to retrieve the data from that place in the

1505



20 Automation Engine

cloud. The communication between these locations always passes over Esko Cloud. In other
words, it is never peer-to-peer. So, per location, 1 line to the internet is sufficient.

For security reasons, all communication happens over HTTPS.

Can one group or organization have multiple 'Sites' on Esko Cloud?

Yes, this is possible. You might for instance still want to split all data from pharmaceutical jobs
away from any other data.

What to do when my Automation Engine server is moved to new hardware?

Esko advises to, create a new equipment entry on Esko Cloud for that new hardware.

What do I Need to have Access to Esko Cloud?

Per organization (a group that owns the several locations with an AE server), 1 administrative
account is needed, being a user and password (Okta). With this account, the data structures for
the organization can be set up in Esko Cloud. These data structures can also be referred to as
the 'Share & Approve' site for this organization.

Why should I ask my IT department to make sure Time Synchronization is set
up on my Automation Engine?

Time information is stored locally in each location and also when data is put in Esko Cloud.
To verify whether certain information is in sync, the time information (coming from different
sources) is compared. To avoid problems with this time comparison, you need to make sure
that the time as reported by your Automation Engine server is quite accurate (i.e.: being the
same as respected official Time Servers).

When Cloud Jobs are automatically Created Locally, Where are they Created?

When your location is invited to collaborate on a job, a local job is created automatically on
your Automation Engine (somewhere in an AE 'Container').

This is possible by making sure that the Create Job task uses the tool Smart Job Location to
determine the local folder for this job.

Important:  In this context, where Automation Engine servers exchange Jobs, the setup of this
Smart Job Location in very important.

Note:  The Create Job tasks that ended successfully are automatically removed from the Tasks
view or panel.

Learn all about this tool in Smart Job Location on page 195.

An example: You could set up rules that organize job folders on a specific Container, in
alphabetical groups of customers, and per year. In the Smart Job Location tool, in the tab
Rules, click  Add, and specify this:

• Condition

• If Job Field: (SmartName) <Job Customer name>
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• Matches: (?i)[a-e].* (click 'Edit' to get help creating this regular expression)

• and add additional rules for [f-k] and so on...

• Then use as Job folder:

• Container: Select the one where you want these Job data from Esko Cloud.

• Folder: <Job Customer Name for path> /a-e/jobs/2019/<Order Id for path> .

• These <...for path> SmartNames are based on the standard SmartName with the
same name but these have an extra formatting that replaces each '/' by a '-'. This way,
the folder names are supported by Windows.

Note:  Learn how to do this in SmartNames >  String Extract >  Formatting Options > 
Text >  Custom Encoding >  Edit.

20.6.  FAQs and Tips on Customer Consolidation

How do I best Start Organizing these Customers?

In the beginning, when an Esko Cloud site is available and configured for your organization,
there will be no cloud customers yet.

Note:  On Esko Cloud, customers are called Partners.

1. Your first step is to start uploading all the customers from 1 specific Automation Engine
location to Esko Cloud, maybe from the one in your group's headquarter. This will also
create a link between each local customer and its cloud version. This tool is named Upload
All Local Customers.

As soon as such a customer is linked, you can start sharing jobs and uploading some of
their files to Esko Cloud..

So yes, in that first (headquarters?) location, all local customers can be uploaded in 1 go.

2. For each other AE location in the group, the situation is different:

You can only start uploading files or sharing jobs once this customer link exists.

When uploading a job (sharing) for a customer that is not yet linked to a cloud customer,
you must verify whether the customer already exists in the cloud.

• If so, you must manually link that local customer to that cloud customer.
• If not so, then you must first manually create a cloud customer of that local customer

and then link these 2.

How can I see if a local customer is linked to a cloud customer?

When you view the list of customers in the Pilot, make sure to add the column 'Esko Cloud
Status' to the list of visible columns (Views >  Columns).

The cloud icon indicates if that customer is linked to one on Esko Cloud.
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Some info fields of a customer differ between the several locations. What
should I do?

Standardize! At least make some efforts on the path of standardization, in working in the same
way in all locations.

Note:  A customer's name, ID and many other attributes typically originate in a business
system. Standardizing on one business system for the whole organisation will of course help to
avoid that different locations have same customers with (slightly) different names or settings.

This setup does not support actual 'mappings' of customers port mappings (for 'n' locations
within an organization, that would mean we need to defining  (n * (n - 1)) / 2 
mappings).

Is there any Automatic Synchronisation of Customer Information?

No.

This is because we don't know which system has the latest and correct customer specification.
This could be the business system. But what if locations use different business systems? It
could be the local one on Automation Engine. It could be the one on Esko Cloud.

Therefor, there is no automatic synchronization of customer information.

However, an AE user can always manually sync information of local customers with their cloud
counterparts, or vice versa.

To upload a local customer's info to Esko Cloud, choose the task or tool Upload Changes to Esko
Cloud on page 1487.

To download info from a Esko Cloud customer to the local customer, choose the tool Download
Changes from Esko Cloud on page 1486.

What happens if a 2nd (etc..) location also decides to Upload All Local
Customers ?

Upload All Local Customers will, for each local customer, try to create a cloud customer. It tries
this without already trying to automatically link a local customer to a cloud customer.

• Success: If such an attempt succeeds for a local customer, then there is a new cloud
customer.

• However, it's possible that this customer now has 2 representations in the cloud: one that
was made by the first location ("headquarter") and one that was made by this 2nd location.

Here's the problem: When you now want to share a job from this customer, it's possible that
you must share 2 jobs: one based on the name given by the headquarter location and one
based on the name given by this 2nd location.

Of course, the above scenario can occur for every location that decides to click on Upload
All Local Customers. This can so end up in the worst case where you have as many
representations for 1 customer as there are locations...

• Fail: If the attempt to create a cloud customer from the information of a local customer
fails, then this most likely means that there is already a cloud customer with information
that is too similar. You now have to decide yourself, manually, what to do in this case.

You then use the tool that shows both their information side by side, and based on that you
decide to link them or not (example).
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Our group installs a new AE. Should l First Import All Cloud Customers?

When a new (master) Automation Engine is installed in some location, it will not have any local
customers yet. Here are some guidelines in the event that the new AE also needs to be linked
to Esko Cloud:

• As an alternative to building that list of local customers based on those in your local
business system, you could choose to Import All Cloud Customers. For every cloud
customer, this tool creates a local customer and also links them.

So yes, on a brand new Automation Engine, you could choose to import all cloud customers.

• However, when you download a job from Esko Cloud (you accept a job invitation), then the
system checks if there is already a local customer that links to the customer of the job.

• When yes, then of course that local customer is used as customer for the imported job.

• When not, a new local customer is created on Automation Engine and a link is made
between these 2 customers.

Important:  This means that there is a kind of auto-import of cloud customers (= creating local
customers) when jobs are shared with your location.

This also illustrates the risk that a customer can get 2 representations on your local
Automation Engine: one possibly made by your business system and one made by accepting a
shared job to collaborate with another location.

However, there is still no real harm done. To avoid the above situation, you must do the
manual effort to iterate over all the local customers to establish a link with a cloud counterpart.

20.7.  FAQs on Collaboration Workflow

Where can I see which other locations in my organization are also connected
to Esko Cloud?

With a web-browser, go to the AE Server web page and choose Server Checks > Network.

In the section Esko Cloud locations, you get a list of the other locations in your organization
and an indication whether these are actively connected to Esko Cloud.

Also, when you share a job with another location, you see a list of the other configured
locations, so one can choose who to share with.

How can I make files available to other locations?

When a location shares a job, a node is created in the data structures on Esko Cloud. The node
contains meta-data about the job (parameters/inks/barcodes) but it also provides for storing
files on Esko Cloud.

You can see which files of a job were uploaded to Esko Cloud right in the Pilot. Open the Job
and choose the dedicated view "Shared Files".

To upload a file into the Cloud Folder of the Job, open a job, select local file(s) and launch the
task Upload Files to Esko Cloud. This task can also be part of a workflow ticket.
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On Esko Cloud, the uploaded files are automatically placed in a folder with same name, in its
same structure as the local job folder.

For example: To upload a file to the cloud in a subfolder Needs-Image-Retouching, you must
first move the file locally into the folder Needs-Image-Retouching and then upload the file
to Esko Cloud.

Important:  It is very important to standardize on the folder structure within jobs. Eventually,
all locations that collaborate on a job will see the Cloud Folder of the Job. And as a result
of uploading (and downloading) files to (and from) Esko Cloud, many of the subfolders in
the cloud will be automatically created mirror versions of the job's subfolders in the various
locations.

How can I download files from Esko Cloud?

When opening a job in the Pilot, the Shared Files view shows all files that were uploaded for
that job. In that view, you can select files, right-click and choose Download to Job Folder. They
will be copied to the local job, in a same subfolder.

Attention:  Also in this case, it is very important to standardize on a job's folder
structure in all locations of the organization.

You can also download files from Esko Cloud by using the task Download Files from Esko Cloud.
Add this task in a workflow and you can immediately start processing these files.

How can I see which jobs other locations shared to us?

Learn about extra columns in the Jobs overview and about Smart Views on Sharing Status of Jobs
on page 1497.

How do I know about failures in creating jobs triggered by an invitation from
another location?

As mentioned above, when another location invites your location to collaborate on a job, a
corresponding local job will be created on your Automation Engine.

This job is created by the Create Job task. This task can fail, probably related to linking the
customer.

• To easily see which of these job creations went wrong, set these filters in your Tasks view:
set the Task Type to Create Job, the Source Type on Esko Cloud and the State to Failed.

• Smart Views in Tasks view:

The first time a Pilot connects to Esko Cloud, some extra Smart Views will be added that
help you filtering cloud related tasks. If you don't want these Smart Views, just de-select
them in Define Task Filters in the Task menu.

For example: The Smart View CloudJob-Import-failures shows the Create Job tasks that,
after an invitation to collaborate on a cloud job, failed to create a local job.

• An extra tool that can help in this case is to create and use a dedicated Create Job ticket
that launches an extra workflow in case the Create Job task fails. This workflow could for
example create a To Do item. This will ask the attention of some user to check what is
wrong here.
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How can I see which jobs we share with other locations?

First enable these extra columns in the Jobs view: Cloud Status, owner location, Shared By,
Shared With.

To see which jobs your location shares with other locations for collaboration, set these filters in
the Jobs Overview:

• owner location should be set to your own location

• and the Shared With field should not be empty.

The first time a Pilot connects to Esko Cloud, some extra Smart Views will be created that help
you filtering cloud related jobs. If you don't want these Smart Views, just de-select them in
Manage Job Filters in the Job menu.

The Smart View CloudJobs-MineShared shows you the jobs your location is sharing with
others.

The job's attribute 'categories' are different between the several locations.
What should I do?

Also here, the only answer is to work towards standardisation.

Is Job information automatically synchronized?

Yes.

• The location that shares a job with another location in the organization, is known as the
owner location of the job.

• When a local job is shared, the job's folders and its whole Setup is pushed by the owner
location into Esko Cloud: job parameters, job inks, job barcodes, job preview.

• Any other location that is invited to the job (shared with), creates a local job by downloading
all this job information from Esko Cloud to become a local job.

• Uploading a job setup to Esko Cloud ('sharing') can only done by the owner location.
• Downloading the setup of a job on Esko Cloud onto the local job can done by all locations

that were invited to collaborate on the job.
• When, in the owner location, the job is being changed (parameters / inks / barcodes /

preview), then

• these changes will immediately be updated on Esko Cloud.
• and from there they will also automatically be downloaded (synchronized) to the

locations that collaborate on that job (where the job was shared to).

• Attention:  When a location that is not the owner location does modifications
to the local job, these modifications will remain local ; they are not propagated/
synchronized to Esko Cloud.

Note:  In the setup where AE locations collaborate, it is not the intention that the invited
locations do modifications to the job information. The invited locations should deliver
results by uploading result files into some subfolder of the Esko Cloud Job Folder.

Can files automatically be downloaded from Esko Cloud?
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Yes, by using an Access Point of the type Esko Cloud.

This tool allows to monitor a specific subfolder within each job to which your location was
invited to collaborate.

When it detects a file in such a subfolder, the access point will get triggered:

• It will download the file from Esko Cloud to a folder with same name in the local job. Then,
the file is removed from Esko Cloud.

• Typically, a workflow is launched on that downloaded file. This workflow will run in the
correct job context (this means it can use job information and job specific SmartNames).

Learn more in Esko Cloud Access Point on page 1503.

Are the folders in my job automatically synchronized?

No.

However, Automation Engine offers the tools to automate this if you want:

• Files can be uploaded into subfolders of a job's cloud folder via local workflows. This gives
you full control on when to upload which files.

• Files can be downloaded automatically from Esko Cloud into the correct local job by setting
up an Esko Cloud Access Point.

What happens when my Automation Engine was offline for a while?

An Automation Engine server can get disconnected from Esko Cloud for several reasons: The
internet connection was lost, the server was down to install upgrades or hotfixes or to do some
maintenance to its hardware (additional disk space, ...).

This location could therefore have missed some events about job invitations or file uploads in
subfolders that are monitored by an Esko Cloud Access Point.

To catch up on these events, Automation Engine automatically runs a task each time its
software starts up: the Synchronize with Esko Cloud (Download) task.This task appears in the
Pilot's Tasks View after each start-up.

When the task ran successfully, the result should be that, regarding Esko Cloud, nothing seems
to be missing (invitations and uploads are in back in sync)

How do I share resources, like DGC curves, CMS information?

This is not yet possible in this version of Automation Engine.

How do I share Products?

This is not yet possible in this version of Automation Engine.

20.8.  FAQs on Tickets on Esko Cloud

How do I share tickets with other locations?
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Without Esko Cloud, it is possible to exchange tickets by using the Export / Import Ticket tools
in the Pilot. This writes a .zip file that can be exchanged via standard tools (E-mail, FTP,… ).

It is also possible to upload global (yellow) tickets to the data structures of the Esko Cloud. You
can not upload job specific (blue) tickets to Esko Cloud.

Because (workflow) tickets are not linked to a customer, the nodes for uploaded tickets are
stored in another data tree as the job information. Any location in the organization can see all
the tickets that were uploaded.

To use an uploaded ticket in production, it must be downloaded and stored as a local ticket. Do
this by choosing the Import Ticket From Esko Cloud entry in the Ticket menu.

Many tickets have dependencies. A lot of them like SmartNames, DGC curves and SmartMarks
will also be downloaded and placed or installed on the local Automation Engine.

Attention:  This will overwrite any already existing items or files with the same name.
Also mind that there is no versioning of tickets.

Any AE user can upload and anyone can download Workflow Tickets..

There is no automatic synchronizing of tickets. This is because the impact on production could
be too intrusive.

However, there is an indication how your local ticket compares to the one in Esko Cloud:

• Should I download because someone in another location uploaded a modification to the
Ticket in the Esko Cloud ?

• Should I upload because someone in our location made a modification to the local Ticket ?

To see this indication on how the local ticket compares to its cloud counterpart, make the
column Cloud Status visible in the Tickets view.

Note:  This indication is only meaningful if your Automation Engine is setup with time
synchronization.

20.9.  Workflow Examples - Combing the Tools and
Tasks

Our Example Group: "SuperPrint"

The group SuperPrint, has an Esko Cloud site and there configured its 4 locations that have
an Automation Engine server: Mexico City, Berlin, Sydney and Tokyo.
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20.9.1.  EXA 1 - Delegating work to an Other Location

Description of this example

The location in Berlin, BER001, regularly needs 3D models to be made of the label jobs that
they prepare.

The expertise and tools to do this is only available in MEX001, the location in Mexico City.

This example shows how the users in MEX001 can automatically get the files that they need to
work on.

In our case, the job name is 'Funky Monk 2018' and is for customer 'Brewski-Brew'.

Step 1 - PREPARE - customer consolidation

As always, nothing in this example will work when the involved customer account has not yet
been consolidated.

To do:

• In BER001, upload the local customer Brewski-Brew to Esko Cloud or link it with an
existing one on Esko Cloud that also represents that same company.

• In MEX001, Import from Esko Cloud the cloud customer Brewski-Brew.

Step 2 - PREPARE - At the location that should receive Files, create an Access
Point

The 3D work needs to be done in MEX001, so they should receive the files.

1514



20Automation Engine

To do:

• On that Automation Engine in Mexico City, create an Esko Cloud access point.
• Let it scan folders named '3D - To Do'.

Step 3 - Share the job on Esko Cloud (only)

To do:

• In BER001, select the job 'Funky Monk 2018' and share it.

In our example, we will not share it yet with 'MEX001'. This way, no other location can see
this job until we think it's ready.

In BER001, in the Pilot, the job now appears in the job's view 'Shared Files'. Users in BER001
can also use 'Show on Esko Cloud' to see it on the Esko Cloud site itself.

Step 4 - Start uploading files to Esko Cloud

In BER001:

• Upload the files that you want your colleagues in MEX001 to get to the job's subfolder '3D -
To Do' .

• You are free to upload other data from other subfolders to Esko Cloud.

Step 5 - Now share the job with the location MEX001

• In BER001, select the job 'Funky Monk 2018' and, in the dialog 'Sharing', in the field Share
with, add the name MEX001 . Confirm with OK.

• In MEX001, this automatically creates a local version of that job. As a reminder and mainly to
keep the name unique, the owner location of the job is added as prefix to the local name of
the job.
 

 

• However, it does not show any files in that local job folder yet:
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Step 6 - BER001 starts uploading files to the Esko Cloud job that is also shared
to MEX001

• In BER001, you now have all data ready to share with the colleagues in MEX001.

You have put them in a subfolder that has the exact same name as the one that was used
for the access point in MEX001.

 

 

• Select all those files and launch Upload to Esko Cloud.

Note:  It is not important if you upload them together or separate in time.

Step - In MEX001, files are automatically downloaded (because of the Access
Point)

• In MEX001, the access point monitors the jobs on Esko Cloud that it was invited to.

It detects that files arrived in the folder '3D - To Do' of the job Funky Monk 2018.

• The access point downloads the files to the local job folder of 'Funky Monk 2018', where it
creates a subfolder with the same name '3D - To Do' and saves them in there.

Note:  All of this uploading and downloading happens very fast. It may even be difficult to
see the files on Esko Cloud ; they are only there for a split second.

Possible workflow extensions

You could notify users in MEX001 about the new incoming work. You can do this by having the
access point also launch a workflow.

Once MEX001 is done with the 3D work, you could as well automate the sending of the result
files back to the location that requested them.
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20.9.2.  EXA 2 - Notify Users about Problems with Jobs arriving from
Esko Cloud

This is an extension to the workflow in EXA 1 - Delegating work to an Other Location on page
1514. We there described how Jobs and files arrive in MEX001. The users in MEX001 can see
them arrive when they look a the Jobs overview in their Pilot.

In this example we go a step further. To avoid that the users in MEX001 have to check what
happens, we will adapt the workflow so that they also get a To Do message about this incoming
work.

Follow these steps:

1. In TOK001, the job 'Yakitori_Maxi' is for customer 'Nippon Foods', a new customer. We select
it, right-click and choose Sharing. This dialog appears because this customer is not linked
yet to one on Esko Cloud:
 

 
2. This linking dialog can't find a match on Esko Cloud. So we click No.

 

 
3. We use this dialog to create the Esko Cloud customer and link the local one to it.
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Click Create and Link. Both dialogs will close.

In the view Customers, the customer Nippon Foods will now show with a cloud icon:
 

 
4. We now again try to share this job to Esko Cloud. We will also share it to our colleagues in

Berlin:
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Click OK and see the result in the Jobs overview:
 

 
In Tokyo office, everything seems fine. We will now check what's happening in Berlin.

5. In Berlin (BER001), we should see this job appear in the Smart View 'Shared by Other
Locations, but it doesn't:
 

 

What happened? The people in BER001 could scan the Tasks view and there look for an
explanation. But in this example we made it easier for them.
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6. The To Do list in BER001 shows a new action to respond to. Its details contain an extra piece
of information at the bottom. It offers a link to find out what went wrong.
 

 
7. Clicking on this link takes the user directly to the Tasks view and selects the Create Job task

that had a problem to create that shared job here in BER001. The task's Details explain why
this job could not be created:
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Note:  When the To Do list is open as a separate window, and you click the link there, then
the Pilot window already needs to be in the 'Containers' mode, which offers the general
Tasks view.

Two questions now pop up:

• How can you avoid this problem?
• How can you set this up, getting a To Do with that link?

How can you avoid this problem?

This typical problem can be avoid if you allow the Create Job task to also create that cloud
customer on your local Automation Engine server. This is not an option in the task itself but
part of the Esko Cloud configuration:
 

 

Note:  This option is by default not select as it can lead to local customer conflicts. As
mentioned earlier, the best way to avoid those is to standardise and consolidate on customer
IDs and names.

How can you set this up, getting a To Do with that link?

1. When Esko Cloud is asked to share a job to a location, it will create a local job on that
location's AE. The Create Job task ticket that is used is the one defined in Configure > Esko
Cloud > Sharing (see above).

Note:  By default, this ticket is one provided by Esko named Job Creation From Remote
Location.

2. Open that ticket. In it's tab Advanced, see the option When this task fails. The ticket that is
selected there is the one that we want to create a To Do message.
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Note:  By default, this ticket is one provided by Esko named When Job Creation From
Remote Location Failed.

3. Now open that ticket. This default one only contains the task Wait for Action (Checkpoint).
 

 
4. Open that ticket and see how the To Do option and that extra message were defined:
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20.9.3.  EXA 3 - Notify Users that Files have Arrived from Esko Cloud

In Example 2, we learned that, when Esko Cloud wants to share a job to your location, that you
can customize the tasks that start automatically. We used that to alert users when job creation
from the cloud fails.

In this example we want to automatically notify users when new files are arriving in the local
jobs that were shared to us from Esko Cloud.

Informing the users already when the job was just created locally might be too soon. In this
example we wait until there are any files there to work with.

We can do this by using the Access Point that scan the cloud folder that will bring the files
locally. We learned in Esko Cloud Access Point that we can also here launch a workflow.

1. Let's first make that custom workflow.

Note:  Even when you only need the action of a single task ticket, you have to make it a
workflow ticket to be able to select it in the Access Point.
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2. Then we select that workflow in the Access Point that was set up to download any such
work from Esko Cloud.
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Now, when the access point downloads files, this will also create items in the To Do list (one for
each file).

20.9.4.  EXA 4 - (WIP) Automatically sending the result data back to
location that requested it

Core message: In MEX001: WFL to copy to a "3D done" folder before Upload 2
Cloud

Description from SVV:
• The 3D specialist processes the files. When finished, he/she places the result files in a local

folder '3D-work-done'.

• These result files can be uploaded to Esko Cloud, in other words, they should arrive in the
3D-work-done subfolder of the Cloud Folder of the job.

We can do this by launching a workflow that triggers a Copy/Move task followed by a
Upload Files to Esko Cloud.

• Back in Berlin, the location that requested the 3D work, : an Esko CloudAccess Point
monitors the subfolder 3D-work-done in any of the jobs on Esko Cloud.

When it sees the result files appearing in such a folder, it downloads these result 3D files
into the folder 3D-work-done of the local job, in Berlin.

Also here, a workflow can be launched that notifies operators of the arrival of these files.

• Finally, at some point, the job can be removed from Esko Cloud: a AE user in Berlin does this
by unsharing the job, manually or by running the task Unshare Job.

Automatically, any remaining files on Esko Cloud are removed. Also, in Mexico, the
corresponding job is removed.

All work is done and delivered, all cleanup at remote locations has been performed.

Note:  Cleanup in Esko Cloud and other locations also happens when the job is deleted
locally (in Berlin) instead of only unsharing it.
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21.  Integrating with WebCenter

21.1.  Introduction

Automation Engine is not available outside its intranet (LAN). You should see it as an in-house
system. Automation Engine can of course be connected with many other systems. And those
systems can be web-enabled. Those systems will also have a different kind of users.

WebCenter is such a system. It is typically used by

• your colleagues working in places outside the intranet (in other plants, other countries,
sales people on the road etc.)

• your customers or other business partners.

If you look at what is communicated between Automation Engine and WebCenter, we
distinguish these types:

• exchanging files: exchanging files from Automation Engine to WebCenter and vice versa.
• exchanging information: exchanging the meta data from a Job to a Project and vice versa.
• sending direct commands to the WebCenter application (advanced setups).

Let's have a look at the main integration concepts between these 2 Esko products:

• WebCenter users want to send instructions or data to the Automation Engine users
• WebCenter workflows contain steps that are prepress actions. These are 'sub-contracted'

to Automation Engine. For example: WebCenter can not pre-flight designs, so it will ask
Automation Engine to do that.

• Automation Engine sending commands to WebCenter.

Publish and Approval
New or changed designs that were made print-ready need approval from the customer.
Because the customer cannot directly access Automation Engine's Jobs or Containers, the
prepress department will have Automation Engine publish the document to WebCenter.
WebCenter then manages this approval process with the customer and delivers the (final)
answer back to Automation Engine.

Using WebCenter as a centralized product management system
WebCenter can be used to store all the prepress data centrally. Local prepress sites then
download to their Automation Engine the data that they need for prepress or production
tasks. This means that the files in Automation Engine Containers are actually temporary data
whereas the long term data storage is then on WebCenter.

Important:  Automation Engine does not keep track of versions of files. WebCenter does and
that is important when you use WebCenter as your central storage of prepress data.
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Note:  Mind that you can choose to do this for only a part of your prepress data. For example
only for the files of some of your largest customers where prepress production is done in
different countries.

Note:  When Automation Engine users from different sites need data from the central
WebCenter storage, then several types of access rights will define what data they can see and
what they can do with it.

Note:  The parameters of a Automation Engine Product (Part) can be pushed as document
attributes on WebCenter (when the document is part of a BOM).

Apart from storing the prepress data centrally on the web, WebCenter can also use Automation
Engine as background server of some prepress functionality. A WebCenter workflow where
your customer is working with your sales rep could include a workflow step where Automation
Engine is asked to preflight the PDFs.

Automation Engine sending commands to WebCenter
All the above is possible through a handful of tasks and features that handle such
communication. Automation Engine can go a lot further than this and instruct WebCenter in
much more detail. Some examples:

• Automation Engine managing WebCenter users, groups, customers (create, delete...).
• Automation Engine managing WebCenter documents (download, download metadata,

delete, set attributes...).
• Automation Engine managing WebCenter projects (create, manage members, get lists, get

document lists...).
• and much more.

This advanced technique is enabled by the Integrate with WebCenter task on page 1543 in
Automation Engine. It offers over 50 different commands to send to WebCenter.

Note:  Automation Engine can also be told by an external system to send these commands to
WebCenter. For more on this topic, see the chapter on Integrating with External Systems.

21.2.  WebCenter Sites

Go to Tools >  Configure >  WebCenter Sites to configure links from Automation Engine to
WebCenter sites.

 

1527



21 Automation Engine

 

Website:

Specify the web address of the WebCenter site. After you entered the WebCenter address,
click Open... to check if the WebCenter site is up and running. If you are redirected to the login
page, it means that the address is correct and that the site is up and running.

Tip:  Be aware that this address is also the address that will be included in the notification
e-mails when adding links to documents (approval cycle start E-mail). You should therefore
make sure that the address can be accessed from the outside. Make sure to not use an internal
address, but one that you want your (external) users to use when they use WebCenter.

WebCenter and Automation Engine are in the same LAN

Select this toggle if this is true. This will most likely be the case. Deselect this toggle if
WebCenter and Automation Engine are not in the same LAN.

Note:  How can you verify if these two systems are in the same LAN? They are in the same LAN
when you can connect from WebCenter’s application server, this is the system where JBOSS is
installed, to an Automation Engine Job Folder with the credentials of the System Account (by
default the user BGSYSTEM or the one you changed it to, using the System Account page in the
Server Web page).

WebCenter's Approval Client:

If WebCenter and Automation Engine are not in the same LAN, you first need to create an
Automation Engine Approval Client in WebCenter. This is necessary to give Automation
Engine permissions to listen to the approval messages that are stored in WebCenter.

1528



21Automation Engine

Tip:  If the Approval Client does not exist yet, follow these steps:

1. In WebCenter, log in as Administrator.
2. Go to the Admin section. In Configurations, select Workflow and Tunnel Approval

Clients.
3. Click the link “New Workflow and Tunnel Approval Client".
4. Enter a User name and a Password for the Automation Engine client. Mind that this is also

the user name and password that have to be entered when configuring the WebCenter site
in Automation Engine.

Fill out the client Name and Password and click the Check Connection button. This will check
if the user can log on successfully.

The Info button displays the following information: ”In case Automation Engine and WebCenter
are not in the same local area network (LAN), the retrieval of the approval results is secured by a
name and password. The name and password specified in Automation Engine must match the name
and password specified in WebCenter by the WebCenter administrator. When clicking the 'Check'
button, the WebCenter version will be checked and the name and password will be validated by
WebCenter.”

Check Connection

When you click this button, you should, after a few seconds, get a window saying “Check OK".
The software version of that WebCenter will also be mentioned.

Note:  The button will check the validity of the user name or password to connect to that
WebCenter but not of your WebCenter’s Approval Client.

Note:  Passwords are encrypted.

Note:  When you connect to a secured WebCenter site (for example one that uses HTTPS://),
then you have to export its security certificate and import it on the Automation Engine server.
If this is not done, publishing from Automation Engine to WebCenter will result in an error.
Learn more on how to do this in the chapter Install SSL Certificates on the Workflow
Production Server of the WebCenter documentation.

Tip:  After configuring a new WebCenter site, it is recommended to close your Pilot and start it
again in order to see the updated list of WebCenter sites in your tickets.

21.3.  The WebCenter View in Automation Engine Pilot
When a Job is selected in the Automation Engine Pilot, the Views category 'General' offers a
view named WebCenter.

This View shows you all documents in a WebCenter project related to this Job without having
to open a browser to look at the project in WebCenter itself. The Pilot user can also see the
documents' approval status in WebCenter and can also download those documents from this
View.
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How to set up
In the Pilot, in the list of Views, click on the WebCenter icon. If the WebCenter View is not
configured yet, you will get a configuration page where you can fill out your WebCenter
address and the user name/password that will be used to connect to WebCenter. If the
WebCenter View is already configured, but you want to change the configuration, you can right-
click in the window and you will get the configuration window again.

Tip:  In the configuration, you need to specify the Project name. It is common practice to map
Jobs to WebCenter Projects using the SmartNames [Job Name] / [ Project Name]. On
the configuration page, use the SmartName [Job Name] for the Project name.

Troubleshooting
If you do not see anything appear in your WebCenter View, right-click on the View canvas and
select Configure. Copy the value of the URL, open a browser window and go to this URL. You
should get the WebCenter login window. To log in, use the same credentials as in the configure
page. If you can log in with the user name of the configure page, retype the password in the
configure page that you just used for logging in to WebCenter. This ensures that the password
is still up-to-date. Try again to connect to WebCenter. If it still does not work, verify that the
Project name you try to access really exists in WebCenter. Ensure that the SmartNames resolve
correctly to the project in WebCenter.

21.4.  WebCenter Integration Tasks

21.4.1.  Create or Modify WebCenter Project task

Concept

This task allows to create a WebCenter Project from Automation Engine. If the project already
exists, it will be updated with new or changed parameters.
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Tip:  Some users want a WebCenter Project for every new Job in Automation Engine.

• When you manually create a Job, you can (in the advanced tab) select this task to be
launched when you create the Job.

• In a workflow, you can insert this task as a step after the Create Job task.

The WebCenter Project that you create is not limited to having the attributes that you defined
here in this task. The Project can also get extra attributes from the selected Project Template or
the Customer Company.

Requirements

To use this task successfully, you need

• in Automation Engine:

• to be in a Job context, a Job with minimally an Order ID.

• the user name and password of a WebCenter Project Manager.

• in WebCenter:

• a Project template with attributes matching the Automation Engine Job
parameters (Order ID, SubOrder ID, and - if used - any custom parameter defined in
the Parameters tab of the Job setup).

Note:  Make sure the WebCenter attributes have the correct type for your Job parameter
data. For example, when passing on a date parameter, the corresponding WebCenter
attribute should have the type 'Date and Time'. When passing on a numeric value, the
WebCenter attribute should have the type 'Numeric' ('Float' or 'Integer'). For more
information about attributes, see the WebCenter documentation.

Attention:  If the WebCenter attributes do not have the exact same name as the
Automation Engine Job parameters, the Job parameters will not be passed on.

• Optionally, check the WebCenter naming of Customer Company and Customer
Location.

Task Options

Most fields allow both direct input and/or using SmartNames.
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• WebCenter Site: Select one of the configured WebCenter sites. Optionally, click
Configure... to access the Configure panel where those are set up. Learn more in
'WebCenter Sites on page 215'.

• Project: The name of the WebCenter Project.

• Project Template: Define if you want the new Project to be based on a Project template.

Note:  Make sure you select a Project template with attributes that match the Automation
Engine Job parameters.

• Project Status, Customer Company, Customer Location: Click the refresh button to get
an updated list.

• Project Description: If you want, define a description for this Project.

• Project Manager User Name: Define which WebCenter user will be the manager of this
Project.

Note:

• This user must already exist in WebCenter.
• This can be the same user as the one you use to contact WebCenter with (the user and

password fields further below). Also, that user that contacts WebCenter in this ticket
must have at least as much visibility in WebCenter as the Project Manager user that
you enter here.

• User Name: This the user that you contact WebCenter with and who will create or modify
the Project.

Note:  The user you enter here must be a Project Manager in WebCenter to be able to
create Projects.
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• Password:

• Encrypted. Type it in. It will not be shown visible.
• Use SmartNames. Some customers prefer a SmartName because they do not want

Automation Engine users to know this password or because they want the latest changes
in that password to be automatically picked up here.

Modifying workflow parameters using this task

As mentioned in Modifying Workflow Parameters During a Workflow on page 814, this task can
also be used to modify Workflow Parameters.

This task allows you to modify the value of a specific Workflow Parameter with the value of the
Project ID of the created or modified WebCenter Project. The mapping of the Project ID to a
specific Workflow Parameter can be done using the Map Output Parameters dialog.
 

 

21.4.2.  Publish on WebCenter task

The Publish on WebCenter task allows to upload files from Automation Engine to a
WebCenter Project.

Optionally, you can request WebCenter to start an approval cycle on those files. In that case,
this Publish on WebCenter task will remain in a waiting status until the WebCenter sends back
the final answer of that cycle ('approved' or 'rejected').

Note:  An approval cycle in WebCenter ends when all approval members have answered or
when someone used a 'forced approve' or 'forced reject' answer.

This ticket has three tabs:

• Destination: Define in which WebCenter Project you want to publish the file.

• Publish: Define what version of the file you want to make public on WebCenter.

• Approval: Define if and how you want to start an approval cycle.

Modifying workflow parameters using this task
As mentioned in Modifying Workflow Parameters During a Workflow on page 814, this task can
also be used to modify Workflow Parameters.

This task allows you to modify the value of a specific Workflow Parameter with the value of the
Document Version ID of the document you publish in WebCenter.

The mapping of the Document Version ID to a specific Workflow Parameter can be done using
the Map Output Parameters Dialog. When you open this task ticket as part of a workflow, you
will find it in the Advanced settings.
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Destination

Note:  You can use SmartNames in most of the fields.

 

 

• WebCenter Site: Select the WebCenter site you want to publish the document to. Click
the Configure... button if you want to add or change WebCenter sites. Learn more in
'WebCenter Sites on page 215'.

• Project: Define in which WebCenter Project you want to publish the document.

Tip:  Use [JobName] as Project name to map your Jobs in Automation Engine to the
Projects in WebCenter.

Important:  If the WebCenter Project does not yet exist at publish time, it will be created.
Mind that the user that does the publish needs to be Project Manager in WebCenter to be
able to create a Project in WebCenter.

Remember:  The recommended method to create a WebCenter Project is by using the
Create or Modify WebCenter Project task.
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Note:

When this task creates the Project, the Project manager will be :

• the Project Manager of the Template group if the WebCenter user executing the task is
part of that group.

• or the WebCenter user executing this task.

• Folder: Define in which folder of that Project that the documents should be stored.

Note:  If the folder does not exist yet, it will be created if the user is a Project Manager in
WebCenter. With user we here mean the WebCenter user that you define further below in
this ticket.

• Project Template: If the task needs to create the WebCenter Project, define here which
existing Project template should be used.

Note:  Some WebCenter users do not see all Project templates. Templates are filtered
according the user’s visibility. When you define a user’s visibility, you can list a set of
companies and/or a set of groups. The effect on this is the following:

1. If a template has a customer defined, this customer (= company), needs to be in the list
of companies that the user can see. If the company is not in the list of visible companies
of this user, the template is not visible for this user. This means that this user can not
use this template to create a new Project.

2. When the template has group members, WebCenter checks whether the user can see all
the group members. As soon as there is one group in the template that is not visible to
this the user, the template is considered as ‘not visible’ for this user. Again, the user will
not be able to create a new project based on this template.

• Document Name: This field allows you to set a specific name of the published document. If
left blank, it takes the original name of the document.

Note:  If the document already exists, the task will create a new version of the document.

Note:  If the document already exists in a different folder of that Project, the task will fail.

• Document Description: This will be the document's description in WebCenter.

• Document Attributes: This allows to set specific attributes for the document in
WebCenter. These may have different names than what you call them in Automation
Engine. For example you can map some metadata from the PDF to a Document Attribute.

• User Name and Password: Enter the name and password of the WebCenter user that will
connect to WebCenter and upload the document.

Note:  The task will fail in error if this WebCenter user lacks upload rights, even if the Project
exists.

Publish
In this tab you decide what version of the input file you want to publish and/or if you want to
prepare special view data for the WebCenter Viewer.

• Allow Viewing and Annotating in WebCenter on page 1536.

• Allow Downloading in WebCenter on page 1536.
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Allow Viewing and Annotating in WebCenter
Select Publish Annotations when you also want to publish the XFDF files that were created by
the Inspection tasks. Learn more in Inspection Results as Annotations in Viewers on page 1054.

Select Prepare for viewing and annotating to have the graphic files prepared into raster data
for the (WebCenter) Viewer. These rasterized data will then also be published to WebCenter.

Note:  The graphics kernel that is used to prepare the files for the Viewer follows the settings
that were chosen in the Configure tool Viewer - View * Files As in * . For new installations of
v20 or later, the default setting is to view PDF files as in ArtPro+.

Note:  This option can not be selected on when WebCenter and Automation Engine are not in
the same LAN.

Note:  When this option is not selected, WebCenter itself will then need to create this raster
data for viewing.

The Resolution for non-images (linework, text, ...) will be the maximum resolution you will
have in the WebCenter Viewer. You can choose between:

• Optimal: The best resolution is used, mainly based on the size of the file. It is
recommended to select this option. For small files, it will rasterize with a high resolution.
For large files, it will be a lower resolution. This balance is to ensure you always have a fast
viewing experience in the Viewer, both when you first open the file and when you start
zooming in.

• Custom: Allows you to specify a resolution yourself. When you set a high resolution, it will
create large rasterized files. Set a low resolution for a lower quality view of the document in
the WebCenter Viewer.

Important:  For images, the maximum available resolution is used.

Anti-aliasing: This is relevant for the linework objects that need pre-processing and for which
extra images are generated (CTs). Anti-aliasing smooth-ens the staircase effect you get in these
CTs. Text will be more readable, also when zooming in.

Automatic grouping of input file into digital film sets: In a workflow, the publish task can
be used right after a RIP task that creates digital films (for example LEN or TIFF files). In such
cases, you may want to publish these files as one document. Enable this option to bundle that
set of digital film files and publish them as one document to WebCenter. Each digital film will
make up one separation of the document.

Note:  When digital film files were rasterized as one group, the Viewer tool will also recognize
them as 1 set of separations.

Allow Downloading in WebCenter
Make available for download:

• When this option is off, the Publish on WebCenter task will not publish the task's input file
to WebCenter but only the 'prepared' rasterized files. Choose this option when you do not
want any form of your production files to be downloaded by WebCenter users.

• When this option is on, you can choose which files you will make available for download on
WebCenter (if the user has such permissions):

1536



21Automation Engine

• Input files. For example: your task input file is a production PDF, and that is the PDF you
want the WebCenter users to have access to. Or you already had made low resolution PDFs,
and you choose to publish those instead.

• PDF files for proofing. In this case, you choose not to publish the input file but a PDF file
for proofing that does not exist yet. Select from the list of PDF export tickets which kind
of PDF you wish to create and then publish to the WebCenter user. This way, you offer the
outside world a 'PDF proxy' file instead of your real input production file.

Attention:  Always choose this option when the task input files are not self-
contained. For example when your PDF refers to artwork, fonts or other PDFs.

Note:  If you select PDF files for proofing the viewing quality will be limited to the
resolution of the PDF files for viewing.

When disabling both Prepare for viewing and annotating and Make available for
download, a warning box is displayed indicating that no data will be published. You need to
select at least one type of data to publish.

Approval
The Approval tab allows you to select if and when an approval cycle should be started on
WebCenter.

Important:  Make sure you already have an approval cycle set up in WebCenter! This approval
cycle setup will indicate who to invite, what their role is and more. Mind that the approval cycle
can be part of a Project template that you here selected.

 

 

Start the Approval Cycle and wait for approval. Select this if you want the approval cycle to
start automatically as soon as the file is uploaded to WebCenter. For this, you need to have an
approval rule specified in the Project or Project folder where you upload the document to. By
default, WebCenter will apply the folder approval setup if it exists. If not, the Project approval
setup will be applied.

Due Date: If the WebCenter user that you use to log in with ('Destination' tab) has the Change
Approval Setup permission in WebCenter, you can also set the approval due date.

Note:  The due date specified here will take priority over the due date specified in WebCenter.

You can choose one of the following:

Choice Explanation

Immediate This will set the due date to the time that the
task was launched.
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Choice Explanation

Today This will set the due date to today, at a user
specified time.

Tomorrow This will set the due date to tomorrow at a
user specified time.

In ... hours This will set the due date to a specified
number hours from the time the task was
launched.

In ... days This will set the due date to a specified
number of days from the time the task
was launched and at a specified time. A
SmartName can be used to set the number of
days.

For example "in 2 days at 5:43 PM" is the same
as "the day after tomorrow at 5:43 PM".

On Use the calendar to set the due date and time.

Job due date This will set the due date to the one specified
in the Job setup.

Select SmartName... If you use a SmartName, it will also be added
to the above menu items.

Note:  The SmartName should be conform to
the ISO 8601 date string format. For example
2014-12-27T11:30:00+02:00

Annotations:

If any annotations were made during the WebCenter approval cycle, the Publish on
WebCenter task generates a annotations summary. At the end of the approval cycle, an HTML
file will be generated. This HTML file redirects the Automation Engine user directly to the
WebCenter annotations page in a browser. He will be asked to login to WebCenter.

You can here decide the folder and name where this 'shortcut' HTML will be written.
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What if you get conditional approvals?
Documents that are approved conditionally in WebCenter will go through the Approved with a
Condition output of the Publish on Web task (standard of the type 'warning').
 

 

It is good practice to use a Wait for Action (Checkpoint) task for those documents, so the
Automation Engine operator can fix them manually. For more details about conditional
approval, see the WebCenter documentation.

What if you have multiple input files?
When your Publish on WebCenter task has multiple input files, and your ticket requests an
approval cycle, then an approval cycle will be started for each of those input files. When the
Publish on WebCenter task has received an answer for all files, it will then show their specific
status in the task's output pins: which one was approved or rejected etc...

When you use the Split task in front of the Publish on WebCenter task, then Automation
Engine will start up a Publish task per input file.

Troubleshooting tip
If you get errors in this publish task and the log file does not give you an indication what might
go wrong, then try to do the same steps interactively inside WebCenter, using the user account
that you had used in your Publish ticket. If the error is due to permissions, you will quickly
figure out what goes wrong.
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Publishing Automation Engine Products to WebCenter

Attention:  This page addresses customers who use the Automation Engine Products
tool. Learn more about this tool in the chapter Products on page 548.

When you publish an Automation Engine Product to WebCenter, the Product Properties and
Product (Part) Parameters will be taken as WebCenter Attributes. If there are existing
WebCenter attributes with corresponding names, their values will be updated during
publishing.

Attention:  For this to work, WebCenter needs to be enabled to work with BOM - Bill
Of Materials. This is a setting in WebCenter -> Admin -> General Preferences.

The following Product (Part) properties and Product (Part) Parameters are synchronized with
WebCenter Attributes (see further how to rename these internal names to more readable
ones):

Automation Engine Properties/Parameter WebCenter Attribute (Internal name)

Product Customer Reference ae.p.cusref

Product Custom Field 1 ae.p.category1

Product Custom Field 2 ae.p.category2

Product Custom Field 3 ae.p.category3

Product Internal ID ae.p.id

Product ID ae.p.prodid

Product Name ae.p.name

Product Description ae.p.desc

Product Part Internal ID ae.ppid

Part Default Angle ae.pp.defaultangle

Part Default Dotshape ae.pp.defaultdotshape

Part URL ae.pp.url

Part Default Ruling ae.pp.defaultruling

Part Preferred InkBook ae.pp.preferredinkbook

Part Preferred InkBook UI ae.pp.preferredinkbookui

Part Internal ID ae.pp.id

Part Custom Field 3 ae.pp.category3

Part Custom Field 2 ae.pp.category2

Part File ae.pp.file

Part Status ae.pp.status

Part Status Nickname ae.pp.status_nickname

Part Status User ae.pp.status_user

Part Status Notes ae.pp.status_notes
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Automation Engine Properties/Parameter WebCenter Attribute (Internal name)

Part Status Date ae.pp.status_date

Part Folder ae.pp.folder

Part Custom Field 1 ae.pp.category1

Part Name ae.pp.name

Part Inks ae.pp.inks

Part Barcodes ae.pp.barcodes

Product Customer Name ae.c.name

Product Customer Description ae.c.desc

Product Customer ID ae.c.id

MyProductParameter1 ae.p.par.MyProductParameter1

MyProductPartParameter2 ae.pp.par.MyProductPartParameter1

When a Product or Product Part is published, the corresponding WebCenter Documents are
automatically added to the Bill Of Materials  of the WebCenter Project. The Product Amount
for the Job (if given) is updated as the Count property of the Bill of Materials.

Tip:  You can rename the internal name of WebCenter Attributes to a more readable name by
first adding it to a Category:
 

 

Learn more about this in the PDF named Connection between Automation Engine and
WebCenter 14  that you can download from https://www.esko.com/en/support/product?
id=WebCenter.

21.4.3.  Download WebCenter Document task

This task allows to download documents from WebCenter into an Automation Engine
Container (or Job Folder). Optionally, downloaded documents including their document
attributes can be immediately added to the Products database.
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The following SmartNames are useful in a Download WebCenter Document task:

• WebCenter Document Folder: The folder in the WebCenter project that holds the
document that you are downloading.

• WebCenter Document Name: The name of the WebCenter document that you are
downloading.

• WebCenter Document Original File name: The original name of the file that was
uploaded to WebCenter and there made a document.

 

 

• Output in and File name The above screen-shot shows how the default ticket proposes
you a logic place and name for the file you are downloading.

• Site: The WebCenter site to download the document from. Click Configure... to add or
change WebCenter site configurations (enabled only for administrator users). Learn more in
'WebCenter Sites on page 215'.

• Project Name: The name of the WebCenter Project that you want to download a document
from.

• Document Name: The name of the WebCenter document that you want to download.
• Lock document: Check this option if you want to lock the document in WebCenter. When

the document is locked, other WebCenter users will not be allowed to upload new versions.
Only the WebCenter user that locked the document can publish a new version and/or
unlock the document.

• User Name and Password: of the WebCenter user that downloads and/or locks the
document.

• Create or update Job Product: Check this option if you want to add the downloaded
document as an Automation Engine Product for the Job you are working in. If the file
is already a Product, the WebCenter document attributes are merged with the existing
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Product (Part) parameters. If the attribute already exists as Product (Part) parameter,
that Product (Part) parameter's value is updated. If the attribute was not a Product (Part)
parameter yet, it is added as a Product parameter.

Important:  In order to use the option Create or update Job Product, the task must run in
a Job context!

21.5.  Advanced WebCenter Integration

21.5.1.  Integrate with WebCenter task

Concept

WebCenter can be used

• interactively, in a browser, by a WebCenter user
• by an external system, through a special connection setup
• by Automation Engine, by using the Integrate with WebCenter task.

This Automation Engine task goes a lot further than the ones we documented earlier that only
focus on exchanging files and creating projects in WebCenter. This Integrate with WebCenter
task enables Automation Engine to perform more than 50 different types of actions on
WebCenter. Some of these actions are very elaborate commands or requests for information
and some even change configurations.

Note:  The technology behind this task has historically often been referred to as the
"WebCenter SDK"

Attention:  This task requires advanced knowledge of both WebCenter and Automation
Engine.

Task Options
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• Output in and File name: Depending on the Action chosen below, these fields might be
relevant or not. If the action triggers this task to have an output file, then you can here
define their folder and name.

• Site: Select the WebCenter site from the list. Click Configure... to add or change WebCenter
site configurations (enabled only for administrator users). Learn more in 'WebCenter Sites on
page 215'.

Note:  A connection will be made with the WebCenter that you select. It will not just test
the connection but will also get the list of possible commands from that specific WebCenter
server. That list then becomes the list of Actions (for this WebCenter).

• Action: Select the action. When the selected action offers options, the Options... button will
become active. The options dialog is specific per action. Here is an example:
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See how selecting the action "Get List of Documents" automatically offers a sub-type of
action to choose, here "Specify folder(s) by ID" (or "by Name"). The button Options... offers
another specific dialog with more options for this Action.

Attention:  Most option fields offer Tool Tips which extra information, conditions
and general tips. Tool tips appear when you hold your mouse-cursor over the field.

• User Name and Password. Define which WebCenter user will execute the selected action
on WebCenter. Make sure this user has the required privileges.

More info

More detailed technical info is available in the "WebCenter SDK documentation". Learn more
about this document in this Esko Knowledge Base article: KB 92180925.

Modifying workflow parameters using this task

As mentioned in Modifying Workflow Parameters During a Workflow on page 814, this task can
also be used to modify Workflow Parameters.

The Integrate with WebCenter task allows you to modify the value of a specific Workflow
Parameter with the result of the action executed by the task.

For example (as shown in below screen shot): When you select the action "Get Document
History", you can update the value of a specific Workflow Parameter with the value of the
approval status of the document. First you need to define to which Workflow Parameter a
specific Output Parameter needs to be mapped to. You can do this using the Map Output
Parameters Dialog.
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22.  Integrating with Share & Approve

22.1.  What is Share & Approve?

Share & Approve is a web-based approval tool from Esko. It is available in a SaaS model. It
is based on Esko Cloud architecture. Learn more on https://www.esko.com/en/products/share-
approve.

Documentation on the product Share & Approve can be found on https://www.esko.com/en/
Support/Product?id=Share%20and%20Approve.

Setting up the connection from your Automation Engine to a Share & Approve site is very
similar as when doing this to enable collaboration between AE's by sharing Jobs.

Several dedicated tasks enable the communication with Share & Approve.

22.2.  Upload Files to Share & Approve

Concept
This task uploads the selected files to a specific folder on your Share & Approve site. You can
upload any file that resides on an Automation Engine Container.

This task will not upload folders.

This task will not start an approval cycle.

Settings
 

 

• Site: Select one of the sites from the list. These are the sites that your Esko Cloud account
(token) allows to access. Their name is shown as <organization-ID>/<Site-Name>. Click
Configure... to manage or see them in more detail.
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Note:  In this ticket, we strongly advise to only select a site that was set up to serve as
approval tool. Do not select a site that was set up to enable an AE collaboration workflow!

• Upload to: Specify the folder to upload to. The path is relative to the root of the selected
site. Subfolders are created on Share & Approve as needed.

When a file was already uploaded, a new version is created on Share & Approve.

Note:  This field needs to be URL encoded.

Note:  This field is case-sensitive! So be extra careful when typing in a path.

Attention:  When selecting files that are not in an active job folder, then do not use
SmartNames that require a job context, like [Job Customer ID].

Note:  Also very large files can be uploaded. For example > 1 Gb.

Note:  When used in a workflow ticket, see how an empty token is put on the output-pin
'OK'. No other local file was generated. The output pin 'Uploaded' links back to the local
input file (when it was successfully uploaded). This makes it possible to extend the workflow
on that file after that step.
 

 

22.3.  Start Approval Cycle on Share & Approve

Concept

This task starts an approval cycle on Share & Approve. The task ends when the approval cycle
has been started.

If you want a workflow to wait until the approval cycle has ended, then have this task followed
by the task Wait For Approval Cycle on Share & Approve.

In a workflow ticket, the input for this task needs to come from any of these tasks:

• Upload Files to Esko Cloud Job Folder (workflow token)
• Select Files on Esko Cloud Job Folder (.json file)
• Upload Files to Share & Approve (workflow token)

Attention:  Make sure that the local files for which you started an approval cycle are
not changed during the that approval cycle.
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Attention:  An approval cycle that ends in rejecting the file has no further influence in
Automation Engine. You could for example still output or expose that file.

When you upload a new version of a file while its approval cycle is still ongoing, then the first
cycle will be stopped immediately and a new one will be started.

Settings

• Approval type:

• Folder approval:

The approval cycle is started conform the approval setup for the folder in Share &
Approve where the files reside, or the setup that that folder inherits it from a parent
folder.

Note:  When you use a SmartName to choose this type of approval, it should resolve to
'folder'.

Note:  The task will fail when no approval cycle was set up for that folder.

• By E-mail:

• Approver: A comma separated list of E-mail addresses.

• When the E-mail address corresponds to a registered user in the Share & Approve
site, then the E-mail provides a link to log on to the Share & Approve site with his
Share & Approve credentials.

Registered users are invited to the approval cycle with the role 'Approver'.

• When the E-mail address does not correspond to a registered user in the Share
& Approve site, then the E-mail will provide a direct link that opens the file in the
Viewer tool of Share & Approve. The user will not be asked for to log in. They can
decide the File's status in this Viewer. They have no access to any other pages of
the Share & Approve UI.

This type of user is also referred to as a 'Shared Link User'.

The link that these unregistered users get to that file on Share & Approve is
temporary. Technically, such a link is also known as an 'unguessable' link.

Unregistered users are invited to the approval cycle with the role 'Reviewer'.

Note:  When using a SmartName to choose this type, it should resolve to 'email'.

• Due Date: Specify a time when the approval cycle must have ended.

When this due date has been reached, and the approval cycle is not yet finished, then Share
& Approve sends out an overdue notification. Also, in the UI of Share & Approve, the due
date is shown in red.

Note:  When using a SmartName, its result should be compliant with xsd:datetime
(ISO8601).
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22.4.  Wait for Approval on Share & Approve

This task waits until the Share & Approve approval cycle of each input file has ended.

The task ends when all related approval cycles have ended. Due dates have no influence here.

When the task ends, a report .json file is put on the 'OK' output pin (one report per approval
cycle). Typically, this file is interpreted by the next step 'Route Approval Cycle'.
 

 

Note:  Canceling this task does not stop the approval cycle. It just means that you give up
waiting.

The task ticket offers no settings.

22.5.  Route Approval Cycle

In a workflow, this task allows to take appropriate actions depending on the end state of the
approval cycle.

Typically, this step is preceded by the step Wait for Approval on Share & Approve.
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The output pin shows both the input PDF (the local one) and the .json file containing the
comments.

The default output pins are

• Approved
• Approved with Condition
• Force Approved
• Force Approved with Condition
• Rejected
• Force Rejected
• Unexpected
• Error

The task ticket offers no settings.

Learn more about approval states in the documentation of Share & Approve.

22.6.  FAQs

Can I use Share & Approve tasks in combination with AE Job Sharing tasks?
Yes you can.

You can for example make a workflow that selects or uploads files to an Esko Cloud Job Folder
and then starts an approval cycle on them.
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23.  Integrating with External Systems

23.1.  Introduction
This chapter is a guide for those who want to connect their Automation Engine server with
other systems. Typically these systems are

• Business Systems like MIS (Management Information System) or ERP (Enterprise Resource
Planning). These systems usually have components like order entry, price calculation,
customer database, production planning, stock etc.. These systems can be purchased by
your company from an MIS vendor and then adapted to your specific business process or
your company could have created her own unique system.

• Asset Management systems. They focus on managing and sharing your prepress data and
are usually web-enabled.

A connection between your Automation Engine server and (one of) these systems is of
course digital and can be one-directional, bi-directional or, in case more than 2 systems are
connected, even triangular.

Note:  Throughout this document, for the sake of simplification, we will name such systems
'the external system'.

Note:  Many features that we describe in this chapter require the optional module named
Automation Engine Connect.

Note:  A separate chapter is available on Integrating Automation Engine with Esko WebCenter.

23.1.1.  Why Integrate?

Faster.
No time is wasted by waiting, usually for a person.

Better.
Error reduction: no errors re-typing or misinterpreting. A small error can have huge costs. A
wrong 'status' interpretation can have major production (cost) consequences.

More consistent, more process control.
Having a consistent way of working will benefit all. It is easier to train new people. It will be
required when your company is trying to receive quality certifications (ISO etc..).

Operators in both departments can focus on more added value tasks.
The freed up time can now be used to increase the quality of what they do or to think their
actions over. Hiring new (young) people will be easier when they see you have modern ways of
working.
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Now let's have a look at what information typically is exchanged in each direction.

23.1.2.  External System sending commands To Automation Engine

Create an Automation Engine Job and set Job parameters.
An Automation Engine Job represents a job order that you get from the business system. So
it is logical not to create those Automation Engine Jobs manually but to get your instructions
from that system in an automated digital way. All the parameters should then be picked up in a
highly automated workflow.

Create an Automation Engine Product and set Product parameters.
New design data that arrive can be automatically added to the Automation Engine Products
database, including the detailed product specifications like barcode and inks. Often, these
design data arrive before there is a job order to produce them. The workflow can link this
newly created product to a Job.

Start an Automation Engine workflow with parameters defined by the
external system.

Not all parameters need to be stored first in a Job or Product: Automation Engine can also
retrieve parameters from an external system during a workflow and use these parameters in
subsequent steps of the workflow.

23.1.3.  Automation Engine sending commands To an External System

Setting Job or Product status in that external system.
The business system is very interested in what is happening with the job in the prepress
department. Being automatically informed on the exact status can have major benefits: Your
sales/service people will have up to date info for your customer. Your production will be more
efficient when its planning is based on reality. Automation Engine can send such feedback
automatically. And based on that new status, the external system may also decide to start an
own automatic workflow.

Initiating actions on that external system.
Automation Engine could even do more than that. It could really talk to that external
application, ask questions and come back with a set of information.

23.1.4.  Some general advice

Have a project manager
Appoint someone who owns the mission to do this. This integration can affect many people
so someone needs to be in charge. It is actually possible that it is the first time that these
2 different departments (sales-service and prepress) are part of a same project. Each
department will defend its way of working. Each department will not know all complexities of
'the other side'.
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Change Management
When you start eliminating some human intervention, it is possible that new questions will
come to the surface. Any changes in the way you work in such a busy production environment
will need to be defended. The integration is indeed technical but it is actually not 'just an
IT project': the reason you do this will be of interest to higher management. Often higher
management is where such ideas to integrate start. Making some changes will be necessary to
get that higher efficiency that they are looking for.

Step by Step
Start with a step that is 'obvious' and build from there. Before 'going live', carefully test and
dare to consider all sides of the changes that this integration will cause. Using both the new
and the old workflow can be confusing, so be prepared to switch over fast.

23.1.5.  Need any help?

If you want help with your integration project, Esko offers 2 levels of service.

• Standard training by an Esko Academy trainer.

Esko trainers will explain the Esko part of the tools.

Tip:  After learning about the concepts and features in this documentation, we advise to
also check the chapter Examples on page 1638.

• Help from an Esko Solution Architect.

Esko Solution Architects are experienced in such system integrations and have a broader
knowledge of 'workflow', beyond the world of Esko products. Contact your Esko sales rep if
you want to know more.

23.1.6.  What about JDF?

Note:  Job Definition Format is a standard language based on XML. It was created by the CIP4
group to help standardize system integration in the printing industry. Learn more on http://
www.cip4.org.

Integrations that use JDF/JMF require assistance from an Esko Solution Architect. That is why
this documentation does not cover JDF/JMF.

Note:  With some specific MIS, Esko optionally offers a 'standard' integration package based on
a White Paper. Contact your sales contact if you want to know more.

23.2.  Integration Concepts

Let's distinguish the main concepts in integrating with Automation Engine. In many integrations,
several of these concepts are combined. There is no pre-defined order in which these concepts
whould be used in your particular case.
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The tools that we here introduce are documented in detail in the next chapters.

23.2.1.  Access Points Triggering a Workflow on Automation Engine

Access Points trigger a workflow after they detected a signal from 'outside'. They use a 'polling'
mechanism: they check at a regular time interval if they have to trigger that workflow. There
are many types of Access Points and you can create as many as you need.

 

 

A typical example is a classic hot folder (a Folder Access Point), where the incoming data is
then processed and the result is output on another folder. For example: design PDFs arrive
in a hot folder and from there they will be automatically trapped and then written to another
folder.

However, Access points are not only used to start work on that incoming data. They can also
receive parameters for the workflow that they will start. These parameters define what needs
to be done in the workflow with some other (set of) file(s). For example: a Folder Access Point
receives an XML from the order entry system. The XML describes a list of re-run print Jobs. And
for each Job it describes which Products need to be linked into that Job and what quantity
needs to be printed.

Or, instead of receiving those parameters, Access Points can go and search for them. For
example: a Database Access Point looks up the desired trapping distance in an external
system. This results in a SmartName that the trapping task then uses.

Other types of Access Points are FTP, SFTP, Mail, Web Service. Then there are several variants
that get their data from cloud storage applications. Learn more in Access Points on page 1561.
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It's all about SmartNames!

In most cases, these parameters that come in from the external system are turned into
SmartNames. And then these SmartNames will be picked up in the workflow tasks. These
SmartNames can be stored in Job or Product parameters, when they describe job or product
characteristics that are relevant for the lifetime of the job or product. When the parameters
are relevant only for the workflow started by the access point, they can be used as workflow
parameters.

23.2.2.  Automation Engine tasks Interacting directly with the
External System

Not only Access Points can contact an external system. There are also 2 Automation Engine
tasks that are dedicated to interact with external systems. Contrary to Access Points, their
interaction can be bi-directional. Besides retrieving data from external systems, these tasks
can also be used to provide feedback to external systems. This will be described in more detail
later. However, these 2 tasks are typically used because the workflow needs this interaction
before it continues. The result of these tasks will be used in the next steps of the workflow. As
usual, this can be creating Jobs or Products, or get values for SmartNames to be used in that
workflow.

 

 

•
The Interact with Database task 

Automation Engine can use this task to read a value from an external database. For
example: an operator starts a workflow to Step & Repeat and output. The workflow asks
the database of the production planning system on which press this job will be printed.
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This is needed to know the layout size and also any dot gain curve. This press choice can be
decided very late, so it might not have been part of the Job parameters that were created
earlier.

Note:  Reading from an external database is also possible by using a simple SmartName
query or by using a Database Access Point.

Automation Engine can also use this task to write directly into the database of the
external system. For example to inform it on the new status of a Job or Product. When that
system can not read XML messages with such information, then you can consider to have
Automation Engine write this information directly into the database of that system.

Caution:  This is a very direct way to have applications connect. This must be well
designed and carefully tested.

Important:  Esko takes no liability for queries that write or change fields in that external
database.

•
The Interact with Web Service task 

The concept is very similar to the one above, but here the task uses HTTP calls to a web
service. Also here, both read ('GET') and write ('POST') commands are possible. When the
external system is running a web service, you will be able to access it via HTTP (Hypertext
Transfer Protocol). However, you also need to learn how to communicate to that system.
Some applications will indeed publish their API (Application Programming Interface). For
example Automation Engine can use this task to ask a question to Google Maps. This is only
possible because Google Maps did publish its API (and runs a web service). This example is
illustrated in the chapter Examples on page 1638.

Typically, both these tasks execute such interactions as part of a larger workflow in Automation
Engine. Find their detailed documentation in the chapter Tasks Interacting with other Systems on
page 1624.

Note:  The Integrate with WebCenter task is described in Advanced WebCenter Integration on
page 1543, a chapter of the document on integrating Automation Engine with WebCenter.

23.2.3.  Automation Engine Mapper tasks Transforming Data

Automation Engine offers many ways to use XML to control the workflow. Automation Engine
also offers many features to create XML files. But sometimes you need to create an XML with a
different content or formatting.

This Create XML File task is typically used to create XML files that are to be read by external
systems. In such XML files, you sometimes want more or less information. And sometimes you
need to re-format data in a way that the external system prefers.

Then there are the specific data formatting tasks like Split XML, Join XML or Map Data task.
These are powerful tools that offer many more ways to control XML files. Sometimes the data
(information) that comes from an external system first needs to be transformed before it can
be used in Automation Engine. Sometimes, these transformations are classic file conversions
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like CSV to XML. The Map Data task was created to do this. Sometimes the XML will first need
to be split in several XMLs (Split XML task). Sometimes it will be useful to join several data files
into one XML (Join XML task).

 

 

Data transforming tasks can be used at any step in a workflow. They are used

• at the start of a workflow, to help transform what an Access Point delivered.
• at any other point in a workflow, also often at the end, to translate information into a

format that the external system prefers.

Find a detailed description of these tasks in the chapter Data Transforming Tasks on page
1592).

Transforming data from an Access Point
Here are some examples where data transforming tasks are used right at the beginning of a
workflow that is started by an Access Point:

• The external system provides a list of jobs to be processed under the form of a large XML
that it writes on the Folder Access Point. The Split XML file  task then creates 1 XML file
per job entry. These separate XML files are then used for the Create Job task.

• The external system sends an CSV file on a Folder Access Point. The Map Data task first
transforms it into an XML. Later in the workflow, SmartNames will get their values by
reading from that XML file (Xpath queries).

• Some Access Points do not even result in data files yet. In case of a Database Access Point
or a Web Service Access Point, the accessed data can arrive as a several XML files. This is
where you can use the Join XML task to create a single and maybe even simpler XML file.
Again, that XML file is then typically the base to provide SmartNames their workflow specific
value.

1559



23 Automation Engine

Transforming data from a workflow
There are many moments where it can be necessary to transform Automation Engine
information. Typically when sending information to external systems. Some of these external
systems have their own mapping tools to read these incoming XMLs anyway. But sometimes
you will be asked to have Automation Engine transform this information first.

Some examples:

• The MIS can not read an XML file but can read CSV. This is a classic use case for the Map
data task.

• The XMP (metadata) of a PDF needs to be sent to the external system as an XML. The
LinkEdge task does that. But maybe the MIS wants to have the ink coverage information
formatted in a different way. And maybe it is also necessary to convert the millimeters into
inches.

• When using the Interact with Web Service task to ask the web service of Google Maps the
distance to a customer, the answer needs to end up in an XML or a SmartName.

• A Step & Repeat task requires a specific XML as input file, with a different structure than
the one from the external system.

• The Create Job task requires information that is present in 3 XMLs, from 3 different
sources.

• The XML with feedback that you want to send to the external system needs to contain both
a Job status and some meta data from the PDF.

23.2.4.  Automation Engine sending data Back to the External System

We briefly described this topic in the introduction (Automation Engine sending commands To an
External System on page 1554). Here, we add some detail and mention some tools.

A workflow in Automation Engine always generates output data, and often even many kinds.
A lot of that data is not just for other prepress components, but for external systems. We
distinguish 2 main types of data:

• Sending Prepress data (back)

• Data for output devices like proofers and RIPs (CTP, DFE, Press)
• Data for people, often customer service or sales people or end-customers (PDFs

attached in e-mail or sent via FTP)
• Data for external systems, some of which web-enabled, often to view, approve or

exchange 'assets'. In many cases it is not the original production files that are sent but
smaller versions (less Mb) or more secure versions like password protected PDFs (JPEGs,
RGB-PDFs, viewer streaming data, 3D files...)

• Sending Communication data (back).  Here, the goal is to inform. Some communication
will be about a status, for example 'plates made'. Some will be about describing the
(new) prepress data themselves, for example the ink coverage of a production PDF. This
communication data can also be files or it could be 'live':

• Communication files: XML, XMP-XML, CSV, TXT

• written on a network share, typically on a hot folder of the external system
• sent via e-mail or FTP
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• Communicating directly with the external system: (see also Automation Engine tasks
Interacting directly with the External System on page 1557.)

• directly to its database, writing or updating fields
• directly to the web service of the API of that external system

 

 

Transforming data before sending
Sometimes the external system does not support one of the above file formats or interaction
protocols. In those cases, the Map Data task can help to convert. Find an introduction to this
concept in Automation Engine Mapper tasks Transforming Data on page 1558.

Tip:  You do not always need to send a lot of Mb to send a lot of information. For example: an
XML describing de bar code parameters can be more useful than a high-res PDF. You could
zoom-in on the PDF but the XML will tell you even the non-visible parameters of that bar code
(type, bar width reduction, distortion...)

23.3.  Access Points
An Access Point launches a workflow after it detected a signal from 'outside'. Automation
Engine offers many types of Access Points. The most classic example is a Folder Access Point,
which is also often referred to as a 'hot folder'.

Tip:  We advise you to first read about the concept of Access Points.

The Access Points View and Tool
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The Access Points View (in the Views category Setup) is where you create, modify and have an
overview of your Access Points.
 

 
The top part of this view shows a list of all the Access Points that you configured.

The bottom part is a task monitor that shows the Tasks that were executed by the selected
Access Point.

Working with Access Points (the basics)

We here list the main functionality that is available in tool bar (or via the File menu). The next
pages add details per type of Access Point.

• : To create a new Access Point.

• : To duplicate an Access Point. The selected Access Point will open with empty fields for
Name and Description.

• : To delete a selected Access Point. You will be asked to confirm.

• : To 'scan now'. To manually make the selected Access Point scan for new files at that
time. This can be useful when you do not want to wait for the time interval (see further).

Note:  This function is disabled for the Web Service Access Point.

To modify an existing Access Point, select it from the list and double click it.

To deactivate  an Access Point, right-click it and choose Deactivate Access Point.

Differences in how they work
This table illustrates that some Access Points work in a slightly different way:

Table: Access Points - technical differences

Access Point Type Checks for data
at regular time

interval ('Polling')

Uploads that data Starts a workflow

Folder V V typically

FTP V V typically

SFTP V V typically
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Access Point Type Checks for data
at regular time

interval ('Polling')

Uploads that data Starts a workflow

Mail V V typically

Database V - (**) typically

Web Service - (*) - (***) always

Google Drive V V typically

OneDrive V V typically

Box V V typically

Amazon S3 V V typically

Esko Cloud V V typically

(*) The external system decides when to contact the Access Point.

(**) The Access Point goes to and gets info from an external database.

(***) The Access Point waits until it receives an HTTP command from the external system.

Access Point SmartNames

There is a specific category of SmartNames for Access Points. They enable smart re-use of
many attributes of an Access Point. All Access Point SmartNames are also automatically stored
as workflow parameters.

Learn more about SmartNames in the dedicated chapter SmartNames on page 591.

23.3.1.  Folder Access Point

Concept

What is a Folder Access Point?
A Folder Access Point monitors a folder located somewhere in an Automation Engine
Container. Every time one or more files are uploaded into that folder, the Folder Access
Point will move the files to another folder where they will be processed. Folder Access Points
are typically created to launch a workflow using those incoming files as input files for that
workflow.

However, you can also choose not launch a workflow. In that case the Access Point only serves
to upload files onto a specific folder in an Automation Engine Container.

Note:  The Folder Access Point is the folder itself, not any of its subfolders.

Tip:  The section Examples on page 1638 contains an example case of a Folder Access Point.
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Note:  Folder Access Points can also be used to process incoming JDF files. Learn more about
using JDF in What about JDF? on page 1555.

What about Hot Folders?
Before version 14 of Automation Engine, you could create Hot Folders. When you upgrade to
version 14, they will not be automatically migrated to Folder Access Points. They will stay hot
folders and will still function as they did before.

Note:  If you created hot folders in a version older than version 14, you will also keep your Hot
Folders view in the Pilot of your version 14. If you haven't created hot folders in Automation
Engine before upgrading to version 14, you will not see the Hot Folders view in the Pilot.

Tip:  When you (manually) convert a hot folder into a folder access point, you can use the
Export Ticket... button in the setup of the hot folder. You can then use that ticket in the setup
of the Folder Access Point.

The following options were previously available in hot folders but are not available in Folder
Access Points. This is because there are now other and better ways to do these actions:

• the annotation for the workflow task (you now write a 'description').
• grouped launching (you now can still create this effect by using a ZIP, but the most typical

use cases are covered when you use the Gang Run Printing related features).

• delete input files when the workflow is finished (you now can do this by using a Delete File
task at the end of your workflow).

Creating or modifying a Folder Access Point
Follow these steps to create or modify Folder Access Points:

1. In the Pilot click on Access Points view. Alternatively, chooseTools > Access Points.
2. In the dedicated Access Points view, click on . Alternatively, choose File > New.
3. In the resulting window, select Folder and click OK.

The New Folder Access Point window will open. Here is one with some typical settings
already filled in:
 

 
4. Enter a Name for the Access Point.
5. If you want, enter a Description.

This will help identifying your Access Point without having to read all its settings.
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6. In the tab Folder Settings, define which folder will be the actual Access Point that will be
monitored by Automation Engine. Use the browse button to indicate it.
This folder needs to be inside a Container. This folder may not be inside another Folder
Access Point.

7. In the tab Monitoring, define the time interval.

• Check Every. Enter the time interval with which Automation Engine should check if any
new files came in. Think of the time interval as the maximum time it takes for the new
files to be picked up.

• Schedule. If you want this Access Point to be inactive during a part of the day, then
activate this option and indicate the start and end time of that period.

Note:  Such a temporary inactive state will not be shown in the general Access Points
View. In that View, the column 'Active' shows its general status.

8. In the tab Automatic Actions, define what needs to happen.

• Move Files to. This is the folder where the files will be processed. These files have to be
moved to avoid that the Access Point  would process the same files again and again.

Important:  If this destination folder is part of a Job Folder, the workflow that this access
point launches will run in the context of that Job.

• Rename Files to. If you want you can choose to rename these files too. To do this, enter
the new file name.

Tip:  Typically, SmartNames are used here to help indicate in their name when they were
processed or where they came from.

• Action. Choose:

• None. Choose this option when you only want to use this Access Point to move the
files.

• Workflow. Choose this option when you want a workflow to start. Select the
workflow ticket from the offered list. The new accessed files will be used as input files
for this workflow. If these files are inside a Job Folder, the workflow will be run in the
context of that Job.

Attention:  Make sure your workflow can start with the type of files that will
arrive.

Options:

• Operator: Choose the operator that will be shown as operator for the workflow
task.

Tip:  If you do not want to assign one specific person, you could create an operator
named "Access Points" or "Automatic" and assign that one here. Also remember
that the Access Points Task Monitor shows you the tasks launched by the selected
Access Point.
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Note:  If you leave this option blank, a system user "UPLC" will be used.

• Priority: Choose the priority for this workflow: Low, Normal or High. The default
priority is 'Normal'.

• Process JDF: Choose this option when this Access Point will be used to process
incoming JDF files. For more info on JDF, read this section: What about JDF? on page
1555.

23.3.2.  FTP Access Point

Concept
An FTP Access Point monitors a folder on an FTP site. At a regular time interval, it checks
if new files have arrived in that folder and it then moves them to a specified folder in an
Automation Engine Container.

Note:  There is no FTP server embedded in Automation Engine, so this functionality relies on a
FTP server that has been setup separately from Automation Engine.

This also works for new files in any subfolders of the scanned FTP site. Those files will be
moved to an identical structure of subfolders that will be automatically created.

Note:  Non ASCII characters are not supported (ASCII = a-z, A-Z, 0-9).

An FTP access point can also start a workflow on those files.

After uploading them, the access point deletes these files from the FTP site. However, the
folders (and subfolders) are not deleted. This way, the folder structure of FTP site stays intact.

Note:  The Pilot also offers a manual way to upload files from an FTP site. When you right-click
on a folder or Job Folder, the function Upload from FTP site is offered. This FTP Access Point
is an automated version of that feature.

Creating or modifying an FTP Access Point
Follow these steps to create or modify FTP Access Points:

1. In the Automation Engine Pilot go to the Access Points View. Alternatively, choose Tools >
Access Points.

2. In the dedicated Access Points View, click on . Alternatively, choose File > New.
3. In the resulting window, select FTP and click OK.

The New FTP Access Point window will open. Here is one with some typical settings already
filled in:
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4. Enter a Name for the Access Point.
5. If you want, enter a Description.

This will help identifying your Access Point without having to read all its settings.
6. In the tab FTP Settings, define where and how you wish to connect.

• Server: Enter the name of the FTP server.

• File Transfer: Choose either Binary or ASCII.

Tip:  Binary will always work, but if you have an ASCII file, the transfer speed will be
higher when you choose ASCII.

• Connection Mode:

• Select Passive if there is a firewall between the FTP server and Automation Engine
that is blocking the FTP server from setting up connections to Automation Engine.

Tip:  By default, the FTP transfer uses Active Connection Mode (where the FTP server
opens the data connection). When Passive is selected, the system will use Passive
Connection Mode instead (where the client initiates the connection).

• Select Secure FTP if you are connecting to a secure FTP server (over FTPS, not SSL or
SSH). If you are experiencing problems using secure FTP, try connecting over regular
FTP and ask your IT administrator to check the security settings of your FTP server.

• Select UTF-8 Encoding to avoid encoding problems in file names. For example when
downloading file names with French characters onto a Chinese FTP server.
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• Advanced: Select Relax reply parsing to get FTP scanning working when it interacts
with an FTP server that does not fully comply to the communication standards when
replying.

The 'exception' error that this can solve will mention state a
MalformedServerReplyException: Truncated server reply: '220 ' and you
will see this message “ the remote FTP server malformed a reply “

• User Name  and Password: Enter a valid user name and password for this FTP server.

• Folder: This is the folder on the FTP server that will be monitored. As mentioned in
Concept on page 1566, also its subfolders will be monitored.

• Customer: If you want to link a specific customer to this Access Point, use Select to pick
it from the list. Then you can use it as a SmartName.

7. In the tab Monitoring, define the time interval.

• Check Every. Enter the time interval with which Automation Engine should check if any
new files came in. Think of the time interval as the maximum time it takes for the new
files to be picked up.

• Schedule. If you want this Access Point to be inactive during a part of the day, then
select this option and indicate the start and end time of that period.

Note:  Such a temporary inactive state will not be shown in the general Access Points
View. In that View, the column 'Active' shows its general status.

8. In the tab Automatic Actions, define what needs to happen.

• Move Files to.

• Folder. Indicate where you want the files to be moved to. Browse to a folder in a
Container.

Important:  If this destination folder is part of a Job Folder, the workflow that this
access point launches will run in the context of that Job.

• Customer's Upload Folder. Alternatively, you can choose to move these files to the
Customer's Upload Folder. This is a folder you can define in the definition of the
Customer.

• Rename Files to. If you want you can choose to rename these files too. To do this, enter
the new file name.

Tip:  Typically, SmartNames are used here to help indicate in their name when they were
processed or where they came from.

• Action. Choose:

• None. Choose this option when you only want to use this Access Point to move the
files.
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• Workflow. Choose this option when you also want a workflow to start. Select the
workflow ticket from the offered list. The new accessed files will be used as input files
for this workflow. If these files are inside a Job Folder, the workflow will be run in the
context of that Job.

Attention:  Make sure your workflow can start with the type of files that will
arrive.

Options:

• Operator: choose the operator that will be shown as operator for the workflow
task.

Tip:  if you do not want to assign one specific person, you could create an operator
named "Access Points" or "Automatic" and assign that one here. Also remember
that the Access Points Task Monitor shows you the tasks launched by the selected
Access Point.

• Priority: choose the priority for this workflow: Low, Normal or High. The default
priority is 'Normal'.

• Process JDF. Choose this option when this Access Point will be used to process
incoming JDF files. For more info on JDF, read What about JDF? on page 1555.

23.3.3.  SFTP Access Point

Concept

An SFTP Access Point monitors a folder on an SFTP site. At a regular time interval, it checks
if new files have arrived in that folder and then moves them to a specified folder in an
Automation Engine Container.

This also works for new files in any subfolders of the scanned SFTP site. By default, those files
will be moved to an identical structure of subfolders that will be automatically created (learn
more options below).

After downloading them, the access point deletes these files from the SFTP site. The folder
structure on the SFTP site is kept.

An SFTP access point can also start a workflow on those files.

There is also a task that serves to upload files from within a container to such an SFTP site.
Learn more in Upload via SFTP  on page 1590.

Note:  The difference between SFTP and FTP(S):

FTPS (secure FTP) is the FTP protocol on top of SSL (similar to how HTTPS is the SSL secure
version of HTTP). Do not confuse FTPS with SFTP, which uses SSH (secure shell). SFTP is seen
as more reliable and secure and can also solve issues with firewalls. Learn more in this online
article describing the difference between FTPS and SFTP.
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Creating or modifying an SFTP Access Point

Most steps and options are equal to those described for an FTP Access Point. When creating
one, select the type SFTP.

In the setup dialog, click Configure... for direct access to the SFTP sites item in the Configure tool.
This configure item is where you manage the specifics of the SFTP authentication.

Creating and Copying Folder names

In many cases, not just the name of the file is interesting, but also the place where it was
stored on the SFTP server. It might therefore be useful to re-use (parts of) that folder structure
on the Automation Engine container. The folder names can also contain many other forms of
information: their name might reflect the customer name, job order ID, production category,
etc.

Learn about how to re-use the names of those remote folders and combine them with
SmartNames in this section describing the same possibilities for the cloud storage access points.

.

File and Folder Name Limitations
• Windows' "reserved characters" are not supported, nor in the name of the destination folder

nor in the names of the files that you download. See their list here.

• Non ASCII characters (ASCII = a-z, A-Z, 0-9) are only supported if the SFTP server you are
downloading from uses UTF8 encoding.

23.3.4.  Mail Access Point

Concept
A Mail Access Point scans an e-mail account and extracts the e-mail attachments of new
incoming e-mail. These files are uploaded to a folder in a Container. A Mail Access Point can
also start a workflow on those files.

Here are 2 typical examples of how Mail Access Point SmartNames can help you do even
more:

• You can agree with the e-mail sender to start the subject line with the Job number. This
helps you direct these files to the right folder.

• The address of the e-mail sender can be used to later send him an e-mail back about the
status of the files he sent.

Creating or modifying a Mail Access Point
Follow these steps to create or modify Mail Access Points:

1. In the Pilot click on Access Points view. Alternatively, choose Tools > Access Points.
2. Click on  to create a new Access Point. Alternatively, choose File > New.
3. In the resulting window, select Mail and click OK.
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The New Mail Access Point window will open up. An example:
 

 
4. Enter a Name for the Access Point.
5. If you want, enter a Description.

This will help identifying your Access Point without having to read all its settings.
6. Define the Mail Settings:

Some examples:
 

 

• Incoming Mail Server: Enter the name of the mail server.

• Account Type: Depending on the mailbox configuration, choose either POP or IMAP.
See examples of both in above screenshots.

• Secure Mail: Select this if the mailbox is a secure type.

• User Name and Password: Enter the user name and password of the mail account that
will receive the e-mails that you want to access.

• Customer: If you want to link a specific customer to this Access Point, use Select to pick
it from the list. You can then use it as a SmartName.

7. In the tab Monitoring, define the time interval.
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• Check Every. Enter the time interval with which Automation Engine should check if any
new files came in. Think of the time interval as the maximum time it takes for the new
files to be picked up.

• Schedule. If you want this Access Point to be inactive during a part of the day, then
activate this option and indicate the start and end time of that period.

Note:  Such a temporary inactive state will not be shown in the general Access Points
View. In that View, the column 'Active' shows its general status.

8. In the tab Automatic Actions, define what needs to happen.

• Move Files to.

• Folder. Indicate where you want the files to be moved to. Browse to a folder in a
Container.

Important:  If this destination folder is part of a Job Folder, the workflow that this
access point launches will run in the context of that Job.

• Customer's Upload Folder. Alternatively, you can choose to move these files to the
Customer's Upload Folder. This is a folder you can define in the definition of the
Customer.

• Rename Files to. If you want you can choose to rename these files too. To do this, enter
the new file name.

Tip:  Typically, SmartNames are used here to help indicate in their name when they were
processed or where they came from.

• Action. Choose:

• None. Choose this option when you only want to use this Access Point to move the
files.

• Workflow. Choose this option when you want a workflow to start. Select the
workflow ticket from the offered list. The new accessed files will be used as input files
for this workflow. If these files are inside a Job Folder, the workflow will be run in the
context of that Job.

Attention:  Make sure your workflow can start with the type of files that will
arrive.

Options:

• Operator: choose the operator that will be shown as operator for the workflow
task.

Tip:  if you do not want to assign one specific person, you could create an operator
named "Access Points" or "Automatic" and assign that one here. Also remember
that the Access Points Task Monitor shows you the tasks launched by the selected
Access Point.
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• Priority: choose the priority for this workflow: Low, Normal or High. The default
priority is 'Normal'.

• Process JDF. Choose this option when this Access Point will be used to process
incoming JDF files. For more info on JDF, read this section: What about JDF? on page
1555.

23.3.5.  Database Access Point

Concept
A Database Access Point  reads, at a regular time interval, information from an external
database. That information is written into one or more XML files. The Database Access Point 
can also start a workflow.

A typical use case is checking an external system for a new status. That new status will be a
reason for Automation Engine to start an action. For example: in that external database, when
the status of a Job or Product is found on "preflight required", Automation Engine starts a
preflight workflow. Or the output tasks will be started for all jobs that are found in a status
"Jobs to expose".

Tip:  The chapter Examples on page 1638 contains an example case of a Database Access
Point.

To prevent that these statuses keep triggering these actions over and over again, the Database
Access Point offers the choice to update or delete those (status) fields. For example: the status
"Proof required" would be updated to "Proof started on Esko".

These use cases are often identical to those where an external system sends an XML file to
Automation Engine. Here are some typical reasons to use a Database Access Point instead of
such an XML transfer:

• The external system can not export the wanted data to XML. Or it would require an
expensive intervention or an upgrade of the software version.

• Exporting an XML would be a manual action by a user of that external system. And all
manual actions can be forgotten.

Creating or modifying a Database Access Point
Follow these steps to create or modify a Database Access Point:

1. In the Pilot click on Access Points view. Alternatively, choose Tools > Access Points.
2. Click on  to create a new Access Point. Alternatively, choose File > New.
3. In the resulting window, select Database and click OK.

The New Database Access Point window will open up. Here is one with some typical
settings already filled in:
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4. Enter a Name for the Access Point.
5. If you want, enter a Description.

This will help identifying your Access Point without having to read all its settings.
6. Define the Database Settings:

• External Database: Select the database from the list. The list shows the External
Databases that you configured via Tools > Configure.

• Enter the desired SQL Select Query: The query will search for records or it will search
specific values in one or more columns. An XML file will be generated for each record
that matches the query.

Here is an example of a such an XML file. The query was looking for more info on Jobs
with the status 'New'. This XML shows the resulting details of the Job 1213. See how the
'Select *' returned all the columns of the row of this Job 1213: name, operation etc...

?xml version="1.0" encoding="UTF-8?>
<design select="SELECT * FROM design WHERE status = "NEW"" producer="DBPoller-
MIS-1" created="2013-04-24T11:26:14.210+02:00">
    <id>1213</id>
    <name>MyDesign</name>
    <operation>CreateJobCard</operation>
    <width>12</width>
    <height>500</height>
    <depth>50</depth>
    <status>NEW</status>
</design>
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Note:  As soon as you select a Database Access Point, the query will be checked if it is
valid. If it is not valid, an error message will be shown.

• After Processing: Now choose what should happen after the results from the
query were processed.

• Delete the records: This will delete the records that the query selected in the
external database. It will make them empty.

• Update the records: This will update the records that the query selected in the
external database with a new value. Click on Add to update the desired parameters.
Fill in the Column Name and the New Value in that database column and click OK.

Note:  If you want to update a record that contains a date and/or time, use the
format yyyyMMddHHmmss for the new value of the column or use now to insert the
date and time of the moment that the record is updated.

7. In the tab Monitoring, define the time interval.

• Check Every. Enter the time interval with which Automation Engine should execute this
database query.

• Schedule. If you want this Access Point to be inactive during a part of the day, then
activate this option and indicate the start and end time of that period.

Note:  Such a temporary inactive state will not be shown in the general Access Points
View. In that View, the column 'Active' shows its general status.

8. In the tab Automatic Actions, define what needs to happen.

• Move Files to. Indicate where you want the resulting XML file(s) to be written. Browse to
a folder in a Container.

Important:  If this destination folder is part of a Job Folder, the workflow that this access
point launches will run in the context of that Job.

• Rename Files to. If you want you can choose to rename these files too. To do this, enter
the new file name.

Tip:  Typically, SmartNames are used here to help indicate in their name when they were
processed or where they came from.

• Action. Choose:

• None. Choose this option when you want no further action.

• Workflow. Choose this option when you also want a workflow to start. Select the
workflow ticket from the list. If these files are inside a Job Folder, the workflow will be
run in the context of that Job.
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Attention:  Make sure your workflow finds its input files. These can be the
XML files from the query but that is not required.

Options:

• Operator: choose the operator that will be shown as operator for the workflow
task.

Tip:  if you do not want to assign one specific person, you could create an operator
named "Access Points" or "Automatic" and assign that one here. Also remember
that the Access Points Task Monitor shows you the tasks launched by the selected
Access Point.

• Priority: choose the priority for this workflow: Low, Normal or High. The default
priority is 'Normal'.

23.3.6.  Web Service Access Point

Concept
When a system has a web service, other software applications can send commands or queries
to that system by using HTTP requests to the URL of the web service.

Note:  This type of communication is a solution when the two systems you can not exchange
(XML) files on hot folders. This is the case when the two systems are not in the same LAN or
can't use shared folders due to security limitations.

Automation Engine also has a web server. A Web Service Access Point is a way for external
systems to start workflows on Automation Engine by sending a command to the web service of
Automation Engine.

Tip:  In this section on differences between Access Points, you can read how a Web Service
Access Point works somewhat different than the other types of Access Points. One important
difference is that the Web Service Access Point does not use the concept of time intervals. It
is the external system that fully decides when to send a command to Automation Engine.

The HTTP requests can be both HTTP POST requests and HTTP GET requests. If the HTTP POST
request also 'posts' data files, then they will be used as input files for the workflow that will be
started.

Note:  When using a HTTP GET request, parameters of the web service call are encoded in the
URL using HTTP query strings. When using HTTP POST requests, the parameters are encoded
in the content part of the HTTP request.

Note:  Automation Engine also offers tasks that can convert JSON data into XML and vice versa.
Learn more in Convert JSON to XML task on page 1593 and in Convert XML to JSON task on page
1595.
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Configuring and Checking the Automation Engine Web Service

Purpose

The web service of Automation Engine will be running automatically on the Automation Engine
server.

Note:  This web service is also used when you access the Automation Engine Server Web Page in
a browser.

You can check the status of the Automation Engine Web Service by entering this in a browser:
http://<name of your server>:<port>/ws/ . The port number is the one as defined in the Configure
tool > Automation Engine Web Service. By default this port number is 4415.

For example: If your Automation Engine server is named AESERVER1, then the URL to enter in
your browser is http://aeserver1:4415/ws/ .

The web page that then appears offers more guidelines on formatting more detailed HTTP
commands.

Security

To obtain more security, communicating with a Web Server can be encrypted. Encryption is
done using the private key of a certificate. Decryption is done using the public key of a
certificate.

Another way to obtain more security when communicating with a Web Server is to require
authentication to get access to certain services. This means that one must prove that he is who
he claims to be.

Settings

You have the choice to enable HTTP and/or to enable HTTPS. Usually, only one of the two is
chosen.
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• Enable HTTP

• Enter the correct Port number.

• Click Test Connection to test it. The opens the default browser and issues a HTTP-GET
command to the context of the Access Points. If the HTTP-GET succeeds, an HTTP-POST
will most likely also be possible.

• Enable HTTPS

HTTPS creates a secure channel over an insecure network. Learn more on this wiki-page.

• Enter the correct Port number.

• SSL Certificate (mandatory option): This is the official certificate that will do the
encryption. The name mentioned here is its 'friendly name'. This official certificate
must be imported in 'Windows Certificate Manager' (certmgr.msc) in the 'Personal-
Certificates' for the 'Service Account' of the (Master) Automation Engine server. This is
typically the user 'BGSystem'.

Note:  To learn more on how to import a certificate in Windows Certificate Manager,
consult the Microsoft documentation corresponding to your OS version.

Attention:  Automation Engine only supports the usage of officially trusted
certificates (as signed by and to be bought from a Certificate Authority (CA) and to
be imported in the Windows Certificate Manager.

• Click Test Connection to test it. This opens the default browser and issues a HTTP-GET
command to the context of the Access Points.

If the HTTP-GET succeeds (SSL-Handshake + Authentication if configured), an HTTP-POST
will most likely also be possible.

For HTTPS, the FQDN (fully qualified domain name) for the AE master server is calculated
(DNS) and used in an attempt to use a host name that better matches the certificate.

• Authentication: Choose here whether the web service requires an authentication.
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• No authentication.

• "Automation Engine" authentication. In this case, users must authenticate with the
'AE LogonServer'. This means they need to use the same credentials as when they log
on to the Pilot. User names should adhere to this form: user@aeserver, For example
admin@AEserver01.

Note:  Only the 'BASIC' HTTP authentication protocol is supported.

Creating a Web Service Access Point

Note:  Setting up a Web Service Access Point is simple. The complexity lies in the content of
the HTTP requests that are sent to it (see next pages).

Follow these steps to create a Web Service Access Point:

1. In the Pilot click on Access Points view. Alternatively, choose Tools > Access Points.
2. Click on  to create a new Access Point. Alternatively, choose File > New.
3. In the resulting dialog, select Web Service and click OK.

The New Web Service Access Point dialog will open up. Here is one with some typical
settings already filled in:
 

 
4. Enter a Name for the Access Point.

This name will automatically be used to complete the URL for this Access Point.
5. If you want, enter a Description.

This will help identifying your Access Point without having to read all its settings.
6. See the resulting URL. This is where the external system needs to send its command to

launch the workflow defined below.
7. Select the Workflow that this Access Point will start.
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Options:

• Operator: choose the operator that will be shown as operator for the workflow task.

Tip:  If you do not want to assign one specific person, you could create an operator
named "Access Points" or "Automatic" and assign that one here. Also remember that the
Access Points Task Monitor shows you the tasks launched by the selected Access Point.

• Priority: choose the priority for this workflow: Low, Normal or High. The default priority
is 'Normal'.

8. In Communication, define if you want this Access Point to use synchronous
communication.

• When the web service is asynchronous, the workflow is added to the tasks queue like
any other workflow that is started manually or automatically. The web service responds
to the caller immediately after adding the workflow to the queue with a standard
message mentioning the task-id of the queued workflow. The web service will not wait
for the workflow to execute and finish. See some examples of such a response in HTTP
Responses on page 1584.

• When the web service is synchronous, the web service only responds to the caller
when the workflow is finished. In this case the response is the result of that workflow, its
output files. See some examples of such a response in HTTP Responses on page 1584.

Main benefit here is that the user of the external system (the caller) gets a fast response
with the file(s) or information he asked for. For example: the user of the external system
selects an ArtiosCAD design and asks Automation Engine to calculate a specific sheet
layout. Seconds later, this user sees the detailed information about the resulting sheet
because his system read the metadata of the MFG that the workflow created. This then
helps the user to calculate the cost of this type of layout.

Attention:  One or more of the Automation Engine server's processing channels
should be reserved for processing these incoming HTTP requests. This avoids that
the response is delayed because of other tasks. Learn more in the Automation
Engine Server Web Page, in the Server Setup page of the section Server Admin.

Timeout: When the external system has not received a response after this time, the
workflow will be cancelled.

HTTP POST Requests

Launching a workflow using an HTTP POST request

The HTTP POST requests must meet the following requirements:

• The value of the Content-Type header of the HTTP POST request should be, in most cases,
multipart/form-data.

• HTTP request parts can be added to the HTTP POST requests to attach data files and/or to
add parameters (also see further).

• For every HTTP request part that is added to an HTTP POST request, a Content-Disposition
header should be present.
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• For each data file, the (UTF-8 encoded) file name of the data file should be specified in
the corresponding Content-Disposition header.

• For each parameter, the name of the parameter should be specified in the
corresponding Content-Disposition header.

• The encoding of the HTTP POST requests should be base64 or no encoding (for example
binary, 8bit,…).

For example:

POST /ws/myFavoriteWorkflow HTTP/1.1
Host: aeserver01:4415
Content-Type: multipart/form-data; boundary=----------------------146677a63ef
Content-Length: <length of request body in octets (8-bit bytes)>
...  
----------------------146677a63ef
Content-Disposition: form-data; name="wfparam1"
 
2mm
----------------------146677a63ef
Content-Disposition: form-data; name="wfparam2"
 
4mm
----------------------146677a63ef
Content-Disposition: form-data; name="inputfile1"; filename="inputfile1.pdf"
Content-Transfer-Encoding: binary
 
<binary contents of inputfile1.pdf>
----------------------146677a63ef
Content-Disposition: form-data; name="inputfile2"; filename="inputfile2.pdf"
Content-Transfer-Encoding: binary
 
<binary contents of inputfile2.pdf>

Attaching data files to be used as input files for the workflow that is
launched

You can attach data files to be used as input files for the workflow that is launched by adding
them as HTTP request parts to the HTTP POST request. For each data file, the (UTF-8 encoded)
file name of the data file should be specified in the corresponding Content-Disposition
header.

For example:

POST /ws/myFavoriteWorkflow HTTP/1.1
Host: aeserver01:4415
Content-Type: multipart/form-data; boundary=----------------------146677a63ef
Content-Length: <length of request body in octets (8-bit bytes)>
... 

----------------------146677a63ef
Content-Disposition: form-data; name="inputfile1"; filename="inputfile1.pdf"
Content-Transfer-Encoding: binary 

<binary contents of inputfile1.pdf>
...

When the workflow is launched, the data files are handled in one of the following ways:

• When the workflow is launched in a specific Job, the data files will be moved to the Job
Folder.

• When the workflow is not launched in a specific Job and the workflow is successfully
finished, the data files will be deleted.
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• When the workflow is not launched in a specific Job and the workflow did not finish
successfully, the data files will be kept in this shared folder:

\\<name of your server>\AutomationEngineTmpFolder

When no data files are attached to the HTTP POST request, the Web Service Access Point will
generate an XML file containing some information about the HTTP GET request. This XML file
will then be used as input file for the workflow to be launched and will be handled in the same
way as attached data files would be handled.

Launching a workflow with only a single input file ('PLAIN POST')

Since AE 16.1, you can also POST a PLAIN file, rather than a 'multipart' post containing the
file(s).

For example:

POST /ws/myFavoriteWorkflow HTTP/1.1
Host: aeserver01:4415
Content-Type: text/xml
Content-Length: <size of inputfile>

<binary contents of inputfile>

Launching a workflow in a specific Job

You can specify the Job in which the workflow should be launched by adding parameters
as HTTP request parts to the HTTP POST request. The name of each parameter should be
specified in the corresponding Content-Disposition header.

The Job in which the workflow should be launched can be specified using the Job ID, the
Job Name, the Order ID or using both the Order ID and the Sub Order ID. The parameters
you need to add as HTTP request parts to the HTTP POST request are, respectively, jobid,
jobname, orderid or orderid and suborderid . The values for these parameters should be
UTF-8 encoded.

For example:

POST /ws/myFavoriteWorkflow HTTP/1.1
Host: aeserver01:4415
Content-Type: multipart/form-data; boundary=----------------------146677a63ef
Content-Length: <length of request body in octets (8-bit bytes)>
...
  
----------------------146677a63ef
Content-Disposition: form-data; name="orderid"
 
2014-100254
...

Specifying the values of the workflow parameters of the workflow that is
launched

You can also set the values of the workflow parameters of the workflow by adding parameters
as HTTP request parts to the HTTP POST request. These parameters should have the same
names as the names of the workflow parameter(s) which value you want to set. The values for
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these parameters should be UTF-8 encoded . For each parameter, the name of the parameter
should also be specified in the corresponding Content-Disposition header.

For example:

POST /ws/myFavoriteWorkflow HTTP/1.1
Host: aeserver01:4415
Content-Type: multipart/form-data; boundary=----------------------146677a63ef
Content-Length: <length of request body in octets (8-bit bytes)>
...
  
----------------------146677a63ef
Content-Disposition: form-data; name="wfparam1"
 
2mm
...

HTTP GET Requests

Launching a workflow using an HTTP GET request

When using HTTP GET requests to launch workflows on a Web Service Access Point, no data
files can be attached.

Every time an HTTP GET request is received on the URL of the Web Service Access Point, it will
generate an XML file containing some information about the HTTP GET request. This XML file
can then be used as input file for the workflow to be launched.

• When the workflow is launched in a specific Job, this XML file will be moved to the Job
Folder.

• When the workflow is not launched in a specific Job and the workflow is successfully
finished, this XML file will be deleted.

• When the workflow is not launched in a specific Job and the workflow did not finish
successfully, this XML file will be kept in this shared folder:

\\<name of your server>\AutomationEngineTmpFolder

Launching a workflow in a specific Job

You can specify the Job in which the workflow should be launched by adding parameters to
the query string of the HTTP URL. The Job in which the workflow should be launched can
be specified using the Job ID, the Job Name, the Order ID or using both the Order ID and
the Sub Order ID. The parameters you need to add to the query string of the HTTP URL
are, respectively, jobid, jobname, orderid or orderid and suborderid. The values for these
parameters should be UTF-8 encoded.

For example:

http://aeserver01:4415/ws/myFavoriteWorkflow?jobid=ee6b08ca-eecf-4cb7-b2e1-254c20d82546
http://aeserver01:4415/ws/myFavoriteWorkflow?jobname=Libelle-2014-week12
http://aeserver01:4415/ws/myFavoriteWorkflow?orderid=2014-100254
http://aeserver01:4415/ws/myFavoriteWorkflow?orderid=2014-100255&suborderid=001

Specifying the values of the workflow parameters of the workflow that is
launched
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You can also set values for workflow parameters by adding parameters to the query string of
the HTTP URL. These parameters should have the same names as the names of the workflow
parameter(s) which value you want to set. The values for these parameters should be UTF-8
encoded .

For example:

http://aeserver01:4415/ws/myFavoriteWorkflow?wfparam1=2mm
http://aeserver01:4415/ws/myFavoriteWorkflow?wfparam1=2mm&wfparam2=4mm
http://aeserver01:4415/ws/myFavoriteWorkflow?jobname=Libelle-2014-week12&wfparam1=2mm

HTTP Responses

Attention:  When using a Web Service Access Point, the corresponding HTTP
responses should always be checked because they can contain error messages.

As mentioned earlier, the response is different if the communication is synchronous or
asynchronous.

Asynchronous Communication Responses

• In case the workflow was successfully launched, the HTTP response will contain the task ID
of the workflow task that was launched.

An example:

<?xml version="1.0" encoding="UTF-8"?>
<message>
    <response>taskid=dd145a15-49bb-4625-a0da-6d3aee663ae3</response>
</message>

• In case the workflow could not be launched successfully and/or an error occurred, the HTTP
response will contain one or more error messages.

An example where the workflow ticket could not be found:

<?xml version="1.0" encoding="UTF-8"?>
<message>
    <error>
        <code>-110</code>
        <msg>Problem loading ticket: swft/Web Service Access Point Test WF</msg>
    </error>
</message>

Synchronous Communication Responses

The response depends on what the workflow created:

• When the workflow task created one file, it will return that one file. An example of such
a response where one PDF was created (see the response header as captured from a
browser's "network traffic" view after launching the call from that browser):
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• When the workflow task created multiple files, it will return a MIME file containing them. An
example of such a response:
 

 

• When the workflow task did not create any output files (in an OK status), the response
mentions this as a remark:

<message>
 <response>taskid=def75756-ad52-42ac-829e-93a7a90d2741
          <remark>WorkFlow produced no OK-outputs.</remark>
 </response>
</message>

23.3.7.  Esko Cloud Access Point

This type is described in the chapter "Collaborating via Esko Cloud  on page 1471".

Find a direct link here.

23.3.8.  Cloud Storage Access Points

Concept and Generic Options

Concept
A cloud storage access point scans a folder "in the cloud" and downloads (moves) any new
files that appear in that folder or its subfolders onto a folder inside an Automation Engine
Container. The downloaded files are removed from the cloud storage. The access point can
also start a workflow on those files.

Note:  There is also a task that can upload data from within an Automation Engine container to
such a cloud storage folder.

Attention:  Windows' "reserved characters" are not supported, nor in the name of the
destination folder nor in the names of the files that you download. Learn more here.

Automation Engine supports these cloud storage providers: Box, Google Drive, OneDrive and
Amazon S3.

Attention:  OneDrive for Business is not supported.

Before you can use such an access point, you need to configure one or more account
authorizations in the Configure tool.
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Generic Options
We here illustrate the options that most providers have in common. Any specifics per provider
are mentioned in their dedicated pages hereafter.

• The first steps to create a cloud storage access point are very similar to creating any other
access point. See an example of the detailed steps in the first 5 steps of this page.

• In the Settings tab of the provider:

• Account. Choose an account from the list that you first added in the Configure tool. Only
the accounts for the selected provider are shown. Click Configure to see or create that
configuration.

• Folder. By default, this is the account's home directory. Remember that subfolders of
the specified folder are also scanned. When you do not want all these folders scanned,
you can specify a subfolder, for example " /PrePressData". Then, only all data in that
folder and its subfolders will be scanned.

Learn more below about options to use or replace (parts) of this path in the destination
path.

• In the tab Monitoring: These options are identical to those explained here.

• In the tab Automatic Actions: Downloaded files with a same name are overwritten. The
options are identical to those explained here.

Creating and Copying of Folder Names

In many cases, not just the name of the file is interesting, but also the place where it was
stored on the cloud storage. It might therefore be useful to re-use (parts of) that folder
structure on the Automation Engine container. The folder names can also contain many other
forms of information: their name might reflect the customer name, job order ID, production
category, etc.

An example: we assume the following situation and then illustrate several possibilities in the
below table:

• On the cloud storage, the home directory of the used account contains " SuperBeer/
bottle/blond33.pdf  "

• We want to move the new found files onto " file://AEserver/Data1/FromTheCloud ".

• You can use " /@-<number> " to specify how many cloud storage folder levels you do not
want to copy from the cloud path onto the new one. To make sure you do not copy any
parts at all of the cloud path, you can for example enter " /@-99 ".

Table: Different cases based on above example:

"Folder" in the
tab "<provider>
Settings"

"Move Files To" in the tab
"Automatic Actions"

Result

empty or " / " file://AEserver/Data1/
FromTheCloud

file://AEserver/Data1/FromTheCloud/
SuperBeer/bottle/blond33.pdf

" /@-1 " file://AEserver/Data1/
FromTheCloud

file://AEserver/Data1/FromTheCloud/bottle/
blond33.pdf

" /@-2 " file://AEserver/Data1/
FromTheCloud

file://AEserver/Data1/FromTheCloud/
blond33.pdf
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"Folder" in the
tab "<provider>
Settings"

"Move Files To" in the tab
"Automatic Actions"

Result

" /@-2 " file://AEserver/Data1/
FromTheCloud/ [First Folder
of File]

file://AEserver/Data1/FromTheCloud/
SuperBeer/blond33.pdf

" /@-2 " file://AEserver/Data1/
FromTheCloud/ [Folder of
File]

file://AEserver/Data1/FromTheCloud/bottle/
blond33.pdf

Note:  Above example is also valid for the FTP and SFTP access points.

Google Drive Access Point
 

 

The options for a Google Drive access point are identical to those for the other cloud storage
providers.

Learn more in the section Generic Options on page 1586.

Box Access Point
 

 

The options for a Box access point are identical to those for the other cloud storage providers.

Learn more in the section Generic Options on page 1586.

OneDrive Access Point
 

 

The options for a OneDrive (Personal Cloud Storage) access point are identical to those for the
other cloud storage providers.

Learn more in the section Generic Options on page 1586.

Attention:  OneDrive for Business is not supported.
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Amazon S3 Access Point
 

 

Many options for an Amazon S3 access point are identical to those for the other cloud storage
providers. Learn more in the section Generic Options on page 1586.

The tab 'Amazon S3 Settings' contains an extra option 'Bucket'. This is Amazon's term for
"root folder".

• Bucket: This is a mandatory field to define the root folder. All subfolders will
be scanned, unless you define another folder in the option below. Example:
Pharmadata.Chicago.Superprint.

• Folder: When you here specify a folder (one that resides in the Bucket defined above), then
that is the one will be scanned (and all it subfolders).

23.3.9.  SAP Access Point

The SAP access point and the Interact with SAP task serve to integrate with an ERP system
from SAP.

Such integrations are managed through assistance from Esko Solution Services.

23.4.  Upload tasks

These tasks enable to upload data from within an Automation Engine Container to an FTP site
or to a cloud storage (application).

Before you can use these, you need to configure their connection in the Configure tool.

23.4.1.  Upload via FTP

This task allows to upload files to a folder on an FTP server. You need to have an FTP account
on that server. You can use the task to send the files to more than one FTP location.

1. In the task ticket, click New... to define a location. The Edit FTP Location dialog pops up.
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2. Connection:

• Host: the name of the server you want to send your files to.

Tip:  To use a port other than the default port, add : and the port number after the host
name. For example: myftpserver:1085

• Folder: Specify a FTP folder. When this field is empty, the files will be stored on the
default directory.

Tip:  Using SmartNames to help you to organize the arriving data.

• Connection Timeout: (By default 30.000 milliseconds).You only need to increase this
value if you are working on a slow network and keep getting time out errors.

• Secure FTP: Select this if you are connecting to a secure FTP server (over FTPS)

Tip:  If you are experiencing problems using secure FTP, try connecting over regular FTP,
and ask your IT administrator to check the security settings of your FTP server.

Tip:  FTPS (secure FTP) is the FTP protocol on top of SSL (similar to how HTTPS is the SSL
secure version of HTTP). Do not confuse FTPS with SFTP, which uses SSH (secure shell).
Uploading files via SFTP is therefor a different task, which is more reliable and can also
solve issues with firewalls.

• UTF-8 Encoding: Select this to avoid encoding problems in file names. For example when
sending French file names to a Chinese FTP server.

3. Enter the User name and password that allows you to connect to that FTP server:
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Tip:  To avoid that you have to change this ticket every time the password (and user name)
changes, it might be useful to use SmartNames. This help for example when the user name
and password is stored centrally and when SmartNames can retrieve their value via an SQL
query.

4. File uploading settings:

• File Transfer: Binary will always work, but if the file(s) you send are ASCII file(s), then the
transfer will go a bit faster when selecting ASCII.

• If File Exists:

• Overwrite and give warning: The file will be overwritten, but the tasks finishes in the
state Warning.

• Overwrite: This will just overwrite the file and the tasks finishes OK.

• Generate a unique file name: This will append the task ID to the file name, and
store the file at the destination under its unique name.

• Generate an error: The file will not be sent, the task will fail.

• Connection Mode: By default, the transfer uses Active connection mode (where the FTP
server opens the data connection).

When your system is behind a firewall that blocks incoming FTP server connections,
select Passive connection mode (where the client initiates the connection).

23.4.2.  Upload via SFTP

Concept
This task uses SFTP to upload files from within an Automation Engine Container to a folder
on a host that runs an SSH-Server. When a file already exists on the destination folder, it is
overwritten.

Note:  IT security may require that you use this protocol i.s.o. FTP(S). Learn more in this online
article describing the difference between FTPS and SFTP.

Attention:  The task takes care of the client side. Esko does not provide information on
how to set up an SSH server.

Note:  SFTP is often used to send files to a Mac OS computer.

Settings
• Server: Select a configured SFTP server. Click Configure... to open the SFTP sites topic in the

Configure panel.

• Folder: When you leave this field empty, the files will be sent to the user's home directory.
When you specify a folder, it will be a subfolder of the user's home directory. Use a slash to
define extra subfolder(s), for example FromAE/pharma1 or include SmartNames: FromAE/
[Date]/[Job ID] or FromAE/[Date]/[Folder of File].
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Attention:

• Windows' "reserved characters" are not supported, nor in the name of the
destination folder nor in the names of the files that you upload. See their list here.

• Non ASCII characters (ASCII = a-z, A-Z, 0-9) are only supported if the SFTP server
you are uploading to supports UTF8 encoding.

• When the task is canceled, the task continues uploading the current file but does
not start uploading the next input file.

• Files with a size greater than 150 MB can not be uploaded reliably.

• If Folder Does Not Exist: When the destination folder does not exist,

• select Create Folder when you want to have it created. The same happens when you
Select a SmartName that returns the value "1".

• select Task Fails to not have it created and end the task in error. The same happens
when you Select a SmartName that returns the value "0".

23.4.3.  Upload To Cloud Storage

This task uploads files from within an Automation Engine Container to a folder on a cloud
storage service (Box, Google Drive or OneDrive).

Attention:  This task does not upload to Esko Cloud. Learn about the dedicated tasks
and tools in the chapter Collaborating via Esko Cloud  on page 1471.

Settings

• Account: Select the cloud storage account that you configured earlier. Click Configure... to
access that item in the Configure tool.

• Bucket (Amazon S3 only). This is a mandatory field to define the root folder. All subfolders
will be scanned, unless you define another folder in the option below. Example:
Pharmadata.Chicago.Superprint.

• Folder: Define the folder where you want to upload the files. When you leave this field
empty, the files are uploaded to the account's home directory.

Note:  (Amazon S3 only): When you here specify a folder (one that resides in the Bucket
defined above), then that is the one that will be scanned (and all it subfolders).

When you specify a folder, it will be a subfolder of the account's home directory.

Note:  Use a slash to define extra subfolder(s), for example FromAE/pharma1 or include
SmartNames: FromAE/[Date]/[Job ID] or FromAE/[Date]/[Folder of File] .
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Attention:

• This path needs to URL encoded. Windows' "reserved characters" are not supported,
nor in the name of the destination folder nor in the names of the files that you
upload. These characters are

• < (less than)
• > (greater than)
• : (colon)
• " (double quote)
• / (forward slash)
• \ (backslash)
• | (vertical bar or pipe)
• ? (question mark)
• * (asterisk)

• When the task is canceled, the task continues uploading the current file but does
not start uploading the next input file.

• Files with a size greater than 150 MB can not be uploaded reliably.

Attention:  When you upload a same file again to the same folder, the result
depends on the type of cloud storage application:

• Google Drive

• A new version is added.
• The 'Modified' date is the date of the uploaded file.

• Box

• A new version is added.
• The 'Modified' date is the date of uploading.

• OneDrive and Amazon S3

• The newly uploaded file overwrites the old file.
• The 'Modified' date is the date of uploading.

• If Folder Does Not Exist: When the destination folder does not exist,

• select Create Folder when you want to have it created. The same happens when you
Select a SmartName that returns the value "1".

• select Task Fails to not have it created and end the task in error. The same happens
when you Select a SmartName that returns the value "0".

23.5.  Data Transforming Tasks

We introduced the concept of these tasks in the chapter Automation Engine Mapper tasks
Transforming Data on page 1558.
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Attention:  These types of tasks require good knowledge of SmartNames.

Attention:  The XPath Builder makes it a lot easier to extract parts from XML files. This
tool is documented in a separate chapter on SmartNames.

23.5.1.  Convert JSON to XML task

Concept

JSON stands for 'JavaScript Object Notation'. Learn more on https://en.wikipedia.org/wiki/JSON or
http://www.json.org/fatfree.html.

When Automation Engine is to receive information from a web service, that application may
prefer to directly send JSON data to Automation Engine in stead of first converting it into the
more generic XML format.

The JSON file could be of the JSON 'Object' type or of the JSON 'Array' type. This task can
convert such JSON data into corresponding XML data, the format that Automation Engine has
many tools for.

Note:  When Automation Engine needs to send data to a web service, it can also convert XML
data to JSON data. Learn more in Convert XML to JSON task on page 1595.

JSON sample

• JSON Object: An 'object' starts and ends with '{' and '}'. Between them, a number of string
value pairs can reside. String and value is separated by a ':' and if there is more than one
string value pair, they are separated by ','.

Syntax:

{ key: value, .......}

Example:

{ "companyName": "Esko", "location": "Bangalore", "email":"admin@esko.com" }

In JSON, objects can nest 'arrays' (which start and ends with '[' and ']') within it. An example:

{ "Companies": [{ "Name":"Esko" ,"Location":"Bangalore" },
 { "Name":"Danaher" ,"Location":"US" } ] }

• JSON Array: An 'array' starts and ends with '[' and ']'. Between them, a number of values
can reside. If there is more than one value, they are separated by a ',' .

Syntax:

[ value, .......]
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An example:

[ 
     { "name": "Bidhan Chatterjee", "email": "bidhan@example.com"},
     {"name": "Rameshwar Ghosh","email": "datasoftonline@example.com"}
     ]

Task Options

• Root Element Name: Specify the name of the root element in the output XML. The default
value is "ROOT".

• Array Element Name: Specify the element name for each JSON array item in the output
XML. The default value is "ARRAY_ITEM".

The task will fail when the input XML file is not well formed.

The task automatically adds an extension .json to the output file. The output file will be in
UTF 8 format.

Workflow Example

There are several examples when Automation Engine can get a response from a web service in
JSON format.

One of them is the Interact with Web Service task. Its JSON output can so be converted to XML.
 

 
Also a Web Service Access Point could bring such JSON data.

Tip:  With that type of Access Point, it might be enough to type an inline JSONPath expression
to extract some (workflow) parameters. Learn more in JSONPath Expressions on page 755.

Conversion Example

See how the JSON (left) was converted to XML (right):
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23.5.2.  Convert XML to JSON task

Concept

JSON stands for 'JavaScript Object Notation'. Learn more on https://en.wikipedia.org/wiki/JSON.

When Automation Engine is to send information to an external web service, that application
may prefer to receive JSON data in stead of XML.

This task can convert XML into corresponding JSON data.

Note:  When Automation Engine is receiving JSON data from an external web service, it can also
convert JSON to XML. Learn more in Convert JSON to XML task on page 1593.

Task Options

This task offers no options.

Workflow Example

A typical workflow would be to convert XML to JSON right before sending it to the external web
application (using the Interact with Web Service task):
 

 

23.5.3.  Create XML File task

The Create XML File task is typically used to export value from SmartNames to an external
system.

Important:  This task does not use its task input file to start building the XML from. The
content of the XML that you will create is completely defined inside the task window.

Defining the content of the XML
The Create XML File task offers a blank canvas where you need to define all the content of the
XML that you want to create. In below example you see a combination of self written XML code
(blue) and some SmartNames (green). Click on + [ ] insert SmartName to pick a SmartName
from the list. Alternatively, right-click and choose a SmartName from the offered categories.
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Note:  The XML file has to start with an XML declaration. This line indicates the file encoding
to the reading application. To add such a line, you can simply right-click and choose
Insert XML Declaration to insert this industry default one: <?xml version="1.0"
encoding="UTF-8"?>

Note:  Any links to externally defined XML schema (for example a reference to a DTD or XSD)
may influence performance. Preferably remove such links from the XML file.

• Replace reserved characters in SmartName values with XML entities: It is possible
that the SmartName returns characters that are not allowed in XML. With this option, you
choose to map these special characters mapped into these 'XML entities'. Below list shows
these mappings:

Reserved characters in
result value

Meaning XML Entities

" quotation mark &quot;

' apostrophe &apos;

& ampersand &amp;

> greater than &gt;

< smaller than &lt;

 

• Task fails when output XML is not a valid XML file : Enable this option to have
Automation Engine check the validity of the XML. If this option is on, the task will fail if the
XML is not valid. The validation checks the XML formatting and the XML tag endings.
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Note:  This task does not check XML schemas such as XSD, DTD, etc.

23.5.4.  Map Data task

Concept
The Map Data task is a powerful tool that can be used to

• convert CSV files into XML and vice versa.
• transform the content of a CSV or XML file: extract, join, rename or re-format parts.

Note:  A CSV or comma separated file is a structured text file. In such files commas or some
other character are used as field separators. CSV can be generated by exporting an XLS file in
Microsoft Excel.

Some example use cases:

• After interacting with an external system, you need to simplify or re-write the XML files that
you received.

• You need to combine information from different sources into 1 file, but also reformat it (this
is more than what the Join XML task can do). For example getting job specification from
an incoming XML file and getting ink information from the metadata of an uploaded PDF
(XMP). You want to combine those into one XML that can be used for the Job Creation task.
To do this, the XMP ink information should also be transformed to the XML format that is
needed for Job Creation task.

• You need to transform an XML that you received before it can be used by the Create CAD
Sheet task.

• You receive an XML file with all possible sheet layouts. Now you need to create a list of
these layouts using a custom text format (for example plain text with line breaks, CSV or
XML).

Tip:  The chapter Examples on page 1638 contains many examples that use this task.

Main Tools in the Task Panel
 

1597



23 Automation Engine

 

The Map Data task panel consists of three main parts:

1. Option to choose the Output Format.
2. Canvas to specify the content of the output file of this task.
3. List of Parameters that you want to read from the task's input files.

Choose the Output Format
• XML: Click on Options to define these output format options:

• Replace reserved characters in parameter values with XML entities: It is possible
that the parameters from the input files return characters that are not allowed in XML.
With this option, you choose to map these special characters to 'XML entities'. Below list
shows these mappings:

Reserved characters
in result value

Meaning XML Entities

" quotation mark &quot;

' apostrophe &apos;

& ampersand &amp;

> greater than &gt;

< smaller than &lt;

• Task fails when output XML is not a valid XML file: Enable this option to have
Automation Engine check the validity of the XML. If this option is on, the task will fail if
the XML is not valid. The validation checks the XML formatting and the XML tag endings.

Note:  This task does not check XML schemas such as XSD, DTD, etc.

• CSV: Click on Options to define this Output Format option:
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• Text Encoding: Choose what type of text encoding that the system that will read this CSV
file prefers. The default is UTF-8.

Canvas to Specify the Content of the Output file
The canvas on the left there is where you can

• insert XML or CSV data from another file. This is the typical way to insert your example
output file, after which you can start replacing its absolute values with SmartNames or
Parameters.

• insert Parameters from your input files (from the list on the right side of the panel)
• insert SmartNames
• insert Xpath expressions (the standard language to extract specific parts of an XML)
• ...

See more in Specifying the Output File on page 1604.

Tip:  Right-click in the canvas to get a list of content to insert.

A List of Parameters from your Input Files
In this field, you build up a list of parameters from your input files. You can then insert these
parameters easily in the canvas on the left, similar to how you insert SmartNames. These
parameters can come from one or more input files.

At the moment you set up the Map Data task, it is good practice to use example input files that
contain the same parameters as the files that will be the real input files of the Map Data task
once it is started in a workflow. It is also a good idea to start from a sample output file (see
further).

See more in Setting Up (Example) Input Files on page 1599 and Adding Parameters on page
1602.

Main Workflow in Using the Map Data Task
Before we go in more detail explaining all the possibilities of this powerful task, it is good
practice to stick to following main workflow:

• Step 1: Get an example of the output file you need to create. Analyse its structure.
• Step 2: Get (an) example input file(s). Analyse its structure.
• Step 3: Create the parameters from the input file(s).
• Step 4: Specify the output file. Use your example output file and the parameters that you

made from the input file(s).
• Step 5: Test the resulting ticket in a workflow, using real input files.

Setting Up (Example) Input Files

Attention:  An example input file is a file that you use while you set up the Map Data
ticket. Be aware that this example file is often not your real input file once the task is
running!
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Important:  The Map Data task allows to create parameters without the help of example
input files but this will be much more complex. We advise to create the parameters based on
example input files because it will help you with correct spelling, see the larger context and
give you immediate feedback.

2 ways to select an Input File

• In the Pilot, select one or more input files before you open the Map Data ticket. These files
will show up as input files.

• Open the Map Data ticket and click on Set Up Input Files....

Setting up an Input File is explained in more detail in the next sections of this document.

Working with Multiple Task Input files
By default a Map Data task will start as soon as it gets one input file. The task will not wait for
a list of input files to be complete. But you can easily solve that.

To make the Map Data task work on multiple input files, you need to make a workflow where
you have a Data Collector task before your Map Data task.
 

 
The Data Collector task will wait for outputs of previous tasks and hand them over as one
group to the next task.

How to Control the Order of Multiple Input Files
If your Map Data task has more than one input file, it is very important to control the order of
those input files. What you want to avoid is

• parameters that do not find their value because they look in the wrong input file.
• parameters that find a value but one that comes from the wrong input file.

Some examples that illustrate the importance of parameters looking in the correct input file:

• Your Map Data ticket is part of a workflow that creates a new Job. Does the parameter
[date] or [time] come from the input file from the MIS or from the metadata-XML from the
PDF that the customer sent you? The difference can result in a conflict about your due date
of that Job!

• Your parameter [print technique] selects the field in row 2, column 5 of a CSV file. If this
parameter searches this field in the wrong input file, then your search can return "Rio de
Janeiro" instead of "Digital Flexo"!

To control the order of your input files, we advise to first use the Data Collector task, followed
by a Sort task and only then followed by the Map Data task.
 

 

The Data Collector task will wait for outputs of previous tasks and hand them over as one
group to the next task.
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The Sort task enables you to sort that group. You can base the order on file name, time or
SmartNames.

Setting up (Example) Input Files - Details

1. Click on the Set up Input Files....
A panel opens that shows your current list of Input Files, their name and order in the list,
their type (XML or CSV) and if they link to an example file or not.

2. To add or modify one, click on Add or double click an existing Input file definition.
The Set Up panel opens.
 

 
3. Choose the File Type of the desired Input File: XML File or CSV File.

4. In case you chose CSV File, you can change the following CSV options:

• Text Encoding: Indicate the Text Encoding of the CSV file. The default encoding is
Unicode UTF-8.

• Field Separator: Indicate which character is used to separate the fields in the CSV. Check
your CSV in a simple text editor to detect it.

• Quote Character: Indicate if the value in the CSV contains quotes that you do not want
to keep. For example: In the CSV the value is written as "25000" but you want to extract
only the 25000.

• Ignore line breaks: Check this option if the CSV only contains one record (column).

• Ignore first line: Check this option if the first line of the CSV contains the names of the
columns.

Note:  These CSV options have a great impact on the way the CSV input files are
handled. A selected value field (using the field number and the line number of the field)
can be the wrong one if the CSV options are not set correctly.
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5. If you want, select an example file to be able to easily select data to be used as the value for
parameters.

Removing an Input file

In the Set Up Input files panel, the Remove button will remove the selected input file.

When there are no parameters created yet that use that input file, the input file item will be
removed. You will not be asked to confirm.

But when the input file is in use, you will see a warning mentioning this use. You will be asked
to confirm before deleting the input file item together with all the parameters or 'repeating
content' that require that input file.

Note:  A similar warning and effect happens when you change the File Type of the Input file
(from XML to CSV or vice versa).

Adding Parameters
There are basically 3 ways to create new parameters:

• creating them one by one, using the Add button.

• loading multiple parameters from a file, using the  button.

• duplicating an existing parameter, using the  button.

Adding Parameters
Once you specified the output format and set up the (example) input files, you can start adding
parameters that represent the values that you wish to insert from the task's input files into the
output file.

To add parameters, proceed as follows:

1. Click Add underneath the Parameters list.
The Add Parameter dialog prompts.

2. Enter a Name for the new parameter.
3. Select the Input File that contains the value for the parameter.
4. Specify where the value for the parameter is located in the selected Input File:

• In case you selected an XML Input File, specify the XPath Expression of the value in the
input file to be used as the value for the parameter. If you selected an example XML file
for the XML input file, you can easily create the XPath Expression using the Edit button.
This will open the XPath Builder. For more information on XPath Builder, see The XPath
Builder  on page 631 (chapter 'SmartNames').
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Attention:  When the expression asks for the text node that contains no text (an
'empty node'), the task will fail ("ParseErrorException").

• In case you selected a CSV Input File, specify the Field number and the Line number of
the field in the input CSV file to be used as the value for the parameter. If you selected an
example CSV file for the CSV input file, you can select the desired field using the Select
Field button.

5. Separator. If the XPath expression returns multiple elements, decide what character you
want to be used as separator.

6. Formatting Options. If you suspect that the chosen value might have leading and/or
trailing spaces, select Remove leading and trailing spaces.

7. If you want to save the created parameter as a SmartName, then click Save as
SmartName.... In the prompted dialog, enter a comprehensive Name and Description and
choose whether or not you want this SmartName to be Private.

8. Click OK to add the parameter to the Parameters list.

The created Parameter is now in the Parameters list. You can now insert the created
parameter in the output XML or CSV (see Specifying the Output File on page 1604).
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Note:

• To edit an existing parameter, select it in the Parameter list and double-click it.

• To delete an existing parameter, select the parameter and click Remove. You will get a
warning when you try to delete a parameter that is in use (in the canvas on the left).

• To delete all unused parameters, click on the action button  underneath the
Parameters list and choose Delete Unused Parameters. You will be asked to confirm.

• To add Parameters from an example input file, see the next section.

Loading Multiple Parameters from a File
Instead of creating parameters one by one, you can choose to load multiple parameters from a
file. Those that you would not need are easy to remove from the list anyway. To do so, proceed
as follows:

1. Underneath the Parameters list, click on the Action  button.
2. Choose Load Parameters from File in the prompted menu.

The Load Parameters from File dialog will prompt.
3. Select the desired Input File from which you want to load the parameters.
4. If the selected Input File is an XML file, proceed as follows:

a) Specify the XPath Expression to load the XML parameters from the Input File. You can
click Edit to open the Xpath Builder to help you build the desired XPath Expression. .

b) Click OK.
All parameters from the selected XML Element will be loaded, including child elements
and all attributes

5. If the selected Input File is a CSV file, proceed as follows:
a) If the First line contains parameter names, select the similarly named option and the

values from the first line will also become parameters.
b) Click OK

CSV Parameters will now be added for every field of every record in the Input File.

Note:  About names of parameters:

• When one or more parameters that are loaded from the example input file have the same
name (because the XML element name, the XML attribute name or the CSV field name in
the example XML/CSV file is the same), their names will be made unique by auto-numbering
them.

• When one or more parameters with the same name already exist, a warning dialog will pop
up asking you if you want to replace them or not. If you choose to replace them, this will
overwrite their current contents.

Specifying the Output File
The canvas on the left of a Map Data ticket is where you define what your resulting XML or CSV
output file will contain.
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There are many types of smart content that you can add to this canvas. And you can even type

in some content yourself. Some of these types of content are listed via the  button. You
will also see a complete list of possibilities when you right-click inside the canvas.

Note:  Most of these are sensitive to the position of your cursor at the moment you right-
clicked. They will not be offered when they are not valid at that specific insertion point.

Caution:  There is no 'Undo' function while editing in this canvas.

Tip:  Find a good example in the chapter Examples on page 1638. It shows how 2 XMLs from
the application Google Maps are mapped into one smaller output XML. That output XML so
contains only specific content to be picked up as workflow parameters.

Here are all the methods and data types that you can enter:

Cut-Copy-Paste
These standard functions work on all types of data you have entered here.

Clear Contents
This will clear the whole canvas.

Insert SmartName
Your output XML can also contain SmartNames. This way you can add information to the XML
that was maybe not present in the input files but important extra data for the system that will
read the output file.

Note:  You can also use the dedicated  button.

Paste from File...
The complete content of the selected file will be added here. This will be possible with all
content that is in a format that can be output to XML or CSV.

Important:  Use this function to paste your example output file.

Insert XML Declaration
It is a good practice to have an 'XML declaration' at the start of your XML file. This line indicates
the file encoding to the reading application. This feature will here insert the industry default
one:

<?xml version="1.0" encoding="UTF-8"?>

Insert XML Element
Type in the name of the element that you want to insert. An opening and closing statement of
that element will be inserted. For example:

<Distance></Distance>

Often, you will continue by inserting a Parameter in between those two.
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Insert XML Attribute
Type in the name and value of the attribute that you want to insert. For example:

units="miles"

For example: see how this attribute was inserted in the above element:

<Distance units="miles"></Distance>

Insert Parameter
Choose the parameter from the list. Alternatively, select the parameter in the parameter list on
the right side and

• Click the  to insert that parameter at the current cursor position in the canvas.

• Drag & drop the  to the right position in the canvas.

For example: the parameter [GoogleMapsDist] was is inserted in above example:

<Distance units="miles">[GoogleMapsDist]</Distance>

Insert New Parameter
This is a shortcut that combines the adding of a new parameter with its immediate placement
in the canvas. After you inserted this new one, it will also appear in the parameter list on the
right.

Avoiding Problems with some 'Velocity' Characters
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Attention:  The underlying technology of the Map Data task is Apache Velocity. This task
allows to build and execute so called 'Velocity templates'. This enables a very powerful
tool, but also imposes some limitations.

Some characters in Velocity have a special meaning. For example $ points to a 'variable',
# to a 'directive'.

The task can handle such characters when they are entered via Map Data 'Parameters'.
But if those characters appear in the fixed text of the template or in the resolved
SmartName values, then the task may fail unexpectedly.

For example: The following desired output would make the task fail:

• <job>
<separation value=”ink#1”>
</job>

• Or, in case a SmartName is used (where inkname would result in ink#1):

<job>
<separation value=”<<inkname/>>”>
</job>

To avoid this problem, you need to add #[[ at the beginning and ]]# at the end of the
string that contains those special characters.

For example:

• <job>
<separation value=”ink#[[#]]#1”>
</job>

• Or, in case of SmartNames:

<job>
<separation value=”#[[<<inkname/>>]]#”>
</job>

Important:  Esko's support and documentation on Velocity templates is limited to what is
described in this manual.

Inserting Repeating Content
Your output XML can include a block of repeating content that represents a repeating XML
element in your XML input file. For example: for each book described in the input file, you want
to pick up selected parameters like its author, category and price (see this example in below
screen shots).

Creating a Repeating Content Block

Make sure your cursor is at the correct place in the canvas and then right-click or use the
dedicated  button. In the dialog, type the XPath expression that selects the repeating XML
element in your selected Input File or click Edit to use the Xpath Builder.
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Click OK and see the repeating content block appear in pink. If you want, you can now
manually add XML elements:
 

 

Loading Parameters into a Repeating Content Block

You can now add parameters in the way we described above. However, we here describe an
optimized way that will avoid loading too many parameters that you may not need.

1. Place your cursor inside the repeating content block and select Load Parameters from

File... from the  button under the list of Parameters.
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2. In the Load Parameters from File dialog, you have a choice:

 

 

a. You can specify an XPath Expression to an XML element inside the repeating XML
element in the Input File. To do this, click Edit to open the Xpath Builder and there
select the XML element.
 

 
b. Or you can choose to load all parameters from that repeating XML element. To do this,

leave the XPath Expression field blank.

3. Click OK in the Load Parameters from File dialog. This will add Parameters for every child
XML element of the selected XML element and for all of their XML attributes. Their pink
color indicates they can (only) be used for repeating content:
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4. Now build your repeating content block by positioning your cursor in between an XML

element and clicking the pink arrow of a parameter. An example:
 

 

Nested Repeating Content

It is also possible to insert repeating content inside another repeating content block. See this
example:
 

 

23.5.5.  Join XML Files task
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Concept
The Join XML task joins the content of its input XML files. In case you do not want the full
content of all these input files, there are options to determine what parts you want or from
what root level down that you want their content.

Some typical examples:

• The information you need is spread over several source XML files, maybe even coming from
different systems. You need (parts of) them combined in 1 XML file.

• You want to change the content of an XML. After splitting it you can re-join specific parts.

Note:  The Map Data task can also be used to join XML files, but it offers much more features
and options than this Join XML task.

Example and Options
The Join XML task joins multiple input XML files into 1 output XML file. The default option of
this task is to take the full content of the input files and join everything together into 1 XML file.
 

 

Name of the output XML file

The default name of the output XML file is set to [File]-joined. [File] is here the name of the
first input file. You can of course change this setting.

Xpath expression that extracts content from the input XML files

Tip:  In the previous topic about the Split XML task, we introduced Xpath expressions and
also introduced the XPath Builder tool.

This canvas is where you can define the content of the output XML. If you do not want the full
content of all your input files, use XPath expressions to define what you want to extract from
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them. Per input file, all nodes that comply with the given XPath expression are imported into
the output XML file.

Click on  to insert SmartNames to help build your XPath expression.

Click on  to open the XPath Builder. For more info on XPath Builder please see The XPath
Builder  on page 631 (chapter 'SmartNames').

If this canvas is left empty, and if you didn't specify a Root Element, then all the nodes under
the root node are considered (XPath == /*/*).

Root Element in your output file

Each input XML file has its own root element. You can define here what you want as root
element in the output XML file. See an example where this root element was set to 'ink':
 

 

If this field is left empty, then the tag name of the root of the first input file will be used.

Example

You have these 2 XML files:

• One XML file lists ink attributes of a (first) ink of a PDF:
 

 

• Another XML file contains information on the ink coverage of that file:
 

 

You now want to join these 2 files into 1 XML file with all the ink attributes together.
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• This is the result if you use no options:
 

 

• This is the result when you set the option Root Element to PrintItem:
 

 

• This is the result when you also used the Edit button to add the XPath Expression /Job/
ink
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Because the Xpath extracted only the content of <ink>, the pdf file name and the customer
name are not kept in this joined file.

Note:  To further change the structure, order or content, you can use the Map Data task.

23.5.6.  Split XML File task

Concept
Sometimes you want to split XML files to make them more easy to use Automation Engine
workflows. These XML files typically come from an external system. The Split XML task needs
1 XML file as input and will write 1 or more XML files as output. Some typical examples:

• Every morning your MIS system sends you a list with new Jobs and their details. To use that
XML for the Create Job task, you need to split it into 1 XML per Job.

• Your MIS system sends an XML per customer order, but your workflows are set up per
production item of an order. In this case, the Split XML task helps you to generate an XML
file per production item. This makes it easier to automate your workflow. This example is
elaborated below.

Tip:  You can also use this task to split an XML that was created by Automation Engine itself.
For example to make that XML more manageable for an external system.

Supported input files
The input of this task is XML. Files with a different extension than .xml will not be recognised
or processed.

Note:  Exception: JDF files are also allowed as input. The resulting output will be XML files.
These XML files will no longer be valid as JDF file.

How do you decide what to split?
How you split the task's input file is defined by XPath expressions (built of static text and
SmartNames). The task splits each matching element into separate XML files.

The built-in XPath Builder will help you to write those expressions. See further.
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Example and Options

General Behavior
• Encoding

• When the input XML file contains a header that specifies an encoding (for example
encoding="ISO-8859-3"), the task will write the output files in that encoding.

• When no header or encoding is specified, the resulting files will have UTF-8 encoding by
default.

• XML Validation

The task will generate well formed XML, but there is no support for schema or DTD
validation. References to DTD's for validation will be removed.

Example

The following code is grouping 2 production items in 1 XML file:

<?xml version="1.0"?>
<job>
  <commoncomponent>Z</commoncomponent>
  <commoncomponent content="Y" />
  <productionitem>
    <subelement content="A" />
    <subelement>1</subelement>
  </productionitem>
  <productionitem>
    <subelement content="B" />
    <subelement>2</subelement>
  </productionitem>
</job>

To split each production item into a separate XML file, type this expression in the XPath input
field:

/job/productionitem
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This will split the file into these 2 files:

<?xml version="1.0" encoding="UTF-8" standalone="no" ?>
<job>
  <commoncomponent>Z</commoncomponent>
  <commoncomponent content="Y" />
  <productionitem>
    <subelement content="A" />
    <subelement>1</subelement>
  </productionitem>
</job>

<?xml version="1.0" encoding="UTF-8" standalone="no" ?>
<job>
  <commoncomponent>Z</commoncomponent>
  <commoncomponent content="Y" />
  <productionitem>
    <subelement content="B" />
    <subelement>2</subelement>
  </productionitem>
</job>

Note:  The SmartName [ File Number ] is available for this task only. It is added by default to
automatically generate unique names for the output files.

Options
• Keep context :

• When selected, the XML content that is not selected by the expression will be kept in the
output file, of course except the sibling elements of the selected elements (siblings are
elements at the same level with the same name).

By also keeping this extra context info, the result XMLs will look like the input XML, as
they will still have the same structure.

Attention:  With this option selected, the next option (the below described
setting to decide which parser method is used (DOM or SAX)) can influence which
extra contextual parts are kept in the output XML files.

• When not selected, the output file will only contain the parts that your XPath expression
selected.

Using the above example as input, the task will split it into these 2 XML files:

<?xml version="1.0" encoding="UTF-8" standalone="no" ?>
<productionitem>
  <subelement content="A" />
  <subelement>1</subelement>
</productionitem>

<?xml version="1.0" encoding="UTF-8" standalone="no" ?>
<productionitem>
  <subelement content="B" />
  <subelement>2</subelement>
</productionitem>
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• When an input file contains a 'namespace declaration' in the parent XML structure
('xmlns'), then that namespace declaration will be added as an attribute of the top level
element. For example:

<?xml version="1.0" encoding="UTF-8"?>
<job xmlns:esko="http://www.esko.com/myowns/">
  <commoncomponent>Z</commoncomponent>
  <commoncomponent content="Y" />
  <esko:productionitem>
    <esko:subelement content="A" />
    <esko:subelement>1</esko:subelement>
  </esko:productionitem>
  <esko:productionitem>
    <esko:subelement content="B" />
    <esko:subelement>2</esko:subelement>
  </esko:productionitem>
</job>

With such namespace declaration on the top level element, the split will result in these
files:

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<esko:productionitem xmlns:esko="http://www.esko.com/myowns/">
  <esko:subelement content="A" />
  <esko:subelement>1</esko:subelement>
</esko:productionitem>

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<esko:productionitem xmlns:esko="http://www.esko.com/myowns/">
  <esko:subelement content="B" />
  <esko:subelement>2</esko:subelement>
</esko:productionitem>

• Standards Compliant (DOM/XSL) or Limited but less memory intensive (SAX):

The XML file format was not designed to contain huge dumps of information. However,
some users want to use such huge XML files as input files for this task. This can cause
memory problems. This is why the task also offers a different method in reading the file,
one that is optimized to read (parse) huge XML files.

• Standards compliant (DOM/XSL):

This method takes the complete file in memory and then starts processing it. Depending
on your server, this can become a problem when the size of the XML file is hundreds of
megabytes. When, for example, the input XML file is 1 Gb, the AE server will, for this task,
need at least 1 Gb of memory during the (long) time it processes this file.

'DOM' stands for Document Object Model. This is the XPath parser that is fully compliant
with all standards.

Before AE v20, this task always used this DOM method for its XPath processing.

• Limited but less memory intensive (SAX):

This method only takes one element at the time in memory. This is advised for huge files
that still have a simple structure.

'SAX' stands for Simple API for XML parsing.

The Esko implementation of the SAX parser does have these limitations:

• In combination with the option "Keep context", the context is limited to nodes that
are higher in the xml hierarchy.
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• Expressions can only have conditions that apply to a node itself, not to other nodes.
• Advanced features like the "//" operator, functions and axis are not supported.

In other words, only constructions like these are supported:

• /nodename/nodename
• /nodename[@attribute='value']/nodename[@attribute='value']
• /*[local-name()='nodename'][namespace-uri()='http://..."]

Learn more and see several examples in The DOM or SAX choice affects the result of 'Keep
Context' on page 1619 .

Creating XPath Expressions
Usually you will not define the XPath expression by typing it in the task window yourself. Use
the Edit button to open de XPath Builder. This tool will help you create your own correct
XPath expression by clicking the variable elements. By selecting parts in the window with
Example XML Content, you will see the resulting XPath expression automatically appear in
the top part of this tool.

Important:  When the Example XML content window is empty, this means that you forgot to
select an XML input file before opening the Split XML task.

 

 
Selecting the option Select siblings allows you to automatically select the right level.

In above example, the user selected the level 'productionitem'. The selection is shown in
yellow. The siblings are also automatically selected and are shown in grey. The correct XPath
expression that is needed to split that level of elements will automatically appear in the top
part of this tool.

You can easily build complex expressions with this tool, such as:
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• selecting elements conditionally.
• selecting an element from a specific 'namespace'.

Find more information on the XPath Builder in The XPath Builder  on page 631 (chapter
SmartNames).

The DOM or SAX choice affects the result of 'Keep Context'
The option to 'Keep context' can lead to different output in 'SAX' versus in 'DOM'. See various
examples below.

What if you do not want that result? Your only alternative is to use the other parsing method
(DOM / SAX). Both methods have their own specific effects in how they 'Keep context'.

The logic behind these effects is too complex to be described by rules. We can only illustrate
them via below examples.

Note:  When showing XML files like the below examples, we always use the application
Notepad ++. When you open XML files in a browser, you might detect slight differences in how
they interpret their grammar. For example An open/close on 1 same line in stead of spread
over 2 lines.

Example 1 - Without 'Keep context'

Below example shows how the input file, with that XPath expression, is split into 3 output files,
one for each selected node.

The content of the output files is decided by the Xpath expression combined with the other 2
options.

In this simple example, without 'Keep context', the result is the same whether 'DOM' or' SAX' is
chosen:
 

 

Example 2 - With 'Keep context'

This is the same example as above but now the option 'Keep context' is selected.

The output now also contains other XML content.

With this simple input file and with this xpath expression, the result is the same whether DOM
or SAX is chosen:
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Example 3 - With 'Keep context', SAX

This time the input file and also the XPath expression are slightly different.

This is the output when we use the 'SAX' method:
 

 

Example 4 - With 'Keep context', DOM

This is the same as the example above but this time we used the 'DOM' method.

Notice the difference in the output:
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Example 5 - With 'Keep context', SAX

This is the same as example 3 but a level deeper: See the extra /sub/ in the XPath expression.

This time, also the level of the 'sub' element is kept in the output. But again it stays empty:
 

 

Example 6 - Another example where SAX keeps less XML context than DOM

This time the XPath expression extracts a 'type':

• Using SAX parsing:
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• Using DOM parsing.

Again, the 'DOM' method keeps more context information:

 

 

Examples of unsupported Xpath expressions when using 'SAX'

Whether you use 'Keep context ' or not, various types of XPath expressions are not supported
when using the 'SAX' method:

• When using 'SAX' , the operator '//' is not supported.
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• When using 'SAX', recursive expressions are not supported (expressions on sub-element).
 

 

• When using 'SAX', also these expressions will result in an error:
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23.6.  Tasks Interacting with other Systems

Note:  Apart from the tasks that we here document, Automation Engine can also offer these
tasks that are only available through Esko Solution Services:

• Interact with SAP task on page 1630

• Run ArtiosCAD Standard on page 417

• Synchronize ArtiosCAD Boards on page 468

• Synchronize ArtiosCAD Companies on page 468

• Export ArtiosCAD Design Info on page 275

23.6.1.  Interact using JDF

Attention:  This task is only available via Esko Solution Services.

This task submits a JDF file to a JDF enabled device or system using a JMF SubmitQueueEntry
command.

The task takes a JDF file as input.

After sending the JMF SubmitQueueEntry command, the task remains in a waiting state until
the JMF controller sends back a JMF ReturnQueueEntry command to Automation Engine.
The output of the task is the returned JDF file.

Options:

• JMF Controller: This is the HTTP address of the JMF controller.

• Submit MIME (JMF+JDF): If this option is enabled, a MIME package containing the JMF
SubmitQueueEntry and the input is made and submitted to the JMF controller over HTTP.
If this option is not enabled, the JDF is submitted to the JMF controller.

• Include auxiliary files (PDF...) in MIME package: If this option is enabled all external files
referred to in the JDF with a “file:” URL will be included in the MIME package.

23.6.2.  Interact using JMF

Attention:  This task is only available via Esko Solution Services.

This task will submit a JMF to a JDF enabled device or system.

The task takes a JMF as input. The output of the task is the JMF response of the JMF controller
to this message.

Options:
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• JMF Controller: This is the HTTP address of the JMF controller.

23.6.3.  Interact with Database task

Concept

Tip:  The tasks that interact directly with external systems were introduced in Automation
Engine tasks Interacting directly with the External System on page 1557. You there also read how
this task compares to the Database Access Point.

The Interact with Database task allows you to communicate directly with an external
database. It allows both getting information from that database (read) and sending
information to that external database (write).

As mentioned in the chapter Integration Concepts on page 1555, a typical use for this task is to
feed information back to external systems by using this task in a workflow. For example, you
can set up this task to update a record in a table of your MIS when your workflow has reached
a certain stage. For example setting the status record to 'Proof Ready'.

Warning:  This task may not be used to interact with Automation Engine databases.
This is not supported by Esko. This can damage your server configuration.

Warning:  See the important remark in the task panel. As mentioned earlier in this
document, using SQL statements to change records of an external database can
potentially harm that database. If you are using this technique then this means that you
have a database specialist who takes all liabilities for these SQL queries.

Tip:  The chapter Examples on page 1638 contains 2 examples that contact an external
database.

Setup and Options

File Name
When the SQL query is a 'select' statement (see further), the task will dump the found records
in an XML file. The default ticket offers the SmartName [Table Name] as name for that output
XML file. In below screenshot, this name would then be 'ProductionDetails'.

Note:  The SmartName [Table Name] is only offered in a context where it makes sense.

Caution:  Not all SQL queries will resolve a name of a database table. Do not use the
SmartName [Table Name] when it is possible that no table name is found.
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External Database
Select a database from the list of configured databases. Click Configure... to access the
configure tool directly. Learn more about configuring External Databases in the the related
item in the Configure tool.

Important:  Before linking Automation Engine with an external database, please check your
license agreements with the database manufacturer.

Statement
Choose the type of SQL statement that you want to use: SELECT or OTHER.

• SELECT

When using the Select statement, the output of the task will be an XML file.

See an example of such a resulting XML. Notice that the SQL statement is also mentioned
inside.

 

 

Advanced Options...: You can avoid creating an XML file that is too big by limiting the
number of records with the option Maximum number of records per file. The task will
then generate as many files as needed.
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• Other

In this mode, you can execute any other SQL statement such as INSERT, UPDATE etc.
However, the task will in this case not generate an output file.

Note:  When the Statement type is set to Other, you cannot execute a Select statement.

In this example the status of the Job is changed in the orders database:

 

 

Execute SQL Statement
Decide if you want the SQL statement to be executed Once or Once per input file.

For example: You have multiple input files for this task: banana.pdf, lemon.pdf and mango.pdf.
When your SQL statement uses the SmartName [File] (= the task's input file), then the option
Once per input file will make the task run for each input file. With the option Once, the task
would only run for the banana.pdf (the first input file).

Tip:  Starting a task once and having it run on multiple input files is much lighter for the
software than starting the task multiple times with each time only one input file.

23.6.4.  Interact with Web Service task

Concept

Tip:  The tasks that interact directly with external systems were introduced in the chapter
Integration Concepts on page 1555.

The Interact with Web Service task uses HTTP requests to communicate with a web service of
an external system. Both read ('GET') and write ('POST') commands are possible. The result of
this task is typically an XML file.

When an external system is running a web service, you will be able to access it via HTTP
(HyperText Transfer Protocol). However, to do this, you also need to learn what you can
communicate to that system, what language you need to speak to it. Some applications will
indeed publish their API (Application Programming Interface). And it is that API documentation
that will tell you what you can enter in the Interact with Web Service ticket.

Tip:  The chapter Examples on page 1638 contains an example where a web service is
contacted.
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Difference with a Web Service Access Point.
• A Web Service Access Point is a way for an external system to speak to the web service of

Automation Engine. This Interact with Web Service task is the reverse: it is Automation
Engine that interacts with the web service of an external system.

• An Access Point is used to start a workflow. This Interact with Web Service task can be
inserted at any step of the workflow.

Setup and Options
 

 

Output folder and File Name
Define here the path and name of your output file. The type of output file is defined by the API.
We advise to choose XML.

When the Method is GET, this file will contain what the external system returns you. When
the Method is any other type, the output file will only contain a status of the interaction (for
example 'OK').

Service
Choose the web service from the list. Click Configure... to access the Configure tool where you
define such external Web Services. Learn more in this related item in the Configure tool.
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Method
There are various types of HTTP methods that you can send to a web service. Choose the
method from the list:

• GET. This most frequently used method will retrieve data from that external system.
Consider the URL as the question and the output file as your answer.

For example: Ask Google Maps the distance from your company to your customer.

• POST. This method creates a new object on the external system.

• This method is commonly used to post actual data, to upload a file to the external
system. Therefore, click on Options... and choose to Attach input files. All input files
are added to a single HTTP request and SmartNames are resolved in the context of
the first input file. In case each input file must be sent separately, then add a Data
Splitter task before the Interact with Web Service task in the workflow. In that case
SmartNames will be resolved for each file.

Note:  The parameters are sent as "application/x-www-form-urlencoded" data.
When XML files are attached, the data is sent as "multipart/form-data".

• The POST method also enables to send a SOAP request. The exact text of the SOAP
request needs to be put in an XML file and you need to add a single parameter
"SOAPAction" with the needed value.

Note:  the Create XML task can be used to embed SmartNames inside the SOAP
request.

Note:  Find an example in the Esko Knowledge Base.

• Options...

• Attach input files: Select this if you want to include the task input files into the POST.

• Use chunked encoding: Select this to use "HTTP Chunked Encoding", which means
there is no size limitation. This is advised when posting large files.

Note:  Note that this can only work if the receiving server supports this HTTP protocol
extension.

Note:  When selected, it is also used for data that might return as a result of your
POST command.

• PUT. This method requests the external system to store data or information under the
given (existing) URL.

• DELETE. This method requests the external system to delete the information corresponding
to the given URL.

• Select SmartName.... You can even use a SmartName to define the method.

Note:  PUT and DELETE are only used for 'RESTful' web services. 'REST' is the main architecture
style of HTTP. An alternative is 'SOAP'.
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Path
This path will be documented in the API of the external system. APIs often present several
paths that you can address.

In the above example of a ticket to access Google Maps, the information will be gotten from
the 'directions' part of the API. The path ends with XML which here means that we choose to
get an XML file back (and not a JSON file for example).

Headers
The API documentation will instruct you if you need to use HTTP headers. To do this, add their
key and value in the Headers list.

Parameters
The API documentation will instruct you what parameters you can use. To do this, add their key
and value in the Parameters list. This is where the actual 'question' will become more clear.

In the above example, you can see how the ticket asks Google Maps a distance between the
origin and destination address. Other parameters could be more optional, like in this case the
option to only calculate distances for routes that avoid toll roads.

Tip:  Just Google "Google maps API" or click here to learn how Google Maps is a nice example of
how an external system publishes its API.

Tip:  This page with examples contains an example that uses the Google Maps API.

23.6.5.  Interact with SAP task

The SAP access point and the Interact with SAP task serve to integrate with an ERP system
from SAP.

Such integrations are managed through assistance from Esko Solution Services.

23.7.  Tasks often used in Integration Workflows

23.7.1.  Create Job task

Concept, Workflow and FAQs
The Create Job task creates an Automation Engine Job based on an XML input file containing
the job parameters. Typically this input XML file comes from your business system. It is inside
this system that the job-orders are decided and where many of its prepress production
parameters are entered first. Typically, a Folder Access Point receives this XML file and then
starts a workflow containing this Create Job task.
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Tip:  Read more about the concept of integrating with external systems in Introduction on page
1553.

Tip:  The chapter Examples on page 1638 contains many examples where this task is used.

It is possible that the XML file that feeds this Create Job task does not come directly from the
business system. Maybe you first have to combine it with another input file that contains other
job parameters. Such other parameters could for example arrive as metadata inside a PDF.
The data formatting tasks Split XML, Join XML and Map Data offer all tools to combine these
parameters into 1 XML file.

Should the XML be in a specific format?
No, but it should be a valid XML of course. You will set up SmartNames or XPath expressions
that map the vocabulary of that business system to the terminology required in Automation
Engine. For example your business system uses the term 'Order Number' to describe the name
of a job. You can then make a SmartName that maps 'Order Number' to 'Job Name'.

Can one XML file create multiple Jobs?
If your XML contains the description of multiple jobs, then you first need to split that XML into
multiple XML files that each describe one job. To do that you will set up a workflow with the
Split XML task in front of this Create Job task. Also use the Data Splitter task to make sure
that the Create Job task is started for each incoming XML file.
 

 

Can the input file be a CSV file?
If you want to create a Job from a CSV file, then use the Map Data task to convert it to an XML
file.

What if my business system can not export an XML file?
When your business system is not capable to export a job description in XML format, you can
consider the alternative where Automation Engine asks your business system if there is a new
job to be created. Learn about the various possible techniques in Access Points on page 1561.

Can the task find its parameters outside the task's input file?
Yes. The input file of this task does not have to be the XML file that delivers all the parameters.
It can even be a PDF. The parameters could also be looked for in other files than the task's
input file. Some examples of such special setups:

• A Create Job ticket with a PDF as input file and where the SmartNames do SQL queries to
an external database.

• A Create Job ticket with SmartNames that find their values in workflow parameters.

• A Create Job ticket with (SmartNames that are) Xpath expressions to some centrally stored
XML that the business system writes there every night at 3 AM.

The Create Job task can get the values for its parameters from different sources. It can for
example
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• find the main job order specifications from the business system's XML file (name, ID,
customer, due date)

• AND get the some ink information from the metadata of a PDF
• AND get a custom parameter 'Press' from a workflow parameter [wfp.PressName].

What if the Job already exists? Can I use this task to update Jobs?
Yes you can also use this task to update existing Jobs. If Automation Engine detects that the Job
already exists, it will update the Job with any new or changed values.

This task will function as an Update Job task

• when it sees that the [Job Name] already exists
• OR when it sees that the combination of [ Job Order ID] and [Job Sub Order ID] already

exists.

At the end of this chapter, you can find a sample XML that can be used to create jobs from.
Remember that the format of the XML is free. This sample is not a template, it is just one
example.

We will now document the settings in the different tab sheets.

Important:  To set up a Create Job ticket, you need advanced knowledge of SmartNames.

Job
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For most of the fields in this task, you can choose to set a SmartName or a combination of
SmartNames.

You can also use an XPath expression to extract values from an XML file. Click  to use the
Xpath Builder or if you are an expert in XPath, type them in yourself.

Attention:  In the input fields that offer an , it is not supported to insert a
SmartName in your XPath expression! Still, the SmartName icon stays visible which
might be confusing.

In these fields, XPath expressions are direct 'inline' commands to the input file, which
needs to be an XML file. In other cases, for example when the input file is a PDF file,
you could use SmartNames, which can also be built out of XPath Queries. SmartNames are
then a indirect way of getting the value (not 'inline').

• Order ID: This field must have a value. You can not leave it empty.
• Sub Order ID
• Name: In the screen shot example, we combined 2 SmartNames with some absolute text

( _ ).
• Description:

Note:  The above example shows an XPath expression. If you are an expert in building
XPath expressions, you can also directly type XPath expressions in this field. The syntax
for doing this is  "XPath:" followed by a valid XPath expression for the input file. Example:

• Due Date: The format needs to be compliant with ISO 8601 (YYYY-MM-DDThh:mm:ssTZD) .
For example: 2014-07-28T12:00:00+01:00

• Project ID:

Tip:  Some users use this field to define the name of the project on Esko WebCenter that
corresponds with this Job..

• Category: For this field, you can also choose a category from the list.

Tip:  The categories in the list are all those that were already used in a Job.

• Custom Fields: The custom fields that appear here are the ones that you defined in
Configure > Jobs > Job Setup (maximum 6). Alternatively to using a SmartName or XPath,
choose a value from the list.

• Job Folder: The system needs to know where to create the actual folder for this Job.

Note:  Beware that you do need to define a complete network path here, not just a folder
name.

You have these choices:

• Use the SmartName [Smart Job Location] to use this setting as defined in Configure >
Jobs > Smart Job Location.

• Click  to browse to the desired job location.
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• Click  to browse to a folder in a container, and then use SmartNames to define a
subfolder.

Note:  If you want to make the path smarter by adding the name of the customer, then
you best set that up as a Smart Job Location.

Customer
Using the same techniques as described for the tab 'Job', you here define the customer details
for the Job you are creating.

• Customer ID. You can alternatively select the ID from the customer list panel.

• Customer Name.

• Customer Description.

• Customer's Job Reference. This is the name that your customer uses for this Job.

• Customer Service Representative. You can alternatively select the CSR from the list.

• E-mail.

Inks
Setting up the inks for the new Job can only be done if the input file is an XML file and if the ink
properties are stored in attributes of XML elements.

In the example below the XML input file contains an element "Farben" (German for "inks"). This
is an array of "Farbe" elements, each describing an ink.

 

 

The Create Job task will create an ink in the new Job for each of these elements in the XML.
The table in the dialog defines how to map XML attributes of each element to an ink property.
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• Load Ink Information from an XML element. Enable this and then choose how you will
load this specification: You have these 2 options:

• XML element Name: Indicate the XML element that contains the ink specification. In above
example the ink info is described in the element Farben.

• XPath expression : Alternatively, use an XPath Expression to the XML element containing
the ink information. For example: /CreateJob/Farben

Note:

• To open the XPath builder, select XPath expression and click on the Edit button in the
text field.

• The XML that the ticket sees as input file will be loaded in the XPath builder.
Alternatively, you can right-click in the canvas and choose Paste from File... to select the
example XML input file.

• When you edit the XPath expression again, that same XML (example) input file will be
automatically used.

For each job ink parameter, specify the corresponding XML element that is used in the XML file.
To do this, select the parameter and click Edit.

• Ink name

• Ink type

• Ink book

• Angle
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• Ruling
• Dot Shape
• Printing Method

Parameters
To add custom parameters to the job you are creating, click Add and enter its Name and
Value.

Both fields are SmartName enabled. Typically, the Name will be an absolute value and the
Value is a SmartName that extracts the custom parameters from an XML file.

For example:
 

 

Bar Codes
The Create Job task also allows to add parameters for one or more bar codes.

Important:  The Create Job task does not check the consistency of these bar code
parameters. This means that the creator of the input file is responsible to create bar code
parameters that are compliant.

You can Add or Remove parameters for multiple bar codes.

For each bar code, you can set the following parameters by adding a SmartName or an XPath
expression. Some also offer to select a value from a list.
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Attention:  Some parameters will not be relevant for some bar code types.

• Type.
• Sub Type. A list will be offered if you selected a Type that offers Sub Types..
• Code. As mentioned above, the code is not checked for validation here.
• Composite Code. Only some types offer to add an extra composite code.
• Output Resolution
• Bar Width Reduction
• Device Compensation
• Narrow Bar. Only some types work with a specification of Narrow Bar and Ratio
• Magnification
• Ratio. Only some types work with a specification of Narrow Bar and Ratio

Template
You can use an existing job as a template job for the new job that you here create. If you
decide so, you can select which attributes and parameters that you want to get from that
template job.

Note:  For more information about using template jobs and their options, see the dedicated
chapter Jobs on page 495.

Select Use an existing job as a template if you want to create your job based on another job.

In Choose Job, Select the job from the list or use a SmartName to have the job selected. An
example of a SmartName could be [customer name]_template

Then choose what to Include from the template job into the new job:

• Files
• Folders
• Hot Folders. This item will only appear if your server still has hot folders from before v14.
• Tickets. These are the (blue) Job tickets.
• Milestones. Times will be set relative to the creation date of the new job.
• Parameters. Custom parameters.
• Inks.
• Categories

Attention:  If there any parameters that you pick up both from the input file and from
a template job, then those from the input file will be kept.

Advanced
The Create Job task can automatically launch a workflow when the new job is created and
even when the task updates the job.

To do this, select when you want have a workflow launched and select the workflow from the
list. You can even choose both moments.

Note:  If the Create Job task itself is part of a workflow, the workflow that is chosen in this task
will start immediately, as a separate workflow. It will not wait for the workflow that contains the
Create Job task to finish.
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The advantage of this function is that the chosen workflow will be launched in the context of
that created/updated job. This means that all the used SmartNames will get their value from that
job.

Attention:  In case you create a workflow that contains the Create Job task as a
workflow step and then continues with other steps, then the tasks following that Create
Job step will not run in the context of the new/updated job: they will run in the context
where the (main) workflow initially started!

Sample Input XML
Click this link to find a ZIP with the samples used in the page 'Examples on page 1638'.

Download the ZIP file and unzip it to a local folder or directly into an Automation Engine
Container.

In its the folder named "Create a Job using XML", find a sample XML that you can use to test
setting up SmartNames, Xpath expressions and so build and test an example Create Job task.

23.7.2.  Add To Products task

The Add To Products task allows to create Automation Engine Products. The task can get their
properties out of file names, paths, SmartNames or values out of XML data.

This task is often used after workflow steps first made a smart selection of input files.

This task is documented in the chapter Products on page 548. Find a direct link here.

23.7.3.  Link Product To Job task

The Link Product To Job task allows to link or multiple Products to a Job.

This task is documented in the chapter Products on page 548. Find a direct link here.

23.8.  Examples

These examples will help you build and understand the workflows of typical integration use
cases.

At the beginning of each example, we also mention which tools and tasks are used. We also
add a link where you can find the sample (XML) files used in that example.
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Note:  An example often requires you to understand the features explained in the previous
examples.

23.8.1.  Creating a Job using XML

Summary

We will create a Job based on the sample XML. Most of the work is creating the XPath Query
SmartNames.

Tools used in this example:

• A sample XML describing 1 job order
• SmartNames including Xpath Builder

• The Create Job task

Step 1 - Analyze your Input XML file
Click this link to find a ZIP with the sample XML file used in this example.

Save the file in a logical place in an Automation Engine Container.

Open it (double-click) and have a look at its structure:
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See how a lot of job info is inside the parent element 'CreateJob' and how the ink information is
inside a different parent element 'InkSpecifications'.

Note:  In this sample, even the full path for the JobFolder is filled in. This is usually not the case.
A business system usually leaves it up to you to decide where to store your prepress data.
Some MIS do want to control this as well. Advantage of already knowing exactly where your
prepress files are is that they can then also show some of them to their MIS users (final PDF,
JPEG..). However, most MIS will not decide that path for you but will ask you to let them know
where you decided to create that JobFolder. In that workflow, the MIS usually wants you to a
return them a XML containing that JobFolder path.

Step 2 - Create your SmartNames
SmartNames will read specific pieces of that XML and so populate the various properties of
the Job you will create. To read parts of that XML, we will use SmartNames of the type XPath
Query.

Note:  You can also create SmartNames directly from within the Create Job task. However,
because they are Xpath queries that involve a sample input file, we advise to create them using
the main SmartNames tool . It will be somewhat easier to do it there.

1. Go to the SmartNames tool and indicate your sample input XML file
Because you will probably make a dozen new XPath SmartNames, it will be easier when you
only have to indicate your sample input file once. Do this in the Resolve all using: section.
 

 

Note:  You do not have to click on 'Show' at this moment.

2. Make a first XPath Query SmartName
1.

In the SmartNames tool, in the top bar, click on  to create a new SmartName.. Choose
Type XPath Query.
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An example query about 'vsize' appears. It will be removed automatically later. See the part
/text() at the end. This means that the query will not select the full element but only the
value of that element.

At the bottom,
2. Click on 'Edit' to open the XPath Builder.

 

 
As a first SmartName, we will create the Xpath Query representing the Job's OrderID.

All you need to do here is click on the value that the SmartName will be looking for. It will be
highlighted in yellow and the resulting XPath Expression will automatically appear in the top
field.

3. Click on 'OK' to close the 'Edit Xpath Expression' dialog. The expression will have replaced
the example one. The resulting value will also be shown bottom left in 'Result:' (in below
screen shot: "002").

4. Now save your new SmartName. Give it a logical name and maybe add some tags and a
description.
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3. Now make the other SmartNames (quickly)
The next SmartNames will be made very similarly. Double click the one you just made and
while keeping the SmartName dialog open, follow these steps:

• click Edit

• in the Xpath Builder,

• click on the value you want the SmartName to represent
• click OK to close the Xpath Builder

• click Save As... and enter an appropriate name, tag and descriptions

Repeat this for all the SmartNames you wish to use in the Create Job task.

Step 3 - Insert the SmartNames in the Create Job ticket
Open a Create Job ticket and insert the created SmartNames in their corresponding fields.
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Do the same for all fields in the other tabs.

Don't forget to save your ticket.

Picking up the Ink parameters from the XML
As explained in Inks on page 1634, the Inks tab is constructed differently.

In our sample XML, see how the ink information is described in a parent element
InkSpecifications. And in there, per ink in an element named 'Ink'. And there are 8 inks
described.
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You also see that the names of the ink parameters are not all identical to those used in the
Job setup in Automation Engine. In many cases these words in the XML may not be in English.
This terminology in the XML (in the business system) needs to be mapped to the official one in
Automation Engine. This is explained in the documentation of the Create Job task.

See the correct settings for our example:

• The element name under which all the ink info is found is InkSpecifications.

• The parameter names in your XML (right) have been mapped to the standard names in
Automation Engine (left):
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Note:  These names are not case-sensitive.

Note:  If one XML Element name is wrongly mapped, the Create Job task will not fail but
only this wrong parameter will stay empty in the Job Inks setup.

• Alternatively, in our example, You can use this Xpath Expression to select that element
describing all the inks:
 

 

This is the result in the created Job:
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Step 4 - Test your Workflow
Test you workflow by launching it from within the Pilot.

In the Pilot, select the input XML file and launch the workflow. It should create the Job and the
Job should contain all the parameters you had set up.

When the Job was created but one or more parameters were not found, the status of that
'Create Job' workflow step will be 'warning' (orange).

• The task's details info will already tell you that "There were problems resolving some job fields".
• The task's log file will tell you what specific SmartName(s) has a problem. For example

"Could not resolve(2) job.customer : <NameOfTheSmartNameThatFails>/"

Step 5 - Add automation by starting this workflow from an Access Point
When an external system sends you a XML files describing Jobs to create, we advise to
automate this workflow.

A typical way to do this is to create a Folder Access Point. The folder of that Folder Access
Point is then the place where the XMLs will arrive. The workflow that the Folder Access Point
will automatically start at a regular time interval is then the one you created in this example.

Note:  Learn more on setting up such automation in Folder Access Point on page 1563.

Attention:  It is also common for external systems to send the prepress department
you an XML file containing the description of multiple job orders . And often those
systems only send such a list once or twice per day. This use case is explained in a next
example Creating Multiple Jobs from One XML on page 1646.

23.8.2.  Creating Multiple Jobs from One XML

Summary

Note:  This example requires you to master the features explained in the previous example
Creating a Job using XML on page 1639.
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You receive an XML from the business system. It is a list of job-orders and their production
parameters. Some are already started in prepress, some are new, some are on hold. Your
goal is to create Jobs of all those in the status 'ReadyForPrepress'. The XML needs to be split
into multiple XML files each describing one Job. These XML files are then input files for the
Create Job task. The job-order info in the XML files is too elaborate. You will only pick up some
selected parameters from those XML files.

Tools used in this example:

• SmartNames including Xpath Builder

• Split XML task

• Data Splitter workflow control

• Create Job task

Step 1 - Analyze the XML describing Multiple Jobs

Tip:  Click this link to find a ZIP with the sample XML file used in this example.

The XML in this example describes the 3 job orders. See how 2 of them have the status
'ReadyForPrepress'.
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Note:  In this example XML, we removed typical extra parameters about the customer, bar
code and inks. The principle of those types was already explained in Creating a Job using XML on
page 1639.

Attention:  If you send this XML to the Create Job task, it would only create the first Job
it finds in the XML.

Step 2 - Create the Workflow Ticket
This is the workflow we need:
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• The Split XML task splits the XML into multiple XML files. If you don't do this, the Create Job
task would only create the first Job is finds in the XML.

• The Data Splitter makes sure the next task sees the many input files. It prevents that the
task is only launched on the first input file.

• The Create Job task creates Jobs, as determined in the Data Splitter, for each incoming
XML file.

Note:  The Create Job has no output files. If you want to continue the workflow with its
input files (the split XML files), then configure a specific output pin for that. Learn more on
these possibilities in The Workflow Editor and also Building Workflows in the User Guide.

Step 3 - Splitting the XML but also using a Filter on Status
In the Split XML task, we need this XPath Expression:
 

 

• The expression /Jobs/Job will result in splitting the XML on that level of elements: one per
Job.

• The extra filter [Status = 'ReadyForPrepress'] will limit that to jobs with that status.

This Xpath expression can easily be built by using the Xpath Builder. Open it via the Edit
button.

Note:  When the filter does not find any matching 'node' (job), the task will error and mention
this as the reason.

• Output in: Define where you want the split XMLs to be written.
• File name:Define the name of the split XML(s). The default setting will add a number.

Step 4 - Importance of the Data Splitter
When you do not use the Data Splitter, the Create Job task will receive all the XMLs generated
by the Split task as 1 group on its input pin. In this case only the first incoming XML will be
processed and the rest will be ignored. The Data Splitter step in this workflow will make sure
the Create Job task receives the XMLs as separate files so each of them gets processed.

Because we (possibly) have multiple input XML files, we need these (default) settings:
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We do not want the split XML files to be grouped. The Create Job task needs to be launched on
each one of them.

Find more details on this task in Data Splitter on page 780.

Step 5 - Create the Xpath SmartNames
Identical as explained in the previous example Creating a Job using XML on page 1639, you
need to

• create SmartNames that you will use in the Create Job ticket. As explained in Step 2 - Create
your SmartNames on page 1640.

• insert those SmartNames in the Create Job ticket. As explained earlier in Step 3 - Insert the
SmartNames in the Create Job ticket on page 1642.

Step 6 - Workflow Result
Select the XML describing multiple Jobs and launch your workflow.

The Create Job task will be started per incoming XML. In this case 2 times, because only 2 had
the status 'ReadyForPrepress'.
 

 

Note:  Workflow controls like the Data Splitter do not appear in this task overview.

See the files the workflow created:
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The 2 Jobs that had the status 'ReadyForPrepress' will be created:

 

 

23.8.3.  Create Multiple Jobs from a CSV file

Summary
Every morning, you receive a CSV file from the planning department with a list of job orders for
the prepress department. Each row in the CSV represents a job order. This data needs to be
converted into separate XML files to send to the Create Job task.

Note:  a CSV is a Comma Separated Value file. This is usually an exported file from a database
or an XLS file.

Tools used in this example:

• SmartNames including Xpath Builder

• Map Data task

• Split XML task

• Data splitter workflow control

• Create Job task

Step 1 - Analyse the CSV file

Tip:  Click this link to find a ZIP with the sample CSV file used in this example.

Our example CSV contains a description of 2 job orders.
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Because the Create Job task does not work with CSV files, we first need to create an XML. And
as you saw in the previous example Creating Multiple Jobs from One XML on page 1646, we will
need 1 XML per Job to create.

Note:  At this point it is good to detect any data fields that will need reformatting. In this
example workflow, the format of the due date will need to be mapped to the format that is
required for that field in the Job Setup.

Step 2 - Create the Workflow Ticket
This is the workflow that we need to create Jobs from a CSV with descriptions of multiple job
orders:

 

 

• The Map Data task defines what parts of the CSV will be mapped into the XML file.

• The Split XML task splits that XML into multiple XML files, like we did in the previous
example.

• The Data Splitter makes sure that the next task sees the many input files. It prevents that
the task is only launched on the first input file.

• The Create Job task creates Jobs, one for each incoming XML file.

Step 3 - Mapping the CSV to XML
The Map Data ticket will

• convert the CSV to XML
• define which parts of the CSV are needed in the XML
• define how the parameters should be named in the XML. You can keep their names if you

want to.
• define what part in the XML will be Repeating Content. This is needed because you are

not sure how many jobs there will be in that CSV / XML. The CSV that you receive tomorrow
can have a different amount of rows. This is the 'for each' principle as explained earlier in
Specifying the Output File on page 1604.

Note:  The order in which we define the settings in this ticket is important.

1. Define the CSV as input file

• Select your CSV file and open the workflow ticket that you made in the previous step.
• Double click the Map Data step. This automatically sets your CSV as input file:
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• Now set 2 specific options that define how our example CSV should be read. Double click

the line 'Input File 1' to open its setup. Set the Field Separator to Semicolon. Because
the first line of the CSV contains the field headers (not values we want to read), check the
option Ignore first line. Remember that your specific CSV might be different, so do check
all options.
 

 
• Click OK to close that dialog.
• Maybe now is a good time to already define the folder and name of your output XML. As

usual, you can use SmartNames in Output in: and File Name:.
• Click Continue.
• Make sure the Output Format: is on 'XML'. In the Options... make sure to activate the

Replace reserved characters in parameter values with XML entities. In this example,
there are no such characters.

2. Define the Repeating Content in the XML

Note:  Make sure you have already read the chapter documenting this advanced technology.
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This ticket allows many ways to use it. Following steps are specific for this CSV to XML
workflow:

In the Map Data ticket, in the canvas where you define the output XML,

• Right-click and choose Insert XML Declaration. This is just good practice when creating
XML.

• Right-click and choose Insert Element . Give it a logical names, for example <Jobs>

• Put your cursor in between the open and closing element, right-click and choose Insert
Repeating Content (or click on ).

Remember:  You can not make any existing content 'Repeating' later ; you need to create
the 'Repeating Content' block first and then add content inside.

 

 
Every line (row) in your CSV represents a job order. So you do want Every line in your CSV
to become the Repeating Content. Remember we already decided to ignore the first line of
the CSV.

• Click OK. A pink field for Repeating Content is created. Also the field parameters were
created automatically. They are colored pink because they are linked to the selected
Repeating Content field.
 

1654



23Automation Engine

 

• Now, inside that Repeating Content field, continue specifying the content of the XML.
Insert Elements and click the pink parameters in between the opening and closing element.

Caution:  Make sure your XML elements do not contain spaces!

This is a basic and valid example:
 

 
You can see we only use 5 of the parameters in this example. You can of course pick up a lot
more.

Note:  Remember that the XML file will just be an in-between format. You will later, in the
Create Job ticket, still map the XML elements to the real fields in the Job Setup.

• Click OK to close the set up of your Map Data ticket.

• Save your Workflow ticket. No need to close it.

Step 4 - Test your CSV to XML Mapping
We advise to already test what we set up in our Map Data ticket. Because if that output does
not look good, it is better to correct that now instead of using a wrong XML file as input for the
next workflow steps.

With the CSV as input file, launch the workflow. Because we haven't defined the settings for the
next workflow steps yet, the workflow will surely fail.
 

 
You now see that your CSV was mapped to an XML. Double click the output file to open it. It
should look like this:
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You see

• the main structure /Jobs/Job

• the description of the 2 Jobs,
• including the 5 parameters that we picked up from their definition in the CSV.

When your XML is not OK, then solve the problem first before defining the next workflow steps.

Step 5 - Set up the Split XML step
• Leave the workflow ticket and go back to your Pilot.
• Go to the folder where you wrote the output of the Map Data ticket and select the

Orders_for_Prepress_CSV2XML.XML

• Open the default Split XML ticket. Your XML will be seen as input file.

• Click Edit to open the Xpath Builder.

• Click on a Job node
 

 
The resulting Expression will be shown above: /Jobs/Job .

• Click OK to close the dialog.
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• Your ticket is ready. Save it with a logic name.
• Open your workflow and replace the default Split XML step with this specific one.

• Save your workflow.

Step 6 - Test your workflow again
• Select the CSV and launch your workflow. Because we haven't defined the settings for

Create Job ticket yet, the workflow will surely fail.

What you now need to see is the 2 XMLs as output of the Split XML ticket.
 

 

• Double-click one of the split off XML files to open it. It should look like this:
 

 

Step 7 - Check the Data Splitter
The Data Splitter control in your workflow should have the (default) settings to 'not group'.
It's purpose is identical as in previous example, where we explained the importance of the Data
Splitter.

Step 8 - Defining the SmartNames for the Create Job ticket
Making the SmartNames and inserting them into your Create Job ticket is not different here
than explained in earlier examples, like in Step 2 - Create your SmartNames on page 1640
and Step 3 - Insert the SmartNames in the Create Job ticket on page 1642. We will first briefly

1657



23 Automation Engine

recapitulate that part and then we will pay extra attention to setting up the SmartName for the
Due date.

Creating the necessary SmartNames
Follow these steps to create the SmartNames:

• In your Pilot, go to the SmartNames tool.
• On the right, in Resolve all using:, select A file: and browse to one of the split off XML files

(for example Orders_for_Prepress_CSV2XML_1.xml).
• Create Xpath Query SmartNames for

• OrderID
• CustomerName
• CustomerID
• CSRemail

Creating the SmartName for the Due Date
• In your Pilot, go to the SmartNames tool.
•

Click on  to create a New SmartName.
• Choose the type : Xpath Query.
• Click on Edit. In the XPath Builder, select the value for the element DueDate.

 

 
• In the setup of an Automation Engine Job, the due date needs to be specified according the

ISO 8601 standard. We therefore need to reformat that date from how it was defined in the
CSV ('30-09-14'). Now set the formatting options as follows (see screen shot below):

• Click on Formatting Options....

• Set the Data Format to Date and Time.
• Set the Format to ISO 8601.
• Choose your Time Zone (the one of your Automation Engine server).

Below left in the dialog, you will see that the Result is still not OK.
• Click on Input Format Options....

• Set the Format to Custom.

1658



23Automation Engine

• Set the Language.

• Choose Custom Format. Now write how your data was formatted in the CSV: dd-MM-
yy.

Caution:  The month is here defined by an 'M' in capitals! A lowercase 'm' will
be seen as minutes!

• Click OK. The correct result should now be visible in the Formatting Options dialog.

 

 
Now save your SmartName and give it a logic name. For example "From XML - CSV Due date
for ISO".

The resulting Create Job ticket

• Open the workflow and double-click the Create Job ticket.

• Add your SmartNames. It could look like this:
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• Now save your workflow ticket.

Step 9 - Workflow Result
In the Pilot, select your CSV file and launch your workflow. It will look like this:
 

 

It will have created these 2 Jobs:
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23.8.4.  Creating Jobs using a Database Access Point

Summary

We will use a Database Access Point to query an external database (one from a business
system where the job orders originate). The query will, at a regular time interval, ask that
database which new Jobs need to be created on Automation Engine. The result of this query
are XML files with the description of those Jobs. Those XML files will be used to create the Jobs
(as shown in previous examples).

Tools used in this example:

• An external database
• A Database Access Point
• SmartNames including Xpath Builder
• The Data Splitter workflow control
• The Create Job task

Step 1 - Analyse the External Database

Tip:  Click this link to find a ZIP with the sample database used in this example.

This is the database we will query in this example:
 

 

• The database software type is a MS SQL server.
• It runs on a a server computer named EAW11DL306.
• The name of the database that we will access is MyExternalSystem (there could be more

served by this same software).
• The name of the (opened) table is MyOrders.
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• The table contains the description of 6 job orders.

• The Status column shows that 3 job orders are 'Ready For Prepress' . Those are the
ones that we want to create on Automation Engine.

Step 2 - Configure the Link to the External Database

Set up the link with the external database. This is done in via Tools > Configure > External
Databases. Learn more on such configurations in External Databases on page 175.

For this example, this is the configuration we need:

 

 

Step 3 - Set up the Database Access Point

Note:  Setting up Database Access Points is documented in Creating or modifying a Database
Access Point on page 1573.

This is an example of the Access Point we need:
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• In the Pilot, create a new Access Point and choose the type Database.

• Give it a logical Name and Description.

Database Settings
• Select the External Database you configured in the previous step.

• Enter the SQL Select Query:

• 'SELECT' indicates which columns you want to get a value from.

• 'FROM' indicates the database table where these columns are.

• 'WHERE' indicates an extra filter: you do not want all the jobs from that table, but only
those with the status 'Ready For Prepress'.

Note:  SQL queries are case-sensitive!

Note:  It is possible to select values from different tables, for example if you want to get
more details about the customer or about production tools. This examples does not do
that.

Note:  Esko does not offer training or support in database queries. This is mentioned in
more detail in Concept of tasks interacting directly with external systems and Concept of the
Interact with Database task.

• After Processing: We here use Update the records to change the status field in the
external database to 'InPrepress'. This is necessary to avoid that, after the next time
interval, these jobs would be created/updated again (because they would still be in the
status 'Ready For Prepress'.)

Tip:  You can choose to not do this status-update here but rather wait until the workflow
really has created the Job. In the following workflow, you can then use an extra Interact
with Database ticket to update that status in the external database with for example a
status 'Job Created and Started in Prepress'.

Monitoring

Define the time interval with which the query should be done.

Note:  There is no need to set it to '1 minute' to make testing easier. See further how we will
use the scan now button instead.

Automatic Actions
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The query will write an XML file for each job order that it finds in the specified status.

• Move Files to: Define where you want those XML files to be written. The Job they represent
does not exist yet so we advise to write them in some central folder. See an example in the
screen shot.

• Rename Files to: Their default name [File] actually consists of [table_name]_[date-
and-time]. You can overrule this or add more SmartNames. Also see later when we show
the result.

• Action: We will add a workflow in later steps of this example. For the moment, leave this to
None.

Click OK to confirm your settings

Your Database Access Point now exists.

Activate the Access Point

Right-click and choose Activate Access Point.
 

 

Step 4 - Test your Database Access Point

Select your Database Access Point and click the  button to scan now.

This will execute the SQL query immediately.

An Alert window will appear with the result. In our example, we see
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• 3 XML files were created because 3 job orders had the status that we were asking for:
'Ready For Prepress'.

• Their name is the result of the SmartNames as explained in the previous step.

This is one of the resulting XML files:
 

 
See how the XML file contains the query that was used.

These XML files will now be used as input files to create Jobs.

Check the new status in the database
Remember the Update the records setting in previous step. See how, for the 3 job orders that
first had the status 'Ready For Prepress', the status has now changed to 'InPrepress':
 

 

Attention:  When testing this Access Point, do remember that every time you run
it that the status of those job orders will change to 'InPrepress' ! This means that
the next time the Access Point will do nothing simply because there are no more
job orders in that database with the required status 'Ready For Prepress'! So, in
between tests, you have to manually reset those statuses to 'Ready For Prepress'.
And remember that the queries are case-sensitive!
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Step 5 - Create your SmartNames
Identical to how we did this in step 2 of the first example, we will now create the SmartNames
that will map the fields in the XML to the Job setup fields in the Create Job task.

1. In the Pilot, go to the SmartNames View.
2. On the right, in Resolve all using:, check the button for A file and browse to one of the XML

files you created in the previous step.
3. Click on Create a New SmartName.
4. In the dialog, indicate the type Xpath Query.
5. Click on Edit to open the Xpath Builder.
6. In the XML content, highlight the first value you want to make a SmartName for. For

example OrderNr.
 

 
The resulting Xpath Expression will appear.

7. Click OK.
You will see the result value 1235 appear bottom left in Result: .

8. Click Save As... and give the new SmartName a logical name. For example
EXA_DB_Myorders_OrderNr.

9. Keep the dialog open and click again on Edit. Repeat steps 6 to 8 for the next SmartNames
that you want to make in this example, except the SmartName for the Due Date, that one
needs an extra formatting. See next step:

10.Creating the SmartName for due date is here identical to how we did it in the previous
example. You need to make sure the output format is according the ISO standard for this Job
setup field. And you need to indicate how the input is constructed. In our example this is
dd-MM-yy.

11.When finished saving all SmartNames, close the dialog (press Cancel or use Save for your
last SmartName)

12.Back in the SmartNames View, type a view filter that will only show your 5 new
SmartNames and then click on Show (right panel)
You should now see this:
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Step 6 - Create the Workflow with the Create Job task
To have the Jobs created automatically, create this workflow:

1. In the Pilot, go back to the Files or Job mode and click on  to create a new workflow.
2. Build a workflow that starts with a Data Splitter (keep its default settings 'don't group

output'), followed by a Create Job ticket.
 

 
3. Already save your workflow with a logical name. Remember we will later attach it to the

Database Access Point.
4. Double click the Create Job ticket and add the SmartNames to their matching fields.

It should look like this:
 

 
The Job Folder setting in the screen shot is just an example of many ways to define it.
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5. Save your workflow.

Step 7 - Test your workflow
In your Pilot, go to that (central) folder where your 3 XML files were written. Select these 3
input files and launch your workflow.

 

 

See how the Data Splitter receives 3 XML files and hands them over one by one to the Create
Job ticket that creates these 3 Jobs:

 

 

Tip:  Also check again if the due dates are formatted correctly.
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Step 8 - Add the workflow to the Access Point and test again
Open your Database Access Point. In Action, choose Launch Workflow and select your
workflow. Click OK to confirm.
 

 

According the set time interval, your Database Access Point will run and now also use its
resulting XML files as input files for your workflow.

When your Database Access Point is selected., you see the workflow task appear:
 

 

23.8.5.  Launching a workflow with parameters from an XML

Summary
A workflow is automatically launched when the business system writes an XML file on a Folder
Access Point. The XML file describes what to do with what file: it contains a full path to a
new design file and describes many parameters that will be used as Workflow Parameters  in
the workflow that will be launched.
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Such a concept is used by business systems that trigger a workflow on Automation Engine
based on a new status. For example: when the business system notices that the status of
a job order changes to 'Design Arrived', it decides to already start a prepress workflow
on Automation Engine (the one that is typical for new designs from that customer). It is also
common that such setups are not limited to only one status leading to one workflow. Some
customers elaborate on this process and have 2 or 3 such links between a status in the
business system and an automatically launched workflow on Automation Engine.

Tools used in this example:

• SmartNames including the Xpath Builder

• Workflow Parameters

• A Folder Access Point

• These tasks: Preflight with PitStop, Create Report (ReportMaker), Zip, Send E-mail,
Upload via FTP

• These workflow controls: Select Referenced File, Router, Data Collector.

Note:  In this example we do not use Automation Engine's Job concept.

Note:  This example assumes you are already comfortable making advanced workflows.

Step 1 - Analyse the incoming XML

Tip:  Click this link to find a ZIP with the sample XML file used in this example.

This is the type of XML file that we receive from the business system:
 

 
In the XML file, notice

• the job order number and some customer details
• a absolute full URL to the design file that just arrived. The design is named 'Shrek.pdf'.

• some decisions if the workflow needs preflighting or creation of a report card.
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Step 2 - Create the Workflow
Now create the basic structure of our workflow. Add the steps as in the screen shot. We will
add more detail later. It is possible that some of the connections can not be made yet.
 

 
Notice these main process steps:

• the workflow needs to run on the PDF, not on the incoming XML file that will land on the
Folder Access Point (that we will create later in this example). That is why we will also use
Select referenced File to select that 'Shrek.pdf' (see further).

• the workflow parameters will indicate whether the route to Preflight with PitStop and/or
route to the Create Report (ReportMaker) needs to be taken.

• if the Router confirms that preflighting is needed, the step will do that and use a Profile
defined in the XML.

• if the Router confirms that a design report card is needed, the Create Report
(ReportMaker) will create that.

• the Data Collector collects the Preflight Report and/or the Design Report card, after which
they are ZIP'ed together.

• the XML will indicate the next router if this ZIP needs to be sent to the customer via E-mail
or via FTP.

Save your workflow with a logical name, for example EXA_XML_Workflow.

Step 3 - Load Workflow Parameters from the XML
The XML files that the external system sends will always have the same elements, but with
mostly different values. This is a typical case to use Workflow Parameters.

Note:  Learn more about Workflow Parameters in Workflow Parameters.

1. Open the workflow you created and in the menu go to Advanced  > Manage Workflow
Parameters.

2. Check Use values from XML file and enter these SmartNames [URL of Folder of
Input]/[File].xml (see also in below screen shot).

3. Click on Load Workflow Parameters from XML... (below right). Browse to your XML
example file and click Open. Choose to Leave blank to select all elements below the root
element.
All the XML element names will be listed, with their value from in this specific example XML:
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4. Click on X to close this dialog.

These parameters are now Workflow Parameters. Every time this workflow is launched,
they will be "loaded" before even starting the first workflow step.

5. Save your workflow.

Step 4 - Select the Design file that is Referenced in the XML
The workflow needs to run on the design file, not on the XML file. The design file is referenced
in the XML file.

1. In the Pilot, select the example input XML file and then open the workflow you created.
2. In the workflow, open the step Select Referenced File.
3. In Select by:, choose File Path.
4. In File Path, click on Edit to open the Xpath Builder.
5. In the Xpath Builder, the input XML file of your workflow will be shown as Example XML

Content.
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Select the path (the value of the Design element).
On top, the resulting Xpath Expression will be shown.

6. Click OK to close the Xpath Builder.
The Xpath Expression is now copied as File Path.

7. Check the option Provide a warning when no files were selected.
 

 
8. Click OK to confirm these settings.
9. Save your workflow.

Step 5 - Pick up the Workflow Parameters in your Workflow
We refer to the standard documentation to learn more on making workflows or on the tasks
and workflow controls used in this example. We will here focus on what is specific in our
example workflow.

Our workflow does not use the Job concept and we (therefore) use Workflow Parameters:
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• in the 3 Routers

• in the Preflight with PitStop step

• in the Create Report (ReportMaker) step

• in the Send E-mail step

• in the Upload via FTP step.

In the 3 Routers

A value in the XML decides where the workflow will route to. Follow these steps for each
Router (they are very similar in all 3 routers):

1. In the workflow, open the Router.
2. In Route based on, choose SmartName value from the list.
3. In SmartName, pick the appropriate one from the list, category 'Workflow

Parameters' ([WFP.) and click Insert.
 

 
As can be seen in below screen shot, the 1st Router in the workflow needs the SmartName
[wfp.PreFlightYesNo] . The 2nd Router needs [wfp.ReportCardYesNo]. The 3rd
Router needs [wfp.SendViaFTPorEMAIL].

4. Close the list of SmartNames by clicking on the X.
5. Now set the relation between the SmartName value and the route to follow.

See this example for the 1st Router deciding if preflight should be done:
 

1674



23Automation Engine

 
See this example for the 2nd Router deciding if a report card should be created:
 

 
See this example for the 3rd Router deciding whether FTP or E-mail should be used:
 

 
6. Click OK to confirm the Router settings and close the workflow step.
7. Save your workflow.

In the Preflight step

In our example, the XML file also decides which preflight profile needs to be used.
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Note:  See the full documentation of this workflow step in Preflight with PitStop Task on page
1045.

1. In the workflow, open the step Preflight with PitStop.
2. Define the Output folder and name. Mind that this is not for the preflight report file.
3. In the Preflight tab, in Profile, insert the Workflow Parameter SmartName  for the profile

as part of the path.
 

 
4. In the Report tab, define the output folder and name for the preflight report that you will

send to the customer.
 

 
5. Set any other options as wished.
6. Click OK to confirm the settings and close this workflow step.
7. Now drag the logical connections between the steps. The pin that represents the output of

the preflight report should link to the Data Collector. That file will be sent to the customer,
the input design file will not be sent.
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8. Save your workflow.

In the Send E-mail step

In our example, the XML file decides if the resulting files will be e-mailed or FTP'd to the
customer.

Note:  See the full documentation of this ticket in Send E-mail on page 418.

1. In the workflow, open the step Send via E-mail.
2. In To, add the Workflow Parameter SmartName for the E-mail of the customer contact for

this job order.
3. In the Subject line, add the Workflow Parameter SmartName for the job order.
4. In Message, add the Workflow Parameter SmartName for the name of the customer

contact.
5. Fill in extra fields as wished

 

 
6. Click OK to confirm the settings and close this workflow step.
7. Save your workflow.
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In the Upload via FTP step

In our example, the XML file decides if the resulting files will be e-mailed or FTP'd to the
customer.

Note:  See the full documentation of this ticket in Upload via FTP on page 1588.

1. In the workflow, open the step Upload via FTP .
2. Enter the name of the Host.
3. In Folder, use the Workflow Parameter SmartNames to send the ZIP into a folder with a

logical name. For example:
 

 
4. Set other settings as wished.
5. Click OK to confirm and close this dialog.
6. TIP: Optionally, you can send the customer contact an E-mail that his files are on the FTP

server. Use the Notification tool of this workflow step to do this. Insert the Workflow
Parameter SmartName for the E-mail and name, similar to how we did it in the settings of
the 'Send E-mail' step.

7. Click OK to confirm the settings and close this workflow step.
8. Save your workflow.

Step 6 - Data structure of this Workflow
This is a workflow that does not use the Job concept, so you can not store all your data in
subfolders of a Job Folder.

The data structure that this example workflow creates looks like this:
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• The folder MIS-XML-WFL DATA contains all the data that this workflow creates. See the
logical names of the (automatically) created subfolders. These folder names were set in the
'Output in' fields of the relevant workflow steps.

• The folder MIS-XML-WFL HOT will be the folder used for the Folder Access Point.

Step 7 - Test the Workflow
1. In the Pilot, select your input XML file.
2. Then select the workflow you created and open it (double click).
3.

Launch and Monitor: Press CTRL-ALT-Enter or Press ALT while clicking .
4. Drag the output file numbers so you can see these output files:

 

 

Step 8 - Create the Folder Access Point and Test Again

Note:  If you are not familiar yet with Access Points, then first read Access Points on page
1561.

1. In the Pilot, go to the Access Points view.
2. Create a new Access Point and choose the type Folder.
3. Give it a logical Name and Description.
4. In Folder Settings, indicate the folder where the external system will write the XML files.

 

 
5. In Monitoring, set your preferred time interval.
6. In Automatic Actions, indicate the folder where the XML files should be moved to once

they are processed.
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7. Set the Action to Launch Workflow and select the workflow of this example.
8. Click OK to confirm and close.
9. With the new Access Point selected, wait until the time interval passes or press 'Scan now'

to see the resulting tasks appear:
 

 
The screen shot shows 2 extra tests where the Preflight ended with a warning.

10.Check the workflow in more detail (output files and folders, XMLs with different options).

Step 9 - Possible Workflow Extensions
Here are some ideas to make this workflow even more powerful:

Feedback new status to MIS

It would be logic to inform the (business) system that sent you the XML on the fact that the
workflow has finished. Here are some tips on how to do that:

• Adding a Create XML step to the workflow and send an XML with the status on a folder that
that system will scan.

• Adding a Interact with Database  step to the workflow and have a database query write
that status right back into that system's database.

Note:  We can not use Milestones here because we are not working in a Job context.
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Learn more about such possibilities in Automation Engine sending data Back to the External
System on page 1560

Adding the Preflight Status already in the Email or Report File name

The customer might want to first check the designs where the Preflight showed an error or
warning. To make this possible, you could extend the workflow to capture the Preflight status
and use it as a SmartName. You could then insert that SmartName

• in the Email subject and or message
• in the FTP folder or name of the ZIP.

23.8.6.  Getting info from a Web Service into a Workflow

Summary

Your company has printing plants in site A and site B. Automation Engine is in headquarters
('site HQ') where also the business system is. To enable a cheaper and faster delivery, your
planning system asks Automation Engine which printing plant is closest to the customer, where
the printed product should be shipped to ('site C').
 

 
Automation Engine asks the web service of GoogleMaps the distances and reports the result
back to the planning system. The planning system sends its request to Automation Engine via
an XML file. Automation Engine will also send a result back as an XML file.

Tools used in this example:

• SmartNames using Xpath Builder

• Workflow Parameters

• Interact with Web Service task

• Map Data task

• The Data Collector  and Sort  workflow control

Step 1 - Analyse the Input XML

Tip:  Click this link to find a ZIP with the sample XML file used in this example.

In our example, this is the XML file that we get from the planning system
(RouteCalcRequest.xml):
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For job-order 234567, the planning system asks which printing site is closest to the delivery site
in Memphis: A (Nashville) or B (New Orleans).

Note:  This example contains address as they are written in the USA.

Step 2 - Configure the Web Service
As documented in Interact with Web Service task on page 1627, the GoogleMaps API needs to
be added in Configure >  External Web Services.

 

 

Step 3 - Create the workflow
Create a workflow with these steps. We will define some details later.

1. In Pilot, select the input XML file and create a workflow with these steps (the 2 'GoogleMaps'
steps are Interact with Web Service steps.)
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See how the workflow will use a Map Data step to join and partially redefine the outputs
from the 2 interactions with GoogleMaps. Alternatively, you could make this workflow by
using a Map Data step after each interaction with GoogleMaps step, and then later end it
with a Join XML step.

2. Edit the names of the 2 Interact with Web Service steps to those as in the screen shot.
3. Save your workflow with a logical name. For example "EXA - WEB - RouteCalc ".

Step 4 - Load Workflow Parameters from the XML
This example does not use the Job concept so we will create Workflow Parameters and pick
those up throughout the workflow.

1. Open the workflow you created and in the menu go to Advanced  > Manage Workflow
Parameters.

2. Check Use values from XML file and enter theis combination of SmartNames: [URL of
Folder of Input]/[File].xml (see also in below screen shot).

3. Click on Load Workflow Parameters from XML... (below right). Browse to your XML
example file and click Open. Choose to Leave blank to select all elements below the root
element.
All the XML element names will be listed, with their value from in this specific example XML:
 

 
4. Click on X to close this dialog.

These parameters are now Workflow Parameters. Every time this workflow is launched,
they will be "loaded" before even starting the first workflow step.
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5. Save your workflow.

Step 5 - Define the 2 Interact with Web Service steps
The settings for these 2 steps are almost identical. We will explain the ones for step 'A' and at
the end show the differences with those for 'B'.

1. Double-click the step 'GoogleMaps A' to open it.
2. Set logical values for the Output in and File Name fields.

 

 
3. Choose the web Service you configured for Google Maps and choose the Method GET.
4. Enter the Path as defined in the API documentation of Google Maps.

Because we are only interested in the distances, we here use Google Map's API
'distancematrix' and not the API 'directions'.

5. In Parameters, use Workflow parameters to define the API's key origins and
destinations.
Unlike in Google Map's API 'directions', the keys 'origin' and 'destination' are both in
plural here! The comma or space between the parts of the address needs to lead to a valid
address specification for Google Maps.

6. The key units is optional. The default already is 'imperial' (miles, feet, inches ..)
7. Press OK to confirm and close this dialog.
8. Now double-click the other step 'GoogleMaps B' to open it.
9. Make sure the File name of the output XML file is different! And for the key origins, use the

Workflow parameters that match the printing site 'B':
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10.Press OK to confirm and close this dialog.
11.Save your workflow.

Step 6 - Settings to Collect and Sort the 2 Responses
It is important in this workflow to keep control over the order of the 2 XML files that Google
Maps will return us. You do not want to risk mixing up the distances for site A or B.

Settings for the Data Collector step:
Keep the default settings: Group all collected data

Settings for the Sort step:
Keep the default settings: Sort by file name in ascending order

Save your workflow.

Step 7 - First test to get the Google Maps result files
To define the settings for the Map Data step, we need the result XML files from the
interactions with Google Maps.

1. In Pilot, select the input XML file RouteCalcRequest.xml and launch your workflow EXA
- WEB - RouteCalc. It will probably fail, because we haven't defined the Map Data step
yet.

2. You should get these 2 files:
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Right-click and choose 'Open to inspect them.

This is what Google Maps returns us when we ask the distance between site A and the
delivery site:

 

 

And this is what Google Maps returns us when asking the distance between site B and the
delivery site:
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Note:  In Google Maps API, the default value unit for time is seconds and the default value
unit for distance is meters.

Step 8 - Settings in the Map Data step
Next thing to do in this workflow is merge this information into one XML file.

1. In your workflow (edit mode!), open the Map Data step.
You will see that it proposes the workflow's input file (RouteCalcRequest.xml) as example
input file . This is not what we want here!

2. Select the line with that default example Input File and double-click to open it. Browse to
the first input file we really want as example: GoogleMaps_result_A.xml, which we wrote
in a subfolder GoogleMapsFeedback. Click OK to confirm.

3. Click Add and browse to the 2nd file we got back from Google Maps and add it as 2nd
example Input File. Click OK to confirm.

4. This also a good time to set a logical folder and file name for this output XML file that we
will feed back to the planning system. Let's assume that our output folder is a hot folder of
that planning system. Use the Workflow Parameter [wfp.OrderNr] in the file name.
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5. Click Continue to start defining the XML content that we want to send back.
6. We will first pick up some parameters from the example input files. On the right, in

Parameters, click Add.
7. Click Edit to open the Xpath Builder and highlight the value of the <text> version of the

element <distance> (222 mi).
 

 
8. Click OK to close. In the Add Parameter dialog, enter the name 'Distance_From_A' and

click OK to close.
9. Do the same for the value of the <text> version of the element <duration> (3 hours 18 mins).
10.Then create the same 2 parameters but using the other example input file

'GoogleMaps_result_B.xml' ('394 mi' and '5 hours 38 mins').
You end up with these 4:
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11.Now specify the output XML as shown in below screen shot. See how we use a mix of

Workflow Parameters and Parameters  from the example Input Files.
 

 
12.Click OK to close this workflow step.
13.Save your workflow.

Step 9 - Test the complete workflow
Our workflow is now complete (we assume that the place where the Map Data step writes the
output XML is monitored by the planning system).

1. In Pilot, select the input XML file RouteCalcRequest.xml and launch your workflow 'EXA
- WEB - RouteCalc'.

2. Check the flow and names of the output files. It should look like this:
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3. Right-click and open the final output file '2345657_RouteCalc_Result.xml'. It should

look like this:
 

 

The planning system will conclude that, for this job order, the printing site in Nashville is
closest.

23.8.7.  Updating a Product Status in an External System via Interact
with Database

Summary

Our workflow includes changing the status of a Product Part to Waiting for Approval.
Because this information is important for the service and sales staff, we will also inform the
business system of this new status.

Note:  In this example, we assume you are familiar with the Products tool. Learn more in the
dedicated chapter Products on page 548.

Tools used in this example:

• Products tool

• Manage Product Status task

• Interact with Database task, to an external MS SQL Server

• Mark File and Select Marked File  task

• ReportMaker task

• Send E-mail  task

Step 1 - Analysis and Setup of the External Database

Tip:  Click this link to find a ZIP with the sample database file used in this example.

Structure of the External Database Table

This is the database we will interact with:
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• The database software type is a MS SQL server.

• It runs on a a server computer named EAW11DL306.

• The name of the database that we will access is MyExternalSystem.

• The name of the (opened) table is ProductionItems.

• The table contains the description of 4 production items.

• The item 'yolo juice' shows its 'ItemStatus' on 'Design arrived'. That is the database
record that we will change in this example.

Configuring the Link to this External Database

Setting up the link to this External Database is identical to how we did it for a previous
example in Step 2 - Configure the Link to the External Database on page 1662.

Step 2 - Initial Product Status and Job Setup
This is the starting configuration we need on Automation Engine:

• In Pilot  > Products > Manage Product Statuses, create a Status 'Design arrived' with a
blue color and create a status 'Waiting For Approval' with a yellow color.

• Create a Product 666-2712. Give it the status 'Design arrived' and link it to the Job 1237.
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• The Job 1237 is for customer FruitCo.
 

 

Step 3 - Create the Workflow
In our example, we assume that the design was already preflighted and made ready for print.
Our workflow starts by creating a proof report and e-mailing it to the customer. It then changes
the Product status to Waiting For Approval and also updates the external database of this
new status.

1. Create this workflow and save it as 'EXA - PRODSTAT' :
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2. In the Mark File step, set the tag 'Product file' .
3. In the Create Report step, we advise these logical settings:

• choose any Report Template

• choose to Export to an extra PDF (we will e-mail the report PDF so you do not want the
PDF to refer to external files!)

• choose a to Output the file somewhere in the Job Folder  (because the report will
probably contain Job specific info)

• choose a logical File Name which will make sense to the customer when he receives it
via e-mail.

 

 
4. In the Send E-mail step, we advise these logical settings:

 

 
5. In the Select Mark File step, use 'Product file' as the tag to be selected.
6. In the Manage Product Status step, select the Status 'Waiting For Approval'.
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7. Save your workflow.

The Interact with Database  step is described in the next step of this example.

Step 4 - Setup of the Interact with Database Step
These are settings we need:
 

 

• Output in and File Name: because we are changing an existing database record, the type
of SQL statement in this example is 'UPDATE'. As mentioned in the documentation of this task,
this task only outputs an XML file for 'SELECT ' statements.

• External Database: select the one you set up for the database in this example.
• Statement: use Other.
• SQL: use the query as shown in the screen shot. The 2 SmartNames make this query work

for all Product (Parts).
• Click OK to close.
• Save your workflow.

Step 5 - Test the Workflow
1. In Pilot, open the Job '1237'.
2. In Products View, select the linked in Product '666-2712'.
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3. Launch the workflow 'EXA - PRODSTAT' that you created (using a Favorite or right-click
Launch with or...).
 

 
4. This is the result in the Pilot ; notice the Product's change in status and color:

 

 
5. This is the resulting finished workflow:
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6. This is how the external database should have changed ; notice the new status 'Waiting

For Approval' for item '666-2712':
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24.  Using Scripts

24.1.  Scripting Concept

Automating Desktop and Other Applications

Although Automation Engine already offers a broad set of tools to create custom workflows,
it is still possible that you miss some functionality or that the available functionality does not
support the native graphics format that you want to run them on.

This is why Automation Engine also offers custom scripting: you can write scripts (small
programs) that typically represent actions that operators do interactively in their graphic
desktop applications..

Once you created that script, the Run Script task enables to insert that task into your normal
workflows. This is how you can automate your desktop applications.

Some examples:

• To automate actions in desktop applications like Adobe Illustrator, Photoshop, InDesign
(Server), etc. (via ExtendScript on Mac Os and Windows).

• To convert files into a format that Automation Engine tasks support. For example converting
non-PDF compatible AI files into PDFs.

Attention:  It is up to the user to verify that his intended use of the offered automation
functionality is compliant with any third party license agreement and/or other
restrictions applicable to any non-Esko products.

Supported Script Types

• AppleScript (Mac)
• ShellScript (Mac)
• Batch files (Windows)
• Windows Script (VBScript, JScript) (Windows)
• ExtendScript (Mac and Windows)

Attention:  When scripting Adobe applications, the Script Runner tool on Windows
does no longer support 32 bit versions of those applications.

The Script Runner Tool

Executing such scripts starts in the Run Script task. One of the settings in that task is to choose
if the script will be executed by a separate Script Runner tool (that you installed earlier on a
Mac or Windows client computer), or if the script can run on the Automation Engine server
itself (in an on-board 'script runner').
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When, for example, your script is a Windows batch file, it will be possible to run it on the
Automation Engine server itself. But when the script needs to interact with a Mac (Adobe)
application, it will require help from a standalone Script Runner that you also installed on that
Mac.

Learn more in The Script Runner Tool  on page 1698.

Extra Information and Tips available as KB articles

Because the area of scripting is often about customization, the examples in this documentation
do not cover all use cases.

We therefor advise to also check Esko's Knowledge Base for articles on this topic.

24.2.  The Script Runner Tool

The Automation Engine does not actually run your custom script: the task communicates with
an Automation Engine Script Runner.

Attention:  As mentioned in Scripting Concept, the 'Run Script' task can run the script on
the AE server itself (a Windows Script or batch file) or it could use a standalone Script
Runner tool on a Mac or Windows client.

Here 's an overview of the workflow when a standalone Script Runner tool is used:
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1. The Run Script task sends a request to run the selected script on its input file(s). The task
can communicate optional script parameters and also defines the output folder for the
resulting file(s).

2. The selected Script Runner processes the request and runs the script.
3. The Script Runner sends the results back to the Run Script task.
4. The workflow continues with the outputs from this Run Script task.

24.3.  Installing Script Runner

Follow these steps to install the Script Runner tool

1. Go to the Automation Engine Server Web page, section Client Apps > Tools and Download
Automation Engine Script Runner.

2. After downloading, double-click the ‘dmg’ file (Mac) or the 'exe' file (Windows) to start the
installation. Follow the instructions in the Assistant (Mac) or Installshield Wizard (Windows).

3. Check the tool's preferences to make sure it is running on that computer:

• On Windows, open Start > All Programs > Esko > Automation Engine Script Runner >
Preferences.

• On Mac, open Applications > Automation Engine Script Runner > Esko > Automation
Engine Script Runner > Script Runner Preferences.

In the Script Runner Preferences dialog, you can:

• Start / Stop the Script Runner (or just check if it is running).

Note:  On Windows, this will run the Script Runner as a 'Service'. Learn about (the need
for) other methods in Adobe Applications on Windows: Run Script Runner as an Application
(Not as a Service) on page 1723.

• Enable / disable Start at login

• View / change the Port that the Script Runner is communicating with

• View / change the default folders for (types of) scripts.

Example (on Windows):
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Attention:  The above shown folders are local, on the Script Runner computer.
Learn how you can (also) store them centrally in Configuring Script Runner  on page
1700.

24.4.  Configuring Script Runner
The Automation Engine server needs to know where your Script Runner tool(s) were installed.
You could for example have 2 Macs dedicated to run scripts and also have the Automation
Engine server itself have some Windows scripts or batch files running.

1. Install Script Runner on the client computers that will run scripts. Learn more in Installing
Script Runner on page 1699.

2. In a Pilot, go to Tools >  Configure.
3. Go to the category Scripts.
4. Now define which computers will run the scripts. Press Insert or choose File > New to add

one.
 

 
5. Give a suitable name to that Script Runner. Press F2 or choose File > Rename
6. In the Host field, enter the computer name or IP address of the Script Runner computer.
7. Enter the Port used to connect this computer to your Automation Engine server.

By default, this is 1983.
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8. Click Test Connection. You should now see a list of all available scripts on that computer or
see a message 'No scripts available'.
These are the scripts that the Run Script Task will let you choose from when you have
selected that Script Runner configuration.
You can store script on a local (Script Runner) client or centrally on the Automation Engine
server:

• Local: You can store scripts on your local client computer on the folder specific for script
type. But note that Automation Engine does not back up these local scripts. It can be
useful however to only have them local when you are still writing and testing a script or
when you do not intend to give access to other Script Runners in your network.

Note:  The default location on a client computer is /Library/Scripts/Esko (Mac) and
C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts (Windows).

• Central: Alternatively, you can store your scripts in a central Automation Engine system
folder. This option is suitable when you want to make your scripts available to all
configured Script Runners. They will then also be part of your Automation Engine
backup.

Note:  The default location on the AE server is C:\Esko
\bg_data_fastserver_v100\Scripts. The subfolder names indicate the type of
script.

9. Choose Save (from the menu of the Configure panel).
10.Select the Configure category Scripts (not a configured item, but one level higher). On this

level you see a dialog where you can choose Download Scripts to download all scripts
from all configured Script Runner tool(s) and centralize them onto the Automation Engine
server. This is done to have a central library that will also be part of your server configuration
backup.

Note:  You will be asked to confirm when local scripts would overwrite central ones.

24.5.  The Run Script Task

Note:  Learn about the concept and the setup of custom scripts in Scripting Concept  on page
1697.

This task contacts a Script Runner tool to run a script on the input file(s).
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1. Run on: Choose the Script Runner item that you configured in the Configure panel.
2. Select the Script Type. The types are different, depending if the selected Script Runner runs

on a Mac or a Windows computer:
a) For Mac: You can choose from AppleScript, Shell Script and ExtendScript.
b) For Windows: You can choose from Batch File, ExtendScript, Windows Script and

Windows Script.
From version 16.1, you can only install the Script Runner tool on a 64 bit host, but you
can still run 32bit Windows scripts by specifying the script type as 'Windows Script (32
bit)'.

3. Select the Application. This field helps to find the right application, especially when you
have multiple versions installed. The drop down list is a default list that you can edit.

• On Mac: this is the (original) name of the .app file of that application
• On Windows: the "Target location" that appears when you ask the "Properties" of that

application. An example:
 

 

Tip:  It is possible that you do not have to enter the full name, but minimally the part
that will help the task to recognize which of the multiple versions you want. For example
when you both have a CS and a CC version, then the year and the bit version do not have
to be mentioned extra (because those are only mentioned after the 'CS' or 'CC' part).

4. Select the Script File. You can select one from the drop-down list, enter a path or/and use
SmartNames.

5. When the script needs one or more optional parameter(s), enter them in Script
Parameters. Click Add and type the parameter.
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Note:  Learn more details and see some examples in the next pages.

24.6.  Scripting on Mac OS

A Script Runner on Mac OS supports AppleScript and Shell Script to automate operations.

Note:

Sample scripts are provided as-is with no warranty of fitness for a particular purpose. These
scripts are solely intended to demonstrate techniques for accomplishing common tasks.
Additional script logic and error-handling may need to be added to achieve the desired results
in your specific environment.

It is up to the user to verify that his intended use of the offered automation functionality is
compliant with any third party license agreement and/or other restrictions applicable to any
non-Esko products.

24.6.1.  AppleScript - Example 1

AppleScript is a scripting language that enables direct control of script-able applications and of
many parts of the Mac OS. An AppleScript-able application is one that makes its operations and
data available in response to AppleScript messages, called Apple events.

We recommend using AppleScript because:

• it is highly integrated into the Mac OS
• it is supported by a lot of third party applications
• it very accessible to scripting beginners.

1. Open the AppleScript Editor and add following code:

 

 

Option Description

main This function will be called by the Script Runner. Only the code in
this main function gets executed.

1703



24 Automation Engine

Option Description

inputs The first argument of the main function: a list of input file paths
(type: list of strings).

outputFolder Second argument of the main function: the folder where AE expects
the script’s result files. AE will continue the flow with the files you
write in this folder. If you leave this folder empty, AE will continue
the flow with the inputs of the Run Script task (type: string).

params Third argument of the main function: additional script parameters
injected into the script via the Run Script ticket (type: list of strings).

log Extra log information in the Run Script task details.

return “OK” This will communicate to the Run Script task that everything went
fine. Other possibilities are return “Warning” and return
“Error”.

2. Save this code as an AppleScript text file in the Script Runner’s AppleScript folder (default: /
Library/Scripts/Esko/AppleScript) or in the Automation Engine AppleScript folder.

 

 

Note:  Script Runner supports ‘Text’ format. Therefore it is essential to change the file
format to ‘Text’.

3. You can add following code to test this script locally in the AppleScript Editor. Save the file
and click Run to execute the script.
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Notice the ‘Hello, World!’ and ‘OK’ result in the event log. The Script Runner does not
interpret the test code in your script. It will execute the contents of the main function and
ignore the rest. You can keep any test code for future local testing.

4. In the Pilot, go to Files view where you can select a file and open a New Task. Choose the
Run Script task, modify its settings and launch the task.
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Learn more in The Run Script Task on page 1701.

Note that the ‘Hello, World!’ in the task details and ‘OK’ state correspond with log “Hello,
World!”’ and ‘return “OK”’ in the script.
 

 

24.6.2.  AppleScript - Example 2

In this example, we use AppleScript to copy every input file with a size smaller than the
size specified in the script parameters to the output folder. To do that, we use inputs,
outputFolder and params in the AppleScript.

First, we illustrate how to duplicate files without the size restriction and then we proceed with
the actual case.

1. Open the AppleScript Editor and add the below shown code. This code is aimed to iterate
through the list of inputs. It enables you to handle the inputs one by one, via the ‘input’
variable.
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2. You can modify the Script as shown below to duplicate the files to a specified output folder

without size restrictions. Save this code as an AppleScript text file in the default AppleScript
folder of Script Runner (default: /Library/Scripts/Esko/AppleScript) or in the Automation
Engine AppleScript folder.

 

 
3. Add the file size check in the code as shown below. This will duplicate the file when the

input file size is smaller than the maximum size from the script parameters. If this condition
is not met, it will add an entry in the log and there will be "Warning". Save the file.
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4. In the Pilot, go to Files view, select the files to be copied and open a New Task. Choose the

Run Script task, modify its settings and launch. This modified ticket will duplicate every
selected file which is smaller than 10MB to the current job’s Script Output folder. In this
example, we executed this task for two files (BigBox.pdf: 22MB and SmallLabel.pdf: <1MB).
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‘SmallLabel.pdf’ is duplicated into the job’s 'ScriptOutput' folder. ‘BigBox.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in a ‘Warning’ state and added an entry in the
task details.
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24.6.3.  Shell Script - Example

In this example, we use a Shell Script to copy every input file with a size smaller than the
specified size in the script parameters to the output folder.

1. Open a text editor and add the below shown code. When the Script Runner executes this
code, $1 (the script’s first argument) will contain a string of input file paths separated by :
. The code splits up the concatenated file paths into a real list. This helps to iterate through
the list and handle the Run Script task’s inputs one by one.

 

 
2. Write the code as shown below. This script copies the input to the output folder if the

input’s file size is smaller than the maximum size from the script parameters. If the size of
the file is bigger, it adds an entry in the log and makes sure the task ends in ‘Warning’ state
(via exit value ‘1’). Save this code as a text file to the Script Runner's Shell folder (default: /
Library/Scripts/Esko/Shell) or to the Automation Engine Shell folder.
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$1 First Shell Script argument: the Run Script task’s inputs. A string of input
file paths, separated by ‘:’.

$2 Second Shell Script argument or output folder: This is the folder where
Automation Engine expects the script’s result files. AE will continue the
flow with the files you write in this folder. If you leave this folder empty,
AE will continue the flow with the inputs of the Run Script task.

$3, $4, $5, … Remaining Shell Script arguments: additional script parameters which
you can inject into the script via the Run Script task.
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exitValue Ending Status of the task

0 OK

1 Warning

2 Error

3. In the Pilot, go to Files view, select a file and open a New Task. Choose the Run Script task,
modify its settings and launch. This modified ticket will duplicate every selected file which
is smaller than 10MB to the current job’s Script Output folder. In this example, we executed
this task for two files (BigBox.pdf: 22MB and SmallLabel.pdf: <1MB).

 

 

‘SmallLabel.pdf’ is duplicated into the job’s Script Output folder. ‘BigBox.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in ‘Warning’ state (due to exitValue=1 in the
code) and added an entry in the task details.
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24.7.  Scripting on Windows

A Script Runner on Windows supports Windows Scripts and Batch files. We recommend
Windows Script for its scripting abilities comparable to batch files, its wider range of supported
features and the simpler syntax. Windows Script is plain-text VBScript or JScript which is
interpreted and run by the Windows Script Host.

Note:  Sample scripts are provided as-is with no warranty of fitness for a particular purpose.
These scripts are solely intended to demonstrate techniques for accomplishing common tasks.
Additional script logic and error-handling may need to be added to achieve the desired results
in your specific environment.

It is up to the user to verify that his intended use of the offered automation functionality is
compliant with any third party license agreement and/or other restrictions applicable to any
non-Esko products.

24.7.1.  Windows Script Example 1

1. Open a text editor and add the below shown code:
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Function
Main

The function that will be called by the Script
Runner. Script Runner executes only the code in
this main function.

inputs First argument of main function: a list of input file
paths (type: list of strings).

outputFolder Second argument of the main function: the folder
where AE expects the script’s result files. AE will
continue the flow with the files you write in this
folder. If you leave this folder empty, AE will
continue the flow with the inputs of the Run Script
task (type: string).

params Third argument of the main function: additional
script parameters injected into the script via the
Run Script ticket (type: list of strings).

WScript.Echo This puts some extra log info in the Run Script task
details and log. This call prints text to the Console
and adds a newline character without Script Runner
context.

Main = “OK” This communicates to the Run Script task that
everything went fine. Other possibilities are Main =
“Warning” and Main = “Error”.

2. You can test this script locally by adding the code shown below. Save this file. Open
command prompt. Change the directory to the script’s parent directory. Run command
‘cscript MyHelloWorld.vbs’.
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This will produce the output ‘Hello, World!’ to the console. The Script Runner does not
interpret the test code in your script. It will execute the contents of the main function and
ignore the rest. You can keep your test code for future local testing.

3. In a Pilot, go to Files view, select a file and open a New Task. Choose the Run Script task,
modify its settings and launch the task.

 

 

Note that the ‘Hello, World!’ in the task details and ‘OK’ state are corresponding with
WScript.Echo “Hello, World!” and Main = “OK” in the script.
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24.7.2.  Windows Script Example 2

In this example, we use Windows Script to copy every input file with a size smaller than the size
specified in the script parameters to the output folder. We use inputs, outputFolder and
params in the script to achieve our objective.

First, we illustrate how to duplicate files without the size restriction and then we proceed with
the actual example.

1. Open a text editor and add the below shown code. This code is aimed to iterate through the
list of inputs. It enables you to handle the inputs one by one, via the ‘input’ variable.
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2. You can modify the Script as shown below to duplicate the files to a specified

output folder without size restrictions. Save this code as a text file with ‘.vbs’
extension (VBScript) in the Windows Script folder of Script Runner (default: C:\Esko
\bg_data_fastserverscrrunnt_v100\Scripts\WindowsScript) or in the Automation Engine
WindowsScript folder.

 

 
3. Add the file size check in the code as shown below. This will duplicate the file when the

input file size is smaller than the maximum size from the script parameters. If this condition
is not met it will add an entry in the log and there will be "Warning". Save the file.
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4. In a Pilot, go to Files view, select the files to be copied and open a New Task. Choose the

Run Script task, modify its settings and launch. This modified ticket will duplicate every
selected file which is smaller than 10MB to the current job’s 'ScriptOutput' folder. In this
example, we executed this task for two files (BigBox.pdf: 22MB and SmallLabel.pdf: <1MB).

 

1718



24Automation Engine

 

‘SmallLabel.pdf’ is duplicated into the job’s 'ScriptOutput' folder. ‘BigBox.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in ‘Warning’ state and added an entry in the
task details.

 

 

24.7.3.  Batch File Example

In this example, we use a Batch file to copy every input file with a size smaller than the size
specified in the script parameters to the output folder.

1. Open a text editor and add the below shown code. This code is aimed to iterate through
the list of inputs. It enables you to handle the inputs one by one, via the command %1 (the
script’s first argument) will contain a string of input file paths, separated by ‘;’.
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2. You can modify the Script as shown below to duplicate the files to a specified output folder

with a size check. Save this code as a text file with ‘. bat ’ extension in the Script Runner
Batch File Folder (default: C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts\BatchFile)
or in the Automation Engine 'BatchFile' folder.
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%1 First batch file argument: the Run Script task’s inputs. A string of input file paths,
separated by ‘;’.

%2 Second batch file argument or output folder: the folder where AE expects the
script’s result files. AE will continue the flow with the files you write in this folder.
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If you leave this folder empty, AE will continue the flow with the inputs of the Run
Script task.

%3, %4,
%5…

Remaining batch file arguments: additional script parameters, injected into the
script via the Run Script task.

Exit
value

Ending Status of the task

0 OK

1 Warning

2 Error

3. In a Pilot, go to Files view, select the files to be copied and open a New Task. Choose the
Run Script task, modify its settings and launch. This modified ticket will duplicate every
selected file which is smaller than 10MB to the current job’s Script Output folder. In this
example, we executed this task for two files (BigBox.pdf: 22MB and SmallLabel.pdf: <1MB).

 

 

‘SmallLabel.pdf’ is duplicated into the job’s 'ScriptOutput' folder. ‘BigBox.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in ‘Warning’ state and added an entry in the
task details.
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24.8.  Using ExtendScript (Mac & Windows)

24.8.1.  Adobe Applications on Windows: Run Script Runner as an
Application (Not as a Service)

When you use ExtendScript on Windows, you can avoid troubles while accessing your user
specific settings such as Adobe applications' Presets , Actions etc. by stopping the Script
Runner service and running it as an application for the logged in user (who also defined
the Adobe settings).

Follow these steps to do this:

• Open Start > All Programs > Esko > Automation Engine Script Runner > Preferences.

• Stop the Script Runner and deselect Start at login (which actually means ‘Start as service’)
and Close Preferences.

• Start it as a console application by double clicking its executable in the Script
Runner’s program folder >\bin_ix86\egscrrun.exe. For example C:\Esko
\bg_prog_fastserverscrrunnt_v141\bin_ix86\egscrrun.exe

24.8.2.  ExtendScript in Adobe Illustrator - Example 1

ExtendScript is JavaScript extended for Adobe CS/CC applications. Adobe provides the
ExtendScript Toolkit (ESTK): a complete IDE (integrated development environment) to program
ExtendScript. Learn more about Adobe scripting resources in the Adobe Scripting Center.
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Attention:  As mentioned in the introduction, Adobe (Windows) 32 bit applications are
no longer supported on a standalone Script Runner tool.

1. Open the ExtendScript Toolkit and add the below shown code. Save this code in the Script
Runner’s ExtendScript folder. The default location is : /Library/Scripts/Esko/ExtendScript
for a Script Runner on Mac or C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts
\ExtendScript on Windows. Alternatively, you can save them in the ExtendScript folder of
Automation Engine.

 

 

Main This function will be called by the Script Runner. Only the code in this
main function gets executed.

Inputs First argument of main function: a list of input file paths (type: list of
strings).

outputFolder Second argument of the main function: the folder where AE expects the
script’s result files. AE will continue the flow with the files you write in this
folder. If you leave this folder empty, AE will continue the flow with the
inputs of the Run Script task (type: string).

params Third argument of main function: additional script parameters, injected
into the script via the Run Script ticket (type: list of strings).

$.writeln This writes extra log information in the Run Script task details and log.
Without Script Runner context this call prints text to the Console, and
adds a newline character.

alert This registers some extra log info in the Run Script  task details and log.
Without Script Runner context this call displays an alert box.

return “OK”; This communicates to the Run Script task that everything went fine.
Other possibilities are Return = “Warning” and Return = “Error”.

2. To test the script locally in the ExtendScript Toolkit, add below shown code, save and run the
script.
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As a result, ‘Hello, World!’ and ‘OK’ are shown in the Console and the alert box pops up:

 

The Script Runner does not interpret the test code in your script. It will execute only the
contents of the main function and ignore the rest. You can keep your test code for future
local testing.

3. In the Pilot, go to Files view, select a file and open a New Task. Choose the Run Script task,
modify its settings and launch the task.

 

1725



24 Automation Engine

 

Note that the ‘Hello, World!’ in the task details and ‘OK’ state are corresponding with
$.writeln("Hello World!")and Return = “OK” in the script.
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24.8.3.  ExtendScript in Adobe Illustrator - Example 2

In this example we use ExtendScript to Open a file in Illustrator and print it using a Print
Preset.  

Note:  Make sure you read this page first: Adobe Applications on Windows: Run Script Runner as
an Application (Not as a Service) on page 1723.

Note:  To prevent having to start up the Script Runner every time you log in, add its executable
to your user’s/system’s Startup Items.

1. Define a My Print Preset in your Adobe Illustrator application.
2. Open the ExtendScript Toolkit and add the below shown code. This code is aimed to iterate

through the list of inputs. It enables you to handle the inputs one by one, via the input
variable.

 

 
3. To print every input file using a Print Preset from the script parameters in the Run Script

task, write the code as shown below. Save this code in the default ExtendScript folder (of
Script Runner or of Automation Engine).
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4. In a Pilot, go to Files view, select a file and open a New Task. Choose the Run Script task,

modify its settings and launch the task.
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Launching this ticket will print the selected Illustrator files using the Print Preset specified
as script parameters (My Print Preset) in the task.

24.8.4.  ExtendScript in Adobe Photoshop - Example

Note:

Sample scripts are solely intended to demonstrate techniques for accomplishing common
tasks. Additional script logic and error-handling may need to be added to achieve the desired
results in your specific environment.

It is up to the user to verify that his intended use of the offered automation functionality is
compliant with any third party license agreement and/or other restrictions applicable to any
non-Esko products.

In this example, we illustrate a script that performs a Photoshop "action" and then
produces a JPEG output. The script 'EskoPSDoActionAndSaveasJPG.jsx' is available from the
sample scripts subfolder "ExtendScript" in /Library/Scripts/Esko (Mac) or C:\Esko
\bg_data_fastserverscrrunnt_v100\Scripts (Windows).

1. You have to save the Set and Action in Photoshop. In this example we are using an action
named "Molten Lead" which is one of the "Default Actions" (folder) as Set (variable 2)
and "Molten Lead" as Action (variable 1).

2. You can open the script with ExtendScript Toolkit to edit the script if required. However, in
this sample, we do not need to edit the script.
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3. Edit the settings of the Run Script task as shown below:

 

 
a) Run on: is the name of the computer where your Automation Engine ScriptRunner is

installed. The name in this example is ShaletMac. Learn more about configuring and
naming a Script Runner in Configuring Script Runner  on page 1700.

b) Script Type: choose ExtendScript.
c) Script File: choose EskoPSDoActionAndSaveasJPG.jsx.
d) Script Parameters: Add the name of your Photoshop Action name followed by your

Set. In this example, Molten Lead; Default Actions
e) Save the task ticket.

4. Launch the task:
a) Select a Photoshop file.
b) Right-click the file and browse for the ticket.
c) Click Launch.
You will see that while the script starts to run on the Automation Engine server, Photoshop
opens, performs the actions, closes and continues the script. The result of this sample script
is an adjusted JPEG file.
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24.9.  Script Samples

Click this link to download a PDF containing some samples of scripts.
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25.  How to ...?

25.1.  How to Work with Technical Inks

Note:  Technical inks (and varnish inks) are only used in Normalized PDF. This attribute is not
present in PDF+ files.

The recommended way to work with technical inks is to follow these main rules:

• Put objects in technical inks in top layers.

 

 

Objects colored with technical inks are stored in 1 or more layers at the top of the
render stack. The advantage of this is that, when you use a PDF generated this way in an
application capable of handling layers (PDF Optional Content Groups), you will also be able
to view and print the design correctly with or without objects in technical inks by switching
on or off the corresponding layers.
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Caution:  This only works as intended when the objects in technical inks do not
influence the normal printing separations of the file. Also see below. Objects in
technical inks do not influence printing separations.

It is best to avoid that objects in technical inks influence printing separations, for example
knocking them out. Therefore it is best to stroke or fill objects with a spot color in blend
mode Normal and switch on Overprint.

Do not use technical inks in opacity masks.

Do not put objects with printing inks on top of objects with technical inks in other blend
modes (Hue, Saturation, Color, Luminosity, etc.).

• Avoid using technical inks and normal printing inks in a same object.

• You can use the task Optimize and Clean (PSFix) to detect any interaction between objects
in technical inks and printing separations. Its auto correction feature can switch on
overprint if the object was put in knock-out. Since overprint is an attribute of the object
and not of an individual separation of an object, this will result in unintended changes of
the printing separations.

• Use a solid tint.

• It is recommended to color an object with 100% of a technical ink. Avoid using tints,
shadings, etc.
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25.2.  Hybrid Press Workflow

25.2.1.  Concept of Hybrid Printing

Packaging and labels are sometimes printed using a combination of printing methods: some of
the separations are printed in flexo, a metallic separation is printed using screen printing, and
some other data are added to the label using inkjet printing.

In the label industry it is common to see all these printing methods integrated in a single press.
These presses are often referred to as “combi-presses” or “hybrid presses”. 

These pages describe how to handle designs that will be produced using several printing
methods. The described workflow is valid both when using integrated hybrid presses and when
using multiple presses of different types.

25.2.2.  What is the Problem?

Working with hybrid presses poses specific challenges in the prepress phase.

You may receive a file that contains separations for different printing methods. In your
prepress and output workflow, some of these separations may need to be treated differently
than others. Some typical cases:

• Trapping parameters may need to be different per printing method
• Printing marks may need to be different per printing method
• Plate distortion parameters may be needed for one printing method (typically flexo) but not

for other separations.

25.2.3.  How to define the Printing Method of a Separation?

The Printing Method of a separation can be set by an operator in an Esko editor (ArtPro,
DeskPack, PackEdge, Plato) or by a setting in a Normalize task. The there set printing methods
are stored in the ArtPro file or Normalized PDF(PLA) file but also in the PDFs that you export
from those files (using the editor or a task).

Predefined list of printing methods
These editors and tasks offer a predefined set of printing methods. It is recommended to use
these whenever possible as this will guarantee interoperability of the generated files between
sites and even countries. The values are stored in the PDF with proper localization handling.

You can also enter custom values. In this case these custom values need to be agreed between
sender and receivers so that printing methods can be recognized consistently by receivers.
This is not obvious in a global economy with senders and receivers in different parts of the
world.
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Assigning a Printing Method manually in ArtPro, PackEdge or Plato
Figure 1: The Separations dialog in ArtPro

Figure 2: The Inks dialog in PackEdge and Plato

Assigning a Printing method in a 'Normalize' Task
The Normalize PDF file task, the Normalize PostScript, PDF, Illustrator file task and the Normalize
Tiff/IT file task offer a dedicated column in their tab 'Inks':

 

 

Automating the Assignment of a Printing Method
Follow these steps to automate the assignment of printing methods:

1. You can use the Pilot and set these values manually in the Inks tab of the Job Setup dialog.
These values can also be set during automatic job creation by an MIS system, via JDF or XML.
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2. You can then use the Check Job Parameters task to apply the values defined in the job setup

to PDFs and Normalized PDFs. Mind that you will need to enable the Auto Correct option
for Inks:
 

 

25.2.4.  How Are the Printing Methods Stored in the PDF?

The printing method of each separation is stored in the XMP of the PDF (Normalized or native
PDF). This makes this information also accessible for third-party applications.

An example:
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25.2.5.  How to Differentiate the Processing of Separations for
Different Printing Methods?

The Extract Inks task in Automation Engine was created just to enable workflows handling these
different requirements for different printing methods.

Here is an example workflow:

 

 

1. In the first step, the Check Job Parameters task sets printing methods for the different
separations in the incoming PDF. In case you use the Products tool, you could use the
Check Product Parameters task in stead.

2. Then, a Step & Repeat task creates a layout.

Note:  When the task also applies a SmartMarks set, you can choose to already set the
marks in inks of a selected printing method. See this example of defining inks of a gradation
strip:
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3. The Extract Inks task then creates 3 different files only containing the inks of the selected
printing method:

• The top branch of the workflow extracts the flexo separations. 
 

 

• The middle branch extracts offset separations.

• The bottom branch extracts separations for screen printing.
4. Finally, each branch sends the PDF(PLA) with only the selected separations to a RIP with

specific settings for that same printing method.

25.3.  Integrating with Nexus (soon outdated)
Integrating with Nexus is based on a task that in v18 was declared to be soon outdated.

Learn more in the chapter "How to...?" of the manual of AE 16.1. It contains information on this
setup and also the page describing the Send to Nexus task.

25.4.  Integrating with Odystar (soon outdated)
Integrating with Odystar is based on a task that in v16 was declared to be soon outdated.
Learn more in Send to Odystar (soon outdated).
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26.  Pre-Install IT Requirements

26.1.  Introduction

This document describes the information needed to prepare and facilitate the installation of an
Automation Engine. It also answers typical IT related questions.

General system requirements for the involved computers can be found on this page.

Note:  This document mentions components and features that are commercially optional.

Note:  CP is often used as abbreviation for 'Commercial Print' (page workflows).

There are two sections in this document :

1. Technical details of an Automation Engine setup.
2. Guidelines and good practices in setting up an Automation Engine environment.

26.2.  Technical Details

26.2.1.  Automation Engine in its environment

Components Glossary

Component Description

Automation Engine Master server Main server where all clients are connecting
to. This server manages the Jobs, tasks and
other databases. This server also executes the
actual server tasks.

Automation Engine Assistant server Assistant server that can execute tasks to take
away load from the Master server.

Application server Component serving the Automation Engine
page workflow tools (the Pilot modes for
commercial print). It is also used by some
tools in the Layout module. Note: Since AE
v20, the AE Viewer no longer uses this server
but uses its own Viewer server.
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Database server Server where the databases are located.
Typically this component is found on the
Automation Engine Master server.

Client A client workstation is connecting to the
Automation Engine Master server via Pilot or
Shuttle. Editors can also connect to the server
(Esko editors or Adobe Illustrator).

Imaging Engine Esko RIP component built into Automation
Engine (commercial option). Offers tasks to
generate digital files for proofs and/or plates.

FlexRip Separate Esko RIP product that the
Automation Engine Master connects to.
FlexRip/FlexProof was the predecessor of
Imaging Engine.

WebCenter Esko's online collaboration tool.

File server Where the actual data is. Automation Engine
can work with all files in data shares that
you configured to be Automation Engine
'Containers'.

Mail server Your mail server that can be used by
Automation Engine to send out e-mails.

 

 

26.2.2.  Automation Engine installation
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Automation Engine System Account
Automation Engine needs a System Account user to run its service and to connect to other
network components.

The Automation Engine System Account must meet following requirements on the
Automation Engine Master server computer:

• should be a member of the group Administrators

• should have the right "Logon as Batch"

• should have the right "Logon as Service".

An installation of Automation Engine creates a local user BGSYSTEM on the Automation Engine
Master according to these requirements. This user then serves as the Automation Engine
System Account.

If, for IT reasons, you want to change this user, you need to use the dedicated tool in the
System Account page in the Server Admin web page.

Services
An installation of Automation Engine will install these services:

Service name Service running under Purpose

BGMD Automation Engine System
Account

Automation Engine's main
service

EG STATION INFORMATION
SERVICE

Local System User System info collection service

EGWEBSRV Automation Engine System
Account

Web server for the Server Web
Page and client updates

FLEXlm License Manager Local System User License manager

FLEXnet licensing service Local System User License manager

EGNKLS Local System User Esko NetKey License Server.
Used as Global Vision License
server for the Global Vision
"Inspect" tasks.

MSSQLSERVER Network Service Default database server

MSSQLServerADHelper Network Service SQL Server Active Directory
Helper

SQLWriter Network Service SQL Server VSS Writer

SQLBrowser Network Service SQL Server Browser

Shares
These shares are created during the installation of Automation Engine:
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Sharename Purpose Access

AutomationEngineImgFolder Temporary folder for image
data

server only

AutomationEngineLogging Automation Engine log files server only

AutomationEngineTmpFolder Temporary folder for
Automation Engine tasks

server only

bg_data_cms_v010 Central resources - Color
management data

server and clients

bg_data_custom_v010 Central resources -
Automation Engine presets

server and clients

bg_data_dgc_v010 Central resources - Dot gain
curves

server and clients

bg_data_fonts_v040 Central resources - Fonts data server and clients

bg_data_ipldata_v010 Central resources - CIP3/
Inkplanner presets

server and clients

bg_data_marks_v010 Central resources -
SmartMarks sets

server and clients

bg_data_screens_v020 Central resource - Screens for
Imaging Engine

server and Imaging Engine
RIPs.

bg_data_system_v010 Central resources - License
configuration

server and clients

DeskPackContainer Container for temporary
DeskPack iles

server and clients

ExampleJobContainer Default data container created
at first install

server and clients

FastRipTask FlexRip temporary folder server and clients

Impose FastImpose templates, marks
and defaults

server and clients

PitStop Enfocus PitStop templates and
configuration data

server and clients

Note:  The access right of these shares is set to Read/Write for 'Everyone'.
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Note:

In case you would like to restrict permissions on these shares, be aware that these permissions
affect the access by desktop applications like PackEdge, ArtPro Action List Editor, Curve Pilot,
FlexRip, etc. Note that they do not affect access to the Pilot.

The Windows users used to start up these desktop applications, as well as the Windows users
used to mount shares needed for Mac applications, must have read and write access to those
shares.

Additionally, the Automation Engine system account must have read and write access to these
shares as well.

Installation Folder
Automation Engine is by default installed in a folder Esko on the root drive. Automation Engine
can not be installed in the Program Files or Program Files (x86) folder.

Every Automation Engine installation will create and use a temporary folder in the Esko folder
(BG_TMP).

Tip:  It is good practice to defer that folder to a drive other than the system drive. Learn more
in the Installation Guide on page 1761.

26.2.3.  Network Details

Network Configuration
Automation Engine requires TCP and IPv4 to work.

Note:  IPv6 is not supported.

You need to configure DNS correctly. Links to other networks should be configured using host
names, not IP addresses.

If a DNS and/or proxy server is used, make sure all components in the environment
(Automation Engine server(s), Automation Engine client, Proxy Server) are able to do an
nslookup on hostname of all other components.

Caution:  After installation of the Automation Engine software, the host name of that
server can not be changed.

Ports
These are the ports used by Automation Engine and the client software:

TCP :

• 8000-9000 for BGMD and the Automation Engine servers
• 5182 for ShuttleServer, unless configured otherwise
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• 4401 for the Automation Engine JDF Server (service port)
• 1433 for the SQL server (default installation)
• 27100 and a dynamic port for Station Information Service
• 1098 RMI port for the Automation Engine Application Server
• 1099 the JNDI Naming Service for the Automation Engine Application Server
• 4444 the RMI Object for the Automation Engine Application Server
• 4445 the Transaction Manager for the Automation Engine Application Server
• 5544 the Automation Engine CDID server that communicates with a CDI's DFS application
• 10002 the Global Vision License server (learn more here)

• 27000 for the License Manager service

• 4420 for JMF communication with Imaging Engine.

HTTP:

• 80 + 9999 for Tomcat/ServerAdminWebPage (egwebsrv.exe)
• 8080 for the Automation Engine Application Server
• 4411 for the Automation Engine JDFServer (JMF)
• 4412 for the Automation Engine Frip2JDF Server, which communicates with the DFS/

PlatePrep and Grapholas software on CDI's
• 4415 for the Automation Engine Web Service (ElemServer) (unless configured otherwise)
• 9000 for the web server port of the browser UI as used in the QuickStart deployment of

Automation Engine
• 44110 for the JMF port of the SubmitJDF task
• 44111 for JMF port of the Devices server.

Connection with clients:

• The server sometimes relies on ephemeral ports, for example for uploading files in Pilot.
These ports are picked randomly between 49152 and 65535.

LAN/WAN Network Performance
Automation Engine client-server connection requires decent network performance. This is also
true for the server's access to remote containers and/or devices.

Latency simulations in a lab environment show that:

• With delays below 20ms, client (Pilot) performance or access to remote containers and/or
devices is optimal.

• With delays till 50ms, client performance or access to remote containers and/or devices is
relatively acceptable.

• With delays around 100ms (and higher), client performance or access to remote containers
and/or devices is poor to unacceptable.

Therefore Automation Engine is not suited to run in a WAN environment.
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Warning:  Using tools such as remote desktop services is in violation with the EULA
(End User License Agreement).

26.2.4.  Database server

Installing Automation Engine also automatically installs an SQL Express database engine.
However, for scaling and performance reasons, one can choose to use a Full SQL Server.
Learn more in Using a Full SQL Server on page 1755.

Note:  Since v18.0, SQL 2008 and 2008 R2 are no longer supported. Learn more on the Esko
Knowledge Base in this article about upgrading SQL 2005/2008/2008R2 to a recent supported
version.

Installation Details
Mandatory components:

• SQL Server Database Engine
• Replication and Fulltext components

Mandatory installation parameters:

• Collation settings: Use Windows' defaults (supported from Automation Engine 14.0.1 on)
• Security Mode: SQL
• TCP protocol for the SQL Server service: enabled

Note:  These are the installation parameters used to install the default MSSQL Express server:

/ACTION=INSTALL
/FEATURES=SQLEngine
/BROWSERSVCSTARTUPTYPE=Automatic
/SQLSVCSTARTUPTYPE=Automatic
/SQLSVCACCOUNT=”NT AUTHORITY\SYSTEM”
/SQLSYSADMINACCOUNTS=”BUILTIN\ADMINISTRATORS”
/IACCEPTSQLSERVERLICENSETERMS=1
/INSTANCENAME=<instancename> of MSSQLSERVER for unnamed instance
/SECURITYMODE=SQL
/SAPWD=<default password>
/TCPENABLED=1

Configuration details
Automation Engine requires 4 databases to run:

• BSJobs
• FastLane_TM
• FastLane
• fasttrack

Note:  The terms BS and FastLane refer to names of old Esko products that Automation
Engine's server framework originates from.

To access and modify these databases, Automation Engine needs a user who can:
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• Log in to the Database server
• Database roles:

• db_owner: Members have full access.
• db_accessadmin: Members can manage Windows groups and SQL Server logins.
• db_datareader: Members can read all data.
• db_datawriter: Members can add, delete, or modify data in the tables.
• db_ddladmin: Members can run dynamic-link library (DLL) statements.
• db_securityadmin: Members can modify role membership and manage permissions.
• db_backupoperator: Members can back up the database.

Oracle as Database Server for the Application Server component

Attention:  From Automation Engine 18 on, this support for Oracle was set to 'Soon
Outdated'. This means that, in a next major version, support for this database server
will be removed.

An Oracle database server can be used to run the Automation Engine Application
Server.

Using Oracle will increase performance of the Pilot modes Pages, Proofs and Plates. These
modes are only used in a production workflow for books and magazines.

Following database server versions are supported:

• Oracle 10g Standard Edition, Enterprise Edition
• Oracle 11g Standard Edition, Enterprise Edition

Caution:  Using Oracle as a database server for BSJobs, FastLane_TM and FastLane
is not supported.

26.2.5.  File Server

File Server OS Types
All Esko applications running on Windows OS can use data that is available on network shares.
For Automation Engine to perform according to expectations, these shares need to be on NTFS
volumes on Windows file servers. As file server, we recommend to use Windows Server 2008
R2, Windows Server 2012, Windows Server 2012 R2 or Windows 2016 (preferably the same
version as for the Automation Engine server).

As only Windows file servers are supported, Mac OS X or Unix/Linux (CIFS/SMB or NFS) data
servers for example are not supported (including many Network Attached Storage units).

Supported Access Protocols
Esko does not support file server access over protocols other than "Windows File Sharing".
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File Server Access
The Automation Engine System Account must have read and write access on the shares. Learn
more in Automation Engine System Account on page 1741.

26.2.6.  Mail Server

Automation Engine can send e-mail to communicate with your colleagues or customers, but
also with Esko Customer Service, to report and document any problems.

Supported protocols are :

• smtp
• smtps (secure)

You can set up your corporate mail server or any Google Servers to be used by the Automation
Engine to send e-mails. For setting up a Google Server, you need a Google mail account. You
can configure Automation Engine to use a secure connection to smtp.gmail.com on port 465
using that account. 

Learn more on configuring the use of an e-mail server in E-Mail Configuration on page 173.

26.2.7.  Users and Groups

Old and New User Model - Before and Since v20

BEFORE v20. The OLD User Model

Before v20, users created by Automation Engine were always Windows users on the
Automation Engine server computer. You could use a tool in Automation Engine to add them,
but they were actually created on the Windows OS of the server.

• Local Windows user. This is a user whose user name and encrypted password are stored
on the computer itself.

• Domain Windows user. This is a user whose user name and password are stored on a
domain controller rather than the computer the user is logging in to. Your IT staff manually
had to add those domain users to the Windows groups BGUSERS or BGADMIN.

As security requirements became more important, Automation Engine had to step away from
this model.

Learn more on the page Migrating from the Old User Model to the New one  on page 1748.

SINCE v20. The NEW User Model

As introduced in the page about Authentication and Authorization, user accounts that you can
sign in with to Automation Engine 20 and later can come from several Identity Providers (IdPs).

Creating users using an Automation Engine tool no longer creates Windows users.

1747

https://en.wikipedia.org/wiki/Identity_provider


26 Automation Engine

Since v20, Automation Engine accounts can be provided:

• by Automation Engine itself: These are called Internal users.

• by the Windows user subsystem: These Windows users exist after an upgrade
(corresponding to both local and domain Windows users from the old user model), or can
get created when a domain Windows user signs in for the first time.

• by an external IdP:

• LDAP.

Attention:  In v20.0, the support for LDAP users is still in pre-release.

Only Microsoft Active Directory on a Windows Domain Controller is supported as an
external IdP.

When LDAP support goes mainstream, Automation Engine setups with Windows domain
users will obviously be guided to use this type of provider.

• The support for more providers is in progress.

Configuration of the User Model in Automation Engine

You can disable specific identity providers and configure the ones you want.

This is done in a special version of the Server Admin web page that only runs locally on the AE
server computer itself.

Learn more in the chapter on AE Server management, in The AE Server Config web page on page
1778.

Migrating from the Old User Model to the New one

Automatic Migration to the New User Model during an Upgrade to v20

When upgrading an Automation Engine to version 20.0 or higher,

• All existing Automation Engine users, both local and domain Windows users, are converted
to the new user model and categorized as users of the provider 'Windows'. See the column
Provider in the Users view.

• You can use these migrated users in v20, but, in a next major version, Automation Engine
will no longer support users of the provider Windows.

Attention:  We strongly advise to prepare to further migrate users from the legacy
provider Windows to the modern Internal or LDAP provider. Learn about the
dedicated tool to migrate users.

• The migrated users keep all their attributes, including its e-mail, Access Rights, Views, Smart
Views, Favorites, etc.

• The migrated users can sign in with their same user name and password.
• The former user properties Name and Domain are now combined into the single new User

Name property in which the former name and domain are separated by the @ sign.

• New AE users with provider Windows that map to local Windows users (on the AE master
server) will always have a user name that ends in "@<server>", with <server> being the
host name of the AE master.
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• As before, when a user's domain is not the local host, he needs to add the domain name
to his user name, for example george23@bigcompany.com .

• The upgrade also migrates the two predefined Windows user groups BGADMIN and
BGUSERS to the v20 concept of groups, where they still contain the same users.

• Members of the group BGADMIN are, as before v20, granted the right to administer the
server.

• The upgrade also creates as many new AE roles as there were custom groups as you
could see in the Pilot of the older version ( Setup views >  Users view >  tab Groups).
Their names and predefined Access Rights are kept, as these new AE roles serve the same
purpose as the old custom groups. The imported AE users that previously belonged to such
an old custom group, are now attributed the corresponding new AE role.

• Automation Engine continues to need a System Account user to start and run the
main server software (the service BGMD) and to enable connectivity to other network
components. This account (by default the user BGSYSTEM) still needs to be a Windows user,
for example to grant client users the access to 'Explore' Containers (access to data shares).
Learn more in Automation Engine System Account on page 1741.

When, on v20, Restoring a Backup from an Older Version

• All users in the backup (these are all users that at least once actively logged on to the older
version server where the backup is taken from) are 'imported' at restore time into the new
user model of AE 20.0 as new AE users with provider Windows.

• The behavior after restoring is identical to how it was before v20. For example, only the user
related information about Favorites is restored, which implies that not all functionality that
in one way or another relates to users and/or relates to information about them will behave
as on the system the backup was taken from).

• The behavior about local or domain Windows users after the restoring is the same as after
an upgrade to v20 (see above).

Migrating Users Yourself to another Provider

The Users view offers a dedicated tool to manually migrate users.

Learn more in Migrating Users on page 1749.

Migrating Users

Migrating Windows users to Internal or LDAP users

• In the Users view, select one or more users from the provider Windows.

When selecting multiple Windows users, they must all belong to the same domain. The
domain of a user is the part of the user name after the (last) "@" character.

Attention:  Users that were not visible in the Users View at the moment of selection
will not be taken into the selection. An example: If you have 200 Windows users
belonging to the same domain, you should not select all of them and migrate all 200
in one go. Only the users visible in the view at the time of selection will belong to the
selection (maximum +- 50).

• Right-click your selection and choose Migrate Users...
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• Provider: Select the new provider:

• Internal:

• Windows user passwords cannot just be taken over. That is why users that are
migrated to an internal user will receive an e-mail that invites them to choose a
new password. When no e-mail address was set, the password of the user will
need to be changed manually by the administrator.

• All other user related properties are kept (Full Name, E-mail Address, Description).
• Note that migrating a user will not remove that local Windows user at the Windows

OS level, nor will it remove it from the BGUSERS or BGADMIN local Windows group
it belongs to. Still it will not be possible anymore to use this local Windows user's
credentials to gain access to Automation Engine.

• LDAP:

Important:  In v20.0, the support for LDAP accounts is still in pre-release.

• Remove Groups: When migrating users, it is possible to select some groups from which
the selected users should be removed.

This could be the moment to remove them from the old groups BGUSERS and BGADMIN
that were migrated during the upgrade to v20.

• Domain: Leave this field empty to strip of the domain name from the user name. Or
type in a new domain name for that user. Be aware of these consequences:

• When migrating to the Internal provider:

• Leaving the domain part as it was will always require the full name to be used
at sign in time (whereas, before migrating the user, the name without the domain
part may have been sufficient).

The benefit however is that this choice ensures that all user related info is kept
(settings for Views, Access Rights, Red Alerts as well as Preferences and Favorites)
and user related behavior remains identical (for example user presets in Access
Points, To Dos, Tickets, SmartName resolving, Notification e-mails).
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• Clearing the domain part makes it easier at sign-in time, but comes with the
limitation that only the user related info about Favorites can be kept. This choice
may also influence the user related behavior.

• Changing the domain part into another domain name is possible, but probably
does not make much sense. It also comes with the same consequences as clearing
the domain part.

• When migrating to the LDAP provider:

• Leaving the domain part as it was keeps all user related info (settings for Views,
Access Rights, Red Alerts as well as Preferences and Favorites) and user related
behavior remains identical (for example user presets in Access Points, To Dos,
Tickets, SmartName resolving, Notification e-mails) .

• Changing the domain part into another domain name could make sense if that
is required to map the (domain) Windows provider identities to LDAP provider
ones. This however comes with the limitation that only the user related info about
Favorites can be kept. Also, the user related behavior may be influenced by this
choice as well.

• Clearing the domain part makes no sense.

• Click Migrate. A dialog will provide feedback.

FAQs about the User Model - WIP
• Q: Does Automation Engine support Single Sign-On?

The Automation Engine client software does not yet offer any implementation for Single
Sign-On" (SSO).

• Q: What if the password of the only Admin user can't be found?

1. When you have access to that user's mailbox, try the "Forgot password?" tool to set a
new password.

2. When you can't use this tool, contact Esko Support.

Attention:  For security reasons, user information is kept out of Automation
Engine's SQL databases.

• Q: What happens when I restore a backup that contains pre-v20 users?

For example: you have a new installation of v20 and restore a backup onto it that was made
of a v18.1.

The v18.1 users in that backup will be added to the new v20 as they were: They will appear
in the Users view, with provider Windows.

So basically the result is the same as if you would have upgraded on that server from v18.1
to v20.
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User and Groups in the Old User Model

Windows Users & Windows User Groups

Before v20, users in Automation Engine always mapped to Windows users Automation Engine
master server computer. 

These Windows users were organized in two local Windows groups on that Automation Engine
server:

• BGUSERS: normal users

• BGADMIN: administrator users

Attention:  Automation Engine user groups do not correspond to Windows user
groups.

Before v20, in the old user model, there was no tool in the Pilot to create user groups. All had
to be done via Windows tools.

Before v20, when you used the tool in the Pilot to create a new user, a local Windows user with
the same name was created on the Automation Engine server computer.

Windows Domain Users

You could also add existing Windows "domain users" to become Automation Engine users. This
is still valid in the new user model since v20.

If you want to use domain users, your IT staff needs to assign these domain users to either the
BGUSERS or the BGADMIN local Windows group. 

To use domain users in Automation Engine, this requires that the Automation Engine System
Account can retrieve user info from the Active Directory.

Learn more in Automation Engine System Account on page 1741.

Caution:  Automation Engine does not offer support for Domain Groups.

The System Account

The Automation Engine System Account is a special user that runs the Automation Engine
services and connects to other network components.

The default System Account is the user BGSYSTEM.

You can change this to another account by using the System Account page in the Server Admin
web page.

26.2.8.  The Automation Engine Pilot

1752



26Automation Engine

Java
On Windows and MacOS, a Java Runtime Environment (JRE version 1.8) is distributed with the
Pilot client application. You do not need to install Java on the client computer yourself.

26.2.9.  The Automation Engine Web Service

Web server software that Automation Engine web tools are hosted on

Automation Engine tool is hosted on

Automation Web Services (used by the Web
Service Access Points)

Jetty

Automation Engine Server Admin web page Tomcat

FAQs

• Can we apply a certificate to the Automation Engine Server Admin web page (because
out of the box there is no certification assigned at all)?

• A: Yes. Learn more on the page Configuring and Checking the Automation Engine Web
Service on page 1577.

• What is Automation Engine's dependency on IIS (Internet Information Services from
Microsoft)?

• A: None.

26.3.  General Guidelines

26.3.1.  Scalability and Performance

Adding an Automation Engine Assistant

Adding Assistants spreads the task load over more computers.

Per Master server group, independent of the number of Assistants in this group, the maximum
of processing channels is 16.

When, even with 16 processing channels, queues keep getting longer and tasks are still not
executed fast enough, then you should consider adding an extra Master server (group).
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Adding an Assistant to Increase Throughput
Automation Engine comes with a built-in limit on the amount of concurrent tasks (tasks
that are processed simultaneously). The number of concurrent tasks that can be processed
depends on the licenses purchased . When you evaluate and define the amount of needed
concurrent tasks you should take into account the number of processed files and the number
of task run on these files over a certain period.

The amount of concurrent tasks needs to be in line with the capacity (RAM/CPU) of the
Automation Engine server. More concurrent tasks will increase the load on the system. If the
capacity of the Automation Engine server has reached it's limits, it can be increased by adding
one or more Assistant servers. One Automation Engine server will then take the role of Master,
the other(s) will take the role of Assistant. The Master will monitor its own load and the load of
the assistants to decide on which server a task should be executed.

Adding an Assistant for Redundancy
An Automation Engine Assistant is not an out of the box fail safe solution.

However, it could be used in a fail safe scenario. In case the Master breaks down, an
Automation Engine server in an Assistant role can be promoted to become the Master
server. A full backup package of the Master (Configuration, Resources, Databases) can then
be restored on the Assistant to rebuild the initial configuration. Note: the backup package
of the Master generated by the scheduled backup procedure of Automation Engine can be
automatically copied to the Assistant.

Fail safe solutions based on proper backup tools or on snapshots of virtual images are a valid
alternative, and might be seen as a more effective solution.

Adding an Assistant versus Adding an extra Master

When throughput needs to be increased, adding an Assistant is sometimes not the best option.
When the production/organization can be split into logical components, it could make sense to
add an extra Master.

Also in a group of a Master and his Assistants there is only 1 'CPU queue'. Each time an entry of
this queue can be processed (= when a processing channel becomes available), the best suited
computer in that group is chosen to execute this task. The best suited computer is the one with
the least load on CPU/memory.

Tip:  Learn more on Master and Assistant setups in the chapter Automation Engine Server
Management on page 1778, in its section on Server Roles  on page 1785.

Redirecting Central Resources
Following shares are considered as central resources:

• bg_data_cms_v010
• bg_data_custom_v010
• bg_data_dgc_v010
• bg_data_fonts_v040
• bg_data_ipldata_v010
• bg_data_marks_v010
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• bg_data_screens_v020

It is allowed to redirect these resources to a central file server. Valid reasons for doing this are:

• Access: these shares also need to be accessible for other applications/servers
than Automation Engine (PackEdge, ArtPro, FlexRip,...)

• Backup strategy: these shares contain critical files such as color profiles, marks, curves etc.
Remember that these shares are also included in Automation Engine's scheduled backup.

Note:  Esko recommends keeping the resources on the Automation Engine server to avoid
extra network traffic.

Using a Full SQL Server

Express edition versus Full SQL Server
Automation Engine requires a working DBMS (Database Management System) for its proper
operation and "persistent storage".

Microsoft's SQL Server Express Edition is delivered and installed together with Automation
Engine. Automation Engine is configured to work with this SQL Server as default DBMS in this
out-of-the-box setup. The installation creates new and empty databases and users.

The SQL Server Express Edition software has these limitations :

• Database sizes are limited to 10 GB.
• The service named SQLServer will only use 1 CPU and will restrict its memory usage to 1

GB.

In many cases, the SQL Server Express Edition will be sufficient. However, from a certain load
or performance expectation onwards, it is highly recommended to upgrade your Express
edition to a "full" SQL Server.

The next pages give recommendations as to when the DBMS for an Automation Engine
installation should be upgraded from an Express Edition to a full SQL Server.

Database Size Limitations

SQL Server Express Edition, which is delivered along with Automation Engine, has a size
limitation of 10 GB per database. However, you can scale up to a full version of SQL Server to
increase the size limit to the disk size.

Given that Automation Engine has three main databases (or four, depending on the
configuration), consider the following points:

• Jobs database: Automation Engine does not function as an archiving system. To keep the
Jobs database size under the limits, we recommend:

• only keep a Job online for it's lifetime. The concept of a Job is temporary by nature. Jobs,
after a while, are done. If you have many re-prints of products, then consider using the
Products tool as well (which does use the same database as Jobs).

• archiving unused Jobs and Products.

1755



26 Automation Engine

Note:  Theoretical limits regarding the number of Jobs and Products exceed the practical
Express Edition server demands (<50.000 Jobs / <250.000 Products) considerably.

• Task Monitor database: To keep the size of the Task Monitor database under limits, we
recommend:

• setting up adequate Task Clean Up rules. Clean up can be removing them of it can be
moving them to a separate task-archive: the Task History database.

Note:  The theoretical limit on the number of tasks in the Task Monitor in terms of size
(>100.000 tasks) is overruled by what the Express Edition server can handle in terms of
performance (<100.000 tasks).

• Task History database: When you do not want to delete the past tasks, we recommend to
regularly (automatically) archive them into the Task History database, this to keep the Task
Monitor database database size under limits.

• fasttrack database: used for the page workflows' Pages, Plates and Proofs View . The SQL
Express Edition is not supported to be used for the Pages, Plates and Proofs Views.

Learn more in:

• Performance Considerations on page 1756.

• Recommendations on page 1757.

Performance Considerations

The Automation Engine server performance depends on the performance of the used DBMS.
This may be noticeable when searching a Job in the Pilot (for example while filtering ), when
monitoring tasks (while filtering or scrolling), when executing tasks (while persisting their state,
progress, ticket, ...) etc.

The number of tasks ran per day and the average number of connected operators (using a
Pilot or Shuttle) determines the load put on the Automation Engine server and its DBMS. In
addition, the setup of the DBMS and the environment in which it is running will also have an
important effect on performance :

• The SQL Server software can be installed on the same computer as the Automation Engine
software or on another computer. 

• If the SQL Server is installed on another computer, then the network is involved. Under-
performing network components may seriously influence DBMS performance. Other
software running on that computer may influence performance as well.

• If the SQL Server is installed on the same computer as the Automation Engine (Master or
Assistant), that may have an impact on the amount of memory and CPU resources available
to Automation Engine.

• An SQL Server can be set up to run 1 instance (unnamed or the default), or even multiple
(named) instances. In case of an Express Edition, each instance then has its own limitations
(as described above), independent of the others.

• Each Automation Engine database may be configured independently of the others (to
potentially point to different SQL Server instances on potentially different computers).

Issues with database performance can be noticed in the following situations (but are not
limited to): 

• a decline in average response time as experienced by users of the Pilot.
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• a decline in average time between the moment of submitting a task and the moment the
submitted task starts processing.

Recommendations

We recommend upgrading the SQL Server Express Edition to a full SQL Server in one or more
of the following conditions:

• when more than 30.000 tasks are processed per day. This typically corresponds to 1.000
Jobs or files per day.

• when more than 100.000 processed tasks are constantly present in the Task Monitor
(assuming that cleanup rules are set up adequately).

• when more than 20 active Pilots are connected simultaneously.
• when Automation Engine is licensed and configured to run more than 7 concurrent tasks.
• when the database size limitation risks to be exceeded.
• when you use the functionality of the Pages, Proofs and Plates views (in page imposition

workflows).
• when there is a continuous load on the Automation Engine server (when production runs 24

hours per day).

When upgrading to a full SQL Server, special attention must go to provide sufficiently powerful
hardware. When the SQL Server is installed on a dedicated computer, we recommend:

• SQL Server 2012, 2014, 2016 or 2017 Standard Edition
• a powerful machine (4-8 CPU)
• 64-bit OS (Windows Server 2012, 2012 R2 or 2016)
• with at least 16 GB RAM (preferably 32 GB)
• with a high performance network card.

Note:  While SQL Server Express Edition is expected to be adequate, problems due to database
hiccups can happen (for example when peak load happens frequently, which might cause
some of the numbers mentioned above to be surpassed temporarily, but not on average). In
such cases, we recommend consulting Esko Support and switching to a full SQL server.

Local versus Remote SQL Server
Especially when you choose to work with a Full SQL Server, Esko recommends to not have
this database server(s) installed on the Automation Engine Master server but on a separate
computer. This is often done in case of large IT setups or to comply with specific internal IT
requirements.

Attention:  Using a remote SQL Server does means that there is a large amount of
(extra) network traffic between that database server and the Automation Engine server
software. This setup therefore requires a very reliable and fast network.

Note:  It may be easier to increase the power of your Automation Engine server computer than
to increase the speed of your network.

Note:  Depending on the chosen licensing model of your SQL Server, the amount of CPUs of
the computer that you install it on may have a significant impact on its cost. This may so also
influence where you install it.
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Example Configurations
An Automation Engine setup is modular and scalable. This setup depends on the load that
your server needs to carry and on the fail safe requirements.

Small Size Configuration
This includes:

• One Master Server: set up as Automation Engine Master. The role of this server is managing
Jobs and tasks as well as processing tasks.

• One File Server: the computer that stores the data that Automation Engine can access and
process.

Note:  Esko recommends to have a dedicated file server in every case, even for small size
configurations.

Medium Size Configuration
This includes:

• One Master Server: set up as Automation Engine Master. The role of this server is managing
Jobs and tasks as well as processing tasks.

• One Assistant Server: configured as an Automation Engine Assistant. This server will only
process tasks.

• One File Server: the computer that stores the data that Automation Engine can access and
process.

Large Configuration
This includes:

• One Master Server: set up as Automation Engine Master. The role of this server is managing
Jobs and tasks as well as processing tasks.

• One Assistant Server: configured as an Automation Engine Assistant. This server will only
process tasks.

• One File Server: the computer that stores the data that Automation Engine can access and
process.

• One Viewing Assistant: configured to handle the Viewing sessions of all the clients.
• One Database Server: the Master server connects to a dedicated database server.

Very Large configuration
This includes two separate server groups consisting of one Master server and two Assistant
servers. Both server groups are completely independent units.

• Two Master Servers: both set up as Automation Engine Master. The role of these servers is
managing (each their own) Jobs and tasks as well as processing (their own) tasks.

• Four Assistant Servers: configured as an Automation Engine Assistant. These servers will
only process tasks.

• One File Server: the computer that stores the data that Automation Engine can access and
process.
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Per group, one server is set up as Automation Engine Master. The role of this server is reduced
to only managing Jobs and tasks. The server has a relatively low amount of CPU and RAM. This
server runs a full SQLServer database engine.

Two servers are configured as Assistant. Their role is to process tasks. These servers have a
high amount of CPU and RAM.

The data processed by both server groups is stored on the file server.

26.3.2.  Snapshots/Cloning

Taking a snapshot or cloning for fail safe purposes can be done under the condition that no
licenses are activated on the server itself. When failing to do so, after restoring a snapshot of a
virtual server or restoring a backup clone, the licenses will be broken.

This can be overcome by:

• temporarily deactivating the licenses before creating a snapshot or a clone.
• installing the licenses on a computer other than the Automation Engine server.

26.3.3.  Remote Desktop Services

Warning:  Running the Automation Engine client software via Remote Desktop Services
is in violation with the EULA (End User License Agreement).

26.3.4.  Installing Other Applications on the Automation Engine
server computer

Automation Engine requires a dedicated server to run on. Installing other software might
influence the functioning of Automation Engine and therefore is strongly discouraged.

Installing other Esko Applications on the Automation Engine server
1. WebCenter: Automation Engine and WebCenter can not be installed on the same server.

Both applications will malfunction if installed on the same server.
2. FlexRip / Imaging Engine: FlexRip / Imaging Engine can be installed on the same server as

Automation Engine. For performance reasons, Esko advises to have these components on
different servers.

3. PackEdge / Plato / i-cut Layout: These Esko editors are typically installed on a client
station but can be installed on the same server as Automation Engine (for example to build
templates). However, Esko does not recommend to use the server as a client workstation.

4. Nexus: Automation Engine and Nexus cannot be installed on the same server. Both
applications will malfunction if installed on the same server.
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Virus Scanners and Firewalls
Make sure that virus scanners and firewalls (including OS firewalls) do not interfere with the
Automation Engine software (blocking temp files, processes).
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27.  Installation Guide

27.1.  Copyright Notice
© Copyright 2020 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are
the property of Esko Software BV. The material, information and instructions are provided
on an AS IS basis without warranty of any kind. There are no warranties granted or extended
by this document. Furthermore Esko Software BV does not warrant, guarantee or make any
representations regarding the use, or the results of the use of the software or the information
contained herein. Esko Software BV shall not be liable for any direct, indirect, consequential or
incidental damages arising out of the use or inability to use the software or the information
contained herein.

The information contained herein is subject to change without notice. Revisions may be issued
from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system,
or published, in any form or in any way, electronically, mechanically, by print, photoprint,
microfilm or any other means without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®
 Colors displayed in the software application or in the user documentation may

not match PANTONE-identified standards. Consult current PANTONE Color Publications for
accurate color. PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. ©

Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to
distribute for use only in combination with Studio Visualizer. PANTONE Color Data and/or
Software shall not be copied onto another disk or into memory unless as part of the execution
of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org).
All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk
Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP
are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric
Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).
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Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign,
PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the
United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are
registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark
Office.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered
trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Kortrijksesteenweg 1095

B – 9051 Gent

info.eur@esko.com

27.2.  How to Install Automation Engine 20

27.2.1.  Before installing Automation Engine 20

Before you install Automation Engine 20 on your system, prepare or check these topics:

• Check the document Pre-Installation IT Requirements Guide, which is also a chapter in the
Automation Engine Complete Manual, available on http://help.esko.com/products/Automation
%20Engine.
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• Install Automation Engine 20 on a "clean" system, where no Esko software has been
installed yet. If any other version of Automation Engine was installed already, see the
section How to Upgrade to Automation Engine 20 on page 1770.

• You will need the DVD: "Automation Engine 20 installation".

Note:  If you downloaded the software from MySoftware.esko.com, you will need to mount
the corresponding .iso files as virtual DVD, or unpack the .iso files first.

Note:  Make sure you are aware which type of installation you are doing. This is explained
in the next page, in Types of Installations.

• Your computer must meet the minimum requirements for the installation, as described on
www.esko.com/systemrequirements.

• Windows operating system:

• The windows OS on an AE server must be a "Server" type. The supported versions of
the Microsoft Server OS are listed on http://www.esko.com/systemrequirements.

Note:  Windows Server 2008 R2 is only supported for doing an upgrade from
a previous version of Automation Engine. A new install on that OS is no longer
supported.

• The Windows OS must be a 64 bit.
• Databases. Automation Engine server software uses many databases. A standard

installation installs the default supplied Microsoft SQL Express edition on the Automation
Engine server.

• The supported versions of Microsoft SQL Server are listed on http://www.esko.com/
systemrequirements. In the Server Admin web page, use Server Checks > Databases
to check if the installed database software is supported.

• Automation Engine can use a full SQL Server instead of the default installed Express
edition. Learn more about pro's and con's on this page in the chapter "Pre-Install IT
Requirements Guide".

• You need software licenses for Automation Engine: a product key file. If you do not have a
product key file yet, contact Esko Support.

• You need internet access from that server computer.
• You need to have Administrator privileges.
• Make sure your anti-virus software is not blocking the installation or configuration.
• You may not have an IIS web server installed on your system.

27.2.2.  Types of Installations

The installation procedure will ask you which type of installation you want to do.

Attention:  Before making these decisions, first learn about the possibilities of different
database servers on this page in the chapter Pre-Install IT Requirements on page 1739.

• Standard Installation

• Automation Engine Master, Device Manager or WebCenter OBGE.

These installations also install the default supplied Microsoft SQL Express edition on the
Automation Engine server.
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Note:  A Device Manager is a server software limited to communicating with CDI's or
Kongsberg table devices. A WebCenter OBGE (On Board Graphics Engine) is a limited
Automation Engine used to calculate the view files for an Esko WebCenter. This will
typically be installed on the WebCenter Application Server.

• Automation Engine Assistant.

This installs an Automation Engine that you can (later) configure to be used as an
Automation Engine Assistant. This option will not install a Microsoft SQL Express server.

• Installation for use with an existing Microsoft SQL Server

• Automation Engine Master, Device Manager or WebCenter OBGE.

These installations will use a remote SQL Server that is already available in the network.
They will not install a Microsoft SQL Express server. For example: when you are installing
an OBGE and you want it to use the SQL Server already used by your (full) WebCenter.

Attention:  This type of installation includes an embedded mini database server
engine. This embedded engine is not fit for production ; it is a temporary setup
until you have chosen a different supported database engine.

27.2.3.  How to perform the Automation Engine 20 System Readiness
Check

Before you install Automation Engine 20, a System Readiness Check is required. This checks
whether the operating system is suited for installing and running this Esko product.

1. On the DVD, in the section Software installation, click the type of installation that fits your
purpose (as explained in Types of Installations on page 1763).

2. In the section Installation, under Instructions, click Run the Automation Engine
Readiness Check.

3. At the end of the Readiness Check, read the resulting messages carefully.
4. If the Readiness Check resulted in any problem, correct it before proceeding.
5. Click Exit.
6. Proceed to install the Esko License Server.

27.2.4.  How to install the Esko License Server

Use of the Automation Engine software is protected by licenses. These licenses are distributed
as a product key file (in .HTML). To import the licenses into the Esko License Server, the product
keys in the product key file must be activated using the Activate Server Licenses tool.

You need:

• A product key file for the Automation Engine 20 product components. If you do not have a
product key file yet, contact Esko Support.

• Internet access, to activate the licenses.
• An Esko ID in order to activate the licenses. Get one at http://www.esko.com/licensing/

CreateAccount.

Follow these steps:
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1. On the DVD, in the section Installation, under Instructions, click Install the License
Server Components.

2. Install the Esko License Server by clicking Install the Network License Manager.
3. Follow the instructions of the installation wizard.
4. When the installation is finished, click Network License manager > Network License

Manager.
5. Local License Manager: If you want to activate the license on your local computer

(recommended in case of an Automation Engine Master), follow these steps:
a) In the Esko Network License Manager, click Activate.
b) Follow the instructions of the Activate License Wizard.
c) When asked how to activate the licenses, choose on-line activation.
d) When asked about the product keys, choose I have a file containing one or more

product keys.
e) Click Browse to select the product key file.
f) When asked, fill in your Account Name and Password.
g) Click Finish.

The licensed products you can use are now visible in the Esko License Server.
h) Close the License Manager and click Go back in the top-right corner of the page to

return to the  Installation page.
6. Remote License Manager: If you are using a remote license manager (typical in case of an

Automation Engine Assistant), you only need to indicate where it is. Follow these steps:
a) In the Network License manager, open the Help menu and click License client

configuration.
b) In the License Client Configuration window, in the field "computer name of the License

server" type in the host name of the license server and click Apply.
c) Click Exit.

7. Now continue by clicking on Install the prerequisite components.

27.2.5.  How to install the Automation Engine Prerequisite
Components

Depending on the products to be installed on this particular system, various components are
required for installation. The installation wizard for these prerequisite components checks the
licenses, lists the prerequisite components to install, requests confirmation for installation and
then installs the required components.

The installation wizard installs the following components:

• Microsoft Visual Studio Redistributables

• Esko CAD-X components for Standard and Enterprise Editions.

Note:  Do not install the CAD-X components when ArtiosCAD is already installed on that
server.

• Database Engine for the Automation Engine components (if you choose a Standard
Automation Engine Installation)

Follow these steps:
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1. On the DVD, in the section installation, click Install the Prerequisites Components.
2. Follow the instructions of the installation wizard.
3. When you choose a Standard installation, when asked to enter a password for the SQL

Server, click Use Default to use the default sa password. Or you can enter a Password,
confirm it and click Use Password to use a different password, for example because of
"Strong Password" requirements.

Note:  During the pre-installation of the Database Engine for Automation Engine, the
Microsoft .NET Framework 4.6.1 will be installed. You may get a warning saying that the
system needs to be rebooted, followed by a fatal error "The SQL Server instance is not
installed". If this happens, reboot your server and install the prerequisites again.

4. The installation wizard will ask you to close all Esko applications. Click Yes when asked
Ready to continue?

5. Follow the instructions of the installation wizard.
6. Click Continue. Click Yes in the Installshield Wizard Complete message window.
7. Depending on your activated licenses, the Automation Engine Prerequisite Components

First Installation process may ask you separately about the CAD-X component installation
for both the Standard Edition component and the Enterprise Edition component. In both
cases, click Yes when asked Ready to continue?.

8. Follow the instructions of the installation wizard.
9. Click Exit.

You will be redirected to the installation page to continue with the next step.

27.2.6.  How to install Automation Engine 20

1. After running the System Readiness Check and installing the License Server
Components, when all prerequisites are fulfilled, you can start the installation.

2. Click the Install Automation Engine 20 link on the installation page.
The Automation Engine 20 Software Installation wizard will open up.

3. Follow the instructions of the installation wizard.
4. Read the Software and Data license agreement carefully and select Yes, I accept the

license agreement.
5. When asked to select the products to install on this system, select Automation Engine 20.

The group Common Components cannot be deselected and will be installed on all
systems.

6. Select the Destination Folder for the chosen products or accept the defaults.
7. Follow the instructions of the installation wizard.
8. At the end of the installation, click Finish.

The pre-installation task checks the password complexity rules and domain policies. If the
default password for the BGSYSTEM user does not fulfill the requirements, a pop-up dialog
requests a password.

During installation, only a BGSYSTEM user is created. This user will be used as Automation
Engine System Account (you can choose to change it later using the System Account page). A
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clean installation ends with two empty local user groups: BGUSERS and BGADMIN. Add the
BGSYSTEM user to the BGADMIN local user group.

Note:  Learn more about Users and Groups on page 1747 in the separate chapter Pre-Install IT
Requirements on page 1739.

After installation of Automation Engine, a shortcut named "Automation Engine Client Apps"
is put on the desktop of the server computer.

Double-click this shortcut to open the Automation Engine Client Apps web page in your
default browser.

This page describes the two types of Client Applications:

• Desktop client applications (Pilot or Shuttle): These need to be installed on each workstation
from where you want to use Automation Engine.

• Browser based client applications: These run inside a browser and do not need to be
installed. You may want to bookmark some specific pages.

27.2.7.  How to Install Pilot or Shuttle

The Automation Engine client software is distributed via the Server Web Page.

Note:  Whenever your Automation Engine server is updated, the Pilot or Shuttle will request
an update. The automatic update mechanism alerts you to update when hot-fixes and minor
version updates (for example 18.1 to 18.1.1) are available. If you are doing a major version
upgrade (for example: 18.1 to 20), you need to re-install the client applications (and when
ready, remove the old ones).

Note:  Installing the Pilot is shown in detail in one of the old eLearning modules offered in on
https://docs.esko.com/docs/en-us/automationengine/18/quickstartguide/home.html (example on
Windows).

1. Open your web browser and go to http://servername:9999/ or  http://servername,
where servername is the name of the computer running the Automation Engine server
software.

2. The first time you install one of the client applications, you will be asked to create an
Administrator account.
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Once you have created the administrator account, you will be directed to either

• the tab "Client Apps" where you can download Client Applications if you did install a
Standard Automation Engine.

• or to the Create Automation Engine Database page if you did install an Automation
Engine Master for use with an existing Microsoft SQL Server. This is where you then
need to configure and create your Automation Engine databases.

In the Create Automation Engine Database window, select your Microsoft SQL Server
and Instance name, type in the sa password and type in the Database folder and either

• click create to start the automatic creation and configuration of the databases,

• or, if you want to create and configure the databases manually, click Continue using
embedded databases.

Attention:  It is not supported to use Automation Engine with embedded
databases in a production environment.

Learn more about creating databases for Automation Engine in Creating a Database 
on page 1796. Learn more about configuring an Automation Engine database in
Automation Engine Database on page 162.

After creation and configuration of the databases, you will be redirected to the Main
page of the tab "Client Apps", where you can download the client applications.

3. Click Download.
4. Start the installation by double-clicking the downloaded executable.
5. Follow the instructions of the installation wizard.
6. Read the Software and Data license agreement carefully and select Yes, I accept the

license agreement.
7. Follow the instructions of the installation wizard.
8. At the end of the installation, click Finish.
9. Double-click the Automation Engine Pilot or Shuttle shortcut on the desktop.
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10.Fill in the User name, Password and Server Name. You can here use the administrator
account that you created earlier. Click OK.
The Pilot or Shuttle will start up.

Initial Configuration (Pilot)
After an initial installation of Automation Engine, you typically want to configure a minimal
setup that includes:

• Containers. Define which existing or new data shares contain the data that Automation
Engine will be able to work with.

Learn more in  Containers on page 133.

Note:  An initial installation already creates an ExampleJobContainer on the disk where
you installed the server software.

• Users. An initial installation creates a default user and user group.

Learn more in Accounts Views on page 139.

• Task Cleanup Rules: This is needed to avoid that your tasks database becomes too large
and then slows down your server.

Note:  A new installation will also have created a default Task Cleanup rules. Learn more
about changing or adding such rules in Task Cleanup Rules on page 165.

• Temporary data.

Automation Engine creates a lot of temporary data on the folder defined by the Windows
variable %BG_TMP. The folder where this variable is set to should be a fast drive with >50 GB
free space.

By default this is installed on the same drive as where the software is installed. In case that
disk threatens to fill up, we advise to redirect that variable to another place. Learn how to
do this in this KB article.

27.2.8.  How to Open the Browser Client

To open the Automation Engine browser client, open a web browser on your workstation and
go to http://servername:9000 , where servername is the name of the computer running
the Automation Engine server software.

Important:  When your browser client is not using HTTPS in its communication with the AE
server, the sign-in dialog will mention this and refer to this KB article that explains how to set up
using HTTPS.

Note:  Configuring an Automation Engine browser client is shown in the eLearning module
about Installation and Configuration. This eLearning module is a summary of what is described
in the chapter 'Post-Install Configuration' in this manual.
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Initial Configuration (Browser Client)
After an initial installation of Automation Engine, you typically want to configure a minimal
setup that includes:

• Containers

At first sign in to the browser client, you will be asked to define a Data Container. Define
which existing or new data shares contain the data that Automation Engine will be able to
work with.

Note:  An initial installation already creates an ExampleJobContainer on the disk where
you installed the server software.

• Users

At first sign in to the browser client, you will also be asked to create an administrator user.

Note:  The others can later be created via the menu Admin >  Users.

• Task Cleanup Rules

The product preparation tasks that run on the server will be cleaned up automatically by
default 'Task Cleanup rules'.

• Temporary data.

Automation Engine creates a lot of temporary data on the folder defined by the Windows
variable %BG_TMP. The folder where this variable is set to should be a fast drive with >50 GB
free space.

By default this is installed on the same drive as where the software is installed. In case that
disk threatens to fill up, we advise to redirect that variable to another place. Learn how to
do this in this KB article.

27.3.  How to Create a full Backup of Automation
Engine 20

You can create backups with the tools available in Server Admin section of the Automation
Engine Server Web Page.

These tools are documented in the page Backup on page 1790 of the chapter Automation
Engine Server Management on page 1778.

27.4.  How to Upgrade to Automation Engine 20
You need to upgrade to Automation Engine 20 in the following order:

1. Create a backup of your current Automation Engine.
2. Perform the System Readiness Check.
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3. Upgrade the License Manager.
4. Upgrade the prerequisite components.
5. Upgrade the Automation Engine software.

27.4.1.  Before Upgrading to Automation Engine 20

Before you upgrade to Automation Engine 20, prepare the following:

• Check the document Pre-Install IT Requirements on page 1739, a separate chapter in the
Automation Engine complete manual.

• You will need the DVD "Automation Engine 20 installation".

Note:  If you downloaded the software from MySoftware.esko.com, you will need to mount the
corresponding .iso file as virtual DVD.

• You must have a working version of Automation Engine 16 or higher.

• Your computer must meet the minimum requirements for the installation, as described on
www.esko.com/en/SystemRequirements.

Attention:  Make sure to check that the version of SQL Server that your previous AE
version was using as database server is still supported.

• You need a product key file for the upgrade (every new major version requires a new license
set). If you do not have a product key file yet, contact Esko Support.

• Use Status Overview on page 1781 to make sure no more users are connected or using the
system.

• The upgrade will check if you are still using tasks that have become Outdated in the version
that you are installing. If any are found, you will have the chance to abort the installation.
Learn more about such tasks in Outdated and Soon Outdated Tasks in this Version on page
488.
 

 

• Reboot the server before upgrading Automation Engine.
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27.4.2.  How to Create a Backup of your current Automation Engine

As an extra security measure, we advise to create a backup of your current version of
Automation Engine before upgrading.

• When your current version is 14.0 or higher, make a backup as described in Backup on page
1790 (in the chapter AE Server Management).

• When your current version is 12.x,

• first make a backup as described in Backup on page 1790,

• then upgrade to either 14.x or 16.0,
• then again make a backup and then upgrade to 18.x

• When your version is 10 or lower, contact Esko Customer Support.

27.4.3.  How to Perform the Automation Engine 20 System Readiness
Check

1. On the DVD, in the section Installation, under Instructions, click Run the Automation
Engine Readiness Check.
Learn more in How to perform the Automation Engine 20 System Readiness Check on page
1764.

2. Proceed to install the Esko License Server. Click Install the License Server Components.

27.4.4.  How to upgrade the Esko License Server Components

The Automation Engine 20 product is protected by (new) licenses. These licenses are
distributed as a product key file (a .HTML file). To import these new licenses into the Esko
License Server, you must first upgrade the Esko License Server components.

1. On the DVD, in the section Installation, click Install the License Server Components.
2. Follow the instructions of the installation wizard.

During the upgrade of the Network License Manager, the current Esko License Server will
be stopped temporary, during which the currently used licenses will be unavailable.

3. When the installation has finished, click Load the new licenses.
4. In the Load new licenses window, click Activate Server Licenses.
5. In the Network License Manager, click Activate.
6. Follow the instructions of the Activate License Wizard.
7. Select on-line activation.
8. Select I have a file containing one or more product keys.
9. Click Browse to select the product key file.
10.Fill in your Account Name and Password.
11.Click Finish.
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The licenses for the upgraded products are now listed in the License Manager.
12.Close the License Manager and click Go back in the top-right corner of the page.
13.Click on Continue with the installation of the prerequisite components link.

27.4.5.  How to Upgrade the Prerequisite Components

Follow these steps to upgrade the Prerequisite Components:

1. On the installation page, click Install the prerequisite components.
2. Follow the instructions of the installation wizard.
3. The installation wizard will ask you to close all Esko applications. Click Yes when asked

Ready to continue?
4. Follow the instructions of the installation wizard.
5. Click Continue. Click Yes in the Installshield Wizard Complete message window.
6. Automation Engine 20 Prerequisite Components Installation window will ask you about

CAD-X component installation, both 'Standard' and 'Enterprise'. Click Yes if ArtiosCAD is not
installed.

7. Follow the instructions of the installation wizard
8. Click Exit.

You will be redirected to the installation page to continue with the next step.

27.4.6.  How to Upgrade Automation Engine software

After the upgrade of the prerequisite components, your system is ready to upgrade to
Automation Engine 20.

1. Click on the Install the Esko Software 20 Automation Engine link on the installation page.
The Automation Engine 20 Software Installation wizard will open up.

2. Follow the instructions of the installation wizard.
3. Read the Software and Data license agreement carefully and select Yes, I accept the

license agreement.
4. When asked to select the products to install on this system, select Automation Engine 20.

The group Common Components cannot be deselected and will be installed on all
systems.

5. Follow the instructions of the installation wizard.
6. Select the Destination Folder for the chosen products or accept the defaults.
7. During the pre-installation this question will appear "If you continue Automation

Engine <number-of-the-new-version> will be installed but it may not be
possible to return to <number-of-your-current-version>. Do you want to
continue the installation anyway?". Answer Yes.

8. Follow the instructions of the installation wizard.
9. At the end of the installation, click Finish.
10.Now install Automation Engine Client Applications. Learn more in How to Install Pilot or

Shuttle on page 1767.
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27.5.  How to Upgrade onto a New Server Computer
These are the typical cases when you want to change the hardware (computer) of your
Automation Engine server:

• You decided yourself that the server computer needs to be updated, usually for
performance reasons.

• Your server computer no longer matches Esko's requirements for an Automation Engine
server. A typical case is when the Windows OS is no longer supported.

For example: Automation Engine 16 server is no longer supported on Windows 2003 or
Windows 2008 RTM 32/64bit. If your server runs Windows 2003 or Windows 2008 RTM
32/64bit , the hardware will also be too old by now to use it for such a vital production
tool. This means you will most probably not change the OS on that old server but install
Automation Engine on a new computer with a recent Windows OS. For a list of supported
OS, see http://www.esko.com/systemrequirements.

Attention:

• Since Automation Engine 18, Windows 2008 R2 is no longer supported for new
installations. However, it will still support Windows 2008 R2 for upgrades.

• A next version of Automation Engine will not support Windows 2008 R2 anymore.

Note:  Your new server computer can have a different name than the old server computer.

To move your Automation Engine server configuration to a new server, follow these main
steps:

1. Install Automation Engine on the new server

First you install Automation Engine on this 'virgin' new server. Follow the standard procedure
as described in How to Install Automation Engine 20 on page 1762.

2. Backup your old server config, using the backup tool from your old
Automation Engine server software

To get the configuration of your old server onto your new one, use the backup tool that is
offered in the Automation Engine Server Web Page of the old server (go to http://<name-
of-your-OLD-server>:9999/ and sign in).

3. Restore that backup on your new Automation Engine server.

To do this, use the Restore function as documented in Restore on page 1792 .
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27.6.  How to Repair an Automation Engine Server
You typically need to repair a system when software program files got deleted or became
corrupt. For example a virus can cause such damage.

Note:  Only Automation Engine components of the same version as the one on the DVD can be
repaired/re-installed.

To repair the Automation Engine server software, proceed as follows:

1. Open the Automation Engine Software Installation window:

• If you insert the distribution DVD into the DVD drive, or mount the corresponding .iso
file, the window appears automatically.

• If you unpacked a downloaded .iso file, or if the window doesn't open automatically,
double-click setup.exe in the root folder.

2. Select the installation language.
3. Click Proceed to the installation.
4. Click Repair / re-install Automation Engine and Choose which component you want to

repair.

27.7.  How to Uninstall Automation Engine server
software

When you uninstall a version of Automation Engine, only that Automation Engine server
software and the configuration of that version is removed. Also the "DeskPackContainer" is
removed.

Resource files like color data, fonts or curves are not touched.

You can choose to uninstall the current version or an older version.

Note:  Although technically not required, it is a good standard practice to make a backup of
your current configuration before doing an uninstallation.
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27.8.  How to install the Configuration Manager
The Configuration Manager tool collects a lot of data regarding software versions, hotfixes,
OS etc. This information can be useful for Esko customer support. It can also alert you on
expiring licenses.
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Only install the Configuration Manager if there is no Configuration Manager active on your
network yet. There can only be one Configuration Manager active on the network.

How to install the Configuration Manager is described in its own (installation) manual. Find it
on http://help.esko.com/products/Configuration%20Manager.
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28.  Automation Engine Server
Management

28.1.  The AE Server Config web page

Concept
This web page serves to administer only very specific parts of the configuration.

Attention:  This page can only be accessed from a browser on the Automation Engine
server computer itself.

Q: Why is this a separate tool than the other Server Admin web page?

• A: The signing in to a server admin page requires you to have credentials that correspond
to a Windows user on your AE server computer that has administrative rights. The main
reason for this is that even when the AE server software is down, you still need to be able to
administer some of that server software..

There are 2 ways to open the Server Config web page. On the AE server computer,

• either type this URL in the browser: http://localhost:9897/

• or go to Start >  (Programs) > Esko > Automation Engine Server Config

Note:  When you open this page at a moment when there is no administrator account yet on
that Automation Engine (typically right after a first installation), then the Get Started page is
presented first. This page serves to create that initial administrator account. Learn more in .

This page offers 2 tabs:

• Server Config.

• Server Admin.

28.1.1.  The Get Started page

You need an administrator account to start working with Automation Engine.

This page enables you to create such an administrator account and get started.

• Fill in these fields (all are required):User Name, Full Name, E-mail Address, Password,
Confirm Password.
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• Then click Create Account. The user account will be created and the Server Config page will
be shown.

28.1.2.  Server Config tab

Tab 'Identity Providers'

Learn the basics about Automation Engine's user model in Accounts Views and more technical
detail on the page Users and Groups on page 1747.

• LDAP: Select LDAP authentication when you want to have LDAP accounts able to sign in to
Automation Engine.

Attention:  In v20.0 the support for LDAP is still in pre-release.

• LDAP Server: LDAP server name.
• System user Name: System user name of the LDAP server.
• System user Password: System password of the LDAP server.
• User Distinguished Name (DN): A comma separated list.
• Required Group Membership: A comma separated list.
• Use Secure Connection (LDAPS):

• Internal: The default IdP, internally in Automation Engine.

• Enforce complex passwords: Select this when you require the Automation Engine
internal users to have complex passwords. It then sets these password requirements:

• at least 8 characters
• at least 1 digit
• at least 1 uppercase character
• at least 1 special character ! @ # $ % ^ & * ( ) _ +
• excluding spaces

When signing in, the enabled authentication methods will be used in this order: LDAP,
Internal and Windows.

• Windows

• Windows Authentication: Select this when you still want to use local Windows users in
Automation Engine.

Attention:  Windows based authentication will become obsolete in a next major
version.

Tab 'Browser Client'

• Enable Browser Client

• Protocol

• HTTP
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• HTTP Port. Default is 9000. When changing this number, you will be asked to
confirm.

Attention:  Do not change this port number when tasks are running on the
server.

• HTTPS

• HTTPS Port: Default is 9443. When changing this number, you will be asked to
confirm.

Attention:  Do not change this port number when tasks are running on the
server.

• SSL Certificate Port: By default, a self-signed certificate will be used. The browser
will show a warning when accessing the browser client. The actual message
depends on the used browser and its version.

You can add a certificate to the list by installing an SSL certificate on the server
using Window Certificate Manager. It should be installed in the Personal store for
the System Account <servername>\BGSYSTEM. Select

• Redirect HTTP to HTTPS: When selected, type in the HTTP Port. The default HTTP
port is 9000. When changing this number, you will be asked to confirm.

Attention:  Do not change this port number when tasks are running on the
server.

• Disable Browser Client: When disabling this button, the browser client can no longer be
accessed on the LAN.

When applying any changes, you will be asked to confirm.

Attention:  Do not make these changes when tasks are running on the server.

28.1.3.  Server Admin tab

All below tools are also part of the main Server Admin web page, as described here.

Status Overview
• Server Status

• Stop Server

• Activate Server

• Download Log Files

Status info shown:

• Connected Clients

• Executing Tasks
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• Current Role

• Web Server

• Restart Web Server
• Download Log Files

28.2.  The AE Server Admin web page (:9999)
The Automation Engine Server Web Page allows you to administer and diagnose your server,
to define backups, to download client applications, etc. , .

Open the Automation Engine Server Web Page by entering http://<name of your
server>  or http://<name of your server>:9999 in the address field of your browser.

In this tool, the section Server Admin offers the features to manage your Automation Engine
server. Its sub-pages are documented below.

Attention:  When you come to this page right after doing a fresh install where you
choose a Special installation (one that does not install the default MS SQL Server
Express), you will be prompted to first the create all Automation Engine databases.
Alternatively, you can also continue using the "Embedded" database (for test-purposes
only). Learn more below in When No Databases were Installed Yet on page 1796.

28.2.1.  Status Overview
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The Status Overview shows

• Server Status:

• Use the Stop/Start Server button to stop or start the Automation Engine server
software. Starting or stopping the Automation Engine server software can take several
minutes.  This page will indicate the status during this process. You can refresh manually
or visit other pages while it is processing.

• Activate Server also restarts the software but adds extra processes. When activating the
server, a log window will indicate the server activation progress. Only use this on advise
of Esko specialists.

• The number of connected clients and executing tasks is shown here. You can see more of
their details in the next page Server Activity.

• The Log Files button downloads a ZIP file to your computer. The ZIP file contains a folder
named egappsrvlogs with Viewer log files (ImageList*.log), a folder jbosslogs
with Application Server log files and also the installation logfiles fastserver_*.log and
dvd_*.log.

• Server version: Learn more about the installed software in the page About.

• Current Role. Learn more about Master and Assistant servers in the page Server Setup.

• Server Databases: You can perform detailed checks on databases in the section Server
Checks. This is documented in Troubleshooting the Server on page 1803.

• Web Server: Use this to restart the Automation Engine web service. This web server is used
for HTTP based integration with external systems and is also used to run this web tool.
This page is automatically refreshed when the web server is restarted. You can also refresh
manually.

The Log Files button downloads a ZIP file to your computer containing the log files of the
web server and of the Server Admin page.

Log files for Client Apps are not shown in the Server Admin page because they are
executed on the client computer.

FAQs on Restarting and Reactivating the Server

Can I Stop or Activate a Server that still has Connected Clients?
If you try stopping or activating a Master or Assistant server with connected clients and/or
executing tasks, you will be asked to close all the Automation Engine applications. If you fail to
do so, the open applications will be interrupted and the server will be automatically stopped or
activated within five minutes.

Note:  Stopping or Activating the server makes it impossible to login via a new client or start a
new task on this Automation Engine server.

Note:  In Master-Assistant setups, you can restart an Assistant server and continue working on
the Master and/or other Assistants. Only the running tasks on that restarting Assistant server
will be stopped.
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Can I Cancel the Stop and Activate Processes?
You can cancel the Stop or Activate process by clicking on Cancel . You will be able to login
again from a client and start new tasks.

You can also Force Stop or Force Activate while waiting for the open applications to close.
The server will then break the connection with clients and will cancel all the executing tasks.

28.2.2.  Server Activity

This page provides details about the connected clients and about the tasks that are currently
executing.
 

 

28.2.3.  Server Setup
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• Server Setup

• The Current role of an Automation Engine server can be 'Master', 'Assistant' or 'Idle'.
Learn more below in Server Roles  on page 1785.

• Learn more about Processing capabilities here.

• Task Queues

Automation Engine's internal CPU queues that handle the task load can work in dynamic or
in static mode.

Dynamically manage the number of tasks:

• When selected, the CPU queues manage the tasks in dynamic mode. This means that
the amount of tasks that are allowed to run concurrent depends on the current load. As
always, the maximum amount is defined by the licensed number of processing channels.

• When not selected, the CPU queues manage the tasks in static mode. You then can, per
type of processing queue, set the maximum number of tasks that can be run concurrent.

Warnings appear when you set a number too high.

• Cluster Setup

A cluster is the group of an Automation Engine Master and his Assistant servers.
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• Processing channels: This shows you how many were calculated to be active. This
number will be the same as mentioned for the "CPU" queue in the above topic on task
queues (when in static mode).

• Reserved channels for the Automation Engine web service.

Especially when you use synchronous communication in Web Service access points, you
need to make sure that the HTTP response back to the external system does not have to
wait for other processing tasks.

Note:  This number needs to be lower than the available processing channels
(mentioned above).

• Central resource server: Define here which computer in the cluster serves the central
resources.

Learn more in the pages below.

Server Roles
You can configure an Automation Engine server installation as Automation Engine Master,
Assistant or asIdle (used as Data Server).

These multi-server setups act as a set of co-operating servers to distribute the workload and
provide recovery when one of them goes down. These configurations are all within one same
LAN.

Automation Engine Standalone setup
A Standalone Automation Engine server is the simplest setup. You have one server and that
one is the master.

However, One same organization could have a configuration with more than one standalone
server. In this setup,

• each system has its own set of resources (such as Color Engine data, DGC data, font data,
custom data, marks data, ink planner data, task history database). Each system functions
independently without sharing the workload.

• each system has it own local license management.
• you can create Containers on shares of other systems.
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Automation Engine server setup with Assistant system(s)
This consists of an Automation Engine Master server and one or more Automation Engine
Assistant systems. In this setup,

• the Assistants use Master resources to execute tasks.
• Automation Engine clients (Pilot, Shuttle, Browser) connect to the Master computer, not to

the Assistants.
• the workload on these systems is allocated to the system with the smallest load, preferably

another Assistant. If one of the Assistant systems goes down, it is automatically removed
from the configuration and the other systems take over the workload.

If the Master system goes down, the complete configuration will be down. But after one of
the Assistants has be promoted to Master, the system can be restarted. This is why a recent
backup of the Master is always to be stored on another computer.
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Automation Engine server setup with Assistant system(s) and Data Server
You can configure an Automation Engine Data Server (role: "Idle") which can be accessed when
the Master goes down along with the Assistants. A Data Server system can be set up for all
the resources required to facilitate the take over of the Master role by one of the Assistant
systems.  

 

 

Note:  When you use the Print Task to output on PostScript printers, you should define and
configure the PostScript printers on all the systems (Master and Assistant).

We recommend installing the PostScript printers

• locally on the Master system (in Master-Assistant Setups)
• or locally on the Data Server (Data Server-Assistant server setups).

Configure them on the network so that you can access them on all other systems as network
printer.

Licensing Requirements for Different Server Setups
You need specific licenses to install or convert systems to Automation Engine Assistants and/or
Master.
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These licenses are installed on the Master (in Master-Assistant Server setups) and on the Data
Server (in Assistant-Data Server Setups). These systems act as remote license manager systems
for the Assistant or Master.

Processing Capabilities
What do you allow this server to do?

Can Run Tasks
Select this option to allow this server to execute tasks. If you have a Master server with
(several) Assistants and the Master is heavily loaded, you can disable this option for the Master
server, and so allocate all workload related to tasks to the Assistant server(s).

Note:  Even when you disable the Master server from running tasks, many types of (light) tasks
will still run on the Master server.

• Maximum number of inspection tasks that can be run simultaneously: If you use the
Global Vision inspection tasks, indicate here how many you want to have executed at the
same time.

Note:  These tasks are run in a separate CPU queue named "CPU_GV". Learn more in Queue
Monitor.

Can Prepare and View Files (Viewer)
Select this option to allow this server to run file streaming sessions. These sessions support
the Automation Engine Viewer's deep zoom which is started when you view a file that has no
prepared view data or when you zoom deeper than the resolution of the prepared view data.

Note:  In the Windows Task Manager, these processes are named sdbserver.exe.

The Maximum number of files that can be viewed simultaneously is important when your
server also needs to run other tasks. Learn more about when such sessions automatically
close in Limiting How Many Files you can Open on page 999.

Important:  We strongly recommend that only experienced system administrators or Esko
support staff modify this setting. 

Can Calculate Layouts (Gang Run printing)
Select this option to allow this server to calculate layouts for Gang Run Printing.

The Gang Run Printing uses a nesting server that starts processes to calculate the optimal
nested layouts (PDFPLA) of Gang Run jobs for one particular substrate queue at the time.
These calculations can be time consuming. You can here define how many substrate queues
are allowed to calculate simultaneously.

Attention:  The default maximum number is 1. Increasing this number may lead to the
Automation Engine server slowing down.

Learn more about Gang Run Printing in its dedicated chapter Gang Run Printing.
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Central Resource Server
By default, the Master server uses the locally installed resources.

These resources are:

• bg_data_cms_v010 – the Color Engine database
• bg_data_custom_v010 - a folder containing various resources like ArtPro action lists, Print

Rule Checker profiles, etc.
• bg_data_dgc_v010 - the Curve Pilot database contains dot gain curves
• bg_data_fonts_v040 – the central fonts repository
• bg_data_ipldata_v010 – the Ink planner data
• bg_data_marks_v010 – the SmartMarks repository
• bg_data_screens_v020 - the Imaging Engine screens.

On the Master server, you can use this page to redirect these resources to another system. To
do this, type in the name of the other (Data server) system in the server name field.

Attention:  However, for performance reasons, Esko advises to keep these resources
on the master server.

Note:  You can not redirect individual resources.

28.2.4.  System Account

By default, the Automation Engine server service (BGMD) and the Automation Engine Web
Service (egwebsrv) by default run on the service account BGSYSTEM.

Changing the password of the default System Account of Automation Engine

This important account initially has a default password. When you in doubt what this password
is, contact Esko support. 

Many customers insist on changing the user name and password of this account, usually due
to IT regulations.

This is possible but needs to happen with the dedicated tool in the Server Admin web page
(Server Admin >  System Account).

Changing the System Account of Automation Engine
• You can change the user name to another existing Windows user. This user should be a

member of the Windows Administrators group on the Master computer.
• Modifying the System Account will, in one operation, modify the service account of the

Automation Engine server service (BGMD) and of the Automation Engine Web Service
(egwebsrv).

You can use either the local or domain user name.

• If you have configured a Container or Resource on a computer other than the Master,
Assistant or Data Server, you have to modify the system account manually.
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• If you have configured an Imaging Engine on a computer other than the Master, Assistant
or Data Server, then the modification of the system account will be pushed to the Imaging
Engine.

Important:  This requires that the new user was added as a member of the Windows
Administrators group of the Imaging Engine host. When that is done, also a stop/start of
Imaging Engine is required (see Automation Engine Pilot > Configure >  Imaging Engine)).

28.2.5.  Maintenance

This page serves to rebuild database indexes. Heavily fragmented indexes can cause
Automation Engine to respond slowly. You can remedy index fragmentation by reorganizing or
rebuilding an index.

Click on Start Maintenance Now, select the databases you want to rebuild and click OK.

Please mind the dialog's disclaimer:

 

 

Note:  The Application Server database index cannot be rebuild when the database is not
running.

Scheduling Maintenance

When you want to schedule this maintenance to happen later, unlock the  and click Add
Maintenance Schedule. Select the databases, frequency and start time. Click OK. Please mind
the dialog's disclaimer.

28.2.6.  Backup

This page serves to make backups of the server's Configuration, Resources and Databases.

1790



28Automation Engine

Tip:  It is always a good idea to write the backup on a different computer than where the data
originally are. You can of course keep a local path as destination and then for example copy the
backup data onto a DVD or USB. The backup is created in a subfolder named Backup__yyyy-
MM-dd-HHMM. A full backup is named FullBackup__....

Tip:  You can use a UNC path as location. Just make sure that the corresponding share is
accessible.

 

 
You can schedule a backup or run it instantly.

• When choosing Make Backup Now, you will first be asked which data set you want.

• When scheduling, you can define when and what to backup and also how many backups
you want to keep.

Important:  Especially backups of databases can be large. Use the setting Keep only last
'x' backups to avoid filling up the disk where you keep the backups.

In Backup history,

• the icon  indicates a scheduled backup.

• click on Info to see the server name, date, time, size and composition of the backup.

• click Remove to manually remove a backup.

To restore a backup, go to the page Restore .

FAQs on Backing Up the Server Configuration

Is the Configuration of the Automation Engine Backed Up Automatically?
No but you can easily schedule automatic backups yourself. Learn more in Backup.
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What is included in the Automation Engine Backup ?
The backup always includes the basic Configuration like tickets, workflows, SmartNames,
configuration settings etc. Additionally, you can include Resources: these are the DGC files,
Marks, Color Engine data, Fonts and Imaging Engine screens. And you can also include the
Databases.

Note:  A backup of the databases is also called a Restore Point. When you plan an upgrade,
we refer to the specific chapter in the separate installation documentation. chapter with the
Installation Guide.

28.2.7.  Restore

In the Restore page, you can

• restore, duplicate or migrate your server configuration,
• restore resources or databases only.

Attention:  The server software should be stopped before you can open the lock 
and choose a backup to restore.

 

 

How to Restore the Server
When you choose a backup and click on Restore, you can choose to

• Restore configuration: This is used to go back in time, probably to correct some mistakes,
for example when you deleted too many workflow tickets. This restores everything from
the selected backup.

Note:  This action is only possible when you restore on the server where the backup has
been taken.
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• Duplicate configuration (test): This is used when building test setups, for example to test
pre-release software or to set up a shadow production server.

Attention:

• This function does not restore: Central Resources, Databases, Container setups,
Customers, HotFolders, etc. These data are not taken over from the backup and
are so left untouched. Mind that the data inside Containers was not part of the
backup.

• This function always restores (if available in the backup): (workflow) Tickets,
SmartNames, Users, DFS information and all data related to the folder
bg_data_custom_v010 .

Note:  To build a test setup, you first need to install a full Automation Engine server on the
testing computer. This will also require a separate set of licenses. And then you can use this
mode to restore the configuration on that testing computer. This way, you can have your
production and testing/shadow systems run in parallel.

• Migrate configuration (production): This is used when you plan to move your server to
another computer or when you upgrade onto a separate computer.

Note:  To do this, you first need to install a full Automation Engine server on the new
computer. You then use Migrate Configuration to restore the old/previous production
settings onto the new computer.

You can also use Migrate Configuration to give the Master's configuration to an Assistant
when the Master goes down.

Note:  The Master backup can be found on the Assistant computer (by default on C:\Esko
\AEBackup).

• Restore databases only: Click OK to see a further selection of which databases you want
to restore: Jobs (also includes Customers, Access Points..), Tasks, Task History, Application
Server (page workflows), WFMgr (internal), Gang Run, JDF, etc.

• Restore resources only: Click OK to see a further selection of which resources you want to
restore: DGCs, MarksFonts, CMS , Screens, Custom, etc.

FAQs on Restoring Server Backups

Can I only Restore specific Parts of the Backup?
When you restore Resources,you can specify selections:
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How should I use Backup and Restore when I upgrade my Automation Engine
server software?

For all questions on upgrades, we refer to the Installation Guide, which is a specific chapter in
AE's Complete manual.

28.2.8.  Databases

In the Databases page you can manage all databases that are on any accessible SQL server in
your network. Depending on the permissions on the selected SQL Instance, you can:

• View the SQL server status.
• View the properties and status for each database.
• Backup or Restore databases.
• Repair databases (for example to repair access rights.)
• Move databases.
• Create or remove databases.

Note:  Even when you are logged in to the Server Admin page, you also need to log in to the
SQL Server instance separately. For example via the user sa.
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Note:  When you use Gang Run Printing, it is possible to have a setup where this mode uses
its own database, separated from the BSJobs database. You can then see it here listed as a
separate database named GangRunPrinting.

The database Status can be any of these:

• Online: The SQL Server instance where the server database is located is running. This also
implies that the user name and password used to login to the SQL Server instance are
correct. The server database is online and available for access.

• Not Accessible: The SQL Server instance where the server database is located is running.
Valid credentials (user name and password) are used. But the server database on the SQL
Server instance is not accessible.

• Not Found: The SQL Server instance where the server database should be located is
running and the credentials used to login to the SQL Server instance are valid. But the
server database could not be found on the SQL Server instance.

• Login Failed:: The SQL Server instance where the server database should be located is
running. The server database is not available because the credentials used to login to the
SQL Server instance are invalid.

• Offline: The server database is not available because the SQL Server instance where it is
located is currently not running.

• Unknown: The status of the server database on the SQL Server instance is unknown.
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Creating a Database
These are cases when this tool is useful:

• Some customers want to run the Automation Engine databases on an own full SQL Server
that they are already using. They then use this tool to create the necessary databases. It
also creates the required users and sets the required user rights.

• When your (default) SQL Server Express edition is having trouble with one or more too large
databases, Esko advises to upgrade to a full SQL Server. In case you do not do this, it is
possible to use this tool to create multiple smaller databases. For example customers who
heavily use both the Jobs tool and the Gang Run printing tool. In this case they can create an
extra database for the gang run printing and indicate that one in Configure >  Automation
Engine Database.

1. Click on + to open the Create database dialog.

2. Fill in a Database name that is currently not used.
3. In Use data, choose which database you want to create: A new empty database (No (empty

database)) or From a backup or From existing database files.
4. When they do not appear automatically, enter the location and the file name for the Master

database file and the Transaction log file. Alternatively, Browse to set a specific location
for these files.

Note:  The file names can be either a local or a UNC path. If the selected SQL Server is not
the local SQL Server, the Browse button will be disabled. In such cases, fill in the UNC path.

5. Click OK to create the database.

When No Databases were Installed Yet
When you first come to the Server Admin page after doing a fresh install where you choose
a Special installation (one that does not install the default MS SQL Server Express), you will be
prompted to first create all the required Automation Engine databases.
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Creating the databases is what you want when you decided to use a MS (full) SQL Server from
the beginning. Alternatively, in stead of creating new databases, you can here also choose to
continue using the "embedded" databases (for test-purposes only). Both cases are described
below:

In the case as described above, the Server Admin page will first present you the Create
Automation Engine Databases dialog:
 

 

Creating new databases on a MS SQL Server

• Select the (remote) SQL Server and Instance where you want to create the Automation
Engine databases.

• When the SQL Server you want to use is not in the list, you can add it by clicking 'Select
another SQL Server'. In the dialog, fill in a valid server and click OK.

• When the running instances on the selected SQL Server can not be detected (because for
example the SQL Server Browser is not running on that host), you can then still choose
an instance by typing its port number in the Instance field.

• Provide a user name and password with sufficient privileges, typically the user 'sa'.

• Fill in the local path to the folder on the (remote) SQL Server host in which the database
files should be stored.

• Click Create to start the creation process. When the creation process was successful, you
will be asked to restart the server.

Continue using the embedded databases

Click Continue using embedded databases to skip creating databases.

Choose this option

• when you want a custom setup, for example one where the databases are spread out over
multiple instances. To configure such a custom setup, go to the Automation Engine Database
section in the Pilot's Configure tool.
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• when Esko support staff advises this. For example as part of a solution for a database
problem.

In both cases, you will see a warning that embedded databases are not at all fit to use in
production environment. Learn more in the page describing options in the Configure panel:
Generic setting (Setup tab): DBMS Type  on page 162.

Choosing this option still allows you to cancel.

Deleting a Database
You can delete a database if it is not used by Automation Engine. If it is running, trying to
delete it will trigger a warning.

1. Select a database from the list and click the - button.
2. In the confirmation dialog, choose either or both of the options:.

• Delete database files from disk
• Close existing connections

3. Click OK to confirm.

Database Back Up

• Select a database and click Backup. The Backup database dialog will open.
• Enter the location and the file name for the Backup file or use Browse to choose an

existing backup file.

Note:  The file names can be either a local or UNC path. If the selected SQL Server is not the
local SQL Server, the Browse button will be disabled. In such cases, fill in the UNC path.

• Click OK.

If the selected SQL Server does not have access to the UNC path you entered, the Server
Admin Web Tool will show this warning: "Backup file for database X could not be
created. Please make sure the path for the backup file is correct.".

You can ensure access to the UNC path share by following this procedure:

1. In Windows Explorer, right-click the shared folder and then click Properties.
2. Select the Security tab.
3. Click Advanced. The Advanced Security Settings dialog opens.
4. Under the Permissions tab, click Change Permissions.
5. Click Add.
6. Click Object Types and make sure the Computers check-box is checked. Click OK.
7. In the text field, enter the name of the SQL Server computer name for which you want to

add permissions. Click Check Names. Click OK. The Permission Entry dialog opens.
8. Make sure the Allow check-box next to Create files / write data is checked. Click OK.
9. Click OK and close the open dialogs.

Restoring a Database
Select the database and click Restore. Browse to the location and file name and click OK. 
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When you want to restore a database that does not exist (any more) in the list of SQL Server
Instance databases, then click on +  to create a database from a backup file or from existing
database files. Learn more in Creating a Database  on page 1796.

Note:  If the database you are trying to restore is used by Automation Engine and the
Automation Engine server is running, it will not be possible to restore the database and you
will get a warning.

Moving or Renaming a Database

1. Select the database from the list and click Move. The Move database dialog will open.
2. Enter the (new) location and the (new) file name for the Master database file and for the

Transaction log file or use the Browse button to select to them.

Note:  The file names can be either a local or UNC path. If the selected SQL Server is not the
local SQL Server, the Browse button will be disabled. In such cases, fill in the UNC path.

3. Decide if you want to Close existing connections.
4. Click OK to move/rename the database.

28.2.9.  SQL Server

This page allows you to manage SQL Server instances.
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Note:  When the SQL Server Database is installed on the same system as the Automation
Engine server, the option SA credentials allows to check if the SA credentials used by
Automation Engine are still in sync with that database. This option is not shown for other
SQL databases. It is also not shown until you are logged in to the SQL server with the right

credentials (click  to do so).

When the Check detects that the credentials are not in sync, a dialog asks to enter the current
password for the SA user. Mind that this dialog does not allow you to specify a new password
for SA, only to update the stored SA password used by AE.

How to Log in to an SQL Server Instance
• Select an SQL Server from the list of all SQL Servers that could be detected in your local

network.
When there is one, the local SQL Server will be selected as default.

• To choose one that is not in the list, click Select another SQL Server, enter the name of the
SQL Server and click OK.
You can see the list of SQL Server Instances and their statuses beneath the SQL Server list.
You can select the Server Instance on which you want to manage the databases.

Note:  When the SQL Server Browser service is not running or when your access is blocked
to the Server Service, the status of the Instance will be unknown.

Note:  When the list of SQL Server Instances is not available, you can select an SQL Server
Instance by entering its port number. The port number of the default SQL Server Instance
will already be filled in.

•
After selecting the SQL Server Instance, click the lock  at the bottom of the page and enter
your credentials to login.
You have to login to an SQL Server Instance to be able to manage its databases.

Note:  All SQL instances configured with Automation Engine have two users by default:
sa and admin. The sa user has all permissions to manage databases. The admin user
has a limited set of permissions, you may get warnings while performing certain database
actions.

•
You can log out from the SQL Server Instance by clicking on the lock .

• You can view the databases installed on an SQL Server Instance by selecting it and logging
in. The list of databases will load after logging in.
Detailed database information will be available to the right of the selected database.

FAQ on SQL Server Instances

How to Start or Stop an SQL Server Instance?
Select the SQL Server Instance and click on Start / Stop the server.

Note:  You are not required to login to the SQL Server Instance to start or stop the Server.
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How to View the Properties of a SQL Server Instance?
The properties of an SQL Server Instance are shown automatically after you successfully
logged in. Learn more in How to Log in to an SQL Server Instance on page 1800.

How to Modify the Maximum Memory of an SQL Server Instance?
Click the Modify link next to the Max. physical memory. In the dialog, enter a value and click
OK.

How to View SQL Server Logs?
Click the Show link next to SQL Server logs. You can see the SQL Server logs in the following
dialog.

Note:  When you have limited permissions, you will get a warning when you attempt to view
the SQL Server logs.

 

28.2.10.  About

The About page shows detailed information about the Automation Engine server software
version, updates and hotfixes that were installed on this server.
 

 
To learn more details about a hotfix, click its Info button. You will see its name, a description
what it is for, on what version it should be installed and when it was created.

28.2.11.  How to Redirect the Temporary Files folder

The Automation Engine server requires a folder for creating temporary files. By default, this
folder is C:\Esko\bg_data_fastserver_v100\tmp. Because this default folder is located on
the system partition, this could lead to disk space problems. To prevent this, you can redirect
the folder for these temporary files.
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You will need:

• Administrator Rights
• A large disk partition

Follow these steps to create a specific temporary folder for the Automation Engine server:

1. In Windows Explorer, create a folder on a large disk partition, that you want to be used for
these temporary files.

2. In Control Panel, click System > Advanced System Settings.
3. Click the Advanced tab.
4. Click Environment Variables.
5. In the Environment Variables dialog, select the BG_TMP variable under System variables.
6. Click Edit.
7. Fill in the full path specification of the selected temporary folder in the Variable Value box

and click OK.
8. Go to Automation Engine Server Web Page > Server Admin > Status Overview page.

Click on the Activate Server . When activating the server, a log window will indicate the
server activation progress.

1802



29Automation Engine

29.  Troubleshooting
Automation Engine administrators can easily run diagnostic tests on the Automation Engine
server and on the Pilot. These tools help to understand and fix the problems without help from
Esko support.

29.1.  Alerts

Concept

Alerts is an (old) tool to inform Pilot users about important events related to Automation
Engine's working or configuration.

Many of these events are also managed with more recent tools, like the 'Server Checks' or the
'Connection Doctor'.

Typical for alerts is that they pop up in the Pilot, in a separate dialog.

Types and examples
• A red alert reports a system problem or urgent important information. For example:

Containers that can't be accessed, database problems, upcoming shutdown of the server,
communication related errors (Access Points), etc.

• An orange alert advises you to make some change. For example: Change how a workflow
is constructed because it generated an excessive amount of tokens (which slows down the
server).

Managing Alerts
• Cleanup: The only way to clean up the list of alerts is to manually (multi-)select items and

press 'delete'.
• Some alerts can be switched off. This is done per user. Learn more in User Properties - OLD.

29.2.  Troubleshooting the Server

In the Automation Engine Server Web Page, the section Server Checks helps an Automation
Engine administrator to diagnose and fix any problems.

You can open the server web page by entering http://<name of your server>  or
http://<name of your server>:9999 in the address field of your browser.
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Note:  You will be asked to log in using an administrator account or use an account that is a
member of the BGADMIN user group on the Automation Engine server.

29.2.1.  Checking the Databases

The Databases page checks

• if the database system of the database is up and running.
• if the database is online and accessible for the Automation Engine server.
• if the size of the database is not nearing its size limit.

Click Info to see some more information like the database file name and the SQL Server and/
or SQL Server instance where the database is located (if the database system is Microsoft SQL
Server).

Note:  These are the databases that are configured in the Configure tool, in Automation Engine
Databases.

 

 

The Status of the database can be one of these:

•  The database is online and accessible.

•  The database is online and accessible, but there are one or more warnings (for example
the database is near its size limit or the connection speed is not sufficient).

Note:  The connection speed is checked by this small test:

1. Start the timing
2. Connect to the specific database
3. Retrieve some data (db query of “select @@Version”)
4. Stop the timing.

This test is repeated 10 times, and then an average is calculated. When that average speed
exceeds 100 ms, the status is a warning.

•  The database is not online or is not accessible (for example no connection could be
made to the database system, or the login failed).
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•  The status of the database is unknown. This is the case when the DBMS type of your
Application Server database is Oracle or when any of the other databases is an Embedded
database. There are no tests available for these two types.

Note:  When the Automation Engine server is not running, you can still check the status of its
databases. In this case however, the Database System field will be empty.

29.2.2.  Checking the Containers

The Containers page checks the status of each container configured on this Automation
Engine server.
 

 

This page checks

• if the container is online and accessible for the Automation Engine server.
• if the used disk space of the disk where the container is located is not getting too high.

The percentage of used disk space at which you get a warning or an error can be set in the
Settings page.

29.2.3.  Checking Disks

The Disks page checks and shows detailed information about the disks where the Automation
Engine system folders are located.
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For every Automation Engine system folder, this page checks:

• If the disk where the system folder is located is accessible to the Server.
• If the free disk space of the disk where the system folder is located is not getting too low.

• When the free disk space is less than 20 GB, the check will show a warning.
• When the free disk space is less than 5 GB, the check will show an error.

29.2.4.  Checking the Network

The Network page checks and shows detailed information about network connections of
the Automation Engine server, including those to external systems like the License Server,
WebCenter Sites and Devices.
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The network checks are grouped into 3 categories:

• General: This category checks

• if the Automation Engine server can connect to the Online Help (http://help.esko.com).
• if the DNS settings are configured correctly (does the server name of this server

computer match with what the DNS returns to other systems when they try to access it).
• if the License Server can be reached (in case of failure, basic network tests are done to

verify DNS configuration and TCP/IP connectivity).
• if the Assistant Server(s) can be reached (in case of failure, basic network tests are done

to verify DNS configuration and TCP/IP connectivity).
• WebCenter Sites: This category checks the network connection between the Automation

Engine server and the configured WebCenter sites.
• RIPs: The connection with configured Imaging Engines or FlexRips.
• Workflow Servers: The connection between the Automation Engine server and Nexus or

Odystar servers, which are used by the ‘Send to …tasks' (by now outdated' tasks).
• Digital Presses: The connection with configured digital presses.
• Devices: The connection with configured Devices (CDI Imagers or Kongsberg tables).
• Esko Cloud Locations. Learn more in Collaborating via Esko Cloud  on page 1471.

If there are no network checks available or applicable for a certain category, then that category
will not be shown, except for the General category, which is always shown.

Possible Statuses
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•  The network test succeeded.
•  The network test succeeded, but there are one or more warnings.
•  The network test failed.
•  The network test was not applicable or was skipped.

29.2.5.  Checking System Health

These three categories check the health of your server computer: Processor Cores, Memory
and Tasks.
 

 

Processor Cores
The check determines if sufficient processor cores are present for the current Automation
Engine setup.

For each Automation Engine server (master and assistants):

• The number of processor cores is calculated that are required to run the configured
number of file streaming sessions (the Viewer) and Gang Run Printing sessions.

• 2 file streaming sessions require 1 processor core. If the number of file streaming
sessions is not even, an extra processor core is required.

• 1 gang run printing session requires 1 processor core.
• Based on this calculation, if there are not enough processor cores, the resulting status is a

warning and a specific message. An example:

The number of processor cores in "name-of-the-server" ({1}) is not
sufficient. A system that can run {2} file streaming sessions and {3}
gang run printing sessions requires at least {4} processor cores.

For the whole cluster, the remaining number of processor cores is checked against the number
of defined processing channels. 1 processing channel requires 1 processor core.

Note:  The remaining number of processor cores in the cluster is the sum of all remaining
cores in each host after subtracting the ones needed for file streaming and gang run printing
sessions.
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When there are not enough processor cores to run tasks, the resulting status is a warning and
a message appears. An example:

The number of processor cores in the cluster available for running tasks
({0}) is not sufficient. There should be at least {1} processor cores
available. Please consider reducing the number of file streaming sessions
and/or gang run printing sessions or consider upgrading your cluster.

Memory
This check determines if sufficient memory (RAM) is present for the current Automation Engine
setup.

For each Automation Engine server (master and assistants):

• The amount of memory is calculated that is required to run the configured number of file
streaming sessions (Viewer) and gang run printing sessions. 1 file streaming session
requires 1 GB. 1 gang run printing session requires 500 MB.

• Based on this calculation, if there are is not enough memory, the resulting status is a
warning and a specific message is shown. An example:

The amount of memory in "{hostname}" ({1}) is not sufficient. A system
that can run {2} file streaming sessions and {3} gang run printing
sessions requires at least {4}.

For the whole cluster, the remaining amount of memory is checked against the number of
processing channels defined. 1 processing channel requires 2 GB.

Note:  The remaining amount of memory in the cluster = the sum of all remaining memory
in each host after subtracting the memory needed for file streaming and gang run printing
sessions.

If there is not enough memory to run tasks, the resulting status is a warning and a specific
message appears. An example:

The amount of memory in the cluster available for running tasks ({0}) is
not sufficient. There should be at least {1} available. Please consider
reducing the number of file streaming sessions and/or gang run printing
sessions or consider upgrading your cluster.

Tasks

The number of tasks in the tasks database is checked against some predefined thresholds.
Also, a check for old tasks is done.

• The thresholds depend on the database version:

• For an SQL Express edition, the warning threshold is 30.000, the error threshold is
100.000 .

• For all other database versions, the warning threshold is 200.000, the error threshold is
none.

• Old tasks are tasks that were launched more than 6 months ago. The check returns a
specific message. An example:

The Tasks database contains {0} tasks of which {1} tasks are older than
6 months. Please consider adding cleanup rules for the Tasks database
in Configure.
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29.2.6.  Scheduled Checks

This page allows to schedule automatic runs of the Server Checks. When there are warnings
or errors, they send a report via e-mail.

To add a scheduled check, click the Add Scheduled Check button.
 

 

• Select one or more items to Check.

• Select the Frequency and the Start time.

• Specify if you want the report to be sent on Warning or Error or on Error Only.

• Specify the e-mail address or a semicolon-separated list of e-mail addresses that the report
should be sent to.

Click OK to add the scheduled check.

Your scheduled check appears in the list. Add more if you want to.
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29.2.7.  Settings

 

 

Enter the new values for the settings you wish to change and click Apply. The new values will
be used the next time those checks are done.

For the check on Containers, you can decide the percentage of used disk space that triggers a
warning (90% by default) or an error (99% by default).

29.3.  Troubleshooting the Pilot
The Connection Doctor checks if the Pilot's connection to the Automation Engine server works
properly. This tool helps you to fix a problem without the need to contact Esko support.
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Consulting the Connection Doctor
In the Pilot, choose Tools > Connection Doctor.
 

 

Note:  When you have troubling logging on to the Pilot (or Shuttle), the error message will also
allow to start up this tool:
 

 

This tool checks:

• Access to the Automation Engine server software
• Latency in the network between client and server
• Access to the service on the server that runs the Automation Engine Viewer
• Access to updates of the client software (triggered by a change of the server software)
• Direct access to the internet (of this client computer).

Example:
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Status Details
Detailed messages explain the result of the check:

Table: Server

Message Clarification

The Automation Engine server is down
for maintenance. Please try again later or
contact your administrator.

The maintenance status includes: server
updates, server upgrades or the installation of
hot fixes.

The Automation Engine server is
restarting. Please try again in a moment.

This can take a few seconds to a few minutes.

The server you're connecting to is an
assistant server. Please connect to the
master server <host_name of the master>.

In setups where Automation Engine runs on
multiple servers, one server is designated as
master. The other servers take up the role of
assistants. The master server is the server you
need to log in to.

The server is currently set to idle.
Please try again later or contact your
administrator.

When a server has no or expired licenses
and a server restart is done, the server starts
up in idle mode ; it then does not accept
connections.

There was a problem connecting to
<host_name>. Please check that the host
name is correct and <host_name> is on.

This computer is unable to connect to the
host. Please check that the host name is filled
in correctly and that the computer is switched
on. Contact your IT department for more
assistance.

There was a problem connecting to
<host_name>. Please check that the server
is running.

This client computer is unable to connect
to the Automation Engine server. The most
common reason for this is that the server
software is not running.

If the server software is running, check if
your computer is correctly connected to the
network.

1813



29 Automation Engine

Message Clarification
Contact your IT department for more
assistance.

There was a problem connecting to
<host_name>. Please check that the
server is running, and verify with your IT
administrator if the "<host_name>'s" host
file is correct.

This computer is unable to connect to the
Automation Engine server. The most common
reason for this is that the server software is
not running.

If the server software is running, verify if
the hosts file of your operating system
is correct. The hosts configuration of this
computer contains explicit references to the
Automation Engine server's host name and its
IP addresses. A configuration error could be
the cause of this connection problem.

Contact your IT department for more
assistance.

There was a problem connecting to
<host_name>. Please check that your
computer is connected to the network.

This computer is unable to access the
network. You can try and diagnose the
problem by using one of the following
methods:

• On Mac, go to: Applications > System
Preferences > Network > Assist me... to
test your connection .

• On Windows, go to: Start > Control Panel
> Network and Internet > Network
and Sharing Center > Troubleshoot
Problems > Network Adapter to test your
connection.

Table: Latency

Message Clarification

Latency in connection to the server is
acceptable.

The response time between this computer
and the server (the 'ping') is less than 20
milliseconds, which is considered good (green
status).

Latency in connection to the server can be
problematic.

The response time between this computer
and the server is between 20 milliseconds and
100 milliseconds (orange status). This is OK for
normal operations.

Latency in connection to the server is likely
unacceptable.

The response time between this computer
and the server is more than 100 milliseconds
(red status). This is considered too slow
for normal operation. Consult with your IT
department what can be done to improve the
speed.
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Table: Viewer

Message Clarification

There was a problem connecting to the
Application Server. Please check that
the server is running. Contact your
administrator if the problem persists.

Esko's 'Application Server' is a dedicated
software service that enables the Viewer tool.
In this case this service could not be reached.
Check if the server is running.

The Application Server <host_name> is not
running on port <port_number>. Please
contact your administrator.

The Application Server is not running on the
designated port.

Note:  Since v20, the Viewer no longer uses this Application Server.

Table: Software Update

Message Clarification

Software updates will be downloaded and
installed when they become available.

The Automation Engine Web Server is
accessible from this computer. Updates of the
client software will be available.

The Automation Engine Web Server could
not be reached. Software updates will not
be installed on this machine.

This is most likely due to firewall restrictions.
Contact your administrator to resolve this
issue.

Note:  The Automation Engine server hosts software updates for its client applications like
the Pilot and Shuttle. This test checks if software updates can be downloaded from the server
to the client computer. The test will fail if the Automation Engine Web Server is not correctly
hosted on port 9999. For example, if another web service has claimed this port on the server.
Please contact your Automation Engine administrator to resolve this issue.

Table: Direct internet access

Message Clarification

Esko online help is available at http://
help.esko.com/.

This computer can access the internet.

Pilot was unable to connect to the
Internet. Please check the Internet proxy
preferences of your operating system if
you have experience problems accessing
Esko online help.

This computer was unable to connect to the
internet (it failed to, as a sample test, access
Esko's help pages). Check the internet proxy
preferences of your operating system. Contact
your IT department for more assistance.

Note:  When Esko's online help pages are unreachable, a warning is shown. This does not
necessarily mean that the online help is unavailable. Your internet browser, which is used to
display the help pages, may be configured with an internet proxy that enables you to access
the online help even if the Pilot is unable to connect to it. Please contact your IT administrator
for more information.
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29.4.  Troubleshooting the Software

The Diagnostics tool allows you to monitor the status and activity of the Automation Engine
software in deep technical detail. This tool is typically used by Esko support staff. In case they
want you to use it, they will instruct you how to use it.
 

 

This tool is automatically installed on any client computer that downloaded a Pilot and/
or Shuttle from the Automation Engine Server web page. You can start it up by using its
desktop shortcut.
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